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 Understand the basics

  What is mixed reality?What is mixed reality?

The mixed reality ecosystem is an emerging landscape of physical and digital interactions, limited only by your

imagination. Whether you're an experienced developer or a new convert, we recommend that you begin your

mixed reality journey with the resources we've laid out below. There's a lot of new ground to cover, so let's get

started!

If you're new to mixed reality, it's important that you start from the bottom and work your way up through its

core concepts, experiences, and capabilities. You have several options here: we have a focused module on

Microsoft Learn that will get you up to speed in no time, or you can choose to explore the individual journeys

we've set up below. Any of these paths will help you set a firm foundation for designing and developing your

own ideas in mixed reality.

Introduction to Mixed Reality module

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/discover/get-started-with-mr.md
https://docs.microsoft.com/en-us/learn/modules/intro-to-mixed-reality


C O N C EP TC O N C EP T O UTC O M EO UTC O M E

Mixed reality is a spectrum Mixed reality blends the physical with the digital to provide
the next evolution in human, computer, and environment
interactions

What is a hologram? Our HoloLens headset lets you view holograms, which are
objects made of light and sound that appear in the world
around you like real objects. Holograms respond to your
gaze, gestures and voice commands, and can interact with
real-world surfaces around you

Mixed reality learning overview Try out our curated mixed reality module through Microsoft
Learn

Expand your design process Expand your design mindset with spatial thinking,
bodystorming, and acting when creating your immersive
experiences

 See how industry partners are using mixed reality

  

Before you dive into application design or development, you need to understand what we mean by mixed

reality. This section is designed to get you acquainted with the mixed reality spectrum, including environmental

input, perceptual changes, design challenges, and devices.

https://docs.microsoft.com/en-us/hololens
https://customers.microsoft.com/story/839709-mercedes-benz-automotive-holoLens-en-usa


Mercedes-Benz is transforming the service workforce with HoloLens 2 and Dynamics 365 Remote AssistMercedes-Benz is transforming the service workforce with HoloLens 2 and Dynamics 365 Remote Assist

  BHP increases the pace of innovation with mixed reality and IoT, despite lockdownBHP increases the pace of innovation with mixed reality and IoT, despite lockdown

  Healthcare startup cuts time to market by up to 70%, despite pandemicHealthcare startup cuts time to market by up to 70%, despite pandemic

  View complex construction projects with Bentley's digital construction softwareView complex construction projects with Bentley's digital construction software

Mercedes-Benz USA is using HoloLens 2 and Dynamics 365 Remote Assist to improve service technician

efficiency, solve problems more quickly, and reduce the cost and environmental impact of service-related travel.

Despite COVID-19's impact and restrictions, BHP is delivering support and training to field workers from

thousands of miles away with HoloLens 2 and Dynamics 365 Remote Assist.

Healthcare startup Mediview has developed a remarkable product that uses 3D holograms projected either

directly on top of the patient’s anatomy or hovering above it to help surgeons see the patient's internal anatomy

and guide them through procedures.

Synchro is digital construction software that enables users to view complex construction projects in mixed

reality. Their 4D digital construction platform combines traditional Gantt chart CPM scheduling with integrated

4D visualization capabilities in real time.

https://customers.microsoft.com/story/839709-mercedes-benz-automotive-holoLens-en-usa
https://customers.microsoft.com/story/850776-bhp-energy-dynamics-365-hololens
https://customers.microsoft.com/story/850776-bhp-energy-dynamics-365-hololens
https://customers.microsoft.com/story/848966-mediview-mcs-story
https://customers.microsoft.com/story/848966-mediview-mcs-story
https://binged.it/31AR3kP
https://binged.it/31AR3kP


  PTC's Vuforia Studio authoring solution promotes workforce productivity and safetyPTC's Vuforia Studio authoring solution promotes workforce productivity and safety

  Philips helps physicians "see" inside their patientsPhilips helps physicians "see" inside their patients

  Explore HoloLens and mixed reality servicesExplore HoloLens and mixed reality services

Vuforia Studio's efficient mixed reality authoring solution promotes workforce productivity and safety by

delivering information when and where workers need it most: in the real-world context of their daily work

environment.

Philips is piloting HoloLens in the domain of image-guided invasive procedures, during which physicians rely on

live X-ray, ultrasound, and other sources of information to "see" inside the patient and guide their actions.

If you're curious to see how the different mixed reality hardware and services work, check out the links below.

These links will lead you to different parts of the Microsoft documentation. We recommend that you set

bookmarks and return here to continue on your design and development journey.

https://binged.it/31ARrjh
https://binged.it/31ARrjh
https://binged.it/31B1RiR
https://binged.it/31B1RiR


C O N C EP TC O N C EP T O UTC O M EO UTC O M E

HoloLens hardware HoloLens 2 offers the most comfortable and immersive
mixed reality experience available, with industry-leading
solutions that deliver value in minutes—all enhanced by the
reliability, security, and scalability of cloud and AI services
from Microsoft

Dynamics 365 Explore a range of products that can empower employees
and optimize operations with Dynamics 365, including
Remote Assist, Layout, and Guides. You gain meaningful
insights from getting hands-on with real work, real devices,
and real users

Azure Cloud Services Build compelling immersive experiences on different
platforms with spatial awareness, spatial anchors, and
complex 3D model rendering

Microsoft Mesh Mesh lets people connect with presence, share across space,
and collaborate with one another, from anywhere in the
world, through Mesh-enabled mixed reality experiences.
With Mesh, you can enhance virtual meetings, conduct
virtual design sessions, help others remotely, and host
virtual meet-ups

 What would you like to do next?

IMPORTANTIMPORTANT

Star t designingStar t designing

Learn the basic concepts you need to begin designing and prototyping.

Star t developingStar t developing

Choose a development path based on your skill level, work style, or platform interest.

Come to an eventCome to an event

Get started with your Mixed Reality development journey.

All mixed reality development materials are provided on this site for your reference only. Your application, its usage, and

its effect on end users is your sole responsibility as the application developer; this means you must ensure that your app

doesn't cause discomfort, injury, or any other harm to the end user, and includes appropriate warnings and disclaimers.

You must always take the appropriate steps in the development and publishing of your application to ensure that your

application is safe, and that you meet all obligations in your App Developer Agreement with Microsoft.

https://www.microsoft.com//hololens/hardware
https://dynamics.microsoft.com/mixed-reality/overview/
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/remote-assist/ra-overview
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/layout/
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/guides/
https://docs.microsoft.com/en-us/mesh/overview
https://docs.microsoft.com/en-us/legal/windows/agreements/app-developer-agreement
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Mixed reality is the next wave in computing followed by mainframes, PCs, and smartphones. Mixed reality is

going mainstream for consumers and businesses. It liberates us from screen-bound experiences by offering

instinctual interactions with data in our living spaces and with our friends. Online explorers, in hundreds of

millions around the world, have experienced mixed reality through their handheld devices. Mobile AR offers the

most mainstream mixed reality solutions today on social media. People may not even realize that the AR filters

they use on Instagram are mixed reality experiences. Windows Mixed Reality takes all these user experiences to

the next level with stunning holographic representations of people, high fidelity holographic 3D models, and the

real world around them.

Mixed reality is a blend of physical and digital worlds, unlocking natural and intuitive 3D human, computer, and

environmental interactions. This new reality is based on advancements in computer vision, graphical processing,

display technologies, input systems, and cloud computing. The term "mixed reality" was introduced in a 1994

paper by Paul Milgram and Fumio Kishino, "A Taxonomy of Mixed reality Visual Displays." Their paper explored

the concept of a virtuality continuum and the taxonomy of visual displays. Since then, the application of mixed

reality has gone beyond displays to include:

Environmental understanding: spatial mapping and anchors.

Human understanding: hand-tracking, eye-tracking, and speech input.

Spatial sound.

Locations and positioning in both physical and virtual spaces.

Collaboration on 3D assets in mixed reality spaces.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/discover/mixed-reality.md
https://search.ieice.org/bin/summary.php?id=e77-d_12_1321


 Environmental input and perception

Image: mixed reality is the result of blending the physical world with the digital world.

In recent decades, the relationship between humans and computers has continued to evolve by means of input

methods. A new discipline has emerged that's known as human-computer interaction or "HCI". Human input can

now include keyboards, mice, touch, ink, voice, and Kinect skeletal tracking.

Advancements in sensors and processing power are creating new computer perceptions of environments based

on advanced input methods. This is why API names in Windows that reveal environmental information are

called the perception APIs. Environmental inputs can capture:

a person's body position in the physical world (head tracking)

objects, surfaces, and boundaries (spatial mapping and scene understanding)

ambient lighting and sound

object recognition

physical locations

Image: The interactions between computers, humans, and environments.

A combination of three essential elements sets the stage for creating true mixed reality experiences:

Computer processing powered by the cloud

Advanced input methods

Environmental perceptions

As we move through the physical world, our movements are mapped in a digital reality. Physical boundaries

https://docs.microsoft.com/en-us/azure/kinect-dk/about-azure-kinect-dk
https://docs.microsoft.com/en-us/uwp/api/windows.perception


 The mixed reality spectrum

https://www.youtube.com/embed/_xpI0JosYUk 

  Augmented vs. virtual realityAugmented vs. virtual reality

 Devices and experiences

influence mixed reality experiences such as games or task-based guidance in a manufacturing facility. With

environmental input and perceptions, experiences start to blend between physical and digital realities.

Mixed reality blends both physical and digital worlds. These two realities mark the polar ends of a spectrum

known as the virtuality continuum. We refer to this spectrum of realities as the mixed reality spectrum. On one

end of the spectrum, we have the physical reality that we as humans exist. On the other end of the spectrum, we

have the corresponding digital reality.

Most mobile phones on the market today have little to no environmental perception capabilities. The

experiences these phones offer can't mix physical and digital realities.

The experiences that overlay graphics, video streams, or holograms in the physical world are called augmented

reality. The experiences that occlude your view to present a fully immersive digital experience are virtual reality.

The experiences that can transition between augmented and virtual realities form mixed reality, where you can:

Place a digital object, such as a hologram, in the physical world as if it were physically present.

Be personally and digitally present in the physical world, in the form of an avatar, to asynchronously

collaborate with others at different points in time.

When a user is in virtual reality, the physical obstacles in their immediate surroundings, such as walls and

furniture, are represented digitally within the experience so that the user can avoid colliding with those physical

obstacles.

Image: The mixed reality spectrum

Most augmented reality and virtual reality experiences available today represent a small subset of the larger

mixed reality spectrum. Windows 10 is built with the entire spectrum in mind, and allows blending digital

representations of people, places, and things with the real world.

There are two main types of devices that deliver Windows Mixed Reality experiences:

1. Holographic devicesHolographic devices  are characterized by the device's ability to display digital objects as if they existed in

https://www.youtube.com/embed/_xpI0JosYUk


C H A RA C T ERIST ICC H A RA C T ERIST IC H O LO GRA P H IC  DEVIC ESH O LO GRA P H IC  DEVIC ES IM M ERSIVE  DEVIC ESIM M ERSIVE  DEVIC ES

Example deviceExample device Microsoft HoloLens Samsung HMD Odyssey+

DisplayDisplay See-through display. Allows the user to
see the physical environment while
wearing the headset.

Opaque display. Blocks out the physical
environment while wearing the headset.

MovementMovement Full six-degrees-of-freedom movement,
both rotation and translation.

Full six-degrees-of-freedom movement,
both rotation and translation.

NOTENOTE

the real world.

2. Immersive VR devicesImmersive VR devices  are characterized by the device's ability to create a sense of presence by blocking

out the physical world and replacing it with a fully immersive digital experience.

Whether a device is tethered to a separate PC (via USB cable or Wi-Fi) or untethered doesn't reflect whether a device is

holographic or immersive. Features that improve mobility often provide better experiences. Holographic and immersive

devices can be either tethered or untethered.

Mixed reality experiences are the result of technological advancements. There aren't any devices today that can

run experiences across the entire spectrum. Windows 10 provides a common mixed reality platform for both

device manufacturers and developers. Any given device today can support a specific range within the mixed

reality spectrum. In the future, new devices with more expansive range are expected: holographic devices will be

more immersive, and immersive devices will be more holographic.

Image: Where devices exist on the mixed reality spectrum

As an application or game developer, what type of experiences do you want to create? The experiences will

typically target a specific point or part on the spectrum. You'll need to consider the capabilities of devices you

wish to target. Experiences that rely on the physical world will run best on HoloLens.

Towards the left (near physical reality).Towards the left (near physical reality). Users remain present in their physical reality, and aren't made to

believe they have left that reality.



 Next Discovery Checkpoint

In the middle (fully mixed reality).In the middle (fully mixed reality). These experiences blend the real world and the digital world. For

example, in the movie Jumanji, the physical structure of the house where the story took place was blended

with a jungle environment.

Towards the r ight (near digital reality).Towards the r ight (near digital reality). Users experience a digital reality and are unaware of the

physical reality around them.

You're in the beginning of the discovery journey we've laid out for you, and exploring the basics of mixed reality.

From here, you can continue to the next foundational topic:

What is a hologram?

https://en.wikipedia.org/wiki/Jumanji
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https://www.youtube.com/embed/MVXH5V8MVQo 

 Device support

FeatureFeature HoloLens (first gen)HoloLens (first gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Holograms ✔️ ✔️ ❌

 A hologram is made of light and sound
  LightLight

HoloLens lets you view hologramsholograms , which are objects made of light and sound that appear in the world around

you like real objects. Holograms can respond to your gaze, gestures, and voice commands. They can even

interact with real-world surfaces around you. Holograms are digital objects that are part of your world.

The holograms that HoloLens renders appear in the holographic frame directly in front of users' eyes.

Holograms add light to your world, which means that you see both the light from the display and the light from

your surrounding world. Since HoloLens uses an additive display that adds light, the black color will be rendered

transparent.

Holograms can have different appearances and behaviors. Some are realistic and solid, and others are

cartoonish and ethereal. You can use holograms to highlight features in your environment or use them as

elements in your app's user interface.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/discover/hologram.md
https://www.youtube.com/embed/MVXH5V8MVQo
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


  SoundSound

 A hologram can be placed in the world or tag along with you

Holograms can also produce sounds, which appear to come from a specific place in your environment. On

HoloLens, sound comes from two speakers that are located directly above your ears. Same as the holographic

displays, the speakers are additive, introducing new sounds without blocking the sounds from your

environment.

When you have a fixed location for a hologram, you can place it precisely at that point in the world. As you walk

around, the hologram appears stationary based on the world around you, just like a physical object. If you use a

spatial anchor to pin the object, the system can even remember where you left it when you come back later.

Some holograms follow the user instead. They position themselves based on the user. You can choose to bring a

hologram with you, and then place it on the wall once you get to another room.

Best practicesBest practices

Some scenarios demand that holograms remain easily discoverable or visible throughout the experience.

There are two high-level approaches to this kind of positioning. Let's call them display-lockeddisplay-locked and body-body-

lockedlocked.

Place the hologram at a comfortable viewing distance typically about 1-2 meters away from the head.

Allow elements to drift if they must be continually in the holographic frame, or consider moving your content

to one side of the display when the user changes their point of view. For more information, see the

billboarding and tag-along article.

Display-lockedDisplay-locked content is locked to the display device. This type of content is tricky for several

reasons, including an unnatural feeling of "clingyness" that makes many users frustrated and wanting

to "shake it off." In general, designers have found it better to avoid display-locking content.

Body-lockedBody-locked content can be far more forgiving. Body-locking is when you tether a hologram to the

user's body or gaze vector in 3D space. Many experiences have adopted a body-locking behavior

where the hologram follows the user's gaze, which allows the user to rotate their body and move

through space without losing the hologram. Incorporating a delay helps the hologram movements to

feel more natural. For example, some core UI of the Windows Holographic OS uses a variation on

body-locking that follows the user's gaze with a gentle, elastic-like delay while the user turns their

head.

Place holograms in the optimal zone--between 1.25 m and 5 mPlace holograms in the optimal zone--between 1.25 m and 5 m

Two meters is the optimal viewing distance. The experience will start to degrade as you get closer than one



 A hologram interacts with you and your world

meter. At distances less than one meter, holograms that regularly move in depth are more likely to be

problematic than stationary holograms. Consider gracefully clipping or fading out your content when it gets too

close so you don't jar the user into an unpleasant viewing experience.

Holograms aren't only about light and sound; they're also an active part of your world. Gaze at a hologram and

gesture with your hand, and a hologram can start to follow you. Give a voice command, and the hologram can

reply.

Holograms enable personal interactions that aren't possible elsewhere. Because the HoloLens knows where it is

in the world, a holographic character can look at you directly in the eyes and start a conversation with you.

A hologram can also interact with your surroundings. For example, you can place a holographic bouncing ball

above a table. Then, with an air tap, watch the ball bounce, and make sound as it hits the table.



 A hologram is what 
you can dream up

 Next Discovery Checkpoint

Holograms can also be occluded by real-world objects. For example, a holographic character might walk

through a door and behind a wall, out of your sight.

Tips for integrating holograms and the real worldTips for integrating holograms and the real world

Aligning to gravitational rules makes holograms easier to relate to and more believable. For example: Place a

holographic dog on the ground & a vase on the table rather than have them floating in space.

Many designers have found that they can integrate more believable holograms by creating a "negative

shadow" on the surface that the hologram is sitting on. They do this by creating a soft glow on the ground

around the hologram and then subtracting the "shadow" from the glow. The soft glow integrates with the

light from the real world. The shadow is used to ground the hologram in the environment.

As a holographic developer, you have the power to break your creativity out of 2D screens and into the world

around you.

What will you build?

You're on the discovery journey we've laid out, and exploring the basics of Mixed Reality. From here, you can

continue to the next foundational topic:

Expand your design process
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 General modules

  Introduction to Mixed RealityIntroduction to Mixed Reality

 Unity modules

  Build mixed reality digital twins with Azure Digital Twins and UnityBuild mixed reality digital twins with Azure Digital Twins and Unity

Microsoft Learn is where everyone comes to learn. Discover new skills, find certifications, and advance your

career in minutes with interactive, hands-on learning paths.

The more tools you have when developing for Mixed Reality the better. While documentation and written

tutorials are crucial, if you're more of a visual learner then our video content on Microsoft Learn is the place to

be. More modules are being added all the time, so be sure to check back for more updates!

Our Learn modules help you become proficient in Mixed Reality development, offering a module-based

structure to get you started with key tools like Mixed Reality Toolkit, Unity, and Azure mixed reality services.

Getting to Hello World has never been clearer, as we lay out the Learning Objectives, Prerequisites, and set time

to completion expectations all in one interface.

Browse Mixed Reality Learn modules

If you're curious about the foundations of Mixed Reality or haven't chosen a development path yet, start with our

tech-agnostic learning modules to get started.

Build a foundation in the core concepts, terminology, and design processes unique to the Mixed Reality

development space.

Learning objectivesLearning objectives

By the end of this module, you'll be able to:

Define Mixed Reality and differentiate between virtual and augmented reality

Describe the core ideas behind holograms

Start designing and developing 3D applications

Understand what Mixed Reality offers in real-world apps

Use the power of the cloud for Mixed Reality

Whether you're just starting or an experienced professional, our hands-on approach to Mixed Reality

development in Unity helps you get to your goals faster, with more confidence, and at your own pace.

Learn how to create of a mixed reality HoloLens 2 application using Azure Digital Twins and Unity, a real-time

3D platform.

Learning objectivesLearning objectives

By the end of this learning path, you'll be able to:

Install and configure your development environment for building Mixed Reality solutions for the HoloLens 2,

using Azure Digital Twins and Unity

Create a 3D scene in Unity using static and dynamic terrain data with Microsoft’s Maps SDK

Use MRTK interactions to provide a rich user experience

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/discover/mr-learning-overview.md
https://docs.microsoft.com/en-us/learn/browse/?terms=mixed+reality
https://docs.microsoft.com/en-us/learn/modules/intro-to-mixed-reality/
https://docs.microsoft.com/en-us/learn/paths/build-mixed-reality-azure-digital-twins-unity/


  Set up a mixed reality project in Unity with the Mixed Reality ToolkitSet up a mixed reality project in Unity with the Mixed Reality Toolkit

  Create a language translator app with Unity + Azure Cognitive ServicesCreate a language translator app with Unity + Azure Cognitive Services

  Render a model with Azure Remote RenderingRender a model with Azure Remote Rendering

Connect to a Digital Twin data source on Azure

Stream telemetry data to assets in your Unity Scene, using Azure services, including ADT

Visualize the data on a HoloLens 2 via SignalR

Send data updates from the HoloLens 2 app back to Azure Digital Twin

Import the Mixed Reality Toolkit into your Unity project to accelerate your mixed reality development.

Learning objectivesLearning objectives

By the end of this module you'll be able to:

Configure Unity for Windows Mixed Reality Development

Import the Mixed Reality Toolkit (MRTK) foundation package into Unity

Add MRTK to a Unity scene

Compare and contrast the three primary MRTK interaction models

Manipulate holograms using ObjectManipulator

Create alanguagetranslator applicationforyour Mixed Realitydevice (Windows Mixed Reality, HoloLens 2, and so

on)by usingCognitiveServices.

Learning objectivesLearning objectives

By the end of this module, you'll be able to:

Configure a Unity project for the Speech service in Azure Cognitive Services

Integrate the Speech service with a Windows Mixed Reality application

Use speech recognition to translate text

Create an Azure Remote Rendering session and render a 3D model.

Learning objectivesLearning objectives

By the end of this module, you'll be able to:

Create a Remote Rendering session

Load a 3D model

Render a 3D model

https://docs.microsoft.com/en-us/learn/modules/mixed-reality-toolkit-project-unity/
https://docs.microsoft.com/en-us/learn/modules/create-language-translator-mixed-reality-application-unity-azure-cognitive-services/
https://docs.microsoft.com/en-us/learn/modules/render-model-azure-remote-rendering-unity/
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 Enhanced environment apps (HoloLens only)

One of the advantages of developing apps for Windows Mixed Reality is the spectrum of experiences the

platform can support. From fully immersive, virtual environments, to light information layering over a user ’s

current environment, Windows Mixed Reality provides a robust set of tools to bring any experience to life. It's

important for an app maker to understand early in their development process as to where along this spectrum

their experience lies. This decision will ultimately impact both the app design makeup and the technological path

for development.

One of the most powerful ways that mixed reality can bring value is letting developers place digital information

or content in a user ’s current environment. This approach is popular for apps where the contextual placement of

digital content in the real world is paramount and keeping the user ’s real world environment “present” during

their experience is key. Users can also move between real world digital tasks with ease. This lends even more

credence to the promise that the mixed reality apps the user sees are truly a part of their environment.

Enhanced environment apps

Example usesExample uses

A mixed reality notepad style app that allows users to create and place notes around their environment

A mixed reality television app placed in a comfortable spot for viewing

A mixed reality cooking app placed above the kitchen island to help a cooking task

A mixed reality app that gives users the feeling of “x-ray vision” (that is, a hologram placed on top of and

mimics a real world object, while allowing the user to see “inside it” holographically)

Mixed reality annotations placed throughout a factory to give worker ’s necessary information

Mixed reality way finding in an office space

Mixed reality tabletop experiences (that is, board game style experiences)

Mixed reality communication apps like Skype

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/discover/types-of-mixed-reality-apps.md


 Blended environment apps

 Immersive environment apps

Given Windows Mixed Reality’s ability to recognize and map the user's environment, it's able to create a digital

layer that can be overlaid on the user ’s space. Thin layer respects the shape and boundaries of the user ’s

environment, but the app may choose to transform certain elements best suited to immerse the user in the app.

This is called a blended environment app. Unlike an enhanced environment app, blended environment apps may

only care enough about the environment to best use its makeup for encouraging specific user behavior (like

encouraging movement or exploration) or by replacing elements with changes (a kitchen counter is skinned to

show a different tile pattern). This type of experience may even transform an element into an entirely different

object, but still keep the rough dimensions of the object as its base (a kitchen island is transformed into a

dumpster for a crime thriller game).

Blended environment apps

Example usesExample uses

A mixed reality interior design app that can paint walls, countertops, or floors in different colors and patterns

A mixed reality app that allows an automotive designer to layer new design iterations for an upcoming car

refresh on top of an existing car

A bed is “covered” and replaced by a mixed reality fruit stand in children’s game

A desk is “covered” and replaced with a mixed reality dumpster in a crime thriller game

A hanging lantern is “covered” and replaced with signpost using roughly the same shape and dimension

An app that allows users to blast holes in their real or immersive world walls, which reveal a magical world

Immersive environment apps are centered around an environment that completely changes the user ’s world

and can place them in a different time and space. These environments can feel real, creating immersive and

thrilling experiences that are only limited by the app creator ’s imagination. Unlike blended environment apps,

once Windows Mixed Reality identifies the user ’s space, an immersive environment app may totally disregard

the user ’s current environment and replace it whole stock with one of its own. These experiences may also

separate time and space, meaning a user could walk the streets of Rome in an immersive experience, while

remaining relatively still in their real world space. Context of the real world environment may not be important

to an immersive environment app.



 See also

Immersive environment apps

Example usesExample uses

An immersive app that lets a user tour a space separate from their own (that is, walk through a famous

building, museum, popular city)

An immersive app that orchestrates an event or scenario around the user (that is, a battle or a performance)

Development overview

App model

App views
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 Thinking spatially during the design process

When Microsoft launched the HoloLens (1st gen) to eager developers in 2016, the team had already partnered

with studios inside and out of Microsoft to build the device’s launch experiences. These teams learned by doing,

finding both opportunities and challenges in the new field of mixed reality design.

We turned their methods and insights into a curriculum that we teach new developers in our Mixed Reality

Academy. The curriculum includes week-long design workshops we offer to our enterprise partners).

Below is a snapshot of everything we've learned to help our enterprise partners prepare their teams for mixed

reality development. While many of these methods originally target HoloLens development, imagining and

communicating in 3D are critical to the full spectrum of mixed reality experiences.

Any design process or design framework is meant to iterate thinking: To approach a problem broadly, to share

ideas with others effectively, to evaluate those ideas and reach a solution. Today, we have well-established

design and development methods for building experiences on desktops, phones, and tablets. Teams have clear

expectations of what is necessary to iterate an idea and turn it into a product for users.

Teams are often composed of a mix of development, design, research, and management. All roles should

participate in the design process. The barrier to entry for contributing an idea for a mobile app is as simple as

drawing a rectangle for the device’s screen. Meanwhile, sketching UI elements with boxes and lines is enough to

establish technical requirements or define potential user behavior.

With mixed reality, the traditional 2D design process begins to break down. Sketching in 3D is difficult for most

people, and using 2D tools like pen and paper or whiteboards, can often limit ideas to those dimensions.

Meanwhile, 3D tools, built for gaming or engineering, require a high degree of skill to quickly flesh out ideas.

The lack of lightweight tools is compounded by the technical uncertainty inherent with new devices, where

foundational interaction methods are still being established. These challenges can potentially limit the design

contributions to team members with 3D development backgrounds — drastically reducing the team’s ability to

iteration.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/discover/case-study-expanding-the-design-process-for-mixed-reality.md


 Techniques for expanding the design process

 Generating ideas with bodystorming

Teams from the Mixed Reality Partner Program in our workshop

When we work with external partners, we hear stories of teams waiting for the developer to finish the prototype

before they can continue their design process. The rest of the team is then potentially blocked from making

meaningful progress on the product. Developers end up with all the responsibility for solving both the technical

implementation and user experience as they attempt to put a rough idea into code.

Our teams at Microsoft have a set of techniques to more effectively include their team and quickly iterate

through complex design problems. While not a formal process, these techniques are intended to supplement

rather than replace your workflow. These methods allow team members without specialized 3D skills to offer

ideas before diving into the prototyping phase. Different roles and disciplines can be part of the design process,

not just 3D designers, and developers. Uncovering opportunities and identifying possible challenges might

occur later in development.

Getting your team to think about events occurring in the real world, beyond the traditional world of 2D devices,

is key to developing innovative mixed reality experiences. At Microsoft, we've found the best results by

encouraging interaction with physical props in a real-world space. Using simple, cheap crafting materials we

build physical props to represent digital objects, user interfaces, and animations in a proposed experience. This

technique is called bodystorming and has been a staple of product ideation within industrial design for decades.



 Acting and expert feedback

Simple, cheap art supplies used in bodystorming

Simple, physical props level the playing field for participants, allowing individuals with different skillsets and

backgrounds to contribute ideas and uncover opportunities inherent to mixed reality experiences instead of

being locked into 2D thinking. While technical prototyping or high-fidelity storyboarding requires a skilled 3D

developer or artist, a few Styrofoam balls and cardboard can be enough to showcase how an interface might

unfold in physical space. These techniques apply to both mixed reality development with HoloLens and the

immersive headsets. For example, a set of plastic connectors might roughly illustrate the size of holograms that

appear in a HoloLens experience or as props to act out interactable elements or motion designs in a virtual

world.

Bodystorming is a technique used to quickly generate ideas and evaluate ideas that are too nebulous to

prototype. At Microsoft, bodystorming is most commonly used to quickly vet an idea. It can also help host a

more in-depth session if you involve outside stakeholders who aren't familiar with mixed reality development or

need to distill broad scenarios. Remember that the purpose of bodystorming is to ideate quickly and efficiently

by encouraging participants to think spatially. Detailed artwork or precise measurements aren't important at

this stage. Physical props need only meet the minimum requirements to explore or communicate an idea. Ideas

presented through bodystorming are not expected to be fully vetted, but the process can help narrow down

possibilities to test later during the in-device prototyping phase. As such, bodystorming doesn't replace technical

prototyping, but rather offsets the burden of solving both technical and design challenges during the

prototyping phase.

Following the bodystorming process of ideating with physical objects in the real world, the next step is to walk

through an experience with these objects. We call this phase of the process acting and it often involves staging

how a user would move through the experience or a specific interaction.



 Capturing ideas with storyboards

Teams acting out a scenario during a workshop

Acting with physical props allows participants to experience the user's perspective, while allowing outside

observers to see how events play out. This presents an ideal time to include a wider audience of team members

or stakeholders who can provide specific ‘expert’ feedback. For example, if you're exploring a mixed reality

experience designed for hospitals, acting out your thinking to a medical professional can provide invaluable

feedback. Another example is when you might have a specific challenge you're trying to understand, like spatial

audio or budgeting for asset quality vs. performance. In these cases, acting gives experts a quick, rough concept

of how the experience might unfold, without the need for a device-based prototype.

This sort of acting isn't formalized, with no need to bring in professional talent, but in situations where we want

to share the thinking with others who aren't present, we'll video record a ‘scene’ of interaction or include a

storyboard artist to observe and sketch key moments. Acting can also be a lightweight activity, often happening

in-situ during the bodystorming phase. Deciding which method to use depends on the audience and the fidelity

needed to prompt the appropriate type of feedback. It ultimately comes down to whatever will most effectively

capture your team’s thinking.

The best method for conveying the ideas and concepts of your proposed experience depends on your intended

audience, and the type of feedback your next iteration requires. When presenting new ideas to team members,

low fidelity re-enactments of bodystorming can be enough to bring someone up to speed. When introducing

your experience concepts to new stakeholders or potential users, the best method is often storyboarding.

Storyboarding is a technique common to the entertainment industry, found behind the scenes in movies and

video game development. The technique helps convey both the overall flow of an experience (at low fidelities)

and the aesthetic look and feel (at high fidelities). As with prototyping, understanding the fidelity needs of your

storyboard is key to gathering the right feedback and avoiding counter-productive discussions.



 Design process

Example of a low-fidelity storyboard

Low-fidelity storyboards are the right fidelity for quick discussions, especially when conveying high-level ideas.

These can be as simple as stick-figure drawings and primitive shapes to denote virtual elements in a scene or

the proximity of interactive components (both physical and virtual). While these are useful given the relative

ease and low skill barrier to execute, remember the lesson from bodystorming: Not everyone can see 2D

depictions of an experience and understand the 3D implications.

Example of a high-fidelity storyboard

High-fidelity storyboards are a powerful tool when bringing in new stakeholders or combining insights from a

bodystorming session with the proposed aesthetic direction of your experience. Storyboards can build off mood

boards to illustrate the final appearance of a virtual experience, and capture key moments that may be pivotal to

the final product. Keep in mind that high-fidelity storyboards often require an artist, especially one embedded

within the team, who can capture difficult-to-describe ideas. At Microsoft, we have added storyboard artists,

often with backgrounds in game development, to our mixed reality teams who attend meetings prepared to

quickly capture sketches that will later be expanded into higher fidelity mockups. These individuals work closely

with technical artists, helping to convey the artistic direction of assets used in the final experience.

Our process today starts with whiteboarding and sticky notes and expands into physical bodystorming and

acting. We then translate that thinking into storyboards and something we call a 'One-Line Concept' (the high-

level sentence that describes what we're making) before moving on to prototyping and asset creation. Our

design work is often physical before we get into the development phase.



 Expanding your team's skills

Overall design process

The design process is messy and every team is different. However, methods like bodystorming, acting, and

storyboarding can help alleviate difficulties in iteration.

In reality, its continuous iterative phases

Altering your process to better accommodate mixed reality experiences depends on more closely connecting

technical and design roles. Working with partners at Microsoft, we've seen several teams successfully transition

into 3D development, and we find the biggest advantage comes from team members stepping out of their

comfort zone and developing skills that give them more involvement throughout the development process (not

just limiting their skills to design or development).

Feedback and iteration are key to any successful design, and with mixed reality experiences, this sort of feedback

often skews to more technical concepts, especially given the relative nascency of mixed reality’s technology and

tools. Building your design team’s skills in technical areas, including skills with tools like Unity or Unreal, helps



 Helping your team explore mixed reality quickly and effectively

those individuals better understand the approach of developers and provide more effective feedback during

prototyping. Similarly, developers who understand the fundamental UX concepts of mixed reality experiences

(and potential design pitfalls) can help them offer implementation insights during the early phases of planning.

We usually get questions from partners working in mixed reality about how best to grow their team and

skillsets with 3D tools. This is a difficult question to answer given the state of the industry, as teams are faced

with building tomorrow’s experiences with yesterday’s tools. Many teams are gathering individuals with

backgrounds in gaming and entertainment, where 3D development has been a staple for decades. Teams are

also encouraging their existing teams to pick up tools like Unity and 3D modeling software. While these are both

essential needs for meeting the baseline of mixed reality experiences today, there will likely be a great number

of specialized tools and skills to help build tomorrow’s ground-breaking applications.

The field of mixed reality design is always changing, with more focus on data and cloud services in holographic

experiences. This next generation of experiences will take advantage of advanced natural language processing

and real-time computer vision, and more inherently social scenarios within immersive experiences. For example,

experiences in virtual reality allow designers to build imaginative environments and spaces, requiring a skill set

more akin to architecture or psychology rather than traditional interface design. Or you can consider

experiences in the real world with HoloLens, where the use cases often involve highly specialized fields such as

medicine, engineering, or manufacturing, where specific environments and real-time data are essential elements

of the experience. Working across roles, using both design and specialized knowledge, and having a willingness

to learn new tools are invaluable skill for teams working in mixed reality.

In the early days of HoloLens, these techniques came out of necessity as the device’s early prototype hardware

proved to be a less than ideal format for quickly iterating through design ideas. Interaction methods, including

fundamental UI in the operating system were explored with bodystorming, while acting helped our usability

team understand fundamental user behaviors for scenarios in the workplace. In the end, the team established a

strong baseline for the HoloLens core UX, communicating concepts across team roles and allowing OS

development to move quickly in parallel with hardware development.

Whether it's bodystorming, acting, reviewing with experts, or storyboarding, these techniques are intended to

save you time and effort. While we're still very much in the early days of HoloLens and virtual reality



  Sample list of workshop suppliesSample list of workshop supplies

 Next Discovery Checkpoint

development, expanding your design process for mixed reality will help your team spend their energy exploring

new and challenging design problems rather than overcoming difficulties communicating ideas.

Simple art supplies provide team members with the necessary tools to explain ideas without any advanced

artistic skills. Here's a sample of what our team commonly uses during bodystorming:

Styrofoam discs

Styrofoam cubes

Styrofoam cones

Styrofoam spheres

Cardboard boxes

Wooden dowels

Lollipop sticks

Cardstock

Paper cups

Duct tape

Masking tape

Scissors

Paperclips

Filing clamps

Post-Its

Twine

Pencils

Sharpies

Congratulations, you've completed the core of the Mixed Reality discovery journey! You can either see how

industry partners are using Mixed Reality, explore the HoloLens, or start your design or development journeys:

Start your design journey

Start your development journey
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NOTENOTE

 Designing for mixed reality

Please allow for a small loading window to account for all the cool GIFs and embedded videos on this page.

Learning how to design for mixed reality can be hard because the medium doesn't always translate well to 2D

design processes. Here at Microsoft, we've created a free app for the HoloLens 2 to help you learn the

fundamentals of mixed reality UX Design firsthand. The unique approach of the Designing Holograms app dives

into mixed reality behaviors, tips, and recommendations to help you create engaging and amazing HoloLens

apps of your own. Download the app for free from the Microsoft Store and learn from Microsoft’s Mixed Reality

Design Team!

Download the Designing Holograms app

Designing Hologram’s demo room (also known as the doll house)

Like many of you, I used to design mobile apps. Coming from a 2D design world, jumping into full on spatial

computing, where everything is now in the world, was a significant shift. In mixed reality, apps aren't confined to

a 2D screen anymore; in fact, they're almost free, placed in the real world and interacting with real objects.

To me, connecting 3D experiences to conventional 2D design processes is the most challenging aspect of mixed

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/discover/designing-holograms.md
https://www.microsoft.com/p/designing-holograms/9nxwnjklrzwd


 An opportunity to teach

 Exploring the doll house

reality development. In conversations with customers, I would hear things like “I know what features to include

and how to get them up and running. It’s code, I can follow the docs and tutorials, but the user experience? So

many features, different input options, different scenarios, and physical environments, it’s overwhelming".

Image from the HoloLens 2 Design Workshop in San Francisco

It wasn’t obvious at first, but an excellent opportunity was presented to use mixed reality as a Medium to teach

it.

Designing Holograms is a visual experience that explains mixed reality design concepts and recommendations.

It’s just you and a virtual teacher demonstrating mixed reality design concepts. Everything is from a third person

perspective with the experience firmly in your own space.

Designing Holograms trailer video

The doll house is the virtual environment we use throughout the app. The environment is an 80 x 60 x 40-cm

miniature room that contains the basic elements that most rooms have in common, like walls, lamps, furniture, a

table, and a TV. The doll house is the main protagonist of the app experience, so we needed to make sure it

would work great in any environment. Think of it as a small demo room for visualizing all sorts of mixed reality

concepts.

Video of the Dollhouse adjustment behavior

https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Designing-Holograms-app-trailer/player
https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Dollhouse-adjustment-behavior-in-the-Designing-Holograms-app/player


  1:1 vs 1:10 prototypes1:1 vs 1:10 prototypes
Our initial assumption was that 1:1 demonstrations would be amazing, almost like looking at a real life teacher.

The user would see everything that the teacher sees at a real life scale. However, we immediately realized that

there would be a few problems:

Most developers will run their apps in offices, or rooms smaller than the demo room, so it wouldn’t fit.

Displays are additive, meaning the entire virtual environment will be overlaid over a user ’s room. That can

get confusing with two tables, maybe double couches, and walls that don’t align.

And worst of all a virtual environment heavily constrained by a field of view.

When we tried out a mini 1:10 scale, the result was a fantastic birds-eye view of a realistic room. You could see

everything that was going on from any angle all at the same time. What was most surprising is that most testers

found it so much more immersive to see a small version, then they never toggled back to the 1:1 scale. So we

decided to actually scrap the 1:1 version and avoid the extra work required to adapt UI and other aspects of the

app.

Field of view with 1:1 scale



 Using Mixed Reality Capture

 Manipulating captures and virtual objects

  Head Gaze AdjustmentHead Gaze Adjustment

Field of view with 1:10 scale

One of the most characteristic features of this app is the use of Mixed Reality Capture to teach and demonstrate

mixed reality design concepts.

Microsoft has a Mixed Reality Capture studio in San Francisco. Microsoft also licenses this technology to other

studios, which include Avatar Dimension in Washington D.C., Metastage in Los Angeles, Dimension Studios in

London, SK Telecom in Seoul, and Volucap in Berlin. You can find more information on our Mixed Reality Capture

Studios here.

Raw footage of Daniel Escudero from one of the 106 cameras in the Mixed Reality Capture Studio in San

Francisco.

The capture process generates a keyframed mesh, normals, and texture, which can be delivered as OBJ/PNG

files for further post-production, or ready for playback as an H.264 compressed MP4 file. These files can be

imported into Unity, Unreal, Native, and WebXR projects. Files can run on Windows, iOS, Mac, Android, Magic

Leap, and Playstation VR.

The Capture Player provided to analyze mp4s that contain video with audio and embedded meshes.

Mixed Reality Captures produce virtual representations of people or animals, but at times you may need those

characters to interact with other virtual objects. The following two examples show different ways we

manipulated the scenes to achieve this effect.

https://www.microsoft.com/mixed-reality/capture-studios
https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Raw-capture-footage-for-the-Designing-Holograms-app/player
https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Mixed-Reality-Capture-footage-for-the-Designing-Holograms-app/player


  Syncing Animated ObjectsSyncing Animated Objects

Headgaze adjustment lets you move a captured person’s head at runtime, meaning you could have a capture

face towards a user. In our case, we used it to show the field of view and field of interest. What you see below is

a moving gameobject acting as a target for the head gaze to look at. As we move the target from side to side,

the head of the capture follows.

We used this trick to make sure that the idle capture would always face towards holograms placed in different

parts of the doll house.

The Capture’s head being moved at runtime following a target gameobject in Unity.

The second one, was animating objects to sync with a capture’s movement. In different parts of the app, we

imported sequential OBJs of a specific capture every five frames. The OBJs were then animated in the scene to

make sure they would match the corresponding frame of the capture. It’s a tedious process of animating and

keyframing, but the result is great. You can now see a Mixed Reality Capture interacting with non-captured

objects.



  UI creative processUI creative process

Synced animation between a Mixed Reality Capture and UI panel

When we started the UI design, we wanted to show some of the magic and possibility that holograms have to

offer. Simply showing static 2D windows and text boxes doesn’t feel right in the 3D world. Many of the

possibilities at hand just don't show up, so right from the beginning we decided to move away from that and

make full use of holographic 3D space.

At first, we started with adding some thickness to the panels, icons, and text information. Still, as a user, what I

see is a text box. Text boxes with images, but we aren't there. We went further by making use of the Mixed

Reality Toolkit (MRTK) shaders. The MRTK shaders became a powerful tool, and we made use of its stencil

features to add negative depth to the panels. That means instead of adding elements in front of a text box, the

icons now appear behind a transparent panel. What I see now as a user is something that I just can’t replicate

anymore in the real world, and this is where holographic magic started to happen. Also as a user I don’t really

like to read, I do a lot already in the physical world.

Obviously icons work a lot better than simple text does, to provide an even more powerful guidance, I then

started creating a set of animated objects and avatars, each of them telling a tiny story about what is being done

in the respective scenario and how it’s being used.



 Core concepts
Head Tracking and Eye TrackingHead Tracking and Eye Tracking

Hand TrackingHand Tracking

Spatial AwarenessSpatial Awareness

Holographic frameHolographic frame

https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Microsofts-Designing-Holograms-Head-Tracking-and-Eye-Tracking-Chapter/player
https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Microsofts-Designing-Holograms-Hand-Tracking-Chapter/player
https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Microsofts-Designing-Holograms-Spatial-Awareness-Chapter/player


Coordinate systemsCoordinate systems

Eye trackingEye tracking



Room scan visualization and spatial mappingRoom scan visualization and spatial mapping

Scene understandingScene understanding



 "Try it out" moments

Point and commit with hand raysPoint and commit with hand rays

Designing Holograms teaches mixed reality concepts, but it also allows you to try them in your room. After

some of those explanations, we pause and take you out of the doll house and into an interactive moment. Here

are some examples of those interactive moments:



The hand tracking frame showing when hands are detected and when they enter the field of view.

Interacting with colliding crystals through far interaction



 About the team

Daniel EscuderoDaniel Escudero
Lead Technical Designer
Dan is the Creative Director on Designing Holograms and currently works as Design Lead for the Microsoft’s Mixed
Reality Academy in San Francisco, and was previously a Designer in one of Microsoft’s Mixed Reality Studios in
London.

Mar tin WettigMar tin Wettig
Senior 3D Artist
Martin leads 3D Art and UI Design on Designing Holograms and was previously a Senior 3D Artist at one of
Microsoft’s Mixed Reality Studios in Berlin.

Exploring near interaction affordances

A huge thank you to the Mixed Reality Design Team for sharing so much knowledge, and to the amazing folks at

Object Theory for being essential teammates through every step of the project. Thank you all for you amazing

talent, for your passion and exceptional eye for design.

Download the Designing Holograms app

https://objecttheory.com/
https://www.microsoft.com/p/designing-holograms/9nxwnjklrzwd
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Stories, learnings, and experiences the Mixed Reality team has found and jotted down along the way.

Ford GT40 experienceFord GT40 experience

This case study lets you get up-close with the legendary racecar that beat Ferrari in the 1966 24 Hours of Le

Mans race, as the Ford GT40 springs to life on the table in front of you.

February 2021

 ScaleScale

apps across devices with different GPU capabilitiesapps across devices with different GPU capabilities

See how to optimize a mixed reality app to deliver the best experience across a range of GPU performance

capabilities.

May 2022

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/discover/case-studies-overview.md
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-scaling-datascape-across-devices-with-different-performance
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-scaling-datascape-across-devices-with-different-performance


 BuildingBuilding

HoloSketch, a spatial layout, and UX sketching app for HoloLensHoloSketch, a spatial layout, and UX sketching app for HoloLens

HoloSketch is an on-device spatial layout and UX sketching tool for HoloLens to help build holographic

experiences.

July 2017

 Expanding the spatial mappingExpanding the spatial mapping

capabilities of HoloLenscapabilities of HoloLens

When creating our first apps for Microsoft HoloLens, we were eager to see just how far we could push the

boundaries of spatial mapping on the device.

December 2016

 Lessons from the Lowe's kitchenLessons from the Lowe's kitchen

The HoloLens team wants to share some of the best practices that were derived from the Lowe's HoloLens

project.

September 2016

https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-building-holosketch,-a-spatial-layout-and-ux-sketching-app-for-hololens
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-building-holosketch,-a-spatial-layout-and-ux-sketching-app-for-hololens
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-expanding-the-spatial-mapping-capabilities-of-hololens
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-expanding-the-spatial-mapping-capabilities-of-hololens
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-lessons-from-the-lowes-kitchen
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-lessons-from-the-lowes-kitchen


 Galaxy Explorer

 Creating anCreating an

immersive experience in Fragmentsimmersive experience in Fragments

Fragments are an interactive crime drama for Microsoft HoloLens, where you follow the clues to solve a mystery

that takes place in your real-world space.

August 2016

 3 HoloStudio UI and interaction3 HoloStudio UI and interaction

design learningsdesign learnings

HoloStudio was one of the first apps for HoloLens. Because of this, we had to create new best practices for 3D UI

and interaction design. We did this through user testing, prototyping, and trial and error.

July 2016

 How it works - Mixed Reality Capture StudiosHow it works - Mixed Reality Capture Studios

Microsoft Mixed Reality Capture Studios enables content creators to create 360-degree holograms from real life

subjects that can be used in applications across augmented reality, virtual reality, and 2D screens.

July 2016

Before Microsoft HoloLens shipped, we asked our developer community what kind of app they'd like to see an

https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-creating-an-immersive-experience-in-fragments
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-creating-an-immersive-experience-in-fragments
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-3-holostudio-ui-and-interaction-design-learnings
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-3-holostudio-ui-and-interaction-design-learnings


 HoloTour

experienced internal team build for the new device. More than 5000 ideas were shared, and after a 24-hour

Twitter poll, the winner was an idea called Galaxy Explorer.

 Creating a galaxy in mixed realityCreating a galaxy in mixed reality

Before Microsoft HoloLens shipped, we asked our developer community what kind of app they'd like to see an

experienced internal team build for the new device. More than 5000 ideas were shared, and after a 24-hour

Twitter poll, the winner was an idea called Galaxy Explorer.

February 2016

The Making of Galaxy Explorer for HoloLens 2The Making of Galaxy Explorer for HoloLens 2

Welcome to the journey of how we're updating Galaxy Explorer for HoloLens 2. Galaxy Explorer was originally

developed as an open-source application for HoloLens (1st gen) through the Share Your Idea program, and is

one of the first mixed reality experiences many people had. Now we're updating it for the new capabilities of

HoloLens 2.

June 2019

https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-creating-a-galaxy-in-mixed-reality
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-creating-a-galaxy-in-mixed-reality


HoloTour for Microsoft HoloLens provides immersive 3D personal tours of iconic locations around the world. As

the designers, artists, producers, audio designers, and developers working on this project found out, creating a

convincingly real 3D rendering of a well-known location takes a unique blend of creative and technological

wizardry.

 Spatial sound design for HoloTourSpatial sound design for HoloTour

To create a truly immersive 3D virtual tour for Microsoft HoloLens, the panoramic videos and holographic

scenery are only part of the formula.

August 2016

 Creating impossible perspectivesCreating impossible perspectives

for HoloTourfor HoloTour

We wanted your experiences in HoloTour for HoloLens to be unforgettable. In addition to the traditional tourist

stops, we planned out some "impossible perspectives".

August 2016

 Capturing and creating contentCapturing and creating content

for HoloTourfor HoloTour

HoloTour provides immersive 3D personal tours of iconic locations around the world. As we found out, creating

a convincingly real 3D rendering of a well-known location takes a blend of creative and technological wizardry.

August 2016

https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-creating-impossible-perspectives-for-holotour
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-creating-impossible-perspectives-for-holotour
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-capturing-and-creating-content-for-holotour
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-capturing-and-creating-content-for-holotour


 RoboRaid

 Design and human experience

In this mixed reality first-person shooter, use gaze and gesture to target enemies, and dodge incoming fire using

natural movements. Spatial mapping turns each room into a unique game level, while spatial sound lets you use

the entire room to play—even the spaces behind you.

 Using spatial sound in RoboRaidUsing spatial sound in RoboRaid

Spatial sound is one of the most exciting features of Microsoft HoloLens, providing a way for users to perceive

what's going on around them when objects are out of the line of sight.

February 2016

 Looking throughLooking through

holes in your realityholes in your reality

This case study explains how to implement the "magic window" effect on HoloLens, allowing the user to see

behind walls, under the floor, and into virtual openings within their actual environment.

February 2016

Read our high-level thoughts, and understand the principles we follow.

https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-looking-through-holes-in-your-reality
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-looking-through-holes-in-your-reality


Representing humans in mixed realityRepresenting humans in mixed reality

What kind of opportunities emerge when we can't only create fantastic elements, but use the most realistic

captures of environments, objects, and people in mixed reality?

November 2017

 My first year onMy first year on

the HoloLens design teamthe HoloLens design team

My journey from a 2D flatland to the 3D world started when I joined the HoloLens design team in January 2016.

January 2016

https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-representing-humans-in-mixed-reality
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-representing-humans-in-mixed-reality
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-my-first-year-on-the-hololens-design-team
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-my-first-year-on-the-hololens-design-team


Capturing and creating content for HoloTourCapturing and creating content for HoloTour

Adding techniques to your design process to help your team think spatially and more easily envision mixed

reality experiences.

April 2018

 AfterNow'sAfterNow's

process - envisioning, prototyping, buildingprocess - envisioning, prototyping, building

At AfterNow, we work with you to turn your ideas and aspirations into concrete, fully operational products, and

experiences ready for the market. But before we write a single line of code, we create a blueprint through a

process called envisioning.

April 2017

https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-afternows-process-envisioning,-prototyping,-building
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-afternows-process-envisioning,-prototyping,-building


   

 

Navigating the Windows Mixed Reality home
 7/6/2022 • 6 minutes to read • Edit Online

 Start Menu

 Launching apps

Just like the Windows PC experience starts with the desktop, Windows Mixed Reality starts with the home. The

Windows Mixed Reality home uses our innate ability to understand and navigate 3D places. With HoloLens, your

home is your physical space, but with immersive headsets, your home is a virtual place.

Your home is also where you’ll use the Start menu to open and place apps and content. You can fill your home

with mixed reality content and multitask by using multiple apps at the same time. The things you place in your

home stay there, even if you restart your device.

The Start menu consists of:

System information (network status, battery percentage, current time, and volume)

Cortana (on immersive headsets, a Start tile; on HoloLens, at the top of Start)

Pinned apps

The All apps button (plus sign)

Photo and video buttons for mixed reality capture

Switch between the pinned apps and All apps views by selecting the plus or minus buttons. To open the Start

menu on HoloLens, use the bloom gesture. On an immersive headset, press the Windows button on your

controller.

To launch an app, select it on Start. The Start menu will disappear, and the app will open in placement mode, as

either a 2D window or a 3D model.

To run the app, you’ll need to then place it in your home:

1. Use your gaze or controller to position the app where you want it. It will automatically adjust (in size and

position) to conform to the space where you place it.

2. Place the app using air-tap (HoloLens) or the Select button (immersive headsets). To cancel and bring back

the Start menu, use the bloom gesture or the Windows button.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/discover/navigating-the-windows-mixed-reality-home.md
https://docs.microsoft.com/en-us/hololens/holographic-photos-and-videos


 Moving and adjusting apps

 Getting around your home

2D apps, created for desktop, mobile, or Xbox can be modified to run as mixed reality immersive apps using the

HolographicSpace API. An immersive app takes the user out of the home and into an immersive experience.

Users can return home with the bloom gesture (HoloLens) or by pressing the Windows button on their

controller (immersive headsets).

Apps can also be launched via an app-to-app API or via Cortana.

Select AdjustAdjust on the app bar to reveal controls that move, scale, and rotate mixed reality content. When you’re

finished, select DoneDone.

Different apps may have other options on the app bar. For example, Microsoft Edge has Scroll, Drag, and Zoom

choices. 

The BackBack button navigates back to previously viewed screens in the app. It will stop when you reach the

beginning of the experiences shown in the app, and won't navigate to other apps.

https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicspace


 Immersive headset input support

  Motion controllersMotion controllers

  GamepadGamepad

With HoloLensHoloLens , you move through physical space to move around your home.

With immersive headsetsimmersive headsets , you can get up and walk around in your playspace to move within a similar area in

the virtual world. To move across longer distances, use the thumbstick on your controller to virtually "walk," or

you can use teleportation to immediately jump longer distances.

To telepor t:To telepor t:

1. Bring up the teleportation reticle.

2. Place the reticle where you want to teleport.

3. Release the button to teleport where the reticle was placed.

Using motion controllers: press the thumbstick forward and hold it in that position.

Using an Xbox controller : press the left thumbstick forward and hold it in that position.

Using a mouse: hold down the right-click mouse button (and use the scroll wheel to rotate the

direction you want to face when you teleport).

Using motion controllers: tilt the controller (on which you're holding the thumbstick forward) to move

the reticle.

Using an Xbox controller : use your gaze to move the reticle.

Using a mouse: move your mouse to move the reticle.

To vir tually "walk :"To vir tually "walk :"

Using motion controllers: click down on the thumbstick and hold, then move the thumbstick in the direction

you want to "walk."

Using an Xbox controller : click down on the left thumbstick and hold, then move the thumbstick in the

direction you want to "walk."

Windows Mixed Reality immersive headsets support multiple input types for navigating the Windows Mixed

Reality home. HoloLens doesn't support accessory inputs for navigation, because you physically walk around

and see your environment. However, HoloLens does support inputs for interacting with apps.

The best Windows Mixed Reality experience will be with Windows Mixed Reality motion controllers that support

six degrees-of-freedom tracking using just the sensors in your headset - no external cameras or markers

required!

Navigation commands coming soon.

Left thumbstick :Left thumbstick :

https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


  Keyboard and mouseKeyboard and mouse

 Cortana

 Store, Settings, and system apps

 

Tap the r ight thumbstickr ight thumbstick  left or right to rotate the direction you're facing by 45 degrees.

Pressing the AA button selects and acts like the air tap gesture.

Pressing the GuideGuide button brings up the Start menu and acts like the bloom gesture.

Pressing the left and r ight tr iggersleft and r ight tr iggers  lets you zoom in and out of a 2D desktop app you're interacting with in

the home.

Press and hold the left thumbstick forward to bring up the teleportation reticle.

Tap the thumbstick left, right, or back to move left, right, or back in small increments.

Click down on the left thumbstick and hold, then move the thumbstick in the direction you want to

virtually "walk."

Note:Note: Use Windows Key + YWindows Key + Y  to switch the mouse between controlling your PC's desktop and the Windows

Mixed Reality home.

Within the Windows Mixed Reality home:

Pressing the left-clickleft-click  mouse button selects and acts like the air tap gesture.

Holding the r ight-clickr ight-click  mouse button brings up the teleportation reticle.

Pressing the WindowsWindows key on the keyboard brings up the Start Menu and acts like the bloom gesture.

When gazing at a 2D desktop app, you can left-clickleft-click  to select, r ight-clickr ight-click  to bring up context menus, and

use the scroll wheelscroll wheel  to scroll ( just like on your PC's desktop).

Cortana is your personal assistant in Windows Mixed Reality, just like on PC and phone. HoloLens has a built-in

microphone, but immersive headsets may require extra hardware. Use Cortana to open apps, restart your

device, look up things online, and more. Developers may also choose to integrate Cortana into their experiences.

You can also use voice commands to get around your home. For example, point at a button (using gaze or a

controller, depending on the device) and say “Select.” Other voice commands include “Go home,” “Bigger,”

“Smaller,” “Close,” and “Face me.”

Windows Mixed Reality has several built-in apps, such as:

Microsoft StoreMicrosoft Store to get apps and games

Feedback HubFeedback Hub to submit feedback about the system and system apps

SettingsSettings  to configure system settings (including networking and system updates)

Microsoft EdgeMicrosoft Edge to browse websites

PhotosPhotos  to view and share photos and videos

CalibrationCalibration (HoloLens only) for adjusting the HoloLens experience to the current user

Learn GesturesLearn Gestures  (HoloLens) or Learn Mixed RealityLearn Mixed Reality  (immersive headsets) to learn about using your device

3D Viewer3D Viewer  to decorate your world with mixed reality content

Mixed Reality Por talMixed Reality Por tal  (desktop) for setting up and managing your immersive headset and streaming a live

preview of your view in the headset for others to see.

Movies and TVMovies and TV for viewing 360 videos and the latest movies and tv shows

Cor tanaCor tana for all of your virtual assistant needs

DesktopDesktop (immersive headsets) for viewing your desktop monitor while in an immersive headset

File ExplorerFile Explorer  Access files and folders located on your device

https://dev.windows.com/cortana
https://docs.microsoft.com/en-us/hololens/hololens-network


See also
App views

Motion controllers

Hardware accessories

Environment considerations for HoloLens

Implementing 3D app launchers

Creating 3D models for use in the Windows Mixed Reality home

https://docs.microsoft.com/en-us/hololens/hololens-environment-considerations
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 Pairing Bluetooth accessories

 Motion controllers

Windows Mixed Reality devices support accessories. You can use Bluetooth or USB ports to pair supported

accessories to an immersive headset from your PC.

For information about using Bluetooth accessories with HoloLens, see Connect to Bluetooth and USB-C devices.

Windows Mixed Reality immersive headsets require accessories for input beyond gaze and voice. Supported

accessories include keyboard and mousekeyboard and mouse, gamepadgamepad, and motion controllersmotion controllers .

Pairing a Bluetooth peripheral with an immersive headset is similar to pairing a Bluetooth peripheral with a

Windows 10 desktop or mobile device:

1. From the Start Menu, open the SettingsSettings  app

2. Go to DevicesDevices

3. Turn on the Bluetooth radio if it's off using the slider switch

4. Place your Bluetooth device in pairing mode. This process varies from device to device, but on most

Bluetooth devices press and hold one or more buttons.

5. Wait for the name of the device to show up in the list of Bluetooth devices. When it does, select the device

then select the PairPair  button. If you have many Bluetooth devices nearby, you may need to scroll to the bottom

of the Bluetooth device list to see the device you're trying to pair.

6. When pairing Bluetooth peripherals with input capability (for example: Bluetooth keyboards), a 6-digit or an

8-digit pin may be displayed. Be sure to type that pin on the peripheral and then press enter to complete

pairing with the headset.

Windows Mixed Reality motion controllers are supported by immersive headsets, but not HoloLens. These

controllers offer precise and responsive movement tracking in your field of view. Sensors in the immersive

headset do the tracking, meaning there's no need to install hardware on the walls in your space. Each controller

features several methods of input.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/discover/hardware-accessories.md
https://docs.microsoft.com/en-us/hololens/hololens-connect-devices


 Bluetooth keyboards

 Bluetooth gamepads

 Other Bluetooth accessories

 Unpairing a Bluetooth peripheral

English language Qwerty Bluetooth keyboards can be paired and used anywhere you can use the holographic

keyboard. Getting a quality keyboard makes a difference, so we recommend the Microsoft Universal Foldable

Keyboard or the Microsoft Designer Bluetooth Desktop.

You can use a controller with apps and games that specifically enable gamepad support. Gamepads cannot be

used to control the HoloLens user interface.

Xbox Wireless Controllers that come with the Xbox One S or sold as accessories for the Xbox One S feature

Bluetooth connectivity, so you can use them with HoloLens and immersive headsets. The Xbox Wireless

Controller must be updated before it can be used with HoloLens.

Other brands of Bluetooth gamepads may work with Windows Mixed Reality devices, but support will vary by

application.

As long as the peripheral supports either the Bluetooth HID or GATT profiles, it can pair with HoloLens. Other

Bluetooth HID and GATT devices besides keyboard, mice, and the HoloLens Clicker may require a companion

application on Microsoft HoloLens to be fully functional.

Unsupported peripherals include:

Peripherals in the Bluetooth audio profiles aren't supported.

Bluetooth audio devices such as speakers and headsets may be available in the Settings app, but aren't

supported with Microsoft HoloLens as an audio endpoint.

Bluetooth-enabled phones and PCs aren't supported for pairing and file transfers.

1. From the Start Menu, open the SettingsSettings  app

2. Go to DevicesDevices

3. Turn on the Bluetooth radio if it's off

4. Find your device in the list of available Bluetooth devices

5. Select your device from the list and then select the RemoveRemove button

https://www.microsoft.com/accessories/products/keyboards/universal-foldable-keyboard/gu5-00001
https://www.microsoft.com/accessories/products/keyboards/designer-bluetooth-desktop/7n9-00001
https://support.xbox.com/xbox-one/accessories/update-controller-for-stereo-headset-adapter
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 Online Communities

C O M M UN IT Y  N A M EC O M M UN IT Y  N A M E L IN KL IN K DESC RIP T IO NDESC RIP T IO N

HoloDevelopers SlackHoloDevelopers Slack Join Here The HoloDevelopers Slack was initially
created as a place for developers
exploring HoloLens to get to know one
another, form friendships, build trust,
and get help from each other. It has
grown into a thriving community that
covers the spectrum of mixed reality
across many platforms, devices, and
companies.

Stack OverflowStack Overflow MR Questions

Reddit WMR HeadsetsReddit WMR Headsets WMR subreddit

Reddit HoloLensReddit HoloLens HoloLens subreddit

 Local Communities

C O M M UN IT Y  N A M EC O M M UN IT Y  N A M E C O UN T RYC O UN T RY C IT YC IT Y L IN KL IN K

Augmented RealityAugmented Reality
MelbourneMelbourne

Australia Melbourne Link

Chicago AWE NiteChicago AWE Nite USA Chicago Link

HoloMagiciansHoloMagicians Japan Tokyo Link

Mixed Reality UserMixed Reality User
Group - NetherlandsGroup - Netherlands

Netherlands Rijswijk Link

VR PhilippinesVR Philippines Philippines N/A Link

XRL AXRL A USA Los Angeles Link

At Microsoft, we believe having access to strong communities is essential for developers, platforms, and

ecosystems to grow. Use the information below to take part in communities and meet some of the team

members who are here to help you.

If you run a community that you would like included on this page, send an email here with the details

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/discover/community.md
https://aka.ms/holodevelopers
https://stackoverflow.com/questions/tagged/windows-mixed-reality
https://www.reddit.com/r/WindowsMR/
https://www.reddit.com/r/HoloLens/
mailto:jemccull@microsoft.com
https://www.meetup.com/armelbourne/
https://www.meetup.com/AWENiteChicago/
https://hololens.connpass.com/
https://www.mixug.com
https://www.facebook.com/vrphilippines/
https://www.meetup.com/XRLA_Meetup/
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Daniel EscuderoDaniel Escudero
MR Academy Lead Designer

Interactive designer,
prototyper, and coder,
specialized in Mixed Reality,
with over 15 years of
interaction design
experience. Currently
designing and prototyping
new Mixed Reality
interactions, while creating
workshops and hackathons
with San Francisco Bay Area
partners and the MR, VR,
and AR communities.
Mentor and speaker for
Mixed Reality Design at
multiple MR, VR, and AR
events and lectures.

San Francisco, CA Email

Daniel GonzalezDaniel Gonzalez
Program Manager II

Redmond, WA Email

Jane FangJane Fang
Principal Program Manager
Lead

San Francisco, CA Email

Jesse McCullochJesse McCulloch
Program Manager II

Jesse is a Program Manager
on the Mixed Reality
Developer Ecosystem team
at Microsoft. He's often
found hanging out in
developer Slack groups, on
Twitter trying to keep up
with everything going on in
this rapidly growing space,
or in a big metal tube flying
through the air on his way
to engage with developers
in the real world.

Redmond, Wa Email

Jo RyallJo Ryall
Head of Marketing, SF
Academy

San Francisco, CA Email

mailto:daescu@microsoft.com
mailto:dgonza@microsoft.com
mailto:jafang@microsoft.com
mailto:jemccull@microsoft.com
mailto:joryal@microsoft.com


Nick KlingensmithNick Klingensmith
MR Academy Lead Engineer

Nick is an experienced game
developer specializing in
tool development, graphics
programming, MR, and
Unity! With over 100
published games, he's
worked on small arcade
games, mobile high fidelity
GPU pushing titles, all the
way to massive networked
social games. The tools he's
published on the Unity
Asset Store are also used in
thousands of games, on
just about every modern
platform imaginable. Nick
has collected most of the
official Unity certifications,
and also helped write them.
Nick currently works for
Microsoft as the lead
engineer on the Mixed
Reality Academy team in
San Francisco.

San Francisco, CA Email

T EA M  M EM B ERT EA M  M EM B ER A B O UTA B O UT LO C AT IO NLO C AT IO N EM A ILEM A IL

 Microsoft MR Design Team, Developer Experience
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Yoon ParkYoon Park
Principal UX Designer

Yoon is a designer, creative
technologist, and author
from Seoul, Korea. As a
Principal UX Designer at
Microsoft’s Mixed Reality
design team, he's leading
the design effort for the
open-source Mixed Reality
Toolkit(MRTK) project,
Mixed Reality Design
Labs(MRDL), and
documentation. He shares
his personal MR project
design stories on Medium.

Redmond, WA Twitter Medium LinkedIn
Email

mailto:niklinge@microsoft.com
https://medium.com/@dongyoonpark/designing-type-in-space-for-hololens-2-4d926355d5b3
https://twitter.com/cre8ivepark
https://medium.com/@dongyoonpark
https://www.linkedin.com/in/cre8ivepark/
mailto:dongyoon.park@microsoft.com


Cameron MickaCameron Micka
Senior Software Engineer

Cameron Micka is a
software engineer who
takes pride in empowering
developers to achieve their
artistic and creative
ambitions. Cameron joined
Microsoft in 2016 after
developing video games for
nearly a decade at
LucasArts Entertainment,
Fun Bits Interactive, and his
own startup. At Microsoft,
Cameron’s role is to build
tools for Mixed Reality
developers and consult with
partners and customers.

Redmond, WA Twitter Email
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 Azure Cloud Advocate Spatial Computing Team
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April SpeightApril Speight
Cloud Advocate

I've been in the tech industry for 7
years after a career in luxury fashion as
a menswear stylist and visual
merchandiser. I love working with bots
and voice enabled devices. However,
I'm currently creating new realities
within the world of spatial computing!
I like meeting new coders and people
on their journey to transition into the
tech industry. I provide advice and
code tutorials on both my website and
YouTube channel. In my spare time,
you can either find me crafting or
scratching' on turntables!

Twitter

The charter of Azure Cloud Advocates is to help every technologist on the planet succeed. This applies to

students, enterprise employees, and startups. They engage in outreach to developers and others in the software

ecosystem, all designed to further technical education and skill with the Microsoft Cloud + AI platform.

The members listed here are the Cloud Advocates that work on the Spatial Computing team within the Cloud

Advocate organization. They work extremely close with the Mixed Reality Developer Ecosystem team, and it's

often hard to tell where one team stops, and the other one starts.

https://twitter.com/tcmicka
mailto:cameron.micka@microsoft.com
https://www.vogueandcode.com/code
https://www.youtube.com/c/vogueandcode
https://twitter.com/vogueandcode


AyAyşegül Yönetegül Yönet
Sr. Cloud Advocate

Ayşegül is a Senior Azure Cloud
Developer Advocate at Microsoft and
focuses on Spatial Computing, Mixed
Reality, Cognitive Services, and Data
Visualization. She's a co-chair of W3C
Immersive Web Working Group and
Community Group and a Google
Developer Expert for Web
Technologies. She co-hosts of San
Francisco WebXR Meetup and enjoys
teaching at different non-profit
organizations aiming to increase
diversity in the software industry. She's
the co-founder of Code4GoodCode4Good, an
organization with the vision of helping
people to contribute to open source.
Previously she led Women Who Code
meetups, Girl Develop It and Black
Girls Code workshops and was a CTO
at AnnieCannons, a bootcamp
dedicated to teaching tech skills to
human trafficking survivors. Lately she
enjoys creating tutorials for YouTube
AysSomething Channel and YouTube
WebXR Channel.

Twitter
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https://www.w3.org/immersive-web/
https://www.w3.org/community/immersive-web/
https://www.meetup.com/Web-VR/
https://www.anniecannons.com/
https://www.youtube.com/channel/UCeo_soIgcgBSd3SVRbs_MPQ?view_as=subscriber
https://www.youtube.com/channel/UCNzjXKJVyqYVyPY8rGKwFtQ?view_as=subscriber
https://twitter.com/AysSomething


Em Lazer-WalkerEm Lazer-Walker
Cloud Advocate

Em (she/her or they/them) is a Cloud
Advocate for Microsoft based in
Toronto. She’s an artist/engineer who
makes interactive art, experimental
games, and open-source software
tools to empower creativity. Most of
her work focuses on using
nontraditional interfaces to reframe
everyday objects and spaces as playful
experiences and to inspire people to
become self-motivated learners. She’s
built projects as far-flung as a site-
specific generative poetry walk, a
game played on 19th century
telegraph hardware, and a commercial
board game that uses Amazon Alexa.
In the past, she’s worked at companies
like Pivotal Labs and Etsy, on games
and apps such as Words With Friends
and Timehop, and as a researcher in
the MIT Media Lab's Playful Systems
research group. She’s passionate about
fostering diverse and inclusive
communities, and organizes game
events such as the Roguelike
Celebration and the annual
alt.ctrl.PARTY.
As a game designer and installation
artist, her work has been featured in
places such as the Smithsonian
American Art Museum and the Venice
Architectural Biennale, and has been
showcased at games events and
spaces such as IndieCade (2016
finalist), alt.ctrl.GDC, Bit Bash, Come
Out and Play, Babycastles, Different
Games, and New York Toy Fair (2019
Game of the Year nominee).

Twitter

Madoka ChiyodaMadoka Chiyoda
Cloud Advocate

I joined Microsoft in 2016 after being a
mobile app developer using Xamarin
for years. I love both programming
and drawing manga, so I'm doing
both. Check my manga work here.

Twitter
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https://roguelike.club/
https://alt.ctrl.party/
https://twitter.com/lazerwalker
https://chomado.com/
https://twitter.com/chomado


Thomas LewisThomas Lewis
Cloud Advocate Lead

Cloud Advocate in Microsoft's
Developer Relations. Spatial
Computing + Academic advocacy.
Favorites: MR/AR/VR/XR, Web, Design
& otters. Pronouns: he/him.

Twitter
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 Microsoft Mixed Reality MVPs
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Aleksandr KudishovAleksandr Kudishov
Russia

MVP focused on Game Development
& Windows Development, VR/AR/MR.
Game Producer, Tech Evangelist,
Holographic Developer, MSP Lead of
Game-Development.

Email

Microsoft Most Valuable Professionals, or MVPs, are technology experts who passionately share their

knowledge with the community. They're always on the "bleeding edge" and have an unstoppable urge to get

their hands on new, exciting technologies. They have deep knowledge of Microsoft products and services, and

can bring together diverse platforms, products, and solutions, to solve real world problems. MVPs make up a

global community of over 4,000 technical experts and community leaders across 90 countries/regions, driven

by their passion, community spirit, and quest for knowledge. Above all, MVPs are always willing to help others -

that's what sets them apart.

https://twitter.com/tommylee
mailto:draconifore@gmail.com


Alexander MeijersAlexander Meijers
The Netherlands, Rijswijk

A professional who inspires, motivates,
and educates businesses on how to
use emerging technologies using
Virtual, Augmented, and Mixed Reality
in their journey to digital innovation.
He has a strong background on
SharePoint, Office 365, and Microsoft
Azure and is working with machine
learning, artificial intelligence, and
cognitive services. Primarily focused on
manufacturing, construction, industry,
logistics, and maritime/offshore, his
goal is helping businesses to achieve
more on creating, improving,
smartening, and shortening of
business processes by using services,
apps, and devices like HoloLens and
Kinect for Azure.

Email

András Velvar tAndrás Velvar t
Budapest, Hungary

András has been a Microsoft Most
Valuable Professional (in Windows
Development / Mixed Reality) for 12
years. He's a frequent speaker at
technology events (Sessionize profile).
He's the author of the open-source
MVPToolkit for Unity that allows Unity
developers to create maintainable,
testable AR/VR enterprise applications.
András' passion is the future of
Human-Computer Interaction,
including mixed, augmented, and
virtual reality, conversational interfaces,
speech recognition. Created multiple
Pluralsight courses, including on
Apple's ARKit and Microsoft's UWP
XAML technologies.

Email
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mailto:alexander@appzinside.com
https://sessionize.com/velvart-andras/
mailto:velvart.andras@response.hu


Bronwen ZandeBronwen Zande
Brisbane, Australia

Bronwen Zande is a Director of Soul
Solutions, having spent more of her life
as a developer than not. She's a long-
term Microsoft Most Valuable
Professional (MVP) having been
awarded MVP status for Windows
Development, Emerging Experiences,
Kinect, Bing Maps, and Live Services.

Bronwen is an active community
member involved in promoting IT as a
career with her participation in judging
Imagine Cup, Young ICT Explorers, and
Technology Takes You Anywhere.
Bronwen was a founding member of
the Brisbane Girl Geek Dinners,
organizer of Developer, Developer,
Developer Brisbane (now DDD
Brisbane), and a multi-year Australian
activator for SheEO.

She is an avid traveler and when not
behind the lens of a camera can often
be found presenting at a local meetup
or user group while on her travels.

Email

Bruno AnjosBruno Anjos
Brazil

Innovation Manager, work at
management and architecture of
Digital Pages innovation projects, with
expertise for XR - Augmented Reality,
Mixed and Virtual Reality platforms.
Microsoft MVP in Mixed Reality 2020-
2021 in Mixed Reality. I work as an
expert in the development and
planning of Mixed Reality solutions -
focusing on Microsoft HoloLens.
Experience with game and application
development, and asset creation and
multimedia content.

Email
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mailto:bronwen@soulsolutions.com.au
mailto:brunof.anjos@outlook.com


Clemente GiorioClemente Giorio
Torino, Italia

"Hacker, geek, maker, researcher,
innovator, trainer, developer...
Has made science and technology his
passion other than his job. Follows
many communities and is often
actively involved as a speaker and
event organizer in particular with:
Coding Gym, DotNetPodcast,
FabLabNapoli, DotNetCampania and
HoloLens Developers.
His signature dishes, far from the
stove, are: Artificial Intelligence,
Computer Vision, Internet of Things,
Natural User Interface, and Mixed
Reality.
Microsoft MVP and Intel Software
Innovator, works as Senior Research &
Development Engineer for Deltatre,
where he develops software
prototypes.

Email

Eric ProvencherEric Provencher
Montreal, QC, Canada

Eric is a Spatial Design Engineer
working on Advanced XR Authoring
Research at Unity Labs. Experienced in
working on MRTK and cross-platform
mixed reality application framework
development from his time at CAE and
a close Microsoft Mixed Reality partner.
Eric maintains MRTK-Quest, a widely
used open-source extension to MRTK.
MRTK-Quest brings native support of
the Oculus ecosystem, including
controller and hand tracking support
on Oculus Quest.

Email

Fabrice BarbinFabrice Barbin
France

Entrepreneur, innovation, and
technology enthusiast for years,
Fabrice is CEO at SYNERGIZ, Microsoft
Mixed Reality Partner, pioneer of
HoloLens use cases in France. Actively
promoting Microsoft technologies as
speaker, rewarded MVP for 12 years,
Fabrice is interested by a large set of
products: HoloLens, Kinect4Azure, IoT,
Surface Hub, Ink, Touch, IA, Machine
Learning, Cognitive Services, Azure

Email
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mailto:tinuxnet@hotmail.com
mailto:erproven@gmail.com
http://www.synergiz.com
mailto:fbarbin@synergiz.com


Francesco ClasadonteFrancesco Clasadonte
Milan, Italy

Fanciful and creative, I engage in
everything I'm passionate about. For
three years I have been working as a
researcher at Politecnico di Milano,
focusing my research on interactive
technologies for children with
disabilities, gaining experiences in
developing IOT systems, smart objects,
robot interaction, lighting design,
multisensory environment, and natural
user interfaces both in national and
international projects.

Currently, I'm working at
FifthIngenium as Senior Creative
Developer, in the fields of IOT, web
solutions, system integration, with
focus on emerging and innovative
technologies such as mixed reality and
artificial intelligence.

Email

Gianni Rosa GallinaGianni Rosa Gallina
Italy

Gianni is a Microsoft MVP since 2011,
focusing on emerging technologies, AI,
and Virtual/Augmented/Mixed Reality
since 2013. Currently he's R&D Senior
Software Engineer in Deltatre's
Innovation Lab, designing, and
prototyping next generation solutions
for sport-related experiences and
services, from VR/MR apps to end-to-
end Azure architectures and video
workflows, passing by Cognitive
Services, AI and much more. Besides
that, he's an active member of the local
community "Torino Technologies
Group" (TTG), organizer and trainer for
Coding Gym Torino monthly meetups,
Pluralsight online courses author,
publish articles on his blog and he's
speaker in national and international
tech conferences and events.

Email

Jessica EngstromJessica Engstrom
Stockholm, Sweden

Microsoft MVP - Windows Platform
Development, Public speaker, UX, Bots,
and Mixed Reality. Coding After Work
Podcast co-host. User group and
conference organizer

Email
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https://fifthingenium.com
mailto:klasaf@outlook.com
mailto:giannishub@hotmail.com
mailto:jessica@catoholic.se


Jimmy EngstromJimmy Engstrom
Stockholm, Sweden

Microsoft MVP - Windows Platform
Development, speaker, Blazor, Mixed
Reality, HoloLens, and Windows
developer. Coding After Work Podcast
co-host. User group and conference
organizer

Email

Joost van SchaikJoost van Schaik
Amersfoort, The Netherlands

I'm not the one to paint big stories
and wide vistas in the MR space – I call
myself a developer++ and I make
things happen. My primary claims to
'fame' are my blog and my apps – one
of the first indie apps for both
HoloLens 1 and 2 available from the
Store are mine. Look for publisher
"LocalJoost" and see for yourself. In the
past three years I've been involved in
quite some commercial projects too. I
consider myself a community person –
I love to share my knowledge, both on
my blog and in person.

Email

Lance LarsenLance Larsen
Madison, WI, USA

Lance Larsen is a Microsoft MVP, a
founder, and the Chief Visionary
Officer (CVO) of HOLOSOFT as well
avid Community Speaker -and-
president of MADdotNET, Madison
Wisconsin's .NET developer
community! Additionally, he's one of
the original organizers of That
Conference - the Summer Camp for
Geeks. Most proud to have focused on
"Growing-up Geek" talks to raise the
next generation of kids on technology.
Technology focused on "HoloLens /
Mixed Reality", "VR / AR for industry",
"Azure Spatial Anchors", "Azure Kinect",
"Unity Development" and much more...

Email
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mailto:jimmy@engstromjimmy.se
mailto:joostvanschaik@outlook.com
https://www.holosoft.com
https://www.maddotnet.com
mailto:lance@lancelarsen.com


Lance McCar thyLance McCar thy
Boston, MA, USA

Lance McCarthy is an exceptional
community leader with an acute
expertise for all things .NET and C#
(especially on the XAML stack) and
HoloLens/Mixed Reality applications.
Lance is helpful online, guiding and
answering questions from Microsoft
developers on Twitter as
@lancewmccarthy and blogs at
DVLUP.com. He organizes & hosts
events in the Boston area such as user
group nights, mini-code camps, and
full hackathons.

Email

Matteo ValorianiMatteo Valoriani
Milan, Italy

Speaker at national and international
conferences, travel and technology
lover, Matteo is Microsoft MVPs since
2014 focusing on Natural User
Interfaces, Kinect, Emerging
Technologies, Volumetric Video,
Augmented Intelligence, and Mixed
Reality.

After working in Microsoft, a PhD on
Computer Vision and unconventional
paradigms for ambient interaction,
Matteo founded and lead
FifthIngenium, an Italian high-tech
company, Microsoft Partner, specialized
on HoloLens and Mixed Reality
solutions for Training, Healthcare, and
Industry 4.0. Every day Matteo helps
its customers, medium and large
companies, to understand and exploit
the potential of Mixed Reality and AI.
Matteo believes in the power of
technology to improve people's lives
and for this reason he promotes and
develops technological projects with
high social impact in the field of
disability and children's education.

Email
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mailto:lance@dvlup.com
https://www.fifthingenium.com
mailto:matteo.valoriani@fifthingenium.com


Philipp BauknechtPhilipp Bauknecht
Pforzheim, Germany

Hi, I'm Philipp Bauknecht from
Germany, Founder & CEO of
medialesson GmbH an early adopter of
HoloLens and member of the
Microsoft Mixed Reality Partner
Program. I help my customer's design,
architect, build and operate modern,
beautiful, and useable Apps that run
on any platform as a consultant,
architect, and trainer together with my
team of highly skilled designers and
developers. Besides I teach Interface
Design at the Pforzheim University and
engage with the community as a
speaker at conferences and user
groups and organizer of code camps
and hackathons. I was selected as one
of the 100 creative talents by the
European Union and the Committee of
the Regions. I'm a Microsoft Most
Valuable Professional (MVP) for
Windows Development since 2013. In
2017, I was accepted into the
Microsoft Regional Director Program.

Email

Rafał LegiRafał Legięddź
Pabianice, Poland

Rafał works as a software engineer for
Avenga. Being in the industry since
2007 he develops his passion for the
software at every possible moment. He
believes that being pragmatic in our
field is helpful and proves that by
switching technologies he uses
whenever there's a need or an
opportunity to learn new concepts.
Started with .NET back-end solutions,
he quickly became a web guy and then
he got his head around different kind
of mobile technologies and VR/AR.
Also a Microsoft MVP in Windows
Development.

As his passion evolved, he became
obsessed with knowledge sharing and
community activities. That resulted in
co-founding a conference and a series
of other actions like giving talks or
conducting workshops.

Email
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mailto:bauknecht@medialesson.de
mailto:rafal.legiedz@gmail.com


René SchulteRené Schulte
Dresden, Germany

René Schulte is Director of Global
Innovation at Valorem Reply working
with teams across the globe on
emerging technologies like the
revolutionary 3D volumetric video
telepresence solution HoloBeam and
the AR Cloud enabling large, cross-
platform user experiences with
persistence. He is a creative thought
leader with a passion for UX and deep
technical knowledge from more than
10 years in VR/AR/MR/XR technology
and 3D programming, developing for
the Microsoft HoloLens since 2015,
was featured on Forbes and is listed as
VR/AR/MR dev influencer. He also
coded AI deep learning neural
networks before it was cool and is
applying modern AI to empower
humans. He is a frequent keynote and
session speaker and panelist at
conferences like //build, Unite, Vision
VR/AR Summit, VRDC (GDC), AWE, ESA
and more. Blogs about many topics.
He also created popular open-source
libraries like WriteableBitmapEx and
the AR library SLARToolKit. He was
honored several times for his dev
community work with the Microsoft
MVP award, recognized as Microsoft
Regional Director and Global Advisory
Board member for the VR/AR
Association.

He lives in Dresden, Germany with his
wife and their 5 children.

Email

Simon Darkside JacksonSimon Darkside Jackson
United Kingdom

Long time game evangelist, from the
early days of basic, pascal and C++.

Jumped on the XNA bandwagon in its
infancy from the sailing ship MDX,
from there I've expanded far and wide
dealing with game and development
frameworks from here to the beyond.
Currently enjoying my first year as a
published author and entrant in the ID
program and seeking to get as many
people on boarded as possible.
Additionally I'm being dragged round
the UK supporting the Unity porting
programs (maybe MonoGame later)
and getting lots of projects on to the
windows platform.

Email
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mailto:schulte.rene@outlook.com
mailto:gamedevspace@hotmail.co.uk


Takahiro MiyauraTakahiro Miyaura
Nara, Japan

I'm working as a software engineer,
and developer in IT industry. In
particular, I've been doing research
XR(VR/AR/MR etc.) technologies, and
various technologies(AI, IoT, and so on)
that can take advantage of XR.

Email

Tamás DemeTamás Deme
Budapest, Hungary

Tamás is a mixed reality engineer
working at the Atlanta based VIM,
where he develops solutions for
devices ranging from servers to a
headset that shows you holograms.
He's a five times Microsoft MVP in
Windows Development, interested in
open-source projects, teaching and
mentoring. You can find him online at
https://tomzorz.me or on twitter at
https://twitter.com/tomzorz_.

Email

Tatsuro UedaTatsuro Ueda
Mie, Japan

MR Educator of Physics in 5 countries
including Afrika, President of Feel
Physics

Email
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mailto:cafe.kobe@gmail.com
https://tomzorz.me
https://twitter.com/tomzorz_
mailto:mixedreality@tomzorz.me
mailto:tatsuro.ueda@feel-physics.jp


Vincent GuiguiVincent Guigui
Paris, France

In charge of the Innovative
Interactions division at OCTO
Technology, I help our customers
develop new interactions between
human and digital world.

I am a lecturer on Innovation and
Natural User Interfaces topics, talking
about Immersive Experiences
(VR/AR/MR), Conversational Interfaces
(Bot), and potential future of the user
interfaces...

Since 2013, I've been awarded by
Microsoft as one of the european
leading experts on Kinect, Natural User
Interfaces, and HoloLens (Most
Valuable Professional award).

Email
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https://www.octo.com
mailto:vincent@guigui.fr


   

 

Start designing and prototyping
 7/6/2022 • 4 minutes to read • Edit Online

 Design checkpoints

  1. Getting started1. Getting started

Mixed Reality applications are unlike anything else in the world today, and designing them is hard work. Not

only do you have to account for the new combinations of real and virtual worlds you're creating, but also the

new user experiences they afford. Since Mixed Reality is a big place, we've selected important points along its

design spectrum and laid them out below as a series of checkpoints. These are meant to be sequential, but if

you've already dipped your feet in feel free to jump to any of the following sections.

Take a look at our design overview video to get started:

Use the following checkpoints to bring your application ideas and concepts into the world of mixed reality.

Like all journeys, your adventure into designing Mixed Reality applications starts with the basics. We

recommend familiarizing yourself with the What is Mixed Reality and What is a hologram? articles to get your

mind primed for immersive design. Once you've completed your read-through, you'll be ready to start your

Mixed Reality design journey!

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/design.md
https://www.microsoft.com/en-us/videoplayer/embed/RE4LhlW


C H EC KP O IN TC H EC KP O IN T O UTC O M EO UTC O M E

Expand your design process Get a first-hand look at design process for Mixed Reality,
gathered from designers inside and outside of Microsoft

Types of Mixed Reality apps Decide where your app experience will live on the Mixed
Reality spectrum

Designing Holograms app Learn the fundamentals of Mixed Reality UX Design by
experiencing with behaviors, tips, and recommendations for
creating amazing HoloLens apps (available for download
from Microsoft Store in HoloLens 2)

MRTK Examples Hub Experience common spatial interactions and UX building
blocks for Mixed Reality (available for download from
Microsoft Store in HoloLens 2)

OptionalOptional Download the Figma Toolkit The Figma Toolkit provides assets for you to use for
sketching and laying out UI based on the components
available in MRTK

  2. Core concepts2. Core concepts
Whether you're developing for VR or AR, there are several core concepts that apply to designing fluid immersive

experiences. Understanding the users point of view, positioning objects, and ensuring everyone is comfortable

and safe are your top priorities at this stage of your journey. By the end of this section you'll have a solid

foundation to carry through into interaction design.

https://www.microsoft.com/p/designing-holograms/9nxwnjklrzwd
https://www.microsoft.com/en-us/p/mrtk-examples-hub/9mv8c39l2sj4


C O N C EP TC O N C EP T O UTC O M EO UTC O M E

Holographic frame Understand how users see your content overlaid onto the
real world when wearing their headsets

Coordinate systems Learn how to position holograms in meaningful places in the
world, whether it's their physical room or a virtual realm
you've created

Spatial mapping Anchor objects in the user's world and take advantage of
real world's physical surfaces

Comfort considerations Ensure user comfort and safety by creating and presenting
immersive content in a way that mimics the natural world

  3. Interaction design3. Interaction design
No matter how beautiful and immersive a virtual experience is, it's useless without interaction. This section will

walk you through basic interaction models, hand and motion controllers, voice input, and gathering eye tracking

data from your users. By the end of this section you'll be ready to tackle the last big topic on your design

journey: user experience.



C O N C EP TC O N C EP T O UTC O M EO UTC O M E

Interaction models Provide your users with instinctual interactions through
hand, eye, and voice input

Hands and motion controllers Learn how to interact with holograms at close range with a
user' hands or at long range with precise interactions

Voice input Use voice commands as input in your immersive apps to
control surrounding holograms and environments

Eye Tracking Add a new level of context and human understanding in a
holographic experience by using information about what
your users are looking at

  4. User experience elements4. User experience elements

C O N C EP TC O N C EP T O UTC O M EO UTC O M E

Common controls and behaviors Learn about frequently used spatial interactions and UI
building blocks

Color, light, and materials Design quality assets for Mixed Reality that take color,
lighting, and materials into account

Object scale Incorporate as many real-world visual cues as possible to us
help your users understand where objects are, how big they
are, and what they’re made of

Now that you've mastered basic interactions, you can focus on the finer points of user experience elements and

how to adapt them for Mixed Reality's unique environments. You'll cover common behaviors, asset design,

object scaling, and typography, while making the experience intuitive for your users. This section marks the end

of the official Mixed Reality design journey, but there are more resources in the What's next? section to keep you

going.



Typography Use clear, readable text in three-dimensional space to give
your users the important information they need

C O N C EP TC O N C EP T O UTC O M EO UTC O M E

 What's next?

  Choose a prototyping optionChoose a prototyping option

NOTENOTE

  Other resourcesOther resources

A designer's job is never done, especially when learning to create immersive experiences in a new paradigm. The

following sections will take you beyond the beginner level design material you've already completed and into

the world of Mixed Reality development. These topics and resources aren't in any sequential order, so feel free to

explore!

Figma ToolkitFigma Toolkit

Figma Toolkit provides the assets that can be used for sketching and laying out UI. All UI controls are based on

the components available in MRTK.

Learn UnityLearn Unity

Learn how to create interactive experiences with Unity. Learn by doing, from start to finish.

Mixed Reality Toolkit (MRTK)Mixed Reality Toolkit (MRTK)

With spatial interaction and UI building blocks, jump-start your mixed reality design and development with

Unity.

Microsoft MaquetteMicrosoft Maquette

Design for VR. Microsoft Maquette makes spatial prototyping easy, quick, and immersive.

Starting with MRTK3 we are introducing a new Mixed Reality design language to developers. For more information, see

the MRTK3 documentation.

Understand the basicsUnderstand the basics

Get a better understanding of what defines mixed reality and how it’s being used.

https://github.com/Microsoft/MRDL_Unity_PeriodicTable
https://learn.unity.com/
https://learn.unity.com/
https://github.com/Microsoft/MixedRealityToolkit-Unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/
https://www.maquette.ms/
https://www.maquette.ms/
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/mrtk3-overview


Come to an eventCome to an event

Get started with your Mixed Reality development journey.

Install the toolsInstall the tools

Use the installation checklist to get the tools you need to build apps for HoloLens and mixed reality.

Star t developingStar t developing

Choose a development path based on your skill level, work style, or platform interest.
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 Introduction

 Overview

 Objectives

  Help solve customer challengesHelp solve customer challenges

Hello, and welcome to your design guidance for mixed reality.Hello, and welcome to your design guidance for mixed reality.

This guidance is written by Microsoft designers, developers, program managers, and researchers. Work from

our writers spans holographic devices, including HoloLens, immersive devices, and HP Windows Mixed Reality

headsets. We recommend thinking about this article as a set of topics for Windows head-mounted design.

We're entering a tremendously exciting new era of computing right along with you. Breakthroughs in head-

mounted displays, spatial sound, sensors, environmental awareness, input, and 3D graphics lead and challenge

us to define new types of experiences. The new frontier is dramatically more personal, intuitive, immersive, and

contextual.

Wherever possible, we'll offer actionable design guidance with related code on GitHub. That said, because we're

learning right along with you, we can't always offer specific, actionable guidance here. Some of what we share

will be in the spirit of ‘lessons we’ve learned' and ‘avoid going down that path’.

And we know, many innovations will be generated by the larger design community. So, we look forward to

hearing from you, learning from you, and working closely with you. We’ll do our best to share our insights, even

if they're exploratory and early. Our goal is to help developers and designers with their design thinking, best

practices, and the related open-source controls, patterns, and sample apps that you can use directly in your own

work.

Here’s a quick overview of how this design guidance is organized:

Over viewOver view  - Learn about the design process, core concepts, and interaction factors to consider.

Core conceptsCore concepts  - Learn about comfort, holographic frame, spatial mapping, and other core concepts to

consider.

Interaction modelsInteraction models  - This guidance is structured around three primary interaction models.

UX elementsUX elements  - Use controls and behaviors as building blocks to create your own application experience.

ResourcesResources  - Jump-start your project with design tools and prototyping options.

For all the above, we aim to deliver the right mix of text, illustrations, and videos. You’ll see us experimenting

with different formats and techniques, all with the intent of delivering what you need. And in the months ahead,

we’ll expand this taxonomy to include a broader set of design topics. Whenever possible, we’ll give you a heads-

up about what is coming next, so keep checking back.

Here’s a quick look at some high-level objectives that are guiding this work so you can understand where we’re

coming from

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/about-this-design-guidance.md


  Point the way towards a new, more human way of computingPoint the way towards a new, more human way of computing

  Meet creators where they areMeet creators where they are

 

We wrestle with many of the same issues that you do, and we understand how challenging your work is. It’s

exciting to explore and define a new frontier… and it can also be daunting. Old paradigms and practices are

being rethought, customers need new experiences, and there's so much potential for innovation. Given that we

want this work to be as comprehensive as possible, moving well beyond a style guide. We aim to deliver a

comprehensive set of design guidance that covers mixed reality interaction, commanding, navigation, input, and

style – all grounded in human behavior and scenarios.

While it's important to focus on specific customer problems, we also want to push ourselves to deliver more. We

believe great design isn't “just” problem-solving, but also a way to meaningfully activate human evolution. New

ways of human behavior, interpersonal relationships, activities, and environments fuel our innovation. We want

our guidance to reflect all these more aspirational ways of thinking too.



  Share as much as possible, from experimental to explicitShare as much as possible, from experimental to explicit

  The right balance of global and local designThe right balance of global and local design

 

We hope many audiences find this guidance to be helpful. You have different skillsets (beginning, intermediate,

advanced), use different tools (Unity, DirectX, C++, C#, other), are familiar with various platforms (Windows, iOS,

Android), come from different backgrounds (mobile, enterprise, gaming), and are working on different size

teams (solo, small, medium, large). So, this guidance can be viewed with different perspectives and needs.

Whenever possible, we'll try to keep this diversity in mind, and make our guidance as relevant as possible to as

many people as possible. We know that many of you're already on GitHub. So, we'll directly link to GitHub repos

and forums to meet you where you already are.

 

One of the challenges of offering design guidance in this new 3D medium is that we don’t always have definitive

guidance to offer. Just like you, we're learning, experimenting, prototyping, problem-solving, and adjusting as we

hit obstacles. Rather than wait for some mythical future moment when we've it all figured out, we aim to share

our thinking with you in real time, even if it isn't conclusive. Our end goal is to be definitive wherever we can,

providing clear, flexible design guidance tied to open-source code, and actionable in Microsoft development and

design tools. But getting to that point takes many rounds of iteration and learning. We want to engage with you,

and learn with you, along the way. We'll do our best to share as we go, even with our stuff that is experimental.



  Have a discussionHave a discussion

 Dive in

 

We’ll offer two levels of design guidance: global and local. Our 'global' design guidance is included in the Fluent

Design System. Fluent details how we think about fundamentals like light, depth, motion, material, and scale

across all Microsoft design--our devices, products, tools, and services. That said, significant device-specific

differences exist across this larger system. So, our 'local' design guidance for head-mounted displays describes

designing for holographic and immersive devices that often have different input and output methods and

different user needs and scenarios. Local design guidance covers topics unique to HMDs. For example: 3D

environments and objects; shared environments; the use of sensors, eye tracking, and spatial mapping; and the

opportunities of spatial audio. Throughout our guidance, you'll likely see us refer to both these global and the

local aspects. Hopefully this will help you ground your work in a larger foundation of design while taking

advantage of the design differences between specific devices.

 

Most importantly, we want to engage with you, the community of holographic and immersive designers and

developers, to define this exciting new era of design. As mentioned above, we know we don’t have all the

answers. That's why we believe many exciting solutions and innovations will come from you. We aim to be open

and available to hear about them, and discuss with you online and at events, and add value wherever we can.

We are excited to be a part of this amazing design community, embarking on an adventure together.

We hope this introductory article provides some meaningful context as you explore our design guidance. Dive

in, and let us know your thoughts in the GitHub forums you'll find linked in our articles, or at Microsoft Design

on Twitter and Facebook. Let's co-design the future together!

https://fluent.microsoft.com
https://twitter.com/MicrosoftDesign
https://www.facebook.com/microsoftdesign/
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Before diving into the design of your experience, it's helpful to understand a few core concepts. Each topic below

describes an underlying structural element that affects and contributes to the quality of the mixed reality

experience you're creating.

 App modelApp model

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/core-concepts-landingpage.md


 Comfor tComfor t

 CoordinateCoordinate

systemssystems

 Spatial mappingSpatial mapping



Room scan visualizationRoom scan visualization

 SceneScene

understandingunderstanding



   

 

App model
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 App lifecycle

 Placement and launch

Windows Mixed Reality uses the app model provided by the Universal Windows Platform (UWP), which is a

model and environment for modern Windows apps. The UWP app model defines how apps are safely installed,

updated, versioned, and removed completely. It also governs the application life cycle - how apps execute, sleep,

and stop - and how they can preserve state. Finally, the app model covers integration and interaction with the

operating system, files, and other apps.

Apps with a 2D view arranged in the Windows Mixed Reality home

The lifecycle of a mixed reality app involves standard app concepts such as placement, launch, termination, and

removal.

Every app starts in mixed reality by placing an app tile ( just a Windows secondary tile) in the Windows Mixed

Reality home. These app tiles, on placement, will start running the app. The tiles persist and stay at their placed

location, acting like launchers for any time you want to get back to the app.

Placement puts a secondary tile in the world

As soon as placement completes (unless the placement was started by an app to app launch), the app starts

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/app-model.md
https://docs.microsoft.com/en-us/windows/uwp/get-started/
https://docs.microsoft.com/en-us/uwp/api/windows.ui.startscreen.secondarytile


 Remove is close/terminate process

 App suspension/termination

launching. Windows Mixed Reality can run a limited number of apps at one time. you place and launch an app,

other active apps may suspend. Suspended apps leave a screenshot of the app's last state on its app tile

wherever you placed it. For more information on handling resume and other lifecycle events, see Windows 10

UWP app lifecycle.

 

Left: after placing a tile, the app starts running. Right: state diagram for app running, suspended, or not running.

When you remove a placed app tile from the world, the underlying processes closes. This can be useful for

ensuring your app is stopped or restarting a problematic app.

In the Windows Mixed Reality home, the user can create multiple entry points for an app by launching your app

from the Start menu and placing the app tile in the world. Each app tile behaves as a different entry point, and

has a separate tile instance in the system. A query for SecondaryTile.FindAllAsync will result in a

Secondar yTileSecondar yTile for each app instance.

When a UWP app suspends, a screenshot is taken of the current state.

https://docs.microsoft.com/en-us/windows/uwp/launch-resume/app-lifecycle
https://docs.microsoft.com/en-us/uwp/api/windows.ui.startscreen.secondarytile#windows_ui_startscreen_secondarytile_findallasync


SC EN A RIOSC EN A RIO RESUM IN GRESUM IN G A C T IVAT EDA C T IVAT ED

Launch new instance of app from the
Start menu

ActivatedActivated with a new TileId

Launch second instance of app from
the Start menu

ActivatedActivated with a new TileIdTileId

Select the instance of the app that isn't
currently active

ActivatedActivated with the TileIdTileId associated
with the instance

Select a different app, then select the
previously active instance

ResumingResuming raised

Select a different app, then select the
instance that was previously inactive

ResumingResuming raised Then ActivatedActivated with the TileIdTileId
associated with the instance

 Extended execution

Screenshots are shown for suspended apps

One key difference from other Windows 10 shells is how the app is informed of an app instance activation via

the CoreApplication.Resuming and CoreWindow.Activated events.

Sometimes your app needs to continue doing work in the background or playing audio. Background tasks are

available on HoloLens.

https://docs.microsoft.com/en-us/uwp/api/windows.applicationmodel.core.coreapplication#windows_applicationmodel_core_coreapplication_resuming
https://docs.microsoft.com/en-us/uwp/api/windows.ui.core.corewindow#windows_ui_core_corewindow_activated
https://docs.microsoft.com/en-us/uwp/api/windows.ui.startscreen.secondarytile#windows_ui_startscreen_secondarytile_tileid
https://docs.microsoft.com/en-us/windows/uwp/launch-resume/declare-background-tasks-in-the-application-manifest


 See also

Apps can run in the background

App views

Updating 2D UWP apps for mixed reality

3D app launcher design guidance

Implementing 3D app launchers
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https://www.youtube.com/embed/TneGSeqVAXQ

 Device support

FeatureFeature HoloLens (1stHoloLens (1st
gen)gen)

HoloLens 2HoloLens 2 ImmersiveImmersive
headsetsheadsets

Stationary frame of reference ✔️ ✔️ ✔️

Attached frame of reference ✔️ ✔️ ✔️

Stage frame of reference Not supported yet Not supported yet ✔️

Spatial anchors ✔️ ✔️ ✔️

Spatial mapping ✔️ ✔️ ❌

Scene understanding ❌ ✔️ ❌

 Mixed reality experience scales

EXP ERIEN C E SC A L EEXP ERIEN C E SC A L E REQ UIREM EN T SREQ UIREM EN T S EXA M P L E EXP ERIEN C EEXA M P L E EXP ERIEN C E

Orientation-onlyOrientation-only Headset orientationHeadset orientation (gravity-
aligned)

360° video viewer

Seated-scaleSeated-scale Above plus headset positionheadset position based
on zero position

Racing game or space simulator

Standing-scaleStanding-scale Above plus stage floor originstage floor origin Action game where you duck and
dodge in place

Room-scaleRoom-scale Above plus stage bounds polygonstage bounds polygon Puzzle game where you walk around
the puzzle

At their core, mixed reality apps place holograms in your world that look like and sound real objects. This

involves precisely positioning and orienting those holograms at meaningful places in the world, whether the

world is their physical room or a virtual realm you've created. Windows provides various real-world coordinate

systems for expressing geometry, which is known as spatial coordinate systemsspatial coordinate systems . You can use spatial

coordinate systems to reason about hologram position, orientation, gaze ray, or hand positions.

You can design Mixed reality apps for a broad range of user experiences, from 360-degree video viewers using

headset orientation to full world-scale apps and games using spatial mapping and spatial anchors:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/coordinate-systems.md
https://www.youtube.com/embed/TneGSeqVAXQ
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/immersive-headset-hardware-details


World-scaleWorld-scale Spatial anchorsSpatial anchors (and typically spatial
mapping)

Game with enemies coming from your
real walls, such as RoboRaid

EXP ERIEN C E SC A L EEXP ERIEN C E SC A L E REQ UIREM EN T SREQ UIREM EN T S EXA M P L E EXP ERIEN C EEXA M P L E EXP ERIEN C E

6DO F  T RA C K IN G6DO F  T RA C K IN G F LO O R DEF IN EDF LO O R DEF IN ED 360°  T RA C K IN G360°  T RA C K IN G
B O UN DSB O UN DS
DEF IN EDDEF IN ED

SPAT IA LSPAT IA L
A N C H O RSA N C H O RS

M A XM A X
EXP ERIEN C EEXP ERIEN C E

No - - - - Orientation-Orientation-
onlyonly

YesYes No - - - SeatedSeated

YesYes YesYes No - - Standing -Standing -
For wardFor ward

YesYes YesYes YesYes No - Standing -Standing -
360°360°

YesYes YesYes YesYes YesYes No RoomRoom

YesYes YesYes YesYes YesYes YesYes WorldWorld

 Spatial coordinate systems

 Building an orientation-only or seated-scale experience

The experience scales above follow a "nesting dolls" model. The key design principle for Windows Mixed Reality

is a given headset supports apps built for a target experience scale and all lesser scales:

The Stage frame of reference isn't yet supported on HoloLens. A room-scale app on HoloLens currently needs to

use spatial mapping or scene understanding to find the user's floor and walls.

All 3D graphics applications use Cartesian coordinate systems to reason about the positions and orientations of

virtual objects. These coordinate systems establish 3 perpendicular axes along which to position objects: an X, Y,

and Z axis.

In mixed reality, your apps reason about virtual and physical coordinate systems. Windows calls a coordinate

system that has real meaning in the physical world a spatial coordinate systemspatial coordinate system.

Spatial coordinate systems express their coordinate values in meters. This means that objects placed two units

apart in either the X, Y, or Z axis will appear 2 meters apart from one another when rendered in mixed reality.

Knowing this, you can easily render objects and environments at real-world scale.

In general, Cartesian coordinate systems can be either right-handed or left-handed. Spatial coordinate systems

on Windows are always right-handed, which means that the positive X-axis points right, the positive Y-axis

points up (aligned to gravity) and the positive Z-axis points towards you.

In both kinds of coordinate systems, the positive X-axis points to the right and the positive Y-axis points up. The

difference is whether the positive Z-axis points towards or away from you. Remember which direction the

positive Z-axis points by pointing the fingers of either your left or right hand in the positive X direction and

curling them to the positive Y direction. The direction your thumb points, either toward or away from you, is the

direction that the positive Z-axis points for that coordinate system.

https://www.microsoft.com/p/roboraid/9nblggh5fv3j
https://docs.microsoft.com/en-us/windows/uwp/graphics-concepts/coordinate-systems


  Stationary frame of referenceStationary frame of reference

  Attached frame of referenceAttached frame of reference

 Building a standing-scale or room-scale experience

  Stage frame of referenceStage frame of reference

The key to holographic rendering is changing your app's view of its holograms each frame as the user moves

around, to match their predicted head motion. You can build seated-scale experiencesseated-scale experiences  that respect changes

to the user's head position and head orientation using a stationar y frame of referencestationar y frame of reference.

Some content must ignore head position updates, staying fixed at a chosen heading and distance from the user

always. The primary example is 360-degree video: because the video is captured from a single fixed perspective,

it would ruin the illusion for the view position to move based on the content, even though the view orientation

changes as the user looks around. You can build such or ientation-only experiencesorientation-only experiences  using an attachedattached

frame of referenceframe of reference.

The coordinate system provided by a stationary frame of reference works to keep the positions of objects near

the user as stable as possible based on the world, while respecting changes in the user's head position.

For seated-scale experiences in a game engine such as Unity, a stationary frame of reference is what defines the

engine's "world origin." Objects that are placed at a specific world coordinate use the stationary frame of

reference to define their position in the real-world using those same coordinates. Content that stays put in the

world, even as the user walks around, is known as world-lockedworld-locked content.

An app will typically create one stationary frame of reference on startup and use its coordinate system

throughout the app's lifetime. As an app developer in Unity, you can just start placing content based on the

origin, which will be at the user's initial head position and orientation. If the user moves to a new place and

wants to continue their seated-scale experience, you can recenter the world origin at that location.

Over time, as the system learns more about the user's environment, it may determine that distances between

various points in the real-world are shorter or longer than the system previously believed. If you render

holograms in a stationary frame of reference for an app on HoloLens where users wander beyond an area about

5 meters wide, your app may observe drift in the observed location of those holograms. If your experience has

users wandering beyond 5 meters, you're building a world-scale experience, which will require other techniques

to keep holograms stable, as described below.

An attached frame of reference moves with the user as they walk around, with a fixed heading defined when the

app first creates the frame. This lets the user comfortably look around at content placed within that frame of

reference. Content rendered in this user-relative way is called body-lockedbody-locked content.

When the headset can't figure out where it is in the world, an attached frame of reference provides the only

coordinate system, which can be used to render holograms. This makes it ideal for displaying fallback UI to tell

the user that their device can't find them in the world. Apps that are seated-scale or higher should include an

orientation-only fallback to help the user get going again, with UI similar to that shown in the Mixed Reality

home.

To go beyond seated-scale on an immersive headset and build a standing-scale experiencestanding-scale experience, you can use the

stage frame of referencestage frame of reference.

To provide a room-scale experienceroom-scale experience, letting users walk around within the 5-meter boundary they pre-defined,

you can check for stage boundsstage bounds  as well.

When first setting up an immersive headset, the user defines a stagestage, which represents the room in which

they'll experience mixed reality. The stage minimally defines a stage or iginstage or igin , a spatial coordinate system

centered at the user's chosen floor position and forward orientation where they intend to use the device. By

placing content in this stage coordinate system at the Y=0 floor plane, you can ensure your holograms appear

https://unity3d.com/


  Stage boundsStage bounds

 Building a world-scale experience

  Why a single rigid coordinate system cannot be used beyond 5 metersWhy a single rigid coordinate system cannot be used beyond 5 meters

  Spatial anchorsSpatial anchors

comfortably on the floor when the user is standing, providing users with a standing-scale experiencestanding-scale experience.

The user may also optionally define stage boundsstage bounds , an area within the room that they've cleared out to move

around in mixed reality. If so, the app can build a room-scale experienceroom-scale experience, using these bounds to ensure that

holograms are always placed where the user can reach them.

Because the stage frame of reference provides a single fixed coordinate system within which to place floor-

relative content, it's the easiest path for porting standing-scale and room-scale applications developed for

virtual reality headsets. However, as with those VR platforms, a single coordinate system can only stabilize

content in about a 5 meters (16 foot) diameter, before lever-arm effects cause content far from the center to shift

noticeably as the system adjusts. To go beyond 5 meters, spatial anchors are needed.

HoloLens allows for true world-scale experiencesworld-scale experiences  that let users wander beyond 5 meters. To build a world-

scale app, you'll need new techniques beyond those used for room-scale experiences.

Today, when writing games, data visualization apps, or virtual reality apps, the typical approach is to establish

one absolute world coordinate system that all other coordinates can reliably map back to. In that environment,

you can always find a stable transform that defines a relationship between any two objects in that world. If you

didn't move those objects, their relative transforms would always remain the same. This kind of global

coordinate system works well when rendering a purely virtual world where you know all of the geometry in

advance. Room-scale VR apps today typically establish this kind of absolute room-scale coordinate system with

its origin on the floor.

In contrast, an untethered mixed reality device such as HoloLens has a dynamic sensor-driven understanding of

the world, continuously adjusting its knowledge over time of the user's surroundings as they walk many meters

across an entire floor of a building. In a world-scale experience, if you placed all your holograms in a single rigid

coordinate system, those holograms would necessarily drift over time, either based on the world or to each

other.

For example, the headset may currently believe two locations in the world to be 4 meters apart, and then later

refine that understanding, learning that the locations are in fact 3.9 meters apart. If those holograms had initially

been placed 4 meters apart in a single rigid coordinate system, one of them would then always appear 0.1

meters off from the real world.

Windows Mixed Reality solves the issue described in the previous section by letting you create spatial anchors to

mark important points in the world where the user has placed holograms. A spatial anchor represents an

important point in the world that the system should keep track of over time.

As the device learns about the world, these spatial anchors can adjust their position based on one another as

needed to ensure each anchor stays precisely where it was placed based on the real-world. By placing a spatial

anchor at the location where the user places a hologram and then positioning that hologram based on its spatial

anchor, you can ensure the hologram maintains optimal stability, even as the user roams across tens of meters.

This continuous adjustment of spatial anchors based on one another is the key difference between coordinate

systems from spatial anchors and stationary frames of reference:

Holograms placed in the stationary frame of reference all keep a rigid relationship to one another.

However, as the user walks long distances, that frame's coordinate system may drift based on the world

to ensure that holograms next to the user appear stable.

Holograms placed in the stage frame of reference also keep a rigid relationship to one another. In



  Spatial anchor persistenceSpatial anchor persistence

  Spatial anchor sharingSpatial anchor sharing

 Avoid head-locked content

 Handling tracking errors

contrast to the stationary frame, the stage frame always remains fixed in place based on its defined

physical origin. However, content rendered in the stage's coordinate system beyond its 5-meter boundary

will only appear stable while the user is standing within that boundary.

Holograms placed using one spatial anchor may drift based on holograms placed using another spatial

anchor. This allows Windows to improve its understanding of the position of each spatial anchor, even if,

for example, one anchor needs to adjust itself left and another anchor needs to adjust right.

In contrast to a stationary frame of reference, which always optimizes for stability near the user, the stage frame

of reference and spatial anchors ensure stability near their origins. This helps those holograms stay precisely in

place over time, but it also means that holograms rendered too far away from their coordinate system's origin

will experience increasingly severe lever-arm effects. This is because small adjustments to the position and

orientation of the stage or anchor are magnified proportional to the distance from that anchor.

A good rule of thumb is to ensure that anything you render based on a distant spatial anchor's coordinate

system is within about 3 meters of its origin. For a nearby stage origin, rendering distant content is OK, as any

increased positional error will affect only small holograms that won't shift much in the user's view.

Spatial anchors can also allow your app to remember an important location even after your app suspends or the

device is shut down.

You can save to disk the spatial anchors your app creates, and then load them back again later, by persisting

them to your app's spatial anchor storespatial anchor store. When saving or loading an anchor, you provide a string key that is

meaningful to your app, to identify the anchor later. Think of this key as the filename for your anchor. If you want

to associate other data with that anchor, such as a 3D model that the user placed at that location, save that to

your app's local storage and associate it with the key you chose.

By persisting anchors to the store, your users can place individual holograms or place a workspace around

which an app will place its various holograms, and then find those holograms later where they expect them,

over many uses of your app.

You can also use Azure Spatial Anchors for asynchronous hologram persistence across HoloLens, iOS, and

Android devices. By sharing a durable cloud spatial anchor, multiple devices can observe the same persisted

hologram over time, even if those devices aren't present together at the same time.

Your app can also share a spatial anchor in real time with other devices, allowing for real-time shared

experiences.

By using Azure Spatial Anchors, your app can share a spatial anchor across multiple HoloLens, iOS, and Android

devices. By having each device render a hologram using the same spatial anchor, all users will see the hologram

appear at the same place in the real world.

We strongly discourage rendering head-locked content, which stays at a fixed spot in the display (such as a

HUD). In general, head-locked content is uncomfortable for users and doesn't feel like a natural part of their

world.

Head-locked content should usually be replaced with holograms that are attached to the user or placed in the

world itself. For example, cursors should generally be pushed out into the world, scaling naturally to reflect the

position and distance of the object under the user's gaze.

https://docs.microsoft.com/en-us/azure/spatial-anchors/overview
https://docs.microsoft.com/en-us/azure/spatial-anchors/overview


  Headset can't track due to insufficient sensor dataHeadset can't track due to insufficient sensor data

  Headset tracks incorrectly due to dynamic changes in the environmentHeadset tracks incorrectly due to dynamic changes in the environment

  Headset tracks incorrectly because the environment has changed significantly over timeHeadset tracks incorrectly because the environment has changed significantly over time

  Headset tracks incorrectly due to identical spaces in an environmentHeadset tracks incorrectly due to identical spaces in an environment

 See also

In some environments such as dark hallways, it may not be possible for a headset using inside-out tracking to

locate itself correctly in the world. This can lead holograms to either not show up or appear at incorrect places if

handled incorrectly. We now discuss the conditions in which this can happen, its impact on user experience, and

tips to best handle this situation.

Sometimes, the headset's sensors aren't able to figure out where the headset is. This can happen if:

The room is dark

If the sensors are covered by hair or hands

If the surroundings don't have enough texture.

When this happens, the headset will be unable to track its position with enough accuracy to render world-locked

holograms. You can't figure out where a spatial anchor, stationary frame, or stage frame is based on the device.

However, you can still render body-locked content in the attached frame of reference.

Your app should tell the user how to get positional tracking back, rendering some fallback body-locked content

that describes some tips, such as uncovering the sensors and turning on more lights.

The device can't track properly if there are lots of dynamic changes in the environment, such as many people

walking around in the room. In this case, the holograms may seem to jump or drift as the device tries to track

itself in this dynamic environment. We recommend using the device in a less dynamic environment if you hit

this scenario.

When you start using a headset in an environment where furniture, wall hangings, and so on, has been moved,

it's possible that some holograms may appear shifted from their original locations. The earlier holograms may

also jump around as the user moves in the new space because the system's understanding of your space is no

longer true. The system then tries to remap the environment while also trying to reconcile the features of the

room. In this scenario, it's advised to encourage users to replace holograms they pinned in the world if they

aren't appearing where expected.

Sometimes, a home or other space may have two identical areas. For example, two identical conference rooms,

two identical corner areas, two large identical posters that cover the device's field of view. In such scenarios, the

device may, at times, get confused between the identical parts and mark them as the same in its internal

representation. This may cause the holograms from some areas to appear in other locations. The device may

start to lose tracking often since its internal representation of the environment has been corrupted. In this case,

it's advised to reset the system's environmental understanding. Resetting the map leads to loss of all spatial

anchor placements. This will cause the headset to track well in the unique areas of the environment. However,

the problem may reoccur if the device gets confused between the identical areas again.

Coordinate systems in Unity

Coordinate systems in DirectX

Spatial anchors

Shared experiences in mixed reality

Azure Spatial Anchors

Case study - Looking through holes in your reality

https://docs.microsoft.com/en-us/windows/mixed-reality/develop/unity/coordinate-systems-in-unity
https://docs.microsoft.com/en-us/azure/spatial-anchors
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-looking-through-holes-in-your-reality
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 Device support

FeatureFeature HoloLensHoloLens Immersive headsetsImmersive headsets

Room scan visualization ✔️ ❌

 Building a custom scanning experience

 Cached versus continuous spatial mapping

Applications that require spatial mapping rely on the device to collect data over time and across sessions. The

completeness and quality of the mapping data depends on many factors, including the amount of exploration

the user has done, how much time has passed since the exploration, and whether objects such as furniture and

doors have moved since the device scanned the area.

To ensure useful spatial mapping data, applications developers have several options:

Rely on what may have already been collected. This data may be incomplete initially.

Ask the user to use the bloom gesture to get to the Windows Mixed Reality home and then explore the area

they wish to use for the experience. They can use air-tap to confirm that all the necessary area is known to

the device.

Build a custom exploration experience in their own application.

In all these cases, the actual data gathered during the exploration is stored by the system and the application

doesn't need to do this. If you'd like to see room scan visualization in action, check out our DesigningDesigning

Holograms - Spatial AwarenessHolograms - Spatial Awareness  video demo below:

This video was taken from the "Designing Holograms" HoloLens 2 app. Download and enjoy the full experience

here.

Applications may analyze the spatial mapping data at the start of the experience to judge whether they want the

user to do extra steps to improve its completeness and quality. If analysis indicates quality should be improved,

developers should provide a visualization to overlay on the world to indicate:

How much of the total volume in the users vicinity needs to be part of the experience

Where the user should go to improve data

Users don't know what makes a "good" scan. They need to be shown or told what to look for if they’re asked to

evaluate a scan – flatness, distance from actual walls, and so on. The developer should implement a feedback

loop that includes refreshing the spatial mapping data during the scanning or exploration phase.

In many cases, it's best to tell the user what they need to do to get the necessary scan quality. For example, look

at the ceiling, look behind furniture, and so on.

The spatial mapping data is the most heavy weight data source applications can consume. To avoid performance

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/room-scan-visualization.md
https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Microsofts-Designing-Holograms-Spatial-Awareness-Chapter/player
https://aka.ms/dhapp
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


  Cached spatial mappingCached spatial mapping

  Continuous spatial mappingContinuous spatial mapping

 See also

issues such as dropped frames or stuttering, consumption of this data should be done carefully.

Active scanning during an experience can be both beneficial and detrimental, so you'll need to decide which

method to use based on the experience.

If there's cached spatial mapping data, the application typically takes a snapshot of the spatial mapping data and

uses this snapshot during the experience.

BenefitsBenefits

Reduced overhead on the system while the experience is running leading to dramatic power, thermal, and

cpu performance gains.

A simpler implementation of the main experience since it is not interrupted by changes in the spatial data.

A single one time cost on any post processing of the spatial data for physics, graphics, and other purposes.

DrawbacksDrawbacks

The movement of real world objects or people is not reflected by the cached data. for example, the

application might consider a door open when it's closed now.

Potentially more application memory to maintain the cached version of the data.

A good case for this method is a controlled environment or a table top game.

Certain applications may rely on continues scanning to refresh spatial mapping data.

BenefitsBenefits

You don't need to build in a separate scanning or exploration experience upfront in your application.

The movement of real world objects can be reflected by the game, although with some delay.

DrawbacksDrawbacks

Higher complexity in the implementation of the main experience.

Potential overhead from the extra graphic and physics processing, as changes need to be incrementally

ingested by these systems.

Higher power, thermal, and CPU impact.

A good case for this method is one where holograms are expected to interact with moving objects, for example,

a holographic car that drives on the floor may want to bump into a door depending on whether it's open or

closed.

Spatial mapping

Coordinate systems

Spatial sound design
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 Device supports

FeatureFeature HoloLens (1st gen)HoloLens (1st gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Spatial mapping ✔️ ✔️ ❌

 Why is spatial mapping important?

 Conceptual overview

Spatial mapping provides a detailed representation of real-world surfaces in the environment around the

HoloLens, allowing developers to create a convincing mixed reality experience. By merging the real world with

the virtual world, an application can make holograms seem real. Applications can also more naturally align with

user expectations by providing familiar real-world behaviors and interactions.

Spatial mapping makes it possible to place objects on real surfaces. This helps anchor objects in the user's world

and takes advantage of real world depth cues. Occluding your holograms based on other holograms and real

world objects helps convince the user that these holograms are actually in their space. Holograms floating in

space or moving with the user won't feel as real. When possible, place items for comfort.

Visualize surfaces when placing or moving holograms (use a projected grid). This helps users know where they

can best place their holograms, and shows if the spot they're trying to place the hologram isn't mapped. You can

"billboard items" toward the user if they end up at too much of an angle.

An example of a spatial mapping mesh covering a room

The two primary object types used for spatial mapping are the 'Spatial Surface Observer' and the 'Spatial

Surface'.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/spatial-mapping.md
https://www.youtube-nocookie.com/embed/zff2aQ1RaVo
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


 Spatial Awareness design concepts demo

 Spatial Mapping vs. Scene Understanding WorldMesh

 What influences spatial mapping quality?

 Common usage scenarios

The application provides the Spatial Surface Observer with one or more bounding volumes, to define the

regions of space in which the application wishes to receive spatial mapping data. For each of these volumes,

spatial mapping will provide the application with a set of Spatial Surfaces.

These volumes may be stationary (in a fixed location based on the real world) or they may be attached to the

HoloLens (they move, but don't rotate, with the HoloLens as it moves through the environment). Each spatial

surface describes real-world surfaces in a small volume of space, represented as a triangle mesh attached to a

world-locked spatial coordinate system.

As the HoloLens gathers new data about the environment, and as changes to the environment occur, spatial

surfaces will appear, disappear, and change.

If you'd like to see Spatial Awareness design concepts in action, check out our Designing Holograms -Designing Holograms -

Spatial AwarenessSpatial Awareness  video demo below. When you've finished, continue on for a more detailed dive into specific

topics.

This video was taken from the "Designing Holograms" HoloLens 2 app. Download and enjoy the full experience

here.

For HoloLens 2, it's possible to query a static version of the spatial mapping data using Scene understanding

SDK (EnableWorldMesh setting). Here are the differences between two ways of accessing the spatial mapping

data:

Spatial Mapping API:

Scene understanding SDK:

Limited range: the spatial mapping data available to applications in a limited size cached 'bubble'

around the user.

Provides low latency updates of changed mesh regions through SurfacesChanged events.

Variable level of details controlled by Triangles Per Cubic Meter parameter.

Unlimited range - provides all the scanned spatial mapping data within the query radius.

Provides a static snapshot of the spatial mapping data. Getting the updated spatial mapping data

requires running a new query for the whole mesh.

Consistent level of details controlled by RequestedMeshLevelOfDetail setting.

Several factors, detailed here, can affect the frequency and severity of these errors. However, you should design

your application so that the user can achieve their goals even in the presence of errors in the spatial mapping

data.

https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Microsofts-Designing-Holograms-Spatial-Awareness-Chapter/player
https://aka.ms/dhapp
https://docs.microsoft.com/en-us/hololens/hololens-environment-considerations


  PlacementPlacement
Spatial mapping provides applications with the opportunity to present natural and familiar forms of interaction

to the user ; what could be more natural than placing down your phone on the desk?

Constraining the placement of holograms (or more generally, any selection of spatial locations) to lie on

surfaces provides a natural mapping from 3D (point in space) to 2D (point on surface). This reduces the amount

of information the user needs to provide to the application and makes the user's interactions faster, easier, and

more precise. This is true because 'distance away' isn't something that we're used to physically communicating

to other people or to computers. When we point with our finger, we're specifying a direction but not a distance.

An important caveat here's that when an application infers distance from direction (for example by doing a

raycast along the user's gaze direction to find the nearest spatial surface), this must yield results that the user

can reliably predict. Otherwise, the user will lose their sense of control and this can quickly become frustrating.

One method that helps with this is to do multiple raycasts instead of just one. The aggregate results should be

smoother and more predictable, less susceptible to influence from transient 'outlier' results (as can be caused by

rays passing through tiny holes or hitting small bits of geometry that the user isn't aware of). Aggregation or

smoothing can also be performed over time; for example, you can limit the maximum speed at which a

hologram can vary in distance from the user. Simply limiting the minimum and maximum distance value can

also help, so the hologram being moved doesn't suddenly fly away into the distance or come crashing back into

the user's face.

Applications can also use the shape and direction of surfaces to guide hologram placement. A holographic chair

shouldn't penetrate through walls and should sit flush with the floor even if it's slightly uneven. This kind of

functionality would likely rely upon the use of physics collisions rather than raycasts, however similar concerns

will apply. If the hologram being placed has many small polygons that stick out, like the legs on a chair, it may

make sense to expand the physics representation of those polygons to something wider and smoother so that

they're more able to slide over spatial surfaces without snagging.

At its extreme, user input can be simplified away entirely and spatial surfaces can be used to do entirely

automatic hologram placement. For example, the application could place a holographic light-switch somewhere

on the wall for the user to press. The same caveat about predictability applies doubly here; if the user expects

control over hologram placement, but the application doesn't always place holograms where they expect (if the

light-switch appears somewhere that the user can't reach), then this will be a frustrating experience. It can

actually be worse to do automatic placement that requires user correction some of the time, than to just require

the user to always do placement themselves; because successful automatic placement is expected, manual

correction feels like a burden!

Note also that the ability of an application to use spatial surfaces for placement depends heavily on the

application's scanning experience. If a surface hasn't been scanned, then it cannot be used for placement. It's up

to the application to make this clear to the user, so that they can either help scan new surfaces or select a new

location.

Visual feedback to the user is of paramount importance during placement. The user needs to know where the

hologram is based on the nearest surface with grounding effects. They should understand why the movement of



  OcclusionOcclusion

  PhysicsPhysics

  NavigationNavigation

their hologram is being constrained (for example, because of collisions with another nearby surface). If they

can't place a hologram in the current location, then visual feedback should make it clear why not. For example, if

the user is trying to place a holographic couch stuck half-way into the wall, then the portions of the couch that

are behind the wall should pulsate in an angry color. Or conversely, if the application can't find a spatial surface

in a location where the user can see a real-world surface, then the application should make this clear. The

obvious absence of a grounding effect in this area may achieve this purpose.

One of the primary uses of spatial mapping surfaces is simply to occlude holograms. This simple behavior has a

huge impact on the perceived realism of holograms, helping to create a visceral sense that really inhabits the

same physical space as the user.

Occlusion also provides information to the user ; when a hologram appears to be occluded by a real-world

surface, this provides extra visual feedback as to the spatial location of that hologram in the world. Conversely,

occlusion can also usefully hide information from the user ; occluding holograms behind walls can reduce visual

clutter in an intuitive way. To hide or reveal a hologram, the user merely has to move their head.

Occlusion can also be used to prime expectations for a natural user interface based upon familiar physical

interactions; if a hologram is occluded by a surface it is because that surface is solid, so the user should expect

that the hologram will collide with that surface and not pass through it.

Sometimes, occlusion of holograms is undesirable. If a user needs to interact with a hologram, then they need to

see it - even if it is behind a real-world surface. In such cases, it usually makes sense to render such a hologram

differently when it's occluded (for example, by reducing its brightness). This way, the user can visually locate the

hologram, but they'll still know it's behind something.

The use of physics simulation is another way in which spatial mapping can be used to reinforce the presence of

holograms in the user's physical space. When my holographic rubber ball rolls realistically off my desk, bounces

across the floor and disappears under the couch, it might be hard for me to believe that it's not there.

Physics simulation also provides the opportunity for an application to use natural and familiar physics-based

interactions. Moving a piece of holographic furniture around on the floor will likely be easier for the user if the

furniture responds as if it were sliding across the floor with the appropriate inertia and friction.

To generate realistic physical behaviors, you'll likely need to do some mesh processing such as filling holes,

removing floating hallucinations and smoothing rough surfaces.

You'll also need to consider how your application's scanning experience influences its physics simulation. Firstly,

missing surfaces won't collide with anything; what happens when the rubber ball rolls off down the corridor and

off the end of the known world? Secondly, you need to decide whether you'll continue to respond to changes in

the environment over time. In some cases, you'll want to respond as quickly as possible; say if the user is using

doors and furniture as movable barricades in defense against a tempest of incoming Roman arrows. In other

cases though, you may want to ignore new updates; driving your holographic sports car around the racetrack

on your floor may suddenly not be so fun if your dog decides to sit in the middle of the track.

Applications can use spatial mapping data to grant holographic characters (or agents) the ability to navigate the

real world in the same way a real person would. This can help reinforce the presence of holographic characters

by restricting them to the same set of natural, familiar behaviors as those of the user and their friends.

Navigation capabilities could be useful to users as well. Once a navigation map has been built in a given area, it

could be shared to provide holographic directions for new users unfamiliar with that location. This map could be

designed to help keep pedestrian 'traffic' flowing smoothly, or to avoid accidents in dangerous locations like

construction sites.



  VisualizationVisualization

NOTENOTE

 Using The Surface Observer

The key technical challenges involved in implementing navigation functionality will be reliable detection of

walkable surfaces (humans don't walk on tables!) and graceful adaptation to changes in the environment

(humans don't walk through closed doors!). The mesh may require some processing before it's usable for path-

planning and navigation by a virtual character. Smoothing the mesh and removing hallucinations may help

avoid characters becoming stuck. You may also wish to drastically simplify the mesh to speed up your

character's path-planning and navigation calculations. These challenges have received a great deal of attention

in the development of video game technology, and there's a wealth of available research literature on these

topics.

The built-in NavMesh functionality in Unity cannot be used with spatial mapping surfaces. This is because spatial

mapping surfaces aren't known until the application starts, but NavMesh data files need to be generated from

source assets ahead of time. Also note that, the spatial mapping system won't provide information about

surfaces far away from the user's current location. So the application must 'remember' surfaces itself if it's to

build a map of a large area.

Most of the time it's appropriate for spatial surfaces to be invisible; to minimize visual clutter and let the real

world speak for itself. However, sometimes it's useful to visualize spatial mapping surfaces directly, despite their

real-world counterparts being visible.

For example, when the user is trying to place a hologram onto a surface (placing a holographic cabinet on the

wall, say) it can be useful to 'ground' the hologram by casting a shadow onto the surface. This gives the user a

much clearer sense of the exact physical proximity between the hologram and the surface. This is also an

example of the more general practice of visually 'previewing' a change before the user commits to it.

By visualizing surfaces, the application can share with the user its understanding of the environment. For

example, a holographic board game could visualize the horizontal surfaces that it has identified as 'tables', so

the user knows where they should go to interact.

Visualizing surfaces can be a useful way to show the user nearby spaces that are hidden from view. This could

provide a way to give the user access to their kitchen (and all of its contained holograms) from their living room.

The surface meshes provided by spatial mapping may not be particularly 'clean'. It's important to visualize them

appropriately. Traditional lighting calculations may highlight errors in surface normals in a visually distracting

manner, while 'clean' textures projected onto the surface may help to give it a tidier appearance. It's also possible

to do mesh processing to improve mesh properties, before the surfaces are rendered.

HoloLens 2 implements a new Scene Understanding Runtime, that provides Mixed Reality developers with a structured,

high-level environment representation designed to simplify the implementation of placement, occlusion, physics and

navigation.

The starting point for spatial mapping is the surface observer. Program flow is as follows:

Create a surface observer object

Provide one or more spatial volumes, to define the regions of interest in which the application wishes

to receive spatial mapping data. A spatial volume is simply a shape defining a region of space, such as

a sphere or a box.

Use a spatial volume with a world-locked spatial coordinate system to identify a fixed region of the

physical world.

Use a spatial volume, updated each frame with a body-locked spatial coordinate system, to identify a



 Mesh Caching

Use polling or notification to retrieve information about spatial surfaces

Process surfaces changes

Process the asynchronous mesh request (more details in following sections).

region of space that moves (but doesn't rotate) with the user.

These spatial volumes may be changed later at any time, as the status of the application or the user

changes.

You may 'poll' the surface observer for spatial surface status at any time. Instead, you may register for

the surface observer's 'surfaces changed' event, which will notify the application when spatial surfaces

have changed.

For a dynamic spatial volume, such as the view frustum, or a body-locked volume, applications will

need to poll for changes each frame by setting the region of interest and then obtaining the current

set of spatial surfaces.

For a static volume, such as a world-locked cube covering a single room, applications may register for

the 'surfaces changed' event to be notified when spatial surfaces inside that volume may have

changed.

Iterate the provided set of spatial surfaces.

Classify spatial surfaces as added, changed, or removed.

For each added or changed spatial surface, if appropriate submit an asynchronous request to receive

updated mesh representing the surface's current state at the desired level of detail.

Spatial surfaces are represented by dense triangle meshes. Storing, rendering, and processing these meshes can

consume significant computational and storage resources. As such, each application should adopt a mesh

caching scheme appropriate to its needs, to minimize the resources used for mesh processing and storage. This

scheme should determine which meshes to keep and which to discard, and when to update the mesh for each

spatial surface.

Many of the considerations discussed there will directly inform how your application should approach mesh

caching. You should consider how the user moves through the environment, which surfaces are needed, when

different surfaces will be observed and when changes in the environment should be captured.

When interpreting the 'surfaces changed' event provided by the surface observer, the basic mesh caching logic

is as follows:

If the application sees a spatial surface ID that it hasn't seen before, it should treat this as a new spatial

surface.

If the application sees a spatial surface with a known ID but with a new update time, it should treat this as an

updated spatial surface.

If the application no longer sees a spatial surface with a known ID, it should treat this as a removed spatial

surface.

It's up to each application to then make the following choices:

For new spatial surfaces, should mesh be requested?

For updated spatial surfaces, should mesh be requested?

Generally mesh should be requested immediately for new spatial surfaces, which may provide useful

new information to the user.

However, new spatial surfaces near and in front of the user should be given priority and their mesh

should be requested first.

If the new mesh isn't needed, if for example the application has permanently or temporarily 'frozen' its

model of the environment, then it shouldn't be requested.



 Rendering

For removed spatial surfaces, should mesh be discarded?

Should mesh be discarded for any other spatial surfaces?

Updated spatial surfaces near and in front of the user should be given priority and their mesh should

be requested first.

It may also be appropriate to give higher priority to new surfaces than to updated surfaces, especially

during the scanning experience.

To limit processing costs, applications may wish to throttle the rate at which they process updates to

spatial surfaces.

It may be possible to infer that changes to a spatial surface are minor, for example if the bounds of the

surface are small, in which case the update may not be important enough to process.

Updates to spatial surfaces outside the current region of interest of the user may be ignored entirely,

though in this case it may be more efficient to modify the spatial bounding volumes in use by the

surface observer.

Generally mesh should be discarded immediately for removed spatial surfaces, so that hologram

occlusion remains correct.

However, if the application has reason to believe that a spatial surface will reappear shortly (based

upon the design of the user experience), then it may be more efficient to keep it than to discard its

mesh and recreate it again later.

If the application is building a large-scale model of the user's environment, then it may not wish to

discard any meshes at all. It will still need to limit resource usage though, possibly by spooling meshes

to disk as spatial surfaces disappear.

Some relatively rare events during spatial surface generation can cause spatial surfaces to be replaced

by new spatial surfaces in a similar location but with different IDs. So, applications that choose not to

discard a removed surface should take care not to end up with multiple highly overlapped spatial

surfaces meshes covering the same location.

Even while a spatial surface exists, if it's no longer useful to the user's experience then it should be

discarded. For example, if the application 'replaces' the room on the other side of a doorway with an

alternate virtual space then the spatial surfaces in that room no longer matter.

Here's an example mesh caching strategy, using spatial and temporal hysteresis:

Consider an application that wishes to use a frustum-shaped spatial volume of interest that follows the user's

gaze as they look around and walk around.

A spatial surface may disappear temporarily from this volume simply because the user looks away from the

surface or steps further away from it... only to look back or moves closer again a moment later. In this case,

discarding and re-creating the mesh for this surface represents many redundant processings.

To reduce the number of changes processed, the application uses two spatial surface observers, one

contained within the other. The larger volume is spherical and follows the user 'lazily'; it only moves when

necessary to ensure that its center is within 2.0 meters of the user.

New and updated spatial surface meshes are always processed from the smaller inner surface observer, but

meshes are cached until they disappear from the larger outer surface observer. This allows the application to

avoid processing many redundant changes because of local user movement.

Since a spatial surface may also disappear temporarily because of tracking loss, the application also defers

discarding removed spatial surfaces during tracking loss.

In general, an application should evaluate the tradeoff between reduced update processing and increased

memory usage to determine its ideal caching strategy.

There are three primary ways in which spatial mapping meshes tend to be used for rendering:



For surface visualization

For occluding holograms behind real-world surfaces

For modifying the appearance of holograms occluded by real-world surfaces

It's often useful to visualize spatial surfaces directly. For example, casting 'shadows' from objects onto

spatial surfaces can provide helpful visual feedback to the user while they're placing holograms on

surfaces.

One thing to bear in mind is that spatial meshes are different to the kind of meshes that a 3D artist

might create. The triangle topology won't be as 'clean' as human-created topology, and the mesh will

suffer from various errors.

To create a pleasing visual aesthetic, you may want to do some mesh processing, for example to fill

holes or smooth surface normals. You may also wish to use a shader to project artist-designed

textures onto your mesh instead of directly visualizing mesh topology and normals.

Spatial surfaces can be rendered in a depth-only pass, which only affects the depth buffer and doesn't

affect color render targets.

This primes the depth buffer to occlude subsequently rendered holograms behind spatial surfaces.

Accurate occlusion of holograms enhances the sense that holograms really exist within the user's

physical space.

To enable depth-only rendering, update your blend state to set the RenderTargetWriteMask to zero for

all color render targets.

Normally rendered geometry is hidden when it's occluded. This is achieved by setting the depth

function in your depth-stencil state to "less than or equal", which causes geometry to be visible only

where it's closercloser  to the camera than all previously rendered geometry.

However, it may be useful to keep certain geometry visible even when it's occluded, and to modify its

appearance when occluded as a way of providing visual feedback to the user. For example, this allows

the application to show the user the location of an object while making it clear that is behind a real-

world surface.

To achieve this, render the geometry a second time with a different shader that creates the desired

'occluded' appearance. Before rendering the geometry for the second time, make two changes to your

depth-stencil state. First, set the depth function to "greater than or equal" so that the geometry will be

visible only where it's fur therfur ther  from the camera than all previously rendered geometry. Second, set

the DepthWriteMask to zero, so that the depth buffer won't be modified (the depth buffer should

continue to represent the depth of the geometry closestclosest to the camera).

Performance is an important concern when rendering spatial mapping meshes. Here are some rendering

performance techniques specific to rendering spatial mapping meshes:

Adjust triangle density

Use frustum culling

When requesting spatial surface meshes from your surface observer, request the lowest density of

triangle meshes that will suffice for your needs.

It may make sense to vary triangle density on a surface by surface basis, depending on the surface's

distance from the user, and its relevance to the user experience.

Reducing triangle counts will reduce memory usage and vertex processing costs on the GPU, though

it won't affect pixel processing costs.

Frustum culling skips drawing objects that cannot be seen because they are outside the current

display frustum. This reduces both CPU and GPU processing costs.

Since culling is performed on a per-mesh basis and spatial surfaces can be large, breaking each spatial

surface mesh into smaller chunks may result in more efficient culling (in that fewer offscreen triangles

are rendered). There's a tradeoff, however ; the more meshes you have, the more draw calls you must

make, which can increase CPU costs. In an extreme case, the frustum culling calculations themselves

could even have a measurable CPU cost.

https://docs.microsoft.com/en-us/windows/win32/direct3d9/depth-buffers
https://docs.microsoft.com/en-us/windows/win32/api/d3d11_1/ns-d3d11_1-d3d11_render_target_blend_desc1
https://docs.microsoft.com/en-us/windows/win32/api/d3d11/ns-d3d11-d3d11_depth_stencil_desc
https://docs.microsoft.com/en-us/windows/win32/api/d3d11/ns-d3d11-d3d11_depth_stencil_desc


 Mesh Processing

 Raycasting and Collision

Adjust rendering order

Spatial surfaces tend to be large, because they represent the user's entire environment surrounding

them. Pixel processing costs on the GPU can be high, especially in cases where there's more than one

layer of visible geometry (including both spatial surfaces and other holograms). In this case, the layer

nearest to the user will be occluding any layers further away, so any GPU time spent rendering those

more distant layers is wasted.

To reduce this redundant work on the GPU, it helps to render opaque surfaces in front-to-back order

(closer ones first, more distant ones last). By 'opaque' we mean surfaces for which the

DepthWriteMask is set to one in your depth-stencil state. When the nearest surfaces are rendered,

they'll prime the depth buffer so that more distant surfaces are efficiently skipped by the pixel

processor on the GPU.

An application may want to do various operations on spatial surface meshes to suit its needs. The index and

vertex data provided with each spatial surface mesh uses the same familiar layout as the vertex and index

buffers that are used for rendering triangle meshes in all modern rendering APIs. However, one key fact to be

aware of is that spatial mapping triangles have a front-clockwise winding orderfront-clockwise winding order . Each triangle is represented

by three vertex indices in the mesh's index buffer and these indices will identify the triangle's vertices in a

clockwiseclockwise order, when the triangle is viewed from the frontfront side. The front side (or outside) of spatial surface

meshes corresponds as you would expect to the front (visible) side of real world surfaces.

Applications should only do mesh simplification if the coarsest triangle density provided by the surface observer

is still insufficiently coarse - this work is computationally expensive and already being performed by the runtime

to generate the various provided levels of detail.

Because each surface observer can provide multiple unconnected spatial surfaces, some applications may wish

to clip these spatial surface meshes against each other, then zipper them together. In general, the clipping step is

required, as nearby spatial surface meshes often overlap slightly.

In order for a physics API (such as Havok) to provide an application with raycasting and collision functionality

for spatial surfaces, the application must provide spatial surface meshes to the physics API. Meshes used for

physics often have the following properties:

They contain only small numbers of triangles. Physics operations are more computationally intensive than

rendering operations.

They're 'water-tight'. Surfaces intended to be solid shouldn't have small holes in them; even holes too small

to be visible can cause problems.

They're converted into convex hulls. Convex hulls have few polygons and are free of holes, and they're much

more computationally efficient to process than raw triangle meshes.

When doing raycasts against spatial surfaces, bear in mind that these surfaces are often complex, cluttered

shapes full of messy little details - just like your desk! This means that a single raycast is often insufficient to

give you enough information about the shape of the surface and the shape of the empty space near it. It's

usually a good idea to do many raycasts within a small area and to use the aggregate results to derive a more

reliable understanding of the surface. For example, using the average of 10 raycasts to guide hologram

placement on a surface will yield a far smoother and less 'jittery' result that using just a single raycast.

However, bear in mind that each raycast can have a high computational cost. Depending on your usage scenario,

you should trade off the computational cost of extra raycasts (done every frame) against the computational cost

of mesh processing to smooth and remove holes in spatial surfaces (done when spatial meshes are updated).

https://docs.microsoft.com/en-us/windows/win32/api/d3d11/ns-d3d11-d3d11_depth_stencil_desc
https://docs.microsoft.com/en-us/windows/win32/direct3d9/rendering-from-vertex-and-index-buffers
https://www.havok.com/


 

The environment scanning experience
Each application that uses spatial mapping should consider providing a 'scanning experience'; the process

through which the application guides the user to scan surfaces that are necessary for the application to function

correctly.

Example of scanning

The nature of this scanning experience can vary greatly depending upon each application's needs, but two main

principles should guide its design.

Firstly, clear communication with the user is the pr imar y concernclear communication with the user is the pr imar y concern. The user should always be aware of

whether the application's requirements are being met. When they aren't being met, it should be immediately

clear to the user why this is so and they should be quickly led to take the appropriate action.

Secondly, applications should attempt to str ike a balance between efficiency and reliabilityapplications should attempt to str ike a balance between efficiency and reliability . When it's

possible to do so reliablyreliably , applications should automatically analyze spatial mapping data to save the user time.

When it isn't possible to do so reliably, applications should instead enable the user to quickly provide the

application with the additional information it requires.

To help design the right scanning experience, consider which of the following possibilities are applicable to your

application:

No scanning experienceNo scanning experience

An application may function perfectly without any guided scanning experience; it will learn about

surfaces that are observed in the course of natural user movement.

For example, an application that lets the user draw on surfaces with holographic spray paint requires

knowledge only of the surfaces currently visible to the user.

The environment may be scanned already if it's one in which the user has already spent lots of time

using the HoloLens.

Bear in mind however that the camera used by spatial mapping can only see 3.1 m in front of the user,

so spatial mapping won't know about any more distant surfaces unless the user has observed them

from a closer distance in the past.

So the user understands which surfaces have been scanned, the application should provide visual

feedback to this effect, for example casting virtual shadows onto scanned surfaces may help the user

place holograms on those surfaces.



For this case, the spatial surface observer's bounding volumes should be updated each frame to a

body-locked spatial coordinate system, so that they follow the user.

Find a suitable locationFind a suitable location

An application may be designed for use in a location with specific requirements.

For example, the application may require an empty area around the user so they can safely practice

holographic kung-fu.

Applications should communicate any specific requirements to the user up-front, and reinforce them

with clear visual feedback.

In this example, the application should visualize the extent of the required empty area and visually

highlight the presence of any undesired objects within this zone.

For this case, the spatial surface observer's bounding volumes should use a world-locked spatial

coordinate system in the chosen location.

Find a suitable configuration of surfacesFind a suitable configuration of surfaces

An application may require a specific configuration of surfaces, for example two large, flat, opposing

walls to create a holographic hall of mirrors.

In such cases, the application will need to analyze the surfaces provided by spatial mapping to detect

suitable surfaces, and direct the user toward them.

The user should have a fallback option if the application's surface analysis isn't reliable. For example, if

the application incorrectly identifies a doorway as a flat wall, the user needs a simple way to correct

this error.

Scan par t of the environmentScan par t of the environment

An application may wish to only capture part of the environment, as directed by the user.

For example, the application scans part of a room so the user may post a holographic classified ad for

furniture they wish to sell.

In this case, the application should capture spatial mapping data within the regions observed by the

user during their scan.

Scan the whole roomScan the whole room

An application may require a scan of all of the surfaces in the current room, including those behind

the user.

For example, a game may put the user in the role of Gulliver, under siege from hundreds of tiny

Lilliputians approaching from all directions.

In such cases, the application will need to determine how many of the surfaces in the current room

have already been scanned, and direct the user's gaze to fill in significant gaps.

The key to this process is providing visual feedback that makes it clear to the user which surfaces

haven't yet been scanned. The application could, for example, use distance-based fog to visually

highlight regions that aren't covered by spatial mapping surfaces.

Take an initial snapshot of the environmentTake an initial snapshot of the environment

An application may wish to ignore all changes in the environment after taking an initial 'snapshot'.

This may be appropriate to avoid disruption of user-created data that is tightly coupled to the initial

state of the environment.

In this case, the application should make a copy of the spatial mapping data in its initial state once the

scan is complete.

Applications should continue receiving updates to spatial mapping data if holograms are still to be

correctly occluded by the environment.

Continued updates to spatial mapping data also allow visualizing any changes that have occurred,

clarifying to the user the differences between prior and present states of the environment.

https://docs.microsoft.com/en-us/windows/win32/direct3d9/fog-formulas
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Take user-initiated snapshots of the environmentTake user-initiated snapshots of the environment

An application may only wish to respond to environmental changes when instructed by the user.

For example, the user could create multiple 3D 'statues' of a friend by capturing their poses at

different moments.

Allow the user to change the environmentAllow the user to change the environment

An application may be designed to respond in real time to any changes made in the user's

environment.

For example, the user drawing a curtain could trigger 'scene change' for a holographic play taking

place on the other side.

Guide the user to avoid errors in the spatial mapping dataGuide the user to avoid errors in the spatial mapping data

An application may wish to provide guidance to the user while they're scanning their environment.

This can help the user to avoid certain kinds of errors in the spatial mapping data, for example by

staying away from sunlit windows or mirrors.

One extra detail to be aware of is that the 'range' of spatial mapping data isn't unlimited. While spatial mapping

does build a permanent database of large spaces, it only makes that data available to applications in a 'bubble'

of limited size around the user. If you start at the beginning of a long corridor and walk far enough away from

the start, then eventually the spatial surfaces back at the beginning will disappear. You can mitigate this by

caching those surfaces in your application after they've disappeared from the available spatial mapping data.

It may help to detect common types of errors in surfaces and to filter, remove or modify the spatial mapping

data as appropriate.

Bear in mind that spatial mapping data is intended to be as faithful as possible to real-world surfaces, so any

processing you apply risks shifting your surfaces further from the 'truth'.

Here are some examples of different types of mesh processing that you may find useful:

Hole fil l ingHole fil l ing

If a small object made of a dark material fails to scan, it will leave a hole in the surrounding surface.

Holes affect occlusion: holograms can be seen 'through' a hole in a supposedly opaque real-world

surface.

Holes affect raycasts: if you're using raycasts to help users interact with surfaces, it may be undesirable

for these rays to pass through holes. One mitigation is to use a bundle of multiple raycasts covering

an appropriately sized region. This will allow you to filter 'outlier' results, so that even if one raycast

passes through a small hole, the aggregate result will still be valid. However, this approach comes at a

computational cost.

Holes affect physics collisions: an object controlled by physics simulation may drop through a hole in

the floor and become lost.

It's possible to algorithmically fill such holes in the surface mesh. However, you'll need to tune your

algorithm so that 'real holes' such as windows and doorways don't get filled in. It can be difficult to

reliably differentiate 'real holes' from 'imaginary holes', so you'll need to experiment with different

heuristics such as 'size' and 'boundary shape'.

Hallucination removalHallucination removal

Reflections, bright lights, and moving objects can leave small lingering 'hallucinations' floating in mid-

air.

Hallucinations affect occlusion: hallucinations may become visible as dark shapes moving in front of

and occluding other holograms.



 Prototyping and debugging
  Useful toolsUseful tools

Hallucinations affect raycasts: if you're using raycasts to help users interact with surfaces, these rays

could hit a hallucination instead of the surface behind it. As with holes, one mitigation is to use many

raycasts instead of a single raycast, but again this will come at a computational cost.

Hallucinations affect physics collisions: an object controlled by physics simulation may become stuck

against a hallucination and be unable to move through a seemingly clear area of space.

It's possible to filter such hallucinations from the surface mesh. However, as with holes, you'll need to

tune your algorithm so that real small objects such as lamp-stands and door handles don't get

removed.

SmoothingSmoothing

Spatial mapping may return surfaces that appear to be rough or 'noisy' in comparison to their real-

world counterparts.

Smoothness affects physics collisions: if the floor is rough, a physically simulated golf ball may not roll

smoothly across it in a straight line.

Smoothness affects rendering: if a surface is visualized directly, rough surface normals can affect its

appearance and disrupt a 'clean' look. It's possible to mitigate this by using appropriate lighting and

textures in the shader that is used to render the surface.

It's possible to smooth out roughness in a surface mesh. However, this may push the surface further

away from the corresponding real-world surface. Maintaining a close correspondence is important to

produce accurate hologram occlusion, and to enable users to achieve precise and predictable

interactions with holographic surfaces.

If only a cosmetic change is required, it may be sufficient to smooth vertex normals without changing

vertex positions.

Plane findingPlane finding

There are many forms of analysis that an application may wish to perform on the surfaces provided

by spatial mapping.

One simple example is 'plane finding'; identifying bounded, mostly planar regions of surfaces.

Planar regions can be used as holographic work-surfaces, regions where holographic content can be

automatically placed by the application.

Planar regions can constrain the user interface, to guide users to interact with the surfaces that best

suit their needs.

Planar regions can be used as in the real world, for holographic counterparts to functional objects

such as LCD screens, tables or whiteboards.

Planar regions can define play areas, forming the basis of video game levels.

Planar regions can aid virtual agents to navigate the real world, by identifying the areas of floor that

real people are likely to walk on.

The HoloLens emulator can be used to develop applications using spatial mapping without access to a

physical HoloLens. It allows you to simulate a live session on a HoloLens in a realistic environment, with all of

the data your application would normally consume, including HoloLens motion, spatial coordinate systems,

and spatial mapping meshes. This can be used to provide reliable, repeatable input, which can be useful for

debugging problems and evaluating changes to your code.

To reproduce a scenario, capture spatial mapping data over the network from a live HoloLens, then save it to

disk and reuse it in later debugging sessions.

The Windows device portal 3D view provides a way to see all of the spatial surfaces currently available via

the spatial mapping system. This provides a basis of comparison for the spatial surfaces inside your

application; for example, you can easily tell if any spatial surfaces are missing or are being displayed in the
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 Troubleshooting

 See also

wrong place.

Because errors in the spatial mapping data may strongly affect your user's experience, we recommend that

you test your application in a wide variety of environments.

Don't get trapped in the habit of always testing in the same location, for example at your desk. Make sure to

test on various surfaces of different positions, shapes, sizes, and materials.

Similarly, while synthetic or recorded data can be useful for debugging, don't become too reliant upon the

same few test cases. This may delay finding important issues that more varied testing would have caught

earlier.

It's a good idea to perform testing with real (and ideally uncoached) users, because they may not use the

HoloLens or your application in exactly the same way that you do. In fact, it may surprise you how divergent

people's behavior, knowledge, and assumptions can be!

In order for the surface meshes to be orientated correctly, each GameObject needs to be active before it's

sent to the SurfaceObserver to have its mesh constructed. Otherwise, the meshes will show up in your space

but rotated at weird angles.

The GameObject that runs the script that communicates with the SurfaceObserver needs to be set to the

origin. Otherwise, all of GameObjects that you create and send to the SurfaceObserver to have their meshes

constructed will have an offset equal to the offset of the Parent Game Object. This can make your meshes

show up several meters away, which makes it hard to debug what is going on.

Coordinate systems

Spatial mapping in DirectX

Spatial mapping in Unity

Scene Understanding

Room scan visualization

Spatial sound design

Case study - Looking through holes in your reality

https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-looking-through-holes-in-your-reality
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 Developing with Scene Understanding

  SDKSDK

  SampleSample

Scene understanding provides Mixed Reality developers with a structured, high-level environment

representation designed to make developing for environmentally aware applications intuitive. Scene

understanding does this by combining the power of existing mixed reality runtimes, like the highly accurate but

less structured spatial mapping and new AI driven runtimes. By combining these technologies, Scene

understanding generates representations of 3D environments that are similar to those you may have used in

frameworks such as Unity or ARKit/ARCore. The Scene understanding entry point begins with a Scene Observer,

which is called by your application to compute a new scene. Today, the technology can generate 3 distinct but

related object categories:

Simplified watertight environment meshes that infer the planar room structure without clutter

Plane regions for placement that we call Quads

A snapshot of the spatial mapping mesh that aligns with the Quads/Watertight data that we surface

This document is intended to provide a scenario overview and to clarify the relationship that Scene

understanding and Spatial mapping share. If you'd like to see Scene Understanding in action, check out our

Designing Holograms - Spatial AwarenessDesigning Holograms - Spatial Awareness  video demo below:

This video was taken from the "Designing Holograms" HoloLens 2 app. Download and enjoy the full experience

here.

This article only serves to introduce the Scene Understanding runtime and concepts. If you're looking for

documentation on how to develop with Scene Understanding, you may be interested in the following articles:

Scene Understanding SDK overview

You can download the Scene Understanding Sample app from the sample GitHub site:

Scene Understanding Sample

If you don't have a device and wish to access sample scenes to try Scene Understanding out, there are scenes in

the sample asset folder :

Scene Understanding Sample Scenes

If you're looking for specific details on developing with Scene Understanding, see the Scene Understanding SDK

overview documentation.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/scene-understanding.md
https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Microsofts-Designing-Holograms-Spatial-Awareness-Chapter/player
https://aka.ms/dhapp
https://github.com/microsoft/MixedReality-SceneUnderstanding-Samples
https://github.com/sceneunderstanding-microsoft/unitysample/tree/master/Assets/Resources/SerializedScenesForPCPath
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FeatureFeature HoloLens (1st gen)HoloLens (1st gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Scene understanding ❌ ✔️ ❌

 Common usage scenarios

  PlacementPlacement

Common spatial mapping usage scenarios: placement, occlusion, physics, and navigation.

Many of the core scenarios for environmentally aware applications can be addressed by both Spatial mapping

and Scene understanding. These core scenarios include placement, occlusion, physics, and so on. A core

difference between Scene understanding and Spatial mapping is a tradeoff of maximal accuracy and latency to

structure and simplicity. If your application requires the lowest-latency possible and mesh triangles that only

you'll want to access, use Spatial Mapping directly. If you're doing higher-level processing, you may consider

switching to the Scene understanding model as it should provide you with a superset of functionality. You'll

always have access to the most complete and accurate spatial mapping data possible because Scene

understanding provides a snapshot of the spatial mapping mesh as part of its representation.

The following sections revisit the core spatial mapping scenarios in the context of the new Scene understanding

SDK.

Scene understanding provides new constructs designed to simplify placement scenarios. A scene can compute

primitives called SceneQuads, which describe flat surfaces on which holograms can be placed. SceneQuads have

been designed around placement and describe a 2D surface and provide an API for placement on that surface.

Previously, when using the triangle mesh to do placement, one had to scan all areas of the quad and do hole

filling/post-processing to identify good locations for object placement. This isn't always necessary with Quads,

as the Scene understanding runtime infers which quad areas weren't scanned, and invalidate areas that aren't

part of the surface.

Image #1Image #1  - SceneQuads with inference disabled, capturing placement areas for scanned regions.

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


  OcclusionOcclusion

  PhysicsPhysics

  NavigationNavigation

Image #2Image #2  - Quads with inference enabled, placement is no longer limited to scanned areas.

If your application intends to place 2D or 3D holograms on rigid structures of your environment, the simplicity

and convenience of SceneQuads for placement is preferable to computing this information from the spatial

mapping mesh. For more information on this topic, see the Scene understanding SDK reference

NoteNote For legacy placement code that depends on the spatial mapping mesh, the spatial mapping mesh can be

computed along with SceneQuads by setting EnableWorldMesh setting. If Scene understanding API doesn't

satisfy your application's latency requirements, we recommend you continue to use the Spatial mapping API.

Spatial mapping occlusion remains the least latent way to capture the real-time state of the environment.

Though this may be useful to provide occlusion in highly dynamic scenes, you may wish to consider Scene

understanding for occlusion for several reasons. If you use the spatial mapping mesh generated by Scene

Understanding, you can request data from spatial mapping that wouldn't be stored in the local cache and isn't

available from the perception APIs. Using Spatial Mapping for occlusion alongside watertight meshes will

provide extra value, specifically completion of unscanned room structure.

If your requirements can tolerate the increased latency of Scene understanding, application developers should

consider using the Scene understanding watertight mesh, and the spatial mapping mesh in unison with planar

representations. This would provide a "best of both worlds" scenario where simplified watertight occlusion is

married with finer nonplanar geometry providing the most realistic occlusion maps possible.

Scene understanding generates watertight meshes that decompose space with semantics, specifically to address

many limitations to physics that spatial mapping meshes impose. Watertight structures ensure physics ray casts

always hit, and semantic decomposition allows for simpler generation of nav meshes for indoor navigation. As

described in the section on occlusion, creating a scene with EnableSceneObjectMeshes and EnableWorldMesh

will produce the most physically complete mesh possible. The watertight property of the environment mesh

prevents hit tests from failing to hit surfaces. The mesh data will ensure physics are interacting with all objects in

the scene and not just the room structure.

Planar meshes decomposed by semantic class are ideal constructs for navigation and path planning, easing

many of the issues described in the Spatial mapping navigation overview. The SceneMesh objects computed in

the scene are de-composed by surface type ensuring that nav-mesh generation is limited to surfaces that can be

walked on. Because of the floor structures' simplicity, dynamic nav-mesh generation in 3d engines such as Unity

are attainable depending on real-time requirements.

Generating accurate nav-meshes currently still requires post-processing, namely applications must still project

occluders on to the floor to ensure that navigation doesn't pass through clutter/tables and so on. The most

accurate way to accomplish this is to project the world mesh data, which is provided if the scene is computed



  VisualizationVisualization

  See AlsoSee Also

with the EnableWorldMesh flag.

While spatial mapping visualization can be used for real-time feedback of the environment, there are many

scenarios where the simplicity of planar and watertight objects provides more performance or visual quality.

Shadow projection and grounding techniques that are described using spatial mapping may be more pleasing if

projected on the planar surfaces provided by Quads or the planar watertight mesh. This is especially true for

environments/scenarios where thorough pre-scanning isn't optimal because the scene will infer, and complete

environments and planar assumptions will minimize artifacts.

Additionally, the total number of surfaces returned by Spatial Mapping is limited by the internal spatial cache,

while Scene understanding's version of the Spatial Mapping mesh can access spatial mapping data that isn't

cached. Because of this, Scene understanding is more suited to capturing mesh representations for larger spaces

(for example, larger than a single room) for visualization or further mesh processing. The world mesh returned

with EnableWorldMesh will have a consistent level of detail throughout, which may yield a more pleasing

visualization if rendered as wireframe.

Scene understanding SDK

Spatial mapping
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 Best practices

  Create spatial anchors where users place themCreate spatial anchors where users place them

  Always render anchored holograms within 3 meters of their anchorAlways render anchored holograms within 3 meters of their anchor

A spatial anchor represents an important point in the world that the system tracks over time. Each anchor has an

adjustable coordinate system, based on other anchors or frames of reference, to ensure anchored holograms

stay precisely in place. Rendering a hologram in an anchor's coordinate system gives you the most precise

positioning for that hologram at any given time. This comes at the cost of small adjustments over time to the

hologram's position as the system continually moves it back into place based on the real world.

You can also persist and share spatial anchors across application sessions and across devices:

By saving local spatial anchors to disk and loading them back later, your application can calculate the same

location in the real world across multiple application sessions on a single HoloLens.

By using Azure Spatial Anchors to create a cloud anchor, your application can share a spatial anchor across

multiple HoloLens, iOS, and Android devices. By having each device render a hologram using the same

spatial anchor, users will see the hologram appear at the same place in the real world. This allows for real-

time shared experiences.

You can also use Azure Spatial Anchors for asynchronous hologram persistence across HoloLens, iOS, and

Android devices. By sharing a durable cloud spatial anchor, multiple devices can observe the same persisted

hologram over time, even if those devices aren't present together at the same time.

For standing-scale or room-scale experiences for tethered desktop headsets that will stay within a 5-meter

diameter, you can typically use the stage frame of reference instead of spatial anchors, which provides you a

single coordinate system in which to render all content. However, if your application lets users wander beyond 5

meters in HoloLens, perhaps operating throughout an entire floor of a building, you'll need spatial anchors to

keep content stable.

While spatial anchors are great for holograms that should remain fixed in the world, once an anchor is placed, it

can't be moved. There are alternatives to anchors that are more appropriate for dynamic holograms that tag

along with the user. It's best to position dynamic holograms using a stationary frame of reference (the

foundation for Unity's world coordinates) or an attached frame of reference.

These spatial anchor guidelines will help you render stable holograms that accurately track the real world.

Typically, users are the ones explicitly placing spatial anchors.

For example, on HoloLens, an application can intersect the user's gaze ray with the spatial mapping mesh to let

the user decide where to place a hologram. When the user taps to place that hologram, create a spatial anchor at

the intersection point, and then place the hologram at the origin of that anchor's coordinate system.

Local spatial anchors are easy and performant to create. The system combines internal data if multiple anchors

can share their underlying sensor data. We recommend creating a new local spatial anchor for each hologram

that a user explicitly places, except in cases outlined below, such as rigid groups of holograms.

Spatial anchors stabilize their coordinate system near the anchor's origin. If you render holograms more than 3

meters from the origin, the holograms might experience noticeable positional errors in proportion to their

distance from that origin because of lever-arm effects. This works if the user stands near the anchor, since the

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/spatial-anchors.md
https://docs.microsoft.com/en-us/azure/spatial-anchors/overview
https://docs.microsoft.com/en-us/azure/spatial-anchors/overview


  Group holograms that should form a rigid clusterGroup holograms that should form a rigid cluster

  Render highly dynamic holograms using the stationary frame of reference instead of a local spatial anchorRender highly dynamic holograms using the stationary frame of reference instead of a local spatial anchor

  Avoid creating a grid of spatial anchorsAvoid creating a grid of spatial anchors

  Release local spatial anchors you no longer needRelease local spatial anchors you no longer need

hologram is far away from the user, too. In other words, the angular error of the distant hologram will be small.

However, if the user walks up to that distant hologram, it will be large in their view, making the lever-arm effects

from the faraway anchor origin obvious.

Multiple holograms can share the same spatial anchor if the application expects those holograms to maintain

fixed relationships with one another.

For example, if you're animating a holographic solar system in a room, it's better to tie all of the solar system

objects to a single anchor in the center. That way, they'll move smoothly based on each other. In this case, it's the

solar system as a whole that is anchored, even though its component parts are moving dynamically around the

anchor.

The key caveat to maintain hologram stability is to follow the 3-meter rule above.

If you have a highly dynamic hologram, such as a character walking around a room or a floating UI that follows

along the wall near the user, it's best to skip local spatial anchors, and render those holograms directly in the

coordinate system provided by the stationary frame of reference. In Unity, you achieve this by placing

holograms directly in world coordinates without a WorldAnchor. Holograms in a stationary frame of reference

might experience drift when the user is far from the hologram. But this is less likely to be noticeable for dynamic

holograms: either the hologram is constantly moving anyway or its motion constantly keeps it close to the user

where drift will be minimized.

One interesting case of dynamic holograms is an object that is animating from one anchored coordinate system

to another. For example, you might have two castles 10 meters apart, each on their own spatial anchor with one

castle firing a cannonball at the other castle. When the cannonball is fired, you can render it at the appropriate

location in the stationary frame of reference to coincide with the cannon in the first castle's anchored coordinate

system. It can then follow its trajectory in the stationary frame of reference as it flies 10 meters through the air.

As the cannonball reaches the other castle, you can move it into the second castle's anchored coordinate system

to allow for physics calculations with that castle's rigid bodies.

If you're sharing a highly dynamic hologram across devices, pick some cloud spatial anchor to act as their parent

because stationary frames of reference cannot be shared across devices. However, you should ensure either the

dynamic hologram or the devices viewing it stay within the anchor's 3-meter radius so the hologram appears

stable on all devices.

You may be tempted to have your application drop a regular grid of spatial anchors as the user walks around,

transitioning dynamic objects from anchor to anchor as they move around. However, this involves more

management for your application, without the benefit of the deep sensor data that the system itself maintains

internally. For these cases, you'll achieve better results by placing your holograms in the stationary frame of

reference as described in the section above. When you're pre-positioning a set of cloud spatial anchors around a

static space, consider placing the spatial anchors at the locations of the key holograms the user comes across

per the principle above rather than creating an arbitrary grid of anchors. This ensures that you'll get maximum

stability for those key holograms.

While a local spatial anchor is active, the system prioritizes keeping the sensor data that is near that anchor. If

you're no longer using a spatial anchor, stop accessing its coordinate system. This allows its underlying sensor

data to be removed as necessary.

This is especially important for local anchors you've persisted to the spatial anchor store. The sensor data behind

these anchors will be kept around permanently to allow your application to find that anchor in future sessions,

which reduces the space available to track other anchors. Only persist local anchors that you need to find again



 See also

in future sessions. We recommend removing them from the store when they're no longer meaningful to the

user.

For cloud spatial anchors, your storage can scale as your scenario requires. You can store as many cloud anchors

as you need, releasing them when you know that your users won't need the anchor again.

Coordinate systems

Shared experiences in mixed reality

Azure Spatial Anchors

Persistence in Unity

Spatial anchors in DirectX

Case study - Looking through holes in your reality

https://docs.microsoft.com/en-us/azure/spatial-anchors
https://docs.microsoft.com/en-us/windows/mixed-reality/develop/unity/persistence-in-unity
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-looking-through-holes-in-your-reality
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 Device support

FeatureFeature HoloLens (1st gen)HoloLens (1st gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Bloom ✔️ ❌ ❌

Wrist icon ❌ ✔️ ❌

Eye gaze and palm up pinch ❌ ✔️ ❌

 Bloom

The Start gesture is a hand gesture used to invoke the Start Menu. It's the equivalent of pressing the Windows

key on keyboards, the Xbox icon on Xbox controllers, or the Windows icon on immersive headset motion

controllers. Pay special attention to reserved system gestures on each Mixed Reality device to prevent conflicts

when you're designing interactions.

We designed “Bloom” to bring up the start menu in HoloLens (1st gen), which is a symbolic gesture mimicking a

flower blossom. It's distinctive for sure-footed interaction, easy of use, and quick to recall. To use the gesture,

hold out your hand with your palm up and fingertips together, then open your hand by spreading your fingers.

Step 1: Palm up with finger tips togetherStep 1: Palm up with finger tips together

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/system-gesture.md
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


 Start gesture

Step 2: Palm up with finger tips spreadStep 2: Palm up with finger tips spread

In HoloLens 2, we replaced the Bloom gesture with a virtual wrist icon, which is more instinctual for users. By

showing users the icon on the wrist, they can intuitively reach out and press it with their other hand.

Step 1: Palm up to show the wrist iconStep 1: Palm up to show the wrist icon



 One-handed Start gesture

IMPORTANTIMPORTANT

Step 2: Press the wrist iconStep 2: Press the wrist icon

For the one-handed Start gesture to work:

1. You must update to the November 2019 update (build 18363.1039) or later.

2. Your eyes must be calibrated on the device so that eye tracking functions correctly. If you do not see orbiting dots

around the Start icon when you look at it, your eyes are not calibrated on the device.

You can also use the Start gesture with only one hand. Hold out your hand with your palm facing you and look

at the Star t iconStar t icon on your inner wrist. While keeping your eye on the iconWhile keeping your eye on the icon, pinch your thumb and index

finger together.



 See also

Step 1: Palm up to show the wrist iconStep 1: Palm up to show the wrist icon

Step 2: Eye gaze at the icon then pinchStep 2: Eye gaze at the icon then pinch

Instinctual interactions

Eye-gaze

Voice input



   

 

Introducing instinctual interactions
 7/6/2022 • 7 minutes to read • Edit Online

 Basic hand tracking and instinctual interactions demo

The philosophy of simple, instinctual interactions is interwoven throughout the mixed reality (MR) platform.

We've taken three steps to ensure that application designers and developers can provide their customers with

easy and intuitive interactions.

First, we've made sure our sensors and input technologies combine into multimodal interaction models. These

interaction models include hand and eye tracking along with natural language input. Based on our research,

designing and developing within a multimodal framework (and not based on individual inputs) is the key to

creating instinctual experiences.

Second, we recognize that many developers target multiple HoloLens devices, such as HoloLens 2 and HoloLens

(1st gen) or HoloLens and VR. So we've designed our interaction models to work across devices, even if the

input technology varies on each device. For example, far interaction on a Windows Immersive headset with a

6DoF controller and HoloLens 2 both use identical affordances and patterns. This makes it easy for cross-device

application development and provides a natural feel to user interactions.

While we recognize that there are thousands of effective, engaging, and magical interactions possible in MR,

we've found that intentionally employing a single interaction model in an application is the best way to ensure

users are successful and have a great experience. To that end, we've included three things in this interaction

guidance:

Specific guidance around the three primary interaction models and the components and patterns required

for each.

Supplemental guidance about other benefits that our platform provides.

General guidance to help select the appropriate interaction model for your development scenario.

Check out our Designing Holograms - Head Tracking and Eye TrackingDesigning Holograms - Head Tracking and Eye Tracking video demo below, then move on

to more specific topics:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/interaction-fundamentals.md


 Multimodal interaction models

ModelModel Example scenariosExample scenarios FitFit HardwareHardware

Hands and motion
controllers

3D spatial experiences, such
as spatial layout and design,
content manipulation, or
simulation.

Great for new users coupled
with voice, eye tracking or
head gaze. Low learning
curve. Consistent UX across
hand tracking and 6DoF
controllers.

HoloLens 2
Immersive headsets

Hands-free Contextual experiences
where a user's hands are
occupied, such as on-the-
job learning and
maintenance.

Some learning required. If
hands are unavailable, the
device pairs well with voice
and natural language.

HoloLens 2
HoloLens (1st gen)
Immersive headsets

Gaze and commit Click-through experiences,
for example, 3D
presentations, demos.

Requires training on HMDs
but not on mobile. Best for
accessible controllers. Best
for HoloLens (1st gen).

HoloLens 2
HoloLens (1st gen)
Immersive headsets
Mobile AR

  By the end of this page, you'll understand our guidance on:By the end of this page, you'll understand our guidance on:

 Choose an interaction model for your customer

  Why follow this guidance?Why follow this guidance?

This video was taken from the "Designing Holograms" HoloLens 2 app. Download and enjoy the full experience

here.

Based on our research and feedback from customers, we've discovered that three primary interaction models

suit most mixed reality experiences. In many ways, the interaction model is the user's mental model for how to

complete a workflow. Each of these interaction models is optimized for a set of customer needs and is

convenient, powerful, and usable when used correctly.

The chart below is a simplified overview. Detailed information for using each interaction model is linked in the

pages below with images and code samples.

To avoid gaps in the user interaction experience, it's best to follow the guidance for a single model from

beginning to end.

The sections below walk through the steps for selecting and implementing one of these interaction models.

Choosing an interaction model for your customer

Implementing the interaction model

Transitioning between interaction models

Design next steps

Typically, developers and creators have thought through the types of interactions that their customers can have.

To encourage a customer-focused approach to design, we recommend the following guidance for selecting the

interaction model that's optimized for your customer.

https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Microsofts-Designing-Holograms-Hand-Tracking-Chapter/player
https://aka.ms/dhapp


ModelModel How do I know it'sHow do I know it's
working?working?

How do I know what IHow do I know what I
can do?can do?

How do I know what IHow do I know what I
just did?just did?

Hands and motion
controllers

I see a hand mesh, a
fingertip affordance, or
hand/controller rays.

I see grabbable handles, or
a bounding box appears
when my hand is near an
object.

I hear audible tones and see
animations on grab and
release.

Head-gaze and commit I see a cursor in the center
of my field of view.

The cursor changes state
when it's over certain
objects.

I see/hear visual and
audible confirmations when
I take action.

Hands-free (Head-gaze and
dwell)

I see a cursor in the center
of my field of view.

I see a progress indicator
when I dwell on an
interactable object.

I see/hear visual and
audible confirmations when
I take action.

Hands-free (Voice
commanding)

I see a listening indicator
and captions that show
what the system heard.

I get voice prompts and
hints. When I say: "What
can I say?" I see feedback.

I see/hear visual and
audible confirmations when
I give a command, or get
disambiguation UX when
needed.

  Below are questions that we've found help teams select an interaction model:Below are questions that we've found help teams select an interaction model:

We test our interaction models for objective and subjective criteria, including physical and cognitive effort,

intuitiveness, and learnability.

Because interactions differ, visual/audio affordances and object behavior might differ between interaction

models.

Combining parts of multiple interaction models creates the risk of competing affordances, such as

simultaneous hand rays and a head-gaze cursor. This can overwhelm and confuse users.

Here are some examples of how affordances and behaviors are optimized for each interaction model. We often

see new users have similar questions, such as "how do I know the system is working", "how do I know what I

can do", and "how do I know if it understood what I just did?"

1. Q: Do my users want to touch holograms and perform precision holographic manipulations?

A: If so, check out the Hands and motion controllers interaction model for precision targeting and

manipulation.

2. Q: Do my users need to keep their hands free for real-world tasks?

A: If so, take a look at the Hands-free interaction model, which provides a great hands-free experience

through gaze and voice-based interactions.

3. Q: Do my users have time to learn interactions for my MR application or do they need the interactions

with the lowest learning curve possible?

A: For the lowest learning curve and most intuitive interactions, we recommend the Hands and motion

controllers model, as long as users can use their hands for interaction.

4. Q: Do my users use motion controllers for pointing and manipulation?

A: The Hands and motion controllers model includes all guidance for a great experience with motion

controllers.



NOTENOTE

 Transitioning interaction models

NOTENOTE

 See also

5. Q: Do my users use an accessibility controller or a common Bluetooth controller, such as a clicker?

A: We recommend the Head-gaze and commit model for all non-tracked controllers. It's designed to

allow a user to traverse an entire experience with a simple "target and commit" mechanism.

6. Q: Do my users only progress through an experience by "clicking through" (for example in a 3D

slideshow-like environment), as opposed to navigating dense layouts of UI controls?

A: If users don't need to control a lot of UI, Head-gaze and commit offers a learnable option where users

don't have to worry about targeting.

7. Q: Do my users use both HoloLens (1st gen) and HoloLens 2/Windows Mixed Reality immersive headsets

(VR)?

A: Since Head-gaze and commit are the interaction model for HoloLens (1st gen), we recommend that

creators who support HoloLens (1st gen) use Head-gaze and commit for any features or modes that

users will experience on a HoloLens (1st gen) headset. See the next section on Transitioning interaction

models for details on making a great experience for multiple HoloLens generations.

8. Q: What about users who are mobile, covering a large space or moving between spaces, versus users

who tend to work in a single space?

A: Any of the interaction models will work for these users.

More guidance specific to app design coming soon.

There are also use cases that might require using more than one interaction model. For example, your

application's creation flow uses the "hands and motion controllers" interaction model, but you want to employ a

hands-free mode for field technicians. If your experience does require multiple interaction models, users might

have difficulty transitioning from one model to another, especially when they're new to mixed reality.

We're constantly working on more guidance that will be available to developers and designers, informing them about the

how, when, and why for using multiple MR interaction models.

Comfort

Eye-based interaction

Eye tracking on HoloLens 2

Gaze and commit

Gaze and dwell

Hands - Direct manipulation

Hands - Gestures

Hands - Point and commit

Instinctual interactions

Motion controllers

https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/news


Spatial mapping

Spatial sound design

Voice input
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 Device support

Input modelInput model HoloLens (1st gen)HoloLens (1st gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Direct manipulation with hands ❌ Not supported ✔️ Recommended ➕ Supported. For UI,
we recommend point
and commit with hands
instead.

 Basic hand tracking and instinctual interactions demo

Direct manipulation is an input model that involves touching holograms directly with your hands. The idea

behind this concept is that objects behave just as they would in the real world. Buttons can be activated simply

by pressing them, objects can be picked up by grabbing them, and 2D content behaves like a virtual

touchscreen. Direct manipulation is affordance-based, meaning it's user-friendly. There are no symbolic gestures

to teach users. All interactions are built around a visual element that you can touch or grab. It's considered a

"near" input model in that it's best used for interacting with content within arms reach.

Direct manipulation is a primary input model on HoloLens 2, which uses the new articulated hand-tracking

system. The input model is also available on immersive headsets by using motion controllers, but isn't

recommended as a primary means of interaction outside of object manipulation. Direct manipulation isn't

available on HoloLens (1st gen).

If you'd like to see Head and Eye Tracking design concepts in action, check out our Designing Holograms -Designing Holograms -

Head Tracking and Eye TrackingHead Tracking and Eye Tracking video demo below. When you've finished, continue on for a more detailed

dive into specific topics.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/direct-manipulation.md
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/immersive-headset-hardware-details


 Collidable fingertip

This video was taken from the "Designing Holograms" HoloLens 2 app. Download and enjoy the full experience

here.

On HoloLens 2, the user's hands are recognized and interpreted as left and right-hand skeletal models. To

implement the idea of touching holograms directly with hands, ideally, five colliders could be attached to the five

fingertips of each hand skeletal model. However, because of the lack of tactile feedback, 10 collidable fingertips

can cause unexpected and unpredictable collisions with holograms.

We suggest only putting a collider on each index finger. The collidable index fingertips can still serve as active

touch points for diverse touch gestures involving other fingers. Touch gestures include One-finger press, One-

finger tap, Two-finger press, and Five-finger press, as shown below:

Collidable finger tipCollidable finger tip

One-finger pressOne-finger press

https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Microsofts-Designing-Holograms-Hand-Tracking-Chapter/player
https://aka.ms/dhapp


  Sphere colliderSphere collider

  Fingertip cursorFingertip cursor

One-finger tapOne-finger tap

Five-finger pressFive-finger press

Instead of using a random generic shape, we suggest you use a sphere collider. Then you can visually render it

to provide better cues for near targeting. The sphere's diameter should match the thickness of the index finger to

increase touch accuracy. It's easier to retrieve the variable of finger thickness by calling the hand API.

In addition to rendering a collidable sphere on the index fingertip, we've created an advanced fingertip cursor to

achieve a better near-targeting experience. It's a donut-shaped cursor attached to the index fingertip. According

to proximity, it dynamically reacts to a target for orientation and size as detailed below:

When an index finger moves toward a hologram, the cursor is always parallel to the hologram's surface and

gradually shrinks its size.

As soon as the finger touches the surface, the cursor shrinks into a dot and emits a touch event.

With interactive feedback, users can achieve high precision near-targeting tasks, such as triggering a hyperlink

or pressing a button as shown below.



Finger tip cursor farFinger tip cursor far

Finger tip cursor nearFinger tip cursor near

Finger tip cursor contactFinger tip cursor contact



 Bounding box with proximity shader
The hologram itself also requires the ability to provide both visual and audio feedback to compensate the lack of

tactile feedback. For that, we generate the concept of a bounding box with a proximity shader. A bounding box is

a minimum volumetric area that encloses a 3D object. The bounding box has an interactive rendering

mechanism called a proximity shader. The proximity shader behaves:

Hover (far)Hover (far)

When the index finger is within a range, a fingertip spotlight is cast on the surface of the bounding box.

Hover (near)Hover (near)

When the fingertip gets closer to the surface, the spotlight shrinks.

Contact beginsContact begins

As soon as the fingertip touches the surface, the entire bounding box changes color or generates visual effects

to reflect the touch state.



 Pressable button

Contact endsContact ends

A sound effect can also be activated to enhance the visual touch feedback.

With a collidable fingertip, users are now ready to interact with a fundamental holographic UI component, such

as a pressable button. A pressable button is a holographic button tailored for a direct finger press. Again,

because of the lack of tactile feedback, a pressable button equips a couple mechanisms to tackle tactile

feedback-related issues.

The first mechanism is a bounding box with a proximity shader, which is detailed in the previous section. It

gives users a better sense of proximity when they approach and make contact with a button.

The second mechanism is depression. Depression creates a sense of pressing down after a fingertip contacts

a button. The mechanism ensures that the button tightly moves with the fingertip along the depth axis. The

button can be triggered when it reaches a chosen depth (on press) or leaves the depth (on release) after

passing through it.

The sound effect should be added to enhance feedback when the button is triggered.

Finger is far  awayFinger is far  away



 2D slate interaction

  To interact with the slate contactTo interact with the slate contact

Finger approachesFinger approaches

Contact beginsContact begins

Press downPress down

A 2D slate is a holographic container used to host 2D app content, such as a web browser. The design concept

for interacting with a 2D slate via direct manipulation is the same as interacting with a physical touch screen.



TouchTouch

Use an index finger to press a hyperlink or a button.

ScrollScroll

Use an index finger to scroll a slate content up and down.

ZoomZoom



  For manipulating the 2D slate itselfFor manipulating the 2D slate itself

The user's two index fingers are used to zoom in and out of the slate content, according to the relative motion of

the fingers.

MoveMove

Move your hands toward corners and edges to reveal the closest manipulation affordances. Grab the Holobar at

the top of the 2D slate, which lets you move the whole slate.

ScaleScale

Grab the manipulation affordances and do uniform scaling through the corner affordances.



 3D object manipulation

  Affordance-based manipulationAffordance-based manipulation

ReflowReflow

Grab the manipulation affordances and do reflow via the edge affordances.

HoloLens 2 lets users enable their hands to direct and manipulate 3D holographic objects by applying a

bounding box to each 3D object. The bounding box provides better depth perception through its proximity

shader. With the bounding box, there are two design approaches for 3D object manipulation.

Affordance-base manipulation lets you manipulate the 3D object through a bounding box along with the

manipulation affordances around it.

MoveMove

As soon as a user's hand is close to a 3D object, the bounding box, and the nearest affordance are revealed.

Users can grab the bounding box to move the whole object.



  Non-affordance-based manipulationNon-affordance-based manipulation

 Instinctual gestures

RotateRotate

Users can grab the edge affordances to rotate.

ScaleScale

Users can grab the corner affordances to scale uniformly.

Non-affordance-based manipulation doesn't attach affordance to the bounding box. Users can only reveal the

bounding box, then directly interact with it. If the bounding box is grabbed with one hand, the translation and

rotation of the object are associated to motion and orientation of the hand. When the object is grabbed with two

hands, users can translate, scale, and rotate it according to relative motions of two hands.

Specific manipulation requires precision. We recommend that you use affordance-based manipulationaffordance-based manipulation

because it provides a high level of granularity. For flexible manipulation, we recommend you use non-non-

affordance manipulationaffordance manipulation as it allows for instant and playful experiences.

With HoloLens (1st gen), we taught users a couple of predefined gestures, such as bloom and air tap. For



HoloLens 2, we don't ask users to memorize any symbolic gestures. All required user gestures, where users

need to interact with holograms and content, are instinctual. The way to achieve instinctual gestures is to help

users perform gestures through the design of UI affordances.

For example, if we encourage the user to grab an object or a control point with a two finger pinch, the object or

the control point should be small. If we want the user to do a five finger grab, the object or the control point

should be relatively large. Similar to buttons, a tiny button would limit users to press it with a single finger. A

large button would encourage users to press it with their palms.

Small objectSmall object

Medium objectMedium object



 Symmetric design between hands and 6 DoF controllers

 Optimize with eye tracking

Large objectLarge object

You may have noticed that there are interaction parallels we can draw between hands in AR and motion

controllers in VR. Both inputs can be used to trigger direct manipulations in their respective environments. In

HoloLens 2, grabbing and dragging with hands at a close distance works much the same way as the grab button

does on WMR motion controllers. This provides users with interaction familiarity between the two platforms,

which might prove useful if you ever decide to port your application between platforms.

Direct manipulation can feel magical if it works as intended. But it can also become frustrating if you can’t move

your hand anywhere without unintentionally triggering a hologram. Eye tracking potentially helps to better

identify what the user ’s intent is.

WhenWhen: Reduce unintentionally triggering a manipulation response. Eye tracking allows for better

understanding what a user is currently engaged with. For example, imagine you're reading through a

holographic (instructional) text when reaching over to grab you real-world work tool.

By doing so, you accidentally move your hand across some interactive holographic buttons that you hadn't even

noticed before. For example, it may be outside the user's field-of-view (FoV).

If the user hasn't looked at a hologram for a while, yet a touch or grasp event has been detected for it, the

interaction is likely unintentional.

Which oneWhich one: Aside from addressing false positive activations, another example includes better identifying

which holograms to grab or poke as the precise intersection point may not be clear from your

perspective, especially if several holograms are positioned close to each other.

While eye tracking on HoloLens 2 has limitations based on how accurately it can determine your eye

gaze, this can still be helpful for near interactions because of depth disparity when interacting with hand

input. This means it's sometimes difficult to determine whether your hand is behind or in front of a

hologram to precisely grab a manipulation widget, for example.



 Manipulation in MRTK (Mixed Reality Toolkit) for Unity

 See also

Where toWhere to: Use information about what a user is looking at with quick-throwing gestures. Grab a

hologram and roughly toss it toward your intended destination.

While this sometimes works, quickly doing hand gestures may result in highly inaccurate destinations.

However, eye tracking could improve the accuracy of the gesture.

With MRTKMRTK, you can easily achieve common manipulation behavior using the script ObjectManipulatorObjectManipulator . With

ObjectManipulator, you can grab and move objects directly with hands or with hand ray. It also supports two-

handed manipulation for scaling and rotating an object.

MRTK - Manipulation

Head-gaze and commit

Point and commit with hands

Instinctual interactions

https://github.com/Microsoft/MixedRealityToolkit-Unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/object-manipulator
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 Scenarios

 Hands and motion controllers modalities

  Direct manipulation with handsDirect manipulation with hands

After reading the interaction overview, you choose the hand and motion controller interaction model. This

means you're developing an application requiring users to use two hands to interact with the holographic world.

Your application is going to achieve the goal of removing the boundary between virtual and physical.

Some specific scenarios might be:

Providing information workers 2D virtual screens with UI affordances to display and control content

Providing first line workers tutorials and guides for factory assembly lines

Developing professional tools for assisting and educating medical professionals

Using 3D virtual objects to decorate the real world or to create a second world

Creating location-based services and games using the real world as a background

Modality applying the power of hands that users can use to touch and manipulate holograms. By using daily life

experiences and providing proper visual affordances, users can use the same way of manipulating real world

objects to interact with virtual ones.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/hands-and-tools.md


  Point and commit with handsPoint and commit with hands

  Motion controllersMotion controllers

 See also

This modality empowers users to interact with holograms in a distance. It enables users to make the best use of

surroundings. Users can place holograms anywhere and still access them from any distance. The mental models

and gestures for controlling and manipulating 2D and 3D holograms are highly in sync with those of direct

manipulation.

Motion controllers extend the user's physical capabilities with precise interactions across a range of distances

while using one or both hands. These hardware accessories provide shortcuts to many commonly used

interactions and provide sure-footed, tactile feedback for various actions. Currently, motion controllers are only

available for Windows Mixed Reality (WMR) scenarios.

Head-gaze and commit

Head-gaze and dwell

Direct manipulation with hands

Point and commit with hands



Hands-free
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 Device support

FeatureFeature HoloLens (1st gen)HoloLens (1st gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Motion controllers ❌ ❌ ✔️

 Hardware details
https://www.youtube.com/embed/1nlcdDNOdm8

Motion controllers are hardware accessories that allow users to take action in mixed reality. An advantage of

motion controllers over gestures is that the controllers have a precise position in space, allowing for fine grained

interaction with digital objects. For Windows Mixed Reality immersive headsets, motion controllers are the

primary way that users will take action in their world.

Image: A Windows Mixed Reality motion controller

Windows Mixed Reality motion controllers offer precise and responsive movement tracking in your field of view

using the sensors in the immersive headset. There's no need to install hardware on the walls in your space.

These motion controllers will offer the same ease of setup and portability as Windows Mixed Reality immersive

headsets. Our device partners plan to market and sell these controllers on retail shelves this holiday.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/motion-controllers.md
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://www.youtube.com/embed/1nlcdDNOdm8


 Setup
  Before you beginBefore you begin

  Pairing controllersPairing controllers

Get to know your controller

Features:Features:

Optical tracking

Trigger

Grab button

Thumbstick

Touchpad

You'll need:You'll need:

A set of two motion controllers.

Four AA batteries.

A PC with Bluetooth 4.0 support.

Check for Windows, Unity, and driver updatesCheck for Windows, Unity, and driver updates

Visit Install the tools for the preferred versions of Windows, Unity, and so on, for mixed reality development.

Make sure you have the most up-to-date headset and motion controller drivers.

Motion controllers can be bonded with host PC using Windows settings like any other Bluetooth device.

1. Insert two AA batteries into the back of the controller. Leave the battery cover off for now.

2. If you're using an external USB Bluetooth Adapter instead of a built-in Bluetooth radio, review the Bluetooth

best practices before proceeding. For desktop configuration with built-in radio, ensure antenna is connected.

3. Open Windows SettingsWindows Settings  -> DevicesDevices  -> Add Bluetooth or other deviceAdd Bluetooth or other device -> BluetoothBluetooth and remove any

earlier instances of “Motion controller – Right” and “Motion controller – Left”. Check also Other devices

category at the bottom of the list.

4. Select Add Bluetooth or other deviceAdd Bluetooth or other device and see it starting to discover Bluetooth devices.

5. Press and hold the controller's Windows button to turn on the controller, release once it buzzes.

6. Press and hold the pairing button (tab in the battery compartment) until the LEDs begin pulsing.

https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/mixed-reality-software
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/troubleshooting-windows-mixed-reality#bluetooth-best-practices


  Updating controller firmwareUpdating controller firmware

7. Wait "Motion controller - Left" or "Motion controller - Right" to appear to the bottom of the list. Select to pair.

Controller will vibrate once when connected.

Image: Select "Motion controller" to pair ; if there are multiple instances, select one from the bottom of the list

8. You'll see the controller appear in the Bluetooth settings under “Mouse, keyboard, & pen” categor y“Mouse, keyboard, & pen” categor y  as

ConnectedConnected. At this point, you may get a firmware update – see next section.

9. Reattach battery cover.

10. Repeat steps 1-9 for the second controller.

After successfully pairing both controllers, your settings should look like the following, under “Mouse,“Mouse,

keyboard, & pen” categor ykeyboard, & pen” categor y  

Image: Motion controllers connected

If the controllers are turned off after pairing, their status will show up as Paired. For controllers permanently

under the “Other devices” category, pairing may have only partially completed. In this case, run the pairing steps

again to get controller functional.

If an immersive headset is connected to your PC with new controller firmware is available, the firmware will

be pushed to your motion controllers automatically the next time you turn them on. Controller firmware

updates are indicated by a pattern of illuminating LED quadrants in a circular motion, and take 1-2 minutes.

After the firmware update completes, the controllers will reboot and reconnect. Both controllers should be

connected now. 

Image: Controllers connected in Bluetooth settings



 Gazing and pointing

  Managing recoil when pointingManaging recoil when pointing

 Grip pose vs. pointing pose

  Grip poseGrip pose

Verify your controllers work properly:

1. Launch Mixed Reality Por talMixed Reality Por tal  and enter your Mixed Reality Home.

2. Move your controllers and verify tracking, test buttons, and verify teleportation works. If they don't,

then check out motion controller troubleshooting.

Windows Mixed Reality supports two key models for interaction; gaze and commitgaze and commit and point and commitpoint and commit:

With gaze and commitgaze and commit, users target an object with their gaze, and then select objects with hand air-taps, a

gamepad, a clicker, or their voice.

With point and commitpoint and commit, a user can aim a pointing-capable motion controller at the target object and then

select objects with the controller's trigger.

Apps that support pointing with motion controllers should also enable gaze-driven interactions where possible,

to give users a choice in what input devices they use.

When using motion controllers to point and commit, your users will use the controller to target and interact by

pulling its trigger. Users who pull the trigger vigorously may end up aiming the controller higher at the end of

their trigger pull than they'd intended.

To manage any such recoil that may occur when users pull the trigger, your app can snap its targeting ray when

the trigger's analog axis value rises above 0.0. You can then take action using that targeting ray a few frames

later once the trigger value reaches 1.0, as long as the final press occurs within a short time window. When

using the higher-level composite Tap gesture, Windows will manage this targeting ray capture and timeout for

you.

Windows Mixed Reality supports motion controllers in different form factors, with each controller's design

differing in its relationship between the user's hand position and the natural "forward" direction that apps

should use for pointing when rendering the controller.

To better represent these controllers, there are two kinds of poses you can investigate for each interaction

source; the gr ip posegrip pose and the pointer posepointer pose.

The gr ip posegrip pose represents the location of either the palm of a hand detected by a HoloLens, or the palm holding

a motion controller.

On immersive headsets, the grip pose is best used to render the user 's handthe user 's hand or an object held in the user 'san object held in the user 's

handhand, such as a sword or gun. The grip pose is also used when visualizing a motion controller, as the

renderable modelrenderable model  provided by Windows for a motion controller uses the grip pose as its origin and center of

rotation.

The grip pose is defined specifically as follows:

The gr ip positiongrip position: The palm centroid when holding the controller naturally, adjusted left or right to center

the position within the grip. On the Windows Mixed Reality motion controller, this position generally aligns

with the Grasp button.

https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/troubleshooting-windows-mixed-reality#motion-controllers


  Pointer posePointer pose

 Controller tracking state

https://www.youtube.com/embed/rkDpRllbLII

  Reasoning about tracking state explicitlyReasoning about tracking state explicitly

T RA C K IN G STAT ET RA C K IN G STAT E SO URC ELO SSRISKSO URC ELO SSRISK P O SIT IO N A C C URA C YP O SIT IO N A C C URA C Y T RY GET P O SIT IO NT RY GET P O SIT IO N

High accuracyHigh accuracy < 1.0 High true

High accuracy (at risk ofHigh accuracy (at risk of
losing)losing)

== 1.0 High true

Approximate accuracyApproximate accuracy == 1.0 Approximate true

No positionNo position == 1.0 Approximate false

The gr ip or ientation's Right axisgr ip or ientation's Right axis : When you completely open your hand to form a flat five-finger pose,

the ray that is normal to your palm (forward from left palm, backward from right palm)

The gr ip or ientation's For ward axisgr ip or ientation's For ward axis : When you close your hand partially (as if holding the controller), the

ray that points "forward" through the tube formed by your non-thumb fingers.

The gr ip or ientation's Up axisgr ip or ientation's Up axis : The Up axis implied by the Right and Forward definitions.

The pointer posepointer pose represents the tip of the controller pointing forward.

The system-provided pointer pose is best used to raycast when you're rendering the controller  model itselfrendering the controller  model itself .

If you're rendering some other virtual object in place of the controller, such as a virtual gun, you should point

with a ray that is most natural for that virtual object, such as a ray that travels along the barrel of the app-

defined gun model. Because users can see the virtual object and not the physical controller, pointing with the

virtual object will likely be more natural for those using your app.

Like the headsets, the Windows Mixed Reality motion controller requires no setup of external tracking sensors.

Instead, the controllers are tracked by sensors in the headset itself.

If the user moves the controllers out of the headset's field of view, in most cases Windows will continue to infer

controller positions and provide them to the app. When the controller has lost visual tracking for long enough,

the controller's positions will drop to approximate-accuracy positions.

At this point, the system will body-lock the controller to the user, tracking the user's position as they move

around, while still exposing the controller's true orientation using its internal orientation sensors. Many apps

that use controllers to point at and activate UI elements can operate normally while in approximate accuracy

without the user noticing.

Apps that wish to treat positions differently based on tracking state may go further and inspect properties on

the controller's state, such as SourceLossRisk and PositionAccuracy:

These motion controller tracking states are defined as follows:

High accuracy:High accuracy: While the motion controller is within the headset's field of view, it will generally provide

high-accuracy positions, based on visual tracking. A moving controller that momentarily leaves the field of

view or is momentarily obscured from the headset sensors (for example, by the user's other hand) will

continue to return high-accuracy poses for a short time, based on inertial tracking of the controller itself.

High accuracy (at r isk of losing):High accuracy (at r isk of losing): When the user moves the motion controller past the edge of the

headset's field of view, the headset will soon be unable to visually track the controller's position. The app

https://www.youtube.com/embed/rkDpRllbLII


 Interactions: Low-level spatial input

 Composite gestures: High-level spatial input

knows when the controller has reached this FOV boundary by seeing the SourceLossRiskSourceLossRisk  reach 1.0. At that

point, the app may choose to pause controller gestures that require a steady stream of high quality poses.

Approximate accuracy:Approximate accuracy: When the controller has lost visual tracking for long enough, the controller's

positions will drop to approximate-accuracy positions. At this point, the system will body-lock the controller

to the user, tracking the user's position as they move around, while still exposing the controller's true

orientation using its internal orientation sensors. Many apps that use controllers to point at and activate UI

elements can operate as normal while in approximate accuracy without the user noticing. Apps with heavier

input requirements may choose to sense this drop from HighHigh accuracy to ApproximateApproximate accuracy by

inspecting the PositionAccuracyPositionAccuracy  property, for example to give the user a more generous hitbox on off-

screen targets during this time.

No position:No position: While the controller can operate at approximate accuracy for a long time, sometimes the

system knows that even a body-locked position isn't meaningful at the moment. For example, a controller

that was turned on may have never been observed visually, or a user may put down a controller that's then

picked up by someone else. At those times, the system won't provide any position to the app, and

Tr yGetPositionTr yGetPosition will return false.

The core interactions across hands and motion controllers are SelectSelect, MenuMenu, GraspGrasp, TouchpadTouchpad, ThumbstickThumbstick ,

and HomeHome.

SelectSelect is the primary interaction to activate a hologram, consisting of a press followed by a release. For

motion controllers, you perform a Select press using the controller's trigger. Other ways to perform a Select

are by speaking the voice command "Select". The same select interaction can be used within any app. Think

of Select as the equivalent of a mouse click; a universal action that you learn once and then apply across all

your apps.

MenuMenu is the secondary interaction for acting on an object, used to pull up a context menu or take some other

secondary action. With motion controllers, you can take a menu action using the controller's menu button.

(that is, the button with the hamburger "menu" icon on it)

GraspGrasp is how users can directly take action on objects at their hand to manipulate them. With motion

controllers, you can do a grasp action by squeezing your fist tightly. A motion controller may detect a Grasp

with a grab button, palm trigger, or other sensor.

TouchpadTouchpad allows the user to adjust an action in two dimensions along the surface of a motion controller's

touchpad, committing the action by clicking down on the touchpad. Touchpads provide a pressed state,

touched state, and normalized XY coordinates. X and Y range from -1 to 1 across the range of the circular

touchpad, with a center at (0, 0). For X, -1 is on the left and 1 is on the right. For Y, -1 is on the bottom and 1

is on the top.

ThumbstickThumbstick  allows the user to adjust an action in two dimensions by moving a motion controller's

thumbstick within its circular range, committing the action by clicking down on the thumbstick. Thumbsticks

also provide a pressed state and normalized XY coordinates. X and Y range from -1 to 1 across the range of

the circular touchpad, with a center at (0, 0). For X, -1 is on the left and 1 is on the right. For Y, -1 is on the

bottom and 1 is on the top.

HomeHome is a special system action that is used to go back to the Start Menu. It's similar to pressing the

Windows key on a keyboard or the Xbox button on an Xbox controller. You can go Home by pressing the

Windows button on a motion controller. Note, you can always return to Start by saying "Hey Cortana, Go

Home". Apps can't react specifically to Home actions, as these are handled by the system.

Both hand gestures and motion controllers can be tracked over time to detect a common set of high-level

composite gesturescomposite gestures . This enables your app to detect high-level taptap, holdhold, manipulationmanipulation and navigationnavigation

gestures, whether users end up using hands or controllers.



 Rendering the motion controller model

 FAQ
  Can I pair motion controllers to multiple PCs?Can I pair motion controllers to multiple PCs?

  How do I update motion controller firmware?How do I update motion controller firmware?

  How I can check battery level?How I can check battery level?

  

3D controller  models3D controller  models  Windows makes available to apps a renderable model of each motion controller

currently active in the system. By having your app dynamically load and articulate these system-provided

controller models at runtime, you can ensure your app is forward-compatible to any future controller designs.

We recommend rendering all renderable models at the gr ip posegrip pose of the controller, as the origin of the model is

aligned with this point in the physical world. If you're rendering controller models, you may then wish to raycast

into your scene from the pointer posepointer pose, which represents the ray along which users will naturally expect to

point, given that controller's physical design.

For more information about how to load controller models dynamically in Unity, see the Rendering the motion

controller model in Unity section.

2D controller  line ar t2D controller  line ar t While we recommend attaching in-app controller tips and commands to the in-app

controller models themselves, some developers may want to use 2D line art representations of the motion

controllers in flat "tutorial" or "how-to" UI. For those developers, we've made .png motion controller line art files

available in both black and white below (right-click to save).

Full-resolution motion controllers line art in '''white'''

Full-resolution motion controllers line art in '''black'''

Motion controllers support pairing with a single PC. Follow instructions on motion controller setup to pair your

controllers.

Motion controller firmware is part of the headset driver and will be updated automatically on connection, if

necessary. Firmware updates typically take 1-2 minutes depending on Bluetooth radio and link quality. In rare

cases, controller firmware updates may take up to 10 minutes, which can indicate poor Bluetooth connectivity or

radio interference. See Bluetooth best practices in the Enthusiast Guide to troubleshoot connectivity issues. After

a firmware update, controllers will reboot and reconnect to the host PC (you may notice the LEDs go bright for

tracking). If a firmware update is interrupted (for example, the controllers lose power), it will be attempted again

the next time the controllers are powered on.

In the Windows Mixed Reality home, you can turn your controller over to see its battery level on the reverse side

of the virtual model. There's no physical battery level indicator.

file:///C:/localrun/t/fs14/bgqa/windows/mixed-reality/design/images/motioncontrollers-white.png
file:///C:/localrun/t/fs14/bgqa/windows/mixed-reality/design/images/motioncontrollers-black.png
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/troubleshooting-windows-mixed-reality#bluetooth-best-practices


Can you use these controllers without a headset? Just for the joystick/trigger/etc input?Can you use these controllers without a headset? Just for the joystick/trigger/etc input?

 Troubleshooting

 Filing motion controller feedback/bugs

 See also

Not for Universal Windows Applications.

See motion controller troubleshooting in the Enthusiast Guide.

Give us feedback in Feedback Hub, using the "Mixed Reality -> Input" category.

Motion controllers in Unity

Hands and motion controllers in DirectX

Gestures

Enthusiast's Guide: Your Windows Mixed Reality home

Enthusiast's Guide: Using games & apps in Windows Mixed Reality

How inside-out tracking works

https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/troubleshooting-windows-mixed-reality#motion-controllers
https://docs.microsoft.com/en-us/hololens/hololens-feedback
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/your-mixed-reality-home
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/using-games-and-apps-in-windows-mixed-reality
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/tracking-system


   

 

Point and commit with hands
 7/6/2022 • 5 minutes to read • Edit Online

 Device support

Input modelInput model HoloLens (1st gen)HoloLens (1st gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Point and commit with hands ❌ Not supported ✔️ Recommended ✔️ Recommended

 Hand rays

Point and commit with hands is an input model that lets users target, select, and manipulate out of reach 2D and

3D content. This "far" interaction technique is unique to mixed reality because humans don't naturally interact

with the real world that way. For example, in the super hero movie, X-Men, the character Magneto can

manipulate far objects in the distance with his hands. This isn't something humans can do in reality. In both

HoloLens (AR) and Mixed Reality (MR), we equip users with this magical power to break the physical constraint

of the real world. Not only is it a fun holographic experience, but it also makes user interactions more effective

and efficient.

"Point and commit with hands" is one of the new features that use the new articulated hand-tracking system.

This input model is also the primary input model on immersive headsets by using motion controllers.

On HoloLens 2, we created a hand ray that shoots out from the center of the user's palm. This ray is treated as

an extension of the hand. A donut-shaped cursor is attached to the end of the ray to indicate the location where

the ray intersects with a target object. The object that the cursor lands on can then receive gestural commands

from the hand.

This basic gestural command is triggered by using the thumb and index finger to do the air-tap action. By using

the hand ray to point and air tap to commit, users can activate a button or a hyperlink. With more composite

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/point-and-commit.md
https://en.wikipedia.org/wiki/Magneto_(comics)
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


 Transition between near and far

gestures, users can navigating web content and manipulating 3D objects from a distance. The visual design of

the hand ray should also react to these point and commit states, as described and shown below:

Pointing statePointing state

In the pointing state, the ray is a dash line and the cursor is a donut shape.

Commit stateCommit state

In the commit state, the ray turns into a solid line and the cursor shrinks to a dot.

Instead of using specific gestures like "pointing with index finger" to direct the ray, we designed the ray to

comout out from the center of the users' palm. This way, we've released and reserved the Five Fingers for more

manipulative gestures like pinch and grab. With this design, we create only one mental model - the same set of

hand gestures are used for both near and far interaction. You can use the same grab gesture to manipulate



 2D slate interaction

objects at different distances. The invocation of the rays is automatic and proximity-based as follows:

Near manipulationNear manipulation

When an object is within arm's length (roughly 50 cm), the rays are turned off automatically, encouraging near

interaction.

Far manipulationFar manipulation

When the object is farther than 50 cm, the rays are turned on. The transition should be smooth and seamless.

A 2D slate is a holographic container hosting 2D app contents, such as a web browser. The design concept for far

interacting with a 2D slate is to use hand rays to target and air tap to select. After targeting with a hand ray,

users can air tap to trigger a hyperlink or a button. They can use one hand to "air tap and drag" to scroll slate

content up and down. The relative motion of using two hands to air tap and drag can zoom in and out the slate



content.

Targeting the hand ray at the corners and edges reveals the closest manipulation affordance. By "grab and drag"

manipulation affordances, users can do uniform scaling through the corner affordances, and can reflow the slate

via the edge affordances. Grabbing and dragging the holobar at the top of the 2D slate lets users move the

entire slate.

ClickClick

ScrollScroll



 3D object manipulation

  Affordance-based manipulationAffordance-based manipulation

ZoomZoom

For manipulating the 2D slateFor manipulating the 2D slate

Users point the hand ray at the corners or edges to reveal the closest manipulation affordance.

By applying a manipulation gesture on the affordance, users can do uniform scaling through the corner

affordance, and can reflow the slate via the edge affordance.

By applying a manipulation gesture on the holobar at the top of the 2D slate, users can move the entire slate.

In direct manipulation, there are two ways for users to manipulate 3D objects: affordance-based manipulation

and non-affordance based manipulation. In the point and commit model, users can achieve exactly the same

tasks through the hand rays. No extra learning is needed.

Users use hand rays to point and reveal the bounding box and manipulation affordances. Users can apply the

manipulation gesture on the bounding box to move the whole object, on the edge affordances to rotate, and on

the corner affordances to scale uniformly. 



  Non-affordance-based manipulationNon-affordance-based manipulation

 Instinctual gestures

MoveMove

RotateRotate

ScaleScale

Users point with hand rays to reveal the bounding box then directly apply manipulation gestures on it. With one

hand, the translation and rotation of the object are associated to motion and orientation of the hand. With two

hands, users can translate, scale, and rotate it according to relative motions of two hands.

The concept of instinctual gestures for point and commit is similar to that for direct manipulation with hands.

The gestures users do on a 3D object are guided by the design of UI affordances. For example, a small control

point might motivate users to pinch with their thumb and index finger, while a user might want to use all Five

Fingers to grab a larger object.



Small objectSmall object

Medium objectMedium object

Large objectLarge object



 Symmetric design between hands and 6 DoF controller

 Hand ray in MRTK (Mixed Reality Toolkit) for Unity

The concept of point and commit for far interaction was created and defined for the Mixed Reality Portal (MRP).

In this scenario, a user wears an immersive headset and interacts with 3D objects via motion controllers. The

motion controllers shoot out rays for pointing and manipulating far objects. There are buttons on the controllers

for further committing different actions. We apply the interaction model of rays and attached them to both

hands. With this symmetric design, users who are familiar with MRP won't need to learn another interaction

model for far pointing and manipulation when they use HoloLens 2, and the other way around.

Controller  raysController  rays

Hand raysHand rays



 See also

By default, MRTK provides a hand ray prefab (DefaultControllerPointer.prefab) which has the same visual state as

the shell's system hand ray. It's assigned in MRTK's Input profile, under Pointers. In an immersive headset, the

same rays are used for the motion controllers.

MRTK - Pointer profile

MRTK - Input system

MRTK - Pointers

Direct manipulation with hands

Gaze and commit

Hands - Direct manipulation

Hands - Gestures

Instinctual interactions

https://github.com/microsoft/MixedRealityToolkit-Unity/tree/main/Assets/MixedRealityToolkit.SDK/Features/UX/Prefabs/Pointers
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/configuration/mixed-reality-configuration-guide#pointer-configuration
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/overview
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/pointers


   

 

Hands-free
 7/6/2022 • 3 minutes to read • Edit Online

 Scenarios

 Hands-free modalities
  Voice inputVoice input

  Gaze and dwellGaze and dwell

 Transitioning in and out of hands-free

  Assume the user is already in the mode that they want to switch toAssume the user is already in the mode that they want to switch to

As outlined in the interaction model overview, once you've identified your users and their goals, ask yourself

what environmental or situational challenges they might face as they work to accomplish their tasks. For

example, many users need to use their hands to accomplish their real-world goals, and they'll have difficulty

interacting with a hands-and-controllers based interface.

Some specific scenarios include:

Being guided through a task, while the user's hands are busy

Referencing materials while the user's hands are busy

Hand fatigue

Gloves that can't be tracked

Carrying something in their hands

Social awkwardness when using large hand gestures

Tight spaces

Using your voice to command and control an interface offers a convenient way to operate hands-free and to use

shortcuts to skip multiple steps if you want. With voice input, the user can read any button's name out loud to

activate it ("see it, say it") and converse with a digital agent who can accomplish tasks for you.

In some hands-free situations, using your voice isn't ideal or even possible. Loud factory environments, privacy,

or social norms can all be constraints. The gaze + dwell model allows the user to navigate an app without any

extra input aside from their eye or head gaze: The user simply keeps gazing (with their head or eyes) at the

target and lingers there for a moment to activate it. To learn more about the individual design considerations for

gaze + dwell, check out eye-gaze + dwell and head-gaze + dwell.

For these scenarios, freeing your hands from interacting with holograms for commanding and navigation can

range from being an absolute requirement to operating the application, end-to-end, to an added convenience

that the user can transition in and out of at any time.

If the application requires that it will always be used hands-free, whether by using dwell, custom voice

commands, or the single voice command, "select", then make sure to make the appropriate accommodations in

your UI.

If your target user needs to switch from hands to hands-free at their discretion, then it's important to take the

following principles into account.

For instance, if the user is on the factory floor, watching a video reference on her HoloLens, and decides to pick

up a wrench to start working, she most likely would start working in hands-free without having to put down the

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/hands-free.md


  Create redundant ways to switch modesCreate redundant ways to switch modes

  Add a dash of dramaAdd a dash of drama

 Usability checklist

 See also

wrench to press a button. She can invoke a voice session with a voice command, dwell on an already-visible UI

to begin dwell, or say the word "select".

The user can:

Switch to hands-free while hands-free

Switch to hands with your hands

Switch to the controller using a controller

While the first principle is about access, the second one is about availability. There shouldn't just be a single way

to transition in and out of a mode.

Some examples would be:

A button to begin voice interactions

A voice command to transition to, using head-gaze and dwell

A mode switch is a big deal. It's important that when these transitions happen that they be an explicit, even a

dramatic switch, to let the user know what happened.

Can the user do ever ything and anything hands-free, end-to-end?Can the user do ever ything and anything hands-free, end-to-end?

Every interactable should be accessible hands-free

Ensure that there's a replacement for all custom gestures, such as resizing, placing, swipes, taps, and so on.

Ensure that the user has confident control of UI presence, placement, and verbosity always

Getting UI out of the way

Addressing UI that is out of field of view (FOV)

How much I see, where, when

Are the mechanics of the interaction being taught and reinforced with the r ight affordances?Are the mechanics of the interaction being taught and reinforced with the r ight affordances?

Does the user understand ...

... What mode they are in?

... What they can do in this mode?

... What is the current state?

... How they can transition out?

Is the UI optimized for hands-free?Is the UI optimized for hands-free?

Example: Dwell affordances aren't built in to typical 2D patterns

Example: Voice targeting is better with object highlighting

Example: Voice interactions are better with captions that need to be turned on

Eye tracking on HoloLens 2

Gaze and commit

Gaze and dwell

Hands - Direct manipulation

Hands - Gestures



Hands - Point and commit

Instinctual interactions

Voice input



   

 

Voice input
 7/6/2022 • 12 minutes to read • Edit Online

 Voice and gaze

https://www.youtube.com/embed/eHMkOpNUtR8

 Device support

FeatureFeature HoloLens (1st gen)HoloLens (1st gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Voice input ✔️ ✔️ ✔️ (with microphone)

 The "select" command

Voice is one of the key forms of input on HoloLens. It allows you to directly command a hologram without

having to use hand gestures. Voice input can be a natural way to communicate your intent. Voice is especially

good at traversing complex interfaces, because it lets users cut through nested menus with one command.

Voice input is powered by the same engine that supports speech in all Universal Windows Apps. On HoloLens,

speech recognition will always function in the Windows display language configured in your device Settings.

When you're using voice commands, head or eye gaze is the typical targeting mechanism, whether with a cursor

to "select" or to channel your command to an application you're looking at. It may not even be required to show

any gaze cursor ("see it, say it"). Some voice commands don't require a target at all, such as "go to start" or "Hey

Cortana."

HoloLens (1st gen)HoloLens (1st gen)

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/voice-input.md
https://docs.microsoft.com/en-us/windows/uwp/design/input/speech-recognition
https://www.youtube.com/embed/eHMkOpNUtR8
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


 Hey Cortana

Even without specifically adding voice support to your app, your users can activate holograms simply by saying

the system voice command "select". This behaves the same as an air tap on HoloLens, pressing the select button

on the HoloLens clicker, or pressing the trigger on a Windows Mixed Reality motion controller. You'll hear a

sound and see a tooltip with "select" appear as confirmation. "Select" is enabled by a low-power keyword

detection algorithm, which means you can say it anytime with minimal battery life impact. You can even say

"select" with your hands at your side.

HoloLens 2HoloLens 2

To use the "select" voice command in HoloLens 2, you first need to bring up the gaze cursor to use as a pointer.

The command to bring it up is easy to remember--just say, "select".

To exit the mode, use your hands again by air tapping, approaching a button with your fingers, or using the

system gesture.

Image: Say "select" to use the voice command for selection

You can say "Hey Cortana" to bring up Cortana at any time. You don't have to wait for her to appear to continue

asking her your question or giving her an instruction. For example, try saying "Hey Cortana, what's the

weather?" as a single sentence. For more information about Cortana and what you can do, ask her! Say "Hey

Cortana, what can I say?" and she'll pull up a list of working and suggested commands. If you're already in the

Cortana app, select the ?? icon on the sidebar to pull up this same menu.

HoloLens-specific commandsHoloLens-specific commands

"What can I say?"

"Go to Start" - instead of bloom to get to Start Menu

"Launch <app>"

"Move <app> here"

https://docs.microsoft.com/en-us/hololens/hololens1-clicker


 "See It, Say It"

"Take a picture"

"Start recording"

"Stop recording"

"Show hand ray"

"Hide hand ray"

"Increase the brightness"

"Decrease the brightness"

"Increase the volume"

"Decrease the volume"

"Mute" or "Unmute"

"Shut down the device"

"Restart the device"

"Go to sleep"

"What time is it?"

"How much battery do I have left?"

HoloLens has a "see it, say it" model for voice input, where labels on buttons tell users what voice commands

they can say as well. For example, when looking at an app window in HoloLens (1st gen), a user can say "Adjust"

command to adjust the position of the app in the world.

Image: A user can say the "Adjust" command, which they see in the App bar to adjust the position of the app

When apps follow this rule, users can easily understand what to say to control the system. While gazing at a

button in HoloLens (1st gen), you'll see a "voice dwell" tooltip that comes up after a second if the button is voice-

enabled and displays the command to speak to "press" it. To reveal voice tooltips in HoloLens 2, show the voice

cursor by saying "select" or "What can I say" (See image). 



 Voice commands for fast hologram manipulation

 Discovering voice commands

 Dictation

Image: "See it, say it" commands appear below the buttons

There are many voice commands you can say while gazing at a hologram to quickly do manipulation tasks.

These voice commands work on app windows and 3D objects you've placed in the world.

Hologram manipulation commandsHologram manipulation commands

Face me

Bigger | Enhance

Smaller

On HoloLens 2, you can also create more natural interactions in combination with eye-gaze, which implicitly

provides contextual information about what you are referring to. For example, you could look at a hologram and

say "put this" and then look over where you want to place it and say "over here". Or you could look at a

holographic part on a complex machine and say: "give me more information about this".

Some commands, like the commands for fast manipulation above, can be hidden. To learn about what

commands you can use, gaze at an object and say, "what can I say?". A list of possible commands pops up. You

can also use the head gaze cursor to look around and reveal the voice tooltips for each button in front of you.

If you want a complete list, just say, "Show all commands" anytime.

Rather than typing with air taps, voice dictation can be more efficient to enter text into an app. This can greatly

accelerate input with less effort for the user.



 Adding voice commands to your app

  Best practicesBest practices

  Advantages of voice inputAdvantages of voice input

Voice dictation starts by selecting the microphone button on the keyboard

Anytime the holographic keyboard is active, you can switch to dictation mode instead of typing. Select the

microphone on the side of the text input box to get started.

Consider adding voice commands to any experience that you build. Voice is a powerful way control the system

and apps. Because users speak with different kinds of dialects and accents, proper choice of speech keywords

will make sure your users' commands are interpreted unambiguously.

Below are some practices that will aid in smooth speech recognition.

Use concise commandsUse concise commands  - When possible, choose keywords of two or more syllables. One-syllable words

tend to use different vowel sounds when spoken by persons of different accents. Example: "Play video" is

better than "Play the currently selected video"

Use simple vocabular yUse simple vocabular y  - Example: "Show note" is better than "Show placard"

Make sure commands are non-destructiveMake sure commands are non-destructive - Make sure any speech command actions are non-

destructive and can easily be undone in case another person speaking near the user accidentally triggers a

command.

Avoid similar  sounding commandsAvoid similar  sounding commands  - Avoid registering multiple speech commands that sound similar.

Example: "Show more" and "Show store" can be similar sounding.

Unregister your app when not it usesUnregister your app when not it uses  - When your app isn't in a state in which a particular speech

command is valid, consider unregistering it so that other commands aren't confused for that one.

Test with different accentsTest with different accents  - Test your app with users of different accents.

Maintain voice command consistencyMaintain voice command consistency  - If "Go back" goes to the previous page, maintain this behavior in

your applications.

Avoid using system commandsAvoid using system commands  - The following voice commands are reserved for the system, so avoid

using them in your applications:

"Hey Cortana"

"Select"

"Go to start"

Voice input is a natural way to communicate our intents. Voice is especially good at interface traversalstraversals

because it can help users cut through multiple steps of an interface. A user might say "go back" while looking at

a webpage, instead of having to go up and hit the back button in the app. This small time saving has a powerful

emotional effectemotional effect on user ’s perception of the experience and gives them a small amount superpower. Using

voice is also a convenient input method when we have our arms full or are multi-taskingmulti-tasking. On devices where



  Challenges for voice inputChallenges for voice input

  Voice feedback statesVoice feedback states

typing on a keyboard is difficult, voice dictationvoice dictation can be an efficient alternative way to input text. Lastly, in some

cases when the range of accuracyrange of accuracy  for gaze and gesture are limited, voice can help to disambiguate the user's

intent.

How using voice can benefit the userHow using voice can benefit the user

Reduces time - it should make the end goal more efficient.

Minimizes effort - it should make tasks more fluid and effortless.

Reduces cognitive load - it's intuitive, easy to learn, and remember.

It's socially acceptable - it should fit in with societal norms of behavior.

It's routine - voice can readily become a habitual behavior.

While voice input is great for many different applications, it also faces several challenges. Understanding both

the advantages and challenges for voice input enables app developers to make smarter choices for how and

when to use voice input and to create a great experience for their users.

Voice input for continuous input controlVoice input for continuous input control  Fine-grained control is one of them. For example, a user might

want to change their volume in their music app. She can say "louder", but it's not clear how much louder the

system is supposed to make the volume. The user could say: "Make it a little louder", but "a little" is difficult to

quantify. Moving or scaling holograms with voice is similarly difficult.

Reliability of voice input detectionReliability of voice input detection While voice input systems become better and better, sometimes they

may incorrectly hear and interpret a voice command. The key is to address the challenge in your application.

Provide feedback to your users when the system is listening and what the system understood clarifies potential

issues understanding the users' speech.

Voice input in shared spacesVoice input in shared spaces  Voice may not be socially acceptable in spaces that you share with others. Here

are a few examples:

The user may not want to disturb others (for example, in a quiet library or shared office)

Users may feel awkward being seen talking to themselves in public,

A user may feel uncomfortable dictating a personal or confidential message (including passwords) while

others are listening

Voice input of unique or unknown wordsVoice input of unique or unknown words  Difficulties for voice input also come when users are dictating

words that may be unknown to the system, such as nicknames, certain slang words, or abbreviations.

Learning voice commandsLearning voice commands  While the ultimate goal is to naturally converse with your system, often apps still

rely on specific pre-defined voice commands. A challenge associated with a significant set of voice commands is

how to teach them without overloading the user and how to help the user to keep them.

When Voice is applied properly, the user understands what they can say and get clear feedbackwhat they can say and get clear feedback the system

heard them correctlyheard them correctly . These two signals make the user feel confident in using Voice as a primary input. Below

is a diagram showing what happens to the cursor when voice input is recognized and how it communicates that

to the user.



 Top things users should know about "speech" in mixed reality

1. Regular cursor state1. Regular cursor state

2. Communicates voice feedback and then disappears2. Communicates voice feedback and then disappears

3. Returns to regular cursor state3. Returns to regular cursor state

Say "Select""Select" while targeting a button (you can use this anywhere to select a button).

You can say the label name of an app bar buttonlabel name of an app bar button in some apps to take an action. For example, while

looking at an app, a user can say the command "Remove" to remove the app from the world (this saves time

from having to select it with your hand).



 Common questions and concerns users have about voice

 Communication

 Languages

 Troubleshooting

You can start Cortana listening by saying "Hey Cor tana.""Hey Cor tana." You can ask her questions ("Hey Cortana, how tall

is the Eiffel tower"), tell her to open an app ("Hey Cortana, open Netflix"), or tell her to bring up the Start

Menu ("Hey Cortana, take me home") and more.

What can I say?

How do I know the system heard me correctly?

It reacts the wrong way when I give it a voice command.

How do I target my voice to a specific app or app command?

Can I use voice to command things out the holographic frame on HoloLens?

The system keeps getting my voice commands wrong.

It doesn’t react when I give it a voice command.

For applications that want to take advantage of the customized audio input processing options provided by

HoloLens, it's important to understand the various audio stream categories your app can consume. Windows 10

supports several different stream categories and HoloLens makes use of three of these to enable custom

processing to optimize the microphone audio quality tailored for speech, communication, and other, which can

be used for ambient environment audio capture (that is, "camcorder") scenarios.

The AudioCategory_Communications stream category is customized for call quality and narration scenarios

and provides the client with a 16-kHz 24-bit mono audio stream of the user's voice

The AudioCategory_Speech stream category is customized for the HoloLens (Windows) speech engine and

provides it with a 16-kHz 24-bit mono stream of the user's voice. This category can be used by third-party

speech engines if needed.

The AudioCategory_Other stream category is customized for ambient environment audio recording and

provides the client with a 48-kHz 24-bit stereo audio stream.

All this audio processing is hardware accelerated which means the features drain a lot less power than if the

same processing was done on the HoloLens CPU. Avoid running other audio input processing on the CPU to

maximize system battery life and take advantage of the built-in, offloaded audio input processing.

HoloLens 2 supports multiple languages. Keep in mind that speech commands will always run in the system's

display language even if multiple keyboards are installed or if apps attempt to create a speech recognizer in a

different language.

If you're having any issues using "select" and "Hey Cortana", try moving to a quieter space, turning away from

the source of noise, or by speaking louder. At this time, all speech recognition on HoloLens is tuned and

optimized specifically to native speakers of United States English.

For the Windows Mixed Reality Developer Edition release 2017, the audio endpoint management logic will work

fine (forever) after logging out and back in to the PC desktop after the initial HMD connection. Before that first

sign out/in event after going through WMR OOBE, the user could experience various audio functionality issues

ranging from no audio to no audio switching depending on how the system was set up before connecting the

HMD for the first time.

https://docs.microsoft.com/en-us/windows/win32/api/audiosessiontypes/ne-audiosessiontypes-audio_stream_category
https://docs.microsoft.com/en-us/hololens/hololens2-language-support


 Voice input in MRTK (Mixed Reality Toolkit) for Unity

 See also

With MRTKMRTK, you can easily assign voice command on any objects. Use MRTK's Speech Input ProfileSpeech Input Profile to define

your keywords. By assigning SpeechInputHandlerSpeechInputHandler  script, you can make any object respond to the keywords

defined in the Speech Input Profile. SpeechInputHandler also provides speech confirmation label to improve the

user's confidence.

MRTK - Voice command

Gaze and commit

Instinctual interactions

Voice input in DirectX

Voice input in Unity

https://github.com/Microsoft/MixedRealityToolkit-Unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/speech
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  Device supportDevice support

FeatureFeature HoloLens (1st gen)HoloLens (1st gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Eye-gaze ❌ ✔️ ❌

 Head and eye tracking design concepts demo

 Calibration

HoloLens 2 allows for a new level of context and human understanding within the holographic experience by

providing developers with the ability to use information about what the user is looking at. This page explains

how developers can benefit from eye tracking for various use cases, and what to look for when designing eye-

gaze-based user interactions.

Eye tracking API has been designed with a user ’s privacy in mind, avoiding passing any identifiable information,

particularly any biometrics. For eye-tracking capable applications, the user needs to grant app permission to use

eye tracking information.

If you'd like to see Head and Eye Tracking design concepts in action, check out our Designing Holograms -Designing Holograms -

Head Tracking and Eye TrackingHead Tracking and Eye Tracking video demo below. When you've finished, continue on for a more detailed

dive into specific topics.

This video was taken from the "Designing Holograms" HoloLens 2 app. Download and enjoy the full experience

here.

For eye tracking to work accurately, each user is required to go through an eye tracking user calibration for

which the user has to look at a set of holographic targets. This allows the device to adjust the system for a more

comfortable and higher quality viewing experience for the user and to ensure accurate eye tracking at the same

time.

Eye tracking should work for most users, but there are rare cases in which a user can't calibrate successfully.

Calibration might fail for various reasons, including but not limited to:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/eye-tracking.md
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Microsofts-Designing-Holograms-Head-Tracking-and-Eye-Tracking-Chapter/player
https://aka.ms/dhapp
https://docs.microsoft.com/en-us/hololens/hololens-calibration


 Available eye tracking data

 Use cases

  User intentUser intent

The user previously opted out of the calibration process

The user got distracted and didn't follow the calibration targets

The user has certain types of contact lenses and glasses, which the system doesn't yet support

The user has certain eye physiology, eye conditions or had eye surgery, which the system doesn't yet support

External factors inhibiting reliable eye tracking such as smudges on the HoloLens visor or eyeglasses, intense

direct sunlight, and occlusions due to hair in front of the eyes

Developers should make sure to provide adequate support for users for whom eye tracking data may not be

available (who aren't able to calibrate successfully). We have provided recommendations for fallback solutions

in the section at the bottom of this page.

To learn more about the calibration and about how to ensure a smooth experience, check our eye tracking user

calibration page.

Before going into detail about specific use cases for eye-gaze input, we want to briefly point out the capabilities

that the HoloLens 2 Eye Tracking API provides. Developers get access to a single eye-gaze ray (gaze origin and

direction) at approximately 30 FPS (30 Hz). For more detailed information about how to access eye tracking

data, refer to our developer guides for using eye-gaze in DirectX and eye-gaze in Unity.

The predicted eye-gaze is approximately within 1.5 degrees in visual angle around the actual target (see the

illustration below). As slight imprecisions are expected, developers should plan for some margin around this

lower-bound value (for example, 2.0-3.0 degrees may result in a much more comfortable experience). We'll

discuss how to address the selection of small targets in more detail below. For eye tracking to work accurately,

each user is required to go through an eye tracking user calibration.

Optimal target size at a 2-meter distance

Eye tracking enables applications to track where the user is looking in real time. The following use cases

describe some interactions that are possible with eye tracking on HoloLens 2 in mixed reality. These use cases

aren't yet part of the Holographic Shell experience (that is, the interface that you see when you start up your

HoloLens 2). You can try some of them in the Mixed Reality Toolkit, which provides several interesting and

powerful examples for using eye tracking, such as quick and effortless eye-supported target selections, and

automatically scrolling through text based on what the user looks at.

Information about where and what a user looks at provides a powerful context for other inputscontext for other inputs , such as

https://docs.microsoft.com/en-us/hololens/hololens-calibration
https://docs.microsoft.com/en-us/uwp/api/windows.perception.people.eyespose
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/eye-tracking/eye-tracking-main
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/eye-tracking/eye-tracking-main


  Implicit actionsImplicit actions

  Attention trackingAttention tracking

voice, hands, and controllers. This can be used for various tasks. For example, this can range from quickly and

effortlessly targetingtargeting across the scene by looking at a hologram and saying "select" (also see gaze and commit)

or "put this...", then looking over to where the user wants to place the hologram and say "...there". Examples for

this can be found in Mixed Reality Toolkit - Eye-supported Target Selection and Mixed Reality Toolkit - Eye-

supported Target Positioning.

Additionally, an example for user intent might include using information about what users look at to enhance

engagement with embodied virtual agents and interactive holograms. For instance, virtual agents might adapt

available options and their behavior, based on currently viewed content.

The category of implicit actions closely relates to user intent. The idea is that holograms or user interface

elements react in an instinctual way that may not even feel like the user is interacting with the system at all, but

rather that the system and the user are in sync. One example is eye-gaze-based auto scrolleye-gaze-based auto scroll  where the user

can read a long text, which automatically starts scrolling once the user gets to the bottom of the textbox to keep

the user in the flow of reading, without lifting a finger.

A key aspect of this is that the scrolling speed adapts to the reading speed of the user. Another example is eye-eye-

suppor ted zoom and pansuppor ted zoom and pan where the user can feel like diving exactly toward what he or she's focused on.

Triggering and controlling zoom speed can be controlled by voice or hand input, which is important for

providing the user with the feeling of control while avoiding being overwhelmed. We'll talk about these design

considerations in more detail below. Once zoomed in, the user can smoothly follow, for example, the course of a

street to explore his or her neighborhood by using their eye-gaze. More information about these types of

interactions can be found on the Mixed Reality Toolkit - Eye-supported Navigation page.

Other use cases for implicit actions may include:

Smar t notifications:Smar t notifications: Ever get annoyed by notifications popping up right where you're looking? Taking into

account what a user is paying attention to, you can make this experience better by offsetting notifications

from where the user is currently gazing. This limits distractions and automatically dismisses them once the

user is finished reading.

Attentive holograms:Attentive holograms: Holograms that subtly react when being gazed upon. This can range from slightly

glowing UI elements, a slowly blooming flower to a virtual dog starting to look back at the user and wagging

its tail. This interaction might provide an interesting sense of connectivity and satisfaction in your application.

Information on where or what users look at can be an immensely powerful tool. It can help assess usability of

designs and identify problems in workflows to make them more efficient. Eye tracking visualization and

analytics are a common practice in various application areas. With HoloLens 2, we provide a new dimension to

this understanding as 3D holograms can be placed in real-world contexts and assessed accordingly. The Mixed

Reality Toolkit provides basic examples for logging and loading eye tracking data and how to visualize them.

Microsoft is dedicated to facilitating innovation while ensuring that users have an informed and transparent

experience with how their eye tracking information is used. We'll work with our developers and UX teams to

provide guidance for third parties to ensure that experiences are centered around the user.

Other applications in this area may include:

Remote eye-gaze visualization:Remote eye-gaze visualization: Remote eye-gaze visualizations: Visualize what remote collaborators are

looking at, to be able to provide immediate feedback and facilitate more accurate information processing.

User research studies:User research studies: Attention tracking can help researchers get more insights into how users perceive

and engage with the natural environment, without interfering, to design more instinctual human-computer-

interactions. Eye tracking can provide information that is not directly articulated by participants in the study,

which otherwise might be easily missed by the researcher.

Training and performance monitor ing:Training and performance monitor ing: Practice and optimize the execution of tasks by identifying

bottlenecks more effectively in the execution flow. Eye tracking can provide natural, real-time, and objective

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/eye-tracking/eye-tracking-target-selection
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/eye-tracking/eye-tracking-positioning
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/eye-tracking/eye-tracking-navigation
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/eye-tracking/eye-tracking-main


  Other use casesOther use cases

 Using eye-gaze for interaction

 Fallback solutions when eye tracking isn't available

information to help improve training, productivity, and safety in the workplace.

Design evaluations, marketing, and consumer research:Design evaluations, marketing, and consumer research: Eye tracking enables commercial companies

to perform marketing and consumer studies in real-world environments or analyze what captures a user ’s

attention to improve product or space design.

Gaming:Gaming: Ever wanted to have superpowers? Here's your chance! You can levitate holograms by staring

at them. Shoot laser beams from your eyes - try it out in RoboRaid for HoloLens 2. Turn enemies into

stone or freeze them. Use your x-ray vision to explore buildings. Your imagination is the limit! Beware of

not overwhelming the user though - to find out more, check out our eye-gaze-based input design

guidelines.

Expressive avatars:Expressive avatars: Eye tracking aids in more expressive 3D avatars by using live eye tracking data to

animate the avatar's eyes that indicate what the user is looking at.

Text entr y:Text entr y: Eye tracking can be used as an alternative for low-effort text entry, especially when speech or

hands are inconvenient to use.

Building an interaction that takes advantage of fast-moving eye targeting can be challenging. On the one hand,

the eyes move so fast that you need to be careful on how to use eye-gaze input, because otherwise users may

find the experience overwhelming or distracting. On the other hand, you can also create truly magical

experiences that will excite your users! To help you, check out our overview of key advantages, challenges, and

design recommendations for eye-gaze for interaction.

In rare cases, eye tracking data might not be available. This can be because of different reasons from which the

most common are listed below:

The system failed to calibrate the user.

The user skipped the calibration.

The user is calibrated, but decided to not give permission to your app to use their eye tracking data.

The user has unique eyeglasses or some eye condition that the system doesn't yet support.

External factors inhibiting reliable eye tracking such as smudges on the HoloLens visor or eyeglasses, intense

direct sunlight, and occlusions because of hair in front of the eyes.

Developers should ensure that there's appropriate fallback support for these users. On the Eye Tracking in

DirectX page, we explain the APIs required to detect whether eye tracking data is available.

While some users may have consciously decided to revoke, access to their eye tracking data and are ok with the

trade-off of an inferior user experience to the privacy of not providing access to their eye tracking data, in some

cases this may be unintentional. If your app uses eye tracking, and this is an important part of the experience,

we recommend clearly communicating this to the user.

Kindly informing the user why eye tracking is critical for your application (maybe even listing some enhanced

features) to experience the full potential of your application, can help the user to better understand what they're

giving up. Help the user identify why eye tracking may not be working (based on the above checks) and offer

some suggestions to quickly troubleshoot potential issues.

For example, if you can detect that the system supports eye tracking, the user is calibrated and has even given

their permission, yet no eye tracking data is received, then this may point to some other issues such as smudges

https://www.microsoft.com/p/roboraid/9nblggh5fv3j
https://docs.microsoft.com/en-us/hololens/hololens-calibration
https://docs.microsoft.com/en-us/hololens/hololens-calibration


  Fall back for apps using eye-gaze as a primary input pointerFall back for apps using eye-gaze as a primary input pointer

  Fall back for other eye-tracking-specific applicationsFall back for other eye-tracking-specific applications

 See also

or the eyes being occluded.

There are rare cases of users for whom eye tracking may not work. Hence, please be respectful of that by

allowing to dismiss or even disable reminders for enabling eye tracking in your app.

If your app uses eye-gaze as a pointer input to quickly select holograms across the scene, yet eye tracking data

is unavailable, we recommend falling back to head-gaze and start showing the head-gaze cursor. We

recommend using a timeout (for example, 500–1500 ms) to determine whether to switch or not. This action

prevents cursors from appearing every time the system may briefly lose tracking because of fast eye motions or

winks and blinks. If you're a Unity developer, the automatic fallback to head-gaze is already handled in the Mixed

Reality Toolkit. If you're a DirectX developer, you need to handle this switch yourself.

Your app may use eye-gaze in a unique way that is tailored specifically to the eyes. For example, animating an

avatar ’s eyes or for eye-based attention heatmaps relying on precise information about visual attention. In this

case, there's no clear fallback. If eye tracking isn't available, these capabilities may need to be disabled. Again, we

recommend to clearly communicate this to the user who may be unaware that the capability isn't working.

This page has hopefully provided you with a good overview to get you started understanding the role of eye

tracking and eye-gaze input for HoloLens 2. To get started developing, check out our information on the role of

eye-gaze for interacting with holograms, eye-gaze in Unity and eye-gaze in DirectX.

Calibration

Comfort

Eye-gaze-based interaction

Eye-gaze in DirectX

Eye-gaze in Unity (Mixed Reality Toolkit)

Gaze and commit

Voice input

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/eye-tracking/eye-tracking-main
https://docs.microsoft.com/en-us/hololens/hololens-calibration
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/eye-tracking/eye-tracking-main
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/voice-design
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 Device support

FeatureFeature HoloLens (1st gen)HoloLens (1st gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Eye-gaze ❌ ✔️ ❌

 Head and eye tracking design concepts demo

 Eye-gaze input design guidelines

  Benefits of eye-gaze inputBenefits of eye-gaze input

One of our exciting new capabilities on HoloLens 2 is eye tracking. On our Eye tracking on HoloLens 2 page, we

mentioned the need for each user to go through a Calibration, provided some developer guidance, and

highlighted use cases for eye tracking. Eye-gaze input is still a new type of user input and there's a lot to learn.

While eye-gaze input is only used subtly in our Holographic Shell experience (the user interface that you see

when you start your HoloLens 2), several apps, such as the "HoloLens Playground", showcase great examples on

how eye-gaze input can add to the magic of your holographic experience. On this page, we discuss design

considerations for integrating eye-gaze input to interact with your holographic applications.

You'll learn about key advantages and also unique challenges that come with eye-gaze input. Based on these, we

provide several design recommendations to help you create satisfying eye-gaze-supported user interfaces.

If you'd like to see Head and Eye Tracking design concepts in action, check out our Designing Holograms -Designing Holograms -

Head Tracking and Eye TrackingHead Tracking and Eye Tracking video demo below. When you've finished, continue on for a more detailed

dive into specific topics.

This video was taken from the "Designing Holograms" HoloLens 2 app. Download and enjoy the full experience

here.

Building an interaction that takes advantage of fast-moving eye targeting can be challenging. In this section, we

summarize the key advantages and challenges to consider when designing your application.

High speed pointing.High speed pointing. The eye muscle is the fastest reacting muscle in the human body.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/eye-gaze-interaction.md
https://docs.microsoft.com/en-us/hololens/hololens-calibration
https://www.microsoft.com/p/mr-playground/9nb31lh723s2
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Microsofts-Designing-Holograms-Head-Tracking-and-Eye-Tracking-Chapter/player
https://aka.ms/dhapp


  Challenges of eye-gaze as an inputChallenges of eye-gaze as an input

 Design recommendations

Low effor t.Low effor t. Barely any physical movements are necessary.

Implicitness.Implicitness. Often described by users as "mind reading", information about a user's eye movements

lets the system know which target the user plans to engage.

Alternative input channel.Alternative input channel. Eye-gaze can provide a powerful supporting input for hand and voice input

building on years of experience from users based on their hand-eye coordination.

Visual attention.Visual attention. Another important benefit is the possibility to infer what a user is paying attention to.

This can help in various application areas ranging from more effectively evaluating different designs to

aiding in smarter user interfaces and enhanced social cues for remote communication.

In a nutshell, using eye-gaze as an input offers a fast and effortless contextual input signal. This is powerful

when combined with other inputs such as voice and manual input to confirm the user's intent.

While eye-gaze can be used to create satisfying user experiences, which make you feel like a superhero, it's also

important to know what it isn't good at to appropriately account for this. The following list discusses some

challenges to consider and how to address them when working with eye-gaze input:

Your eye-gaze is "always on"Your eye-gaze is "always on" The moment you open your eye lids, your eyes start fixating on things in

the environment. Reacting to every look you make and accidentally issuing actions, because you looked

at something for too long, would result in an unsatisfying experience. We recommend combining eye-

gaze with a voice command, hand gesture, button click or extended dwell to trigger the selection of a

target (for more information, see eye-gaze and commit). This solution also allows for a mode in which the

user can freely look around without being overwhelmed by involuntarily triggering something. This issue

should also be considered when designing visual and auditory feedback when looking at a target. Try not

to overwhelm the user with immediate pop-out effects or hover sounds. Subtlety is key. We'll discuss

some best practices for this further below when talking about design recommendations.

Obser vation vs. controlObser vation vs. control  Imagine that you want to precisely straighten a photograph on your wall. You

look at its borders and its surroundings to see if it aligns well. Now imagine how you would do that when

you want to use your eye-gaze as an input to move the picture. Difficult, isn't it? This describes the double

role of eye-gaze when it's required both for input and control.

Leave before click :Leave before click : For quick target selections, research has shown that a user's eye-gaze can move on

before concluding a manual click (for example, an air tap). Pay special attention to synchronizing the fast

eye-gaze signal with slower control input (for example, voice, hands, controller).

Small targets:Small targets: Do you know the feeling when you try to read text that is just a bit too small to read

comfortably? This straining feeling on your eyes can cause you to feel tired and worn out, because you

try to readjust your eyes to focus better. This is a feeling you might invoke in your users when forcing

them to select targets that are too small in your application using eye targeting. For your design, to create

a pleasant and comfortable experience for your users, we recommend that targets should be at least 2° in

visual angle, preferably larger.

Ragged eye-gaze movementsRagged eye-gaze movements  Our eyes perform rapid movements from fixation to fixation. If you

look at scan paths of recorded eye movements, you can see that they look ragged. Your eyes move

quickly and in spontaneous jumps in comparison to head-gaze or hand motions.

Tracking reliability:Tracking reliability: Eye tracking accuracy may degrade a little in changing light as your eyes adjust to

the new conditions. While this shouldn't necessarily affect your application design, as the accuracy should

be within the 2° limitation, it may be necessary for the user to calibrate again.

The following is a list of specific design recommendations based on the described advantages and challenges



for eye-gaze input:

1. Eye-gaze isn't the same as Head-gaze:Eye-gaze isn't the same as Head-gaze:

Consider whether fast yet ragged eye movements fit your input task :Consider whether fast yet ragged eye movements fit your input task : While our fast and

ragged eye movements are great at quickly selecting targets across our field of view, it's less

applicable for tasks that require smooth input trajectories (for example, drawing or encircling

annotations). In this case, hand or head pointing should be preferred.

Avoid attaching something directly to the user ’s eye-gaze (for example, a slider orAvoid attaching something directly to the user ’s eye-gaze (for example, a slider or

cursor).cursor). With cursors, this may result in a "fleeing cursor" effect because of slight offsets in the

projected eye-gaze signal. With a slider, it can conflict with the double role of controlling the slider

with your eyes while also wanting to check whether the object is at the correct location. For the

example of the slider, it makes more sense to use eye-gaze in combination with hand gestures.

This means that the user could quickly and effortlessly switch among many sliders, raising up their

hand and pinching their thumb and index finger to grab and move it. When the pinch is released,

the slider stops moving. Users could become overwhelmed and distracted, especially if the signal

is imprecise for that user.

2. Combine eye-gaze with other inputs:Combine eye-gaze with other inputs: The integration of eye tracking with other inputs, such as hand

gestures, voice commands or button presses, provides several advantages:

Allow for free obser vation:Allow for free obser vation: Given that the main role of our eyes is to observe our environment,

it's important that users are allowed to look around without triggering any (visual, auditory, and so

on) feedback or actions. Combining eye tracking with another input control allows smooth

transitioning between eye tracking observation and input control modes.

Powerful context provider :Powerful context provider : Using information about where and what the user is looking at

while saying a voice command or using a hand gesture allows seamlessly channeling the input

across the field-of-view. For example: Say "put that there" to quickly and fluently select and

position a hologram across the scene by looking at a target and its intended destination.

Need for synchronizing multimodal inputs:Need for synchronizing multimodal inputs: Combining rapid eye movements with more

complex inputs, such as long voice commands or hand gestures, bears the risk that the user

already continues to look around before the extra input command is finished and recognized. If

you create your own input controls (for example, custom hand gestures), make sure to log the

onset of this input or approximate duration to correlate it with what a user had looked at in the

past.

3. Subtle feedback for eye tracking input:Subtle feedback for eye tracking input: It's useful to provide feedback when a target is looked at to

indicate that the system is working as intended but should be kept subtle. This can include slowly

blending in and out, visual highlights, or doing other subtle target behaviors, such as slow motions, such

as slightly increasing the target size. This indicates that the system correctly detected that the user is

looking at a target without unnecessarily interrupting the user ’s current workflow.

4. Avoid enforcing unnatural eye movements as input:Avoid enforcing unnatural eye movements as input: Don't force users to use specific eye

movements (gaze gestures) to trigger actions in your application.

5. Account for imprecisions:Account for imprecisions: We distinguish two types of imprecisions, which are noticeable to users:

offset and jitter. The easiest way to address an offset is to provide sufficiently large targets to interact

with. It's suggested that you use a visual angle greater than 2° as a reference. For instance, your

thumbnail is about 2° in visual angle when you stretch out your arm. This leads to the following guidance:

Don't force users to select tiny targets. Research has shown that if targets are sufficiently large and

system are designed well, users describe their interactions as effortless, and magical. If targets

become too small, users describe the experience as fatiguing and frustrating.



 See also

This page provided you with a good overview to get you started understanding eye-gaze as an input in mixed

reality. To get started developing, check out our information on eye-gaze in Unity and eye-gaze in DirectX.

Comfort

Eye-gaze in DirectX

Eye-gaze in Unity (Mixed Reality Toolkit)

Eye tracking on HoloLens 2

Gaze and commit

Gaze and dwell

Voice input

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/eye-tracking/eye-tracking-main
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/eye-tracking/eye-tracking-main
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/voice-design
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 Scenarios

 Device support

Input modelInput model HoloLens (1st gen)HoloLens (1st gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Head-gaze and dwell ✔️ Recommended ✔️ Recommended ✔️ Recommended

Eye-gaze and dwell ❌ Not available ✔️ Recommended ❌ Not available

 See also

When hands are occupied with tools and parts, gestures can be tedious or impossible. Voice commands may

also be unreliable in certain contexts, for example under excessively loud conditions. Gaze and dwell offers a

familiar and easy-to-master mechanism for working heads-up and hands-free on HoloLens. Additionally, gaze

and dwell is a great fallback, which is independent of noise interference or silence constraints in the operating

environment. We distinguish two variants of gaze and dwell: Head-gaze and dwell and Eye-gaze and dwell.

Gaze and dwell excels in scenarios where a person's hands are busy with other tasks, and voice isn't 100%

reliable or available because of environmental or social constraints. A good example is a person wearing a

HoloLens to overlay reference information while repairing a car engine. Their hands are busy with tools or

supporting their body as they lean into the engine compartment. The garage space is loud, with the constant

banging and buzzing of tools, making voice commands difficult. Gaze and dwell allows the person using the

HoloLens to confidently navigate their reference material without interrupting their workflow.

Eye-based interaction

Eye tracking on HoloLens 2

Gaze and commit

Hands - Direct manipulation

Hands - Gestures

Hands - Point and commit

Instinctual interactions

Voice input

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/gaze-and-dwell.md
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
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 Advantages of the "eye-gaze and dwell" interaction model

 Challenges of the "eye-gaze and dwell" interaction model

 Design recommendations

The "eye-gaze and dwell" interaction model is a special case of the eye-gaze and commit interaction model:

1. Look at a target and

2. To confirm your intention to select the target, use a secondary explicit input: Simply keep looking at the

target you would like to select.

When your hands are already occupied with a task or holding tools, using them for interacting with holograms

may not be an option. A hands-free interaction alternative for selecting holograms is "eye-gaze and dwell" or in

other words: "look and stare". With this approach, even severely constrained users who can't fully turn their

heads or bodies can interact with holograms (for example, in a highly confined work environment). The user

simply keeps looking at the target they would like to select and different dwell feedback is displayed to indicate

the process.

In general, we recommend to only use dwell-based activations as a last fall-back if neither voice input nor hand

input is available. The reason is that the choice of dwell time can be tricky. Novice users are ok with longer dwell

times, while expert users want to quickly and efficiently navigate through their experiences. This leads to the

challenge of how to adjust the dwell time to the specific needs of a user. If the dwell time is too short: The user

may feel overwhelmed by having holograms react to their eye-gaze all the time. If the dwell time is too long:

The experience may feel too slow and interruptive as the user has to keep looking at targets for a long time.

We recommend using a two-state approach for dwell feedback:

1. Onset delay: When the user starts looking at a target, nothing should immediately happen as this may result

in an unpleasant and overwhelming user experience. Instead start a timer to detect whether the user is

intentionally staring at the target or merely glancing over it. We recommend an onset time of 150-250 ms in

a given proximity (meaning the user is fixating vs. looking around on a large target).

2. Start dwell feedback: After ensuring that the user is intentionally looking at the target, start showing dwell

feedback to inform the user that the dwell activation is being initiated.

3. Continuous Feedback: While the user keeps looking at the target, show a continuous progress indicator so

that the user knows that they have to keep looking at the target. In particular for eye-gaze input, we

recommend pulling in the user's visual attention by starting out with a bigger circle or sphere that contracts

into a smaller version. Showing an indicator for the final state (small circle) helps to communicate to the user

when the dwell will be finished. An example illustration is shown below.

4. Finish: If the user kept fixating the target (for another 650-850 ms), complete the dwell activation and select

the looked-at target.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/gaze-and-dwell-eyes.md


 See also
Eye tracking

Eye-gaze and commit

Gaze and commit

Gaze and dwell

Voice input

https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/voice-design
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 Scenarios

 Device support

Input modelInput model HoloLens (1st gen)HoloLens (1st gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Head-gaze and dwell ✔️ Recommended ✔️ Recommended ✔️ Recommended

 Design principles

When hands are occupied with tools and parts, gestures can be tedious or impossible. Voice commands, like

gestures, can be unreliable in certain contexts, for example under excessively loud conditions. Additionally, using

voice to control computers isn't universally common, but it certainly is gaining steam! Head-gaze and dwell

offers the most familiar and easy-to-master mechanism for working heads-up and hands-free on HoloLens.

Additionally, head-gaze and dwell is 100% reliable independent of noise interference nor silence constraints in

the operating environment.

Head-gaze and dwell is great in scenarios where a person's hands are busy with other tasks. The feature is also

useful when voice isn't 100% reliable or available because of environmental or social constraints. A good

example is a person wearing a HoloLens to overlay reference information while repairing a car engine. Their

hands are busy with tools or supporting their body as they lean into the engine compartment. The garage space

is loud, with the constant banging and buzzing of tools, making voice commands difficult. Head-gaze and dwell

allows the person using the HoloLens to confidently navigate their reference material without interrupting their

workflow.

Avoid "Gaze as a weapon"Avoid "Gaze as a weapon"

Head-gaze and dwell requires visual feedback to be intuitive, but too much feedback can induce anxiety. The

feedback should help a user know what they're targeting, but not autoselect it against their intent. When reading

text, icons, and labels, you need to provide users time to absorb the information before selecting.

Seek Goldilocks speedSeek Goldilocks speed

Dwell interactions can have different timers based on impact of navigation - more frequently used functions will

generally benefit from faster fill times, while more consequential functions may benefit from longer fill times.

When using a fill-effect to show these timers, animation curves of the fill color can positively influence a feeling

of faster fill times. Consideration should be taken to enable user decision from fast/medium/slow fill speed

overrides.

Say no-no to yo-yo effectSay no-no to yo-yo effect

The yo-yo effect is an uncomfortable head movement pattern that happens when the content placement and

head-gaze/dwell controls forces people to look up and down repeatedly. For example, a list nav with the head-

gaze and dwell button at the bottom induces a loop of - look down to dwell, look up at results, look down to

dwell, and so on. The resulting pattern is uncomfortable, so we recommend placing navigation controls in a

centralized location that requires less back-and-forth. Placement of dwell buttons based on their effects

becomes important for comfort. s 

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/gaze-and-dwell-head.md
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


 UX Guidelines and best practices
  Target sizesTarget sizes

  Visual feedbackVisual feedback

  Progressive disclosureProgressive disclosure

  Oversized targetsOversized targets

  Prevent flickering with delayed feedbackPrevent flickering with delayed feedback

 UI patterns
  High frequency buttonsHigh frequency buttons

To be easily accessible, head-gaze and dwell targets need to be large enough to look at comfortably, and hold

one's head stable on the target for the prescribed time. We recommend a minimum target size of 2 degrees to

achieve the most comfortable experience.

When using a radial fill to represent the dwell timer, start from the center of button. A consistent response is less

confusing than all different directions on different buttons.

This rule can be broken though for directional interactions (for example, nav up/down/left/right, and so on).

For example, Microsoft Dynamics 365 Guides makes an exception on NEXT/BACK being left right fills.

Consider inverting radial fill from outside, for scenarios like toggling off a button. The inverse feeling of

pushing a button is a nice visual pattern to maintain.

Progressive disclosure means only showing as much detail as is relevant at each stage of an interaction. For

dwell, that means the dwell target is revealed on highlight (for example, in a list control).

Dwell region can be larger than inactive icon to make it easier to use, like the Back button in Microsoft Dynamics

365 Guides.

Use a short delay before starting visual feedback to avoid flickering when someone passes over a dwell target.

For buttons interacted with frequently, keep the delay short so the application feels reactive.

For buttons that are interacted with infrequently, a longer delay can be appropriate to avoid the interface

feeling twitchy.

High frequency buttons are buttons that are used commonly throughout an application. A good example of

these are the next and back buttons in Microsoft Dynamics 365 Guides.

RecommendationsRecommendations

High frequency buttons should be large, easier to hit with head-gaze

Stay near eye height to avoid ergonomic straining.

Image: Microsoft Dynamics 365 Guides next button



  Low frequency buttonsLow frequency buttons

  ConfirmationsConfirmations

Low frequency buttons are buttons that aren't interacted with as regularly throughout the application. A good

example might be a button to access the settings menu, or a button to clear all work.

Try to keep these buttons out of the way of frequent head-gaze paths to avoid accidental activation.

When an action has significant impact, like charging money, deleting work, or starting a long process, it's useful

to confirm that a person meant to select a button.

RecommendationsRecommendations

Show selection highlight on main button.

Reveal dwell target at same time as selection highlight.

For the secondary button, reveal the dwell target on head-gaze.

Image: Microsoft Dynamics 365 Guides confirmation dialog



  Toggle buttonsToggle buttons

  List viewsList views

Toggle buttons require some nuanced logic to work properly. When a person dwells on a toggle button and

activates it, they need to exit the button and then return to restart the dwell logic. It's important that togglable

buttons have a clear active versus inactive state.

List views present a particular challenge for head-gaze and dwell input. People can scan the content without

feeling like that have to tiptoe around the dwell targets.

RecommendationsRecommendations

Have the entire row highlight when head-gazed but doesn’t begin dwell unless head-gaze is on the specific

dwell target.

Only show the dwell target when the row is highlighted to cut down on visual noise.

Be clear and consistent with the position of dwell targets.

Don't show all dwell targets at once to avoid repetitive UI.

Reuse the same pattern as often as possible to establish UX familiarity.

Image: Microsoft Dynamics 365 Guides list



 See also
Gaze and commit

Hands - Direct manipulation

Hands - Gestures

Hands - Point and commit

Instinctual interactions

Voice input
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 Device support

Input modelInput model HoloLens (1st gen)HoloLens (1st gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Head-gaze and commit ✔️ Recommended ✔️ Recommended (third
choice - See the other
options)

➕ Alternate option

Eye-gaze and commit ❌ Not available ✔️ Recommended (third
choice - See the other
options)

❌ Not available

 Head and eye tracking design concepts demo

Gaze and commit is a fundamental input model that is closely related to the way we're interacting with our

computers using the mouse: Point & click. On this page, we introduce two types of gaze input (head- and eye-

gaze) and different types of commit actions. Gaze and commit is considered a far input model with indirect

manipulation. It's best used for interacting with holographic content that is out of reach.

Mixed reality headsets can use the position and orientation of the user's head to determine their head direction

vector. Think of gaze as a laser pointing straight ahead from directly between the user's eyes. This is a fairly

coarse approximation of where the user is looking. Your application can intersect this ray with virtual or real-

world objects, and draw a cursor at that location to let the user know what they're targeting.

In addition to head gaze, some mixed reality headsets, such as HoloLens 2, include eye tracking systems that

produce an eye-gaze vector. This provides a fine-grained measurement of where the user is looking. In both

cases, the gaze represents an important signal for the user's intent. The better the system can interpret and

predict the user's intended actions, the more user satisfaction and performance improves.

Below are a few examples for how you as a mixed reality developer can benefit from head- or eye-gaze:

Your app can intersect gaze with the holograms in your scene to determine where the user's attention is

(more precise with eye-gaze).

Your app can channel gestures and controller presses based on the user's gaze, which lets the user

seamlessly select, activate, grab, scroll, or otherwise interact with their holograms.

Your app can let the user place holograms on real-world surfaces by intersecting their gaze ray with the

spatial mapping mesh.

Your app can know when the user isn't looking in the direction of an important object, which can lead your

app to give visual and audio cues to turn towards that object.

If you'd like to see Head and Eye Tracking design concepts in action, check out our Designing Holograms -Designing Holograms -

Head Tracking and Eye TrackingHead Tracking and Eye Tracking video demo below. When you've finished, continue on for a more detailed

dive into specific topics.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/gaze-and-commit.md
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Microsofts-Designing-Holograms-Head-Tracking-and-Eye-Tracking-Chapter/player


 Gaze
  Eye- or head-gaze?Eye- or head-gaze?

Eye-gaze targetingEye-gaze targeting Head-gaze targetingHead-gaze targeting

Fast! Slower

Low effort (barely any body
movements necessary)

Can be fatiguing - Possible
discomfort (for example,
neck strain)

Doesn't require a cursor,
but subtle feedback is
recommended

Requires to show a cursor

No smooth eye movements
– for example, not good for
drawing

More controlled and explicit

Difficult for small targets
(for example, tiny buttons
or weblinks)

Reliable! Great fallback!

... ...

  CursorCursor

This video was taken from the "Designing Holograms" HoloLens 2 app. Download and enjoy the full experience

here.

There are several considerations when faced with the question whether you should use the "eye-gaze and

commit" or "head-gaze and commit" input model. If you're developing for an immersive headset or for

HoloLens (1st gen), then the choice is simple: Head-gaze and commit. If you're developing for HoloLens 2, the

choice becomes a little harder. It's important to understand the advantages and challenges that come with each

of them. We compiled some broad pro's and con's in the table below to contrast head- vs. eye-gaze targeting.

This is far from complete and we suggest learning more about eye-gaze targeting in mixed reality here:

Eye tracking on HoloLens 2: General introduction of our new eye tracking capability on HoloLens 2 including

some developer guidance.

Eye-gaze interaction: Design considerations and recommendations when planning to use eye tracking as an

input.

Whether you use head-gaze or eye-gaze for your gaze-and-commit input model, each comes with different sets

of design constraints. These are covered separately in the eye-gaze and commit and head-gaze and commit

articles.

For head gaze, most apps should use a cursor or other auditory/visual indication to give the user confidence in

what they're about to interact with. You typically position this cursor in the world where their head gaze ray first

intersects an object, which may be a hologram or a real-world surface.

For eye gaze, we generally recommend not to show a cursor, as this can quickly become distracting and

annoying for the user. Instead subtly highlight visual targets or use a faint eye cursor to provide confidence

about what the user is about to interact with. For more information, please check out our design guidance for

https://aka.ms/dhapp
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  Gaze and air tap gestureGaze and air tap gesture

eye-based input on HoloLens 2.

Image: An example visual cursor to show gaze

After talking about different ways to gaze at a target, let's talk a bit more about the commit part in gaze and

commit. After targeting an object or UI element, the user can interact or click on it using a secondary input. This

is known as the commit step of the input model.

The following commit methods are supported:

Air tap hand gesture (that is, raise your hand in front of you and bring together your index finger and thumb)

Say "select" or one of the targeted voice commands

Press a single button on a HoloLens Clicker

Press the 'A' button on an Xbox gamepad

Press the 'A' button on an Xbox adaptive controller

Air tap is a tapping gesture with the hand held upright. To use an air tap, raise your index finger to the ready

position, then pinch with your thumb, and raise your index finger back up to release. On HoloLens (1st gen), air

tap is the most common secondary input.

https://docs.microsoft.com/en-us/hololens/hololens1-clicker


  Gaze and "Select" voice commandGaze and "Select" voice command

Finger in the ready positionFinger in the ready position

Press finger down to tap or clickPress finger down to tap or click

Air tap is also available on HoloLens 2. It has been relaxed from the original version. Nearly all types of pinches

are now supported as long as the hand is upright and holding still. This makes it much easier for users to learn

and use the gesture. This new air tap replaces the old one through the same API, so existing applications will

have the new behavior automatically after recompiling for HoloLens 2.

Voice commanding is one of the primary interaction methods in mixed reality. It provides a powerful hands-free

mechanism to control the system. There are different types of voice interaction models:

The generic "Select" command that uses a click actuation or commit as a secondary input.



  Gaze and HoloLens ClickerGaze and HoloLens Clicker

  Gaze and Xbox Wireless ControllerGaze and Xbox Wireless Controller

Object commands (for example, "Close" or "Make it bigger") perform and commit to an action as a secondary

input.

Global commands (for example, "Go to start") don't require a target.

Conversation user interfaces or entities like Cortana have an AI natural language capability.

Custom voice commands

To find out more about details and a comprehensive list of available voice commands and how to use them,

check out our voice commanding guidance.

The HoloLens Clicker is the first peripheral device built specifically for HoloLens. It's included with HoloLens (1st

gen) Development Edition. The HoloLens Clicker lets a user click with minimal hand motion, and commit as a

secondary input. The HoloLens Clicker connects to HoloLens (1st gen) or HoloLens 2 using Bluetooth Low

Energy (BTLE).

More information and instructions to pair the device

Image: HoloLens Clicker

The Xbox Wireless Controller performs a click actuation as a secondary input by using the 'A' button. The device

is mapped to a default set of actions that help navigate and control the system. If you want to customize the

controller, use the Xbox Accessories application to configure your Xbox Wireless Controller.

How to pair an Xbox controller with your PC

Image: Xbox Wireless Controller

https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/voice-design


  Gaze and Xbox Adaptive ControllerGaze and Xbox Adaptive Controller
Designed primarily to meet the needs of gamers with limited mobility, the Xbox Adaptive Controller is a unified

hub for devices that helps make mixed reality more accessible.

The Xbox Adaptive Controller performs a click actuation as a secondary input by using the 'A' button. The device

is mapped to a default set of actions that help navigate and control the system. If you want to customize the

controller, use the Xbox Accessories application to configure your Xbox Adaptive Controller.

Xbox Adaptive Controller

Connect external devices such as switches, buttons, mounts, and joysticks to create a custom controller

experience that is uniquely yours. Button, thumbstick, and trigger inputs are controlled with assistive devices

connected through 3.5-mm jacks and USB ports.



 Composite gestures
  Air tapAir tap

  Tap and holdTap and hold

  ManipulationManipulation

  NavigationNavigation

Xbox Adaptive Controller ports

Instructions to pair the device

More info available on the Xbox site

The air tap gesture (and the other gestures below) reacts only to a specific tap. To detect other taps, such as

Menu or Grasp, your application must directly use the lower-level interactions described in the two key

component gestures section above.

Hold is simply maintaining the downward finger position of the air tap. The combination of air tap and hold

allows for various more complex "click and drag" interactions when combined with arm movement such as

picking up an object instead of activating it or mousedown secondary interactions such as showing a context

menu. Caution should be used when designing for this gesture however, as users can be prone to relaxing their

hand postures during any extended gesture.

Manipulation gestures can be used to move, resize, or rotate a hologram when you want the hologram to react

1:1 to the user's hand movements. One use for such 1:1 movements is to let the user draw or paint in the world.

The initial targeting for a manipulation gesture should be done by gaze or pointing. Once the tap and hold

starts, any object manipulation is handled by hand movements, which frees the user to look around while they

manipulate.

Navigation gestures operate like a virtual joystick, and can be used to navigate UI widgets, such as radial menus.

You tap and hold to start the gesture and then move your hand within a normalized 3D cube, centered around

the initial press. You can move your hand along the X, Y, or Z axis from a value of -1 to 1, with 0 being the

starting point. Navigation can be used to build velocity-based continuous scrolling or zooming gestures, similar

to scrolling a 2D UI by clicking the middle mouse button and then moving the mouse up and down.

https://www.xbox.com/xbox-one/accessories/controllers/xbox-adaptive-controller


 Gesture recognizers

 Hand recognition

 Gesture frame

Navigation with rails refers to the ability of recognizing movements in certain axis until a certain threshold is

reached on that axis. This is only useful when movement in more than one axis is enabled in an application by

the developer, such as if an application is configured to recognize navigation gestures across X, Y axis but also

specified X axis with rails. In this case, the system will recognize hand movements across X axis as long as they

remain within an imaginary rails (guide) on the X axis, if hand movement also occurs on the Y axis.

Within 2D apps, users can use vertical navigation gestures to scroll, zoom, or drag inside the app. This injects

virtual finger touches to the app to simulate touch gestures of the same type. Users can select which of these

actions take place by toggling between the tools on the bar above the application, either by selecting the button

or saying '<Scroll/Drag/Zoom> Tool'.

More info on composite gestures

One benefit of using gesture recognition is that you can configure a gesture recognizer only for the gestures the

currently targeted hologram can accept. The platform only does disambiguation as necessary to distinguish

those particular supported gestures. In this way, a hologram that just supports air tap can accept any length of

time between press and release, while a hologram that supports both tap and hold can promote the tap to a

hold after the hold time threshold.

HoloLens recognizes hand gestures by tracking the position of either or both hands that are visible to the device.

HoloLens sees hands when they are in either the ready state (back of the hand facing you with index finger up)

or the pressed state (back of the hand facing you with the index finger down). When hands are in other poses,

HoloLens ignores them. For each hand that HoloLens detects, you can access its position without orientation and

its pressed state. As the hand nears the edge of the gesture frame, you're also provided with a direction vector,

which you can show to the user so they know how to move their hand to get it back where HoloLens can see it.

For gestures on HoloLens, the hand must be within a gesture frame, in a range that the gesture-sensing cameras

can see appropriately, from nose to waist and between the shoulders. Users need to be trained on this area of

recognition both for success of action and for their own comfort. Many users will initially assume that the

gesture frame must be within their view through HoloLens, and hold up their arms uncomfortably to interact.

When using the HoloLens Clicker, it's not necessary for hands to be within the gesture frame.

For continuous gestures in particular, there's some risk of users moving their hands outside of the gesture frame

while in mid-gesture when moving a holographic object, for example, and losing their intended outcome.

There are three things that you should consider :

User education on the gesture frame's existence and approximate boundaries. This is taught during

HoloLens setup.

Notifying users when their gestures are nearing or breaking the gesture frame boundaries within an

application to the degree that a lost gesture leads to undesired outcomes. Research has shown the key

qualities of such a notification system. The HoloLens shell provides a good example of this type of

notification--visual, on the central cursor, indicating the direction in which boundary crossing is taking

place.

Consequences of breaking the gesture frame boundaries should be minimized. In general, this means

that the outcome of a gesture should be stopped at the boundary, and not reversed. For example, if a user

is moving some holographic object across a room, the movement should stop when the gesture frame is

breached, and not returned to the starting point. The user might experience some frustration, but might



 See also

more quickly understand the boundaries, and not have to restart their full intended actions each time.

Eye-based interaction

Eye tracking on HoloLens 2

Gaze and dwell

Hands - Direct manipulation

Hands - Gestures

Hands - Point and commit

Instinctual interactions

Voice input



   

 

Eye-gaze and commit
 7/6/2022 • 3 minutes to read • Edit Online

 Head and eye tracking design concepts demo

 Design guidelines for eye-gaze and commit

Eye-gaze and commit is a special gaze and commit input model case that involves targeting an object by looking

at it. You can act on the target with a secondary commit input, such as a hand gesture, voice command, or

peripheral input like a game controller.

With HoloLens 2, we have the great opportunity to make gaze and commit faster and more comfortable by

using eye-gaze instead of head-gaze. To extend the common head-gaze and commit interaction model:

1. Look at a target

2. To confirm your intention to select the target, use a secondary explicit input such as a:

Hand gesture (for example, an Air Tap)

Button press (for example, on a Bluetooth keyboard or clicker)

Voice command (for example, "Select")

Dwelling (that is, the user simply keeps looking at the target to select)

However, eye gaze behaves differently to head gaze in certain ways and comes with many unique challenges.

In the Eye Gaze Design Guidelines, we summarize general advantages and challenges when using eye tracking

as an input in your holographic app. In this section, we focus on the specific design considerations for eye-gaze

and commit. First, our eyes move incredibly fast and are great at quickly targeting across the view. Eye-gaze is

ideal for quick gaze-and-commit actions especially when combined with fast commits such as an air tap or

button press.

If you'd like to see Head and Eye Tracking design concepts in action, check out our Designing Holograms -Designing Holograms -

Head Tracking and Eye TrackingHead Tracking and Eye Tracking video demo below. When you've finished, continue on for a more detailed

dive into specific topics.

This video was taken from the "Designing Holograms" HoloLens 2 app. Download and enjoy the full experience

here.

Don't show a cursorDon't show a cursor : While it's nearly impossible to interact without a cursor when using head gaze, the

cursor becomes quickly distracting and annoying when using eye gaze. Instead of relying on a cursor to inform

the user whether eye tracking is working and has correctly detected the currently looked at target, use subtle

visual highlights.

Str ive for subtle blended hover feedbackStr ive for subtle blended hover feedback : What seems great visual feedback for head gaze can result in

terrible, overwhelming experiences using eye gaze. Remember, your eyes are enormously fast, quickly darting

across points in your field-of-view. Quick sudden highlight changes (on/off) may result in flickery feedback

when looking around. So, when providing hover feedback, we recommend using a smoothly blended-in

highlight (and blended-out when looking away). This means at first you would barely notice the feedback when

looking at a target. Over the course of 500-1000 ms the highlight would increase in intensity. While novice users

could keep looking at the target to ensure the system has correctly determined the focused target, expert users

could quickly gaze-and-commit without waiting until the feedback is at its full intensity. We also recommend

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/gaze-and-commit-eyes.md
https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Microsofts-Designing-Holograms-Head-Tracking-and-Eye-Tracking-Chapter/player
https://aka.ms/dhapp


 See also

using a blend-out when fading out the hover feedback. Research has shown that quick motions and contrast

changes are noticeable in your peripheral vision (the area of your visual field where you aren't looking). The

fade-out doesn't have to be as slow as the blend-in. This is only critical when you have high contrast or color

changes for your highlight. If the hover feedback was subtle to begin with, you probably won't notice a

difference.

Look out for synchronizing gaze and commit signalsLook out for synchronizing gaze and commit signals : The synchronization of input signals may be less of

a challenge for simple air taps and button presses. It's something to look out for in case you want to use more

complicated commit actions that may involve long voice commands or complicated hand gestures. Imagine you

look at a target and utter a long voice command. Think about the time you need to say it and the time that the

system needed to detect what you said, your eye gaze has long moved on to some new target in the scene.

Either make your users aware they may need to keep looking at a target until the command has been

recognized or handle the input in a way to determine the onset of the command and what the user had been

looking at back then.

Eye-based interaction

Eye tracking on HoloLens 2

Gaze and commit

Gaze and dwell

Hands - Direct manipulation

Hands - Gestures

Hands - Point and commit

Instinctual interactions

Voice input



   

 

Head-gaze and commit
 7/6/2022 • 3 minutes to read • Edit Online

 Device support

Input modelInput model HoloLens (1st gen)HoloLens (1st gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Head-gaze and commit ✔️ Recommended ✔️ Recommended (third
choice - See the other
options)

➕ Alternate option

 Head and eye tracking design concepts demo

 Target sizing and feedback

Head-gaze and commit is a special case of the gaze and commit input model that involves targeting an object

with a users head direction. You can act on the target with a secondary input, such as the hand gesture air tap or

"Select" voice command.

If you'd like to see Head and Eye Tracking design concepts in action, check out our Designing Holograms -Designing Holograms -

Head Tracking and Eye TrackingHead Tracking and Eye Tracking video demo below. When you've finished, continue on for a more detailed

dive into specific topics.

This video was taken from the "Designing Holograms" HoloLens 2 app. Download and enjoy the full experience

here.

The head gaze vector has been shown repeatedly to be usable for fine targeting, but often works best for gross

targeting--acquiring larger targets. Minimum target sizes of 1 degree to 1.5 degrees allow successful user

actions in most scenarios, though targets of 3 degrees often allow for greater speed. The size that the user

targets is effectively a 2D area even for 3D elements--whichever projection is facing them should be the

targetable area. Providing some salient cue that an element is "active" (that the user is targeting it) is helpful.

This can include treatments like visible "hover" effects, audio highlights or clicks, or clear alignment of a cursor

with an element.

Optimal target size at 2-meter distance

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/gaze-and-commit-head.md
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Microsofts-Designing-Holograms-Head-Tracking-and-Eye-Tracking-Chapter/player
https://aka.ms/dhapp


 Target placement

 Improving targeting behaviors

  Head-gaze stabilization ("gravity wells")Head-gaze stabilization ("gravity wells")

  Closest link algorithmsClosest link algorithms

  Backdating and postdating actionsBackdating and postdating actions

An example of highlighting a gaze targeted object

Users often fail to find UI elements located either too high or low in their field of view. Most of their attention

ends up on areas around their main focus, which is approximately at eye level. Placing most targets in some

reasonable band around eye level can help. Given the tendency for users to focus on a relatively small visual

area at any time (the attentional cone of vision is roughly 10 degrees), grouping UI elements together to the

degree they're related conceptually can use attention-chaining behaviors from item to item as a user moves

their gaze through an area. When designing UI, keep in mind the potential large variation in field of view

between HoloLens and immersive headsets.

An example of grouped UI elements for easier gaze targeting in Galaxy Explorer

If user intent to target something can be determined or closely approximated, it can be helpful to accept near

miss interaction attempts as though they were targeted correctly. Here's a handful of successful methods that

can be incorporated in mixed reality experiences:

This should be turned on most or all of the time. This technique removes the natural head and neck jitters that

users might have as well movement because of looking and speaking behaviors.

These algorithms work best in areas with sparse interactive content. If there's a high probability that you can

determine what a user was attempting to interact with, you can supplement their targeting abilities by assuming

some level of intent.

This mechanism is useful in tasks requiring speed. When a user is moving through a series of targeting and

activation maneuvers at speed, it's useful to assume some intent. It's also useful to allow missed steps to act on



  SmoothingSmoothing

  MagnetismMagnetism

  Focus stickinessFocus stickiness

 See also

targets that the user had in focus slightly before or slightly after the tap (50 ms before/after was effective in

early testing).

This mechanism is useful for pathing movements, reducing the slight jitter and wobbles because of natural head

movement characteristics. When smoothing over pathing motions, smooth by the size and distance of

movements rather than over time.

This mechanism can be thought of as a more general version of closest link algorithms--drawing a cursor

toward a target or simply increasing hitboxes, whether visibly or not, as users approach likely targets by using

some knowledge of the interactive layout to better approach user intent. This can be powerful for small targets.

When determining which nearby interactive elements to give, focus to, focus stickiness provides a bias to the

element that is currently focused. This helps reduce erratic focus switching behaviors when floating at a

midpoint between two elements with natural noise.

Eye-based interaction

Gaze and dwell

Hands - Direct manipulation

Hands - Gestures

Hands - Point and commit

Instinctual interactions

Voice input



   

 

UX elements overview
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 Foundational elements
Learn about the foundational elements that you need to design a great mixed reality experience.

 Color, light, andColor, light, and

materialsmater ials

 ScaleScale

TypographyTypography

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/app-patterns-landingpage.md


 Common controls and behaviors

 SoundSound

Learn about frequently used common spatial interactions and UI building blocks for mixed reality experiences.

CursorCursor



Hand rayHand ray

ButtonButton



Bounding boxBounding box

Interactable objectInteractable object



ManipulationManipulation

Hand menuHand menu



Near menuNear menu

Object collectionObject collection



Voice inputVoice input

KeyboardKeyboard



TooltipTooltip

SlateSlate



SliderSlider

ShaderShader



DialogDialog

Hand coachHand coach



Spatial meshSpatial mesh

Billboarding and tag-alongBillboarding and tag-along



Progress indicatorProgress indicator

Surface magnetismSurface magnetism



   

 

Holographic frame
 7/6/2022 • 11 minutes to read • Edit Online

 Designing for content

  Large objectsLarge objects

  Many objectsMany objects

Users see the world of mixed reality through a rectangular viewport powered by their headset. On the HoloLens,

this rectangular area is called the holographic frame and allows users to see digital content overlaid onto the

real world around them. Designing experiences optimized for the holographic frame creates opportunities,

mitigates challenges, and enhances the user experience of mixed reality applications.

Often designers feel the need to limit the scope of their experience to what the user can immediately see,

sacrificing real-world scale to ensure the user sees an object in its entirety. Similarly designers with complex

applications often overload the holographic frame with content, overwhelming users with difficult interactions,

and cluttered interfaces. Designers creating mixed reality content don't need to limit the experience to directly in

front of the user and within their immediate view. If the physical world around the user is mapped, then all these

surfaces should be considered a potential canvas for digital content and interactions. Proper design of

interactions and content within an experience should encourage the user to move around their space, directing

their attention to key content, and helping see the full potential of mixed reality.

Perhaps the most important technique to encouraging movement and exploration within an app is to let userslet users

adjust to the experienceadjust to the experience. Give users a short period of ‘task-free’ time with the device. This can be as simple as

placing an object in the space and letting users move around it or narrating an introduction to the experience.

This time should be free of any critical tasks or specific gestures like air-tapping. The purpose is to let users

accommodate to viewing content through the device before requiring interactivity or progressing through the

app. This is especially important for first-time users as they get comfortable seeing content through the

holographic frame and the nature of holograms.

Often the content an experience calls for, especially real-world content, will be larger than the holographic frame.

Objects that can't normally fit within the holographic frame should be shrunk to fit when they're first introduced

(either at a smaller scale or at a distance). The key is to let users see the full size of the objectlet users see the full size of the object before the

scale overwhelms the frame. For example, a holographic elephant should be displayed to fit fully within the

frame. This allows users to form a spatial understanding of the animal's overall shape, before sizing it to real-

world scale near the user.

With the full size of the object in mind, users have an expectation of where to move around and look for specific

parts of that object. In an experience with immersive content, it helps to have a way to refer back to the full size

of that content. For example, if the experience involves walking around a model of a virtual house, it helps to

have a smaller doll-house size version of the experience to pinpoint where they are inside the house.

For an example of designing for large objects, see Volvo Cars.

Experiences with many objects or components should consider using the full space around the user to avoid

cluttering the holographic frame directly in front of the user. We recommend slowing introducing content to an

experience, especially with experiences that plan to serve many objects to the user. The key is to let userslet users

understand the content layoutunderstand the content layout in the experience, which helps them gain a spatial understanding of what’s

around them as content updates.

One technique to achieve this is to provide persistent points (also known as landmarks) in the experience that

anchors content to the real world. For example, a landmark could be a physical object in the real-world, such as

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/holographic-frame.md


 Interaction considerations

  Attention directorsAttention directors

  Commanding, navigation, and menusCommanding, navigation, and menus

  Gaze and gaze targetingGaze and gaze targeting

a table where digital content appears, or a digital object, such as a set of digital screens where content frequently

appears. Objects can also be placed in the periphery of the holographic frame to encourage user to look toward

key content. Discovery of content beyond the periphery can be aided by attention directors.

Placing objects in the periphery can encourage users to look to the side and this can be aided by attention

directors, as described below. For more information on holographic frame considerations, see the comfort

documentation.

As with content, interactions in a mixed reality experience need not be limited to what the user can immediately

see. Interactions can take place anywhere in the real-world space around the user. These interactions can help

encourage users to move around and explore experiences.

Indicating points of interest or key interactions can be crucial to progressing users through an experience. User

attention and movement of the holographic frame can be directed in subtle or heavy-handed ways. Remember

to balance attention directors with periods of free exploration in mixed reality (especially at the start of an

experience) to avoid overwhelming the user. In general, there are two types of attention directors:

Visual directors:Visual directors: The easiest way to let the user know they should move in a specific direction is to provide

a visual indication. This can be done through a visual effect (for example, a path the user can visually follow

toward the next part of the experience) or even as simple directional arrows. Any visual indicator should be

grounded within the user's environment, not 'attached' to the holographic frame or the cursor.

Audio directors:Audio directors: Spatial sound can provide a powerful way to establish objects in a scene. You can alert

users to objects entering an experience, or direct attention to a specific point in space by moving the user's

view toward key objects. Using audio directors to guide the user ’s attention can be more subtle and less

intrusive than visual directors. In some cases, it can be best to start with an audio director, then move on to a

visual director if the user doesn't recognize the cue. Audio directors can also be paired with visual directors

for added emphasis.

Interfaces in mixed reality experiences ideally are paired tightly with the digital content they control. As such,

free-floating 2D menus are often not ideal for interaction and can be difficult for users too comfortably with

inside the holographic frame. For experiences that do require interface elements such as menus or text fields,

consider using a tag-along method to follow the holographic frame after a short delay. Avoid locking content to

the frame like a heads-up display, as this can be disorienting for the user and break the sense of immersion for

other digital objects in the scene.

You can also place interface elements directly on the specific content they control, allowing interactions to

happen naturally around the user's physical space. For example, break a complex menu into separate parts, with

each button or group of controls attached to the specific object the interaction affects. To take this concept

further, consider the use of interactable objects.

The holographic frame presents a tool for the developer to trigger interactions and evaluate where a user's

attention dwells. Gaze is one of the key interactions on HoloLens, where gaze can be paired with gestures (such

as with air-tapping) or voice (allowing for shorter, more natural voice-based interactions). As such, this makes

the holographic frame both a space for observing digital content and interacting with it. If the experience calls

for interacting with multiple objects around the user's space (for example, multi-selecting objects around the

user's space with gaze + gesture), consider bringing those objects into the user's view or limiting the amount of

necessary head movement to promote user comfort.



 Performance

 Examples
  Volvo CarsVolvo Cars
https://www.youtube.com/embed/cvLdbpICVGk

  Lowe's KitchenLowe's Kitchen

Gaze can also be used to track user attention through an experience and see which objects or parts of the scene

the user paid the most attention to. This can be especially use for debugging an experience, allowing for

analytical tools like heatmaps to see where users are spending the most time or are missing certain objects or

interaction. Gaze tracking can also provide a powerful tool for facilitators in experiences (see the Lowe's Kitchen

example).

If you'd like to see Head and Eye Tracking design concepts in action, check out our Designing Holograms -Designing Holograms -

Head Tracking and Eye TrackingHead Tracking and Eye Tracking video demo below:

This video was taken from the "Designing Holograms" HoloLens 2 app. Download and enjoy the full experience

here.

Proper use of the holographic frame is fundamental to the performance quality experiences. A common

technical (and usability) challenge is overloading the user's frame with digital content, causing rendering

performance to degrade. Consider instead using the full space around the user to arrange digital content, using

the techniques described above, to lessen the burden of rendering and ensure an optimal display quality.

In the showroom experience from Volvo Cars, customers are invited to learn about a new car's capabilities in a

HoloLens experience guided by a Volvo associate. Volvo faced a challenge with the holographic frame: a full-size

car is too large to put right next to a user. The solution was to begin the experience with a physical landmark, a

central table in the showroom, with a smaller digital model of the car placed on top of the table. This ensures the

user is seeing the full car when it's introduced, allowing for a sense of spatial understanding once the car grows

to its real-world scale later in the experience.

Volvo's experience also makes use of visual directors, creating a long visual effect from the small-scale car

model on the table to a wall in the show room. This leads to a 'magic window' effect, showing the full view of

the car at a distance, illustrating further features of the car at real-world scale. The head movement is horizontal,

without any direct interaction from the user (instead gathering cues visually and from the Volvo associate's

narration of the experience).

A store experience from Lowe's invites customers into a full-scale mockup of a kitchen to showcase various

remodeling opportunities as seen through the HoloLens. The kitchen in the store provides a physical backdrop

for digital objects, a blank canvas of appliances, countertops, and cabinets for the mixed reality experience to

unfold.

Physical surfaces act as static landmarks for the user to ground themselves in the experience, as a Lowe's

associate guides the user through different product options and finishes. In this way, the associate can verbally

direct the user's attention to the 'refrigerator' or 'center of the kitchen' to showcase digital content.

https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Microsofts-Designing-Holograms-Head-Tracking-and-Eye-Tracking-Chapter/player
https://aka.ms/dhapp
https://www.youtube.com/embed/cvLdbpICVGk


  FragmentsFragments

A Lowe's associate uses a tablet to guide customers through the HoloLens experience.

The user's experience is managed, in part, by a tablet experience controlled by the Lowe's associate. Part of the

associate's role in this case would also be to limit excessive head movement, directing their attention smoothly

across the points of interest in the kitchen. The tablet experience also provides the Lowe's associate with gaze

data in the form of a heatmap view of the kitchen, helping understand where the user is dwelling (for example,

on a specific area of cabinetry) to more accurately provide them with remodeling guidance.

For a deeper look at the Lowe's Kitchen experience, see Microsoft's keynote at Ignite 2016.

In the HoloLens game Fragments, you living room is transformed into virtual crime scene showing clues and

evidence, and a virtual meeting room, where you talk with characters that sit on your chairs and lean on your

walls.

Fragments were designed to take place in a user's home, with characters interacting with real-world objects and

surfaces.

When users initially begin the experience, they're given a short period of adjustment with little to no interaction.

Instead, they're encouraged to look around and orient themselves and ensures the room is properly mapped for

the game's interactive content.

Throughout the experience, characters become focal points and act as visual directors (head movements

between characters, turning to look or gesture toward areas of interest). The game also relies on more

prominent visual cues when a user takes too long to find an object or event and makes heavy use of spatial

audio (especially with characters voices when entering a scene).

https://www.youtube.com/watch?v=gC_4JxF0e_k


  Destination: MarsDestination: Mars
In the Destination: Mars experience featured at NASA's Kennedy Space Center, visitors were invited into an

immersive trip to the surface of Mars, guided by virtual representation of legendary astronaut Buzz Aldrin.

A virtual Buzz Aldrin becomes the focal point for users in Destination: Mars.

As an immersive experience, these users were encouraged to look around, moving their head in all directions to

see the virtual Martian landscape. Although to ensure the comfort of the users, Buzz Aldrin's narration and

virtual presence provided a focal point throughout the experience. This virtual recording of Buzz (created by

Microsoft's Mixed Reality Capture Studios) stood at real, human size, in the corner of the room allowing users to

see him in near-complete view. Buzz's narration directed users to focus on different points in the environment

(for example, a set of Martian rocks on the floor or a mountain range in the distance) with specific scene

changes or objects introduced by him.

The virtual narrators will turn to follow a user's movement, creating a powerful focal point throughout the

experience.

The realistic representation of Buzz provided a powerful focal point, complete with subtle techniques to turn

https://blogs.windows.com/devices/2016/09/19/hololens-experience-destination-mars-now-open-at-kennedy-space-center-visitor-complex/
https://www.microsoft.com/mixed-reality/capture-studios


 See also

Buzz toward the user to feel as though he's there, speaking to you. As the user moves about the experience, Buzz

will shift toward you to a threshold before returning to a neutral state if the user moves too far beyond his

periphery. If the user looks way from Buzz completely (for example, to look at something elsewhere in the

scene) then back to Buzz, the narrator's directional position will once again be focused on the user. Techniques

like this provide a powerful sense of immersion and create a focal point within the holographic frame, reducing

excessive head movement and promoting user comfort.

Instinctual interactions

Comfort

Scale

Head-gaze and dwell

Hologram stability



   

 

Designing content for holographic display
 7/6/2022 • 4 minutes to read • Edit Online

 Challenges with bright color on a large surface

When designing content for holographic displays, there are several elements that you need to consider for

achieving the best experience. We've listed some of our recommendations below and you can learn more about

the characteristics of holographic displays at Color, light and materials page.

Based on our HoloLens experience research and testing, we found that using bright colors in a large area of the

display can cause several issues:

Eye fatigueEye fatigue

Since holographic display is additive, holograms with bright colors use more light. Bright, solid color in a large

area of the display can easily cause eye fatigue for the user.

Hand occlusionHand occlusion

Bright color makes it difficult for the user to see their hands when directly interacting with objects. Since the

user can't see their hands, it becomes difficult to perceive the depth/distance between the hand/finger to the

target surface. The Finger Cursor helps compensate for this issue, but it can still be challenging on a bright white

surface.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/designing-content-for-holographic-display.md


 Design guidelines for color choices

Difficult to see the hand on the bright colored content backplate

Color uniformityColor uniformity

Because of the characteristics of holographic displays, a large bright area on the display can become blotchy. By

using dark color schemes, you can minimize this issue.

Use dark color for the UI backgroundUse dark color for the UI background

By using the dark color scheme, you can minimize eye fatigue and improve the confidence on direct hand

interactions.

Examples of dark color used for the content background

Use semibold or bold font weightUse semibold or bold font weight

HoloLens allows your experience to show beautiful high-resolution text. However, it's recommended that you

avoid thin font weights such as light or semi-light because the vertical strokes can jitter in small font size.



 Challenges with transparent or translucent UI backplate

Bold or semi-bold font weight (upper panel) improves the legibility

Use MRTK’s HolographicBackplate mater ialUse MRTK’s HolographicBackplate mater ial

The HolographicBackplate material is applied to several UI panels in the HoloLens shell. One of its features is an

iridescence effect that is visible to users as they shift their position based on the panel. The backplate color shifts

subtly across a predefined spectrum, creating an engaging and dynamic visual effect without interfering with

content readability. This subtle shift in color also serves to compensate for any minor color irregularities.

Examples of transparent UI backplate

Visual complexity and accessibilityVisual complexity and accessibility

Since holographic objects blend with the physical environment, content or UI legibility on transparent or

translucent windows could be degraded. Additionally, when transparent holographic objects are overlaid on top

of each other, it could make it difficult for the user to interact because of the confusing depth.

PerformancePerformance

For transparent or translucent objects to render correctly they must be sorted and blended with any objects,

which exist in the background. Sorting of transparent objects has a modest CPU cost, blending has considerable

GPU cost because it doesn't allow the GPU to do hidden surface removal via z-culling (i.e depth testing). Not

allowing hidden surface removal increases the number of operations needed for the final rendered pixel. This

puts on more pressure fill rate constraints.



 Design guidelines for transparent elements

 Dark UI examples in MRTK (Mixed Reality Toolkit) for Unity

 See also

Hologram stability issue with Depth LSR technologyHologram stability issue with Depth LSR technology

To improve holographic reprojection, or hologram stability, an application can submit a depth buffer to the

system for every rendered frame. When using the depth buffer for reprojection, you need to write a depth

buffer for every color rendered pixel a corresponding depth. Any pixel with a depth value should also have color

value. If the above guidance isn't followed, areas of the rendered image that lack valid depth information may be

reprojected in a way that produces artifacts, which are often visible as a wave-like distortion.

Use opaque UI backgroundUse opaque UI background

By default, transparent or translucent objects don't write depth to allow for proper blending. Ways to mitigate

this issue include, using opaque objects, ensuring translucent objects appear close to opaque objects (such as a

translucent button in front of an opaque backplate), forcing translucent objects to write depth (not applicable in

all scenarios), or rendering proxy objects, which only contribute depth values at the end of the frame.

Solutions within MRTK-Unity: /windows/mixed-reality/mrtk-unity/performance/hologram-stabilization#depth-

buffer-sharing-in-unity

By using a solid and opaque backplate, we can secure legibility and interaction confidence.

Minimize the number of pixels affectedMinimize the number of pixels affected

If your project must use transparent objects, try to minimize the number of pixels affected. For example, if an

object is only visible under certain conditions (like an additive glow effect), disable the object when it's fully

invisible (instead of setting the additive color to black). For simple 2D shapes created using a quad with an alpha

mask, consider creating a mesh representation of the shape with an opaque shader instead.

MRTKMRTK provides many UI building block examples based on the dark color schemes.

Near Menu

Dialog

Hand Menu

Color, light, and materials

Cursors

Hand ray

Button

Interactable object

Bounding box and App bar

Manipulation

Hand menu

Near menu

Object collection

https://github.com/Microsoft/MixedRealityToolkit-Unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/near-menu
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/dialog
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/hand-menu


Voice command

Keyboard

Tooltip

Slate

Slider

Shader

Billboarding and tag-along

Displaying progress

Surface magnetism
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 Overview
  Immersive viewsImmersive views

  2D views2D views

Windows apps can contain two kinds of views: immersive viewsimmersive views  and 2D views2D views . Apps can switch between

their various immersive and 2D views, showing their 2D views either on a monitor as a window or in a headset

as a slate. Apps that have at least one immersive view are categorized as mixed reality appsmixed reality apps . Apps that never

have an immersive view are 2D apps2D apps .

An immersive view gives your app the ability to create holograms in the world around you or immerse the user

in a virtual environment. When an app is drawing in the immersive view, no other app is drawing at the same

time—holograms from multiple apps aren't composited together. By continually adjusting the perspective from

which your app renders its scene to match the user's head movements, your app can render world-locked

holograms. World-locked holograms stay at a fixed point in the real world or can render a virtual world that

holds its position as a user moves.

When in an immersive view, holograms can be placed in the world around you

On HoloLens, your app renders its holograms on top of the user's real-world surroundings. On a Windows

Mixed Reality immersive headset, the user can't see the real world, and so your app must render everything the

user will see.

The Windows Mixed Reality home (including the Start menu and holograms you've placed around the

environment) doesn't render while in an immersive view either. On HoloLens, Cortana relays any system

notifications that occur while an immersive view is showing, to which the user can respond with voice input.

While in an immersive view, your app is also responsible for handling all input. Input in Windows Mixed Reality

is made up of gaze, gesture (HoloLens only), [voice, and motion controllers (immersive headsets only).

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/app-views.md
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


 Choosing a view

Multiple apps with a 2D view placed around the Windows Mixed Reality home

An app with a 2D view appears in the Windows Mixed Reality home (sometimes called the "shell") as a virtual

slate, rendered alongside the app launchers and other holograms the user has placed in their world. The user

can adjust this slate to move and scale it, though it remains at a fixed resolution whatever its size. If your app's

first view is a 2D view, your 2D content will fill the same slate used to launch the app.

In a desktop headset, you can run any Universal Windows Platform (UWP) apps that run on your desktop

monitor today. These apps are already rendering 2D views today, and their content will automatically appear on

a slate in the user's world when launched. 2D UWP apps can target the Windows.UniversalWindows.Universal  device family to

run on both desktop headsets and on HoloLens as slates.

One key use of 2D views is showing a text entry form that uses the system keyboard. Because the shell can't

render on top of an immersive view, the app has to switch to a 2D view to show the system keyboard. Apps that

want to accept text input need to switch to a 2D view with a text box. While that text box has focus, the system

will show the system keyboard, allowing the user to enter text.

An app can have 2D views on both the desktop monitor and in an attached headset on a desktop PC. For

example, you can browse Edge on your desktop monitor using its main 2D view to find a 360-degree video.

When you play that video, Edge will launch a secondary immersive view inside the headset to display the

immersive video content.

When your app activates, you can choose what type of view you'd like to display. For an app's CoreApplicationCoreApplication,

there's always a primary app view and any number of further app views you would like to create. On desktop,

you can think of an app view as a window. Our mixed reality app templates create a Unity project where the

primary app view is immersive.

Your app can create an extra 2D app view using technology like XAML, to use Windows 10 features such as in-

app purchase. If your app started as a UWP app for other Windows 10 devices, your primary view is 2D.

However, you can "light up" in mixed reality by adding another app view that's immersive to show an experience

volumetrically. Imagine building a photo viewer app in XAML where the slideshow button switched to an

immersive app view that flew photos from the app across the world and surfaces.

https://docs.microsoft.com/en-us/uwp/api/windows.ui.viewmanagement.applicationview


 Creating an immersive view

 2D view in the Windows Mixed Reality home

The running app can have a 2D view or an immersive view

Mixed reality apps create an immersive view, which is achieved with the HolographicSpace type.

An app that is purely immersive should always create an immersive view on launch, even if launched from the

desktop. Immersive views always show up in the headset, regardless of where they were created from.

Activating an immersive view will display the Mixed Reality Portal and guide the user to put on their headset.

An app that starts with a 2D view on the desktop monitor may create a secondary immersive view to show

content in the headset. An example of this is a 2D Edge window on the monitor displaying a 360-degree video in

the headset.

An app running in an immersive view is the only one visible

https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicspace


 Placement of additional app tiles

 Switching views
  

Anything other than an immersive view is rendered as a 2D view in your world.

An app may have 2D views on both the desktop monitor and in the headset. A new 2D view will be placed in the

same shell as the view that created it, either on the monitor or in the headset. It isn't currently possible for an

app or a user to move a 2D view between the Mixed Reality home and the monitor.

Apps running in a 2D view share the space with other apps

You can place as many apps with a 2D view in your world as you want with the Secondary Tile APIs. These

"pinned" tiles will appear as splash screens that users must place and then can later use to launch your app.

Windows Mixed Reality doesn't currently support rendering any of the 2D tile content as live tiles.

Apps can have multiple placements using secondary tiles

https://docs.microsoft.com/en-us/windows/uwp/design/shell/tiles-and-notifications/secondary-tiles


Switching from the 2D XAML view to the immersive viewSwitching from the 2D XAML view to the immersive view

NOTENOTE

  Switching from the immersive view back to a keyboard XAML viewSwitching from the immersive view back to a keyboard XAML view

If the app uses XAML, then the XAML IFrameworkViewSource will control the first view of the app. The app will

need to switch to the immersive view before activating the CoreWindowCoreWindow , to ensure the app launches directly

into the immersive experience.

Use CoreApplication.CreateNewView and ApplicationViewSwitcher.SwitchAsync to make it the active view.

Do not specify the ApplicationViewSwitchingOptions.ConsolidateViews flag to SwitchAsyncSwitchAsync when switching from the

XAML view to the immersive view, or the slate that launched the app will be removed from the world.

SwitchAsyncSwitchAsync should be called using the Dispatcher associated with the view you are switching into.

You will need to SwitchAsyncSwitchAsync back to the XAML view if you need to launch a virtual keyboard or want to activate

another app.

 

Left: apps can switch between 2D view and immersive view. Right: when an app goes into an immersive view,

the Windows Mixed Reality home and other apps disappear.

One common reason for switching back-and-forth between views is displaying a keyboard in a mixed reality

app. The shell is only able to display the system keyboard if the app is showing a 2D view. If the app needs to get

text input, it may provide a custom XAML view with a text input field, switch to it, and then switch back after the

input is complete.

Like in the previous section, you can use ApplicationViewSwitcher.SwitchAsyncApplicationViewSwitcher.SwitchAsync to transition back to a XAML

https://docs.microsoft.com/en-us/uwp/api/windows.applicationmodel.core.iframeworkviewsource
https://docs.microsoft.com/en-us/uwp/api/windows.applicationmodel.core.coreapplication#windows_applicationmodel_core_coreapplication_createnewview_windows_applicationmodel_core_iframeworkviewsource_
https://docs.microsoft.com/en-us/uwp/api/windows.ui.viewmanagement.applicationviewswitcher#windows_ui_viewmanagement_applicationviewswitcher_switchasync_system_int32_
https://docs.microsoft.com/en-us/uwp/api/windows.ui.viewmanagement.applicationviewswitchingoptions
https://docs.microsoft.com/en-us/uwp/api/windows.ui.core.corewindow#windows_ui_core_corewindow_dispatcher


 App size

 App tiles

 App to app interactions

 

view from your immersive view.

2D app views always appear in a fixed virtual slate. This makes all 2D views show the exact same amount of

content. Here are some further details about the size of your app's 2D view:

The aspect ratio of the app is preserved while resizing.

App resolution and scale factor aren't changed by resizing.

Apps aren't able to query their actual size in the world.

Apps with a 2D view appear with fixed window sizes

The Start menu uses the standard small tile and medium tile for pins and the All AppsAll Apps  list in mixed reality.

The Start menu for Windows Mixed Reality

As you build apps, you have access to the rich app to app communication mechanisms available on Windows

10. Many of the new Protocol APIs and file registrations work perfectly on HoloLens to enable app launching

and communication.

For desktop headsets, the app associated with a given file extension or protocol may be a Win32 app that can

only appear on the desktop monitor or in the desktop slate.



Protocols

 File pickers

A P PA P P EXT EN SIO N SEXT EN SIO N S

Photos bmp, gif, jpg, png, avi, mov, mp4, wmv

Microsoft Edge htm, html, pdf, svg, xml

 App contracts and Windows Mixed Reality extensions

C O N T RA C T  O R EXT EN SIO NC O N T RA C T  O R EXT EN SIO N SUP P O RT ED?SUP P O RT ED?

Account Picture Provider (extension) Unsupported

Alarm Unsupported

App service Supported but not fully functional

Appointments provider Unsupported

AutoPlay (extension) Unsupported

Background tasks (extension) Partially Supported (not all triggers work)

Update task (extension) Supported

Cached file updater contract Supported

HoloLens supports app to app launching via the Windows.System.Launcher APIs.

There are some things to consider when launching another application:

When doing a non-modal launch, such as LaunchUriAsync, the user must place the app before interacting

with it.

When doing a modal launch, such as through LaunchUriForResultsAsync, the modal app is placed on top

of the window.

Windows Mixed Reality can't overlay applications on top of exclusive views. To show the launched app,

Windows takes the user back to the world to display the application.

HoloLens supports both FileOpenPicker and FileSavePicker contracts. However, no app comes pre-installed that

fulfills the file picker contracts. These apps - OneDrive, for example - can be installed from the Microsoft Store.

If you have more than one file picker app installed, you won't see any disambiguation UI for choosing which app

to launch. Instead, the first file picker installed will be chosen. When saving a file, the filename is generated

which includes the timestamp. This cannot be changed by the user.

By default, the following extensions are supported locally:

App contracts and extension points allow you to register your app to take advantage of deeper operating system

features like handling a file extension or using background tasks. This is a list of the supported and unsupported

contracts and extension points on HoloLens.

https://docs.microsoft.com/en-us/uwp/api/windows.system.launcher
https://docs.microsoft.com/en-us/uwp/api/windows.system.launcher#windows_system_launcher_launchuriasync_windows_foundation_uri_
https://docs.microsoft.com/en-us/uwp/api/windows.system.launcher#windows_system_launcher_launchuriforresultsasync_windows_foundation_uri_windows_system_launcheroptions_windows_foundation_collections_valueset_
https://docs.microsoft.com/en-us/uwp/api/windows.storage.pickers.fileopenpicker
https://docs.microsoft.com/en-us/uwp/api/windows.storage.pickers.filesavepicker
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#account_picture_provider
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#alarm
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#app_service
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#appointmnets_provider
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#autoplay
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#background_tasts
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#update_task
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#cached_file_updater


Camera settings (extension) Unsupported

Dial protocol Unsupported

File activation (extension) Supported

File Open Picker contract Supported

File Save Picker contract Supported

Lock screen call Unsupported

Media playback Unsupported

Play To contract Unsupported

Preinstalled config task Unsupported

Print 3D Workflow Supported

Print task settings (extension) Unsupported

URI activation (extension) Supported

Restricted launch Unsupported

Search contract Unsupported

Settings contract Unsupported

Share contract Unsupported

SSL/certificates (extension) Supported

Web account provider Supported

C O N T RA C T  O R EXT EN SIO NC O N T RA C T  O R EXT EN SIO N SUP P O RT ED?SUP P O RT ED?

 App file storage

  Known foldersKnown folders

P RO P ERT YP RO P ERT Y SUP P O RT ED O N  H O LO L EN SSUP P O RT ED O N  H O LO L EN S SUP P O RT ED O N  IM M ERSIVESUP P O RT ED O N  IM M ERSIVE
H EA DSET SH EA DSET S

DESC RIP T IO NDESC RIP T IO N

All storage is through the Windows.Storage namespace. HoloLens doesn't support app storage sync/roaming.

For more information, check out the documentation below:

Files, folders, and libraries

Store and retrieve settings and other app data

See KnownFolders for the full details for UWP apps.

https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#camera_settings
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#dial_protocol
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#file_activation
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#file_open_picker_contract
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#file_save_picker_contract
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#lock_screen_call
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#media_playback
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#playto_contract
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#preinstalled_config_task
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#print_3d_workflow
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#print_task_settings
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#protocol_activation
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#restricted_launch
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#search_contract
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#settings_contract
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#share_contract
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#ssl_certificates
https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh464906(v=win.10)#web_account_provider
https://docs.microsoft.com/en-us/uwp/api/windows.storage
https://docs.microsoft.com/en-us/windows/uwp/files/index
https://docs.microsoft.com/en-us/windows/uwp/design/app-settings/store-and-retrieve-app-data
https://docs.microsoft.com/en-us/uwp/api/windows.storage.knownfolders


AppCaptures ✔️ ✔️ Gets the App Captures
folder.

CameraRoll ✔️ ✔️ Gets the Camera Roll folder.

DocumentsLibrary ✔️ ✔️ Gets the Documents library.
The Documents library isn't
intended for general use.

MusicLibrary ✔️ ✔️ Gets the Music library.

Objects3D ✔️ ✔️ Gets the Objects 3D folder.

PicturesLibrary ✔️ ✔️ Gets the Pictures library.

Playlists ✔️ ✔️ Gets the play lists folder.

SavedPictures ✔️ ✔️ Gets the Saved Pictures
folder.

VideosLibrary ✔️ ✔️ Gets the Videos library.

HomeGroup ✔️ Gets the HomeGroup folder.

MediaServerDevices ✔️ Gets the folder of media
server (Digital Living
Network Alliance (DLNA))
devices.

RecordedCalls ✔️ Gets the recorded calls
folder.

RemovableDevices ✔️ Gets the removable devices
folder.

 App package

 See also

With Windows 10, you no longer target an operating system but instead target your app to one or more device

families. A device family identifies the APIs, system characteristics, and behaviors that you can expect across

devices within the device family. It also determines the set of devices on which your app can be installed from

the Microsoft Store.

To target both desktop headsets and HoloLens, target your app to the Windows. UniversalWindows. Universal  device family.

To target just desktop headsets, target your app to the Windows.DesktopWindows.Desktop device family.

To target just HoloLens, target your app to the Windows.HolographicWindows.Holographic device family.

App model

Updating 2D UWP apps for mixed reality

Getting a HolographicSpace

Navigating the Windows Mixed Reality home

Types of mixed reality apps

https://docs.microsoft.com/en-us/uwp/api/windows.storage.knownfolders#windows_storage_knownfolders_appcaptures
https://docs.microsoft.com/en-us/uwp/api/windows.storage.knownfolders#windows_storage_knownfolders_cameraroll
https://docs.microsoft.com/en-us/uwp/api/windows.storage.knownfolders#windows_storage_knownfolders_documentslibrary
https://docs.microsoft.com/en-us/uwp/api/windows.storage.knownfolders#windows_storage_knownfolders_musiclibrary
https://docs.microsoft.com/en-us/uwp/api/windows.storage.knownfolders#windows_storage_knownfolders_objects3d
https://docs.microsoft.com/en-us/uwp/api/windows.storage.knownfolders#windows_storage_knownfolders_pictureslibrary
https://docs.microsoft.com/en-us/uwp/api/windows.storage.knownfolders#windows_storage_knownfolders_playlists
https://docs.microsoft.com/en-us/uwp/api/windows.storage.knownfolders#windows_storage_knownfolders_savedpictures
https://docs.microsoft.com/en-us/uwp/api/windows.storage.knownfolders#windows_storage_knownfolders_videoslibrary
https://docs.microsoft.com/en-us/uwp/api/windows.storage.knownfolders#windows_storage_knownfolders_homegroup
https://docs.microsoft.com/en-us/uwp/api/windows.storage.knownfolders#windows_storage_knownfolders_mediaserverdevices
https://docs.microsoft.com/en-us/uwp/api/windows.storage.knownfolders#windows_storage_knownfolders_recordedcalls
https://docs.microsoft.com/en-us/uwp/api/windows.storage.knownfolders#windows_storage_knownfolders_removabledevices
https://docs.microsoft.com/en-us/windows/uwp/get-started/universal-application-platform-guide#device-families


   

 

Comfort
 7/6/2022 • 12 minutes to read • Edit Online

 Vergence-accommodation conflict

https://www.youtube.com/embed/-606oZKLa_s

  Guidance for holographic devicesGuidance for holographic devices

During natural viewing, the human visual system relies on multiple sources of information, or “cues,” to interpret

3D shapes and the relative positions of objects. Some cues rely only on a single eye, or monocular cue,

including:

Linear perspective

Familiar size

Occlusion

Depth-of-field blur

Accommodation.

Other cues rely on both eyes, or binocular cues, and include:

Vergence - essentially the relative rotations of the eyes required to look at an object

Binocular disparity - the pattern of differences between the projections of the scene on the back of the two

eyes

To ensure maximum comfort on head-mounted displays, it’s important to create and present content in a way

that mimics cues in the natural world. From a physical perspective, it's also important to design content that

doesn't require fatiguing motions of the neck or arms. In this article, we’ll go over key considerations to keep in

mind to achieve these goals.

To view objects clearly, humans must accommodate, or adjust their eyes’ focus, to the distance of the object. At

the same time, the rotation of both eyes must converge to the object’s distance to avoid seeing double images.

In natural viewing, vergence and accommodation are linked. When you view something near, for example, a

house fly close to your nose, your eyes cross and accommodate to a near point. Conversely, if you view

something at optical infinity (roughly starting at 6 m or farther for normal vision), your eyes’ lines of sight

become parallel and your eyes’ lenses accommodate to infinity.

In most head-mounted displays, users will always accommodate to the focal distance of the display to get a

sharp image, but converge to the distance of the object of interest to get a single image. When users

accommodate and converge to different distances, the natural link between the two cues is broken, leading to

visual discomfort or fatigue.

HoloLens displays are fixed at an optical distance approximately 2.0 m away from the user. Users must always

accommodate near 2.0 m to maintain a clear image in the device. App developers can guide where users' eyes

converge by placing content and holograms at various depths. Discomfort from the vergence-accommodation

conflict can be avoided or minimized by keeping content to which users converge as close to 2.0 m as possible.

For example, in a scene with lots of depth, place the areas of interest near 2.0 m from the user when possible.

When content cannot be placed near 2.0 m, discomfort from the vergence-accommodation conflict is greatest

when the user ’s gaze switches back and forth between different distances. In other words, it's much more

comfortable to look at a stationary hologram that stays 50 cm away than to look at a hologram 50 cm away that

moves toward and away from you over time.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/comfort.md
https://en.wikipedia.org/wiki/Perspective_(graphical)
https://en.wikipedia.org/wiki/Size#Perception_of_size
https://en.wikipedia.org/wiki/Depth_of_field
https://en.wikipedia.org/wiki/Accommodation_(eye)
https://en.wikipedia.org/wiki/Vergence
https://en.wikipedia.org/wiki/Stereopsis
https://en.wikipedia.org/wiki/Accommodation_%2528eye%2529
https://en.wikipedia.org/wiki/Convergence_(eye)
https://www.youtube.com/embed/-606oZKLa_s
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Optimal distance for placing holograms from the user

For maximum comfort, the optimal zone for hologram placement is between 1.25 m and 5 mthe optimal zone for hologram placement is between 1.25 m and 5 m . In every

case, designers should attempt to structure content scenes to encourage users to interact 1 m or farther away

from the content (for example, adjust content size and default placement parameters).

Although content may occasionally need to be displayed closer than 1 m, we recommend against ever

presenting holograms closer than 40 cm. Thus, we recommend starting to fade out content at 40 cm andfade out content at 40 cm and

placing a rendering clipping plane at 30 cmplacing a rendering clipping plane at 30 cm to avoid any nearer objects.

Objects that move in depth are more likely than stationary objects to produce discomfort because of the

vergence-accommodation conflict. Similarly, requiring users to rapidly switch between near-focus and far-focus

(for example, because of a pop-up hologram requiring direct interaction) can cause visual discomfort and

fatigue. Extra care should be taken to minimize how often users are: v iewing content that is movingExtra care should be taken to minimize how often users are: v iewing content that is moving

in depth; or rapidly switching focus between near and far hologramsin depth; or rapidly switching focus between near and far holograms .

When designing content for direct (near) interaction in HoloLens 2, or in any applications where contentin any applications where content

must be placed closer than 1 m, extra care should be taken to ensure user comfor tmust be placed closer than 1 m, extra care should be taken to ensure user comfor t. The odds of

discomfort due to the vergence-accommodation conflict increase exponentially with decreasing viewing

distance. Additionally, users may experience increased blurriness when viewing content at near interaction

distances, so we recommend testing content rendered both within the zone of optimal hologram placement and

closer (less than 1.0 m down to the clipping plane) to ensure it remains clear and comfortable to view.

We recommend creating a “depth budget” for apps based on the amount of time a user isWe recommend creating a “depth budget” for apps based on the amount of time a user is

expected to view content that is near (less than 1.0 m) and moving in depthexpected to view content that is near (less than 1.0 m) and moving in depth. An example is to avoid

placing the user in those situations more than 25% of the time. If the depth budget is exceeded, we recommend

careful user testing to ensure it remains a comfortable experience.

In general, we also recommend careful testing to ensure any interaction requirements (for example, velocity of

movement, reachability, etc.) at near interaction distances remain comfortable for users.

For immersive devices, the guidance and best practices for HoloLens still applies, but the specific values for the

Zone of Comfort are shifted depending on the focal distance to the display. In general, the focal distances to

these displays are between 1.25m-2.5m. When in doubt, avoid rendering objects of interest too near to users

and instead try to keep most content 1 m or farther away.



Interpupillary distance and vertical offset

  Guidance for holographic devicesGuidance for holographic devices
  HoloLens (1st gen)HoloLens (1st gen)

  HoloLens 2HoloLens 2

  Guidance for immersive devicesGuidance for immersive devices

 Rendering rates

When viewing digital content on head-mounted displays (HMD), the position of a viewer’s eyes based on the

display position of digital content is critical. Specifically, both interpupillary distance (IPD) and vertical offset

(VO) are important for comfortable viewing of digital content in HMDs.

IPD refers to the distance between the pupils, or centers, of an individual’s eyes. VO refers to the potential

vertical offset of digital content shown to each eye relative to the horizontal axis of the viewer's eyes (notably,

this is NOT the same as horizontal offset, or binocular disparity). Mis-matching either or both of these factors to

an individual user can worsen the effects of discomfort caused by vergence-accommodation conflict, but it can

even cause discomfort when V-A conflict is minimized (for example, for content displayed at the 2.0-m focal

distance of the HoloLens).

For HoloLens (1st gen), IPD is estimated and set during device calibration. For new users to an already set up

device, calibration must be run or IPD must be set manually. VO depends wholly on device fit. Specifically, to

minimize VO, the device needs to be resting on a user ’s head such that the displays are level with the axis of

his/her eyes.

For HoloLens 2, IPD is estimated and set during eye/device calibration. For new users to an already set up

device, calibration must be run to ensure IPD is set correctly. VO is accounted for automatically in HoloLens 2.

Windows Mixed Reality immersive HMDs have no automatic calibration for IPD or VO. IPD can be set manually

in software (under Mixed Reality Portal settings, see calibration), or some HMDs have a mechanical slider that

allows the user to adjust the spacing of the lenses to a comfortable position that roughly matches their IPD.

Mixed reality apps are unique because users can move freely in the world and interact with virtual content like

as though they were real objects. To maintain this impression, it's critical to render holograms so they appear

stable in the world and animate smoothly. Rendering at a minimum of 60 frames per second (FPS) helps achieve

this goal. There are some Mixed Reality devices that support rendering at framerates higher than 60 FPS and for

these devices it's recommended to render at the higher framerates to provide an optimal user experience.

Diving deeperDiving deeper

To draw holograms to look, like they're stable in the real or virtual world, apps need to render images from the

user's position. Since image rendering takes time, HoloLens and other Windows Mixed Reality devices predict

where a user's head will be when the images are shown in the displays. This prediction algorithm is an

approximation. Windows Mixed Reality algorithms and hardware adjust the rendered image to account for the

discrepancy between the predicted head position and the actual head position. This process makes the image

seen by the user appear as if it were rendered from the correct location, and holograms feel stable. The updates

work best for small changes in head position, and they can't completely account for some rendered image

differences, like those caused by motion-parallax.

By rendering at a minimum framerate of 60 FPS, you're doing two things to help make stableBy rendering at a minimum framerate of 60 FPS, you're doing two things to help make stable

holograms:holograms:

1. Reducing the appearance of judder, which is characterized by uneven motion and double images. Faster

hologram motion and lower render rates are associated with more pronounced judder. Therefore, striving to

always maintain 60 FPS (or your device’s maximum render rate) will help avoid judder for moving

holograms.

2. Minimizing the overall latency. In an engine with a game thread and a render thread running in lockstep,

https://en.wikipedia.org/wiki/Pupillary_distance
https://docs.microsoft.com/en-us/hololens/hololens-calibration
https://docs.microsoft.com/en-us/hololens/hololens-calibration
https://docs.microsoft.com/en-us/hololens/hololens-calibration


 Self-motion and user locomotion

  Guidance for holographic devicesGuidance for holographic devices

  Guidance for immersive devicesGuidance for immersive devices

 Heads-up displays

running at 30FPS can add 33.3 ms of extra latency. By reducing latency, this decreases prediction error, and

increases hologram stability.

Performance analysisPerformance analysis

There are different tools that can be used to benchmark your application frame rate such as:

GPUView

Visual Studio Graphics Debugger

Profilers built into 3D engines such as the Frame Debugger in Unity

The only limitation is the size of your physical space; if you want to allow users to move farther in the virtual

environment than they can in their real rooms, then a form of purely virtual motion must be implemented.

However, sustained virtual motion that doesn't match the user ’s real, physical motion can often induce motion

sickness. This outcome is because the visual cues for self-motion from the virtual world conflicting with the

vestibular cues for self-motion coming from the real world.

Fortunately, there are tips for implementing user locomotion that can help avoid the issue:

Always put the user in control of their movements; unexpected self-motion is problematic

Humans are sensitive to the direction of gravity. Therefore, non-user-initiated vertical motions especially

should be avoided.

One method to allow the user to move to another location in a large virtual environment is to give the

impression they're moving a small object in the scene. This effect can be achieved as follows:

1. Provide an interface where the user can select a spot in the virtual environment where they want to move.

2. Upon selection, shrink the scene rendering down to a disk around the desired spot.

3. While keeping the spot selected, allow the user to move it as though it were a small object. The user can then

move the selection close to their feet.

4. Upon deselection, resume rendering the entire scene.

The preceding holographic device approach doesn't work as well in an immersive device because it requires the

app to render a large black void or another default environment while moving the “disk.” This treatment disrupts

one’s sense of immersion. One trick for user locomotion in an immersive headset is the “blink” approach. This

implementation provides the user with control over their motion and gives a brief impression of movement, but

makes it so brief that the user is less likely to feel disoriented by the purely virtual self-motion:

1. Provide an interface where the user can select a spot in the virtual environment where they want to move.

2. Upon selection, begin a rapid simulated (100 m/s) motion towards that location while quickly fading out the

rendering.

3. Fade the rendering back in after finishing the translation.

In first-person-shooter video games, heads-up displays (HUDs) persistently present information such as player

health, mini-maps, and inventories directly on the screen. HUD's work well to keep the player informed without

intruding on the gameplay experience. In mixed reality experiences, HUDs have the potential to cause significant

discomfort and must be adapted to the more immersive context. Specifically, HUDs that are rigidly locked to the

user ’s head orientation are likely to produce discomfort. If an app requires a HUD, we recommend body locking

rather than head locking. This treatment can be implemented as a set of displays that immediately translate with

https://en.wikipedia.org/wiki/Vestibular_system


 Text legibility

 Holographic frame considerations

the user, but don't rotate with the user ’s head until a threshold of rotation is reached. Once that rotation is

achieved, the HUD may reorient to present the information within the user ’s field of view. Avoid implementing

1:1 HUD rotation and translation based on the user ’s head motions.

Optimal text legibility can help reduce eye strain and maintain user comfort, especially in applications or

scenarios that require users to read while using an HMD. Text legibility depends on various factors including:

Display properties such as pixel density, brightness, and contrast.

Lens properties like chromatic aberration

Text/font properties such as weight, spacing, serifs, and font/background color.

In general, we recommend testing specific applications for legibility and making font sizes as large as possible

for a comfortable experience. You can find more detailed guidance for holographic and immersive devices in our

Typography and Text in Unity pages.

For mixed reality experiences with large objects or many objects, it's crucial to consider how much head and

neck movement is necessary to interact with content. Experiences can be divided into three categories in terms

of head movement:

HorizontalHorizontal  (side to side)

Ver ticalVer tical  (up and down)

ImmersiveImmersive (both horizontal and vertical)

When possible, limit most interactions to either horizontal or vertical categories, ideally with most experiences

taking place in the center of the holographic frame while the user's head is in a neutral position. Avoid

interactions that cause the user to constantly move their view to an unnatural head position (for example,

always looking up to access a key menu interaction).



 Gaze direction

 Arm positions

 See also

Optimal region for content is 0 degrees to 35 degrees below horizon

Horizontal head movement is more for frequent interactions, while vertical movements should be reserved for

uncommon events. For example, an experience involving a long horizontal timeline should limit vertical head

movement for interactions (like looking down at a menu).

Consider encouraging full-body movement, rather than just head movement, by placing objects around the

user's space. Experiences with moving objects or large objects should pay special attention to head movement,

especially where they require frequent movement along both the horizontal and vertical axes.

To avoid eye and neck strain, content should be designed so that excessive eye and neck movements are

avoided.

AvoidAvoid gaze angles more than 10 degrees above the horizon (vertical movement)

AvoidAvoid gaze angles more than 60 degrees below the horizon (vertical movement)

AvoidAvoid neck rotations more than 45-degrees off-center (horizontal movement)

The optimal (resting) gaze angle is considered between 10-20 degrees below horizon, as the head tends to tilt

downward slightly, especially during activities.

Muscle fatigue can accumulate when users are expected to keep a hand raised throughout the duration of an

experience. It can also be fatiguing to require the user to repeatedly make air tap gestures over long durations.

We therefore recommend experiences avoid requiring constant, repeated gesture input. This goal can be

achieved by incorporating short breaks or offering a mixture of gesture and speech input to interact with the

app.

Gaze

Hologram stability

Instinctual interactions

Holographic frame

Calibration

https://docs.microsoft.com/en-us/hololens/hololens-calibration
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 Rendering on immersive vs. holographic devices

 Fundamentals of rendering on holographic devices

Designing content for mixed reality requires careful consideration of color, lighting, and materials for all your

virtual assets. Aesthetic purposes can include using light and material to set the tone of an immersive

environment, while functional purposes can include using striking colors to alert users of an impending action.

Each of these decisions must be weighed against the opportunities and constraints of your experience’s target

device.

Below are guidelines specific to rendering assets on both immersive and holographic headsets. Many of these

are closely tied to other technical areas and a list of related subjects can be found in the See also section at the

end of this article.

Content rendered in immersive headsets will appear visually different when compared to content rendered in

holographic headsets. While immersive headsets generally render content much as you would expect on a 2D

screen, holographic headsets like HoloLens use color-sequential, see-through RGB displays to renders

holograms.

Always take time to test your holographic experiences in a holographic headset. The appearance of content,

even if it's built specifically for holographic devices, will differ as seen on secondary monitors or in snapshots.

Remember to walk around experiences with a device, testing the lighting of holograms and observing from all

sides (as well as from above and below) how your content renders. Be sure to test with a range of brightness

settings on the device. It's unlikely all users will share an assumed default, and a diverse set of lighting

conditions.

Holographic devices have additive displaysHolographic devices have additive displays  – Holograms are created by adding light to the light

from the real world – white will appear brightly, while black will appear transparent.

Colors impact var ies with the user ’s environmentColors impact var ies with the user ’s environment – There are many diverse lighting conditions in a

user ’s room. Create content with appropriate levels of contrast to help with clarity.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/color-light-and-materials.md


 Designing with color

 Technical considerations

 Design guidelines for holographic display

Avoid dynamic lightingAvoid dynamic lighting – Holograms that are uniformly lit in holographic experiences are the most

efficient. Using advanced, dynamic lighting will likely exceed the capabilities of mobile devices. When

dynamic lighting is required, it's recommended to use the Mixed Reality Toolkit Standard shader.

Because of the nature of additive displays, certain colors can appear different on holographic displays. Some

colors will pop in lighting environments while others will appear as less impactful. Cool colors tend to recede

into the background while warm colors jump to the foreground. Consider these factors as you explore color in

your experiences:

Rendering light colorsRendering light colors  - White appears bright and should be used sparingly. For most cases, consider a

white value around R 235 G 235 B 235. Large bright areas may cause user discomfort. For the UI

window's backplate, it's recommended to use dark colors.

Rendering dark colorsRendering dark colors  - Because of the nature of additive displays, dark colors appear transparent. A

solid black object will appear no different from the real world. See Alpha channel below. To give the

appearance of “black”, try a very dark grey RGB value such as 16,16,16.

Color uniformityColor uniformity  - Typically holograms are rendered brightly enough so that they maintain color

uniformity, whatever the background. Large areas may become blotchy. Avoid large regions of bright,

solid color.

GamutGamut - HoloLens benefits from a "wide gamut" of color, conceptually similar to Adobe RGB. As a result,

some colors can show different qualities and representation in the device.

GammaGamma - The brightness and contrast of the rendered image will vary between immersive and

holographic devices. These device differences often appear to make dark areas of color and shadows,

more or less bright.

Color separationColor separation - Also called "color breakup" or "color fringing", color separation most commonly

occurs with moving holograms (including cursor) when a user tracks objects with their eyes.

AliasingAliasing - Be considerate of aliasing, jagged or “stair steps” where the edge of a hologram’s geometry

meets the real world. Using textures with high detail can aggravate this effect. Textures should be mapped

and filtering enabled. Consider fading the edges of holograms or adding a texture that creates a black

edge border around objects. Avoid thin geometry where possible.

Alpha channelAlpha channel  - You must clear your alpha channel to fully transparent for any parts where you aren't

rendering a hologram. Leaving the alpha undefined leads to visual artifacts when taking images/videos

from the device.

Texture softeningTexture softening - Since light is additive in holographic displays, it's best to avoid large regions of

bright, solid color as they often don't produce the intended visual effect.

https://github.com/microsoft/MixedRealityToolkit-Unity/blob/mrtk_release/Documentation/README_MRTKStandardShader.md


 Storytelling with light and color

 Materials

When designing content for holographic displays, there are several elements that you need to consider

achieving the best experience. Visit Designing content for holographic display for the guidelines and

recommendations.

Light and color can help make your holograms appear more naturally in a user's environment and offer

guidance and help for the user. For holographic experiences, consider these factors as you explore lighting and

color :

VignettingVignetting - A 'vignette' effect to darken materials can help focus the user's attention on the center of

the field of view. This effect darkens the hologram's material at some radius from the user's gaze vector.

This is also effective when the user views holograms from an oblique or glancing angle.

EmphasisEmphasis  - Draw attention to objects or points of interaction by contrasting colors, brightness, and

lighting. For a more detailed look at lighting methods in storytelling, see Pixel Cinematography - A

Lighting Approach for Computer Graphics.

Image: Use of color to show emphasis for storytelling elements, shown here in a scene from Fragments.

Materials are crucial elements for making realistic holograms. By providing proper visual characteristics, you can

http://media.siggraph.org/education/cgsource/Archive/ConfereceCourses/S96/course30.pdf
https://www.microsoft.com/p/fragments/9nblggh5ggm8


 See also

make compelling holographic objects that can blend well with the physical environment. Materials are also

important for providing visual feedback for the various types of user input interactions.

MRTK provides an MRTK Standard Shader with various visual effect options that can be used for visual feedback.

For example, you can use 'Proximity Light' property to provide a lighting effect when the user's finger is

approaching the object's surface. Learn more about MRTK Standard Shader

Video loop: Example of visual feedback based on proximity to a bounding box 

Designing content for holographic display

Color Separation

Holograms

Microsoft Design Language - color

Universal Windows Platform - color

https://github.com/Microsoft/MixedRealityToolkit-Unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/rendering/mrtk-standard-shader
https://www.microsoft.com/design/color
https://docs.microsoft.com/en-us/windows/uwp/style/color
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 How to suggest the scale of objects and environments

  Use the distance of objects as they're presented to the userUse the distance of objects as they're presented to the user

The key to displaying realistic holographic content is mimicking the visual statistics of the real world as closely

as possible. Incorporate visual cues to help real-world users understand where objects are, how big they are,

and what they’re made of. The scale of an object is one of the most important visual cues because it gives viewer

a sense of the objects size and cues to its location. Further, viewing objects at real scale is one of the key

experience differentiators for mixed reality in general – something that hasn’t been possible on previous screen-

based viewing.

There are many ways to suggest the scale of an object, some of which have possible effects on other perceptual

factors. The key one is to display objects at a ‘real’ size, and maintain that realistic size as users move.

Holograms will take up a different amount of a user ’s visual angle of a user as they come closer or further away,

the same way that real objects do.

One common method is to use the distance of objects as they're presented to the user. For example, consider

visualizing a large family car in front of the user. If the car was directly in front of them within arm’s length, it

would be too large to fit in the user ’s field of view. Close objects require the user to move their head and body to

understand the entirety of the object. If the car is placed further away (across the room), the user can establish a

sense of scale by seeing the entire object in their field of view. Users could then move themselves closer to the

object for a more detailed inspection.

Volvo used this technique to create a showroomVolvo used this technique to create a showroom experience for a new car, using the scale of the

holographic car in a way that felt realistic and intuitive to the user. The experience begins with the car hologram

on a physical table, allowing the user to understand the total size and shape of the model. Later in the

experience, the car expands to a scale beyond the size of the device's field of view. Since the user already

acquired a frame of reference from the smaller model, they can adequately navigate around features of the car.

Image: Volvo Cars experience for HoloLens

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/scale.md
https://www.youtube.com/watch?v=DilzwF90vec


  Use holograms to modify the user's real spaceUse holograms to modify the user's real space

 Experimenting with scale

Another method is to use holograms to modify the user's real space, replacing the existing walls or ceilings with

environments or appending ‘holes’ or ‘windows’. This allows over-sized objects to seemingly 'break-through'

the physical space. For example, a large tree might not fit in most users’ living rooms, but by putting a virtual

sky on their ceiling, the physical space expands into the virtual. This allows the user to walk around the base of

the virtual tree and gather a sense of scale and real-world appearance. Users can then look up to see it extend

far beyond the physical space of the room.

Minecraft developed a concept experiencesMinecraft developed a concept experiences  using a similar technique. By adding a virtual window to a

physical surface, the existing objects in the room are placed in the context of a vastly larger environment,

beyond the physical scale limitations of the room.

Image: Minecraft concept experience for HoloLens

Designers have experimented with modifying the scale by changing the displayed ‘real’ size of the object. At the

same time, they maintain a single object position to approximate an object moving towards the viewer without

any actual movement. This was tested in some cases as a way to simulate up-close viewing of items while still

respecting potential comfort limitations of viewing virtual content closer than the “zone of comfort” would

suggest.

This can create a few possible artifacts in the experience however :

For virtual objects that represent some object with a ‘known’ size to the viewer, changing the scale without

changing the position leads to conflicting visual cues. The eyes may still ‘see’ the object at some depth

because of vergence cues. For more information, see the Comfort article. The size acts as a monocular cue

that the object might be getting closer. These conflicting cues lead to confused perceptions – viewers often

see the object as staying in place (because of the constant depth cue) but growing rapidly.

In some cases, change of scale is seen as a ‘looming’ cue instead, where the object may or may not be seen

to change scale by a viewer, but does appear to be moving directly toward the viewer’s eyes (which can be an

uncomfortable sensation).

With comparison surfaces in the real world, such scaling changes are sometimes seen as changing position

https://minecraft.net/
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along multiple axes – objects appear to drop lower instead of moving closer (similar in a 2D projection of 3D

movement in some cases).

Finally, for objects without a known ‘real world’ size (for example, arbitrary shapes with arbitrary sizes, UI

elements, and so on), changing scale may act functionally as a way to mimic changes in distance. Viewers

don't have as many pre-existing top-down cues to understand the object’s true size or location, so the scale

can be processed as a more important cue.

Color, light, and materials

Typography

Spatial sound design
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 Typography in mixed reality

  Create clear hierarchyCreate clear hierarchy

Text is an important element for delivering information in your app experience. Just like typography on 2D

screens, the goal is to be clear and readable. With the three-dimensional aspect of mixed reality, there's an

opportunity to affect the text and the overall user experience in an even greater way.

When we talk about type in 3D, we tend to think extruded, volumetric 3D text. Except for some logotype designs

and a few other limited applications, extruded text tends to degrade the readability of the text. Even though we're

designing experiences for 3D, we use 2D for the type because it's more legible and easier to read.

In HoloLens, type is constructed with holograms using light based on the additive color system. Just like other

holograms, type can be placed in the actual environment where it can be world locked and observed from any

angle. The parallax effect between the type and the environment also adds depth to the experience.

Typographic rules in mixed reality are no different from anywhere else. Text in both the physical world and the

virtual world needs to be legible and readable. Text could be on a wall or superimposed on a physical object. It

could be floating along with a digital user interface. Whatever the context, we apply the same typographic rules

for reading and recognition.

Build contrast and hierarchy by using different type sizes and weights. Defining a type ramp and following it

throughout the app experience will provide a great user experience with consistent information hierarchy.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/typography.md
https://en.wikipedia.org/wiki/Parallax


  Limit your fontsLimit your fonts

  Avoid thin font weightsAvoid thin font weights

  ColorColor

Define your type ramp and follow it throughout the app experience

Avoid using more than two different font families in a single context. Too many fonts will break the harmony

and consistency of your experience and make it harder to consume information. In HoloLens, since the

information is overlaid on top of the physical environment, using too many font styles will degrade the

experience. Segoe UI is the font for all Microsoft digital designs. It's used consistently in the Windows Mixed

Reality shell. You can download the Segoe UI font file from the Windows design toolkit page.

More information about the Segoe UI typeface

Avoid using light or semilight font weights for type sizes under 42 pt because thin vertical strokes will vibrate

and degrade legibility. Modern fonts with enough stroke thickness work well. For example, Helvetica and Arial

are legible in HoloLens using regular or bold weights.

In HoloLens, since the holograms are constructed with an additive light system, white text is highly legible. You

can find examples of white text on the Start menu and the App bar. Even though white text works well without a

back plate on HoloLens, a complex physical background could make the type difficult to read. We recommend

using white text on a dark or colored back plate to improve the user's focus and minimize the distraction from a

physical background.

https://docs.microsoft.com/en-us/windows/uwp/design-downloads/
https://docs.microsoft.com/en-us/windows/uwp/design/style/typography


 Recommended font size

Examples of white text on a dark or colored back plate. 

To use dark text, you should use a bright back plate to make it readable. In additive color systems, black is

displayed as transparent. This means you won't see the black text without a colored back plate.

Examples of white on black and black on white text

Examples of black text in the system apps - Store and Settings

As you can expect, type sizes that we use on a PC or a tablet device (typically between 12–32pt) look small at a

distance of 2 meters. It depends on the characteristics of each font, but in general the recommended minimum

viewing angle and the font height for legibility are around 0.35°-0.4°/12.21-13.97 mm based on our user

research studies. It's about 35-40 pt with the scaling factor introduced in Text in Unity page.



  The minimum legible font sizeThe minimum legible font size

DISTA N C EDISTA N C E VIEW IN G A N GL EVIEW IN G A N GL E T EXT  H E IGH TT EXT  H E IGH T F O N T  SIZ E**F O N T  SIZ E**

45 cm (direct manipulation
distance)

0.4°-0.5° 3.14–3.9mm 8.9–11.13pt

2 m 0.35°-0.4° 12.21–13.97mm 34.63-39.58 pt

  The comfortably legible font sizeThe comfortably legible font size

DISTA N C EDISTA N C E VIEW IN G A N GL EVIEW IN G A N GL E T EXT  H E IGH TT EXT  H E IGH T F O N T  SIZ E**F O N T  SIZ E**

45 cm (direct manipulation
distance)

0.65°-0.8° 5.1-6.3 mm 14.47-17.8 pt

2 m 0.6°-0.75° 20.9-26.2 mm 59.4-74.2 pt

For the near interaction at 0.45 m(45 cm), the minimum legible font's viewing angle and the height are 0.4°-0.5°

/ 3.14–3.9mm. It's about 9-12 pt with the scaling factor introduced in Text in Unity.

Content at near and far interaction range

Segoe UI (the default font for Windows) works well in most cases. Avoid using light or semi light font families in

small size since thin vertical strokes will vibrate and it will degrade the legibility. Modern fonts with enough

stroke thickness work well. For example, Helvetica and Arial look gorgeous and are legible in HoloLens with

regular or bold weights.

For more detailed information about text size calculation in Unity, refer to For more detailed information about text size calculation in Unity, refer to Text in UnityText in Unity



 Resources
  Segoe fontsSegoe fonts

  HoloLens fontHoloLens font

Viewing distance, angle, and text height

(Zip file)

(Zip file)

Image: The HoloLens font gives you the symbol glyphs used in Windows Mixed Reality.

https://download.microsoft.com/download/1/B/C/1BCF071A-78EE-4968-ACBE-15461C274B61/Segoe%20fonts%20v1705.zip
https://download.microsoft.com/download/3/8/D/38D659E2-4B9C-413A-B2E7-1956181DC427/Hololens%20font.zip


 See also
Text in Unity

Color, light, and materials
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https://www.youtube.com/embed/aB3TDjYklmo 

 Spatialization

https://www.youtube.com/embed/PTPvx7mDon4

 Device support

FeatureFeature HoloLens (first gen)HoloLens (first gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Spatialization ✔️ ✔️ ✔️

Spatialization hardware
acceleration

❌ ✔️ ❌

 Case studies

 Spatializer personalization

In real life, spatial sound is vital. When someone calls your name, you know which way to look. If you drop a

coin on the sidewalk, you can tell which way it has rolled. Why? Because you can hear "spatially"--in other

words, you can tell where in your environment the sound is occurring.

In a mixed reality app, you may have to look up, down, from side to side, or behind you to find something that's

happening. At times, it can be unclear where you should look. Spatial sound connects holograms more deeply to

the mixed-reality world and supplies information about the environment and object state. You can provide cues

from the direction you want to draw attention to; this helps users to maintain awareness of their real-world

surroundings and can guide them to their next steps. This increases user confidence in gesture and voice

interactions.

Use of sounds in mixed reality requires a different approach than in touch and keyboard-and-mouse

applications. Key sound design decisions include which sounds to spatialize and which interactions to sonify. For

detailed guidance, see our Spatial sound best practices article.

Spatialization is the directional component of spatial sound. For a 7.1 home theater setup, spatialization is as

simple as panning between loudspeakers. But for headphones in mixed reality, it's essential to use an HRTF-

based technology for accuracy and comfort. Windows offers HRTF-based spatialization, and this support is

hardware-accelerated on HoloLens 2.

For suggestions on effective use of spatialization in your application, see Spatial sound best practices.

HoloTour virtually takes users to tourist and historical sites around the world. See the Sound design for

HoloTour case study. A special microphone and rendering setup were used to capture the subject spaces.

RoboRaid is a high-energy shooter for HoloLens. The Sound design for RoboRaid case study describes the

design choices that were made to ensure spatial sound was used to the fullest dramatic effect.

The low-latency head tracking of mixed reality headsets, including HoloLens, supports high-quality HRTF-based

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/spatial-sound.md
https://www.youtube.com/embed/aB3TDjYklmo
https://en.wikipedia.org/wiki/Head-related_transfer_function
https://www.youtube.com/embed/PTPvx7mDon4
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


 Spatializer platform support

 Spatializer middleware support

 Acoustics

 Next steps

spatialization.

HRTFs manipulate the level and phase differences between ears across the frequency spectrum. They're based

on physical models and measurements of human head, torso, and ear shapes (pinnae). Our brains respond to

these differences to provide perceived direction in sound.

Every individual has a unique ear shape, head size, and ear position. So the best HRTFs conform to you. To

increase spatialization accuracy, HoloLens uses your inter-pupilary distance (IPD) from the headset displays to

adjust the HRTFs for your head size.

Windows offers spatialization, including HRTFs, via the ISpatialAudioClient API. This API exposes the HoloLens 2

HRTF hardware acceleration to applications.

Support for Windows' HRTFs is available for the following third-party audio engines.

A Unity audio engine plugin

A Wwise audio engine plugin

Spatial sound is about more than direction. Other dimensions include occlusion, obstruction, reverb, portaling,

and source modeling. Collectively these dimensions are referred to as acoustics. Without acoustics, spatialized

sounds lack perceived distance.

Acoustics treatments range from simple to complex. You can use a reverb that's supported by any audio engine

to push spatialized sounds into the environment of the listener. Acoustics systems such as Project Acoustics

provide richer and more compelling acoustics treatment. Project Acoustics can model the effect of walls, doors,

and other scene geometry on a sound. It's an effective option for cases where the relevant scene geometry is

known at development time.

Spatial sound in Unity

Spatial sound best practices

https://docs.microsoft.com/en-us/windows/win32/coreaudio/spatial-sound
https://www.audiokinetic.com/products/plug-ins/msspatial/
https://docs.microsoft.com/en-us/gaming/acoustics/what-is-acoustics
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https://www.youtube.com/embed/aB3TDjYklmo

 When to add sounds

  Inform and reinforceInform and reinforce

  Exercise restraintExercise restraint

  Don't rely solely on soundsDon't rely solely on sounds

 How to sonify interactions

  Gesture interactionsGesture interactions

If you're new to working with spatial sound, see our Spatial sound overview.

You can use sound to inform and reinforce the user's mental model of application state. Use spatialization, when

appropriate, to place sounds in the mixed-reality world. When you connect the auditory and the visual in this

way, you deepen the intuitive nature of interactions and increase user confidence.

Mixed-reality applications often have a greater need for sound than 2D apps because of their lack of a tactile

interface. Add sounds when they inform the user or reinforce interactions.

For events that aren't initiated by the user, such as notifications, use sound to inform the user that a change

occurred.

Interactions may have several stages. Use sound to reinforce stage transitions.

See the following examples of interactions, events, and suggested sound characteristics.

Users don't have an unlimited capacity for audio information.

Each sound should communicate specific, valuable information.

When your app plays a sound to inform the user, temporarily reduce the volume of other sounds.

For button hover sounds (see the following information), add a time delay to prevent excessive sound

triggering.

Sounds that are used well are valuable to your users. But make sure your application is usable even with the

sound turned off.

Users may be hearing impaired.

Your application may be used in a loud environment.

Users may have privacy concerns or other reasons to disable device audio.

Interaction types in mixed reality include gesture, direct manipulation, and voice. Use the following suggested

characteristics to select or design sounds for these interactions.

In mixed reality, users may interact with buttons by using a mouse. Button actions generally occur when the user

releases rather than presses the button to give the user a chance to cancel the interaction. Use sounds to

reinforce these stages. To assist users in targeting distant buttons, also consider using a pointer-hover sound.

Button-press sounds should be a short, tactile "click."

Example: MRTK_ButtonPress.wav

Button-"unpress" sounds should have a similar tactile feel. A higher pitch than the press sound reinforces the

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/spatial-sound-design.md
https://www.youtube.com/embed/aB3TDjYklmo
https://github.com/microsoft/MixedRealityToolkit-Unity/tree/main/Assets/MRTK/SDK/StandardAssets/Audio/MRTK_ButtonPress.wav


  Direct manipulationDirect manipulation

  Voice interactionsVoice interactions

  NotificationsNotifications

sense of completion.

Example: MRTK_ButtonUnpress.wav

For hover sounds, consider using a subtle and non-threatening sound, such as a low-frequency thud or

bump.

On HoloLens 2, articulated hand tracking supports direct manipulation of user-interface elements. Sounds are

important when there's no other physical feedback.

A button press sound is important because the user doesn't get any other indication when they reach the

bottom of the key stroke. Sound indicators of key travel can be small, subtle, and occluded. As with gesture

interactions, button presses should get a short, tactile sound like a click. Unpresses should have a similar click

sound but with raised pitch.

Example: MRTK_ButtonPress.wav

Example: MRTK_ButtonUnpress.wav

It's difficult to visually confirm a grab or release action. The user's hand will often be in the way of any visual

effect, and hard-bodied objects lack a real-world visual analog of "grabbing." Sounds can effectively

communicate successful grab and release interactions.

Grab actions should have a short, somewhat-muffled tactile sound that prompts the idea of fingers closing

around an object. Sometimes there's also a "whoosh" sound that leads up to the grabbing sound to

communicate the motion of the hand.

Example: MRTK_Move_Start.wav

Release actions should get a similarly short and tactile sound. It's usually lower pitched than the grab sound

and in reverse order, with an impact and then a "whoosh" to communicate that the object is settling into

place.

Example: MRTK_Move_End.wav

A drawing interaction should get a persistent, looping sound with volume determined by the user's hand

movement. It should be silent when the user's hand is still and loudest when the hand is moving quickly.

Voice interactions often have subtle visual elements. Use sounds to reinforce interaction stages. You may want to

use more-tonal sounds to distinguish them from gesture and direct-manipulation sounds.

Use a positive-sounding tone for voice command confirmations. Rising tones and major musical intervals

are effective.

Use a shorter, less-positive-sounding tone for voice command failures. Avoid negative sounds. Instead, use a

more percussive, neutral sound to communicate that the application is moving on from the interaction.

If your application has a wake word, use a short, gentle tone when the device starts listening. Use a subtle

looping sound while the application is listening.

Notifications signal application-state changes and other events the user didn't initiate. State changes can include

process completions, messages, and phone calls.

In mixed reality, objects sometimes move out of the user's field of view. Pair moving animated objects with a

spatialized sound that depends on the object type and speed of motion.

It helps to play a spatialized sound at the end of an animation to inform the user of the object's new position.

For gradual movements, a "whoosh" sound during movement helps the user track the object.

Message notification sounds may be heard repeatedly, sometimes in quick succession. It's important they don't

stand out or sound harsh. Mid-range positive tonal sounds are effective.

https://github.com/microsoft/MixedRealityToolkit-Unity/tree/main/Assets/MRTK/SDK/StandardAssets/Audio/MRTK_ButtonUnpress.wav
https://github.com/microsoft/MixedRealityToolkit-Unity/tree/main/Assets/MRTK/SDK/StandardAssets/Audio/MRTK_ButtonPress.wav
https://github.com/microsoft/MixedRealityToolkit-Unity/tree/main/Assets/MRTK/SDK/StandardAssets/Audio/MRTK_ButtonUnpress.wav
https://github.com/microsoft/MixedRealityToolkit-Unity/tree/main/Assets/MRTK/SDK/StandardAssets/Audio/MRTK_Move_Start.wav
https://github.com/microsoft/MixedRealityToolkit-Unity/tree/main/Assets/MRTK/SDK/StandardAssets/Audio/MRTK_Move_End.wav


 Handle spatialization

  Which sounds to spatializeWhich sounds to spatialize

  When and how to apply distance-based attenuationWhen and how to apply distance-based attenuation

  Which spatialization technology to useWhich spatialization technology to use

 Next steps

Incoming-call sounds should have similar qualities to a cell phone ringtone. These sounds are looping

musical phrases that play until the user answers the call.

Voice communication connection and disconnection should have a short, tonal sound. The connection sound

should be a positive tone to indicate a successful connection. The disconnection sound should be a neutral

sound to indicate completion of the call.

Spatialization uses stereo headphones or speakers to place sounds in the mixed-reality world.

A sound should be spatialized when it's associated with an event that has a spatial location. This includes UI,

embodied AI voices, and visual indicators.

Spatialize user interface elements to help declutter the user's sonic "space" by limiting the number of stereo

sounds that they hear. Manipulation interactions such as touching, grabbing, and releasing feel more natural

when audio feedback is spatialized. Consider the following information about distance attenuation for these

elements.

Spatialize visual indicators and embodied AI voices to intuitively inform users when these things are outside the

field of view.

In contrast, avoid spatialization for faceless AI voices and other elements that lack a well-defined spatial location.

Spatialization without a related visual element can distract users into thinking there's a visual element that they

can't find.

Spatialization does come with some CPU cost. Many applications have at most two sounds playing

simultaneously. The cost of spatialization in that case is likely negligible. You can use the MRTK frame rate

monitor to judge the impact of adding spatialization.

In the physical world, sounds that are farther away are quieter. Your audio engine can model this attenuation

based on the source distance. Use distance-based attenuation when it communicates relevant information.

The distances to visual indicators, animated holograms, and other informative sounds are relevant to the user.

Use distance-based attenuation to intuitively provide cues.

Adjust the attenuation curve for each source to fit the size of your mixed-reality world's spaces. Your audio

engine's default curve is often meant for large (up to half-kilometer) spaces.

Sounds that reinforce the progressive stages of button actions and other interactions shouldn't get attenuation

applied. The reinforcing effects of these sounds are more important than communicating the distance to the

button. Variations can be distracting, especially with keyboards, when many button clicks may be heard in

succession.

With headphones or the HoloLens speakers, use head-related transfer function (HRTF)-based spatialization

technologies. These technologies model the sound propagation around the head in the physical world. Even

when a sound source is on the far side of one's head, sound propagates to the distant ear with some attenuation

and delay. Speaker panning relies only on attenuation and applies total attenuation in the left ear when sounds

are on the right side, and the other way around. This technique can be uncomfortable for "normal hearing"

listeners and inaccessible for listeners who have hearing impairment in one ear.

Use spatial sound in Unity



Case study of Roboraid

Case study of HoloTour
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 The tech

 Behind the scenes

  Capturing the audioCapturing the audio

Panoramic videos and holographic scenery are only part of the formula for an immersive Microsoft HoloLens

tour. This article describes how sound was used to make you feel like you're actually in each HoloTour location.

The beautiful imagery and holographic scenes that you see in HoloTour are only one part of a believable mixed-

reality experience. While holograms only appear in front of a user, HoloLens can deliver spatial sound from all

directions, which provides a more-complete sensory experience.

Spatial sound provides cues to indicate a direction the user should turn or to let the user know there are more

holograms to see within their space. We can also attach a sound directly to a hologram and continually update

the direction and distance that the hologram is from the user. This technique makes it seem as if the sound is

coming directly from that object.

For HoloTour, we wanted to take advantage of the spatial sound capabilities of HoloLens, so we created a 360-

degree ambient environment that's synchronized with the video to reveal the sonic highlights of specific

locations.

We created HoloTour experiences of two different locations: Rome and Machu Picchu. To make these tours feel

authentic and compelling, we wanted to capture audio from the locations where we filmed instead of using

generic sounds.

In our case study about capturing the visual content for HoloTour, we talk about the design of our camera rig. It

consisted of 14 GoPro cameras in a 3D-printed housing that was designed to fit the tripod. To capture audio, we

added a quad-microphone array below the cameras. The sound feeds into a compact four-channel recording

unit at the base of the tripod. We chose microphones that did well but were small enough to avoid interfering

with the cameras.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/case-study-spatial-sound-design-for-holotour.md
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-capturing-and-creating-content-for-holotour


  Editing the audioEditing the audio

  Assembling the sceneAssembling the scene

Custom camera and microphone rig

This setup captures sound in four directions. We recorded enough information to re-create a 3D aural panorama

of spatial sound, which we could later synchronize to the 360-degree video.

One challenge of the camera-array audio is that you're at the mercy of off-camera sounds, such as sirens,

airplanes, or high winds. To make sure we had all the sound elements we needed, we used stereo and mono

mobile recorders to capture asynchronous, ambient sound at specific points of interest in each location. These

recordings give the sound designer clean content to add interest and improve directionality in post-production.

Every capture day generates many files. So it was important to develop a system to track which files correspond

to a particular location or camera shot. Our recording unit was set up to automatically name files by date and

"take" number. We backed up files to external drives at the end of each day. We also found it important to

verbally slate the beginning of the audio recordings. This precaution allows easy contextual identification of the

content in case file-name problems occur. It was also important to visually slate the camera rig capture, because

the video and audio were recorded as separate media and had to be synchronized during post-production.

Back at the studio after the capture trip, the first step in assembling a directional and immersive aural experience

is to review all the captured audio for a location. We pick the best takes and identify highlights that can be

applied during integration. The audio is then edited and cleaned up. For example, a car horn blast that lasts a

second or so and repeats a few times might be replaced with quieter ambient audio from the same capture

session.

After the video edit for a location is set, the sound designer can synchronize the corresponding audio. At this

point, we assess both the camera-rig and mobile sound captures to decide which elements would build the best

immersive audio scene. We found it useful to put all the sound elements into an audio editor and build quick

linear mock-ups to experiment with different mix ideas. This step gave us better-formed ideas for when it came

time to build the actual HoloTour scenes.

The first step to building a 3D ambient scene is to create a bed of general background ambient looping sounds

that will support other features and interactive sound elements in a scene. We take a holistic approach to



 Tips and tricks

 See also

implementation as determined by the design criteria for any particular scene. Some scenes might index toward

using the synchronized camera capture. More "cinematic" moments might require a curated approach that relies

on discretely placed sounds, interactive elements, and music.

When we indexed on the camera-capture audio, we placed spatial sound-enabled ambient audio emitters that

corresponded to the directional orientation of the cameras. The north camera view plays audio from the north

microphone, and likewise for the other cardinal directions. These emitters are world-locked, which means the

sound changes when users turn their heads. This technique effectively models the sound of standing at that

location. Listen to Piazza Navona or The Pantheon for examples of scenes that use a good mix of camera-

captured audio.

In a different approach, we sometimes play looping stereo ambience with spatial sound emitters that are placed

around the scene. These emitters play one-off sounds of randomized volume, pitch, and trigger frequency. This

technique creates ambience that has an enhanced sense of directionality. In Aguas Alienates, for example, you

can hear how each quadrant of the panorama has specific emitters that highlight specific areas of the geography

but work together to create an overall immersive ambience.

There are other ways to highlight directionality and improve immersion to make full use of the spatial sound

capabilities of HoloLens. We've provided a list here. Listen for these effects the next time that you try HoloTour.

Look targets:Look targets: These sounds are triggered when you look at a specific object or area of the holographic

frame. For example, look toward the street-side café in Rome's Piazza Navona to subtly trigger busy-

restaurant sounds.

Local vision:Local vision: The journey though HoloTour contains certain "beats" where your tour guide, aided by

holograms, explores a topic in-depth. For instance, as the façade of the Pantheon dissolves to reveal the

oculus, reverberating audio that was placed as a 3D emitter from inside the Pantheon encourages the user to

explore the interior.

Enhanced directionality:Enhanced directionality: Within many scenes, we placed sounds in various ways to add to directionality. In

the Pantheon scene, for example, the sound of the fountain was placed as a separate emitter close enough to

the user that they could get a sense of "sonic parallax" as they walk around the play space. In Peru's Salinas

de Maras scene, the sounds of individual little streams were placed as separate emitters to build a more

immersive ambient environment, surrounding the user with the authentic sounds of that location.

Spline emitter :Spline emitter : These emitters move in 3D space based on the visual position of the object that they're

attached to. An example is the train in Machu Picchu, where we used a spline emitter to give a distinct sense

of directionality and movement.

Music and SFX:Music and SFX: Certain aspects of HoloTour that represent a more stylized or cinematic approach use

music and sound effects to heighten emotional impact. For example, the gladiator battle at the end of the

Rome tour uses special effects like whooshes and stingers to strengthen the effect of labels that appear in the

scenes.

Spatial sound

Spatial sound design

Spatial sound in Unity

Video: Microsoft HoloLens: HoloTour

https://www.youtube.com/watch?v=pLd9WPlaMpY
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 The tech

 Behind the scenes

  Be mindful of taxing the CPUBe mindful of taxing the CPU

  Rewarding a successful dodgeRewarding a successful dodge

This article describes challenges the Microsoft HoloLens Experience Team faced while creating audio for the

RoboRaid mixed-reality first-person shooter.

Spatial sound is one of the most exciting features of Microsoft HoloLens, letting users perceive what's going on

around them when objects aren't in the line of sight.

In RoboRaid, the most obvious and effective use of spatial sound is alerting the player to something happening

outside of their peripheral vision. For example, the Breacher can enter from any of the scanned walls in the

room. If you're not facing the location where it's entering, you might miss it. To alert you to this invasion, you'll

hear a distinct bit of audio coming from where the Breacher is entering, which lets you know you need to act

quickly to stop it.

Creating spatial sound for HoloLens apps is so new and unique that problems can be difficult to solve because

there aren't any past projects to reference. Hopefully, these examples of the audio challenges we faced while

making RoboRaid will help you as you create audio for your own apps.

Spatial sound can be demanding on the CPU. For a busy experience like RoboRaid, it was crucial to keep the

number of spatial sound instances to under eight at any given time. Usually, it was as easy as setting the limit of

instances for different audio events. Any instances that happen after the limit is reached are killed. For example,

when drones spawn, their screams are limited to three instances at any given time. Considering only about four

drones can spawn at once, three screams are plenty since there’s no way your brain can keep track of that many

similar-sounding audio events. This freed up resources for other spatial sound events, like enemy explosions or

enemies preparing to shoot.

The dodging mechanic is one of the most important gameplay mechanics in RoboRaid, and also something that

we felt was truly unique to the HoloLens experience. As such, we wanted to make successful dodges very

rewarding to the player. We got the Doppler "whizz-by" to sound compelling fairly early on in the development.

Initially, my plan was to use a loop and manipulate it in real-time using volume, pitch, and filter. The

implementation for this was going to be very elaborate. Before committing resources to build this we created a

cheap prototype using an asset with the Doppler effect baked in just to find out how it felt. Our talented dev

made it so that this whizz-by asset would play back exactly 0.7 second before the projectile will have passed by

the player ’s ear and the results felt amazing! Needless to say, we ditched the more complex solution and

implemented the prototype.

(For more information about creating an audio asset with the Doppler effect built in, see 100 Whooshes in 2

Minutes.) 

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/case-study-using-spatial-sound-in-roboraid.md
https://www.microsoft.com/p/roboraid/9nblggh5fv3j
http://designingsound.org/2010/02/26/charles-deenen-special-100-whooshes-in-2-minutes/


  Ditching ineffective soundsDitching ineffective sounds

  Communicating a hitCommunicating a hit

  Getting big sound from small speakersGetting big sound from small speakers

Originally, we had wanted to play an explosion sound behind the player once they’ve successfully dodged the

enemy projectile, but we decided to ditch this for several reasons. First, it didn’t feel as effective as the whizz-by

SFX we used for the dodge. By the time the projectile hits a wall behind you, something else would have

happened in the game that would mask that sound. Second, we didn’t have collision on the floor, so we couldn’t

get the explosion to play when the projectile hit the floor instead of the walls. And finally, there was the CPU cost

of spatial sound. The Elite Scorpion enemy (one that can crawl inside the wall) has a special attack that shoots

about eight projectiles. Not only did that make a huge mess in the mix, it also introduced awful crackling

because it was hitting the CPU too hard.

An interesting issue we ran into on the HoloLens was how difficult it was to effectively communicate that a

player had been hit. What makes a mixed reality experience successful is the feeling that the story is happening

to you. That means you have to believe YOU are fighting an alien robot invasion in your own living room.

Players obviously won't feel anything when they get hit, so we had to find a way to convince the player that

something bad happened to them. In conventional games, you might see an animation that lets you know your

character has taken a hit, or the screen might flash red and your character might grunt a little. Since these types

of cues don't work in a mixed reality experience, we decided to combine the visual cue with an exaggerated

sound that indicates you've taken damage. I created a big sound, and made it so prominent in the mix that it

ducked everything down. Then, to make it stand out even more, we added a short warning sound as if a nuclear

sub was sinking. 

HoloLens speakers are small and light to suit the needs of the device, so you can’t expect to hear too much low-

end. Similar to developing for smart phones or handheld gaming devices, sound designers and composers have

to be mindful of the frequency content of their audio. I always design sounds or write music with full frequency

range because wearing headphones is an option for the users. However, to ensure compatibility with HoloLens

speakers, I run a test occasionally by putting an EQ in the master of any DAW I happen to be working in. The EQ



  Making your audio cues stand outMaking your audio cues stand out

 Do it yourself

setting consists of a high-pass filter around 600 Hz to 700 Hz (not too steep) and low-pass filter at around 10K

(steep). That should give you an approximate idea of how your sounds will play back on the device.

If you're relying on bass to give the sense of chord changing in your music, you may find that your music

completely loses the sense of root when you apply this EQ setting. To remedy this, I added another layer to the

bass that is one octave higher (with some rich harmonics) and mixed it to get the sense of root back. Sometimes

using distortion to amp up the harmonics will give enough frequency content in the upper range to make our

brain think that there’s something underneath it. This is true for SFX like impacts, explosions, or sounds for

special moments, such as a boss' super attacks. You really can’t rely on the low-end to give the player a sense of

impact or weight. As with music, using distortion to give some crunch definitely helped.

Naturally, everyone on the team wanted bombastic music, loud guns, and crazy explosions; but they also wanted

to be able to hear voiceover or any other game-critical audio cues.

On a console game with full range of frequency, you have more options to divide frequencies up depending on

the importance of the sound. For RoboRaid, I was limited in the number of ranges of frequencies I could curve

out from sounds. If you use low-pass filter and curve out too much from the higher end of the spectrum, you

won’t have anything left on the sound because there’s not much low-end.

To make RoboRaid sound as big as it can on the device, we had to lower the dynamic range of the whole

experience and made extensive use of ducking by creating a clear hierarchy of importance for different types of

sounds. I set the ducking from -2 dB to -6 dB depending on the importance. I personally don’t like obvious

ducking in games, so I spent a lot of time tuning the fade in/out timing and the amount of volume attenuation.

We set up separate busses for spatial sound, non-spatial sound, VO, and dry bus without reverb for music. Then,

we created high priority, critical, and non-critical busses so the assets were set up to go to their appropriate

busses.

I hope audio professionals out there will have as much fun and excitement working on their own apps as I did

working on RoboRaid. I can’t wait to see (and hear!) what the talented folks outside Microsoft will come up with

for HoloLens.

One trick I discovered to make certain events (such as explosions) sound "bigger"—like they're filling up the

room—was to create a mono asset for the spatial sound and mix it with a 2D stereo asset, to be played back in

3D. It does take some tuning, since having too much information in the stereo content will lessen the

directionality of the mono assets. However, getting the balance right will result in huge sounds that will get

players to turn their heads in the right direction.

You can try out big sounds yourself using the audio assets below:

Scenario 1Scenario 1

1. Download roboraid_enemy_explo_mono.wav and set to play back through spatial sound and assign it to an

event.

2. Download roboraid_enemy_explo_stereo.wav and set to play back in 2D stereo and assign to the same event

as above. Because these assets are normalized to Unity, attenuate volume of both assets so that it doesn’t

clip.

3. Play both sounds together. Move your head around to feel how spatial it sounds.

Scenario 2Scenario 2

1. Download roboraid_enemy_explo_summed.wav and set to play back through spatial sound and assign to an

event.

2. Play this asset by itself then compare it to the event from Scenario 1.

file:///C:/localrun/t/fs14/bgqa/windows/mixed-reality/design/images/roboraid-enemy-explo-mono.wav
file:///C:/localrun/t/fs14/bgqa/windows/mixed-reality/design/images/roboraid-enemy-explo-stereo.wav
file:///C:/localrun/t/fs14/bgqa/windows/mixed-reality/design/images/roboraid-enemy-explo-summed.wav


 See also

3. Try different balance of mono and stereo files.

Spatial sound

RoboRaid for Microsoft HoloLens

https://www.microsoft.com/p/roboraid/9nblggh5fv3j
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 Device support

FeatureFeature HoloLens (1st gen)HoloLens (1st gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Finger cursor ❌ ✔️ ❌

Ray cursor ❌ ✔️ ✔️

Head-gaze cursor ✔️ ✔️ ✔️

 Finger cursor

A cursor provides continuous feedback based on where the headset believes a users current focus is at a given

time. Cursor feedback includes what area, hologram, or point in the virtual environment responds to input. Even

though the cursor is a digital representation of where the device understands the user's attention to be, that's

not the same as determining the user's intentions. The cursor feedback also lets users know what system

responses to expect. You can use the feedback to communicate their intention to the device, which increases

user confidence.

There are 3 kinds of cursors: finger, rayfinger, ray , and head-gazehead-gaze. These pointing cursors work with different input

modalities on HoloLens, HoloLens 2, and immersive headsets. Below is guidance on which type of cursor to use

for each type of headset and interaction model. In the Mixed Reality Toolkit (MRTK), we've created drag-and-drop

cursors modules to help you build the right pointing experience.

The finger cursor is only available on the HoloLens 2 to enhance the "direct manipulation with hands"

interaction mode. We've attached rings to the tips of both index fingers to better understand where the finger is

pointing. The ring size is based on the proximity of the finger to the UI surface, which shrinks to a small dot

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/cursors.md
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


 Ray cursor

when the finger touches the UI. The closer the finger, the smaller the ring. 

Visual feedback states of finger cursorVisual feedback states of finger cursor  1: The ring shrinks to a dot. 2: The ring aligns with surface. 3: The

ring is perpendicular to finger vector. 4: No ring.

Ray cursors attach to the end of far pointing rays to allow manipulation of objects that are out of hands-reach. In

immersive headsets, the rays shoot out from motion controllers and end in dot cursors. In HoloLens 2, we apply

the mental model of these motion controller rays and designed hand rays that originate from the palms and end

in ring-shaped cursors that are consistent with finger cursors used in direct manipulation. 

Ray cursors of motion controllersRay cursors of motion controllers



 Head-gaze cursor

Ray cursors of handsRay cursors of hands

The head-gaze cursor is a dot that attaches to the end of an invisible head-gaze vector that uses the position and

rotation of the head to point. To execute actions, this pointing cursor is paired with various commit inputs such

as air tap, voice commands, dwell, and button press. In HoloLens 2, head-gaze is best paired with any commit

input that isn't air tap, as there will be interaction conflict between air tap and far hand rays. 

Head-gaze cursor with hand gestureHead-gaze cursor with hand gesture



 Cursor customization recommendations

  Cursor scaleCursor scale

  Directionless cursor shapeDirectionless cursor shape

  Look and feelLook and feel

Head-gaze cursor with voice commandHead-gaze cursor with voice command

If you would like to customize the cursor feedback behaviors and appearances, here are some design

recommendations:

The cursor should be no larger than the available targets, allowing users to easily interact with and view the

content.

Depending on the experience you create, scaling the cursor as the user looks around is also an important

consideration. For example, as the user looks further away in your experience, the cursor shouldn't become

too small such that it's lost.

When scaling the cursor, consider applying a soft animation to it as it scales to give it an organic feeling.

Avoid obstructing content. Holograms are what make the experience memorable and the cursor shouldn't be

taking away from them.

Although there's no one right cursor shape, we recommend that you use a directionless shape like a torus. A

cursor that points in some direction (For example, a traditional arrow cursor) might confuse the user to

always look that way.

An exception to this is when using the cursor to communicate interaction instruction to the user. For example,

when scaling holograms in the Mixed Reality OS, the cursor temporarily includes arrows that instructs the

user on how to move their hand to scale the hologram.

A donut or torus shaped cursor works for many applications.

Pick a color and shape that best represents the experience you're creating.

Cursors are especially prone to color separation.

A small cursor with balanced opacity keeps it informative without dominating the visual hierarchy.



  Visual cuesVisual cues

  Possible actionsPossible actions

  Input stateInput state

 Going "cursor-free"

Be cognizant of using shadows or highlights behind your cursor as they might obstruct content and distract

from the task at hand.

Cursors should align to and hug the surfaces in your app. Users will have a feeling that the system can see

where they're looking, but also that the system is aware of their surroundings. For example, the cursor in the

Mixed Reality OS aligns to the surfaces of the user's world, creating a feeling of awareness of the world even

when the user isn't looking directly at a hologram.

Magnetically locking the cursor to an interactive element when it's close to the user can help improve

confidence that user will interact with that element when they use a selection action.

If your experience is focused on a single hologram, your cursor should align and hug only that hologram and

change shape when you look away from that hologram. This can convey to the user that the hologram is

actionable and they can interact with it.

If your application uses spatial mapping, then your cursor could align and hug every surface it sees. This

gives feedback to the users that HoloLens and your application can see their space. This reinforces the fact

that holograms are real and in our world and helps bridge the gap between real and virtual.

Have an idea of what the cursor should do when there are no holograms or surfaces in view. Placing it at a

predetermined distance in front of the user is one option.

The cursor can be represented by different icons to convey possible actions a hologram can do, such as

scaling or rotation.

Only add extra information on the cursor if it means something to the user. Otherwise, users might either not

notice the state changes or get confused by the cursor.

We could use the cursor to display the user's input state or intent. For example, we could display an icon

telling the user the system sees their hand state and that the application knows they're ready to take

action.

We could also use the cursor to show users that voice commands have been heard by the system via a

momentary color change

The following cursor states can be implemented in different ways. You might implement these different

states by modeling the cursor like a state machine. For example:

Idle state is where you show the default cursor.

Ready state is when you've detected the user's hand in the ready position.

Interaction state is when the user is doing a particular interaction.

Possible Actions state or hover state is when you convey possible actions that can be performed on a

hologram.

You could also implement these states in a skin-able manner to display different art assets when you detect

different states.

Designing without a cursor is recommended when the sense of immersion is a key component of an experience

and when pointing interactions (through gaze and gesture) don't require great precision. The system still needs

to meet the normal requirements of a cursor : providing users with continuous feedback on the system's

understanding of their pointing, and helping them to communicate their intentions to the system. This may be

achievable through other noticeable state changes.



 Cursor in MRTK (Mixed Reality Toolkit) for Unity

 See also

By default, MRTK provides a cursor prefab(DefaultCursor.prefab) which has the same visual state as the shell's

system cursor. It's assigned in MRTK's Input profile, under Pointers. You can replace/customize this cursor for

your experience. For the experience with eye-tracking input, MRTK also provides EyeGazeCursor, which has

subtle visual to minimize the distraction.

MRTK - Pointer profile

MRTK - Input system

MRTK - Pointers

Gestures

Head-gaze and commit

https://github.com/Microsoft/MixedRealityToolkit-Unity
https://github.com/microsoft/MixedRealityToolkit-Unity/tree/mrtk_release/Assets/MixedRealityToolkit.SDK/Features/UX/Prefabs/Cursors
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/configuration/mixed-reality-configuration-guide#pointer-configuration
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/overview
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/pointers
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 Device support

Input modelInput model HoloLens (1st gen)HoloLens (1st gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Point and commit with hands ❌ Not supported ✔️ Recommended ✔️ Recommended

 Hand rays

Point and commit with hands is an input model that lets users target, select, and manipulate out of reach 2D and

3D content. This "far" interaction technique is unique to mixed reality because humans don't naturally interact

with the real world that way. For example, in the super hero movie, X-Men, the character Magneto can

manipulate far objects in the distance with his hands. This isn't something humans can do in reality. In both

HoloLens (AR) and Mixed Reality (MR), we equip users with this magical power to break the physical constraint

of the real world. Not only is it a fun holographic experience, but it also makes user interactions more effective

and efficient.

"Point and commit with hands" is one of the new features that use the new articulated hand-tracking system.

This input model is also the primary input model on immersive headsets by using motion controllers.

On HoloLens 2, we created a hand ray that shoots out from the center of the user's palm. This ray is treated as

an extension of the hand. A donut-shaped cursor is attached to the end of the ray to indicate the location where

the ray intersects with a target object. The object that the cursor lands on can then receive gestural commands

from the hand.

This basic gestural command is triggered by using the thumb and index finger to do the air-tap action. By using

the hand ray to point and air tap to commit, users can activate a button or a hyperlink. With more composite

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/point-and-commit.md
https://en.wikipedia.org/wiki/Magneto_(comics)
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


 Transition between near and far

gestures, users can navigating web content and manipulating 3D objects from a distance. The visual design of

the hand ray should also react to these point and commit states, as described and shown below:

Pointing statePointing state

In the pointing state, the ray is a dash line and the cursor is a donut shape.

Commit stateCommit state

In the commit state, the ray turns into a solid line and the cursor shrinks to a dot.

Instead of using specific gestures like "pointing with index finger" to direct the ray, we designed the ray to

comout out from the center of the users' palm. This way, we've released and reserved the Five Fingers for more

manipulative gestures like pinch and grab. With this design, we create only one mental model - the same set of

hand gestures are used for both near and far interaction. You can use the same grab gesture to manipulate



 2D slate interaction

objects at different distances. The invocation of the rays is automatic and proximity-based as follows:

Near manipulationNear manipulation

When an object is within arm's length (roughly 50 cm), the rays are turned off automatically, encouraging near

interaction.

Far manipulationFar manipulation

When the object is farther than 50 cm, the rays are turned on. The transition should be smooth and seamless.

A 2D slate is a holographic container hosting 2D app contents, such as a web browser. The design concept for far

interacting with a 2D slate is to use hand rays to target and air tap to select. After targeting with a hand ray,

users can air tap to trigger a hyperlink or a button. They can use one hand to "air tap and drag" to scroll slate

content up and down. The relative motion of using two hands to air tap and drag can zoom in and out the slate



content.

Targeting the hand ray at the corners and edges reveals the closest manipulation affordance. By "grab and drag"

manipulation affordances, users can do uniform scaling through the corner affordances, and can reflow the slate

via the edge affordances. Grabbing and dragging the holobar at the top of the 2D slate lets users move the

entire slate.

ClickClick

ScrollScroll



 3D object manipulation

  Affordance-based manipulationAffordance-based manipulation

ZoomZoom

For manipulating the 2D slateFor manipulating the 2D slate

Users point the hand ray at the corners or edges to reveal the closest manipulation affordance.

By applying a manipulation gesture on the affordance, users can do uniform scaling through the corner

affordance, and can reflow the slate via the edge affordance.

By applying a manipulation gesture on the holobar at the top of the 2D slate, users can move the entire slate.

In direct manipulation, there are two ways for users to manipulate 3D objects: affordance-based manipulation

and non-affordance based manipulation. In the point and commit model, users can achieve exactly the same

tasks through the hand rays. No extra learning is needed.

Users use hand rays to point and reveal the bounding box and manipulation affordances. Users can apply the

manipulation gesture on the bounding box to move the whole object, on the edge affordances to rotate, and on

the corner affordances to scale uniformly. 



  Non-affordance-based manipulationNon-affordance-based manipulation

 Instinctual gestures

MoveMove

RotateRotate

ScaleScale

Users point with hand rays to reveal the bounding box then directly apply manipulation gestures on it. With one

hand, the translation and rotation of the object are associated to motion and orientation of the hand. With two

hands, users can translate, scale, and rotate it according to relative motions of two hands.

The concept of instinctual gestures for point and commit is similar to that for direct manipulation with hands.

The gestures users do on a 3D object are guided by the design of UI affordances. For example, a small control

point might motivate users to pinch with their thumb and index finger, while a user might want to use all Five

Fingers to grab a larger object.



Small objectSmall object

Medium objectMedium object

Large objectLarge object



 Symmetric design between hands and 6 DoF controller

 Hand ray in MRTK (Mixed Reality Toolkit) for Unity

The concept of point and commit for far interaction was created and defined for the Mixed Reality Portal (MRP).

In this scenario, a user wears an immersive headset and interacts with 3D objects via motion controllers. The

motion controllers shoot out rays for pointing and manipulating far objects. There are buttons on the controllers

for further committing different actions. We apply the interaction model of rays and attached them to both

hands. With this symmetric design, users who are familiar with MRP won't need to learn another interaction

model for far pointing and manipulation when they use HoloLens 2, and the other way around.

Controller  raysController  rays

Hand raysHand rays



 See also

By default, MRTK provides a hand ray prefab (DefaultControllerPointer.prefab) which has the same visual state as

the shell's system hand ray. It's assigned in MRTK's Input profile, under Pointers. In an immersive headset, the

same rays are used for the motion controllers.

MRTK - Pointer profile

MRTK - Input system

MRTK - Pointers

Direct manipulation with hands

Gaze and commit

Hands - Direct manipulation

Hands - Gestures

Instinctual interactions

https://github.com/microsoft/MixedRealityToolkit-Unity/tree/main/Assets/MixedRealityToolkit.SDK/Features/UX/Prefabs/Pointers
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/configuration/mixed-reality-configuration-guide#pointer-configuration
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/overview
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/pointers
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 Visual affordances

A button is one of the most foundational and crucial UI elements in mixed reality. It lets your users trigger

immediate actions. Since there is no physical feedback in mixed reality, it is crucial to provide enough visual and

audio feedback to increase the user's interaction confidence.

In HoloLens 2 button design, based on many design iterations, prototypings, and user research studies, we

integrated multiple visual affordances and audio cues that help the user's depth perception and interaction in

empty space.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/button.md
https://www.microsoft.com/en-us/videoplayer/embed/RWJHgW


Proximity lightProximity light



Focus highlightFocus highlight



Compressing cageCompressing cage



 Audio cues

 Voice commanding

Pulse on tr iggerPulse on tr igger

Proper audio feedback can dramatically improve the user experience. HoloLens 2's button provides audio

feedback to communicate the following cues:

Contact beginsContact begins : Play sound when touch begins (near interaction)

Contact endsContact ends : Play sound on touch end (near interaction)

Pinch beginsPinch begins : Play sound on pinch select (far interaction with gaze or rays)

Pinch endsPinch ends : Play sound on pinch release (far interaction with gaze or rays)

For any buttons in mixed reality, it's important to support alternative interaction options. By default, we

recommend that voice commanding be supported for any buttons. In HoloLens 2's button design, we provide a

tooltip during the hover state to improve discoverability.



 Sizing recommendations

  Target size for direct hand interactionTarget size for direct hand interaction

DISTA N C EDISTA N C E VIEW IN G A N GL EVIEW IN G A N GL E SIZ ESIZ E

45 cm no smaller than 2° 1.6 x 1.6 cm

Image: Tooltip for the voice command

To ensure all interactable objects can easily be touched, we recommend making sure the interactable meets a

minimum size based on the distance it's placed from the user. The visual angle is often measured in degrees of

visual arc. Visual angle is based on the distance between the user's eyes and the object and stays constant, while

the physical size of the target may change as the distance from the user changes. To determine the necessary

physical size of an object based on the distance from the user, try using a visual angle calculator such as this

one.

Below are the recommendations for minimum sizes of interactable content.

https://elvers.us/perception/visualAngle/


  Target size for buttonsTarget size for buttons

DISTA N C EDISTA N C E M IN IM UM  SIZ EM IN IM UM  SIZ E

45 cm 3.2 x 3.2 cm

  Target size for hand ray or gaze interactionTarget size for hand ray or gaze interaction

DISTA N C EDISTA N C E VIEW IN G A N GL EVIEW IN G A N GL E SIZ ESIZ E

2 m no smaller than 1° 3.5 x 3.5 cm

Target size for direct hand interaction

When creating buttons for direct interaction, we recommend a larger minimum size of 3.2 x 3.2 cm to ensure

that there's enough space to contain an icon and potentially some text.

Target size for the buttons

Target size for hand ray or gaze interaction



 Design guidelines
  Avoid transparent backplateAvoid transparent backplate

  Use shared backplateUse shared backplate

When designing menu UI with buttons, it is recommended to use opaque backplate. Transparent backplates are

not recommended for the following reasons:

Hard to interact with because it is difficult to understand how deep the button has to be pressed to trigger

event

Legibility issue on complex physical environment

Holograms displayed through the transparent plate can show swimming effect issue when used with Depth

LSR stabilization technology.

See Designing content for holographic display for more details on color choices and guidelines for holographic

display.

Examples of transparent UI backplate

For multiple buttons, it is recommended to use shared backplate instead of individual button's backplate.

Reduce the visual noise and complexity

Clear grouping



 Button in MRTK (Mixed Reality Toolkit)

 See also

Examples of shared UI backplate

MRTK for UnityMRTK for Unity  and MRTK for UnrealMRTK for Unreal  provide various types of button prefabs, including HoloLens 2 style

buttons. The HoloLens 2 button component contains all visual feedback and interaction details that were

introduced in this page. By using it, you can leverage the result from many design iterations and user researches

that our designers, developers, researchers had conducted.

Check out the MRTK - Button for more instructions and customized examples.

Cursors

Hand ray

Button

Interactable object

Bounding box and App bar

Manipulation

Hand menu

Near menu

Object collection

Voice command

Keyboard

Tooltip

Slate

Slider

Shader

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/button


Billboarding and tag-along

Displaying progress

Surface magnetism
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 Important properties of the interactable object
  Visual cuesVisual cues

  Far interactionsFar interactions

A button has long been a metaphor used for triggering an event in the 2D abstract world. In the three-

dimensional mixed reality world, we don’t have to be confined to this world of abstraction anymore. Anything

can be an interactable objectinteractable object that triggers an event. An interactable object can be anything from a coffee cup

on a table to a balloon in midair. We still do make use of traditional buttons in certain situation such as in dialog

UI. The visual representation of the button depends on the context.

Visual cues are sensory cues from light, received by the eye, and processed by the visual system during visual

perception. Since the visual system is dominant in many species, especially humans, visual cues are a large

source of information in how the world is perceived.

Since the holographic objects are blended with the real-world environment in mixed reality, it could be difficult

to understand which objects you can interact with. For any interactable objects in your experience, it's important

to provide differentiated visual cues for each input state. This helps the user understand which part of your

experience is interactable and makes the user confident by using a consistent interaction method.

For any objects that user can interact with gaze, hand ray, and motion controller's ray, we recommend having

different visual cue for these three input states:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/interactable-object.md


Default (Obser vation) stateDefault (Obser vation) state

Default idle state of the object. The cursor isn't on the object. Hand isn't detected.



Targeted (Hover) stateTargeted (Hover) state

When the object is targeted with gaze cursor, finger proximity or motion controller's pointer. The cursor is on the

object. Hand is detected, ready.



Pressed statePressed state

When the object is pressed with an air tap gesture, finger press or motion controller's select button. The cursor

is on the object. Hand is detected, air tapped.

You can use techniques such as highlighting or scaling to provide visual cues for the user ’s input state. In mixed

reality, you can find examples of visualizing different input states on the Start menu and with app bar buttons.

Here's what these states look like on a holographic buttonholographic button:



Default (Obser vation) stateDefault (Obser vation) state

Targeted (Hover) stateTargeted (Hover) state



  Near interactions (direct)Near interactions (direct)

Pressed statePressed state

HoloLens 2 supports articulated hand tracking input, which allows you to interact with objects. Without haptic

feedback and perfect depth perception, it can be hard to tell how far away your hand is from an object or

whether you're touching it. It's important to provide enough visual cues to communicate the state of the object,

in particular the state of your hands based on that object.

Use visual feedback to communicate the following states:

Default (Obser vation)Default (Obser vation) : Default idle state of the object.

HoverHover : When a hand is near a hologram, change visuals to communicate that hand is targeting hologram. 

Distance and point of interactionDistance and point of interaction: As the hand approaches a hologram, design feedback to communicate

the projected point of interaction, and how far from the object the finger is

Contact beginsContact begins : Change visuals (light, color) to communicate that a touch has occurred

GraspedGrasped: Change visuals (light, color) when the object is grasped

Contact endsContact ends : Change visuals (light, color) when touch has ended

Hover (Far)Hover (Far)

Highlighting based on the proximity of the hand.



Hover (Near)Hover (Near)

Highlight size changes based on the distance to the hand.

Touch / pressTouch / press

Visual plus audio feedback.

GraspGrasp

Visual plus audio feedback.

A button on HoloLens 2 is an example of how the different input interaction states are visualized:

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/button


DefaultDefault

HoverHover

Reveal a proximity-based lighting effect.

TouchTouch

Show ripple effect.



  The "ring" visual cue on HoloLens 2The "ring" visual cue on HoloLens 2

  Audio cuesAudio cues

  Voice commandingVoice commanding

PressPress

Move the front plate.

On HoloLens 2, there's an extra visual cue, which can help the user's perception of depth. A ring near their

fingertip shows up and scales down as the fingertip gets closer to the object. The ring eventually converges into

a dot when the pressed state is reached. This visual affordance helps the user understand how far they are from

the object.

Video loop: Example of visual feedback based on proximity to a bounding box

For direct hand interactions, proper audio feedback can dramatically improve the user experience. Use audio

feedback to communicate the following cues:

Contact beginsContact begins : Play sound when touch begins

Contact endsContact ends : Play sound on touch end

Grab beginsGrab begins : Play sound when grab starts

Grab endsGrab ends : Play sound when grab ends

For any interactable objects, it's important to support alternative interaction options. By default, we recommend

that voice commanding be supported for any objects that are interactable. To improve discoverability, you can

https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/voice-design


 Sizing recommendations

  Target size for direct hand interactionTarget size for direct hand interaction

DISTA N C EDISTA N C E VIEW IN G A N GL EVIEW IN G A N GL E SIZ ESIZ E

45 cm no smaller than 2° 1.6 x 1.6 cm

also provide a tooltip during the hover state.

Image: Tooltip for the voice command

To ensure all interactable objects can easily be touched, we recommend making sure the interactable meets a

minimum size based on the distance it's placed from the user. The visual angle is often measured in degrees of

visual arc. Visual angle is based on the distance between the user's eyes and the object and stays constant, while

the physical size of the target may change as the distance from the user changes. To determine the necessary

physical size of an object based on the distance from the user, try using a visual angle calculator such as this

one.

Below are the recommendations for minimum sizes of interactable content.

https://elvers.us/perception/visualAngle/


  Target size for hand ray or gaze interactionTarget size for hand ray or gaze interaction

DISTA N C EDISTA N C E VIEW IN G A N GL EVIEW IN G A N GL E SIZ ESIZ E

2 m no smaller than 1° 3.5 x 3.5 cm

 Interactable object in MRTK (Mixed Reality Toolkit) for Unity

Target size for direct hand interaction

Target size for hand ray or gaze interaction

In MRTKMRTK, you can use the script InteractableInteractable to make objects respond to various types of input interaction

states. It supports various types of themes that allow you define visual states by controlling object properties

such as color, size, material, and shader.

Interactable

Button

Hand interaction examples scene

https://github.com/Microsoft/MixedRealityToolkit-Unity
https://github.com/microsoft/MixedRealityToolkit-Unity/tree/mrtk_release/Assets/MixedRealityToolkit.SDK/Features/UX/Interactable/Scripts
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/interactable
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/button
https://github.com/microsoft/MixedRealityToolkit-Unity/blob/mrtk_release/Documentation/README_HandInteractionExamples.md


 See also

MixedRealityToolkit's Standard shader provides various options such as proximity lightproximity light that helps you create

visual and audio cues.

MRTK Standard Shader

Cursors

Hand ray

Button

Interactable object

Bounding box and App bar

Manipulation

Hand menu

Near menu

Object collection

Voice command

Keyboard

Tooltip

Slate

Slider

Shader

Billboarding and tag-along

Displaying progress

Surface magnetism

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/rendering/mrtk-standard-shader
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 What is the Bounding box?

  Scaling an objectScaling an object

Bounding is the standard interface for object manipulation in Mixed Reality. This feature provides the user with a

visual cue that the object is currently adjustable. On HoloLens 2, the bounding box works with direct hand

manipulation and responds to the user's finger's proximity. It shows visual feedback to help the user perceive

the distance from the object.

The corners of the bounding box tell the user that the object can scale. The handles follow a widely understood

pattern for adjusting scale. This visual cue shows users the total area of the object – even if it’s not visible

outside of an adjustment mode. Without this feature, an object snapped to another object or surface may appear

to behave like there was space around it that shouldn’t be there.

Video loop: Scaling an object via bounding box

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/app-bar-and-bounding-box.md


  Rotating an objectRotating an object

  Visual feedback on hand proximity on HoloLens 2Visual feedback on hand proximity on HoloLens 2

 What is the App bar?

The vertical rectangular affordances on the edges of the bounding box are rotation indicators. This gives the

user more fine adjustment over their placed holograms. Not only can they adjust and scale, but now rotate as

well.

Video loop: Rotating an object via bounding box

On HoloLens 2, there's an extra visual cue, which can help the user's perception of depth. A ring near their

fingertip shows up and scales down as the fingertip gets closer to the object. The ring eventually converges into

a dot when the pressed state is reached. This visual affordance helps the user understand how far they are from

the object.

Video loop: Example of visual feedback based on proximity to a bounding box

For Unity app development, see For Unity app development, see Bounding box in the Mixed Reality Toolkit-Unity.Bounding box in the Mixed Reality Toolkit-Unity.

The App bar is an object-level menu, which contains a series of buttons displayed on the bottom edge of a

hologram's bounds. This pattern is commonly used to let users remove and adjust holograms. The App bar was

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/bounding-box


  The App bar follows the userThe App bar follows the user

 Bounding box in MRTK (Mixed Reality Toolkit) for Unity

 See also

designed primarily as a way to manage placed objects in a user's environment. Coupled with the bounding box,

a user has full control over where and how objects are oriented in mixed reality.

Since this pattern is used with objects that are world locked, as a user moves around the object the App bar will

always display on the objects' side closest to the user. While not technically billboarding, this feature effectively

achieves the same result. Preventing a user's position to occlude or block functionality that would otherwise be

available from a different location in their environment. 

Video loop: Walking around a hologram, the App bar follows

MRTKMRTK provides scripts and prefabs for the Bounding box and App bar. You can add a Bounding box by assigning

the BoundingBox.cs script onto any object.

MRTK - Bounding Box

Cursors

Hand ray

Button

Interactable object

Bounding box and App bar

Manipulation

Hand menu

Near menu

Object collection

Voice command

Keyboard

Tooltip

Slate

Slider

Shader

https://github.com/Microsoft/MixedRealityToolkit-Unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/bounding-box


Billboarding and tag-along

Displaying progress

Surface magnetism



   

 

Direct manipulation with hands
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 Device support

Input modelInput model HoloLens (1st gen)HoloLens (1st gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Direct manipulation with hands ❌ Not supported ✔️ Recommended ➕ Supported. For UI,
we recommend point
and commit with hands
instead.

 Basic hand tracking and instinctual interactions demo

Direct manipulation is an input model that involves touching holograms directly with your hands. The idea

behind this concept is that objects behave just as they would in the real world. Buttons can be activated simply

by pressing them, objects can be picked up by grabbing them, and 2D content behaves like a virtual

touchscreen. Direct manipulation is affordance-based, meaning it's user-friendly. There are no symbolic gestures

to teach users. All interactions are built around a visual element that you can touch or grab. It's considered a

"near" input model in that it's best used for interacting with content within arms reach.

Direct manipulation is a primary input model on HoloLens 2, which uses the new articulated hand-tracking

system. The input model is also available on immersive headsets by using motion controllers, but isn't

recommended as a primary means of interaction outside of object manipulation. Direct manipulation isn't

available on HoloLens (1st gen).

If you'd like to see Head and Eye Tracking design concepts in action, check out our Designing Holograms -Designing Holograms -

Head Tracking and Eye TrackingHead Tracking and Eye Tracking video demo below. When you've finished, continue on for a more detailed

dive into specific topics.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/direct-manipulation.md
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/immersive-headset-hardware-details


 Collidable fingertip

This video was taken from the "Designing Holograms" HoloLens 2 app. Download and enjoy the full experience

here.

On HoloLens 2, the user's hands are recognized and interpreted as left and right-hand skeletal models. To

implement the idea of touching holograms directly with hands, ideally, five colliders could be attached to the five

fingertips of each hand skeletal model. However, because of the lack of tactile feedback, 10 collidable fingertips

can cause unexpected and unpredictable collisions with holograms.

We suggest only putting a collider on each index finger. The collidable index fingertips can still serve as active

touch points for diverse touch gestures involving other fingers. Touch gestures include One-finger press, One-

finger tap, Two-finger press, and Five-finger press, as shown below:

Collidable finger tipCollidable finger tip

One-finger pressOne-finger press

https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Microsofts-Designing-Holograms-Hand-Tracking-Chapter/player
https://aka.ms/dhapp


  Sphere colliderSphere collider

  Fingertip cursorFingertip cursor

One-finger tapOne-finger tap

Five-finger pressFive-finger press

Instead of using a random generic shape, we suggest you use a sphere collider. Then you can visually render it

to provide better cues for near targeting. The sphere's diameter should match the thickness of the index finger to

increase touch accuracy. It's easier to retrieve the variable of finger thickness by calling the hand API.

In addition to rendering a collidable sphere on the index fingertip, we've created an advanced fingertip cursor to

achieve a better near-targeting experience. It's a donut-shaped cursor attached to the index fingertip. According

to proximity, it dynamically reacts to a target for orientation and size as detailed below:

When an index finger moves toward a hologram, the cursor is always parallel to the hologram's surface and

gradually shrinks its size.

As soon as the finger touches the surface, the cursor shrinks into a dot and emits a touch event.

With interactive feedback, users can achieve high precision near-targeting tasks, such as triggering a hyperlink

or pressing a button as shown below.



Finger tip cursor farFinger tip cursor far

Finger tip cursor nearFinger tip cursor near

Finger tip cursor contactFinger tip cursor contact



 Bounding box with proximity shader
The hologram itself also requires the ability to provide both visual and audio feedback to compensate the lack of

tactile feedback. For that, we generate the concept of a bounding box with a proximity shader. A bounding box is

a minimum volumetric area that encloses a 3D object. The bounding box has an interactive rendering

mechanism called a proximity shader. The proximity shader behaves:

Hover (far)Hover (far)

When the index finger is within a range, a fingertip spotlight is cast on the surface of the bounding box.

Hover (near)Hover (near)

When the fingertip gets closer to the surface, the spotlight shrinks.

Contact beginsContact begins

As soon as the fingertip touches the surface, the entire bounding box changes color or generates visual effects

to reflect the touch state.



 Pressable button

Contact endsContact ends

A sound effect can also be activated to enhance the visual touch feedback.

With a collidable fingertip, users are now ready to interact with a fundamental holographic UI component, such

as a pressable button. A pressable button is a holographic button tailored for a direct finger press. Again,

because of the lack of tactile feedback, a pressable button equips a couple mechanisms to tackle tactile

feedback-related issues.

The first mechanism is a bounding box with a proximity shader, which is detailed in the previous section. It

gives users a better sense of proximity when they approach and make contact with a button.

The second mechanism is depression. Depression creates a sense of pressing down after a fingertip contacts

a button. The mechanism ensures that the button tightly moves with the fingertip along the depth axis. The

button can be triggered when it reaches a chosen depth (on press) or leaves the depth (on release) after

passing through it.

The sound effect should be added to enhance feedback when the button is triggered.

Finger is far  awayFinger is far  away



 2D slate interaction

  To interact with the slate contactTo interact with the slate contact

Finger approachesFinger approaches

Contact beginsContact begins

Press downPress down

A 2D slate is a holographic container used to host 2D app content, such as a web browser. The design concept

for interacting with a 2D slate via direct manipulation is the same as interacting with a physical touch screen.



TouchTouch

Use an index finger to press a hyperlink or a button.

ScrollScroll

Use an index finger to scroll a slate content up and down.

ZoomZoom



  For manipulating the 2D slate itselfFor manipulating the 2D slate itself

The user's two index fingers are used to zoom in and out of the slate content, according to the relative motion of

the fingers.

MoveMove

Move your hands toward corners and edges to reveal the closest manipulation affordances. Grab the Holobar at

the top of the 2D slate, which lets you move the whole slate.

ScaleScale

Grab the manipulation affordances and do uniform scaling through the corner affordances.



 3D object manipulation

  Affordance-based manipulationAffordance-based manipulation

ReflowReflow

Grab the manipulation affordances and do reflow via the edge affordances.

HoloLens 2 lets users enable their hands to direct and manipulate 3D holographic objects by applying a

bounding box to each 3D object. The bounding box provides better depth perception through its proximity

shader. With the bounding box, there are two design approaches for 3D object manipulation.

Affordance-base manipulation lets you manipulate the 3D object through a bounding box along with the

manipulation affordances around it.

MoveMove

As soon as a user's hand is close to a 3D object, the bounding box, and the nearest affordance are revealed.

Users can grab the bounding box to move the whole object.



  Non-affordance-based manipulationNon-affordance-based manipulation

 Instinctual gestures

RotateRotate

Users can grab the edge affordances to rotate.

ScaleScale

Users can grab the corner affordances to scale uniformly.

Non-affordance-based manipulation doesn't attach affordance to the bounding box. Users can only reveal the

bounding box, then directly interact with it. If the bounding box is grabbed with one hand, the translation and

rotation of the object are associated to motion and orientation of the hand. When the object is grabbed with two

hands, users can translate, scale, and rotate it according to relative motions of two hands.

Specific manipulation requires precision. We recommend that you use affordance-based manipulationaffordance-based manipulation

because it provides a high level of granularity. For flexible manipulation, we recommend you use non-non-

affordance manipulationaffordance manipulation as it allows for instant and playful experiences.

With HoloLens (1st gen), we taught users a couple of predefined gestures, such as bloom and air tap. For



HoloLens 2, we don't ask users to memorize any symbolic gestures. All required user gestures, where users

need to interact with holograms and content, are instinctual. The way to achieve instinctual gestures is to help

users perform gestures through the design of UI affordances.

For example, if we encourage the user to grab an object or a control point with a two finger pinch, the object or

the control point should be small. If we want the user to do a five finger grab, the object or the control point

should be relatively large. Similar to buttons, a tiny button would limit users to press it with a single finger. A

large button would encourage users to press it with their palms.

Small objectSmall object

Medium objectMedium object



 Symmetric design between hands and 6 DoF controllers

 Optimize with eye tracking

Large objectLarge object

You may have noticed that there are interaction parallels we can draw between hands in AR and motion

controllers in VR. Both inputs can be used to trigger direct manipulations in their respective environments. In

HoloLens 2, grabbing and dragging with hands at a close distance works much the same way as the grab button

does on WMR motion controllers. This provides users with interaction familiarity between the two platforms,

which might prove useful if you ever decide to port your application between platforms.

Direct manipulation can feel magical if it works as intended. But it can also become frustrating if you can’t move

your hand anywhere without unintentionally triggering a hologram. Eye tracking potentially helps to better

identify what the user ’s intent is.

WhenWhen: Reduce unintentionally triggering a manipulation response. Eye tracking allows for better

understanding what a user is currently engaged with. For example, imagine you're reading through a

holographic (instructional) text when reaching over to grab you real-world work tool.

By doing so, you accidentally move your hand across some interactive holographic buttons that you hadn't even

noticed before. For example, it may be outside the user's field-of-view (FoV).

If the user hasn't looked at a hologram for a while, yet a touch or grasp event has been detected for it, the

interaction is likely unintentional.

Which oneWhich one: Aside from addressing false positive activations, another example includes better identifying

which holograms to grab or poke as the precise intersection point may not be clear from your

perspective, especially if several holograms are positioned close to each other.

While eye tracking on HoloLens 2 has limitations based on how accurately it can determine your eye

gaze, this can still be helpful for near interactions because of depth disparity when interacting with hand

input. This means it's sometimes difficult to determine whether your hand is behind or in front of a

hologram to precisely grab a manipulation widget, for example.



 Manipulation in MRTK (Mixed Reality Toolkit) for Unity

 See also

Where toWhere to: Use information about what a user is looking at with quick-throwing gestures. Grab a

hologram and roughly toss it toward your intended destination.

While this sometimes works, quickly doing hand gestures may result in highly inaccurate destinations.

However, eye tracking could improve the accuracy of the gesture.

With MRTKMRTK, you can easily achieve common manipulation behavior using the script ObjectManipulatorObjectManipulator . With

ObjectManipulator, you can grab and move objects directly with hands or with hand ray. It also supports two-

handed manipulation for scaling and rotating an object.

MRTK - Manipulation

Head-gaze and commit

Point and commit with hands

Instinctual interactions

https://github.com/Microsoft/MixedRealityToolkit-Unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/object-manipulator
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 Best practices

The hand menu is one of the most unique UX patterns in HoloLens 2. It allows you to quickly bring up hand-

attached UI. Since it's accessible anytime and can be shown and hidden easily, it's great for quick actions.

You'll find our recommended best practices for working with hand menus in the list below. You can also find an

example scene demonstrating the hand menu in MRTK.

Keep the number of buttons smallKeep the number of buttons small

Because of the close distance between a hand-locked menu and the eyes, and the tendency for users to focus on

a relatively small visual area at any time (the attentional cone of vision is roughly 10 degrees), we recommend

keeping the number of buttons small. Based on our exploration, one column with three buttons works well by

keeping all the content within the field of view (FOV) even when a user moves their hands to the center of the

FOV.

Use hand menu for quick actionUse hand menu for quick action

Raising an arm and maintaining the position could easily cause arm fatigue. Use a hand-locked method for the

menu requiring a short interaction. If your menu is complex and requires extended interaction times, consider

using world-locked or body-locked instead.

Button / Panel angleButton / Panel angle

Menus should billboard towards the opposite shoulder and middle of the head: This allows a natural hand move

to interact with the menu with the opposite hand and avoids any awkward or uncomfortable hand positions

when touching buttons.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/hand-menu.md
https://www.microsoft.com/en-us/videoplayer/embed/RE4AJAg
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/hand-menu


 Hand menu with large and complex UI controls

It's recommended to limit the number of buttons or UI controls on hand-attached menus. This is because extended

interaction with a large number of UI elements can cause arm fatigue. If your experience requires a large menu,

provide an easy way for the user to world lock the menu. One technique we recommend is to world-lock then menu

when the hand drops or flips away from the user. A second technique is to allow the user to directly grab the menu

with the other hand. When the user releases the menu, the menu should world lock. This way, a user can interact

with various UI elements comfortably and confidently over an extended period of time.

 How to prevent false activation

Consider suppor ting one-handed or hands-free operationConsider suppor ting one-handed or hands-free operation

Don't assume both of the user's hands are always available. Consider a wide range of contexts when one or both

hands aren't available, and make sure your design accounts for those situations. To support a one-handed hand

menu, you can try transitioning the menu placement from hand-locked to world-locked when the hand flips

(goes palm down). For hands-free scenarios, consider using a voice command to invoke the hand menu.

Avoid adding buttons near the wrist (system home button)Avoid adding buttons near the wrist (system home button)

If the hand menu buttons are placed too close to the home button, it may accidentally trigger while interacting

with the hand menu.

When the menu is world-locked, make sure to provide a way to move the menu, and close the menu when it's

no longer needed. Make the menu movable by providing handles on the sides or top of menu. Add a close

button to allow the menu to close. Allow for the menu to reattach to the hand when the user hand faces the user.

We also recommend requiring that the users gaze at their hand to prevent false activations (see below).

Large menu that shows a usability issueLarge menu that shows a usability issue

World-locked menu on hand dropWorld-locked menu on hand drop

Manual grab & pull to world-lock the menuManual grab & pull to world-lock the menu

If you use just palm-up as an event to trigger the hand menu, it may accidentally appear when you don't need it

(false-positive), because people move their hands both intentionally (for communication and object

manipulation) and unintentionally. To reduce false activations, add an extra step besides the palm-up event to

invoke the hand menu (such as fully opened fingers, or the user intentionally gazing at their hand).

https://www.microsoft.com/en-us/videoplayer/embed/RE4AOPx
https://www.microsoft.com/en-us/videoplayer/embed/RE4AGZi
https://www.microsoft.com/en-us/videoplayer/embed/RE4AJAf


 Hand menu placement best practices

Require Flat PalmRequire Flat Palm

By requiring a flat open hand, you can prevent false activation that might occur as the user manipulates objects

or gestures while communicating within an environment.

Require GazeRequire Gaze

By requiring the user to gaze at their hand (either with eye gaze or head gaze), it prevents false activations

because of the user having to direct their attention to the hand as a secondary activation step (with a tunable

distance threshold used to allow for user comfort).

In human anatomy, the ulnar nerve is a nerve that runs near the ulna bone. The ulna is a long bone found in the

forearm that stretches from the elbow to the smallest finger.

Below are two recommended placements based on our explorations:

A. Ulnar inside palmA. Ulnar inside palm

This position is reliable because the hands don't overlap each other. This is critical for accurate hand detection

and tracking.

https://www.microsoft.com/en-us/videoplayer/embed/RE4Asn4


 Menu positions that aren't recommended

B. Ulnar above handB. Ulnar above hand

This location is comfortable for users because they don't need to raise their arm too much to interact with the

hand menu. We recommend placing menus 13 cm13 cm above the palm and align the buttons inside the ulnar palm.

Read more about the optimal button size

For technical reasons, we recommend this location with one required implementation: the developer will need

to freeze the menu once the user's opposite hand gets close to interacting with it. This will avoid jitteriness from

overlapping hands and also allows for a faster targeting of the buttons.

HoloLens 2 cameras identify hands accurately when they're separate from each other. Any overlapping hands

can cause hand menus move away from the anchor location.

We have done user research with different menus layouts and locations, the following menu locations are NOTNOT

recommendedrecommended, find the cons of each study below:

Above the armAbove the arm

1 - Difficult to maintain good hand tracking

2 - Causes user fatigue because of unnatural position

Above fingersAbove fingers



1 - Hand fatigue because of holding out hand for a long time

2 - Hand tracking issues on index and middle fingers

Above-center palmAbove-center palm

1 - Hand tracking issues because of overlapping hands

2 - Hand fatigue because of holding hands for long time to interact with menus

 Top finger tipTop finger tip

1 - Hand tracking issues

2 - Hand fatigue from holding hand above normal posture

3 - Issues pressing buttons with other fingers by accident because of limited space between fingers



 Hand menu in MRTK (Mixed Reality Toolkit) for Unity

 See also

Back of the armBack of the arm

1 - Can trigger home button by accident

2 - Not a natural or comfortable position

MRTKMRTK provides scripts and example scenes for the hand menu. The HandConstraintPalmUp solver script allows

you to attach any objects to the hands with various configurable options. MRTK's hand menu examples include

useful options such as flat palm and gaze requirement for preventing false activation.

Hand Menu Documentations

Hand Menu Example Scene

You can try hand menu examples in HoloLens 2 with MRTK Examples Hub app.

Hand Menu Scene in MRTK Examples Hub

Cursors

Hand ray

Button

Interactable object

Bounding box and App bar

Manipulation

Hand menu

Near menu

Object collection

Voice command

Keyboard

Tooltip

Slate

Slider

https://github.com/Microsoft/MixedRealityToolkit-Unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/hand-menu
https://github.com/microsoft/MixedRealityToolkit-Unity/blob/main/Assets/MRTK/Examples/Demos/HandTracking/Scenes/HandMenuExamples.unity
https://www.microsoft.com/p/mrtk-examples-hub/9mv8c39l2sj4?activetab=pivot:overviewtab
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 Near menu in MRTK (Mixed Reality Toolkit) for Unity

 See also

A near menu is a collection of buttons on a panel that follow your users with tag-along behavior. The panel stays

within a set distance range and angle, which lets users comfortably interact with content. If you need to world-

lock or disable the panel's tag-along behavior, use the pin button or grab and place the menu. Pinning the panel

lets your users focus on the target content without any distractions. You can re-enable the tag-along behavior at

any time by pressing the pin button to make the menu follow the user again.

MRTKMRTK provides various near menu prefab examples.

MRTK - Near menu

Cursors

Hand ray

Button

Interactable object

Bounding box and App bar

Manipulation

Hand menu

Near menu

Object collection

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/near-menu.md
https://github.com/Microsoft/MixedRealityToolkit-Unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/near-menu
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 Object collection examples

Object collection is a layout control, which helps you lay out an array of objects in a predefined three-

dimensional shape. It supports various surface styles - **plane, cylinder, sphere, and radialradial . You can adjust the

radius and size of the objects and the space between them. Object collection supports any object from Unity -

both 2D and 3D. In the Mixed Reality ToolkitMixed Reality Toolkit, we have created Unity script and examples that will help you

create an object collection.

Periodic Table of the Elements is a sample app that demonstrates how Object collection works. It uses Object

collection to lay out 3D chemical element boxes in different shapes.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/object-collection.md
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/object-collection


  3D objects3D objects

  2D objects2D objects

Object collection examples shown in the Periodic Table of the Elements sample app

You can use Object collection to lay out imported 3D objects. The example below shows a plane and a cylinder

layout of some 3D chair objects.

Examples of plane and cylindrical layouts of 3D objects

You can also use 2D images with Object collection. The examples below demonstrate how 2D images can be

displayed in a grid.



 

Examples of using object collection with 2D images



Object collection in MRTK (Mixed Reality Toolkit) for Unity

 See also

MRTK - Object collection
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Interactable object

Bounding box and App bar

Manipulation
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Voice command
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https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/object-collection


   

 

Voice input
 7/6/2022 • 12 minutes to read • Edit Online

 Voice and gaze

https://www.youtube.com/embed/eHMkOpNUtR8

 Device support

FeatureFeature HoloLens (1st gen)HoloLens (1st gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Voice input ✔️ ✔️ ✔️ (with microphone)

 The "select" command

Voice is one of the key forms of input on HoloLens. It allows you to directly command a hologram without

having to use hand gestures. Voice input can be a natural way to communicate your intent. Voice is especially

good at traversing complex interfaces, because it lets users cut through nested menus with one command.

Voice input is powered by the same engine that supports speech in all Universal Windows Apps. On HoloLens,

speech recognition will always function in the Windows display language configured in your device Settings.

When you're using voice commands, head or eye gaze is the typical targeting mechanism, whether with a cursor

to "select" or to channel your command to an application you're looking at. It may not even be required to show

any gaze cursor ("see it, say it"). Some voice commands don't require a target at all, such as "go to start" or "Hey

Cortana."

HoloLens (1st gen)HoloLens (1st gen)

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/voice-input.md
https://docs.microsoft.com/en-us/windows/uwp/design/input/speech-recognition
https://www.youtube.com/embed/eHMkOpNUtR8
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


 Hey Cortana

Even without specifically adding voice support to your app, your users can activate holograms simply by saying

the system voice command "select". This behaves the same as an air tap on HoloLens, pressing the select button

on the HoloLens clicker, or pressing the trigger on a Windows Mixed Reality motion controller. You'll hear a

sound and see a tooltip with "select" appear as confirmation. "Select" is enabled by a low-power keyword

detection algorithm, which means you can say it anytime with minimal battery life impact. You can even say

"select" with your hands at your side.

HoloLens 2HoloLens 2

To use the "select" voice command in HoloLens 2, you first need to bring up the gaze cursor to use as a pointer.

The command to bring it up is easy to remember--just say, "select".

To exit the mode, use your hands again by air tapping, approaching a button with your fingers, or using the

system gesture.

Image: Say "select" to use the voice command for selection

You can say "Hey Cortana" to bring up Cortana at any time. You don't have to wait for her to appear to continue

asking her your question or giving her an instruction. For example, try saying "Hey Cortana, what's the

weather?" as a single sentence. For more information about Cortana and what you can do, ask her! Say "Hey

Cortana, what can I say?" and she'll pull up a list of working and suggested commands. If you're already in the

Cortana app, select the ?? icon on the sidebar to pull up this same menu.

HoloLens-specific commandsHoloLens-specific commands

"What can I say?"

"Go to Start" - instead of bloom to get to Start Menu

"Launch <app>"

"Move <app> here"

https://docs.microsoft.com/en-us/hololens/hololens1-clicker


 "See It, Say It"

"Take a picture"

"Start recording"

"Stop recording"

"Show hand ray"

"Hide hand ray"

"Increase the brightness"

"Decrease the brightness"

"Increase the volume"

"Decrease the volume"

"Mute" or "Unmute"

"Shut down the device"

"Restart the device"

"Go to sleep"

"What time is it?"

"How much battery do I have left?"

HoloLens has a "see it, say it" model for voice input, where labels on buttons tell users what voice commands

they can say as well. For example, when looking at an app window in HoloLens (1st gen), a user can say "Adjust"

command to adjust the position of the app in the world.

Image: A user can say the "Adjust" command, which they see in the App bar to adjust the position of the app

When apps follow this rule, users can easily understand what to say to control the system. While gazing at a

button in HoloLens (1st gen), you'll see a "voice dwell" tooltip that comes up after a second if the button is voice-

enabled and displays the command to speak to "press" it. To reveal voice tooltips in HoloLens 2, show the voice

cursor by saying "select" or "What can I say" (See image). 



 Voice commands for fast hologram manipulation

 Discovering voice commands

 Dictation

Image: "See it, say it" commands appear below the buttons

There are many voice commands you can say while gazing at a hologram to quickly do manipulation tasks.

These voice commands work on app windows and 3D objects you've placed in the world.

Hologram manipulation commandsHologram manipulation commands

Face me

Bigger | Enhance

Smaller

On HoloLens 2, you can also create more natural interactions in combination with eye-gaze, which implicitly

provides contextual information about what you are referring to. For example, you could look at a hologram and

say "put this" and then look over where you want to place it and say "over here". Or you could look at a

holographic part on a complex machine and say: "give me more information about this".

Some commands, like the commands for fast manipulation above, can be hidden. To learn about what

commands you can use, gaze at an object and say, "what can I say?". A list of possible commands pops up. You

can also use the head gaze cursor to look around and reveal the voice tooltips for each button in front of you.

If you want a complete list, just say, "Show all commands" anytime.

Rather than typing with air taps, voice dictation can be more efficient to enter text into an app. This can greatly

accelerate input with less effort for the user.



 Adding voice commands to your app

  Best practicesBest practices

  Advantages of voice inputAdvantages of voice input

Voice dictation starts by selecting the microphone button on the keyboard

Anytime the holographic keyboard is active, you can switch to dictation mode instead of typing. Select the

microphone on the side of the text input box to get started.

Consider adding voice commands to any experience that you build. Voice is a powerful way control the system

and apps. Because users speak with different kinds of dialects and accents, proper choice of speech keywords

will make sure your users' commands are interpreted unambiguously.

Below are some practices that will aid in smooth speech recognition.

Use concise commandsUse concise commands  - When possible, choose keywords of two or more syllables. One-syllable words

tend to use different vowel sounds when spoken by persons of different accents. Example: "Play video" is

better than "Play the currently selected video"

Use simple vocabular yUse simple vocabular y  - Example: "Show note" is better than "Show placard"

Make sure commands are non-destructiveMake sure commands are non-destructive - Make sure any speech command actions are non-

destructive and can easily be undone in case another person speaking near the user accidentally triggers a

command.

Avoid similar  sounding commandsAvoid similar  sounding commands  - Avoid registering multiple speech commands that sound similar.

Example: "Show more" and "Show store" can be similar sounding.

Unregister your app when not it usesUnregister your app when not it uses  - When your app isn't in a state in which a particular speech

command is valid, consider unregistering it so that other commands aren't confused for that one.

Test with different accentsTest with different accents  - Test your app with users of different accents.

Maintain voice command consistencyMaintain voice command consistency  - If "Go back" goes to the previous page, maintain this behavior in

your applications.

Avoid using system commandsAvoid using system commands  - The following voice commands are reserved for the system, so avoid

using them in your applications:

"Hey Cortana"

"Select"

"Go to start"

Voice input is a natural way to communicate our intents. Voice is especially good at interface traversalstraversals

because it can help users cut through multiple steps of an interface. A user might say "go back" while looking at

a webpage, instead of having to go up and hit the back button in the app. This small time saving has a powerful

emotional effectemotional effect on user ’s perception of the experience and gives them a small amount superpower. Using

voice is also a convenient input method when we have our arms full or are multi-taskingmulti-tasking. On devices where



  Challenges for voice inputChallenges for voice input

  Voice feedback statesVoice feedback states

typing on a keyboard is difficult, voice dictationvoice dictation can be an efficient alternative way to input text. Lastly, in some

cases when the range of accuracyrange of accuracy  for gaze and gesture are limited, voice can help to disambiguate the user's

intent.

How using voice can benefit the userHow using voice can benefit the user

Reduces time - it should make the end goal more efficient.

Minimizes effort - it should make tasks more fluid and effortless.

Reduces cognitive load - it's intuitive, easy to learn, and remember.

It's socially acceptable - it should fit in with societal norms of behavior.

It's routine - voice can readily become a habitual behavior.

While voice input is great for many different applications, it also faces several challenges. Understanding both

the advantages and challenges for voice input enables app developers to make smarter choices for how and

when to use voice input and to create a great experience for their users.

Voice input for continuous input controlVoice input for continuous input control  Fine-grained control is one of them. For example, a user might

want to change their volume in their music app. She can say "louder", but it's not clear how much louder the

system is supposed to make the volume. The user could say: "Make it a little louder", but "a little" is difficult to

quantify. Moving or scaling holograms with voice is similarly difficult.

Reliability of voice input detectionReliability of voice input detection While voice input systems become better and better, sometimes they

may incorrectly hear and interpret a voice command. The key is to address the challenge in your application.

Provide feedback to your users when the system is listening and what the system understood clarifies potential

issues understanding the users' speech.

Voice input in shared spacesVoice input in shared spaces  Voice may not be socially acceptable in spaces that you share with others. Here

are a few examples:

The user may not want to disturb others (for example, in a quiet library or shared office)

Users may feel awkward being seen talking to themselves in public,

A user may feel uncomfortable dictating a personal or confidential message (including passwords) while

others are listening

Voice input of unique or unknown wordsVoice input of unique or unknown words  Difficulties for voice input also come when users are dictating

words that may be unknown to the system, such as nicknames, certain slang words, or abbreviations.

Learning voice commandsLearning voice commands  While the ultimate goal is to naturally converse with your system, often apps still

rely on specific pre-defined voice commands. A challenge associated with a significant set of voice commands is

how to teach them without overloading the user and how to help the user to keep them.

When Voice is applied properly, the user understands what they can say and get clear feedbackwhat they can say and get clear feedback the system

heard them correctlyheard them correctly . These two signals make the user feel confident in using Voice as a primary input. Below

is a diagram showing what happens to the cursor when voice input is recognized and how it communicates that

to the user.



 Top things users should know about "speech" in mixed reality

1. Regular cursor state1. Regular cursor state

2. Communicates voice feedback and then disappears2. Communicates voice feedback and then disappears

3. Returns to regular cursor state3. Returns to regular cursor state

Say "Select""Select" while targeting a button (you can use this anywhere to select a button).

You can say the label name of an app bar buttonlabel name of an app bar button in some apps to take an action. For example, while

looking at an app, a user can say the command "Remove" to remove the app from the world (this saves time

from having to select it with your hand).



 Common questions and concerns users have about voice

 Communication

 Languages

 Troubleshooting

You can start Cortana listening by saying "Hey Cor tana.""Hey Cor tana." You can ask her questions ("Hey Cortana, how tall

is the Eiffel tower"), tell her to open an app ("Hey Cortana, open Netflix"), or tell her to bring up the Start

Menu ("Hey Cortana, take me home") and more.

What can I say?

How do I know the system heard me correctly?

It reacts the wrong way when I give it a voice command.

How do I target my voice to a specific app or app command?

Can I use voice to command things out the holographic frame on HoloLens?

The system keeps getting my voice commands wrong.

It doesn’t react when I give it a voice command.

For applications that want to take advantage of the customized audio input processing options provided by

HoloLens, it's important to understand the various audio stream categories your app can consume. Windows 10

supports several different stream categories and HoloLens makes use of three of these to enable custom

processing to optimize the microphone audio quality tailored for speech, communication, and other, which can

be used for ambient environment audio capture (that is, "camcorder") scenarios.

The AudioCategory_Communications stream category is customized for call quality and narration scenarios

and provides the client with a 16-kHz 24-bit mono audio stream of the user's voice

The AudioCategory_Speech stream category is customized for the HoloLens (Windows) speech engine and

provides it with a 16-kHz 24-bit mono stream of the user's voice. This category can be used by third-party

speech engines if needed.

The AudioCategory_Other stream category is customized for ambient environment audio recording and

provides the client with a 48-kHz 24-bit stereo audio stream.

All this audio processing is hardware accelerated which means the features drain a lot less power than if the

same processing was done on the HoloLens CPU. Avoid running other audio input processing on the CPU to

maximize system battery life and take advantage of the built-in, offloaded audio input processing.

HoloLens 2 supports multiple languages. Keep in mind that speech commands will always run in the system's

display language even if multiple keyboards are installed or if apps attempt to create a speech recognizer in a

different language.

If you're having any issues using "select" and "Hey Cortana", try moving to a quieter space, turning away from

the source of noise, or by speaking louder. At this time, all speech recognition on HoloLens is tuned and

optimized specifically to native speakers of United States English.

For the Windows Mixed Reality Developer Edition release 2017, the audio endpoint management logic will work

fine (forever) after logging out and back in to the PC desktop after the initial HMD connection. Before that first

sign out/in event after going through WMR OOBE, the user could experience various audio functionality issues

ranging from no audio to no audio switching depending on how the system was set up before connecting the

HMD for the first time.

https://docs.microsoft.com/en-us/windows/win32/api/audiosessiontypes/ne-audiosessiontypes-audio_stream_category
https://docs.microsoft.com/en-us/hololens/hololens2-language-support


 Voice input in MRTK (Mixed Reality Toolkit) for Unity

 See also

With MRTKMRTK, you can easily assign voice command on any objects. Use MRTK's Speech Input ProfileSpeech Input Profile to define

your keywords. By assigning SpeechInputHandlerSpeechInputHandler  script, you can make any object respond to the keywords

defined in the Speech Input Profile. SpeechInputHandler also provides speech confirmation label to improve the

user's confidence.

MRTK - Voice command

Gaze and commit

Instinctual interactions

Voice input in DirectX

Voice input in Unity

https://github.com/Microsoft/MixedRealityToolkit-Unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/speech
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 System keyboard in MRTK (Mixed Reality Toolkit) for Unity

 Next Development Checkpoint

 See also

Your mixed reality application can invoke the system keyboard at any time, which behaves according to the

target platform's capabilities. For example, the keyboard on HoloLens 2 supports direct hand interactions, while

HoloLens (1st gen) keyboards support gaze and air-taps.

MRTK - System keyboard

If you're following the Unity development journey we've laid out, your next task is to deploy your application to

a device or emulator.

Deploy to HoloLens or Windows Mixed Reality immersive headsets

Cursors

Hand ray

Button

Interactable object

Bounding box and App bar

Manipulation

Hand menu

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/keyboard.md
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/system-keyboard


Near menu

Object collection

Voice command

Keyboard

Tooltip

Slate

Slider

Shader

Billboarding and tag-along

Displaying progress

Surface magnetism
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 Tooltip in MRTK (Mixed Reality Toolkit) for Unity

 See also

A tooltip is a short description that is linked to another control or object. They're used to convey a hint or extra

information upon closer inspection. Tooltips help users understand unfamiliar objects in the physical

environment that aren't described directly.

MRTK - Tooltip

Cursors

Hand ray

Button

Interactable object

Bounding box and App bar

Manipulation

Hand menu

Near menu

Object collection

Voice command

Keyboard

Tooltip

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/tooltip.md
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/tooltip
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Shader

Billboarding and tag-along

Displaying progress

Surface magnetism
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 Slate in MRTK (Mixed Reality Toolkit) for Unity

 See also

A slate is a thin window style control for displaying 2D content like plain text, images, or documents. A slate

offers a grabbable title bar with buttons for 'Follow me (tag-along)' and close functionality. The content within a

slate can be scrolled via direct manipulation just like a physical touch screen. You can use gaze, air-tap, and drag

gesture or a motion controller's pointer as well.

MRTK - Slate

Cursors

Hand ray

Button

Interactable object

Bounding box and App bar

Manipulation

Hand menu

Near menu

Object collection

Voice command

Keyboard

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/slate.md
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/slate


Tooltip
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Slider
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Surface magnetism
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 Slider in MRTK (Mixed Reality Toolkit) for Unity

 See also

A slider is a UI component used to set a value. It provides a visual indication of adjustable content, and the

current setting in the total range of content. It's displayed as a track with options on either side. A knob or lever

is dragged to one end or the other to make the choice, indicating the current value. The Pinch Slider can be

moved by directly grabbing the slider, either directly or at a distance. Sliders work with various input types, such

as gaze and air-tap and a motion controller.

MRTK - Slider

Cursors

Hand ray

Button

Interactable object

Bounding box and App bar

Manipulation

Hand menu

Near menu

Object collection

Voice command

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/slider.md
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/sliders
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 Examples of visual effects using MRTK (Mixed Reality Toolkit) Standard
shader

Since holographic objects are mixed with physical ones in the real environment, it's important to provide visual

cues to the user. The Mixed Reality Toolkit Standard shader provides various types of visual effects for use with

holograms. The shading system uses a single, flexible shader to achieve visuals similar to Unity's Standard

Shader. The shader implements Fluent Design System principles and remains performant on mixed reality

devices. 

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/shader.md
https://www.microsoft.com/design/fluent/#/


Proximity lightProximity light



 Standard shader in MRTK for Unity

 See also

Border lightBorder light

MRTK - Standard shader

Cursors

Hand ray

Button

Interactable object

Bounding box and App bar

Manipulation

Hand menu

Near menu

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/rendering/mrtk-standard-shader
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 Dialog in MRTK (Mixed Reality Toolkit) for Unity

Dialog controls are UI overlays that provide contextual app information, often requesting a user action. Use

dialogs to give users important information and request confirmation or extra information before an action can

be completed.

MRTK provides dialog control in three sizes with one or two button options. You can also specify the placement

distance for near or far interaction range.

DialogSmall_192x96.prefab: 192x96mm

DialogMedium_192x128.prefab: 192x128mm

DialogLarge_192x192.prefab: 192x192mm

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/dialog-ui.md


 See also

For more information, see MRTK - Dialog.

Cursors

Hand ray

Button

Interactable object

Bounding box and App bar

Manipulation

Hand menu

Near menu

Object collection

Voice command

Keyboard

Tooltip

Slate

Slider

Shader

Billboarding and tag-along

Displaying progress

Surface magnetism

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/dialog
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 Hand coach provided

Hand coach triggers 3D modeled hands when the system doesn't detect the user ’s hands. This feature is a

“teaching” component that helps guide the user when the gesture hasn't been taught. If users haven't done the

specified gesture for a period, the hands will loop with a delay. The Hand coach could be used to represent

pressing a button or picking up a hologram.

The current interaction model represents a wide variety of gesture controls such as scrolling, far select, and near

tap. Below is a full list of existing hand gestures provided in MRTK:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/hand-coach.md
https://github.com/microsoft/MixedRealityToolkit-Unity/tree/mrtk_release/Assets


Example of Near Select - Used show how to select buttons or close interactable objectsExample of Near Select - Used show how to select buttons or close interactable objects



Example of Air  Tap - Used to show how to select objects that are far  awayExample of Air  Tap - Used to show how to select objects that are far  away



Example of Moving an object in space-Used to show how to move a hologram in spaceExample of Moving an object in space-Used to show how to move a hologram in space



Example of Rotate-Used to show how to rotate holograms or objectsExample of Rotate-Used to show how to rotate holograms or objects



Example of Scale- Used to show how to manipulate holograms to be bigger or smallerExample of Scale- Used to show how to manipulate holograms to be bigger or smaller



Example of Palm up – Suggested use, to br ing up hand menusExample of Palm up – Suggested use, to br ing up hand menus



Example of Hand Flip – Another way to br ing up Hand MenusExample of Hand Flip – Another way to br ing up Hand Menus



 Design concepts

  IntuitiveIntuitive

Example of Scroll – Used for scrolling a list or a long documentExample of Scroll – Used for scrolling a list or a long document

For Hololens2, we designed out hand interactions based on instinctual and natural hand gestures. We believe

these to be intuitive to most users, so we didn't create dedicated gesture learning moments. Instead, we created

the hand coach to help users learn about these gestures if they get stuck or are unfamiliar with hologram

interactions. Without a learning moment, we felt that showing users how to perform an action by demonstrating

it would be the best option. We found that users were able to figure out the gesture but needed a little guidance.

If we detect a user doesn't interact with an object for a period, a Hand coach would be triggered demonstrating

the correct hand and finger placement.

When animating hands, it should be obvious and shouldn't cause any confusion. The hand animation is a

representation of the gesture you're trying to prompt the user to understand.

For example, if you wish a user to press a button, a hand pressing a button would be triggered.



  Hand scaleHand scale

 Can I create my own?

Hand Coach demonstrating Near Tapping a Gem

We tested various hand sizes with the UI menus and felt that if the hands were true to size, it gave a menacing

feeling. If they were too small, it was hard to see and understand the gesture.

Voice over and handsVoice over and hands

Don’t expect users can listen to one set of instructions via voice over and watch different instructions via Hand

coach. Sequence your instructions to help users focus versus compete for their attention to reduce sensory

overload.

Yes! We encourage you to create your own unique gesture for your game and contribute back to the

community! We've provided a Maya file of a Rigged hand that can be used for your app, which can be

downloaded here: Download HandCoach_MRTK.zip

file:///C:/localrun/t/fs14/bgqa/windows/mixed-reality/design/files/handcoach_mrtk.zip


Example of animated Hand Poking a box in Maya

Recommended authoring toolRecommended authoring tool

Among 3D artists, many choose to use Autodesk’s Maya, which can use HoloLens to transform the way assets

are created. The hands file provided is a Maya Binary File, so it's recommended to use Maya to animate and

export the hands. If you prefer to use another 3D program, here's a .FBX.FBX: Download HandCoachMRTK_FBX.zip to

create your own controller setup.

If using the downloadable maya Hand File provided, it's suggested to scale down the hands in unity to 0.6.

https://www.youtube.com/watch?v=q0K3n0Gf8mA
file:///C:/localrun/t/fs14/bgqa/windows/mixed-reality/design/files/handcoachmrtk_fbx.zip


  Technical SpecsTechnical Specs

 Exporting from Maya

Rigged Hands

Two handed File is available in Maya Ascii format

Right and Left Hand is available in Maya Binary format

Set your Maya file to 24 FPS

Within the file, there's a left and right hand, which can be used for two handed or single-handed gestures.

The right hand will only be visible by default.

It's suggested to leave a buffer of about 10 frames at the beginning and end for fades

If animating an object with a specified target, its best practice to animate to a Default box or Null.

If the hand is animating a physical object such as a box, its best practice to not animate the translation in

Maya but wait to animate it in Unity or in Code.

Visible Animation should be 1.5 secs for any meaningful information to be conveyed

When you feel satisfied with your animation:

Select all joints and bake key frames

Delete the Controllers, Select the joints and mesh and export as an FBX

If there are Multiple Animations, you can use Maya’s built-in Game Exporter :

https://knowledge.autodesk.com/support/maya/learn-

explore/caas/CloudHelp/cloudhelp/2015/ENU/Maya/files/Game-Exporter-htm.html

After you're satisfied with your animation

Select all joints: Select > Hierarchy

https://knowledge.autodesk.com/support/maya/learn-explore/caas/CloudHelp/cloudhelp/2015/ENU/Maya/files/Game-Exporter-htm.html


Bake out your animation: Switch to Animation > Key > Bake Animation

Delete the Controller Rig: Outliner > MainR_Grp or MainL_Grp

Export as FBX: Select JNT + Mesh: File > Export Selection (option box) > Export Selection



When exporting as an FBX and brought into Unity, scale the hands down to 0.6. We found that this was perfect

balance for displaying the hands.

Unity Settings for HandCoach_R prefab found in MRTK



 Implementing Hands into your Unity project
  Best practicesBest practices

  What to avoidWhat to avoid

It's suggested to scale down the hands in unity to 0.6

Hands should be played twice and if not completed then continuously looped until gesture is completed.

The hands should be looped twice to ensure the user had time to register and see the gesture. The hands

should fade in and out between loops.

If user ’s hands are visible by HL2 cameras but users aren't doing the interaction needed of them the

hands will appear after 10 seconds.

If user ’s hands are NOT visible by HL2 cameras, the hands will appear after 5 seconds.

If user ’s hands are visibly tracked by HL2 cameras in the middle of the animation, the animation will

complete and fade out.

If you're including voice over, we suggest that it corresponds to the gesture of the hand.

If you've taught the hands at least once, only repeat the gesture if it's detected that the user is stuck.

If specific finger/hand positions are critical, ensure users can clearly see these nuances in the animation.

Try angling the hands so the most important parts are clearly visible.

If you notice distortion on the hands, you need to go to Unity's Quality settings increase the number of

bones. Go to Unity's Edit > Project Settings > Quality > Other > Blend Weights. Make sure "4 bones" are

selected to see Smooth Joints.

Scaling the Hands too large

Placing the Hands too close to the user

Hands should only be taught once. Over teaching can cause confusion and messiness

Bringing it into Unity, download the latest MRTK here: https://github.com/microsoft/MixedRealityToolkit-Unity

Material: Teaching_Hand2

Scripts: Refer to MRTK guidelines for MRTK hand coach

Per- project setting

https://github.com/microsoft/MixedRealityToolkit-Unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/hand-coach


 See also

Scene set to UWP: Instruction can be found in the Set up a new OpenXR project with MRTK

article.

Interaction-fundamentals

Asset Creation Process

Gestures

Install the Tools

Set up a new OpenXR project with MRTK

Unity development overview

MRTK 101

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/


   

 

Spatial mesh
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 Design guideline

 Spatial mesh visualization in MRTK (Mixed Reality Toolkit) for Unity

Users learn how a device perceives and understands the physical environment through spatial mesh

visualization. Proper spatial mesh visualization can create a delightful and magical experience while providing

spatial context.

It's important to allow the user to focus and interact with content. Continuous visualization of the spatial mesh

in the background can be distracting. We recommend visualizing the environment sparingly, either only once in

the initial launch or when the user clearly shows they want to see the environmental mesh by targeting and air-

tapping space. You can observe this behavior in the Mixed Reality Portal. 

MRTK provides several materials for the spatial mesh visualization.

MRTK_Wireframe.mat, MRTK_Wireframe.matMRTK_Wireframe.mat, MRTK_Wireframe.mat: Default static spatial mesh material, which shows the

mesh outlines without animation. This material is useful for debugging purposes since it shows the entire

spatial mesh geometries. However, it isn't recommended for production. 

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/spatial-mesh-ux.md


 See also

MRTK_SurfaceReconstruction.matMRTK_SurfaceReconstruction.mat: This material gives you an animated pulse effect on the spatial

mesh. You can use this material to visualize the environment at a specific moment or on the user's air-tap

input. See PulseShaderExamples.unityPulseShaderExamples.unity  scene for the examples. 

For more information, see MRTK - Spatial Awareness and MRTK - Pulse Shader.

Cursors

Hand ray

Button

Interactable object

Bounding box and App bar

Manipulation

Hand menu

Near menu

Object collection

Voice command

Keyboard

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/spatial-awareness/spatial-awareness-getting-started
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/rendering/pulse-shader
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 What is billboarding?

 What is a tag-along?

Billboarding is a behavioral concept that can be applied to objects in mixed reality. Objects with billboarding

always orient themselves to face the user. Text and menu systems are common use cases, where static objects

placed in the user's environment (world-locked) would be otherwise obscured or unreadable when users move

around.

Objects with billboarding enabled can rotate freely in the user's environment. They can also be constrained to a

single axis depending on design considerations. Keep in mind, billboarded objects can clip or occlude

themselves when placed too close to other objects, or in HoloLens, too close scanned surfaces. To avoid this,

think about the total footprint an object may produce when rotated on the axis enabled for billboarding.

Tag-along is a behavioral concept that can be added to holograms. A tag-along object attempts to stay in a

range that allows the user to interact comfortably.

The HoloLens Start menu is a great example of tag-along behavior

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/billboarding-and-tag-along.md


 Billboarding and Tag-along in MRTK (Mixed Reality Toolkit) for Unity

 See also

Tag-along objects have parameters, which can fine-tune the way they behave. Content can be in or out of the

user ’s line of sight while the user moves around their environment. As you move, the content attempts to stay

within the user ’s periphery by sliding towards the edge of the view. The content might be temporarily out of

view depending on how quickly the user is moving. When the user gazes towards the tag-along object, it comes

more fully into view. Think of content always being "a glance away" so users never forget what direction their

content is in.

Extra parameters can make the tag-along object feel attached to the user's head by a rubber band. Dampening

acceleration or deceleration gives weight to the object making it feel more physically present. This spring

behavior is an affordance that helps the user build an accurate mental model of how tag-along works. Audio

helps provide other cues for when users have objects in tag-along mode. Audio should reinforce the speed of

movement; a fast head turn should provide a more noticeable sound effect, while walking at a natural speed

should have minimal or no audio effects.

Just like truly head-locked content, tag-along objects can prove overwhelming or nauseating if they move wildly

or spring too much in the user ’s view. As a user looks around, then quickly stops, their senses tell them they've

stopped. Their balance informs them that their head has stopped turning and their vision sees the world stop

turning. However, if tag-along keeps on moving when the user has stopped, it may confuse their senses.

MRTKMRTK provides scripts for the Billboarding and tag-along behavior. Assign the Billboard.cs script onto any object

to add billboarding behavior and make the object always face you. To add tag-along behavior, use the

RadialView.cs script. You can adjust various options such as lerping time, distance, and degree.

MRTK - Radial View Solver

MRTK - Billboard script

Cursors

Hand ray

Button

Interactable object

Bounding box and App bar

Manipulation

Hand menu

Near menu
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Voice command

Keyboard

Tooltip
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Billboarding and tag-along

Displaying progress

Surface magnetism

https://github.com/Microsoft/MixedRealityToolkit-Unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/solvers/solver#radialview
https://github.com/microsoft/MixedRealityToolkit-Unity/blob/main/Assets/MRTK/SDK/Features/UX/Scripts/Utilities/Billboard.cs
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 Types of progress

  Progress barProgress bar

A progress control provides feedback that a long-running operation is underway. When a progress indicator is

visible, users can see the wait time and can't interact with the app.

It's important to provide the user information about what is happening. In mixed reality, users can be easily

distracted by the physical environment or objects if your app doesn't have good visual feedback. For situations

that take a few seconds, like when data is loading or a scene is updating, it's a good idea to show a visual

indicator. There are two options to show the user that an operation is underway – a Progress barProgress bar  or a

Progress r ingProgress r ing.

A Progress bar shows the percentage completed of a task. It should be used during an operation whose

duration is known (determinate), but its progress shouldn't block the user's interaction with the app.

Image: Progress bar example in HoloLens

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/progress.md


  Progress ringProgress ring

  Progress with a custom objectProgress with a custom object

A Progress ring only has an indeterminate state, and should be used when user interaction is blocked until the

operation has completed.

Image: Progress ring example in HoloLens

You can add to your app's personality and brand identity by customizing the Progress control with your own

custom 2D/3D objects.

Image: Progress with custom mesh example in HoloLens



 Best practices

 Progress indicator in MRTK (Mixed Reality Toolkit) for Unity

 See also

Tightly couple billboarding or tag-along to the display of Progress since the user can easily move their head

into empty space and lose context. Your app might look like it has crashed if the user is unable to see

anything. Billboarding and tag-along is built into the Progress prefab.

It's always good to provide status information about what is happening to the user. The Progress prefab

provides various visual styles including the Windows standard ring-type progress for providing status. You

can also use a custom mesh with an animation if you want the style of your progress to align to your app’s

brand.

MRTK - Progress indicator prefabs

MRTK - Scene transition service
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https://github.com/microsoft/MixedRealityToolkit-Unity/tree/main/Assets/MRTK/SDK/Features/UX/Prefabs/ProgressIndicators
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/extensions/scene-transition-service
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 Surface magnetism in MRTK (Mixed Reality Toolkit) for Unity

 See also

Surface magnetism lets you place holographic objects on real-world physical surfaces. By aligning the object's

orientation with the real-world surface, you can create a more immersive and natural experience for the user.

MRTKMRTK provides scripts and example scenes for the surface magnetism technique. You can use surface

magnetism with various types of inputs such as hand-ray, eye gaze, and motion controllers.

MRTK - Surface magnetism solver

MRTK - Spatial awareness + Surface magnetism example scenes

Cursors

Hand ray

Button

Interactable object

Bounding box and App bar

Manipulation

Hand menu

Near menu

Object collection

Voice command

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/surface-magnetism.md
https://github.com/Microsoft/MixedRealityToolkit-Unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/solvers/solver#surfacemagnetism
https://github.com/microsoft/MixedRealityToolkit-Unity/blob/main/Assets/MRTK/Examples/Demos/Solvers/Scenes/SurfaceMagnetismSpatialAwarenessExample.unity
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NOTENOTE

 Getting started with Maquette

Microsoft is not actively developing Microsoft Maquette at this time, and the access to the application in the store will be

discontinued. Microsoft will apply the learnings from building the application and the feedback from the community to

enable better tools for Mixed Reality content creation in the future. While there are no plans to open source any of

Maquette's source code, we will continue to offer the application as a download here. We want to thank the community

for the journey and support.

Download the Maquette app package

 

Microsoft Maquette makes spatial prototyping easy, quick, and immersive. As a VR developer, you can use the

various tools and assets that Maquette provides to construct and iterate ideas in space.

Import images & 3D content, and export Maquette content for use in other tools.

Design Incredible Immersive Interfaces, Spaces, & Experiences.

Bring Maquette Content Into Unity With the Unity Add-on.

Here is a list of Maquette tutorial videos in alphabetical order :

Interacting with UI

Moving around

Teleporting

Manipulating content

Rotational snapping

Surface snapping

Duplicating content

Erasing content

Selecting content

Needle selection

Grouping content

Gimbal positioning

Bounding manipulation

Orientation tool

Coloring content

Lighting

Hull brush

Volume brush

Tube brush

Parametric objects

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/maquette.md
https://aka.ms/MaquetteDownloadAppPackage
https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Maquette-Teaser/player
https://docs.microsoft.com/en-us/shows/docs-mixed-reality/maquette-hand-ui
https://docs.microsoft.com/en-us/shows/docs-mixed-reality/maquette-swimming
https://docs.microsoft.com/en-us/shows/docs-mixed-reality/maquette-teleporting
https://docs.microsoft.com/en-us/shows/docs-mixed-reality/maquette-object-manipulation
https://docs.microsoft.com/en-us/shows/docs-mixed-reality/maquette-rotational-snapping
https://docs.microsoft.com/en-us/shows/docs-mixed-reality/maquette-surface-snapping
https://docs.microsoft.com/en-us/shows/docs-mixed-reality/maquette-duplicating-content
https://docs.microsoft.com/en-us/shows/docs-mixed-reality/maquette-erasing-content
https://docs.microsoft.com/en-us/shows/docs-mixed-reality/maquette-selecting-content
https://docs.microsoft.com/en-us/shows/docs-mixed-reality/maquette-needle-selection
https://docs.microsoft.com/en-us/shows/docs-mixed-reality/maquette-grouping-content
https://docs.microsoft.com/en-us/shows/docs-mixed-reality/maquette-gimbal
https://docs.microsoft.com/en-us/shows/docs-mixed-reality/maquette-bounding-manipulation
https://docs.microsoft.com/en-us/shows/docs-mixed-reality/maquette-orientation-tool
https://docs.microsoft.com/en-us/shows/docs-mixed-reality/maquette-coloring-content
https://docs.microsoft.com/en-us/shows/docs-mixed-reality/maquette-lighting
https://docs.microsoft.com/en-us/shows/docs-mixed-reality/maquette-hull-brush
https://docs.microsoft.com/en-us/shows/docs-mixed-reality/maquette-volume-brush
https://docs.microsoft.com/en-us/shows/docs-mixed-reality/maquette-tube-brush
https://docs.microsoft.com/en-us/shows/docs-mixed-reality/maquette-parametric-objects


 Export content from Maquette
  Part 1 - Export content from MaquettePart 1 - Export content from Maquette

  Part 2 - Import the Maquette Unity Add-On into UnityPart 2 - Import the Maquette Unity Add-On into Unity

  Part 3 - Import Maquette Content into Unity with the Unity Add-OnPart 3 - Import Maquette Content into Unity with the Unity Add-On

Lock object

1. Use the Select Tool to highlightwhat you want to export to Unity.

2. Highlight your desired content,and select the Expor tExpor t icon at the bottom of the Select menu on your hand.

3. In the context menu that appears, rename the content for export, and select Export toeither .FBX, .GLB,

or.GLTF file types.

4. A File Explorer window will appear on your desktop showing your exported files, and you can always find

Maquette's exported filesin~Documents/Maquette/Expor ts/~Documents/Maquette/Expor ts/

The Maquette Unity Editor Add-On package ensures .FBX and .GLTF files exported from Maquette appear in

Unity in the same way they appear in Maquette. Without importing this package, Unity will not display

Maquette's materials and images.

1. Open the Unity project where you intend to use your Maquette content within.

2. In theUnity taskbar, selectAssets > Impor t Package > Custom PackageAssets > Impor t Package > Custom Package, and open theMicrosoft

Maquette Unity Editor Add-On package, downloaded from the button above.

3. SelectImpor tImpor tat the bottom right ofthe window that appears.

Download the Unity Add-on

1. Import theMaquette Unity Editor Add-Onpackage (See the section below for more info)into your Unity

project.

2. Bring your .FBX, .GLB, or .GLTF files exported from Maquette into your Unity project. Unity will preserve

the grouping hierarchy of your content, and the materials and images as they appear in Maquette, with

your imported theMicrosoft Maquette Unity Editor Add-On.

https://docs.microsoft.com/en-us/shows/docs-mixed-reality/maquette-lock-object
https://aka.ms/MaquetteDownloadAddOn
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 Optimize and convert 3D models

 Check your 3D models

 For Unity Developers: Mixed Reality Toolkit and Asset Store

 

If you’re developing for the HoloLens or immersive headsets such as the HP Reverb 2, there’s a good chance

that you’ll need to have 3D models in your app. Thankfully, you don’t have to be a 3D artist, or have one on your

team, to assemble the assets you need to realize your vision. There are a number of ways to obtain pre-made

models free, or at a reasonable cost. We’ll take a look at some of these below. We’ll also discuss how you can get

started if you're interested in creating your own 3D models.

We recommend that you use the Dynamics 365 optimizing guide.

If you're looking for other tools to post-process 3D models, you can optimize any glTF 2.0 model using the

Windows Mixed Reality Asset Converter available on GitHub. This toolkit includes a command line tool that uses

these steps in sequence in order to convert a glTF 2.0 core asset for use in the Windows Mixed Reality home.

For general best practices, see our real-time 3D model conversion and optimization guide.

To check your 3D models, we recommend that you use the Babylon.js 3D viewer tool in the scene explorer.

If you’re a Unity developer and need objects that you can use for spatial interaction and UI, you don’t have to go

far. If you're using our Mixed Reality Toolkit (MRTK) in your project, you already have a wide range of built-in

objects including bounding boxes, pressable buttons, hand menus, slates, sliders and more.

If you’re new to MRTK, download the MRTK Examples Hub app and have a look around.

The Unity Asset Store is a great place to find assets that you can quickly integrate into your project. Their

inventory is massive and they claim to have over 11,000 five-star assets so there’s a good chance you can find

what you need or something close. It’s worth taking a look, especially when you consider that many of the

assets are free.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/3d-modeling.md
https://www.microsoft.com/en-us/hololens
https://www.hp.com/us-en/vr/reverb-g2-vr-headset.html
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/import-tool/optimize-models
https://github.com/microsoft/glTF-Toolkit
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/import-tool/best-practices
https://www.babylonjs.com
https://www.microsoft.com/en-us/p/mrtk-examples-hub/9mv8c39l2sj4?activetab=pivot:overviewtab
https://assetstore.unity.com/3d


Pre-made Assets

 Make your own 3D Models

There are numerous Web sites that offer pre-made 3D and CAD (Computer-Aided Design) models and

animations at reasonable or no cost. Some of the more popular ones are:

Sketchfab

CAD Models HoloLens in the Microsoft store

Turbo Squid

CGTrader

Mixamo (models and animations)

Blender Market (Learn more about the Blender modeling tool below)

3DExport

If you can't find pre-made 3D models that fulfill your needs, it may be worth your while to develop some 3D

modeling skills or have someone on your team do so. At its highest level, 3D modeling is a vast, complex skill

that encompasses numerous subdisciplines:

Rigging and animating

Shaders

Particles

Materials

Game optimization

UV mapping

Scripting

Lighting

As you can imagine, it requires considerable time and effort to become a highly proficient 3D modeler. The good

news is that you don’t have to become an expert to reap some benefits; just having a few basic skills in your

toolbox, such as the ability to change materials on a model or convert a high-poly model to a low-poly one, can

result in significant improvements to your apps.

Here are some of the more popular 3D modeling programs.

Autodesk Maya

Blender

Blender is a popular choice partly because these kinds of tools tend to be expensive and Blender is free. In past

years, Blender was viewed as less capable than the high-end tools in this category. However, it has undergone

substantial improvements in the last few versions and is now considered by many to be a fully professional-

level tool.

3ds Max

Houdini

ZBrush

CAD (Computer-Aided Design)CAD (Computer-Aided Design)

CAD programs also let you build 3D models and may offer you advanced domain-specific features that you

https://sketchfab.com/tags/hololens
https://www.microsoft.com/en-us/p/cad-models-hololens/9pb4ddf8fxzs?activetab=pivot:overviewtab
https://www.turbosquid.com/Search/3D-Models/hololens
https://www.cgtrader.com/3d-models/hololens
https://www.mixamo.com/#/
https://www.blendermarket.com/
https://3dexport.com/
https://www.autodesk.com/products/maya/overview?term=1-YEAR&tab=subscription
https://www.blender.org/
https://www.autodesk.com/products/3ds-max/overview?term=1-YEAR&tab=subscription
https://www.sidefx.com/
http://pixologic.com/features/about-zbrush.php


 Learning Resources

 Using 3D Viewer on HoloLens 2 and HoloLens (1st gen)

  HoloLens (1st gen) Beta versionHoloLens (1st gen) Beta version

C a u t i o nC a u t i o n

  ResourcesResources

won’t get in one of the programs listed above. For example, if your app targets infrastructure, buildings, circuits,

telecommunications networks, thermodynamics, mechanical parts, medical devices, or manufacturing, then a

CAD program may be the best choice for you. You can create models in the CAD program and then convert

them into a format that can be used for mixed reality apps.

Here are some of the more popular CAD programs.

AutoCAD

Autodesk Inventor

Siemens NX

Catia

SolidWorks

The best place to start looking for tutorials, videos, and other learning resources is on the Web site of your

chosen tool. Large streaming video sites like Youtube have many tutorials about 3D modeling, but since anyone

can post a video, the quality can vary widely. Some tools have dedicated Youtube channels--two examples are

Blender and Maya.

Another free, worthwhile resource may be your local public library. Many libraries offer streaming eLearning

videos on their Web sites, and there tend to be many computer topics from high-quality sources. For example,

the San Francisco public library offers videos from LinkedIn Learning.

If you’re willing to pay, here are some of the more popular video tutorial sites:

Udemy.

Udacity

Coursera

edX

HoloLens 2 and HoloLens (1st gen) both ship with a version of the 3D Viewer application. The 3D Viewer on

HoloLens 2 is designed to serve a very different purpose than 3D Viewer for the desktop or Model Viewer from

HoloLens (1st gen). 3D Viewer for HoloLens 2 is more of a "Decorate your space" app. You'll notice that

holograms persist in place and remain visible even while other 2D apps are running. This means that models

loaded into 3D Viewer for HoloLens 2 must closely align to the requirements for 3D App Launchers.

The 3D Viewer Beta application is only available on HoloLens (1st gen) devices. The beta version can handle

showing higher-complexity models, while the original 3D Viewer doesn't. However, if you're working with lots of

complex models, you might find Azure Remote Rendering to be a better long-term option.

Check out our 3D Viewer Beta on HoloLens (1st gen) documentation for a list of supported files, features, use-

cases, and troubleshooting details.

The 3D Viewer Beta applications only runs on x86 and x64 architecture, and won't work with ARM for HoloLens

2 devices.

https://www.autodesk.com/products/autocad/overview?term=1-YEAR&tab=subscription
https://www.autodesk.com/products/inventor/overview?term=1-YEAR&tab=subscription
https://www.plm.automation.siemens.com/global/en/products/nx/
https://www.3ds.com/products-services/catia/?wockw=card_content_cta_1_url%253A%2522https%253A%252F%252Fblogs.3ds.com%252Fcatia%252F%2522
https://my.solidworks.com/try-solidworks?mktid=13825&utm_campaign=202007_nam_sw_BINGSWOPT_en_XOP2062_rise_brand_nam_us_exact&utm_medium=cpc&utm_source=bing&utm_content=search&utm_term=1970a52062131481b383c4a1cb107268&gclid=1970a52062131481b383c4a1cb107268&gclsrc=3p.ds&msclkid=1970a52062131481b383c4a1cb107268
https://www.youtube.com/user/BlenderFoundation
https://www.youtube.com/c/MayaHowTos
https://www.linkedin.com/learning-login/go/sfpl
https://www.udemy.com
https://www.udacity.com/
https://www.coursera.org/
https://www.edx.org/
https://docs.microsoft.com/en-us/azure/remote-rendering/
https://docs.microsoft.com/en-us/hololens/holographic-3d-viewer-beta


Download glTF Viewer

Download mixpace

Download droppar.io

Download SketchUp Viewer

Download 3skeng AR

https://www.microsoft.com/p/gltf-viewer/9mwmgknx8fkh
https://www.microsoft.com/p/mixpace/9ph50tf4jvlv
https://www.microsoft.com/p/droppario/9nf4hq5gr82d
https://www.microsoft.com/p/sketchup-viewer/9ngf868jkvm3
https://www.microsoft.com/p/3skeng-ar/9mvmq3dz3p71
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 Things to consider

A SSET SA SSET S C P UC P U GP UGP U M EM O RYM EM O RY

Polygons 0% 5% 10%

Textures 5% 15% 25%

Shaders 15% 35% 0%

DynamicsDynamics

Windows Mixed Reality builds on the decades of investment Microsoft has made into DirectX. All of the

experience and skills developers have with building 3D graphics continues to be valuable with HoloLens.

The assets you create for a project come in many shapes and forms. They can be composed of a series of

textures/images, audio, video, 3D models, and animations. We can't begin to cover all the tools that are available

to create the different types of assets used in a project. For this article, we'll focus on 3D asset creation methods.

Concept, creation, integration, and iteration flow

When looking at the experience, you're trying to create, think of it as a budgetbudget that you can spend to try to

create the best experience. There aren't necessarily any hard limits on the number of polygonspolygons  or mater ialmater ial

typestypes  you can use in your assets. Think of it more as a budgeted set of tradeoffs.

Below is an example budget for your experience. Performance isn't a single point of failure, but death by a

thousand cuts. 

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/asset-creation-process.md


Physics 5% 15% 0%

Real-time lighting 10% 0% 0%

Media (audio/video) - 15% 25%

Script/logic 25% 0% 5%

General overhead 5% 5% 5%

TotalTotal 65%65% 90%90% 70%70%

 Authoring assets

  Creating assetsCreating assets

Total number of assetsTotal number of assets

How many assets are active in the scene?

Complexity of assetsComplexity of assets

How many triangles / polygons?

How complex is the shader? When using the Mixed Reality Toolkit, it's recommended to use the Mixed Reality

Toolkit Standard shader to reduce shader complexity.

Both the developers and artists have to consider the capabilities of the device and the graphics engine. Microsoft

HoloLens has all of the computational and graphics built into the device. It shares the capabilities developers

would find on a mobile platform.

The asset creation process is the same whether your experience targets a holographic device or an immersive

device. The primary thing to note is the device capability and scale. You can see the real world in mixed reality, so

you'll want to maintain the correct scale based on the experience.

We'll start with the ways to get assets for your project:

1. Creating Assets (Authoring tools and object capture)

2. Purchasing Assets (Buying assets online)

3. Porting Assets (Taking existing assets)

4. Outsourcing Assets (Importing assets from third parties)

Authoring toolsAuthoring tools

First you can create your own assets in several different ways. 3D artists use various applications and tools to

create models, which consist of meshesmeshes , texturestextures , and mater ialsmater ials . This is then saved in a file format that can be

imported or used by the graphics engine used by the app, such as .FBX.FBX or .OBJ.OBJ . Any tool that generates a

model that your chosen graphics engine supports will work on HoloLensHoloLens . Among 3D artists, many choose to

use Autodesk’s Maya because it can use HoloLens to transform the way assets are created. If you want to get

something in quick, you can also use 3D Builder that comes with Windows to export .OBJ for use in your

application.

Object captureObject capture

There's also the option to capture objects in 3D. Capturing inanimate objects in 3D and editing them with digital

content creation software is increasingly popular with the rise of 3D printing. Using the Kinect 2Kinect 2  sensor and 3D

Builder you can use the capture feature to create assets from real world objects. This is also a suite of tools to do

the same with photogrammetr yphotogrammetr y  by processing several images to stitch together and mesh and textures.

https://github.com/microsoft/MixedRealityToolkit-Unity/blob/mrtk_release/Documentation/README_MRTKStandardShader.md
https://www.youtube.com/watch?v=q0K3n0Gf8mA
https://developer.microsoft.com/windows/hardware/3d-print/3d-builder-resources
https://developer.microsoft.com/windows/hardware/3d-print/3d-builder-resources
https://en.wikipedia.org/wiki/Comparison_of_photogrammetry_software


  

Purchasing assetsPurchasing assets

  Porting assetsPorting assets

  Outsourcing assetsOutsourcing assets

Another excellent option is to purchase assets for your experience. There are a ton of assets available through

services such as the Unity Asset Store or TurboSquid among others.

When you purchase assets from a third party, you always want to check the following properties:

What's the poly count?What's the poly count?

Are there levels of detail (LODs) for the model?Are there levels of detail (LODs) for the model?

Is the source file available?Is the source file available?

Know what you're gettingKnow what you're getting

Does it fit within your budget?

A models level of detail lets you scale the detail of a model for performance.

Not included with Unity Asset Store but always included with services like TurboSquid.

Without the source file, you can't modify the asset.

Make sure the source file provided can be imported by your 3D tools.

Are animations provided?

Make sure to check the contents list of the asset you're purchasing.

In some cases you'll be handed existing assets that were originally built for other devices and different apps. In

most cases, these assets can be converted to formats compatible with the graphics engine their app is using.

When porting assets to use in your HoloLens application, you'll want to ask the following questions:

Can you impor t directly or does need to be conver ted to another format?Can you impor t directly or does need to be conver ted to another format? Check the format you're

importing with the graphics engine you're using.

If conver ting to a compatible format is anything lost?If conver ting to a compatible format is anything lost? Sometimes details can be lost or importing can

cause artifacts that need to be cleaned up in a 3D authoring tool.

What is the tr iangle / polygon count for the asset?What is the tr iangle / polygon count for the asset? Based on the budget for your application you can

use Simplygon or similar tools to decimate (procedurally or manually reduce poly count) the original asset to

fit within your applications budget.

Another option for larger projects that require more assets than your team is equipped to create is to outsource

asset creation. The process of outsourcing involves finding the right studio or agency that specializes in

outsourcing assets. This can be the most expensive option but also be the most flexible in what you get.

Clear ly define what you're requestingClear ly define what you're requesting

Provide a BudgetProvide a Budget

Understand the costsUnderstand the costs

Provide as much detail as possible

Front, side, and back concept images

Reference art showing asset in context

Scale of object (Usually specified in centimeters)

Poly count range

Number of textures

Type of shader (For Unity and HoloLens you should always default to mobile shaders first)

What's the outsourcing policy for change requests?

Outsourcing can work well based on your projects timeline but requires more oversight to guarantee that you

get the right assets you need the first time.

https://www.assetstore.unity3d.com/
https://www.turbosquid.com/
https://www.assetstore.unity3d.com/
https://www.turbosquid.com/
https://www.simplygon.com/


   

 

Design your own immersive environments
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NOTENOTE

 Device support

FeatureFeature HoloLensHoloLens Immersive headsetsImmersive headsets

Custom home environments ❌ ✔️

 Trying a sample environment

This is an experimental feature. Give it a try and have fun with it, but don't be surprised if everything doesn't quite work

as expected. We're evaluating the viability of this feature and interest in using it, so please tell us about your experience

(and any bugs you've found) in the developer forums.

Starting with the Windows 10 April 2018 update, we've enabled an experimental feature that lets you add

custom environments to the Places picker (on the Start menu) to use as the Windows Mixed Reality home.

Windows Mixed Reality has two default environments, Cliff House and Skyloft, you can choose as your home.

Creating custom environments allows you to expand the list with your own creations. We're making this feature

available in an early state to evaluate interest from creators and developers. See what kinds of worlds you create

and understand how you work with different authoring tools.

When using a custom environment you'll notice that teleporting, interacting with apps, and placing holograms

works just like it does in the Cliff House and Skyloft. You can browse the web in a fantasy landscape or fill a

futuristic city with holograms - the possibilities are endless!

We've created a sample environment that shows off some of the creative possibilities of custom home

environments. Follow these steps to try it out:

1. Download our sample Fantasy Island environment (link points to self-extracting executable).

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/add-custom-home-environments.md
https://forums.hololens.com/categories/custom-home-environments
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/release-notes-april-2018
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://download.microsoft.com/download/B/2/5/B25C1AEF-40CD-4B03-A596-4BCA3D33035A/Fantasy_Island.exe


 Creating your own custom environment

  Modeling guidelinesModeling guidelines

  Exporting your environmentExporting your environment

  Environment limitsEnvironment limits

NOTENOTE

Fantasy Island sample environment

2. Run the Fantasy_Island.exeFantasy_Island.exe file you downloaded.

When attempting to run a .exe file downloaded from the web (like this one), you may encounter a "Windows

protected your PC" pop-up. To run Fantasy_Island.exe from this pop-up, select More infoMore info and then RunRun

anywayanyway . This security setting is meant to protect you from downloading files you may not want to trust, so

please only choose this option when you trust the source of the file.

3. Open File ExplorerFile Explorer  and navigate to the environments folder by pasting the following file location in the

address bar : %LOCALAPPDATA%\Packages\EnvironmentsApp_cw5n1h2txyewy\LocalState .

4. Copy the sample environment that you downloaded into this folder.

5. Restart Mixed Reality Por talMixed Reality Por tal  to refresh the list of environments in the Places picker.

6. Put on your headset. Once you're in the home, open the Star t menuStar t menu using the Windows button your

controller.

7. Select the PlacesPlaces  icon above the list of pinned apps to choose a home environment.

8. You'll find the Fantasy Island environment that you downloaded in your list of places. Select FantasyFantasy

IslandIsland to enter your new custom home environment!

In addition to using our sample environments, you can export your own custom environments using your

favorite 3D editing software.

When modeling your environment, keep the following recommendations in mind so that users spawns in the

correct orientation in a believably sized world:

1. Users will spawn at 0,0,0 so center your spawn location around the origin.

2. Working Units should be set to meters so that assets can be authored at world scale.

3. The Up axis should be set to “Y”.

4. The asset should face “forward” towards the positive Z axis.

5. You don't have to combine all your meshes, but it's recommended if you're targeting resource-constrained

devices.

Windows Mixed Reality relies on binary glTF (.glb) as the asset delivery format for environments. glTF is a

royalty free open standard for 3D asset delivery maintained by the Khronos group. Microsoft’s support for the

format across Windows apps and experiences will grow as glTF evolves as an industry standard for

interoperable 3D content.

The first step in exporting assets to be used as custom home environments is generating a glTF 2.0 model. The

glTF working group maintains a list of supported exporters and converters to create a glTF 2.0 model. To get

started, use one of the programs listed on this page to create and export a glTF 2.0 model, or convert an existing

model using one of the supported converters.

All environments must be < 256 mbs. Environments larger than 256 mbs will fail to load and fall back to an

empty world with just the default skybox surrounding the user. Keep this file size limit in mind when creating

https://github.com/KhronosGroup/glTF/blob/master/README.md#converters-and-exporters


  Optimizing your environmentOptimizing your environment

F L A GF L A G REC O M M EN DED VA L UE( S)REC O M M EN DED VA L UE( S) DESC RIP T IO NDESC RIP T IO N

-max-texture-size 1024 or 2048 Tweak the value to improve the quality
of the textures, default is 512x512. A
larger value will significantly impact the
file size of the environment so keep
the 256-mb limit in mind

-min-version 1803 Custom environments are only
supported on versions of windows >=
1803. This flag will remove textures for
older versions and reduce the file size
of the final asset

WindowsMRAssetConverter FileToConvert.gltf -max-texture-size 1024 -min-version 1803

  Testing your environmentTesting your environment

 Sending feedback

 Troubleshooting and tips
  How do I change the name of the environment?How do I change the name of the environment?

  How do I remove custom environments from my Places picker?How do I remove custom environments from my Places picker?

your models. Additionally, if you plan to optimize your environment using the WindowsMRAssetConverter as

described below, be cognizant that the texture size will increase as the optimizer creates textures that have a

larger file size, but load faster.

Windows Mixed Reality supports many optional optimizations that can significantly reduce your environment

load times. Pay special attention with environments that have lots of textures, as they'll sometimes time out

while loading. In general, we recommend this step for all assets, however, smaller environments with few or

low-resolution textures won't always require it.

To make this process easier, we've created the Windows Mixed Reality Asset Converter (available on GitHub) to

do your optimizations. This tool uses a set of utilities available in the Microsoft glTF toolkit to optimize any

standard 2.0 glTF or.glb by performing an extra texture packing, compression, and resolution down-scaling.

The converter currently supports several flags to tweak the exact behavior of the optimizations. We recommend

running with the following flags for best results:

For example:

Once you have your final.glb environment, you're ready to test it out in the headset. Start at step 2 in the "Trying

a sample environment" section to use your custom environment as the mixed reality home.

While we're evaluating this experimental feature, we're interested in learning how you're using custom

environments, any bugs you may find, and how you like the feature. Share any feedback for creating and using

custom home environments in the developer forums.

The file name in the environments folder will be used in the Places picker. To change the name of your

environment, rename the environment file name, and then restart Mixed Reality Portal.

To remove a custom environment, open the environments folder on your PC (

%LOCALAPPDATA%\Packages\EnvironmentsApp_cw5n1h2txyewy\LocalState ) and delete the environment. Once you

restart Mixed Reality Portal, this environment will no longer appear in the Places picker.

https://github.com/Microsoft/glTF-Toolkit/releases
https://forums.hololens.com/categories/custom-home-environments


  How do I default to my favorite custom environment?How do I default to my favorite custom environment?

  I spawn into a blank spaceI spawn into a blank space

  It takes a long time to load my environmentIt takes a long time to load my environment

  The scale of my environment is incorrectThe scale of my environment is incorrect

  The spawn location in my environment is incorrectThe spawn location in my environment is incorrect

  The audio doesn't sound correct in the environmentThe audio doesn't sound correct in the environment

 See also

You can't currently change the default environment. Each time you restart Mixed Reality Portal, you'll be

returned to the Cliff House environment.

Windows Mixed Reality doesn't support environments that exceed 256 mb. When an environment exceeds this

limit, you'll land in the empty sky box with no model.

You can add optional optimizations to your environment to make it load faster. See "Optimizing your

environment" for details.

Windows Mixed Reality translates glTF units to 1 meter when loading environments. If your environment loads

up an unexpected scale, double check your exporter to ensure that you're modeling at a 1-meter scale.

The default spawn location is located at 0,0,0 in the environment. It's not currently possible to customize this

location, so you must modify the spawn point by exporting your environment with the origin positioned at the

spawn point you want.

When you create your custom environment, it will be using an acoustics rendering simulation that doesn't

match the physical space you've created. Sound may come from the wrong directions and may sound muffled.

Windows Mixed Reality Asset Converter (on GitHub)

https://github.com/Microsoft/glTF-Toolkit/releases


   

 

MRTK Figma Toolkit
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NOTENOTE

 How to use Figma Toolkit

MRTK Figma Toolkit provides 2D versions of the HoloLens 2 style UI controls that you can find in the MRTK for

Unity or MRTK for Unreal. You can use this in the design process for creating UI layouts and storyboards.

View MRTK Figma Toolkit

Starting with MRTK3 we are introducing a new Mixed Reality design language to developers. For more information, see

the MRTK3 documentation.

Use Duplicate to your draftsDuplicate to your drafts  menu to make a copy.

Click Back to filesBack to files  to see duplicated copy. You can use this copy for your own creation.

To download and work locally, use File > save local copyFile > save local copy  menu. Import downloaded file (.fig) into Figma

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/figma-toolkit.md
https://www.microsoft.com/en-us/videoplayer/embed/RWGqke
https://www.figma.com/file/zeGez3Phuzel9JrU1o20nn/Figma-Toolkit-for-MRTK-HoloLens-Windows-Mixed-Reality?node-id=116%253A4
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/mrtk3-overview


 UI Gallery & Components

using the Impor tImpor t button on the upper right corner.

You can use the PagesPages  menus on the left to open different pages included in the file.

Open IntroductionIntroduction page to learn about how to use components and states.

UI Gallery and Components page show all available components for your design.



Using AssetsAssets  tab, you can browse these components and drag into your page.



 Examples
Figma Toolkit could be useful to sketch menu UI.

Assets could be used for storyboarding.



 See also
Cursors

Hand ray

Button

Interactable object

Bounding box and App bar

Manipulation

Hand menu

Near menu

Object collection

Voice command

Keyboard

Tooltip

Slate

Slider

Shader

Billboarding and tag-along

Displaying progress

Surface magnetism



   

 

MRTK Figma Bridge for Unity (Beta)
 7/6/2022 • 2 minutes to read • Edit Online

 Prerequisites

IMPORTANTIMPORTANT

 How to use MRTK Figma Bridge
  1. Installation1. Installation

MRTK Figma Bridge for Unity allows you to bring the layout from Figma Toolkit into Unity. The bridge can

import UI layout created with MRTK Figma Toolkit, then instantiates corresponding MRTK prefabs with proper

position and size. Figma Bridge will help design integration process and collaboration between designers and

developers.

See MRTK Figma ToolkitMRTK Figma Toolkit page to learn about Figma Toolkit which is the design file with HoloLens 2 style UI

library.

See Install the tools for the required software for Mixed Reality development

Unity 2019 or higher

MRTK-Unity 2.7.0 or higher

Requires MRTK-Unity 2.7.0 or higherRequires MRTK-Unity 2.7.0 or higher

Since Figma Toolkit and Figma Bridge are based on MRTK 2.7.0 prefabs, MRTK 2.7.0 or higher version is required. When

used with lower version of MRTK, some components won't be translated properly.

Figma Unity Bridge can be installed through Mixed Reality Feature Tool. Download and run Mixed Reality

Feature Tool.

In Discover featuresDiscover features  page, under Mixed Reality ToolkitMixed Reality Toolkit section, select MRTK Figma BridgeMRTK Figma Bridge. Follow the

steps to finish MR Feature Tool and come back to your Unity project. Unity will import the package for MRTK

Figma Bridge.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/figma-unity-bridge.md
https://www.microsoft.com/en-us/videoplayer/embed/RWKiO4
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/


  2. Open Figma Bridge window2. Open Figma Bridge window

  3. Generate and enter your Figma Token3. Generate and enter your Figma Token

Once the import process is done, you will be able to find Figma Bridge under the menu Mixed Reality >Mixed Reality >

Toolkit > Figma BridgeToolkit > Figma Bridge

On the Figma website, click Figma menu on the upper left corner, open Help and account > Account settings.

Generate a new personal access token in the 'Personal access tokens' section.



  4. Enter ID for a Figma document4. Enter ID for a Figma document

  5. Build a page5. Build a page

Each Figma document has a unique ID in the URL. Copy and paste this ID into Figma Bridge.

Click Get FileGet File to download Figma file. You can download other Figma files by entering a new ID.

Click Load FileLoad File to open a Figma file.

Figma Bridge will display the list of pages in the Figma file. Check pages that you want to build in Unity. Click

Build pagesBuild pages  button.



  6. Refresh a document for changes6. Refresh a document for changes

 See also

You can modify Figma file on the web (or using the desktop editor) and click RefreshRefresh to retrieve any changes.

Click Build pagesBuild pages  to build with updates. This way, you can easily iterate your design in Figma and see it in

Unity.

Figma Toolkit

Cursors

Hand ray

Button

Interactable object

Bounding box and App bar

Manipulation

Hand menu

Near menu

Object collection

Voice command

Keyboard

Tooltip

Slate



Slider

Shader

Billboarding and tag-along

Displaying progress

Surface magnetism



   

 

Shared experiences in mixed reality
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 Six questions to define shared scenarios

  1. How are they sharing?1. How are they sharing?

  2. What is the group size?2. What is the group size?

Holograms don't need to stay private to just one user. Holographic apps may share spatial anchors from one

HoloLens, iOS, or Android device to another, enabling users to render a hologram at the same place in the real

world across multiple devices.

Before you begin designing for shared experiences, it’s important to define the target scenarios. These scenarios

help clarify what you’re designing and establish a common vocabulary to help compare and contrast features

required in your experience. Understanding the core problem, and the different avenues for solutions, is key to

uncovering opportunities inherent in this new medium.

Through internal prototypes and explorations from our HoloLens partner agencies, we created six questions to

help you define shared scenarios. These questions form a framework, not intended to be exhaustive, to help

distill the important attributes of your scenarios.

A presentation might be led by a single virtual user, while multiple users can collaborate, or a teacher might

provide guidance to virtual students working with virtual materials—the complexity of the experiences

increases based on the level of agency a user has or can have in a scenario.

There are many ways to share, but we’ve found that most of them fall into three categories:

PresentationPresentation: When the same content is being shown to several users. For example: A professor is giving

out a lecture to several students using the same holographic material being presented to everyone. The

professor, however, could have his/her own hints and notes that may not be visible to others.

CollaborationCollaboration: When people are working together to achieve some common goals. For example: The

professor gave out a project to learn about doing a heart surgery. Students pair up and create a shared skills

lab experience, which allows medical students to collaborate on the heart model and learn.

GuidanceGuidance: When one person is helping someone to solve a problem in a more one-to-one style interaction.

For example: The professor giving guidance to a student when he/she is doing the heart surgery skills lab in

the shared experience.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/design/shared-experiences-in-mixed-reality.md


  3. Where is everyone?3. Where is everyone?

  4. When are they sharing?4. When are they sharing?

One-to-oneOne-to-one sharing experiences can provide a strong baseline and ideally your proofs of concept can be

created at this level. But be aware that sharing with large groups (beyond six people) can lead to difficulties both

technical (data and networking) and social (the impact of being in a room with several avatars). Complexity

increases exponentially as you go from smallsmall  to large groupslarge groups .

We have found that the needs of groups can fall into three size categories:

1:1

Small < 7

Large >= 7

Group size makes for an important question because it influences:

Representations of people in holographic space

Scale of objects

Scale of environment

The strength of mixed reality comes into play when a shared experience can take place in the same location. We

call that colocatedcolocated. Conversely, when the group is distributed and at least one participant isn't in the same

physical space (as is often the case with VR) we call that a remote experienceremote experience. Often, it’s the case that your

group has bothboth colocated and remote participants (for example, two groups in conference rooms).

Following categories help convey where users are located:

ColocatedColocated: All your users will be in the same physical space.

RemoteRemote: All your users will be in separate physical spaces.

BothBoth: Your users will be a mix of colocated and remote spaces.

This question is crucial because it influences:

How people communicate?

What objects they see. Are all objects shared?

Whether we need to adapt to their environment?

For example: Whether they should have avatars?

We typically think of synchronoussynchronous  experiences when shared experiences come to mind: We’re all doing it

together. But if we include a single, virtual element that was added by someone else, we have an asynchronousasynchronous

scenario. Imagine a note, or voice memo, left in a virtual environment. How do you handle 100 virtual memos

left on your design? What if they’re from dozens of people with different levels of privacy?

Consider your experiences as one of these categories of time:

https://vimeo.com/160704056


  5. How similar are their physical environments?5. How similar are their physical environments?

  6. What devices are they using?6. What devices are they using?

SynchronouslySynchronously : Sharing the holographic experience at the same time. For example: Two students doing the

skills lab at the same time.

AsynchronouslyAsynchronously : Sharing the holographic experience at different times. For example: Two students doing

the skills lab but working on separate sections at different times.

BothBoth: Your users will sometimes be sharing synchronously but other times asynchronously. For example: A

professor grading the assignment done by the students at a later time and leaving notes for students for the

next day.

This question is important because it influences:

Object and environment persistence. For example: Storing the states so they can be retrieved.

User perspective. For example: Perhaps remembering what the user was looking at when leaving notes.

The likelihood of two identical real-life environments, outside of colocated experiences, is slim unless those

environments have been designed to be identical. You’re more likely to have similarsimilar  environments. For

example, conference rooms are similar—they typically have a centrally located table surrounded by chairs.

Living rooms, on the other hand, are dissimilar** and can include any number of pieces of furniture in an infinite

array of layouts.

Consider your sharing experiences fitting into one of these two categories:

S imilarS imilar : Environments that tend to have similar furniture, ambient light and sound, physical room size. For

example: Professor is in lecture hall A and students are in lecture hall B. Lecture hall A might have fewer

chairs than B but they both may have a physical desk to place holograms on.

DissimilarDissimilar : Environments that are different in furniture settings, room sizes, light, and sound considerations.

For example: A professor is in a focus room, but students are in a large lecture hall, filled with students and

teachers.

It's important to think about the environment, as it will influence:

How people will experience these objects. For example: If your experience works best on a table and the user

has no table? Or on a flat floor surface but the user has a cluttered space.

Scale of the objects. For example: Placing a six feet human model on a table could be challenging but a heart

model would work great.

Today you’re often likely to see shared experiences between two immersive devicesimmersive devices  (those devices might

differ slightly For buttons and relative capability, but not greatly) or two holographic devicesholographic devices  given the

solutions being targeted at these devices. But consider if 2D devices2D devices  (a mobile/desktop participant or observer)

will be a necessary consideration, especially in situations of mixed 2D and 3D devicesmixed 2D and 3D devices . Understanding the

types of devices your participants will be using is important, not only because they come with different fidelity

https://docs.microsoft.com/en-us/hololens/hololens-environment-considerations
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


 Exploring the potential of shared experiences

and data constraints and opportunities, but because users have unique expectations for each platform.

Answers to the questions above can be combined to better understand your shared scenario, crystallizing the

challenges as you expand the experience. For the team at Microsoft, this helped establish a road map for

improving the experiences we use today, understanding the nuance of these complex problems and how to take

advantage of shared experiences in mixed reality.

For example, consider one of Skype’s scenarios from the HoloLens launch: a user worked through how to fix a

broken light switch with help from a remotely located expert.

An expert provides 1:11:1  guidance from his 2D2D, desktop computer to a user of a 3D, mixed-reality3D, mixed-reality  device. The

guidanceguidance is synchronoussynchronous  and the physical environments are dissimilardissimilar .

An experience like this is a step-change from our current experience—applying the paradigm of video and voice

to a new medium. But as we look to the future, we must better define the opportunity of our scenarios and build

experiences that reflect the strength of mixed reality.

Consider the OnSight collaboration tool, developed by NASA’s Jet Propulsion Laboratory. Scientists working on

data from the Mars rover missions can collaborate with colleagues in real time within the data from the Martian

landscape.

A scientist explores an environment using a 3D, mixed-reality3D, mixed-reality  device with a smallsmall  group of remoteremote

colleagues using 3D and 2D3D and 2D devices. The collaborationcollaboration is synchronoussynchronous  (but can be revisited

asynchronously) and the physical environments are (virtually) similarsimilar .

https://www.youtube.com/watch?v=iBfzs3G8BEA
https://www.youtube.com/watch?v=XtUyUJAVQ6w


 Get started building shared experiences

 Evaluating tech options

 Shared static holograms (no interactions)

 Share first person perspective

 Multi-user collaborative experience

Experiences like OnSight present new opportunities to collaborate. From physically pointing out elements in the

virtual environment to standing next to a colleague and sharing their perspective as they explain their findings.

OnSight uses the lens of immersion and presence to rethink sharing experiences in mixed reality.

Intuitive collaboration is the bedrock of conversation, working together and understanding how we can apply

this intuition to the complexity of mixed reality is crucial. If we can not only recreate sharing experiences in

mixed reality but supercharge them, it will be a paradigm shift for the future of work. Designing for shared

experiences in mixed reality is new and exciting space—and we’re only at the beginning.

Depending on your application and scenario, there will be various requirements to achieve your desired

experience. Some of these include:

Match-makingMatch-making: Ability to create sessions, advertise sessions, discover and invite specific people, both locally

and remotely to join your session.

Anchor shar ingAnchor shar ing: Ability to align coordinates across multiple devices in a common local space, so holograms

appear in the same place for all people.

NetworkingNetworking: Ability to have positions, interactions, and movements of people and holograms synchronized

in real time across all participants.

State storageState storage: Ability to store hologram characteristics and locations in space for mid-session join, recall at

a later time, and robustness against network issues.

The key to shared experiences is having multiple users seeing the same holograms in the world on their own

device, frequently done by sharing anchors to align coordinates across devices.

To share anchors, use the Azure Spatial Anchors:

First the user places the hologram.

App creates a spatial anchor, to pin that hologram precisely in the world.

The anchors can be shared to HoloLens, iOS, and Android devices via Azure Spatial Anchors.

With a shared spatial anchor, the app on each device now has a common coordinate system in which they can

place content. Now the app can ensure to position and orient the hologram at the same location.

On HoloLens devices, you can also share anchors offline from one device to another. Use the links below to

decide what's best for your application.

There are various service and technology options available to help build multi-user mixed reality experiences. It

can be tricky to choose a path, so taking a scenario-focused perspective, some options are detailed below.

Leverage Azure Spatial Anchors in your app. Enabling and sharing spatial anchors across devices allows you to

create an application where users see holograms in the same place at the same time. Additional syncing across

devices is needed to enable users to interact with holograms and see movements or state updates of holograms.

Leverage built-in Miracast support for local users when you have a supported Miracast receiver such as a PC or

TV. No additional app code is needed.

https://docs.microsoft.com/en-us/azure/spatial-anchors
https://docs.microsoft.com/en-us/azure/spatial-anchors/
https://docs.microsoft.com/en-us/azure/spatial-anchors/


NOTENOTE

 Future work

 See also

Start with our multi-user learning tutorial, which leverages Azure Spatial Anchors for local users and Photon

SDK for syncing the content/state in the scene. Create locally collaborative applications where each user has

his/her own perspective on the holograms in the scene and can each fully interact with the holograms. Updates

are provided across all devices and interaction conflict management is handled by Photon.

Please note that Photon is a non-Microsoft product, so a billing relationship with Photon may be required to productize

and scale for higher usage.

Component capabilities and interfaces will help in providing common consistency and robust support across

the various scenarios and underlying technologies. Until then, choose the best path that aligns to the scenario

you're trying to achieve in your application.

Different scenario or desire to use a different tech/service? Provide feedback as GitHub issues in the

corresponding repo, at the bottom of this page, or reach out on HoloDevelopers slack.

Azure Spatial Anchors

Shared spatial anchors in DirectX

Shared experiences in Unity

https://docs.microsoft.com/en-us/azure/spatial-anchors/
https://www.photonengine.com/PUN
https://www.photonengine.com/
https://holodevelopers.slack.com/
https://docs.microsoft.com/en-us/azure/spatial-anchors
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 New to mixed reality development?
  Learn the concepts, products and servicesLearn the concepts, products and services

  Start building a mixed reality experienceStart building a mixed reality experience

NOTENOTE

 

Mixed reality is a big place, where real and virtual worlds collide with a bang. The possibilities are endless, and it

starts with you. Choose your engine, download your tools, and dust off your keyboard. Welcome to the mixed

reality ecosystem--it's time to create.

You can choose a starting point below based on where you are in your journey so far.

Start at the very beginning with an overview of what mixed reality is and how it differs from Virtual and

Augmented Reality. Learn about the HoloLens, immersive headsets, and holograms. Explore basic design and

develop concepts and related technologies such as Azure Remote Rendering.

Introduction to mixed reality on Microsoft Learn

If you're already familiar with the basic concepts and want to get started building something, check out our

"HoloLens 2 Fundamentals" tutorial series. You'll build a mixed reality experience where the user can explore a

hologram modeled after NASA's Mars Curiosity Rover. This will give you a firm grasp of MRTK and show you

how it can speed up your development process.

HoloLens 2 Fundamentals tutorials

Starting with MRTK3 we are introducing a new Mixed Reality design language to developers. For more information, see

the MRTK3 documentation.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/development.md
https://docs.microsoft.com/en-us/learn/modules/intro-to-mixed-reality/
https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/mrtk3-overview


Choose your own development path
Are you an intermediate-to-advanced developer with some previous experience in Mixed, Augmented, or Virtual

Reality? We'll help you choose the proper tools and get set up, if needed, and then we'll direct you to our curated

development paths across Unity, Unreal, Native, or Web.

Install the tools
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TIPTIP

 Installation checklist

TO O LTO O L N OT ESN OT ES

Windows 10Windows 10  (Manual install link) or Windows 11Windows 11  (Manual
install link)

Install the most recent version of Windows 10 or 11.

Installing Windows 10Installing Windows 10  
You can install the most recent versions of Windows 10 or
11 via Windows Update in Settings or by creating
installation media using the links in the column to the left. 

See current release notes for information about the newest
mixed reality features available with each release of Windows
10 or 11. Enable developer mode on your PCEnable developer mode on your PC at
Settings > Update & Security > For developers. 

Note for enterprise and corporate-managed PCsNote for enterprise and corporate-managed PCs
If your PC is managed by an your organization's IT
department, you might need to contact them in order to
update. 

'N' versions of Windows'N' versions of Windows
Windows Mixed Reality immersive (VR) headsets are not
supported on 'N' versions of Windows.

Get the tools you need to build applications for Microsoft HoloLens and Windows Mixed Reality immersive (VR)

headsets. There is no separate SDK for Windows Mixed Reality development; you'll use Visual Studio with the

Windows 10 or Windows 11 SDK.

Don't have a mixed reality device? You can install the HoloLens emulator to test some functionality of mixed

reality apps without a HoloLens. You can also use the Windows Mixed Reality simulator to test your mixed reality

apps for immersive headsets.

We recommend installing either the Unity or Unreal game engine as the easiest way to get started creating

mixed reality apps. However, you can also build against DirectX if you'd like to use a custom engine.

If you're using Unity, you can use Mixed Reality Toolkit for Unity's input simulation to test various types of input

interactions, such as hand-tracking and eye-tracking input. For Unreal projects, use the UX Tools plugin to test

common input interactions and user experience features.

Bookmark this page and check it regularly to keep up-to-date on the most recent version of each tool recommended for

mixed reality development.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/install-the-tools.md
https://github.com/Microsoft/MixedRealityToolkit-Unity
https://github.com/microsoft/MixedReality-UXTools-Unreal
https://www.microsoft.com/software-download/windows10
https://www.microsoft.com/software-download/windows11
https://docs.microsoft.com/en-us/hololens/hololens-release-notes


Visual Studio 2022Visual Studio 2022  (Install link) 

Fully-featured integrated development environment (IDE) for
Windows and more. You'll use Visual Studio to write code,
debug, test, and deploy.

Installing Visual Studio 2022Installing Visual Studio 2022  
Be sure you install the following workloads: 

● .NET desktop development
● Desktop development with C++
● Universal Windows Platform (UWP) development
● Game development with Unity (if planning to useif planning to use
UnityUnity ) 

Note:Note:  Some of these workloads may be pre-installed if
you've installed Unity first. Make sure you have all of these
workloads for a successful deployment. 

Within the UWP workload, make sure the followingmake sure the following
components are included for installationcomponents are included for installation:

*● Windows 10 SDK version 10.0.19041.0 or 10.0.18362.0,
or Windows 11 SDK
● USB Device Connectivity (required to deploy/debug to
HoloLens over USB)
● C++ (v142) Universal Windows Platform tools (required
when using Unity)

Note about HoloLens (1st gen) and desktopNote about HoloLens (1st gen) and desktop
Windows Mixed Reality headsetsWindows Mixed Reality headsets
If you are only developing applications for desktop Windows
Mixed Reality headsets or HoloLens (1st gen), you can use
Visual Studio 2017 and use the Windows SDK installed by it.

HoloLens 2 Emulator (Windows Holographic, versionHoloLens 2 Emulator (Windows Holographic, version
22H1 May 2022 Update)22H1 May 2022 Update) (Install link: 10.0.20348.1450)

HoloLens (1st gen) EmulatorHoloLens (1st gen) Emulator  (Install link:
10.0.17763.134) 

The optional emulator lets you run applications on a
HoloLens virtual machine image without a physical
HoloLens.

See Using the HoloLens emulator for more information on
getting started with the optional emulator.

Your system must suppor t Hyper-VYour system must suppor t Hyper-V  for the emulator
installation to succeed. Reference the System Requirements
section below for details. 

Note on HoloLens (1st gen) EmulatorNote on HoloLens (1st gen) Emulator  
Visual Studio 2017 is required to successfully complete the
installation. If you're installing the HoloLens (1st gen)
emulator with Visual Studio 2022 you need to deselect the
VS templates and install them from the Visual Studio
Marketplace.

TO O LTO O L N OT ESN OT ES

 Install your engine of choice

 Troubleshooting
  Setting Developer Mode is grayed outSetting Developer Mode is grayed out

Now that you have your Windows 10 or 11, Visual Studio, and Windows 10 or 11 SDK ready to go, let's install

and set up the engine of your choice.

Choosing your engine

If you're running into issues enabling Developer Mode on your device you might not be the device owner. In

multi-user mode, the person who uses the device first is the device owner--any subsequent users won't have the

https://visualstudio.microsoft.com/downloads/
https://go.microsoft.com/fwlink/?linkid=2198236
https://go.microsoft.com/fwlink/?linkid=2065980
https://marketplace.visualstudio.com/items?itemName=WindowsMixedRealityteam.WindowsMixedRealityAppTemplatesVSIX
https://docs.microsoft.com/en-us/hololens/security-adminless-os


NOTENOTE

  I can't deploy over USBI can't deploy over USB

required permissions to enable Developer Mode or other configuration changes. However, there is an exception

where the first user may not be the device owner in an Autopilot environment, which is detailed in the HoloLens

security documentation.

Possible solutions include:

Having the device owner turn Developer Mode on before passing the device to other users or developers

Suggesting that your IT/MDM Admin enables CSP Policy ApplicationManagement/AllowDeveloperUnlock for

the specific device or a developer device group.

Using the Advanced Recovery Companion (ARC)

This policy can be set by Provisioning Packages or via MDM for HoloLens devices

You can learn more about device management in the HoloLens device managementHoloLens device management  overview.

If you're not able to deploy an application directly over USB, make sure you've met all the installation

requirements listed above and follow our step-by-step tutorial.

https://docs.microsoft.com/en-us/hololens/security-adminless-os#device-owner
https://docs.microsoft.com/en-us/windows/client-management/mdm/policy-csp-applicationmanagement#applicationmanagement-allowdeveloperunlock
https://docs.microsoft.com/en-us/hololens/hololens-provisioning
https://docs.microsoft.com/en-us/hololens/hololens-mdm-configure
https://docs.microsoft.com/en-us/hololens/hololens-recovery
https://docs.microsoft.com/en-us/hololens/hololens-csp-policy-overview
https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/#building-your-application-to-your-hololens-2
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IMPORTANTIMPORTANT

 Engine overview

 Features and devices

LO GIST IC SLO GIST IC S UN IT YUN IT Y UN REA LUN REA L JAVA SC RIP TJAVA SC RIP T
C USTO M  EN GIN E C USTO M  EN GIN E 
( USIN G O P EN XR)( USIN G O P EN XR)

Language C# C++ JavaScript C/C++

Pricing Unity pricing Unreal pricing Free Free

There are several development paths you can take through our documentation. The first step is finding the

technology that's right for you. If you already have one in mind, go ahead and jump right to its respective tab

below. If you're on the fence or just starting out, take a look through each one and understand what they offer,

the available platforms and tools, and start creating!

Take a look at our por ting guides over viewpor ting guides over view if you have existing projects that you want to bring over to HoloLens 2 or

immmersive VR headsets like the Reverb G2. We have guides for projects that are using HTK, MRTK v1, SteamVR or were

developed for immersive headsets such as the Oculus Rift or HTC Vive.

NOTENOTE

UnityUnity  is one of the leading real-time development platforms on the market, with underlying runtime

code written in C++ and all development scripting is done in C#. Whether you're looking to build games,

movies and animation cinematics, or even render architectural or engineering concepts in a virtual world,

Unity has the infrastructure to support you.

Please make sure to check out known issues in certain Unity versions before choosing a Unity version.

Unreal Engine 4Unreal Engine 4  is a powerful, open source creation engine with full support for mixed reality in both

C++ and Blueprints. As of Unreal Engine 4.25, HoloLens support is full-featured and production-ready.

With capabilities such as the flexible Blueprints Visual Scripting system, designers can virtually use the

full range of concepts and tools generally only available to programmers. Creators across industries can

leverage the freedom and control to deliver cutting-edge content, interactive experiences, and immersive

virtual worlds.

NativeNative developers with experience writing their own 3D renderers can build a custom engine using

OpenXR. OpenXR is an open royalty-free API standard from Khronos that provides engines native access

to a wide range of devices from vendors across the mixed reality spectrum. You can develop using

OpenXR on a HoloLens 2 or Windows Mixed Reality immersive headset on the desktop.

WebWeb developers creating compelling cross-browser AR/VR web experiences can use WebXRWebXR .

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/choosing-an-engine.md
https://store.unity.com/#plans-individual
https://www.unrealengine.com/download


DEVIC E  F EAT URESDEVIC E  F EAT URES UN IT YUN IT Y UN REA LUN REA L JAVA SC RIP TJAVA SC RIP T
C USTO M  EN GIN E C USTO M  EN GIN E 
( USIN G O P EN XR)( USIN G O P EN XR)

Device/display
tracking

✔️ ✔️ ✔️ ✔️

Hand input ✔️ ✔️ ✔️ ✔️

Eye input ✔️ ✔️ ❌ ✔️

Voice input ✔️ ✔️ ✔️ ✔️

Motion controllers ✔️ ✔️ ✔️ ✔️

Plane/mesh hit
testing

✔️ ✔️ ✔️ ✔️

Scene understanding ✔️ ✔️ ❌ ✔️

Spatial sound ✔️ ✔️ ✔️ ✔️

QR code detection ✔️ ✔️ ❌ ✔️

H A RDWA REH A RDWA RE UN IT YUN IT Y UN REA LUN REA L JAVA SC RIP TJAVA SC RIP T
C USTO M  EN GIN E C USTO M  EN GIN E 
( USIN G O P EN XR)( USIN G O P EN XR)

HoloLens 2 ✔️ ✔️ ✔️ ✔️

HoloLens (1st gen) ✔️ ✔️ ❌ WinRT (Legacy) only

Windows Mixed
Reality headsets

✔️ ✔️ ✔️ ✔️

SteamVR headsets ✔️ ✔️ ✔️ ✔️

Oculus Quest/Rift ✔️ ✔️ ✔️ ✔️

Mobile
(ARCore/ARKit)

✔️ ✔️ ✔️ ❌

TO O L STO O L S UN IT YUN IT Y UN REA LUN REA L JAVA SC RIP TJAVA SC RIP T
C USTO M  EN GIN E C USTO M  EN GIN E 
( USIN G O P EN XR)( USIN G O P EN XR)

Mixed Reality Toolkit ✔️ ✔️ ❌ ❌

World Locking Tools ✔️ ❌ ❌ ❌

https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


C LO UD SERVIC ESC LO UD SERVIC ES UN IT YUN IT Y UN REA LUN REA L JAVA SC RIP TJAVA SC RIP T
C USTO M  EN GIN E C USTO M  EN GIN E 
( USIN G O P EN XR)( USIN G O P EN XR)

Azure Spatial
Anchors

✔️ ✔️ ❌ ✔️

Azure Object
Anchors

✔️ ❌ ❌ ✔️

Azure Remote
Rendering

✔️ * ❌ ❌ ✔️ *

NOTENOTE

 Next steps
 

 

  Next Development CheckpointNext Development Checkpoint

Azure Remote Rendering is currently supported in apps using the legacy WinRT APIs (Windows XR plugin in Unity).

ARR support for OpenXR apps is coming soon.

Unity

Unreal

JavaScript

Native (OpenXR)

If you're following the Unity for HoloLens development checkpoint journey we've laid out, your next task is to

work through our HoloLens 2 tutorial series.

HoloLens 2 tutorial series

Otherwise, continue on to install the right version of Unity and get set up with your first mixed reality Unity

project:

Choose the right Unity version for you

You can always go back to the Unity development checkpoints for HoloLens and VR at any time.

https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/


   

 

 

 Mixed Reality services

  Azure Remote RenderingAzure Remote Rendering

Unlock what every human is an expert at—the three-dimensional, physical world around us—with Azure mixed reality services.

Help people create, learn, and collaborate more effectively by capturing and surfacing digital information within the context of

their work and world. Bring 3D to mobile devices, headsets, and other untethered devices. Using Azure, help ensure that your most

sensitive information is protected.

Mixed Reality cloud services like Azure Remote RenderingAzure Remote Rendering and Azure Spatial AnchorsAzure Spatial Anchors  help developers build compelling

immersive experiences on a variety of platforms. These services allow you to integrate spatial awareness into your projects when

you're making applications for 3D training, predictive equipment maintenance, and design review, all in the context of your users’

environments.

Azure Remote Rendering, or ARR, is a service that lets you render highly complex 3D models in real time and stream them to a

device. ARR is now generally available and can be added to your Unity or Native C++ projects targeting HoloLens 2 or Windows

desktop PC.

https://docs.microsoft.com/en-us/azure/remote-rendering/


https://docs.microsoft.com/en-us/shows/Mixed-Reality/Intro-to-Azure-Mixed-Reality-Services-Azure-Remote-Rendering/player

ARR is an essential component of any Mixed Reality application that runs on an untethered device, as they have less computational

rendering power. Take the following side-by-side engine model comparison as an example: the high-fidelity model on the left has

over 18 million triangles, while the reduced model on the right has only around 200,000. In scenarios where every detail matters

—industrial plant management, design review for assets like truck engines, pre-operative surgery planning, and more—3D

visualization brings that detail to life. It's what helps designers, engineers, doctors, and students better understand complex

information and make the right call. But this simplification can result in a loss of important detail that's needed in key business and

design decisions.

ARR solves this problem by moving the rendering workload to high-end GPUs in the cloud. A cloud-hosted graphics engine then

takes over and renders the image, encodes it as a video stream, and streams the model directly to the target device.

For complex models that are too much for one high-end GPU to handle, ARR distributes the workload to multiple GPUs and

merges the result into a single image, making the process entirely transparent to the user.

As an added bonus, ARR doesn't restrict what kind of user interface you can use in your app. At the end of a frame, your locally

rendered content is automatically combined with the remote image as seen in the image below:

https://docs.microsoft.com/en-us/shows/Mixed-Reality/Intro-to-Azure-Mixed-Reality-Services-Azure-Remote-Rendering/player


  Azure Spatial AnchorsAzure Spatial Anchors
Azure Spatial Anchors, or ASA, is a cross-platform service that allows you to build spatially aware mixed reality applications. With

Azure Spatial Anchors, you can map, persist, and share holographic content across multiple devices at real-world scale. AOA is now

in public preview for you to try out in your apps.

Azure Spatial Anchors is a uniquely tailored solution for common use cases in Mixed Reality, including:

Way-findingWay-finding: Where two or more spatial anchors could be connected to create a task list or points of interest a user must

interact with.

Multi-user experiencesMulti-user experiences : Where users could pass moves back and forth by interacting with objects in the same virtual space.

Persisting vir tual content in the real-worldPersisting vir tual content in the real-world: Where users could place virtual objects in the real-world that are viewable

from other supported devices.

https://docs.microsoft.com/en-us/azure/spatial-anchors/


  Azure Object AnchorsAzure Object Anchors

The service can be developed in a host of environments and deployed to a large group of devices and platforms. This gives them

special dispensation for their own list of available platforms:

Unity for HoloLens

Unity for iOS

Unity for Android

Native iOS

Native Android

C++/WinRT and DirectX for HoloLens

Xamarin for iOS

Xamarin for Android

Azure Object Anchors, or AOA, is a mixed reality service that helps you create rich, immersive experiences by automatically

aligning 3D content with physical objects. Gain contextual understanding of objects without the need for markers or manual

alignment. Save significant touch labor, reduce alignment errors, and improve user experiences by building mixed reality

applications with Object Anchors.

Azure Object Anchors are especially tailored to common Mixed Reality use cases, including:

TrainingTraining: Create Mixed Reality training experiences for your workers, without the need to place markers or spend time

manually adjusting hologram alignment.

Task GuidanceTask Guidance: Walking employees through a set of tasks can be greatly simplified when using Mixed Reality.

Asset FindingAsset Finding: If you already have a 3D model of some object in your physical space, Azure Object Anchors can enable you to

locate and track instances of that object in your physical environment.

https://docs.microsoft.com/en-us/azure/object-anchors/


 Cognitive Services

  SpeechSpeech
Discover how Speech enables the integration of speech processing capabilities into any app or service. Convert spoken language

into text or produce natural sounding speech from text using standard (or customizable) voice fonts. Try any service free—and

quickly build speech-enabled apps and services with the following capabilities.

https://docs.microsoft.com/en-us/azure/cognitive-services/speech-service/
https://docs.microsoft.com/en-us/azure/cognitive-services/speech-service/


  VisionVision

 Standalone Unity services

  Device supportDevice support

Azure Cloud Ser viceAzure Cloud Ser vice HoloLens 1st GenHoloLens 1st Gen Immersive headsetsImmersive headsets

Language translation ✔️ ✔️

Computer vision ✔️ ✔️

Custom vision ✔️ ✔️

Cross-device notifications ✔️ ✔️

Face recognition ✔️ ✔️

Functions and storage ✔️ ✔️

Streaming video ❌ ✔️

Machine learning ✔️ ✔️

Functions and storage ✔️ ✔️

Application insights ✔️ ✔️

Object detection ✔️ ✔️

Microsoft Graph ✔️ ✔️

Bot integration ✔️ ✔️

Recognize, identify, caption, index, and moderate your pictures, videos, and digital ink content.Learn how Vision makes it possible

for apps and services to accurately identify and analyze content within images, videos, and digital ink.

The standalone services listed below don't apply to Mixed Reality, but can be helpful in a wide range of development contexts. If

you're developing in Unity, each of these services can be integrated into your new or existing projects.

https://docs.microsoft.com/en-us/azure/cognitive-services/computer-vision/
https://docs.microsoft.com/en-us/azure/cognitive-services/computer-vision/
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


 

See also
Azure Spatial Anchor tutorials for HoloLens 2 - 1 of 3 Getting started with Azure Spatial Anchors

Azure Speech Services tutorials for HoloLens 2 - 1 of 4 Integrating and using speech recognition and transcription

https://docs.microsoft.com/en-us/learn/modules/azure-spatial-anchors-tutorials/2-get-started-with-azure-spatial-anchors
https://docs.microsoft.com/en-us/learn/modules/azure-speech-services-tutorials-mrtk/
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 Sample application case studies
 

 

  HoloLens 2 open-source sample appsHoloLens 2 open-source sample apps

Every development journey starts with a look back at what other developers have successfully built - mixed

reality is no different. Currently, all of our tutorials and sample apps are built in Unity or Unreal. As we develop

content for other engines and platforms, you'll find them under the relevant heading in the Table of Contents.

Sample application case studies

Feature samples

Unity

Unreal

The open-source sample apps were created by our teams to help you get a handle on Mixed Reality

development first-hand. We've provided the projects and full source code as a learning reference.

These sample apps are made with the Mixed Reality Toolkit for Unity.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/features-and-samples.md


Periodic Table of the Elements 2.0Periodic Table of the Elements 2.0

MRTK Examples HubMRTK Examples Hub

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/example-scenes/example-hub
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/example-scenes/example-hub


  HoloLens (first gen) open-source sample appsHoloLens (first gen) open-source sample apps

 Feature samples

SurfacesSurfaces

Galaxy Explorer 2 .0Galaxy Explorer 2 .0

Periodic Table of the Elements 1.0

Galaxy Explorer 1.0

Lunar Module

For each of the developer scenarios listed below, there are feature samples that correspond to specific

implementations that are covered in our documentation and cover a range of development platforms and

hardware devices.



SC EN A RIOSC EN A RIO F EAT URE SA M P L EF EAT URE SA M P L E EN GIN EEN GIN E DESC RIP T IO NDESC RIP T IO N

Build basic Unity mixedBuild basic Unity mixed
reality scenariosreality scenarios

OpenXR with Unity samples Unity C# Get started with cross-
platform developer tools
using the latest Unity
2020.LTS and OpenXR
plugin.

Anchoring StrategiesAnchoring Strategies Local anchor Persist and share spatial
anchors across application
sessions and across devices.
See the Spatial anchors
article.

Azure Spatial Anchors
samples

Build spatially aware mixed
reality applications with the
essential capabilities of
Azure Spatial Anchors.

QR Codes Unity C# Detect QR Codes in the
environment.

Collaboration in mixedCollaboration in mixed
realityreality

User identity Unity C# Set up your HoloLens 2
device using Azure Active
Directory (AAD) credentials.

Azure Spatial Anchors
samples

Build spatially aware mixed
reality applications with the
essential capabilities of
Azure Spatial Anchors.

Spatial interactionSpatial interaction Basic hologram sample Windows 10 C++ Render a spinning cube in
Windows Mixed Reality.

Scene/ObjectScene/Object
understandingunderstanding

Scene understanding
samples

Unity C# Help design
environmentally-aware
mixed reality applications.

Azure Object Anchors
samples

Unity C# Detect an object in the
physical world using a 3D
model and estimate its
6DoF pose with Azure
Object Anchors.

Contextual dataContextual data
overlaysoverlays

QR Codes Unity C# Detect QR Codes in the
environment.

Poster tracker sample Unity C# Align a hologram with a real
world object.

Build mixed reality digital
twins

Unity C# Learn how to create a
mixed reality application
using Azure Digital Twins
and Unity, a real-time 3D
platform.

https://github.com/microsoft/OpenXR-Unity-MixedReality-Samples#sample-for-anchors-and-anchor-persistence
https://github.com/Azure/azure-spatial-anchors-samples
https://docs.microsoft.com/en-us/azure/spatial-anchors/overview
https://github.com/Azure/azure-spatial-anchors-samples
https://docs.microsoft.com/en-us/azure/spatial-anchors/overview
https://github.com/Azure/azure-object-anchors
https://docs.microsoft.com/en-us/azure/object-anchors/overview


Capturing camera dataCapturing camera data Mixed reality capture
sample

Windows 10 C++ Capture the first-person
experience of mixing real
and digital worlds as a
photo or video.

Research Mode samples Windows 10 C++ Access to key sensors on a
HoloLens device for
research applications.

Holographic RemotingHolographic Remoting Holographic Remoting
player

Windows 10 C++ Stream holographic content
from a PC to your Microsoft
HoloLens in real time by
using a Wi-Fi connection.

Azure Remote Rendering
samples

Unity C# Test the Azure Remote
Rendering service by using
the resources for sample
data listed here.

Task management andTask management and
guidanceguidance

Dynamics 365 Remote
Assist

Collaborate more efficiently
by working together from
different locations with
Dynamics 365 Remote
Assist on HoloLens,
HoloLens 2, Android, or iOS
devices.

Dynamics 365 Guides Help operators learn during
the flow of work by
providing holographic
instructions when and
where they're needed.

World LockingWorld Locking
hologramsholograms

World locked physics
sample

Unity C# Explore a few virtual physics
experiences that are
enabled by World Locking
Tools' world-locked
coordinate system.

Space pin sample Unity C# Move closer to the inner
workings of a real-world
application that needs to
align a large object or
objects with real-world
features. The Space Pin
sample offers a simplified
and more focused view of
the Space Pin feature.

Ray pins example Unity C# Demonstrate how to set up
Space Pins by manually
manipulating marker
objects into position using
MRTK affordances.

SC EN A RIOSC EN A RIO F EAT URE SA M P L EF EAT URE SA M P L E EN GIN EEN GIN E DESC RIP T IO NDESC RIP T IO N

https://docs.microsoft.com/en-us/azure/remote-rendering/samples/sample-model
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/remote-assist/ra-overview
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/guides/
https://docs.microsoft.com/en-us/mixed-reality/world-locking-tools/documentation/howtos/samples/worldlockedphysicssample
https://docs.microsoft.com/en-us/mixed-reality/world-locking-tools/documentation/howtos/samples/spacepin
https://docs.microsoft.com/en-us/mixed-reality/world-locking-tools/documentation/howtos/samples/raypins


World Locking Tools with
Azure Spatial Anchors
sample

Unity C# Provide a stable coordinate
system that can be
persisted across sessions
and shared across devices
in your application. This is
made possible when
combining World Locking
Tools for Unity (WLT) with
Azure Spatial Anchors
(ASA).

Managing Power and
Thermals

Managing Power &
Thermals

Unity C#, Win32 C++ When the HoloLens 2 is
running in warm
environments or with heavy
performance requirements
(CPU/GPU usage, peripheral
usage, etc.),
PowerThermalNotification
SDK can be used to
subscribe to notification
events, allowing the device
to operate longer. See the
PowerThermalNotification
API reference.

SC EN A RIOSC EN A RIO F EAT URE SA M P L EF EAT URE SA M P L E EN GIN EEN GIN E DESC RIP T IO NDESC RIP T IO N

  Build basic OpenXR scenariosBuild basic OpenXR scenarios

SA M P L ESA M P L E REF EREN C E A RT IC L EREF EREN C E A RT IC L E P L AT F O RMP L AT F O RM DESC RIP T IO NDESC RIP T IO N

If you're new to building basic mixed reality scenarios, these samples will help you to getting started.

For developers targeting Unity 2020 to build HoloLens 2 or mixed reality applications, the OpenXR Plugin can

be used instead of the Windows XR Plugin for better cross-platform compatibilities. The Mixed Reality OpenXR

Plugin also works well with the latest version of the Mixed Reality Toolkit (2.7.x).

https://docs.microsoft.com/en-us/mixed-reality/world-locking-tools/documentation/howtos/samples/wlt_asa_sample
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification


Mixed Reality OpenXR with
Unity samples

Using the OpenXR plugin Unity C# These sample projects
showcase how to build
Unity applications for
HoloLens 2 or Mixed Reality
headsets using the Mixed
Reality OpenXR plugin. 

The following sample
scenarios are covered: 

OpenXR MRTK Base Unity
project

See sample readme Unity C# This repo contains a Unity
project that is set up with
the Microsoft Mixed Reality
Toolkit Foundations and
Standard Assets packages
and the Microsoft OpenXR
Plugin package.

Using Unity 2020.3 and
MRTK 2.7.2

What is MRTK Unity C# MRTK-Unity is a Microsoft-
driven project that provides
a set of components and
features that are used to
accelerate cross-platform
MR app development in
Unity.

OpenXR Explorer See sample readme C++, Windows, Linux,
OpenXR

OpenXR Explorer is a handy
debug tool for OpenXR
developers. It allows for
easy switching between
OpenXR runtimes, shows
lists of the runtime's
supported extensions, and
allows for inspection of
common properties and
enumerations, with direct
links to relevant parts of
the OpenXR specification!

SA M P L ESA M P L E REF EREN C E A RT IC L EREF EREN C E A RT IC L E P L AT F O RMP L AT F O RM DESC RIP T IO NDESC RIP T IO N

Using hand tracking
joints and mesh
inputs in Unity

Using anchor and
anchor persistence

Using
ARPlaneManager on
HoloLens2

Using
ARRaycastManager
on HoloLens2

Using eye tracking
on HoloLens2

Using locatable
camera in unity

https://github.com/microsoft/OpenXR-Unity-MixedReality-Samples
https://github.com/microsoft/OpenXR-Unity-MixedReality-Samples#sample-for-hand-tracking
https://github.com/microsoft/OpenXR-Unity-MixedReality-Samples#sample-for-anchors-and-anchor-persistence
https://github.com/microsoft/OpenXR-Unity-MixedReality-Samples#sample-for-arfoundation-compatibility
https://github.com/microsoft/OpenXR-Unity-MixedReality-Samples#sample-for-arfoundation-compatibility
https://github.com/microsoft/OpenXR-Unity-MixedReality-Samples#sample-for-eye-tracking
https://github.com/microsoft/OpenXR-Unity-MixedReality-Samples#sample-for-locatable-camera
https://github.com/microsoft/UnityOpenXRMRTKBase
https://github.com/jessemcculloch/UnityOpenXRMRTKBase#unityopenxrmrtkbase
https://github.com/microsoft/MixedRealityToolkit-Unity#example-scenes
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/
https://github.com/maluoi/openxr-explorer#msdynttrid=udu2MjGd1z293SGMmgAul0BalrUKvy4iwBnBrc3lEn4
https://github.com/maluoi/openxr-explorer#openxr-explorer


OpenXR Samples for Mixed
Reality Developers

What is OpenXR C++ These OpenXR samples use
C++17 and Direct3D 11.
The same source code
works across UWP
applications running on
HoloLens 2 and Win32
applications running on
Windows Desktop with
Windows Mixed Reality
immersive headsets.

SA M P L ESA M P L E REF EREN C E A RT IC L EREF EREN C E A RT IC L E P L AT F O RMP L AT F O RM DESC RIP T IO NDESC RIP T IO N

  Collaboration in mixed realityCollaboration in mixed reality

  User identityUser identity

SA M P L ESA M P L E REF EREN C E A RT IC L EREF EREN C E A RT IC L E

AAD Login on HoloLens 2 Overview of Microsoft identity platform

  Spatial interaction - basic hologram sampleSpatial interaction - basic hologram sample

SA M P L ESA M P L E REF EREN C E A RT IC L EREF EREN C E A RT IC L E

Windows Universal samples - basic hologram See sample readme

  Scene understandingScene understanding
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Mixed Reality Scene
Understanding samples (SU
SDK)

Scene understanding Unity C# and SU SDK A Unity-based sample
application that showcases
Scene Understanding on
HoloLens 2.

Scene Understanding
sample (MRTK + SU SDK)

Scene understanding
observer (MRTK)

Unity C#, MRTK + SU SDK MRTK + Scene
Understanding SDK sample.

  Contextual data overlaysContextual data overlays

  

In mixed reality, people come together virtually to share experiences and collaborate. Samples listed here

demonstrate some features that make such collaboration possible.

This sample sets up your HoloLens 2 device using Azure Active Directory (AAD) credentials, and then configures

the device to use iris login.

This sample runs on Windows Mixed Reality and renders a spinning cube. You can interact with the cube by

placing it in a new position, and various input methods are allowed. This sample works on PCs with headset

devices attached, and also on Microsoft HoloLens.

Scene understanding provides Mixed Reality developers with a structured, high-level environment

representation. Scene understanding is designed for developing intuitive and environmentally aware

applications, by combining the power of existing mixed reality runtimes. These runtimes are the highly accurate

but less structured spatial mapping and new AI driven runtimes.

Contextual data is the background information that provides a broader understanding of an event, person, or

item. With Augmented Reality (AR), this information can be displayed and precisely aligned with physical objects

to provide insights, instructions, service records, and other important data.

https://github.com/microsoft/OpenXR-MixedReality
https://github.com/peted70/aad-hololens
https://docs.microsoft.com/en-us/azure/active-directory/develop/v2-overview
https://github.com/microsoft/Windows-universal-samples/tree/main/Samples/BasicHologram
https://github.com/microsoft/Windows-universal-samples/tree/main/Samples/BasicHologram#basic-hologram-sample
https://github.com/microsoft/MixedReality-SceneUnderstanding-Samples
https://github.com/microsoft/MixedRealityToolkit-Unity/blob/main/Assets/MRTK/Examples/Experimental/SceneUnderstanding/Scenes/SceneUnderstandingExample.unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/spatial-awareness/scene-understanding


QR codesQR codes

SA M P L ESA M P L E REF EREN C E A RT IC L EREF EREN C E A RT IC L E

QR code tracking in Unity QR codes

  Poster tracker samplePoster tracker sample

SA M P L ESA M P L E REF EREN C E A RT IC L EREF EREN C E A RT IC L E

Poster calibration sample See sample readme

  Build mixed reality digital twinsBuild mixed reality digital twins

SA M P L ESA M P L E REF EREN C E A RT IC L EREF EREN C E A RT IC L E

Building mixed reality digital twins with Azure Digital Twins
and Unity

Full learning path

  Camera capturesCamera captures

  Holographic Mixed Reality CaptureHolographic Mixed Reality Capture

SA M P L ESA M P L E REF EREN C E A RT IC L EREF EREN C E A RT IC L E

Mixed Reality Capture samples Mixed Reality Capture

  Research ModeResearch Mode

SA M P L E A P P L IC AT IO NSA M P L E A P P L IC AT IO N REF EREN C E A RT IC L EREF EREN C E A RT IC L E

HoloLens (first gen) Research Mode

HoloLens 2 Research Mode

  Holographic RemotingHolographic Remoting

HoloLens 2 can detect QR codes in the environment around the headset, establishing a coordinate system at

each code's real-world location.

It is often helpful to be able to align a hologram to a real-world object, or align multiple HoloLens devices to a

common set of world coordinates, so that everyone sees the same holograms in the same location. For instance,

in your Unity scene, you can add a "poster" where you want to anchor your scene (perhaps a game board), and

then add holograms on or around it. Then you can print the poster, lay it on a table, and run the

calibration/alignment tool, which will move the holographic version of the poster so that it aligns with the

physical version of the poster. This moves all of the linked holograms to the correct alignment.

In this sample, you'll learn how to create a mixed reality HoloLens 2 application using Azure Digital Twins and

Unity, a real-time 3D platform.

Unstructured environment sensor data that your Mixed Reality device captures are converted into powerful

abstract or holographic representations of the physical world around us.

Mixed reality capture (MRC) captures the first-person experience of the combined real and digital worlds as a

photo or video and shares what you see with others in real time.

Research Mode was introduced in the first-generation HoloLens to give access to key sensors on the device,

specifically for research applications that are not intended for deployment. The sample applications below are

examples for accessing and recording Research Mode streams and using the intrinsic and extrinsic.

The Holographic Remoting Player is a companion app that connects to PC apps and games that support

https://github.com/microsoft/MixedReality-QRCode-Sample
https://github.com/microsoft/MixedRealityCompanionKit/tree/master/PosterCalibrationSample
https://github.com/microsoft/MixedRealityCompanionKit/tree/master/PosterCalibrationSample#postercalibrationsample
https://github.com/MicrosoftDocs/mslearn-mr-adt-in-unity
https://docs.microsoft.com/en-us/learn/paths/build-mixed-reality-azure-digital-twins-unity/
https://docs.microsoft.com/en-us/samples/microsoft/windows-universal-samples/holographicmixedrealitycapture/
https://docs.microsoft.com/en-us/windows/mixed-reality/locatable-camera#locating-the-device-camera-in-the-world
https://github.com/microsoft/HoloLensForCV/tree/master/Samples
https://github.com/microsoft/HoloLens2ForCV/tree/main/Samples
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Holographic Remoting samples Holographic Remoting Overview

Holographic Remoting. Holographic Remoting streams holographic content from a PC to your Microsoft

HoloLens in real time using a Wi-Fi connection, and is supported on HoloLens (first gen) and HoloLens 2.

https://github.com/microsoft/MixedReality-HolographicRemoting-Samples


   

 

Porting overview
 7/6/2022 • 2 minutes to read • Edit Online

 Recommended project targets

  UnityUnity

  UnrealUnreal

 Porting scenarios
  HoloLens (1st Gen) Unity apps to HoloLens 2HoloLens (1st Gen) Unity apps to HoloLens 2

  Immersive VR headsetsImmersive VR headsets

  2D Universal Windows applications2D Universal Windows applications

If you need to port or upgrade your existing projects for Mixed Reality, the process is determined by whether

your app is built with Unity or Unreal Engine and also whether it targets HoloLens (1st Gen) or HoloLens 2, or

SteamVR. This overview page contains our current recommendations for each platform and device--be sure to

check back as these processes are always changing.

First, set up your project target based on either our Unity or Unreal recommendations, and then follow one or

more of our porting scenarios:

HoloLens (1st Gen) to HoloLens 2

Immersive VR headsets

2D UWP apps

It's important to keep your projects up-to-date. Refer to the engine-based resources listed below for our current

recommendations.

For up-to-date guidance on the recommended Unity and MRTK version, see Choosing a Unity version.

We recommend OpenXR as the path forward in Mixed Reality development, so be sure to visit our OpenXR

overview and our guide for migrating a Unity 2019 project to Unity 2020 + OpenXR

For up-to-date guidance on the recommended Unreal and MRTK versions, see Setting up your Unreal project.

If you have an existing HoloLens (1st Gen) Unity application that you'd like to port over to a HoloLens 2, follow

the instructions in our HoloLens porting article.

If you've built content for other VR devices, you'll need to retarget any vendor-specific VR SDKs and (potentially)

input-mapping APIs. You can find information for both Unity and Unreal porting scenarios in our immersive

apps porting guide.

For SteamVR experiences that you want to update for Windows Mixed Reality headsets, refer to our SteamVR

updating guide.

If you have an existing 2D UWP app that you'd like to port to either a Windows Mixed Reality immersive headset

or HoloLens, follow our porting 2D UWP apps for Windows Mixed Reality instructions.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/porting-apps/porting-overview.md


   

 

Migrate a Unity 2019 project to Unity 2020 +
OpenXR
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 1. Update MRTK to the latest stable version

  Select the features you wantSelect the features you want

NOTENOTE

For the smoothest migration, we recommend that you complete all the steps in this article in the order

presented. Here's an overview of the major steps:

1. Update MRTK to the latest stable version.

2. Move your project to Unity 2019 XR Plug-in Management.

3. Choose "Windows Mixed Reality."

4. Upgrade to Unity 2020.3 LTS.

5. Use the Mixed Reality Feature Tool to install more packages.

6. Configure XR Plugin Management for OpenXR.

If you’re already using MRTK, we suggest that the first step in your migration should be to run the Mixed Reality

Feature Tool and update to the latest stable version of MRTK.

The descriptions and images in this section are based on the most recent version of the Tool. If the instructions don't

match what you're seeing, check to ensure that you're not using an older version of the Tool.

1. Open the Microsoft Mixed Reality Feature Tool and then click the Star tStar t button.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/porting-apps/migrate-a-unity-2019-project-to-openxr.md


2. Select the Browse button (it's the "three-dot" button in the image below), then navigate to your project,

and then open it.

3. Select Discover Features.Discover Features.

NoteNote: You may need to wait a few seconds while the Tool refreshes the packages from the feeds.

4. On the Discover FeaturesDiscover Features  page, note that there is a list of six package groups.



  Import the featuresImport the features

 2. Move your project to Unity 2019 XR Plug-in Management

5. Click the "+" button to the left of Mixed Reality ToolkitMixed Reality Toolkit and then select the latest version of MixedMixed

Reality Toolkit FoundationReality Toolkit Foundation.

1. After you've made your selection(s), click Get FeaturesGet Features .

2. On the Impor t FeaturesImpor t Features  page, the left-side column, FeaturesFeatures , displays the packages you just selected. The

right-side column, Required dependenciesRequired dependencies , displays any dependencies. You can click the DetailsDetails  link for

any of these items to learn more about them.

3. When you're ready to move on, select Impor t.Impor t. On the Review and ApproveReview and Approve page, you can review

information about the packages.

4. Select Approve.Approve. The Feature Tool displays a message that says your project has been updated.

5. Return to the Unity Editor and click a blank area in the UI. You'll see a message telling you that your packages

are being imported.

By doing this upgrade while still using Unity 2019, you can view the MRTK Project Configurator and see any

"deprecated API" warnings about how to get current. The warnings will tell you what to change. If you don't do

this MRTK upgrade first, the old API might be gone and you won’t have those warnings.

Learn more about the Mixed Reality Feature Tool.

After you've updated MRTK, you can instruct Unity 2019 to use XR Plug-in Management.

1. In the Unity editor on the menu bar, select EditEdit > Project SettingsProject Settings .

2. In the left side column of the Project SettingsProject Settings  window, select XR Plugin ManagementXR Plugin Management.

As this point, you might see a button labeled Install XR Plugin ManagementInstall XR Plugin Management button. If so, continue on with

the steps below. If you already have the XR management system installed, you can skip the rest of the steps in

this section and continue on to the next section, "Choose 'Windows Mixed Reality'."



 3. Choose "Windows Mixed Reality"

1. Click the Install XR Plugin ManagementInstall XR Plugin Management button.

2. A dialog named Built in VR DetectedBuilt in VR Detected appears and asks if you want to remove the built-in VR package.

Click OkOk.

3. The Built in VR EnabledBuilt in VR Enabled dialog box appears. Click OkOk. This disables built-in VR.

4. The MRTK Project ConfiguratorMRTK Project Configurator  window appears and requests that you enable an XR pipeline. Select

the second option, XR SDK/SR ManagementXR SDK/SR Management.

5. On the next page in the Configurator, click Show SettingsShow Settings .

We're not quite ready to install OpenXR yet, but this next set of steps helps you to get clean on any APIs that

were only available and supported on the “Built-in XR” path. (If you’re using MRTK, most of this is abstracted for

you.)

1. In the Unity Editor Project SettingsProject Settings  window, ensure that you're on the XR Plug-in ManagementXR Plug-in Management page.

2. Do one of the following:

3. The MRTK Project ConfiguratorMRTK Project Configurator  window appears again. Click the NextNext button, and then click NextNext again.

(You may want to take a moment to read the explanations on these pages before moving on.)

4. Select Impor t TMP EssentialsImpor t TMP Essentials .

5. Select DoneDone. This closes the Configurator.

6. Close the Project SettingsProject Settings  window, save your project, and then exit Unity.

If you're targeting the HoloLens 2:If you're targeting the HoloLens 2:

Ensure that you're in the Universal Windows Platform tab (it's the second tab and displays the

Windows logo) and then, under Plug-in-ProvidersPlug-in-Providers , select Windows Mixed Reality.Windows Mixed Reality.

If you're targeting Desktop VR:If you're targeting Desktop VR:

Ensure that you're in the Desktop tab (it's the first tab and displays an image of a monitor), and then,

under Plug-in-ProvidersPlug-in-Providers , select Windows Mixed Reality.Windows Mixed Reality.



NOTENOTE

 4. Upgrade to Unity 2020.3 LTS

 5. Use the Mixed Reality Feature Tool to install more packages

 6. Configure XR Plugin Management for OpenXR

When you use XR Plug-in Management in Unity 2019, Azure Spatial Anchors (ASA) isn't supported. If your project has

ASA code, you won’t be able to test it until after you've installed Unity 2020. Otherwise, you should be able to validate

your app at this stage.

1. Install the latest LTS patch release of Unity 2020.3.

2. Open your Unity 2019 project in Unity 2020.3.

You’ll see a dialog asking if you want to upgrade your project to a newer version of Unity. Click CONFIRMCONFIRM.

If you were previously using AR Foundation 2.0, the project will move you forward automatically to AR

Foundation 4.0.

Use the Mixed Reality Feature Tool to import the packages below.

1. If you’re using ASA, open the Azure Mixed Reality Ser vicesAzure Mixed Reality Ser vices  drop-down and select the latest version of

Azure Spatial Anchors SDK CoreAzure Spatial Anchors SDK Core and Azure Spatial Anchors SDK for WindowsAzure Spatial Anchors SDK for Windows .

2. Open the Platform Suppor tPlatform Suppor t drop-down and select the latest version of Mixed Reality OpenXR Plugin.Mixed Reality OpenXR Plugin.

3. After the packages load, a WarningWarning dialog appears asking if you want to restart the Unity editor in order to

enable backends. Select Yes.Yes.

4. When Unity reopens, the MRTK Project ConfiguratorMRTK Project Configurator  appears. Take a moment to read the explanations in

the window, and then select ApplyApply .

5. A dialog appears stating that Unity must be restarted for the input system to take effect. Select ApplyApply .

After Unity reopens again, you can set OpenXR as the runtime:

1. On the menu bar, select EditEdit > Project SettingsProject Settings .

Look in the left-side column and ensure that you're on the XR Plug-in ManagementXR Plug-in Management page and in the

Universal Windows Platform tab (there's an image of the Windows logo on the tab).

2. In the Plug-in ProvidersPlug-in Providers  list, select OpenXROpenXR .



3. In the same section, select Microsoft HoloLens feature group.Microsoft HoloLens feature group.

4. Note that there's now a yellow warning triangle next to OpenXROpenXR . Hover your cursor over the triangle,

then read the message in the popup, and then select the triangle.

5. In the OpenXR Project ValidationOpenXR Project Validation window, there are several issues listed. Select the Fix AllFix All  button.

6. One issue remains and tells you that you must add at least one interaction profile. To do so, click Edit.Edit.



This takes you to the settings for the OpenXROpenXR  plugin in the Project SettingsProject Settings  window.

7. Select the plus sign (+) button three times, each time choosing a different profile:

Eye Gaze Interaction ProfileEye Gaze Interaction Profile

Microsoft Hand Interaction ProfileMicrosoft Hand Interaction Profile

Microsoft Motion Controller  ProfileMicrosoft Motion Controller  Profile

If the Eye Gaze Interaction ProfileEye Gaze Interaction Profile, or any other profile, appears with a yellow triangle next to it, select

the triangle, and then in the OpenXR Project ValidationOpenXR Project Validation window, click the FixFix button.



 See also

8. In the OpenXR Feature GroupsOpenXR Feature Groups  section, select Microsoft HoloLensMicrosoft HoloLens , and then select Hand TrackingHand Tracking

and Motion Controller  ModelMotion Controller  Model  if they're not already selected.

9. Click the Depth Submission ModeDepth Submission Mode drop down and then select Depth 16 BitDepth 16 Bit.

10. Close the Project SettingsProject Settings  window and any other windows that are still open.

Your project is now fully migrated.

OpenXR overview

Getting started with OpenXR

More information on OpenXR

OpenXR 1.0 specification

OpenXR 1.0 API reference

OpenXR 1.0 quick reference guide

https://www.khronos.org/openxr/
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html
https://www.khronos.org/registry/OpenXR/specs/1.0/man/html/openxr.html
https://www.khronos.org/files/openxr-10-reference-guide.pdf
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ST EP  1ST EP  1 ST EP  2ST EP  2 ST EP  3ST EP  3 ST EP  4ST EP  4

Download latest tools Update Unity Project Compile for ARM Migrate to MRTK v2

 Prerequisites

NOTENOTE

 Migrate your project to the latest version of Unity

 Update scene/project settings in Unity

This guide is tailored to help developers with an existing Unity application for HoloLens (1st gen) port their

application to the HoloLens 2 device. There are four key steps to porting a HoloLens (1st gen) Unity application

to HoloLens 2.

The sections below detail information for each stage:

We highly recommend that you use source control to save a snapshot your application's original state before

starting the porting process. We also recommend that you save checkpoint states at various times during the

process. You may find it helpful to have another instance of the original application open in Unity so you can

compare side-by-side during the porting process.

Before porting, ensure that you have the latest tools installed for Windows Mixed Reality development. For most existing

HoloLens developers, this involves updating to the latest version of Visual Studio 2019 and installing the appropriate

Windows SDK. The content that follows dives further into different Unity versions and the Mixed Reality Toolkit (MRTK)

Version 2.

For more information, see Install the tools.

If you're using MRTK v2, we recommend that you update to MRTK 2.7 before you upgrade your project to Unity

2020.3 LTS. MRTK 2.7 supports Unity 2018, 2019 and 2020, allowing you to ensure your project is ready for

Unity 2020 even before you upgrade Unity. Assess any plugin dependencies that currently exist in your project

and determine whether these DLLs can be built for ARM64. For projects with a hard ARM dependent plugin, you

may need to continue building your app for ARM.

After updating to Unity 2020.3 LTS, we recommend that you update particular settings in Unity for optimal

results on the device. These settings are outlined in detail under recommended settings for Unity.

To reiterate, the .NET scripting back-end is being deprecated in Unity 2018 and removed as of Unity 2019. You

should strongly consider switching your project to IL2CPP.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/porting-apps/porting-hl1-hl2.md
https://github.com/microsoft/MixedRealityToolkit-Unity
https://docs.unity3d.com/Manual/Plugins.html
https://unity3d.com/unity/qa/lts-releases
https://docs.unity3d.com/Manual/windowsstore-dotnet.html
https://docs.unity3d.com/Manual/IL2CPP.html


NOTENOTE

 Compile dependencies/plugins for ARM processor

IMPORTANTIMPORTANT

 Update to MRTK version 2

  Prepare for the migrationPrepare for the migration

The IL2CPP scripting backend can cause longer build times from Unity to Visual Studio. Developers should set up their

developer machine for optimizing IL2CPP build times. You might also benefit from setting up a cache server, especially for

Unity projects with a large amount of assets (excluding script files) or constantly changing scenes and assets. When

opening a project, Unity stores qualifying assets into an internal cache format on the developer machine. Items must be

re-imported and re-processed when modified. This process can be done once, saved in a cache server, and then shared

with other developers to save time, as opposed to every developer processing the re-import of new changes locally.

After addressing any breaking changes that result from moving to the updated Unity version, build and test

your current applications on HoloLens (1st gen). This is a good time to create and save a commit into source

control.

HoloLens (1st gen) executes applications on an x86 processor ; the HoloLens 2 uses an ARM processor. Existing

HoloLens applications need to be ported over to support ARM. As noted earlier, Unity 2018 LTS supports

compiling ARM32 apps while Unity 2019 and later supports compiling ARM32 and ARM64 apps. Developing

for ARM64 applications is preferred because there's a material difference in performance. However, this requires

all plugin dependencies to also be built for ARM64.

Review all DLL dependencies in your application. We recommend removing dependencies that are no longer

needed for your project. For remaining plugins that are required, ingest the respective ARM32 or ARM64

binaries into your Unity project.

After ingesting the relevant DLLs, build a Visual Studio solution from Unity and compile an AppX for ARM in

Visual Studio to to verify that your application can be built for ARM processors. We recommend that you save

the application as a commit in your source control solution.

Applications using MRTK v1 can be run on HoloLens 2 after changing the build target to ARM, assuming that all other

requirements are met. This includes making sure you have ARM versions of all your plugins. However, your app won't

have access to HoloLens 2-specific functions like articulated hand and eye tracking. MRTK v1 and MRTK v2 have different

namespaces that allow both versions to be in the same project, which is useful for transitioning from one to the other.

MRTK Version 2 is the new toolkit on top of Unity that supports both HoloLens (1st gen) and HoloLens 2. It's

also where all the new HoloLens 2 capabilities have been added, such as hand interactions and eye tracking.

Check out the following resources for more information on using MRTK version 2:

MRTK - Documentation home

Installation guide

MRTK - Hand tracking

MRTK - Eye tracking

Before ingesting the new *.unitypackage files for MRTK v2, we recommend that you take an inventory of (1) any

custom-built code that integrates with MRTK v1, and (2) any custom-built code for input interactions or UX

components. The most common and prevalent conflict for a mixed reality developer ingesting MRTK v2 involves

input and interactions. We recommend that you review MRTK v2 input model.

https://docs.unity3d.com/Manual/IL2CPP-OptimizingBuildTimes.html
https://docs.unity3d.com/Manual/CacheServer.html
https://docs.unity3d.com/Manual/Plugins.html
https://github.com/microsoft/MixedRealityToolkit-Unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/install-the-tools
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/hand-tracking
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/eye-tracking/eye-tracking-main
https://github.com/Microsoft/MixedRealityToolkit-Unity/releases
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/overview


  Migrating the projectMigrating the project

  Best practicesBest practices

  Testing your applicationTesting your application

 Updating your interaction model for HoloLens 2
C a u t i o nC a u t i o n

Finally, the new MRTK v2 has transitioned from a model of scripts and in-scene manager objects to a

configuration and services provider architecture. This results in a cleaner scene hierarchy and architecture

model, but requires a learning curve for understanding the new configuration profiles. Read the Mixed Reality

Toolkit Configuration Guide to start becoming familiar with the important settings and profiles that you must

adjust to the needs of your application.

After importing MRTK v2, your Unity project most likely has many compiler-related errors. These are common

because of the new namespace structure and component names. Continue to resolve these errors by modifying

your scripts to the new namespaces and components.

For information on the specific API differences between HTK/MRTK and MRTK v2, see the porting guide on the

MRTK Version 2 wiki.

Give priorty to the MRTK standard shader.

Work on one breaking change type at a time (example: IFocusable to IMixedRealityFocusHandler).

Test after every change and use source control.

Use default MRTK UX (buttons, slates, and so on), when possible.

Refrain from modifying MRTK files directly; create wrappers around MRTK components.

Review and explore sample scenes provided in the MRTK, especially HandInteractionExamples.scene.

Rebuild canvas-based UI with quads, colliders, and TextMeshPro text.

Enable Depth Buffer Sharing or set focus point; for better performance, use a 16-bit depth buffer. Ensure that

when you render color, you also render depth. Unity generally doesn't write depth for transparent and text

gameobjects.

Select S ingle Pass Instanced RenderingSingle Pass Instanced Rendering.

Use the HoloLens 2 configuration profile for MRTK

This action eases future MRTK ingestion and updates.

In MRTK Version 2, you can simulate hand interactions directly in Unity and develop with the new APIs for hand

interactions and eye tracking. The HoloLens 2 device is required to create a satisfying user experience. We

recommend that you study the documentation and tools for greater understanding. MRTK v2 supports

development on HoloLens (1st gen) and traditional input models such as "select via air-tap" can be tested on

HoloLens (1st gen).

If your project is using any of the XR.WSA APIs, note that these are being phased out in favor of Unity's new XR

input APIs in future Unity releases. You can find more information about the XR input APIs here.

Once your application is ported and prepped for HoloLens 2, you're ready to consider updating your interaction

model and hologram design placements. In HoloLens (1st gen), your application likely has a gaze and commit

interaction model with holograms relatively far away to fit into the field of view.

To update your application design to be best suited for HoloLens 2:To update your application design to be best suited for HoloLens 2:

1. MRTK components: Per the pre-work, if you added MRTK v2, there are various components/scripts to

leverage that have been designed and optimized for HoloLens 2.

2. Interaction model: Consider updating your interaction model. For most scenarios, we recommend that you

switch from gaze and commit to hands. Some of your holograms may be out of arm's reach, and switching

to hands results in far interaction pointing rays and grab gestures.

3. Hologram placement: After switching to a hands interaction model, consider moving some holograms closer

https://github.com/microsoft/MixedRealityToolkit-Unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/configuration/mixed-reality-configuration-guide
https://github.com/microsoft/MixedRealityToolkit-Unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/updates-deployment/htk-to-mrtk-porting-guide
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/rendering/mrtk-standard-shader
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.toolkit.input.imixedrealityfocushandler
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/profiles/profiles#hololens-2-profile
https://github.com/microsoft/MixedRealityToolkit-Unity
https://docs.unity3d.com/Manual/xr_input.html
https://github.com/microsoft/MixedRealityToolkit-Unity


 Additional tips about moving applications from x86 to ARM

 See also

so users can directly interact with them by using near-interaction grab gestures with their hands. The types of

holograms to move closer to directly grab or interact with are:

small target menus

controls

buttons

smaller holograms that, when grabbed and inspected, fit within the HoloLens 2 field of view.

Applications and scenarios vary; we’ll continue to refine and post design guidance based on feedback and

continued learnings.

Straightforward Unity applications are simple because you can build an ARM application bundle or

deploy directly to the device for the bundle to run. Some Unity native plugins can present certain

development challenges. Because of this, you must upgrade all Unity native plugins to Visual Studio 2019

and then rebuild for ARM.

One application used the Unity AudioKinetic Wwise plugin. The Unity version in use didn't have a UWP

ARM plugin, and there was a considerable effort to rework sound capabilities into the application in

question to run on ARM. Ensure that all required plugins for your development plans are installed and

available in Unity.

In some cases, a UWP/ARM plugin might not exist for application-required plugins, which blocks the

ability to port the application and run it on HoloLens 2. Contact your plugin provider to resolve the issue

and provide support for ARM.

The minfloat (and variants such as min16float, minint, and so on) in shaders might behave differently on

HoloLens 2 than on HoloLens (1st gen). Specifically, these guarantee that at least the specified number of

bits will be used. On Intel/Nvidia GPUs, minfloats are largely treated as 32 bits. On ARM, the number of

bits specified is actually adhered to. In practice, these numbers might have less precision or range on

HoloLens 2 than they did on HoloLens (1st gen).

The _asm instructions don’t appear to work on ARM, meaning any code using _asm instructions must be

rewritten.

ARM doesn't support the SIMD instruction set because various headers, such as xmmintrin.h,

emmintrin.h, tmmintrin.h, and immintrin.h, aren't available on ARM.

The shader compiler on ARM runs during the first draw call after the shader has been loaded or

something the shader relies on has changed, not at shader load time. The impact on framerate can be

noticeable, depending on how many shaders need to be compiled, with implications for how shaders

should be handled, packaged, and updated differently on HoloLens 2 vs HoloLens (1st gen).

Install the tools

MRTK - Installation guide

MRTK - Documentation home

Porting from HoloToolkit/MRTK to MRTK version 2

Recommended settings for Unity

Understanding performance for Mixed Reality

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/install-the-tools
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/updates-deployment/htk-to-mrtk-porting-guide


   

 

Port VR apps to Windows Mixed Reality
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 Common porting steps

 Unity porting steps

  1. Upgrade to the latest public build of Unity with Windows MR support1. Upgrade to the latest public build of Unity with Windows MR support

Windows 10 includes support for immersive and holographic headsets. Other devices like the Oculus Rift or

HTC Vive have dependencies on libraries that exist above the operating system's platform API. To bring existing

Win32 Unity VR apps over to Windows Mixed Reality, you need to retarget vendor-specific VR SDK usage to

Unity's cross-vendor VR APIs and plugins.

Porting VR apps to Windows Mixed Reality requires the following high-level processes:

1. Make sure your PC is running the Windows 10, version 1709 (the Fall Creator 's Update) or newerWindows 10, version 1709 (the Fall Creator 's Update) or newer , or

Windows 11Windows 11 .

2. Upgrade to the latest version of your graphics or game engine. Game engines must support the WindowsWindows

10 SDK version 10.0.15063.010 SDK version 10.0.15063.0  or higher.

3. Upgrade middleware, plug-ins, and components. If your app contains any components, upgrade to the latest

versions.

4. Target the latest Unity version and OpenXR plugin. Remove dependencies on duplicate SDKs. Depending on

which device your content targeted, remove or conditionally compile out that SDK.

5. Work through build issues specific to your app, your engine, and your component dependencies.

Start with the following common porting steps:

NOTENOTE

1. Make sure you have the right development hardware. The VR enthusiast guide lists the recommended

development hardware.

2. Upgrade to the latest flight of Windows 10.

a. Install the Windows 10 Creators Update

b. Join the Windows Insider Program.

c. Enable Developer Mode

d. Switch to the Windows Insider Fast flights through Settings > Update & Security SectionSettings > Update & Security Section.

The Windows Mixed Reality platform is still under active development. Join the Windows Insider Program to access

the Windows Insider Fast flight. Don't get preview builds from the Insider Skip Ahead ring, because those builds

aren't the most stable for mixed reality development.

3. If you're using Visual Studio, upgrade to the most recent build. See Install the tools under Visual Studio

2022. Be sure to install the Game Development with UnityGame Development with Unity  workload.

Review the common steps to make sure your development environment is set up correctly. To port your existing

Unity content, follow these steps:

1. Save a copy of your project before you get started.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/porting-apps/porting-guides.md
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/windows-mixed-reality-minimum-pc-hardware-compatibility-guidelines
https://www.microsoft.com/software-download/windows10
https://insider.windows.com
https://docs.microsoft.com/en-us/windows/uwp/get-started/enable-your-device-for-development
https://docs.microsoft.com/en-us/archive/blogs/uktechnet/joining-insider-preview


  2. Upgrade your middleware to the latest versions2. Upgrade your middleware to the latest versions

  3. Target your application to run on Win323. Target your application to run on Win32

NOTENOTE

  4. Add support for the Mixed Reality OpenXR Plugin4. Add support for the Mixed Reality OpenXR Plugin

  5. Set up your Windows Mixed Reality hardware5. Set up your Windows Mixed Reality hardware

  6. Use the stage to place content on the floor6. Use the stage to place content on the floor

XRDevice.SetTrackingSpaceType(TrackingSpaceType.Stationary);

2. Download the latest recommended public build of Unity with Windows Mixed Reality support.

3. If your project was built on an older version of Unity, review the Unity Upgrade Guides.

4. Follow the instructions for using Unity's automatic API updater.

5. See if you need to make any other changes to get your project running, and work through any errors and

warnings.

With any Unity update, you might need to update one or more middleware packages that your game or

application depends on. Updating to the latest middleware increases the likelihood of success throughout the

rest of the porting process.

From inside your Unity application:

1. Navigate to FileFile > Build SettingsBuild Settings .

2. Select PC, Mac, L inux StandalonePC, Mac, L inux Standalone.

3. Set target platform to WindowsWindows .

4. Set architecture to x86x86 .

5. Select Switch PlatformSwitch Platform .

If your application has any dependencies on device-specific services, such as match making from Steam, disable them now.

You can hook up the Windows equivalent services later.

1. Choose and install a Unity version and XR plugin. While the Unity 2020.3 LTS with the Mixed Reality

OpenXR plugin is best for Mixed Reality development, you can also build apps with other Unity

configurations.

2. Remove or conditionally compile out any library support specific to another VR SDK. Those assets might

change settings and properties on your project in ways that are incompatible with Windows Mixed

Reality.

For example, if your project references the SteamVR SDK, update your project to instead use Unity's

common VR APIs, which support both Windows Mixed Reality and SteamVR.

3. In your Unity project, target the Windows 10 SDK.

4. For each scene, set up the camera.

1. Review steps in Immersive headset setup.

2. Learn how to Use the Windows Mixed Reality simulator and Navigate the Windows Mixed Reality home.

You can build Mixed Reality experiences across a wide range of experience scales. If you're porting a seated-scale

experience, make sure Unity is set to the Stationar yStationar y  tracking space type:

This code sets Unity's world coordinate system to track the stationary frame of reference. In the Stationary

tracking mode, content you place in the editor just in front of the camera's default location (forward is -Z)

https://docs.unity3d.com/Manual/UpgradeGuides.html
https://docs.unity3d.com/Manual/APIUpdater.html
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/before-you-start


if (XRDevice.SetTrackingSpaceType(TrackingSpaceType.RoomScale))
{
    // RoomScale mode was set successfully.  App can now assume that y=0 in Unity world coordinate 
represents the floor.
}
else
{
    // RoomScale mode was not set successfully.  App can't make assumptions about where the floor plane is.
}

  7. Work through your input model7. Work through your input model

appears in front of the user when the app launches. To recenter the user's seated origin, you can call Unity's

XR.InputTracking.Recenter method.

If you're porting a standing-scale experience or room-scale experience, you're placing content relative to the

floor. You reason about the user's floor using the spatial stage, which represents the user's defined floor-level

origin. The spatial stage can include an optional room boundary you set up during the first run.

For these experiences, make sure Unity is set to the RoomScaleRoomScale tracking space type. RoomScale is the default,

but set it explicitly and ensure you get back true . This practice catches situations where the user has moved

their computer away from the room they calibrated.

Once your app successfully sets the RoomScale tracking space type, content placed on the y=0 plane appears on

the floor. The origin at (0, 0, 0) is the specific place on the floor where the user stood during room setup, with -Z

representing the forward direction they faced during setup.

In script code, you can then call the TryGetGeometry  method on the UnityEngine.Experimental.XR.Boundary  type

to get a boundary polygon, specifying a boundary type of TrackedArea . If the user defined a boundary, you get

back a list of vertices. You can then deliver a room-scale experience to the user, where they can walk around the

scene you create.

The system automatically renders the boundary when the user approaches it. Your app doesn't need to use this

polygon to render the boundary itself.

Example of results:

For more information, see Coordinate systems in Unity.

Each game or application that targets an existing head-mounted display (HMD) has a set of inputs that it

handles, types of inputs that it needs for the experience, and specific APIs that it calls to get those inputs. It's

simple and straightforward to take advantage of the inputs available in Windows Mixed Reality.

See the input porting guide for Unity for details about how Windows Mixed Reality exposes input, and how the

input maps to what your application does now.

https://docs.unity3d.com/ScriptReference/XR.InputTracking.Recenter.html
https://docs.microsoft.com/en-us/windows/mixed-reality/develop/unity/coordinate-systems-in-unity


IMPORTANTIMPORTANT

  8. Test and tune performance8. Test and tune performance

 Input mapping

IMPORTANTIMPORTANT

 See also

If you use HP Reverb G2 controllers, see HP Reverb G2 Controllers in Unity for further input mapping instructions.

Windows Mixed Reality is available on many devices, ranging from high end gaming PCs to broad market

mainstream PCs. These devices have significantly different compute and graphics budgets available for your

application.

If you ported your app using a premium PC with significant compute and graphics budgets, be sure to test and

profile your app on hardware that represents your target market. For more information, see Windows Mixed

Reality minimum PC hardware compatibility guidelines.

Both Unity and Visual Studio include performance profilers, and both Microsoft and Intel publish guidelines on

performance profiling and optimization.

For an extensive discussion of performance, see Understand performance for Mixed Reality. For specific details

about Unity, see Performance recommendations for Unity.

For input mapping information and instructions, see Input porting guide for Unity.

If you use HP Reverb G2 controllers, see HP Reverb G2 Controllers in Unity for further input mapping instructions.

Unity OpenXR Plugin

Windows Mixed Reality minimum PC hardware compatibility guidelines

Understand performance for Mixed Reality

Performance recommendations for Unity

Motion controllers

Motion controllers in Unity

UnityEngine.XR.InputTracking

https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/windows-mixed-reality-minimum-pc-hardware-compatibility-guidelines
https://docs.unity3d.com/Manual/Profiler.html
https://docs.microsoft.com/en-us/visualstudio/profiling/index
https://software.intel.com/articles/vr-content-developer-guide
https://docs.unity3d.com/Packages/com.unity.xr.openxr@0.1/manual/index.html
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/windows-mixed-reality-minimum-pc-hardware-compatibility-guidelines
https://docs.unity3d.com/ScriptReference/XR.InputTracking.html


   

 

Updating SteamVR apps for Windows Mixed Reality
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 Initial setup instructions

 Controller Models

 Controls

NOTENOTE

 Tooltips and UI

 Haptics

We encourage developers to test and optimize their SteamVR experiences to run on Windows Mixed Reality

headsets. This documentation covers common improvements you can make to get your experiences running

great on Windows Mixed Reality.

To start testing out your game or app on Windows Mixed Reality make sure to first follow our getting started

guide.

1. If your app renders controller models:

2. Experiences that have a notion of handedness should get hints from the input APIs to differentiate controllers

(Unity example)

Use the Windows Mixed Reality motion controller models

Use IVRRenderModel::GetComponentState to get local transforms to component parts (for example,

Pointer pose)

When designing or adjusting your control layout, keep in mind the following set of reserved commands:

1. Clicking down the left and r ight analog thumbstickleft and r ight analog thumbstick  is reserved for the Steam DashboardSteam Dashboard.

If you're using an HP Reverb G2 controller, clicking the right menu button is reserved for the Steam DashboardSteam Dashboard.

2. The Windows buttonWindows button will always return users to the Windows Mixed Reality home.

If possible, default to thumbstick-based teleportation to match the Windows Mixed Reality home teleportation

behavior

Many VR games take advantage of motion controller tooltips and overlays to teach users their app or games

most important commands. When tuning your application for Windows Mixed reality, we recommend reviewing

this part of your experience to make sure the tooltips map to the Windows controller models.

Additionally if there are any points in your experience where you display images of the controllers make sure to

provide updated images using the Windows Mixed Reality motion controllers.

Beginning with the Windows 10 April 2018 Update, haptics are now supported for SteamVR experiences on

Windows Mixed Reality. If your SteamVR app or game already includes support for haptics, it should now work

(with no additional work) with Windows Mixed Reality motion controllers.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/porting-apps/updating-your-steamvr-application-for-windows-mixed-reality.md
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/using-steamvr-with-windows-mixed-reality
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/release-notes-april-2018


 Launching SteamVR apps from Windows Mixed Reality Start menu

 Windows Mixed Reality logo

 Bugs and feedback

 FAQs and troubleshooting

 See also

Windows Mixed Reality motion controllers use a standard haptics motor, as opposed to the linear actuators

found in some other SteamVR motion controllers. This can lead to a slightly different-than-expected user

experience. So, we recommend testing and tuning your haptics design with Windows Mixed Reality motion

controllers. For example, sometimes short haptic pulses (5-10 ms) are less noticeable on Windows Mixed Reality

motion controllers. To produce a more noticeable pulse, experiment with sending a longer “click” (40-70 ms) to

give the motor more time to spin up before being told to power off again.

For VR experiences distributed through Steam, we've updated Windows Mixed Reality for SteamVR along with

the latest Windows releases. SteamVR titles now show up in the Windows Mixed Reality Start menu in the "All

apps" list automatically.

To display Windows Mixed Reality support for your title, go to the "Edit Store Page" link on your App Landing

Page, select the "Basic Info" tab, and scroll down to "Virtual Reality." Uncheck the "Hide Windows Mixed Reality"

and then publish to the store.

Your feedback is invaluable when it comes to improving the Windows Mixed Reality SteamVR experience.

Submit all feedback and bugs through the Windows Feedback Hub. Here are some tips on how to make your

SteamVR feedback as helpful as possible.

If you have questions or comments to share, you can also reach us on our Steam forum.

If you're running into general issues setting up or playing your experience, check out the latest troubleshooting

steps.

Install the tools

Headset and motion controller driver history

Windows Mixed Reality minimum PC hardware compatibility guidelines

https://steamcommunity.com/games/719950/announcements/detail/1687045485866139800
https://insider.windows.com
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/filing-feedback
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/using-steamvr-with-windows-mixed-reality#sharing-feedback-on-steamvr
https://steamcommunity.com/app/719950/discussions/
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/troubleshooting-windows-mixed-reality#steamvr
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/mixed-reality-software
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/windows-mixed-reality-minimum-pc-hardware-compatibility-guidelines
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 Creating a 2D UWP app for mixed reality

  Building a new 2D UWP appBuilding a new 2D UWP app

  Bringing an existing 2D Store app to UWPBringing an existing 2D Store app to UWP

STA RT IN G P O IN TSTA RT IN G P O IN T A P P X M A N IF EST  P L AT F O RM  TA RGETA P P X M A N IF EST  P L AT F O RM  TA RGET H O W  TO  M A KE T H IS UN IVERSA L?H O W  TO  M A KE T H IS UN IVERSA L?

Windows Phone (Silverlight) Silverlight App Manifest Migrate to WinRT

Windows Phone 8.1 Universal 8.1 AppX Manifest that Doesn't
Include Platform Target

Migrate your app to the Universal
Windows Platform

Windows Store 8 8 AppX Manifest that Doesn't Include
Platform Target

Migrate your app to the Universal
Windows Platform

Windows Store 8.1 Universal 8.1 AppX Manifest that Doesn't
Include Platform Target

Migrate your app to the Universal
Windows Platform

  Run your 2D app in a Windows Mixed Reality immersive headsetRun your 2D app in a Windows Mixed Reality immersive headset

 Targeting both immersive headsets and HoloLens

Windows Mixed Reality lets your users see holograms as if they're right around them in the physical and digital

world. At its core, both HoloLens and the Desktop PCs you attach immersive headset accessories to are

Windows 10 devices. You're able to run almost all Universal Windows Platform (UWP) apps in the Store as 2D

apps.

The first step to bringing a 2D app to mixed reality headsets is to get your app running as a standard 2D app on

your desktop monitor.

To build a new 2D app for mixed reality, you build a standard 2D Universal Windows Platform (UWP) app. No

other app changes are required for that app to then run as a slate in mixed reality.

To get started building a 2D UWP app, check out the Create your first app article.

If you already have a 2D Windows app in the Store, make sure it's targeting the Windows 10 Universal Windows

Platform (UWP). Here are all the potential starting points you may have with your Store app today: 

If you have a 2D Unity app today built as a Win32 app on the PC, Mac & Linux StandalonePC, Mac & Linux Standalone build target,

switch to the Universal Windows PlatformUniversal Windows Platform build target for mixed reality.

We'll talk about ways that you can restrict your app specifically to HoloLens using the Windows.Holographic

device family below.

If you've deployed your 2D app to a desktop machine and tried it out on your monitor, you're ready to try it out

on an immersive desktop headset!

Just go to the Start menu within the mixed reality headset and launch the app from there. The desktop shell and

the holographic shell both share the same set of UWP apps, and so the app should already be present once

you've deployed from Visual Studio.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/porting-apps/building-2d-apps.md
https://docs.microsoft.com/en-us/windows/uwp/get-started/your-first-app
https://docs.microsoft.com/en-us/previous-versions/windows/apps/dn642486(v=vs.105)
https://docs.microsoft.com/en-us/previous-versions/visualstudio/visual-studio-2015/misc/migrate-apps-to-the-universal-windows-platform-uwp
https://docs.microsoft.com/en-us/previous-versions/visualstudio/visual-studio-2015/misc/migrate-apps-to-the-universal-windows-platform-uwp
https://docs.microsoft.com/en-us/previous-versions/visualstudio/visual-studio-2015/misc/migrate-apps-to-the-universal-windows-platform-uwp


  Change your device family to Windows.UniversalChange your device family to Windows.Universal

  Run in the HoloLens EmulatorRun in the HoloLens Emulator

Congratulations! Your app is now using the Windows 10 Universal Windows Platform (UWP).

Your app is now capable of running on today's Windows devices like Desktop, Mobile, Xbox, Windows Mixed

Reality immersive headsets, HoloLens, and future Windows devices. However, to actually target all of those

devices, you will need to ensure your app is targeting the Windows. Universal device family.

Now let's jump into your AppX manifest to ensure your Windows 10 UWP app can run on HoloLens:

Open your app's solution file with Visual StudioVisual Studio and navigate to the app package manifest

Right-click the Package.appxmanifestPackage.appxmanifest file in your Solution and go to View CodeView Code

Ensure your Target Platform is Windows. Universal in the dependencies section

<Dependencies>
  <TargetDeviceFamily Name="Windows.Universal" MinVersion="10.0.10240.0" 
MaxVersionTested="10.0.10586.0" />
</Dependencies>

Save!

If you don't use Visual Studio for your development environment, you can open AppXManifest.xmlAppXManifest.xml  in the text

editor of your choice to ensure you're targeting the Windows.UniversalWindows.Universal  TargetDeviceFamily.

Now that your UWP app targets "Windows.Universal", let's build your app and run it in the HoloLens Emulator.

Make sure you're installed the HoloLens Emulator.

In Visual Studio, select the x86x86  build configuration for your app



  Next stepsNext steps

  Running your UWP app in the debuggerRunning your UWP app in the debugger

Select HoloLens EmulatorHoloLens Emulator  in the deployment target drop-down menu

Select Debug > Star t DebuggingDebug > Star t Debugging to deploy your app and start debugging.

The emulator will start and run your app.

With a keyboard, mouse, and an Xbox controller, place your app in the world to launch it.

At this point, one of two things can happen:

1. Your app will show its splash and start running after it's placed in the Emulator! Awesome!

2. Or after you see a loading animation for a 2D hologram, loading will stop and you'll just see your app at its

splash screen. This means that something went wrong and it will take more investigation to understand how

to bring your app to life in Mixed Reality.

You'll need to debug to get to the root of possible issues that are stopping your UWP app from starting on

HoloLens.

These steps will walk you through debugging your UWP app using the Visual Studio debugger.

If you haven't already done so, open your solution in Visual Studio. Change the target to the HoloLensHoloLens

EmulatorEmulator  and the build configuration to x86x86 .

Select Debug > Star t DebuggingDebug > Star t Debugging to deploy your app and start debugging.



 Update your UI

  2D app view resolution and scale factor2D app view resolution and scale factor

Place the app in the world with your mouse, keyboard, or Xbox controller.

Visual Studio should now break somewhere in your app code.

If your app doesn't immediately crash or break into the debugger because of an unhandled error, then

go through a test pass of the core features of your app to make sure everything is running and

functional. You may see errors like pictured below (internal exceptions that are being handled). To

ensure you don't miss internal errors that impact the experience of your app, run through your

automated tests and unit tests to make sure everything behaves as expected.

Now that your UWP app is running on immersive headsets and HoloLens as a 2D hologram, next we'll make

sure it looks beautiful. Here are some things to consider :

Windows Mixed Reality will run all 2D apps at a fixed resolution and DPI that equates to 853x480 effective

pixels. Consider if your design needs refinement at this scale and review the design guidance below to

improve your experience on HoloLens and immersive headsets.

Windows Mixed Reality doesn't support 2D live tiles. If your core functionality is showing information on a

live tile, consider moving that information back into your app or explore 3D app launchers.



  2D app view interface design best practices2D app view interface design best practices

  Understand the app modelUnderstand the app model

  App bar and back buttonApp bar and back button

Windows 10 moves all visual design from real screen pixels to effective pixelseffective pixels . That means, developers design

their UI following the Windows 10 Human Interface Guidelines for effective pixels, and Windows scaling ensures

those effective pixels are the right size for usability across devices, resolutions, DPI, and so on. See this great

read on MSDN and this BUILD presentation for more information.

Even with the unique ability to place apps in your world at a range of distances, TV-like viewing distances are

recommended to produce the best readability and interaction with gaze/gesture. Because of that, a virtual slate

in the Mixed Reality Home will display your flat UWP view at:

1280x720, 150%DPI1280x720, 150%DPI (853x480 effective pixels)

This resolution has several advantages:

This effective pixel layout will have about the same information density as a tablet or small desktop.

It matches the fixed DPI and effective pixels for UWP apps running on Xbox One, enabling seamless

experiences across devices.

This size looks good when scaled across our range of operating distances for apps in the world.

Do:Do:

Follow the Windows 10 Human Interface Guidelines (HIG) for styles, font sizes and button sizes. HoloLens

will do the work to ensure your app will have compatible app patterns, readable text sizes, and appropriate

hit target sizing.

Ensure your UI follows best practices for responsive design to look best at HoloLens's unique resolution and

DPI.

Use the "light" color theme recommendations from Windows.

Don't:Don't:

Change your UI too drastically when in mixed reality, to ensure users have a familiar experience in and out of

the headset.

The app model for mixed reality is designed to use the Mixed Reality Home, where many apps live together.

Think of this as the mixed reality equivalent of the desktop, where you run many 2D apps at once. This has

implications on app life cycle, Tiles, and other key features of your app.

https://docs.microsoft.com/en-us/windows/uwp/design/layout/screen-sizes-and-breakpoints-for-responsive-design
https://video.ch9.ms/sessions/build/2015/2-63_Build_2015_Windows_Scaling.pptx
https://dev.windows.com/design
https://docs.microsoft.com/en-us/windows/uwp/design/layout/screen-sizes-and-breakpoints-for-responsive-design


  Test your 2D app's designTest your 2D app's design

 New input possibilities

 Publish and Maintain your Universal app

 See also

2D views are decorated with an app bar above their content. The app bar has two points of app-specific

personalization:

Title:Title: displays the displayname of the Tile associated with the app instance

Back Button:Back Button: raises the BackRequested event when pressed. Back Button visibility is controlled by

SystemNavigationManager.AppViewBackButtonVisibility.

App bar UI in 2D app view

It's important to test your app to make sure the text is readable, the buttons are targetable, and the overall app

looks correct. You can test on a desktop headset, a HoloLens, an emulator, or a touch device with resolution set

to 1280x720 @150%.

HoloLens uses advanced depth sensors to see the world and see users. This enables advanced hand gestures

like bloom and air-tap. Powerful microphones also enable voice experiences.

With Desktop headsets, users can use motion controllers to point at apps and take action. They can also use a

gamepad, targeting objects with their gaze.

Windows takes care of all of this complexity for UWP apps, translating your gaze, gestures, voice, and motion

controller input to pointer events that abstract away the input mechanism. For example, a user may have done

an air-tap with their hand or pulled the Select trigger on a motion controller, but 2D applications don't need to

know where the input came from - they just see a 2D touch press, as if on a touchscreen.

Here are the high-level concepts/scenarios you should understand for input when bringing your UWP app to

HoloLens:

Gaze turns into hover events, which can unexpectedly trigger menus, flyouts or other user interface elements

to pop up just by gazing around your app.

Gaze isn't as precise as mouse input. Use appropriately sized hit targets for HoloLens, similar to touch-

friendly mobile applications. Small elements near the edges of the app are especially hard to interact with.

Users must switch input modes to go from scrolling to dragging to two finger panning. If your app was

designed for touch input, consider ensuring that no major functionality is locked behind two finger panning.

If so, consider having alternative input mechanisms like buttons that can start two finger panning. For

example, the Maps app can zoom with two finger panning but has a plus, minus, and rotate button to

simulate the same zoom interactions with single clicks.

Voice input is a critical part of the mixed reality experience. We've enabled all of the speech APIs that are in

Windows 10 powering Cortana when using a headset.

Once your app is up and running, package your app to submit it to the Microsoft Store.

https://docs.microsoft.com/en-us/uwp/api/windows.ui.core.systemnavigationmanager
https://docs.microsoft.com/en-us/uwp/api/windows.ui.core.systemnavigationmanager
https://docs.microsoft.com/en-us/windows/uwp/design/input/handle-pointer-input#pointer_events


App model

Head-gaze and commit

Motion controllers

Voice input

Submitting an app to the Microsoft Store

Using the HoloLens emulator
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 General Input.GetButton and Input.GetAxis APIs

IMPORTANTIMPORTANT

 XR input APIs

NOTENOTE

 Grip pose and pointer pose

  Grip poseGrip pose

You can port your input logic to Windows Mixed Reality by using one of two approaches:

Unity's general Input.GetButton or Input.GetAxis APIs that span across multiple platforms.

The UnityEngine.XRModule APIs, which offer richer data specifically for motion controllers and HoloLens

hands.

Unity currently uses its general Input.GetButton  and Input.GetAxis  APIs to expose input for the Oculus SDK

and the OpenVR SDK. If your apps already use these APIs for input, these APIs are the easiest path to support

motion controllers in Windows Mixed Reality. You just need to remap buttons and axes in the Input Manager.

For more information, see the Unity button/axis mapping table and the overview of the Common Unity APIs.

If you use HP Reverb G2 controllers, see HP Reverb G2 Controllers in Unity for further input mapping instructions.

Unity releases have phased out the XR.WSA APIs in favor of the XR SDK. For new projects, it's best to use the XR

input APIs from the beginning. For more information, see Unity XR Input.

If your app already builds custom input logic for each platform, you can use the Windows-specific spatial input

APIs in the UnityEngine.InputSystem.XR namespace. These APIs let you access more information, such as

position accuracy or source kind, to tell hands and controllers apart on HoloLens.

If you use HP Reverb G2 controllers, all input APIs continue to work except for InteractionSource.supportsTouchpad ,

which returns false with no touchpad data.

Windows Mixed Reality supports motion controllers in different form factors. Each controller's design differs in

its relationship between the user's hand position and the natural forward direction that apps use for pointing

when rendering the controller.

To better represent these controllers, you can investigate two kinds of poses for each interaction source, grip

pose and pointer pose. You express all pose coordinates in Unity world coordinates.

The gr ip posegrip pose represents the location of either the palm of a hand detected by a HoloLens, or the palm holding

a motion controller. On immersive headsets, use this pose to render the user's hand or an object held in the

user's hand, such as a sword or gun.

The gr ip positiongrip position is the palm centroid when holding the controller naturally, adjusted left or right to center

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/porting-apps/input-porting-guide-for-unity.md
https://docs.unity3d.com/ScriptReference/Input.GetButton.html
https://docs.unity3d.com/ScriptReference/Input.GetAxis.html
https://docs.unity3d.com/ScriptReference/UnityEngine.XRModule.html
https://docs.unity3d.com/Manual/OculusControllers.html
https://docs.unity3d.com/Manual/OpenVRControllers.html
https://docs.unity3d.com/Manual/xr_input.html
https://docs.unity3d.com/Packages/com.unity.inputsystem@1.0/api/UnityEngine.InputSystem.XR.html


  Pointer posePointer pose

 See also

the position within the grip.

The gr ip or ientation's r ight axisgr ip or ientation's r ight axis  is the ray that's normal to your palm, forward from left palm, backward

from right palm, when you completely open your hand to form a flat five-finger pose.

The gr ip or ientation's for ward axisgr ip or ientation's for ward axis  is the ray that points forward through the tube formed by your non-

thumb fingers when you close your hand partially, as if holding the controller.

The gr ip or ientation's up axisgr ip or ientation's up axis  is the up axis implied by the right and forward definitions.

Access the grip pose through Unity's XR.InputTracking.GetNodeStates APIs, like XRNodeState.TryGetPosition or

XRNodeState.TryGetRotation.

The pointer posepointer pose represents the tip of the controller pointing forward. This pose is best used to ray cast

pointing at UI when you're rendering the controller model itself.

The pointer pose is available in Unity only through the Windows MR-specific API, 

sourceState.sourcePose.TryGetPosition/Rotation , passing in InteractionSourceNode.Pointer  as the argument.

Porting guides

Porting overview

UnityEngine.XR.InputTracking

Motion controllers

Motion controllers in Unity

https://docs.unity3d.com/ScriptReference/XR.InputTracking.GetNodeStates.html
https://docs.unity3d.com/ScriptReference/XR.XRNodeState.TryGetPosition.html
https://docs.unity3d.com/ScriptReference/XR.XRNodeState.TryGetRotation.html
https://docs.unity3d.com/ScriptReference/XR.InputTracking.html
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IMPORTANTIMPORTANT

 Development checkpoints

 1. Getting started

C H EC KP O IN TC H EC KP O IN T O UTC O M EO UTC O M E

Introducing the Mixed Reality Toolkit Begin your journey by getting acquainted with the Mixed
Reality Toolkit and what it has to offer

Download the Mixed Reality Feature Tool A new developer tool for discovering, updating, and adding
Mixed Reality feature packages to your Unity projects

Setup your developer environment Download and install the latest Unity package and setup
your project for mixed reality

Complete the HoloLens 2 tutorial series Dive into beginner level MRTK tutorials for HoloLens 2
hardware

IMPORTANTIMPORTANT

Unity is one of the leading real-time development platforms on the market. Underlying runtime code is written

in C++ and all development scripting is created using C#. Whether you're looking to build games, movies and

animation cinematics, or even render architectural or engineering concepts in a virtual world, Unity has the

infrastructure to support you. When you're ready to get started, head to the development checkpoints below!

Take a look at our por ting guidespor ting guides if you have an existing Unity project that you want to bring over to HoloLens 2. We

have guides for projects that are using HTK, MRTK v1, or SteamVR.

Use the following checkpoints to bring your Unity games and applications into the world of mixed reality. If you

haven't already explored the Designing Holograms sample application, we recommend downloading and using

it to familiarize yourself with the basics of Mixed Reality UX.

The easiest way to develop in Unity is with the Mixed Reality Toolkit. MRTK will help you automatically setup a

project for Mixed Reality and provide a set of features to accelerate your development process. By the end of this

section, you'll have a basic understanding of the Mixed Reality Toolkit, a properly configured development

environment for Mixed Reality apps, and a working MRTK project in Unity that you built yourself.

If you'd like to create a new Unity project without importing Mixed Reality Toolkit, there are a small set of Unity settings

you'll need to manually change for Windows Mixed Reality. Take a look at our configuration guide for more information.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/unity-development-overview.md
https://www.microsoft.com/p/designing-holograms/9nxwnjklrzwd
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/
https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/


NOTENOTE

 2. Core building blocks

F EAT UREF EAT URE C A PA B IL IT IESC A PA B IL IT IES

Camera Fully optimize visual quality and hologram stability in your
Mixed Reality apps

World locking and spatial anchors Solve stabilization issues, camera adjustment, and integrate a
stable coordinate system solution

Shared experiences View and interact collectively with the same hologram at a
fixed point in space using spatial anchor sharing

Gaze Let users target holograms with by looking at them

Motion controllers Add spatial actions to your Mixed Reality apps

Gestures Use hand gestures as input in your Mixed Reality experiences

Hand and eye tracking Integrate articulated hand and eye tracking input into your
user experience

Spatial mapping Map your physical space with a virtual mesh overlay to mark
the boundaries of your environment

Spatial sound Enhance your apps with immersive 3D audio

Text Get sharp, high-quality text that has a manageable size and
quality rendering

Voice input Capture spoken keywords, phrases, and dictation from your
users

 3. Advanced features

Once you've setup MRTK in your project, standard Unity game objects like the camera will light up immediately for a

seated-scale experience. You can find instructions on changing the experience scale of your application on the coordinate

systems page.

All of the core building blocks for mixed reality applications are exposed in a manner consistent with other Unity

APIs. These building blocks are available as standalone features and through the Mixed Reality Toolkit. You might

not need all of them at once, but we recommend exploring early on. After diving into the core building blocks

listed below, you'll have a toolbox full of features you can integrate into a Mixed Reality project by themselves or

through MRTK.

Other key features that play a role in mixed reality applications are available through Unity APIs without any

extra packages or setup. These features can be added to Unity projects with or without MRTK installed. After

diving into the more advanced capabilities that Unity offers, you'll be able to build deeper, complex Mixed Reality

apps.

https://docs.microsoft.com/en-us/windows/mixed-reality/develop/unity/coordinate-systems-in-unity


F EAT UREF EAT URE C A PA B IL IT IESC A PA B IL IT IES

Photo video camera Capture photos and video content in your Mixed Reality
application

Focus point Provide HoloLens a hint about how to best perform
stabilization on the holograms currently being displayed

Tracking loss Handle scenarios where your device can't locate itself in the
applications world space

Keyboard input Get input from real-world and Mixed Reality keyboards in
your apps

 4. Deploying to a device or emulator

 5. Adding services

 

 

 6. Low-code alternatives
 

 

Once you've got your holographic Unity project ready for testing, your next step is to export and build a Unity

Visual Studio solution. With that VS solution in hand, you can run your application in one of three ways on a real

or simulated device. By the end of this section, you'll be able to deploy your application on whichever device or

emulator fits your development needs.

HoloLens or Windows Mixed Reality immersive headset

HoloLens emulator

Windows Mixed Reality immersive headset simulator

At this point in your development journey you might be looking to add services or for a helping hand with

commercial deployment. Integrating Azure Cloud Services can level up your projects in a major way. We've

compiled a few starting points for you to explore and expand your Mixed Reality knowledge.

Azure Remote Rendering

Azure Spatial Anchors

Azure Remote Rendering (ARR) is a service that lets you to render highly complex 3D models in real time. ARR is

currently in public preview. It can be added to your Unity or Native C++ projects targeting HoloLens 2 or

Windows desktop PC.

Overview

Quickstart: Render a model in Unity

Quickstart: Deploy to HoloLens

Quickstart: Deploy to desktop

Tutorial: Azure Remote Rendering series

Azure Remote Rending sample

We also have a comprehensive list of support documentation for additional Azure services that you can add to

your Unity projects on a self-serve basis.

Dynamics 365

Microsoft Dynamics 365 Guides is a mixed-reality application for Microsoft HoloLens that lets operators learn

during the flow of work by providing holographic instructions when and where they are needed. These

https://docs.microsoft.com/en-us/azure/remote-rendering/overview/about
https://docs.microsoft.com/en-us/azure/remote-rendering/quickstarts/render-model
https://docs.microsoft.com/en-us/azure/remote-rendering/quickstarts/deploy-to-hololens
https://docs.microsoft.com/en-us/azure/remote-rendering/quickstarts/deploy-to-desktop
https://docs.microsoft.com/en-us/azure/remote-rendering/tutorials/unity/tutorial-landing
https://docs.microsoft.com/en-us/azure/remote-rendering/samples/showcase-app


 What's next?

  PortingPorting

  TutorialsTutorials

 

 

  Additional resourcesAdditional resources

TO P ICTO P IC DESC RIP T IO NDESC RIP T IO N

MRTK Architecture overview Get a deeper understanding of how the MRTK SDK works in
your projects

Settings and performance Profile your app, update your Unity settings, and get the
best hologram stabilization performance available

instruction cards are visually tethered to the place where the work must be done, and can include images,

videos, and 3D holographic models.

Overview

Get started

I'm an Admin

I'm an Author

I'm an Operator

Entity reference for developers

A developers job is never done, especially when learning a new tool or SDK. The following sections can take you

into areas beyond the beginner level material you've already completed, along with helpful resources if you get

stuck. Note that these topics and resources aren't in any sequential order, so feel free to jump around and

explore!

If you have existing apps that you'd like to port over, the articles listed below are your next stop:

HoloToolkit/MRTK to MRTK v2

Porting guide for immersive apps

Input porting guide

If you're looking to add specific Mixed Reality features to your applications, we have several curated tutorials

that can run you through the process from end-to-end. Our most popular HoloLens 2 and HoloLens (1st Gen)

content is listed below, but you can find the entire collection by visiting the tutorials overview.

HoloLens 2

HoloLens (1st Gen)

Getting started

Azure Spatial Anchors

Multi-user capabilities

Azure Speech Services

Spatial audio

Azure Cloud Services

PC Holographic Remoting

Before going out into the world of mixed reality on your own, we recommend taking a look at the MRTK-related

documentation listed below. These articles are great jumping off points for understanding how MRTK works in

greater detail and will give you insight into making your app more performant.

https://docs.microsoft.com/en-us/dynamics365/mixed-reality/guides/
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/guides/get-started
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/guides/setup
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/guides/authoring-overview
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/guides/operator-overview
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/guides/developer-entity-reference
https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/
https://docs.microsoft.com/en-us/learn/modules/azure-spatial-anchors-tutorials/
https://docs.microsoft.com/en-us/learn/modules/azure-speech-services-tutorials-mrtk/
https://docs.microsoft.com/en-us/learn/modules/spatial-audio-tutorials-mrtk/
https://docs.microsoft.com/en-us/learn/modules/azure-cloud-services-tutorials/1-introduction
https://docs.microsoft.com/en-us/learn/modules/pc-holographic-remoting-tutorials/
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/architecture/overview
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/performance/perf-getting-started


Getting started with MRTK + XR Transfer over to the alternative XR pipeline provided by Unity

TO P ICTO P IC DESC RIP T IO NDESC RIP T IO N

  Unity resourcesUnity resources

RESO URC ERESO URC E DESC RIP T IO NDESC RIP T IO N

Scripting reference This section of the documentation contains details of the
scripting API that Unity provides and is accessible online
from the Unity Editor by clicking Help > ScriptingHelp > Scripting
ReferenceReference

Manual This manual is designed to help you learn how to use Unity,
from basic to advanced techniques, and is accessible online
or from the Unity Editor by clicking Help > ManualHelp > Manual

 Have feedback?

In addition to this documentation available on docs.microsoft.com, Unity installs documentation for Windows

Mixed Reality functionality alongside the Unity Editor. The Unity provided documentation includes two separate

sections.

You can find us on the Unity Forums by tagging MicrosoftMicrosoft and a combination of the following tags to help us

understand what plugin you're providing feedback for :

HoloLens 2

Windows Mixed Reality

OpenXR

XRSDK

Legacy XR

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/configuration/getting-started-with-mrtk-and-xrsdk
https://docs.unity3d.com/ScriptReference/
https://docs.unity3d.com/Manual/index.html
https://aka.ms/unityforums
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Reality
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IMPORTANTIMPORTANT

 Development checkpoints

  1. Getting started1. Getting started

C H EC KP O IN TC H EC KP O IN T O UTC O M EO UTC O M E

Install the latest tools Download and install the latest Unity package and setup
your project for mixed reality

Configuring your project for VR and Windows Mixed Reality
headsets

Learn how to build applications that render digital content
on holographic and VR display devices

IMPORTANTIMPORTANT

  2. Core building blocks2. Core building blocks

If you're brand new to Unity, we recommend that you explore the beginner level tutorials on the Unity Learn

platform before continuing. It's also a good idea to visit the Unity Mixed Reality forums to engage with the

online community building mixed reality apps. You never know what cool assets or solutions you might find out

in the wild. When you're ready to get started with MRTK head to the development checkpoints below!

Take a look at our por ting guidespor ting guides if you have an existing Unity project that you want to bring over to a Windows Mixed

Reality immersive headset.

Use the following checkpoints to bring your Unity games and applications into the world of mixed reality.

There are a small set of Unity settings you'll need to manually change for Windows Mixed Reality and VR

development. These are broken down into two categories: per-project and per-scene. By the end of this section,

you'll have the tools and project settings to start creating your own apps!

Check out our Unity project configuration guide for more information on setting up your projects.

After starting a new immersive project, you'll need some basic building blocks to develop immersive apps. All of

the core building blocks for mixed reality applications are exposed in a manner consistent with other Unity APIs.

You might not need all of them at once, but we recommend exploring early on. After diving into the core

building blocks listed below, you'll have a toolbox full of features you can integrate into a VR project.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/unity-development-wmr-overview.md
https://unity3d.com/learn/tutorials
https://forum.unity3d.com/forums/hololens.102/


F EAT UREF EAT URE C A PA B IL IT IESC A PA B IL IT IES

Camera Fully optimize visual quality and hologram stability in your
Mixed Reality apps

World locking and spatial anchors Solve stabilization issues, camera adjustment, and integrate a
stable coordinate system solution

Motion controllers Add spatial actions to your Mixed Reality apps

Gestures Use hand gestures as input in your Mixed Reality experiences

Spatial sound Enhance your apps with immersive 3D audio

Text Get sharp, high-quality text that has a manageable size and
quality rendering

Voice input Capture spoken keywords, phrases, and dictation from your
users

  3. Advanced features3. Advanced features

F EAT UREF EAT URE C A PA B IL IT IESC A PA B IL IT IES

Tracking loss Handle scenarios where your device can't locate itself in the
applications world space

Keyboard input Get input from real-world and Mixed Reality keyboards in
your apps

  4. Deploying to a device or emulator4. Deploying to a device or emulator

 What's next?

  PortingPorting

Other key features that play a role in immersive applications are available through Unity APIs without any extra

packages or setup. After diving into the more advanced capabilities that Unity offers, you'll be able to build

deeper, complex VR apps.

Once you've got your holographic Unity project ready for testing, your next step is to export and build a Unity

Visual Studio solution. With that VS solution in hand, you can run your application on real or simulated devices.

By the end of this section, you'll be able to deploy your application on a device or emulator that fits your

development needs.

Windows Mixed Reality immersive headset

Windows Mixed Reality immersive headset simulator

A developers job is never done, especially when learning a new tool or SDK. The following sections can take you

into areas beyond the beginner level material you've already completed, along with helpful resources if you get

stuck. Note that these topics and resources aren't in any sequential order, so feel free to jump around and

explore!

If you have existing apps that you'd like to port over, the articles listed below are your next stop:

Porting VR apps to Windows Mixed Reality

Updating SteamVR apps for Windows Mixed Reality



  Additional resourcesAdditional resources
Before going out into the world of mixed reality on your own, we recommend taking a look at the extra

documentation below.

VR enthusiast guide

Unity Asset Store

https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/vr-journey
https://assetstore.unity.com
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 HoloLens 2 tutorials

 HoloLens 1 tutorials

 MRTK3 Tutorial: "Zappy's Playground"

Currently, all of our tutorials, learn modules and sample apps are Unity or Unreal based. As we develop content

for other engines and platforms, you'll find them under the relevant heading in the Table of Contents.

The HoloLens 2 Fundamentals tutorials for Unity are designed to teach techniques and best practices for

developing mixed reality applications. The tutorials are based on the Mixed Reality Toolkit 2.7 (MRTK 2.7) or later.

HoloLens 2 Fundamentals tutorials

HoloLens 1 Tutorials

HoloLens 1 Azure Services Tutorials

Zappy's Playground is a cross-platform developer sample that showcases how to develop intuitive and

comprehensive end-to-end experiences for mixed reality. Using the latest features from Microsoft and Unity

such as MRTK3, OpenXR, XRI, ARFoundation and more, it provides a place to learn and a foundation for your

own app development.

MRTK3 tutorial Zappy's Playground

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials.md
https://github.com/microsoft/MixedRealityToolkit-Unity
https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/
https://github.com/microsoft/ZappysPlayground
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Zappy's Playground is a cross-platform developer sample that showcases how to develop intuitive and

comprehensive end-to-end experiences for mixed reality. Using the latest features from Microsoft and Unity

such as MRTK3, OpenXR, XRI, ARFoundation and more, it provides a place to learn and a foundation for your

own app development.

Download the tutorial

In this tutorial, you'll gain experience with the following features:

Use gaze to view text in an expanding tile.

Move towards objects and have them expand as a result.

Use data-driven UI objects such as name input.

Gaze to interact with distant content and reveal more information.

Gaze and pinch to select objects at a distance.

Use surface magnetism to orient holographic objects to real-world surfaces.

Listen to spatial audio to help you locate objects in 3D space.

Grab, rotate and scale objects using bounds control.

Use different audio or visual themes to enhance the experience.

Here's a summary of the MRTK3 features that are covered in the tutorial:

Directional Indicators

Scene Understanding

Gaze and pinch

Surface Magnetism

Near and Far Interaction

UX Controls

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/playground-tutorial.md
https://github.com/microsoft/ZappysPlayground


Bounds Controls

Data Binding

UI Follow

Spatial Audio

Theming
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 Objectives

 Prerequisites

IMPORTANTIMPORTANT

IMPORTANTIMPORTANT

Welcome to the Multi-User Capabilities tutorials! Through this tutorial series, you will learn the fundamentals of

building a multi-user experience using Photon Unity Networking (PUN). PUN is one of several networking

options available to mixed reality developers to create shared experiences.

Tutorials in this series:

Setting up Photon Unity Networking

Connecting multiple users

Sharing object movements with multiple users

Learn how to create a PUN app and connect your Unity project to it

Learn how to connect multiple users in a shared experience

Learn how to share the object movements with other users

A Windows 10 computer configured with the correct tools installed

Windows 10 SDK 10.0.18362.0 or later

A HoloLens 2 device configured for development

Unity Hub with Unity 2020 LTS installed and the Universal Windows Platform Build Support module added

Completed the Getting started tutorials series or some basic prior experience with Unity and MRTK

If you intend to deploy to Android as well as HoloLens

If you intend to deploy to iOS as well as HoloLens

A developer enabled and ARCore capable Android device with USB connection to your Windows or

macOS computer

Unity Hub with Unity 2020 LTS installed and the Android Build Support module added

A macOS computer with the latest version of Xcode and CocoaPods installed

An ARKit compatible iOS device with USB connection to your macOS computer

Unity Hub with Unity 2020 LTS installed and the iOS Build Support module added

The recommended Mixed Reality Toolkit version for this tutorial series is MRTK 2.7.

The recommended Unity version for this tutorial series is Unity 2020 LTS. This supersedes any Unity version requirements

stated in the prerequisites linked above.

Next Tutorial: 2. Setting up Photon Unity Networking

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/mr-learning-sharing-01.md
https://www.photonengine.com/PUN
https://docs.unity3d.com/Manual/GettingStartedInstallingHub.html
https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/
https://developer.android.com/studio/debug/dev-options
https://developers.google.com/ar/discover/supported-devices
https://docs.unity3d.com/Manual/GettingStartedInstallingHub.html
https://geo.itunes.apple.com/us/app/xcode/id497799835?mt=12
https://cocoapods.org
https://developer.apple.com/documentation/arkit/verifying_device_support_and_user_permission
https://docs.unity3d.com/Manual/GettingStartedInstallingHub.html
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 Objectives

 Creating and preparing the Unity project

 Enabling additional capabilities

In this tutorial, you will prepare for creating a shared experience using Photon Unity Networking (PUN). You will

learn how to create a PUN app, import PUN assets into your Unity project, and connect your Unity project to the

PUN app.

Learn how to create a PUN app

Learn how to find and import the PUN assets

Learn how to connect your Unity project to the PUN app

In this section, you will create a new Unity project and get it ready for MRTK development.

First, follow the Initializing your project and deploying your first application, excluding the Adding hand

interaction to an object and Build your application to your device instructions, which includes the following

steps:

1. Creating the Unity project and give it a suitable name, for example, MRTK Tutorials

2. Switching the build platform

3. Importing the TextMeshPro Essential Resources

4. Importing the Mixed Reality Toolkit and Configuring the Unity project

5. Creating the scene and configuring MRTK and give the scene a suitable name, for example,

MultiUserCapabilities

Then follow the Changing the Spatial Awareness Display Option instructions to:

1. Change the MRTK configuration profileMRTK configuration profile for to the DefaultHoloLens2ConfigurationProfileDefaultHoloLens2ConfigurationProfile

2. Change the spatial awareness mesh display optionsspatial awareness mesh display options  to OcclusionOcclusion.

In the Unity menu, select EditEdit > Project Settings...Project Settings... to open the Player Settings window, then locate the PlayerPlayer

> Publishing SettingsPublishing Settings  section:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/mr-learning-sharing-02.md
https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/
https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/#adding-hand-interaction-to-an-object
https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/#building-your-application-to-your-hololens-2
https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/#creating-the-unity-project
https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/#switching-the-build-platform
https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/#importing-the-textmeshpro-essential-resources
https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/#importing-the-mixed-reality-toolkit-and-configuring-the-unity-project
https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/#creating-the-scene-and-configuring-mrtk
https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/#changing-the-spatial-awareness-display-option


 Importing the tutorial assets

In the Publishing SettingsPublishing Settings , scroll down to the CapabilitiesCapabilities  section and double-check that the InternetClientInternetClient,

MicrophoneMicrophone, SpatialPerceptionSpatialPerception, and GazeInputGazeInput capabilities, which you enabled during the Configuring the

Unity project step above, are enabled.

Then enable the following additional capabilities:

InternetClientSer verInternetClientSer ver  capability

Pr ivateNetworkClientSer verPr ivateNetworkClientSer ver  capability

Download and impor timpor t the following Unity custom packages in the order they are listedin the order they are listed:

MRTK.HoloLens2.Unity.Tutorials.Assets.GettingStarted.2.7.2.unitypackage

MRTK.HoloLens2.Unity.Tutorials.Assets.MultiUserCapabilities.2.7.2.unitypackage

https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/#configuring-the-unity-project
https://github.com/microsoft/MixedRealityLearning/releases/download/getting-started-v2.7.2/MRTK.HoloLens2.Unity.Tutorials.Assets.GettingStarted.2.7.2.unitypackage
https://github.com/microsoft/MixedRealityLearning/releases/download/multi-user-capabilities-v2.7.2/MRTK.HoloLens2.Unity.Tutorials.Assets.MultiUserCapabilities.2.7.2.unitypackage


TIPTIP

NOTENOTE

 Importing the PUN assets

 For a reminder on how to import a Unity custom package, you can refer to the Importing the tutorial assets instructions.

After importing the MultiUserCapabilities tutorial assets package, you will see several CS0246 errors in the Console

window stating that the type or namespace is missing. This is expected and will be resolved in the next section when you

import the PUN assets.

In the Unity menu, select WindowWindow  > Asset StoreAsset Store to open the Asset Store window, search for and select PUN 2PUN 2

- FREE- FREE from Exit Games, click the DownloadDownload button to download the asset package to your Unity account.

When the download is complete, click the Impor tImpor t button to open the Import Unity Package window:

In the Import Unity Package window, click the AllAll  button to ensure all the assets are selected, then click the

Impor tImpor t button to import the assets:

https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/#importing-the-tutorial-assets
https://docs.microsoft.com/en-us/dotnet/csharp/language-reference/compiler-messages/cs0246


 Creating the PUN application

Once Unity has completed the import process, the Pun Wizard window will appear with the PUN Setup menu

loaded, you can ignore or close this window for now:

In this section, you will create a Photon account, if you don't already have one, and create a new PUN app.

Navigate to the Photon dashboard and sign in if you already have an account you want to use, otherwise, click

the Create OneCreate One link and follow the instructions to register a new account:

https://dashboard.photonengine.com/account/signin


Once signed in, click the Create a New AppCreate a New App button:



On the Create a New Application page, enter the following values:

For Photon Type, select PUN

For Name, enter a suitable name, for example, MRTK Tutorials

For Description, optionally enter a suitable description

For Url, leave the field empty

Then click the CreateCreate button to create the new app:



Once Photon has finished the creation process, the new PUN app will appear on your dashboard:



 Connecting the Unity project to the PUN application
In this section, you will connect your Unity project to the PUN app you created in the previous section.

On the Photon dashboard, click the App IDApp ID field to reveal the app ID, then copy it to your clipboard:



In the Unity menu, select WindowWindow  > Photon Unity NetworkingPhoton Unity Networking > PUN WizardPUN Wizard to open the Pun Wizard

window, click the Setup ProjectSetup Project button to open the PUN Setup menu, and configure it as follows:

In the AppId or EmailAppId or Email  field, paste the PUN app ID you copied in the previous step

Then click the Setup ProjectSetup Project button to apply the app ID:



 Congratulations

Once Unity has finished the PUN setup process, the PUN Setup menu will display the message Done!Done!  and

automatically select the PhotonSer verSettingsPhotonSer verSettings  asset in the Project window, so its properties are displayed in

the Inspector window:

You have successfully created a PUN app and connected it to your Unity project. Your next step is to allow

connections with other users so that multiple users can see each other.

Next Tutorial: 3. Connecting multiple users
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 Objectives

 Preparing the scene

 Configuring PUN to instantiate the user prefab

In this tutorial, you will learn how to connect multiple users as part of a live shared experience. By the end of the

tutorial, you will be able to run the app on multiple devices and have each user see the avatar of other users

move in real-time.

Learn how to connect multiple users in a shared experience

In this section, you will prepare the scene by adding some of the tutorial prefabs.

In the Project window, navigate to the AssetsAssets  > MRTK.Tutorials.MultiUserCapabilitiesMRTK.Tutorials.MultiUserCapabilities  > PrefabsPrefabs  folder,

then click-and-drag the following prefabs into the Hierarchy window to add them to your scene:

NetworkLobbyNetworkLobby  prefab

SharedPlaygroundSharedPlayground prefab

In this section, you will configure the project to use the PhotonUser prefab.

In the Project window, navigate to the AssetsAssets  > MRTK.Tutorials.MultiUserCapabilitiesMRTK.Tutorials.MultiUserCapabilities  > ResourcesResources  folder.

In the Hierarchy window, expand the NetworkLobbyNetworkLobby  object and select the NetworkRoomNetworkRoom child object, then in

the Inspector window, locate the Photon Room (Scr ipt)Photon Room (Scr ipt)  component and configure it as follows:

To the Photon User PrefabPhoton User Prefab field, assign the PhotonUserPhotonUser  prefab from the Resources folder

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/mr-learning-sharing-03.md


 Trying the experience with multiple users

TIPTIP

C a u t i o nC a u t i o n

 Congratulations

If you now build and deploy the Unity project to your HoloLens, then, back in Unity, enter Game mode while the

app is running on your HoloLens, you will see the HoloLens user avatar move when you move your head

(HoloLens) around:

For a reminder on how to build and deploy your Unity project to HoloLens 2, you can refer to the Building your app to

your HoloLens 2 instructions.

The app needs to connect to Photon, so make sure your computer/device is connected to the internet.

You have successfully configured your project to allow multiple users to connect to the same experience and see

https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/#building-your-application-to-your-hololens-2


each other's movements. In the next tutorial, you will implement functionality so that the movements of objects

are also shared across multiple devices.

Next Tutorial: 4. Sharing object movements with multiple users
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 Objectives

 Preparing the scene

In this tutorial, you will learn how to share the movements of objects so that all participants of a shared

experience can collaborate and view each other's interactions.

Configure your project to share the movements of objects

Learn how to build a basic multi-user collaborative app

In this section, you will prepare the scene by adding the tutorial prefab.

In the Hierarchy window, expand the MixedRealityPlayspaceMixedRealityPlayspace object and select the Main CameraMain Camera child object,

then in the Inspector window, use the Add ComponentAdd Component button to add the AR Camera Manager (Scr ipt)AR Camera Manager (Scr ipt)

component to the Main CameraMain Camera object:

In the Project window, navigate to the AssetsAssets  > MRTK.Tutorials.MultiUserCapabilitiesMRTK.Tutorials.MultiUserCapabilities  > PrefabsPrefabs  folder and

drag the TableAnchorTableAnchor  prefab onto the SharedPlaygroundSharedPlayground object in the Hierarchy window to add it to your

scene as a child of the SharedPlayground object:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/mr-learning-sharing-04.md


 Configuring PUN to instantiate the objects

In the Hierarchy window, ensure the MixedRealityPlayspaceMixedRealityPlayspace object is expanded and the TableAnchorTableAnchor  object

is selected. Drag the Main CameraMain Camera component into the CameraCamera field of the TableAnchorTableAnchor 's AR SessionAR Session

OriginOrigin component:

In this section, you will configure the project to use the Rover Explorer experience created during the Getting

started tutorials and define where it will be instantiated.

In the Project window, navigate to the AssetsAssets  > MRTK.Tutorials.MultiUserCapabilitiesMRTK.Tutorials.MultiUserCapabilities  > ResourcesResources  folder.

In the Hierarchy window, expand the NetworkLobbyNetworkLobby  object and select the NetworkRoomNetworkRoom child object, then in

the Inspector window, locate the Photon Room (Scr ipt)Photon Room (Scr ipt)  component and configure it as follows:

To the Rover Explorer PrefabRover Explorer Prefab field, assign the RoverExplorer_Complete_VariantRoverExplorer_Complete_Variant prefab from the

Resources folder

https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/


 Trying the experience with shared object movement

With the NetworkRoomNetworkRoom child object still selected, in the Hierarchy window, expand the TableAnchorTableAnchor  object,

then in the Inspector window, locate the Photon Room (Scr ipt)Photon Room (Scr ipt)  component and configure it as follows:

To the Rover Explorer LocationRover Explorer Location field, assign the TableAnchor > TableTable child object from the Hierarchy

window

If you now build and deploy the Unity project to your HoloLens, and then, back in Unity, press the Play button to

enter Game mode while the app is running on your HoloLens, you will see the object move in Unity when you

move the object in HoloLens:



 Congratulations
You have successfully configured your project to synchronize object movements so users can see the objects

move when other users move them. This will ensure that the users see each other in their actual physical

locations. It will also ensure that objects appear in the same physical position and rotation for all users. If you

want to learn how to physically align the now-synchronized movements, see our "Create a new HoloLens Unity

app using Azure Spatial Anchors" tutorial.

In this multi-user capabilities tutorial series you learned how to set up a Photon account, create a PUN app,

integrate PUN into the Unity project, and configure user avatars and shared objects. This tutorial concludes the

series.

https://docs.microsoft.com/en-us/azure/spatial-anchors/tutorials/tutorial-new-unity-hololens-app
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IMPORTANTIMPORTANT

 Device support

C O URSEC O URSE H O LO L EN SH O LO L EN S IM M ERSIVE  H EA DSET SIM M ERSIVE  H EA DSET S

MR Basics 100: Getting started with
Unity

✔️ ✔️

 Prerequisites

 Chapter 1 - Create a New Project

 Chapter 2 - Setup the Camera

The Mixed Reality Academy tutorials were designed with HoloLens (1st gen), Unity 2017, and Mixed Reality Immersive

Headsets in mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for

guidance in developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being

used for HoloLens 2 and may not be compatible with newer versions of Unity. They will be maintained to continue

working on the supported devices. A new series of tutorials has been posted for HoloLens 2.

This tutorial will walk you through creating a basic mixed reality app built with Unity.

A Windows 10 PC configured with the correct tools installed.

To build an app with Unity, you first need to create a project. This project is organized into a few folders, the

most important of which is your Assets folder. This is the folder that holds all assets you import from digital

content creation tools such as Maya, Max Cinema 4D or Photoshop, all code you create with Visual Studio or

your favorite code editor, and any number of content files that Unity creates as you compose scenes, animations

and other Unity asset types in the editor.

To build and deploy UWP apps, Unity can export the project as a Visual Studio solution that will contain all

necessary asset and code files.

1. Start Unity

2. Select NewNew

3. Enter a project name (e.g. "MixedRealityIntroduction")

4. Enter a location to save your project

5. Ensure the 3D3D toggle is selected

6. Select Create projectCreate project

Congrats, you are all setup to get started with your mixed reality customizations now.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/holograms-100.md
https://docs.microsoft.com/en-us/windows/mixed-reality/develop/unity/tutorials/mrlearning-base
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://www.youtube-nocookie.com/embed/2L5IFO0hnYA


 Chapter 3 - Setup the Project Settings

  Unity performance and quality settingsUnity performance and quality settings

The Unity Main Camera handles head tracking and stereoscopic rendering. There are a few changes to make to

the Main Camera to use it with mixed reality.

1. Select File > New Scene

First, it will be easier to lay out your app if you imagine the starting position of the user as (XX: 0, YY : 0, ZZ: 0). Since

the Main Camera is tracking movement of the user's head, the starting position of the user can be set by setting

the starting position of the Main Camera.

1. Select Main CameraMain Camera in the HierarchyHierarchy  panel

2. In the InspectorInspector  panel, find the TransformTransform component and change the PositionPosition from (XX: 0, YY : 1, ZZ: -10) to

(XX: 0, YY : 0, ZZ: 0)

Second, the default Camera background needs some thought.

For HoloLens applicationsFor HoloLens applications , the real world should appear behind everything the camera renders, not a Skybox

texture.

1. With the Main CameraMain Camera still selected in the HierarchyHierarchy  panel, find the CameraCamera component in the InspectorInspector

panel and change the Clear FlagsClear Flags  dropdown from SkyboxSkybox to Solid ColorSolid Color .

2. Select the BackgroundBackground color picker and change the RGBARGBA values to (0, 0, 0, 0)

For mixed reality applications targeted to immersive headsetsFor mixed reality applications targeted to immersive headsets , we can use the default Skybox texture

that Unity provides.

1. With the Main CameraMain Camera still selected in the HierarchyHierarchy  panel, find the CameraCamera component in the InspectorInspector

panel and keep the Clear FlagsClear Flags  dropdown to SkyboxSkybox.

Third, let us consider the near clip plane in Unity and prevent objects from being rendered too close to the users

eyes as a user approaches an object or an object approaches a user.

For HoloLens applicationsFor HoloLens applications , the near clip plane can be set to the HoloLens recommended 0.85 meters.

1. With the Main CameraMain Camera still selected in the HierarchyHierarchy  panel, find the CameraCamera component in the InspectorInspector

panel and change the Near Clip PlaneNear Clip Plane field from the default 0 .30.3  to the HoloLens recommended 0.850.85 .

For mixed reality applications targeted to immersive headsetsFor mixed reality applications targeted to immersive headsets , we can use the default setting that Unity

provides.

1. With the Main CameraMain Camera still selected in the HierarchyHierarchy  panel, find the CameraCamera component in the InspectorInspector

panel and keep the Near Clip PlaneNear Clip Plane field to the default 0 .30.3 .

Finally, let us save our progress so far. To save the scene changes, select File > Save Scene AsFile > Save Scene As , name the scene

MainMain, and select SaveSave.

In this chapter, we will set some Unity project settings that help us target the Windows Holographic SDK for

development. We will also set some quality settings for our application. Finally, we will ensure our build targets

are set to Universal Windows Platform.

Unity quality settings for HoloLensUnity quality settings for HoloLens

https://www.youtube-nocookie.com/embed/eP1ZwB4wSNA
https://www.youtube-nocookie.com/embed/ItRoiXccC0g


  Target Windows 10 SDKTarget Windows 10 SDK

NOTENOTE

Since maintaining high framerate on HoloLens is so important, we want the quality settings tuned for fastest

performance. For more detailed performance information, Performance recommendations for Unity.

1. Select Edit > Project Settings > QualityEdit > Project Settings > Quality

2. Select the dropdowndropdown under the Universal Windows PlatformUniversal Windows Platform logo and select Ver y LowVer y Low . You'll know the

setting is applied correctly when the box in the Universal Windows Platform column and Ver y LowVer y Low  row is

green.

For mixed reality applications targeted to occluded displaysFor mixed reality applications targeted to occluded displays , you can leave the quality settings to its

default values.

Target Windows Holographic SDKTarget Windows Holographic SDK

We need to let Unity know that the app we are trying to export should create an immersive view instead of a 2D

view. We do this by enabling Virtual Reality support on Unity targeting the Windows 10 SDK.

1. Go to Edit > Project Settings > PlayerEdit > Project Settings > Player .

2. In the Inspector PanelInspector Panel  for Player Settings, select the Universal Windows PlatformUniversal Windows Platform icon.

3. Expand the XR SettingsXR Settings  group.

4. In the RenderingRendering section, check the Vir tual Reality Suppor tedVir tual Reality Suppor ted checkbox to add a new Vir tual RealityVir tual Reality

SDKsSDKs  list.

5. Verify that Windows Mixed RealityWindows Mixed Reality  appears in the list. If not, select the ++ button at the bottom of the list

and choose Windows Mixed RealityWindows Mixed Reality .

If you do not see the Universal Windows PlatformUniversal Windows Platform icon, double check to make sure you selected Universal Windows

Platform Build Support during installation. If not, you may need to reinstall Unity with the correct Windows installation.



 Chapter 4 - Create a cube

 Chapter 5 - Verify on device from Unity editor

  Initial setupInitial setup

  For HoloLens use Unity RemotingFor HoloLens use Unity Remoting

  For other mixed reality supported headsetsFor other mixed reality supported headsets

 Chapter 6 - Build and deploy to device from Visual Studio

Awesome job on getting all the project settings applied. Next, let us add a hologram!

Creating a cube in your Unity project is just like creating any other object in Unity. Placing a cube in front of the

user is easy because Unity's coordinate system is mapped to the real world - where one meter in Unity is

approximately one meter in the real world.

1. In the top left corner of the HierarchyHierarchy  panel, select the CreateCreate dropdown and choose 3D Object > Cube3D Object > Cube.

2. Select the newly created CubeCube in the HierarchyHierarchy  panel

3. In the InspectorInspector  find the TransformTransform component and change PositionPosition to (XX: 0, YY : 0, ZZ: 2). This positions the

cube 2 meters in front of the user's starting position.

4. In the TransformTransform component, change RotationRotation to (XX: 45, YY : 45, ZZ: 45) and change ScaleScale to (XX: 0.25, YY : 0.25,

ZZ: 0.25). This scales the cube to 0.25 meters.

5. To save the scene changes, select File > Save SceneFile > Save Scene.

Now that we have created our cube, it is time to do a quick check in device. You can do this directly from within

the Unity editor.

1. On your development PC, in Unity, open File > Build SettingsFile > Build Settings  window.

2. Change PlatformPlatform to Universal Windows PlatformUniversal Windows Platform and click Switch PlatformSwitch Platform

1. On your HoloLens, install and run the Holographic Remoting Player, available from the Windows Store.

Launch the application on the device, and it will enter a waiting state and show the IP address of the device.

Note down the IP.

2. Open Window > XR > Holographic EmulationWindow > XR > Holographic Emulation.

3. Change Emulation ModeEmulation Mode from NoneNone to Remote to DeviceRemote to Device.

4. In Remote MachineRemote Machine, enter the IP address of your HoloLens noted earlier.

5. Click ConnectConnect.

6. Ensure the Connection StatusConnection Status  changes to green ConnectedConnected.

7. Now you can now click PlayPlay  in the Unity editor.

You will now be able to see the cube in device and in the editor. You can pause, inspect objects, and debug just

like you are running an app in the editor, because that's essentially what's happening, but with video, audio, and

device input transmitted back and forth across the network between the host machine and the device.

1. Connect the headset to your development PC using the USB cable and the HDMI or display port cable.

2. Launch the Mixed Reality Por talMixed Reality Por tal  and ensure you have completed the first run experience.

3. From Unity, you can now press the Play button.

You will now be able to see the cube rendering in your mixed reality headset and in the editor.

https://www.youtube-nocookie.com/embed/qKcK1Yuj-HQ
https://www.youtube-nocookie.com/embed/vmCfiIdRb6Q
https://www.youtube-nocookie.com/embed/USSu8yHUdbk


  Export to the Visual Studio solutionExport to the Visual Studio solution

  Compile the Visual Studio solutionCompile the Visual Studio solution

  Deploy to mixed reality device over Wi-FiDeploy to mixed reality device over Wi-Fi

  Deploy to mixed reality device over USBDeploy to mixed reality device over USB

  Deploy to EmulatorDeploy to Emulator

  Try out your appTry out your app

 See also

We are now ready to compile our project to Visual Studio and deploy to our target device.

1. Open File > Build SettingsFile > Build Settings  window.

2. Click Add Open ScenesAdd Open Scenes  to add the scene.

3. Change PlatformPlatform to Universal Windows PlatformUniversal Windows Platform and click Switch PlatformSwitch Platform .

4. In Universal Windows PlatformUniversal Windows Platform settings, ensure SDKSDK is Universal 10Universal 10 .

5. For Target device, leave to Any DeviceAny Device for occluded displays or switch to HoloLensHoloLens .

6. UWP Build TypeUWP Build Type should be D3DD3D.

7. UWP SDKUWP SDK could be left at Latest installedLatest installed.

8. Click BuildBuild.

9. In the file explorer, click New FolderNew Folder  and name the folder "App""App".

10. With the AppApp folder selected, click the Select FolderSelect Folder  button.

11. When Unity is done building, a Windows File Explorer window will appear.

12. Open the AppApp folder in file explorer.

13. Open the generated Visual Studio solution (MixedRealityIntroduction.sln in this example)

Finally, we will compile the exported Visual Studio solution, deploy it, and try it out on the device.

1. Using the top toolbar in Visual Studio, change the target from DebugDebug to ReleaseRelease and from ARMARM to X86X86 .

The instructions differ for deploying to a device versus the emulator. Follow the instructions that match your

setup.

1. Click on the arrow next to the Local MachineLocal Machine button, and change the deployment target to RemoteRemote

MachineMachine.

2. Enter the IP address of your mixed reality device and change Authentication ModeAuthentication Mode to Universal

(Unencrypted Protocol) for HoloLens and WindowsWindows for other devices.

3. Click Debug > Star t without debuggingDebug > Star t without debugging.

For HoloLensFor HoloLens , If this is the first time deploying to your device, you will need to pair using Visual Studio.

Ensure you device is plugged in via the USB cable.

1. For HoloLensFor HoloLens , click on the arrow next to the Local MachineLocal Machine button, and change the deployment target to

DeviceDevice.

2. For targeting occluded devices attached to your PCFor targeting occluded devices attached to your PC , keep the setting to Local Machine. Ensure you

have the Mixed Reality Por talMixed Reality Por tal  running.

3. Click Debug > Star t without debuggingDebug > Star t without debugging.

1. Click on the arrow next to the DeviceDevice button, and from drop down select HoloLens EmulatorHoloLens Emulator .

2. Click Debug > Star t without debuggingDebug > Star t without debugging.

Now that your app is deployed, try moving all around the cube and observe that it stays in the world in front of

you.
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 Chapter 1 - "Holo" world

The Mixed Reality Academy tutorials were designed with HoloLens (1st gen), Unity 2017, and Mixed Reality Immersive

Headsets in mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for

guidance in developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being

used for HoloLens 2 and may not be compatible with newer versions of Unity. They will be maintained to continue

working on the supported devices. A new series of tutorials has been posted for HoloLens 2.

This tutorial will walk you through a complete project, built in Unity, that demonstrates core Windows Mixed

Reality features on HoloLens including gaze, gestures, voice input, spatial sound and spatial mapping.

The tutorial will take approximately 1 hour to complete.

A Windows 10 PC configured with the correct tools installed.

A HoloLens device configured for development.

Download the files required by the project. Requires Unity 2017.2 or later.

Un-archive the files to your desktop or other easy to reach location. Keep the folder name as OrigamiOrigami .

If you still need Unity 5.6 support, please use this release.

If you still need Unity 5.5 support, please use this release.

If you still need Unity 5.4 support, please use this release.

If you want to look through the source code before downloading, it's available on GitHub.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/holograms-101.md
https://docs.microsoft.com/en-us/windows/mixed-reality/develop/unity/tutorials/mrlearning-base
https://www.youtube-nocookie.com/embed/XKIIEC5BMWg
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://github.com/Microsoft/HolographicAcademy/archive/Holograms-101.zip
https://github.com/Microsoft/HolographicAcademy/archive/v1.5.6-101.zip
https://github.com/Microsoft/HolographicAcademy/archive/v1.5.5-101.zip
https://github.com/Microsoft/HolographicAcademy/archive/v1.5.4-101.zip
https://github.com/Microsoft/HolographicAcademy/tree/Holograms-101


  ObjectivesObjectives

  InstructionsInstructions

  Setup the main virtual cameraSetup the main virtual camera

  Setup the sceneSetup the scene

  Export the project from Unity to Visual StudioExport the project from Unity to Visual Studio

In this chapter, we'll setup our first Unity project and step through the build and deploy process.

Set up Unity for holographic development.

Make a hologram.

See a hologram that you made.

Start Unity.

Select OpenOpen.

Enter location as the OrigamiOrigami folder you previously un-archived.

Select OrigamiOrigami and click Select FolderSelect Folder .

Since the OrigamiOrigami project does not contain a scene, save the empty default scene to a new file using: FileFile /

Save Scene AsSave Scene As .

Name the new scene OrigamiOrigami and press the SaveSave button.

In the Hierarchy PanelHierarchy Panel , select Main CameraMain Camera.

In the InspectorInspector  set its transform position to 0,0 ,00,0 ,0 .

Find the Clear FlagsClear Flags  property, and change the dropdown from SkyboxSkybox to Solid colorSolid color .

Click on the BackgroundBackground field to open a color picker.

Set R , G, B, and AR, G, B, and A to 00 .

In the Hierarchy PanelHierarchy Panel , click on CreateCreate and Create EmptyCreate Empty .

Right-click the new GameObjectGameObject and select Rename. Rename the GameObject to OrigamiCollectionOrigamiCollection.

From the HologramsHolograms folder in the Project Panel (expand Assets and select Holograms or double click the

Holograms folder in the Project Panel):

Right-click the Directional L ightDirectional L ight object in the Hierarchy PanelHierarchy Panel  and select DeleteDelete.

From the HologramsHolograms folder, drag L ightsL ights  into the root of the Hierarchy PanelHierarchy Panel .

In the HierarchyHierarchy , select the OrigamiCollectionOrigamiCollection.

In the InspectorInspector , set the transform position to 0, -0 .5 , 2 .00, -0.5 , 2 .0 .

Press the PlayPlay  button in Unity to preview your holograms.

You should see the Origami objects in the preview window.

Press PlayPlay  a second time to stop preview mode.

Drag StageStage into the Hierarchy to be a child of OrigamiCollectionOrigamiCollection.

Drag Sphere1Sphere1  into the Hierarchy to be a child of OrigamiCollectionOrigamiCollection.

Drag Sphere2Sphere2  into the Hierarchy to be a child of OrigamiCollectionOrigamiCollection.

In Unity select File > Build SettingsFile > Build Settings .

Select Universal Windows PlatformUniversal Windows Platform in the PlatformPlatform list and click Switch PlatformSwitch Platform .

Set SDKSDK to Universal 10Universal 10  and Build TypeBuild Type to D3DD3D.

Check Unity C# ProjectsUnity C# Projects .

Click Add Open ScenesAdd Open Scenes  to add the scene.

Click BuildBuild.

In the file explorer window that appears, create a New FolderNew Folder  named "App".

https://www.youtube-nocookie.com/embed/PmtZGjYFroY


 Chapter 2 - Gaze

  ObjectivesObjectives

  InstructionsInstructions

Single click the App FolderApp Folder .

Press Select FolderSelect Folder .

When Unity is done, a File Explorer window will appear.

Open the AppApp folder.

Open (double click) Origami.slnOrigami.sln .

Using the top toolbar in Visual Studio, change the target from Debug to ReleaseRelease and from ARM to X86X86 .

Click on the arrow next to the Device button, and select Remote MachineRemote Machine to deploy over Wi-Fi.

Set the AddressAddress  to the name or IP address of your HoloLens. If you do not know your device IP

address, look in Settings > Network & Internet > Advanced OptionsSettings > Network & Internet > Advanced Options  or ask Cortana "Hey"Hey

Cor tana, What's my IP address?"Cor tana, What's my IP address?"

If the HoloLens is attached over USB, you may instead select DeviceDevice to deploy over USB.

Leave the Authentication ModeAuthentication Mode set to UniversalUniversal .

Click SelectSelect

Click Debug > Star t Without debuggingDebug > Star t Without debugging or press Ctr l + F5Ctr l + F5 . If this is the first time deploying to your

device, you will need to pair it with Visual Studio.

The Origami project will now build, deploy to your HoloLens, and then run.

Put on your HoloLens and look around to see your new holograms.

In this chapter, we are going to introduce the first of three ways of interacting with your holograms -- gaze.

Visualize your gaze using a world-locked cursor.

Go back to your Unity project, and close the Build Settings window if it's still open.

Select the HologramsHolograms folder in the Project panelProject panel .

Drag the CursorCursor  object into the Hierarchy panelHierarchy panel  at the root level.

Double-click on the CursorCursor  object to take a closer look at it.

Right-click on the Scr iptsScr ipts  folder in the Project panel.

Click the CreateCreate sub-menu.

Select C# Scr iptC# Scr ipt.

Name the script WorldCursorWorldCursor . Note: The name is case-sensitive. You do not need to add the .cs extension.

Select the CursorCursor  object in the Hierarchy panelHierarchy panel .

Drag and drop the WorldCursorWorldCursor  script into the Inspector panelInspector panel .

Double-click the WorldCursorWorldCursor  script to open it in Visual Studio.

Copy and paste this code into WorldCursor.csWorldCursor.cs  and Save AllSave All .

https://www.youtube-nocookie.com/embed/MSO2BoFSQbM


using UnityEngine;

public class WorldCursor : MonoBehaviour
{
    private MeshRenderer meshRenderer;

    // Use this for initialization
    void Start()
    {
        // Grab the mesh renderer that's on the same object as this script.
        meshRenderer = this.gameObject.GetComponentInChildren<MeshRenderer>();
    }

    // Update is called once per frame
    void Update()
    {
        // Do a raycast into the world based on the user's
        // head position and orientation.
        var headPosition = Camera.main.transform.position;
        var gazeDirection = Camera.main.transform.forward;

        RaycastHit hitInfo;

        if (Physics.Raycast(headPosition, gazeDirection, out hitInfo))
        {
            // If the raycast hit a hologram...
            // Display the cursor mesh.
            meshRenderer.enabled = true;

            // Move the cursor to the point where the raycast hit.
            this.transform.position = hitInfo.point;

            // Rotate the cursor to hug the surface of the hologram.
            this.transform.rotation = Quaternion.FromToRotation(Vector3.up, hitInfo.normal);
        }
        else
        {
            // If the raycast did not hit a hologram, hide the cursor mesh.
            meshRenderer.enabled = false;
        }
    }
}

 Chapter 3 - Gestures

  ObjectivesObjectives

  InstructionsInstructions

Rebuild the app from File > Build SettingsFile > Build Settings .

Return to the Visual Studio solution previously used to deploy to your HoloLens.

Select 'Reload All' when prompted.

Click Debug -> Star t Without debuggingDebug -> Star t Without debugging or press Ctr l + F5Ctr l + F5 .

Now look around the scene and notice how the cursor interacts with the shape of objects.

In this chapter, we'll add support for gestures. When the user selects a paper sphere, we'll make the sphere fall

by turning on gravity using Unity's physics engine.

Control your holograms with the Select gesture.

We'll start by creating a script then can detect the Select gesture.

https://www.youtube-nocookie.com/embed/kW3ThJ2MbvQ


In the Scr iptsScr ipts  folder, create a script named GazeGestureManagerGazeGestureManager .

Drag the GazeGestureManagerGazeGestureManager  script onto the OrigamiCollectionOrigamiCollection object in the Hierarchy.

Open the GazeGestureManagerGazeGestureManager  script in Visual Studio and add the following code:



using UnityEngine;
using UnityEngine.XR.WSA.Input;

public class GazeGestureManager : MonoBehaviour
{
    public static GazeGestureManager Instance { get; private set; }

    // Represents the hologram that is currently being gazed at.
    public GameObject FocusedObject { get; private set; }

    GestureRecognizer recognizer;

    // Use this for initialization
    void Awake()
    {
        Instance = this;

        // Set up a GestureRecognizer to detect Select gestures.
        recognizer = new GestureRecognizer();
        recognizer.Tapped += (args) =>
        {
            // Send an OnSelect message to the focused object and its ancestors.
            if (FocusedObject != null)
            {
                FocusedObject.SendMessageUpwards("OnSelect", SendMessageOptions.DontRequireReceiver);
            }
        };
        recognizer.StartCapturingGestures();
    }

    // Update is called once per frame
    void Update()
    {
        // Figure out which hologram is focused this frame.
        GameObject oldFocusObject = FocusedObject;

        // Do a raycast into the world based on the user's
        // head position and orientation.
        var headPosition = Camera.main.transform.position;
        var gazeDirection = Camera.main.transform.forward;

        RaycastHit hitInfo;
        if (Physics.Raycast(headPosition, gazeDirection, out hitInfo))
        {
            // If the raycast hit a hologram, use that as the focused object.
            FocusedObject = hitInfo.collider.gameObject;
        }
        else
        {
            // If the raycast did not hit a hologram, clear the focused object.
            FocusedObject = null;
        }

        // If the focused object changed this frame,
        // start detecting fresh gestures again.
        if (FocusedObject != oldFocusObject)
        {
            recognizer.CancelGestures();
            recognizer.StartCapturingGestures();
        }
    }
}

Create another script in the Scripts folder, this time named SphereCommandsSphereCommands .

Expand the OrigamiCollectionOrigamiCollection object in the Hierarchy view.



using UnityEngine;

public class SphereCommands : MonoBehaviour
{
    // Called by GazeGestureManager when the user performs a Select gesture
    void OnSelect()
    {
        // If the sphere has no Rigidbody component, add one to enable physics.
        if (!this.GetComponent<Rigidbody>())
        {
            var rigidbody = this.gameObject.AddComponent<Rigidbody>();
            rigidbody.collisionDetectionMode = CollisionDetectionMode.Continuous;
        }
    }
}

 Chapter 4 - Voice
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Drag the SphereCommandsSphereCommands  script onto the Sphere1Sphere1  object in the Hierarchy panel.

Drag the SphereCommandsSphereCommands  script onto the Sphere2Sphere2  object in the Hierarchy panel.

Open the script in Visual Studio for editing, and replace the default code with this:

Export, build and deploy the app to your HoloLens.

Look at one of the spheres.

Perform the select gesture and watch the sphere drop onto the surface below.

In this chapter, we'll add support for two voice commands: "Reset world" to return the dropped spheres to their

original location, and "Drop sphere" to make the sphere fall.

Add voice commands that always listen in the background.

Create a hologram that reacts to a voice command.

In the Scr iptsScr ipts  folder, create a script named SpeechManagerSpeechManager .

Drag the SpeechManagerSpeechManager  script onto the OrigamiCollectionOrigamiCollection object in the Hierarchy

Open the SpeechManagerSpeechManager  script in Visual Studio.

Copy and paste this code into SpeechManager.csSpeechManager.cs  and Save AllSave All :

https://www.youtube-nocookie.com/embed/1-Aq0VVtHM8


using System.Collections.Generic;
using System.Linq;
using UnityEngine;
using UnityEngine.Windows.Speech;

public class SpeechManager : MonoBehaviour
{
    KeywordRecognizer keywordRecognizer = null;
    Dictionary<string, System.Action> keywords = new Dictionary<string, System.Action>();

    // Use this for initialization
    void Start()
    {
        keywords.Add("Reset world", () =>
        {
            // Call the OnReset method on every descendant object.
            this.BroadcastMessage("OnReset");
        });

        keywords.Add("Drop Sphere", () =>
        {
            var focusObject = GazeGestureManager.Instance.FocusedObject;
            if (focusObject != null)
            {
                // Call the OnDrop method on just the focused object.
                focusObject.SendMessage("OnDrop", SendMessageOptions.DontRequireReceiver);
            }
        });

        // Tell the KeywordRecognizer about our keywords.
        keywordRecognizer = new KeywordRecognizer(keywords.Keys.ToArray());

        // Register a callback for the KeywordRecognizer and start recognizing!
        keywordRecognizer.OnPhraseRecognized += KeywordRecognizer_OnPhraseRecognized;
        keywordRecognizer.Start();
    }

    private void KeywordRecognizer_OnPhraseRecognized(PhraseRecognizedEventArgs args)
    {
        System.Action keywordAction;
        if (keywords.TryGetValue(args.text, out keywordAction))
        {
            keywordAction.Invoke();
        }
    }
}

Open the SphereCommandsSphereCommands  script in Visual Studio.

Update the script to read as follows:



using UnityEngine;

public class SphereCommands : MonoBehaviour
{
    Vector3 originalPosition;

    // Use this for initialization
    void Start()
    {
        // Grab the original local position of the sphere when the app starts.
        originalPosition = this.transform.localPosition;
    }

    // Called by GazeGestureManager when the user performs a Select gesture
    void OnSelect()
    {
        // If the sphere has no Rigidbody component, add one to enable physics.
        if (!this.GetComponent<Rigidbody>())
        {
            var rigidbody = this.gameObject.AddComponent<Rigidbody>();
            rigidbody.collisionDetectionMode = CollisionDetectionMode.Continuous;
        }
    }

    // Called by SpeechManager when the user says the "Reset world" command
    void OnReset()
    {
        // If the sphere has a Rigidbody component, remove it to disable physics.
        var rigidbody = this.GetComponent<Rigidbody>();
        if (rigidbody != null)
        {
            rigidbody.isKinematic = true;
            Destroy(rigidbody);
        }

        // Put the sphere back into its original local position.
        this.transform.localPosition = originalPosition;
    }

    // Called by SpeechManager when the user says the "Drop sphere" command
    void OnDrop()
    {
        // Just do the same logic as a Select gesture.
        OnSelect();
    }
}

 Chapter 5 - Spatial sound
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Export, build and deploy the app to your HoloLens.

Look at one of the spheres, and say "Drop SphereDrop Sphere".

Say "Reset WorldReset World" to bring them back to their initial positions.

In this chapter, we'll add music to the app, and then trigger sound effects on certain actions. We'll be using

spatial sound to give sounds a specific location in 3D space.

Hear holograms in your world.

In Unity select from the top menu Edit > Project Settings > AudioEdit > Project Settings > Audio

https://www.youtube-nocookie.com/embed/Aj4de5Ncbfo


using UnityEngine;

public class SphereSounds : MonoBehaviour
{
    AudioSource impactAudioSource = null;
    AudioSource rollingAudioSource = null;

    bool rolling = false;

    void Start()
    {
        // Add an AudioSource component and set up some defaults
        impactAudioSource = gameObject.AddComponent<AudioSource>();
        impactAudioSource.playOnAwake = false;
        impactAudioSource.spatialize = true;
        impactAudioSource.spatialBlend = 1.0f;
        impactAudioSource.dopplerLevel = 0.0f;
        impactAudioSource.rolloffMode = AudioRolloffMode.Logarithmic;
        impactAudioSource.maxDistance = 20f;

        rollingAudioSource = gameObject.AddComponent<AudioSource>();
        rollingAudioSource.playOnAwake = false;
        rollingAudioSource.spatialize = true;
        rollingAudioSource.spatialBlend = 1.0f;
        rollingAudioSource.dopplerLevel = 0.0f;
        rollingAudioSource.rolloffMode = AudioRolloffMode.Logarithmic;
        rollingAudioSource.maxDistance = 20f;
        rollingAudioSource.loop = true;

        // Load the Sphere sounds from the Resources folder
        impactAudioSource.clip = Resources.Load<AudioClip>("Impact");
        rollingAudioSource.clip = Resources.Load<AudioClip>("Rolling");
    }

    // Occurs when this object starts colliding with another object
    void OnCollisionEnter(Collision collision)
    {
        // Play an impact sound if the sphere impacts strongly enough.
        if (collision.relativeVelocity.magnitude >= 0.1f)
        {
            impactAudioSource.Play();
        }
    }

In the Inspector Panel on the right side, find the Spatializer PluginSpatializer Plugin setting and select MS HRTFMS HRTF

SpatializerSpatializer .

From the HologramsHolograms folder in the Project panel, drag the AmbienceAmbience object onto the OrigamiCollectionOrigamiCollection

object in the Hierarchy Panel.

Select OrigamiCollectionOrigamiCollection and find the Audio SourceAudio Source component in the Inspector panel. Change these

properties:

In the Scr iptsScr ipts  folder, create a script named SphereSoundsSphereSounds .

Drag and drop SphereSoundsSphereSounds  to the Sphere1Sphere1  and Sphere2Sphere2  objects in the Hierarchy.

Open SphereSoundsSphereSounds  in Visual Studio, update the following code and Save AllSave All .

Check the SpatializeSpatialize property.

Check the Play On AwakePlay On Awake.

Change Spatial BlendSpatial Blend to 3D3D by dragging the slider all the way to the right. The value should change

from 0 to 1 when you move the slider.

Check the LoopLoop property.

Expand 3D Sound Settings3D Sound Settings , and enter 0 .10.1  for Doppler LevelDoppler Level .

Set Volume RolloffVolume Rolloff  to Logarithmic RolloffLogarithmic Rolloff .

Set Max DistanceMax Distance to 2020 .



    }

    // Occurs each frame that this object continues to collide with another object
    void OnCollisionStay(Collision collision)
    {
        Rigidbody rigid = gameObject.GetComponent<Rigidbody>();

        // Play a rolling sound if the sphere is rolling fast enough.
        if (!rolling && rigid.velocity.magnitude >= 0.01f)
        {
            rolling = true;
            rollingAudioSource.Play();
        }
        // Stop the rolling sound if rolling slows down.
        else if (rolling && rigid.velocity.magnitude < 0.01f)
        {
            rolling = false;
            rollingAudioSource.Stop();
        }
    }

    // Occurs when this object stops colliding with another object
    void OnCollisionExit(Collision collision)
    {
        // Stop the rolling sound if the object falls off and stops colliding.
        if (rolling)
        {
            rolling = false;
            impactAudioSource.Stop();
            rollingAudioSource.Stop();
        }
    }
}

 Chapter 6 - Spatial mapping
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Save the script, and return to Unity.

Export, build and deploy the app to your HoloLens.

Move closer and further from the Stage and turn side-to-side to hear the sounds change.

Now we are going to use spatial mapping to place the game board on a real object in the real world.

Bring your real world into the virtual world.

Place your holograms where they matter most to you.

In Unity, click on the HologramsHolograms folder in the Project panel.

Drag the Spatial MappingSpatial Mapping asset into the root of the HierarchyHierarchy .

Click on the Spatial MappingSpatial Mapping object in the Hierarchy.

In the Inspector panelInspector panel , change the following properties:

Export, build and deploy the app to your HoloLens.

When the app runs, a wireframe mesh will overlay your real world.

Watch how a rolling sphere will fall off the stage, and onto the floor!

Check the Draw Visual MeshesDraw Visual Meshes  box.

Locate Draw Mater ialDraw Mater ial  and click the circle on the right. Type "wireframewireframe" into the search field at the

top. Click on the result and then close the window. When you do this, the value for Draw Material

should get set to Wireframe.

https://www.youtube-nocookie.com/embed/Pkt1_wNLLXY


using UnityEngine;

public class TapToPlaceParent : MonoBehaviour
{
    bool placing = false;

    // Called by GazeGestureManager when the user performs a Select gesture
    void OnSelect()
    {
        // On each Select gesture, toggle whether the user is in placing mode.
        placing = !placing;

        // If the user is in placing mode, display the spatial mapping mesh.
        if (placing)
        {
            SpatialMapping.Instance.DrawVisualMeshes = true;
        }
        // If the user is not in placing mode, hide the spatial mapping mesh.
        else
        {
            SpatialMapping.Instance.DrawVisualMeshes = false;
        }
    }

    // Update is called once per frame
    void Update()
    {
        // If the user is in placing mode,
        // update the placement to match the user's gaze.

        if (placing)
        {
            // Do a raycast into the world that will only hit the Spatial Mapping mesh.
            var headPosition = Camera.main.transform.position;
            var gazeDirection = Camera.main.transform.forward;

            RaycastHit hitInfo;
            if (Physics.Raycast(headPosition, gazeDirection, out hitInfo,
                30.0f, SpatialMapping.PhysicsRaycastMask))
            {
                // Move this object's parent object to
                // where the raycast hit the Spatial Mapping mesh.
                this.transform.parent.position = hitInfo.point;

                // Rotate this object's parent object to face the user.
                Quaternion toQuat = Camera.main.transform.localRotation;
                toQuat.x = 0;
                toQuat.z = 0;
                this.transform.parent.rotation = toQuat;
            }
        }
    }
}

Now we'll show you how to move the OrigamiCollection to a new location:

In the Scr iptsScr ipts  folder, create a script named TapToPlaceParentTapToPlaceParent.

In the HierarchyHierarchy , expand the OrigamiCollectionOrigamiCollection and select the StageStage object.

Drag the TapToPlaceParentTapToPlaceParent script onto the Stage object.

Open the TapToPlaceParentTapToPlaceParent script in Visual Studio, and update it to be the following:

Export, build and deploy the app.

Now you should now be able to place the game in a specific location by gazing at it, using the Select gesture

and then moving to a new location, and using the Select gesture again.
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using UnityEngine;

public class HitTarget : MonoBehaviour
{
    // These public fields become settable properties in the Unity editor.
    public GameObject underworld;
    public GameObject objectToHide;

    // Occurs when this object starts colliding with another object
    void OnCollisionEnter(Collision collision)
    {
        // Hide the stage and show the underworld.
        objectToHide.SetActive(false);
        underworld.SetActive(true);

        // Disable Spatial Mapping to let the spheres enter the underworld.
        SpatialMapping.Instance.MappingEnabled = false;
    }
}

 The end

Reveal the entrance to a holographic underworld.

Now we'll show you how to uncover the holographic underworld:

From the HologramsHolograms folder in the Project Panel:

In the Scr iptsScr ipts  folder, create a script named HitTargetHitTarget.

In the HierarchyHierarchy , expand the OrigamiCollectionOrigamiCollection.

Expand the StageStage object and select the TargetTarget object (blue fan).

Drag the HitTargetHitTarget script onto the TargetTarget object.

Open the HitTargetHitTarget script in Visual Studio, and update it to be the following:

Drag Under worldUnder world into the Hierarchy to be a child of OrigamiCollectionOrigamiCollection.

In Unity, select the TargetTarget object.

Two public properties are now visible on the Hit TargetHit Target component and need to reference objects in our

scene:

Export, build and deploy the app.

Place the Origami Collection on the floor, and then use the Select gesture to make a sphere drop.

When the sphere hits the target (blue fan), an explosion will occur. The collection will be hidden and a hole to

the underworld will appear.

Drag Under worldUnder world from the HierarchyHierarchy  panel to the Under worldUnder world property on the Hit TargetHit Target

component.

Drag StageStage from the HierarchyHierarchy  panel to the Object to HideObject to Hide property on the Hit TargetHit Target

component.

And that's the end of this tutorial!

You learned:

How to create a holographic app in Unity.

How to make use of gaze, gesture, voice, sound, and spatial mapping.



 See also

How to build and deploy an app using Visual Studio.

You are now ready to start creating your own holographic experience!

MR Basics 101E: Complete project with emulator

Gaze

Head-gaze and commit

Voice input

Spatial sound

Spatial mapping
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MR Basics 101E: Complete project with
emulator

✔️

 Before you start
  PrerequisitesPrerequisites

  Project filesProject files

NOTENOTE

 Chapter 1 - "Holo" world

  ObjectivesObjectives

The Mixed Reality Academy tutorials were designed with HoloLens (1st gen), Unity 2017, and Mixed Reality Immersive

Headsets in mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for

guidance in developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being

used for HoloLens 2 and may not be compatible with newer versions of Unity. They will be maintained to continue

working on the supported devices. A new series of tutorials has been posted for HoloLens 2.

This tutorial will walk you through a complete project, built in Unity, that demonstrates core Windows Mixed

Reality features on HoloLens including gaze, gestures, voice input, spatial sound and spatial mapping. The

tutorial will take approximately 1 hour to complete.

A Windows 10 PC configured with the correct tools installed.

Download the files required by the project. Requires Unity 2017.2 or later.

Un-archive the files to your desktop or other easy to reach location. Keep the folder name as OrigamiOrigami .

If you still need Unity 5.6 support, please use this release.

If you still need Unity 5.5 support, please use this release.

If you still need Unity 5.4 support, please use this release.

If you want to look through the source code before downloading, it's available on GitHub.

In this chapter, we'll setup our first Unity project and step through the build and deploy process.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/holograms-101e.md
https://docs.microsoft.com/en-us/windows/mixed-reality/develop/unity/tutorials/mrlearning-base
https://www.youtube-nocookie.com/embed/Xzm8_s05mm8
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://github.com/Microsoft/HolographicAcademy/archive/Holograms-101.zip
https://github.com/Microsoft/HolographicAcademy/archive/v1.5.6-101.zip
https://github.com/Microsoft/HolographicAcademy/archive/v1.5.5-101.zip
https://github.com/Microsoft/HolographicAcademy/archive/v1.5.4-101.zip
https://github.com/Microsoft/HolographicAcademy/tree/Holograms-101
https://www.youtube-nocookie.com/embed/qotpUpIQxVU


  InstructionsInstructions

  Setup the main cameraSetup the main camera

  Setup the sceneSetup the scene

  Export the project from Unity to Visual StudioExport the project from Unity to Visual Studio

Set up Unity for holographic development.

Make a hologram.

See a hologram that you made.

Start Unity.

Select OpenOpen.

Enter location as the OrigamiOrigami folder you previously un-archived.

Select OrigamiOrigami and click Select FolderSelect Folder .

Save the new scene: FileFile / Save Scene AsSave Scene As .

Name the scene OrigamiOrigami and press the SaveSave button.

In the Hierarchy PanelHierarchy Panel , select Main CameraMain Camera.

In the InspectorInspector  set its transform position to 0,0 ,00,0 ,0 .

Find the Clear FlagsClear Flags  property, and change the dropdown from SkyboxSkybox to Solid colorSolid color .

Click on the BackgroundBackground field to open a color picker.

Set R , G, B, and AR, G, B, and A to 00 .

In the Hierarchy PanelHierarchy Panel , click on CreateCreate and Create EmptyCreate Empty .

Right-click the new GameObjectGameObject and select Rename. Rename the GameObject to OrigamiCollectionOrigamiCollection.

From the HologramsHolograms folder in the Project PanelProject Panel :

Right-click the Directional L ightDirectional L ight object in the Hierarchy PanelHierarchy Panel  and select DeleteDelete.

From the HologramsHolograms folder, drag L ightsL ights  into the root of the Hierarchy PanelHierarchy Panel .

In the HierarchyHierarchy , select the OrigamiCollectionOrigamiCollection.

In the InspectorInspector , set the transform position to 0, -0 .5 , 2 .00, -0.5 , 2 .0 .

Press the PlayPlay  button in Unity to preview your holograms.

You should see the Origami objects in the preview window.

Press PlayPlay  a second time to stop preview mode.

Drag StageStage into the Hierarchy to be a child of OrigamiCollectionOrigamiCollection.

Drag Sphere1Sphere1  into the Hierarchy to be a child of OrigamiCollectionOrigamiCollection.

Drag Sphere2Sphere2  into the Hierarchy to be a child of OrigamiCollectionOrigamiCollection.

In Unity select File > Build SettingsFile > Build Settings .

Select Windows StoreWindows Store in the PlatformPlatform list and click Switch PlatformSwitch Platform .

Set SDKSDK to Universal 10Universal 10  and Build TypeBuild Type to D3DD3D.

Check Unity C# ProjectsUnity C# Projects .

Click Add Open ScenesAdd Open Scenes  to add the scene.

Click Player Settings...Player Settings... .

In the Inspector Panel select the Windows Store logoWindows Store logo. Then select Publishing SettingsPublishing Settings .

In the CapabilitiesCapabilities  section, select the MicrophoneMicrophone and SpatialPerceptionSpatialPerception capabilities.

Back in the Build Settings window, click BuildBuild.

Create a New FolderNew Folder  named "App".

Single click the App FolderApp Folder .

Press Select FolderSelect Folder .

When Unity is done, a File Explorer window will appear.

Open the AppApp folder.



 Chapter 2 - Gaze

  ObjectivesObjectives

  InstructionsInstructions

Open the Origami Visual Studio SolutionOrigami Visual Studio Solution.

Using the top toolbar in Visual Studio, change the target from Debug to ReleaseRelease and from ARM to X86X86 .

Click on the arrow next to the Device button, and select HoloLens EmulatorHoloLens Emulator .

Click Debug -> Star t Without debuggingDebug -> Star t Without debugging or press Ctr l + F5Ctr l + F5 .

After some time the emulator will start with the Origami project. When first launching the emulator, it

can take as long as 15 minutes for the emulator to start up. Once it starts, do not close it.

In this chapter, we are going to introduce the first of three ways of interacting with your holograms -- gaze.

Visualize your gaze using a world-locked cursor.

Go back to your Unity project, and close the Build Settings window if it's still open.

Select the HologramsHolograms folder in the Project panelProject panel .

Drag the CursorCursor  object into the Hierarchy panelHierarchy panel  at the root level.

Double-click on the CursorCursor  object to take a closer look at it.

Right-click on the Scr iptsScr ipts  folder in the Project panel.

Click the CreateCreate sub-menu.

Select C# Scr iptC# Scr ipt.

Name the script WorldCursorWorldCursor . Note: The name is case-sensitive. You do not need to add the .cs extension.

Select the CursorCursor  object in the Hierarchy panelHierarchy panel .

Drag and drop the WorldCursorWorldCursor  script into the Inspector panelInspector panel .

Double-click the WorldCursorWorldCursor  script to open it in Visual Studio.

Copy and paste this code into WorldCursor.csWorldCursor.cs  and Save AllSave All .

https://www.youtube-nocookie.com/embed/BPWTbAC210k


using UnityEngine;

public class WorldCursor : MonoBehaviour
{
    private MeshRenderer meshRenderer;

    // Use this for initialization
    void Start()
    {
        // Grab the mesh renderer that's on the same object as this script.
        meshRenderer = this.gameObject.GetComponentInChildren<MeshRenderer>();
    }

    // Update is called once per frame
    void Update()
    {
        // Do a raycast into the world based on the user's
        // head position and orientation.
        var headPosition = Camera.main.transform.position;
        var gazeDirection = Camera.main.transform.forward;

        RaycastHit hitInfo;

        if (Physics.Raycast(headPosition, gazeDirection, out hitInfo))
        {
            // If the raycast hit a hologram...
            // Display the cursor mesh.
            meshRenderer.enabled = true;

            // Move thecursor to the point where the raycast hit.
            this.transform.position = hitInfo.point;

            // Rotate the cursor to hug the surface of the hologram.
            this.transform.rotation = Quaternion.FromToRotation(Vector3.up, hitInfo.normal);
        }
        else
        {
            // If the raycast did not hit a hologram, hide the cursor mesh.
            meshRenderer.enabled = false;
        }
    }
}

 Chapter 3 - Gestures

  ObjectivesObjectives

  InstructionsInstructions

Rebuild the app from File > Build SettingsFile > Build Settings .

Return to the Visual Studio solution previously used to deploy to the emulator.

Select 'Reload All' when prompted.

Click Debug -> Star t Without debuggingDebug -> Star t Without debugging or press Ctr l + F5Ctr l + F5 .

Use the Xbox controller to look around the scene. Notice how the cursor interacts with the shape of objects.

In this chapter, we'll add support for gestures. When the user selects a paper sphere, we'll make the sphere fall

by turning on gravity using Unity's physics engine.

Control your holograms with the Select gesture.

We'll start by creating a script than can detect the Select gesture.

https://www.youtube-nocookie.com/embed/6d-0RHeKHq4


In the Scr iptsScr ipts  folder, create a script named GazeGestureManagerGazeGestureManager .

Drag the GazeGestureManagerGazeGestureManager  script onto the OrigamiCollectionOrigamiCollection object in the Hierarchy.

Open the GazeGestureManagerGazeGestureManager  script in Visual Studio and add the following code:



using UnityEngine;
using UnityEngine.XR.WSA.Input;

public class GazeGestureManager : MonoBehaviour
{
    public static GazeGestureManager Instance { get; private set; }

    // Represents the hologram that is currently being gazed at.
    public GameObject FocusedObject { get; private set; }

    GestureRecognizer recognizer;

    // Use this for initialization
    void Start()
    {
        Instance = this;

        // Set up a GestureRecognizer to detect Select gestures.
        recognizer = new GestureRecognizer();
        recognizer.Tapped += (args) =>
        {
            // Send an OnSelect message to the focused object and its ancestors.
            if (FocusedObject != null)
            {
                FocusedObject.SendMessageUpwards("OnSelect", SendMessageOptions.DontRequireReceiver);
            }
        };
        recognizer.StartCapturingGestures();
    }

    // Update is called once per frame
    void Update()
    {
        // Figure out which hologram is focused this frame.
        GameObject oldFocusObject = FocusedObject;

        // Do a raycast into the world based on the user's
        // head position and orientation.
        var headPosition = Camera.main.transform.position;
        var gazeDirection = Camera.main.transform.forward;

        RaycastHit hitInfo;
        if (Physics.Raycast(headPosition, gazeDirection, out hitInfo))
        {
            // If the raycast hit a hologram, use that as the focused object.
            FocusedObject = hitInfo.collider.gameObject;
        }
        else
        {
            // If the raycast did not hit a hologram, clear the focused object.
            FocusedObject = null;
        }

        // If the focused object changed this frame,
        // start detecting fresh gestures again.
        if (FocusedObject != oldFocusObject)
        {
            recognizer.CancelGestures();
            recognizer.StartCapturingGestures();
        }
    }
}

Create another script in the Scripts folder, this time named SphereCommandsSphereCommands .

Expand the OrigamiCollectionOrigamiCollection object in the Hierarchy view.



using UnityEngine;

public class SphereCommands : MonoBehaviour
{
    // Called by GazeGestureManager when the user performs a Select gesture
    void OnSelect()
    {
        // If the sphere has no Rigidbody component, add one to enable physics.
        if (!this.GetComponent<Rigidbody>())
        {
            var rigidbody = this.gameObject.AddComponent<Rigidbody>();
            rigidbody.collisionDetectionMode = CollisionDetectionMode.Continuous;
        }
    }
}

 Chapter 4 - Voice

  ObjectivesObjectives

  InstructionsInstructions

Drag the SphereCommandsSphereCommands  script onto the Sphere1Sphere1  object in the Hierarchy panel.

Drag the SphereCommandsSphereCommands  script onto the Sphere2Sphere2  object in the Hierarchy panel.

Open the script in Visual Studio for editing, and replace the default code with this:

Export, build and deploy the app to the HoloLens emulator.

Look around the scene, and center on one of the spheres.

Press the AA button on the Xbox controller or press the Spacebar to simulate the Select gesture.

In this chapter, we'll add support for two voice commands: "Reset world" to returns the dropped spheres to their

original location, and "Drop sphere" to make the sphere fall.

Add voice commands that always listen in the background.

Create a hologram that reacts to a voice command.

In the Scr iptsScr ipts  folder, create a script named SpeechManagerSpeechManager .

Drag the SpeechManagerSpeechManager  script onto the OrigamiCollectionOrigamiCollection object in the Hierarchy

Open the SpeechManagerSpeechManager  script in Visual Studio.

Copy and paste this code into SpeechManager.csSpeechManager.cs  and Save AllSave All :

https://www.youtube-nocookie.com/embed/LxbOhnd2_GM


using System.Collections.Generic;
using System.Linq;
using UnityEngine;
using UnityEngine.Windows.Speech;

public class SpeechManager : MonoBehaviour
{
    KeywordRecognizer keywordRecognizer = null;
    Dictionary<string, System.Action> keywords = new Dictionary<string, System.Action>();

    // Use this for initialization
    void Start()
    {
        keywords.Add("Reset world", () =>
        {
            // Call the OnReset method on every descendant object.
            this.BroadcastMessage("OnReset");
        });

        keywords.Add("Drop Sphere", () =>
        {
            var focusObject = GazeGestureManager.Instance.FocusedObject;
            if (focusObject != null)
            {
                // Call the OnDrop method on just the focused object.
                focusObject.SendMessage("OnDrop", SendMessageOptions.DontRequireReceiver);
            }
        });

        // Tell the KeywordRecognizer about our keywords.
        keywordRecognizer = new KeywordRecognizer(keywords.Keys.ToArray());

        // Register a callback for the KeywordRecognizer and start recognizing!
        keywordRecognizer.OnPhraseRecognized += KeywordRecognizer_OnPhraseRecognized;
        keywordRecognizer.Start();
    }

    private void KeywordRecognizer_OnPhraseRecognized(PhraseRecognizedEventArgs args)
    {
        System.Action keywordAction;
        if (keywords.TryGetValue(args.text, out keywordAction))
        {
            keywordAction.Invoke();
        }
    }
}

Open the SphereCommandsSphereCommands  script in Visual Studio.

Update the script to read as follows:



using UnityEngine;

public class SphereCommands : MonoBehaviour
{
    Vector3 originalPosition;

    // Use this for initialization
    void Start()
    {
        // Grab the original local position of the sphere when the app starts.
        originalPosition = this.transform.localPosition;
    }

    // Called by GazeGestureManager when the user performs a Select gesture
    void OnSelect()
    {
        // If the sphere has no Rigidbody component, add one to enable physics.
        if (!this.GetComponent<Rigidbody>())
        {
            var rigidbody = this.gameObject.AddComponent<Rigidbody>();
            rigidbody.collisionDetectionMode = CollisionDetectionMode.Continuous;
        }
    }

    // Called by SpeechManager when the user says the "Reset world" command
    void OnReset()
    {
        // If the sphere has a Rigidbody component, remove it to disable physics.
        var rigidbody = this.GetComponent<Rigidbody>();
        if (rigidbody != null)
        {
            rigidbody.isKinematic = true;
            Destroy(rigidbody);
        }

        // Put the sphere back into its original local position.
        this.transform.localPosition = originalPosition;
    }

    // Called by SpeechManager when the user says the "Drop sphere" command
    void OnDrop()
    {
        // Just do the same logic as a Select gesture.
        OnSelect();
    }
}

 Chapter 5 - Spatial sound

  ObjectivesObjectives

  InstructionsInstructions

Export, build and deploy the app to the HoloLens emulator.

The emulator will support your PC's microphone and respond to your voice: adjust the view so the cursor is

on one of the spheres, and say "Drop Sphere".

Say "Reset WorldReset World" to bring them back to their initial positions.

In this chapter, we'll add music to the app, and then trigger sound effects on certain actions. We'll be using

spatial sound to give sounds a specific location in 3D space.

Hear holograms in your world.

https://www.youtube-nocookie.com/embed/Xc3C4VA10w4


using UnityEngine;

public class SphereSounds : MonoBehaviour
{
    AudioSource impactAudioSource = null;
    AudioSource rollingAudioSource = null;

    bool rolling = false;

    void Start()
    {
        // Add an AudioSource component and set up some defaults
        impactAudioSource = gameObject.AddComponent<AudioSource>();
        impactAudioSource.playOnAwake = false;
        impactAudioSource.spatialize = true;
        impactAudioSource.spatialBlend = 1.0f;
        impactAudioSource.dopplerLevel = 0.0f;
        impactAudioSource.rolloffMode = AudioRolloffMode.Logarithmic;
        impactAudioSource.maxDistance = 20f;

        rollingAudioSource = gameObject.AddComponent<AudioSource>();
        rollingAudioSource.playOnAwake = false;
        rollingAudioSource.spatialize = true;
        rollingAudioSource.spatialBlend = 1.0f;
        rollingAudioSource.dopplerLevel = 0.0f;
        rollingAudioSource.rolloffMode = AudioRolloffMode.Logarithmic;
        rollingAudioSource.maxDistance = 20f;
        rollingAudioSource.loop = true;

        // Load the Sphere sounds from the Resources folder
        impactAudioSource.clip = Resources.Load<AudioClip>("Impact");
        rollingAudioSource.clip = Resources.Load<AudioClip>("Rolling");
    }

    // Occurs when this object starts colliding with another object
    void OnCollisionEnter(Collision collision)
    {
        // Play an impact sound if the sphere impacts strongly enough.
        if (collision.relativeVelocity.magnitude >= 0.1f)
        {
            impactAudioSource.Play();
        }
    }

    // Occurs each frame that this object continues to collide with another object
    void OnCollisionStay(Collision collision)

In the Unity select from the top menu Edit > Project Settings > AudioEdit > Project Settings > Audio

Find the Spatializer PluginSpatializer Plugin setting and select MS HRTF SpatializerMS HRTF Spatializer .

From the HologramsHolograms folder, drag the AmbienceAmbience object onto the OrigamiCollectionOrigamiCollection object in the

Hierarchy Panel.

Select OrigamiCollectionOrigamiCollection and find the Audio SourceAudio Source component. Change these properties:

In the Scr iptsScr ipts  folder, create a script named SphereSoundsSphereSounds .

Drag SphereSoundsSphereSounds  to the Sphere1Sphere1  and Sphere2Sphere2  objects in the Hierarchy.

Open SphereSoundsSphereSounds  in Visual Studio, update the following code and Save AllSave All .

Check the SpatializeSpatialize property.

Check the Play On AwakePlay On Awake.

Change Spatial BlendSpatial Blend to 3D3D by dragging the slider all the way to the right.

Check the LoopLoop property.

Expand 3D Sound Settings3D Sound Settings , and enter 0 .10.1  for Doppler LevelDoppler Level .

Set Volume RolloffVolume Rolloff  to Logarithmic RolloffLogarithmic Rolloff .

Set Max DistanceMax Distance to 2020 .



    void OnCollisionStay(Collision collision)
    {
        Rigidbody rigid = gameObject.GetComponent<Rigidbody>();

        // Play a rolling sound if the sphere is rolling fast enough.
        if (!rolling && rigid.velocity.magnitude >= 0.01f)
        {
            rolling = true;
            rollingAudioSource.Play();
        }
        // Stop the rolling sound if rolling slows down.
        else if (rolling && rigid.velocity.magnitude < 0.01f)
        {
            rolling = false;
            rollingAudioSource.Stop();
        }
    }

    // Occurs when this object stops colliding with another object
    void OnCollisionExit(Collision collision)
    {
        // Stop the rolling sound if the object falls off and stops colliding.
        if (rolling)
        {
            rolling = false;
            impactAudioSource.Stop();
            rollingAudioSource.Stop();
        }
    }
}

 Chapter 6 - Spatial mapping

  ObjectivesObjectives

  InstructionsInstructions

Save the script, and return to Unity.

Export, build and deploy the app to the HoloLens emulator.

Wear headphones to get the full effect, and move closer and further from the Stage to hear the sounds

change.

Now we are going to use spatial mapping to place the game board on a real object in the real world.

Bring your real world into the virtual world.

Place your holograms where they matter most to you.

Click on the HologramsHolograms folder in the Project panel.

Drag the Spatial MappingSpatial Mapping asset into the root of the HierarchyHierarchy .

Click on the Spatial MappingSpatial Mapping object in the Hierarchy.

In the Inspector panelInspector panel , change the following properties:

Export, build and deploy the app to the HoloLens emulator.

When the app runs, a mesh of a previously scanned real-world living room will be rendered in wireframe.

Watch how a rolling sphere will fall off the stage, and onto the floor!

Check the Draw Visual MeshesDraw Visual Meshes  box.

Locate Draw Mater ialDraw Mater ial  and click the circle on the right. Type "wireframewireframe" into the search field at the

top. Click on the result and then close the window.

Now we'll show you how to move the OrigamiCollection to a new location:

https://www.youtube-nocookie.com/embed/S-517Y63Cnk


using UnityEngine;

public class TapToPlaceParent : MonoBehaviour
{
    bool placing = false;

    // Called by GazeGestureManager when the user performs a Select gesture
    void OnSelect()
    {
        // On each Select gesture, toggle whether the user is in placing mode.
        placing = !placing;

        // If the user is in placing mode, display the spatial mapping mesh.
        if (placing)
        {
            SpatialMapping.Instance.DrawVisualMeshes = true;
        }
        // If the user is not in placing mode, hide the spatial mapping mesh.
        else
        {
            SpatialMapping.Instance.DrawVisualMeshes = false;
        }
    }

    // Update is called once per frame
    void Update()
    {
        // If the user is in placing mode,
        // update the placement to match the user's gaze.

        if (placing)
        {
            // Do a raycast into the world that will only hit the Spatial Mapping mesh.
            var headPosition = Camera.main.transform.position;
            var gazeDirection = Camera.main.transform.forward;

            RaycastHit hitInfo;
            if (Physics.Raycast(headPosition, gazeDirection, out hitInfo,
                30.0f, SpatialMapping.PhysicsRaycastMask))
            {
                // Move this object's parent object to
                // where the raycast hit the Spatial Mapping mesh.
                this.transform.parent.position = hitInfo.point;

                // Rotate this object's parent object to face the user.
                Quaternion toQuat = Camera.main.transform.localRotation;
                toQuat.x = 0;
                toQuat.z = 0;
                this.transform.parent.rotation = toQuat;
            }
        }
    }
}

 

In the Scr iptsScr ipts  folder, create a script named TapToPlaceParentTapToPlaceParent.

In the HierarchyHierarchy , expand the OrigamiCollectionOrigamiCollection and select the StageStage object.

Drag the TapToPlaceParentTapToPlaceParent script onto the Stage object.

Open the TapToPlaceParentTapToPlaceParent script in Visual Studio, and update it to be the following:

Export, build and deploy the app.

Now you should now be able to place the game in a specific location by gazing at it, using the Select gesture

(AA or Spacebar) and then moving to a new location, and using the Select gesture again.



The end

 See also

And that's the end of this tutorial!

You learned:

How to create a holographic app in Unity.

How to make use of gaze, gesture, voice, sounds, and spatial mapping.

How to build and deploy an app using Visual Studio.

You are now ready to start creating your own holographic apps!

MR Basics 101: Complete project with device

Gaze

Head-gaze and commit

Voice input

Spatial sound

Spatial mapping
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MR Input 210: Gaze ✔️ ✔️

 Before you start
  PrerequisitesPrerequisites

  Project filesProject files

The Mixed Reality Academy tutorials were designed with HoloLens (1st gen), Unity 2017, and Mixed Reality Immersive

Headsets in mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for

guidance in developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being

used for HoloLens 2 and may not be compatible with newer versions of Unity. They will be maintained to continue

working on the supported devices. A new series of tutorials has been posted for HoloLens 2.

Gaze is the first form of input and reveals the user's intent and awareness. MR Input 210 (aka Project Explorer) is

a deep dive into gaze-related concepts for Windows Mixed Reality. We will be adding contextual awareness to

our cursor and holograms, taking full advantage of what your app knows about the user's gaze.

We have a friendly astronaut here to help you learn gaze concepts. In MR Basics 101, we had a simple cursor

that just followed your gaze. Today we're moving a step beyond the simple cursor :

We're making the cursor and our holograms gaze-aware: both will change based on where the user is

looking - or where the user is not looking. This makes them context-aware.

We will add feedback to our cursor and holograms to give the user more context on what is being targeted.

This feedback can be audio and visual.

We'll show you targeting techniques to help users hit smaller targets.

We'll show you how to draw the user's attention to your holograms with a directional indicator.

We'll teach you techniques to take your holograms with the user as she moves around in your world.

The videos embedded in each of the chapters below were recorded using an older version of Unity and the Mixed Reality

Toolkit. While the step-by-step instructions are accurate and current, you may see scripts and visuals in the corresponding

videos that are out-of-date. The videos remain included for posterity and because the concepts covered still apply.

A Windows 10 PC configured with the correct tools installed.

Some basic C# programming ability.

You should have completed MR Basics 101.

A HoloLens device configured for development.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/holograms-210.md
https://docs.microsoft.com/en-us/windows/mixed-reality/develop/unity/tutorials/mrlearning-base
https://www.youtube-nocookie.com/embed/yKAttGduVp0
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


NOTENOTE

  Errata and NotesErrata and Notes

 Chapter 1 - Unity Setup

  ObjectivesObjectives

  InstructionsInstructions

  Unity settings for HoloLensUnity settings for HoloLens

  Import project assetsImport project assets

Download the files required by the project. Requires Unity 2017.2 or later.

Un-archive the files to your desktop or other easy to reach location.

If you want to look through the source code before downloading, it's available on GitHub.

In Visual Studio, "Just My Code" needs to be disabled (unchecked) under Tools->Options->Debugging in

order to hit breakpoints in your code.

Optimize Unity for HoloLens development.

Import assets and setup the scene.

View the astronaut in the HoloLens.

1. Start Unity.

2. Select New ProjectNew Project.

3. Name the project ModelExplorerModelExplorer .

4. Enter location as the GazeGaze folder you previously un-archived.

5. Make sure the project is set to 3D3D.

6. Click Create ProjectCreate Project.

We need to let Unity know that the app we are trying to export should create an immersive view instead of a 2D

view. We do that by adding HoloLens as a virtual reality device.

1. Go to Edit > Project Settings > PlayerEdit > Project Settings > Player .

2. In the Inspector PanelInspector Panel  for Player Settings, select the Windows StoreWindows Store icon.

3. Expand the XR SettingsXR Settings  group.

4. In the RenderingRendering section, check the Vir tual Reality Suppor tedVir tual Reality Suppor ted checkbox to add a new Vir tual RealityVir tual Reality

SDKsSDKs  list.

5. Verify that Windows Mixed RealityWindows Mixed Reality  appears in the list. If not, select the ++ button at the bottom of the list

and choose Windows HolographicWindows Holographic.

Next, we need to set our scripting backend to .NET.

1. Go to Edit > Project Settings > PlayerEdit > Project Settings > Player  (you may still have this up from the previous step).

2. In the Inspector PanelInspector Panel  for Player Settings, select the Windows StoreWindows Store icon.

3. In the Other SettingsOther Settings  Configuration section, make sure that Scr ipting BackendScripting Backend is set to .NET.NET

Finally, we'll update our quality settings to achieve a fast performance on HoloLens.

1. Go to Edit > Project Settings > QualityEdit > Project Settings > Quality .

2. Click on downward pointing arrow in the DefaultDefault row under the Windows Store icon.

3. Select Ver y LowVer y Low  for Windows Store AppsWindows Store Apps .

https://github.com/Microsoft/HolographicAcademy/archive/Holograms-210-Gaze.zip
https://github.com/Microsoft/HolographicAcademy/tree/Holograms-210-Gaze
https://www.youtube-nocookie.com/embed/_Ccn6riQ6vU


  Setup the sceneSetup the scene

  Save the projectSave the project

  Build the projectBuild the project

1. Right click the AssetsAssets  folder in the ProjectProject panel.

2. Click on Impor t Package > Custom PackageImpor t Package > Custom Package.

3. Navigate to the project files you downloaded and click on ModelExplorer.unitypackageModelExplorer.unitypackage.

4. Click OpenOpen.

5. After the package loads, click on the Impor tImpor t button.

1. In the Hierarchy, delete the Main CameraMain Camera.

2. In the HoloToolkitHoloToolkit folder, open the InputInput folder, then open the PrefabsPrefabs  folder.

3. Drag and drop the MixedRealityCameraParentMixedRealityCameraParent prefab from the PrefabsPrefabs  folder into the HierarchyHierarchy .

4. Right-click the Directional L ightDirectional L ight in the Hierarchy and select DeleteDelete.

5. In the HologramsHolograms folder, drag and drop the following assets into the root of the HierarchyHierarchy :

6. Start Play ModePlay Mode ▶ to view the astronaut.

7. Click Play ModePlay Mode ▶ again to StopStop.

8. In the HologramsHolograms folder, find the FitboxFitbox asset and drag it to the root of the HierarchyHierarchy .

9. Select the FitboxFitbox in the HierarchyHierarchy  panel.

10. Drag the AstroManAstroMan collection from the HierarchyHierarchy  to the Hologram CollectionHologram Collection property of the Fitbox in

the InspectorInspector  panel.

AstroManAstroMan

LightsL ights

SpaceAudioSourceSpaceAudioSource

SpaceBackgroundSpaceBackground

1. Save the new scene: File > Save Scene AsFile > Save Scene As .

2. Click New FolderNew Folder  and name the folder ScenesScenes .

3. Name the file “ModelExplorerModelExplorer ” and save it in the ScenesScenes  folder.

1. In Unity, select File > Build SettingsFile > Build Settings .

2. Click Add Open ScenesAdd Open Scenes  to add the scene.

3. Select Universal Windows PlatformUniversal Windows Platform in the PlatformPlatform list and click Switch PlatformSwitch Platform .

4. If you're specifically developing for HoloLens, set Target deviceTarget device to HoloLensHoloLens . Otherwise, leave it on AnyAny

devicedevice.

5. Ensure Build TypeBuild Type is set to D3DD3D and SDKSDK is set to Latest installedLatest installed (which should be SDK 16299 or newer).

6. Click BuildBuild.

7. Create a New FolderNew Folder  named "App".

8. Single click the AppApp folder.

9. Press Select FolderSelect Folder .

When Unity is done, a File Explorer window will appear.

1. Open the AppApp folder.

2. Open the ModelExplorer Visual Studio SolutionModelExplorer Visual Studio Solution.

If deploying to HoloLens:

1. Using the top toolbar in Visual Studio, change the target from Debug to ReleaseRelease and from ARM to x86x86 .

2. Click on the drop down arrow next to the Local Machine button, and select Remote MachineRemote Machine.

3. Enter your HoloLens device IP addressyour HoloLens device IP address  and set Authentication Mode to Universal (Unencr yptedUniversal (Unencr ypted

Protocol)Protocol) . Click SelectSelect. If you do not know your device IP address, look in Settings > Network &Settings > Network &
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Internet > Advanced OptionsInternet > Advanced Options .

4. In the top menu bar, click Debug -> Star t Without debuggingDebug -> Star t Without debugging or press Ctr l + F5Ctr l + F5 . If this is the first time

deploying to your device, you will need to pair it with Visual Studio.

5. When the app has deployed, dismiss the FitboxFitbox with a select gestureselect gesture.

If deploying to an immersive headset:

1. Using the top toolbar in Visual Studio, change the target from Debug to ReleaseRelease and from ARM to x64x64 .

2. Make sure the deployment target is set to Local MachineLocal Machine.

3. In the top menu bar, click Debug -> Star t Without debuggingDebug -> Star t Without debugging or press Ctr l + F5Ctr l + F5 .

4. When the app has deployed, dismiss the FitboxFitbox by pulling the trigger on a motion controller.

Cursor visual design and behavior.

Gaze-based cursor feedback.

Gaze-based hologram feedback.

We're going to base our work on some cursor design principles, namely:

The cursor is always present.

Don't let the cursor get too small or big.

Avoid obstructing content.

1. In the HoloToolkit\Input\PrefabsHoloToolkit\Input\Prefabs  folder, find the InputManagerInputManager  asset.

2. Drag and drop the InputManagerInputManager  onto the HierarchyHierarchy .

3. In the HoloToolkit\Input\PrefabsHoloToolkit\Input\Prefabs  folder, find the CursorCursor  asset.

4. Drag and drop the CursorCursor  onto the HierarchyHierarchy .

5. Select the InputManagerInputManager  object in the HierarchyHierarchy .

6. Drag the CursorCursor  object from the HierarchyHierarchy  into the InputManager's S impleSinglePointerSelectorSimpleSinglePointerSelector 's

CursorCursor  field, at the bottom of the InspectorInspector .

1. Rebuild the app from File > Build SettingsFile > Build Settings .

2. Open the App folderApp folder .

3. Open the ModelExplorer Visual Studio SolutionModelExplorer Visual Studio Solution.

4. Click Debug -> Star t Without debuggingDebug -> Star t Without debugging or press Ctr l + F5Ctr l + F5 .

5. Observe how the cursor is drawn, and how it changes appearance if it is touching a hologram.

1. In the HierarchyHierarchy  panel, expand the AstroManAstroMan->GEO_GGEO_G->Back_CenterBack_Center  object.

2. Double click on Interactible.csInteractible.cs  to open it in Visual Studio.

3. Uncomment the lines in the IFocusable.OnFocusEnter()IFocusable.OnFocusEnter()  and IFocusable.OnFocusExit()IFocusable.OnFocusExit()  callbacks in

Interactible.csInteractible.cs . These are called by the Mixed Reality Toolkit's InputManager when focus (either by gaze or

https://www.youtube-nocookie.com/embed/S24u0V_T7ZI


/* TODO: DEVELOPER CODING EXERCISE 2.d */

void IFocusable.OnFocusEnter()
{
    for (int i = 0; i < defaultMaterials.Length; i++)
    {
        // 2.d: Uncomment the below line to highlight the material when gaze enters.
        defaultMaterials[i].EnableKeyword("_ENVIRONMENT_COLORING");
    }
}

void IFocusable.OnFocusExit()
{
    for (int i = 0; i < defaultMaterials.Length; i++)
    {
        // 2.d: Uncomment the below line to remove highlight on material when gaze exits.
        defaultMaterials[i].DisableKeyword("_ENVIRONMENT_COLORING");
    }
}

NOTENOTE
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by controller pointing) enters and exits the specific GameObject's collider.

We use EnableKeyword  and DisableKeyword  above. In order to make use of these in your own app with the Toolkit's

Standard shader, you'll need to follow the Unity guidelines for accessing materials via script. In this case, we've already

included the three variants of highlighted material needed in the Resources folder (look for the three materials with

highlight in the name).

1. As before, build the project and deploy to the HoloLens.

2. Observe what happens when the gaze is aimed at an object and when it's not.

Make it easier to target holograms.

Stabilize natural head movements.

1. In the HierarchyHierarchy  panel, select the InputManagerInputManager  object.

2. In the InspectorInspector  panel, find the Gaze StabilizerGaze Stabilizer  script. Click it to open in Visual Studio, if you want to take a

look.

3. In the InspectorInspector , you can edit the Stored Stability SamplesStored Stability Samples  value. This value represents the number of

samples that the stabilizer iterates on to calculate the stabilized value.

This script iterates over samples of Raycast data and helps stabilize the user's gaze for precision

targeting.

Add a directional indicator on the cursor to help find holograms.

https://docs.unity3d.com/Manual/MaterialsAccessingViaScript.html
https://github.com/Microsoft/HolographicAcademy/tree/Holograms-210-Gaze/Completed/ModelExplorer/Assets/Resources/Models/AstroMan/Materials
https://www.youtube-nocookie.com/embed/TFnuLva4VJ0
https://www.youtube-nocookie.com/embed/htVbJCMlj64
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We're going to use the DirectionIndicator.csDirectionIndicator.cs  file which will:

1. Show the directional indicator if the user is not gazing at the holograms.

2. Hide the directional indicator if the user is gazing at the holograms.

3. Update the directional indicator to point to the holograms.

Let's get started.

1. Click on the AstroManAstroMan object in the HierarchyHierarchy  panel and click the arrowclick the arrow  to expand it.

2. In the HierarchyHierarchy  panel, select the DirectionalIndicatorDirectionalIndicator  object under AstroManAstroMan.

3. In the InspectorInspector  panel, click the Add ComponentAdd Component button.

4. In the menu, type in the search box Direction IndicatorDirection Indicator . Select the search result.

5. In the HierarchyHierarchy  panel, drag and drop the CursorCursor  object onto the CursorCursor  property in the InspectorInspector .

6. In the ProjectProject panel, in the HologramsHolograms folder, drag and drop the DirectionalIndicatorDirectionalIndicator  asset onto the

Directional IndicatorDirectional Indicator  property in the InspectorInspector .

7. Build and deploy the app.

8. Watch how the directional indicator object helps you find the astronaut.

Use billboarding to have holograms always face towards you.

We will be using the Billboard.csBillboard.cs  file to keep a GameObject oriented such that it is facing the user at all times.

1. In the HierarchyHierarchy  panel, select the AstroManAstroMan object.

2. In the InspectorInspector  panel, click the Add ComponentAdd Component button.

3. In the menu, type in the search box BillboardBillboard. Select the search result.

4. In the InspectorInspector  set the Pivot AxisPivot Axis  to YY .

5. Try it! Build and deploy the app as before.

6. See how the Billboard object faces you no matter how you change the viewpoint.

7. Delete the script from the AstroManAstroMan for now.

Use Tag-Along to have our holograms follow us around the room.

As we work on this issue, we'll be guided by the following design constraints:

Content should always be a glance away.

Content should not be in the way.

Head-locking content is uncomfortable.

The solution used here is to use a "tag-along" approach.

A tag-along object never fully leaves the user's view. You can think of the a tag-along as being an object attached

to the user's head by rubber bands. As the user moves, the content will stay within an easy glance by sliding

towards the edge of the view without completely leaving. When the user gazes towards the tag-along object, it

https://www.youtube-nocookie.com/embed/qFiLr_LUACE
https://www.youtube-nocookie.com/embed/Ct8ORZAX5JU


/* TODO: DEVELOPER CODING EXERCISE 6.a */
// 6.a: Uncomment the lines below to perform a Tagalong action.
if (interactibleAction != null)
{
    interactibleAction.PerformAction();
}

comes more fully into view.

We're going to use the S impleTagalong.csSimpleTagalong.cs  file which will:

1. Determine if the Tag-Along object is within the camera bounds.

2. If not within the view frustum, position the Tag-Along to partially within the view frustum.

3. Otherwise, position the Tag-Along to a default distance from the user.

To do this, we first must change the Interactible.csInteractible.cs  script to call the TagalongActionTagalongAction.

1. Edit Interactible.csInteractible.cs  by completing coding exercise 6.a (uncommenting lines 84 to 87).

The InteractibleAction.csInteractibleAction.cs  script, paired with Interactible.csInteractible.cs  performs custom actions when you tap on

holograms. In this case, we'll use one specifically for tag-along.

In the Scr iptsScr ipts  folder click on TagalongAction.csTagalongAction.cs  asset to open in Visual Studio.

Complete the coding exercise or change it to this:

Double click the TagalongActionTagalongAction script to open it in Visual Studio.

At the top of the HierarchyHierarchy , in the search bar type ChestButton_CenterChestButton_Center  and select the result.

In the InspectorInspector  panel, click the Add ComponentAdd Component button.

In the menu, type in the search box Tagalong ActionTagalong Action. Select the search result.

In HologramsHolograms folder find the TagalongTagalong asset.

Select the ChestButton_CenterChestButton_Center  object in the HierarchyHierarchy . Drag and drop the TagAlongTagAlong object from

the ProjectProject panel onto the InspectorInspector  into the Object To TagalongObject To Tagalong property.

Drag the Tagalong ActionTagalong Action object from the InspectorInspector  into the Interactible ActionInteractible Action field on the

InteractibleInteractible script.

We need to add the following:

Add functionality to the PerformAction function in the TagalongAction script (inherited from

InteractibleAction).

Add billboarding to the gazed-upon object, and set the pivot axis to XY.

Then add simple Tag-Along to the object.

Here's our solution, from TagalongAction.csTagalongAction.cs :



// Copyright (c) Microsoft Corporation. All rights reserved.
// Licensed under the MIT License. See LICENSE in the project root for license information.

using HoloToolkit.Unity;
using UnityEngine;

public class TagalongAction : InteractibleAction
{
    [SerializeField]
    [Tooltip("Drag the Tagalong prefab asset you want to display.")]
    private GameObject objectToTagalong;

    private void Awake()
    {
        if (objectToTagalong != null)
        {
            objectToTagalong = Instantiate(objectToTagalong);
            objectToTagalong.SetActive(false);

            /* TODO: DEVELOPER CODING EXERCISE 6.b */

            // 6.b: AddComponent Billboard to objectToTagAlong,
            // so it's always facing the user as they move.
            Billboard billboard = objectToTagalong.AddComponent<Billboard>();

            // 6.b: AddComponent SimpleTagalong to objectToTagAlong,
            // so it's always following the user as they move.
            objectToTagalong.AddComponent<SimpleTagalong>();

            // 6.b: Set any public properties you wish to experiment with.
            billboard.PivotAxis = PivotAxis.XY; // Already the default, but provided in case you want to 
edit
        }
    }

    public override void PerformAction()
    {
        // Recommend having only one tagalong.
        if (objectToTagalong == null || objectToTagalong.activeSelf)
        {
            return;
        }

        objectToTagalong.SetActive(true);
    }
}

Try it! Build and deploy the app.

Watch how the content follows the center of the gaze point, but not continuously and without blocking it.
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 Before you start
  PrerequisitesPrerequisites

The Mixed Reality Academy tutorials were designed with HoloLens (1st gen), Unity 2017, and Mixed Reality Immersive

Headsets in mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for

guidance in developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being

used for HoloLens 2 and may not be compatible with newer versions of Unity. They will be maintained to continue

working on the supported devices. A new series of tutorials has been posted for HoloLens 2.

Gestures turn user intention into action. With gestures, users can interact with holograms. In this course, we'll

learn how to track the user's hands, respond to user input, and give feedback to the user based on hand state

and location.

In MR Basics 101, we used a simple air-tap gesture to interact with our holograms. Now, we'll move beyond the

air-tap gesture and explore new concepts to:

Detect when the user's hand is being tracked and provide feedback to the user.

Use a navigation gesture to rotate our holograms.

Provide feedback when the user's hand is about to go out of view.

Use manipulation events to allow users to move holograms with their hands.

In this course, we'll revisit the Unity project Model ExplorerModel Explorer , which we built in MR Input 210. Our astronaut

friend is back to assist us in our exploration of these new gesture concepts.

The videos embedded in each of the chapters below were recorded using an older version of Unity and the Mixed Reality

Toolkit. While the step-by-step instructions are accurate and current, you may see scripts and visuals in the corresponding

videos that are out-of-date. The videos remain included for posterity and because the concepts covered still apply.

A Windows 10 PC configured with the correct tools installed.

Some basic C# programming ability.

You should have completed MR Basics 101.

You should have completed MR Input 210.

A HoloLens device configured for development.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/holograms-211.md
https://docs.microsoft.com/en-us/windows/mixed-reality/develop/unity/tutorials/mrlearning-base
https://www.youtube-nocookie.com/embed/c9zlpfFeEtc
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
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Download the files required by the project. Requires Unity 2017.2 or later.

Un-archive the files to your desktop or other easy to reach location.

If you want to look through the source code before downloading, it's available on GitHub.

"Enable Just My Code" needs to be disabled (unchecked) in Visual Studio under Tools->Options->Debugging

in order to hit breakpoints in your code.

1. Start Unity.

2. Select OpenOpen.

3. Navigate to the GestureGesture folder you previously un-archived.

4. Find and select the Star tingStar ting/Model ExplorerModel Explorer  folder.

5. Click the Select FolderSelect Folder  button.

6. In the ProjectProject panel, expand the ScenesScenes  folder.

7. Double-click ModelExplorerModelExplorer  scene to load it in Unity.

1. In Unity, select File > Build SettingsFile > Build Settings .

2. If Scenes/ModelExplorerScenes/ModelExplorer  is not listed in Scenes In BuildScenes In Build, click Add Open ScenesAdd Open Scenes  to add the scene.

3. If you're specifically developing for HoloLens, set Target deviceTarget device to HoloLensHoloLens . Otherwise, leave it on AnyAny

devicedevice.

4. Ensure Build TypeBuild Type is set to D3DD3D and SDKSDK is set to Latest installedLatest installed (which should be SDK 16299 or newer).

5. Click BuildBuild.

6. Create a New FolderNew Folder  named "App".

7. Single click the AppApp folder.

8. Press Select FolderSelect Folder  and Unity will start building the project for Visual Studio.

When Unity is done, a File Explorer window will appear.

1. Open the AppApp folder.

2. Open the ModelExplorer Visual Studio SolutionModelExplorer Visual Studio Solution.

If deploying to HoloLens:

1. Using the top toolbar in Visual Studio, change the target from Debug to ReleaseRelease and from ARM to x86x86 .

2. Click on the drop down arrow next to the Local Machine button, and select Remote MachineRemote Machine.

3. Enter your HoloLens device IP addressyour HoloLens device IP address  and set Authentication Mode to Universal (Unencr yptedUniversal (Unencr ypted

Protocol)Protocol) . Click SelectSelect. If you do not know your device IP address, look in Settings > Network &Settings > Network &

Internet > Advanced OptionsInternet > Advanced Options .

4. In the top menu bar, click Debug -> Star t Without debuggingDebug -> Star t Without debugging or press Ctr l + F5Ctr l + F5 . If this is the first time

deploying to your device, you will need to pair it with Visual Studio.

5. When the app has deployed, dismiss the FitboxFitbox with a select gestureselect gesture.

If deploying to an immersive headset:

https://github.com/Microsoft/HolographicAcademy/archive/Holograms-211-Gesture.zip
https://github.com/Microsoft/HolographicAcademy/tree/Holograms-211-Gesture
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  Build and DeployBuild and Deploy

1. Using the top toolbar in Visual Studio, change the target from Debug to ReleaseRelease and from ARM to x64x64 .

2. Make sure the deployment target is set to Local MachineLocal Machine.

3. In the top menu bar, click Debug -> Star t Without debuggingDebug -> Star t Without debugging or press Ctr l + F5Ctr l + F5 .

4. When the app has deployed, dismiss the FitboxFitbox by pulling the trigger on a motion controller.

You might notice some red errors in the Visual Studio Errors panel. It is safe to ignore them. Switch to the Output panel to

view actual build progress. Errors in the Output panel will require you to make a fix (most often they are caused by a

mistake in a script).

Subscribe to hand tracking events.

Use cursor feedback to show users when a hand is being tracked.

On HoloLens 2 , hands detected fires whenever hands are visible (not just when a finger is pointing up).

In the HierarchyHierarchy  panel, expand the InputManagerInputManager  object.

Look for and select the GesturesInputGesturesInput object.

The InteractionInputSource.csInteractionInputSource.cs  script performs these steps:

1. Subscribes to the InteractionSourceDetected and InteractionSourceLost events.

2. Sets the HandDetected state.

3. Unsubscribes from the InteractionSourceDetected and InteractionSourceLost events.

Next, we'll upgrade our cursor from MR Input 210 into one that shows feedback depending on the user's

actions.

1. In the HierarchyHierarchy  panel, select the CursorCursor  object and delete it.

2. In the ProjectProject panel, search for CursorWithFeedbackCursorWithFeedback and drag it into the HierarchyHierarchy  panel.

3. Click on InputManagerInputManager  in the HierarchyHierarchy  panel, then drag the CursorWithFeedbackCursorWithFeedback object from the

HierarchyHierarchy  into the InputManager's S impleSinglePointerSelectorSimpleSinglePointerSelector 's CursorCursor  field, at the bottom of the

InspectorInspector .

4. Click on the CursorWithFeedbackCursorWithFeedback in the HierarchyHierarchy .

5. In the InspectorInspector  panel, expand Cursor State DataCursor State Data on the Object CursorObject Cursor  script.

The Cursor State DataCursor State Data works like this:

Any Obser veObser ve state means that no hand is detected and the user is simply looking around.

Any InteractInteract state means that a hand or controller is detected.

Any HoverHover  state means the user is looking at a hologram.

In Unity, use File > Build SettingsFile > Build Settings  to rebuild the application.

Open the AppApp folder.

https://www.youtube-nocookie.com/embed/D1FcIyuFTZQ
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using HoloToolkit.Unity.InputModule;
using UnityEngine;

/// <summary>
/// GestureAction performs custom actions based on
/// which gesture is being performed.
/// </summary>
public class GestureAction : MonoBehaviour, INavigationHandler, IManipulationHandler, ISpeechHandler
{
    [Tooltip("Rotation max speed controls amount of rotation.")]
    [SerializeField]
    private float RotationSensitivity = 10.0f;

If it's not already open, open the ModelExplorer Visual Studio SolutionModelExplorer Visual Studio Solution.

In Visual Studio, click Debug -> Star t Without debuggingDebug -> Star t Without debugging or press Ctr l + F5Ctr l + F5 .

After the application deploys to the HoloLens, dismiss the fitbox using the air-tap gesture.

Move your hand into view and point your index finger to the sky to start hand tracking.

Move your hand left, right, up and down.

Watch how the cursor changes when your hand is detected and then lost from view.

If you're on an immersive headset, you'll have to connect and disconnect your controller. This feedback

becomes less interesting on an immersive device, as a connected controller will always be "available".

(If you already built/deployed this project in Visual Studio during set-up, then you can open that

instance of VS and click 'Reload All' when prompted).

Use Navigation gesture events to rotate the astronaut.

To use Navigation gestures in our app, we are going to edit GestureAction.csGestureAction.cs  to rotate objects when the

Navigation gesture occurs. Additionally, we'll add feedback to the cursor to display when Navigation is available.

1. In the HierarchyHierarchy  panel, expand CursorWithFeedbackCursorWithFeedback .

2. In the HologramsHolograms folder, find the ScrollFeedbackScrollFeedback asset.

3. Drag and drop the ScrollFeedbackScrollFeedback prefab onto the CursorWithFeedbackCursorWithFeedback GameObject in the HierarchyHierarchy .

4. Click on CursorWithFeedbackCursorWithFeedback .

5. In the InspectorInspector  panel, click the Add ComponentAdd Component button.

6. In the menu, type in the search box CursorFeedbackCursorFeedback . Select the search result.

7. Drag and drop the ScrollFeedbackScrollFeedback object from the HierarchyHierarchy  onto the Scroll Detected Game ObjectScroll Detected Game Object

property in the Cursor FeedbackCursor Feedback component in the InspectorInspector .

8. In the HierarchyHierarchy  panel, select the AstroManAstroMan object.

9. In the InspectorInspector  panel, click the Add ComponentAdd Component button.

10. In the menu, type in the search box Gesture ActionGesture Action. Select the search result.

Next, open GestureAction.csGestureAction.cs  in Visual Studio. In coding exercise 2.c, edit the script to do the following:

1. Rotate the AstroManRotate the AstroMan object whenever a Navigation gesture is performed.

2. Calculate the rotationFactorrotationFactor  to control the amount of rotation applied to the object.

3. Rotate the objectRotate the object around the y-axis when the user moves their hand left or right.

Complete coding exercises 2.c in the script, or replace the code with the completed solution below:

https://www.youtube-nocookie.com/embed/sm-kxtKksSo


    private bool isNavigationEnabled = true;
    public bool IsNavigationEnabled
    {
        get { return isNavigationEnabled; }
        set { isNavigationEnabled = value; }
    }

    private Vector3 manipulationOriginalPosition = Vector3.zero;

    void INavigationHandler.OnNavigationStarted(NavigationEventData eventData)
    {
        InputManager.Instance.PushModalInputHandler(gameObject);
    }

    void INavigationHandler.OnNavigationUpdated(NavigationEventData eventData)
    {
        if (isNavigationEnabled)
        {
            /* TODO: DEVELOPER CODING EXERCISE 2.c */

            // 2.c: Calculate a float rotationFactor based on eventData's NormalizedOffset.x multiplied by 
RotationSensitivity.
            // This will help control the amount of rotation.
            float rotationFactor = eventData.NormalizedOffset.x * RotationSensitivity;

            // 2.c: transform.Rotate around the Y axis using rotationFactor.
            transform.Rotate(new Vector3(0, -1 * rotationFactor, 0));
        }
    }

    void INavigationHandler.OnNavigationCompleted(NavigationEventData eventData)
    {
        InputManager.Instance.PopModalInputHandler();
    }

    void INavigationHandler.OnNavigationCanceled(NavigationEventData eventData)
    {
        InputManager.Instance.PopModalInputHandler();
    }

    void IManipulationHandler.OnManipulationStarted(ManipulationEventData eventData)
    {
        if (!isNavigationEnabled)
        {
            InputManager.Instance.PushModalInputHandler(gameObject);

            manipulationOriginalPosition = transform.position;
        }
    }

    void IManipulationHandler.OnManipulationUpdated(ManipulationEventData eventData)
    {
        if (!isNavigationEnabled)
        {
            /* TODO: DEVELOPER CODING EXERCISE 4.a */

            // 4.a: Make this transform's position be the manipulationOriginalPosition + 
eventData.CumulativeDelta
        }
    }

    void IManipulationHandler.OnManipulationCompleted(ManipulationEventData eventData)
    {
        InputManager.Instance.PopModalInputHandler();
    }

    void IManipulationHandler.OnManipulationCanceled(ManipulationEventData eventData)
    {
        InputManager.Instance.PopModalInputHandler();



    }

    void ISpeechHandler.OnSpeechKeywordRecognized(SpeechEventData eventData)
    {
        if (eventData.RecognizedText.Equals("Move Astronaut"))
        {
            isNavigationEnabled = false;
        }
        else if (eventData.RecognizedText.Equals("Rotate Astronaut"))
        {
            isNavigationEnabled = true;
        }
        else
        {
            return;
        }

        eventData.Use();
    }
}

  Build and DeployBuild and Deploy

 Chapter 3 - Hand Guidance

  ObjectivesObjectives

  InstructionsInstructions

  Build and DeployBuild and Deploy

You'll notice that the other navigation events are already filled in with some info. We push the GameObject onto

the Toolkit's InputSystem's modal stack, so the user doesn't have to maintain focus on the Astronaut once

rotation has begun. Correspondingly, we pop the GameObject off the stack once the gesture is completed.

1. Rebuild the application in Unity and then build and deploy from Visual Studio to run it in the HoloLens.

2. Gaze at the astronaut, two arrows should appear on either side of the cursor. This new visual indicates that

the astronaut can be rotated.

3. Place your hand in the ready position (index finger pointed towards the sky) so the HoloLens will start

tracking your hand.

4. To rotate the astronaut, lower your index finger to a pinch position, and then move your hand left or right to

trigger the NavigationX gesture.

Use hand guidance scorehand guidance score to help predict when hand tracking will be lost.

Provide feedback on the cursorfeedback on the cursor  to show when the user's hand nears the camera's edge of view.

1. In the HierarchyHierarchy  panel, select the CursorWithFeedbackCursorWithFeedback object.

2. In the InspectorInspector  panel, click the Add ComponentAdd Component button.

3. In the menu, type in the search box Hand GuidanceHand Guidance. Select the search result.

4. In the ProjectProject panel HologramsHolograms folder, find the HandGuidanceFeedbackHandGuidanceFeedback asset.

5. Drag and drop the HandGuidanceFeedbackHandGuidanceFeedback asset onto the Hand Guidance IndicatorHand Guidance Indicator  property in the

InspectorInspector  panel.

Rebuild the application in Unity and then build and deploy from Visual Studio to experience the app on

HoloLens.

Bring your hand into view and raise your index finger to get tracked.

Start rotating the astronaut with the Navigation gesture (pinch your index finger and thumb together).

Move your hand far left, right, up, and down.

https://www.youtube-nocookie.com/embed/ULzlVw4e14I


 Chapter 4 - Manipulation

  ObjectivesObjectives

  InstructionsInstructions

As your hand nears the edge of the gesture frame, an arrow should appear next to the cursor to warn you

that hand tracking will be lost. The arrow indicates which direction to move your hand in order to prevent

tracking from being lost.

Use Manipulation events to move the astronaut with your hands.

Provide feedback on the cursor to let the user know when Manipulation can be used.

GestureManager.cs and AstronautManager.cs will allow us to do the following:

1. Use the speech keyword "Move AstronautMove Astronaut" to enable ManipulationManipulation gestures and "Rotate AstronautRotate Astronaut" to

disable them.

2. Switch to responding to the Manipulation Gesture RecognizerManipulation Gesture Recognizer .

Let's get started.

1. In the HierarchyHierarchy  panel, create a new empty GameObject. Name it "AstronautManagerAstronautManager ".

2. In the InspectorInspector  panel, click the Add ComponentAdd Component button.

3. In the menu, type in the search box Astronaut ManagerAstronaut Manager . Select the search result.

4. In the InspectorInspector  panel, click the Add ComponentAdd Component button.

5. In the menu, type in the search box Speech Input SourceSpeech Input Source. Select the search result.

We'll now add the speech commands required to control the interaction state of the astronaut.

1. Expand the KeywordsKeywords  section in the InspectorInspector .

2. Click the ++ on the right hand side to add a new keyword.

3. Type the Keyword as Move AstronautMove Astronaut. Feel free to add a Key Shortcut if desired.

4. Click the ++ on the right hand side to add a new keyword.

5. Type the Keyword as Rotate AstronautRotate Astronaut. Feel free to add a Key Shortcut if desired.

6. The corresponding handler code can be found in GestureAction.csGestureAction.cs , in the

ISpeechHandler.OnSpeechKeywordRecognizedISpeechHandler.OnSpeechKeywordRecognized handler.

Next, we'll setup the manipulation feedback on the cursor.

1. In the ProjectProject panel HologramsHolograms folder, find the PathingFeedbackPathingFeedback asset.

2. Drag and drop the PathingFeedbackPathingFeedback prefab onto the CursorWithFeedbackCursorWithFeedback object in the HierarchyHierarchy .

3. In the HierarchyHierarchy  panel, click on CursorWithFeedbackCursorWithFeedback .

4. Drag and drop the PathingFeedbackPathingFeedback object from the HierarchyHierarchy  onto the Pathing Detected GamePathing Detected Game

ObjectObject property in the Cursor FeedbackCursor Feedback component in the InspectorInspector .

Now we need to add code to GestureAction.csGestureAction.cs  to enable the following:

https://www.youtube-nocookie.com/embed/f3m8MvU60-I


using HoloToolkit.Unity.InputModule;
using UnityEngine;

/// <summary>
/// GestureAction performs custom actions based on
/// which gesture is being performed.
/// </summary>
public class GestureAction : MonoBehaviour, INavigationHandler, IManipulationHandler, ISpeechHandler
{
    [Tooltip("Rotation max speed controls amount of rotation.")]
    [SerializeField]
    private float RotationSensitivity = 10.0f;

    private bool isNavigationEnabled = true;
    public bool IsNavigationEnabled
    {
        get { return isNavigationEnabled; }
        set { isNavigationEnabled = value; }
    }

    private Vector3 manipulationOriginalPosition = Vector3.zero;

    void INavigationHandler.OnNavigationStarted(NavigationEventData eventData)
    {
        InputManager.Instance.PushModalInputHandler(gameObject);
    }

    void INavigationHandler.OnNavigationUpdated(NavigationEventData eventData)
    {
        if (isNavigationEnabled)
        {
            /* TODO: DEVELOPER CODING EXERCISE 2.c */

            // 2.c: Calculate a float rotationFactor based on eventData's NormalizedOffset.x multiplied by 
RotationSensitivity.
            // This will help control the amount of rotation.
            float rotationFactor = eventData.NormalizedOffset.x * RotationSensitivity;

            // 2.c: transform.Rotate around the Y axis using rotationFactor.
            transform.Rotate(new Vector3(0, -1 * rotationFactor, 0));
        }
    }

    void INavigationHandler.OnNavigationCompleted(NavigationEventData eventData)
    {
        InputManager.Instance.PopModalInputHandler();
    }

    void INavigationHandler.OnNavigationCanceled(NavigationEventData eventData)
    {
        InputManager.Instance.PopModalInputHandler();
    }

    void IManipulationHandler.OnManipulationStarted(ManipulationEventData eventData)
    {
        if (!isNavigationEnabled)
        {
            InputManager.Instance.PushModalInputHandler(gameObject);

1. Add code to the IManipulationHandler.OnManipulationUpdatedIManipulationHandler.OnManipulationUpdated function, which will move the

astronaut when a ManipulationManipulation gesture is detected.

2. Calculate the movement vectormovement vector  to determine where the astronaut should be moved to based on hand

position.

3. MoveMove the astronaut to the new position.

Complete coding exercise 4.a in GestureAction.csGestureAction.cs , or use our completed solution below:



            manipulationOriginalPosition = transform.position;
        }
    }

    void IManipulationHandler.OnManipulationUpdated(ManipulationEventData eventData)
    {
        if (!isNavigationEnabled)
        {
            /* TODO: DEVELOPER CODING EXERCISE 4.a */

            // 4.a: Make this transform's position be the manipulationOriginalPosition + 
eventData.CumulativeDelta
            transform.position = manipulationOriginalPosition + eventData.CumulativeDelta;
        }
    }

    void IManipulationHandler.OnManipulationCompleted(ManipulationEventData eventData)
    {
        InputManager.Instance.PopModalInputHandler();
    }

    void IManipulationHandler.OnManipulationCanceled(ManipulationEventData eventData)
    {
        InputManager.Instance.PopModalInputHandler();
    }

    void ISpeechHandler.OnSpeechKeywordRecognized(SpeechEventData eventData)
    {
        if (eventData.RecognizedText.Equals("Move Astronaut"))
        {
            isNavigationEnabled = false;
        }
        else if (eventData.RecognizedText.Equals("Rotate Astronaut"))
        {
            isNavigationEnabled = true;
        }
        else
        {
            return;
        }

        eventData.Use();
    }
}

  Build and DeployBuild and Deploy

 Chapter 5 - Model expansion

Rebuild in Unity and then build and deploy from Visual Studio to run the app in HoloLens.

Move your hand in front of the HoloLens and raise your index finger so that it can be tracked.

Focus the cursor over the astronaut.

Say 'Move Astronaut' to move the astronaut with a Manipulation gesture.

Four arrows should appear around the cursor to indicate that the program will now respond to Manipulation

events.

Lower your index finger down to your thumb, and keep them pinched together.

As you move your hand around, the astronaut will move too (this is Manipulation).

Raise your index finger to stop manipulating the astronaut.

Note: If you do not say 'Move Astronaut' before moving your hand, then the Navigation gesture will be used

instead.

Say 'Rotate Astronaut' to return to the rotatable state.



  ObjectivesObjectives

  InstructionsInstructions

Expand the Astronaut model into multiple, smaller pieces that the user can interact with.

Move each piece individually using Navigation and Manipulation gestures.

In this section, we will accomplish the following tasks:

1. Add a new keyword "Expand ModelExpand Model" to expand the astronaut model.

2. Add a new Keyword "Reset ModelReset Model" to return the model to its original form.

We'll do this by adding two more keywords to the Speech Input Source from the previous chapter. We'll also

demonstrate another way to handle recognition events.

1. Click back on AstronautManagerAstronautManager  in the InspectorInspector  and expand the KeywordsKeywords  section in the InspectorInspector .

2. Click the ++ on the right hand side to add a new keyword.

3. Type the Keyword as Expand ModelExpand Model . Feel free to add a Key Shortcut if desired.

4. Click the ++ on the right hand side to add a new keyword.

5. Type the Keyword as Reset ModelReset Model . Feel free to add a Key Shortcut if desired.

6. In the InspectorInspector  panel, click the Add ComponentAdd Component button.

7. In the menu, type in the search box Speech Input HandlerSpeech Input Handler . Select the search result.

8. Check Is Global L istenerIs Global L istener , since we want these commands to work regardless of the GameObject we're

focusing.

9. Click the ++ button and select Expand ModelExpand Model  from the Keyword dropdown.

10. Click the ++ under Response, and drag the AstronautManagerAstronautManager  from the HierarchyHierarchy  into the None (Object)None (Object)

field.

11. Now, click the No FunctionNo Function dropdown, select AstronautManagerAstronautManager , then ExpandModelCommandExpandModelCommand.

12. Click the Speech Input Handler's ++ button and select Reset ModelReset Model  from the Keyword dropdown.

13. Click the ++ under Response, and drag the AstronautManagerAstronautManager  from the HierarchyHierarchy  into the None (Object)None (Object)

field.

14. Now, click the No FunctionNo Function dropdown, select AstronautManagerAstronautManager , then ResetModelCommandResetModelCommand.

https://www.youtube-nocookie.com/embed/dA11P4P0VO8
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 The End

Try it! Build and deploy the app to the HoloLens.

Say Expand ModelExpand Model  to see the expanded astronaut model.

Use NavigationNavigation to rotate individual pieces of the astronaut suit.

Say Move AstronautMove Astronaut and then use ManipulationManipulation to move individual pieces of the astronaut suit.

Say Rotate AstronautRotate Astronaut to rotate the pieces again.

Say Reset ModelReset Model  to return the astronaut to its original form.

Congratulations! You have now completed MR Input 211: GestureMR Input 211: Gesture.

You know how to detect and respond to hand tracking, navigation and manipulation events.

You understand the difference between Navigation and Manipulation gestures.

You know how to change the cursor to provide visual feedback for when a hand is detected, when a hand is

about to be lost, and for when an object supports different interactions (Navigation vs Manipulation).
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MR Input 212: Voice ✔️ ✔️

 Before you start
  PrerequisitesPrerequisites

The Mixed Reality Academy tutorials were designed with HoloLens (1st gen), Unity 2017, and Mixed Reality Immersive

Headsets in mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for

guidance in developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being

used for HoloLens 2 and may not be compatible with newer versions of Unity. They will be maintained to continue

working on the supported devices. A new series of tutorials has been posted for HoloLens 2.

Voice input gives us another way to interact with our holograms. Voice commands work in a very natural and

easy way. Design your voice commands so that they are:

Natural

Easy to remember

Context appropriate

Sufficiently distinct from other options within the same context

In MR Basics 101, we used the KeywordRecognizer to build two simple voice commands. In MR Input 212, we'll

dive deeper and learn how to:

Design voice commands that are optimized for the HoloLens speech engine.

Make the user aware of what voice commands are available.

Acknowledge that we've heard the user's voice command.

Understand what the user is saying, using a Dictation Recognizer.

Use a Grammar Recognizer to listen for commands based on an SRGS, or Speech Recognition Grammar

Specification, file.

In this course, we'll revisit Model Explorer, which we built in MR Input 210 and MR Input 211.

The videos embedded in each of the chapters below were recorded using an older version of Unity and the Mixed Reality

Toolkit. While the step-by-step instructions are accurate and current, you may see scripts and visuals in the corresponding

videos that are out-of-date. The videos remain included for posterity and because the concepts covered still apply.

A Windows 10 PC configured with the correct tools installed.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/holograms-212.md
https://docs.microsoft.com/en-us/windows/mixed-reality/develop/unity/tutorials/mrlearning-base
https://www.youtube-nocookie.com/embed/BYpYsVFYjdw
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


  Project filesProject files

NOTENOTE

  Errata and NotesErrata and Notes

 Unity Setup
  InstructionsInstructions

  BuildingBuilding

Some basic C# programming ability.

You should have completed MR Basics 101.

You should have completed MR Input 210.

You should have completed MR Input 211.

A HoloLens device configured for development.

Download the files required by the project. Requires Unity 2017.2 or later.

Un-archive the files to your desktop or other easy to reach location.

If you want to look through the source code before downloading, it's available on GitHub.

"Enable Just My Code" needs to be disabled (unchecked) in Visual Studio under Tools->Options->Debugging

in order to hit breakpoints in your code.

1. Start Unity.

2. Select OpenOpen.

3. Navigate to the HolographicAcademy-Holograms-212-VoiceHolographicAcademy-Holograms-212-Voice folder you previously un-archived.

4. Find and select the Star tingStar ting/Model ExplorerModel Explorer  folder.

5. Click the Select FolderSelect Folder  button.

6. In the ProjectProject panel, expand the ScenesScenes  folder.

7. Double-click ModelExplorerModelExplorer  scene to load it in Unity.

1. In Unity, select File > Build SettingsFile > Build Settings .

2. If Scenes/ModelExplorerScenes/ModelExplorer  is not listed in Scenes In BuildScenes In Build, click Add Open ScenesAdd Open Scenes  to add the scene.

3. If you're specifically developing for HoloLens, set Target deviceTarget device to HoloLensHoloLens . Otherwise, leave it on AnyAny

devicedevice.

4. Ensure Build TypeBuild Type is set to D3DD3D and SDKSDK is set to Latest installedLatest installed (which should be SDK 16299 or newer).

5. Click BuildBuild.

6. Create a New FolderNew Folder  named "App".

7. Single click the AppApp folder.

8. Press Select FolderSelect Folder  and Unity will start building the project for Visual Studio.

When Unity is done, a File Explorer window will appear.

1. Open the AppApp folder.

2. Open the ModelExplorer Visual Studio SolutionModelExplorer Visual Studio Solution.

If deploying to HoloLens:

1. Using the top toolbar in Visual Studio, change the target from Debug to ReleaseRelease and from ARM to x86x86 .

2. Click on the drop down arrow next to the Local Machine button, and select Remote MachineRemote Machine.

3. Enter your HoloLens device IP addressyour HoloLens device IP address  and set Authentication Mode to Universal (Unencr yptedUniversal (Unencr ypted

Protocol)Protocol) . Click SelectSelect. If you do not know your device IP address, look in Settings > Network &Settings > Network &

https://github.com/Microsoft/HolographicAcademy/archive/Holograms-212-Voice.zip
https://github.com/Microsoft/HolographicAcademy/tree/Holograms-212-Voice
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 Chapter 1 - Awareness

  ObjectivesObjectives

  Voice Command DesignVoice Command Design

  DODO

  DON'TDON'T

Internet > Advanced OptionsInternet > Advanced Options .

4. In the top menu bar, click Debug -> Star t Without debuggingDebug -> Star t Without debugging or press Ctr l + F5Ctr l + F5 . If this is the first time

deploying to your device, you will need to pair it with Visual Studio.

5. When the app has deployed, dismiss the FitboxFitbox with a select gestureselect gesture.

If deploying to an immersive headset:

1. Using the top toolbar in Visual Studio, change the target from Debug to ReleaseRelease and from ARM to x64x64 .

2. Make sure the deployment target is set to Local MachineLocal Machine.

3. In the top menu bar, click Debug -> Star t Without debuggingDebug -> Star t Without debugging or press Ctr l + F5Ctr l + F5 .

4. When the app has deployed, dismiss the FitboxFitbox by pulling the trigger on a motion controller.

You might notice some red errors in the Visual Studio Errors panel. It is safe to ignore them. Switch to the Output panel to

view actual build progress. Errors in the Output panel will require you to make a fix (most often they are caused by a

mistake in a script).

Learn the Dos and Don'tsDos and Don'ts  of voice command design.

Use KeywordRecognizerKeywordRecognizer  to add gaze based voice commands.

Make users aware of voice commands using cursor feedbackfeedback .

In this chapter, you'll learn about designing voice commands. When creating voice commands:

Create concise commands. You don't want to use "Play the currently selected video", because that command

is not concise and would easily be forgotten by the user. Instead, you should use: "Play Video", because it is

concise and has multiple syllables.

Use a simple vocabulary. Always try to use common words and phrases that are easy for the user to discover

and remember. For example, if your application had a note object that could be displayed or hidden from

view, you would not use the command "Show Placard", because "placard" is a rarely used term. Instead, you

would use the command: "Show Note", to reveal the note in your application.

Be consistent. Voice commands should be kept consistent across your application. Imagine that you have two

scenes in your application and both scenes contain a button for closing the application. If the first scene used

the command "Exit" to trigger the button, but the second scene used the command "Close App", then the

user is going to get very confused. If the same functionality persists across multiple scenes, then the same

voice command should be used to trigger it.

Use single syllable commands. As an example, if you were creating a voice command to play a video, you

should avoid using the simple command "Play", as it is only a single syllable and could easily be missed by

the system. Instead, you should use: "Play Video", because it is concise and has multiple syllables.

Use system commands. The "Select" command is reserved by the system to trigger a Tap event for the

currently focused object. Do not re-use the "Select" command in a keyword or phrase, as it might not work as

you expect. For example, if the voice command for selecting a cube in your application was "Select cube", but

the user was looking at a sphere when they uttered the command, then the sphere would be selected instead.

Similarly app bar commands are voice enabled. Don't use the following speech commands in your

https://www.youtube-nocookie.com/embed/fDwijJWuEc0
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 Chapter 2 - Acknowledgement

  ObjectivesObjectives

CoreWindow View:

Use similar sounds. Try to avoid using voice commands that rhyme. If you had a shopping application which

supported "Show Store" and "Show More" as voice commands, then you would want to disable one of the

commands while the other was in use. For example, you could use the "Show Store" button to open the store,

and then disable that command when the store was displayed so that the "Show More" command could be

used for browsing.

1. Go Back

2. Scroll Tool

3. Zoom Tool

4. Drag Tool

5. Adjust

6. Remove

In Unity's HierarchyHierarchy  panel, use the search tool to find the holoComm_screen_meshholoComm_screen_mesh object.

Double-click on the holoComm_screen_meshholoComm_screen_mesh object to view it in the SceneScene. This is the astronaut's watch,

which will respond to our voice commands.

In the InspectorInspector  panel, locate the Speech Input Source (Scr ipt)Speech Input Source (Scr ipt)  component.

Expand the KeywordsKeywords  section to see the supported voice command: Open CommunicatorOpen Communicator .

Click the cog to the right side, then select Edit Scr iptEdit Scr ipt.

Explore SpeechInputSource.csSpeechInputSource.cs  to understand how it uses the KeywordRecognizerKeywordRecognizer  to add voice

commands.

In Unity, use File > Build SettingsFile > Build Settings  to rebuild the application.

Open the AppApp folder.

Open the ModelExplorer Visual Studio SolutionModelExplorer Visual Studio Solution.

(If you already built/deployed this project in Visual Studio during set-up, then you can open that instance of VS

and click 'Reload All' when prompted).

In Visual Studio, click Debug -> Star t Without debuggingDebug -> Star t Without debugging or press Ctr l + F5Ctr l + F5 .

After the application deploys to the HoloLens, dismiss the fit box using the air-tap gesture.

Gaze at the astronaut's watch.

When the watch has focus, verify that the cursor changes to a microphone. This provides feedback that the

application is listening for voice commands.

Verify that a tooltip appears on the watch. This helps users discover the "Open Communicator" command.

While gazing at the watch, say "Open Communicator" to open the communicator panel.

Record a message using the Microphone input.

Give feedback to the user that the application is listening to their voice.

https://www.youtube-nocookie.com/embed/87ViteoPpyU
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// TODO: 2.a Delete the following two lines:
RecordButton.SetActive(false);
MessageUIRenderer.gameObject.SetActive(false);

  Build and DeployBuild and Deploy

 Chapter 3 - Understanding and the Dictation Recognizer

  ObjectivesObjectives

The MicrophoneMicrophone capability must be declared for an app to record from the microphone. This is done for you already in

MR Input 212, but keep this in mind for your own projects.

1. In the Unity Editor, go to the player settings by navigating to "Edit > Project Settings > Player"

2. Click on the "Universal Windows Platform" tab

3. In the "Publishing Settings > Capabilities" section, check the MicrophoneMicrophone capability

In Unity's HierarchyHierarchy  panel, verify that the holoComm_screen_meshholoComm_screen_mesh object is selected.

In the InspectorInspector  panel, find the Astronaut Watch (Scr ipt)Astronaut Watch (Scr ipt)  component.

Click on the small, blue cube which is set as the value of the Communicator PrefabCommunicator Prefab property.

In the ProjectProject panel, the CommunicatorCommunicator  prefab should now have focus.

Click on the CommunicatorCommunicator  prefab in the ProjectProject panel to view its components in the InspectorInspector .

Look at the Microphone Manager (Scr ipt)Microphone Manager (Scr ipt)  component, this will allow us to record the user's voice.

Notice that the CommunicatorCommunicator  object has a Speech Input Handler (Scr ipt)Speech Input Handler (Scr ipt)  component for responding to

the Send MessageSend Message command.

Look at the Communicator (Scr ipt)Communicator (Scr ipt)  component and double-click on the script to open it in Visual Studio.

Communicator.cs is responsible for setting the proper button states on the communicator device. This will allow

our users to record a message, play it back, and send the message to the astronaut. It will also start and stop an

animated wave form, to acknowledge to the user that their voice was heard.

In Communicator.csCommunicator.cs , delete the following lines (81 and 82) from the Star tStar t method. This will enable the

'Record' button on the communicator.

In Visual Studio, rebuild your application and deploy to the device.

Gaze at the astronaut's watch and say "Open Communicator" to show the communicator.

Press the RecordRecord button (microphone) to start recording a verbal message for the astronaut.

Start speaking, and verify that the wave animation plays on the communicator, which provides feedback to

the user that their voice is heard.

Press the StopStop button (left square), and verify that the wave animation stops running.

Press the PlayPlay  button (right triangle) to play back the recorded message and hear it on the device.

Press the StopStop button (right square) to stop playback of the recorded message.

Say "Send Message" to close the communicator and receive a 'Message Received' response from the

astronaut.

Use the Dictation Recognizer to convert the user's speech to text.

Show the Dictation Recognizer's hypothesized and final results in the communicator.

https://www.youtube-nocookie.com/embed/TIMddr-HqEU
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// Copyright (c) Microsoft Corporation. All rights reserved.
// Licensed under the MIT License. See LICENSE in the project root for license information.

using System.Collections;
using System.Text;
using UnityEngine;
using UnityEngine.UI;
using UnityEngine.Windows.Speech;

namespace Academy
{
    public class MicrophoneManager : MonoBehaviour
    {
        [Tooltip("A text area for the recognizer to display the recognized strings.")]
        [SerializeField]
        private Text dictationDisplay;

        private DictationRecognizer dictationRecognizer;

        // Use this string to cache the text currently displayed in the text box.
        private StringBuilder textSoFar;

        // Using an empty string specifies the default microphone.
        private static string deviceName = string.Empty;
        private int samplingRate;
        private const int messageLength = 10;

        // Use this to reset the UI once the Microphone is done recording after it was started.

In this chapter, we'll use the Dictation Recognizer to create a message for the astronaut. When using the

Dictation Recognizer, keep in mind that:

You must be connected to WiFi for the Dictation Recognizer to work.

Timeouts occur after a set period of time. There are two timeouts to be aware of:

Only one type of recognizer (Keyword or Dictation) can run at a time.

If the recognizer starts and doesn't hear any audio for the first five seconds, it will timeout.

If the recognizer has given a result but then hears silence for twenty seconds, it will timeout.

The MicrophoneMicrophone capability must be declared for an app to record from the microphone. This is done for you already in

MR Input 212, but keep this in mind for your own projects.

1. In the Unity Editor, go to the player settings by navigating to "Edit > Project Settings > Player"

2. Click on the "Universal Windows Platform" tab

3. In the "Publishing Settings > Capabilities" section, check the MicrophoneMicrophone capability

We're going to edit MicrophoneManager.csMicrophoneManager.cs  to use the Dictation Recognizer. This is what we'll add:

1. When the Record buttonRecord button is pressed, we'll star t the DictationRecognizerstar t the DictationRecognizer .

2. Show the hypothesishypothesis  of what the DictationRecognizer understood.

3. Lock in the resultsresults  of what the DictationRecognizer understood.

4. Check for timeouts from the DictationRecognizer.

5. When the Stop buttonStop button is pressed, or the mic session times out, stop the DictationRecognizerstop the DictationRecognizer .

6. Restart the KeywordRecognizerKeywordRecognizer , which will listen for the Send MessageSend Message command.

Let's get started. Complete all coding exercises for 3.a in MicrophoneManager.csMicrophoneManager.cs , or copy and paste the

finished code found below:



        private bool hasRecordingStarted;

        void Awake()
        {
            /* TODO: DEVELOPER CODING EXERCISE 3.a */

            // 3.a: Create a new DictationRecognizer and assign it to dictationRecognizer variable.
            dictationRecognizer = new DictationRecognizer();

            // 3.a: Register for dictationRecognizer.DictationHypothesis and implement DictationHypothesis 
below
            // This event is fired while the user is talking. As the recognizer listens, it provides text of 
what it's heard so far.
            dictationRecognizer.DictationHypothesis += DictationRecognizer_DictationHypothesis;

            // 3.a: Register for dictationRecognizer.DictationResult and implement DictationResult below
            // This event is fired after the user pauses, typically at the end of a sentence. The full 
recognized string is returned here.
            dictationRecognizer.DictationResult += DictationRecognizer_DictationResult;

            // 3.a: Register for dictationRecognizer.DictationComplete and implement DictationComplete below
            // This event is fired when the recognizer stops, whether from Stop() being called, a timeout 
occurring, or some other error.
            dictationRecognizer.DictationComplete += DictationRecognizer_DictationComplete;

            // 3.a: Register for dictationRecognizer.DictationError and implement DictationError below
            // This event is fired when an error occurs.
            dictationRecognizer.DictationError += DictationRecognizer_DictationError;

            // Query the maximum frequency of the default microphone. Use 'unused' to ignore the minimum 
frequency.
            int unused;
            Microphone.GetDeviceCaps(deviceName, out unused, out samplingRate);

            // Use this string to cache the text currently displayed in the text box.
            textSoFar = new StringBuilder();

            // Use this to reset the UI once the Microphone is done recording after it was started.
            hasRecordingStarted = false;
        }

        void Update()
        {
            // 3.a: Add condition to check if dictationRecognizer.Status is Running
            if (hasRecordingStarted && !Microphone.IsRecording(deviceName) && dictationRecognizer.Status == 
SpeechSystemStatus.Running)
            {
                // Reset the flag now that we're cleaning up the UI.
                hasRecordingStarted = false;

                // This acts like pressing the Stop button and sends the message to the Communicator.
                // If the microphone stops as a result of timing out, make sure to manually stop the 
dictation recognizer.
                // Look at the StopRecording function.
                SendMessage("RecordStop");
            }
        }

        /// <summary>
        /// Turns on the dictation recognizer and begins recording audio from the default microphone.
        /// </summary>
        /// <returns>The audio clip recorded from the microphone.</returns>
        public AudioClip StartRecording()
        {
            // 3.a Shutdown the PhraseRecognitionSystem. This controls the KeywordRecognizers
            PhraseRecognitionSystem.Shutdown();

            // 3.a: Start dictationRecognizer
            dictationRecognizer.Start();



            // 3.a Uncomment this line
            dictationDisplay.text = "Dictation is starting. It may take time to display your text the first 
time, but begin speaking now...";

            // Set the flag that we've started recording.
            hasRecordingStarted = true;

            // Start recording from the microphone for 10 seconds.
            return Microphone.Start(deviceName, false, messageLength, samplingRate);
        }

        /// <summary>
        /// Ends the recording session.
        /// </summary>
        public void StopRecording()
        {
            // 3.a: Check if dictationRecognizer.Status is Running and stop it if so
            if (dictationRecognizer.Status == SpeechSystemStatus.Running)
            {
                dictationRecognizer.Stop();
            }

            Microphone.End(deviceName);
        }

        /// <summary>
        /// This event is fired while the user is talking. As the recognizer listens, it provides text of 
what it's heard so far.
        /// </summary>
        /// <param name="text">The currently hypothesized recognition.</param>
        private void DictationRecognizer_DictationHypothesis(string text)
        {
            // 3.a: Set DictationDisplay text to be textSoFar and new hypothesized text
            // We don't want to append to textSoFar yet, because the hypothesis may have changed on the next 
event
            dictationDisplay.text = textSoFar.ToString() + " " + text + "...";
        }

        /// <summary>
        /// This event is fired after the user pauses, typically at the end of a sentence. The full 
recognized string is returned here.
        /// </summary>
        /// <param name="text">The text that was heard by the recognizer.</param>
        /// <param name="confidence">A representation of how confident (rejected, low, medium, high) the 
recognizer is of this recognition.</param>
        private void DictationRecognizer_DictationResult(string text, ConfidenceLevel confidence)
        {
            // 3.a: Append textSoFar with latest text
            textSoFar.Append(text + ". ");

            // 3.a: Set DictationDisplay text to be textSoFar
            dictationDisplay.text = textSoFar.ToString();
        }

        /// <summary>
        /// This event is fired when the recognizer stops, whether from Stop() being called, a timeout 
occurring, or some other error.
        /// Typically, this will simply return "Complete". In this case, we check to see if the recognizer 
timed out.
        /// </summary>
        /// <param name="cause">An enumerated reason for the session completing.</param>
        private void DictationRecognizer_DictationComplete(DictationCompletionCause cause)
        {
            // If Timeout occurs, the user has been silent for too long.
            // With dictation, the default timeout after a recognition is 20 seconds.
            // The default timeout with initial silence is 5 seconds.
            if (cause == DictationCompletionCause.TimeoutExceeded)
            {



            {
                Microphone.End(deviceName);

                dictationDisplay.text = "Dictation has timed out. Please press the record button again.";
                SendMessage("ResetAfterTimeout");
            }
        }

        /// <summary>
        /// This event is fired when an error occurs.
        /// </summary>
        /// <param name="error">The string representation of the error reason.</param>
        /// <param name="hresult">The int representation of the hresult.</param>
        private void DictationRecognizer_DictationError(string error, int hresult)
        {
            // 3.a: Set DictationDisplay text to be the error string
            dictationDisplay.text = error + "\nHRESULT: " + hresult;
        }

        /// <summary>
        /// The dictation recognizer may not turn off immediately, so this call blocks on
        /// the recognizer reporting that it has actually stopped.
        /// </summary>
        public IEnumerator WaitForDictationToStop()
        {
            while (dictationRecognizer != null && dictationRecognizer.Status == SpeechSystemStatus.Running)
            {
                yield return null;
            }
        }
    }
}

  Build and DeployBuild and Deploy

 Chapter 4 - Grammar Recognizer

  ObjectivesObjectives

Rebuild in Visual Studio and deploy to your device.

Dismiss the fit box with an air-tap gesture.

Gaze at the astronaut's watch and say "Open Communicator".

Select the RecordRecord button (microphone) to record your message.

Start speaking. The Dictation RecognizerDictation Recognizer  will interpret your speech and show the hypothesized text in the

communicator.

Try saying "Send Message" while you are recording a message. Notice that the Keyword RecognizerKeyword Recognizer  does

not respond because the Dictation RecognizerDictation Recognizer  is still active.

Stop speaking for a few seconds. Watch as the Dictation Recognizer completes its hypothesis and shows the

final result.

Begin speaking and then pause for 20 seconds. This will cause the Dictation RecognizerDictation Recognizer  to timeout.

Notice that the Keyword RecognizerKeyword Recognizer  is re-enabled after the above timeout. The communicator will now

respond to voice commands.

Say "Send Message" to send the message to the astronaut.

Use the Grammar Recognizer to recognize the user's speech according to an SRGS, or Speech Recognition

Grammar Specification, file.

https://www.youtube-nocookie.com/embed/J2dYJNSvv18
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 The End

The MicrophoneMicrophone capability must be declared for an app to record from the microphone. This is done for you already in

MR Input 212, but keep this in mind for your own projects.

1. In the Unity Editor, go to the player settings by navigating to "Edit > Project Settings > Player"

2. Click on the "Universal Windows Platform" tab

3. In the "Publishing Settings > Capabilities" section, check the MicrophoneMicrophone capability

1. In the HierarchyHierarchy  panel, search for Jetpack_CenterJetpack_Center  and select it.

2. Look for the Tagalong ActionTagalong Action script in the InspectorInspector  panel.

3. Click the little circle to the right of the Object To Tag AlongObject To Tag Along field.

4. In the window that pops up, search for SRGSToolboxSRGSToolbox and select it from the list.

5. Take a look at the SRGSColor.xmlSRGSColor.xml  file in the StreamingAssetsStreamingAssets  folder.

a. The SRGS design spec can be found on the W3C website here.

In our SRGS file, we have three types of rules:

A rule which lets you say one color from a list of twelve colors.

Three rules which listen for a combination of the color rule and one of the three shapes.

The root rule, colorChooser, which listens for any combination of the three "color + shape" rules. The shapes

can be said in any order and in any amount from just one to all three. This is the only rule that is listened for,

as it's specified as the root rule at the top of the file in the initial <grammar> tag.

Rebuild the application in Unity, then build and deploy from Visual Studio to experience the app on HoloLens.

Dismiss the fit box with an air-tap gesture.

Gaze at the astronaut's jetpack and perform an air-tap gesture.

Start speaking. The Grammar RecognizerGrammar Recognizer  will interpret your speech and change the colors of the shapes

based on the recognition. An example command is "blue circle, yellow square".

Perform another air-tap gesture to dismiss the toolbox.

Congratulations! You have now completed MR Input 212: VoiceMR Input 212: Voice.

You know the Dos and Don'ts of voice commands.

You saw how tooltips were employed to make users aware of voice commands.

You saw several types of feedback used to acknowledge that the user's voice was heard.

You know how to switch between the Keyword Recognizer and the Dictation Recognizer, and how these two

features understand and interpret your voice.

You learned how to use an SRGS file and the Grammar Recognizer for speech recognition in your application.

https://www.w3.org/TR/speech-grammar/
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IMPORTANTIMPORTANT

 Device support

C O URSEC O URSE H O LO L EN SH O LO L EN S IM M ERSIVE  H EA DSET SIM M ERSIVE  H EA DSET S

MR Spatial 220: Spatial sound ✔️ ✔️

 Before you start
  PrerequisitesPrerequisites

  Project filesProject files

The Mixed Reality Academy tutorials were designed with HoloLens (1st gen), Unity 2017, and Mixed Reality Immersive

Headsets in mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for

guidance in developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being

used for HoloLens 2 and may not be compatible with newer versions of Unity. They will be maintained to continue

working on the supported devices. A new series of tutorials has been posted for HoloLens 2.

Spatial sound breathes life into holograms and gives them presence in our world. Holograms are composed of

both light and sound, and if you happen to lose sight of your holograms, spatial sound can help you find them.

Spatial sound is not like the typical sound that you would hear on the radio, it is sound that is positioned in 3D

space. With spatial sound, you can make holograms sound like they're behind you, next to you, or even on your

head! In this course, you will:

Configure your development environment to use Microsoft Spatial Sound.

Use Spatial Sound to enhance interactions.

Use Spatial Sound in conjunction with Spatial Mapping.

Understand sound design and mixing best practices.

Use sound to enhance special effects and bring the user into the Mixed Reality world.

A Windows 10 PC configured with the correct tools installed.

Some basic C# programming ability.

You should have completed MR Basics 101.

A HoloLens device configured for development.

Download the files required by the project. Requires Unity 2017.2 or later.

Un-archive the files to your desktop or other easy to reach location.

If you still need Unity 5.6 support, please use this release. This release may no longer be up-to-date.

If you still need Unity 5.5 support, please use this release. This release may no longer be up-to-date.

If you still need Unity 5.4 support, please use this release. This release may no longer be up-to-date.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/holograms-220.md
https://docs.microsoft.com/en-us/windows/mixed-reality/develop/unity/tutorials/mrlearning-base
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://github.com/Microsoft/HolographicAcademy/archive/Holograms-220-SpatialSound.zip
https://github.com/Microsoft/HolographicAcademy/archive/v1.5.6-220.zip
https://github.com/Microsoft/HolographicAcademy/archive/v1.5.5-220.zip
https://github.com/Microsoft/HolographicAcademy/archive/v1.5.4-220.zip
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 Chapter 1 - Unity Setup
  ObjectivesObjectives

  InstructionsInstructions

If you want to look through the source code before downloading, it's available on GitHub.

"Enable Just My Code" needs to be disabled (unchecked) in Visual Studio under Tools->Options->Debugging

in order to hit breakpoints in your code.

Change Unity's sound configuration to use Microsoft Spatial Sound.

Add 3D sound to an object in Unity.

Start Unity.

Select OpenOpen.

Navigate to your Desktop and find the folder you previously un-archived.

Click on the Star ting\DecibelStar ting\Decibel  folder and then press the Select FolderSelect Folder  button.

Wait for the project to load in Unity.

In the ProjectProject panel, open Scenes\Decibel.unityScenes\Decibel.unity .

In the HierarchyHierarchy  panel, expand HologramCollectionHologramCollection and select P0LYP0LY .

In the Inspector, expand AudioSourceAudioSource and notice that there is no SpatializeSpatialize check box.

By default, Unity does not load a spatializer plugin. The following steps will enable Spatial Sound in the project.

In Unity's top menu, go to Edit > Project Settings > AudioEdit > Project Settings > Audio.

Find the Spatializer PluginSpatializer Plugin dropdown, and select MS HRTF SpatializerMS HRTF Spatializer .

In the HierarchyHierarchy  panel, select HologramCollection > P0LYHologramCollection > P0LY .

In the InspectorInspector  panel, find the Audio SourceAudio Source component.

Check the SpatializeSpatialize checkbox.

Drag the Spatial BlendSpatial Blend slider all the way to 3D3D, or enter 11  in the edit box.

We will now build the project in Unity and configure the solution in Visual Studio.

1. In Unity, select File > Build SettingsFile > Build Settings .

2. Click Add Open ScenesAdd Open Scenes  to add the scene.

3. Select Universal Windows PlatformUniversal Windows Platform in the PlatformPlatform list and click Switch PlatformSwitch Platform .

4. If you're specifically developing for HoloLens, set Target deviceTarget device to HoloLensHoloLens . Otherwise, leave it on AnyAny

devicedevice.

5. Ensure Build TypeBuild Type is set to D3DD3D and SDKSDK is set to Latest installedLatest installed (which should be SDK 16299 or newer).

6. Click BuildBuild.

7. Create a New FolderNew Folder  named "App".

8. Single click the AppApp folder.

9. Press Select FolderSelect Folder .

When Unity is done, a File Explorer window will appear.

1. Open the AppApp folder.

2. Open the Decibel Visual Studio SolutionDecibel Visual Studio Solution.

https://github.com/Microsoft/HolographicAcademy/tree/Holograms-220-SpatialSound


 Chapter 2 - Spatial Sound and Interaction
  ObjectivesObjectives

  Part 1 - Enhancing RealismPart 1 - Enhancing Realism
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  InstructionsInstructions

  Part 2 - Directing the User's GazePart 2 - Directing the User's Gaze
  Key ConceptsKey Concepts

If deploying to HoloLens:

1. Using the top toolbar in Visual Studio, change the target from Debug to ReleaseRelease and from ARM to x86x86 .

2. Click on the drop down arrow next to the Local Machine button, and select Remote MachineRemote Machine.

3. Enter your HoloLens device IP addressyour HoloLens device IP address  and set Authentication Mode to Universal (Unencr yptedUniversal (Unencr ypted

Protocol)Protocol) . Click SelectSelect. If you do not know your device IP address, look in Settings > Network &Settings > Network &

Internet > Advanced OptionsInternet > Advanced Options .

4. In the top menu bar, click Debug -> Star t Without debuggingDebug -> Star t Without debugging or press Ctr l + F5Ctr l + F5 . If this is the first time

deploying to your device, you will need to pair it with Visual Studio.

If deploying to an immersive headset:

1. Using the top toolbar in Visual Studio, change the target from Debug to ReleaseRelease and from ARM to x64x64 .

2. Make sure the deployment target is set to Local MachineLocal Machine.

3. In the top menu bar, click Debug -> Star t Without debuggingDebug -> Star t Without debugging or press Ctr l + F5Ctr l + F5 .

Enhance hologram realism using sound.

Direct the user's gaze using sound.

Provide gesture feedback using sound.

Spatialize hologram sounds.

Sound sources should be placed at an appropriate location on the hologram.

The appropriate location for the sound is going to depend on the hologram. For example, if the hologram is of a

human, the sound source should be located near the mouth and not the feet.

The following instructions will attach a spatialized sound to a hologram.

In the HierarchyHierarchy  panel, expand HologramCollectionHologramCollection and select P0LYP0LY .

In the InspectorInspector  panel, in the AudioSourceAudioSource, click the circle next to AudioClipAudioClip and select PolyHoverPolyHover  from

the pop-up.

Click the circle next to OutputOutput and select SoundEffectsSoundEffects  from the pop-up.

Project Decibel uses a Unity AudioMixerAudioMixer  component to enable adjusting sound levels for groups of sounds. By

grouping sounds this way, the overall volume can be adjusted while maintaining the relative volume of each

sound.

In the AudioSourceAudioSource, expand 3D Sound Settings3D Sound Settings .

Set Doppler LevelDoppler Level  to 00 .

Setting Doppler level to zero disables changes in pitch caused by motion (either of the hologram or the user). A

classic example of Doppler is a fast-moving car. As the car approaches a stationary listener, the pitch of the

engine rises. When it passes the listener, the pitch lowers with distance.

Use sound to call attention to important holograms.

The ears help direct where the eyes should look.

The brain has some learned expectations.
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  Part 3 - Gesture FeedbackPart 3 - Gesture Feedback
  Key ConceptsKey Concepts

  InstructionsInstructions

  Build and DeployBuild and Deploy

One example of learned expectations is that birds are generally above the heads of humans. If a user hears a

bird sound, their initial reaction is to look up. Placing a bird below the user can lead to them facing the correct

direction of the sound, but being unable to find the hologram based on the expectation of needing to look up.

The following instructions enable P0LY to hide behind you, so that you can use sound to locate the hologram.

In the HierarchyHierarchy  panel, select ManagersManagers .

In the InspectorInspector  panel, find Speech Input HandlerSpeech Input Handler .

In Speech Input HandlerSpeech Input Handler , expand Go HideGo Hide.

Change No FunctionNo Function to PolyActions.GoHidePolyActions.GoHide.

Provide the user with positive gesture confirmation using sound

Do not overwhelm the user - overly loud sounds get in the way

Subtle sounds work best - do not overshadow the experience

In the HierarchyHierarchy  panel, expand HologramCollectionHologramCollection.

Expand EnergyHubEnergyHub and select BaseBase.

In the InspectorInspector  panel, click Add ComponentAdd Component and add Gesture Sound HandlerGesture Sound Handler .

In Gesture Sound HandlerGesture Sound Handler , click the circle next to Navigation Star ted ClipNavigation Star ted Clip and Navigation UpdatedNavigation Updated

ClipClip and select RotateClickRotateClick  from the pop-up for both.

Double click on "GestureSoundHandler" to load in Visual Studio.

Gesture Sound Handler performs the following tasks:

Create and configure an AudioSourceAudioSource.

Place the AudioSourceAudioSource at the location of the appropriate GameObjectGameObject.

Plays the AudioClipAudioClip associated with the gesture.

1. In Unity, select File > Build SettingsFile > Build Settings .

2. Click BuildBuild.

3. Single click the AppApp folder.

4. Press Select FolderSelect Folder .

Check that the Toolbar says "Release", "x86" or "x64", and "Remote Device". If not, this is the coding instance of

Visual Studio. You may need to re-open the solution from the App folder.

If prompted, reload the project files.

As before, deploy from Visual Studio.

After the application is deployed:

Observe how the sound changes as you move around P0LY.

Say "Go Hide" to make P0LY move to a location behind you. Find it by the sound.

Gaze at the base of the Energy Hub. Tap and drag left or right to rotate the hologram and notice how the



 Chapter 3 - Spatial Sound and Spatial Mapping
  ObjectivesObjectives

  Part 1 - Physical World InteractionPart 1 - Physical World Interaction
  Key ConceptsKey Concepts

  InstructionsInstructions

  Part 2 - Sound OcclusionPart 2 - Sound Occlusion
  Key ConceptsKey Concepts

clicking sound confirms the gesture.

Note: There is a text panel that will tag-along with you. This will contain the available voice commands that you

can use throughout this course.

Confirm interaction between holograms and the real world using sound.

Occlude sound using the physical world.

Physical objects generally make a sound when encountering a surface or another object.

Sounds should be context appropriate within the experience.

For example, setting a cup on a table should make a quieter sound than dropping a boulder on a piece of metal.

In the HierarchyHierarchy  panel, expand HologramCollectionHologramCollection.

Expand EnergyHubEnergyHub, select BaseBase.

In the InspectorInspector  panel, click Add ComponentAdd Component and add Tap To Place With Sound and ActionTap To Place With Sound and Action.

In Tap To Place With Sound and ActionTap To Place With Sound and Action:

Check Place Parent On TapPlace Parent On Tap.

Set Placement SoundPlacement Sound to PlacePlace.

Set Pickup SoundPickup Sound to PickupPickup.

Press the + in the bottom right under both On Pickup ActionOn Pickup Action and On Placement ActionOn Placement Action. Drag

EnergyHub from the scene into the None (Object)None (Object)  fields.

Under On Pickup ActionOn Pickup Action, click on No FunctionNo Function -> EnergyHubBaseEnergyHubBase -> ResetAnimationResetAnimation.

Under On Placement ActionOn Placement Action, click on No FunctionNo Function -> EnergyHubBaseEnergyHubBase -> OnSelectOnSelect.

Sound, like light, can be occluded.

A classic example is a concert hall. When a listener is standing outside of the hall and the door is closed, the

music sounds muffled. There is also typically a reduction in volume. When the door is opened, the full spectrum

of the sound is heard at the actual volume. High frequency sounds are generally absorbed more than low



  InstructionsInstructions

frequencies.

In the HierarchyHierarchy  panel, expand HologramCollectionHologramCollection and select P0LYP0LY .

In the InspectorInspector  panel, click Add ComponentAdd Component and add Audio EmitterAudio Emitter .

The Audio Emitter class provides the following features:

Restores any changes to the volume of the AudioSourceAudioSource.

Performs a Physics.RaycastNonAllocPhysics.RaycastNonAlloc from the user's position in the direction of the GameObjectGameObject to

which the AudioEmitterAudioEmitter  is attached.

The RaycastNonAlloc method is used as a performance optimization to limit allocations as well as the number of

results returned.

For each IAudioInfluencerIAudioInfluencer  encountered, calls the ApplyEffectApplyEffect method.

For each previous IAudioInfluencerIAudioInfluencer  that is no longer encountered, call the RemoveEffectRemoveEffect method.

Note that AudioEmitter updates on human time scales, as opposed to on a per frame basis. This is done because

humans generally do not move fast enough for the effect to need to be updated more frequently than every

quarter or half of a second. Holograms that teleport rapidly from one location to another can break the illusion.

In the HierarchyHierarchy  panel, expand HologramCollectionHologramCollection.

Expand EnergyHubEnergyHub and select BlobOutsideBlobOutside.

In the InspectorInspector  panel, click Add ComponentAdd Component and add Audio OccluderAudio Occluder .

In Audio OccluderAudio Occluder , set Cutoff FrequencyCutoff Frequency  to 15001500 .

This setting limits the AudioSource frequencies to 1500 Hz and below.

Set Volume Pass ThroughVolume Pass Through to 0.90.9 .

This setting reduces the volume of the AudioSource to 90% of it's current level.

Audio Occluder implements IAudioInfluencer to:

Apply an occlusion effect using an AudioLowPassFilterAudioLowPassFilter  which gets attached to the AudioSourceAudioSource managed

buy the AudioEmitterAudioEmitter .

Applies volume attenuation to the AudioSource.

Disables the effect by setting a neutral cutoff frequency and disabling the filter.

The frequency used as neutral is 22 kHz (22000 Hz). This frequency was chosen due to it being above the

nominal maximum frequency that can be heard by the human ear, this making no discernable impact to the

sound.

In the HierarchyHierarchy  panel, select SpatialMappingSpatialMapping.

In the InspectorInspector  panel, click Add ComponentAdd Component and add Audio OccluderAudio Occluder .

In Audio OccluderAudio Occluder , set Cutoff FrequencyCutoff Frequency  to 750750 .

When multiple occluders are in the path between the user and the AudioEmitterAudioEmitter , the lowest frequency is

applied to the filter.

Set Volume Pass ThroughVolume Pass Through to 0.750.75 .

When multiple occluders are in the path between the user and the AudioEmitterAudioEmitter , the volume pass through is

applied additively.

In the HierarchyHierarchy  panel, select ManagersManagers .

In the InspectorInspector  panel, expand Speech Input HandlerSpeech Input Handler .
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  Normalize all soundsNormalize all sounds

  Design for an untethered experienceDesign for an untethered experience

In Speech Input HandlerSpeech Input Handler , expand Go ChargeGo Charge.

Change No FunctionNo Function to PolyActions.GoChargePolyActions.GoCharge.

Expand Come HereCome Here.

Change No FunctionNo Function to PolyActions.ComeBackPolyActions.ComeBack .

As before, build the project in Unity and deploy in Visual Studio.

After the application is deployed:

Say "Go Charge" to have P0LY enter the Energy Hub.

Note the change in the sound. It should sound muffled and a little quieter. If you are able to position yourself

with a wall or other object between you and the Energy Hub, you should notice a further muffling of the sound

due to the occlusion by the real world.

Say "Come Here" to have P0LY leave the Energy Hub and position itself in front of you.

Note that the sound occlusion is removed once P0LY exits the Energy Hub. If you are still hearing occlusion,

P0LY may be occluded by the real world. Try moving to ensure you have a clear line of sight to P0LY.

The size of the space provides subliminal queues that contribute to sound localization.

Room models are set per-AudioSourceAudioSource.

The MixedRealityToolkit for Unity provides code for setting the room model.

For Mixed Reality experiences, select the room model that best fits the real world space.

If you are creating a Virtual Reality scenario, select the room model that best fits the virtual environment.

Understand considerations for effective sound design.

Learn mixing techniques and guidelines.

This section discusses key sound and experience design considerations and guidelines.

This avoids the need for special case code to adjust volume levels per sound, which can be time consuming and

limits the ability to easily update sound files.

https://github.com/Microsoft/MixedRealityToolkit-Unity


  Emit sound from logical locations on your hologramsEmit sound from logical locations on your holograms

  Familiar sounds are most localizableFamiliar sounds are most localizable

  Be cognizant of user expectationsBe cognizant of user expectations

  Avoid hidden emittersAvoid hidden emitters

  Part 2 - Sound MixingPart 2 - Sound Mixing
  Target your mix for 70% volume on the HoloLensTarget your mix for 70% volume on the HoloLens

  HoloLens at 100% volume should drown out external soundsHoloLens at 100% volume should drown out external sounds

  Use the Unity AudioMixer to adjust categories of soundsUse the Unity AudioMixer to adjust categories of sounds

  Mix sounds based on the user's gazeMix sounds based on the user's gaze

  Building your mixBuilding your mix

HoloLens is a fully contained, untethered holographic computer. Your users can and will use your experiences

while moving. Be sure to test your audio mix by walking around.

In the real world, a dog does not bark from its tail and a human's voice does not come from his/her feet. Avoid

having your sounds emit from unexpected portions of your holograms.

For small holograms, it is reasonable to have sound emit from the center of the geometry.

The human voice and music are very easy to localize. If someone calls your name, you are able to very

accurately determine from what direction the voice came and from how far away. Short, unfamiliar sounds are

harder to localize.

Life experience plays a part in our ability to identify the location of a sound. This is one reason why the human

voice is particularly easy to localize. It is important to be aware of your user's learned expectations when placing

your sounds.

For example, when someone hears a bird song they generally look up, as birds tend to be above the line of sight

(flying or in a tree). It is not uncommon for a user to turn in the correct direction of a sound, but look in the

wrong vertical direction and become confused or frustrated when they are unable to find the hologram.

In the real world, if we hear a sound, we can generally identify the object that is emitting the sound. This should

also hold true in your experiences. It can be very disconcerting for users to hear a sound, know from where the

sound originates and be unable to see an object.

There are some exceptions to this guideline. For example, ambient sounds such as crickets in a field need not be

visible. Life experience gives us familiarity with the source of these sounds without the need to see it.

Mixed Reality experiences allow holograms to be seen in the real world. They should also allow real world

sounds to be heard. A 70% volume target enables the user to hear the world around them along with the sound

of your experience.

A volume level of 100% is akin to a Virtual Reality experience. Visually, the user is transported to a different

world. The same should hold true audibly.

When designing your mix, it is often helpful to create sound categories and have the ability to increase or

decrease their volume as a unit. This retains the relative levels of each sound while enabling quick and easy

changes to the overall mix. Common categories include; sound effects, ambience, voice overs and background

music.

It can often be useful to change the sound mix in your experience based on where a user is (or is not) looking.

One common use for this technique are to reduce the volume level for holograms that are outside of the

Holographic Frame to make it easier for the user to focus on the information in front of them. Another use is to

increase the volume of a sound to draw the user's attention to an important event.

When building your mix, it is recommended to start with your experience's background audio and add layers

based on importance. Often, this results in each layer being louder than the previous.

Imagining your mix as an inverted funnel, with the least important (and generally quietest sounds) at the

bottom, it is recommended to structure your mix similar to the following diagram.



  Part 3 -PerformancePart 3 -Performance
  CPU usageCPU usage

  Stream long audio filesStream long audio files

 Chapter 5 - Special Effects
  ObjectivesObjectives

Voice overs are an interesting scenario. Based on the experience you are creating you may wish to have a stereo

(not localized) sound or to spatialize your voice overs. Two Microsoft published experiences illustrate excellent

examples of each scenario.

HoloTour uses a stereo voice over. When the narrator is describing the location being viewed, the sound is

consistent and does not vary based on the user's position. This enables the narrator to describe the scene

without taking away from the spatialized sounds of the environment.

Fragments utilizes a spatialized voice over in the form of a detective. The detective's voice is used to help bring

the user's attention to an important clue as if an actual human was in the room. This enables an even greater

sense of immersion into the experience of solving the mystery.

When using Spatial Sound, 10 - 12 emitters will consume approximately 12% of the CPU.

Audio data can be large, especially at common sample rates (44.1 and 48 kHz). A general rule is that audio files

longer than 5 - 10 seconds should be streamed to reduce application memory usage.

In Unity, you can mark an audio file for streaming in the file's import settings.

Add depth to "Magic Windows".

Bring the user into the virtual world.

https://www.microsoft.com/store/p/holotour/9nblggh5pj87
https://www.microsoft.com/store/p/fragments/9nblggh5ggm8


  Magic WindowsMagic Windows
  Key ConceptsKey Concepts

  InstructionsInstructions

Creating views into a hidden world, is visually compelling.

Enhance realism by adding audio effects when a hologram or the user is near the hidden world.

In the HierarchyHierarchy  panel, expand HologramCollectionHologramCollection and select Under worldUnder world.

Expand Under worldUnder world and select VoiceSourceVoiceSource.

In the InspectorInspector  panel, click Add ComponentAdd Component and add User Voice EffectUser Voice Effect.

An AudioSourceAudioSource component will be added to VoiceSourceVoiceSource.

In AudioSourceAudioSource, set OutputOutput to UserVoice (Mixer)UserVoice (Mixer) .

Check the SpatializeSpatialize checkbox.

Drag the Spatial BlendSpatial Blend slider all the way to 3D3D, or enter 11  in the edit box.

Expand 3D Sound Settings3D Sound Settings .

Set Doppler LevelDoppler Level  to 00 .

In User Voice EffectUser Voice Effect, set Parent ObjectParent Object to the Under worldUnder world from the scene.

Set Max DistanceMax Distance to 11 .

Setting Max DistanceMax Distance tells User Voice EffectUser Voice Effect how close the user must be to the parent object before the effect

is enabled.

In User Voice EffectUser Voice Effect, expand Chorus ParametersChorus Parameters .

Set DepthDepth to 0.10.1 .

Set Tap 1 VolumeTap 1 Volume, Tap 2 VolumeTap 2 Volume and Tap 3 VolumeTap 3 Volume to 0.80.8 .

Set Original Sound VolumeOriginal Sound Volume to 0.50.5 .

The previous settings configure the parameters of the Unity AudioChorusFilterAudioChorusFilter  used to add richness to the

user's voice.

In User Voice EffectUser Voice Effect, expand Echo ParametersEcho Parameters .

Set DelayDelay  to 300300

Set Decay RatioDecay Ratio to 0.20.2 .

Set Original Sound VolumeOriginal Sound Volume to 00 .

The previous settings configure the parameters of the Unity AudioEchoFilterAudioEchoFilter  used to cause the user's voice to

echo.

The User Voice Effect script is responsible for :

Measuring the distance between the user and the GameObjectGameObject to which the script is attached.

Determining whether or not the user is facing the GameObjectGameObject.

The user must be facing the GameObject, regardless of distance, for the effect to be enabled.

Applying and configuring an AudioChorusFilterAudioChorusFilter  and an AudioEchoFilterAudioEchoFilter  to the AudioSourceAudioSource.

Disabling the effect by disabling the filters.

User Voice Effect uses the Mic Stream Selector component, from the MixedRealityToolkit for Unity, to select the

high quality voice stream and route it into Unity's audio system.

In the HierarchyHierarchy  panel, select ManagersManagers .

In the InspectorInspector  panel, expand Speech Input HandlerSpeech Input Handler .

In Speech Input HandlerSpeech Input Handler , expand Show Under worldShow Under world.

https://github.com/Microsoft/MixedRealityToolkit-Unity


  Build and DeployBuild and Deploy

 The End

Change No FunctionNo Function to Under worldBase.OnEnableUnder worldBase.OnEnable.

Expand Hide Under worldHide Under world.

Change No FunctionNo Function to Under worldBase.OnDisableUnder worldBase.OnDisable.

As before, build the project in Unity and deploy in Visual Studio.

After the application is deployed:

Face a surface (wall, floor, table) and say "Show Underworld".

The underworld will be shown and all other holograms will be hidden. If you do not see the underworld, ensure

that you are facing a real-world surface.

Approach within 1 meter of the underworld hologram and start talking.

There are now audio effects applied to your voice!

Turn away from the underworld and notice how the effect is no longer applied.

Say "Hide Underworld" to hide the underworld.

The underworld will be hidden and the previously hidden holograms will reappear.

Congratulations! You have now completed MR Spatial 220: Spatial soundMR Spatial 220: Spatial sound.

Listen to the world and bring your experiences to life with sound!
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IMPORTANTIMPORTANT

 Device support

C O URSEC O URSE H O LO L EN SH O LO L EN S IM M ERSIVE  H EA DSET SIM M ERSIVE  H EA DSET S

MR Spatial 230: Spatial mapping ✔️

 Before you start
  PrerequisitesPrerequisites

  Project filesProject files

The Mixed Reality Academy tutorials were designed with HoloLens (1st gen), Unity 2017, and Mixed Reality Immersive

Headsets in mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for

guidance in developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being

used for HoloLens 2 and may not be compatible with newer versions of Unity. They will be maintained to continue

working on the supported devices. A new series of tutorials has been posted for HoloLens 2.

Spatial mapping combines the real world and virtual world together by teaching holograms about the

environment. In MR Spatial 230 (Project Planetarium) we'll learn how to:

Scan the environment and transfer data from the HoloLens to your development machine.

Explore shaders and learn how to use them for visualizing your space.

Break down the room mesh into simple planes using mesh processing.

Go beyond the placement techniques we learned in MR Basics 101, and provide feedback about where a

hologram can be placed in the environment.

Explore occlusion effects, so when your hologram is behind a real-world object, you can still see it with x-ray

vision!

A Windows 10 PC configured with the correct tools installed.

Some basic C# programming ability.

You should have completed MR Basics 101.

A HoloLens device configured for development.

Download the files required by the project. Requires Unity 2017.2 or later.

Un-archive the files to your desktop or other easy to reach location.

If you still need Unity 5.6 support, please use this release.

If you still need Unity 5.5 support, please use this release.

If you still need Unity 5.4 support, please use this release.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/holograms-230.md
https://docs.microsoft.com/en-us/windows/mixed-reality/develop/unity/tutorials/mrlearning-base
https://www.youtube-nocookie.com/embed/NSNYRkUX6Mw
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://github.com/Microsoft/HolographicAcademy/archive/Holograms-230-SpatialMapping.zip
https://github.com/Microsoft/HolographicAcademy/archive/v1.5.6-230.zip
https://github.com/Microsoft/HolographicAcademy/archive/v1.5.5-230.zip
https://github.com/Microsoft/HolographicAcademy/archive/v1.5.4-230.zip


NOTENOTE

  NotesNotes

 Unity setup

If you want to look through the source code before downloading, it's available on GitHub.

"Enable Just My Code" in Visual Studio needs to be disabled (unchecked) under Tools > Options > Debugging

in order to hit breakpoints in your code.

Start UnityUnity .

Select NewNew  to create a new project.

Name the project Planetar iumPlanetar ium.

Verify that the 3D3D setting is selected.

Click Create ProjectCreate Project.

Once Unity launches, go to Edit > Project Settings > PlayerEdit > Project Settings > Player .

In the InspectorInspector  panel, find and select the green Windows StoreWindows Store icon.

Expand Other SettingsOther Settings .

In the RenderingRendering section, check the Vir tual Reality Suppor tedVir tual Reality Suppor ted option.

Verify that Windows HolographicWindows Holographic appears in the list of Vir tual Reality SDKsVir tual Reality SDKs . If not, select the ++ button at

the bottom of the list and choose Windows HolographicWindows Holographic.

Expand Publishing SettingsPublishing Settings .

In the CapabilitiesCapabilities  section, check the following settings:

Go to Edit > Project Settings > QualityEdit > Project Settings > Quality

In the InspectorInspector  panel, under the Windows Store icon, select the black drop-down arrow under the 'Default'

row and change the default setting to Ver y LowVer y Low .

Go to Assets > Impor t Package > Custom PackageAssets > Impor t Package > Custom Package.

Navigate to the ...\HolographicAcademy-Holograms-230-SpatialMapping\Star ting...\HolographicAcademy-Holograms-230-SpatialMapping\Star ting folder.

Click on Planetar ium.unitypackagePlanetar ium.unitypackage.

Click OpenOpen.

An Impor t Unity PackageImpor t Unity Package window should appear, click on the Impor tImpor t button.

Wait for Unity to import all of the assets that we will need to complete this project.

In the HierarchyHierarchy  panel, delete the Main CameraMain Camera.

In the ProjectProject panel, HoloToolkit-SpatialMapping-230\Utilities\PrefabsHoloToolkit-SpatialMapping-230\Utilities\Prefabs  folder, find the Main CameraMain Camera

object.

Drag and drop the Main CameraMain Camera prefab into the HierarchyHierarchy  panel.

In the HierarchyHierarchy  panel, delete the Directional L ightDirectional L ight object.

In the ProjectProject panel, HologramsHolograms folder, locate the CursorCursor  object.

Drag & drop the CursorCursor  prefab into the HierarchyHierarchy .

In the HierarchyHierarchy  panel, select the CursorCursor  object.

In the InspectorInspector  panel, click the LayerLayer  drop-down and select Edit Layers...Edit Layers... .

Name User Layer 31User Layer 31  as "SpatialMappingSpatialMapping".

InternetClientServer

PrivateNetworkClientServer

Microphone

SpatialPerception

https://github.com/Microsoft/HolographicAcademy/tree/Holograms-230-SpatialMapping
https://www.youtube-nocookie.com/embed/y2Y4LhK6TEM


 Chapter 1 - Scanning

Save the new scene: File > Save Scene As...File > Save Scene As...

Click New FolderNew Folder  and name the folder ScenesScenes .

Name the file "Planetar iumPlanetar ium" and save it in the ScenesScenes  folder.

ObjectivesObjectives

Learn about the SurfaceObserver and how its settings impact experience and performance.

Create a room scanning experience to collect the meshes of your room.

InstructionsInstructions

In the ProjectProject panel HoloToolkit-SpatialMapping-230\SpatialMapping\PrefabsHoloToolkit-SpatialMapping-230\SpatialMapping\Prefabs  folder, find the

SpatialMappingSpatialMapping prefab.

Drag & drop the SpatialMappingSpatialMapping prefab into the HierarchyHierarchy  panel.

Build and Deploy (par t 1)Build and Deploy (par t 1)

In Unity, select File > Build SettingsFile > Build Settings .

Click Add Open ScenesAdd Open Scenes  to add the Planetar iumPlanetar ium scene to the build.

Select Universal Windows PlatformUniversal Windows Platform in the PlatformPlatform list and click Switch PlatformSwitch Platform .

Set SDKSDK to Universal 10Universal 10  and UWP Build TypeUWP Build Type to D3DD3D.

Check Unity C# ProjectsUnity C# Projects .

Click BuildBuild.

Create a New FolderNew Folder  named "App".

Single click the AppApp folder.

Press the Select FolderSelect Folder  button.

When Unity is done building, a File Explorer window will appear.

Double-click on the AppApp folder to open it.

Double-click on Planetar ium.slnPlanetar ium.sln to load the project in Visual Studio.

In Visual Studio, use the top toolbar to change the Configuration to ReleaseRelease.

Change the Platform to x86x86 .

Click on the drop-down arrow to the right of 'Local Machine', and select Remote MachineRemote Machine.

Enter your device's IP address in the Address field and change Authentication Mode to UniversalUniversal

(Unencr ypted Protocol)(Unencr ypted Protocol) .

Click Debug -> Star t Without debuggingDebug -> Star t Without debugging or press Ctr l + F5Ctr l + F5 .

Watch the OutputOutput panel in Visual Studio for build and deploy status.

Once your app has deployed, walk around the room. You will see the surrounding surfaces covered by black

and white wireframe meshes.

Scan your surroundings. Be sure to look at walls, ceilings, and floors.

Build and Deploy (par t 2)Build and Deploy (par t 2)

Now let's explore how Spatial Mapping can affect performance.

In Unity, select Window > ProfilerWindow > Profiler .

Click Add Profiler  > GPUAdd Profiler  > GPU.

Click Active Profiler  > <Enter IP>Active Profiler  > <Enter IP>.

Enter the IP addressIP address  of your HoloLens.

Click ConnectConnect.

https://www.youtube-nocookie.com/embed/888oW51z_cE
https://docs.microsoft.com/en-us/hololens/hololens-network#identifying-the-ip-address-of-your-hololens-on-the-wi-fi-network


 Chapter 2 - Visualization

Observe the number of milliseconds it takes for the GPU to render a frame.

Stop the application from running on the device.

Return to Visual Studio and open SpatialMappingObser ver.csSpatialMappingObser ver.cs . You will find it in the

HoloToolkit\SpatialMapping folder of the Assembly-CSharp (Universal Windows) project.

Find the Awake()Awake()  function, and add the following line of code: Tr ianglesPerCubicMeter = 1200;Tr ianglesPerCubicMeter = 1200;

Re-deploy the project to your device, and then reconnect the profilerreconnect the profiler . Observe the change in the number

of milliseconds to render a frame.

Stop the application from running on the device.

Save and load in UnitySave and load in Unity

Finally, let's save our room mesh and load it into Unity.

Return to Visual Studio and remove the Tr ianglesPerCubicMeterTr ianglesPerCubicMeter  line that you added in the Awake()Awake()

function during the previous section.

Redeploy the project to your device. We should now be running with 500500  triangles per cubic meter.

Open a browser and enter in your HoloLens IPAddress to navigate to the Windows Device Por talWindows Device Por tal .

Select the 3D View3D View  option in the left panel.

Under Surface reconstructionSurface reconstruction select the UpdateUpdate button.

Watch as the areas that you have scanned on your HoloLens appear in the display window.

To save your room scan, press the SaveSave button.

Open your DownloadsDownloads  folder to find the saved room model SRMesh.objSRMesh.obj .

Copy SRMesh.objSRMesh.obj  to the AssetsAssets  folder of your Unity project.

In Unity, select the SpatialMappingSpatialMapping object in the HierarchyHierarchy  panel.

Locate the Object Surface Obser ver (Scr ipt)Object Surface Obser ver (Scr ipt)  component.

Click the circle to the right of the Room ModelRoom Model  property.

Find and select the SRMeshSRMesh object and then close the window.

Verify that the Room ModelRoom Model  property in the InspectorInspector  panel is now set to SRMeshSRMesh.

Press the PlayPlay  button to enter Unity's preview mode.

The SpatialMapping component will load the meshes from the saved room model so you can use them in

Unity.

Switch to SceneScene view to see all of your room model displayed with the wireframe shader.

Press the PlayPlay  button again to exit preview mode.

NOTE:NOTE: The next time that you enter preview mode in Unity, it will load the saved room mesh by default.

ObjectivesObjectives

Learn the basics of shaders.

Visualize your surroundings.

InstructionsInstructions

In Unity's HierarchyHierarchy  panel, select the SpatialMappingSpatialMapping object.

In the InspectorInspector  panel, find the Spatial Mapping Manager (Scr ipt)Spatial Mapping Manager (Scr ipt)  component.

Click the circle to the right of the Surface Mater ialSurface Mater ial  property.

Find and select the BlueLinesOnWallsBlueLinesOnWalls  material and close the window.

In the ProjectProject panel ShadersShaders  folder, double-click on BlueLinesOnWallsBlueLinesOnWalls  to open the shader in Visual

Studio.

https://www.youtube-nocookie.com/embed/RnkvXl-aXD4


 Chapter 3 - Processing

This is a simple pixel (vertex to fragment) shader, which accomplishes the following tasks:

1. Converts a vertex's location to world space.

2. Checks the vertex's normal to determine if a pixel is vertical.

3. Sets the color of the pixel for rendering.

Build and DeployBuild and Deploy

Return to Unity and press PlayPlay  to enter preview mode.

Blue lines will be rendered on all vertical surfaces of the room mesh (which automatically loaded from our

saved scanning data).

Switch to the SceneScene tab to adjust your view of the room and see how the entire room mesh appears in Unity.

In the ProjectProject panel, find the Mater ialsMater ials  folder and select the BlueLinesOnWallsBlueLinesOnWalls  material.

Modify some properties and see how the changes appear in the Unity editor.

Click PlayPlay  again to exit preview mode.

Build and deploy to the HoloLens and observe how the shader rendering appears on real surfaces.

In the InspectorInspector  panel, adjust the L ineScaleLineScale value to make the lines appear thicker or thinner.

In the InspectorInspector  panel, adjust the L inesPerMeterL inesPerMeter  value to change how many lines appear on each

wall.

Unity does a great job of previewing materials, but it's always a good idea to check-out rendering in the device.

ObjectivesObjectives

Learn techniques to process spatial mapping data for use in your application.

Analyze spatial mapping data to find planes and remove triangles.

Use planes for hologram placement.

InstructionsInstructions

In Unity's ProjectProject panel, HologramsHolograms folder, find the SpatialProcessingSpatialProcessing object.

Drag & drop the SpatialProcessingSpatialProcessing object into the HierarchyHierarchy  panel.

The SpatialProcessing prefab includes components for processing the spatial mapping data.

SurfaceMeshesToPlanes.csSurfaceMeshesToPlanes.cs  will find and generate planes based on the spatial mapping data. We will use

planes in our application to represent walls, floors and ceilings. This prefab also includes

RemoveSurfaceVer tices.csRemoveSurfaceVer tices.cs  which can remove vertices from the spatial mapping mesh. This can be used to

create holes in the mesh, or to remove excess triangles that are no longer needed (because planes can be used

instead).

In Unity's ProjectProject panel, HologramsHolograms folder, find the SpaceCollectionSpaceCollection object.

Drag and drop the SpaceCollectionSpaceCollection object into the HierarchyHierarchy  panel.

In the HierarchyHierarchy  panel, select the SpatialProcessingSpatialProcessing object.

In the InspectorInspector  panel, find the Play Space Manager (Scr ipt)Play Space Manager (Scr ipt)  component.

Double-click on PlaySpaceManager.csPlaySpaceManager.cs  to open it in Visual Studio.

PlaySpaceManager.cs contains application-specific code. We will add functionality to this script to enable the

following behavior :

1. Stop collecting spatial mapping data after we exceed the scanning time limit (10 seconds).

2. Process the spatial mapping data:

a. Use SurfaceMeshesToPlanes to create a simpler representation of the world as planes (walls, floors,

https://www.youtube-nocookie.com/embed/kaUKiNiDxwY


using System.Collections.Generic;
using UnityEngine;
using UnityEngine.Windows.Speech;
using Academy.HoloToolkit.Unity;

/// <summary>
/// The SurfaceManager class allows applications to scan the environment for a specified amount of time 
/// and then process the Spatial Mapping Mesh (find planes, remove vertices) after that time has expired.
/// </summary>
public class PlaySpaceManager : Singleton<PlaySpaceManager>
{
    [Tooltip("When checked, the SurfaceObserver will stop running after a specified amount of time.")]
    public bool limitScanningByTime = true;

    [Tooltip("How much time (in seconds) that the SurfaceObserver will run after being started; used when 
'Limit Scanning By Time' is checked.")]
    public float scanTime = 30.0f;

    [Tooltip("Material to use when rendering Spatial Mapping meshes while the observer is running.")]
    public Material defaultMaterial;

    [Tooltip("Optional Material to use when rendering Spatial Mapping meshes after the observer has been 
stopped.")]
    public Material secondaryMaterial;

    [Tooltip("Minimum number of floor planes required in order to exit scanning/processing mode.")]
    public uint minimumFloors = 1;

    [Tooltip("Minimum number of wall planes required in order to exit scanning/processing mode.")]
    public uint minimumWalls = 1;

    /// <summary>
    /// Indicates if processing of the surface meshes is complete.
    /// </summary>
    private bool meshesProcessed = false;

    /// <summary>
    /// GameObject initialization.
    /// </summary>
    private void Start()
    {
        // Update surfaceObserver and storedMeshes to use the same material during scanning.
        SpatialMappingManager.Instance.SetSurfaceMaterial(defaultMaterial);

        // Register for the MakePlanesComplete event.
        SurfaceMeshesToPlanes.Instance.MakePlanesComplete += SurfaceMeshesToPlanes_MakePlanesComplete;
    }

    /// <summary>
    /// Called once per frame.
    /// </summary>
    private void Update()
    {
        // Check to see if the spatial mapping data has been processed
        // and if we are limiting how much time the user can spend scanning.
        if (!meshesProcessed && limitScanningByTime)
        {
            // If we have not processed the spatial mapping data
            // and scanning time is limited...

3. Generate a collection of holograms in the world and place them on wall and floor planes near the user.

a. Use SurfaceMeshesToPlanes to create a simpler representation of the world as planes (walls, floors,

ceilings, etc).

b. Use RemoveSurfaceVertices to remove surface triangles that fall within plane boundaries.

Complete the coding exercises marked in PlaySpaceManager.cs, or replace the script with the finished solution

from below:



            // Check to see if enough scanning time has passed
            // since starting the observer.
            if (limitScanningByTime && ((Time.time - SpatialMappingManager.Instance.StartTime) < scanTime))
            {
                // If we have a limited scanning time, then we should wait until
                // enough time has passed before processing the mesh.
            }
            else
            {
                // The user should be done scanning their environment,
                // so start processing the spatial mapping data...

                /* TODO: 3.a DEVELOPER CODING EXERCISE 3.a */

                // 3.a: Check if IsObserverRunning() is true on the
                // SpatialMappingManager.Instance.
                if(SpatialMappingManager.Instance.IsObserverRunning())
                {
                    // 3.a: If running, Stop the observer by calling
                    // StopObserver() on the SpatialMappingManager.Instance.
                    SpatialMappingManager.Instance.StopObserver();
                }

                // 3.a: Call CreatePlanes() to generate planes.
                CreatePlanes();

                // 3.a: Set meshesProcessed to true.
                meshesProcessed = true;
            }
        }
    }

    /// <summary>
    /// Handler for the SurfaceMeshesToPlanes MakePlanesComplete event.
    /// </summary>
    /// <param name="source">Source of the event.</param>
    /// <param name="args">Args for the event.</param>
    private void SurfaceMeshesToPlanes_MakePlanesComplete(object source, System.EventArgs args)
    {
        /* TODO: 3.a DEVELOPER CODING EXERCISE 3.a */

        // Collection of floor and table planes that we can use to set horizontal items on.
        List<GameObject> horizontal = new List<GameObject>();

        // Collection of wall planes that we can use to set vertical items on.
        List<GameObject> vertical = new List<GameObject>();

        // 3.a: Get all floor and table planes by calling
        // SurfaceMeshesToPlanes.Instance.GetActivePlanes().
        // Assign the result to the 'horizontal' list.
        horizontal = SurfaceMeshesToPlanes.Instance.GetActivePlanes(PlaneTypes.Table | PlaneTypes.Floor);

        // 3.a: Get all wall planes by calling
        // SurfaceMeshesToPlanes.Instance.GetActivePlanes().
        // Assign the result to the 'vertical' list.
        vertical = SurfaceMeshesToPlanes.Instance.GetActivePlanes(PlaneTypes.Wall);

        // Check to see if we have enough horizontal planes (minimumFloors)
        // and vertical planes (minimumWalls), to set holograms on in the world.
        if (horizontal.Count >= minimumFloors && vertical.Count >= minimumWalls)
        {
            // We have enough floors and walls to place our holograms on...

            // 3.a: Let's reduce our triangle count by removing triangles
            // from SpatialMapping meshes that intersect with our active planes.
            // Call RemoveVertices().
            // Pass in all activePlanes found by SurfaceMeshesToPlanes.Instance.
            RemoveVertices(SurfaceMeshesToPlanes.Instance.ActivePlanes);



            // 3.a: We can indicate to the user that scanning is over by
            // changing the material applied to the Spatial Mapping meshes.
            // Call SpatialMappingManager.Instance.SetSurfaceMaterial().
            // Pass in the secondaryMaterial.
            SpatialMappingManager.Instance.SetSurfaceMaterial(secondaryMaterial);

            // 3.a: We are all done processing the mesh, so we can now
            // initialize a collection of Placeable holograms in the world
            // and use horizontal/vertical planes to set their starting positions.
            // Call SpaceCollectionManager.Instance.GenerateItemsInWorld().
            // Pass in the lists of horizontal and vertical planes that we found earlier.
            SpaceCollectionManager.Instance.GenerateItemsInWorld(horizontal, vertical);
        }
        else
        {
            // We do not have enough floors/walls to place our holograms on...

            // 3.a: Re-enter scanning mode so the user can find more surfaces by
            // calling StartObserver() on the SpatialMappingManager.Instance.
            SpatialMappingManager.Instance.StartObserver();

            // 3.a: Re-process spatial data after scanning completes by
            // re-setting meshesProcessed to false.
            meshesProcessed = false;
        }
    }

    /// <summary>
    /// Creates planes from the spatial mapping surfaces.
    /// </summary>
    private void CreatePlanes()
    {
        // Generate planes based on the spatial map.
        SurfaceMeshesToPlanes surfaceToPlanes = SurfaceMeshesToPlanes.Instance;
        if (surfaceToPlanes != null && surfaceToPlanes.enabled)
        {
            surfaceToPlanes.MakePlanes();
        }
    }

    /// <summary>
    /// Removes triangles from the spatial mapping surfaces.
    /// </summary>
    /// <param name="boundingObjects"></param>
    private void RemoveVertices(IEnumerable<GameObject> boundingObjects)
    {
        RemoveSurfaceVertices removeVerts = RemoveSurfaceVertices.Instance;
        if (removeVerts != null && removeVerts.enabled)
        {
            removeVerts.RemoveSurfaceVerticesWithinBounds(boundingObjects);
        }
    }

    /// <summary>
    /// Called when the GameObject is unloaded.
    /// </summary>
    private void OnDestroy()
    {
        if (SurfaceMeshesToPlanes.Instance != null)
        {
            SurfaceMeshesToPlanes.Instance.MakePlanesComplete -= SurfaceMeshesToPlanes_MakePlanesComplete;
        }
    }
}

Build and DeployBuild and Deploy



 Chapter 4 - Placement

using System.Collections.Generic;
using UnityEngine;
using Academy.HoloToolkit.Unity;

/// <summary>
/// Enumeration containing the surfaces on which a GameObject
/// can be placed.  For simplicity of this sample, only one
/// surface type is allowed to be selected.
/// </summary>
public enum PlacementSurfaces
{
    // Horizontal surface with an upward pointing normal.

Before deploying to the HoloLens, press the PlayPlay  button in Unity to enter play mode.

After the room mesh is loaded from file, wait for 10 seconds before processing starts on the spatial mapping

mesh.

When processing is complete, planes will appear to represent the floor, walls, ceiling, etc.

After all of the planes have been found, you should see a solar system appear on a table of floor near the

camera.

Two posters should appear on walls near the camera too. Switch to the SceneScene tab if you cannot see them in

GameGame mode.

Press the PlayPlay  button again to exit play mode.

Build and deploy to the HoloLens, as usual.

Wait for scanning and processing of the spatial mapping data to complete.

Once you see planes, try to find the solar system and posters in your world.

ObjectivesObjectives

Determine if a hologram will fit on a surface.

Provide feedback to the user when a hologram can/cannot fit on a surface.

InstructionsInstructions

In Unity's HierarchyHierarchy  panel, select the SpatialProcessingSpatialProcessing object.

In the InspectorInspector  panel, find the Surface Meshes To Planes (Scr ipt)Surface Meshes To Planes (Scr ipt)  component.

Change the Draw PlanesDraw Planes  property to NothingNothing to clear the selection.

Change the Draw PlanesDraw Planes  property to WallWall , so that only wall planes will be rendered.

In the ProjectProject panel, Scr iptsScr ipts  folder, double-click on Placeable.csPlaceable.cs  to open it in Visual Studio.

The PlaceablePlaceable script is already attached to the posters and projection box that are created after plane finding

completes. All we need to do is uncomment some code, and this script will achieve the following:

1. Determine if a hologram will fit on a surface by raycasting from the center and four corners of the bounding

cube.

2. Check the surface normal to determine if it is smooth enough for the hologram to sit flush on.

3. Render a bounding cube around the hologram to show its actual size while being placed.

4. Cast a shadow under/behind the hologram to show where it will be placed on the floor/wall.

5. Render the shadow as red, if the hologram cannot be placed on the surface, or green, if it can.

6. Re-orient the hologram to align with the surface type (vertical or horizontal) that it has affinity to.

7. Smoothly place the hologram on the selected surface to avoid jumping or snapping behavior.

Uncomment all code in the coding exercise below, or use this completed solution in Placeable.csPlaceable.cs :

https://www.youtube-nocookie.com/embed/Srhtpid1uZc


    Horizontal = 1,

    // Vertical surface with a normal facing the user.
    Vertical = 2,
}

/// <summary>
/// The Placeable class implements the logic used to determine if a GameObject
/// can be placed on a target surface. Constraints for placement include:
/// * No part of the GameObject's box collider impacts with another object in the scene
/// * The object lays flat (within specified tolerances) against the surface
/// * The object would not fall off of the surface if gravity were enabled.
/// This class also provides the following visualizations.
/// * A transparent cube representing the object's box collider.
/// * Shadow on the target surface indicating whether or not placement is valid.
/// </summary>
public class Placeable : MonoBehaviour
{
    [Tooltip("The base material used to render the bounds asset when placement is allowed.")]
    public Material PlaceableBoundsMaterial = null;

    [Tooltip("The base material used to render the bounds asset when placement is not allowed.")]
    public Material NotPlaceableBoundsMaterial = null;

    [Tooltip("The material used to render the placement shadow when placement it allowed.")]
    public Material PlaceableShadowMaterial = null;

    [Tooltip("The material used to render the placement shadow when placement it not allowed.")]
    public Material NotPlaceableShadowMaterial = null;

    [Tooltip("The type of surface on which the object can be placed.")]
    public PlacementSurfaces PlacementSurface = PlacementSurfaces.Horizontal;

    [Tooltip("The child object(s) to hide during placement.")]
    public List<GameObject> ChildrenToHide = new List<GameObject>();

    /// <summary>
    /// Indicates if the object is in the process of being placed.
    /// </summary>
    public bool IsPlacing { get; private set; }

    // The most recent distance to the surface.  This is used to 
    // locate the object when the user's gaze does not intersect
    // with the Spatial Mapping mesh.
    private float lastDistance = 2.0f;

    // The distance away from the target surface that the object should hover prior while being placed.
    private float hoverDistance = 0.15f;

    // Threshold (the closer to 0, the stricter the standard) used to determine if a surface is flat.
    private float distanceThreshold = 0.02f;

    // Threshold (the closer to 1, the stricter the standard) used to determine if a surface is vertical.
    private float upNormalThreshold = 0.9f;

    // Maximum distance, from the object, that placement is allowed.
    // This is used when raycasting to see if the object is near a placeable surface.
    private float maximumPlacementDistance = 5.0f;

    // Speed (1.0 being fastest) at which the object settles to the surface upon placement.
    private float placementVelocity = 0.06f;

    // Indicates whether or not this script manages the object's box collider.
    private bool managingBoxCollider = false;

    // The box collider used to determine of the object will fit in the desired location.
    // It is also used to size the bounding cube.
    private BoxCollider boxCollider = null;



    // Visible asset used to show the dimensions of the object. This asset is sized
    // using the box collider's bounds.
    private GameObject boundsAsset = null;

    // Visible asset used to show the where the object is attempting to be placed.
    // This asset is sized using the box collider's bounds.
    private GameObject shadowAsset = null;

    // The location at which the object will be placed.
    private Vector3 targetPosition;

    /// <summary>
    /// Called when the GameObject is created.
    /// </summary>
    private void Awake()
    {
        targetPosition = gameObject.transform.position;

        // Get the object's collider.
        boxCollider = gameObject.GetComponent<BoxCollider>();
        if (boxCollider == null)
        {
            // The object does not have a collider, create one and remember that
            // we are managing it.
            managingBoxCollider = true;
            boxCollider = gameObject.AddComponent<BoxCollider>();
            boxCollider.enabled = false;
        }

        // Create the object that will be used to indicate the bounds of the GameObject.
        boundsAsset = GameObject.CreatePrimitive(PrimitiveType.Cube);
        boundsAsset.transform.parent = gameObject.transform;
        boundsAsset.SetActive(false);

        // Create a object that will be used as a shadow.
        shadowAsset = GameObject.CreatePrimitive(PrimitiveType.Quad);
        shadowAsset.transform.parent = gameObject.transform;
        shadowAsset.SetActive(false);
    }

    /// <summary>
    /// Called when our object is selected.  Generally called by
    /// a gesture management component.
    /// </summary>
    public void OnSelect()
    {
        /* TODO: 4.a CODE ALONG 4.a */

        if (!IsPlacing)
        {
            OnPlacementStart();
        }
        else
        {
            OnPlacementStop();
        }
    }

    /// <summary>
    /// Called once per frame.
    /// </summary>
    private void Update()
    {
        /* TODO: 4.a CODE ALONG 4.a */

        if (IsPlacing)
        {
            // Move the object.
            Move();



            Move();

            // Set the visual elements.
            Vector3 targetPosition;
            Vector3 surfaceNormal;
            bool canBePlaced = ValidatePlacement(out targetPosition, out surfaceNormal);
            DisplayBounds(canBePlaced);
            DisplayShadow(targetPosition, surfaceNormal, canBePlaced);
        }
        else
        {
            // Disable the visual elements.
            boundsAsset.SetActive(false);
            shadowAsset.SetActive(false);

            // Gracefully place the object on the target surface.
            float dist = (gameObject.transform.position - targetPosition).magnitude;
            if (dist > 0)
            {
                gameObject.transform.position = Vector3.Lerp(gameObject.transform.position, targetPosition, 
placementVelocity / dist);
            }
            else
            {
                // Unhide the child object(s) to make placement easier.
                for (int i = 0; i < ChildrenToHide.Count; i++)
                {
                    ChildrenToHide[i].SetActive(true);
                }
            }
        }
    }

    /// <summary>
    /// Verify whether or not the object can be placed.
    /// </summary>
    /// <param name="position">
    /// The target position on the surface.
    /// </param>
    /// <param name="surfaceNormal">
    /// The normal of the surface on which the object is to be placed.
    /// </param>
    /// <returns>
    /// True if the target position is valid for placing the object, otherwise false.
    /// </returns>
    private bool ValidatePlacement(out Vector3 position, out Vector3 surfaceNormal)
    {
        Vector3 raycastDirection = gameObject.transform.forward;

        if (PlacementSurface == PlacementSurfaces.Horizontal)
        {
            // Placing on horizontal surfaces.
            // Raycast from the bottom face of the box collider.
            raycastDirection = -(Vector3.up);
        }

        // Initialize out parameters.
        position = Vector3.zero;
        surfaceNormal = Vector3.zero;

        Vector3[] facePoints = GetColliderFacePoints();

        // The origin points we receive are in local space and we 
        // need to raycast in world space.
        for (int i = 0; i < facePoints.Length; i++)
        {
            facePoints[i] = gameObject.transform.TransformVector(facePoints[i]) + 
gameObject.transform.position;
        }



        // Cast a ray from the center of the box collider face to the surface.
        RaycastHit centerHit;
        if (!Physics.Raycast(facePoints[0],
                        raycastDirection,
                        out centerHit,
                        maximumPlacementDistance,
                        SpatialMappingManager.Instance.LayerMask))
        {
            // If the ray failed to hit the surface, we are done.
            return false;
        }

        // We have found a surface.  Set position and surfaceNormal.
        position = centerHit.point;
        surfaceNormal = centerHit.normal;

        // Cast a ray from the corners of the box collider face to the surface.
        for (int i = 1; i < facePoints.Length; i++)
        {
            RaycastHit hitInfo;
            if (Physics.Raycast(facePoints[i],
                                raycastDirection,
                                out hitInfo,
                                maximumPlacementDistance,
                                SpatialMappingManager.Instance.LayerMask))
            {
                // To be a valid placement location, each of the corners must have a similar
                // enough distance to the surface as the center point
                if (!IsEquivalentDistance(centerHit.distance, hitInfo.distance))
                {
                    return false;
                }
            }
            else
            {
                // The raycast failed to intersect with the target layer.
                return false;
            }
        }

        return true;
    }

    /// <summary>
    /// Determine the coordinates, in local space, of the box collider face that 
    /// will be placed against the target surface.
    /// </summary>
    /// <returns>
    /// Vector3 array with the center point of the face at index 0.
    /// </returns>
    private Vector3[] GetColliderFacePoints()
    {
        // Get the collider extents.  
        // The size values are twice the extents.
        Vector3 extents = boxCollider.size / 2;

        // Calculate the min and max values for each coordinate.
        float minX = boxCollider.center.x - extents.x;
        float maxX = boxCollider.center.x + extents.x;
        float minY = boxCollider.center.y - extents.y;
        float maxY = boxCollider.center.y + extents.y;
        float minZ = boxCollider.center.z - extents.z;
        float maxZ = boxCollider.center.z + extents.z;

        Vector3 center;
        Vector3 corner0;
        Vector3 corner1;
        Vector3 corner2;
        Vector3 corner3;



        Vector3 corner3;

        if (PlacementSurface == PlacementSurfaces.Horizontal)
        {
            // Placing on horizontal surfaces.
            center = new Vector3(boxCollider.center.x, minY, boxCollider.center.z);
            corner0 = new Vector3(minX, minY, minZ);
            corner1 = new Vector3(minX, minY, maxZ);
            corner2 = new Vector3(maxX, minY, minZ);
            corner3 = new Vector3(maxX, minY, maxZ);
        }
        else
        {
            // Placing on vertical surfaces.
            center = new Vector3(boxCollider.center.x, boxCollider.center.y, maxZ);
            corner0 = new Vector3(minX, minY, maxZ);
            corner1 = new Vector3(minX, maxY, maxZ);
            corner2 = new Vector3(maxX, minY, maxZ);
            corner3 = new Vector3(maxX, maxY, maxZ);
        }

        return new Vector3[] { center, corner0, corner1, corner2, corner3 };
    }

    /// <summary>
    /// Put the object into placement mode.
    /// </summary>
    public void OnPlacementStart()
    {
        // If we are managing the collider, enable it. 
        if (managingBoxCollider)
        {
            boxCollider.enabled = true;
        }

        // Hide the child object(s) to make placement easier.
        for (int i = 0; i < ChildrenToHide.Count; i++)
        {
            ChildrenToHide[i].SetActive(false);
        }

        // Tell the gesture manager that it is to assume
        // all input is to be given to this object.
        GestureManager.Instance.OverrideFocusedObject = gameObject;

        // Enter placement mode.
        IsPlacing = true;
    }

    /// <summary>
    /// Take the object out of placement mode.
    /// </summary>
    /// <remarks>
    /// This method will leave the object in placement mode if called while
    /// the object is in an invalid location.  To determine whether or not
    /// the object has been placed, check the value of the IsPlacing property.
    /// </remarks>
    public void OnPlacementStop()
    {
        // ValidatePlacement requires a normal as an out parameter.
        Vector3 position;
        Vector3 surfaceNormal;

        // Check to see if we can exit placement mode.
        if (!ValidatePlacement(out position, out surfaceNormal))
        {
            return;
        }

        // The object is allowed to be placed.



        // The object is allowed to be placed.
        // We are placing at a small buffer away from the surface.
        targetPosition = position + (0.01f * surfaceNormal);

        OrientObject(true, surfaceNormal);

        // If we are managing the collider, disable it. 
        if (managingBoxCollider)
        {
            boxCollider.enabled = false;
        }

        // Tell the gesture manager that it is to resume
        // its normal behavior.
        GestureManager.Instance.OverrideFocusedObject = null;

        // Exit placement mode.
        IsPlacing = false;
    }

    /// <summary>
    /// Positions the object along the surface toward which the user is gazing.
    /// </summary>
    /// <remarks>
    /// If the user's gaze does not intersect with a surface, the object
    /// will remain at the most recently calculated distance.
    /// </remarks>
    private void Move()
    {
        Vector3 moveTo = gameObject.transform.position;
        Vector3 surfaceNormal = Vector3.zero;
        RaycastHit hitInfo;

        bool hit = Physics.Raycast(Camera.main.transform.position,
                                Camera.main.transform.forward,
                                out hitInfo,
                                20f,
                                SpatialMappingManager.Instance.LayerMask);

        if (hit)
        {
            float offsetDistance = hoverDistance;

            // Place the object a small distance away from the surface while keeping 
            // the object from going behind the user.
            if (hitInfo.distance <= hoverDistance)
            {
                offsetDistance = 0f;
            }

            moveTo = hitInfo.point + (offsetDistance * hitInfo.normal);

            lastDistance = hitInfo.distance;
            surfaceNormal = hitInfo.normal;
        }
        else
        {
            // The raycast failed to hit a surface.  In this case, keep the object at the distance of the 
last
            // intersected surface.
            moveTo = Camera.main.transform.position + (Camera.main.transform.forward * lastDistance);
        }

        // Follow the user's gaze.
        float dist = Mathf.Abs((gameObject.transform.position - moveTo).magnitude);
        gameObject.transform.position = Vector3.Lerp(gameObject.transform.position, moveTo, 
placementVelocity / dist);

        // Orient the object.



        // We are using the return value from Physics.Raycast to instruct
        // the OrientObject function to align to the vertical surface if appropriate.
        OrientObject(hit, surfaceNormal);
    }

    /// <summary>
    /// Orients the object so that it faces the user.
    /// </summary>
    /// <param name="alignToVerticalSurface">
    /// If true and the object is to be placed on a vertical surface, 
    /// orient parallel to the target surface.  If false, orient the object 
    /// to face the user.
    /// </param>
    /// <param name="surfaceNormal">
    /// The target surface's normal vector.
    /// </param>
    /// <remarks>
    /// The alignToVerticalSurface parameter is ignored if the object
    /// is to be placed on a horizontalSurface
    /// </remarks>
    private void OrientObject(bool alignToVerticalSurface, Vector3 surfaceNormal)
    {
        Quaternion rotation = Camera.main.transform.localRotation;

        // If the user's gaze does not intersect with the Spatial Mapping mesh,
        // orient the object towards the user.
        if (alignToVerticalSurface && (PlacementSurface == PlacementSurfaces.Vertical))
        {
            // We are placing on a vertical surface.
            // If the normal of the Spatial Mapping mesh indicates that the
            // surface is vertical, orient parallel to the surface.
            if (Mathf.Abs(surfaceNormal.y) <= (1 - upNormalThreshold))
            {
                rotation = Quaternion.LookRotation(-surfaceNormal, Vector3.up);
            }
        }
        else
        {
            rotation.x = 0f;
            rotation.z = 0f;
        }

        gameObject.transform.rotation = rotation;
    }

    /// <summary>
    /// Displays the bounds asset.
    /// </summary>
    /// <param name="canBePlaced">
    /// Specifies if the object is in a valid placement location.
    /// </param>
    private void DisplayBounds(bool canBePlaced)
    {
        // Ensure the bounds asset is sized and positioned correctly.
        boundsAsset.transform.localPosition = boxCollider.center;
        boundsAsset.transform.localScale = boxCollider.size;
        boundsAsset.transform.rotation = gameObject.transform.rotation;

        // Apply the appropriate material.
        if (canBePlaced)
        {
            boundsAsset.GetComponent<Renderer>().sharedMaterial = PlaceableBoundsMaterial;
        }
        else
        {
            boundsAsset.GetComponent<Renderer>().sharedMaterial = NotPlaceableBoundsMaterial;
        }

        // Show the bounds asset.



        boundsAsset.SetActive(true);
    }

    /// <summary>
    /// Displays the placement shadow asset.
    /// </summary>
    /// <param name="position">
    /// The position at which to place the shadow asset.
    /// </param>
    /// <param name="surfaceNormal">
    /// The normal of the surface on which the asset will be placed
    /// </param>
    /// <param name="canBePlaced">
    /// Specifies if the object is in a valid placement location.
    /// </param>
    private void DisplayShadow(Vector3 position,
                            Vector3 surfaceNormal,
                            bool canBePlaced)
    {
        // Rotate and scale the shadow so that it is displayed on the correct surface and matches the 
object.
        float rotationX = 0.0f;

        if (PlacementSurface == PlacementSurfaces.Horizontal)
        {
            rotationX = 90.0f;
            shadowAsset.transform.localScale = new Vector3(boxCollider.size.x, boxCollider.size.z, 1);
        }
        else
        {
            shadowAsset.transform.localScale = boxCollider.size;
        }

        Quaternion rotation = Quaternion.Euler(rotationX, gameObject.transform.rotation.eulerAngles.y, 0);
        shadowAsset.transform.rotation = rotation;

        // Apply the appropriate material.
        if (canBePlaced)
        {
            shadowAsset.GetComponent<Renderer>().sharedMaterial = PlaceableShadowMaterial;
        }
        else
        {
            shadowAsset.GetComponent<Renderer>().sharedMaterial = NotPlaceableShadowMaterial;
        }

        // Show the shadow asset as appropriate.
        if (position != Vector3.zero)
        {
            // Position the shadow a small distance from the target surface, along the normal.
            shadowAsset.transform.position = position + (0.01f * surfaceNormal);
            shadowAsset.SetActive(true);
        }
        else
        {
            shadowAsset.SetActive(false);
        }
    }

    /// <summary>
    /// Determines if two distance values should be considered equivalent. 
    /// </summary>
    /// <param name="d1">
    /// Distance to compare.
    /// </param>
    /// <param name="d2">
    /// Distance to compare.
    /// </param>
    /// <returns>



    /// <returns>
    /// True if the distances are within the desired tolerance, otherwise false.
    /// </returns>
    private bool IsEquivalentDistance(float d1, float d2)
    {
        float dist = Mathf.Abs(d1 - d2);
        return (dist <= distanceThreshold);
    }

    /// <summary>
    /// Called when the GameObject is unloaded.
    /// </summary>
    private void OnDestroy()
    {
        // Unload objects we have created.
        Destroy(boundsAsset);
        boundsAsset = null;
        Destroy(shadowAsset);
        shadowAsset = null;
    }
}

 Chapter 5 - Occlusion

Build and DeployBuild and Deploy

As before, build the project and deploy to the HoloLens.

Wait for scanning and processing of the spatial mapping data to complete.

When you see the solar system, gaze at the projection box below and perform a select gesture to move it

around. While the projection box is selected, a bounding cube will be visible around the projection box.

Move you head to gaze at a different location in the room. The projection box should follow your gaze. When

the shadow below the projection box turns red, you cannot place the hologram on that surface. When the

shadow below the projection box turns green, you can place the hologram by performing another select

gesture.

Find and select one of the holographic posters on a wall to move it to a new location. Notice that you cannot

place the poster on the floor or ceiling, and that it stays correctly oriented to each wall as you move around.

ObjectivesObjectives

Determine if a hologram is occluded by the spatial mapping mesh.

Apply different occlusion techniques to achieve a fun effect.

InstructionsInstructions

First, we are going to allow the spatial mapping mesh to occlude other holograms without occluding the real

world:

In the HierarchyHierarchy  panel, select the SpatialProcessingSpatialProcessing object.

In the InspectorInspector  panel, find the Play Space Manager (Scr ipt)Play Space Manager (Scr ipt)  component.

Click the circle to the right of the Secondar y Mater ialSecondar y Mater ial  property.

Find and select the OcclusionOcclusion material and close the window.

Next, we are going to add a special behavior to Earth, so that it has a blue highlight whenever it becomes

occluded by another hologram (like the sun), or by the spatial mapping mesh:

In the ProjectProject panel, in the HologramsHolograms folder, expand the SolarSystemSolarSystem object.

Click on Ear thEar th .

In the InspectorInspector  panel, find the Earth's material (bottom component).

https://www.youtube-nocookie.com/embed/6Xrzh_w-7SE


using UnityEngine;
using Academy.HoloToolkit.Unity;

/// <summary>
/// Determines when the occluded version of the planet should be visible.
/// This script allows us to do selective occlusion, so the occlusionObject
/// will only be rendered when a Spatial Mapping surface is occluding the planet,
/// not when another hologram is responsible for the occlusion.
/// </summary>
public class PlanetOcclusion : MonoBehaviour
{
    [Tooltip("Object to display when the planet is occluded.")]
    public GameObject occlusionObject;

    /// <summary>
    /// Points to raycast to when checking for occlusion.
    /// </summary>
    private Vector3[] checkPoints;

    // Use this for initialization
    void Start()
    {
        occlusionObject.SetActive(false);

        // Set the check points to use when testing for occlusion.
        MeshFilter filter = gameObject.GetComponent<MeshFilter>();
        Vector3 extents = filter.mesh.bounds.extents;
        Vector3 center = filter.mesh.bounds.center;
        Vector3 top = new Vector3(center.x, center.y + extents.y, center.z);
        Vector3 left = new Vector3(center.x - extents.x, center.y, center.z);
        Vector3 right = new Vector3(center.x + extents.x, center.y, center.z);
        Vector3 bottom = new Vector3(center.x, center.y - extents.y, center.z);

        checkPoints = new Vector3[] { center, top, left, right, bottom };
    }

    // Update is called once per frame
    void Update()
    {
        /* TODO: 5.a DEVELOPER CODING EXERCISE 5.a */

        // Check to see if any of the planet's boundary points are occluded.
        for (int i = 0; i < checkPoints.Length; i++)
        {
            // 5.a: Convert the current checkPoint to world coordinates.
            // Call gameObject.transform.TransformPoint(checkPoints[i]).
            // Assign the result to a new Vector3 variable called 'checkPt'.
            Vector3 checkPt = gameObject.transform.TransformPoint(checkPoints[i]);

            // 5.a: Call Vector3.Distance() to calculate the distance
            // between the Main Camera's position and 'checkPt'.
            // Assign the result to a new float variable called 'distance'.
            float distance = Vector3.Distance(Camera.main.transform.position, checkPt);

In the Shader drop-downShader drop-down, change the shader to Custom > OcclusionRimCustom > OcclusionRim . This will render a blue

highlight around Earth whenever it is occluded by another object.

Finally, we are going to enable an x-ray vision effect for planets in our solar system. We will need to edit

PlanetOcclusion.csPlanetOcclusion.cs  (found in the Scripts\SolarSystem folder) in order to achieve the following:

1. Determine if a planet is occluded by the SpatialMapping layer (room meshes and planes).

2. Show the wireframe representation of a planet whenever it is occluded by the SpatialMapping layer.

3. Hide the wireframe representation of a planet when it is not blocked by the SpatialMapping layer.

Follow the coding exercise in PlanetOcclusion.cs, or use the following solution:



            // 5.a: Take 'checkPt' and subtract the Main Camera's position from it.
            // Assign the result to a new Vector3 variable called 'direction'.
            Vector3 direction = checkPt - Camera.main.transform.position;

            // Used to indicate if the call to Physics.Raycast() was successful.
            bool raycastHit = false;

            // 5.a: Check if the planet is occluded by a spatial mapping surface.
            // Call Physics.Raycast() with the following arguments:
            // - Pass in the Main Camera's position as the origin.
            // - Pass in 'direction' for the direction.
            // - Pass in 'distance' for the maxDistance.
            // - Pass in SpatialMappingManager.Instance.LayerMask as layerMask.
            // Assign the result to 'raycastHit'.
            raycastHit = Physics.Raycast(Camera.main.transform.position, direction, distance, 
SpatialMappingManager.Instance.LayerMask);

            if (raycastHit)
            {
                // 5.a: Our raycast hit a surface, so the planet is occluded.
                // Set the occlusionObject to active.
                occlusionObject.SetActive(true);

                // At least one point is occluded, so break from the loop.
                break;
            }
            else
            {
                // 5.a: The Raycast did not hit, so the planet is not occluded.
                // Deactivate the occlusionObject.
                occlusionObject.SetActive(false);
            }
        }
    }
}

 The End

Build and DeployBuild and Deploy

Build and deploy the application to HoloLens, as usual.

Wait for scanning and processing of the spatial mapping data to be complete (you should see blue lines

appear on walls).

Find and select the solar system's projection box and then set the box next to a wall or behind a counter.

You can view basic occlusion by hiding behind surfaces to peer at the poster or projection box.

Look for the Earth, there should be a blue highlight effect whenever it goes behind another hologram or

surface.

Watch as the planets move behind the wall or other surfaces in the room. You now have x-ray vision and can

see their wireframe skeletons!

Congratulations! You have now completed MR Spatial 230: Spatial mappingMR Spatial 230: Spatial mapping.

You know how to scan your environment and load spatial mapping data to Unity.

You understand the basics of shaders and how materials can be used to re-visualize the world.

You learned of new processing techniques for finding planes and removing triangles from a mesh.

You were able to move and place holograms on surfaces that made sense.

You experienced different occlusion techniques and harnessed the power of x-ray vision!
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 Before you start
  PrerequisitesPrerequisites

  Project filesProject files

The Mixed Reality Academy tutorials were designed with HoloLens (1st gen), Unity 2017, and Mixed Reality Immersive

Headsets in mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for

guidance in developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being

used for HoloLens 2 and may not be compatible with newer versions of Unity. They will be maintained to continue

working on the supported devices. A new series of tutorials has been posted for HoloLens 2.

Holograms are given presence in our world by remaining in place as we move about in space. HoloLens keeps

holograms in place by using various coordinate systems to keep track of the location and orientation of objects.

When we share these coordinate systems between devices, we can create a shared experience that allows us to

take part in a shared holographic world.

In this tutorial, we will:

Setup a network for a shared experience.

Share holograms across HoloLens devices.

Discover other people in our shared holographic world.

Create a shared interactive experience where you can target other players - and launch projectiles at them!

A Windows 10 PC configured with the correct tools installed with Internet access.

At least two HoloLens devices configured for development.

Download the files required by the project. Requires Unity 2017.2 or later.

Un-archive the files to your desktop or other easy to reach location. Keep the folder name as

SharedHologramsSharedHolograms .

If you still need Unity 5.6 support, please use this release.

If you still need Unity 5.5 support, please use this release.

If you still need Unity 5.4 support, please use this release.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/holograms-240.md
https://docs.microsoft.com/en-us/windows/mixed-reality/develop/unity/tutorials/mrlearning-base
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://github.com/Microsoft/HolographicAcademy/archive/Holograms-240-SharedHolograms.zip
https://github.com/Microsoft/HolographicAcademy/archive/v1.5.6-240.zip
https://github.com/Microsoft/HolographicAcademy/archive/v1.5.5-240.zip
https://github.com/Microsoft/HolographicAcademy/archive/v1.5.4-240.zip
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If you want to look through the source code before downloading, it's available on GitHub.

In this chapter, we'll setup our first Unity project and step through the build and deploy process.

Setup Unity to develop holographic apps.

See your hologram!

Start Unity.

Select OpenOpen.

Enter location as the SharedHologramsSharedHolograms folder you previously unarchived.

Select Project NameProject Name and click Select FolderSelect Folder .

In the HierarchyHierarchy , right-click the Main CameraMain Camera and select DeleteDelete.

In the HoloToolkit-Sharing-240/Prefabs/CameraHoloToolkit-Sharing-240/Prefabs/Camera folder, find the Main CameraMain Camera prefab.

Drag and drop the Main CameraMain Camera into the HierarchyHierarchy .

In the HierarchyHierarchy , click on CreateCreate and Create EmptyCreate Empty .

Right-click the new GameObjectGameObject and select RenameRename.

Rename the GameObject to HologramCollectionHologramCollection.

Select the HologramCollectionHologramCollection object in the HierarchyHierarchy .

In the InspectorInspector  set the transform positiontransform position to: X: 0 , Y: -0 .25, Z: 2X: 0 , Y: -0 .25, Z: 2 .

In the HologramsHolograms folder in the Project panelProject panel , find the EnergyHubEnergyHub asset.

Drag and drop the EnergyHubEnergyHub object from the Project panelProject panel  to the HierarchyHierarchy  as a child ofchild of

HologramCollectionHologramCollection.

Select File > Save Scene As...File > Save Scene As...

Name the scene SharedHologramsSharedHolograms and click SaveSave.

Press the PlayPlay  button in Unity to preview your holograms.

Press PlayPlay  a second time to stop preview mode.

Expor t the project from Unity to Visual StudioExpor t the project from Unity to Visual Studio

In Unity select File > Build SettingsFile > Build Settings .

Click Add Open ScenesAdd Open Scenes  to add the scene.

Select Universal Windows PlatformUniversal Windows Platform in the PlatformPlatform list and click Switch PlatformSwitch Platform .

Set SDKSDK to Universal 10Universal 10 .

Set Target deviceTarget device to HoloLensHoloLens  and UWP Build TypeUWP Build Type to D3DD3D.

Check Unity C# ProjectsUnity C# Projects .

Click BuildBuild.

In the file explorer window that appears, create a New FolderNew Folder  named "App".

Single click the AppApp folder.

Press Select FolderSelect Folder .

When Unity is done, a File Explorer window will appear.

Open the AppApp folder.

Open SharedHolograms.slnSharedHolograms.sln to launch Visual Studio.

https://github.com/Microsoft/HolographicAcademy/tree/Holograms-240-SharedHolograms
https://www.youtube-nocookie.com/embed/c7qHYYW8rxQ


 Chapter 2 - Interaction

  ObjectivesObjectives

  InstructionsInstructions

 Chapter 3 - Shared Coordinates

Using the top toolbar in Visual Studio, change the target from Debug to ReleaseRelease and from ARM to X86X86 .

Click on the drop-down arrow next to Local Machine, and select Remote DeviceRemote Device.

Click Debug > Star t Without debuggingDebug > Star t Without debugging or press Ctr l + F5Ctr l + F5 . If this is the first time deploying to your

device, you will need to pair it with Visual Studio.

Put on your HoloLens and find the EnergyHub hologram.

Set the AddressAddress  to the name or IP address of your HoloLens. If you do not know your device IP

address, look in Settings > Network & Internet > Advanced OptionsSettings > Network & Internet > Advanced Options  or ask Cortana "Hey"Hey

Cor tana, What's my IP address?"Cor tana, What's my IP address?"

Leave the Authentication ModeAuthentication Mode set to UniversalUniversal .

Click SelectSelect

In this chapter, we'll interact with our holograms. First, we'll add a cursor to visualize our Gaze. Then, we'll add

Gestures and use our hand to place our holograms in space.

Use gaze input to control a cursor.

Use gesture input to interact with holograms.

GazeGaze

In the Hierarchy panelHierarchy panel  select the HologramCollectionHologramCollection object.

In the Inspector panelInspector panel  click the Add ComponentAdd Component button.

In the menu, type in the search box Gaze ManagerGaze Manager . Select the search result.

In the HoloToolkit-Sharing-240\Prefabs\InputHoloToolkit-Sharing-240\Prefabs\Input folder, find the CursorCursor  asset.

Drag and drop the CursorCursor  asset onto the HierarchyHierarchy .

GestureGesture

In the Hierarchy panelHierarchy panel  select the HologramCollectionHologramCollection object.

Click Add ComponentAdd Component and type Gesture ManagerGesture Manager  in the search field. Select the search result.

In the Hierarchy panelHierarchy panel , expand HologramCollectionHologramCollection.

Select the child EnergyHubEnergyHub object.

In the Inspector panelInspector panel  click the Add ComponentAdd Component button.

In the menu, type in the search box Hologram PlacementHologram Placement. Select the search result.

Save the scene by selecting File > Save SceneFile > Save Scene.

Deploy and enjoyDeploy and enjoy

Build and deploy to your HoloLens, using the instructions from the previous chapter.

Once the app launches on your HoloLens, move your head around and notice how the EnergyHub follows

your gaze.

Notice how the cursor appears when you gaze upon the hologram, and changes to a point light when not

gazing at a hologram.

Perform an air-tap to place the hologram. At this time in our project, you can only place the hologram once

(redeploy to try again).

https://www.youtube-nocookie.com/embed/W60xG15a8gc
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using UnityEngine;
using System.Collections.Generic;
using UnityEngine.Windows.Speech;
using Academy.HoloToolkit.Unity;
using Academy.HoloToolkit.Sharing;

public class HologramPlacement : Singleton<HologramPlacement>
{
    /// <summary>
    /// Tracks if we have been sent a transform for the anchor model.

It's fun to see and interact with holograms, but let's go further. We'll set up our first shared experience - a

hologram everyone can see together.

Setup a network for a shared experience.

Establish a common reference point.

Share coordinate systems across devices.

Everyone sees the same hologram!

The InternetClientSer verInternetClientSer ver  and PrivateNetworkClientSer verPrivateNetworkClientSer ver  capabilities must be declared for an app to connect to

the sharing server. This is done for you already in Holograms 240, but keep this in mind for your own projects.

1. In the Unity Editor, go to the player settings by navigating to "Edit > Project Settings > Player"

2. Click on the "Windows Store" tab

3. In the "Publishing Settings > Capabilities" section, check the InternetClientSer verInternetClientSer ver  capability and the

PrivateNetworkClientSer verPr ivateNetworkClientSer ver  capability

In the Project panelProject panel  navigate to the HoloToolkit-Sharing-240\Prefabs\SharingHoloToolkit-Sharing-240\Prefabs\Sharing folder.

Drag and drop the SharingSharing prefab into the Hierarchy panelHierarchy panel .

Next we need to launch the sharing service. Only one PCone PC in the shared experience needs to do this step.

In Unity - in the top-hand menu - select the HoloToolkit-Sharing-240 menuHoloToolkit-Sharing-240 menu.

Select the Launch Sharing Ser viceLaunch Sharing Ser vice item in the drop-down.

Check the Pr ivate NetworkPrivate Network option and click Allow AccessAllow Access  when the firewall prompt appears.

Note down the IPv4 address displayed in the Sharing Service console window. This is the same IP as the

machine the service is being run on.

Follow the rest of the instructions on all PCsall PCs  that will join the shared experience.

In the HierarchyHierarchy , select the SharingSharing object.

In the InspectorInspector , on the Sharing StageSharing Stage component, change the Ser ver AddressSer ver Address  from 'localhost' to the

IPv4 address of the machine running SharingService.exe.

In the HierarchyHierarchy  select the HologramCollectionHologramCollection object.

In the InspectorInspector  click the Add ComponentAdd Component button.

In the search box, type Impor t Expor t Anchor ManagerImpor t Expor t Anchor Manager . Select the search result.

In the Project panelProject panel  navigate to the Scr iptsScr ipts  folder.

Double-click the HologramPlacementHologramPlacement script to open it in Visual Studio.

Replace the contents with the code below.

https://www.youtube-nocookie.com/embed/Ey8yBgWiqtg


    /// Tracks if we have been sent a transform for the anchor model.
    /// The anchor model is rendered relative to the actual anchor.
    /// </summary>
    public bool GotTransform { get; private set; }

    private bool animationPlayed = false;

    void Start()
    {
        // We care about getting updates for the anchor transform.
        CustomMessages.Instance.MessageHandlers[CustomMessages.TestMessageID.StageTransform] = 
this.OnStageTransform;

        // And when a new user join we will send the anchor transform we have.
        SharingSessionTracker.Instance.SessionJoined += Instance_SessionJoined;
    }

    /// <summary>
    /// When a new user joins we want to send them the relative transform for the anchor if we have it.
    /// </summary>
    /// <param name="sender"></param>
    /// <param name="e"></param>
    private void Instance_SessionJoined(object sender, SharingSessionTracker.SessionJoinedEventArgs e)
    {
        if (GotTransform)
        {
            CustomMessages.Instance.SendStageTransform(transform.localPosition, transform.localRotation);
        }
    }

    void Update()
    {
        if (GotTransform)
        {
            if (ImportExportAnchorManager.Instance.AnchorEstablished &&
                animationPlayed == false)
            {
                // This triggers the animation sequence for the anchor model and 
                // puts the cool materials on the model.
                GetComponent<EnergyHubBase>().SendMessage("OnSelect");
                animationPlayed = true;
            }
        }
        else
        {
            transform.position = Vector3.Lerp(transform.position, ProposeTransformPosition(), 0.2f);
        }
    }

    Vector3 ProposeTransformPosition()
    {
        // Put the anchor 2m in front of the user.
        Vector3 retval = Camera.main.transform.position + Camera.main.transform.forward * 2;

        return retval;
    }

    public void OnSelect()
    {
        // Note that we have a transform.
        GotTransform = true;

        // And send it to our friends.
        CustomMessages.Instance.SendStageTransform(transform.localPosition, transform.localRotation);
    }

    /// <summary>
    /// When a remote system has a transform for us, we'll get it here.
    /// </summary>



    /// <param name="msg"></param>
    void OnStageTransform(NetworkInMessage msg)
    {
        // We read the user ID but we don't use it here.
        msg.ReadInt64();

        transform.localPosition = CustomMessages.Instance.ReadVector3(msg);
        transform.localRotation = CustomMessages.Instance.ReadQuaternion(msg);

        // The first time, we'll want to send the message to the anchor to do its animation and
        // swap its materials.
        if (GotTransform == false)
        {
            GetComponent<EnergyHubBase>().SendMessage("OnSelect");
        }

        GotTransform = true;
    }

    public void ResetStage()
    {
        // We'll use this later.
    }
}
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Back in Unity, select the HologramCollectionHologramCollection in the Hierarchy panelHierarchy panel .

In the Inspector panelInspector panel  click the Add ComponentAdd Component button.

In the menu, type in the search box App State ManagerApp State Manager . Select the search result.

Deploy and enjoyDeploy and enjoy

Build the project for your HoloLens devices.

Designate one HoloLens to deploy to first. You will need to wait for the Anchor to be uploaded to the service

before you can place the EnergyHub (this can take ~30-60 seconds). Until the upload is done, your tap

gestures will be ignored.

After the EnergyHub has been placed, its location will be uploaded to the service and you can then deploy to

all other HoloLens devices.

When a new HoloLens first joins the session, the location of the EnergyHub may not be correct on that

device. However, as soon as the anchor and EnergyHub locations have been downloaded from the service,

the EnergyHub should jump to the new, shared location. If this does not happen within ~30-60 seconds, walk

to where the original HoloLens was when setting the anchor to gather more environment clues. If the

location still does not lock on, redeploy to the device.

When the devices are all ready and running the app, look for the EnergyHub. Can you all agree on the

hologram's location and which direction the text is facing?

Everyone can now see the same hologram! Now let's see everyone else connected to our shared holographic

world. In this chapter, we'll grab the head location and rotation of all other HoloLens devices in the same sharing

session.

Discover each other in our shared experience.

Choose and share a player avatar.

Attach the player avatar next to everyone's heads.

https://www.youtube-nocookie.com/embed/5NxJWMV4BP8


using UnityEngine;
using Academy.HoloToolkit.Unity;

/// <summary>
/// Script to handle the user selecting the avatar.
/// </summary>
public class AvatarSelector : MonoBehaviour
{
    /// <summary>
    /// This is the index set by the PlayerAvatarStore for the avatar.
    /// </summary>
    public int AvatarIndex { get; set; }

    /// <summary>
    /// Called when the user is gazing at this avatar and air-taps it.
    /// This sends the user's selection to the rest of the devices in the experience.
    /// </summary>
    void OnSelect()
    {
        PlayerAvatarStore.Instance.DismissAvatarPicker();

        LocalPlayerManager.Instance.SetUserAvatar(AvatarIndex);
    }

    void Start()
    {
        // Add Billboard component so the avatar always faces the user.
        Billboard billboard = gameObject.GetComponent<Billboard>();
        if (billboard == null)
        {
            billboard = gameObject.AddComponent<Billboard>();
        }

        // Lock rotation along the Y axis.
        billboard.PivotAxis = PivotAxis.Y;
    }
}

using UnityEngine;
using System.Collections.Generic;
using UnityEngine.Windows.Speech;
using Academy.HoloToolkit.Unity;
using Academy.HoloToolkit.Sharing;

public class HologramPlacement : Singleton<HologramPlacement>
{

In the Project panelProject panel  navigate to the HologramsHolograms folder.

Drag and drop the PlayerAvatarStorePlayerAvatarStore into the HierarchyHierarchy .

In the Project panelProject panel  navigate to the Scr iptsScr ipts  folder.

Double-click the AvatarSelectorAvatarSelector  script to open it in Visual Studio.

Replace the contents with the code below.

In the HierarchyHierarchy  select the HologramCollectionHologramCollection object.

In the InspectorInspector  click Add ComponentAdd Component.

In the search box, type Local Player ManagerLocal Player Manager . Select the search result.

In the HierarchyHierarchy  select the HologramCollectionHologramCollection object.

In the InspectorInspector  click Add ComponentAdd Component.

In the search box, type Remote Player ManagerRemote Player Manager . Select the search result.

Open the HologramPlacementHologramPlacement script in Visual Studio.

Replace the contents with the code below.



{
    /// <summary>
    /// Tracks if we have been sent a transform for the model.
    /// The model is rendered relative to the actual anchor.
    /// </summary>
    public bool GotTransform { get; private set; }

    /// <summary>
    /// When the experience starts, we disable all of the rendering of the model.
    /// </summary>
    List<MeshRenderer> disabledRenderers = new List<MeshRenderer>();

    void Start()
    {
        // When we first start, we need to disable the model to avoid it obstructing the user picking a hat.
        DisableModel();

        // We care about getting updates for the model transform.
        CustomMessages.Instance.MessageHandlers[CustomMessages.TestMessageID.StageTransform] = 
this.OnStageTransform;

        // And when a new user join we will send the model transform we have.
        SharingSessionTracker.Instance.SessionJoined += Instance_SessionJoined;
    }

    /// <summary>
    /// When a new user joins we want to send them the relative transform for the model if we have it.
    /// </summary>
    /// <param name="sender"></param>
    /// <param name="e"></param>
    private void Instance_SessionJoined(object sender, SharingSessionTracker.SessionJoinedEventArgs e)
    {
        if (GotTransform)
        {
            CustomMessages.Instance.SendStageTransform(transform.localPosition, transform.localRotation);
        }
    }

    /// <summary>
    /// Turns off all renderers for the model.
    /// </summary>
    void DisableModel()
    {
        foreach (MeshRenderer renderer in gameObject.GetComponentsInChildren<MeshRenderer>())
        {
            if (renderer.enabled)
            {
                renderer.enabled = false;
                disabledRenderers.Add(renderer);
            }
        }

        foreach (MeshCollider collider in gameObject.GetComponentsInChildren<MeshCollider>())
        {
            collider.enabled = false;
        }
    }

    /// <summary>
    /// Turns on all renderers that were disabled.
    /// </summary>
    void EnableModel()
    {
        foreach (MeshRenderer renderer in disabledRenderers)
        {
            renderer.enabled = true;
        }

        foreach (MeshCollider collider in gameObject.GetComponentsInChildren<MeshCollider>())
        {



        {
            collider.enabled = true;
        }

        disabledRenderers.Clear();
    }

    void Update()
    {
        // Wait till users pick an avatar to enable renderers.
        if (disabledRenderers.Count > 0)
        {
            if (!PlayerAvatarStore.Instance.PickerActive &&
            ImportExportAnchorManager.Instance.AnchorEstablished)
            {
                // After which we want to start rendering.
                EnableModel();

                // And if we've already been sent the relative transform, we will use it.
                if (GotTransform)
                {
                    // This triggers the animation sequence for the model and
                    // puts the cool materials on the model.
                    GetComponent<EnergyHubBase>().SendMessage("OnSelect");
                }
            }
        }
        else if (GotTransform == false)
        {
            transform.position = Vector3.Lerp(transform.position, ProposeTransformPosition(), 0.2f);
        }
    }

    Vector3 ProposeTransformPosition()
    {
        // Put the model 2m in front of the user.
        Vector3 retval = Camera.main.transform.position + Camera.main.transform.forward * 2;

        return retval;
    }

    public void OnSelect()
    {
        // Note that we have a transform.
        GotTransform = true;

        // And send it to our friends.
        CustomMessages.Instance.SendStageTransform(transform.localPosition, transform.localRotation);
    }

    /// <summary>
    /// When a remote system has a transform for us, we'll get it here.
    /// </summary>
    /// <param name="msg"></param>
    void OnStageTransform(NetworkInMessage msg)
    {
        // We read the user ID but we don't use it here.
        msg.ReadInt64();

        transform.localPosition = CustomMessages.Instance.ReadVector3(msg);
        transform.localRotation = CustomMessages.Instance.ReadQuaternion(msg);

        // The first time, we'll want to send the message to the model to do its animation and
        // swap its materials.
        if (disabledRenderers.Count == 0 && GotTransform == false)
        {
            GetComponent<EnergyHubBase>().SendMessage("OnSelect");
        }



        GotTransform = true;
    }

    public void ResetStage()
    {
        // We'll use this later.
    }
}

Open the AppStateManagerAppStateManager  script in Visual Studio.

Replace the contents with the code below.



using UnityEngine;
using Academy.HoloToolkit.Unity;

/// <summary>
/// Keeps track of the current state of the experience.
/// </summary>
public class AppStateManager : Singleton<AppStateManager>
{
    /// <summary>
    /// Enum to track progress through the experience.
    /// </summary>
    public enum AppState
    {
        Starting = 0,
        WaitingForAnchor,
        WaitingForStageTransform,
        PickingAvatar,
        Ready
    }

    /// <summary>
    /// Tracks the current state in the experience.
    /// </summary>
    public AppState CurrentAppState { get; set; }

    void Start()
    {
        // We start in the 'picking avatar' mode.
        CurrentAppState = AppState.PickingAvatar;

        // We start by showing the avatar picker.
        PlayerAvatarStore.Instance.SpawnAvatarPicker();
    }

    void Update()
    {
        switch (CurrentAppState)
        {
            case AppState.PickingAvatar:
                // Avatar picking is done when the avatar picker has been dismissed.
                if (PlayerAvatarStore.Instance.PickerActive == false)
                {
                    CurrentAppState = AppState.WaitingForAnchor;
                }
                break;
            case AppState.WaitingForAnchor:
                if (ImportExportAnchorManager.Instance.AnchorEstablished)
                {
                    CurrentAppState = AppState.WaitingForStageTransform;
                    GestureManager.Instance.OverrideFocusedObject = HologramPlacement.Instance.gameObject;
                }
                break;
            case AppState.WaitingForStageTransform:
                // Now if we have the stage transform we are ready to go.
                if (HologramPlacement.Instance.GotTransform)
                {
                    CurrentAppState = AppState.Ready;
                    GestureManager.Instance.OverrideFocusedObject = null;
                }
                break;
        }
    }
}

Deploy and EnjoyDeploy and Enjoy
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using UnityEngine;
using Academy.HoloToolkit.Unity;

/// <summary>
/// Keeps track of the current state of the experience.
/// </summary>
public class AppStateManager : Singleton<AppStateManager>
{
    /// <summary>
    /// Enum to track progress through the experience.
    /// </summary>
    public enum AppState
    {
        Starting = 0,
        PickingAvatar,
        WaitingForAnchor,
        WaitingForStageTransform,
        Ready
    }

    // The object to call to make a projectile.
    GameObject shootHandler = null;

    /// <summary>
    /// Tracks the current state in the experience.
    /// </summary>
    public AppState CurrentAppState { get; set; }

    void Start()
    {
        // The shootHandler shoots projectiles.
        if (GetComponent<ProjectileLauncher>() != null)
        {
            shootHandler = GetComponent<ProjectileLauncher>().gameObject;
        }

Build and deploy the project to your HoloLens devices.

When you hear a pinging sound, find the avatar selection menu and select an avatar with the air-tap gesture.

If you're not looking at any holograms, the point light around your cursor will turn a different color when

your HoloLens is communicating with the service: initializing (dark purple), downloading the anchor (green),

importing/exporting location data (yellow), uploading the anchor (blue). If your point light around your

cursor is the default color (light purple), then you are ready to interact with other players in your session!

Look at other people connected to your space - there will be a holographic robot floating above their

shoulder and mimicking their head motions!

In this chapter, we'll make the anchor able to be placed on real-world surfaces. We'll use shared coordinates to

place that anchor in the middle point between everyone connected to the shared experience.

Place holograms on the spatial mapping mesh based on players’ head position.

In the Project panelProject panel  navigate to the HologramsHolograms folder.

Drag and drop the CustomSpatialMappingCustomSpatialMapping prefab onto the HierarchyHierarchy .

In the Project panelProject panel  navigate to the Scr iptsScr ipts  folder.

Double-click the AppStateManagerAppStateManager  script to open it in Visual Studio.

Replace the contents with the code below.

https://www.youtube-nocookie.com/embed/afFTwHQIw0s


        // We start in the 'picking avatar' mode.
        CurrentAppState = AppState.PickingAvatar;

        // Spatial mapping should be disabled when we start up so as not
        // to distract from the avatar picking.
        SpatialMappingManager.Instance.StopObserver();
        SpatialMappingManager.Instance.gameObject.SetActive(false);

        // On device we start by showing the avatar picker.
        PlayerAvatarStore.Instance.SpawnAvatarPicker();
    }

    public void ResetStage()
    {
        // If we fall back to waiting for anchor, everything needed to
        // get us into setting the target transform state will be setup.
        if (CurrentAppState != AppState.PickingAvatar)
        {
            CurrentAppState = AppState.WaitingForAnchor;
        }

        // Reset the underworld.
        if (UnderworldBase.Instance)
        {
            UnderworldBase.Instance.ResetUnderworld();
        }
    }

    void Update()
    {
        switch (CurrentAppState)
        {
            case AppState.PickingAvatar:
                // Avatar picking is done when the avatar picker has been dismissed.
                if (PlayerAvatarStore.Instance.PickerActive == false)
                {
                    CurrentAppState = AppState.WaitingForAnchor;
                }
                break;
            case AppState.WaitingForAnchor:
                // Once the anchor is established we need to run spatial mapping for a
                // little while to build up some meshes.
                if (ImportExportAnchorManager.Instance.AnchorEstablished)
                {
                    CurrentAppState = AppState.WaitingForStageTransform;
                    GestureManager.Instance.OverrideFocusedObject = HologramPlacement.Instance.gameObject;

                    SpatialMappingManager.Instance.gameObject.SetActive(true);
                    SpatialMappingManager.Instance.DrawVisualMeshes = true;
                    SpatialMappingDeformation.Instance.ResetGlobalRendering();
                    SpatialMappingManager.Instance.StartObserver();
                }
                break;
            case AppState.WaitingForStageTransform:
                // Now if we have the stage transform we are ready to go.
                if (HologramPlacement.Instance.GotTransform)
                {
                    CurrentAppState = AppState.Ready;
                    GestureManager.Instance.OverrideFocusedObject = shootHandler;
                }
                break;
        }
    }
}

In the Project panelProject panel  navigate to the Scr iptsScr ipts  folder.



using UnityEngine;
using System.Collections.Generic;
using UnityEngine.Windows.Speech;
using Academy.HoloToolkit.Unity;
using Academy.HoloToolkit.Sharing;

public class HologramPlacement : Singleton<HologramPlacement>
{
    /// <summary>
    /// Tracks if we have been sent a transform for the model.
    /// The model is rendered relative to the actual anchor.
    /// </summary>
    public bool GotTransform { get; private set; }

    /// <summary>
    /// When the experience starts, we disable all of the rendering of the model.
    /// </summary>
    List<MeshRenderer> disabledRenderers = new List<MeshRenderer>();

    /// <summary>
    /// We use a voice command to enable moving the target.
    /// </summary>
    KeywordRecognizer keywordRecognizer;

    void Start()
    {
        // When we first start, we need to disable the model to avoid it obstructing the user picking a hat.
        DisableModel();

        // We care about getting updates for the model transform.
        CustomMessages.Instance.MessageHandlers[CustomMessages.TestMessageID.StageTransform] = 
this.OnStageTransform;

        // And when a new user join we will send the model transform we have.
        SharingSessionTracker.Instance.SessionJoined += Instance_SessionJoined;

        // And if the users want to reset the stage transform.
        CustomMessages.Instance.MessageHandlers[CustomMessages.TestMessageID.ResetStage] = 
this.OnResetStage;

        // Setup a keyword recognizer to enable resetting the target location.
        List<string> keywords = new List<string>();
        keywords.Add("Reset Target");
        keywordRecognizer = new KeywordRecognizer(keywords.ToArray());
        keywordRecognizer.OnPhraseRecognized += KeywordRecognizer_OnPhraseRecognized;
        keywordRecognizer.Start();
    }

    /// <summary>
    /// When the keyword recognizer hears a command this will be called.  
    /// In this case we only have one keyword, which will re-enable moving the
    /// target.
    /// </summary>
    /// <param name="args">information to help route the voice command.</param>
    private void KeywordRecognizer_OnPhraseRecognized(PhraseRecognizedEventArgs args)
    {
        ResetStage();
    }

    /// <summary>
    /// Resets the stage transform, so users can place the target again.
    /// </summary>
    public void ResetStage()
    {
        GotTransform = false;

Double-click the HologramPlacementHologramPlacement script to open it in Visual Studio.

Replace the contents with the code below.



        GotTransform = false;

        // AppStateManager needs to know about this so that
        // the right objects get input routed to them.
        AppStateManager.Instance.ResetStage();

        // Other devices in the experience need to know about this as well.
        CustomMessages.Instance.SendResetStage();

        // And we need to reset the object to its start animation state.
        GetComponent<EnergyHubBase>().ResetAnimation();
    }

    /// <summary>
    /// When a new user joins we want to send them the relative transform for the model if we have it.
    /// </summary>
    /// <param name="sender"></param>
    /// <param name="e"></param>
    private void Instance_SessionJoined(object sender, SharingSessionTracker.SessionJoinedEventArgs e)
    {
        if (GotTransform)
        {
            CustomMessages.Instance.SendStageTransform(transform.localPosition, transform.localRotation);
        }
    }

    /// <summary>
    /// Turns off all renderers for the model.
    /// </summary>
    void DisableModel()
    {
        foreach (MeshRenderer renderer in gameObject.GetComponentsInChildren<MeshRenderer>())
        {
            if (renderer.enabled)
            {
                renderer.enabled = false;
                disabledRenderers.Add(renderer);
            }
        }

        foreach (MeshCollider collider in gameObject.GetComponentsInChildren<MeshCollider>())
        {
            collider.enabled = false;
        }
    }

    /// <summary>
    /// Turns on all renderers that were disabled.
    /// </summary>
    void EnableModel()
    {
        foreach (MeshRenderer renderer in disabledRenderers)
        {
            renderer.enabled = true;
        }

        foreach (MeshCollider collider in gameObject.GetComponentsInChildren<MeshCollider>())
        {
            collider.enabled = true;
        }

        disabledRenderers.Clear();
    }

    void Update()
    {
        // Wait till users pick an avatar to enable renderers.
        if (disabledRenderers.Count > 0)



        {
            if (!PlayerAvatarStore.Instance.PickerActive &&
            ImportExportAnchorManager.Instance.AnchorEstablished)
            {
                // After which we want to start rendering.
                EnableModel();

                // And if we've already been sent the relative transform, we will use it.
                if (GotTransform)
                {
                    // This triggers the animation sequence for the model and
                    // puts the cool materials on the model.
                    GetComponent<EnergyHubBase>().SendMessage("OnSelect");
                }
            }
        }
        else if (GotTransform == false)
        {
            transform.position = Vector3.Lerp(transform.position, ProposeTransformPosition(), 0.2f);
        }
    }

    Vector3 ProposeTransformPosition()
    {
        Vector3 retval;
        // We need to know how many users are in the experience with good transforms.
        Vector3 cumulatedPosition = Camera.main.transform.position;
        int playerCount = 1;
        foreach (RemotePlayerManager.RemoteHeadInfo remoteHead in 
RemotePlayerManager.Instance.remoteHeadInfos)
        {
            if (remoteHead.Anchored && remoteHead.Active)
            {
                playerCount++;
                cumulatedPosition += remoteHead.HeadObject.transform.position;
            }
        }

        // If we have more than one player ...
        if (playerCount > 1)
        {
            // Put the transform in between the players.
            retval = cumulatedPosition / playerCount;
            RaycastHit hitInfo;

            // And try to put the transform on a surface below the midpoint of the players.
            if (Physics.Raycast(retval, Vector3.down, out hitInfo, 5, 
SpatialMappingManager.Instance.LayerMask))
            {
                retval = hitInfo.point;
            }
        }
        // If we are the only player, have the model act as the 'cursor' ...
        else
        {
            // We prefer to put the model on a real world surface.
            RaycastHit hitInfo;

            if (Physics.Raycast(Camera.main.transform.position, Camera.main.transform.forward, out hitInfo, 
30, SpatialMappingManager.Instance.LayerMask))
            {
                retval = hitInfo.point;
            }
            else
            {
                // But if we don't have a ray that intersects the real world, just put the model 2m in
                // front of the user.
                retval = Camera.main.transform.position + Camera.main.transform.forward * 2;
            }



            }
        }
        return retval;
    }

    public void OnSelect()
    {
        // Note that we have a transform.
        GotTransform = true;

        // And send it to our friends.
        CustomMessages.Instance.SendStageTransform(transform.localPosition, transform.localRotation);
    }

    /// <summary>
    /// When a remote system has a transform for us, we'll get it here.
    /// </summary>
    /// <param name="msg"></param>
    void OnStageTransform(NetworkInMessage msg)
    {
        // We read the user ID but we don't use it here.
        msg.ReadInt64();

        transform.localPosition = CustomMessages.Instance.ReadVector3(msg);
        transform.localRotation = CustomMessages.Instance.ReadQuaternion(msg);

        // The first time, we'll want to send the message to the model to do its animation and
        // swap its materials.
        if (disabledRenderers.Count == 0 && GotTransform == false)
        {
            GetComponent<EnergyHubBase>().SendMessage("OnSelect");
        }

        GotTransform = true;
    }

    /// <summary>
    /// When a remote system has a transform for us, we'll get it here.
    /// </summary>
    void OnResetStage(NetworkInMessage msg)
    {
        GotTransform = false;

        GetComponent<EnergyHubBase>().ResetAnimation();
        AppStateManager.Instance.ResetStage();
    }
}

 Chapter 6 - Real-World Physics

  ObjectivesObjectives

Deploy and enjoyDeploy and enjoy

Build and deploy the project to your HoloLens devices.

When the app is ready, stand in a circle and notice how the EnergyHub appears in the center of everyone.

Tap to place the EnergyHub.

Try the voice command 'Reset Target' to pick the EnergyHub back up and work together as a group to move

the hologram to a new location.

In this chapter we'll add holograms that bounce off real-world surfaces. Watch your space fill up with projects

launched by both you and your friends!

Launch projectiles that bounce off real-world surfaces.

https://www.youtube-nocookie.com/embed/XNpQVSyXwMo


  InstructionsInstructions

 Chapter 7 - Grand Finale

  ObjectivesObjectives

  InstructionsInstructions

Share the projectiles so other players can see them.

In the HierarchyHierarchy  select the HologramCollectionHologramCollection object.

In the InspectorInspector  click Add ComponentAdd Component.

In the search box, type Projectile LauncherProjectile Launcher . Select the search result.

Deploy and enjoyDeploy and enjoy

Build and deploy to your HoloLens devices.

When the app is running on all devices, perform an air-tap to launch projectile at real world surfaces.

See what happens when your projectile collides with another player's avatar!

In this chapter, we'll uncover a portal that can only be discovered with collaboration.

Work together to launch enough projectiles at the anchor to uncover a secret portal!

In the Project panelProject panel  navigate to the HologramsHolograms folder.

Drag and drop the Under worldUnder world asset as a child of HologramCollectionchild of HologramCollection.

With HologramCollectionHologramCollection selected, click the Add ComponentAdd Component button in the InspectorInspector .

In the menu, type in the search box ExplodeTargetExplodeTarget. Select the search result.

With HologramCollectionHologramCollection selected, from the HierarchyHierarchy  drag the EnergyHubEnergyHub object to the TargetTarget field in

the InspectorInspector .

With HologramCollectionHologramCollection selected, from the HierarchyHierarchy  drag the Under worldUnder world object to the Under worldUnder world

field in the InspectorInspector .

Deploy and enjoyDeploy and enjoy

Build and deploy to your HoloLens devices.

When the app has launched, collaborate together to launch projectiles at the EnergyHub.

When the underworld appears, launch projectiles at underworld robots (hit a robot three times for extra fun).

https://www.youtube-nocookie.com/embed/kDUPUvZEqRg
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NOTENOTE
The Mixed Reality Academy tutorials were designed with HoloLens (1st gen) and Mixed Reality Immersive Headsets in

mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for guidance in

developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being used for

HoloLens 2. They will be maintained to continue working on the supported devices. There will be a new series of tutorials

that will be posted in the future that will demonstrate how to develop for HoloLens 2. This notice will be updated with a

link to those tutorials when they are posted.

In this course, you will learn how to add translation capabilities to a mixed reality application using Azure

Cognitive Services, with the Translator Text API.

The Translator Text API is a translation Service which works in near real-time. The Service is cloud-based, and,

using a REST API call, an app can make use of the neural machine translation technology to translate text to

another language. For more information, visit the Azure Translator Text API page.

Upon completion of this course, you will have a mixed reality application which will be able to do the following:

1. The user will speak into a microphone connected to an immersive (VR) headset (or the built-in microphone

of HoloLens).

2. The app will capture the dictation and send it to the Azure Translator Text API.

3. The translation result will be displayed in a simple UI group in the Unity Scene.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/mr-azure-301.md
https://azure.microsoft.com/services/cognitive-services/translator-text-api/
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NOTENOTE

 Prerequisites

NOTENOTE

 Before you start

This course will teach you how to get the results from the Translator Service into a Unity-based sample

application. It will be up to you to apply these concepts to a custom application you might be building.

While this course primarily focuses on Windows Mixed Reality immersive (VR) headsets, you can also apply what you learn

in this course to Microsoft HoloLens. As you follow along with the course, you will see notes on any changes you might

need to employ to support HoloLens. When using HoloLens, you may notice some echo during voice capture.

This tutorial is designed for developers who have basic experience with Unity and C#. Please also be aware that the

prerequisites and written instructions within this document represent what has been tested and verified at the time of

writing (May 2018). You are free to use the latest software, as listed within the install the tools article, though it should

not be assumed that the information in this course will perfectly match what you'll find in newer software than what's

listed below.

We recommend the following hardware and software for this course:

A development PC, compatible with Windows Mixed Reality for immersive (VR) headset development

Windows 10 Fall Creators Update (or later) with Developer mode enabled

The latest Windows 10 SDK

Unity 2017.4

Visual Studio 2017

A Windows Mixed Reality immersive (VR) headset or Microsoft HoloLens with Developer mode enabled

A set of headphones with a built-in microphone (if the headset doesn't have a built-in mic and speakers)

Internet access for Azure setup and translation retrieval

To avoid encountering issues building this project, it is strongly suggested that you create the project

mentioned in this tutorial in a root or near-root folder (long folder paths can cause issues at build-time).

The code in this tutorial will allow you to record from the default microphone device connected to your

PC. Make sure the default microphone device is set to the device you plan to use to capture your voice.

To allow your PC to enable dictation, go to Settings > Pr ivacy > Speech, inking & typingSettings > Pr ivacy > Speech, inking & typing and select

the button Turn On speech ser vices and typing suggestionsTurn On speech ser vices and typing suggestions .

If you're using a microphone and headphones connected to (or built-in to) your headset, make sure the

option “When I wear my headset, switch to headset mic” is turned on in Settings > Mixed reality >Settings > Mixed reality >

Audio and speechAudio and speech.

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://support.microsoft.com/help/4039260/windows-10-mixed-reality-pc-hardware-guidelines
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/hololens/hololens1-hardware


WARNINGWARNING

 Chapter 1 – The Azure Portal

Be aware that if you are developing for an immersive headset for this lab, you may experience audio output device issues.

This is due to an issue with Unity, which is fixed in later versions of Unity (Unity 2018.2). The issue prevents Unity from

changing the default audio output device at run time. As a work around, ensure you have completed the above steps,

and close and re-open the Editor, when this issue presents itself.

To use the Azure Translator API, you will need to configure an instance of the Service to be made available to

your application.

NOTENOTE

1. Log in to the Azure Portal.

If you do not already have an Azure account, you will need to create one. If you are following this tutorial in a

classroom or lab situation, ask your instructor or one of the proctors for help setting up your new account.

2. Once you are logged in, click on NewNew  in the top left corner and search for "Translator Text API." Select

EnterEnter .

https://portal.azure.com


NOTENOTE
The word NewNew may have been replaced with Create a resourceCreate a resource, in newer portals.

3. The new page will provide a description of the Translator Text API Service. At the bottom left of this page,

select the CreateCreate button, to create an association with this Service.

4. Once you have clicked on CreateCreate:

a. Insert your desired NameName for this Service instance.

b. Select an appropriate Subscr iptionSubscr iption.



c. Select the Pr icing TierPr icing Tier  appropriate for you, if this is the first time creating a Translator Text

Service, a free tier (named F0) should be available to you.

d. Choose a Resource GroupResource Group or create a new one. A resource group provides a way to monitor,

control access, provision and manage billing for a collection of Azure assets. It is recommended to

keep all the Azure Services associated with a single project (e.g. such as these labs) under a

common resource group).

If you wish to read more about Azure Resource Groups, please visit the resource group article.

e. Determine the LocationLocation for your resource group (if you are creating a new Resource Group). The

location would ideally be in the region where the application would run. Some Azure assets are

only available in certain regions.

f. You will also need to confirm that you have understood the Terms and Conditions applied to this

Service.

g. Select CreateCreate.

5. Once you have clicked on CreateCreate, you will have to wait for the Service to be created, this might take a

minute.

6. A notification will appear in the portal once the Service instance is created.

https://docs.microsoft.com/en-us/azure/azure-resource-manager/resource-group-portal


 Chapter 2 – Set up the Unity project

7. Click on the notification to explore your new Service instance.

8. Click the Go to resourceGo to resource button in the notification to explore your new Service instance. You will be

taken to your new Translator Text API Service instance.

9. Within this tutorial, your application will need to make calls to your Service, which is done through using

your Service’s Subscription Key.

10. From the Quick start page of your Translator Text Service, navigate to the first step, Grab your keys, and

click KeysKeys  (you can also achieve this by clicking the blue hyperlink Keys, located in the Services

navigation menu, denoted by the key icon). This will reveal your Service Keys.

11. Take a copy of one of the displayed keys, as you will need this later in your project.

Set up and test your mixed reality immersive headset.



NOTENOTE
You will not need motion controllers for this course. If you need support setting up an immersive headset, please follow

these steps.

The following is a typical set up for developing with mixed reality and, as such, is a good template for other

projects:

1. Open Unity and click NewNew .

2. You will now need to provide a Unity Project name. Insert MR_TranslationMR_Translation. Make sure the project type is

set to 3D3D. Set the Location to somewhere appropriate for you (remember, closer to root directories is

better). Then, click Create projectCreate project.

3. With Unity open, it is worth checking the default Scr ipt EditorScr ipt Editor  is set to Visual StudioVisual Studio. Go to Edit >Edit >

PreferencesPreferences  and then from the new window, navigate to External ToolsExternal Tools . Change External Scr iptExternal Scr ipt

EditorEditor  to Visual Studio 2017Visual Studio 2017 . Close the PreferencesPreferences  window.

https://support.microsoft.com/help/4043101/windows-10-set-up-windows-mixed-reality


4. Next, go to File > Build SettingsFile > Build Settings  and switch the platform to Universal Windows PlatformUniversal Windows Platform , by

clicking on the Switch PlatformSwitch Platform button.

5. Go to File > Build SettingsFile > Build Settings  and make sure that:

a. Target DeviceTarget Device is set to Any DeviceAny Device.

For Microsoft HoloLens, set Target DeviceTarget Device to HoloLens.

b. Build TypeBuild Type is set to D3DD3D

c. SDKSDK is set to Latest installedLatest installed

d. Visual Studio VersionVisual Studio Version is set to Latest installedLatest installed

e. Build and RunBuild and Run is set to Local MachineLocal Machine



f. Save the scene and add it to the build.

a. Do this by selecting Add Open ScenesAdd Open Scenes . A save window will appear.

b. Create a new folder for this, and any future, scene, then select the New folderNew folder  button, to

create a new folder, name it ScenesScenes .

c. Open your newly created ScenesScenes  folder, and then in the File name: text field, type

MR_TranslationSceneMR_TranslationScene, then press SaveSave.



Be aware, you must save your Unity scenes within the Assets folder, as they must be

associated with the Unity Project. Creating the scenes folder (and other similar folders)

is a typical way of structuring a Unity project.

g. The remaining settings, in Build Settings, should be left as default for now.

6. In the Build Settings window, click on the Player SettingsPlayer Settings  button, this will open the related panel in the

space where the Inspector is located.

7. In this panel, a few settings need to be verified:

a. In the Other SettingsOther Settings  tab:

a. Scr ipting Runtime VersionScr ipting Runtime Version should be StableStable (.NET 3.5 Equivalent).

b. Scr ipting BackendScripting Backend should be .NET.NET

c. API Compatibility LevelAPI Compatibility Level  should be .NET 4.6.NET 4.6



 Chapter 3 – Main Camera setup

b. Within the Publishing SettingsPublishing Settings  tab, under CapabilitiesCapabilities , check:

a. InternetClientInternetClient

b. MicrophoneMicrophone

c. Further down the panel, in XR SettingsXR Settings  (found below Publish SettingsPublish Settings ), tick Vir tual RealityVir tual Reality

Suppor tedSuppor ted, make sure the Windows Mixed Reality SDKWindows Mixed Reality SDK is added.

8. Back in Build SettingsBuild Settings , Unity C# Projects is no longer greyed out; tick the checkbox next to this.

9. Close the Build Settings window.

10. Save your Scene and Project (FILE > SAVE SCENE / FILE > SAVE PROJECTFILE > SAVE SCENE / FILE > SAVE PROJECT).



IMPORTANTIMPORTANT
If you wish to skip the Unity Set up component of this course, and continue straight into code, feel free to download this

.unitypackage, import it into your project as a Custom Package, and then continue from Chapter 5. You will still need to

create a Unity Project.

1. In the Hierarchy Panel, you will find an object called Main CameraMain Camera, this object represents your “head”

point of view once you are “inside” your application.

2. With the Unity Dashboard in front of you, select the Main Camera GameObjectMain Camera GameObject. You will notice that the

Inspector Panel (generally found to the right, within the Dashboard) will show the various components of

that GameObject, with Transform at the top, followed by Camera, and some other components. You will

need to reset the Transform of the Main Camera, so it is positioned correctly.

3. To do this, select the GearGear  icon next to the Camera’s Transform component, and selecting ResetReset.

4. The Transform component should then look like:

a. The Position is set to 0, 0 , 00, 0 , 0

b. Rotation is set to 0, 0 , 00, 0 , 0

c. And Scale is set to 1, 1 , 11, 1 , 1

5. Next, with the Main CameraMain Camera object selected, see the Add ComponentAdd Component button located at the very

bottom of the Inspector Panel.

6. Select that button, and search (by either typing Audio Source into the search field or navigating the

sections) for the component called Audio SourceAudio Source as shown below and select it (pressing enter on it also

works).

7. An Audio Source component will be added to the Main CameraMain Camera, as demonstrated below.

https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20301%20-%20Language%20translation/Azure-MR-301.unitypackage
https://docs.unity3d.com/Manual/AssetPackages.html


 Chapter 4 – Setup Debug Canvas

NOTENOTE
For Microsoft HoloLens, you will need to also change the following, which are part of the CameraCamera component on

your Main CameraMain Camera:

Clear Flags:Clear Flags:  Solid Color.

BackgroundBackground ‘Black, Alpha 0’ – Hex color: #00000000.

To show the input and output of the translation, a basic UI needs to be created. For this course, you will create a

Canvas UI object, with several ‘Text’ objects to show the data.

1. Right-click in an empty area of the Hierarchy Panel, under UIUI, add a CanvasCanvas .



2. With the Canvas object selected, in the Inspector Panel (within the ‘Canvas’ component), change RenderRender

ModeMode to World SpaceWorld Space.

3. Next, change the following parameters in the Inspector Panel’s Rect Transform:

a. POS - XX 0 YY  0 ZZ 40

b. Width - 500

c. Height - 300

d. Scale - XX 0.13 YY  0.13 ZZ 0.13

4. Right click on the CanvasCanvas  in the Hierarchy Panel, under UIUI, and add a PanelPanel . This PanelPanel  will provide a

background to the text that you will be displaying in the scene.

5. Right click on the PanelPanel  in the Hierarchy Panel, under UIUI, and add a Text objectText object. Repeat the same

process until you have created four UI Text objects in total (Hint: if you have the first ‘Text’ object selected,

you can simply press ‘Ctr l’  + ‘D’‘Ctr l’  + ‘D’ , to duplicate it, until you have four in total).

6. For each Text ObjectText Object, select it and use the below tables to set the parameters in the Inspector Panel.

a. For the Rect Transform component:



N A M EN A M E
T RA N SF O RM  -T RA N SF O RM  -
P O SIT IO NP O SIT IO N W IDT HW IDT H H EIGH TH EIGH T

MicrophoneStatusLabel XX -80 YY  90 ZZ 0 300 30

AzureResponseLabel XX -80 YY  30 ZZ 0 300 30

DictationLabel XX -80 YY  -30 ZZ 0 300 30

TranslationResultLabel XX -80 YY  -90 ZZ 0 300 30

N A M EN A M E T EXTT EXT F O N T  SIZ EF O N T  SIZ E

MicrophoneStatusLabel Microphone Status: 20

AzureResponseLabel Azure Web Response 20

DictationLabel You just said: 20

TranslationResultLabel Translation: 20

b. For the Text (Scr ipt)Text (Scr ipt)  component:

c. Also, make the Font Style BoldBold. This will make the text easier to read.

7. For each UI Text object created in Chapter 5, create a new child UI Text objectUI Text object. These children will display

the output of the application. Create child objects through right-clicking your intended parent (e.g.

MicrophoneStatusLabel) and then select UIUI and then select TextText.



8. For each of these children, select it and use the below tables to set the parameters in the Inspector Panel.

N A M EN A M E
T RA N SF O RM  -T RA N SF O RM  -
P O SIT IO NP O SIT IO N W IDT HW IDT H H EIGH TH EIGH T

MicrophoneStatusText X 0 Y -30 Z 0 300 30

AzureResponseText X 0 Y -30 Z 0 300 30

DictationText X 0 Y -30 Z 0 300 30

TranslationResultText X 0 Y -30 Z 0 300 30

N A M EN A M E T EXTT EXT F O N T  SIZ EF O N T  SIZ E

MicrophoneStatusText ?? 20

AzureResponseText ?? 20

DictationText ?? 20

TranslationResultText ?? 20

a. For the Rect TransformRect Transform component:

b. For the Text (Scr ipt)Text (Scr ipt)  component:

9. Next, select the 'centre' alignment option for each text component:

10. To ensure the child UI Textchild UI Text objects are easily readable, change their Color. Do this by clicking on the bar

(currently ‘Black’) next to Color.

11. Then, in the new, little, Color window, change the Hex Color to: 0032EAFF0032EAFF



 Chapter 5 – Create the Results class

12. Below is how the UIUI should look.

a. In the Hierarchy Panel:

b. In the Scene and Game Views:

The first script you need to create is the Results class, which is responsible for providing a way to see the results

of translation. The Class stores and displays the following:

The response result from Azure.



The microphone status.

The result of the dictation (voice to text).

The result of the translation.

To create this class:

1. Right-click in the Project Panel, then Create > FolderCreate > Folder . Name the folder Scr iptsScr ipts .

2. With the Scr iptsScr ipts  folder create, double click it to open. Then within that folder, right-click, and select

Create >Create > then C# Scr iptC# Scr ipt. Name the script Results.

3. Double click on the new Results script to open it with Visual StudioVisual Studio.

4. Insert the following namespaces:



    using UnityEngine;
    using UnityEngine.UI;

    public static Results instance;

    [HideInInspector] 
    public string azureResponseCode;

    [HideInInspector] 
    public string translationResult;

    [HideInInspector] 
    public string dictationResult;

    [HideInInspector] 
    public string micStatus;

    public Text microphoneStatusText;

    public Text azureResponseText;

    public Text dictationText;

    public Text translationResultText;

    private void Awake() 
    { 
        // Set this class to behave similar to singleton 
        instance = this;           
    } 

5. Inside the Class insert the following variables:

6. Then add the Awake() method, which will be called when the class initializes.

7. Finally, add the methods which are responsible for outputting the various results information to the UI.
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    /// <summary>
    /// Stores the Azure response value in the static instance of Result class.
    /// </summary>
    public void SetAzureResponse(string result)
    {
        azureResponseCode = result;
        azureResponseText.text = azureResponseCode;
    }

    /// <summary>
    /// Stores the translated result from dictation in the static instance of Result class. 
    /// </summary>
    public void SetDictationResult(string result)
    {
        dictationResult = result;
        dictationText.text = dictationResult;
    }

    /// <summary>
    /// Stores the translated result from Azure Service in the static instance of Result class. 
    /// </summary>
    public void SetTranslatedResult(string result)
    {
        translationResult = result;
        translationResultText.text = translationResult;
    }

    /// <summary>
    /// Stores the status of the Microphone in the static instance of Result class. 
    /// </summary>
    public void SetMicrophoneStatus(string result)
    {
        micStatus = result;
        microphoneStatusText.text = micStatus;
    }

8. Be sure to save your changes in Visual Studio before returning to Unity.

The second class you are going to create is the MicrophoneManager.

This class is responsible for :

Detecting the recording device attached to the headset or machine (whichever is the default).

Capture the audio (voice) and use dictation to store it as a string.

Once the voice has paused, submit the dictation to the Translator class.

Host a method that can stop the voice capture if desired.

To create this class:

    using UnityEngine; 
    using UnityEngine.Windows.Speech;

1. Double click on the Scr iptsScr ipts  folder, to open it.

2. Right-click inside the Scr iptsScr ipts  folder, click Create > C# Scr iptCreate > C# Scr ipt. Name the script MicrophoneManager.

3. Double click on the new script to open it with Visual Studio.

4. Update the namespaces to be the same as the following, at the top of the MicrophoneManager class:



    // Help to access instance of this object 
    public static MicrophoneManager instance; 

    // AudioSource component, provides access to mic 
    private AudioSource audioSource; 

    // Flag indicating mic detection 
    private bool microphoneDetected; 

    // Component converting speech to text 
    private DictationRecognizer dictationRecognizer; 

    private void Awake() 
    { 
        // Set this class to behave similar to singleton 
        instance = this; 
    } 

    void Start() 
    { 
        //Use Unity Microphone class to detect devices and setup AudioSource 
        if(Microphone.devices.Length > 0) 
        { 
            Results.instance.SetMicrophoneStatus("Initialising..."); 
            audioSource = GetComponent<AudioSource>(); 
            microphoneDetected = true; 
        } 
        else 
        { 
            Results.instance.SetMicrophoneStatus("No Microphone detected"); 
        } 
    } 

5. Then, add the following variables inside the MicrophoneManager class:

6. Code for the Awake() and Start() methods now needs to be added. These will be called when the class

initializes:

7. You can delete the Update() method since this class will not use it.

8. Now you need the methods that the App uses to start and stop the voice capture, and pass it to the

Translator class, that you will build soon. Copy the following code and paste it beneath the Start() method.



WARNINGWARNING

 Chapter 7 – Call to Azure and translator service

    /// <summary> 
    /// Start microphone capture. Debugging message is delivered to the Results class. 
    /// </summary> 
    public void StartCapturingAudio() 
    { 
        if(microphoneDetected) 
        {               
            // Start dictation 
            dictationRecognizer = new DictationRecognizer(); 
            dictationRecognizer.DictationResult += DictationRecognizer_DictationResult; 
            dictationRecognizer.Start(); 

            // Update UI with mic status 
            Results.instance.SetMicrophoneStatus("Capturing..."); 
        }      
    } 

    /// <summary> 
    /// Stop microphone capture. Debugging message is delivered to the Results class. 
    /// </summary> 
    public void StopCapturingAudio() 
    { 
        Results.instance.SetMicrophoneStatus("Mic sleeping"); 
        Microphone.End(null); 
        dictationRecognizer.DictationResult -= DictationRecognizer_DictationResult; 
        dictationRecognizer.Dispose(); 
    }

TIPTIP

    /// <summary>
    /// This handler is called every time the Dictation detects a pause in the speech. 
    /// Debugging message is delivered to the Results class.
    /// </summary>
    private void DictationRecognizer_DictationResult(string text, ConfidenceLevel confidence)
    {
        // Update UI with dictation captured
        Results.instance.SetDictationResult(text);

        // Start the coroutine that process the dictation through Azure 
        StartCoroutine(Translator.instance.TranslateWithUnityNetworking(text));   
    }

Though this application will not make use of it, the StopCapturingAudio() method has also been provided here,

should you want to implement the ability to stop capturing audio in your application.

9. You now need to add a Dictation Handler that will be invoked when the voice stops. This method will then

pass the dictated text to the Translator class.

10. Be sure to save your changes in Visual Studio before returning to Unity.

At this point you will notice an error appearing in the Unity Editor Console Panel (“The name ‘Translator’ does not exist...”).

This is because the code references the Translator class, which you will create in the next chapter.

The last script you need to create is the Translator class.



This class is responsible for :

Authenticating the App with Azure, in exchange for an Auth TokenAuth Token.

Use the Auth TokenAuth Token to submit text (received from the MicrophoneManager Class) to be translated.

Receive the translated result and pass it to the Results Class to be visualized in the UI.

To create this Class:

    using System;
    using System.Collections;
    using System.Xml.Linq;
    using UnityEngine;
    using UnityEngine.Networking;

    public static Translator instance; 
    private string translationTokenEndpoint = 
"https://api.cognitive.microsoft.com/sts/v1.0/issueToken"; 
    private string translationTextEndpoint = 
"https://api.microsofttranslator.com/v2/http.svc/Translate?"; 
    private const string ocpApimSubscriptionKeyHeader = "Ocp-Apim-Subscription-Key"; 

    //Substitute the value of authorizationKey with your own Key 
    private const string authorizationKey = "-InsertYourAuthKeyHere-"; 
    private string authorizationToken; 

    // languages set below are: 
    // English 
    // French 
    // Italian 
    // Japanese 
    // Korean 
    public enum Languages { en, fr, it, ja, ko }; 
    public Languages from = Languages.en; 
    public Languages to = Languages.it; 

NOTENOTE

1. Go to the Scr iptsScr ipts  folder you created previously.

2. Right-click in the Project PanelProject Panel , Create > C# Scr iptCreate > C# Scr ipt. Call the script Translator.

3. Double click on the new Translator script to open it with Visual Studiowith Visual Studio.

4. Add the following namespaces to the top of the file:

5. Then add the following variables inside the Translator class:

The languages inserted into the languages enumenum are just examples. Feel free to add more if you wish; the API

supports over 60 languages (including Klingon)!

There is a more interactive page covering available languages, though be aware the page only appears to work

when the site language is set to '' (and the Microsoft site will likely redirect to your native language). You can

change site language at the bottom of the page or by altering the URL.

The authorizationKeyauthorizationKey value, in the above code snippet, must be the KeyKey you received when you subscribed

to the Azure Translator Text API. This was covered in Chapter 1.

6. Code for the Awake() and Start() methods now needs to be added.

7. In this case, the code will make a call to Azure using the authorization Key, to get a Token.

https://docs.microsoft.com/en-us/azure/cognitive-services/translator/languages
https://www.microsoft.com/translator/business/languages/


    private void Awake() 
    { 
        // Set this class to behave similar to singleton  
        instance = this; 
    } 

    // Use this for initialization  
    void Start() 
    { 
        // When the application starts, request an auth token 
        StartCoroutine("GetTokenCoroutine", authorizationKey); 
    }

NOTENOTE

    /// <summary> 
    /// Request a Token from Azure Translation Service by providing the access key. 
    /// Debugging result is delivered to the Results class. 
    /// </summary> 
    private IEnumerator GetTokenCoroutine(string key)
    {
        if (string.IsNullOrEmpty(key))
        {
            throw new InvalidOperationException("Authorization key not set.");
        }

        using (UnityWebRequest unityWebRequest = UnityWebRequest.Post(translationTokenEndpoint, 
string.Empty))
        {
            unityWebRequest.SetRequestHeader("Ocp-Apim-Subscription-Key", key);
            yield return unityWebRequest.SendWebRequest();

            long responseCode = unityWebRequest.responseCode;

            // Update the UI with the response code 
            Results.instance.SetAzureResponse(responseCode.ToString());

            if (unityWebRequest.isNetworkError || unityWebRequest.isHttpError)
            {
                Results.instance.azureResponseText.text = unityWebRequest.error;
                yield return null;
            }
            else
            {
                authorizationToken = unityWebRequest.downloadHandler.text;
            }
        }

        // After receiving the token, begin capturing Audio with the MicrophoneManager Class 
        MicrophoneManager.instance.StartCapturingAudio();
    }

The token will expire after 10 minutes. Depending on the scenario for your app, you might have to make the same

coroutine call multiple times.

8. The coroutine to obtain the Token is the following:
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WARNINGWARNING

    /// <summary> 
    /// Request a translation from Azure Translation Service by providing a string.  
    /// Debugging result is delivered to the Results class. 
    /// </summary> 
    public IEnumerator TranslateWithUnityNetworking(string text)
    {
        // This query string will contain the parameters for the translation 
        string queryString = string.Concat("text=", Uri.EscapeDataString(text), "&from=", from, 
"&to=", to);

        using (UnityWebRequest unityWebRequest = UnityWebRequest.Get(translationTextEndpoint + 
queryString))
        {
            unityWebRequest.SetRequestHeader("Authorization", "Bearer " + authorizationToken);
            unityWebRequest.SetRequestHeader("Accept", "application/xml");
            yield return unityWebRequest.SendWebRequest();

            if (unityWebRequest.isNetworkError || unityWebRequest.isHttpError)
            {
                Debug.Log(unityWebRequest.error);
                yield return null;
            }

            // Parse out the response text from the returned Xml
            string result = XElement.Parse(unityWebRequest.downloadHandler.text).Value;
            Results.instance.SetTranslatedResult(result);
        }
    }

If you edit the name of the IEnumerator method GetTokenCoroutine()GetTokenCoroutine() , you need to update the StartCoroutine

and StopCoroutine call string values in the above code. As per Unity documentation, to Stop a specific Coroutine,

you need to use the string value method.

9. Next, add the coroutine (with a “support” stream method right below it) to obtain the translation of the

text received by the MicrophoneManager class. This code creates a query string to send to the Azure

Translator Text API, and then uses the internal Unity UnityWebRequest class to make a ‘Get’ call to the

endpoint with the query string. The result is then used to set the translation in your Results object. The

code below shows the implementation:

10. Be sure to save your changes in Visual Studio before returning to Unity.

1. Back in the Unity Editor, click and drag the Results class from the Scr iptsScr ipts  folder to the Main CameraMain Camera

object in the Hierarchy Panel.

2. Click on the Main CameraMain Camera and look at the Inspector Panel. You will notice that within the newly added

Script component, there are four fields with empty values. These are the output references to the

properties in the code.

3. Drag the appropriate TextText objects from the Hierarchy Panel to those four slots, as shown in the image

below.

https://docs.unity3d.com/ScriptReference/MonoBehaviour.StartCoroutine.html
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WARNINGWARNING

 Chapter 10 – Build the UWP solution and sideload on local machine

4. Next, click and drag the Translator class from the Scr iptsScr ipts  folder to the Main CameraMain Camera object in the

Hierarchy Panel.

5. Then, click and drag the MicrophoneManager class from the Scr iptsScr ipts  folder to the Main CameraMain Camera object

in the Hierarchy Panel.

6. Lastly, click on the Main CameraMain Camera and look at the Inspector Panel. You will notice that in the script you

dragged on, there are two drop down boxes that will allow you to set the languages.

At this point you need to test that the Scene has been properly implemented.

Ensure that:

All the settings mentioned in Chapter 1 are set correctly.

The Results, Translator, and MicrophoneManager, scripts are attached to the Main CameraMain Camera object.

You have placed your Azure Translator Text API Service KeyKey  within the authorizationKeyauthorizationKey  variable within the

Translator Script.

All the fields in the Main Camera Inspector Panel are assigned properly.

Your microphone is working when running your scene (if not, check that your attached microphone is the

default device, and that you have set it up correctly within Windows).

You can test the immersive headset by pressing the PlayPlay  button in the Unity Editor. The App should be

functioning through the attached immersive headset.

If you see an error in the Unity console about the default audio device changing, the scene may not function as expected.

This is due to the way the mixed reality portal deals with built-in microphones for headsets that have them. If you see this

error, simply stop the scene and start it again and things should work as expected.

Everything needed for the Unity section of this project has now been completed, so it is time to build it from

Unity.

1. Navigate to Build SettingsBuild Settings : File > Build Settings...File > Build Settings...

2. From the Build SettingsBuild Settings  window, click BuildBuild.

https://support.microsoft.com/help/4027981/windows-how-to-set-up-and-test-microphones-in-windows-10


 Chapter 11 – Deploy your application

3. If not already, tick Unity C# ProjectsUnity C# Projects .

4. Click BuildBuild. Unity will launch a File Explorer window, where you need to create and then select a folder to

build the app into. Create that folder now, and name it App. Then with the App folder selected, press

Select FolderSelect Folder .

5. Unity will begin building your project to the App folder.

6. Once Unity has finished building (it might take some time), it will open a File Explorer window at the

location of your build (check your task bar, as it may not always appear above your windows, but will

notify you of the addition of a new window).

To deploy your application:

1. Navigate to your new Unity build (the App folder) and open the solution file with Visual Studio.

2. In the Solution Configuration select DebugDebug.

3. In the Solution Platform, select x86x86 , Local MachineLocal Machine.

For the Microsoft HoloLens, you may find it easier to set this to Remote Machine, so that you are not

tethered to your computer. Though, you will need to also do the following:

Know the IP AddressIP Address  of your HoloLens, which can be found within the Settings > Network &

Internet > Wi-Fi > Advanced Options; the IPv4 is the address you should use.

Ensure Developer Mode is OnOn; found in Settings > Update & Security > For developers.



 Your finished Translation Text API application

 Bonus exercises
  Exercise 1Exercise 1

  Exercise 2Exercise 2

4. Go to Build menuBuild menu and click on Deploy SolutionDeploy Solution to sideload the application to your PC.

5. Your App should now appear in the list of installed apps, ready to be launched.

6. Once launched, the App will prompt you to authorize access to the Microphone. Make sure to click the

YESYES  button.

7. You are now ready to start translating!

Congratulations, you built a mixed reality app that leverages the Azure Translation Text API to convert speech to

translated text.

Can you add text-to-speech functionality to the app, so that the returned text is spoken?

Make it possible for the user to change the source and output languages ('from' and 'to') within the app itself, so

the app does not need to be rebuilt every time you want to change languages.
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NOTENOTE
The Mixed Reality Academy tutorials were designed with HoloLens (1st gen) and Mixed Reality Immersive Headsets in

mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for guidance in

developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being used for

HoloLens 2. They will be maintained to continue working on the supported devices. There will be a new series of tutorials

that will be posted in the future that will demonstrate how to develop for HoloLens 2. This notice will be updated with a

link to those tutorials when they are posted.

In this course, you will learn how to recognize visual content within a provided image, using Azure Computer

Vision capabilities in a mixed reality application.

Recognition results will be displayed as descriptive tags. You can use this service without needing to train a

machine learning model. If your implementation requires training a machine learning model, see MR and Azure

302b.

The Microsoft Computer Vision is a set of APIs designed to provide developers with image processing and

analysis (with return information), using advanced algorithms, all from the cloud. Developers upload an image

or image URL, and the Microsoft Computer Vision API algorithms analyze the visual content, based upon inputs

chosen the user, which then can return information, including, identifying the type and quality of an image,

detect human faces (returning their coordinates), and tagging, or categorizing images. For more information,

visit the Azure Computer Vision API page.

Having completed this course, you will have a mixed reality HoloLens application, which will be able to do the

following:

1. Using the Tap gesture, the camera of the HoloLens will capture an image.

2. The image will be sent to the Azure Computer Vision API Service.

3. The objects recognized will be listed in a simple UI group positioned in the Unity Scene.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/mr-azure-302.md
https://azure.microsoft.com/services/cognitive-services/computer-vision/
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NOTENOTE

 Prerequisites

NOTENOTE

 Before you start

 

In your application, it is up to you as to how you will integrate the results with your design. This course is

designed to teach you how to integrate an Azure Service with your Unity project. It is your job to use the

knowledge you gain from this course to enhance your mixed reality application.

While this course primarily focuses on HoloLens, you can also apply what you learn in this course to Windows Mixed

Reality immersive (VR) headsets. Because immersive (VR) headsets do not have accessible cameras, you will need an

external camera connected to your PC. As you follow along with the course, you will see notes on any changes you might

need to employ to support immersive (VR) headsets.

This tutorial is designed for developers who have basic experience with Unity and C#. Please also be aware that the

prerequisites and written instructions within this document represent what has been tested and verified at the time of

writing (May 2018). You are free to use the latest software, as listed within the install the tools article, though it should

not be assumed that the information in this course will perfectly match what you'll find in newer software than what's

listed below.

We recommend the following hardware and software for this course:

A development PC, compatible with Windows Mixed Reality for immersive (VR) headset development

Windows 10 Fall Creators Update (or later) with Developer mode enabled

The latest Windows 10 SDK

Unity 2017.4

Visual Studio 2017

A Windows Mixed Reality immersive (VR) headset or Microsoft HoloLens with Developer mode enabled

A camera connected to your PC (for immersive headset development)

Internet access for Azure setup and Computer Vision API retrieval

1. To avoid encountering issues building this project, it is strongly suggested that you create the project

mentioned in this tutorial in a root or near-root folder (long folder paths can cause issues at build-time).

2. Set up and test your HoloLens. If you need support setting up your HoloLens, make sure to visit the HoloLens

setup article.

3. It is a good idea to perform Calibration and Sensor Tuning when beginning developing a new HoloLens App

(sometimes it can help to perform those tasks for each user).

For help on Calibration, please follow this link to the HoloLens Calibration article.

For help on Sensor Tuning, please follow this link to the HoloLens Sensor Tuning article.

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://support.microsoft.com/help/4039260/windows-10-mixed-reality-pc-hardware-guidelines
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens-setup
https://docs.microsoft.com/en-us/hololens/hololens-calibration#hololens-2
https://docs.microsoft.com/en-us/hololens/hololens-updates


Chapter 1 – The Azure Portal
To use the Computer Vision API service in Azure, you will need to configure an instance of the service to be

made available to your application.

NOTENOTE

NOTENOTE

1. First, log in to the Azure Portal.

If you do not already have an Azure account, you will need to create one. If you are following this tutorial in a

classroom or lab situation, ask your instructor or one of the proctors for help setting up your new account.

2. Once you are logged in, click on NewNew  in the top left corner, and search for Computer Vision API, and click

EnterEnter .

The word NewNew may have been replaced with Create a resourceCreate a resource, in newer portals.

3. The new page will provide a description of the Computer Vision API service. At the bottom left of this

page, select the CreateCreate button, to create an association with this service.

https://portal.azure.com


4. Once you have clicked on CreateCreate:

a. Insert your desired NameName for this service instance.

b. Select a Subscr iptionSubscr iption.

c. Select the Pr icing TierPr icing Tier  appropriate for you, if this is the first time creating a Computer Vision API

Service, a free tier (named F0) should be available to you.

d. Choose a Resource GroupResource Group or create a new one. A resource group provides a way to monitor,

control access, provision and manage billing for a collection of Azure assets. It is recommended to

keep all the Azure services associated with a single project (e.g. such as these labs) under a

common resource group).

If you wish to read more about Azure Resource Groups, please visit the resource group article.

e. Determine the Location for your resource group (if you are creating a new Resource Group). The

location would ideally be in the region where the application would run. Some Azure assets are

only available in certain regions.

f. You will also need to confirm that you have understood the Terms and Conditions applied to this

Service.

g. Click Create.

https://docs.microsoft.com/en-us/azure/azure-resource-manager/resource-group-portal


5. Once you have clicked on CreateCreate, you will have to wait for the service to be created, this might take a

minute.

6. A notification will appear in the portal once the Service instance is created.

7. Click on the notification to explore your new Service instance.

8. Click the Go to resourceGo to resource button in the notification to explore your new Service instance. You will be

taken to your new Computer Vision API service instance.



9. Within this tutorial, your application will need to make calls to your service, which is done through using

your service’s Subscription Key.

10. From the Quick start page, of your Computer Vision API service, navigate to the first step, Grab your keys,

and click KeysKeys  (you can also achieve this by clicking the blue hyperlink Keys, located in the services

navigation menu, denoted by the key icon). This will reveal your service Keys.

11. Take a copy of one of the displayed keys, as you will need this later in your project.

12. Go back to the Quick start page, and from there, fetch your endpoint. Be aware yours may be different,

depending on your region (which if it is, you will need to make a change to your code later). Take a copy

of this endpoint for use later :
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TIPTIP
You can check what the various endpoints are HERE.

The following is a typical set up for developing with mixed reality, and as such, is a good template for other

projects.

1. Open Unity and click NewNew .

2. You will now need to provide a Unity Project name. Insert MR_ComputerVisionMR_ComputerVision. Make sure the project

type is set to 3D3D. Set the LocationLocation to somewhere appropriate for you (remember, closer to root

directories is better). Then, click Create projectCreate project.

3. With Unity open, it is worth checking the default Scr ipt EditorScr ipt Editor  is set to Visual StudioVisual Studio. Go to Edit >Edit >

PreferencesPreferences  and then from the new window, navigate to External ToolsExternal Tools . Change External Scr iptExternal Scr ipt

EditorEditor  to Visual Studio 2017Visual Studio 2017 . Close the PreferencesPreferences  window.

https://westus.dev.cognitive.microsoft.com/docs/services/56f91f2d778daf23d8ec6739/operations/56f91f2e778daf14a499e1fa


4. Next, go to File > Build SettingsFile > Build Settings  and select Universal Windows PlatformUniversal Windows Platform , then click on the SwitchSwitch

PlatformPlatform button to apply your selection.

5. While still in File > Build SettingsFile > Build Settings  and make sure that:

a. Target DeviceTarget Device is set to HoloLensHoloLens

For the immersive headsets, set Target DeviceTarget Device to Any Device.

b. Build TypeBuild Type is set to D3DD3D

c. SDKSDK is set to Latest installedLatest installed

d. Visual Studio VersionVisual Studio Version is set to Latest installedLatest installed

e. Build and RunBuild and Run is set to Local MachineLocal Machine

f. Save the scene and add it to the build.

a. Do this by selecting Add Open ScenesAdd Open Scenes . A save window will appear.



b. Create a new folder for this, and any future, scene, then select the New folderNew folder  button, to

create a new folder, name it ScenesScenes .

c. Open your newly created ScenesScenes  folder, and then in the File name: text field, type

MR_ComputerVisionSceneMR_ComputerVisionScene, then click SaveSave.



Be aware, you must save your Unity scenes within the Assets folder, as they must be

associated with the Unity Project. Creating the scenes folder (and other similar folders)

is a typical way of structuring a Unity project.

g. The remaining settings, in Build Settings, should be left as default for now.

6. In the Build Settings window, click on the Player SettingsPlayer Settings  button, this will open the related panel in the

space where the Inspector is located.

7. In this panel, a few settings need to be verified:

a. In the Other SettingsOther Settings  tab:

a. Scr ipting Runtime VersionScr ipting Runtime Version should be StableStable (.NET 3.5 Equivalent).

b. Scr ipting BackendScripting Backend should be .NET.NET

c. API Compatibility LevelAPI Compatibility Level  should be .NET 4.6.NET 4.6
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IMPORTANTIMPORTANT

b. Within the Publishing SettingsPublishing Settings  tab, under CapabilitiesCapabilities , check:

a. InternetClientInternetClient

b. WebcamWebcam

c. Further down the panel, in XR SettingsXR Settings  (found below Publish SettingsPublish Settings ), tick Vir tual RealityVir tual Reality

Suppor tedSuppor ted, make sure the Windows Mixed Reality SDKWindows Mixed Reality SDK is added.

8. Back in Build Settings Unity C# Projects is no longer greyed out; tick the checkbox next to this.

9. Close the Build Settings window.

10. Save your Scene and Project (FILE > SAVE SCENE / FILE > SAVE PROJECTFILE > SAVE SCENE / FILE > SAVE PROJECT).

If you wish to skip the Unity Set up component of this course, and continue straight into code, feel free to download this

.unitypackage, import it into your project as a Custom Package, and then continue from Chapter 5.

1. In the Hierarchy Panel, select the Main CameraMain Camera.

2. Once selected, you will be able to see all the components of the Main CameraMain Camera in the Inspector Panel.

a. The Camera objectCamera object must be named Main CameraMain Camera (note the spelling!)

b. The Main Camera TagTag must be set to MainCameraMainCamera (note the spelling!)

https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20302%20-%20Computer%20vision/Azure-MR-302.unitypackage
https://docs.unity3d.com/Manual/AssetPackages.html


c. Make sure the Transform PositionTransform Position is set to 0, 0 , 00, 0 , 0

d. Set Clear FlagsClear Flags  to Solid ColorSolid Color  (ignore this for immersive headset).

e. Set the BackgroundBackground Color of the Camera Component to Black , Alpha 0 (Hex Code:Black , Alpha 0 (Hex Code:

#00000000)#00000000)  (ignore this for immersive headset).

3. Next, you will have to create a simple “Cursor” object attached to the Main CameraMain Camera, which will help you

position the image analysis output when the application is running. This Cursor will determine the center

point of the camera focus.

To create the Cursor :

1. In the Hierarchy Panel, right-click on the Main CameraMain Camera. Under 3D Object3D Object, click on SphereSphere.

2. Rename the SphereSphere to CursorCursor  (double click the Cursor object or press the ‘F2’ keyboard button with the

object selected), and make sure it is located as child of the Main CameraMain Camera.

3. In the Hierarchy Panel, left click on the CursorCursor . With the Cursor selected, adjust the following variables in

the Inspector Panel:

a. Set the Transform Position to 0, 0 , 50, 0 , 5
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b. Set the Scale to 0.02, 0 .02, 0 .020.02, 0 .02, 0 .02

Once you have captured an image with the HoloLens’ camera, that image will be sent to your Azure Computer

Vision API Service instance for analysis.

The results of that analysis will be a list of recognized objects called TagsTags .

You will use Labels (as a 3D text in world space) to display these Tags at the location the photo was taken.

The following steps will show how to setup the LabelLabel  object.

1. Right-click anywhere in the Hierarchy Panel (the location does not matter at this point), under 3D Object3D Object,

add a 3D Text3D Text. Name it LabelTextLabelText.

2. In the Hierarchy Panel, left click on the LabelTextLabelText. With the LabelTextLabelText selected, adjust the following

variables in the Inspector Panel:

a. Set the PositionPosition to 0,0 ,00,0 ,0

b. Set the ScaleScale to 0.01, 0 .01, 0 .010.01, 0 .01, 0 .01

c. In the component Text MeshText Mesh:

d. Replace all the text within TextText, with "..."

e. Set the AnchorAnchor  to Middle CenterMiddle Center

f. Set the AlignmentAlignment to CenterCenter

g. Set the Tab S izeTab S ize to 44

h. Set the Font S izeFont S ize to 5050

i. Set the ColorColor  to #FFFFFFFF#FFFFFFFF
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3. Drag the LabelTextLabelText from the Hierarchy Panel, into the Asset Folder, within in the Project Panel. This will

make the LabelTextLabelText a Prefab, so that it can be instantiated in code.

4. You should delete the LabelTextLabelText from the Hierarchy Panel, so that it will not be displayed in the opening

scene. As it is now a prefab, which you will call on for individual instances from your Assets folder, there is

no need to keep it within the scene.

5. The final object structure in the Hierarchy Panel should be like the one shown in the image below:

The first script you need to create is the ResultsLabel class, which is responsible for the following:

Creating the Labels in the appropriate world space, relative to the position of the Camera.

Displaying the Tags from the Image Anaysis.

To create this class:

1. Right-click in the Project Panel, then Create > FolderCreate > Folder . Name the folder Scr iptsScr ipts .



2. With the Scr iptsScr ipts  folder create, double click it to open. Then within that folder, right-click, and select

Create >Create > then C# Scr iptC# Scr ipt. Name the script ResultsLabel.

3. Double click on the new ResultsLabel script to open it with Visual StudioVisual Studio.

4. Inside the Class insert the following code in the ResultsLabel class:



    using System.Collections.Generic;
    using UnityEngine;

    public class ResultsLabel : MonoBehaviour
    { 
        public static ResultsLabel instance;

        public GameObject cursor;

        public Transform labelPrefab;

        [HideInInspector]
        public Transform lastLabelPlaced;

        [HideInInspector]
        public TextMesh lastLabelPlacedText;

        private void Awake()
        {
            // allows this instance to behave like a singleton
            instance = this;
        }

        /// <summary>
        /// Instantiate a Label in the appropriate location relative to the Main Camera.
        /// </summary>
        public void CreateLabel()
        {
            lastLabelPlaced = Instantiate(labelPrefab, cursor.transform.position, 
transform.rotation);

            lastLabelPlacedText = lastLabelPlaced.GetComponent<TextMesh>();

            // Change the text of the label to show that has been placed
            // The final text will be set at a later stage
            lastLabelPlacedText.text = "Analysing...";
        }

        /// <summary>
        /// Set the Tags as Text of the last Label created. 
        /// </summary>
        public void SetTagsToLastLabel(Dictionary<string, float> tagsDictionary)
        {
            lastLabelPlacedText = lastLabelPlaced.GetComponent<TextMesh>();

            // At this point we go through all the tags received and set them as text of the label
            lastLabelPlacedText.text = "I see: \n";

            foreach (KeyValuePair<string, float> tag in tagsDictionary)
            {
                lastLabelPlacedText.text += tag.Key + ", Confidence: " + tag.Value.ToString("0.00 
\n");
            }    
        }
    }

5. Be sure to save your changes in Visual Studio before returning to Unity.

6. Back in the Unity Editor, click and drag the ResultsLabel class from the Scr iptsScr ipts  folder to the MainMain

CameraCamera object in the Hierarchy Panel.

7. Click on the Main CameraMain Camera and look at the Inspector Panel.

You will notice that from the script you just dragged into the Camera, there are two fields: CursorCursor  and LabelLabel

PrefabPrefab.
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9. Drag the object called CursorCursor  from the Hierarchy Panel to the slot named CursorCursor , as shown in the image

below.

10. Drag the object called LabelTextLabelText from the Assets Folder in the Project Panel to the slot named LabelLabel

PrefabPrefab, as shown in the image below.

The next class you are going to create is the ImageCapture class. This class is responsible for :

Capturing an Image using the HoloLens Camera and storing it in the App Folder.

Capturing Tap gestures from the user.

To create this class:

    using System.IO;
    using System.Linq;
    using UnityEngine;
    using UnityEngine.XR.WSA.Input;
    using UnityEngine.XR.WSA.WebCam;

    public static ImageCapture instance; 
    public int tapsCount;
    private PhotoCapture photoCaptureObject = null;
    private GestureRecognizer recognizer;
    private bool currentlyCapturing = false;

1. Go to the Scr iptsScr ipts  folder you created previously.

2. Right-click inside the folder, Create > C# Scr iptCreate > C# Scr ipt. Call the script ImageCapture.

3. Double click on the new ImageCapture script to open it with Visual StudioVisual Studio.

4. Add the following namespaces to the top of the file:

5. Then add the following variables inside the ImageCapture class, above the Start() method:

The tapsCounttapsCount variable will store the number of tap gestures captured from the user. This number is used in

the naming of the images captured.

6. Code for Awake() and Start() methods now needs to be added. These will be called when the class

initializes:



    private void Awake()
    {
        // Allows this instance to behave like a singleton
        instance = this;
    }

    void Start()
    {
        // subscribing to the HoloLens API gesture recognizer to track user gestures
        recognizer = new GestureRecognizer();
        recognizer.SetRecognizableGestures(GestureSettings.Tap);
        recognizer.Tapped += TapHandler;
        recognizer.StartCapturingGestures();
    }

    /// <summary>
    /// Respond to Tap Input.
    /// </summary>
    private void TapHandler(TappedEventArgs obj)
    {
        // Only allow capturing, if not currently processing a request.
        if(currentlyCapturing == false)
        {
            currentlyCapturing = true;

            // increment taps count, used to name images when saving
            tapsCount++;

            // Create a label in world space using the ResultsLabel class
            ResultsLabel.instance.CreateLabel();

            // Begins the image capture and analysis procedure
            ExecuteImageCaptureAndAnalysis();
        }
    }

7. Implement a handler that will be called when a Tap gesture occurs.

The TapHandler() method increments the number of taps captured from the user and uses the current Cursor

position to determine where to position a new Label.

This method then calls the ExecuteImageCaptureAndAnalysis() method to begin the core functionality of this

application.

8. Once an Image has been captured and stored, the following handlers will be called. If the process is

successful, the result is passed to the VisionManager (which you are yet to create) for analysis.



    /// <summary>
    /// Register the full execution of the Photo Capture. If successful, it will begin 
    /// the Image Analysis process.
    /// </summary>
    void OnCapturedPhotoToDisk(PhotoCapture.PhotoCaptureResult result)
    {
        // Call StopPhotoMode once the image has successfully captured
        photoCaptureObject.StopPhotoModeAsync(OnStoppedPhotoMode);
    }

    void OnStoppedPhotoMode(PhotoCapture.PhotoCaptureResult result)
    {
        // Dispose from the object in memory and request the image analysis 
        // to the VisionManager class
        photoCaptureObject.Dispose();
        photoCaptureObject = null;
        StartCoroutine(VisionManager.instance.AnalyseLastImageCaptured()); 
    }

    /// <summary>    
    /// Begin process of Image Capturing and send To Azure     
    /// Computer Vision service.   
    /// </summary>    
    private void ExecuteImageCaptureAndAnalysis()  
    {    
        // Set the camera resolution to be the highest possible    
        Resolution cameraResolution = PhotoCapture.SupportedResolutions.OrderByDescending((res) => 
res.width * res.height).First();    

        Texture2D targetTexture = new Texture2D(cameraResolution.width, cameraResolution.height);

        // Begin capture process, set the image format    
        PhotoCapture.CreateAsync(false, delegate (PhotoCapture captureObject)    
        {    
            photoCaptureObject = captureObject;    
            CameraParameters camParameters = new CameraParameters();    
            camParameters.hologramOpacity = 0.0f;    
            camParameters.cameraResolutionWidth = targetTexture.width;    
            camParameters.cameraResolutionHeight = targetTexture.height;    
            camParameters.pixelFormat = CapturePixelFormat.BGRA32;

            // Capture the image from the camera and save it in the App internal folder    
            captureObject.StartPhotoModeAsync(camParameters, delegate 
(PhotoCapture.PhotoCaptureResult result)
            {    
                string filename = string.Format(@"CapturedImage{0}.jpg", tapsCount);

                string filePath = Path.Combine(Application.persistentDataPath, filename);

                VisionManager.instance.imagePath = filePath;

                photoCaptureObject.TakePhotoAsync(filePath, PhotoCaptureFileOutputFormat.JPG, 
OnCapturedPhotoToDisk);

                currentlyCapturing = false;
            });   
        });    
    }

9. Then add the method that the application uses to start the Image capture process and store the image.



WARNINGWARNING
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At this point you will notice an error appearing in the Unity Editor Console Panel. This is because the code references the

VisionManager class which you will create in the next Chapter.

The last script you need to create is the VisionManager class.

This class is responsible for :

Loading the latest image captured as an array of bytes.

Sending the byte array to your Azure Computer Vision API Service instance for analysis.

Receiving the response as a JSON string.

Deserializing the response and passing the resulting Tags to the ResultsLabel class.

To create this class:

    using System;
    using System.Collections;
    using System.Collections.Generic;
    using System.IO;
    using UnityEngine;
    using UnityEngine.Networking;

    [System.Serializable]
    public class TagData
    {
        public string name;
        public float confidence;
    }

    [System.Serializable]
    public class AnalysedObject
    {
        public TagData[] tags;
        public string requestId;
        public object metadata;
    }

NOTENOTE

1. Double click on the Scr iptsScr ipts  folder, to open it.

2. Right-click inside the Scr iptsScr ipts  folder, click Create > C# Scr iptCreate > C# Scr ipt. Name the script VisionManager.

3. Double click on the new script to open it with Visual Studio.

4. Update the namespaces to be the same as the following, at the top of the VisionManager class:

5. At the top of your script, inside the VisionManager class (above the Start() method), you now need to

create two Classes that will represent the deserialized JSON response from Azure:

The TagData and AnalysedObject classes need to have the [System.Serializable] attribute added before the

declaration to be able to be deserialized with the Unity libraries.

6. In the VisionManager class, you should add the following variables:



    public static VisionManager instance;

    // you must insert your service key here!    
    private string authorizationKey = "- Insert your key here -";    
    private const string ocpApimSubscriptionKeyHeader = "Ocp-Apim-Subscription-Key";
    private string visionAnalysisEndpoint = 
"https://westus.api.cognitive.microsoft.com/vision/v1.0/analyze?visualFeatures=Tags";   // This is 
where you need to update your endpoint, if you set your location to something other than west-us.

    internal byte[] imageBytes;

    internal string imagePath;

WARNINGWARNING

WARNINGWARNING

    private void Awake()
    {
        // allows this instance to behave like a singleton
        instance = this;
    }

Make sure you insert your Auth KeyAuth Key  into the authorizationKeyauthorizationKey variable. You will have noted your Auth KeyAuth Key  at

the beginning of this course, Chapter 1.

The visionAnalysisEndpointvisionAnalysisEndpoint  variable might differ from the one specified in this example. The west-uswest-us strictly

refers to Service instances created for the West US region. Update this with your endpoint URL; here are some

examples of what that might look like:

West Europe: 

https://westeurope.api.cognitive.microsoft.com/vision/v1.0/analyze?visualFeatures=Tags

Southeast Asia: 

https://southeastasia.api.cognitive.microsoft.com/vision/v1.0/analyze?visualFeatures=Tags

Australia East: 

https://australiaeast.api.cognitive.microsoft.com/vision/v1.0/analyze?visualFeatures=Tags

7. Code for Awake now needs to be added.

8. Next, add the coroutine (with the static stream method below it), which will obtain the results of the

analysis of the image captured by the ImageCapture Class.

https://westus.dev.cognitive.microsoft.com/docs/services/56f91f2d778daf23d8ec6739/operations/56f91f2e778daf14a499e1fa


    /// <summary>
    /// Call the Computer Vision Service to submit the image.
    /// </summary>
    public IEnumerator AnalyseLastImageCaptured()
    {
        WWWForm webForm = new WWWForm();
        using (UnityWebRequest unityWebRequest = UnityWebRequest.Post(visionAnalysisEndpoint, 
webForm))
        {
            // gets a byte array out of the saved image
            imageBytes = GetImageAsByteArray(imagePath);
            unityWebRequest.SetRequestHeader("Content-Type", "application/octet-stream");
            unityWebRequest.SetRequestHeader(ocpApimSubscriptionKeyHeader, authorizationKey);

            // the download handler will help receiving the analysis from Azure
            unityWebRequest.downloadHandler = new DownloadHandlerBuffer();

            // the upload handler will help uploading the byte array with the request
            unityWebRequest.uploadHandler = new UploadHandlerRaw(imageBytes);
            unityWebRequest.uploadHandler.contentType = "application/octet-stream";

            yield return unityWebRequest.SendWebRequest();

            long responseCode = unityWebRequest.responseCode;     

            try
            {
                string jsonResponse = null;
                jsonResponse = unityWebRequest.downloadHandler.text;

                // The response will be in Json format
                // therefore it needs to be deserialized into the classes AnalysedObject and TagData
                AnalysedObject analysedObject = new AnalysedObject();
                analysedObject = JsonUtility.FromJson<AnalysedObject>(jsonResponse);

                if (analysedObject.tags == null)
                {
                    Debug.Log("analysedObject.tagData is null");
                }
                else
                {
                    Dictionary<string, float> tagsDictionary = new Dictionary<string, float>();

                    foreach (TagData td in analysedObject.tags)
                    {
                        TagData tag = td as TagData;
                        tagsDictionary.Add(tag.name, tag.confidence);                            
                    }

                    ResultsLabel.instance.SetTagsToLastLabel(tagsDictionary);
                }
            }
            catch (Exception exception)
            {
                Debug.Log("Json exception.Message: " + exception.Message);
            }

            yield return null;
        }
    }
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    /// <summary>
    /// Returns the contents of the specified file as a byte array.
    /// </summary>
    private static byte[] GetImageAsByteArray(string imageFilePath)
    {
        FileStream fileStream = new FileStream(imageFilePath, FileMode.Open, FileAccess.Read);
        BinaryReader binaryReader = new BinaryReader(fileStream);
        return binaryReader.ReadBytes((int)fileStream.Length);
    }  

9. Be sure to save your changes in Visual Studio before returning to Unity.

10. Back in the Unity Editor, click and drag the VisionManager and ImageCapture classes from the Scr iptsScr ipts

folder to the Main CameraMain Camera object in the Hierarchy Panel.

To perform a thorough test of your application you will need to sideload it onto your HoloLens. Before you do,

ensure that:

All the settings mentioned in Chapter 2 are set correctly.

All the scripts are attached to the Main CameraMain Camera object.

All the fields in the Main Camera Inspector Panel are assigned properly.

Make sure you insert your Auth KeyAuth Key  into the authorizationKeyauthorizationKey  variable.

Ensure that you have also checked your endpoint in your VisionManager script, and that it aligns to your

region (this document uses west-us by default).

Everything needed for the Unity section of this project has now been completed, so it is time to build it from

Unity.

1. Navigate to Build Settings - File > Build Settings…File > Build Settings…

2. From the Build Settings window, click BuildBuild.

3. If not already, tick Unity C# ProjectsUnity C# Projects .
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NOTENOTE

 Your finished Computer Vision API application

4. Click BuildBuild. Unity will launch a File Explorer window, where you need to create and then select a folder to

build the app into. Create that folder now, and name it App. Then with the App folder selected, press

Select FolderSelect Folder .

5. Unity will begin building your project to the App folder.

6. Once Unity has finished building (it might take some time), it will open a File Explorer window at the

location of your build (check your task bar, as it may not always appear above your windows, but will

notify you of the addition of a new window).

To deploy on HoloLens:

1. You will need the IP Address of your HoloLens (for Remote Deploy), and to ensure your HoloLens is in

Developer ModeDeveloper Mode. To do this:

a. Whilst wearing your HoloLens, open the SettingsSettings .

b. Go to Network & Internet > Wi-Fi > Advanced OptionsNetwork & Internet > Wi-Fi > Advanced Options

c. Note the IPv4IPv4  address.

d. Next, navigate back to SettingsSettings , and then to Update & Security > For DevelopersUpdate & Security > For Developers

e. Set Developer Mode On.

2. Navigate to your new Unity build (the App folder) and open the solution file with Visual Studio.

3. In the Solution Configuration select DebugDebug.

4. In the Solution Platform, select x86x86 , Remote MachineRemote Machine.

5. Go to the Build menuBuild menu and click on Deploy SolutionDeploy Solution, to sideload the application to your HoloLens.

6. Your App should now appear in the list of installed apps on your HoloLens, ready to be launched!

To deploy to immersive headset, set the Solution PlatformSolution Platform to Local Machine, and set the ConfigurationConfiguration to Debug,

with x86 as the PlatformPlatform. Then deploy to the local machine, using the Build menuBuild menu, selecting Deploy Solution.

Congratulations, you built a mixed reality app that leverages the Azure Computer Vision API to recognize real

world objects, and display confidence of what has been seen.



 Bonus exercises
  Exercise 1Exercise 1

  Exercise 2Exercise 2

Just as you have used the Tags parameter (as evidenced within the endpoint used within the VisionManager),

extend the app to detect other information; have a look at what other parameters you have access to HERE.

Display the returned Azure data, in a more conversational, and readable way, perhaps hiding the numbers. As

though a bot might be speaking to the user.

https://westus.dev.cognitive.microsoft.com/docs/services/56f91f2d778daf23d8ec6739/operations/56f91f2e778daf14a499e1fa
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NOTENOTE
The Mixed Reality Academy tutorials were designed with HoloLens (1st gen) and Mixed Reality Immersive Headsets in

mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for guidance in

developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being used for

HoloLens 2. They will be maintained to continue working on the supported devices. There will be a new series of tutorials

that will be posted in the future that will demonstrate how to develop for HoloLens 2. This notice will be updated with a

link to those tutorials when they are posted.

In this course, you will learn how to recognize custom visual content within a provided image, using Azure

Custom Vision capabilities in a mixed reality application.

This service will allow you to train a machine learning model using object images. You will then use the trained

model to recognize similar objects, as provided by the camera capture of Microsoft HoloLens or a camera

connected to your PC for immersive (VR) headsets.

Azure Custom Vision is a Microsoft Cognitive Service which allows developers to build custom image classifiers.

These classifiers can then be used with new images to recognize, or classify, objects within that new image. The

Service provides a simple, easy to use, online portal to streamline the process. For more information, visit the

Azure Custom Vision Service page.

Upon completion of this course, you will have a mixed reality application which will be able to work in two

modes:

Analysis ModeAnalysis Mode: setting up the Custom Vision Service manually by uploading images, creating tags, and

training the Service to recognize different objects (in this case mouse and keyboard). You will then create

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/mr-azure-302b.md
https://docs.microsoft.com/en-us/azure/cognitive-services/custom-vision-service/home


 Device support

C O URSEC O URSE H O LO L EN SH O LO L EN S IM M ERSIVE  H EA DSET SIM M ERSIVE  H EA DSET S

MR and Azure 302b: Custom vision ✔️ ✔️

NOTENOTE

 Prerequisites

NOTENOTE

 Before you start

a HoloLens app that will capture images using the camera, and try to recognize those objects in the real

world.

Training ModeTraining Mode: you will implement code that will enable a "Training Mode" in your app. The training

mode will allow you to capture images using the HoloLens' camera, upload the captured images to the

Service, and train the custom vision model.

This course will teach you how to get the results from the Custom Vision Service into a Unity-based sample

application. It will be up to you to apply these concepts to a custom application you might be building.

While this course primarily focuses on HoloLens, you can also apply what you learn in this course to Windows Mixed

Reality immersive (VR) headsets. Because immersive (VR) headsets do not have accessible cameras, you will need an

external camera connected to your PC. As you follow along with the course, you will see notes on any changes you might

need to employ to support immersive (VR) headsets.

This tutorial is designed for developers who have basic experience with Unity and C#. Please also be aware that the

prerequisites and written instructions within this document represent what has been tested and verified at the time of

writing (July 2018). You are free to use the latest software, as listed within the install the tools article, though it should not

be assumed that the information in this course will perfectly match what you will find in newer software than what is listed

below.

We recommend the following hardware and software for this course:

A development PC, compatible with Windows Mixed Reality for immersive (VR) headset development

Windows 10 Fall Creators Update (or later) with Developer mode enabled

The latest Windows 10 SDK

Unity 2017.4

Visual Studio 2017

A Windows Mixed Reality immersive (VR) headset or Microsoft HoloLens with Developer mode enabled

A camera connected to your PC (for immersive headset development)

Internet access for Azure setup and Custom Vision API retrieval

A series of at least five (5) images (ten (10) recommended) for each object that you would like the Custom

Vision Service to recognize. If you wish, you can use the images already provided with this course (a

computer mouse and a keyboard) .

1. To avoid encountering issues building this project, it is strongly suggested that you create the project

mentioned in this tutorial in a root or near-root folder (long folder paths can cause issues at build-time).

2. Set up and test your HoloLens. If you need support setting up your HoloLens, make sure to visit the HoloLens

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://support.microsoft.com/help/4039260/windows-10-mixed-reality-pc-hardware-guidelines
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20302b%20-%20Custom%20vision/ComputerVision_Images.zip
https://docs.microsoft.com/en-us/hololens/hololens-setup
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setup article.

3. It is a good idea to perform Calibration and Sensor Tuning when beginning developing a new HoloLens app

(sometimes it can help to perform those tasks for each user).

For help on Calibration, please follow this link to the HoloLens Calibration article.

For help on Sensor Tuning, please follow this link to the HoloLens Sensor Tuning article.

To use the Custom Vision Service in Azure, you will need to configure an instance of the Service to be made

available to your application.

NOTENOTE

1. First, navigate to the Custom Vision Service main page.

2. Click on the Get Star tedGet Star ted button.

3. Sign in to the Custom Vision Service Portal.

If you do not already have an Azure account, you will need to create one. If you are following this tutorial in a

classroom or lab situation, ask your instructor or one of the proctors for help setting up your new account.

4. Once you are logged in for the first time, you will be prompted with the Terms of Service panel. Click on

the checkbox to agree to the terms. Then click on I agreeI agree.

https://docs.microsoft.com/en-us/hololens/hololens-calibration#hololens-2
https://docs.microsoft.com/en-us/hololens/hololens-updates
https://azure.microsoft.com/services/cognitive-services/custom-vision-service/


5. Having agreed to the Terms, you will be navigated to the Projects section of the Portal. Click on NewNew

ProjectProject.

6. A tab will appear on the right-hand side, which will prompt you to specify some fields for the project.

a. Insert a Name for your project.

b. Insert a Description for your project (optional).

c. Choose a Resource Group or create a new one. A resource group provides a way to monitor,

control access, provision and manage billing for a collection of Azure assets. It is recommended to

keep all the Azure Services associated with a single project (e.g. such as these courses) under a

common resource group).
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d. Set the Project Types to ClassificationClassification

e. Set the Domains as GeneralGeneral .

If you wish to read more about Azure Resource Groups, please visit the resource group article.

7. Once you are finished, click on Create projectCreate project, you will be redirected to the Custom Vision Service,

project page.

Once in the Custom Vision portal, your primary objective is to train your project to recognize specific objects in

images. You need at least five (5) images, though ten (10) is preferred, for each object that you would like your

application to recognize. You can use the images provided with this course (a computer mouse and a keyboard).

To train your Custom Vision Service project:

1. Click on the ++ button next to Tags.Tags.

2. Add the namename of the object you would like to recognize. Click on SaveSave.

https://docs.microsoft.com/en-us/azure/azure-resource-manager/resource-group-portal
https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20302b%20-%20Custom%20vision/ComputerVision_Images.zip


3. You will notice your TagTag has been added (you may need to reload your page for it to appear). Click the

checkbox alongside your new tag, if it is not already checked.

4. Click on Add ImagesAdd Images  in the center of the page.



NOTENOTE

5. Click on Browse local filesBrowse local files , and search, then select, the images you would like to upload, with the

minimum being five (5). Remember all of these images should contain the object which you are training.

You can select several images at a time, to upload.

6. Once you can see the images in the tab, select the appropriate tag in the My TagsMy Tags  box.

7. Click on Upload filesUpload files . The files will begin uploading. Once you have confirmation of the upload, click

DoneDone.



8. Repeat the same process to create a new TagTag named KeyboardKeyboard and upload the appropriate photos for it.

Make sure to uncheckuncheck Mouse once you have created the new tags, so to show the Add images window.

9. Once you have both Tags set up, click on TrainTrain , and the first training iteration will start building.

10. Once it's built, you'll be able to see two buttons called Make defaultMake default and Prediction URLPrediction URL . Click on

Make defaultMake default first, then click on Prediction URLPrediction URL .



NOTENOTE
The endpoint URL which is provided from this, is set to whichever Iteration has been marked as default. As such, if

you later make a new Iteration and update it as default, you will not need to change your code.

11. Once you have clicked on Prediction URL, open Notepad, and copy and paste the URLURL  and the

Prediction-KeyPrediction-Key , so that you can retrieve it when you need it later in the code.

12. Click on the CogCog at the top right of the screen.

13. Copy the Training KeyTraining Key  and paste it into a Notepad, for later use.



 Chapter 3 - Set up the Unity project

14. Also copy your Project IdProject Id, and also paste it into your Notepad file, for later use.

The following is a typical set up for developing with mixed reality, and as such, is a good template for other

projects.

1. Open Unity and click NewNew .



2. You will now need to provide a Unity project name. Insert AzureCustomVision.AzureCustomVision. Make sure the project

template is set to 3D3D. Set the LocationLocation to somewhere appropriate for you (remember, closer to root

directories is better). Then, click Create projectCreate project.

3. With Unity open, it is worth checking the default Scr ipt EditorScr ipt Editor  is set to Visual StudioVisual Studio. Go to Edit >

Preferences and then from the new window, navigate to External ToolsExternal Tools . Change External Scr ipt EditorExternal Scr ipt Editor

to Visual Studio 2017Visual Studio 2017 . Close the PreferencesPreferences  window.

4. Next, go to File > Build SettingsFile > Build Settings  and select Universal Windows PlatformUniversal Windows Platform , then click on the SwitchSwitch

PlatformPlatform button to apply your selection.



5. While still in File > Build SettingsFile > Build Settings  and make sure that:

a. Target DeviceTarget Device is set to HoloLensHoloLens

For the immersive headsets, set Target DeviceTarget Device to Any Device.

b. Build TypeBuild Type is set to D3DD3D

c. SDKSDK is set to Latest installedLatest installed

d. Visual Studio VersionVisual Studio Version is set to Latest installedLatest installed

e. Build and RunBuild and Run is set to Local MachineLocal Machine

f. Save the scene and add it to the build.

a. Do this by selecting Add Open ScenesAdd Open Scenes . A save window will appear.



b. Create a new folder for this, and any future, scene, then select the New folderNew folder  button, to

create a new folder, name it ScenesScenes .

c. Open your newly created ScenesScenes  folder, and then in the File name: text field, type

CustomVisionSceneCustomVisionScene, then click on SaveSave.

Be aware, you must save your Unity scenes within the Assets folder, as they must be



associated with the Unity project. Creating the scenes folder (and other similar folders)

is a typical way of structuring a Unity project.

g. The remaining settings, in Build Settings, should be left as default for now.

6. In the Build Settings window, click on the Player SettingsPlayer Settings  button, this will open the related panel in the

space where the Inspector is located.

7. In this panel, a few settings need to be verified:

a. In the Other SettingsOther Settings  tab:

a. Scr ipting Runtime VersionScr ipting Runtime Version should be Experimental ( .NET 4.6 Equivalent)Experimental ( .NET 4.6 Equivalent) , which will

trigger a need to restart the Editor.

b. Scr ipting BackendScripting Backend should be .NET.NET

c. API Compatibility LevelAPI Compatibility Level  should be .NET 4.6.NET 4.6

b. Within the Publishing SettingsPublishing Settings  tab, under CapabilitiesCapabilities , check:

a. InternetClientInternetClient

b. WebcamWebcam
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IMPORTANTIMPORTANT

c. MicrophoneMicrophone

c. Further down the panel, in XR SettingsXR Settings  (found below Publish SettingsPublish Settings ), tick Vir tual RealityVir tual Reality

Suppor tedSuppor ted, make sure the Windows Mixed Reality SDKWindows Mixed Reality SDK is added.

8. Back in Build Settings Unity C# Projects is no longer greyed out; tick the checkbox next to this.

9. Close the Build Settings window.

10. Save your Scene and project (FILE > SAVE SCENE / FILE > SAVE PROJECTFILE > SAVE SCENE / FILE > SAVE PROJECT).

If you wish to skip the Unity Set up component of this course, and continue straight into code, feel free to download this

Azure-MR-302b.unitypackage, import it into your project as a Custom PackageCustom Package, and then continue from Chapter 6.

This course requires the use of the NewtonsoftNewtonsoft library, which you can add as a DLL to your assets. The package

containing this library can be downloaded from this Link. To import the Newtonsoft library into your project,

use the Unity Package which came with this course.

1. Add the .unitypackage to Unity by using the Assets > Import Package > Custom Package menu option.

2. In the Impor t Unity PackageImpor t Unity Package box that pops up, ensure everything under (and including) PluginsPlugins  is

selected.

https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20302b%20-%20Custom%20vision/Azure-MR-302b.unitypackage
https://docs.unity3d.com/Manual/AssetPackages.html
https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20302b%20-%20Custom%20vision/NewtonsoftDLL.unitypackage


NOTENOTE

3. Click the Impor tImpor t button to add the items to your project.

4. Go to the NewtonsoftNewtonsoft folder under PluginsPlugins  in the project view and select the Newtonsoft.Json plugin.

5. With the Newtonsoft.Json plugin selected, ensure that Any PlatformAny Platform is uncheckedunchecked, then ensure that

WSAPlayerWSAPlayer  is also uncheckedunchecked, then click ApplyApply . This is just to confirm that the files are configured

correctly.

Marking these plugins configures them to only be used in the Unity Editor. There are a different set of them in the

WSA folder which will be used after the project is exported from Unity.

6. Next, you need to open the WSAWSA folder, within the NewtonsoftNewtonsoft folder. You will see a copy of the same

file you just configured. Select the file, and then in the inspector, ensure that

Any PlatformAny Platform is uncheckedunchecked

onlyonly  WSAPlayerWSAPlayer  is checkedchecked

Dont processDont process  is checkedchecked
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1. In the Hierarchy Panel, select the Main Camera.

2. Once selected, you will be able to see all the components of the Main Camera in the Inspector Panel.

a. The camera object must be named Main CameraMain Camera (note the spelling!)

b. The Main Camera TagTag must be set to MainCameraMainCamera (note the spelling!)

c. Make sure the Transform PositionTransform Position is set to 0, 0 , 00, 0 , 0

d. Set Clear FlagsClear Flags  to Solid ColorSolid Color  (ignore this for immersive headset).

e. Set the BackgroundBackground Color of the camera Component to Black , Alpha 0 (Hex Code:Black , Alpha 0 (Hex Code:

#00000000)#00000000)  (ignore this for immersive headset).



Chapter 6 - Create the CustomVisionAnalyser class.

NOTENOTE

At this point you are ready to write some code.

You will begin with the CustomVisionAnalyser class.

The calls to the Custom Vision Ser viceCustom Vision Ser vice made in the code shown below are made using the Custom Vision REST APICustom Vision REST API .

Through using this, you will see how to implement and make use of this API (useful for understanding how to implement

something similar on your own). Be aware, that Microsoft offers a Custom Vision Ser vice SDKCustom Vision Ser vice SDK that can also be used to

make calls to the Service. For more information visit the Custom Vision Service SDK article.

This class is responsible for :

Loading the latest image captured as an array of bytes.

Sending the byte array to your Azure Custom Vision Service instance for analysis.

Receiving the response as a JSON string.

Deserializing the response and passing the resulting Prediction to the SceneOrganiser class, which will

take care of how the response should be displayed.

To create this class:

1. Right-click in the Asset Folder located in the Project Panel, then click Create > FolderCreate > Folder . Call the folder

Scr iptsScr ipts .

2. Double-click on the folder just created, to open it.

3. Right-click inside the folder, then click CreateCreate > C# Scr iptC# Scr ipt. Name the script CustomVisionAnalyser.

4. Double-click on the new CustomVisionAnalyser script to open it with Visual StudioVisual Studio.

5. Update the namespaces at the top of your file to match the following:

https://github.com/Microsoft/Cognitive-CustomVision-Windows/


using System.Collections;
using System.IO;
using UnityEngine;
using UnityEngine.Networking;
using Newtonsoft.Json;

    /// <summary>
    /// Unique instance of this class
    /// </summary>
    public static CustomVisionAnalyser Instance;

    /// <summary>
    /// Insert your Prediction Key here
    /// </summary>
    private string predictionKey = "- Insert your key here -";

    /// <summary>
    /// Insert your prediction endpoint here
    /// </summary>
    private string predictionEndpoint = "Insert your prediction endpoint here";

    /// <summary>
    /// Byte array of the image to submit for analysis
    /// </summary>
    [HideInInspector] public byte[] imageBytes;

NOTENOTE

    /// <summary>
    /// Initialises this class
    /// </summary>
    private void Awake()
    {
        // Allows this instance to behave like a singleton
        Instance = this;
    }

NOTENOTE

6. In the CustomVisionAnalyser class, add the following variables:

Make sure you insert your Prediction KeyPrediction Key  into the predictionKeypredictionKey variable and your Prediction EndpointPrediction Endpoint

into the predictionEndpointpredictionEndpoint  variable. You copied these to Notepad earlier in the course.

7. Code for Awake()Awake()  now needs to be added to initialize the Instance variable:

8. Delete the methods Star t()Star t()  and Update()Update() .

9. Next, add the coroutine (with the static GetImageAsByteArray()GetImageAsByteArray()  method below it), which will obtain the

results of the analysis of the image captured by the ImageCapture class.

In the AnalyseImageCaptureAnalyseImageCapture coroutine, there is a call to the SceneOrganiser class that you are yet to create.

Therefore, leave those lines commented for nowleave those lines commented for now.
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WARNINGWARNING

    /// <summary>
    /// Call the Computer Vision Service to submit the image.
    /// </summary>
    public IEnumerator AnalyseLastImageCaptured(string imagePath)
    {
        WWWForm webForm = new WWWForm();
        using (UnityWebRequest unityWebRequest = UnityWebRequest.Post(predictionEndpoint, webForm))
        {
            // Gets a byte array out of the saved image
            imageBytes = GetImageAsByteArray(imagePath);

            unityWebRequest.SetRequestHeader("Content-Type", "application/octet-stream");
            unityWebRequest.SetRequestHeader("Prediction-Key", predictionKey);

            // The upload handler will help uploading the byte array with the request
            unityWebRequest.uploadHandler = new UploadHandlerRaw(imageBytes);
            unityWebRequest.uploadHandler.contentType = "application/octet-stream";

            // The download handler will help receiving the analysis from Azure
            unityWebRequest.downloadHandler = new DownloadHandlerBuffer();

            // Send the request
            yield return unityWebRequest.SendWebRequest();

            string jsonResponse = unityWebRequest.downloadHandler.text;

            // The response will be in JSON format, therefore it needs to be deserialized    

            // The following lines refers to a class that you will build in later Chapters
            // Wait until then to uncomment these lines

            //AnalysisObject analysisObject = new AnalysisObject();
            //analysisObject = JsonConvert.DeserializeObject<AnalysisObject>(jsonResponse);
            //SceneOrganiser.Instance.SetTagsToLastLabel(analysisObject);
        }
    }

    /// <summary>
    /// Returns the contents of the specified image file as a byte array.
    /// </summary>
    static byte[] GetImageAsByteArray(string imageFilePath)
    {
        FileStream fileStream = new FileStream(imageFilePath, FileMode.Open, FileAccess.Read);

        BinaryReader binaryReader = new BinaryReader(fileStream);

        return binaryReader.ReadBytes((int)fileStream.Length);
    }

10. Be sure to save your changes in Visual StudioVisual Studio before returning to UnityUnity .

The class you will create now is the CustomVisionObjects class.

This script contains a number of objects used by other classes to serialize and deserialize the calls made to the

Custom Vision Service.

It is important that you take note of the endpoint that the Custom Vision Service provides you, as the below JSON

structure has been set up to work with Custom Vision Prediction v2.0. If you have a different version, you may need to

update the below structure.

https://southcentralus.dev.cognitive.microsoft.com/docs/services/450e4ba4d72542e889d93fd7b8e960de/operations/5a6264bc40d86a0ef8b2c290


To create this class:

using System;
using System.Collections.Generic;
using UnityEngine;
using UnityEngine.Networking;

// The objects contained in this script represent the deserialized version
// of the objects used by this application 

/// <summary>
/// Web request object for image data
/// </summary>
class MultipartObject : IMultipartFormSection
{
    public string sectionName { get; set; }

    public byte[] sectionData { get; set; }

    public string fileName { get; set; }

    public string contentType { get; set; }
}

/// <summary>
/// JSON of all Tags existing within the project
/// contains the list of Tags
/// </summary> 
public class Tags_RootObject
{
    public List<TagOfProject> Tags { get; set; }
    public int TotalTaggedImages { get; set; }
    public int TotalUntaggedImages { get; set; }
}

public class TagOfProject
{
    public string Id { get; set; }
    public string Name { get; set; }
    public string Description { get; set; }
    public int ImageCount { get; set; }
}

/// <summary>
/// JSON of Tag to associate to an image
/// Contains a list of hosting the tags,
/// since multiple tags can be associated with one image
/// </summary> 
public class Tag_RootObject
{
    public List<Tag> Tags { get; set; }
}

1. Right-click inside the Scr iptsScr ipts  folder, then click CreateCreate > C# Scr iptC# Scr ipt. Call the script CustomVisionObjects.

2. Double-click on the new CustomVisionObjectsCustomVisionObjects  script to open it with Visual StudioVisual Studio.

3. Add the following namespaces to the top of the file:

4. Delete the Star t()Star t()  and Update()Update()  methods inside the CustomVisionObjects class; this class should now be

empty.

5. Add the following classes outsideoutside the CustomVisionObjects class. These objects are used by the

Newtonsoft library to serialize and deserialize the response data:



 

public class Tag
{
    public string ImageId { get; set; }
    public string TagId { get; set; }
}

/// <summary>
/// JSON of Images submitted
/// Contains objects that host detailed information about one or more images
/// </summary> 
public class ImageRootObject
{
    public bool IsBatchSuccessful { get; set; }
    public List<SubmittedImage> Images { get; set; }
}

public class SubmittedImage
{
    public string SourceUrl { get; set; }
    public string Status { get; set; }
    public ImageObject Image { get; set; }
}

public class ImageObject
{
    public string Id { get; set; }
    public DateTime Created { get; set; }
    public int Width { get; set; }
    public int Height { get; set; }
    public string ImageUri { get; set; }
    public string ThumbnailUri { get; set; }
}

/// <summary>
/// JSON of Service Iteration
/// </summary> 
public class Iteration
{
    public string Id { get; set; }
    public string Name { get; set; }
    public bool IsDefault { get; set; }
    public string Status { get; set; }
    public string Created { get; set; }
    public string LastModified { get; set; }
    public string TrainedAt { get; set; }
    public string ProjectId { get; set; }
    public bool Exportable { get; set; }
    public string DomainId { get; set; }
}

/// <summary>
/// Predictions received by the Service after submitting an image for analysis
/// </summary> 
[Serializable]
public class AnalysisObject
{
    public List<Prediction> Predictions { get; set; }
}

[Serializable]
public class Prediction
{
    public string TagName { get; set; }
    public double Probability { get; set; }
}



Chapter 8 - Create the VoiceRecognizer class
This class will recognize the voice input from the user.

To create this class:

using System;
using System.Collections.Generic;
using System.Linq;
using UnityEngine;
using UnityEngine.Windows.Speech;

    /// <summary>
    /// Allows this class to behave like a singleton
    /// </summary>
    public static VoiceRecognizer Instance;

    /// <summary>
    /// Recognizer class for voice recognition
    /// </summary>
    internal KeywordRecognizer keywordRecognizer;

    /// <summary>
    /// List of Keywords registered
    /// </summary>
    private Dictionary<string, Action> _keywords = new Dictionary<string, Action>();

1. Right-click inside the Scr iptsScr ipts  folder, then click CreateCreate > C# Scr iptC# Scr ipt. Call the script VoiceRecognizer.

2. Double-click on the new VoiceRecognizerVoiceRecognizer  script to open it with Visual StudioVisual Studio.

3. Add the following namespaces above the VoiceRecognizer class:

4. Then add the following variables inside the VoiceRecognizer class, above the Start() method:

5. Add the Awake()Awake()  and Star t()Star t()  methods, the latter of which will set up the user keywords to be recognized

when associating a tag to an image:



    /// <summary>
    /// Called on initialization
    /// </summary>
    private void Awake()
    {
        Instance = this;
    }

    /// <summary>
    /// Runs at initialization right after Awake method
    /// </summary>
    void Start ()
    {

        Array tagsArray = Enum.GetValues(typeof(CustomVisionTrainer.Tags));

        foreach (object tagWord in tagsArray)
        {
            _keywords.Add(tagWord.ToString(), () =>
            {
                // When a word is recognized, the following line will be called
                CustomVisionTrainer.Instance.VerifyTag(tagWord.ToString());
            });
        }

        _keywords.Add("Discard", () =>
        {
            // When a word is recognized, the following line will be called
            // The user does not want to submit the image
            // therefore ignore and discard the process
            ImageCapture.Instance.ResetImageCapture();
            keywordRecognizer.Stop();
        });

        //Create the keyword recognizer 
        keywordRecognizer = new KeywordRecognizer(_keywords.Keys.ToArray());

        // Register for the OnPhraseRecognized event 
        keywordRecognizer.OnPhraseRecognized += KeywordRecognizer_OnPhraseRecognized;
    }

    /// <summary>
    /// Handler called when a word is recognized
    /// </summary>
    private void KeywordRecognizer_OnPhraseRecognized(PhraseRecognizedEventArgs args)
    {
        Action keywordAction;
        // if the keyword recognized is in our dictionary, call that Action.
        if (_keywords.TryGetValue(args.text, out keywordAction))
        {
            keywordAction.Invoke();
        }
    }

6. Delete the Update()Update()  method.

7. Add the following handler, which is called whenever voice input is recognized:

8. Be sure to save your changes in Visual StudioVisual Studio before returning to UnityUnity .



NOTENOTE

 Chapter 9 - Create the CustomVisionTrainer class

Do not worry about code which might appear to have an error, as you will provide further classes soon, which will fix

these.

This class will chain a series of web calls to train the Custom Vision Service. Each call will be explained in detail

right above the code.

To create this class:

using Newtonsoft.Json;
using System.Collections;
using System.Collections.Generic;
using System.IO;
using System.Text;
using UnityEngine;
using UnityEngine.Networking;

NOTENOTE

WARNINGWARNING

1. Right-click inside the Scr iptsScr ipts  folder, then click CreateCreate > C# Scr iptC# Scr ipt. Call the script CustomVisionTrainer.

2. Double-click on the new CustomVisionTrainer script to open it with Visual StudioVisual Studio.

3. Add the following namespaces above the CustomVisionTrainer class:

4. Then add the following variables inside the CustomVisionTrainer class, above the Star t()Star t()  method.

The training URL used here is provided within the Custom Vision Training 1.2 documentation, and has a structure

of: https://southcentralus.api.cognitive.microsoft.com/customvision/v1.2/Training/projects/{projectId}/

For more information, visit the Custom Vision Training v1.2 reference API.

It is important that you take note of the endpoint that the Custom Vision Service provides you for the training

mode, as the JSON structure used (within the CustomVisionObjectsCustomVisionObjects  class) has been set up to work with

Custom Vision Training v1.2. If you have a different version, you may need to update the Objects structure.

https://southcentralus.api.cognitive.microsoft.com/customvision/v1.2/Training/projects/%257BprojectId%257D/
https://southcentralus.dev.cognitive.microsoft.com/docs/services/f2d62aa3b93843d79e948fe87fa89554/operations/5a3044ee08fa5e06b890f11f
https://southcentralus.dev.cognitive.microsoft.com/docs/services/f2d62aa3b93843d79e948fe87fa89554/operations/5a3044ee08fa5e06b890f11f


    /// <summary>
    /// Allows this class to behave like a singleton
    /// </summary>
    public static CustomVisionTrainer Instance;

    /// <summary>
    /// Custom Vision Service URL root
    /// </summary>
    private string url = 
"https://southcentralus.api.cognitive.microsoft.com/customvision/v1.2/Training/projects/";

    /// <summary>
    /// Insert your prediction key here
    /// </summary>
    private string trainingKey = "- Insert your key here -";

    /// <summary>
    /// Insert your Project Id here
    /// </summary>
    private string projectId = "- Insert your Project Id here -";

    /// <summary>
    /// Byte array of the image to submit for analysis
    /// </summary>
    internal byte[] imageBytes;

    /// <summary>
    /// The Tags accepted
    /// </summary>
    internal enum Tags {Mouse, Keyboard}

    /// <summary>
    /// The UI displaying the training Chapters
    /// </summary>
    private TextMesh trainingUI_TextMesh;

IMPORTANTIMPORTANT

    /// <summary>
    /// Called on initialization
    /// </summary>
    private void Awake()
    {
        Instance = this;
    }

    /// <summary>
    /// Runs at initialization right after Awake method
    /// </summary>
    private void Start()
    { 
        trainingUI_TextMesh = SceneOrganiser.Instance.CreateTrainingUI("TrainingUI", 0.04f, 0, 4, 
false);
    }

Ensure that you add your Ser vice KeySer vice Key  (Training Key) value and Project IdProject Id value, which you noted down

previous; these are the values you collected from the portal earlier in the course (Chapter 2, step 10 onwards).

5. Add the following Star t()Star t()  and Awake()Awake()  methods. Those methods are called on initialization and contain

the call to set up the UI:

6. Delete the Update()Update()  method. This class will not need it.



    internal void RequestTagSelection()
    {
        trainingUI_TextMesh.gameObject.SetActive(true);
        trainingUI_TextMesh.text = $" \nUse voice command \nto choose between the following tags: 
\nMouse\nKeyboard \nor say Discard";

        VoiceRecognizer.Instance.keywordRecognizer.Start();
    }

    /// <summary>
    /// Verify voice input against stored tags.
    /// If positive, it will begin the Service training process.
    /// </summary>
    internal void VerifyTag(string spokenTag)
    {
        if (spokenTag == Tags.Mouse.ToString() || spokenTag == Tags.Keyboard.ToString())
        {
            trainingUI_TextMesh.text = $"Tag chosen: {spokenTag}";
            VoiceRecognizer.Instance.keywordRecognizer.Stop();
            StartCoroutine(SubmitImageForTraining(ImageCapture.Instance.filePath, spokenTag));
        }
    }

    /// <summary>
    /// Call the Custom Vision Service to submit the image.
    /// </summary>
    public IEnumerator SubmitImageForTraining(string imagePath, string tag)
    {
        yield return new WaitForSeconds(2);
        trainingUI_TextMesh.text = $"Submitting Image \nwith tag: {tag} \nto Custom Vision Service";
        string imageId = string.Empty;
        string tagId = string.Empty;

        // Retrieving the Tag Id relative to the voice input
        string getTagIdEndpoint = string.Format("{0}{1}/tags", url, projectId);
        using (UnityWebRequest www = UnityWebRequest.Get(getTagIdEndpoint))
        {
            www.SetRequestHeader("Training-Key", trainingKey);
            www.downloadHandler = new DownloadHandlerBuffer();
            yield return www.SendWebRequest();
            string jsonResponse = www.downloadHandler.text;

            Tags_RootObject tagRootObject = JsonConvert.DeserializeObject<Tags_RootObject>
(jsonResponse);

            foreach (TagOfProject tOP in tagRootObject.Tags)
            {
                if (tOP.Name == tag)
                {
                    tagId = tOP.Id;
                }             

7. Add the RequestTagSelection()RequestTagSelection()  method. This method is the first to be called when an image has been

captured and stored in the device and is now ready to be submitted to the Custom Vision Service, to train

it. This method displays, in the training UI, a set of keywords the user can use to tag the image that has

been captured. It also alerts the VoiceRecognizer class to begin listening to the user for voice input.

8. Add the VerifyTag()VerifyTag()  method. This method will receive the voice input recognized by the

VoiceRecognizerVoiceRecognizer  class and verify its validity, and then begin the training process.

9. Add the SubmitImageForTraining()SubmitImageForTraining()  method. This method will begin the Custom Vision Service

training process. The first step is to retrieve the Tag IdTag Id from the Service which is associated with the

validated speech input from the user. The Tag IdTag Id will then be uploaded along with the image.



                }             
            }
        }

        // Creating the image object to send for training
        List<IMultipartFormSection> multipartList = new List<IMultipartFormSection>();
        MultipartObject multipartObject = new MultipartObject();
        multipartObject.contentType = "application/octet-stream";
        multipartObject.fileName = "";
        multipartObject.sectionData = GetImageAsByteArray(imagePath);
        multipartList.Add(multipartObject);

        string createImageFromDataEndpoint = string.Format("{0}{1}/images?tagIds={2}", url, 
projectId, tagId);

        using (UnityWebRequest www = UnityWebRequest.Post(createImageFromDataEndpoint, 
multipartList))
        {
            // Gets a byte array out of the saved image
            imageBytes = GetImageAsByteArray(imagePath);           

            //unityWebRequest.SetRequestHeader("Content-Type", "application/octet-stream");
            www.SetRequestHeader("Training-Key", trainingKey);

            // The upload handler will help uploading the byte array with the request
            www.uploadHandler = new UploadHandlerRaw(imageBytes);

            // The download handler will help receiving the analysis from Azure
            www.downloadHandler = new DownloadHandlerBuffer();

            // Send the request
            yield return www.SendWebRequest();

            string jsonResponse = www.downloadHandler.text;

            ImageRootObject m = JsonConvert.DeserializeObject<ImageRootObject>(jsonResponse);
            imageId = m.Images[0].Image.Id;
        }
        trainingUI_TextMesh.text = "Image uploaded";
        StartCoroutine(TrainCustomVisionProject());
    }

10. Add the TrainCustomVisionProject()TrainCustomVisionProject()  method. Once the image has been submitted and tagged, this

method will be called. It will create a new Iteration that will be trained with all the previous images

submitted to the Service plus the image just uploaded. Once the training has been completed, this

method will call a method to set the newly created IterationIteration as DefaultDefault, so that the endpoint you are

using for analysis is the latest trained iteration.



    /// <summary>
    /// Call the Custom Vision Service to train the Service.
    /// It will generate a new Iteration in the Service
    /// </summary>
    public IEnumerator TrainCustomVisionProject()
    {
        yield return new WaitForSeconds(2);

        trainingUI_TextMesh.text = "Training Custom Vision Service";

        WWWForm webForm = new WWWForm();

        string trainProjectEndpoint = string.Format("{0}{1}/train", url, projectId);

        using (UnityWebRequest www = UnityWebRequest.Post(trainProjectEndpoint, webForm))
        {
            www.SetRequestHeader("Training-Key", trainingKey);
            www.downloadHandler = new DownloadHandlerBuffer();
            yield return www.SendWebRequest();
            string jsonResponse = www.downloadHandler.text;
            Debug.Log($"Training - JSON Response: {jsonResponse}");

            // A new iteration that has just been created and trained
            Iteration iteration = new Iteration();
            iteration = JsonConvert.DeserializeObject<Iteration>(jsonResponse);

            if (www.isDone)
            {
                trainingUI_TextMesh.text = "Custom Vision Trained";

                // Since the Service has a limited number of iterations available,
                // we need to set the last trained iteration as default
                // and delete all the iterations you dont need anymore
                StartCoroutine(SetDefaultIteration(iteration)); 
            }
        }
    }

11. Add the SetDefaultIteration()SetDefaultIteration()  method. This method will set the previously created and trained iteration

as Default. Once completed, this method will have to delete the previous iteration existing in the Service.

At the time of writing this course, there is a limit of a maximum ten (10) iterations allowed to exist at the

same time in the Service.



    /// <summary>
    /// Set the newly created iteration as Default
    /// </summary>
    private IEnumerator SetDefaultIteration(Iteration iteration)
    {
        yield return new WaitForSeconds(5);
        trainingUI_TextMesh.text = "Setting default iteration";

        // Set the last trained iteration to default
        iteration.IsDefault = true;

        // Convert the iteration object as JSON
        string iterationAsJson = JsonConvert.SerializeObject(iteration);
        byte[] bytes = Encoding.UTF8.GetBytes(iterationAsJson);

        string setDefaultIterationEndpoint = string.Format("{0}{1}/iterations/{2}", 
                                                        url, projectId, iteration.Id);

        using (UnityWebRequest www = UnityWebRequest.Put(setDefaultIterationEndpoint, bytes))
        {
            www.method = "PATCH";
            www.SetRequestHeader("Training-Key", trainingKey);
            www.SetRequestHeader("Content-Type", "application/json");
            www.downloadHandler = new DownloadHandlerBuffer();

            yield return www.SendWebRequest();

            string jsonResponse = www.downloadHandler.text;

            if (www.isDone)
            {
                trainingUI_TextMesh.text = "Default iteration is set \nDeleting Unused Iteration";
                StartCoroutine(DeletePreviousIteration(iteration));
            }
        }
    }

12. Add the DeletePreviousIteration()DeletePreviousIteration()  method. This method will find and delete the previous non-default

iteration:



    /// <summary>
    /// Delete the previous non-default iteration.
    /// </summary>
    public IEnumerator DeletePreviousIteration(Iteration iteration)
    {
        yield return new WaitForSeconds(5);

        trainingUI_TextMesh.text = "Deleting Unused \nIteration";

        string iterationToDeleteId = string.Empty;

        string findAllIterationsEndpoint = string.Format("{0}{1}/iterations", url, projectId);

        using (UnityWebRequest www = UnityWebRequest.Get(findAllIterationsEndpoint))
        {
            www.SetRequestHeader("Training-Key", trainingKey);
            www.downloadHandler = new DownloadHandlerBuffer();
            yield return www.SendWebRequest();

            string jsonResponse = www.downloadHandler.text;

            // The iteration that has just been trained
            List<Iteration> iterationsList = new List<Iteration>();
            iterationsList = JsonConvert.DeserializeObject<List<Iteration>>(jsonResponse);

            foreach (Iteration i in iterationsList)
            {
                if (i.IsDefault != true)
                {
                    Debug.Log($"Cleaning - Deleting iteration: {i.Name}, {i.Id}");
                    iterationToDeleteId = i.Id;
                    break;
                }
            }
        }

        string deleteEndpoint = string.Format("{0}{1}/iterations/{2}", url, projectId, 
iterationToDeleteId);

        using (UnityWebRequest www2 = UnityWebRequest.Delete(deleteEndpoint))
        {
            www2.SetRequestHeader("Training-Key", trainingKey);
            www2.downloadHandler = new DownloadHandlerBuffer();
            yield return www2.SendWebRequest();
            string jsonResponse = www2.downloadHandler.text;

            trainingUI_TextMesh.text = "Iteration Deleted";
            yield return new WaitForSeconds(2);
            trainingUI_TextMesh.text = "Ready for next \ncapture";

            yield return new WaitForSeconds(2);
            trainingUI_TextMesh.text = "";
            ImageCapture.Instance.ResetImageCapture();
        }
    }

13. The last method to add in this class is the GetImageAsByteArray()GetImageAsByteArray()  method, used on the web calls to

convert the image captured into a byte array.



 Chapter 10 - Create the SceneOrganiser class

    /// <summary>
    /// Returns the contents of the specified image file as a byte array.
    /// </summary>
    static byte[] GetImageAsByteArray(string imageFilePath)
    {
        FileStream fileStream = new FileStream(imageFilePath, FileMode.Open, FileAccess.Read);
        BinaryReader binaryReader = new BinaryReader(fileStream);
        return binaryReader.ReadBytes((int)fileStream.Length);
    }

14. Be sure to save your changes in Visual StudioVisual Studio before returning to UnityUnity .

This class will:

Create a CursorCursor  object to attach to the Main Camera.

Create a LabelLabel  object that will appear when the Service recognizes the real-world objects.

Set up the Main Camera by attaching the appropriate components to it.

When in Analysis ModeAnalysis Mode, spawn the Labels at runtime, in the appropriate world space relative to the

position of the Main Camera, and display the data received from the Custom Vision Service.

When in Training ModeTraining Mode, spawn the UI that will display the different stages of the training process.

To create this class:

using UnityEngine;

1. Right-click inside the Scr iptsScr ipts  folder, then click CreateCreate > C# Scr iptC# Scr ipt. Name the script SceneOrganiser.

2. Double-click on the new SceneOrganiser script to open it with Visual StudioVisual Studio.

3. You will only need one namespace, remove the others from above the SceneOrganiser class:

4. Then add the following variables inside the SceneOrganiser class, above the Star t()Star t()  method:



    /// <summary>
    /// Allows this class to behave like a singleton
    /// </summary>
    public static SceneOrganiser Instance;

    /// <summary>
    /// The cursor object attached to the camera
    /// </summary>
    internal GameObject cursor;

    /// <summary>
    /// The label used to display the analysis on the objects in the real world
    /// </summary>
    internal GameObject label;

    /// <summary>
    /// Object providing the current status of the camera.
    /// </summary>
    internal TextMesh cameraStatusIndicator;

    /// <summary>
    /// Reference to the last label positioned
    /// </summary>
    internal Transform lastLabelPlaced;

    /// <summary>
    /// Reference to the last label positioned
    /// </summary>
    internal TextMesh lastLabelPlacedText;

    /// <summary>
    /// Current threshold accepted for displaying the label
    /// Reduce this value to display the recognition more often
    /// </summary>
    internal float probabilityThreshold = 0.5f;

5. Delete the Star t()Star t()  and Update()Update()  methods.

6. Right underneath the variables, add the Awake()Awake()  method, which will initialize the class and set up the

scene.



    /// <summary>
    /// Called on initialization
    /// </summary>
    private void Awake()
    {
        // Use this class instance as singleton
        Instance = this;

        // Add the ImageCapture class to this GameObject
        gameObject.AddComponent<ImageCapture>();

        // Add the CustomVisionAnalyser class to this GameObject
        gameObject.AddComponent<CustomVisionAnalyser>();

        // Add the CustomVisionTrainer class to this GameObject
        gameObject.AddComponent<CustomVisionTrainer>();

        // Add the VoiceRecogniser class to this GameObject
        gameObject.AddComponent<VoiceRecognizer>();

        // Add the CustomVisionObjects class to this GameObject
        gameObject.AddComponent<CustomVisionObjects>();

        // Create the camera Cursor
        cursor = CreateCameraCursor();

        // Load the label prefab as reference
        label = CreateLabel();

        // Create the camera status indicator label, and place it above where predictions
        // and training UI will appear.
        cameraStatusIndicator = CreateTrainingUI("Status Indicator", 0.02f, 0.2f, 3, true);

        // Set camera status indicator to loading.
        SetCameraStatus("Loading");
    }

7. Now add the CreateCameraCursor()CreateCameraCursor()  method that creates and positions the Main Camera cursor, and

the CreateLabel()CreateLabel()  method, which creates the Analysis LabelAnalysis Label  object.



    /// <summary>
    /// Spawns cursor for the Main Camera
    /// </summary>
    private GameObject CreateCameraCursor()
    {
        // Create a sphere as new cursor
        GameObject newCursor = GameObject.CreatePrimitive(PrimitiveType.Sphere);

        // Attach it to the camera
        newCursor.transform.parent = gameObject.transform;

        // Resize the new cursor
        newCursor.transform.localScale = new Vector3(0.02f, 0.02f, 0.02f);

        // Move it to the correct position
        newCursor.transform.localPosition = new Vector3(0, 0, 4);

        // Set the cursor color to red
        newCursor.GetComponent<Renderer>().material = new Material(Shader.Find("Diffuse"));
        newCursor.GetComponent<Renderer>().material.color = Color.green;

        return newCursor;
    }

    /// <summary>
    /// Create the analysis label object
    /// </summary>
    private GameObject CreateLabel()
    {
        // Create a sphere as new cursor
        GameObject newLabel = new GameObject();

        // Resize the new cursor
        newLabel.transform.localScale = new Vector3(0.01f, 0.01f, 0.01f);

        // Creating the text of the label
        TextMesh t = newLabel.AddComponent<TextMesh>();
        t.anchor = TextAnchor.MiddleCenter;
        t.alignment = TextAlignment.Center;
        t.fontSize = 50;
        t.text = "";

        return newLabel;
    }

8. Add the SetCameraStatus()SetCameraStatus()  method, which will handle messages intended for the text mesh providing

the status of the camera.



    /// <summary>
    /// Set the camera status to a provided string. Will be coloured if it matches a keyword.
    /// </summary>
    /// <param name="statusText">Input string</param>
    public void SetCameraStatus(string statusText)
    {
        if (string.IsNullOrEmpty(statusText) == false)
        {
            string message = "white";

            switch (statusText.ToLower())
            {
                case "loading":
                    message = "yellow";
                    break;

                case "ready":
                    message = "green";
                    break;

                case "uploading image":
                    message = "red";
                    break;

                case "looping capture":
                    message = "yellow";
                    break;

                case "analysis":
                    message = "red";
                    break;
            }

            cameraStatusIndicator.GetComponent<TextMesh>().text = $"Camera Status:\n<color={message}>
{statusText}..</color>";
        }
    }

9. Add the PlaceAnalysisLabel()PlaceAnalysisLabel()  and SetTagsToLastLabel()SetTagsToLastLabel()  methods, which will spawn and display the

data from the Custom Vision Service into the scene.



    /// <summary>
    /// Instantiate a label in the appropriate location relative to the Main Camera.
    /// </summary>
    public void PlaceAnalysisLabel()
    {
        lastLabelPlaced = Instantiate(label.transform, cursor.transform.position, 
transform.rotation);
        lastLabelPlacedText = lastLabelPlaced.GetComponent<TextMesh>();
    }

    /// <summary>
    /// Set the Tags as Text of the last label created. 
    /// </summary>
    public void SetTagsToLastLabel(AnalysisObject analysisObject)
    {
        lastLabelPlacedText = lastLabelPlaced.GetComponent<TextMesh>();

        if (analysisObject.Predictions != null)
        {
            foreach (Prediction p in analysisObject.Predictions)
            {
                if (p.Probability > 0.02)
                {
                    lastLabelPlacedText.text += $"Detected: {p.TagName} {p.Probability.ToString("0.00 
\n")}";
                    Debug.Log($"Detected: {p.TagName} {p.Probability.ToString("0.00 \n")}");
                }
            }
        }
    }

    /// <summary>
    /// Create a 3D Text Mesh in scene, with various parameters.
    /// </summary>
    /// <param name="name">name of object</param>
    /// <param name="scale">scale of object (i.e. 0.04f)</param>
    /// <param name="yPos">height above the cursor (i.e. 0.3f</param>
    /// <param name="zPos">distance from the camera</param>
    /// <param name="setActive">whether the text mesh should be visible when it has been 
created</param>
    /// <returns>Returns a 3D text mesh within the scene</returns>
    internal TextMesh CreateTrainingUI(string name, float scale, float yPos, float zPos, bool 
setActive)
    {
        GameObject display = new GameObject(name, typeof(TextMesh));
        display.transform.parent = Camera.main.transform;
        display.transform.localPosition = new Vector3(0, yPos, zPos);
        display.SetActive(setActive);
        display.transform.localScale = new Vector3(scale, scale, scale);
        display.transform.rotation = new Quaternion();
        TextMesh textMesh = display.GetComponent<TextMesh>();
        textMesh.anchor = TextAnchor.MiddleCenter;
        textMesh.alignment = TextAlignment.Center;
        return textMesh;
    }

10. Lastly, add the CreateTrainingUI()CreateTrainingUI()  method, which will spawn the UI displaying the multiple stages of the

training process when the application is in Training Mode. This method will also be harnessed to create

the camera status object.

11. Be sure to save your changes in Visual StudioVisual Studio before returning to UnityUnity .



IMPORTANTIMPORTANT

  AnalysisObject analysisObject = new AnalysisObject();
  analysisObject = JsonConvert.DeserializeObject<AnalysisObject>(jsonResponse);
  SceneOrganiser.Instance.SetTagsToLastLabel(analysisObject);

 Chapter 11 - Create the ImageCapture class

Before you continue, open the CustomVisionAnalyserCustomVisionAnalyser  class, and within the AnalyseLastImageCaptured()AnalyseLastImageCaptured() method,

uncomment the following lines:

The next class you are going to create is the ImageCapture class.

This class is responsible for :

Capturing an image using the HoloLens camera and storing it in the App Folder.

Handling Tap gestures from the user.

Maintaining the Enum value that determines if the application will run in Analysis mode or Training

Mode.

To create this class:

using System;
using System.IO;
using System.Linq;
using UnityEngine;
using UnityEngine.XR.WSA.Input;
using UnityEngine.XR.WSA.WebCam;

1. Go to the Scr iptsScr ipts  folder you created previously.

2. Right-click inside the folder, then click Create > C# Scr iptCreate > C# Scr ipt. Name the script ImageCapture.

3. Double-click on the new ImageCaptureImageCapture script to open it with Visual StudioVisual Studio.

4. Replace the namespaces at the top of the file with the following:

5. Then add the following variables inside the ImageCapture class, above the Star t()Star t()  method:



    /// <summary>
    /// Allows this class to behave like a singleton
    /// </summary>
    public static ImageCapture Instance;

    /// <summary>
    /// Keep counts of the taps for image renaming
    /// </summary>
    private int captureCount = 0;

    /// <summary>
    /// Photo Capture object
    /// </summary>
    private PhotoCapture photoCaptureObject = null;

    /// <summary>
    /// Allows gestures recognition in HoloLens
    /// </summary>
    private GestureRecognizer recognizer;

    /// <summary>
    /// Loop timer
    /// </summary>
    private float secondsBetweenCaptures = 10f;

    /// <summary>
    /// Application main functionalities switch
    /// </summary>
    internal enum AppModes {Analysis, Training }

    /// <summary>
    /// Local variable for current AppMode
    /// </summary>
    internal AppModes AppMode { get; private set; }

    /// <summary>
    /// Flagging if the capture loop is running
    /// </summary>
    internal bool captureIsActive;

    /// <summary>
    /// File path of current analysed photo
    /// </summary>
    internal string filePath = string.Empty;

6. Code for Awake()Awake()  and Star t()Star t()  methods now needs to be added:



    /// <summary>
    /// Called on initialization
    /// </summary>
    private void Awake()
    {
        Instance = this;

        // Change this flag to switch between Analysis Mode and Training Mode 
        AppMode = AppModes.Training;
    }

    /// <summary>
    /// Runs at initialization right after Awake method
    /// </summary>
    void Start()
    {
        // Clean up the LocalState folder of this application from all photos stored
        DirectoryInfo info = new DirectoryInfo(Application.persistentDataPath);
        var fileInfo = info.GetFiles();
        foreach (var file in fileInfo)
        {
            try
            {
                file.Delete();
            }
            catch (Exception)
            {
                Debug.LogFormat("Cannot delete file: ", file.Name);
            }
        } 

        // Subscribing to the HoloLens API gesture recognizer to track user gestures
        recognizer = new GestureRecognizer();
        recognizer.SetRecognizableGestures(GestureSettings.Tap);
        recognizer.Tapped += TapHandler;
        recognizer.StartCapturingGestures();

        SceneOrganiser.Instance.SetCameraStatus("Ready");
    }

7. Implement a handler that will be called when a Tap gesture occurs.



    /// <summary>
    /// Respond to Tap Input.
    /// </summary>
    private void TapHandler(TappedEventArgs obj)
    {
        switch (AppMode)
        {
            case AppModes.Analysis:
                if (!captureIsActive)
                {
                    captureIsActive = true;

                    // Set the cursor color to red
                    SceneOrganiser.Instance.cursor.GetComponent<Renderer>().material.color = 
Color.red;

                    // Update camera status to looping capture.
                    SceneOrganiser.Instance.SetCameraStatus("Looping Capture");

                    // Begin the capture loop
                    InvokeRepeating("ExecuteImageCaptureAndAnalysis", 0, secondsBetweenCaptures);
                }
                else
                {
                    // The user tapped while the app was analyzing 
                    // therefore stop the analysis process
                    ResetImageCapture();
                }
                break;

            case AppModes.Training:
                if (!captureIsActive)
                {
                    captureIsActive = true;

                    // Call the image capture
                    ExecuteImageCaptureAndAnalysis();

                    // Set the cursor color to red
                    SceneOrganiser.Instance.cursor.GetComponent<Renderer>().material.color = 
Color.red;

                    // Update camera status to uploading image.
                    SceneOrganiser.Instance.SetCameraStatus("Uploading Image");
                }              
                break;
        }     
    }

NOTENOTE
In Analysis mode, the TapHandlerTapHandler  method acts as a switch to start or stop the photo capture loop.

In Training mode, it will capture an image from the camera.

When the cursor is green, it means the camera is available to take the image.

When the cursor is red, it means the camera is busy.

8. Add the method that the application uses to start the image capture process and store the image.



    /// <summary>
    /// Begin process of Image Capturing and send To Azure Custom Vision Service.
    /// </summary>
    private void ExecuteImageCaptureAndAnalysis()
    {
        // Update camera status to analysis.
        SceneOrganiser.Instance.SetCameraStatus("Analysis");

        // Create a label in world space using the SceneOrganiser class 
        // Invisible at this point but correctly positioned where the image was taken
        SceneOrganiser.Instance.PlaceAnalysisLabel();

        // Set the camera resolution to be the highest possible
        Resolution cameraResolution = PhotoCapture.SupportedResolutions.OrderByDescending((res) => 
res.width * res.height).First();

        Texture2D targetTexture = new Texture2D(cameraResolution.width, cameraResolution.height);

        // Begin capture process, set the image format
        PhotoCapture.CreateAsync(false, delegate (PhotoCapture captureObject)
        {
            photoCaptureObject = captureObject;

            CameraParameters camParameters = new CameraParameters
            {
                hologramOpacity = 0.0f,
                cameraResolutionWidth = targetTexture.width,
                cameraResolutionHeight = targetTexture.height,
                pixelFormat = CapturePixelFormat.BGRA32
            };

            // Capture the image from the camera and save it in the App internal folder
            captureObject.StartPhotoModeAsync(camParameters, delegate 
(PhotoCapture.PhotoCaptureResult result)
            {
                string filename = string.Format(@"CapturedImage{0}.jpg", captureCount);
                filePath = Path.Combine(Application.persistentDataPath, filename);          
                captureCount++;              
                photoCaptureObject.TakePhotoAsync(filePath, PhotoCaptureFileOutputFormat.JPG, 
OnCapturedPhotoToDisk);              
            });
        });   
    }

9. Add the handlers that will be called when the photo has been captured and for when it is ready to be

analyzed. The result is then passed to the CustomVisionAnalyser or the CustomVisionTrainer depending

on which mode the code is set on.



 Chapter 12 - Before building

    /// <summary>
    /// Register the full execution of the Photo Capture. 
    /// </summary>
    void OnCapturedPhotoToDisk(PhotoCapture.PhotoCaptureResult result)
    {
            // Call StopPhotoMode once the image has successfully captured
            photoCaptureObject.StopPhotoModeAsync(OnStoppedPhotoMode);
    }

    /// <summary>
    /// The camera photo mode has stopped after the capture.
    /// Begin the Image Analysis process.
    /// </summary>
    void OnStoppedPhotoMode(PhotoCapture.PhotoCaptureResult result)
    {
        Debug.LogFormat("Stopped Photo Mode");

        // Dispose from the object in memory and request the image analysis 
        photoCaptureObject.Dispose();
        photoCaptureObject = null;

        switch (AppMode)
        {
            case AppModes.Analysis:
                // Call the image analysis
                StartCoroutine(CustomVisionAnalyser.Instance.AnalyseLastImageCaptured(filePath));
                break;

            case AppModes.Training:
                // Call training using captured image
                CustomVisionTrainer.Instance.RequestTagSelection();
                break;
        }
    }

    /// <summary>
    /// Stops all capture pending actions
    /// </summary>
    internal void ResetImageCapture()
    {
        captureIsActive = false;

        // Set the cursor color to green
        SceneOrganiser.Instance.cursor.GetComponent<Renderer>().material.color = Color.green;

        // Update camera status to ready.
        SceneOrganiser.Instance.SetCameraStatus("Ready");

        // Stop the capture loop if active
        CancelInvoke();
    }

10. Be sure to save your changes in Visual StudioVisual Studio before returning to UnityUnity .

11. Now that all the scripts have been completed, go back in the Unity Editor, then click and drag the

SceneOrganiserSceneOrganiser  class from the Scr iptsScr ipts  folder to the Main CameraMain Camera object in the Hierarchy Panel.

To perform a thorough test of your application you will need to sideload it onto your HoloLens.

Before you do, ensure that:

All the settings mentioned in the Chapter 2 are set correctly.



 Chapter 13 - Build and sideload your application

All the fields in the Main CameraMain Camera, Inspector Panel, are assigned properly.

The script SceneOrganiserSceneOrganiser  is attached to the Main CameraMain Camera object.

Make sure you insert your Prediction KeyPrediction Key  into the predictionKeypredictionKey  variable.

You have inserted your Prediction EndpointPrediction Endpoint into the predictionEndpointpredictionEndpoint variable.

You have inserted your Training KeyTraining Key  into the trainingKeytrainingKey  variable, of the CustomVisionTrainer class.

You have inserted your Project IDProject ID into the projectIdprojectId variable, of the CustomVisionTrainer class.

To begin the Build process:

1. Go to File > Build SettingsFile > Build Settings .

2. Tick Unity C# ProjectsUnity C# Projects .

3. Click BuildBuild. Unity will launch a File ExplorerFile Explorer  window, where you need to create and then select a folder

to build the app into. Create that folder now, and name it AppApp. Then with the AppApp folder selected, click on

Select FolderSelect Folder .

4. Unity will begin building your project to the AppApp folder.

5. Once Unity has finished building (it might take some time), it will open a File ExplorerFile Explorer  window at the

location of your build (check your task bar, as it may not always appear above your windows, but will

notify you of the addition of a new window).

To deploy on HoloLens:

1. You will need the IP Address of your HoloLens (for Remote Deploy), and to ensure your HoloLens is in

Developer ModeDeveloper Mode. To do this:

a. Whilst wearing your HoloLens, open the SettingsSettings .

b. Go to Network & InternetNetwork & Internet > Wi-FiWi-Fi  > Advanced OptionsAdvanced Options

c. Note the IPv4IPv4  address.

d. Next, navigate back to SettingsSettings , and then to Update & SecurityUpdate & Security  > For DevelopersFor Developers

e. Set Developer Mode OnDeveloper Mode On.

2. Navigate to your new Unity build (the AppApp folder) and open the solution file with Visual StudioVisual Studio.

3. In the Solution Configuration select DebugDebug.

4. In the Solution Platform, select x86, Remote Machinex86, Remote Machine. You will be prompted to insert the IP addressIP address  of

a remote device (the HoloLens, in this case, which you noted).

5. Go to BuildBuild menu and click on Deploy SolutionDeploy Solution to sideload the application to your HoloLens.

6. Your app should now appear in the list of installed apps on your HoloLens, ready to be launched!



NOTENOTE

 To use the application:

        // Change this flag to switch between Analysis mode and Training mode 
        AppMode = AppModes.Training;

        // Change this flag to switch between Analysis mode and Training mode 
        AppMode = AppModes.Analysis;

 Chapter 14 - Evaluate and improve your Custom Vision model

To deploy to immersive headset, set the Solution PlatformSolution Platform to Local Machine, and set the ConfigurationConfiguration to Debug,

with x86 as the PlatformPlatform. Then deploy to the local machine, using the BuildBuild menu item, selecting Deploy Solution.

To switch the app functionality between Training mode and Prediction mode you need to update the AppModeAppMode

variable, located in the Awake()Awake()  method located within the ImageCapture class.

or

In Training mode:

Look at MouseMouse or KeyboardKeyboard and use the Tap gestureTap gesture.

Next, text will appear asking you to provide a tag.

Say either MouseMouse or KeyboardKeyboard.

In Prediction mode:

Look at an object and use the Tap gestureTap gesture.

Text will appear providing the object detected, with the highest probability (this is normalized).

To make your Service more accurate, you will need to continue to train the model used for prediction. This is

accomplished through using your new application, with both the training and prediction modes, with the latter

requiring you to visit the portal, which is what is covered in this Chapter. Be prepared to revisit your portal many

times, to continually improve your model.

1. Head to your Azure Custom Vision Portal again, and once you are in your project, select the Predictions

tab (from the top center of the page):

2. You will see all the images which were sent to your Service whilst your application was running. If you

hover over the images, they will provide you with the predictions that were made for that image:



3. Select one of your images to open it. Once open, you will see the predictions made for that image to the

right. If you the predictions were correct, and you wish to add this image to your Service's training model,

click the My Tags input box, and select the tag you wish to associate. When you are finished, click the Save

and close button to the bottom right, and continue on to the next image.

4. Once you are back to the grid of images, you will notice the images which you have added tags to (and

saved), will be removed. If you find any images which you think do not have your tagged item within

them, you can delete them, by clicking the tick on that image (can do this for several images) and then

clicking Delete in the upper right corner of the grid page. On the popup that follows, you can click either

Yes, delete or No, to confirm the deletion or cancel it, respectively.



 Your finished Custom Vision API application

 Bonus exercises
  Exercise 1Exercise 1

  Exercise 2Exercise 2

  Exercise 3Exercise 3

5. When you are ready to proceed, click the green Train button in the top right. Your Service model will be

trained with all the images which you have now provided (which will make it more accurate). Once the

training is complete, make sure to click the Make default button once more, so that your Prediction URL

continues to use the most up-to-date iteration of your Service.

 

Congratulations, you built a mixed reality app that leverages the Azure Custom Vision API to recognize real

world objects, train the Service model, and display confidence of what has been seen.

Train your Custom Vision Ser viceCustom Vision Ser vice to recognize more objects.

As a way to expand on what you have learned, complete the following exercises:

Play a sound when an object is recognized.

Use the API to re-train your Service with the same images your app is analyzing, so to make the Service more

accurate (do both prediction and training simultaneously).
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NOTENOTE
The Mixed Reality Academy tutorials were designed with HoloLens (1st gen) and Mixed Reality Immersive Headsets in

mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for guidance in

developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being used for

HoloLens 2. They will be maintained to continue working on the supported devices. There will be a new series of tutorials

that will be posted in the future that will demonstrate how to develop for HoloLens 2. This notice will be updated with a

link to those tutorials when they are posted.

In this course, you will learn how to integrate Language Understanding into a mixed reality application using

Azure Cognitive Services, with the Language Understanding API.

Language Understanding (LUIS) is a Microsoft Azure service, which provides applications with the ability to

make meaning out of user input, such as through extracting what a person might want, in their own words. This

is achieved through machine learning, which understands and learns the input information, and then can reply

with detailed, relevant, information. For more information, visit the Azure Language Understanding (LUIS) page.

Having completed this course, you will have a mixed reality immersive headset application which will be able to

do the following:

1. Capture user input speech, using the Microphone attached to the immersive headset.

2. Send the captured dictation the Azure Language Understanding Intelligent Service (LUIS).

3. Have LUIS extract meaning from the send information, which will be analyzed, and attempt to determine the

intent of the user ’s request will be made.

Development will include the creation of an app where the user will be able to use voice and/or gaze to change

the size and the color of the objects in the scene. The use of motion controllers will not be covered.

In your application, it is up to you as to how you will integrate the results with your design. This course is

designed to teach you how to integrate an Azure Service with your Unity Project. It is your job to use the

knowledge you gain from this course to enhance your mixed reality application.

Be prepared to Train LUIS several times, which is covered in Chapter 12. You will get better results the more

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/mr-azure-303.md
https://azure.microsoft.com/services/cognitive-services/language-understanding-intelligent-service/
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MR and Azure 303: Natural language
understanding (LUIS)

✔️ ✔️

NOTENOTE

 Prerequisites

NOTENOTE

 Before you start

times LUIS has been trained.

While this course primarily focuses on Windows Mixed Reality immersive (VR) headsets, you can also apply what you learn

in this course to Microsoft HoloLens. As you follow along with the course, you will see notes on any changes you might

need to employ to support HoloLens. When using HoloLens, you may notice some echo during voice capture.

This tutorial is designed for developers who have basic experience with Unity and C#. Please also be aware that the

prerequisites and written instructions within this document represent what has been tested and verified at the time of

writing (May 2018). You are free to use the latest software, as listed within the install the tools article, though it should

not be assumed that the information in this course will perfectly match what you'll find in newer software than what's

listed below.

We recommend the following hardware and software for this course:

A development PC, compatible with Windows Mixed Reality for immersive (VR) headset development

Windows 10 Fall Creators Update (or later) with Developer mode enabled

The latest Windows 10 SDK

Unity 2017.4

Visual Studio 2017

A Windows Mixed Reality immersive (VR) headset or Microsoft HoloLens with Developer mode enabled

A set of headphones with a built-in microphone (if the headset doesn't have a built-in mic and speakers)

Internet access for Azure setup and LUIS retrieval

1. To avoid encountering issues building this project, it is strongly suggested that you create the project

mentioned in this tutorial in a root or near-root folder (long folder paths can cause issues at build-time).

2. To allow your machine to enable Dictation, go to Windows Settings > Pr ivacy > Speech, Inking &Windows Settings > Pr ivacy > Speech, Inking &

TypingTyping and press on the button Turn On speech ser vices and typing suggestionsTurn On speech ser vices and typing suggestions .

3. The code in this tutorial will allow you to record from the Default Microphone DeviceDefault Microphone Device set on your

machine. Make sure the Default Microphone Device is set as the one you wish to use to capture your

voice.

4. If your headset has a built-in microphone, make sure the option “When I wear my headset, switch to

headset mic” is turned on in the Mixed Reality Portal settings.

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://support.microsoft.com/help/4039260/windows-10-mixed-reality-pc-hardware-guidelines
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/hololens/hololens1-hardware


 Chapter 1 – Setup Azure Portal
To use the Language Understanding service in Azure, you will need to configure an instance of the service to be

made available to your application.

NOTENOTE

NOTENOTE

1. Log in to the Azure Portal.

If you do not already have an Azure account, you will need to create one. If you are following this tutorial in a

classroom or lab situation, ask your instructor or one of the proctors for help setting up your new account.

2. Once you are logged in, click on NewNew  in the top left corner, and search for Language Understanding, and

click EnterEnter .

The word NewNew may have been replaced with Create a resourceCreate a resource, in newer portals.

3. The new page to the right will provide a description of the Language Understanding service. At the

bottom left of this page, select the CreateCreate button, to create an instance of this service.

https://portal.azure.com


4. Once you have clicked on Create:

a. Insert your desired NameName for this service instance.

b. Select a Subscr iptionSubscr iption.

c. Select the Pr icing TierPr icing Tier  appropriate for you, if this is the first time creating a LUIS Service, a free

tier (named F0) should be available to you. The free allocation should be more than sufficient for

this course.

d. Choose a Resource GroupResource Group or create a new one. A resource group provides a way to monitor,

control access, provision and manage billing for a collection of Azure assets. It is recommended to

keep all the Azure services associated with a single project (e.g. such as these courses) under a

common resource group).

If you wish to read more about Azure Resource Groups, please visit the resource group article.

e. Determine the LocationLocation for your resource group (if you are creating a new Resource Group). The

location would ideally be in the region where the application would run. Some Azure assets are

only available in certain regions.

f. You will also need to confirm that you have understood the Terms and Conditions applied to this

Service.

g. Select CreateCreate.

https://docs.microsoft.com/en-us/azure/azure-resource-manager/resource-group-portal


5. Once you have clicked on CreateCreate, you will have to wait for the service to be created, this might take a

minute.

6. A notification will appear in the portal once the Service instance is created.

7. Click on the notification to explore your new Service instance.

8. Click the Go to resourceGo to resource button in the notification to explore your new Service instance. You will be

taken to your new LUIS service instance.



 Chapter 2 – The Language Understanding Portal

IMPORTANTIMPORTANT

9. Within this tutorial, your application will need to make calls to your service, which is done through using

your service’s Subscription Key.

10. From the Quick start page, of your LUIS API service, navigate to the first step, Grab your keys, and click

KeysKeys  (you can also achieve this by clicking the blue hyperlink Keys, located in the services navigation

menu, denoted by the key icon). This will reveal your service Keys.

11. Take a copy of one of the displayed keys, as you will need this later in your project.

12. In the Service page, click on Language Understanding Portal to be redirected to the webpage which you

will use to create your new Service, within the LUIS App.

In this section you will learn how to make a LUIS App on the LUIS Portal.

Please be aware, that setting up the Entities, Intents, and Utterances within this chapter is only the first step in building

your LUIS service: you will also need to retrain the service, several times, so to make it more accurate. Retraining your

service is covered in the last Chapter of this course, so ensure that you complete it.

1. Upon reaching the Language Understanding Portal, you may need to login, if you are not already, with

the same credentials as your Azure portal.



2. If this is your first time using LUIS, you will need to scroll down to the bottom of the welcome page, to

find and click on the Create LUIS appCreate LUIS app button.

3. Once logged in, click My appsMy apps  (if you are not in that section currently). You can then click on Create newCreate new

appapp.

4. Give your app a Name.

5. If your app is supposed to understand a language different from English, you should change the Culture

to the appropriate language.

6. Here you can also add a Description of your new LUIS app.

7. Once you press DoneDone, you will enter the Build page of your new LUIS application.



8. There are a few important concepts to understand here:

Intent, represents the method that will be called following a query from the user. An INTENT may have

one or more ENTITIES.

Entity, is a component of the query that describes information relevant to the INTENT.

Utterances, are examples of queries provided by the developer, that LUIS will use to train itself.

If these concepts are not perfectly clear, do not worry, as this course will clarify them further in this chapter.

You will begin by creating the Entities needed to build this course.

9. On the left side of the page, click on Entities, then click on Create new entityCreate new entity .

10. Call the new Entity color, set its type to Simple, then press DoneDone.

11. Repeat this process to create three (3) more Simple Entities named:

upsize

downsize

target

The result should look like the image below:



WARNINGWARNING

NOTENOTE

At this point you can begin creating Intents.

Do not delete the NoneNone intent.

IMPORTANTIMPORTANT

12. On the left side of the page, click on IntentsIntents , then click on Create new intentCreate new intent.

13. Call the new Intent ChangeObjectColorChangeObjectColor .

This Intent name is used within the code later in this course, so for best results, use this name exactly as provided.

Once you confirm the name you will be directed to the Intents Page.

You will notice that there is a textbox asking you to type 5 or more different Utterances.

LUIS converts all Utterances to lower case.



The color of the cylinder must be red

make the cube black

make the cylinder color white

change the sphere to red

change it to green

make this yellow

change the color of this object to blue

14. Insert the following Utterance in the top textbox (currently with the text Type about 5 examples… ), and press

EnterEnter :

You will notice that the new Utterance will appear in a list underneath.

Following the same process, insert the following six (6) Utterances:

For each Utterance you have created, you must identify which words should be used by LUIS as Entities. In this

example you need to label all the colors as a color Entity, and all the possible reference to a target as a target

Entity.

15. To do so, try clicking on the word cylinder in the first Utterance and select target.

16. Now click on the word red in the first Utterance and select color.



TIPTIP

NOTENOTE

17. Label the next line also, where cube should be a target, and black should be a color. Notice also the use of

the words ‘this’, ‘it’, and ‘this object’, which we are providing, so to have non-specific target types

available also.

18. Repeat the process above until all the Utterances have the Entities labelled. See the below image if you

need help.

When selecting words to label them as entities:

For single words just click them.

For a set of two or more words, click at the beginning and then at the end of the set.

You can use the Tokens View toggle button to switch between Entities / Tokens ViewEntities / Tokens View!

19. The results should be as seen in the images below, showing the Entities / Tokens ViewEntities / Tokens View :



increase the dimensions of that

reduce the size of this

i want the sphere smaller

make the cylinder bigger

size down the sphere

size up the cube

decrease the size of that object

increase the size of this object

20. At this point press the TrainTrain button at the top-right of the page and wait for the small round indicator on

it to turn green. This indicates that LUIS has been successfully trained to recognize this Intent.

21. As an exercise for you, create a new Intent called ChangeObjectS izeChangeObjectS ize, using the Entities target, upsize,

and downsize.

22. Following the same process as the previous Intent, insert the following eight (8) Utterances for Size

change:



23. The result should be like the one in the image below:

24. Once both Intents, ChangeObjectColorChangeObjectColor  and ChangeObjectS izeChangeObjectS ize, have been created and trained, click

on the PUBLISHPUBLISH button on top of the page.

25. On the Publish page you will finalize and publish your LUIS App so that it can be accessed by your code.

a. Set the drop down Publish To as ProductionProduction.

b. Set the Timezone to your time zone.

c. Check the box Include all predicted intent scoresInclude all predicted intent scores .

d. Click on Publish to Production S lotPublish to Production S lot.



 Chapter 3 – Set up the Unity project

IMPORTANTIMPORTANT

26. In the section Resources and Keys:

a. Select the region you set for service instance in the Azure Portal.

b. You will notice a Star ter_KeyStar ter_Key  element below, ignore it.

c. Click on Add KeyAdd Key  and insert the Key that you obtained in the Azure Portal when you created your

Service instance. If your Azure and the LUIS portal are logged into the same user, you will be provided

drop-down menus for Tenant name, Subscription Name, and the Key you wish to use (will have the

same name as you provided previously in the Azure Portal.

Underneath Endpoint, take a copy of the endpoint corresponding to the Key you have inserted, you will soon use

it in your code.

The following is a typical set up for developing with the mixed reality, and as such, is a good template for other

projects.

1. Open Unity and click NewNew .

2. You will now need to provide a Unity Project name, insert MR_LUISMR_LUIS . Make sure the project type is set to

3D3D. Set the LocationLocation to somewhere appropriate for you (remember, closer to root directories is better).

Then, click Create projectCreate project.



3. With Unity open, it is worth checking the default Scr ipt EditorScr ipt Editor  is set to Visual StudioVisual Studio. Go to Edit >

Preferences and then from the new window, navigate to External ToolsExternal Tools . Change External Scr ipt EditorExternal Scr ipt Editor

to Visual Studio 2017Visual Studio 2017 . Close the PreferencesPreferences  window.

4. Next, go to File > Build SettingsFile > Build Settings  and switch the platform to Universal Windows PlatformUniversal Windows Platform , by

clicking on the Switch PlatformSwitch Platform button.



5. Go to File > Build SettingsFile > Build Settings  and make sure that:

a. Target DeviceTarget Device is set to Any DeviceAny Device

For the Microsoft HoloLens, set Target DeviceTarget Device to HoloLens.

b. Build TypeBuild Type is set to D3DD3D

c. SDKSDK is set to Latest installedLatest installed

d. Visual Studio VersionVisual Studio Version is set to Latest installedLatest installed

e. Build and RunBuild and Run is set to Local MachineLocal Machine

f. Save the scene and add it to the build.

a. Do this by selecting Add Open ScenesAdd Open Scenes . A save window will appear.

b. Create a new folder for this, and any future, scene, then select the New folderNew folder  button, to



create a new folder, name it ScenesScenes .

c. Open your newly created ScenesScenes  folder, and then in the File name: text field, type

MR_LuisSceneMR_LuisScene, then press SaveSave.

g. The remaining settings, in Build Settings, should be left as default for now.

6. In the Build Settings window, click on the Player SettingsPlayer Settings  button, this will open the related panel in the

space where the Inspector is located.



7. In this panel, a few settings need to be verified:

a. In the Other SettingsOther Settings  tab:

a. Scr ipting Runtime VersionScr ipting Runtime Version should be StableStable (.NET 3.5 Equivalent).

b. Scr ipting BackendScripting Backend should be .NET.NET

c. API Compatibility LevelAPI Compatibility Level  should be .NET 4.6.NET 4.6

b. Within the Publishing SettingsPublishing Settings  tab, under CapabilitiesCapabilities , check:

a. InternetClientInternetClient

b. MicrophoneMicrophone

c. Further down the panel, in XR SettingsXR Settings  (found below Publish SettingsPublish Settings ), tick Vir tual RealityVir tual Reality

Suppor tedSuppor ted, make sure the Windows Mixed Reality SDKWindows Mixed Reality SDK is added.



 Chapter 4 – Create the scene

IMPORTANTIMPORTANT

8. Back in Build Settings Unity C# Projects is no longer greyed out; tick the checkbox next to this.

9. Close the Build Settings window.

10. Save your Scene and Project (FILE > SAVE SCENE / FILE > SAVE PROJECTFILE > SAVE SCENE / FILE > SAVE PROJECT).

If you wish to skip the Unity Set up component of this course, and continue straight into code, feel free to download this

.unitypackage, import it into your project as a Custom Package, and then continue from Chapter 5.

1. Right-click in an empty area of the Hierarchy Panel, under 3D Object3D Object, add a PlanePlane.

2. Be aware that when you right-click within the Hierarchy again to create more objects, if you still have the

last object selected, the selected object will be the parent of your new object. Avoid this left-clicking in an

empty space within the Hierarchy, and then right-clicking.

3. Repeat the above procedure to add the following objects:

a. Sphere

b. Cylinder

c. Cube

d. 3D Text

4. The resulting scene Hierarchy should be like the one in the image below:

https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20303%20-%20Natural%20language%20understanding/Azure-MR-303.unitypackage
https://docs.unity3d.com/Manual/AssetPackages.html


NOTENOTE

X A X ISX  A X IS Y  A X ISY  A X IS Z  A X ISZ  A X IS

0 -1 0

5. Left click on the Main CameraMain Camera to select it, look at the Inspector Panel you will see the Camera object with

all the its components.

6. Click on the Add ComponentAdd Component button located at the very bottom of the Inspector Panel.

7. Search for the component called Audio Source, as shown above.

8. Also make sure that the Transform component of the Main Camera is set to (0,0,0), this can be done by

pressing the GearGear  icon next to the Camera’s Transform component and selecting ResetReset. The Transform

component should then look like:

a. Position is set to 0, 0 , 00, 0 , 0 .

b. Rotation is set to 0, 0 , 00, 0 , 0 .

For the Microsoft HoloLens, you will need to also change the following, which are part of the CameraCamera

component, which is on your Main CameraMain Camera:

Clear Flags:Clear Flags:  Solid Color.

BackgroundBackground ‘Black, Alpha 0’ – Hex color: #00000000.

9. Left click on the PlanePlane to select it. In the Inspector Panel set the Transform component with the following

values:

10. Left click on the SphereSphere to select it. In the Inspector Panel set the Transform component with the

following values:



XX YY ZZ

0 1 4

XX YY ZZ
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XX YY ZZ

-2 6 9

XX YY ZZ

0.1 0.1 0.1
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2 1 2
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-2 1 2

11. Left click on the CylinderCylinder  to select it. In the Inspector Panel set the Transform component with the

following values:

12. Left click on the CubeCube to select it. In the Inspector Panel set the Transform component with the following

values:

Transform - PositionTransform - Position

Transform - RotationTransform - Rotation

13. Left click on the New TextNew Text object to select it. In the Inspector Panel set the Transform component with the

following values:

Transform - PositionTransform - Position

Transform - ScaleTransform - Scale

14. Change Font S izeFont S ize in the Text MeshText Mesh component to 5050 .

15. Change the name of the Text MeshText Mesh object to Dictation TextDictation Text.



 Chapter 5 – Create the MicrophoneManager class

16. Your Hierarchy Panel structure should now look like this:

17. The final scene should look like the image below:

The first Script you are going to create is the MicrophoneManager class. Following this, you will create the

LuisManager, the Behaviours class, and lastly the Gaze class (feel free to create all these now, though it will be

covered as you reach each Chapter).

The MicrophoneManager class is responsible for :

Detecting the recording device attached to the headset or machine (whichever is the default one).

Capture the audio (voice) and use dictation to store it as a string.

Once the voice has paused, submit the dictation to the LuisManager class.



To create this class:

    using UnityEngine;
    using UnityEngine.Windows.Speech;

    public static MicrophoneManager instance; //help to access instance of this object
    private DictationRecognizer dictationRecognizer;  //Component converting speech to text
    public TextMesh dictationText; //a UI object used to debug dictation result

    private void Awake()
    {
        // allows this class instance to behave like a singleton
        instance = this;
    }

    void Start()
    {
        if (Microphone.devices.Length > 0)
        {
            StartCapturingAudio();
            Debug.Log("Mic Detected");
        }
    }

1. Right-click in the Project Panel, Create > FolderCreate > Folder . Call the folder Scr iptsScr ipts .

2. With the Scr iptsScr ipts  folder created, double click it, to open. Then, within that folder, right-click, Create > C#Create > C#

ScriptScr ipt. Name the script MicrophoneManager.

3. Double click on MicrophoneManager to open it with Visual Studio.

4. Add the following namespaces to the top of the file:

5. Then add the following variables inside the MicrophoneManager class:

6. Code for Awake() and Start() methods now needs to be added. These will be called when the class

initializes:



    /// <summary>
    /// Start microphone capture, by providing the microphone as a continual audio source (looping),
    /// then initialise the DictationRecognizer, which will capture spoken words
    /// </summary>
    public void StartCapturingAudio()
    {
        if (dictationRecognizer == null)
        {
            dictationRecognizer = new DictationRecognizer
            {
                InitialSilenceTimeoutSeconds = 60,
                AutoSilenceTimeoutSeconds = 5
            };

            dictationRecognizer.DictationResult += DictationRecognizer_DictationResult;
            dictationRecognizer.DictationError += DictationRecognizer_DictationError;
        }
        dictationRecognizer.Start();
        Debug.Log("Capturing Audio...");
    }

    /// <summary>
    /// Stop microphone capture
    /// </summary>
    public void StopCapturingAudio()
    {
        dictationRecognizer.Stop();
        Debug.Log("Stop Capturing Audio...");
    }

    /// <summary>
    /// This handler is called every time the Dictation detects a pause in the speech. 
    /// This method will stop listening for audio, send a request to the LUIS service 
    /// and then start listening again.
    /// </summary>
    private void DictationRecognizer_DictationResult(string dictationCaptured, ConfidenceLevel 
confidence)
    {
        StopCapturingAudio();
        StartCoroutine(LuisManager.instance.SubmitRequestToLuis(dictationCaptured, 
StartCapturingAudio));
        Debug.Log("Dictation: " + dictationCaptured);
        dictationText.text = dictationCaptured;
    }

    private void DictationRecognizer_DictationError(string error, int hresult)
    {
        Debug.Log("Dictation exception: " + error);
    }

IMPORTANTIMPORTANT

7. Now you need the method that the App uses to start and stop the voice capture, and pass it to the

LuisManager class, that you will build soon.

8. Add a Dictation Handler that will be invoked when the voice pauses. This method will pass the dictation

text to the LuisManager class.

Delete the Update() method since this class will not use it.

9. Be sure to save your changes in Visual Studio before returning to Unity.



 Chapter 6 – Create the LUISManager class

NOTENOTE
At this point you will notice an error appearing in the Unity Editor Console Panel. This is because the code

references the LuisManager class which you will create in the next Chapter.

It is time for you to create the LuisManager class, which will make the call to the Azure LUIS service.

The purpose of this class is to receive the dictation text from the MicrophoneManager class and send it to the

Azure Language Understanding API to be analyzed.

This class will deserialize the JSON response and call the appropriate methods of the Behaviours class to trigger

an action.

To create this class:

    using System;
    using System.Collections;
    using System.Collections.Generic;
    using System.IO;
    using UnityEngine;
    using UnityEngine.Networking;

1. Double click on the Scr iptsScr ipts  folder, to open it.

2. Right-click inside the Scr iptsScr ipts  folder, click Create > C# Scr iptCreate > C# Scr ipt. Name the script LuisManager.

3. Double click on the script to open it with Visual Studio.

4. Add the following namespaces to the top of the file:

5. You will begin by creating three classes insideinside the LuisManager class (within the same script file, above

the Start() method) that will represent the deserialized JSON response from Azure.



    [Serializable] //this class represents the LUIS response
    public class AnalysedQuery
    {
        public TopScoringIntentData topScoringIntent;
        public EntityData[] entities;
        public string query;
    }

    // This class contains the Intent LUIS determines 
    // to be the most likely
    [Serializable]
    public class TopScoringIntentData
    {
        public string intent;
        public float score;
    }

    // This class contains data for an Entity
    [Serializable]
    public class EntityData
    {
        public string entity;
        public string type;
        public int startIndex;
        public int endIndex;
        public float score;
    }

    public static LuisManager instance;

    //Substitute the value of luis Endpoint with your own End Point
    string luisEndpoint = "https://westus.api.cognitive... add your endpoint from the Luis Portal";

    private void Awake()
    {
        // allows this class instance to behave like a singleton
        instance = this;
    }

6. Next, add the following variables inside the LuisManager class:

7. Make sure to place your LUIS endpoint in now (which you will have from your LUIS portal).

8. Code for the Awake() method now needs to be added. This method will be called when the class

initializes:

9. Now you need the methods this application uses to send the dictation received from the

MicrophoneManager class to LUIS, and then receive and deserialize the response.

10. Once the value of the Intent, and associated Entities, have been determined, they are passed to the

instance of the Behaviours class to trigger the intended action.



    /// <summary>
    /// Call LUIS to submit a dictation result.
    /// The done Action is called at the completion of the method.
    /// </summary>
    public IEnumerator SubmitRequestToLuis(string dictationResult, Action done)
    {
        string queryString = string.Concat(Uri.EscapeDataString(dictationResult));

        using (UnityWebRequest unityWebRequest = UnityWebRequest.Get(luisEndpoint + queryString))
        {
            yield return unityWebRequest.SendWebRequest();

            if (unityWebRequest.isNetworkError || unityWebRequest.isHttpError)
            {
                Debug.Log(unityWebRequest.error);
            }
            else
            {
                try
                {
                    AnalysedQuery analysedQuery = JsonUtility.FromJson<AnalysedQuery>
(unityWebRequest.downloadHandler.text);

                    //analyse the elements of the response 
                    AnalyseResponseElements(analysedQuery);
                }
                catch (Exception exception)
                {
                    Debug.Log("Luis Request Exception Message: " + exception.Message);
                }
            }

            done();
            yield return null;
        }
    }

11. Create a new method called AnalyseResponseElements() that will read the resulting AnalysedQuery and

determine the Entities. Once those Entities are determined, they will be passed to the instance of the

Behaviours class to use in the actions.



    private void AnalyseResponseElements(AnalysedQuery aQuery)
    {
        string topIntent = aQuery.topScoringIntent.intent;

        // Create a dictionary of entities associated with their type
        Dictionary<string, string> entityDic = new Dictionary<string, string>();

        foreach (EntityData ed in aQuery.entities)
        {
            entityDic.Add(ed.type, ed.entity);
        }

        // Depending on the topmost recognized intent, read the entities name
        switch (aQuery.topScoringIntent.intent)
        {
            case "ChangeObjectColor":
                string targetForColor = null;
                string color = null;

                foreach (var pair in entityDic)
                {
                    if (pair.Key == "target")
                    {
                        targetForColor = pair.Value;
                    }
                    else if (pair.Key == "color")
                    {
                        color = pair.Value;
                    }
                }

                Behaviours.instance.ChangeTargetColor(targetForColor, color);
                break;

            case "ChangeObjectSize":
                string targetForSize = null;
                foreach (var pair in entityDic)
                {
                    if (pair.Key == "target")
                    {
                        targetForSize = pair.Value;
                    }
                }

                if (entityDic.ContainsKey("upsize") == true)
                {
                    Behaviours.instance.UpSizeTarget(targetForSize);
                }
                else if (entityDic.ContainsKey("downsize") == true)
                {
                    Behaviours.instance.DownSizeTarget(targetForSize);
                }
                break;
        }
    }

IMPORTANTIMPORTANT
Delete the Start() and Update() methods since this class will not use them.

12. Be sure to save your changes in Visual Studio before returning to Unity.



NOTENOTE

 Chapter 7 – Create the Behaviours class

At this point you will notice several errors appearing in the Unity Editor Console Panel. This is because the code references

the Behaviours class which you will create in the next Chapter.

The Behaviours class will trigger the actions using the Entities provided by the LuisManager class.

To create this class:

    public static Behaviours instance;

    // the following variables are references to possible targets
    public GameObject sphere;
    public GameObject cylinder;
    public GameObject cube;
    internal GameObject gazedTarget;

    void Awake()
    {
        // allows this class instance to behave like a singleton
        instance = this;
    }

1. Double click on the Scr iptsScr ipts  folder, to open it.

2. Right-click inside the Scr iptsScr ipts  folder, click Create > C# Scr iptCreate > C# Scr ipt. Name the script Behaviours.

3. Double click on the script to open it with Visual Studio.

4. Then add the following variables inside the Behaviours class:

5. Add the Awake() method code. This method will be called when the class initializes:

6. The following methods are called by the LuisManager class (which you have created previously) to

determine which object is the target of the query and then trigger the appropriate action.



    /// <summary>
    /// Changes the color of the target GameObject by providing the name of the object
    /// and the name of the color
    /// </summary>
    public void ChangeTargetColor(string targetName, string colorName)
    {
        GameObject foundTarget = FindTarget(targetName);
        if (foundTarget != null)
        {
            Debug.Log("Changing color " + colorName + " to target: " + foundTarget.name);

            switch (colorName)
            {
                case "blue":
                    foundTarget.GetComponent<Renderer>().material.color = Color.blue;
                    break;

                case "red":
                    foundTarget.GetComponent<Renderer>().material.color = Color.red;
                    break;

                case "yellow":
                    foundTarget.GetComponent<Renderer>().material.color = Color.yellow;
                    break;

                case "green":
                    foundTarget.GetComponent<Renderer>().material.color = Color.green;
                    break;

                case "white":
                    foundTarget.GetComponent<Renderer>().material.color = Color.white;
                    break;

                case "black":
                    foundTarget.GetComponent<Renderer>().material.color = Color.black;
                    break;
            }          
        }
    }

    /// <summary>
    /// Reduces the size of the target GameObject by providing its name
    /// </summary>
    public void DownSizeTarget(string targetName)
    {
        GameObject foundTarget = FindTarget(targetName);
        foundTarget.transform.localScale -= new Vector3(0.5F, 0.5F, 0.5F);
    }

    /// <summary>
    /// Increases the size of the target GameObject by providing its name
    /// </summary>
    public void UpSizeTarget(string targetName)
    {
        GameObject foundTarget = FindTarget(targetName);
        foundTarget.transform.localScale += new Vector3(0.5F, 0.5F, 0.5F);
    }

7. Add the FindTarget() method to determine which of the GameObjects is the target of the current Intent.

This method defaults the target to the GameObject being “gazed” if no explicit target is defined in the

Entities.
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    /// <summary>
    /// Determines which object reference is the target GameObject by providing its name
    /// </summary>
    private GameObject FindTarget(string name)
    {
        GameObject targetAsGO = null;

        switch (name)
        {
            case "sphere":
                targetAsGO = sphere;
                break;

            case "cylinder":
                targetAsGO = cylinder;
                break;

            case "cube":
                targetAsGO = cube;
                break;

            case "this": // as an example of target words that the user may use when looking at an 
object
            case "it":  // as this is the default, these are not actually needed in this example
            case "that":
            default: // if the target name is none of those above, check if the user is looking at 
something
                if (gazedTarget != null) 
                {
                    targetAsGO = gazedTarget;
                }
                break;
        }
        return targetAsGO;
    }

IMPORTANTIMPORTANT
Delete the Start() and Update() methods since this class will not use them.

8. Be sure to save your changes in Visual Studio before returning to Unity.

The last class that you will need to complete this app is the Gaze class. This class updates the reference to the

GameObject currently in the user ’s visual focus.

To create this Class:

1. Double click on the Scr iptsScr ipts  folder, to open it.

2. Right-click inside the Scr iptsScr ipts  folder, click Create > C# Scr iptCreate > C# Scr ipt. Name the script Gaze.

3. Double click on the script to open it with Visual Studio.

4. Insert the following code for this class:
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    using UnityEngine;

    public class Gaze : MonoBehaviour
    {        
        internal GameObject gazedObject;
        public float gazeMaxDistance = 300;

        void Update()
        {
            // Uses a raycast from the Main Camera to determine which object is gazed upon.
            Vector3 fwd = gameObject.transform.TransformDirection(Vector3.forward);
            Ray ray = new Ray(Camera.main.transform.position, fwd);
            RaycastHit hit;
            Debug.DrawRay(Camera.main.transform.position, fwd);

            if (Physics.Raycast(ray, out hit, gazeMaxDistance) && hit.collider != null)
            {
                if (gazedObject == null)
                {
                    gazedObject = hit.transform.gameObject;

                    // Set the gazedTarget in the Behaviours class
                    Behaviours.instance.gazedTarget = gazedObject;
                }
            }
            else
            {
                ResetGaze();
            }         
        }

        // Turn the gaze off, reset the gazeObject in the Behaviours class.
        public void ResetGaze()
        {
            if (gazedObject != null)
            {
                Behaviours.instance.gazedTarget = null;
                gazedObject = null;
            }
        }
    }

5. Be sure to save your changes in Visual Studio before returning to Unity.

1. To complete the setup of the scene, drag each script that you have created from the Scripts Folder to the

Main CameraMain Camera object in the Hierarchy Panel.

2. Select the Main CameraMain Camera and look at the Inspector Panel, you should be able to see each script that you

have attached, and you will notice that there are parameters on each script that are yet to be set.
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3. To set these parameters correctly, follow these instructions:

a. MicrophoneManager:

From the Hierarchy Panel, drag the Dictation TextDictation Text object into the Dictation TextDictation Text parameter

value box.

b. Behaviours, from the Hierarchy Panel:

Drag the SphereSphere object into the Sphere reference target box.

Drag the CylinderCylinder  into the Cylinder reference target box.

Drag the CubeCube into the Cube reference target box.

c. Gaze:

Set the Gaze Max Distance to 300300  (if it is not already).

4. The result should look like the image below:
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Test that the Scene setup is properly implemented.

Ensure that:

All the scripts are attached to the Main CameraMain Camera object.

All the fields in the Main Camera Inspector Panel are assigned properly.

make the cylinder red

change the cube to yellow

I want the sphere blue

make this to green

change it to white

NOTENOTE

1. Press the PlayPlay  button in the Unity Editor. The App should be running within the attached immersive

headset.

2. Try a few utterances, such as:

If you see an error in the Unity console about the default audio device changing, the scene may not function as

expected. This is due to the way the mixed reality portal deals with built-in microphones for headsets that have

them. If you see this error, simply stop the scene and start it again and things should work as expected.

Once you have ensured that the application is working in the Unity Editor, you are ready to Build and Deploy.

To Build:

1. Save the current scene by clicking on File > SaveFile > Save.

2. Go to File > Build SettingsFile > Build Settings .

3. Tick the box called Unity C# ProjectsUnity C# Projects  (useful for seeing and debugging your code once the UWP project

is created.

4. Click on Add Open ScenesAdd Open Scenes , then click BuildBuild.



5. You will be prompted to select the folder where you want to build the Solution.

6. Create a BUILDS folder and within that folder create another folder with an appropriate name of your

choice.

7. Click Select FolderSelect Folder  to begin the build at that location.
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IMPORTANTIMPORTANT

8. Once Unity has finished building (it might take some time), it should open a File ExplorerFile Explorer  window at the

location of your build.

To Deploy on Local Machine:

1. In Visual Studio, open the solution file that has been created in the previous Chapter.

2. In the Solution PlatformSolution Platform , select x86x86 , Local MachineLocal Machine.

3. In the Solution ConfigurationSolution Configuration select DebugDebug.

For the Microsoft HoloLens, you may find it easier to set this to Remote Machine, so that you are not

tethered to your computer. Though, you will need to also do the following:

Know the IP AddressIP Address  of your HoloLens, which can be found within the Settings > Network &

Internet > Wi-Fi > Advanced Options; the IPv4 is the address you should use.

Ensure Developer ModeDeveloper Mode is OnOn; found in Settings > Update & Security > For developers.

4. Go to the Build menuBuild menu and click on Deploy SolutionDeploy Solution to sideload the application to your machine.

5. Your App should now appear in the list of installed apps, ready to be launched!

6. Once launched, the App will prompt you to authorize access to the Microphone. Use the Motion

Controllers, or Voice Input, or the Keyboard to press the YESYES  button.

This chapter is incredibly important, and may need to be iterated upon several times, as it will help improve the accuracy

of your LUIS service: ensure you complete this.

To improve the level of understanding provided by LUIS you need to capture new utterances and use them to



re-train your LUIS App.

For example, you might have trained LUIS to understand “Increase” and “Upsize”, but wouldn’t you want your

app to also understand words like “Enlarge”?

Once you have used your application a few times, everything you have said will be collected by LUIS and

available in the LUIS PORTAL.

1. Go to your portal application following this LINK, and Log In.

2. Once you are logged in with your MS Credentials, click on your App name.

3. Click the Review endpoint utterancesReview endpoint utterances  button on the left of the page.

4. You will be shown a list of the Utterances that have been sent to LUIS by your mixed reality Application.

You will notice some highlighted Entities.

By hovering over each highlighted word, you can review each Utterance and determine which Entity has been

recognized correctly, which Entities are wrong and which Entities are missed.

In the example above, it was found that the word “spear” had been highlighted as a target, so it necessary to

correct the mistake, which is done by hovering over the word with the mouse and clicking Remove LabelRemove Label .

https://www.luis.ai/home


 Your finished LUIS Integrated application

 Bonus exercises
  Exercise 1Exercise 1

  Exercise 2Exercise 2

 

5. If you find Utterances that are completely wrong, you can delete them using the DeleteDelete button on the

right side of the screen.

6. Or if you feel that LUIS has interpreted the Utterance correctly, you can validate its understanding by

using the Add To Aligned IntentAdd To Aligned Intent button.

7. Once you have sorted all the displayed Utterances, try and reload the page to see if more are available.

8. It is very important to repeat this process as many times as possible to improve your application

understanding.

Have fun!Have fun!

Congratulations, you built a mixed reality app that leverages the Azure Language Understanding Intelligence

Service, to understand what a user says, and act on that information.

While using this application you might notice that if you gaze at the Floor object and ask to change its color, it

will do so. Can you work out how to stop your application from changing the Floor color?

Try extending the LUIS and App capabilities, adding additional functionality for objects in scene; as an example,

create new objects at the Gaze hit point, depending on what the user says, and then be able to use those objects

alongside current scene objects, with the existing commands.
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NOTENOTE
The Mixed Reality Academy tutorials were designed with HoloLens (1st gen) and Mixed Reality Immersive Headsets in

mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for guidance in

developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being used for

HoloLens 2. They will be maintained to continue working on the supported devices. There will be a new series of tutorials

that will be posted in the future that will demonstrate how to develop for HoloLens 2. This notice will be updated with a

link to those tutorials when they are posted.

In this course you will learn how to add face recognition capabilities to a mixed reality application, using Azure

Cognitive Services, with the Microsoft Face API.

Azure Face API is a Microsoft service, which provides developers with the most advanced face algorithms, all in

the cloud. The Face API has two main functions: face detection with attributes, and face recognition. This allows

developers to simply set a set of groups for faces, and then, send query images to the service later, to determine

to whom a face belongs. For more information, visit the Azure Face Recognition page.

Having completed this course, you will have a mixed reality HoloLens application, which will be able to do the

following:

1. Use a Tap GestureTap Gesture to initiate the capture of an image using the on-board HoloLens camera.

2. Send the captured image to the Azure Face API service.

3. Receive the results of the Face API algorithm.

4. Use a simple User Interface, to display the name of matched people.

This will teach you how to get the results from the Face API Service into your Unity-based mixed reality

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/mr-azure-304.md
https://azure.microsoft.com/services/cognitive-services/face/
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NOTENOTE

 Prerequisites

NOTENOTE

 Before you start

application.

In your application, it is up to you as to how you will integrate the results with your design. This course is

designed to teach you how to integrate an Azure Service with your Unity Project. It is your job to use the

knowledge you gain from this course to enhance your mixed reality application.

While this course primarily focuses on HoloLens, you can also apply what you learn in this course to Windows Mixed

Reality immersive (VR) headsets. Because immersive (VR) headsets do not have accessible cameras, you will need an

external camera connected to your PC. As you follow along with the course, you will see notes on any changes you might

need to employ to support immersive (VR) headsets.

This tutorial is designed for developers who have basic experience with Unity and C#. Please also be aware that the

prerequisites and written instructions within this document represent what has been tested and verified at the time of

writing (May 2018). You are free to use the latest software, as listed within the install the tools article, though it should

not be assumed that the information in this course will perfectly match what you'll find in newer software than what's

listed below.

We recommend the following hardware and software for this course:

A development PC, compatible with Windows Mixed Reality for immersive (VR) headset development

Windows 10 Fall Creators Update (or later) with Developer mode enabled

The latest Windows 10 SDK

Unity 2017.4

Visual Studio 2017

A Windows Mixed Reality immersive (VR) headset or Microsoft HoloLens with Developer mode enabled

A camera connected to your PC (for immersive headset development)

Internet access for Azure setup and Face API retrieval

1. To avoid encountering issues building this project, it is strongly suggested that you create the project

mentioned in this tutorial in a root or near-root folder (long folder paths can cause issues at build-time).

2. Set up and test your HoloLens. If you need support setting up your HoloLens, make sure to visit the HoloLens

setup article.

3. It is a good idea to perform Calibration and Sensor Tuning when beginning developing a new HoloLens App

(sometimes it can help to perform those tasks for each user).

For help on Calibration, please follow this link to the HoloLens Calibration article.

For help on Sensor Tuning, please follow this link to the HoloLens Sensor Tuning article.

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://support.microsoft.com/help/4039260/windows-10-mixed-reality-pc-hardware-guidelines
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens-setup
https://docs.microsoft.com/en-us/hololens/hololens-calibration#hololens-2
https://docs.microsoft.com/en-us/hololens/hololens-updates


 Chapter 1 - The Azure Portal
To use the Face API service in Azure, you will need to configure an instance of the service to be made available to

your application.

NOTENOTE

NOTENOTE

1. First, log in to the Azure Portal.

If you do not already have an Azure account, you will need to create one. If you are following this tutorial in a

classroom or lab situation, ask your instructor or one of the proctors for help setting up your new account.

2. Once you are logged in, click on NewNew  in the top left corner, and search for Face API, press EnterEnter .

The word NewNew may have been replaced with Create a resourceCreate a resource, in newer portals.

3. The new page will provide a description of the Face API service. At the bottom left of this prompt, select

the CreateCreate button, to create an association with this service.

https://portal.azure.com


4. Once you have clicked on CreateCreate:

a. Insert your desired name for this service instance.

b. Select a subscription.

c. Select the pricing tier appropriate for you, if this is the first time creating a Face API Service, a free

tier (named F0) should be available to you.

d. Choose a Resource GroupResource Group or create a new one. A resource group provides a way to monitor,

control access, provision and manage billing for a collection of Azure assets. It is recommended to

keep all the Azure services associated with a single project (e.g. such as these labs) under a

common resource group).

If you wish to read more about Azure Resource Groups, please visit the resource group article.

e. The UWP app, Person MakerPerson Maker , which you use later, requires the use of 'West US' for location.

f. You will also need to confirm that you have understood the Terms and Conditions applied to this

Service.

g. Select Create.*

https://docs.microsoft.com/en-us/azure/azure-resource-manager/resource-group-portal


5. Once you have clicked on Create,* you will have to wait for the service to be created, this might take a

minute.

6. A notification will appear in the portal once the Service instance is created.

7. Click on the notifications to explore your new Service instance.

8. When you are ready, click Go to resourceGo to resource button in the notification to explore your new Service

instance.
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NOTENOTE

9. Within this tutorial, your application will need to make calls to your service, which is done through using

your service's subscription 'key'. From the Quick start page, of your Face API service, the first point is

number 1, to Grab your keys.

10. On the Service page select either the blue KeysKeys  hyperlink (if on the Quick start page), or the KeysKeys  link in

the services navigation menu (to the left, denoted by the 'key' icon), to reveal your keys.

Take note of either one of the keys and safeguard it, as you will need it later.

Make sure to download the prebuilt UWP Application called Person Maker. This app is not the end product for

this course, just a tool to help you create your Azure entries, which the later project will rely upon.

Person MakerPerson Maker  allows you to create Azure entries, which are associated with people, and groups of people. The

application will place all the needed information in a format which can then later be used by the FaceAPI, in

order to recognize the faces of people whom you have added.

[IMPORTANT] Person MakerPerson Maker  uses some basic throttling, to help ensure that you do not exceed the number

of service calls per minute for the free subscr iption tierfree subscr iption tier . The green text at the top will change to red and

update as 'ACTIVE' when throttling is happening; if this is the case, simply wait for the application (it will wait

until it can next continue accessing the face service, updating as 'IN-ACTIVE' when you can use it again).

This application uses the Microsoft.ProjectOxford.Face libraries, which will allow you to make full use of the Face

API. This library is available for free as a NuGet Package. For more information about this, and similar, APIs make

sure to visit the API reference article.

https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20304%20-%20Face%20recognition/PersonMaker.zip
https://docs.microsoft.com/en-us/azure/cognitive-services/face/apireference


NOTENOTE

NOTENOTE

These are just the steps required, instructions for how to do these things is further down the document. The PersonPerson

MakerMaker  app will allow you to:

Create a Person Group, which is a group composed of several people which you want to associate with it. With

your Azure account you can host multiple Person Groups.

Create a Person, which is a member of a Person Group. Each person has a number of Face images associated with

it.

Assign face images to a Person, to allow your Azure Face API Service to recognize a Person by the corresponding

face.

Train your Azure Face API Service.

Be aware, so to train this app to recognize people, you will need ten (10) close-up photos of each person which

you would like to add to your Person Group. The Windows 10 Cam App can help you to take these. You must

ensure that each photo is clear (avoid blurring, obscuring, or being too far, from the subject), have the photo in

jpg or png file format, with the image file size being no larger 4 MB4 MB, and no less than 1 KB1 KB.

If you are following this tutorial, do not use your own face for training, as when you put the HoloLens on, you cannot

look at yourself. Use the face of a colleague or fellow student.

Running Person MakerPerson Maker :

1. Open the PersonMakerPersonMaker  folder and double click on the PersonMaker solution to open it with Visual

Studio.

2. Once the PersonMaker solution is open, make sure that:

a. The Solution Configuration is set to DebugDebug.

b. The Solution Platform is set to x86x86

c. The Target Platform is Local MachineLocal Machine.

d. You also may need to Restore NuGet Packages (right-click the Solution and select Restore NuGetRestore NuGet

PackagesPackages ).

3. Click Local Machine and the application will start. Be aware, on smaller screens, all content may not be

visible, though you can scroll further down to view it.



NOTENOTE

IMPORTANTIMPORTANT

4. Insert your Azure Authentication KeyAzure Authentication Key , which you should have, from your Face API service within

Azure.

5. Insert:

a. The ID you want to assign to the Person Group. The ID must be lowercase, with no spaces. Make note

of this ID, as it will be required later in your Unity project.

b. The Name you want to assign to the Person Group (can have spaces).

6. Press Create Person GroupCreate Person Group button. A confirmation message should appear underneath the button.

If you have an 'Access Denied' error, check the location you set for your Azure service. As stated above, this app is

designed for 'West US'.

You will notice that you can also click the Fetch a Known GroupFetch a Known Group button: this is for if you have already created a person

group, and wish to use that, rather than create a new one. Be aware, if you click Create a Person Group with a known

group, this will also fetch a group.

7. Insert the Name of the Person you want to create.

a. Click the Create PersonCreate Person button.

b. A confirmation message should appear underneath the button.
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c. If you wish to delete a person you have previously created, you can write the name into the textbox

and press Delete PersonDelete Person

8. Make sure you know the location of ten (10) photos of the person you would like to add to your group.

9. Press Create and Open FolderCreate and Open Folder  to open Windows Explorer to the folder associated to the person. Add

the ten (10) images in the folder. These must be of JPG or PNG file format.

10. Click on Submit To AzureSubmit To Azure. A counter will show you the state of the submission, followed by a message

when it has completed.

11. Once the counter has finished and a confirmation message has been displayed click on TrainTrain to train

your Service.

Once the process has completed, you are ready to move into Unity.

The following is a typical set up for developing with mixed reality, and as such, is a good template for other

projects.

1. Open Unity and click NewNew .

2. You will now need to provide a Unity Project name. Insert MR_FaceRecognitionMR_FaceRecognition. Make sure the project

type is set to 3D3D. Set the LocationLocation to somewhere appropriate for you (remember, closer to root

directories is better). Then, click Create projectCreate project.



3. With Unity open, it is worth checking the default Scr ipt EditorScr ipt Editor  is set to Visual StudioVisual Studio. Go to Edit >Edit >

PreferencesPreferences  and then from the new window, navigate to External ToolsExternal Tools . Change External Scr iptExternal Scr ipt

EditorEditor  to Visual Studio 2017Visual Studio 2017 . Close the PreferencesPreferences  window.

4. Next, go to File > Build SettingsFile > Build Settings  and switch the platform to Universal Windows PlatformUniversal Windows Platform , by

clicking on the Switch PlatformSwitch Platform button.



5. Go to File > Build SettingsFile > Build Settings  and make sure that:

a. Target DeviceTarget Device is set to HoloLensHoloLens

For the immersive headsets, set Target DeviceTarget Device to Any Device.

b. Build TypeBuild Type is set to D3DD3D

c. SDKSDK is set to Latest installedLatest installed

d. Visual Studio VersionVisual Studio Version is set to Latest installedLatest installed

e. Build and RunBuild and Run is set to Local MachineLocal Machine

f. Save the scene and add it to the build.

a. Do this by selecting Add Open ScenesAdd Open Scenes . A save window will appear.

b. Select the New folderNew folder  button, to create a new folder, name it ScenesScenes .



c. Open your newly created ScenesScenes  folder, and then in the File nameFile name: text field, type

FaceRecSceneFaceRecScene, then press SaveSave.

g. The remaining settings, in Build Settings, should be left as default for now.

6. In the Build Settings window, click on the Player SettingsPlayer Settings  button, this will open the related panel in the

space where the Inspector is located.
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7. In this panel, a few settings need to be verified:

a. In the Other SettingsOther Settings  tab:

a. Scr iptingScr ipting Runtime VersionRuntime Version should be ExperimentalExperimental  (.NET 4.6 Equivalent). Changing this

will trigger a need to restart the Editor.

b. Scr ipting BackendScripting Backend should be .NET.NET

c. API Compatibility LevelAPI Compatibility Level  should be .NET 4.6.NET 4.6

b. Within the Publishing SettingsPublishing Settings  tab, under CapabilitiesCapabilities , check:

InternetClientInternetClient

WebcamWebcam

c. Further down the panel, in XR SettingsXR Settings  (found below Publish SettingsPublish Settings ), tick Vir tual RealityVir tual Reality

Suppor tedSuppor ted, make sure the Windows Mixed Reality SDKWindows Mixed Reality SDK is added.

8. Back in Build Settings, Unity C# ProjectsUnity C# Projects  is no longer greyed out; tick the checkbox next to this.

9. Close the Build Settings window.

10. Save your Scene and Project (FILE > SAVE SCENE / FILE > SAVE PROJECTFILE > SAVE SCENE / FILE > SAVE PROJECT).



IMPORTANTIMPORTANT

 Chapter 5 – Import the Newtonsoft.Json library

IMPORTANTIMPORTANT

If you wish to skip the Unity Set up component of this course, and continue straight into code, feel free to download this

.unitypackage, and import it into your project as a Custom Package. Be aware that this package also includes the import

of the Newtonsoft DLL, covered in Chapter 5. With this imported, you can continue from Chapter 6.

1. In the Hierarchy Panel, select the Main CameraMain Camera.

2. Once selected, you will be able to see all the components of the Main CameraMain Camera in the Inspector Panel.

a. The Camera objectCamera object must be named Main CameraMain Camera (note the spelling!)

b. The Main Camera TagTag must be set to MainCameraMainCamera (note the spelling!)

c. Make sure the Transform PositionTransform Position is set to 0, 0 , 00, 0 , 0

d. Set Clear FlagsClear Flags  to Solid ColorSolid Color

e. Set the BackgroundBackground Color of the Camera Component to Black , Alpha 0 (Hex Code:Black , Alpha 0 (Hex Code:

#00000000)#00000000)

If you imported the '.unitypackage' in the last Chapter, you can skip this Chapter.

To help you deserialize and serialize objects received and sent to the Bot Service you need to download the

Newtonsoft.Json library. You will find a compatible version already organized with the correct Unity folder

structure in this Unity package file.

To import the library:

1. Download the Unity Package.

https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20304%20-%20Face%20recognition/Azure-MR-304.unitypackage
https://docs.unity3d.com/Manual/AssetPackages.html
https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20304%20-%20Face%20recognition/newtonsoftDLL.unitypackage
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2. Click on AssetsAssets , Impor t PackageImpor t Package, Custom PackageCustom Package.

3. Look for the Unity Package you have downloaded, and click Open.

4. Make sure all the components of the package are ticked and click Impor tImpor t.

The purpose of the FaceAnalysis class is to host the methods necessary to communicate with your Azure Face

Recognition Service.

After sending the service a capture image, it will analyse it and identify the faces within, and determine if any

belong to a known person.

If a known person is found, this class will display its name as UI text in the scene.

To create the FaceAnalysis class:

1. Right-click in the Assets Folder located in the Project Panel, then click on CreateCreate > FolderFolder . Call the folder

Scr iptsScr ipts .



    using Newtonsoft.Json;
    using System.Collections;
    using System.Collections.Generic;
    using System.IO;
    using System.Text;
    using UnityEngine;
    using UnityEngine.Networking;

2. Double click on the folder just created, to open it.

3. Right-click inside the folder, then click on CreateCreate > C# Scr iptC# Scr ipt. Call the script FaceAnalysis.

4. Double click on the new FaceAnalysis script to open it with Visual Studio 2017.

5. Enter the following namespaces above the FaceAnalysis class:

6. You now need to add all of the objects which are used for deserialising. These objects need to be added

outsideoutside of the FaceAnalysis script (beneath the bottom curly bracket).



    /// <summary>
    /// The Person Group object
    /// </summary>
    public class Group_RootObject
    {
        public string personGroupId { get; set; }
        public string name { get; set; }
        public object userData { get; set; }
    }

    /// <summary>
    /// The Person Face object
    /// </summary>
    public class Face_RootObject
    {
        public string faceId { get; set; }
    }

    /// <summary>
    /// Collection of faces that needs to be identified
    /// </summary>
    public class FacesToIdentify_RootObject
    {
        public string personGroupId { get; set; }
        public List<string> faceIds { get; set; }
        public int maxNumOfCandidatesReturned { get; set; }
        public double confidenceThreshold { get; set; }
    }

    /// <summary>
    /// Collection of Candidates for the face
    /// </summary>
    public class Candidate_RootObject
    {
        public string faceId { get; set; }
        public List<Candidate> candidates { get; set; }
    }

    public class Candidate
    {
        public string personId { get; set; }
        public double confidence { get; set; }
    }

    /// <summary>
    /// Name and Id of the identified Person
    /// </summary>
    public class IdentifiedPerson_RootObject
    {
        public string personId { get; set; }
        public string name { get; set; }
    }

7. The Start() and Update() methods will not be used, so delete them now.

8. Inside the FaceAnalysis class, add the following variables:



    /// <summary>
    /// Allows this class to behave like a singleton
    /// </summary>
    public static FaceAnalysis Instance;

    /// <summary>
    /// The analysis result text
    /// </summary>
    private TextMesh labelText;

    /// <summary>
    /// Bytes of the image captured with camera
    /// </summary>
    internal byte[] imageBytes;

    /// <summary>
    /// Path of the image captured with camera
    /// </summary>
    internal string imagePath;

    /// <summary>
    /// Base endpoint of Face Recognition Service
    /// </summary>
    const string baseEndpoint = "https://westus.api.cognitive.microsoft.com/face/v1.0/";

    /// <summary>
    /// Auth key of Face Recognition Service
    /// </summary>
    private const string key = "- Insert your key here -";

    /// <summary>
    /// Id (name) of the created person group 
    /// </summary>
    private const string personGroupId = "- Insert your group Id here -";

NOTENOTE

    /// <summary>
    /// Initialises this class
    /// </summary>
    private void Awake()
    {
        // Allows this instance to behave like a singleton
        Instance = this;

        // Add the ImageCapture Class to this Game Object
        gameObject.AddComponent<ImageCapture>();

        // Create the text label in the scene
        CreateLabel();
    }

Replace the keykey  and the personGroupIdpersonGroupId with your Service Key and the Id of the group that you created

previously.

9. Add the Awake() method, which initialises the class, adding the ImageCapture class to the Main Camera

and calls the Label creation method:

10. Add the CreateLabel() method, which creates the Label object to display the analysis result:



    /// <summary>
    /// Spawns cursor for the Main Camera
    /// </summary>
    private void CreateLabel()
    {
        // Create a sphere as new cursor
        GameObject newLabel = new GameObject();

        // Attach the label to the Main Camera
        newLabel.transform.parent = gameObject.transform;

        // Resize and position the new cursor
        newLabel.transform.localScale = new Vector3(0.4f, 0.4f, 0.4f);
        newLabel.transform.position = new Vector3(0f, 3f, 60f);

        // Creating the text of the Label
        labelText = newLabel.AddComponent<TextMesh>();
        labelText.anchor = TextAnchor.MiddleCenter;
        labelText.alignment = TextAlignment.Center;
        labelText.tabSize = 4;
        labelText.fontSize = 50;
        labelText.text = ".";       
    }

11. Add the DetectFacesFromImage() and GetImageAsByteArray() method. The former will request the Face

Recognition Service to detect any possible face in the submitted image, while the latter is necessary to

convert the captured image into a bytes array:



    /// <summary>
    /// Detect faces from a submitted image
    /// </summary>
    internal IEnumerator DetectFacesFromImage()
    {
        WWWForm webForm = new WWWForm();
        string detectFacesEndpoint = $"{baseEndpoint}detect";

        // Change the image into a bytes array
        imageBytes = GetImageAsByteArray(imagePath);

        using (UnityWebRequest www = 
            UnityWebRequest.Post(detectFacesEndpoint, webForm))
        {
            www.SetRequestHeader("Ocp-Apim-Subscription-Key", key);
            www.SetRequestHeader("Content-Type", "application/octet-stream");
            www.uploadHandler.contentType = "application/octet-stream";
            www.uploadHandler = new UploadHandlerRaw(imageBytes);
            www.downloadHandler = new DownloadHandlerBuffer();

            yield return www.SendWebRequest();
            string jsonResponse = www.downloadHandler.text;
            Face_RootObject[] face_RootObject = 
                JsonConvert.DeserializeObject<Face_RootObject[]>(jsonResponse);

            List<string> facesIdList = new List<string>();
            // Create a list with the face Ids of faces detected in image
            foreach (Face_RootObject faceRO in face_RootObject)
            {
                facesIdList.Add(faceRO.faceId);
                Debug.Log($"Detected face - Id: {faceRO.faceId}");
            }

            StartCoroutine(IdentifyFaces(facesIdList));
        }
    }

    /// <summary>
    /// Returns the contents of the specified file as a byte array.
    /// </summary>
    static byte[] GetImageAsByteArray(string imageFilePath)
    {
        FileStream fileStream = new FileStream(imageFilePath, FileMode.Open, FileAccess.Read);
        BinaryReader binaryReader = new BinaryReader(fileStream);
        return binaryReader.ReadBytes((int)fileStream.Length);
    }

12. Add the IdentifyFaces() method, which requests the Face Recognition Service to identify any known face

previously detected in the submitted image. The request will return an id of the identified person but not

the name:



    /// <summary>
    /// Identify the faces found in the image within the person group
    /// </summary>
    internal IEnumerator IdentifyFaces(List<string> listOfFacesIdToIdentify)
    {
        // Create the object hosting the faces to identify
        FacesToIdentify_RootObject facesToIdentify = new FacesToIdentify_RootObject();
        facesToIdentify.faceIds = new List<string>();
        facesToIdentify.personGroupId = personGroupId;
        foreach (string facesId in listOfFacesIdToIdentify)
        {
            facesToIdentify.faceIds.Add(facesId);
        }
        facesToIdentify.maxNumOfCandidatesReturned = 1;
        facesToIdentify.confidenceThreshold = 0.5;

        // Serialize to Json format
        string facesToIdentifyJson = JsonConvert.SerializeObject(facesToIdentify);
        // Change the object into a bytes array
        byte[] facesData = Encoding.UTF8.GetBytes(facesToIdentifyJson);

        WWWForm webForm = new WWWForm();
        string detectFacesEndpoint = $"{baseEndpoint}identify";

        using (UnityWebRequest www = UnityWebRequest.Post(detectFacesEndpoint, webForm))
        {
            www.SetRequestHeader("Ocp-Apim-Subscription-Key", key);
            www.SetRequestHeader("Content-Type", "application/json");
            www.uploadHandler.contentType = "application/json";
            www.uploadHandler = new UploadHandlerRaw(facesData);
            www.downloadHandler = new DownloadHandlerBuffer();

            yield return www.SendWebRequest();
            string jsonResponse = www.downloadHandler.text;
            Debug.Log($"Get Person - jsonResponse: {jsonResponse}");
            Candidate_RootObject [] candidate_RootObject = 
JsonConvert.DeserializeObject<Candidate_RootObject[]>(jsonResponse);

            // For each face to identify that ahs been submitted, display its candidate
            foreach (Candidate_RootObject candidateRO in candidate_RootObject)
            {
                StartCoroutine(GetPerson(candidateRO.candidates[0].personId));

                // Delay the next "GetPerson" call, so all faces candidate are displayed properly
                yield return new WaitForSeconds(3);
            }           
        }
    }

13. Add the GetPerson() method. By providing the person id, this method then requests for the Face

Recognition Service to return the name of the identified person:
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    /// <summary>
    /// Provided a personId, retrieve the person name associated with it
    /// </summary>
    internal IEnumerator GetPerson(string personId)
    {
        string getGroupEndpoint = $"{baseEndpoint}persongroups/{personGroupId}/persons/{personId}?";
        WWWForm webForm = new WWWForm();

        using (UnityWebRequest www = UnityWebRequest.Get(getGroupEndpoint))
        {
            www.SetRequestHeader("Ocp-Apim-Subscription-Key", key);
            www.downloadHandler = new DownloadHandlerBuffer();
            yield return www.SendWebRequest();
            string jsonResponse = www.downloadHandler.text;

            Debug.Log($"Get Person - jsonResponse: {jsonResponse}");
            IdentifiedPerson_RootObject identifiedPerson_RootObject = 
JsonConvert.DeserializeObject<IdentifiedPerson_RootObject>(jsonResponse);

            // Display the name of the person in the UI
            labelText.text = identifiedPerson_RootObject.name;
        }
    }

14. Remember to SaveSave the changes before going back to the Unity Editor.

15. In the Unity Editor, drag the FaceAnalysis script from the Scripts folder in Project panel to the Main

Camera object in the Hierarchy panel. The new script component will be so added to the Main Camera.

The purpose of the ImageCapture class is to host the methods necessary to communicate with your Azure Face

Recognition Service to analyse the image you will capture, identifying faces in it and determining if it belongs to

a known person. If a known person is found, this class will display its name as UI text in the scene.



To create the ImageCapture class:

    using System.IO;
    using System.Linq;
    using UnityEngine;
    using UnityEngine.XR.WSA.Input;
    using UnityEngine.XR.WSA.WebCam;

    /// <summary>
    /// Allows this class to behave like a singleton
    /// </summary>
    public static ImageCapture instance;

    /// <summary>
    /// Keeps track of tapCounts to name the captured images 
    /// </summary>
    private int tapsCount;

    /// <summary>
    /// PhotoCapture object used to capture images on HoloLens 
    /// </summary>
    private PhotoCapture photoCaptureObject = null;

    /// <summary>
    /// HoloLens class to capture user gestures
    /// </summary>
    private GestureRecognizer recognizer;

    /// <summary>
    /// Initialises this class
    /// </summary>
    private void Awake()
    {
        instance = this;
    }

    /// <summary>
    /// Called right after Awake
    /// </summary>
    void Start()
    {
        // Initialises user gestures capture 
        recognizer = new GestureRecognizer();
        recognizer.SetRecognizableGestures(GestureSettings.Tap);
        recognizer.Tapped += TapHandler;
        recognizer.StartCapturingGestures();
    }

1. Right-click inside the Scr iptsScr ipts  folder you have created previously, then click on CreateCreate, C# Scr iptC# Scr ipt. Call

the script ImageCapture.

2. Double click on the new ImageCapture script to open it with Visual Studio 2017.

3. Enter the following namespaces above the ImageCapture class:

4. Inside the ImageCapture class, add the following variables:

5. Add the Awake() and Start() methods necessary to initialise the class and allow the HoloLens to capture

the user's gestures:

6. Add the TapHandler() which is called when the user performs a Tap gesture:



    /// <summary>
    /// Respond to Tap Input.
    /// </summary>
    private void TapHandler(TappedEventArgs obj)
    {
        tapsCount++;
        ExecuteImageCaptureAndAnalysis();
    }

    /// <summary>
    /// Begin process of Image Capturing and send To Azure Computer Vision service.
    /// </summary>
    private void ExecuteImageCaptureAndAnalysis()
    {
        Resolution cameraResolution = PhotoCapture.SupportedResolutions.OrderByDescending
            ((res) => res.width * res.height).First();
        Texture2D targetTexture = new Texture2D(cameraResolution.width, cameraResolution.height);

        PhotoCapture.CreateAsync(false, delegate (PhotoCapture captureObject)
        {
            photoCaptureObject = captureObject;

            CameraParameters c = new CameraParameters();
            c.hologramOpacity = 0.0f;
            c.cameraResolutionWidth = targetTexture.width;
            c.cameraResolutionHeight = targetTexture.height;
            c.pixelFormat = CapturePixelFormat.BGRA32;

            captureObject.StartPhotoModeAsync(c, delegate (PhotoCapture.PhotoCaptureResult result)
            {
                string filename = string.Format(@"CapturedImage{0}.jpg", tapsCount);
                string filePath = Path.Combine(Application.persistentDataPath, filename);

                // Set the image path on the FaceAnalysis class
                FaceAnalysis.Instance.imagePath = filePath;

                photoCaptureObject.TakePhotoAsync
                (filePath, PhotoCaptureFileOutputFormat.JPG, OnCapturedPhotoToDisk);
            });
        });
    }

7. Add the ExecuteImageCaptureAndAnalysis() method, which will begin the process of Image Capturing:

8. Add the handlers that are called when the photo capture process has been completed:
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    /// <summary>
    /// Called right after the photo capture process has concluded
    /// </summary>
    void OnCapturedPhotoToDisk(PhotoCapture.PhotoCaptureResult result)
    {
        photoCaptureObject.StopPhotoModeAsync(OnStoppedPhotoMode);
    }

    /// <summary>
    /// Register the full execution of the Photo Capture. If successful, it will begin the Image 
Analysis process.
    /// </summary>
    void OnStoppedPhotoMode(PhotoCapture.PhotoCaptureResult result)
    {
        photoCaptureObject.Dispose();
        photoCaptureObject = null;

        // Request image caputer analysis
        StartCoroutine(FaceAnalysis.Instance.DetectFacesFromImage());
    }

9. Remember to SaveSave the changes before going back to the Unity Editor.

To perform a thorough test of your application you will need to sideload it onto your HoloLens.

Before you do, ensure that:

All the settings mentioned in the Chapter 3 are set correctly.

The script FaceAnalysis is attached to the Main Camera object.

Both the Auth KeyAuth Key  and Group IdGroup Id have been set within the FaceAnalysis script.

A this point you are ready to build the Solution. Once the Solution has been built, you will be ready to deploy

your application.

To begin the Build process:

1. Save the current scene by clicking on File, Save.

2. Go to File, Build Settings, click on Add Open Scenes.

3. Make sure to tick Unity C# Projects.
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4. Press Build. Upon doing so, Unity will launch a File Explorer window, where you need to create and then

select a folder to build the app into. Create that folder now, within the Unity project, and call it App. Then

with the App folder selected, press Select Folder.

5. Unity will begin building your project, out to the App folder.

6. Once Unity has finished building (it might take some time), it will open a File Explorer window at the

location of your build.

7. Open your App folder, and then open the new Project Solution (as seen above, MR_FaceRecognition.sln).

To deploy on HoloLens:

1. You will need the IP Address of your HoloLens (for Remote Deploy), and to ensure your HoloLens is in

Developer ModeDeveloper Mode. To do this:

a. Whilst wearing your HoloLens, open the SettingsSettings .

b. Go to Network & Internet > Wi-Fi > Advanced OptionsNetwork & Internet > Wi-Fi > Advanced Options

c. Note the IPv4IPv4  address.

d. Next, navigate back to SettingsSettings , and then to Update & Security > For DevelopersUpdate & Security > For Developers

e. Set Developer Mode On.

2. Navigate to your new Unity build (the App folder) and open the solution file with Visual Studio.

3. In the Solution Configuration select DebugDebug.

4. In the Solution Platform, select x86x86 , Remote MachineRemote Machine.
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 Your finished Azure Face API Application

 Bonus exercises
  Exercise 1Exercise 1

  

5. Go to the Build menuBuild menu and click on Deploy SolutionDeploy Solution, to sideload the application to your HoloLens.

6. Your App should now appear in the list of installed apps on your HoloLens, ready to be launched!

To deploy to immersive headset, set the Solution PlatformSolution Platform to Local Machine, and set the ConfigurationConfiguration to Debug,

with x86 as the PlatformPlatform. Then deploy to the local machine, using the Build menuBuild menu, selecting Deploy Solution.

1. Wearing the HoloLens, launch the app.

2. Look at the person that you have registered with the Face API. Make sure that:

The person's face is not too distant and clearly visible

The environment lighting is not too dark

3. Use the tap gesture to capture the person's picture.

4. Wait for the App to send the analysis request and receive a response.

5. If the person has been successfully recognized, the person's name will appear as UI text.

6. You can repeat the capture process using the tap gesture every few seconds.

Congratulations, you built a mixed reality app that leverages the Azure Face Recognition service to detect faces

within an image, and identify any known faces.

The Azure Face APIAzure Face API is powerful enough to detect up to 64 faces in a single image. Extend the application, so

that it could recognize two or three faces, amongst many other people.



Exercise 2Exercise 2
The Azure Face APIAzure Face API is also able to provide back all kinds of attribute information. Integrate this into the

application. This could be even more interesting, when combined with the Emotion API.

https://azure.microsoft.com/services/cognitive-services/emotion/
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NOTENOTE
The Mixed Reality Academy tutorials were designed with HoloLens (1st gen) and Mixed Reality Immersive Headsets in

mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for guidance in

developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being used for

HoloLens 2. They will be maintained to continue working on the supported devices. There will be a new series of tutorials

that will be posted in the future that will demonstrate how to develop for HoloLens 2. This notice will be updated with a

link to those tutorials when they are posted.

In this course, you will learn how to create and use Azure Functions and store data with an Azure Storage

resource, within a mixed reality application.

Azure Functions is a Microsoft service, which allows developers to run small pieces of code, 'functions', in Azure.

This provides a way to delegate work to the cloud, rather than your local application, which can have many

benefits. Azure Functions supports several development languages, including C#, F#, Node.js, Java, and PHP. For

more information, visit the Azure Functions article.

Azure Storage is a Microsoft cloud service, which allows developers to store data, with the insurance that it will

be highly available, secure, durable, scalable, and redundant. This means Microsoft will handle all maintenance,

and critical problems for you. For more information, visit the Azure Storage article.

Having completed this course, you will have a mixed reality immersive headset application which will be able to

do the following:

1. Allow the user to gaze around a scene.

2. Trigger the spawning of objects when the user gazes at a 3D 'button'.

3. The spawned objects will be chosen by an Azure Function.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/mr-azure-305.md
https://docs.microsoft.com/en-us/azure/azure-functions/functions-overview
https://docs.microsoft.com/en-us/azure/storage/common/storage-introduction
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 Chapter 1 - The Azure Portal

4. As each object is spawned, the application will store the object type in an Azure File, located in Azure Storage.

5. Upon loading a second time, the Azure File data will be retrieved, and used to replay the spawning actions

from the previous instance of the application.

In your application, it is up to you as to how you will integrate the results with your design. This course is

designed to teach you how to integrate an Azure Service with your Unity Project. It is your job to use the

knowledge you gain from this course to enhance your mixed reality Application.

While this course primarily focuses on Windows Mixed Reality immersive (VR) headsets, you can also apply what you learn

in this course to Microsoft HoloLens. As you follow along with the course, you will see notes on any changes you might

need to employ to support HoloLens.

This tutorial is designed for developers who have basic experience with Unity and C#. Please also be aware that the

prerequisites and written instructions within this document represent what has been tested and verified at the time of

writing (May 2018). You are free to use the latest software, as listed within the install the tools article, though it should

not be assumed that the information in this course will perfectly match what you'll find in newer software than what's

listed below.

We recommend the following hardware and software for this course:

A development PC, compatible with Windows Mixed Reality for immersive (VR) headset development

Windows 10 Fall Creators Update (or later) with Developer mode enabled

The latest Windows 10 SDK

Unity 2017.4

Visual Studio 2017

A Windows Mixed Reality immersive (VR) headset or Microsoft HoloLens with Developer mode enabled

A subscription to an Azure account for creating Azure resources

Internet access for Azure setup and data retrieval

To avoid encountering issues building this project, it is strongly suggested that you create the project mentioned

in this tutorial in a root or near-root folder (long folder paths can cause issues at build-time).

To use the Azure Storage Ser viceAzure Storage Ser vice, you will need to create and configure a Storage AccountStorage Account in the Azure

portal.

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://support.microsoft.com/help/4039260/windows-10-mixed-reality-pc-hardware-guidelines
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
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1. Log in to the Azure Portal.

If you do not already have an Azure account, you will need to create one. If you are following this tutorial in a

classroom or lab situation, ask your instructor or one of the proctors for help setting up your new account.

2. Once you are logged in, click on NewNew  in the top left corner, and search for Storage account, and click

EnterEnter .

The word NewNew may have been replaced with Create a resourceCreate a resource, in newer portals.

3. The new page will provide a description of the Azure Storage account service. At the bottom left of this

prompt, select the CreateCreate button, to create an association with this service.

https://portal.azure.com


4. Once you have clicked on CreateCreate:

a. Insert a Name for your account, be aware this field only accepts numbers, and lowercase letters.

b. For Deployment model, select Resource managerResource manager .

c. For Account kind, select Storage (general purpose v1)Storage (general purpose v1) .

d. Determine the Location for your resource group (if you are creating a new Resource Group). The

location would ideally be in the region where the application would run. Some Azure assets are

only available in certain regions.

e. For Replication select Read-access-geo-redundant storage (RA-GRS)Read-access-geo-redundant storage (RA-GRS) .

f. For Performance, select StandardStandard.

g. Leave Secure transfer required as DisabledDisabled.

h. Select a Subscription.

i. Choose a Resource Group or create a new one. A resource group provides a way to monitor,

control access, provision and manage billing for a collection of Azure assets. It is recommended to

keep all the Azure services associated with a single project (e.g. such as these labs) under a

common resource group).

If you wish to read more about Azure Resource Groups, please visit the resource group article.

j. You will also need to confirm that you have understood the Terms and Conditions applied to this

Service.

k. Select CreateCreate.

https://docs.microsoft.com/en-us/azure/azure-resource-manager/resource-group-portal


5. Once you have clicked on CreateCreate, you will have to wait for the service to be created, this might take a

minute.

6. A notification will appear in the portal once the Service instance is created.

7. Click on the notifications to explore your new Service instance.

8. Click the Go to resourceGo to resource button in the notification to explore your new Service instance. You will be

taken to your new Storage account service instance.
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9. Click Access keys, to reveal the endpoints for this cloud service. Use Notepad or similar, to copy one of

your keys for use later. Also, note the Connection string value, as it will be used in the AzureServices class,

which you will create later.

You will now write an AzureAzure FunctionFunction in the Azure Service.

You can use an Azure FunctionAzure Function to do nearly anything that you would do with a classic function in your code,

the difference being that this function can be accessed by any application that has credentials to access your

Azure Account.

To create an Azure Function:

1. From your Azure Portal, click on NewNew  in the top left corner, and search for Function App, and click EnterEnter .



NOTENOTE
The word NewNew may have been replaced with Create a resourceCreate a resource, in newer portals.

2. The new page will provide a description of the Azure Function App service. At the bottom left of this

prompt, select the CreateCreate button, to create an association with this service.

3. Once you have clicked on CreateCreate:

a. Provide an App name. Only letters and numbers can be used here (either upper or lower case is

allowed).

b. Select your preferred Subscription.

c. Choose a Resource Group or create a new one. A resource group provides a way to monitor,

control access, provision and manage billing for a collection of Azure assets. It is recommended to

keep all the Azure services associated with a single project (e.g. such as these labs) under a

common resource group).

If you wish to read more about Azure Resource Groups, please visit the resource group article.

d. For this exercise, select Windows as the chosen OSOS .

e. Select Consumption Plan for the Hosting PlanHosting Plan.

https://docs.microsoft.com/en-us/azure/azure-resource-manager/resource-group-portal


f. Determine the Location for your resource group (if you are creating a new Resource Group). The

location would ideally be in the region where the application would run. Some Azure assets are

only available in certain regions. For optimal performance, select the same region as the storage

account.

g. For Storage, select Use existingUse existing, and then using the dropdown menu, find your previously

created storage.

h. Leave Application Insights off for this exercise.

4. Click the CreateCreate button.

5. Once you have clicked on CreateCreate, you will have to wait for the service to be created, this might take a

minute.

6. A notification will appear in the portal once the Service instance is created.

7. Click on the notifications to explore your new Service instance.

8. Click the Go to resourceGo to resource button in the notification to explore your new Service instance. You will be

taken to your new Function App service instance.



9. On the Function App dashboard, hover your mouse over Functions, found within the panel on the left,

and then click the + (plus)+ (plus)  symbol.

10. On the next page, ensure Webhook + APIWebhook + API is selected, and for Choose a language, select CSharpCSharp, as this

will be the language used for this tutorial. Lastly, click the Create this functionCreate this function button.

11. You should be taken to the code page (run.csx), if not though, click on the newly created Function in the

Functions list within the panel on the left.

12. Copy the following code into your function. This function will simply return a random integer between 0

and 2 when called. Do not worry about the existing code, feel free to paste over the top of it.
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    using System.Net;
    using System.Threading.Tasks;

    public static int Run(CustomObject req, TraceWriter log)
    {
        Random rnd = new Random();
        int randomInt = rnd.Next(0, 3);
        return randomInt;
    }

    public class CustomObject
    {
        public String name {get; set;}
    }

13. Select SaveSave.

14. The result should look like the image below.

15. Click on Get function URLGet function URL  and take note of the endpoint displayed. You will need to insert it into the

AzureServices class that you will create later in this course.

The following is a typical set up for developing with Mixed Reality, and as such, is a good template for other

projects.

Set up and test your mixed reality immersive headset.

You will notnot  require Motion Controllers for this course. If you need support setting up the immersive headset, please visit

the mixed reality set up article.

1. Open Unity and click NewNew .

https://support.microsoft.com/help/4043101/windows-10-set-up-windows-mixed-reality


2. You will now need to provide a Unity Project name. Insert MR_Azure_FunctionsMR_Azure_Functions . Make sure the project

type is set to 3D3D. Set the Location to somewhere appropriate for you (remember, closer to root

directories is better). Then, click Create projectCreate project.

3. With Unity open, it is worth checking the default Scr ipt EditorScr ipt Editor  is set to Visual StudioVisual Studio. Go to EditEdit >

PreferencesPreferences  and then from the new window, navigate to External ToolsExternal Tools . Change External Scr iptExternal Scr ipt

EditorEditor  to Visual Studio 2017Visual Studio 2017 . Close the PreferencesPreferences  window.

4. Next, go to FileFile > Build SettingsBuild Settings  and switch the platform to Universal Windows PlatformUniversal Windows Platform , by

clicking on the Switch PlatformSwitch Platform button.



5. Go to FileFile > Build SettingsBuild Settings  and make sure that:

a. Target DeviceTarget Device is set to Any DeviceAny Device.

For Microsoft HoloLens, set Target DeviceTarget Device to HoloLens.

b. Build TypeBuild Type is set to D3DD3D

c. SDKSDK is set to Latest installedLatest installed

d. Visual Studio VersionVisual Studio Version is set to Latest installedLatest installed

e. Build and RunBuild and Run is set to Local MachineLocal Machine

f. Save the scene and add it to the build.

a. Do this by selecting Add Open ScenesAdd Open Scenes . A save window will appear.



b. Create a new folder for this, and any future, scene, then select the New folderNew folder  button, to

create a new folder, name it ScenesScenes .

c. Open your newly created ScenesScenes  folder, and then in the File name:File name: text field, type

FunctionsSceneFunctionsScene, then press SaveSave.

6. The remaining settings, in Build SettingsBuild Settings , should be left as default for now.



7. In the Build Settings window, click on the Player SettingsPlayer Settings  button, this will open the related panel in the

space where the Inspector is located.

8. In this panel, a few settings need to be verified:

a. In the Other SettingsOther Settings  tab:

a. Scr ipting Runtime VersionScr ipting Runtime Version should be ExperimentalExperimental  (.NET 4.6 Equivalent), which will trigger

a need to restart the Editor.

b. Scr ipting BackendScripting Backend should be .NET.NET
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IMPORTANTIMPORTANT

c. API Compatibility LevelAPI Compatibility Level  should be .NET 4.6.NET 4.6

b. Within the Publishing SettingsPublishing Settings  tab, under CapabilitiesCapabilities , check:

InternetClientInternetClient

c. Further down the panel, in XR SettingsXR Settings  (found below Publishing SettingsPublishing Settings ), tick Vir tual RealityVir tual Reality

Suppor tedSuppor ted, make sure the Windows Mixed Reality SDKWindows Mixed Reality SDK is added.

9. Back in Build Settings Unity C# Projects is no longer greyed out; tick the checkbox next to this.

10. Close the Build Settings window.

11. Save your Scene and Project (FILEFILE > SAVE SCENE / FILESAVE SCENE / FILE > SAVE PROJECTSAVE PROJECT).

If you wish to skip the Unity Set up components of this course, and continue straight into code, feel free to download this

.unitypackage, and import it into your project as a Custom Package. This will also contain the DLLs from the next Chapter.

After import, continue from Chapter 7.

1. In the Hierarchy Panel, you will find an object called Main CameraMain Camera, this object represents your "head"

point of view once you are "inside" your application.

https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20305%20-%20Functions%20and%20storage/Azure-MR-305.unitypackage
https://docs.unity3d.com/Manual/AssetPackages.html
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2. With the Unity Dashboard in front of you, select the Main Camera GameObjectMain Camera GameObject. You will notice that the

Inspector Panel (generally found to the right, within the Dashboard) will show the various components of

that GameObject, with Transform at the top, followed by Camera, and some other components. You will

need to reset the Transform of the Main Camera, so it is positioned correctly.

3. To do this, select the GearGear  icon next to the Camera's Transform component, and select ResetReset.

4. Then update the TransformTransform component to look like:

Transform - PositionTransform - Position

Transform - RotationTransform - Rotation

Transform - ScaleTransform - Scale

1. Right-click in an empty area of the Hierarchy Panel, under 3D 3D ObjectObject, add a PlanePlane.
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2. With the PlanePlane object selected, change the following parameters in the Inspector Panel:

Transform - PositionTransform - Position

Transform - ScaleTransform - Scale



3. Right-click in an empty area of the Hierarchy Panel, under 3D Object3D Object, add a CubeCube.

XX YY ZZ

0 3 5

a. Rename the Cube to GazeButtonGazeButton (with the Cube selected, press 'F2').

b. Change the following parameters for Transform PositionTransform Position in the Inspector Panel:

c. Click on the TagTag drop-down button and click on Add TagAdd Tag to open the Tags & Layers Pane.



d. Select the + (plus)+ (plus)  button, and in the New Tag Name field, enter GazeButtonGazeButton, and press SaveSave.

e. Click on the GazeButtonGazeButton object in the Hierarchy Panel, and in the Inspector Panel, assign the

newly created GazeButtonGazeButton tag.

4. Right-click on the GazeButtonGazeButton object, in the Hierarchy Panel, and add an Empty GameObjectEmpty GameObject (which

will be added as a child object).

5. Select the new object and rename it ShapeSpawnPointShapeSpawnPoint.

XX YY ZZ

0 -1 0

a. Change the following parameters for Transform PositionTransform Position in the Inspector Panel:



XX YY ZZ

0 0 -0.6

NOTENOTE

6. Next you will create a 3D Text3D Text object to provide feedback on the status of the Azure service.

Right click on the GazeButtonGazeButton in the Hierarchy Panel again and add a 3D Object3D Object > 3D Text3D Text object as a

child.

7. Rename the 3D Text3D Text object to AzureStatusTextAzureStatusText.

8. Change the AzureStatusTextAzureStatusText object Transform PositionTransform Position as follows:

9. Change the AzureStatusTextAzureStatusText object Transform ScaleTransform Scale as follows: | XX | YY  | ZZ | | :---: | :---: | :---: | | 0.1 | 0.1 |

0.1 |

Do not worry if it appears to be off-centre, as this will be fixed when the below Text Mesh component is updated.

10. Change the Text MeshText Mesh component to match the below:
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TIPTIP
The selected color here is Hex color: 000000FF000000FF , though feel free to choose your own, just ensure it is readable.

11. Your Hierarchy Panel structure should now look like this:

12. Your scene should now look like this:

You will be using Azure Storage for Unity (which itself leverages the .Net SDK for Azure). You can read more

about this at the Azure Storage for Unity article.

There is currently a known issue in Unity which requires plugins to be reconfigured after import. These steps (4

- 7 in this section) will no longer be required after the bug has been resolved.

To import the SDK into your own project, make sure you have downloaded the latest '.unitypackage' from

GitHub. Then, do the following:

https://docs.microsoft.com/en-us/sandbox/gamedev/unity/azure-storage-unity
https://aka.ms/azstorage-unitysdk


1. Add the .unitypackage.unitypackage file to Unity by using the AssetsAssets  > Impor t PackageImpor t Package > Custom PackageCustom Package menu

option.

2. In the Impor t Unity PackageImpor t Unity Package box that pops up, you can select everything under PluginPlugin > StorageStorage.

Uncheck everything else, as it is not needed for this course.

3. Click the Impor tImpor t button to add the items to your project.

4. Go to the Storage folder under Plugins, in the Project view, and select the following plugins only:

Microsoft.Data.Edm

Microsoft.Data.OData

Microsoft.WindowsAzure.Storage

Newtonsoft.Json

System.Spatial

5. With these specific plugins selected, uncheckuncheck Any Platform and uncheckuncheck WSAPlayer then click ApplyApply .
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NOTENOTE

NOTENOTE

We are marking these particular plugins to only be used in the Unity Editor. This is because there are different

versions of the same plugins in the WSA folder that will be used after the project is exported from Unity.

6. In the Storage plugin folder, select only:

Microsoft.Data.Services.Client

7. Check the Don't ProcessDon't Process  box under Platform Settings and click ApplyApply .

We are marking this plugin "Don't process" because the Unity assembly patcher has difficulty processing this

plugin. The plugin will still work even though it is not processed.

The first class you are going to create is the AzureServices class.

The AzureServices class will be responsible for :



Storing Azure Account credentials.

Calling your Azure App Function.

The upload and download of the data file in your Azure Cloud Storage.

To create this Class:

    using System;
    using System.Threading.Tasks;
    using UnityEngine;
    using Microsoft.WindowsAzure.Storage;
    using Microsoft.WindowsAzure.Storage.File;
    using System.IO;
    using System.Net;

1. Right-click in the Asset Folder, located in the Project Panel, CreateCreate > FolderFolder . Name the folder Scr iptsScr ipts .

2. Double click on the folder just created, to open it.

3. Right-click inside the folder, CreateCreate > C# Scr iptC# Scr ipt. Call the script AzureServices.

4. Double click on the new AzureServices class to open it with Visual Studio.

5. Add the following namespaces to the top of the AzureServices:

6. Add the following Inspector Fields inside the AzureServices class:



    /// <summary>
    /// Provides Singleton-like behavior to this class.
    /// </summary>
    public static AzureServices instance;

    /// <summary>
    /// Reference Target for AzureStatusText Text Mesh object
    /// </summary>
    public TextMesh azureStatusText;

    /// <summary>
    /// Holds the Azure Function endpoint - Insert your Azure Function
    /// Connection String here.
    /// </summary>

    private readonly string azureFunctionEndpoint = "--Insert here you AzureFunction Endpoint--";

    /// <summary>
    /// Holds the Storage Connection String - Insert your Azure Storage
    /// Connection String here.
    /// </summary>
    private readonly string storageConnectionString = "--Insert here you AzureStorage Connection 
String--";

    /// <summary>
    /// Name of the Cloud Share - Hosts directories.
    /// </summary>
    private const string fileShare = "fileshare";

    /// <summary>
    /// Name of a Directory within the Share
    /// </summary>
    private const string storageDirectory = "storagedirectory";

    /// <summary>
    /// The Cloud File
    /// </summary>
    private CloudFile shapeIndexCloudFile;

    /// <summary>
    /// The Linked Storage Account
    /// </summary>
    private CloudStorageAccount storageAccount;

    /// <summary>
    /// The Cloud Client
    /// </summary>
    private CloudFileClient fileClient;

    /// <summary>
    /// The Cloud Share - Hosts Directories
    /// </summary>
    private CloudFileShare share;

    /// <summary>
    /// The Directory in the share that will host the Cloud file
    /// </summary>
    private CloudFileDirectory dir;

7. Then add the following member variables inside the AzureServices class:
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IMPORTANTIMPORTANT

    private void Awake()
    {
        instance = this;
    }

    // Use this for initialization
    private void Start()
    {
        // Set the Status text to loading, whilst attempting connection to Azure.
        azureStatusText.text = "Loading...";
    }

    /// <summary>
    /// Call to the Azure Function App to request a Shape.
    /// </summary>
    public async void CallAzureFunctionForNextShape()
    {

    }

IMPORTANTIMPORTANT

Make sure you replace the endpoint and connection string values with the values from your Azure storage, found

in the Azure Portal

8. Code for Awake() and Start() methods now needs to be added. These methods will be called when the

class initializes:

We will fill in the code for CallAzureFunctionForNextShape() in a future Chapter.

9. Delete the Update() method since this class will not use it.

10. Save your changes in Visual Studio, and then return to Unity.

11. Click and drag the AzureServices class from the Scripts folder to the Main Camera object in the Hierarchy

Panel.

12. Select the Main Camera, then grab the AzureStatusTextAzureStatusText child object from beneath the GazeButtonGazeButton

object, and place it within the AzureStatusTextAzureStatusText reference target field, in the Inspector, to provide the

reference to the AzureServices script.

The next script to create, is the ShapeFactory class. The role of this class is to create a new shape, when

requested, and keep a history of the shapes created in a Shape History List. Every time a shape is created, the

Shape History list is updated in the AzureService class, and then stored in your Azure Storage. When the

application starts, if a stored file is found in your Azure Storage, the Shape History list is retrieved and replayed,

with the 3D Text3D Text object providing whether the generated shape is from storage, or new.

To create this class:

1. Go to the Scr iptsScr ipts  folder you created previously.



    using System.Collections.Generic;
    using UnityEngine;

    /// <summary>
    /// Provide this class Singleton-like behaviour
    /// </summary>
    [HideInInspector]
    public static ShapeFactory instance;

    /// <summary>
    /// Provides an Inspector exposed reference to ShapeSpawnPoint
    /// </summary>
    [SerializeField]
    public Transform spawnPoint;

    /// <summary>
    /// Shape History Index
    /// </summary>
    [HideInInspector]
    public List<int> shapeHistoryList;

    /// <summary>
    /// Shapes Enum for selecting required shape
    /// </summary>
    private enum Shapes { Cube, Sphere, Cylinder }

    private void Awake()
    {
        instance = this;
    }

    private void Start()
    {
        shapeHistoryList = new List<int>();
    }

2. Right-click inside the folder, CreateCreate > C# Scr iptC# Scr ipt. Call the script ShapeFactory.

3. Double click on the new ShapeFactory script to open it with Visual Studio.

4. Ensure the ShapeFactory class includes the following namespaces:

5. Add the variables shown below to the ShapeFactory class, and replace the Start() and Awake() functions

with those below:

6. The CreateShape() method generates the primitive shapes, based upon the provided integer parameter.

The Boolean parameter is used to specify whether the currently created shape is from storage, or new.

Place the following code in your ShapeFactory class, below the previous methods:
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    /// <summary>
    /// Use the Shape Enum to spawn a new Primitive object in the scene
    /// </summary>
    /// <param name="shape">Enumerator Number for Shape</param>
    /// <param name="storageShape">Provides whether this is new or old</param>
    internal void CreateShape(int shape, bool storageSpace)
    {
        Shapes primitive = (Shapes)shape;
        GameObject newObject = null;
        string shapeText = storageSpace == true ? "Storage: " : "New: ";

        AzureServices.instance.azureStatusText.text = string.Format("{0}{1}", shapeText, 
primitive.ToString());

        switch (primitive)
        {
            case Shapes.Cube:
            newObject = GameObject.CreatePrimitive(PrimitiveType.Cube);
            break;

            case Shapes.Sphere:
            newObject = GameObject.CreatePrimitive(PrimitiveType.Sphere);
            break;

            case Shapes.Cylinder:
            newObject = GameObject.CreatePrimitive(PrimitiveType.Cylinder);
            break;
        }

        if (newObject != null)
        {
            newObject.transform.position = spawnPoint.position;

            newObject.transform.localScale = new Vector3(0.5f, 0.5f, 0.5f);

            newObject.AddComponent<Rigidbody>().useGravity = true;

            newObject.GetComponent<Renderer>().material.color = UnityEngine.Random.ColorHSV(0f, 1f, 
1f, 1f, 0.5f, 1f);
        }
    }

7. Be sure to save your changes in Visual Studio before returning to Unity.

8. Back in the Unity Editor, click and drag the ShapeFactory class from the Scr iptsScr ipts  folder to the MainMain

CameraCamera object in the Hierarchy Panel.

9. With the Main Camera selected you will notice the ShapeFactory script component is missing the Spawn

Point reference. To fix it, drag the ShapeSpawnPointShapeSpawnPoint object from the Hierarchy Panel to the SpawnSpawn

PointPoint reference target.

The last script you need to create is the Gaze class.

This class is responsible for creating a RaycastRaycast that will be projected forward from the Main Camera, to detect

which object the user is looking at. In this case, the Raycast will need to identify if the user is looking at the

GazeButtonGazeButton object in the scene and trigger a behavior.



To create this Class:

    using UnityEngine;

    /// <summary>
    /// Provides Singleton-like behavior to this class.
    /// </summary>
    public static Gaze instance;

    /// <summary>
    /// The Tag which the Gaze will use to interact with objects. Can also be set in editor.
    /// </summary>
    public string InteractibleTag = "GazeButton";

    /// <summary>
    /// The layer which will be detected by the Gaze ('~0' equals everything).
    /// </summary>
    public LayerMask LayerMask = ~0;

    /// <summary>
    /// The Max Distance the gaze should travel, if it has not hit anything.
    /// </summary>
    public float GazeMaxDistance = 300;

    /// <summary>
    /// The size of the cursor, which will be created.
    /// </summary>
    public Vector3 CursorSize = new Vector3(0.05f, 0.05f, 0.05f);

    /// <summary>
    /// The color of the cursor - can be set in editor.
    /// </summary>
    public Color CursorColour = Color.HSVToRGB(0.0223f, 0.7922f, 1.000f);

    /// <summary>
    /// Provides when the gaze is ready to start working (based upon whether
    /// Azure connects successfully).
    /// </summary>
    internal bool GazeEnabled = false;

    /// <summary>
    /// The currently focused object.
    /// </summary>
    internal GameObject FocusedObject { get; private set; }

    /// <summary>
    /// The object which was last focused on.
    /// </summary>
    internal GameObject _oldFocusedObject { get; private set; }

    /// <summary>
    /// The info taken from the last hit.
    /// </summary>
    internal RaycastHit HitInfo { get; private set; }

    /// <summary>

1. Go to the Scr iptsScr ipts  folder you created previously.

2. Right-click in the Project Panel, CreateCreate > C# Scr iptC# Scr ipt. Call the script Gaze.

3. Double click on the new Gaze script to open it with Visual Studio.

4. Ensure the following namespace is included at the top of the script:

5. Then add the following variables inside the Gaze class:



IMPORTANTIMPORTANT

    /// <summary>
    /// The cursor object.
    /// </summary>
    internal GameObject Cursor { get; private set; }

    /// <summary>
    /// Provides whether the raycast has hit something.
    /// </summary>
    internal bool Hit { get; private set; }

    /// <summary>
    /// This will store the position which the ray last hit.
    /// </summary>
    internal Vector3 Position { get; private set; }

    /// <summary>
    /// This will store the normal, of the ray from its last hit.
    /// </summary>
    internal Vector3 Normal { get; private set; }

    /// <summary>
    /// The start point of the gaze ray cast.
    /// </summary>
    private Vector3 _gazeOrigin;

    /// <summary>
    /// The direction in which the gaze should be.
    /// </summary>
    private Vector3 _gazeDirection;

Some of these variables will be able to be edited in the Editor.

    /// <summary>
    /// The method used after initialization of the scene, though before Start().
    /// </summary>
    private void Awake()
    {
        // Set this class to behave similar to singleton
        instance = this;
    }

    /// <summary>
    /// Start method used upon initialization.
    /// </summary>
    private void Start()
    {
        FocusedObject = null;
        Cursor = CreateCursor();
    }

6. Code for the Awake() and Start() methods now needs to be added.

7. Add the following code, which will create a cursor object at start, along with the Update() method, which

will run the Raycast method, along with being where the GazeEnabled boolean is toggled:



    /// <summary>
    /// Method to create a cursor object.
    /// </summary>
    /// <returns></returns>
    private GameObject CreateCursor()
    {
        GameObject newCursor = GameObject.CreatePrimitive(PrimitiveType.Sphere);
        newCursor.SetActive(false);

        // Remove the collider, so it doesn't block raycast.
        Destroy(newCursor.GetComponent<SphereCollider>());
        newCursor.transform.localScale = CursorSize;

        newCursor.GetComponent<MeshRenderer>().material = new Material(Shader.Find("Diffuse"))
        {
            color = CursorColour
        };

        newCursor.name = "Cursor";

        newCursor.SetActive(true);

        return newCursor;
    }

    /// <summary>
    /// Called every frame
    /// </summary>
    private void Update()
    {
        if(GazeEnabled == true)
        {
            _gazeOrigin = Camera.main.transform.position;

            _gazeDirection = Camera.main.transform.forward;

            UpdateRaycast();
        }
    }

    private void UpdateRaycast()
    {
        // Set the old focused gameobject.
        _oldFocusedObject = FocusedObject;

        RaycastHit hitInfo;

        // Initialise Raycasting.
        Hit = Physics.Raycast(_gazeOrigin,
            _gazeDirection,
            out hitInfo,
            GazeMaxDistance, LayerMask);

        HitInfo = hitInfo;

        // Check whether raycast has hit.
        if (Hit == true)
        {
            Position = hitInfo.point;

            Normal = hitInfo.normal;

            // Check whether the hit has a collider.
            if (hitInfo.collider != null)

8. Next add the UpdateRaycast() method, which will project a Raycast and detect the hit target.



            {
                // Set the focused object with what the user just looked at.
                FocusedObject = hitInfo.collider.gameObject;
            }
            else
            {
                // Object looked on is not valid, set focused gameobject to null.
                FocusedObject = null;
            }
        }
        else
        {
            // No object looked upon, set focused gameobject to null.
            FocusedObject = null;

            // Provide default position for cursor.
            Position = _gazeOrigin + (_gazeDirection * GazeMaxDistance);

            // Provide a default normal.
            Normal = _gazeDirection;
        }

        // Lerp the cursor to the given position, which helps to stabilize the gaze.
        Cursor.transform.position = Vector3.Lerp(Cursor.transform.position, Position, 0.6f);

        // Check whether the previous focused object is this same 
        //    object. If so, reset the focused object.
        if (FocusedObject != _oldFocusedObject)
        {
            ResetFocusedObject();

            if (FocusedObject != null)
            {
            if (FocusedObject.CompareTag(InteractibleTag.ToString()))
            {
                    // Set the Focused object to green - success!
                    FocusedObject.GetComponent<Renderer>().material.color = Color.green;

                    // Start the Azure Function, to provide the next shape!
                    AzureServices.instance.CallAzureFunctionForNextShape();
                }
            }
        }
    }

    /// <summary>
    /// Reset the old focused object, stop the gaze timer, and send data if it
    /// is greater than one.
    /// </summary>
    private void ResetFocusedObject()
    {
        // Ensure the old focused object is not null.
        if (_oldFocusedObject != null)
        {
            if (_oldFocusedObject.CompareTag(InteractibleTag.ToString()))
            {
                // Set the old focused object to red - its original state.
                _oldFocusedObject.GetComponent<Renderer>().material.color = Color.red;
            }
        }
    }

9. Lastly, add the ResetFocusedObject() method, which will toggle the GazeButton objects current color,

indicating whether it is creating a new shape or not.



 Chapter 10 - Completing the AzureServices class

10. Save your changes in Visual Studio before returning to Unity.

11. Click and drag the Gaze class from the Scripts folder to the Main CameraMain Camera object in the Hierarchy Panel.

With the other scripts in place, it is now possible to complete the AzureServices class. This will be achieved

through:

1. Adding a new method named CreateCloudIdentityAsync(), to set up the authentication variables needed

for communicating with Azure.

This method will also check for the existence of a previously stored File containing the Shape List.

If the file is foundIf the file is found, it will disable the user Gaze, and trigger Shape creation, according to the pattern

of shapes, as stored in the Azure Storage fileAzure Storage file. The user can see this, as the Text MeshText Mesh will provide

display 'Storage' or 'New', depending on the shapes origin.

If no file is foundIf no file is found, it will enable the Gaze, enabling the user to create shapes when looking at the

GazeButtonGazeButton object in the scene.



    /// <summary>
    /// Create the references necessary to log into Azure
    /// </summary>
    private async void CreateCloudIdentityAsync()
    {
        // Retrieve storage account information from connection string
        storageAccount = CloudStorageAccount.Parse(storageConnectionString);

        // Create a file client for interacting with the file service.
        fileClient = storageAccount.CreateCloudFileClient();

        // Create a share for organizing files and directories within the storage account.
        share = fileClient.GetShareReference(fileShare);

        await share.CreateIfNotExistsAsync();

        // Get a reference to the root directory of the share.
        CloudFileDirectory root = share.GetRootDirectoryReference();

        // Create a directory under the root directory
        dir = root.GetDirectoryReference(storageDirectory);

        await dir.CreateIfNotExistsAsync();

        //Check if the there is a stored text file containing the list
        shapeIndexCloudFile = dir.GetFileReference("TextShapeFile");

        if (!await shapeIndexCloudFile.ExistsAsync())
        {
            // File not found, enable gaze for shapes creation
            Gaze.instance.GazeEnabled = true;

            azureStatusText.text = "No Shape\nFile!";
        }
        else
        {
            // The file has been found, disable gaze and get the list from the file
            Gaze.instance.GazeEnabled = false;

            azureStatusText.text = "Shape File\nFound!";

            await ReplicateListFromAzureAsync();
        }
    }

    private void Start()
    {
        // Disable TLS cert checks only while in Unity Editor (until Unity adds support for TLS)
#if UNITY_EDITOR
        ServicePointManager.ServerCertificateValidationCallback = delegate { return true; };
#endif

        // Set the Status text to loading, whilst attempting connection to Azure.
        azureStatusText.text = "Loading...";

        //Creating the references necessary to log into Azure and check if the Storage Directory is 
empty
        CreateCloudIdentityAsync();
    }

2. The next code snippet is from within the Start() method; wherein a call will be made to the

CreateCloudIdentityAsync() method. Feel free to copy over your current Start() method, with the below:

3. Fill in the code for the method CallAzureFunctionForNextShape(). You will use the previously created



    /// <summary>
    /// Call to the Azure Function App to request a Shape.
    /// </summary>
    public async void CallAzureFunctionForNextShape()
    {
        int azureRandomInt = 0;

        // Call Azure function
        HttpWebRequest webRequest = WebRequest.CreateHttp(azureFunctionEndpoint);

        WebResponse response = await webRequest.GetResponseAsync();

        // Read response as string
        using (Stream stream = response.GetResponseStream())
        {
            StreamReader reader = new StreamReader(stream);

            String responseString = reader.ReadToEnd();

            //parse result as integer
            Int32.TryParse(responseString, out azureRandomInt);
        }

        //add random int from Azure to the ShapeIndexList
        ShapeFactory.instance.shapeHistoryList.Add(azureRandomInt);

        ShapeFactory.instance.CreateShape(azureRandomInt, false);

        //Save to Azure storage
        await UploadListToAzureAsync();
    }

    /// <summary>
    /// Upload the locally stored List to Azure
    /// </summary>
    private async Task UploadListToAzureAsync()
    {
        // Uploading a local file to the directory created above
        string listToString = string.Join(",", ShapeFactory.instance.shapeHistoryList.ToArray());

        await shapeIndexCloudFile.UploadTextAsync(listToString);
    }

Azure Function App to request a shape index. Once the new shape is received, this method will send the

shape to the ShapeFactory class to create the new shape in the scene. Use the code below to complete the

body of CallAzureFunctionForNextShape().

4. Add a method to create a string, by concatenating the integers stored in the shape history list, and saving

it in your Azure Storage File.

5. Add a method to retrieve the text stored in the file located in your Azure Storage File and deserialize it

into a list.

6. Once this process is completed, the method re-enables the gaze so that the user can add more shapes to

the scene.
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    ///<summary>
    /// Get the List stored in Azure and use the data retrieved to replicate 
    /// a Shape creation pattern
    ///</summary>
    private async Task ReplicateListFromAzureAsync()
    {
        string azureTextFileContent = await shapeIndexCloudFile.DownloadTextAsync();

        string[] shapes = azureTextFileContent.Split(new char[] { ',' });

        foreach (string shape in shapes)
        {
            int i;

            Int32.TryParse(shape.ToString(), out i);

            ShapeFactory.instance.shapeHistoryList.Add(i);

            ShapeFactory.instance.CreateShape(i, true);

            await Task.Delay(500);
        }

        Gaze.instance.GazeEnabled = true;

        azureStatusText.text = "Load Complete!";
    }

7. Save your changes in Visual Studio before returning to Unity.

To begin the Build process:

1. Go to FileFile > Build SettingsBuild Settings .

2. Click BuildBuild. Unity will launch a File Explorer window, where you need to create and then select a folder to

build the app into. Create that folder now, and name it App. Then with the App folder selected, press

Select FolderSelect Folder .
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 Your finished Azure Functions and Storage Application

 Bonus exercises
  

3. Unity will begin building your project to the App folder.

4. Once Unity has finished building (it might take some time), it will open a File Explorer window at the

location of your build (check your task bar, as it may not always appear above your windows, but will

notify you of the addition of a new window).

To deploy your application:

1. Navigate to the App folder which was created in the last Chapter. You will see a file with your apps name,

with the '.sln' extension, which you should double-click, so to open it within Visual Studio.

2. In the Solution PlatformSolution Platform , select x86, Local Machinex86, Local Machine.

3. In the Solution ConfigurationSolution Configuration select DebugDebug.

For the Microsoft HoloLens, you may find it easier to set this to Remote Machine, so that you are not

tethered to your computer. Though, you will need to also do the following:

Know the IP AddressIP Address  of your HoloLens, which can be found within the SettingsSettings  > Network &Network &

InternetInternet > Wi-FiWi-Fi  > Advanced OptionsAdvanced Options ; the IPv4 is the address you should use.

Ensure Developer ModeDeveloper Mode is OnOn; found in SettingsSettings  > Update & SecurityUpdate & Security  > For developersFor developers .

4. Go to the BuildBuild menu and click on Deploy SolutionDeploy Solution to sideload the application to your machine.

5. Your App should now appear in the list of installed apps, ready to be launched and tested!

Congratulations, you built a mixed reality app that leverages both the Azure Functions and Azure Storage

services. Your app will be able to draw on stored data, and provide an action based on that data.



Exercise 1Exercise 1

  Exercise 2Exercise 2

Create a second spawn point and record which spawn point an object was created from. When you load the data

file, replay the shapes being spawned from the location they originally were created.

Create a way to restart the app, rather than having to re-open it each time. Loading ScenesLoading Scenes  is a good spot to

start. After doing that, create a way to clear the stored list in Azure Storage, so that it can be easily reset from

your app.



   

 

HoloLens (1st gen) and Azure 306: Streaming video
 7/6/2022 • 24 minutes to read • Edit Online

NOTENOTE
The Mixed Reality Academy tutorials were designed with HoloLens (1st gen) and Mixed Reality Immersive Headsets in

mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for guidance in

developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being used for

HoloLens 2. They will be maintained to continue working on the supported devices. There will be a new series of tutorials

that will be posted in the future that will demonstrate how to develop for HoloLens 2. This notice will be updated with a

link to those tutorials when they are posted.

In this course you will learn how connect your Azure Media Services to a Windows Mixed Reality VR experience

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/mr-azure-306.md
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C O URSEC O URSE H O LO L EN SH O LO L EN S IM M ERSIVE  H EA DSET SIM M ERSIVE  H EA DSET S

MR and Azure 306: Streaming video ✔️

 Prerequisites

NOTENOTE

 Before you start

to allow streaming 360 degree video playback on immersive headsets.

Azure Media Ser vicesAzure Media Ser vices  are a collection of services that gives you broadcast-quality video streaming services to

reach larger audiences on today’s most popular mobile devices. For more information, visit the Azure Media

Services page.

Having completed this course, you will have a mixed reality immersive headset application, which will be able to

do the following:

1. Retrieve a 360 degree video from an Azure StorageAzure Storage, through the Azure Media Ser viceAzure Media Ser vice.

2. Display the retrieved 360 degree video within a Unity scene.

3. Navigate between two scenes, with two different videos.

In your application, it is up to you as to how you will integrate the results with your design. This course is

designed to teach you how to integrate an Azure Service with your Unity Project. It is your job to use the

knowledge you gain from this course to enhance your mixed reality application.

This tutorial is designed for developers who have basic experience with Unity and C#. Please also be aware that the

prerequisites and written instructions within this document represent what has been tested and verified at the time of

writing (May 2018). You are free to use the latest software, as listed within the install the tools article, though it should

not be assumed that the information in this course will perfectly match what you'll find in newer software than what's

listed below.

We recommend the following hardware and software for this course:

A development PC, compatible with Windows Mixed Reality for immersive (VR) headset development

Windows 10 Fall Creators Update (or later) with Developer mode enabled

The latest Windows 10 SDK

Unity 2017.4

Visual Studio 2017

A Windows Mixed Reality immersive (VR) headset

Internet access for Azure setup and data retrieval

Two 360-degree videos in mp4 format (you can find some royalty-free videos at this download page)

1. To avoid encountering issues building this project, it is strongly suggested that you create the project

mentioned in this tutorial in a root or near-root folder (long folder paths can cause issues at build-time).

2. Set up and test your Mixed Reality Immersive Headset.

https://azure.microsoft.com/services/media-services
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://support.microsoft.com/help/4039260/windows-10-mixed-reality-pc-hardware-guidelines
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://www.mettle.com/360vr-master-series-free-360-downloads-page
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NOTENOTE
You will notnot  require Motion Controllers for this course. If you need support setting up the Immersive Headset,

please click link on how to set up Windows Mixed Reality.

To use the Azure Storage Ser viceAzure Storage Ser vice, you will need to create and configure a Storage AccountStorage Account in the Azure

portal.

NOTENOTE

1. Log in to the Azure Portal.

If you do not already have an Azure account, you will need to create one. If you are following this tutorial in a

classroom or lab situation, ask your instructor or one of the proctors for help setting up your new account.

2. Once you are logged in, click on Storage accountsStorage accounts  in the left menu.

3. On the Storage AccountsStorage Accounts  tab, click on AddAdd.

4. In the Create storage accountCreate storage account tab:

a. Insert a NameName for your account, be aware this field only accepts numbers, and lowercase letters.

https://support.microsoft.com/help/4043101/windows-10-set-up-windows-mixed-reality
https://portal.azure.com


b. For Deployment model,Deployment model, select Resource managerResource manager .

c. For Account kindAccount kind, select Storage (general purpose v1)Storage (general purpose v1) .

d. For PerformancePerformance, select Standard.*

e. For ReplicationReplication select Locally-redundant storage (LRS)Locally-redundant storage (LRS) .

f. Leave Secure transfer requiredSecure transfer required as DisabledDisabled.

g. Select a Subscr iptionSubscr iption.

h. Choose a Resource groupResource group or create a new one. A resource group provides a way to monitor,

control access, provision and manage billing for a collection of Azure assets.

i. Determine the LocationLocation for your resource group (if you are creating a new Resource Group). The

location would ideally be in the region where the application would run. Some Azure assets are

only available in certain regions.

5. You will need to confirm that you have understood the Terms and Conditions applied to this Service.

6. Once you have clicked on CreateCreate, you will have to wait for the service to be created, this might take a

minute.
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7. A notification will appear in the portal once the Service instance is created.

8. At this point you do not need to follow the resource, simply move to the next Chapter.

To use the Azure Media Service, you will need to configure an instance of the service to be made available to

your application (wherein the account holder needs to be an Admin).

1. In the Azure Portal, click on Create a resourceCreate a resource in the top left corner, and search for Media Ser vice,Media Ser vice,

press EnterEnter . The resource you want currently has a pink icon; click this, to show a new page.

2. The new page will provide a description of the Media Ser viceMedia Ser vice. At the bottom left of this prompt, click the

CreateCreate button, to create an association with this service.

3. Once you have clicked on CreateCreate a panel will appear where you need to provide some details about your

new Media Service:

a. Insert your desired Account NameAccount Name for this service instance.



b. Select a Subscr iptionSubscr iption.

c. Choose a Resource GroupResource Group or create a new one. A resource group provides a way to monitor,

control access, provision and manage billing for a collection of Azure assets. It is recommended to

keep all the Azure services associated with a single project (e.g. such as these labs) under a

common resource group).

If you wish to read more about Azure Resource Groups, please follow this link on how to manage

Azure Resource Groups.

d. Determine the LocationLocation for your resource group (if you are creating a new Resource Group). The

location would ideally be in the region where the application would run. Some Azure assets are

only available in certain regions.

e. For the Storage AccountStorage Account section, click the Please select...Please select... section, then click the StorageStorage

AccountAccount you created in the last Chapter.

f. You will also need to confirm that you have understood the Terms and Conditions applied to this

Service.

g. Click CreateCreate.

4. Once you have clicked on CreateCreate, you will have to wait for the service to be created, this might take a

minute.

5. A notification will appear in the portal once the Service instance is created.

https://docs.microsoft.com/en-us/azure/azure-resource-manager/resource-group-portal


6. Click on the notification to explore your new Service instance.

7. Click the Go to resourceGo to resource button in the notification to explore your new Service instance.

8. Within the new Media service page, within the panel on the left, click on the AssetsAssets  link, which is about

halfway down.

9. On the next page, in the top-left corner of the page, click UploadUpload.

10. Click on the FolderFolder  icon to browse your files and select the first 360 Video that you would like to stream.

You can follow this link to download a sample video.

https://vimeo.com/214401712


WARNINGWARNING
Long filenames may cause an issue with the encoder: so to ensure videos do not have issues, consider shortening the

length of your video file names.

11. The progress bar will turn green when the video has finished uploading.

12. Click on the text above (yourser vicename - Assetsyourser vicename - Assets ) to return to the AssetsAssets  page.

13. You will notice that your video has been successfully uploaded. Click on it.

14. The page you are redirected to will show you detailed information about your video. To be able to use

your video you need to encode it, by clicking the EncodeEncode button at the top-left of the page.



15. A new panel will appear to the right, where you will be able to set encoding options for your file. Set the

following properties (some will be already set by default):

a. Media encoder name Media encoder name Media Encoder StandardMedia Encoder Standard

b. Encoding preset Encoding preset Content Adaptive Multiple Bitrate MP4Content Adaptive Multiple Bitrate MP4

c. Job name Job name Media Encoder Standard processing of Video1.mp4Media Encoder Standard processing of Video1.mp4

d. Output media asset name Output media asset name Video1.mp4 -- Media Encoder Standard encodedVideo1.mp4 -- Media Encoder Standard encoded



16. Click the CreateCreate button.

17. You will notice a bar with Encoding job addedEncoding job added, click on that bar and a panel will appear with the

Encoding progress displayed in it.



IMPORTANTIMPORTANT

18. Wait for the Job to be completed. Once it is done, feel free to close the panel with the 'X' at the top right

of that panel.

The time this takes, depends on the file size of your video. This process can take quite some time.

19. Now that the encoded version of the video has been created, you can publish it to make it accessible. To

do so, click the blue link AssetsAssets  to go back to the assets page.



NOTENOTE

NOTENOTE

20. You will see your video along with another, which is of Asset Type Asset Type Multi-Bitrate MP4Multi-Bitrate MP4 .

You may notice that the new asset, alongside your initial video, is Unknown, and has '0' bytes for it's SizeSize, just

refresh your window for it to update.

21. Click this new asset.

22. You will see a similar panel to the one you used before, just this is a different asset. Click the PublishPublish

button located at the top-center of the page.

23. You will be prompted to set a LocatorLocator , which is the entry point, to file/s in your Assets. For your scenario

set the following properties:

a. Locator typeLocator type > ProgressiveProgressive.

b. The datedate and timetime will be set for you, from your current date, to a time in the future (one hundred

years in this case). Leave as is or change it to suit.

For more information about Locators, and what you can choose, visit the Azure Media Services Documentation.

24. At the bottom of that panel, click on the AddAdd button.

https://docs.microsoft.com/en-us/azure/media-services/media-services-concepts


25. Your video is now published and can be streamed by using its endpoint. Further down the page is a FilesFiles

section. This is where the different encoded versions of your video will be. Select the highest possible

resolution one (in the image below it is the 1920x960 file), and then a panel to the right will appear. There

you will find a Download URLDownload URL . Copy this EndpointEndpoint as you will use it later in your code.
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NOTENOTE
You can also press the PlayPlay  button to play your video and test it.

26. You now need to upload the second video that you will use in this Lab. Follow the steps above, repeating

the same process for the second video. Ensure you copy the second EndpointEndpoint also. Use the following link

to download a second video.

27. Once both videos have been published, you are ready to move to the next Chapter.

The following is a typical set up for developing with the Mixed Reality, and as such, is a good template for other

projects.

1. Open UnityUnity  and click NewNew .

2. You will now need to provide a Unity Project name, insert MR_360VideoStreaming.MR_360VideoStreaming.. Make sure the

project type is set to 3D3D. Set the Location to somewhere appropriate for you (remember, closer to root

directories is better). Then, click Create projectCreate project.

https://vimeo.com/214402865


3. With Unity open, it is worth checking the default Scr ipt EditorScr ipt Editor  is set to Visual Studio.Visual Studio. Go to EditEdit

PreferencesPreferences  and then from the new window, navigate to External ToolsExternal Tools . Change External Scr iptExternal Scr ipt

EditorEditor  to Visual Studio 2017Visual Studio 2017 . Close the PreferencesPreferences  window.

4. Next, go to FileFile  Build SettingsBuild Settings  and switch the platform to Universal Windows PlatformUniversal Windows Platform , by clicking

on the Switch PlatformSwitch Platform button.

5. Also make sure that:

a. Target DeviceTarget Device is set to Any Device.Any Device.

b. Build TypeBuild Type is set to D3D.D3D.

c. SDKSDK is set to Latest installed.Latest installed.

d. Visual Studio VersionVisual Studio Version is set to Latest installed.Latest installed.

e. Build and RunBuild and Run is set to Local Machine.Local Machine.

f. Do not worry about setting up ScenesScenes  right now, as you will set these up later.

g. The remaining settings should be left as default for now.



6. In the Build SettingsBuild Settings  window, click on the Player SettingsPlayer Settings  button, this will open the related panel in

the space where the InspectorInspector  is located.

7. In this panel, a few settings need to be verified:

a. In the Other SettingsOther Settings  tab:

a. Scr iptingScr ipting Runtime VersionRuntime Version should be StableStable (.NET 3.5 Equivalent).

b. Scr ipting BackendScripting Backend should be .NET..NET.

c. API Compatibility LevelAPI Compatibility Level  should be .NET 4.6 ..NET 4.6 .

b. Further down the panel, in XR SettingsXR Settings  (found below Publish SettingsPublish Settings ), tick Vir tual RealityVir tual Reality

Suppor tedSuppor ted, make sure the Windows Mixed Reality SDKWindows Mixed Reality SDK is added.
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IMPORTANTIMPORTANT

c. Within the Publishing SettingsPublishing Settings  tab, under CapabilitiesCapabilities , check:

InternetClientInternetClient

8. Once you have made those changes, close the Build SettingsBuild Settings  window.

9. Save your Project File Save Project.

If you wish to skip the Unity Set up component of this course, and continue straight into code, feel free to download this

.unitypackage, import it into your project as a Custom PackageCustom Package, and then continue from Chapter 5Chapter 5 . You will still need

to create a Unity Project.

For this course you will need to download a Unity Asset Package called InsideOutSphere.unitypackageInsideOutSphere.unitypackage.

How-to import the unitypackageunitypackage:

1. With the Unity dashboard in front of you, click on AssetsAssets  in the menu at the top of the screen, then click

on Impor t Package > Custom PackageImpor t Package > Custom Package.

2. Use the file picker to select the InsideOutSphere.unitypackageInsideOutSphere.unitypackage package and click OpenOpen. A list of

components for this asset will be displayed to you. Confirm the import by clicking Impor tImpor t.

3. Once it has finished importing, you will notice three new folders, Mater ialsMater ials , ModelsModels , and PrefabsPrefabs , have

been added to your AssetsAssets  folder. This kind of folder structure is typical for a Unity project.

https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20306%20-%20Streaming%20video/Azure-MR-306.unitypackage
https://docs.unity3d.com/Manual/AssetPackages.html
https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20306%20-%20Streaming%20video/InsideOutSphere.unitypackage


a. Open the ModelsModels  folder, and you will see that the InsideOutSphereInsideOutSphere model has been imported.

b. Within the Mater ialsMater ials  folder you will find the InsideOutSpheresInsideOutSpheres  material lambert1, along with a

material called ButtonMaterial, which is used by the GazeButton, which you will see soon.

c. The PrefabsPrefabs  folder contains the InsideOutSphereInsideOutSphere prefab which contains both the

InsideOutSphereInsideOutSphere model and the GazeButton.

d. No code is includedNo code is included, you will write the code by following this course.

4. Within the HierarchyHierarchy , select the Main CameraMain Camera object, and update the following components:

a. TransformTransform

a. Position = XX: 0, YY : 0, ZZ: 0.

b. Rotation = XX: 0, YY : 0, ZZ: 0.

c. Scale XX: 1, YY : 1, ZZ: 1.

b. CameraCamera

a. Clear FlagsClear Flags : Solid Color.

b. Clipping PlanesClipping Planes : Near : 0.1, Far : 6.

5. Navigate to the PrefabPrefab folder, and then drag the InsideOutSphereInsideOutSphere prefab into the HierarchyHierarchy  Panel.



XX YY ZZ

0 0 0

XX YY ZZ

0 -50 0

XX YY ZZ

0 0 0

6. Expand the InsideOutSphereInsideOutSphere object within the HierarchyHierarchy  by clicking the little arrow next to it. You will

see a childchild object beneath it called GazeButtonGazeButton. This will be used to change scenes and thus videos.

7. In the Inspector Window click on the InsideOutSphereInsideOutSphere's Transform component, ensure that the

following properties are set:

Transform - PositionTransform - Position

Transform - RotationTransform - Rotation

Transform - ScaleTransform - Scale



XX YY ZZ

3.6 1.3 0

XX YY ZZ

0 0 0

XX YY ZZ

1 1 1

8. Click on the GazeButtonGazeButton child object, and set its TransformTransform as follows:

Transform - PositionTransform - Position

Transform - RotationTransform - Rotation

Transform - ScaleTransform - Scale
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The VideoControllerVideoController  class hosts the two video endpoints that will be used to stream the content from the

Azure Media Service.

To create this class:

1. Right-click in the Asset FolderAsset Folder , located in the ProjectProject Panel, and click Create > FolderCreate > Folder . Name the

folder Scr iptsScr ipts .



using System.Collections;
using UnityEngine;
using UnityEngine.SceneManagement;
using UnityEngine.Video;

2. Double click on the Scr iptsScr ipts  folder to open it.

3. Right-click inside the folder, then click Create > C# Scr iptCreate > C# Scr ipt. Name the script VideoControllerVideoController .

4. Double click on the new VideoControllerVideoController  script to open it with Visual Studio 2017.Visual Studio 2017.

5. Update the namespaces at the top of the code file as follows:

6. Enter the following variables in the VideoControllerVideoController  class, along with the Awake()Awake()  method:



    /// <summary> 
    /// Provides Singleton-like behaviour to this class. 
    /// </summary> 
    public static VideoController instance; 

    /// <summary> 
    /// Reference to the Camera VideoPlayer Component.
    /// </summary> 
    private VideoPlayer videoPlayer; 

    /// <summary>
    /// Reference to the Camera AudioSource Component.
    /// </summary> 
    private AudioSource audioSource; 

    /// <summary> 
    /// Reference to the texture used to project the video streaming 
    /// </summary> 
    private RenderTexture videoStreamRenderTexture;

    /// <summary>
    /// Insert here the first video endpoint
    /// </summary>
    private string video1endpoint = "-- Insert video 1 Endpoint here --";

    /// <summary>
    /// Insert here the second video endpoint
    /// </summary>
    private string video2endpoint = "-- Insert video 2 Endpoint here --";

    /// <summary> 
    /// Reference to the Inside-Out Sphere. 
    /// </summary> 
    public GameObject sphere;

    void Awake()
    {
        instance = this;
    }

WARNINGWARNING

    // Use this for initialization
    void Start()
    {
        Application.runInBackground = true;
        StartCoroutine(PlayVideo());
    }

7. Now is the time to enter the endpoints from your Azure Media Service videos:

a. The first into the video1endpoint variable.

b. The second into the video2endpoint variable.

There is a known issue with using https within Unity, with version 2017.4.1f1. If the videos provide an error on

play, try using 'http' instead.

8. Next, the Star t()Star t()  method needs to be edited. This method will be triggered every time the user switches

scene (consequently switching the video) by looking at the Gaze Button.

9. Following the Star t()Star t()  method, insert the PlayVideo()PlayVideo()  IEnumerator method, which will be used to start



    private IEnumerator PlayVideo()
    {
        // create a new render texture to display the video 
        videoStreamRenderTexture = new RenderTexture(2160, 1440, 32, RenderTextureFormat.ARGB32);

        videoStreamRenderTexture.Create();

        // assign the render texture to the object material 
        Material sphereMaterial = sphere.GetComponent<Renderer>().sharedMaterial;

        //create a VideoPlayer component 
        videoPlayer = gameObject.AddComponent<VideoPlayer>();

        // Set the video to loop. 
        videoPlayer.isLooping = true;

        // Set the VideoPlayer component to play the video from the texture 
        videoPlayer.renderMode = VideoRenderMode.RenderTexture;

        videoPlayer.targetTexture = videoStreamRenderTexture;

        // Add AudioSource 
        audioSource = gameObject.AddComponent<AudioSource>();

        // Pause Audio play on Awake 
        audioSource.playOnAwake = true;
        audioSource.Pause();

        // Set Audio Output to AudioSource 
        videoPlayer.audioOutputMode = VideoAudioOutputMode.AudioSource;
        videoPlayer.source = VideoSource.Url;

        // Assign the Audio from Video to AudioSource to be played 
        videoPlayer.EnableAudioTrack(0, true);
        videoPlayer.SetTargetAudioSource(0, audioSource);

        // Assign the video Url depending on the current scene 
        switch (SceneManager.GetActiveScene().name)
        {
            case "VideoScene1":
                videoPlayer.url = video1endpoint;
                break;

            case "VideoScene2":
                videoPlayer.url = video2endpoint;
                break;

            default:
                break;
        }

        //Set video To Play then prepare Audio to prevent Buffering 
        videoPlayer.Prepare();

        while (!videoPlayer.isPrepared)
        {
            yield return null;
        }

        sphereMaterial.mainTexture = videoStreamRenderTexture;

        //Play Video 
        videoPlayer.Play();

        //Play Sound 
        audioSource.Play();

videos seamlessly (so no stutter is seen).
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        audioSource.Play();

        while (videoPlayer.isPlaying)
        {
            yield return null;
        }
    }

    public void ChangeScene()
    {
        SceneManager.LoadScene(SceneManager.GetActiveScene().name == "VideoScene1" ? "VideoScene2" : 
"VideoScene1");
    }

TIPTIP

10. The last method you need for this class is the ChangeScene()ChangeScene()  method, which will be used to swap

between scenes.

The ChangeScene()ChangeScene() method uses a handy C# feature called the Conditional Operator. This allows for conditions

to be checked, and then values returned based on the outcome of the check, all within a single statement. Follow

this link to learn more about Conditional Operator.

11. Save your changes in Visual Studio before returning to Unity.

12. Back in the Unity Editor, click and drag the VideoControllerVideoController  class [from]{.underline} the Scr iptsScr ipts  folder to

the Main CameraMain Camera object in the HierarchyHierarchy  Panel.

13. Click on the Main CameraMain Camera and look at the Inspector PanelInspector Panel . You will notice that within the newly added

Script component, there is a field with an empty value. This is a reference field, which targets the public

variables within your code.

14. Drag the InsideOutSphereInsideOutSphere object from the Hierarchy PanelHierarchy Panel  to the SphereSphere slot, as shown in the image

below.

 

This class is responsible for creating a RaycastRaycast that will be projected forward from the Main CameraMain Camera, to detect

which object the user is looking at. In this case, the RaycastRaycast will need to identify if the user is looking at the

GazeButtonGazeButton object in the scene and trigger a behavior.

To create this Class:

using UnityEngine;

1. Go to the Scr iptsScr ipts  folder you created previously.

2. Right-click in the ProjectProject Panel, Create C# Script. Name the script GazeGaze.

3. Double click on the new GazeGaze script to open it with Visual Studio 2017.Visual Studio 2017.

4. Ensure the following namespace is at the top of the script, and remove any others:

https://docs.microsoft.com/en-us/dotnet/csharp/language-reference/operators/conditional-operator


    /// <summary> 
    /// Provides Singleton-like behaviour to this class. 
    /// </summary> 
    public static Gaze instance;

    /// <summary> 
    /// Provides a reference to the object the user is currently looking at. 
    /// </summary> 
    public GameObject FocusedGameObject { get; private set; }

    /// <summary> 
    /// Provides a reference to compare whether the user is still looking at 
    /// the same object (and has not looked away). 
    /// </summary> 
    private GameObject oldFocusedObject = null;

    /// <summary> 
    /// Max Ray Distance 
    /// </summary> 
    float gazeMaxDistance = 300;

    /// <summary> 
    /// Provides whether an object has been successfully hit by the raycast. 
    /// </summary> 
    public bool Hit { get; private set; }

    private void Awake()
    {
        // Set this class to behave similar to singleton 
        instance = this;
    }

    void Start()
    {
        FocusedGameObject = null;
    }

5. Then add the following variables inside the GazeGaze class:

6. Code for the Awake()Awake()  and Star t()Star t()  methods now needs to be added.

7. Add the following code in the Update()Update()  method to project a Raycast and detect the target hit:
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    void Update()
    {
        // Set the old focused gameobject. 
        oldFocusedObject = FocusedGameObject;
        RaycastHit hitInfo;

        // Initialise Raycasting. 
        Hit = Physics.Raycast(Camera.main.transform.position, Camera.main.transform.forward, out 
hitInfo, gazeMaxDistance);

        // Check whether raycast has hit. 
        if (Hit == true)
        {
            // Check whether the hit has a collider. 
            if (hitInfo.collider != null)
            {
                // Set the focused object with what the user just looked at. 
                FocusedGameObject = hitInfo.collider.gameObject;
            }
            else
            {
                // Object looked on is not valid, set focused gameobject to null. 
                FocusedGameObject = null;
            }
        }
        else
        {
            // No object looked upon, set focused gameobject to null.
            FocusedGameObject = null;
        }

        // Check whether the previous focused object is this same 
        // object (so to stop spamming of function). 
        if (FocusedGameObject != oldFocusedObject)
        {
            // Compare whether the new Focused Object has the desired tag we set previously. 
            if (FocusedGameObject.CompareTag("GazeButton"))
            {
                FocusedGameObject.SetActive(false);
                VideoController.instance.ChangeScene();
            }
        }
    }

8. Save your changes in Visual Studio before returning to Unity.

9. Click and drag the GazeGaze class from the Scripts folder to the Main Camera object in the HierarchyHierarchy  Panel.

The purpose of this Chapter is to setup the two scenes, each hosting a video to stream. You will duplicate the

scene you have already created, so that you do not need to set it up again, though you will then edit the new

scene, so that the GazeButton object is in a different location and has a different appearance. This is to show how

to change between scenes.

1. Do this by going to File > Save Scene as...File > Save Scene as... . A save window will appear. Click the New folderNew folder  button.



TIPTIP

TIPTIP

2. Name the folder ScenesScenes .

3. The Save SceneSave Scene window will still be open. Open your newly created ScenesScenes  folder.

4. In the File name:File name: text field, type VideoScene1VideoScene1 , then press SaveSave.

5. Back in Unity, open your ScenesScenes  folder, and left-click your VideoScene1VideoScene1  file. Use your keyboard, and

press Ctr l + DCtr l + D you will duplicate that scene

The DuplicateDuplicate command can also be performed by navigating to Edit > DuplicateEdit > Duplicate.

6. Unity will automatically increment the scene names number, but check it anyway, to ensure it matches the

previously inserted code.

You should have VideoScene1VideoScene1  and VideoScene2VideoScene2 .

7. With your two scenes, go to File > Build SettingsFile > Build Settings . With the Build SettingsBuild Settings  window open, drag your

scenes to the Scenes in BuildScenes in Build section.

You can select both of your scenes from your ScenesScenes folder through holding the CtrlCtrl button, and then left-

clicking each scene, and finally drag both across.

8. Close the Build SettingsBuild Settings  window, and double click on VideoScene2VideoScene2 .

9. With the second scene open, click on the GazeButtonGazeButton child object of the InsideOutSphereInsideOutSphere, and set its

Transform as follows:

Transform - PositionTransform - Position



XX YY ZZ

0 1.3 3.6

XX YY ZZ

0 0 0

XX YY ZZ

1 1 1

Transform - RotationTransform - Rotation

Transform - ScaleTransform - Scale

10. With the GazeButtonGazeButton child still selected, look at the InspectorInspector  and at the Mesh FilterMesh Filter . Click the little

target next to the MeshMesh reference field:

11. A Select MeshSelect Mesh popup window will appear. Double click the CubeCube mesh from the list of AssetsAssets .

12. The Mesh FilterMesh Filter  will update, and now be a CubeCube. Now, click the GearGear  icon next to Sphere ColliderSphere Collider  and

click Remove ComponentRemove Component, to delete the collider from this object.



13. With the GazeButtonGazeButton still selected, click the Add ComponentAdd Component button at the bottom of the InspectorInspector . In

the search field, type boxbox, and Box ColliderBox Collider  will be an option -- click that, to add a Box ColliderBox Collider  to your

GazeButtonGazeButton object.

14. The GazeButtonGazeButton is now partially updated, to look different, however, you will now create a new

MaterialMater ial , so that it looks completely different, and is easier to recognize as a different object, than the

object in the first scene.

15. Navigate to your Mater ialsMater ials  folder, within the Project PanelProject Panel . Duplicate the ButtonMaterialButtonMaterial  Material

(press Ctr lCtr l  + DD on the keyboard, or left-click the Mater ialMater ial , then from the EditEdit file menu option, select

DuplicateDuplicate).

 

16. Select the new ButtonMaterialButtonMaterial  Material (here named ButtonMaterial 1ButtonMaterial 1 ), and within the InspectorInspector ,

click the AlbedoAlbedo color window. A popup will appear, where you can select another color (choose

whichever you like), then close the popup. The Material will be its own instance, and different to the

original.
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17. Drag the new Mater ialMater ial  onto the GazeButtonGazeButton child, to now completely update its look, so that it is easily

distinguishable from the first scenes button.

18. At this point you can test the project in the Editor before building the UWP project.

Press the PlayPlay  button in the EditorEditor  and wear your headset.

19. Look at the two GazeButtonGazeButton objects to switch between the first and second video.

Once you have ensured that the editor has no errors, you are ready to Build.

To Build:

1. Save the current scene by clicking on File > SaveFile > Save.

2. Check the box called Unity C# ProjectsUnity C# Projects  (this is important because it will allow you to edit the classes
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after build is completed).

3. Go to File > Build SettingsFile > Build Settings , click on BuildBuild.

4. You will be prompted to select the folder where you want to build the Solution.

5. Create a BUILDSBUILDS  folder and within that folder create another folder with an appropriate name of your

choice.

6. Click your new folder and then click Select FolderSelect Folder , so to choose that folder, to begin the build at that

location.

 

7. Once Unity has finished building (it might take some time), it will open a File ExplorerFile Explorer  window at the

location of your build.

Once the build has been completed, a File ExplorerFile Explorer  window will appear at the location of your build. Open the

Folder you named and built to, then double click on the solution (.sln) file within that folder, to open your

solution with Visual Studio 2017.

The only thing left to do is deploy your app to your computer (or Local Machine).

To deploy to Local Machine:

1. In Visual Studio 2017Visual Studio 2017 , open the solution file that has just been created.
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NOTENOTE

2. In the Solution PlatformSolution Platform , select x86, Local Machinex86, Local Machine.

3. In the Solution ConfigurationSolution Configuration select DebugDebug.

4. You will now need to restore any packages to your solution. Right-click on your SolutionSolution, and click

Restore NuGet Packages for Solution...Restore NuGet Packages for Solution...

This is done because the packages which Unity built need to be targeted to work with your local machines

references.

5. Go to Build menuBuild menu and click on Deploy SolutionDeploy Solution to sideload the application to your machine. Visual

Studio will first build and then deploy your application.

6. Your App should now appear in the list of installed apps, ready to be launched.

When you run the Mixed Reality application, you will you be within the InsideOutSphereInsideOutSphere model which you

used within your app. This sphere will be where the video will be streamed to, providing a 360-degree view, of

the incoming video (which was filmed for this kind of perspective). Do not be surprised if the video takes a

couple of seconds to load, your app is subject to your available Internet speed, as the video needs to be fetched

and then downloaded, so to stream into your app. When you are ready, change scenes and open your second

video, by gazing at the red sphere! Then feel free to go back, using the blue cube in the second scene!

Congratulations, you built a mixed reality app that leverages the Azure Media Service to stream 360 videos.



 Bonus Exercises
Exercise 1Exercise 1

It is entirely possible to only use a single scene to change videos within this tutorial. Experiment with your

application and make it into a single scene! Perhaps even add another video to the mix.

Exercise 2Exercise 2

Experiment with Azure and Unity, and attempt to implement the ability for the app to automatically select a

video with a different file size, depending on the strength of an Internet connection.
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NOTENOTE
The Mixed Reality Academy tutorials were designed with HoloLens (1st gen) and Mixed Reality Immersive Headsets in

mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for guidance in

developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being used for

HoloLens 2. They will be maintained to continue working on the supported devices. There will be a new series of tutorials

that will be posted in the future that will demonstrate how to develop for HoloLens 2. This notice will be updated with a

link to those tutorials when they are posted.

In this course, you will learn how to add Machine Learning (ML) capabilities to a mixed reality application using

Azure Machine Learning Studio (classic).

Azure Machine Learning Studio (classic) is a Microsoft service, which provides developers with a large number

of machine learning algorithms, which can help with data input, output, preparation, and visualization. From

these components, it is then possible to develop a predictive analytics experiment, iterate on it, and use it to train

your model. Following training, you can make your model operational within the Azure cloud, so that it can then

score new data. For more information, visit the Azure Machine Learning Studio (classic) page.

Having completed this course, you will have a mixed reality immersive headset application, and will have

learned how do the following:

1. Provide a table of sales data to the Azure Machine Learning Studio (classic) portal, and design an algorithm

to predict future sales of popular items.

2. Create a Unity ProjectUnity Project, which can receive and interpret prediction data from the ML service.

3. Display the predication data visually within the Unity ProjectUnity Project, through providing the most popular sales

items, on a shelf.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/mr-azure-307.md
https://azure.microsoft.com/services/machine-learning-studio/
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 Prerequisites
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 Before you start

 Chapter 1 - Azure Storage Account setup

In your application, it is up to you as to how you will integrate the results with your design. This course is

designed to teach you how to integrate an Azure Service with your Unity Project. It is your job to use the

knowledge you gain from this course to enhance your mixed reality application.

This course is a self-contained tutorial, which does not directly involve any other Mixed Reality Labs.

While this course primarily focuses on Windows Mixed Reality immersive (VR) headsets, you can also apply what you learn

in this course to Microsoft HoloLens. As you follow along with the course, you will see notes on any changes you might

need to employ to support HoloLens. When using HoloLens, you may notice some echo during voice capture.

This tutorial is designed for developers who have basic experience with Unity and C#. Please also be aware that the

prerequisites and written instructions within this document represent what has been tested and verified at the time of

writing (May 2018). You are free to use the latest software, as listed within the install the tools article, though it should

not be assumed that the information in this course will perfectly match what you'll find in newer software than what's

listed below.

We recommend the following hardware and software for this course:

A development PC, compatible with Windows Mixed Reality for immersive (VR) headset development

Windows 10 Fall Creators Update (or later) with Developer mode enabled

The latest Windows 10 SDK

Unity 2017.4

Visual Studio 2017

A Windows Mixed Reality immersive (VR) headset or Microsoft HoloLens with Developer mode enabled

Internet access for Azure setup and ML data retrieval

To avoid encountering issues building this project, it is strongly suggested that you create the project mentioned

in this tutorial in a root or near-root folder (long folder paths can cause issues at build-time).

To use the Azure Translator API, you will need to configure an instance of the service to be made available to

your application.

1. Log in to the Azure Portal.

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://support.microsoft.com/help/4039260/windows-10-mixed-reality-pc-hardware-guidelines
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://portal.azure.com
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NOTENOTE

If you do not already have an Azure account, you will need to create one. If you are following this tutorial in a

classroom or lab situation, ask your instructor or one of the proctors for help setting up your new account.

2. Once you are logged in, click on Storage AccountsStorage Accounts  in the left menu.

The word NewNew may have been replaced with Create a resourceCreate a resource, in newer portals.

3. On the Storage AccountsStorage Accounts  tab, click on AddAdd.

4. In the Create Storage AccountCreate Storage Account panel:

a. Insert a NameName for your account, be aware this field only accepts numbers, and lowercase letters.

b. For Deployment model,Deployment model, select Resource managerResource manager .



c. For Account kindAccount kind, select Storage (general purpose v1)Storage (general purpose v1) .

d. For PerformancePerformance, select StandardStandard.

e. For ReplicationReplication select Read-access-geo-redundant storage (RA-GRS)Read-access-geo-redundant storage (RA-GRS) .

f. Leave Secure transfer requiredSecure transfer required as DisabledDisabled.

g. Select a Subscr iptionSubscr iption.

h. Choose a Resource GroupResource Group or create a new one. A resource group provides a way to monitor,

control access, provision and manage billing for a collection of Azure assets. It is recommended to

keep all the Azure services associated with a single project (e.g. such as these labs) under a

common resource group).

If you wish to read more about Azure Resource Groups, please visit the resource group article.

i. Determine the LocationLocation for your resource group (if you are creating a new Resource Group). The

location would ideally be in the region where the application would run. Some Azure assets are

only available in certain regions.

5. You will also need to confirm that you have understood the Terms and Conditions applied to this Service.

https://docs.microsoft.com/en-us/azure/azure-resource-manager/resource-group-portal
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6. Once you have clicked on CreateCreate, you will have to wait for the service to be created, this might take a

minute.

7. A notification will appear in the portal once the Service instance is created.

To use the Azure Machine Learning, you will need to configure an instance of the Machine Learning service to be

made available to your application.

1. In the Azure Portal, click on NewNew  in the top left corner, and search for Machine Learning StudioMachine Learning Studio

WorkspaceWorkspace, press EnterEnter .



2. The new page will provide a description of the Machine Learning Studio WorkspaceMachine Learning Studio Workspace service. At the

bottom left of this prompt, click the CreateCreate button, to create an association with this service.

3. Once you have clicked on CreateCreate, a panel will appear where you need to provide some details about

your new Machine Learning Studio ser viceMachine Learning Studio ser vice:

a. Insert your desired Workspace nameWorkspace name for this service instance.

b. Select a Subscr iptionSubscr iption.

c. Choose a Resource GroupResource Group or create a new one. A resource group provides a way to monitor,

control access, provision and manage billing for a collection of Azure assets. It is recommended to

keep all the Azure services associated with a single project (e.g. such as these labs) under a

common resource group).

If you wish to read more about Azure Resource Groups, please visit the resource group article.

d. Determine the LocationLocation for your resource group (if you are creating a new Resource Group). The

location would ideally be in the region where the application would run. Some Azure assets are

only available in certain regions. You should use the same resource group that you used for

creating the Azure Storage in the previous Chapter.

https://docs.microsoft.com/en-us/azure/azure-resource-manager/resource-group-portal


e. For the Storage accountStorage account section, click Use existingUse existing, then click the dropdown menu, and from

there, click the Storage AccountStorage Account you created in the last Chapter.

f. Select the appropriate Workspace pr icing tierWorkspace pr icing tier  for you, from the dropdown menu.

g. Within the Web ser vice planWeb ser vice plan section, click CreateCreate new,new, then insert a name for it in the text field.

h. From the Web ser vice plan pr icing tierWeb ser vice plan pr icing tier  section, select the price tier of your choice. A

development testing tier called DEVTEST StandardDEVTEST Standard should be available to you at no charge.

i. You will also need to confirm that you have understood the Terms and Conditions applied to this

Service.

j. Click CreateCreate.

4. Once you have clicked on CreateCreate, you will have to wait for the service to be created, this might take a

minute.

5. A notification will appear in the portal once the Service instance is created.
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6. Click on the notification to explore your new Service instance.

7. Click the Go to resourceGo to resource button in the notification to explore your new Service instance.

8. In the page displayed, under the Additional L inksAdditional L inks  section, click Launch Machine Learning StudioLaunch Machine Learning Studio,

which will direct your browser to the Machine Learning StudioMachine Learning Studio portal.

9. Use the S ign InSign In button, at the top right or in the center, to log into your Machine Learning Studio

(classic).

One of the ways Machine Learning algorithms work is by analyzing existing data and then attempting to predict

future results based on the existing data set. This generally means that the more existing data you have, the

better the algorithm will be at predicting future results.



IMPORTANTIMPORTANT

A sample table is provided to you, for this course, called ProductsTableCSV and can be downloaded here.

The above .zip file contains both the ProductsTableCSVProductsTableCSV and the .unitypackage.unitypackage, which you will need in Chapter 6. This

package is also provided within that Chapter, though separate to the csv file.

This sample data set contains a record of the best-selling objects at every hour of each day of the year 2017.

For example, on day 1 of 2017, at 1pm (hour 13), the best-selling item was salt and pepper.

This sample table contains 9998 entries.

1. Head back to the Machine Learning Studio (classic)Machine Learning Studio (classic)  portal, and add this table as a DatasetDataset for your

ML. Do this by clicking the + New+ New  button in the bottom left corner of the screen.

https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20307%20-%20Machine%20learning/MR%20and%20Azure%20307%20-%20Machine%20learning.zip


2. A section will come up from the bottom, and within that there is navigation panel on the left. Click

DatasetDataset, then to the right of that, From Local FileFrom Local File.
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3. Upload the new DatasetDataset by following these steps:

a. The upload window will appear, where you can BrowseBrowse your hard drive for the new dataset.

b. Once selected, and back in the upload window, leave the checkbox unticked.

c. In the text field below, enter ProductsTableCSV.csvProductsTableCSV.csv  as the name for the dataset (though should

automatically be added).

d. Using the dropdown menu for TypeType, select Generic CSV File with a header (.csv)Generic CSV File with a header (.csv) .

e. Press the tick in the bottom right of the upload window, and your DatasetDataset will be uploaded.

Before you can build your machine learning system, you will need to build an experiment, to validate your

theory about your data. With the results, you will know whether you need more data, or if there is no correlation

between the data and a possible outcome.

To start creating an experiment:

1. Click again on the + New+ New  button on the bottom left of the page, then click on ExperimentExperiment > BlankBlank



ExperimentExperiment.

2. A new page will be displayed with a blank Experiment:

3. From the panel on the left expand Saved DatasetsSaved Datasets  > My DatasetsMy Datasets  and drag the ProductsTableCSVProductsTableCSV

on to the Experiment CanvasExperiment Canvas .

4. In the panel on the left, expand Data TransformationData Transformation > Sample and SplitSample and Split. Then drag the Split DataSplit Data

item in to the Experiment CanvasExperiment Canvas . The Split Data item will split the data set into two parts. One part you

will use for training the machine learning algorithm. The second part will be used to evaluate the

accuracy of the algorithm generated.



5. In the right panel (while the Split Data item on the canvas is selected), edit the Fraction of rows in theFraction of rows in the

first output datasetfirst output dataset to 0.70.7 . This will split the data into two parts, the first part will be 70% of the data,

and the second part will be the remaining 30%. To ensure that the data is split randomly, make sure the

Randomized splitRandomized split checkbox remains checked.

6. Drag a connection from the base of the ProductsTableCSVProductsTableCSV item on the canvas to the top of the Split

Data item. This will connect the items and send the ProductsTableCSVProductsTableCSV dataset output (the data) to the

Split Data input.

7. In the ExperimentsExperiments  panel on the left side, expand Machine LearningMachine Learning > TrainTrain . Drag the Train ModelTrain Model

item out in to the Experiment canvas. Your canvas should look the same as the below.



8. From the bottom leftbottom left of the Split DataSplit Data item drag a connection to the top r ighttop r ight of the Train ModelTrain Model

item. The first 70% split from the dataset will be used by the Train Model to train the algorithm.

9. Select the Train ModelTrain Model  item on the canvas, and in the Proper tiesProper ties  panel (on the right-hand side of your

browser window) click the Launch column selectorLaunch column selector  button.

10. In the text box type productproduct and then press EnterEnter , product will be set as a column to train predictions.

Following this, click on the ticktick  in the bottom-right corner to close the selection dialog.



11. You are going to train a Multiclass Logistic RegressionMulticlass Logistic Regression algorithm to predict the most sold productproduct

based on the hour of the day and the date. It is beyond the scope of this document to explain the details

of the different algorithms provided by the Azure Machine Learning studio, though, you can find out

more from the Machine Learning Algorithm Cheat Sheet

12. From the experiment items panel on the left, expand Machine LearningMachine Learning > Initialize ModelInitialize Model  >

ClassificationClassification, and drag the Multiclass Logistic RegressionMulticlass Logistic Regression item on to the experiment canvas.

13. Connect the output, from the bottom of the Multiclass Logistic RegressionMulticlass Logistic Regression, to the top-left input of the

Train ModelTrain Model  item.

14. In list of experiment items in the panel on the left, expand Machine LearningMachine Learning > ScoreScore, and drag the

Score ModelScore Model  item on to the canvas.

15. Connect the output, from the bottom of the Train ModelTrain Model , to the top-left input of the Score ModelScore Model .

16. Connect the bottom-right output from Split DataSplit Data, to the top-right input of the Score ModelScore Model  item.

https://docs.microsoft.com/en-us/azure/machine-learning/studio/algorithm-cheat-sheet


17. In the list of ExperimentExperiment items in the panel on the left, expand Machine LearningMachine Learning > EvaluateEvaluate, and

drag the Evaluate ModelEvaluate Model  item onto the canvas.

18. Connect the output from the Score ModelScore Model  to the top-left input of the Evaluate ModelEvaluate Model .

19. You have built your first Machine Learning Experiment. You can now save and run the experiment. In the

menu at the bottom of the page, click on the SaveSave button to save your experiment and then click RunRun to

the start the experiment.

20. You can see the statusstatus  of the experiment in the top-right of the canvas. Wait a few moments for the

experiment to finish.

If you have a big (real world) dataset it is likely that the experiment could take hours to run.



21. Right click on the Evaluate ModelEvaluate Model  item in the canvas and from the context menu hover the mouse over

Evaluation ResultsEvaluation Results , then select VisualizeVisualize.

22. The evaluation results will be displayed showing the predicted outcomes versus the actual outcomes. This

uses the 30% of the original dataset, that was split earlier, for evaluating the model. You can see the

results are not great, ideally you would have the highest number in each row be the highlighted item in

the columns.



23. Close the ResultsResults .

24. To use your newly trained Machine Learning model you need to expose it as a Web Ser viceWeb Ser vice. To do this,

click on the Set Up Web Ser viceSet Up Web Ser vice menu item in the menu at the bottom of the page, and click on

Predictive Web Ser vicePredictive Web Ser vice.

25. A new tab will be created, and the train model merged to create the new web service.

26. In the menu at the bottom of the page click SaveSave, then click RunRun. You will see the status updated in the

top-right corner of the experiment canvas.

27. Once it has finished running, a Deploy Web Ser viceDeploy Web Ser vice button will appear at the bottom of the page. You

are ready to deploy the web service. Click Deploy Web Ser viceDeploy Web Ser vice (Classic) in the menu at the bottom of

the page.



NOTENOTE

Your browser may prompt to allow a pop-up, which you should allowallow , though you may need to press

Deploy Web Ser viceDeploy Web Ser vice again, if the deploy page does not show.

28. Once the Experiment has been created you will be redirected to a DashboardDashboard page where you will have

your API KeyAPI Key  displayed. Copy it into a notepad for the moment, you will need it in your code very soon.

Once you have noted your API Key, click on the REQUEST/RESPONSEREQUEST/RESPONSE button in the Default EndpointDefault Endpoint

section underneath the Key.

If you click Test in this page, you will be able to enter input data and view the output. Enter the dayday and hourhour .

Leave the productproduct  entry blank. Then click the ConfirmConfirm button. The output on the bottom of the page will show

the JSON representing the likelihood of each product being the choice.

29. A new web page will open up, displaying the instructions and some examples about the Request structure

required by the Machine Learning Studio (classic). Copy the Request URIRequest URI displayed in this page, into

your notepad.
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NOTENOTE

You have now built a machine learning system that provides the most likely product to be sold based on

historical purchasing data, correlated with the time of the day and day of the year.

To call the web service, you will need the URL for the service endpoint and an API Key for the service. Click on

the ConsumeConsume tab, from the top menu.

The ConsumptionConsumption Info page will display the information you will need to call the web service from your code.

Take a copy of the Pr imar y KeyPrimar y Key  and the Request-ResponseRequest-Response URL. You will need these in the next Chapter.

Set up and test your Mixed Reality Immersive Headset.

You will notnot  require Motion Controllers for this course. If you need support setting up the Immersive Headset, please click

HERE.

1. Open UnityUnity  and create a new Unity Project called MR_MachineLearning.MR_MachineLearning. Make sure the project type is

set to 3D3D.

2. With Unity open, it is worth checking the default Scr ipt EditorScr ipt Editor  is set to Visual StudioVisual Studio. Go to EditEdit >

PreferencesPreferences  and then from the new window, navigate to External ToolsExternal Tools . Change External Scr iptExternal Scr ipt

EditorEditor  to Visual Studio 2017Visual Studio 2017 . Close the PreferencesPreferences  window.

3. Next, go to FileFile > Build SettingsBuild Settings  and switch the platform to Universal Windows PlatformUniversal Windows Platform , by

clicking on the Switch PlatformSwitch Platform button.

4. Also make sure that:

a. Target DeviceTarget Device is set to Any DeviceAny Device.

For the Microsoft HoloLens, set Target DeviceTarget Device to HoloLens.

https://support.microsoft.com/help/4043101/windows-10-set-up-windows-mixed-reality


b. Build TypeBuild Type is set to D3DD3D.

c. SDKSDK is set to Latest installedLatest installed.

d. Visual Studio VersionVisual Studio Version is set to Latest installedLatest installed.

e. Build and RunBuild and Run is set to Local MachineLocal Machine.

f. Do not worry about setting up ScenesScenes  right now, as these are provided later.

g. The remaining settings should be left as default for now.

5. In the Build SettingsBuild Settings  window, click on the Player SettingsPlayer Settings  button, this will open the related panel in

the space where the InspectorInspector  is located.

6. In this panel, a few settings need to be verified:

a. In the Other SettingsOther Settings  tab:

a. Scr iptingScr ipting Runtime VersionRuntime Version should be ExperimentalExperimental  (.NET 4.6 Equivalent)

b. Scr ipting BackendScripting Backend should be .NET.NET

c. API Compatibility LevelAPI Compatibility Level  should be .NET 4.6.NET 4.6
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b. Within the Publishing SettingsPublishing Settings  tab, under CapabilitiesCapabilities , check:

InternetClientInternetClient

c. Further down the panel, in XR SettingsXR Settings  (found below Publish SettingsPublish Settings ), tick Vir tual RealityVir tual Reality

Suppor tedSuppor ted, make sure the Windows Mixed Reality SDKWindows Mixed Reality SDK is added

7. Back in Build SettingsBuild Settings  Unity C# Projects is no longer greyed out; tick the checkbox next to this.

8. Close the Build Settings window.

9. Save your Project (FILE > SAVE PROJECTFILE > SAVE PROJECT).

For this course, you will need to download a Unity Asset Package called Azure-MR-307.unitypackageAzure-MR-307.unitypackage. This

package comes complete with a scene, with all objects in that prebuilt, so you can focus on getting it all working.

The ShelfKeeperShelfKeeper  script is provided, though only holds the public variables, for the purpose of scene setup

structure. You will need to do all other sections.

To import this package:

https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20307%20-%20Machine%20learning/307-Scene-Setup.unitypackage


1. With the Unity dashboard in front of you, click on AssetsAssets  in the menu at the top of the screen, then click

on Impor t Package, Custom PackageImpor t Package, Custom Package.

2. Use the file picker to select the Azure-MR-307.unitypackageAzure-MR-307.unitypackage package and click OpenOpen.

3. A list of components for this asset will be displayed to you. Confirm the import by clicking Impor tImpor t.

4. Once it has finished importing, you will notice that some new folders have appeared in your Unity

Project PanelProject Panel . Those are the 3D models and the respective materials that are part of the pre-made scene

you will work on. You will write the majority of the code in this course.
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5. Within the Project PanelProject Panel  folder, click on the ScenesScenes  folder and double click on the scene inside (called

MR_MachineLearningSceneMR_MachineLearningScene). The scene will open (see image below). If the red diamonds are missing,

simply click the GizmosGizmos button, at the top right of the Game PanelGame Panel .

To leverage the use of JSON libraries (used for serializing and deserializing), a Newtonsoft DLL has been

implemented with the package you brought in. The library should have the correct configuration, though it is

worth checking (particularly if you are having issues with code not working).

To do so:

Left-click on the Newtonsoft file inside the Plugins folder and look at the Inspector panelInspector panel . Make sure

Any PlatformAny Platform is ticked. Go to the UWP tabUWP tab and also ensure Don't processDon't process  is ticked.



 Chapter 8 - Create the ShelfKeeper class
The ShelfKeeperShelfKeeper  class hosts methods that control the UI and products spawned in the scene.

As part of the imported package, you will have been given this class, though it is incomplete. It is now time to

complete that class:

1. Double click on the ShelfKeeperShelfKeeper  script, within the Scr iptsScr ipts  folder, to open it with Visual Studio 2017Visual Studio 2017 .

2. Replace all the code existing in the script with the following code, which sets the time and date and has a

method to show a product.



using UnityEngine;

public class ShelfKeeper : MonoBehaviour
{
    /// <summary>
    /// Provides this class Singleton-like behavior
    /// </summary>
    public static ShelfKeeper instance;

    /// <summary>
    /// Unity Inspector accessible Reference to the Text Mesh object needed for data
    /// </summary>
    public TextMesh dateText;

    /// <summary>
    /// Unity Inspector accessible Reference to the Text Mesh object needed for time
    /// </summary>
    public TextMesh timeText;

    /// <summary>
    /// Provides references to the spawn locations for the products prefabs
    /// </summary>
    public Transform[] spawnPoint;

    private void Awake()
    {
        instance = this;
    }

    /// <summary>
    /// Set the text of the date in the scene
    /// </summary>
    public void SetDate(string day, string month)
    {
        dateText.text = day + " " + month;
    }

    /// <summary>
    /// Set the text of the time in the scene
    /// </summary>
    public void SetTime(string hour)
    {
        timeText.text = hour + ":00";
    }

    /// <summary>
    /// Spawn a product on the shelf by providing the name and selling grade
    /// </summary>
    /// <param name="name"></param>
    /// <param name="sellingGrade">0 being the best seller</param>
    public void SpawnProduct(string name, int sellingGrade)
    {
        Instantiate(Resources.Load(name),
            spawnPoint[sellingGrade].transform.position, 
spawnPoint[sellingGrade].transform.rotation);
    }
}

3. Be sure to save your changes in Visual StudioVisual Studio before returning to UnityUnity .

4. Back in the Unity Editor, check that the ShelfKeeperShelfKeeper  class looks like the below:



 Chapter 9 - Create the ProductPrediction class

IMPORTANTIMPORTANT
If your script does not have the reference targets (i.e. Date (Text Mesh)), simply drag the corresponding objects

from the Hierarchy PanelHierarchy Panel, into the target fields. See below for explanation, if needed:

1. Open the Spawn PointSpawn Point  array within the ShelfKeeperShelfKeeper  component script by left-clicking it. A sub-section

will appear called SizeSize, which indicates the size of the array. Type 33  into the textbox next to SizeSize and press

EnterEnter , and three slots will be created beneath.

2. Within the HierarchyHierarchy  expand the Time DisplayTime Display  object (by left-clicking the arrow beside it). Next click the

Main CameraMain Camera from within the HierarchyHierarchy , so that the InspectorInspector  shows its information.

3. Select the Main CameraMain Camera in the Hierarchy PanelHierarchy Panel. Drag the DateDate and TimeTime objects from the HierarchyHierarchy

PanelPanel to the Date TextDate Text  and Time TextTime Text  slots within the InspectorInspector  of the Main CameraMain Camera in the

ShelfKeeperShelfKeeper  component.

4. Drag the Spawn PointsSpawn Points  from the Hierarchy PanelHierarchy Panel (beneath the Shelf object) to the 33  ElementElement

reference targets beneath the Spawn PointSpawn Point  array, as shown in the image.

The next class you are going to create is the ProductPredictionProductPrediction class.

This class is responsible for :

Querying the Machine Learning Ser viceMachine Learning Ser vice instance, providing the current date and time.

Deserializing the JSON response into usable data.

Interpreting the data, retrieving the 3 recommended products.

Calling the ShelfKeeperShelfKeeper  class methods to display the data in the Scene.

To create this class:

1. Go to the Scr iptsScr ipts  folder, in the Project PanelProject Panel .

2. Right-click inside the folder, CreateCreate > C# Scr iptC# Scr ipt. Call the script ProductPredictionProductPrediction.

3. Double click on the new ProductPredictionProductPrediction script to open it with Visual Studio 2017Visual Studio 2017 .

4. If the File Modification DetectedFile Modification Detected dialog pops up, click *Reload SolutionReload Solution.



using System;
using System.Collections.Generic;
using UnityEngine;
using System.Linq;
using Newtonsoft.Json;
using UnityEngine.Networking;
using System.Runtime.Serialization;
using System.Collections;

    /// <summary>
    /// This object represents the Prediction request
    /// It host the day of the year and hour of the day
    /// The product must be left blank when serialising
    /// </summary>
    public class RootObject
    {
        public Inputs Inputs { get; set; }
    }

    public class Inputs
    {
        public Input1 input1 { get; set; }
    }

    public class Input1
    {
        public List<string> ColumnNames { get; set; }
        public List<List<string>> Values { get; set; }
    }

    /// <summary>
    /// This object containing the deserialised Prediction result
    /// It host the list of the products
    /// and the likelihood of them being sold at current date and time
    /// </summary>
    public class Prediction
    {
        public Results Results { get; set; }
    }

    public class Results
    {
        public Output1 output1;
    }

    public class Output1
    {
        public string type;
        public Value value;
    }

    public class Value
    {
        public List<string> ColumnNames { get; set; }
        public List<List<string>> Values { get; set; }
    }

5. Add the following namespaces to the top of the ProductPrediction class:

6. Inside the ProductPredictionProductPrediction class insert the following two objects which are composed of a number of

nested classes. These classes are used to serialize and deserialize the JSON for the Machine Learning

Service.



    /// <summary>
    /// The 'Primary Key' from your Machine Learning Portal
    /// </summary>
    private string authKey = "-- Insert your service authentication key here --";

    /// <summary>
    /// The 'Request-Response' Service Endpoint from your Machine Learning Portal
    /// </summary>
    private string serviceEndpoint = "-- Insert your service endpoint here --";

    /// <summary>
    /// The Hour as set in Windows
    /// </summary>
    private string thisHour;

    /// <summary>
    /// The Day, as set in Windows
    /// </summary>
    private string thisDay;

    /// <summary>
    /// The Month, as set in Windows
    /// </summary>
    private string thisMonth;

    /// <summary>
    /// The Numeric Day from current Date Conversion
    /// </summary>
    private string dayOfTheYear;

    /// <summary>
    /// Dictionary for holding the first (or default) provided prediction 
    /// from the Machine Learning Experiment
    /// </summary>    
    private Dictionary<string, string> predictionDictionary;

    /// <summary>
    /// List for holding product prediction with name and scores
    /// </summary>
    private List<KeyValuePair<string, double>> keyValueList;

7. Then add the following variables above the previous code (so that the JSON related code is at the bottom

of the script, below all other code, and out of the way):



IMPORTANTIMPORTANT

    void Start()
    {
        // Call to get the current date and time as set in Windows
        GetTodayDateAndTime();

        // Call to set the HOUR in the UI
        ShelfKeeper.instance.SetTime(thisHour);

        // Call to set the DATE in the UI
        ShelfKeeper.instance.SetDate(thisDay, thisMonth);

        // Run the method to Get Predication from Azure Machine Learning
        StartCoroutine(GetPrediction(thisHour, dayOfTheYear));
    }

Make sure to insert the primar y keyprimar y key  and request-response endpointrequest-response endpoint , from the Machine Learning Portal, into

the variables here. The below images show where you would have taken the key and endpoint from.

8. Insert this code within the Star t()Star t()  method. The Star t()Star t()  method is called when the class initializes:

9. The following is the method that collects the date and time from Windows and converts it into a format

that our Machine Learning Experiment can use to compare with the data stored in the table.



    /// <summary>
    /// Get current date and hour
    /// </summary>
    private void GetTodayDateAndTime()
    {
        // Get today date and time
        DateTime todayDate = DateTime.Now;

        // Extrapolate the HOUR
        thisHour = todayDate.Hour.ToString();

        // Extrapolate the DATE
        thisDay = todayDate.Day.ToString();
        thisMonth = todayDate.ToString("MMM");

        // Extrapolate the day of the year
        dayOfTheYear = todayDate.DayOfYear.ToString();
    }

10. You can deletedelete the Update()Update()  method since this class will not use it.

11. Add the following method which will communicate the current date and time to the Machine Learning

endpoint and receive a response in JSON format.



    private IEnumerator GetPrediction(string timeOfDay, string dayOfYear)
    {
        // Populate the request object 
        // Using current day of the year and hour of the day
        RootObject ro = new RootObject
        {
            Inputs = new Inputs
            {
                input1 = new Input1
                {
                    ColumnNames = new List<string>
                    {
                        "day",
                        "hour",
                    "product"
                    },
                    Values = new List<List<string>>()
                }
            }
        };

        List<string> l = new List<string>
        {
            dayOfYear,
            timeOfDay,
            ""
        };

        ro.Inputs.input1.Values.Add(l);

        Debug.LogFormat("Score request built");

        // Serialize the request
        string json = JsonConvert.SerializeObject(ro);

        using (UnityWebRequest www = UnityWebRequest.Post(serviceEndpoint, "POST"))
        {
            byte[] jsonToSend = new System.Text.UTF8Encoding().GetBytes(json);
            www.uploadHandler = new UploadHandlerRaw(jsonToSend);

            www.downloadHandler = new DownloadHandlerBuffer();
            www.SetRequestHeader("Authorization", "Bearer " + authKey);
            www.SetRequestHeader("Content-Type", "application/json");
            www.SetRequestHeader("Accept", "application/json");

            yield return www.SendWebRequest();
            string response = www.downloadHandler.text;

            // Deserialize the response
            DataContractSerializer serializer;
            serializer = new DataContractSerializer(typeof(string));
            DeserialiseJsonResponse(response);
        }
    }

12. Add the following method, which is responsible for deserializing the JSON response, and communicating

the result of the deserialization to the ShelfKeeperShelfKeeper  class. This result will be the names of the three items

predicted to sell the most at current date and time. Insert the code below into the ProductPredictionProductPrediction

class, below the previous method.
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    /// <summary>
    /// Deserialize the response received from the Machine Learning portal
    /// </summary>
    public void DeserialiseJsonResponse(string jsonResponse)
    {
        // Deserialize JSON
        Prediction prediction = JsonConvert.DeserializeObject<Prediction>(jsonResponse);
        predictionDictionary = new Dictionary<string, string>();

        for (int i = 0; i < prediction.Results.output1.value.ColumnNames.Count; i++)
        {
            if (prediction.Results.output1.value.Values[0][i] != null)
            {
                predictionDictionary.Add(prediction.Results.output1.value.ColumnNames[i], 
prediction.Results.output1.value.Values[0][i]);
            }
        }

        keyValueList = new List<KeyValuePair<string, double>>();

        // Strip all non-results, by adding only items of interest to the scoreList
        for (int i = 0; i < predictionDictionary.Count; i++)
        {
            KeyValuePair<string, string> pair = predictionDictionary.ElementAt(i);
            if (pair.Key.StartsWith("Scored Probabilities"))
            {
                // Parse string as double then simplify the string key so to only have the item name
                double scorefloat = 0f;
                double.TryParse(pair.Value, out scorefloat);
                string simplifiedName =
                    pair.Key.Replace("\"", "").Replace("Scored Probabilities for Class", "").Trim();
                keyValueList.Add(new KeyValuePair<string, double>(simplifiedName, scorefloat));
            }
        }

        // Sort Predictions (results will be lowest to highest)
        keyValueList.Sort((x, y) => y.Value.CompareTo(x.Value));

        // Spawn the top three items, from the keyValueList, which we have sorted
        for (int i = 0; i < 3; i++)
        {
            ShelfKeeper.instance.SpawnProduct(keyValueList[i].Key, i);
        }

        // Clear lists in case of reuse
        keyValueList.Clear();
        predictionDictionary.Clear();
    }

13. Save Visual StudioVisual Studio and head back to UnityUnity .

14. Drag the ProductPredictionProductPrediction class script from the Scr iptScr ipt folder, onto the Main CameraMain Camera object.

15. Save your scene and project FileFile > Save Scene/FileSave Scene/File > Save ProjectSave Project.

It is now time to build your project as a UWP solution, so that it can run as a standalone application.

To Build:

1. Save the current scene by clicking on FileFile > Save ScenesSave Scenes .

2. Go to FileFile > Build SettingsBuild Settings



3. Check the box called Unity C# ProjectsUnity C# Projects  (this is important because it will allow you to edit the classes

after build is completed).

4. Click on Add Open ScenesAdd Open Scenes ,

5. Click BuildBuild.

6. You will be prompted to select the folder where you want to build the Solution.

7. Create a BUILDSBUILDS  folder and within that folder create another folder with an appropriate name of your

choice.

8. Click your new folder and then click Select FolderSelect Folder , to begin the build at that location.
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9. Once Unity has finished building (it might take some time), it will open a File ExplorerFile Explorer  window at the

location of your build (check your task bar, as it may not always appear above your windows, but will

notify you of the addition of a new window).

To deploy your application:

1. Navigate to your new Unity build (the AppApp folder) and open the solution file with Visual StudioVisual Studio.

2. With Visual Studio open, you need to Restore NuGet Packages, which can be done through right-clicking

your MachineLearningLab_Build solution, from the Solution Explorer (found to the right of Visual Studio),

and then clicking Restore NuGet Packages:



 Your finished Machine Learning application

3. In the Solution Configuration select DebugDebug.

4. In the Solution Platform, select x86x86 , Local MachineLocal Machine.

For the Microsoft HoloLens, you may find it easier to set this to Remote Machine, so that you are not

tethered to your computer. Though, you will need to also do the following:

Know the IP AddressIP Address  of your HoloLens, which can be found within the Settings > Network &

Internet > Wi-Fi > Advanced Options; the IPv4 is the address you should use.

Ensure Developer ModeDeveloper Mode is OnOn; found in Settings > Update & Security > For developers.

5. Go to Build menuBuild menu and click on Deploy SolutionDeploy Solution to sideload the application to your PC.

6. Your App should now appear in the list of installed apps, ready to be launched.

When you run the Mixed Reality application, you will see the bench that was set up in your Unity scene, and

from initialization, the data you set up within Azure will be fetched. The data will be deserialized within your

application, and the three top results for your current date and time will be provided visually, as three models on

the bench.

Congratulations, you built a mixed reality app that leverages the Azure Machine Learning to make data

predictions and display it on your scene.



 Exercise
Exercise 1Exercise 1

Experiment with the sort order of your application and have the three bottom predictions appear on the shelf, as

this data would potentially be useful also.

Exercise 2Exercise 2

Using Azure TablesAzure Tables  populate a new table with weather information and create a new experiment using the

data.
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NOTENOTE
The Mixed Reality Academy tutorials were designed with HoloLens (1st gen) and Mixed Reality Immersive Headsets in

mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for guidance in

developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being used for

HoloLens 2. They will be maintained to continue working on the supported devices. There will be a new series of tutorials

that will be posted in the future that will demonstrate how to develop for HoloLens 2. This notice will be updated with a

link to those tutorials when they are posted.

In this course, you will learn how to add Notification Hubs capabilities to a mixed reality application using Azure

Notification Hubs, Azure Tables, and Azure Functions.

Azure Notification HubsAzure Notification Hubs  is a Microsoft service, which allows developers to send targeted and personalized

push notifications to any platform, all powered within the cloud. This can effectively allow developers to

communicate with end users, or even communicate between various applications, depending on the scenario.

For more information, visit the Azure Notification HubsAzure Notification Hubs  page.

Azure FunctionsAzure Functions  is a Microsoft service, which allows developers to run small pieces of code, 'functions', in

Azure. This provides a way to delegate work to the cloud, rather than your local application, which can have

many benefits. Azure FunctionsAzure Functions  supports several development languages, including C#, F#, Node.js, Java, and

PHP. For more information, visit the Azure FunctionsAzure Functions  page.

Azure TablesAzure Tables  is a Microsoft cloud service, which allows developers to store structured non-SQL data in the

cloud, making it easily accessible anywhere. The service boasts a schemaless design, allowing for the evolution

of tables as needed, and thus is very flexible. For more information, visit the Azure TablesAzure Tables  page

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/mr-azure-308.md
https://docs.microsoft.com/en-us/azure/notification-hubs/notification-hubs-push-notification-overview
https://docs.microsoft.com/en-us/azure/azure-functions/functions-overview
https://docs.microsoft.com/en-us/azure/cosmos-db/table-storage-overview
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Having completed this course, you will have a mixed reality immersive headset application, and a Desktop PC

application, which will be able to do the following:

1. The Desktop PC app will allow the user to move an object in 2D space (X and Y), using the mouse.

2. The movement of objects within the PC app will be sent to the cloud using JSON, which will be in the

form of a string, containing an object ID, type, and transform information (X and Y coordinates).

3. The mixed reality app, which has an identical scene to the desktop app, will receive notifications regarding

object movement, from the Notification Hubs service (which has just been updated by the Desktop PC

app).

4. Upon receiving a notification, which will contain the object ID, type, and transform information, the mixed

reality app will apply the received information to its own scene.

In your application, it is up to you as to how you will integrate the results with your design. This course is

designed to teach you how to integrate an Azure Service with your Unity Project. It is your job to use the

knowledge you gain from this course to enhance your mixed reality application. This course is a self-contained

tutorial, which does not directly involve any other Mixed Reality Labs.

While this course primarily focuses on Windows Mixed Reality immersive (VR) headsets, you can also apply what you learn

in this course to Microsoft HoloLens. As you follow along with the course, you will see notes on any changes you might

need to employ to support HoloLens. When using HoloLens, you may notice some echo during voice capture.

This tutorial is designed for developers who have basic experience with Unity and C#. Please also be aware that the

prerequisites and written instructions within this document represent what has been tested and verified at the time of

writing (May 2018). You are free to use the latest software, as listed within the install the tools article, though it should

not be assumed that the information in this course will perfectly match what you'll find in newer software than what's

listed below.

We recommend the following hardware and software for this course:

A development PC, compatible with Windows Mixed Reality for immersive (VR) headset development

Windows 10 Fall Creators Update (or later) with Developer mode enabled

The latest Windows 10 SDK

Unity 2017.4

Visual Studio 2017

A Windows Mixed Reality immersive (VR) headset or Microsoft HoloLens with Developer mode enabled

Internet access for Azure setup and to access Notification Hubs

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://support.microsoft.com/help/4039260/windows-10-mixed-reality-pc-hardware-guidelines
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/hololens/hololens1-hardware


Before you start

 Chapter 1 - Create an application on the Microsoft Developer Portal

 Chapter 2 - Retrieve your new apps credentials

To avoid encountering issues building this project, it is strongly suggested that you create the project

mentioned in this tutorial in a root or near-root folder (long folder paths can cause issues at build-time).

You must be the owner of your Microsoft Developer Portal and your Application Registration Portal,

otherwise you will not have permission to access the app in Chapter 2.

To use the Azure Notification HubsAzure Notification Hubs  Service, you will need to create an Application on the Microsoft Developer

Portal, as your application will need to be registered, so that it can send and receive notifications.

1. Log in to the Microsoft Developer Portal.

You will need to log in to your Microsoft Account.

2. From the Dashboard, click Create a new appCreate a new app.

3. A popup will appear, wherein you need to reserve a name for your new app. In the textbox, insert an

appropriate name; if the chosen name is available, a tick will appear to the right of the textbox. Once you

have an available name inserted, click the Reser ve product nameReser ve product name button to the bottom left of the

popup.

4. With the app now created, you are ready to move to the next Chapter.

Log into the Application Registration Portal, where your new app will be listed, and retrieve the credentials

which will be used to setup the Notification Hubs Ser viceNotification Hubs Ser vice within the Azure Por talAzure Por tal .

1. Navigate to the Application Registration Portal.

https://developer.microsoft.com/dashboard
https://apps.dev.microsoft.com
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WARNINGWARNING
You will need to use your Microsoft Account to Login.

This mustmust  be the Microsoft Account which you used in the previous Chapter, with the Windows Store Developer

portal.

2. You will find your app under the My applicationsMy applications  section. Once you have found it, click on it and you

will be taken to a new page which has the app name plus RegistrationRegistration.

3. Scroll down the registration page to find your Application SecretsApplication Secrets  section and the Package SIDPackage SID for

your app. Copy both for use with setting up the Azure Notification Hubs Ser viceAzure Notification Hubs Ser vice in the next Chapter.

With your apps credentials retrieved, you will need to go to the Azure Portal, where you will create an Azure

Notification Hubs Service.

1. Log into the Azure Portal.

https://portal.azure.com


NOTENOTE

NOTENOTE

If you do not already have an Azure account, you will need to create one. If you are following this tutorial in a

classroom or lab situation, ask your instructor or one of the proctors for help setting up your new account.

2. Once you are logged in, click on NewNew  in the top left corner, and search for Notification HubNotification Hub, and click

EnterEnter .

The word NewNew may have been replaced with Create a resourceCreate a resource, in newer portals.

3. The new page will provide a description of the Notification Hubs service. At the bottom left of this

prompt, select the CreateCreate button, to create an association with this service.

4. Once you have clicked on CreateCreate:

a. Insert your desired name for this service instance.



b. Provide a namespacenamespace which you will be able to associate with this app.

c. Select a Location.Location.

d. Choose a Resource GroupResource Group or create a new one. A resource group provides a way to monitor,

control access, provision and manage billing for a collection of Azure assets. It is recommended to

keep all the Azure services associated with a single project (e.g. such as these labs) under a

common resource group).

If you wish to read more about Azure Resource Groups, please follow this link on how to

manage a Resource Group.

e. Select an appropriate Subscr iptionSubscr iption.

f. You will also need to confirm that you have understood the Terms and Conditions applied to this

Service.

g. Select CreateCreate.

5. Once you have clicked on CreateCreate, you will have to wait for the service to be created, this might take a

minute.

6. A notification will appear in the portal once the Service instance is created.

7. Click the Go to resourceGo to resource button in the notification to explore your new Service instance. You will be

taken to your new Notification HubNotification Hub service instance.

https://docs.microsoft.com/en-us/azure/azure-resource-manager/resource-group-portal


 Chapter 4 - Setup Azure Portal: create Table Service

8. From the overview page, halfway down the page, click Windows (WNS).Windows (WNS). The panel on the right will

change to show two text fields, which require your Package SIDPackage SID and Security KeySecurity Key , from the app you set

up previously.

9. Once you have copied the details into the correct fields, click SaveSave, and you will receive a notification

when the Notification Hub has been successfully updated.

After creating your Notification Hubs Service instance, navigate back to your Azure Portal, where you will create



an Azure Tables Service by creating a Storage Resource.

NOTENOTE

1. If not already signed in, log into the Azure Portal.

2. Once logged in, click on NewNew  in the top left corner, and search for Storage accountStorage account, and click EnterEnter .

The word NewNew may have been replaced with Create a resourceCreate a resource, in newer portals.

3. Select Storage account - blob, file, table, queueStorage account - blob, file, table, queue from the list.

4. The new page will provide a description of the Storage accountStorage account service. At the bottom left of this

prompt, select the CreateCreate button, to create an instance of this service.

5. Once you have clicked on CreateCreate, a panel will appear :

a. Insert your desired NameName for this service instance (must be all lowercase).

b. For Deployment modelDeployment model , click Resource managerResource manager .

c. For Account kindAccount kind, using the dropdown menu, select Storage (general purpose v1)Storage (general purpose v1) .

d. Select an appropriate LocationLocation.

https://portal.azure.com


e. For the ReplicationReplication dropdown menu, select Read-access-geo-redundant storage (RA-GRS)Read-access-geo-redundant storage (RA-GRS) .

f. For PerformancePerformance, click StandardStandard.

g. Within the Secure transfer requiredSecure transfer required section, select DisabledDisabled.

h. From the Subscr iptionSubscr iption dropdown menu, select an appropriate subscription.

i. Choose a Resource GroupResource Group or create a new one. A resource group provides a way to monitor,

control access, provision and manage billing for a collection of Azure assets. It is recommended to

keep all the Azure services associated with a single project (e.g. such as these labs) under a

common resource group).

If you wish to read more about Azure Resource Groups, please follow this link on how to

manage a Resource Group.

j. Leave Vir tual networksVir tual networks  as DisabledDisabled if this is an option for you.

k. Click CreateCreate.

6. Once you have clicked on CreateCreate, you will have to wait for the service to be created, this might take a

minute.

7. A notification will appear in the portal once the Service instance is created. Click on the notifications to

explore your new Service instance.

8. Click the Go to resourceGo to resource button in the notification to explore your new Service instance. You will be

taken to your new Storage Service instance overview page.

https://docs.microsoft.com/en-us/azure/azure-resource-manager/resource-group-portal


9. From the overview page, to the right-hand side, click TablesTables .

10. The panel on the right will change to show the Table ser viceTable ser vice information, wherein you need to add a

new table. Do this by clicking the ++ TableTable button to the top-left corner.

11. A new page will be shown, wherein you need to enter a Table nameTable name. This is the name you will use to

refer to the data in your application in later Chapters. Insert an appropriate name and click OKOK.
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12. Once the new table has been created, you will be able to see it within the Table ser viceTable ser vice page (at the

bottom).

Now that your Table ser viceTable ser vice storage account has been setup, it is time to add data to it, which will be used to

store and retrieve information. The editing of your Tables can be done through Visual StudioVisual Studio.

1. Open Visual StudioVisual Studio.

2. From the menu, click ViewView  > Cloud ExplorerCloud Explorer .

3. The Cloud ExplorerCloud Explorer  will open as a docked item (be patient, as loading may take time).



NOTENOTE
If the Subscription you used to create your Storage Accounts is not visible, ensure that you have:

Logged in to the same account as the one you used for the Azure Portal.

Selected your Subscription from the Account Management Page (you may need to apply a filter from your

account settings):

4. Your Azure cloud services will be shown. Find Storage AccountsStorage Accounts  and click the arrow to the left of that to

expand your accounts.

5. Once expanded, your newly created Storage accountStorage account should be available. Click the arrow to the left of

your storage, and then once that is expanded, find TablesTables  and click the arrow next to that, to reveal the

TableTable you created in the last Chapter. Double click your TableTable.

6. Your table will be opened in the center of your Visual Studio window. Click the table icon with the ++ (plus)

on it.



WARNINGWARNING

7. A window will appear prompting for you to Add Entity. You will create three entities in total, each with

several properties. You will notice that PartitionKey and RowKey are already provided, as these are used

by the table to find your data.

8. Update the Value of the Par titionKeyPar titionKey  and RowKeyRowKey  as follows (remember to do this for each row

property you add, though increment the RowKey each time):

9. Click Add proper tyAdd proper ty  to add extra rows of data. Make your first empty table match the below table.

10. Click OKOK when you are finished.

Ensure that you have changed the TypeType of the XX, YY , and ZZ, entries to DoubleDouble.
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11. You will notice your table now has a row of data. Click the ++ (plus) icon again to add another entity.

12. Create an additional property, and then set the values of the new entity to match those shown below.

13. Repeat the last step to add another entity. Set the values for this entity to those shown below.

14. Your table should now look like the one below.

15. You have completed this Chapter. Make sure to save.

Create an Azure Function App, which will be called by the Desktop application to update the TableTable service and

send a notification through the Notification HubNotification Hub.

First, you need to create a file that will allow your Azure Function to load the libraries you need.

1. Open NotepadNotepad (press Windows Key and type notepad).



{
"frameworks": {
    "net46":{
    "dependencies": {
        "WindowsAzure.Storage": "7.0.0",
        "Microsoft.Azure.NotificationHubs" : "1.0.9",
        "Microsoft.Azure.WebJobs.Extensions.NotificationHubs" :"1.1.0"
    }
    }
}
}

NOTENOTE

2. With Notepad open, insert the JSON structure below into it. Once you have done that, save it on your

desktop as project.jsonproject.json. It is important that the naming is correct: ensure it does NOT have a .txtNOT have a .txt file

extension. This file defines the libraries your function will use, if you have used NuGet it will look familiar.

3. Log in to the Azure Portal.

4. Once you are logged in, click on NewNew  in the top left corner, and search for Function AppFunction App, press EnterEnter .

The word NewNew may have been replaced with Create a resourceCreate a resource, in newer portals.

5. The new page will provide a description of the Function AppFunction App service. At the bottom left of this prompt,

select the CreateCreate button, to create an association with this service.

https://portal.azure.com


6. Once you have clicked on CreateCreate, fill in the following:

a. For App nameApp name, insert your desired name for this service instance.

b. Select a Subscr iptionSubscr iption.

c. Select the pricing tier appropriate for you, if this is the first time creating a Function AppFunction App

Ser viceSer vice, a free tier should be available to you.

d. Choose a Resource GroupResource Group or create a new one. A resource group provides a way to monitor,

control access, provision and manage billing for a collection of Azure assets. It is recommended to

keep all the Azure services associated with a single project (e.g. such as these labs) under a

common resource group).

If you wish to read more about Azure Resource Groups, please follow this link on how to

manage a Resource Group.

e. For OSOS , click Windows, as that is the intended platform.

f. Select a Hosting PlanHosting Plan (this tutorial is using a Consumption PlanConsumption Plan.

g. Select a LocationLocation (choose the same location as the storage you have built in the(choose the same location as the storage you have built in the

previous step)previous step)

h. For the StorageStorage section, you must select the Storage Ser vice you created in the previousyou must select the Storage Ser vice you created in the previous

stepstep.

i. You will not need Application Insights in this app, so feel free to leave it OffOff .

j. Click CreateCreate.

https://docs.microsoft.com/en-us/azure/azure-resource-manager/resource-group-portal


7. Once you have clicked on CreateCreate you will have to wait for the service to be created, this might take a

minute.

8. A notification will appear in the portal once the Service instance is created.

9. Click on the notifications to explore your new Service instance.

10. Click the Go to resourceGo to resource button in the notification to explore your new Service instance.

11. Click the ++ (plus) icon next to Functions, to Create new.



12. Within the central panel, the FunctionFunction creation window will appear. Ignore the information in the upper

half of the panel, and click Custom functionCustom function, which is located near the bottom (in the blue area, as

below).

13. The new page within the window will show various function types. Scroll down to view the purple types,

and click HTTP PUTHTTP PUT element.



IMPORTANTIMPORTANT
You may have to scroll further the down the page (and this image may not look exactly the same, if Azure Portal

updates have taken place), however, you are looking for an element called HTTP PUT.

14. The HTTP PUTHTTP PUT window will appear, where you need to configure the function (see below for image).

a. For Language,Language, using the dropdown menu, select C#.

b. For Name,Name, input an appropriate name.

c. In the Authentication levelAuthentication level  dropdown menu, select FunctionFunction.

d. For the Table nameTable name section, you need to use the exact name you used to create your TableTable

service previously (including the same letter case).

e. Within the Storage account connectionStorage account connection section, use the dropdown menu, and select your

storage account from there. If it is not there, click the NewNew  hyperlink alongside the section title, to

show another panel, where your storage account should be listed.

15. Click CreateCreate and you will receive a notification that your settings have been updated successfully.



16. After clicking CreateCreate, you will be redirected to the function editor.

17. Insert the following code into the function editor (replacing the code in the function):



#r "Microsoft.WindowsAzure.Storage"

using System;
using Microsoft.WindowsAzure.Storage;
using Microsoft.WindowsAzure.Storage.Table;
using Microsoft.Azure.NotificationHubs;
using Newtonsoft.Json;

public static async Task Run(UnityGameObject gameObj, CloudTable table, IAsyncCollector<Notification> 
notification, TraceWriter log)
{
    //RowKey of the table object to be changed
    string rowKey = gameObj.RowKey;

    //Retrieve the table object by its RowKey
    TableOperation operation = TableOperation.Retrieve<UnityGameObject>("UnityPartitionKey", rowKey);  

    TableResult result = table.Execute(operation);

    //Create a UnityGameObject so to set its parameters
    UnityGameObject existingGameObj = (UnityGameObject)result.Result; 

    existingGameObj.RowKey = rowKey;
    existingGameObj.X = gameObj.X;
    existingGameObj.Y = gameObj.Y;
    existingGameObj.Z = gameObj.Z;

    //Replace the table appropriate table Entity with the value of the UnityGameObject
    operation = TableOperation.Replace(existingGameObj); 

    table.Execute(operation);

    log.Verbose($"Updated object position");

    //Serialize the UnityGameObject
    string wnsNotificationPayload = JsonConvert.SerializeObject(existingGameObj);

    log.Info($"{wnsNotificationPayload}");

    var headers = new Dictionary<string, string>();

    headers["X-WNS-Type"] = @"wns/raw";

    //Send the raw notification to subscribed devices
    await notification.AddAsync(new WindowsNotification(wnsNotificationPayload, headers)); 

    log.Verbose($"Sent notification");
}

// This UnityGameObject represent a Table Entity
public class UnityGameObject : TableEntity
{
    public string Type { get; set; }
    public double X { get; set; }
    public double Y { get; set; }
    public double Z { get; set; }
    public string RowKey { get; set; }
}



NOTENOTE
Using the included libraries, the function receives the name and location of the object which was moved in the

Unity scene (as a C# object, called UnityGameObjectUnityGameObject ). This object is then used to update the object parameters

within the created table. Following this, the function makes a call to your created Notification Hub service, which

notifies all subscribed applications.

18. With the code in place, click SaveSave.

19. Next, click the << (arrow) icon, on the right-hand side of the page.

20. A panel will slide in from the right. In that panel, click UploadUpload, and a File Browser will appear.

21. Navigate to, and click, the project.jsonproject.json file, which you created in NotepadNotepad previously, and then click the

OpenOpen button. This file defines the libraries that your function will use.

22. When the file has uploaded, it will appear in the panel on the right. Clicking it will open it within the

FunctionFunction editor. It must look exactlyexactly  the same as the next image (below step 23).

23. Then, in the panel on the left, beneath FunctionsFunctions , click the IntegrateIntegrate link.



{
"bindings": [
    {
    "authLevel": "function",
    "type": "httpTrigger",
    "methods": [
        "get",
        "post"
    ],
    "name": "gameObj",
    "direction": "in"
    },
    {
    "type": "table",
    "name": "table",
    "tableName": "SceneObjectsTable",
    "connection": "mrnothubstorage_STORAGE",
    "direction": "in"
    },
    {
    "type": "notificationHub",
    "direction": "out",
    "name": "notification",
    "hubName": "MR_NotHub_ServiceInstance",
    "connection": "MRNotHubNS_DefaultFullSharedAccessSignature_NH",
    "platform": "wns"
    }
]
}

24. On the next page, in the top right corner, click Advanced editorAdvanced editor  (as below).

25. A function.jsonfunction.json file will be opened in the center panel, which needs to be replaced with the following

code snippet. This defines the function you are building and the parameters passed into the function.

26. Your editor should now look like the image below:



27. You may notice the input parameters that you have just inserted might not match your table and storage

details and therefore will need to be updated with your information. Do not do this hereDo not do this here, as it is

covered next. Simply click the Standard editorStandard editor  link, in the top-right corner of the page, to go back.

28. Back in the Standard editorStandard editor , click Azure Table Storage (table)Azure Table Storage (table) , under InputsInputs .

29. Ensure the following match to youryour  information, as they may be different (there is an image below the

following steps):

a. Table nameTable name: the name of the table you created within your Azure Storage, Tables service.

b. Storage account connection:Storage account connection: click newnew , which appears alongside the dropdown menu, and a

panel will appear to the right of the window.



a. Select your Storage AccountStorage Account, which you created previously to host the Function Apps.Function Apps.

b. You will notice that the Storage AccountStorage Account connection value has been created.

c. Make sure to press SaveSave once you are done.

c. The InputsInputs  page should now match the below, showing youryour  information.

30. Next, click Azure Notification Hub (notification)Azure Notification Hub (notification)  - under OutputsOutputs . Ensure the following are matched

to youryour  information, as they may be different (there is an image below the following steps):

a. Notification Hub NameNotification Hub Name: this is the name of your Notification HubNotification Hub service instance, which you

created previously.

b. Notification Hubs namespace connectionNotification Hubs namespace connection: click newnew , which appears alongside the dropdown

menu.



WARNINGWARNING

c. The ConnectionConnection popup will appear (see image below), where you need to select the NamespaceNamespace

of the Notification HubNotification Hub, which you set up previously.

d. Select your Notification HubNotification Hub name from the middle dropdown menu.

e. Set the PolicyPolicy  dropdown menu to DefaultFullSharedAccessSignatureDefaultFullSharedAccessSignature.

f. Click the SelectSelect button to go back.

31. The OutputsOutputs  page should now match the below, but with youryour  information instead. Make sure to press

SaveSave.

Do not edit the Notification Hub name directly (this should all be done using the Advanced EditorAdvanced Editor , provided you

followed the previous steps correctly.



32. At this point, you should test the function, to ensure it is working. To do this:

{  
    "Type":null,
    "X":3,
    "Y":0,
    "Z":1,
    "PartitionKey":null,
    "RowKey":"Obj2",
    "Timestamp":"0001-01-01T00:00:00+00:00",
    "ETag":null
}

a. Navigate to the function page once more:

b. Back on the function page, click the TestTest tab on the far right side of the page, to open the Test

blade:

c. Within the Request bodyRequest body  textbox of the blade, paste the below code:

d. With the test code in place, click the RunRun button at the bottom right, and the test will be run. The

output logs of the test will appear in the console area, below your function code.
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IMPORTANTIMPORTANT

NOTENOTE

WARNINGWARNING
If the above test fails, you will need to double check that you have followed the above steps exactly, particularly

the settings within the integrate panelintegrate panel.

The Desktop application which you are now creating, will notwill not  work in the Unity Editor. It needs to be run outside of the

Editor, following the Building of the application, using Visual Studio (or the deployed application).

The following is a typical set up for developing with Unity and mixed reality, and as such, is a good template for

other projects.

Set up and test your mixed reality immersive headset.

You will notnot  require Motion Controllers for this course. If you need support setting up the immersive headset, please

follow this link on how to set up Windows Mixed Reality.

1. Open UnityUnity  and click NewNew .

2. You need to provide a Unity Project name, insert UnityDesktopNotifHubUnityDesktopNotifHub. Make sure the project type is

set to 3D3D. Set the LocationLocation to somewhere appropriate for you (remember, closer to root directories is

better). Then, click Create projectCreate project.

https://support.microsoft.com/help/4043101/windows-10-set-up-windows-mixed-reality


3. With Unity open, it is worth checking the default Scr ipt EditorScr ipt Editor  is set to Visual StudioVisual Studio. Go to EditEdit >

PreferencesPreferences  and then from the new window, navigate to External ToolsExternal Tools . Change External Scr iptExternal Scr ipt

EditorEditor  to Visual Studio 2017Visual Studio 2017 . Close the PreferencesPreferences  window.

4. Next, go to FileFile > Build SettingsBuild Settings  and select Universal Windows PlatformUniversal Windows Platform , then click on the SwitchSwitch

PlatformPlatform button to apply your selection.

5. While still in FileFile > Build SettingsBuild Settings , make sure that:

a. Target DeviceTarget Device is set to Any DeviceAny Device

This Application will be for your desktop, so must be Any DeviceAny Device

b. Build TypeBuild Type is set to D3DD3D

c. SDKSDK is set to Latest installedLatest installed

d. Visual Studio VersionVisual Studio Version is set to Latest installedLatest installed

e. Build and RunBuild and Run is set to Local MachineLocal Machine

f. While here, it is worth saving the scene, and adding it to the build.

a. Do this by selecting Add Open ScenesAdd Open Scenes . A save window will appear.



b. Create a new folder for this, and any future, scene, then select the New folderNew folder  button, to

create a new folder, name it ScenesScenes .

c. Open your newly created ScenesScenes  folder, and then in the File name:File name: text field, type

NH_Desktop_SceneNH_Desktop_Scene, then press SaveSave.

g. The remaining settings, in Build SettingsBuild Settings , should be left as default for now.
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IMPORTANTIMPORTANT

6. In the same window click on the Player SettingsPlayer Settings  button, this will open the related panel in the space

where the InspectorInspector  is located.

7. In this panel, a few settings need to be verified:

a. In the Other SettingsOther Settings  tab:

a. Scr ipting Runtime VersionScr ipting Runtime Version should be Experimental ( .NET 4.6 Equivalent)Experimental ( .NET 4.6 Equivalent)

b. Scr ipting BackendScripting Backend should be .NET.NET

c. API Compatibility LevelAPI Compatibility Level  should be .NET 4.6.NET 4.6

b. Within the Publishing SettingsPublishing Settings  tab, under CapabilitiesCapabilities , check:

InternetClientInternetClient

8. Back in Build SettingsBuild Settings  Unity C# Projects is no longer greyed out; tick the checkbox next to this.

9. Close the Build SettingsBuild Settings  window.

10. Save your Scene and Project FileFile > Save Scene / FileSave Scene / File > Save ProjectSave Project.

If you wish to skip the Unity Set up component for this project (Desktop App), and continue straight into code,

feel free to download this .unitypackage, import it into your project as a Custom PackageCustom Package, and then continue

from Chapter 9. You will still need to add the script components.

You will be using Azure Storage for Unity (which itself leverages the .Net SDK for Azure). For more information

follow this link about Azure Storage for Unity.

https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20308%20-%20Cross-device%20notifications/Azure-MR-308-Desktop.unitypackage
https://docs.unity3d.com/Manual/AssetPackages.html
https://docs.microsoft.com/en-us/sandbox/gamedev/unity/azure-storage-unity


There is currently a known issue in Unity which requires plugins to be reconfigured after import. These steps (4

- 7 in this section) will no longer be required after the bug has been resolved.

To import the SDK into your own project, make sure you have downloaded the latest .unitypackage.unitypackage from

GitHub. Then, do the following:

1. Add the .unitypackage.unitypackage to Unity by using the Assets > Impor t Package > Custom PackageAssets > Impor t Package > Custom Package menu

option.

2. In the Impor t Unity PackageImpor t Unity Package box that pops up, you can select everything under PluginPlugin >  > StorageStorage.

Uncheck everything else, as it is not needed for this course.

3. Click the Impor tImpor t button to add the items to your project.

4. Go to the StorageStorage folder under PluginsPlugins  in the Project view and select the following plugins only:

Microsoft.Data.Edm

Microsoft.Data.OData

Microsoft.WindowsAzure.Storage

Newtonsoft.Json

System.Spatial

5. With these specific plugins selected, uncheckuncheck Any PlatformAny Platform and uncheckuncheck WSAPlayerWSAPlayer  then click

ApplyApply .

https://aka.ms/azstorage-unitysdk


 

NOTENOTE

NOTENOTE

We are marking these particular plugins to only be used in the Unity Editor. This is because there are different

versions of the same plugins in the WSA folder that will be used after the project is exported from Unity.

6. In the StorageStorage plugin folder, select only:

Microsoft.Data.Services.Client

7. Check the Don't ProcessDon't Process  box under Platform SettingsPlatform Settings  and click ApplyApply .

We are marking this plugin "Don't process", because the Unity assembly patcher has difficulty processing this

plugin. The plugin will still work even though it is not processed.



Chapter 9 - Create the TableToScene class in the Desktop Unity
project
You now need to create the scripts containing the code to run this application.

The first script you need to create is TableToSceneTableToScene, which is responsible for :

Reading entities within the Azure Table.

Using the Table data, determine which objects to spawn, and in which position.

The second script you need to create is CloudSceneCloudScene, which is responsible for :

Registering the left-click event, to allow the user to drag objects around the scene.

Serializing the object data from this Unity scene, and sending it to the Azure Function App.

To create this class:

1. Right-click in the AssetAsset Folder located in the Project Panel, CreateCreate > FolderFolder . Name the folder Scr iptsScr ipts .

2. Double click on the folder just created, to open it.

3. Right-click inside the Scr iptsScr ipts  folder, click CreateCreate > C# Scr iptC# Scr ipt. Name the script TableToSceneTableToScene.



using Microsoft.WindowsAzure.Storage;
using Microsoft.WindowsAzure.Storage.Auth;
using Microsoft.WindowsAzure.Storage.Table;
using UnityEngine;

    /// <summary>    
    /// allows this class to behave like a singleton
    /// </summary>    
    public static TableToScene instance;

    /// <summary>    
    /// Insert here you Azure Storage name     
    /// </summary>    
    private string accountName = " -- Insert your Azure Storage name -- ";

    /// <summary>    
    /// Insert here you Azure Storage key    
    /// </summary>    
    private string accountKey = " -- Insert your Azure Storage key -- ";

 

4. Double-click on the script to open it in Visual Studio 2017.

5. Add the following namespaces:

6. Within the class, insert the following variables:



NOTENOTE

    /// <summary>
    /// Triggers before initialization
    /// </summary>
    void Awake()
    {
        // static instance of this class
        instance = this;
    }

    /// <summary>
    /// Use this for initialization
    /// </summary>
    void Start()
    {  
        // Call method to populate the scene with new objects as 
        // pecified in the Azure Table
        PopulateSceneFromTableAsync();
    }

    /// <summary>    
    /// Populate the scene with new objects as specified in the Azure Table    
    /// </summary>    
    private async void PopulateSceneFromTableAsync()
    {
        // Obtain credentials for the Azure Storage
        StorageCredentials creds = new StorageCredentials(accountName, accountKey);

        // Storage account
        CloudStorageAccount account = new CloudStorageAccount(creds, useHttps: true);

        // Storage client
        CloudTableClient client = account.CreateCloudTableClient(); 

Substitute the accountNameaccountName value with your Azure Storage Service name and accountKeyaccountKey value with the key

value found in the Azure Storage Service, in the Azure Portal (See Image below).

7. Now add the Star t()Star t()  and Awake()Awake()  methods to initialize the class.

8. Within the TableToSceneTableToScene class, add the method that will retrieve the values from the Azure Table and use

them to spawn the appropriate primitives in the scene.



        CloudTableClient client = account.CreateCloudTableClient(); 

        // Table reference
        CloudTable table = client.GetTableReference("SceneObjectsTable");

        TableContinuationToken token = null;

        // Query the table for every existing Entity
        do
        {
            // Queries the whole table by breaking it into segments
            // (would happen only if the table had huge number of Entities)
            TableQuerySegment<AzureTableEntity> queryResult = await 
table.ExecuteQuerySegmentedAsync(new TableQuery<AzureTableEntity>(), token); 

            foreach (AzureTableEntity entity in queryResult.Results)
            {
                GameObject newSceneGameObject = null;
                Color newColor;

                // check for the Entity Type and spawn in the scene the appropriate Primitive
                switch (entity.Type)
                {
                    case "Cube":
                        // Create a Cube in the scene
                        newSceneGameObject = GameObject.CreatePrimitive(PrimitiveType.Cube);
                        newColor = Color.blue;
                        break;

                    case "Sphere":
                        // Create a Sphere in the scene
                        newSceneGameObject = GameObject.CreatePrimitive(PrimitiveType.Sphere);
                        newColor = Color.red;
                        break;

                    case "Cylinder":
                        // Create a Cylinder in the scene
                        newSceneGameObject = GameObject.CreatePrimitive(PrimitiveType.Cylinder);
                        newColor = Color.yellow;
                        break;
                    default:
                        newColor = Color.white;
                        break;
                }

                newSceneGameObject.name = entity.RowKey;

                newSceneGameObject.GetComponent<MeshRenderer>().material = new 
Material(Shader.Find("Diffuse"))
                {
                    color = newColor
                };

                //check for the Entity X,Y,Z and move the Primitive at those coordinates
                newSceneGameObject.transform.position = new Vector3((float)entity.X, (float)entity.Y, 
(float)entity.Z);
            }

            // if the token is null, it means there are no more segments left to query
            token = queryResult.ContinuationToken;
        }

        while (token != null);
    }

9. Outside the TableToSceneTableToScene class, you need to define the class used by the application to serialize and

deserialize the Table EntitiesTable Entities .



 Chapter 10 - Create the CloudScene class in the Desktop Unity
Project

    /// <summary>
    /// This objects is used to serialize and deserialize the Azure Table Entity
    /// </summary>
    [System.Serializable]
    public class AzureTableEntity : TableEntity
    {
        public AzureTableEntity(string partitionKey, string rowKey)
            : base(partitionKey, rowKey) { }

        public AzureTableEntity() { }
        public string Type { get; set; }
        public double X { get; set; }
        public double Y { get; set; }
        public double Z { get; set; }
    }

10. Make sure you SaveSave before going back to the Unity Editor.

11. Click the Main CameraMain Camera from the HierarchyHierarchy  panel, so that its properties appear in the InspectorInspector .

12. With the Scr iptsScr ipts  folder open, select the script TableToScene fileTableToScene file and drag it onto the Main CameraMain Camera.

The result should be as below:

The second script you need to create is CloudSceneCloudScene, which is responsible for :

Registering the left-click event, to allow the user to drag objects around the scene.

Serializing the object data from this Unity scene, and sending it to the Azure Function App.

To create the second script:

1. Right-click inside the Scr iptsScr ipts  folder, click CreateCreate, C# Scr iptC# Scr ipt. Name the script CloudSceneCloudScene



using Newtonsoft.Json;
using System.Collections;
using System.Text;
using System.Threading.Tasks;
using UnityEngine;
using UnityEngine.Networking;

    /// <summary>
    /// Allows this class to behave like a singleton
    /// </summary>
    public static CloudScene instance;

    /// <summary>
    /// Insert here you Azure Function Url
    /// </summary>
    private string azureFunctionEndpoint = "--Insert here you Azure Function Endpoint--";

    /// <summary>
    /// Flag for object being moved
    /// </summary>
    private bool gameObjHasMoved;

    /// <summary>
    /// Transform of the object being dragged by the mouse
    /// </summary>
    private Transform gameObjHeld;

    /// <summary>
    /// Class hosted in the TableToScene script
    /// </summary>
    private AzureTableEntity azureTableEntity;

 

2. Add the following namespaces:

3. Insert the following variables:



    /// <summary>
    /// Triggers before initialization
    /// </summary>
    void Awake()
    {
        // static instance of this class
        instance = this;
    }

    /// <summary>
    /// Use this for initialization
    /// </summary>
    void Start()
    {
        // initialise an AzureTableEntity
        azureTableEntity = new AzureTableEntity();
    }

4. Substitute the azureFunctionEndpointazureFunctionEndpoint value with your Azure Function App URL found in the Azure

Function App Service, in the Azure Portal, as shown in the image below:

5. Now add the Star t()Star t()  and Awake()Awake()  methods to initialize the class.

6. Within the Update()Update()  method, add the following code that will detect the mouse input and drag, which

will in turn move GameObjects in the scene. If the user has dragged and dropped an object, it will pass

the name and coordinates of the object to the method UpdateCloudScene()UpdateCloudScene() , which will call the Azure

Function App service, which will update the Azure table and trigger the notification.



    /// <summary>
    /// Update is called once per frame
    /// </summary>
    void Update()
    {
        //Enable Drag if button is held down
        if (Input.GetMouseButton(0))
        {
            // Get the mouse position
            Vector3 mousePosition = new Vector3(Input.mousePosition.x, Input.mousePosition.y, 10);

            Vector3 objPos = Camera.main.ScreenToWorldPoint(mousePosition);

            Ray ray = Camera.main.ScreenPointToRay(Input.mousePosition);

            RaycastHit hit;

            // Raycast from the current mouse position to the object overlapped by the mouse
            if (Physics.Raycast(ray, out hit))
            {
                // update the position of the object "hit" by the mouse
                hit.transform.position = objPos;

                gameObjHasMoved = true;

                gameObjHeld = hit.transform;
            }
        }

        // check if the left button mouse is released while holding an object
        if (Input.GetMouseButtonUp(0) && gameObjHasMoved)
        {
            gameObjHasMoved = false;

            // Call the Azure Function that will update the appropriate Entity in the Azure Table
            // and send a Notification to all subscribed Apps
            Debug.Log("Calling Azure Function");

            StartCoroutine(UpdateCloudScene(gameObjHeld.name, gameObjHeld.position.x, 
gameObjHeld.position.y, gameObjHeld.position.z));
        }
    }

7. Now add the UpdateCloudScene()UpdateCloudScene()  method, as below:



    private IEnumerator UpdateCloudScene(string objName, double xPos, double yPos, double zPos)
    {
        WWWForm form = new WWWForm();

        // set the properties of the AzureTableEntity
        azureTableEntity.RowKey = objName;

        azureTableEntity.X = xPos;

        azureTableEntity.Y = yPos;

        azureTableEntity.Z = zPos;

        // Serialize the AzureTableEntity object to be sent to Azure
        string jsonObject = JsonConvert.SerializeObject(azureTableEntity);

        using (UnityWebRequest www = UnityWebRequest.Post(azureFunctionEndpoint, jsonObject))
        {
            byte[] jsonToSend = new System.Text.UTF8Encoding().GetBytes(jsonObject);

            www.uploadHandler = new UploadHandlerRaw(jsonToSend);

            www.uploadHandler.contentType = "application/json";

            www.downloadHandler = new DownloadHandlerBuffer();

            www.SetRequestHeader("Content-Type", "application/json");

            yield return www.SendWebRequest();

            string response = www.responseCode.ToString();
        }
    }

8. Save the code and return to Unity

9. Drag the CloudSceneCloudScene script onto the Main CameraMain Camera.

a. Click the Main CameraMain Camera from the HierarchyHierarchy  panel, so that its properties appear in the InspectorInspector .

b. With the Scr iptsScr ipts  folder open, select the CloudSceneCloudScene script and drag it onto the Main CameraMain Camera.

The result should be as below:
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Everything needed for the Unity section of this project has now been completed.

1. Navigate to Build SettingsBuild Settings  (FileFile > Build SettingsBuild Settings ).

2. From the Build SettingsBuild Settings  window, click BuildBuild.

3. A File ExplorerFile Explorer  window will popup, prompting you for a location to Build. Create a new folder (by

clicking New FolderNew Folder  in the top-left corner), and name it BUILDSBUILDS .

a. Open the new BUILDSBUILDS  folder, and create another folder (using New FolderNew Folder  once more), and

name it NH_Desktop_AppNH_Desktop_App.
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b. With the NH_Desktop_AppNH_Desktop_App selected. click Select FolderSelect Folder . The project will take a minute or so to

build.

4. Following build, File ExplorerFile Explorer  will appear showing you the location of your new project. No need to

open it, though, as you need to create the other Unity project first, in the next few Chapters.

The following is a typical set up for developing with the mixed reality, and as such, is a good template for other

projects.

1. Open UnityUnity  and click NewNew .

2. You will now need to provide a Unity Project name, insert UnityMRNotifHubUnityMRNotifHub. Make sure the project

type is set to 3D3D. Set the LocationLocation to somewhere appropriate for you (remember, closer to root

directories is better). Then, click Create projectCreate project.



3. With Unity open, it is worth checking the default Scr ipt EditorScr ipt Editor  is set to Visual StudioVisual Studio. Go to EditEdit >

PreferencesPreferences  and then from the new window, navigate to External ToolsExternal Tools . Change External Scr iptExternal Scr ipt

EditorEditor  to Visual Studio 2017Visual Studio 2017 . Close the PreferencesPreferences  window.

4. Next, go to FileFile > Build SettingsBuild Settings  and switch the platform to Universal Windows PlatformUniversal Windows Platform , by

clicking on the Switch PlatformSwitch Platform button.

5. Go to FileFile > Build SettingsBuild Settings  and make sure that:



a. Target DeviceTarget Device is set to Any DeviceAny Device

For the Microsoft HoloLens, set Target DeviceTarget Device to HoloLens.

b. Build TypeBuild Type is set to D3DD3D

c. SDKSDK is set to Latest installedLatest installed

d. Visual Studio VersionVisual Studio Version is set to Latest installedLatest installed

e. Build and RunBuild and Run is set to Local MachineLocal Machine

f. While here, it is worth saving the scene, and adding it to the build.

a. Do this by selecting Add Open ScenesAdd Open Scenes . A save window will appear.

b. Create a new folder for this, and any future, scene, then select the New folderNew folder  button, to

create a new folder, name it ScenesScenes .

c. Open your newly created ScenesScenes  folder, and then in the File name:File name: text field, type

NH_MR_SceneNH_MR_Scene, then press SaveSave.



g. The remaining settings, in Build SettingsBuild Settings , should be left as default for now.

6. In the same window click on the Player SettingsPlayer Settings  button, this will open the related panel in the space

where the InspectorInspector  is located.

7. In this panel, a few settings need to be verified:

a. In the Other SettingsOther Settings  tab:

a. Scr ipting Runtime VersionScr ipting Runtime Version should be ExperimentalExperimental  (.NET 4.6 Equivalent)

b. Scr ipting BackendScripting Backend should be .NET.NET

c. API Compatibility LevelAPI Compatibility Level  should be .NET 4.6.NET 4.6
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IMPORTANTIMPORTANT

b. Further down the panel, in XR SettingsXR Settings  (found below Publish SettingsPublish Settings ), tick Vir tual RealityVir tual Reality

Suppor tedSuppor ted, make sure the Windows Mixed Reality SDKWindows Mixed Reality SDK is added

c. Within the Publishing SettingsPublishing Settings  tab, under CapabilitiesCapabilities , check:

InternetClientInternetClient

8. Back in Build SettingsBuild Settings , Unity C# ProjectsUnity C# Projects  is no longer greyed out: tick the checkbox next to this.

9. With these changes done, close the Build Settings window.

10. Save your Scene and Project FileFile > Save Scene / FileSave Scene / File > Save ProjectSave Project.

If you wish to skip the Unity Set up component for this project (mixed reality App), and continue straight into

code, feel free to download this .unitypackage, import it into your project as a Custom PackageCustom Package, and then

continue from Chapter 14. You will still need to add the script components.

You will be using Azure Storage for Unity library (which uses the .Net SDK for Azure). Please follow this link on

how to use Azure Storage with Unity. There is currently a known issue in Unity which requires plugins to be

reconfigured after import. These steps (4 - 7 in this section) will no longer be required after the bug has been

resolved.

https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20308%20-%20Cross-device%20notifications/Azure-MR-308-MR.unitypackage
https://docs.unity3d.com/Manual/AssetPackages.html
https://docs.microsoft.com/en-us/sandbox/gamedev/unity/azure-storage-unity


To import the SDK into your own project, make sure you have downloaded the latest .unitypackage. Then, do the

following:

1. Add the .unitypackage you downloaded from the above, to Unity by using the AssetsAssets  > Impor tImpor t

PackagePackage > Custom PackageCustom Package menu option.

2. In the Impor t Unity PackageImpor t Unity Package box that pops up, you can select everything under PluginPlugin > StorageStorage.

3. Click the Impor tImpor t button to add the items to your project.

4. Go to the StorageStorage folder under PluginsPlugins  in the Project view and select the following plugins only:

Microsoft.Data.Edm

Microsoft.Data.OData

Microsoft.WindowsAzure.Storage

Newtonsoft.Json

System.Spatial

5. With these specific plugins selected, uncheckuncheck Any PlatformAny Platform and uncheckuncheck WSAPlayerWSAPlayer  then click

ApplyApply .

https://aka.ms/azstorage-unitysdk
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NOTENOTE

NOTENOTE

You are marking these particular plugins to only be used in the Unity Editor. This is because there are different

versions of the same plugins in the WSA folder that will be used after the project is exported from Unity.

6. In the StorageStorage plugin folder, select only:

Microsoft.Data.Services.Client

7. Check the Don't ProcessDon't Process  box under Platform SettingsPlatform Settings  and click ApplyApply .

You are marking this plugin "Don't process" because the Unity assembly patcher has difficulty processing this

plugin. The plugin will still work even though it isn't processed.

The TableToSceneTableToScene class is identical to the one explained in Chapter 9. Create the same class in the mixed reality

Unity Project following the same procedure explained in Chapter 9.



 Chapter 15 - Creating the NotificationReceiver class in the Mixed
Reality Unity Project

Once you have completed this Chapter, both of your Unity ProjectsUnity Projects  will have this class set up on the Main

Camera.

The second script you need to create is NotificationReceiverNotificationReceiver , which is responsible for :

Registering the app with the Notification Hub at initialization.

Listening to notifications coming from the Notification Hub.

Deserializing the object data from received notifications.

Move the GameObjects in the scene, based on the deserialized data.

To create the NotificationReceiverNotificationReceiver  script:

//using Microsoft.WindowsAzure.Messaging;
using Newtonsoft.Json;
using System;
using System.Collections;
using UnityEngine;

#if UNITY_WSA_10_0 && !UNITY_EDITOR
using Windows.Networking.PushNotifications;
#endif

1. Right-click inside the Scr iptsScr ipts  folder, click CreateCreate, C# Scr iptC# Scr ipt. Name the script NotificationReceiverNotificationReceiver .

 

2. Double click on the script to open it.

3. Add the following namespaces:

4. Insert the following variables:



    /// <summary>
    /// allows this class to behave like a singleton
    /// </summary>
    public static NotificationReceiver instance;

    /// <summary>
    /// Value set by the notification, new object position
    /// </summary>
    Vector3 newObjPosition;

    /// <summary>
    /// Value set by the notification, object name
    /// </summary>
    string gameObjectName;

    /// <summary>
    /// Value set by the notification, new object position
    /// </summary>
    bool notifReceived;

    /// <summary>
    /// Insert here your Notification Hub Service name 
    /// </summary>
    private string hubName = " -- Insert the name of your service -- ";

    /// <summary>
    /// Insert here your Notification Hub Service "Listen endpoint"
    /// </summary>
    private string hubListenEndpoint = "-Insert your Notification Hub Service Listen endpoint-";

5. Substitute the hubNamehubName value with your Notification Hub Service name, and hubListenEndpointhubListenEndpoint value

with the endpoint value found in the Access Policies tab, Azure Notification Hub Service, in the Azure

Portal (see image below).

6. Now add the Star t()Star t()  and Awake()Awake()  methods to initialize the class.



    /// <summary>
    /// Triggers before initialization
    /// </summary>
    void Awake()
    {
        // static instance of this class
        instance = this;
    }

    /// <summary>
    /// Use this for initialization
    /// </summary>
    void Start()
    {
        // Register the App at launch
        InitNotificationsAsync();

        // Begin listening for notifications
        StartCoroutine(WaitForNotification());
    }

    /// <summary>
    /// This notification listener is necessary to avoid clashes 
    /// between the notification hub and the main thread   
    /// </summary>
    private IEnumerator WaitForNotification()
    {
        while (true)
        {
            // Checks for notifications each second
            yield return new WaitForSeconds(1f);

            if (notifReceived)
            {
                // If a notification is arrived, moved the appropriate object to the new position
                GameObject.Find(gameObjectName).transform.position = newObjPosition;

                // Reset the flag
                notifReceived = false;
            }
        }
    }

7. Add the WaitForNotificationWaitForNotification method to allow the app to receive notifications from the Notification Hub

Library without clashing with the Main Thread:

8. The following method, InitNotificationAsync()InitNotificationAsync() , will register the application with the notification Hub

Service at initialization. The code is commented out as Unity will not be able to Build the project. You will

remove the comments when you import the Azure Messaging Nuget package in Visual Studio.



    /// <summary>
    /// Register this application to the Notification Hub Service
    /// </summary>
    private async void InitNotificationsAsync()
    {
        // PushNotificationChannel channel = await 
PushNotificationChannelManager.CreatePushNotificationChannelForApplicationAsync();

        // NotificationHub hub = new NotificationHub(hubName, hubListenEndpoint);

        // Registration result = await hub.RegisterNativeAsync(channel.Uri);

        // If registration was successful, subscribe to Push Notifications
        // if (result.RegistrationId != null)
        // {
        //     Debug.Log($"Registration Successful: {result.RegistrationId}");
        //     channel.PushNotificationReceived += Channel_PushNotificationReceived;
        // }
    }

IMPORTANTIMPORTANT

    ///// <summary>
    ///// Handler called when a Push Notification is received
    ///// </summary>
    //private void Channel_PushNotificationReceived(PushNotificationChannel sender, 
PushNotificationReceivedEventArgs args)    
    //{
    //    Debug.Log("New Push Notification Received");
    //
    //    if (args.NotificationType == PushNotificationType.Raw)
    //    {
    //        //  Raw content of the Notification
    //        string jsonContent = args.RawNotification.Content;
    //
    //        // Deserialise the Raw content into an AzureTableEntity object
    //        AzureTableEntity ate = JsonConvert.DeserializeObject<AzureTableEntity>(jsonContent);
    //
    //        // The name of the Game Object to be moved
    //        gameObjectName = ate.RowKey;          
    //
    //        // The position where the Game Object has to be moved
    //        newObjPosition = new Vector3((float)ate.X, (float)ate.Y, (float)ate.Z);
    //
    //        // Flag thats a notification has been received
    //        notifReceived = true;
    //    }
    //}

9. The following handler, Channel_PushNotificationReceived()Channel_PushNotificationReceived() , will be triggered every time a

notification is received. It will deserialize the notification, which will be the Azure Table Entity that has

been moved on the Desktop Application, and then move the corresponding GameObject in the MR scene

to the same position.

The code is commented out because the code references the Azure Messaging library, which you will add after

building the Unity project using the Nuget Package Manager, within Visual Studio. As such, the Unity project will

not be able to build, unless it is commented out. Be aware, that should you build your project, and then wish to

return to Unity, you will need to re-commentre-comment  that code.

10. Remember to save your changes before going back to the Unity Editor.
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NOTENOTE

11. Click the Main CameraMain Camera from the HierarchyHierarchy  panel, so that its properties appear in the InspectorInspector .

12. With the Scr iptsScr ipts  folder open, select the NotificationReceiverNotificationReceiver  script and drag it onto the MainMain

CameraCamera. The result should be as below:

If you are developing this for the Microsoft HoloLens, you will need to update the Main CameraMain Camera's Camera

component, so that:

Clear Flags: Solid Color

Background: Black

This Chapter is identical to build process for the previous project. Everything needed for the Unity section of this

project has now been completed, so it is time to build it from Unity.

1. Navigate to Build SettingsBuild Settings  ( FileFile > Build SettingsBuild Settings  ).

2. From the Build SettingsBuild Settings  menu, ensure Unity C# ProjectsUnity C# Projects* is ticked (which will allow you to edit the

scripts in this project, after build).

3. After this is done, click BuildBuild.



4. A File ExplorerFile Explorer  window will popup, prompting you for a location to Build. Create a new folder (by

clicking New FolderNew Folder  in the top-left corner), and name it BUILDSBUILDS .

a. Open the new BUILDSBUILDS  folder, and create another folder (using New FolderNew Folder  once more), and

name it NH_MR_AppNH_MR_App.
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WARNINGWARNING

b. With the NH_MR_AppNH_MR_App selected. click Select FolderSelect Folder . The project will take a minute or so to build.

5. Following the build, a File ExplorerFile Explorer  window will open at the location of your new project.

Please remember that, once you add the following NuGet Packages (and uncomment the code in the next Chapter), the

Code, when reopened within the Unity Project, will present errors. If you wish to go back and continue editing in the

Unity Editor, you will need comment that errosome code, and then uncomment again later, once you are back in Visual

Studio.

Once the mixed reality build has been completed, navigate to the mixed reality project, which you built, and

double click on the solution (.sln) file within that folder, to open your solution with Visual Studio 2017. You will

now need to add the WindowsAzure.Messaging.managedWindowsAzure.Messaging.managed NuGet package; this is a library that is used to

receive Notifications from the Notification Hub.

To import the NuGet package:

1. In the Solution ExplorerSolution Explorer , right click on your Solution

2. Click on Manage NuGet PackagesManage NuGet Packages .

3. Select the BrowseBrowse tab and search for WindowsAzure.Messaging.managedWindowsAzure.Messaging.managed.

4. Select the result (as shown below), and in the window to the right, select the checkbox next to ProjectProject.

This will place a tick in the checkbox next to ProjectProject, along with the checkbox next to the Assembly-Assembly-

CSharpCSharp and UnityMRNotifHubUnityMRNotifHub project.
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5. The version initially provided may notmay not be compatible with this project. Therefore, click on the dropdown

menu next to VersionVersion, and click Version 0.1 .7 .9Version 0.1 .7 .9 , then click InstallInstall .

6. You have now finished installing the NuGet package. Find the commented code you entered in the

NotificationReceiverNotificationReceiver  class and remove the comments..

Following having added the NuGet PackagesNuGet Packages , you will need to uncomment some of the code within the

NotificationReceiverNotificationReceiver  class.

This includes:

using Microsoft.WindowsAzure.Messaging;

    /// <summary>
    /// Register this application to the Notification Hub Service
    /// </summary>
    private async void InitNotificationsAsync()
    {
        PushNotificationChannel channel = await 
PushNotificationChannelManager.CreatePushNotificationChannelForApplicationAsync();

        NotificationHub hub = new NotificationHub(hubName, hubListenEndpoint);

        Registration result = await hub.RegisterNativeAsync(channel.Uri);

        // If registration was successful, subscribe to Push Notifications
        if (result.RegistrationId != null)
        {
            Debug.Log($"Registration Successful: {result.RegistrationId}");
            channel.PushNotificationReceived += Channel_PushNotificationReceived;
        }
    }

1. The namespace at the top:

2. All the code within the InitNotificationsAsync()InitNotificationsAsync()  method:



WARNINGWARNING
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The code above has a comment in it: ensure that you have not accidentally uncommented that comment (as the code will

not compile if you have!).

    /// <summary>
    /// Handler called when a Push Notification is received
    /// </summary>
    private void Channel_PushNotificationReceived(PushNotificationChannel sender, 
PushNotificationReceivedEventArgs args)
    {
        Debug.Log("New Push Notification Received");

        if (args.NotificationType == PushNotificationType.Raw)
        {
            //  Raw content of the Notification
            string jsonContent = args.RawNotification.Content;

            // Deserialize the Raw content into an AzureTableEntity object
            AzureTableEntity ate = JsonConvert.DeserializeObject<AzureTableEntity>(jsonContent);

            // The name of the Game Object to be moved
            gameObjectName = ate.RowKey;

            // The position where the Game Object has to be moved
            newObjPosition = new Vector3((float)ate.X, (float)ate.Y, (float)ate.Z);

            // Flag thats a notification has been received
            notifReceived = true;
        }
    }

3. And, lastly, the Channel_PushNotificationReceivedChannel_PushNotificationReceived event:

With these uncommented, ensure that you save, and then proceed to the next Chapter.

You now need to associate the mixed realitymixed reality  project to the Store App you created in at the start of the lab.

1. Open the solution.

2. Right click on the UWP app Project in the Solution Explorer panel, the go to StoreStore, and Associate AppAssociate App

with the Store...with the Store... .



3. A new window will appear called Associate Your App with the Windows StoreAssociate Your App with the Windows Store. Click NextNext.

4. It will load up all the Applications associated with the Account which you have logged in. If you are not

logged in to your account, you can Log InLog In on this page.

5. Find the Store App nameStore App name that you created at the start of this tutorial and select it. Then click NextNext.
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applications

6. Click AssociateAssociate.

7. Your App is now AssociatedAssociated with the Store App. This is necessary for enabling Notifications.

This Chapter may be easier with two people, as the result will include both apps running, one running on your

computer Desktop, and the other within your immersive headset.

The immersive headset app is waiting to receive changes to the scene (position changes of the local

GameObjects), and the Desktop app will be making changes to their local scene (position changes), which will be

shared to the MR app. It makes sense to deploy the MR app first, followed by the Desktop app, so that the

receiver can begin listening.

To deploy the UnityMRNotifHubUnityMRNotifHub app on your Local Machine:



 Your finished your Azure Notification Hubs application

1. Open the solution file of your UnityMRNotifHubUnityMRNotifHub app in Visual Studio 2017Visual Studio 2017 .

2. In the Solution PlatformSolution Platform , select x86, Local Machinex86, Local Machine.

3. In the Solution ConfigurationSolution Configuration select DebugDebug.

4. Go to Build menuBuild menu and click on Deploy SolutionDeploy Solution to sideload the application to your machine.

5. Your App should now appear in the list of installed apps, ready to be launched.

To deploy the UnityDesktopNotifHubUnityDesktopNotifHub app on Local Machine:

1. Open the solution file of your UnityDesktopNotifHubUnityDesktopNotifHub app in Visual Studio 2017Visual Studio 2017 .

2. In the Solution PlatformSolution Platform , select x86, Local Machinex86, Local Machine.

3. In the Solution ConfigurationSolution Configuration select DebugDebug.

4. Go to Build menuBuild menu and click on Deploy SolutionDeploy Solution to sideload the application to your machine.

5. Your App should now appear in the list of installed apps, ready to be launched.

6. Launch the mixed reality application, followed by the Desktop application.

With both applications running, move an object in the desktop scene (using the Left Mouse Button). These

positional changes will be made locally, serialized, and sent to the Function App service. The Function App

service will then update the Table along with the Notification Hub. Having received an update, the Notification

Hub will send the updated data directly to all the registered applications (in this case the immersive headset

app), which will then deserialize the incoming data, and apply the new positional data to the local objects,

moving them in scene.

Congratulations, you built a mixed reality app that leverages the Azure Notification Hubs Service and allow

communication between apps.



 Bonus exercises
  Exercise 1Exercise 1

  Exercise 2Exercise 2

Can you work out how to change the color of the GameObjects and send that notification to other apps viewing

the scene?

Can you add movement of the GameObjects to your MR app and see the updated scene in your desktop app?



   

 

HoloLens (1st gen) and Azure 309: Application
insights

 7/6/2022 • 30 minutes to read • Edit Online

NOTENOTE
The Mixed Reality Academy tutorials were designed with HoloLens (1st gen) and Mixed Reality Immersive Headsets in

mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for guidance in

developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being used for

HoloLens 2. They will be maintained to continue working on the supported devices. There will be a new series of tutorials

that will be posted in the future that will demonstrate how to develop for HoloLens 2. This notice will be updated with a

link to those tutorials when they are posted.

In this course, you'll learn how to add Application Insights capabilities to a mixed reality application, using the

Azure Application Insights API to collect analytics regarding user behavior.

Application Insights is a Microsoft service, allowing developers to collect analytics from their applications and

manage it from an easy-to-use portal. The analytics can be anything from performance to custom information

you would like to collect. For more information, visit the Application Insights page.

Having completed this course, you'll have a mixed reality immersive headset application, which will be able to

do the following:

1. Allow the user to gaze and move around a scene.

2. Trigger the sending of analytics to the Application Insights Service, by using Gaze and Proximity to in-scene

objects.

3. The app will also call upon the Service, fetching information about which object has been approached the

most by the user, within the last 24 hours. That object will change its color to green.

This course will teach you how to get the results from the Application Insights Service, into a Unity-based

sample application. It will be up to you to apply these concepts to a custom application you might be building.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/mr-azure-309.md
https://azure.microsoft.com/services/application-insights/
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✔️ ✔️

NOTENOTE

 Prerequisites

NOTENOTE

 Before you start

WARNINGWARNING

 Chapter 1 - The Azure Portal

While this course primarily focuses on Windows Mixed Reality immersive (VR) headsets, you can also apply what you learn

in this course to Microsoft HoloLens. As you follow along with the course, you will see notes on any changes you might

need to employ to support HoloLens. When using HoloLens, you may notice some echo during voice capture.

This tutorial is designed for developers who have basic experience with Unity and C#. Please also be aware that the

prerequisites and written instructions within this document represent what has been tested and verified at the time of

writing (July 2018). You are free to use the latest software, as listed within the install the tools article, though it should not

be assumed that the information in this course will perfectly match what you will find in newer software than what is listed

below.

We recommend the following hardware and software for this course:

A development PC, compatible with Windows Mixed Reality for immersive (VR) headset development

Windows 10 Fall Creators Update (or later) with Developer mode enabled

The latest Windows 10 SDK

Unity 2017.4

Visual Studio 2017

A Windows Mixed Reality immersive (VR) headset or Microsoft HoloLens with Developer mode enabled

A set of headphones with a built-in microphone (if the headset doesn't have a built-in mic and speakers)

Internet access for Azure setup and Application Insights data retrieval

To avoid issues when building this project, it's strongly suggested that you create the project in this tutorial in a

root or near-root folder (long folder paths can cause issues at build-time).

Be aware, data going to Application Insights takes time, so be patient. If you want to check if the Service has received

your data, check out Chapter 14, which will show you how to navigate the portal.

To use Application Insights, you'll need to create and configure an Application Insights Service in the Azure

portal.

1. Sign in to the Azure Portal.

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://support.microsoft.com/help/4039260/windows-10-mixed-reality-pc-hardware-guidelines
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://portal.azure.com


NOTENOTE

NOTENOTE

If you do not already have an Azure account, you will need to create one. If you are following this tutorial in a

classroom or lab situation, ask your instructor or one of the proctors for help setting up your new account.

2. Once you're logged in, click NewNew  in the top left corner, and search for Application Insights, and click

EnterEnter .

The word NewNew may have been replaced with Create a resourceCreate a resource, in newer portals.

3. The new page to the right will provide a description of the Azure Application Insights Service. At the

bottom left of this page, select the CreateCreate button, to create an association with this Service.

4. Once you've clicked on CreateCreate:

a. Insert your desired NameName for this Service instance.

b. As Application TypeApplication Type, select GeneralGeneral .



c. Select an appropriate Subscr iptionSubscr iption.

d. Choose a Resource GroupResource Group or create a new one. A resource group provides a way to monitor,

control access, provision and manage billing for a collection of Azure assets. It's recommended to

keep all the Azure Services associated with a single project (for example, such as these courses)

under a common resource group).

If you wish to read more about Azure Resource Groups, please visit the resource group article.

e. Select a LocationLocation.

f. You'll also need to confirm that you've understood the Terms and Conditions applied to this

Service.

g. Select CreateCreate.

5. Once you've clicked on CreateCreate, you'll have to wait for the Service to be created, this might take a minute.

6. A notification will appear in the portal once the Service instance is created.

7. Select the notifications to explore your new Service instance.

https://docs.microsoft.com/en-us/azure/azure-resource-manager/resource-group-portal


NOTENOTE

IMPORTANTIMPORTANT

8. Click the Go to resourceGo to resource button in the notification to explore your new Service instance. You'll be taken

to your new Application Insights Service instance.

Keep this web page open and easy to access, you will come back here often to see the data collected.

To implement Application Insights, you will need to use three (3) specific values: Instrumentation KeyInstrumentation Key ,

Application IDApplication ID , and API KeyAPI Key . Below you will see how to retrieve these values from your Service. Make sure to

note these values on a blank Notepad page, because you will use them soon in your code.

9. To find the Instrumentation KeyInstrumentation Key , you'll need to scroll down the list of Service functions, and select

Proper tiesProper ties , the tab displayed will reveal the Ser vice KeySer vice Key .



10. A little below Proper tiesProper ties , you'll find API AccessAPI Access , which you need to click. The panel to the right will

provide the Application IDApplication ID of your app.

11. With the Application IDApplication ID panel still open, click Create API KeyCreate API Key , which will open the Create API key

panel.
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WARNINGWARNING

12. Within the now open Create API key panel, type a description, and tick the three boxestick the three boxes .

13. Click Generate KeyGenerate Key . Your API KeyAPI Key  will be created and displayed.

This is the only time your Ser vice KeySer vice Key  will be displayed, so ensure you make a copy of it now.

The following is a typical setup for developing with the mixed reality, and as such, is a good template for other

projects.

1. Open Unity and click NewNew .



2. You'll now need to provide a Unity Project name, insert MR_Azure_Application_InsightsMR_Azure_Application_Insights . Make sure

the Template is set to 3D3D. Set the Location to somewhere appropriate for you (remember, closer to root

directories is better). Then, click Create projectCreate project.

3. With Unity open, it's worth checking the default Scr ipt EditorScr ipt Editor  is set to Visual StudioVisual Studio. Go to Edit >Edit >

PreferencesPreferences  and then from the new window, navigate to External ToolsExternal Tools . Change External Scr iptExternal Scr ipt

EditorEditor  to Visual Studio 2017Visual Studio 2017 . Close the PreferencesPreferences  window.



4. Next, go to File > Build SettingsFile > Build Settings  and switch the platform to Universal Windows PlatformUniversal Windows Platform , by

clicking on the Switch PlatformSwitch Platform button.

5. Go to File > Build SettingsFile > Build Settings  and make sure that:

a. Target DeviceTarget Device is set to Any deviceAny device

For the Microsoft HoloLens, set Target DeviceTarget Device to HoloLens.

b. Build TypeBuild Type is set to D3DD3D

c. SDKSDK is set to Latest installedLatest installed

d. Build and RunBuild and Run is set to Local MachineLocal Machine

e. Save the scene and add it to the build.

a. Do this by selecting Add Open ScenesAdd Open Scenes . A save window will appear.



b. Create a new folder for this, and any future scene, then click the New folderNew folder  button, to

create a new folder, name it ScenesScenes .

c. Open your newly created ScenesScenes  folder, and then in the File name: text field, type

ApplicationInsightsSceneApplicationInsightsScene, then click SaveSave.

6. The remaining settings, in Build SettingsBuild Settings , should be left as default for now.



7. In the Build SettingsBuild Settings  window, select Player SettingsPlayer Settings , this will open the related panel in the space

where the InspectorInspector  is located.

8. In this panel, a few settings need to be verified:

a. In the Other SettingsOther Settings  tab:

a. Scr iptingScr ipting Runtime VersionRuntime Version should be Experimental ( .NET 4.6 Equivalent)Experimental ( .NET 4.6 Equivalent) , which will

trigger a need to restart the Editor.

b. Scr ipting BackendScripting Backend should be .NET.NET

c. API Compatibility LevelAPI Compatibility Level  should be .NET 4.6.NET 4.6
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b. Within the Publishing SettingsPublishing Settings  tab, under CapabilitiesCapabilities , check:

InternetClientInternetClient

c. Further down the panel, in XR SettingsXR Settings  (found below Publishing SettingsPublishing Settings ), tick Vir tual RealityVir tual Reality

Suppor tedSuppor ted, make sure the Windows Mixed Reality SDKWindows Mixed Reality SDK is added.

9. Back in Build SettingsBuild Settings , Unity C# ProjectsUnity C# Projects  is no longer greyed out; tick the checkbox next to this.

10. Close the Build Settings window.

11. Save your Scene and Project (FILEFILE > SAVE SCENE / FILESAVE SCENE / FILE > SAVE PROJECTSAVE PROJECT).



IMPORTANTIMPORTANT

IMPORTANTIMPORTANT

If you wish to skip the Unity Set up components of this course, and continue straight into code, feel free to download this

Azure-MR-309.unitypackage, import it into your project as a Custom PackageCustom Package. This will also contain the DLLs from the

next Chapter. After import, continue from Chapter 6Chapter 6 .

To use Application Insights within Unity, you need to import the DLL for it, along with the Newtonsoft DLL. There is

currently a known issue in Unity which requires plugins to be reconfigured after import. These steps (4 - 7 in this section)

will no longer be required after the bug has been resolved.

To import Application Insights into your own project, make sure you've downloaded the '.unitypackage',

containing the plugins. Then, do the following:

1. Add the.unitypackage** to Unity by using the Assets > Impor t Package > Custom PackageAssets > Impor t Package > Custom Package menu

option.

2. In the Impor t Unity PackageImpor t Unity Package box that pops up, ensure everything under (and including) PluginsPlugins  is

selected.

3. Click the Impor tImpor t button, to add the items to your project.

4. Go to the InsightsInsights  folder under PluginsPlugins  in the Project view and select the following plugins only:

Microsoft.ApplicationInsights

5. With this plugin selected, ensure that Any PlatformAny Platform is uncheckedunchecked, then ensure that WSAPlayerWSAPlayer  is also

uncheckedunchecked, then click ApplyApply . Doing this is just to confirm that the files are configured correctly.

https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20309%20-%20Application%20insights/Azure-MR-309.unitypackage
https://docs.unity3d.com/Manual/AssetPackages.html
https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20309%20-%20Application%20insights/AppInsights_LabPlugins.unitypackage


NOTENOTE
Marking the plugins like this, configures them to only be used in the Unity Editor. There are a different set of DLLs

in the WSA folder which will be used after the project is exported from Unity.

6. Next, you need to open the WSAWSA folder, within the InsightsInsights  folder. You'll see a copy of the same file you

configured. Select this file, and then in the inspector, ensure that Any PlatformAny Platform is uncheckedunchecked, then

ensure that onlyonly  WSAPlayerWSAPlayer  is checkedchecked. Click ApplyApply .

7. You'll now need to follow steps 4-6steps 4-6 , but for the Newtonsoft plugins instead. See the below screenshot

for what the outcome should look like.



 

Chapter 4 - Set up the camera and user controls
In this Chapter, you'll set up the camera and the controls to allow the user to see and move in the scene.

1. Right-click in an empty area in the Hierarchy Panel, then on CreateCreate > EmptyEmpty .

2. Rename the new empty GameObject to Camera ParentCamera Parent.

3. Right-click in an empty area in the Hierarchy Panel, then on 3D Object3D Object, then on SphereSphere.

4. Rename the Sphere to Right HandRight Hand.

5. Set the Transform ScaleTransform Scale of the Right Hand to 0.1 , 0 .1 , 0 .10.1 , 0 .1 , 0 .1

6. Remove the Sphere ColliderSphere Collider  component from the Right Hand by clicking on the GearGear  in the Sphere

Collider component, and then Remove ComponentRemove Component.
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7. In the Hierarchy Panel, drag the Main CameraMain Camera and the Right HandRight Hand objects onto the Camera ParentCamera Parent

object.

8. Set the Transform PositionTransform Position of both the Main CameraMain Camera and the Right HandRight Hand object to 0, 0 , 00, 0 , 0 .

You'll now create some basic shapes for your scene, with which the user can interact.

1. Right-click in an empty area in the Hierarchy Panel, then on 3D Object3D Object, then select PlanePlane.

2. Set the Plane Transform PositionTransform Position to 0, -1 , 00, -1, 0 .

3. Set the Plane Transform ScaleTransform Scale to 5, 1 , 55, 1 , 5 .



4. Create a basic material to use with your PlanePlane object, so that the other shapes are easier to see. Navigate

to your Project Panel, right-click, then CreateCreate, followed by FolderFolder , to create a new folder. Name it

Mater ialsMater ials .

 

5. Open the Mater ialsMater ials  folder, then right-click, click CreateCreate, then Mater ialMater ial , to create a new material. Name

it BlueBlue.

 

6. With the new BlueBlue material selected, look at the Inspector, and click the rectangular window alongside

AlbedoAlbedo. Select a blue color (the one picture below is Hex Color : #3592FFFFHex Color : #3592FFFF). Click the close button

once you have chosen.



7. Drag your new material from the Mater ialsMater ials  folder, onto your newly created PlanePlane, within your scene (or

drop it on the PlanePlane object within the Hierarchy).

8. Right-click in an empty area in the Hierarchy Panel, then on 3D Object, Capsule3D Object, Capsule.

With the CapsuleCapsule selected, change its TransformTransform Position to: -10, 1 , 0-10, 1 , 0 .

9. Right-click in an empty area in the Hierarchy Panel, then on 3D Object, Cube3D Object, Cube.

With the CubeCube selected, change its TransformTransform Position to: 0 , 0 , 100, 0 , 10 .

10. Right-click in an empty area in the Hierarchy Panel, then on 3D Object, Sphere3D Object, Sphere.

With the SphereSphere selected, change its TransformTransform Position to: 10, 0 , 010, 0 , 0 .



NOTENOTE

WARNINGWARNING

These Position values are suggestions. You are free to set the positions of the objects to whatever you would like,

though it is easier for the user of the application if the objects distances are not too far from the camera.

11. When your application is running, it needs to be able to identify the objects within the scene, to achieve

this, they need to be tagged. Select one of the objects, and in the Inspector panel, click Add Tag...Add Tag..., which

will swap the Inspector with the Tags & LayersTags & Layers  panel.

 

12. Click the + (plus)+ (plus)  symbol, then type the tag name as ObjectInSceneObjectInScene.

If you use a different name for your tag, you will need to ensure this change is also made the DataFromAnalytics,

ObjectTrigger, and Gaze, scripts later, so that your objects are found, and detected, within your scene.

13. With the tag created, you now need to apply it to all three of your objects. From the Hierarchy, hold the

ShiftShift key, then click the CapsuleCapsule, CubeCube, and SphereSphere, objects, then in the Inspector, click the dropdown

menu alongside TagTag, then click the ObjectInScene tag you created.
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The first script you need to create is ApplicationInsightsTrackerApplicationInsightsTracker , which is responsible for :

1. Creating events based on user interactions to submit to Azure Application Insights.

2. Creating appropriate Event names, depending on user interaction.

3. Submitting events to the Application Insights Service instance.

To create this class:

1. Right-click in the Project Panel, then CreateCreate > FolderFolder . Name the folder Scr iptsScr ipts .



    using Microsoft.ApplicationInsights;
    using Microsoft.ApplicationInsights.DataContracts;
    using Microsoft.ApplicationInsights.Extensibility;
    using UnityEngine;

2. With the Scr iptsScr ipts  folder created, double-click it, to open. Then, within that folder, right-click, CreateCreate > C#C#

ScriptScr ipt. Name the script ApplicationInsightsTrackerApplicationInsightsTracker .

3. Double-click the new ApplicationInsightsTrackerApplicationInsightsTracker  script to open it with Visual StudioVisual Studio.

4. Update namespaces at the top of the script to be as below:

5. Inside the class insert the following variables:



    /// <summary>
    /// Allows this class to behavior like a singleton
    /// </summary>
    public static ApplicationInsightsTracker Instance;

    /// <summary>
    /// Insert your Instrumentation Key here
    /// </summary>
    internal string instrumentationKey = "Insert Instrumentation Key here";

    /// <summary>
    /// Insert your Application Id here
    /// </summary>
    internal string applicationId = "Insert Application Id here";

    /// <summary>
    /// Insert your API Key here
    /// </summary>
    internal string API_Key = "Insert API Key here";

    /// <summary>
    /// Represent the Analytic Custom Event object
    /// </summary>
    private TelemetryClient telemetryClient;

    /// <summary>
    /// Represent the Analytic object able to host gaze duration
    /// </summary>
    private MetricTelemetry metric;

NOTENOTE

    /// <summary>
    /// Sets this class instance as a singleton
    /// </summary>
    void Awake()
    {
        Instance = this;
    }

    /// <summary>
    /// Use this for initialization
    /// </summary>
    void Start()
    {
        // Instantiate telemetry and metric
        telemetryClient = new TelemetryClient();

        metric = new MetricTelemetry();

        // Assign the Instrumentation Key to the Event and Metric objects
        TelemetryConfiguration.Active.InstrumentationKey = instrumentationKey;

        telemetryClient.InstrumentationKey = instrumentationKey;
    }

Set the instrumentationKey, applicationId and API_KeyinstrumentationKey, applicationId and API_Key  values appropriately, using the Service Keys from

the Azure Portal as mentioned in Chapter 1, step 9 onwards.

6. Then add the Star t()Star t()  and Awake()Awake()  methods, which will be called when the class initializes:

7. Add the methods responsible for sending the events and metrics registered by your application:
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    /// <summary>
    /// Submit the Event to Azure Analytics using the event trigger object
    /// </summary>
    public void RecordProximityEvent(string objectName)
    {
        telemetryClient.TrackEvent(CreateEventName(objectName));
    }

    /// <summary>
    /// Uses the name of the object involved in the event to create 
    /// and return an Event Name convention
    /// </summary>
    public string CreateEventName(string name)
    {
        string eventName = $"User near {name}";
        return eventName;
    }

    /// <summary>
    /// Submit a Metric to Azure Analytics using the metric gazed object
    /// and the time count of the gaze
    /// </summary>
    public void RecordGazeMetrics(string objectName, int time)
    {
        // Output Console information about gaze.
        Debug.Log($"Finished gazing at {objectName}, which went for <b>{time}</b> second{(time != 1 ? 
"s" : "")}");

        metric.Name = $"Gazed {objectName}";

        metric.Value = time;

        telemetryClient.TrackMetric(metric);
    }

8. Be sure to save your changes in Visual Studio before returning to Unity.

The next script to create is the GazeGaze script. This script is responsible for creating a Raycast that will be projected

forward from the Main Camera, to detect which object the user is looking at. In this case, the Raycast will need

to identify if the user is looking at an object with the ObjectInSceneObjectInScene tag, and then count how long the user

gazes at that object.

1. Double-click the Scr iptsScr ipts  folder, to open it.

2. Right-click inside the Scr iptsScr ipts  folder, click CreateCreate > C# Scr iptC# Scr ipt. Name the script GazeGaze.

3. Double-click the script to open it with Visual Studio.

4. Replace the existing code with the following:



    using UnityEngine;

    public class Gaze : MonoBehaviour
    {
        /// <summary>
        /// Provides Singleton-like behavior to this class.
        /// </summary>
        public static Gaze Instance;

        /// <summary>
        /// Provides a reference to the object the user is currently looking at.
        /// </summary>
        public GameObject FocusedGameObject { get; private set; }

        /// <summary>
        /// Provides whether an object has been successfully hit by the raycast.
        /// </summary>
        public bool Hit { get; private set; }

        /// <summary>
        /// Provides a reference to compare whether the user is still looking at 
        /// the same object (and has not looked away).
        /// </summary>
        private GameObject _oldFocusedObject = null;

        /// <summary>
        /// Max Ray Distance
        /// </summary>
        private float _gazeMaxDistance = 300;

        /// <summary>
        /// Max Ray Distance
        /// </summary>
        private float _gazeTimeCounter = 0;

        /// <summary>
        /// The cursor object will be created when the app is running,
        /// this will store its values. 
        /// </summary>
        private GameObject _cursor;
    }

5. Code for the Awake()Awake()  and Star t()Star t()  methods now needs to be added.



    private void Awake()
    {
        // Set this class to behave similar to singleton
        Instance = this;
        _cursor = CreateCursor();
    }

    void Start()
    {
        FocusedGameObject = null;
    }

    /// <summary>
    /// Create a cursor object, to provide what the user
    /// is looking at.
    /// </summary>
    /// <returns></returns>
    private GameObject CreateCursor()    
    {
        GameObject newCursor = GameObject.CreatePrimitive(PrimitiveType.Sphere);

        // Remove the collider, so it does not block raycast.
        Destroy(newCursor.GetComponent<SphereCollider>());

        newCursor.transform.localScale = new Vector3(0.1f, 0.1f, 0.1f);

        newCursor.GetComponent<MeshRenderer>().material.color = 
        Color.HSVToRGB(0.0223f, 0.7922f, 1.000f);

        newCursor.SetActive(false);
        return newCursor;
    }

6. Inside the GazeGaze class, add the following code in the Update()Update()  method to project a Raycast and detect the

target hit:



    /// <summary>
    /// Called every frame
    /// </summary>
    void Update()
    {
        // Set the old focused gameobject.
        _oldFocusedObject = FocusedGameObject;

        RaycastHit hitInfo;

        // Initialize Raycasting.
        Hit = Physics.Raycast(Camera.main.transform.position, Camera.main.transform.forward, out 
hitInfo, _gazeMaxDistance);

        // Check whether raycast has hit.
        if (Hit == true)
        {
            // Check whether the hit has a collider.
            if (hitInfo.collider != null)
            {
                // Set the focused object with what the user just looked at.
                FocusedGameObject = hitInfo.collider.gameObject;

                // Lerp the cursor to the hit point, which helps to stabilize the gaze.
                _cursor.transform.position = Vector3.Lerp(_cursor.transform.position, hitInfo.point, 
0.6f);

                _cursor.SetActive(true);
            }
            else
            {
                // Object looked on is not valid, set focused gameobject to null.
                FocusedGameObject = null;

                _cursor.SetActive(false);
            }
        }
        else
        {
            // No object looked upon, set focused gameobject to null.
            FocusedGameObject = null;

            _cursor.SetActive(false);
        }

        // Check whether the previous focused object is this same object. If so, reset the focused 
object.
        if (FocusedGameObject != _oldFocusedObject)
        {
            ResetFocusedObject();
        }
        // If they are the same, but are null, reset the counter. 
        else if (FocusedGameObject == null && _oldFocusedObject == null)
        {
            _gazeTimeCounter = 0;
        }
        // Count whilst the user continues looking at the same object.
        else
        {
            _gazeTimeCounter += Time.deltaTime;
        }
    }

7. Add the ResetFocusedObject()ResetFocusedObject()  method, to send data to Application InsightsApplication Insights  when the user has

looked at an object.
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    /// <summary>
    /// Reset the old focused object, stop the gaze timer, and send data if it
    /// is greater than one.
    /// </summary>
    public void ResetFocusedObject()
    {
        // Ensure the old focused object is not null.
        if (_oldFocusedObject != null)
        {
            // Only looking for objects with the correct tag.
            if (_oldFocusedObject.CompareTag("ObjectInScene"))
            {
                // Turn the timer into an int, and ensure that more than zero time has passed.
                int gazeAsInt = (int)_gazeTimeCounter;

                if (gazeAsInt > 0)
                {
                    //Record the object gazed and duration of gaze for Analytics
                    ApplicationInsightsTracker.Instance.RecordGazeMetrics(_oldFocusedObject.name, 
gazeAsInt);
                }
                //Reset timer
                _gazeTimeCounter = 0;
            }
        }
    }

8. You've now completed the GazeGaze script. Save your changes in Visual Studio before returning to Unity.

The next script you need to create is ObjectTr iggerObjectTr igger , which is responsible for :

Adding components needed for collision to the Main Camera.

Detecting if the camera is near an object tagged as ObjectInSceneObjectInScene.

To create the script:

1. Double-click the Scr iptsScr ipts  folder, to open it.

2. Right-click inside the Scr iptsScr ipts  folder, click CreateCreate > C# Scr iptC# Scr ipt. Name the script ObjectTr iggerObjectTr igger .

3. Double-click the script to open it with Visual Studio. Replace the existing code with the following:



 Chapter 9 - Create the DataFromAnalytics class

    using UnityEngine;

    public class ObjectTrigger : MonoBehaviour
    {
        private void Start()
        {
            // Add the Collider and Rigidbody components, 
            // and set their respective settings. This allows for collision.
            gameObject.AddComponent<SphereCollider>().radius = 1.5f;

            gameObject.AddComponent<Rigidbody>().useGravity = false;
        }

        /// <summary>
        /// Triggered when an object with a collider enters this objects trigger collider.
        /// </summary>
        /// <param name="collision">Collided object</param>
        private void OnCollisionEnter(Collision collision)
        {
            CompareTriggerEvent(collision, true);
        }

        /// <summary>
        /// Triggered when an object with a collider exits this objects trigger collider.
        /// </summary>
        /// <param name="collision">Collided object</param>
        private void OnCollisionExit(Collision collision)
        {
            CompareTriggerEvent(collision, false);
        }

        /// <summary>
        /// Method for providing debug message, and sending event information to InsightsTracker.
        /// </summary>
        /// <param name="other">Collided object</param>
        /// <param name="enter">Enter = true, Exit = False</param>
        private void CompareTriggerEvent(Collision other, bool enter)
        {
            if (other.collider.CompareTag("ObjectInScene"))
            {
                string message = $"User is{(enter == true ? " " : " no longer ")}near <b>
{other.gameObject.name}</b>";

                if (enter == true)
                {
                    ApplicationInsightsTracker.Instance.RecordProximityEvent(other.gameObject.name);
                }
                Debug.Log(message);
            }
        }
    }

4. Be sure to save your changes in Visual Studio before returning to Unity.

You'll now need to create the DataFromAnalyticsDataFromAnalytics  script, which is responsible for :

Fetching analytics data about which object has been approached by the camera the most.

Using the Service Keys, that allow communication with your Azure Application Insights Service instance.

Sorting the objects in scene, according to which has the highest event count.

Changing the material color, of the most approached object, to green.

To create the script:



    using Newtonsoft.Json;
    using System;
    using System.Collections;
    using System.Collections.Generic;
    using System.Linq;
    using UnityEngine;
    using UnityEngine.Networking;

    /// <summary>
    /// Number of most recent events to be queried
    /// </summary>
    private int _quantityOfEventsQueried = 10;

    /// <summary>
    /// The timespan with which to query. Needs to be in hours.
    /// </summary>
    private int _timepspanAsHours = 24;

    /// <summary>
    /// A list of the objects in the scene
    /// </summary>
    private List<GameObject> _listOfGameObjectsInScene;

    /// <summary>
    /// Number of queries which have returned, after being sent.
    /// </summary>
    private int _queriesReturned = 0;

    /// <summary>
    /// List of GameObjects, as the Key, with their event count, as the Value.
    /// </summary>
    private List<KeyValuePair<GameObject, int>> _pairedObjectsWithEventCount = new 
List<KeyValuePair<GameObject, int>>();

    // Use this for initialization
    void Start()
    {
        // Find all objects in scene which have the ObjectInScene tag (as there may be other 
GameObjects in the scene which you do not want).
        _listOfGameObjectsInScene = GameObject.FindGameObjectsWithTag("ObjectInScene").ToList();

        FetchAnalytics();
    }

1. Double-click the Scr iptsScr ipts  folder, to open it.

2. Right-click inside the Scr iptsScr ipts  folder, click CreateCreate > C# Scr iptC# Scr ipt. Name the script DataFromAnalyticsDataFromAnalytics .

3. Double-click the script to open it with Visual Studio.

4. Insert the following namespaces:

5. Inside the script, insert the following:

6. Within the DataFromAnalyticsDataFromAnalytics  class, right after the Star t()Star t()  method, add the following method called

FetchAnalytics()FetchAnalytics() . This method is responsible for populating the list of key value pairs, with a

GameObject and a placeholder event count number. It then initializes the GetWebRequest()GetWebRequest()  coroutine.

The query structure of the call to Application Insights can be found within this method also, as the Query

URL endpoint.



    private void FetchAnalytics()
    {
        // Iterate through the objects in the list
        for (int i = 0; i < _listOfGameObjectsInScene.Count; i++)
        {
            // The current event number is not known, so set it to zero.
            int eventCount = 0;

            // Add new pair to list, as placeholder, until eventCount is known.
            _pairedObjectsWithEventCount.Add(new KeyValuePair<GameObject, int>
(_listOfGameObjectsInScene[i], eventCount));

            // Set the renderer of the object to the default color, white
            _listOfGameObjectsInScene[i].GetComponent<Renderer>().material.color = Color.white;

            // Create the appropriate object name using Insights structure
            string objectName = _listOfGameObjectsInScene[i].name;

       // Build the queryUrl for this object.
       string queryUrl = Uri.EscapeUriString(string.Format(
                "https://api.applicationinsights.io/v1/apps/{0}/events/$all?timespan=PT{1}H&$search=
{2}&$select=customMetric/name&$top={3}&$count=true",
        ApplicationInsightsTracker.Instance.applicationId, _timepspanAsHours, "Gazed " + objectName, 
_quantityOfEventsQueried));

            // Send this object away within the WebRequest Coroutine, to determine it is event count.
            StartCoroutine("GetWebRequest", new KeyValuePair<string, int>(queryUrl, i));
        }
    }

7. Right below the FetchAnalytics()FetchAnalytics()  method, add a method called GetWebRequest()GetWebRequest() , which returns an

IEnumerator. This method is responsible for requesting the number of times an event, corresponding

with a specific GameObject, has been called within Application Insights. When all the sent queries have

returned, the DetermineWinner()DetermineWinner()  method is called.



    /// <summary>
    /// Requests the data count for number of events, according to the
    /// input query URL.
    /// </summary>
    /// <param name="webQueryPair">Query URL and the list number count.</param>
    /// <returns></returns>
    private IEnumerator GetWebRequest(KeyValuePair<string, int> webQueryPair)
    {
        // Set the URL and count as their own variables (for readability).
        string url = webQueryPair.Key;
        int currentCount = webQueryPair.Value;

        using (UnityWebRequest unityWebRequest = UnityWebRequest.Get(url))
        {
            DownloadHandlerBuffer handlerBuffer = new DownloadHandlerBuffer();

            unityWebRequest.downloadHandler = handlerBuffer;

            unityWebRequest.SetRequestHeader("host", "api.applicationinsights.io");

            unityWebRequest.SetRequestHeader("x-api-key", 
ApplicationInsightsTracker.Instance.API_Key);

            yield return unityWebRequest.SendWebRequest();

            if (unityWebRequest.isNetworkError)
            {
                // Failure with web request.
                Debug.Log("<color=red>Error Sending:</color> " + unityWebRequest.error);
            }
            else
            {
                // This query has returned, so add to the current count.
                _queriesReturned++;

                // Initialize event count integer.
                int eventCount = 0;

                // Deserialize the response with the custom Analytics class.
                Analytics welcome = JsonConvert.DeserializeObject<Analytics>
(unityWebRequest.downloadHandler.text);

                // Get and return the count for the Event
                if (int.TryParse(welcome.OdataCount, out eventCount) == false)
                {
                    // Parsing failed. Can sometimes mean that the Query URL was incorrect.
                    Debug.Log("<color=red>Failure to Parse Data Results. Check Query URL for issues.
</color>");
                }
                else
                {
                    // Overwrite the current pair, with its actual values, now that the event count 
is known.
                    _pairedObjectsWithEventCount[currentCount] = new KeyValuePair<GameObject, int>
(_pairedObjectsWithEventCount[currentCount].Key, eventCount);
                }

                // If all queries (compared with the number which was sent away) have 
                // returned, then run the determine winner method. 
                if (_queriesReturned == _pairedObjectsWithEventCount.Count)
                {
                    DetermineWinner();
                }
            }
        }
    }



    /// <summary>
    /// Call to determine the keyValue pair, within the objects list, 
    /// with the highest event count.
    /// </summary>
    private void DetermineWinner()
    {
        // Sort the values within the list of pairs.
        _pairedObjectsWithEventCount.Sort((x, y) => y.Value.CompareTo(x.Value));

        // Change its colour to green
        _pairedObjectsWithEventCount.First().Key.GetComponent<Renderer>().material.color = 
Color.green;

        // Provide the winner, and other results, within the console window. 
        string message = $"<b>Analytics Results:</b>\n " +
            $"<i>{_pairedObjectsWithEventCount.First().Key.name}</i> has the highest event count, " +
            $"with <i>{_pairedObjectsWithEventCount.First().Value.ToString()}</i>.\nFollowed by: ";

        for (int i = 1; i < _pairedObjectsWithEventCount.Count; i++)
        {
            message += $"{_pairedObjectsWithEventCount[i].Key.name}, " +
                $"with {_pairedObjectsWithEventCount[i].Value.ToString()} events.\n";
        }

        Debug.Log(message);
    }

8. The next method is DetermineWinner()DetermineWinner() , which sorts the list of GameObject and Int pairs, according to

the highest event count. It then changes the material color of that GameObject to green (as feedback for it

having the highest count). This displays a message with the analytics results.

9. Add the class structure which will be used to deserialize the JSON object, received from Application

Insights. Add these classes at the very bottom of your DataFromAnalyticsDataFromAnalytics  class file, outsideoutside of the

class definition.
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    /// <summary>
    /// These classes represent the structure of the JSON response from Azure Insight
    /// </summary>
    [Serializable]
    public class Analytics
    {
        [JsonProperty("@odata.context")]
        public string OdataContext { get; set; }

        [JsonProperty("@odata.count")]
        public string OdataCount { get; set; }

        [JsonProperty("value")]
        public Value[] Value { get; set; }
    }

    [Serializable]
    public class Value
    {
        [JsonProperty("customMetric")]
        public CustomMetric CustomMetric { get; set; }
    }

    [Serializable]
    public class CustomMetric
    {
        [JsonProperty("name")]
        public string Name { get; set; }
    }

10. Be sure to save your changes in Visual Studio before returning to Unity.

The MovementMovement script is the next script you'll need to create. It's responsible for :

Moving the Main Camera according to the direction the camera is looking towards.

Adding all other scripts to scene objects.

To create the script:

1. Double-click the Scr iptsScr ipts  folder, to open it.

2. Right-click inside the Scr iptsScr ipts  folder, click CreateCreate > C# Scr iptC# Scr ipt. Name the script MovementMovement.

3. Double-click the script to open it with Visual Studio.

4. Replace the existing code with the following:



    using UnityEngine;
    using UnityEngine.XR.WSA.Input;

    public class Movement : MonoBehaviour
    {
        /// <summary>
        /// The rendered object representing the right controller.
        /// </summary>
        public GameObject Controller;

        /// <summary>
        /// The movement speed of the user.
        /// </summary>
        public float UserSpeed;

        /// <summary>
        /// Provides whether source updates have been registered.
        /// </summary>
        private bool _isAttached = false;

        /// <summary>
        /// The chosen controller hand to use. 
        /// </summary>
        private InteractionSourceHandedness _handness = InteractionSourceHandedness.Right;

        /// <summary>
        /// Used to calculate and proposes movement translation.
        /// </summary>
        private Vector3 _playerMovementTranslation;

        private void Start()
        {
            // You are now adding components dynamically 
            // to ensure they are existing on the correct object  

            // Add all camera related scripts to the camera. 
            Camera.main.gameObject.AddComponent<Gaze>();
            Camera.main.gameObject.AddComponent<ObjectTrigger>();

            // Add all other scripts to this object.
            gameObject.AddComponent<ApplicationInsightsTracker>();
            gameObject.AddComponent<DataFromAnalytics>();
        }

        // Update is called once per frame
        void Update()
        {

        }
    }

    /// <summary>
    /// Used for tracking the current position and rotation of the controller.
    /// </summary>
    private void UpdateControllerState()
    {
#if UNITY_WSA && UNITY_2017_2_OR_NEWER
        // Check for current connected controllers, only if WSA.
        string message = string.Empty;

        if (InteractionManager.GetCurrentReading().Length > 0)
        {
            foreach (var sourceState in InteractionManager.GetCurrentReading())

5. Within the MovementMovement class, below the empty Update()Update()  method, insert the following methods that allow

the user to use the hand controller to move in the virtual space:



            foreach (var sourceState in InteractionManager.GetCurrentReading())
            {
                if (sourceState.source.kind == InteractionSourceKind.Controller && 
sourceState.source.handedness == _handness)
                {
                    // If a controller source is found, which matches the selected handness, 
                    // check whether interaction source updated events have been registered. 
                    if (_isAttached == false)
                    {
                        // Register events, as not yet registered.
                        message = "<color=green>Source Found: Registering Controller Source 
Events</color>";
                        _isAttached = true;

                        InteractionManager.InteractionSourceUpdated += 
InteractionManager_InteractionSourceUpdated;
                    }

                    // Update the position and rotation information for the controller.
                    Vector3 newPosition;
                    if (sourceState.sourcePose.TryGetPosition(out newPosition, 
InteractionSourceNode.Pointer) && ValidPosition(newPosition))
                    {
                        Controller.transform.localPosition = newPosition;
                    }

                    Quaternion newRotation;

                    if (sourceState.sourcePose.TryGetRotation(out newRotation, 
InteractionSourceNode.Pointer) && ValidRotation(newRotation))
                    {
                        Controller.transform.localRotation = newRotation;
                    }
                }
            }
        }
        else
        {
            // Controller source not detected. 
            message = "<color=blue>Trying to detect controller source</color>";

            if (_isAttached == true)
            {
                // A source was previously connected, however, has been lost. Disconnected
                // all registered events. 

                _isAttached = false;

                InteractionManager.InteractionSourceUpdated -= 
InteractionManager_InteractionSourceUpdated;

                message = "<color=red>Source Lost: Detaching Controller Source Events</color>";
            }
        }

        if(message != string.Empty)
        {
            Debug.Log(message);
        }
#endif
    }
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    /// <summary>
    /// This registered event is triggered when a source state has been updated.
    /// </summary>
    /// <param name="obj"></param>
    private void InteractionManager_InteractionSourceUpdated(InteractionSourceUpdatedEventArgs obj)
    {
        if (obj.state.source.handedness == _handness)
        {
            if(obj.state.thumbstickPosition.magnitude > 0.2f)
            {
                float thumbstickY = obj.state.thumbstickPosition.y;

                // Vertical Input.
                if (thumbstickY > 0.3f || thumbstickY < -0.3f)
                {
                    _playerMovementTranslation = Camera.main.transform.forward;
                    _playerMovementTranslation.y = 0;
                    transform.Translate(_playerMovementTranslation * UserSpeed * Time.deltaTime * 
thumbstickY, Space.World);
                }
            }
        }
    }

    /// <summary>
    /// Check that controller position is valid. 
    /// </summary>
    /// <param name="inputVector3">The Vector3 to check</param>
    /// <returns>The position is valid</returns>
    private bool ValidPosition(Vector3 inputVector3)
    {
        return !float.IsNaN(inputVector3.x) && !float.IsNaN(inputVector3.y) && 
!float.IsNaN(inputVector3.z) && !float.IsInfinity(inputVector3.x) && 
!float.IsInfinity(inputVector3.y) && !float.IsInfinity(inputVector3.z);
    }

    /// <summary>
    /// Check that controller rotation is valid. 
    /// </summary>
    /// <param name="inputQuaternion">The Quaternion to check</param>
    /// <returns>The rotation is valid</returns>
    private bool ValidRotation(Quaternion inputQuaternion)
    {
        return !float.IsNaN(inputQuaternion.x) && !float.IsNaN(inputQuaternion.y) && 
!float.IsNaN(inputQuaternion.z) && !float.IsNaN(inputQuaternion.w) && 
!float.IsInfinity(inputQuaternion.x) && !float.IsInfinity(inputQuaternion.y) && 
!float.IsInfinity(inputQuaternion.z) && !float.IsInfinity(inputQuaternion.w);
    }   

    // Update is called once per frame
    void Update()
    {
        UpdateControllerState();
    }

6. Lastly add the method call within the Update()Update()  method.

7. Be sure to save your changes in Visual Studio before returning to Unity.

In this Chapter you need to place the MovementMovement script onto the Camera ParentCamera Parent and set its reference targets.
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That script will then handle placing the other scripts where they need to be.

1. From the Scr iptsScr ipts  folder in the Project Panel, drag the MovementMovement script to the Camera ParentCamera Parent object,

located in the Hierarchy Panel.

2. Click the Camera ParentCamera Parent. In the Hierarchy Panel, drag the Right HandRight Hand object from the Hierarchy Panel

to the reference target, ControllerController , in the Inspector Panel. Set the User SpeedUser Speed to 55 , as shown in the

image below.

Everything needed for the Unity section of this project has now been completed, so it's time to build it from

Unity.

1. Navigate to Build SettingsBuild Settings , (FileFile > Build SettingsBuild Settings ).

2. From the Build SettingsBuild Settings  window, click BuildBuild.



3. A File ExplorerFile Explorer  window will pop up, prompting you for a location for the build. Create a new folder (by

clicking New FolderNew Folder  in the top-left corner), and name it BUILDSBUILDS .

a. Open the new BUILDSBUILDS  folder, and create another folder (using New FolderNew Folder  once more), and

name it MR_Azure_Application_InsightsMR_Azure_Application_Insights .
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IMPORTANTIMPORTANT

 Chapter 14 - The Application Insights Service portal

b. With the MR_Azure_Application_InsightsMR_Azure_Application_Insights  folder selected, click Select FolderSelect Folder . The project will

take a minute or so to build.

4. Following Build, File ExplorerFile Explorer  will appear showing you the location of your new project.

To deploy the MR_Azure_Application_InsightsMR_Azure_Application_Insights  app on your Local Machine:

1. Open the solution file of your MR_Azure_Application_InsightsMR_Azure_Application_Insights  app in Visual StudioVisual Studio.

2. In the Solution PlatformSolution Platform , select x86, Local Machinex86, Local Machine.

3. In the Solution ConfigurationSolution Configuration select DebugDebug.

4. Go to Build menuBuild menu and click Deploy SolutionDeploy Solution to sideload the application to your machine.

5. Your app should now appear in the list of installed apps, ready to be launched.

6. Launch the mixed reality application.

7. Move around the scene, approaching objects and looking at them, when the Azure Insight Service has

collected enough event data, it will set the object that has been approached the most to green.

While the average waiting time for the Events and Metrics to be collected by the Service takes around 15 min, in some

occasions it might take up to 1 hour.

Once you have roamed around the scene and gazed at several objects, you can see the data collected in the

Application Insights Service portal.

1. Go back to your Application Insights Service portal.



2. Select Metrics Explorer.

3. It will open in a tab containing the graph, which represent the Events and Metrics related to your

application. As mentioned above, it might take some time (up to 1 hour) for the data to be displayed in

the graph

4. Select the Events bar in the Total of Events by Application Version, to see a detailed breakdown of the

events with their names.



 Your finished your Application Insights Service application

 Bonus Exercises

Congratulations, you built a mixed reality app that leverages the Application Insights Service to monitor user's

activity within your app.

Exercise 1Exercise 1



Try spawning, rather than manually creating, the ObjectInScene objects and set their coordinates on the plane

within your scripts. In this way, you could ask Azure what the most popular object was (either from gaze or

proximity results) and spawn an extra one of those objects.

Exercise 2Exercise 2

Sort your Application Insights results by time, so that you get the most relevant data, and implement that time

sensitive data in your application.
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NOTENOTE
The Mixed Reality Academy tutorials were designed with HoloLens (1st gen) and Mixed Reality Immersive Headsets in

mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for guidance in

developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being used for

HoloLens 2. They will be maintained to continue working on the supported devices. There will be a new series of tutorials

that will be posted in the future that will demonstrate how to develop for HoloLens 2. This notice will be updated with a

link to those tutorials when they are posted.

In this course, you will learn how to recognize custom visual content and its spatial position within a provided

image, using Azure Custom Vision "Object Detection" capabilities in a mixed reality application.

This service will allow you to train a machine learning model using object images. You will then use the trained

model to recognize similar objects and approximate their location in the real world, as provided by the camera

capture of Microsoft HoloLens or a camera connect to a PC for immersive (VR) headsets.

Azure Custom Vision, Object DetectionAzure Custom Vision, Object Detection is a Microsoft Service which allows developers to build custom

image classifiers. These classifiers can then be used with new images to detect objects within that new image, by

providing Box BoundariesBox Boundaries  within the image itself. The Service provides a simple, easy to use, online portal to

streamline this process. For more information, visit the following links:

Azure Custom Vision page

Limits and Quotas

Upon completion of this course, you will have a mixed reality application which will be able to do the following:

1. The user will be able to gaze at an object, which they have trained using the Azure Custom Vision Service,

Object Detection.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/mr-azure-310.md
https://docs.microsoft.com/en-us/azure/cognitive-services/custom-vision-service/home
https://docs.microsoft.com/en-us/azure/cognitive-services/custom-vision-service/limits-and-quotas
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 Prerequisites

NOTENOTE

 Before you start

2. The user will use the Tap gesture to capture an image of what they are looking at.

3. The app will send the image to the Azure Custom Vision Service.

4. There will be a reply from the Service which will display the result of the recognition as world-space text. This

will be accomplished through utilizing the Microsoft HoloLens' Spatial Tracking, as a way of understanding

the world position of the recognized object, and then using the Tag associated with what is detected in the

image, to provide the label text.

The course will also cover manually uploading images, creating tags, and training the Service to recognize

different objects (in the provided example, a cup) by setting the Boundary Box within the image you submit.

Following the creation and use of the app, the developer should navigate back to the Azure Custom Vision Service, and

identify the predictions made by the Service, and determine whether they were correct or not (through tagging anything

the Service missed, and adjusting the Bounding Boxes). The Service can then be re-trained, which will increase the

likelihood of it recognizing real world objects.

This course will teach you how to get the results from the Azure Custom Vision Service, Object Detection, into a

Unity-based sample application. It will be up to you to apply these concepts to a custom application you might

be building.

This tutorial is designed for developers who have basic experience with Unity and C#. Please also be aware that the

prerequisites and written instructions within this document represent what has been tested and verified at the time of

writing (July 2018). You are free to use the latest software, as listed within the install the tools article, though it should not

be assumed that the information in this course will perfectly match what you will find in newer software than what is listed

below.

We recommend the following hardware and software for this course:

A development PC

Windows 10 Fall Creators Update (or later) with Developer mode enabled

The latest Windows 10 SDK

Unity 2017.4 LTS

Visual Studio 2017

A Microsoft HoloLens with Developer mode enabled

Internet access for Azure setup and Custom Vision Service retrieval

A series of at least fifteen (15) images are required) for each object that you would like the Custom Vision to

recognize. If you wish, you can use the images already provided with this course, a series of cups).

1. To avoid encountering issues building this project, it is strongly suggested that you create the project

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/windows/mixed-reality/hololens-hardware-details
https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20310%20-%20Object%20detection/Cup%20Images.zip
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mentioned in this tutorial in a root or near-root folder (long folder paths can cause issues at build-time).

2. Set up and test your HoloLens. If you need support for this, visit the HoloLens setup article.

3. It is a good idea to perform Calibration and Sensor Tuning when beginning developing a new HoloLens App

(sometimes it can help to perform those tasks for each user).

For help on Calibration, please follow this link to the HoloLens Calibration article.

For help on Sensor Tuning, please follow this link to the HoloLens Sensor Tuning article.

To use the Azure Custom Vision Ser viceAzure Custom Vision Ser vice, you will need to configure an instance of it to be made available to

your application.

1. Navigate to the Custom Vision Ser viceCustom Vision Ser vice main page.

2. Click on Getting Star tedGetting Star ted.

3. Sign in to the Custom Vision Portal.

4. If you do not already have an Azure account, you will need to create one. If you are following this tutorial

in a classroom or lab situation, ask your instructor or one of the proctors for help setting up your new

account.

https://docs.microsoft.com/en-us/hololens/hololens-setup
https://docs.microsoft.com/en-us/hololens/hololens-calibration#hololens-2
https://docs.microsoft.com/en-us/hololens/hololens-updates
https://azure.microsoft.com/services/cognitive-services/custom-vision-service/


5. Once you are logged in for the first time, you will be prompted with the Terms of Service panel. Click the

checkbox to agree to the terms. Then click I agreeI agree.

6. Having agreed to the terms, you are now in the My Projects section. Click on New ProjectNew Project.

7. A tab will appear on the right-hand side, which will prompt you to specify some fields for the project.

a. Insert a name for your project

b. Insert a description for your project (OptionalOptional )

c. Choose a Resource GroupResource Group or create a new one. A resource group provides a way to monitor,

control access, provision and manage billing for a collection of Azure assets. It is recommended to

keep all the Azure services associated with a single project (e.g. such as these courses) under a
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NOTENOTE

common resource group).

If you wish to read more about Azure Resource Groups, navigate to the associated Docs

d. Set the Project TypesProject Types  as Object Detection (preview)Object Detection (preview) .

8. Once you are finished, click on Create projectCreate project, and you will be redirected to the Custom Vision Service

project page.

Once in the Custom Vision Portal, your primary objective is to train your project to recognize specific objects in

images.

You need at least fifteen (15) images for each object that you would like your application to recognize. You can

use the images provided with this course (a series of cups).

https://docs.microsoft.com/en-us/azure/azure-resource-manager/resource-group-portal
https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20310%20-%20Object%20detection/Cup%20Images.zip


To train your Custom Vision project:

1. Click on the ++ button next to TagsTags .

2. Add a namename for the tag that will be used to associate your images with. In this example we are using

images of cups for recognition, so have named the tag for this, CupCup. Click SaveSave once finished.



3. You will notice your TagTag has been added (you may need to reload your page for it to appear).



TIPTIP

4. Click on Add imagesAdd images  in the center of the page.

5. Click on Browse local filesBrowse local files , and browse to the images you would like to upload for one object, with the

minimum being fifteen (15).

You can select several images at a time, to upload.



6. Press Upload filesUpload files  once you have selected all the images you would like to train the project with. The

files will begin uploading. Once you have confirmation of the upload, click DoneDone.



7. At this point your images are uploaded, but not tagged.



8. To tag your images, use your mouse. As you hover over your image, a selection highlight will aid you by

automatically drawing a selection around your object. If it is not accurate, you can draw your own. This is

accomplished by holding left-click on the mouse, and dragging the selection region to encompass your

object.

9. Following the selection of your object within the image, a small prompt will ask for you to Add Region

Tag. Select your previously created tag ('Cup', in the above example), or if you are adding more tags, type

that in and click the + (plus)+ (plus)  button.



NOTENOTE

10. To tag the next image, you can click the arrow to the right of the blade, or close the tag blade (by clicking

the XX in the top-right corner of the blade) and then click the next image. Once you have the next image

ready, repeat the same procedure. Do this for all the images you have uploaded, until they are all tagged.

You can select several objects in the same image, like the image below:

11. Once you have tagged them all, click on the taggedtagged button, on the left of the screen, to reveal the tagged

images.



12. You are now ready to train your Service. Click the TrainTrain button, and the first training iteration will begin.

13. Once it is built, you will be able to see two buttons called Make defaultMake default and Prediction URLPrediction URL . Click on

Make defaultMake default first, then click on Prediction URLPrediction URL .
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NOTENOTE
The endpoint which is provided from this, is set to whichever Iteration has been marked as default. As such, if you

later make a new Iteration and update it as default, you will not need to change your code.

14. Once you have clicked on Prediction URLPrediction URL , open Notepad, and copy and paste the URLURL  (also called your

Prediction-EndpointPrediction-Endpoint) and the Ser vice Prediction-KeySer vice Prediction-Key , so that you can retrieve it when you need it

later in the code.

The following is a typical set up for developing with mixed reality, and as such, is a good template for other

projects.

1. Open UnityUnity  and click NewNew .



2. You will now need to provide a Unity project name. Insert CustomVisionObjDetectionCustomVisionObjDetection. Make sure the

project type is set to 3D3D, and set the LocationLocation to somewhere appropriate for you (remember, closer to

root directories is better). Then, click Create projectCreate project.

3. With Unity open, it is worth checking the default Scr ipt EditorScr ipt Editor  is set to Visual StudioVisual Studio. Go to Edit >

Preferences and then from the new window, navigate to External ToolsExternal Tools . Change External Scr ipt EditorExternal Scr ipt Editor

to Visual StudioVisual Studio. Close the PreferencesPreferences  window.



4. Next, go to File > Build SettingsFile > Build Settings  and switch the PlatformPlatform to Universal Windows Platform, and then

clicking on the Switch PlatformSwitch Platform button.

5. In the same Build SettingsBuild Settings  window, ensure the following are set:

a. Target DeviceTarget Device is set to HoloLensHoloLens

b. Build TypeBuild Type is set to D3DD3D

c. SDKSDK is set to Latest installedLatest installed

d. Visual Studio VersionVisual Studio Version is set to Latest installedLatest installed



e. Build and RunBuild and Run is set to Local MachineLocal Machine

f. The remaining settings, in Build SettingsBuild Settings , should be left as default for now.

6. In the same Build SettingsBuild Settings  window, click on the Player SettingsPlayer Settings  button, this will open the related panel

in the space where the InspectorInspector  is located.

7. In this panel, a few settings need to be verified:

a. In the Other SettingsOther Settings  tab:

a. Scr ipting Runtime VersionScr ipting Runtime Version should be ExperimentalExperimental  (.NET 4.6 Equivalent), which will

trigger a need to restart the Editor.

b. Scr ipting BackendScripting Backend should be .NET.NET.

c. API Compatibility LevelAPI Compatibility Level  should be .NET 4.6.NET 4.6 .



b. Within the Publishing SettingsPublishing Settings  tab, under CapabilitiesCapabilities , check:

a. InternetClientInternetClient

b. WebcamWebcam

c. SpatialPerceptionSpatialPerception

 



c. Further down the panel, in XR SettingsXR Settings  (found below Publish SettingsPublish Settings ), tick Vir tual RealityVir tual Reality

Suppor tedSuppor ted, then make sure the Windows Mixed Reality SDKWindows Mixed Reality SDK is added.

8. Back in Build SettingsBuild Settings , Unity C# Projects is no longer greyed out: tick the checkbox next to this.

9. Close the Build SettingsBuild Settings  window.

10. In the EditorEditor , click on EditEdit > Project SettingsProject Settings  > GraphicsGraphics .



11. In the Inspector PanelInspector Panel  the Graphics Settings will be open. Scroll down until you see an array called

Always Include ShadersAlways Include Shaders . Add a slot by increasing the S izeSize variable by one (in this example, it was 8 so

we made it 9). A new slot will appear, in the last position of the array, as shown below:

12. In the slot, click on the small target circle next to the slot to open a list of shaders. Look for the LegacyLegacy

Shaders/Transparent/DiffuseShaders/Transparent/Diffuse shader and double-click it.
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For this course you are provided with a Unity Asset Package called Azure-MR-310.unitypackageAzure-MR-310.unitypackage.

[TIP] Any objects supported by Unity, including entire scenes, can be packaged into a .unitypackage.unitypackage file,

and exported / imported in other projects. It is the safest, and most efficient, way to move assets between

different Unity projectsUnity projects .

You can find the Azure-MR-310 package that you need to download here.

1. With the Unity dashboard in front of you, click on AssetsAssets  in the menu at the top of the screen, then click

on Impor t Package > Custom PackageImpor t Package > Custom Package.

2. Use the file picker to select the Azure-MR-310.unitypackageAzure-MR-310.unitypackage package and click OpenOpen. A list of

components for this asset will be displayed to you. Confirm the import by clicking the Impor tImpor t button.

https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20310%20-%20Object%20detection/Azure-MR-310.unitypackage


3. Once it has finished importing, you will notice that folders from the package have now been added to

your AssetsAssets  folder. This kind of folder structure is typical for a Unity project.

a. The Mater ialsMater ials  folder contains the material used by the Gaze CursorGaze Cursor .

b. The PluginsPlugins  folder contains the Newtonsoft DLL used by the code to deserialize the Service web

response. The two (2) different versions contained in the folder, and sub-folder, are necessary to

allow the library to be used and built by both the Unity Editor and the UWP build.

c. The PrefabsPrefabs  folder contains the prefabs contained in the scene. Those are:

a. The GazeCursorGazeCursor , the cursor used in the application. Will work together with the

SpatialMapping prefab to be able to be placed in the scene on top of physical objects.

b. The LabelLabel , which is the UI object used to display the object tag in the scene when required.

c. The SpatialMappingSpatialMapping, which is the object that enables the application to use create a virtual

map, using the Microsoft HoloLens' spatial tracking.

d. The ScenesScenes  folder which currently contains the pre-built scene for this course.

4. Open the ScenesScenes  folder, in the Project PanelProject Panel , and double-click on the ObjDetectionSceneObjDetectionScene, to load the

scene that you will use for this course.
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NOTENOTE

NOTENOTE
No code is includedNo code is included, you will write the code by following this course.

At this point you are ready to write some code. You will begin with the CustomVisionAnalyserCustomVisionAnalyser  class.

The calls to the Custom Vision Ser viceCustom Vision Ser vice, made in the code shown below, are made using the Custom Vision RESTCustom Vision REST

APIAPI . Through using this, you will see how to implement and make use of this API (useful for understanding how to

implement something similar on your own). Be aware, that Microsoft offers a Custom Vision SDKCustom Vision SDK that can also be used

to make calls to the Service. For more information visit the Custom Vision SDK article.

This class is responsible for :

Loading the latest image captured as an array of bytes.

Sending the byte array to your Azure Custom Vision Ser viceCustom Vision Ser vice instance for analysis.

Receiving the response as a JSON string.

Deserializing the response and passing the resulting PredictionPrediction to the SceneOrganiserSceneOrganiser  class, which

will take care of how the response should be displayed.

To create this class:

1. Right-click in the Asset FolderAsset Folder , located in the Project PanelProject Panel , then click CreateCreate > FolderFolder . Call the folder

Scr iptsScr ipts .

https://github.com/Microsoft/Cognitive-CustomVision-Windows/


using Newtonsoft.Json;
using System.Collections;
using System.IO;
using UnityEngine;
using UnityEngine.Networking;

    /// <summary>
    /// Unique instance of this class
    /// </summary>
    public static CustomVisionAnalyser Instance;

    /// <summary>
    /// Insert your prediction key here
    /// </summary>
    private string predictionKey = "- Insert your key here -";

    /// <summary>
    /// Insert your prediction endpoint here
    /// </summary>
    private string predictionEndpoint = "Insert your prediction endpoint here";

    /// <summary>
    /// Bite array of the image to submit for analysis
    /// </summary>
    [HideInInspector] public byte[] imageBytes;

2. Double-click on the newly created folder, to open it.

3. Right-click inside the folder, then click CreateCreate > C# Scr iptC# Scr ipt. Name the script CustomVisionAnalyser.CustomVisionAnalyser.

4. Double-click on the new CustomVisionAnalyserCustomVisionAnalyser  script to open it with Visual Studio.Visual Studio.

5. Make sure you have the following namespaces referenced at the top of the file:

6. In the CustomVisionAnalyserCustomVisionAnalyser  class, add the following variables:



NOTENOTE

    /// <summary>
    /// Initializes this class
    /// </summary>
    private void Awake()
    {
        // Allows this instance to behave like a singleton
        Instance = this;
    }

NOTENOTE

Make sure you insert your Ser vice Prediction-KeySer vice Prediction-Key into the predictionKeypredictionKey variable and your Prediction-Prediction-

EndpointEndpoint  into the predictionEndpointpredictionEndpoint  variable. You copied these to Notepad earlier, in Chapter 2, Step 14.

7. Code for Awake()Awake()  now needs to be added to initialize the Instance variable:

8. Add the coroutine (with the static GetImageAsByteArray()GetImageAsByteArray()  method below it), which will obtain the

results of the analysis of the image, captured by the ImageCaptureImageCapture class.

In the AnalyseImageCaptureAnalyseImageCapture coroutine, there is a call to the SceneOrganiserSceneOrganiser  class that you are yet to create.

Therefore, leave those lines commented for nowleave those lines commented for now.



    /// <summary>
    /// Call the Computer Vision Service to submit the image.
    /// </summary>
    public IEnumerator AnalyseLastImageCaptured(string imagePath)
    {
        Debug.Log("Analyzing...");

        WWWForm webForm = new WWWForm();

        using (UnityWebRequest unityWebRequest = UnityWebRequest.Post(predictionEndpoint, webForm))
        {
            // Gets a byte array out of the saved image
            imageBytes = GetImageAsByteArray(imagePath);

            unityWebRequest.SetRequestHeader("Content-Type", "application/octet-stream");
            unityWebRequest.SetRequestHeader("Prediction-Key", predictionKey);

            // The upload handler will help uploading the byte array with the request
            unityWebRequest.uploadHandler = new UploadHandlerRaw(imageBytes);
            unityWebRequest.uploadHandler.contentType = "application/octet-stream";

            // The download handler will help receiving the analysis from Azure
            unityWebRequest.downloadHandler = new DownloadHandlerBuffer();

            // Send the request
            yield return unityWebRequest.SendWebRequest();

            string jsonResponse = unityWebRequest.downloadHandler.text;

            Debug.Log("response: " + jsonResponse);

            // Create a texture. Texture size does not matter, since
            // LoadImage will replace with the incoming image size.
            //Texture2D tex = new Texture2D(1, 1);
            //tex.LoadImage(imageBytes);
            //SceneOrganiser.Instance.quadRenderer.material.SetTexture("_MainTex", tex);

            // The response will be in JSON format, therefore it needs to be deserialized
            //AnalysisRootObject analysisRootObject = new AnalysisRootObject();
            //analysisRootObject = JsonConvert.DeserializeObject<AnalysisRootObject>(jsonResponse);

            //SceneOrganiser.Instance.FinaliseLabel(analysisRootObject);
        }
    }

    /// <summary>
    /// Returns the contents of the specified image file as a byte array.
    /// </summary>
    static byte[] GetImageAsByteArray(string imageFilePath)
    {
        FileStream fileStream = new FileStream(imageFilePath, FileMode.Open, FileAccess.Read);

        BinaryReader binaryReader = new BinaryReader(fileStream);

        return binaryReader.ReadBytes((int)fileStream.Length);
    }

9. Delete the Star t()Star t()  and Update()Update()  methods, as they will not be used.

10. Be sure to save your changes in Visual StudioVisual Studio, before returning to UnityUnity .



IMPORTANTIMPORTANT
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As mentioned earlier, do not worry about code which might appear to have an error, as you will provide further classes

soon, which will fix these.

The class you will create now is the CustomVisionObjectsCustomVisionObjects  class.

This script contains a number of objects used by other classes to serialize and deserialize the calls made to the

Custom Vision Service.

To create this class:

using System;
using System.Collections.Generic;
using UnityEngine;
using UnityEngine.Networking;

WARNINGWARNING

// The objects contained in this script represent the deserialized version
// of the objects used by this application 

/// <summary>
/// Web request object for image data
/// </summary>
class MultipartObject : IMultipartFormSection
{
    public string sectionName { get; set; }

    public byte[] sectionData { get; set; }

    public string fileName { get; set; }

    public string contentType { get; set; }
}

/// <summary>
/// JSON of all Tags existing within the project
/// contains the list of Tags
/// </summary> 

1. Right-click inside the Scr iptsScr ipts  folder, then click CreateCreate > C# Scr iptC# Scr ipt. Call the script

CustomVisionObjects.CustomVisionObjects.

2. Double-click on the new CustomVisionObjectsCustomVisionObjects  script to open it with Visual Studio.Visual Studio.

3. Make sure you have the following namespaces referenced at the top of the file:

4. Delete the Star t()Star t()  and Update()Update()  methods inside the CustomVisionObjectsCustomVisionObjects  class, this class should now

be empty.

It is important you follow the next instruction carefully. If you put the new class declarations inside the

CustomVisionObjectsCustomVisionObjects  class, you will get compile errors in chapter 10, stating that AnalysisRootObjectAnalysisRootObject  and

BoundingBoxBoundingBox are not found.

5. Add the following classes outside the CustomVisionObjectsCustomVisionObjects  class. These objects are used by the

NewtonsoftNewtonsoft library to serialize and deserialize the response data:



/// </summary> 
public class Tags_RootObject
{
    public List<TagOfProject> Tags { get; set; }
    public int TotalTaggedImages { get; set; }
    public int TotalUntaggedImages { get; set; }
}

public class TagOfProject
{
    public string Id { get; set; }
    public string Name { get; set; }
    public string Description { get; set; }
    public int ImageCount { get; set; }
}

/// <summary>
/// JSON of Tag to associate to an image
/// Contains a list of hosting the tags,
/// since multiple tags can be associated with one image
/// </summary> 
public class Tag_RootObject
{
    public List<Tag> Tags { get; set; }
}

public class Tag
{
    public string ImageId { get; set; }
    public string TagId { get; set; }
}

/// <summary>
/// JSON of images submitted
/// Contains objects that host detailed information about one or more images
/// </summary> 
public class ImageRootObject
{
    public bool IsBatchSuccessful { get; set; }
    public List<SubmittedImage> Images { get; set; }
}

public class SubmittedImage
{
    public string SourceUrl { get; set; }
    public string Status { get; set; }
    public ImageObject Image { get; set; }
}

public class ImageObject
{
    public string Id { get; set; }
    public DateTime Created { get; set; }
    public int Width { get; set; }
    public int Height { get; set; }
    public string ImageUri { get; set; }
    public string ThumbnailUri { get; set; }
}

/// <summary>
/// JSON of Service Iteration
/// </summary> 
public class Iteration
{
    public string Id { get; set; }
    public string Name { get; set; }
    public bool IsDefault { get; set; }
    public string Status { get; set; }
    public string Created { get; set; }
    public string LastModified { get; set; }



 Chapter 7 - Create the SpatialMapping class

    public string LastModified { get; set; }
    public string TrainedAt { get; set; }
    public string ProjectId { get; set; }
    public bool Exportable { get; set; }
    public string DomainId { get; set; }
}

/// <summary>
/// Predictions received by the Service
/// after submitting an image for analysis
/// Includes Bounding Box
/// </summary>
public class AnalysisRootObject
{
    public string id { get; set; }
    public string project { get; set; }
    public string iteration { get; set; }
    public DateTime created { get; set; }
    public List<Prediction> predictions { get; set; }
}

public class BoundingBox
{
    public double left { get; set; }
    public double top { get; set; }
    public double width { get; set; }
    public double height { get; set; }
}

public class Prediction
{
    public double probability { get; set; }
    public string tagId { get; set; }
    public string tagName { get; set; }
    public BoundingBox boundingBox { get; set; }
}

6. Be sure to save your changes in Visual StudioVisual Studio, before returning to UnityUnity .

This class will set the Spatial Mapping ColliderSpatial Mapping Collider  in the scene so to be able to detect collisions between virtual

objects and real objects.

To create this class:

using UnityEngine;
using UnityEngine.XR.WSA;

1. Right-click inside the Scr iptsScr ipts  folder, then click CreateCreate > C# Scr iptC# Scr ipt. Call the script SpatialMapping.SpatialMapping.

2. Double-click on the new SpatialMappingSpatialMapping script to open it with Visual Studio.Visual Studio.

3. Make sure you have the following namespaces referenced above the SpatialMappingSpatialMapping class:

4. Then, add the following variables inside the SpatialMappingSpatialMapping class, above the Star t()Star t()  method:
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    /// <summary>
    /// Allows this class to behave like a singleton
    /// </summary>
    public static SpatialMapping Instance;

    /// <summary>
    /// Used by the GazeCursor as a property with the Raycast call
    /// </summary>
    internal static int PhysicsRaycastMask;

    /// <summary>
    /// The layer to use for spatial mapping collisions
    /// </summary>
    internal int physicsLayer = 31;

    /// <summary>
    /// Creates environment colliders to work with physics
    /// </summary>
    private SpatialMappingCollider spatialMappingCollider;

    /// <summary>
    /// Initializes this class
    /// </summary>
    private void Awake()
    {
        // Allows this instance to behave like a singleton
        Instance = this;
    }

    /// <summary>
    /// Runs at initialization right after Awake method
    /// </summary>
    void Start()
    {
        // Initialize and configure the collider
        spatialMappingCollider = gameObject.GetComponent<SpatialMappingCollider>();
        spatialMappingCollider.surfaceParent = this.gameObject;
        spatialMappingCollider.freezeUpdates = false;
        spatialMappingCollider.layer = physicsLayer;

        // define the mask
        PhysicsRaycastMask = 1 << physicsLayer;

        // set the object as active one
        gameObject.SetActive(true);
    }

5. Add the Awake()Awake()  and Star t()Star t() :

6. Delete the Update()Update()  method.

7. Be sure to save your changes in Visual StudioVisual Studio, before returning to UnityUnity .

This class is responsible for setting up the cursor in the correct location in real space, by making use of the

SpatialMappingColliderSpatialMappingCollider , created in the previous chapter.

To create this class:

1. Right-click inside the Scr iptsScr ipts  folder, then click CreateCreate > C# Scr iptC# Scr ipt. Call the script GazeCursorGazeCursor

2. Double-click on the new GazeCursorGazeCursor  script to open it with Visual Studio.Visual Studio.



using UnityEngine;

    /// <summary>
    /// The cursor (this object) mesh renderer
    /// </summary>
    private MeshRenderer meshRenderer;

    /// <summary>
    /// Runs at initialization right after the Awake method
    /// </summary>
    void Start()
    {
        // Grab the mesh renderer that is on the same object as this script.
        meshRenderer = gameObject.GetComponent<MeshRenderer>();

        // Set the cursor reference
        SceneOrganiser.Instance.cursor = gameObject;
        gameObject.GetComponent<Renderer>().material.color = Color.green;

        // If you wish to change the size of the cursor you can do so here
        gameObject.transform.localScale = new Vector3(0.01f, 0.01f, 0.01f);
    }

    /// <summary>
    /// Update is called once per frame
    /// </summary>
    void Update()
    {
        // Do a raycast into the world based on the user's head position and orientation.
        Vector3 headPosition = Camera.main.transform.position;
        Vector3 gazeDirection = Camera.main.transform.forward;

        RaycastHit gazeHitInfo;
        if (Physics.Raycast(headPosition, gazeDirection, out gazeHitInfo, 30.0f, 
SpatialMapping.PhysicsRaycastMask))
        {
            // If the raycast hit a hologram, display the cursor mesh.
            meshRenderer.enabled = true;
            // Move the cursor to the point where the raycast hit.
            transform.position = gazeHitInfo.point;
            // Rotate the cursor to hug the surface of the hologram.
            transform.rotation = Quaternion.FromToRotation(Vector3.up, gazeHitInfo.normal);
        }
        else
        {
            // If the raycast did not hit a hologram, hide the cursor mesh.
            meshRenderer.enabled = false;
        }
    }

3. Make sure you have the following namespace referenced above the GazeCursorGazeCursor  class:

4. Then add the following variable inside the GazeCursorGazeCursor  class, above the Star t()Star t()  method.

5. Update the Star t()Star t()  method with the following code:

6. Update the Update()Update()  method with the following code:
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NOTENOTE
Do not worry about the error for the SceneOrganiserSceneOrganiser  class not being found, you will create it in the next

chapter.

7. Be sure to save your changes in Visual StudioVisual Studio, before returning to UnityUnity .

This class will:

Set up the Main Camera by attaching the appropriate components to it.

When an object is detected, it will be responsible for calculating its position in the real world and place a

Tag LabelTag Label  near it with the appropriate Tag NameTag Name.

To create this class:

using System.Collections.Generic;
using System.Linq;
using UnityEngine;

1. Right-click inside the Scr iptsScr ipts  folder, then click CreateCreate > C# Scr iptC# Scr ipt. Name the script SceneOrganiserSceneOrganiser .

2. Double-click on the new SceneOrganiserSceneOrganiser  script to open it with Visual Studio.Visual Studio.

3. Make sure you have the following namespaces referenced above the SceneOrganiserSceneOrganiser  class:

4. Then add the following variables inside the SceneOrganiserSceneOrganiser  class, above the Star t()Star t()  method:



    /// <summary>
    /// Allows this class to behave like a singleton
    /// </summary>
    public static SceneOrganiser Instance;

    /// <summary>
    /// The cursor object attached to the Main Camera
    /// </summary>
    internal GameObject cursor;

    /// <summary>
    /// The label used to display the analysis on the objects in the real world
    /// </summary>
    public GameObject label;

    /// <summary>
    /// Reference to the last Label positioned
    /// </summary>
    internal Transform lastLabelPlaced;

    /// <summary>
    /// Reference to the last Label positioned
    /// </summary>
    internal TextMesh lastLabelPlacedText;

    /// <summary>
    /// Current threshold accepted for displaying the label
    /// Reduce this value to display the recognition more often
    /// </summary>
    internal float probabilityThreshold = 0.8f;

    /// <summary>
    /// The quad object hosting the imposed image captured
    /// </summary>
    private GameObject quad;

    /// <summary>
    /// Renderer of the quad object
    /// </summary>
    internal Renderer quadRenderer;

    /// <summary>
    /// Called on initialization
    /// </summary>
    private void Awake()
    {
        // Use this class instance as singleton
        Instance = this;

        // Add the ImageCapture class to this Gameobject
        gameObject.AddComponent<ImageCapture>();

        // Add the CustomVisionAnalyser class to this Gameobject
        gameObject.AddComponent<CustomVisionAnalyser>();

        // Add the CustomVisionObjects class to this Gameobject
        gameObject.AddComponent<CustomVisionObjects>();
    }

5. Delete the Star t()Star t()  and Update()Update()  methods.

6. Underneath the variables, add the Awake()Awake()  method, which will initialize the class and set up the scene.

7. Add the PlaceAnalysisLabel()PlaceAnalysisLabel()  method, which will Instantiate the label in the scene (which at this point is



    /// <summary>
    /// Instantiate a Label in the appropriate location relative to the Main Camera.
    /// </summary>
    public void PlaceAnalysisLabel()
    {
        lastLabelPlaced = Instantiate(label.transform, cursor.transform.position, 
transform.rotation);
        lastLabelPlacedText = lastLabelPlaced.GetComponent<TextMesh>();
        lastLabelPlacedText.text = "";
        lastLabelPlaced.transform.localScale = new Vector3(0.005f,0.005f,0.005f);

        // Create a GameObject to which the texture can be applied
        quad = GameObject.CreatePrimitive(PrimitiveType.Quad);
        quadRenderer = quad.GetComponent<Renderer>() as Renderer;
        Material m = new Material(Shader.Find("Legacy Shaders/Transparent/Diffuse"));
        quadRenderer.material = m;

        // Here you can set the transparency of the quad. Useful for debugging
        float transparency = 0f;
        quadRenderer.material.color = new Color(1, 1, 1, transparency);

        // Set the position and scale of the quad depending on user position
        quad.transform.parent = transform;
        quad.transform.rotation = transform.rotation;

        // The quad is positioned slightly forward in font of the user
        quad.transform.localPosition = new Vector3(0.0f, 0.0f, 3.0f);

        // The quad scale as been set with the following value following experimentation,  
        // to allow the image on the quad to be as precisely imposed to the real world as possible
        quad.transform.localScale = new Vector3(3f, 1.65f, 1f);
        quad.transform.parent = null;
    }

invisible to the user). It also places the quad (also invisible) where the image is placed, and overlaps with

the real world. This is important because the box coordinates retrieved from the Service after analysis are

traced back into this quad to determined the approximate location of the object in the real world.

8. Add the FinaliseLabel()FinaliseLabel()  method. It is responsible for :

Setting the Label text with the Tag of the Prediction with the highest confidence.

Calling the calculation of the Bounding Box on the quad object, positioned previously, and placing the

label in the scene.

Adjusting the label depth by using a Raycast towards the Bounding Box, which should collide against

the object in the real world.

Resetting the capture process to allow the user to capture another image.



    /// <summary>
    /// Set the Tags as Text of the last label created. 
    /// </summary>
    public void FinaliseLabel(AnalysisRootObject analysisObject)
    {
        if (analysisObject.predictions != null)
        {
            lastLabelPlacedText = lastLabelPlaced.GetComponent<TextMesh>();
            // Sort the predictions to locate the highest one
            List<Prediction> sortedPredictions = new List<Prediction>();
            sortedPredictions = analysisObject.predictions.OrderBy(p => p.probability).ToList();
            Prediction bestPrediction = new Prediction();
            bestPrediction = sortedPredictions[sortedPredictions.Count - 1];

            if (bestPrediction.probability > probabilityThreshold)
            {
                quadRenderer = quad.GetComponent<Renderer>() as Renderer;
                Bounds quadBounds = quadRenderer.bounds;

                // Position the label as close as possible to the Bounding Box of the prediction 
                // At this point it will not consider depth
                lastLabelPlaced.transform.parent = quad.transform;
                lastLabelPlaced.transform.localPosition = CalculateBoundingBoxPosition(quadBounds, 
bestPrediction.boundingBox);

                // Set the tag text
                lastLabelPlacedText.text = bestPrediction.tagName;

                // Cast a ray from the user's head to the currently placed label, it should hit the 
object detected by the Service.
                // At that point it will reposition the label where the ray HL sensor collides with 
the object,
                // (using the HL spatial tracking)
                Debug.Log("Repositioning Label");
                Vector3 headPosition = Camera.main.transform.position;
                RaycastHit objHitInfo;
                Vector3 objDirection = lastLabelPlaced.position;
                if (Physics.Raycast(headPosition, objDirection, out objHitInfo, 30.0f,   
SpatialMapping.PhysicsRaycastMask))
                {
                    lastLabelPlaced.position = objHitInfo.point;
                }
            }
        }
        // Reset the color of the cursor
        cursor.GetComponent<Renderer>().material.color = Color.green;

        // Stop the analysis process
        ImageCapture.Instance.ResetImageCapture();        
    }

9. Add the CalculateBoundingBoxPosition()CalculateBoundingBoxPosition()  method, which hosts a number of calculations necessary to

translate the Bounding Box coordinates retrieved from the Service and recreate them proportionally on

the quad.



NOTENOTE
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    /// <summary>
    /// This method hosts a series of calculations to determine the position 
    /// of the Bounding Box on the quad created in the real world
    /// by using the Bounding Box received back alongside the Best Prediction
    /// </summary>
    public Vector3 CalculateBoundingBoxPosition(Bounds b, BoundingBox boundingBox)
    {
        Debug.Log($"BB: left {boundingBox.left}, top {boundingBox.top}, width {boundingBox.width}, 
height {boundingBox.height}");

        double centerFromLeft = boundingBox.left + (boundingBox.width / 2);
        double centerFromTop = boundingBox.top + (boundingBox.height / 2);
        Debug.Log($"BB CenterFromLeft {centerFromLeft}, CenterFromTop {centerFromTop}");

        double quadWidth = b.size.normalized.x;
        double quadHeight = b.size.normalized.y;
        Debug.Log($"Quad Width {b.size.normalized.x}, Quad Height {b.size.normalized.y}");

        double normalisedPos_X = (quadWidth * centerFromLeft) - (quadWidth/2);
        double normalisedPos_Y = (quadHeight * centerFromTop) - (quadHeight/2);

        return new Vector3((float)normalisedPos_X, (float)normalisedPos_Y, 0);
    }

IMPORTANTIMPORTANT

// Create a texture. Texture size does not matter, since 
// LoadImage will replace with the incoming image size.
Texture2D tex = new Texture2D(1, 1);
tex.LoadImage(imageBytes);
SceneOrganiser.Instance.quadRenderer.material.SetTexture("_MainTex", tex);

// The response will be in JSON format, therefore it needs to be deserialized
AnalysisRootObject analysisRootObject = new AnalysisRootObject();
analysisRootObject = JsonConvert.DeserializeObject<AnalysisRootObject>(jsonResponse);

SceneOrganiser.Instance.FinaliseLabel(analysisRootObject);

10. Be sure to save your changes in Visual StudioVisual Studio, before returning to UnityUnity .

Before you continue, open the CustomVisionAnalyserCustomVisionAnalyser  class, and within the AnalyseLastImageCaptured()AnalyseLastImageCaptured()

method, uncomment the following lines:

Do not worry about the ImageCaptureImageCapture class 'could not be found' message, you will create it in the next chapter.

The next class you are going to create is the ImageCaptureImageCapture class.

This class is responsible for :

Capturing an image using the HoloLens camera and storing it in the App folder.

Handling Tap gestures from the user.

To create this class:

1. Go to the Scr iptsScr ipts  folder you created previously.



using System;
using System.IO;
using System.Linq;
using UnityEngine;
using UnityEngine.XR.WSA.Input;
using UnityEngine.XR.WSA.WebCam;

    /// <summary>
    /// Allows this class to behave like a singleton
    /// </summary>
    public static ImageCapture Instance;

    /// <summary>
    /// Keep counts of the taps for image renaming
    /// </summary>
    private int captureCount = 0;

    /// <summary>
    /// Photo Capture object
    /// </summary>
    private PhotoCapture photoCaptureObject = null;

    /// <summary>
    /// Allows gestures recognition in HoloLens
    /// </summary>
    private GestureRecognizer recognizer;

    /// <summary>
    /// Flagging if the capture loop is running
    /// </summary>
    internal bool captureIsActive;

    /// <summary>
    /// File path of current analysed photo
    /// </summary>
    internal string filePath = string.Empty;

2. Right-click inside the folder, then click CreateCreate > C# Scr iptC# Scr ipt. Name the script ImageCaptureImageCapture.

3. Double-click on the new ImageCaptureImageCapture script to open it with Visual Studio.Visual Studio.

4. Replace the namespaces at the top of the file with the following:

5. Then add the following variables inside the ImageCaptureImageCapture class, above the Star t()Star t()  method:

6. Code for Awake()Awake()  and Star t()Star t()  methods now needs to be added:



    /// <summary>
    /// Called on initialization
    /// </summary>
    private void Awake()
    {
        Instance = this;
    }

    /// <summary>
    /// Runs at initialization right after Awake method
    /// </summary>
    void Start()
    {
        // Clean up the LocalState folder of this application from all photos stored
        DirectoryInfo info = new DirectoryInfo(Application.persistentDataPath);
        var fileInfo = info.GetFiles();
        foreach (var file in fileInfo)
        {
            try
            {
                file.Delete();
            }
            catch (Exception)
            {
                Debug.LogFormat("Cannot delete file: ", file.Name);
            }
        } 

        // Subscribing to the Microsoft HoloLens API gesture recognizer to track user gestures
        recognizer = new GestureRecognizer();
        recognizer.SetRecognizableGestures(GestureSettings.Tap);
        recognizer.Tapped += TapHandler;
        recognizer.StartCapturingGestures();
    }

    /// <summary>
    /// Respond to Tap Input.
    /// </summary>
    private void TapHandler(TappedEventArgs obj)
    {
        if (!captureIsActive)
        {
            captureIsActive = true;

            // Set the cursor color to red
            SceneOrganiser.Instance.cursor.GetComponent<Renderer>().material.color = Color.red;

            // Begin the capture loop
            Invoke("ExecuteImageCaptureAndAnalysis", 0);
        }
    }

IMPORTANTIMPORTANT

7. Implement a handler that will be called when a Tap gesture occurs:

When the cursor is greengreen, it means the camera is available to take the image. When the cursor is redred, it means

the camera is busy.

8. Add the method that the application uses to start the image capture process and store the image:



    /// <summary>
    /// Begin process of image capturing and send to Azure Custom Vision Service.
    /// </summary>
    private void ExecuteImageCaptureAndAnalysis()
    {
        // Create a label in world space using the ResultsLabel class 
        // Invisible at this point but correctly positioned where the image was taken
        SceneOrganiser.Instance.PlaceAnalysisLabel();

        // Set the camera resolution to be the highest possible
        Resolution cameraResolution = PhotoCapture.SupportedResolutions.OrderByDescending
            ((res) => res.width * res.height).First();
        Texture2D targetTexture = new Texture2D(cameraResolution.width, cameraResolution.height);

        // Begin capture process, set the image format
        PhotoCapture.CreateAsync(true, delegate (PhotoCapture captureObject)
        {
            photoCaptureObject = captureObject;

            CameraParameters camParameters = new CameraParameters
            {
                hologramOpacity = 1.0f,
                cameraResolutionWidth = targetTexture.width,
                cameraResolutionHeight = targetTexture.height,
                pixelFormat = CapturePixelFormat.BGRA32
            };

            // Capture the image from the camera and save it in the App internal folder
            captureObject.StartPhotoModeAsync(camParameters, delegate 
(PhotoCapture.PhotoCaptureResult result)
            {
                string filename = string.Format(@"CapturedImage{0}.jpg", captureCount);
                filePath = Path.Combine(Application.persistentDataPath, filename);          
                captureCount++;              
                photoCaptureObject.TakePhotoAsync(filePath, PhotoCaptureFileOutputFormat.JPG, 
OnCapturedPhotoToDisk);              
            });
        });
    }

9. Add the handlers that will be called when the photo has been captured and for when it is ready to be

analyzed. The result is then passed to the CustomVisionAnalyserCustomVisionAnalyser  for analysis.



 Chapter 11 - Setting up the scripts in the scene

    /// <summary>
    /// Register the full execution of the Photo Capture. 
    /// </summary>
    void OnCapturedPhotoToDisk(PhotoCapture.PhotoCaptureResult result)
    {
        try
        {
            // Call StopPhotoMode once the image has successfully captured
            photoCaptureObject.StopPhotoModeAsync(OnStoppedPhotoMode);
        }
        catch (Exception e)
        {
            Debug.LogFormat("Exception capturing photo to disk: {0}", e.Message);
        }
    }

    /// <summary>
    /// The camera photo mode has stopped after the capture.
    /// Begin the image analysis process.
    /// </summary>
    void OnStoppedPhotoMode(PhotoCapture.PhotoCaptureResult result)
    {
        Debug.LogFormat("Stopped Photo Mode");

        // Dispose from the object in memory and request the image analysis 
        photoCaptureObject.Dispose();
        photoCaptureObject = null;

        // Call the image analysis
        StartCoroutine(CustomVisionAnalyser.Instance.AnalyseLastImageCaptured(filePath)); 
    }

    /// <summary>
    /// Stops all capture pending actions
    /// </summary>
    internal void ResetImageCapture()
    {
        captureIsActive = false;

        // Set the cursor color to green
        SceneOrganiser.Instance.cursor.GetComponent<Renderer>().material.color = Color.green;

        // Stop the capture loop if active
        CancelInvoke();
    }

10. Be sure to save your changes in Visual StudioVisual Studio, before returning to UnityUnity .

Now that you have written all of the code necessary for this project, is time to set up the scripts in the scene, and

on the prefabs, for them to behave correctly.

1. Within the Unity EditorUnity Editor , in the Hierarchy PanelHierarchy Panel , select the Main CameraMain Camera.

2. In the Inspector PanelInspector Panel , with the Main CameraMain Camera selected, click on Add ComponentAdd Component, then search for

SceneOrganiserSceneOrganiser  script and double-click, to add it.



3. In the Project PanelProject Panel , open the Prefabs folderPrefabs folder , drag the LabelLabel  prefab into the Label empty reference

target input area, in the SceneOrganiserSceneOrganiser  script that you have just added to the Main Camera, as shown

in the image below:

4. In the Hierarchy PanelHierarchy Panel , select the GazeCursorGazeCursor  child of the Main CameraMain Camera.

5. In the Inspector PanelInspector Panel , with the GazeCursorGazeCursor  selected, click on Add ComponentAdd Component, then search for

GazeCursorGazeCursor  script and double-click, to add it.



6. Again, in the Hierarchy PanelHierarchy Panel , select the SpatialMappingSpatialMapping child of the Main CameraMain Camera.

7. In the Inspector PanelInspector Panel , with the SpatialMappingSpatialMapping selected, click on Add ComponentAdd Component, then search for

SpatialMappingSpatialMapping script and double-click, to add it.

The remaining scripts thats you have not set will be added by the code in the SceneOrganiserSceneOrganiser  script, during

runtime.
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 Chapter 13 - Build the UWP solution and sideload your application

To perform a thorough test of your application you will need to sideload it onto your Microsoft HoloLens.

Before you do, ensure that:

All the settings mentioned in the Chapter 3 are set correctly.

The script SceneOrganiserSceneOrganiser  is attached to the Main CameraMain Camera object.

The script GazeCursorGazeCursor  is attached to the GazeCursorGazeCursor  object.

The script SpatialMappingSpatialMapping is attached to the SpatialMappingSpatialMapping object.

In Chapter 5, Step 6:

Make sure you insert your Ser vice Prediction KeySer vice Prediction Key  into the predictionKeypredictionKey  variable.

You have inserted your Prediction EndpointPrediction Endpoint into the predictionEndpointpredictionEndpoint class.

You are now ready to build you application as a UWP Solution that you will be able to deploy on to the Microsoft

HoloLens. To begin the build process:

1. Go to File > Build SettingsFile > Build Settings .

2. Tick Unity C# ProjectsUnity C# Projects .

3. Click on Add Open ScenesAdd Open Scenes . This will add the currently open scene to the build.

4. Click BuildBuild. Unity will launch a File Explorer window, where you need to create and then select a folder to

build the app into. Create that folder now, and name it AppApp. Then with the AppApp folder selected, click



  To use the application:To use the application:

IMPORTANTIMPORTANT

NOTENOTE

 Your Custom Vision, Object Detection application

Select FolderSelect Folder .

5. Unity will begin building your project to the AppApp folder.

6. Once Unity has finished building (it might take some time), it will open a File ExplorerFile Explorer  window at the

location of your build (check your task bar, as it may not always appear above your windows, but will

notify you of the addition of a new window).

7. To deploy on to Microsoft HoloLens, you will need the IP Address of that device (for Remote Deploy), and

to ensure that it also has Developer ModeDeveloper Mode set. To do this:

a. Whilst wearing your HoloLens, open the SettingsSettings .

b. Go to Network & InternetNetwork & Internet > Wi-FiWi-Fi  > Advanced OptionsAdvanced Options

c. Note the IPv4IPv4  address.

d. Next, navigate back to SettingsSettings , and then to Update & SecurityUpdate & Security  > For DevelopersFor Developers

e. Set Developer ModeDeveloper Mode On.

8. Navigate to your new Unity build (the AppApp folder) and open the solution file with Visual StudioVisual Studio.

9. In the Solution Configuration select DebugDebug.

10. In the Solution Platform, select x86, Remote Machinex86, Remote Machine. You will be prompted to insert the IP addressIP address  of

a remote device (the Microsoft HoloLens, in this case, which you noted).

11. Go to the BuildBuild menu and click on Deploy SolutionDeploy Solution to sideload the application to your HoloLens.

12. Your app should now appear in the list of installed apps on your Microsoft HoloLens, ready to be

launched!

Look at an object, which you have trained with your Azure Custom Vision Ser vice, Object DetectionAzure Custom Vision Ser vice, Object Detection,

and use the Tap gestureTap gesture.

If the object is successfully detected, a world-space Label Text will appear with the tag name.

Every time you capture a photo and send it to the Service, you can go back to the Service page and retrain the Service

with the newly captured images. At the beginning, you will probably also have to correct the Bounding Boxes to be more

accurate and retrain the Service.

The Label Text placed might not appear near the object when the Microsoft HoloLens sensors and/or the

SpatialTrackingComponent in Unity fails to place the appropriate colliders, relative to the real world objects. Try to use the

application on a different surface if that is the case.

Congratulations, you built a mixed reality app that leverages the Azure Custom Vision, Object Detection API,



 Bonus exercises
  Exercise 1Exercise 1

  Exercise 2Exercise 2

  Exercise 3Exercise 3

  Exercise 4Exercise 4

which can recognize an object from an image, and then provide an approximate position for that object in 3D

space.

Adding to the Text Label, use a semi-transparent cube to wrap the real object in a 3D Bounding Box.

Train your Custom Vision Service to recognize more objects.

Play a sound when an object is recognized.

Use the API to re-train your Service with the same images your app is analyzing, so to make the Service more

accurate (do both prediction and training simultaneously).
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NOTENOTE
The Mixed Reality Academy tutorials were designed with HoloLens (1st gen) and Mixed Reality Immersive Headsets in

mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for guidance in

developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being used for

HoloLens 2. They will be maintained to continue working on the supported devices. There will be a new series of tutorials

that will be posted in the future that will demonstrate how to develop for HoloLens 2. This notice will be updated with a

link to those tutorials when they are posted.

In this course, you will learn how to use Microsoft Graph to log in into your Microsoft account using secure

authentication within a mixed reality application. You will then retrieve and display your scheduled meetings in

the application interface.

Microsoft Graph is a set of APIs designed to enable access to many of Microsoft's services. Microsoft describes

Microsoft Graph as being a matrix of resources connected by relationships, meaning it allows an application to

access all sorts of connected user data. For more information, visit the Microsoft Graph page.

Development will include the creation of an app where the user will be instructed to gaze at and then tap a

sphere, which will prompt the user to log in safely to a Microsoft account. Once logged in to their account, the

user will be able to see a list of meetings scheduled for the day.

Having completed this course, you will have a mixed reality HoloLens application, which will be able to do the

following:

1. Using the Tap gesture, tap on an object, which will prompt the user to log into a Microsoft Account (moving

out of the app to log in, and then back into the app again).

2. View a list of meetings scheduled for the day.

In your application, it is up to you as to how you will integrate the results with your design. This course is

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/mr-azure-311.md
https://developer.microsoft.com/graph
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 Prerequisites

NOTENOTE

  Before you startBefore you start

 Chapter 1 - Create your app in the Application Registration Portal

designed to teach you how to integrate an Azure Service with your Unity project. It is your job to use the

knowledge you gain from this course to enhance your mixed reality application.

This tutorial is designed for developers who have basic experience with Unity and C#. Please also be aware that the

prerequisites and written instructions within this document represent what has been tested and verified at the time of

writing (July 2018). You are free to use the latest software, as listed within the install the tools article, though it should not

be assumed that the information in this course will perfectly match what you will find in newer software than what is listed

below.

We recommend the following hardware and software for this course:

A development PC

Windows 10 Fall Creators Update (or later) with Developer mode enabled

The latest Windows 10 SDK

Unity 2017.4

Visual Studio 2017

A Microsoft HoloLens with Developer mode enabled

Internet access for Azure setup and Microsoft Graph data retrieval

A valid Microsoft AccountMicrosoft Account (either personal or work/school)

A few meetings scheduled for the current day, using the same Microsoft Account

1. To avoid encountering issues building this project, it is strongly suggested that you create the project

mentioned in this tutorial in a root or near-root folder (long folder paths can cause issues at build-time).

2. Set up and test your HoloLens. If you need support setting up your HoloLens, make sure to visit the HoloLens

setup article.

3. It is a good idea to perform Calibration and Sensor Tuning when beginning developing a new HoloLens App

(sometimes it can help to perform those tasks for each user).

For help on Calibration, please follow this link to the HoloLens Calibration article.

For help on Sensor Tuning, please follow this link to the HoloLens Sensor Tuning article.

To begin with, you will need to create and register your application in the Application Registration Por talApplication Registration Por tal .

In this Chapter you will also find the Service Key that will allow you to make calls to Microsoft Graph to access

your account content.

1. Navigate to the Microsoft Application Registration Portal and login with your Microsoft Account. Once

you have logged in, you will be redirected to the Application Registration Por talApplication Registration Por tal .

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens-setup
https://docs.microsoft.com/en-us/hololens/hololens-calibration#hololens-2
https://docs.microsoft.com/en-us/hololens/hololens-updates
https://apps.dev.microsoft.com


IMPORTANTIMPORTANT

2. In the My applicationsMy applications  section, click on the button Add an appAdd an app.

The Application Registration Por talApplication Registration Por tal can look different, depending on whether you have previously worked

with Microsoft Graph. The below screenshots display these different versions.

3. Add a name for your application and click CreateCreate.

4. Once the application has been created, you will be redirected to the application main page. Copy the

Application IdApplication Id and make sure to note this value somewhere safe, you will use it soon in your code.



5. In the PlatformsPlatforms section, make sure Native ApplicationNative Application is displayed. If not click on Add PlatformAdd Platform and

select Native ApplicationNative Application.

6. Scroll down in the same page and in the section called Microsoft Graph PermissionsMicrosoft Graph Permissions  you will need to

add additional permissions for the application. Click on AddAdd next to Delegated PermissionsDelegated Permissions .

7. Since you want your application to access the user's Calendar, check the box called Calendars.ReadCalendars.Read and

click OKOK.
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8. Scroll to the bottom and click the SaveSave button.

9. Your save will be confirmed, and you can log out from the Application Registration Por talApplication Registration Por tal .

The following is a typical set up for developing with mixed reality, and as such, is a good template for other

projects.

1. Open Unity and click NewNew .



2. You need to provide a Unity project name. Insert MSGraphMRMSGraphMR . Make sure the project template is set to

3D3D. Set the LocationLocation to somewhere appropriate for you (remember, closer to root directories is better).

Then, click Create projectCreate project.

3. With Unity open, it is worth checking the default Scr ipt EditorScr ipt Editor  is set to Visual StudioVisual Studio. Go to EditEdit >

PreferencesPreferences  and then from the new window, navigate to External ToolsExternal Tools . Change External Scr iptExternal Scr ipt

EditorEditor  to Visual Studio 2017Visual Studio 2017 . Close the PreferencesPreferences  window.



4. Go to FileFile > Build SettingsBuild Settings  and select Universal Windows PlatformUniversal Windows Platform , then click on the SwitchSwitch

PlatformPlatform button to apply your selection.

5. While still in FileFile > Build SettingsBuild Settings , make sure that:

a. Target DeviceTarget Device is set to HoloLensHoloLens

b. Build TypeBuild Type is set to D3DD3D

c. SDKSDK is set to Latest installedLatest installed

d. Visual Studio VersionVisual Studio Version is set to Latest installedLatest installed

e. Build and RunBuild and Run is set to Local MachineLocal Machine

f. Save the scene and add it to the build.

a. Do this by selecting Add Open ScenesAdd Open Scenes . A save window will appear.



b. Create a new folder for this, and any future, scene. Select the New folderNew folder  button, to create

a new folder, name it ScenesScenes .

c. Open your newly created ScenesScenes  folder, and then in the File name: text field, type

MR_ComputerVisionSceneMR_ComputerVisionScene, then click SaveSave.



IMPORTANTIMPORTANT
Be aware, you must save your Unity scenes within the Assets folder, as they must be associated

with the Unity project. Creating the scenes folder (and other similar folders) is a typical way of

structuring a Unity project.

g. The remaining settings, in Build Settings, should be left as default for now.

6. In the Build Settings window, click on the Player SettingsPlayer Settings  button, this will open the related panel in the

space where the Inspector is located.

7. In this panel, a few settings need to be verified:

a. In the Other SettingsOther Settings  tab:

a. Scr iptingScr ipting Runtime VersionRuntime Version should be ExperimentalExperimental  (.NET 4.6 Equivalent), which will

trigger a need to restart the Editor.

b. Scr ipting BackendScripting Backend should be .NET.NET

c. API Compatibility LevelAPI Compatibility Level  should be .NET 4.6.NET 4.6
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IMPORTANTIMPORTANT

b. Within the Publishing SettingsPublishing Settings  tab, under CapabilitiesCapabilities , check:

InternetClientInternetClient

c. Further down the panel, in XR SettingsXR Settings  (found below Publish SettingsPublish Settings ), check Vir tual RealityVir tual Reality

Suppor tedSuppor ted, make sure the Windows Mixed Reality SDKWindows Mixed Reality SDK is added.

8. Back in Build Settings, Unity C# Projects is no longer greyed out; check the checkbox next to this.

9. Close the Build Settings window.

10. Save your scene and project (FILEFILE > SAVE SCENES / FILESAVE SCENES / FILE > SAVE PROJECTSAVE PROJECT).

If you wish to skip the Unity Set up component of this course, and continue straight into code, feel free to download this

Azure-MR-311.unitypackage, import it into your project as a Custom PackageCustom Package, and then continue from Chapter 5.

To use Microsoft Graph within Unity you need to make use of the Microsoft.Identity.ClientMicrosoft.Identity.Client DLL. It is possible

to use the Microsoft Graph SDK, however, it will require the addition of a NuGet package after you build the

Unity project (meaning editing the project post-build). It is considered simpler to import the required DLLs

directly into Unity.

https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20311%20-%20Microsoft%20Graph/Azure-MR-311.unitypackage
https://docs.unity3d.com/Manual/AssetPackages.html


NOTENOTE
There is currently a known issue in Unity which requires plugins to be reconfigured after import. These steps (4 - 7 in this

section) will no longer be required after the bug has been resolved.

To import Microsoft Graph into your own project, download the MSGraph_LabPlugins.zip file. This package has

been created with versions of the libraries that have been tested.

If you wish to know more about how to add custom DLLs to your Unity project, follow this link.

To import the package:

1. Add the Unity Package to Unity by using the AssetsAssets  > Impor t PackageImpor t Package > Custom PackageCustom Package menu

option. Select the package you just downloaded.

2. In the Impor t Unity PackageImpor t Unity Package box that pops up, ensure everything under (and including) PluginsPlugins  is

selected.

3. Click the Impor tImpor t button to add the items to your project.

4. Go to the MSGraphMSGraph folder under PluginsPlugins  in the Project Panel and select the plugin called

Microsoft.Identity.ClientMicrosoft.Identity.Client.

5. With the plugin selected, ensure that Any PlatformAny Platform is unchecked, then ensure that WSAPlayerWSAPlayer  is also

unchecked, then click ApplyApply . This is just to confirm that the files are configured correctly.

https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20311%20-%20Microsoft%20Graph/MSGraph_LabPlugins.unitypackage
https://docs.unity3d.com/Manual/UsingDLL.html
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NOTENOTE
Marking these plugins configures them to only be used in the Unity Editor. There are a different set of DLLs in the

WSA folder which will be used after the project is exported from Unity as a Universal Windows Application.

6. Next, you need to open the WSAWSA folder, within the MSGraphMSGraph folder. You will see a copy of the same file

you just configured. Select the file, and then in the inspector :

ensure that Any PlatformAny Platform is uncheckedunchecked, and that onlyonly  WSAPlayerWSAPlayer  is checkedchecked.

Ensure SDKSDK is set to UWPUWP, and Scr ipting BackendScripting Backend is set to Dot NetDot Net

Ensure that Don't processDon't process  is checkedchecked.

7. Click ApplyApply .

During this Chapter you will set up the Main Camera of your scene:

1. In the Hierarchy Panel, select the Main CameraMain Camera.

2. Once selected, you will be able to see all the components of the Main CameraMain Camera in the Inspector panel.

a. The Camera objectCamera object must be named Main CameraMain Camera (note the spelling!)

b. The Main Camera TagTag must be set to MainCameraMainCamera (note the spelling!)

c. Make sure the Transform PositionTransform Position is set to 0, 0 , 00, 0 , 0



 Chapter 5 - Create MeetingsUI class

d. Set Clear FlagsClear Flags  to Solid ColorSolid Color

e. Set the Background ColorBackground Color  of the Camera Component to Black , Alpha 0Black , Alpha 0  (Hex Code:(Hex Code:

#00000000)#00000000)

3. The final object structure in the Hierarchy Panel should be like the one shown in the image below:

The first script you need to create is MeetingsUIMeetingsUI, which is responsible for hosting and populating the UI of the

application (welcome message, instructions and the meetings details).

To create this class:

1. Right-click on the AssetsAssets  folder in the Project Panel, then select CreateCreate > FolderFolder . Name the folder

Scr iptsScr ipts .



using System;
using UnityEngine;

 

2. Open the Scr iptsScr ipts  folder then, within that folder, right-click, CreateCreate > C# Scr iptC# Scr ipt. Name the script

MeetingsUI.MeetingsUI.

3. Double-click on the new MeetingsUIMeetingsUI script to open it with Visual Studio.

4. Insert the following namespaces:



    /// <summary>
    /// Allows this class to behave like a singleton
    /// </summary>
    public static MeetingsUI Instance;

    /// <summary>
    /// The 3D text of the scene
    /// </summary>
    private TextMesh _meetingDisplayTextMesh;

    /// <summary>
    /// Called on initialization
    /// </summary>
    void Awake()
    {
        Instance = this;
    }

    /// <summary>
    /// Called on initialization, after Awake
    /// </summary>
    void Start ()
    {
        // Creating the text mesh within the scene
        _meetingDisplayTextMesh = CreateMeetingsDisplay();
    }

5. Inside the class insert the following variables:

6. Then replace the Star t()Star t()  method and add an Awake()Awake()  method. These will be called when the class

initializes:

7. Add the methods responsible for creating the Meetings UI and populate it with the current meetings

when requested:
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    /// <summary>
    /// Set the welcome message for the user
    /// </summary>
    internal void WelcomeUser(string userName)
    {
        if(!string.IsNullOrEmpty(userName))
        {
            _meetingDisplayTextMesh.text = $"Welcome {userName}";
        }
        else 
        {
            _meetingDisplayTextMesh.text = "Welcome";
        }
    }

    /// <summary>
    /// Set up the parameters for the UI text
    /// </summary>
    /// <returns>Returns the 3D text in the scene</returns>
    private TextMesh CreateMeetingsDisplay()
    {
        GameObject display = new GameObject();
        display.transform.localScale = new Vector3(0.03f, 0.03f, 0.03f);
        display.transform.position = new Vector3(-3.5f, 2f, 9f);
        TextMesh textMesh = display.AddComponent<TextMesh>();
        textMesh.anchor = TextAnchor.MiddleLeft;
        textMesh.alignment = TextAlignment.Left;
        textMesh.fontSize = 80;
        textMesh.text = "Welcome! \nPlease gaze at the button" +
            "\nand use the Tap Gesture to display your meetings";

        return textMesh;
    }

    /// <summary>
    /// Adds a new Meeting in the UI by chaining the existing UI text
    /// </summary>
    internal void AddMeeting(string subject, DateTime dateTime, string location)
    {
        string newText = $"\n{_meetingDisplayTextMesh.text}\n\n Meeting,\nSubject: {subject},\nToday 
at {dateTime},\nLocation: {location}";

        _meetingDisplayTextMesh.text = newText;
    }

8. DeleteDelete the Update()Update()  method, and save your changessave your changes  in Visual Studio before returning to Unity.

The next script to create is the GraphGraph script. This script is responsible for making the calls to authenticate the

user and retrieve the scheduled meetings for the current day from the user's calendar.

To create this class:

1. Double-click on the Scr iptsScr ipts  folder, to open it.

2. Right-click inside the Scr iptsScr ipts  folder, click CreateCreate > C# Scr iptC# Scr ipt. Name the script GraphGraph.

3. Double-click on the script to open it with Visual Studio.

4. Insert the following namespaces:



using System.Collections.Generic;
using UnityEngine;
using Microsoft.Identity.Client;
using System;
using System.Threading.Tasks;

#if !UNITY_EDITOR && UNITY_WSA
using System.Net.Http;
using System.Net.Http.Headers;
using Windows.Storage;
#endif

IMPORTANTIMPORTANT
You will notice that parts of the code in this script are wrapped around Precompile Directives, this is to avoid

issues with the libraries when building the Visual Studio Solution.

5. Delete the Star t()Star t()  and Update()Update()  methods, as they will not be used.

6. Outside the GraphGraph class, insert the following objects, which are necessary to deserialize the JSON object

representing the daily scheduled meetings:

https://docs.unity3d.com/Manual/PlatformDependentCompilation.html


/// <summary>
/// The object hosting the scheduled meetings
/// </summary>
[Serializable]
public class Rootobject
{
    public List<Value> value;
}

[Serializable]
public class Value
{
    public string subject { get; set; }
    public StartTime start { get; set; }
    public Location location { get; set; }
}

[Serializable]
public class StartTime
{
    public string dateTime;

    private DateTime? _startDateTime;
    public DateTime StartDateTime
    {
        get
        {
            if (_startDateTime != null)
                return _startDateTime.Value;
            DateTime dt;
            DateTime.TryParse(dateTime, out dt);
            _startDateTime = dt;
            return _startDateTime.Value;
        }
    }
}

[Serializable]
public class Location
{
    public string displayName { get; set; }
}

7. Inside the GraphGraph class, add the following variables:



    /// <summary>
    /// Insert your Application Id here
    /// </summary>
    private string _appId = "-- Insert your Application Id here --";

    /// <summary>
    /// Application scopes, determine Microsoft Graph accessibility level to user account
    /// </summary>
    private IEnumerable<string> _scopes = new List<string>() { "User.Read", "Calendars.Read" };

    /// <summary>
    /// Microsoft Graph API, user reference
    /// </summary>
    private PublicClientApplication _client;

    /// <summary>
    /// Microsoft Graph API, authentication
    /// </summary>
    private AuthenticationResult _authResult;

NOTENOTE
Change the appIdappId value to be the App IdApp Id that you have noted in Chapter 1Chapter 1 , step 4, step 4 . This value should be the

same as that displayed in the Application Registration Por tal,Application Registration Por tal,  in your application registration page.

8. Within the GraphGraph class, add the methods S ignInAsync()S ignInAsync()  and AquireTokenAsync()AquireTokenAsync() , that will prompt

the user to insert the log-in credentials.



    /// <summary>
    /// Begin the Sign In process using Microsoft Graph Library
    /// </summary>
    internal async void SignInAsync()
    {
#if !UNITY_EDITOR && UNITY_WSA
        // Set up Grap user settings, determine if needs auth
        ApplicationDataContainer localSettings = ApplicationData.Current.LocalSettings;
        string userId = localSettings.Values["UserId"] as string;
        _client = new PublicClientApplication(_appId);

        // Attempt authentication
        _authResult = await AcquireTokenAsync(_client, _scopes, userId);

        // If authentication is successful, retrieve the meetings
        if (!string.IsNullOrEmpty(_authResult.AccessToken))
        {
            // Once Auth as been completed, find the meetings for the day
            await ListMeetingsAsync(_authResult.AccessToken);
        }
#endif
    }

    /// <summary>
    /// Attempt to retrieve the Access Token by either retrieving
    /// previously stored credentials or by prompting user to Login
    /// </summary>
    private async Task<AuthenticationResult> AcquireTokenAsync(
        IPublicClientApplication app, IEnumerable<string> scopes, string userId)
    {
        IUser user = !string.IsNullOrEmpty(userId) ? app.GetUser(userId) : null;
        string userName = user != null ? user.Name : "null";

        // Once the User name is found, display it as a welcome message
        MeetingsUI.Instance.WelcomeUser(userName);

        // Attempt to Log In the user with a pre-stored token. Only happens
        // in case the user Logged In with this app on this device previously
        try
        {
            _authResult = await app.AcquireTokenSilentAsync(scopes, user);
        }
        catch (MsalUiRequiredException)
        {
            // Pre-stored token not found, prompt the user to log-in 
            try
            {
                _authResult = await app.AcquireTokenAsync(scopes);
            }
            catch (MsalException msalex)
            {
                Debug.Log($"Error Acquiring Token: {msalex.Message}");
                return _authResult;
            }
        }

        MeetingsUI.Instance.WelcomeUser(_authResult.User.Name);

#if !UNITY_EDITOR && UNITY_WSA
        ApplicationData.Current.LocalSettings.Values["UserId"] = 
        _authResult.User.Identifier;
#endif
        return _authResult;
    }

9. Add the following two methods:



    /// <summary>
    /// Build the endpoint to retrieve the meetings for the current day.
    /// </summary>
    /// <returns>Returns the Calendar Endpoint</returns>
    public string BuildTodayCalendarEndpoint()
    {
        DateTime startOfTheDay = DateTime.Today.AddDays(0);
        DateTime endOfTheDay = DateTime.Today.AddDays(1);
        DateTime startOfTheDayUTC = startOfTheDay.ToUniversalTime();
        DateTime endOfTheDayUTC = endOfTheDay.ToUniversalTime();

        string todayDate = startOfTheDayUTC.ToString("o");
        string tomorrowDate = endOfTheDayUTC.ToString("o");
        string todayCalendarEndpoint = string.Format(
            "https://graph.microsoft.com/v1.0/me/calendarview?startdatetime={0}&enddatetime={1}",
            todayDate,
            tomorrowDate);

        return todayCalendarEndpoint;
    }

    /// <summary>
    /// Request all the scheduled meetings for the current day.
    /// </summary>
    private async Task ListMeetingsAsync(string accessToken)
    {
#if !UNITY_EDITOR && UNITY_WSA
        var http = new HttpClient();

        http.DefaultRequestHeaders.Authorization = 
        new AuthenticationHeaderValue("Bearer", accessToken);
        var response = await http.GetAsync(BuildTodayCalendarEndpoint());

        var jsonResponse = await response.Content.ReadAsStringAsync();

        Rootobject rootObject = new Rootobject();
        try
        {
            // Parse the JSON response.
            rootObject = JsonUtility.FromJson<Rootobject>(jsonResponse);

            // Sort the meeting list by starting time.
            rootObject.value.Sort((x, y) => DateTime.Compare(x.start.StartDateTime, 
y.start.StartDateTime));

            // Populate the UI with the meetings.
            for (int i = 0; i < rootObject.value.Count; i++)
            {
                MeetingsUI.Instance.AddMeeting(rootObject.value[i].subject,
                                            rootObject.value[i].start.StartDateTime.ToLocalTime(),
                                            rootObject.value[i].location.displayName);
            }
        }
        catch (Exception ex)
        {
            Debug.Log($"Error = {ex.Message}");
            return;
        }
#endif
    }

a. BuildTodayCalendarEndpoint()BuildTodayCalendarEndpoint() , which builds the URI specifying the day, and time span, in

which the scheduled meetings are retrieved.

b. L istMeetingsAsync()L istMeetingsAsync() , which requests the scheduled meetings from Microsoft Graph.



 Chapter 7 - Create the GazeInput script

10. You have now completed the GraphGraph script. Save your changesSave your changes  in Visual Studio before returning to

Unity.

You will now create the GazeInputGazeInput. This class handles and keeps track of the user's gaze, using a RaycastRaycast

coming from the Main CameraMain Camera, projecting forward.

To create the script:

using UnityEngine;

/// <summary>
/// Class responsible for the User's Gaze interactions
/// </summary>
[System.Serializable]
public class GazeInput : MonoBehaviour
{

    [Tooltip("Used to compare whether an object is to be interacted with.")]
    internal string InteractibleTag = "SignInButton";

    /// <summary>
    /// Length of the gaze
    /// </summary>
    internal float GazeMaxDistance = 300;

    /// <summary>
    /// Object currently gazed
    /// </summary>
    internal GameObject FocusedObject { get; private set; }

    internal GameObject oldFocusedObject { get; private set; }

    internal RaycastHit HitInfo { get; private set; }

    /// <summary>
    /// Cursor object visible in the scene
    /// </summary>
    internal GameObject Cursor { get; private set; }

    internal bool Hit { get; private set; }

    internal Vector3 Position { get; private set; }

    internal Vector3 Normal { get; private set; }

    private Vector3 _gazeOrigin;

    private Vector3 _gazeDirection;

1. Double-click on the Scr iptsScr ipts  folder, to open it.

2. Right-click inside the Scr iptsScr ipts  folder, click CreateCreate > C# Scr iptC# Scr ipt. Name the script GazeInputGazeInput.

3. Double-click on the script to open it with Visual Studio.

4. Change the namespaces code to match the one below, along with adding the '[System.Serializable][System.Serializable] '

tag above your GazeInputGazeInput class, so that it can be serialized:

5. Inside the GazeInputGazeInput class, add the following variables:



    /// <summary>
    /// Start method used upon initialisation.
    /// </summary>
    internal virtual void Start()
    {
        FocusedObject = null;
        Cursor = CreateCursor();
    }

    /// <summary>
    /// Method to create a cursor object.
    /// </summary>
    internal GameObject CreateCursor()
    {
        GameObject newCursor = GameObject.CreatePrimitive(PrimitiveType.Sphere);
        newCursor.SetActive(false);
        // Remove the collider, so it doesn't block raycast.
        Destroy(newCursor.GetComponent<SphereCollider>());
        newCursor.transform.localScale = new Vector3(0.05f, 0.05f, 0.05f);
        Material mat = new Material(Shader.Find("Diffuse"));
        newCursor.GetComponent<MeshRenderer>().material = mat;
        mat.color = Color.HSVToRGB(0.0223f, 0.7922f, 1.000f);
        newCursor.SetActive(true);

        return newCursor;
    }

/// <summary>
/// Called every frame
/// </summary>
internal virtual void Update()
{
    _gazeOrigin = Camera.main.transform.position;

    _gazeDirection = Camera.main.transform.forward;

    UpdateRaycast();
}
/// <summary>
/// Reset the old focused object, stop the gaze timer, and send data if it
/// is greater than one.
/// </summary>
private void ResetFocusedObject()
{
    // Ensure the old focused object is not null.
    if (oldFocusedObject != null)
    {
        if (oldFocusedObject.CompareTag(InteractibleTag))
        {
            // Provide the 'Gaze Exited' event.
            oldFocusedObject.SendMessage("OnGazeExited", SendMessageOptions.DontRequireReceiver);
        }
    }
}

6. Add the CreateCursor()CreateCursor()  method to create the HoloLens cursor in the scene, and call the method from

the Star t()Star t()  method:

7. The following methods enable the gaze Raycast and keep track of the focused objects.
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    private void UpdateRaycast()
    {
        // Set the old focused gameobject.
        oldFocusedObject = FocusedObject;
        RaycastHit hitInfo;

        // Initialise Raycasting.
        Hit = Physics.Raycast(_gazeOrigin,
            _gazeDirection,
            out hitInfo,
            GazeMaxDistance);
            HitInfo = hitInfo;

        // Check whether raycast has hit.
        if (Hit == true)
        {
            Position = hitInfo.point;
            Normal = hitInfo.normal;

            // Check whether the hit has a collider.
            if (hitInfo.collider != null)
            {
                // Set the focused object with what the user just looked at.
                FocusedObject = hitInfo.collider.gameObject;
            }
            else
            {
                // Object looked on is not valid, set focused gameobject to null.
                FocusedObject = null;
            }
        }
        else
        {
            // No object looked upon, set focused gameobject to null.
            FocusedObject = null;

            // Provide default position for cursor.
            Position = _gazeOrigin + (_gazeDirection * GazeMaxDistance);

            // Provide a default normal.
            Normal = _gazeDirection;
        }

        // Lerp the cursor to the given position, which helps to stabilize the gaze.
        Cursor.transform.position = Vector3.Lerp(Cursor.transform.position, Position, 0.6f);

        // Check whether the previous focused object is this same. If so, reset the focused object.
        if (FocusedObject != oldFocusedObject)
        {
            ResetFocusedObject();
            if (FocusedObject != null)
            {
                if (FocusedObject.CompareTag(InteractibleTag))
                {
                    // Provide the 'Gaze Entered' event.
                    FocusedObject.SendMessage("OnGazeEntered", 
                        SendMessageOptions.DontRequireReceiver);
                }
            }
        }
    }

8. Save your changesSave your changes  in Visual Studio before returning to Unity.



You will now need to create the InteractionsInteractions  script, which is responsible for :

Handling the TapTap interaction and the Camera GazeCamera Gaze, which enables the user to interact with the log in

"button" in the scene.

Creating the log in "button" object in the scene for the user to interact with.

To create the script:

using UnityEngine;
using UnityEngine.XR.WSA.Input;

public class Interactions : GazeInput

    /// <summary>
    /// Allows input recognition with the HoloLens
    /// </summary>
    private GestureRecognizer _gestureRecognizer;

    /// <summary>
    /// Called on initialization, after Awake
    /// </summary>
    internal override void Start()
    {
        base.Start();

        // Register the application to recognize HoloLens user inputs
        _gestureRecognizer = new GestureRecognizer();
        _gestureRecognizer.SetRecognizableGestures(GestureSettings.Tap);
        _gestureRecognizer.Tapped += GestureRecognizer_Tapped;
        _gestureRecognizer.StartCapturingGestures();

        // Add the Graph script to this object
        gameObject.AddComponent<MeetingsUI>();
        CreateSignInButton();
    }

1. Double-click on the Scr iptsScr ipts  folder, to open it.

2. Right-click inside the Scr iptsScr ipts  folder, click CreateCreate > C# Scr iptC# Scr ipt. Name the script InteractionsInteractions .

3. Double-click on the script to open it with Visual Studio.

4. Insert the following namespaces:

5. Change the inheritance of the InteractionInteraction class from MonoBehaviour to GazeInputGazeInput.

public class Interactions : MonoBehaviour

6. Inside the InteractionInteraction class insert the following variable:

7. Replace the Star tStar t method; notice it is an override method, which calls the 'base' Gaze class method.

Star t()Star t()  will be called when the class initializes, registering for input recognition and creating the sign in

button in the scene:

8. Add the CreateSignInButton()CreateSignInButton()  method, which will instantiate the sign in button in the scene and set its

properties:
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    /// <summary>
    /// Create the sign in button object in the scene
    /// and sets its properties
    /// </summary>
    void CreateSignInButton()
    {
        GameObject signInButton = GameObject.CreatePrimitive(PrimitiveType.Sphere);

        Material mat = new Material(Shader.Find("Diffuse"));
        signInButton.GetComponent<Renderer>().material = mat;
        mat.color = Color.blue;

        signInButton.transform.position = new Vector3(3.5f, 2f, 9f);
        signInButton.tag = "SignInButton";
        signInButton.AddComponent<Graph>();
    }

    /// <summary>
    /// Detects the User Tap Input
    /// </summary>
    private void GestureRecognizer_Tapped(TappedEventArgs obj)
    {
        if(base.FocusedObject != null)
        {
            Debug.Log($"TAP on {base.FocusedObject.name}");
            base.FocusedObject.SendMessage("SignInAsync", SendMessageOptions.RequireReceiver);
        }
    }

9. Add the GestureRecognizer_Tapped()GestureRecognizer_Tapped()  method, which be respond for the Tap user event.

10. DeleteDelete the Update()Update()  method, and then save your changessave your changes  in Visual Studio before returning to Unity.

In this Chapter you need to place the InteractionsInteractions  script onto the Main CameraMain Camera. That script will then handle

placing the other scripts where they need to be.

From the Scr iptsScr ipts  folder in the Project Panel, drag the script InteractionsInteractions  to the Main CameraMain Camera object, as

pictured below.
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 Chapter 11 - Build the Unity project to UWP

The code handling the gaze will make use of the Tag S ignInButtonSignInButton to identify which object the user will interact

with to sign-in to Microsoft Graph.

To create the Tag:

1. In the Unity Editor click on the Main CameraMain Camera in the Hierarchy Panel.

2. In the Inspector Panel click on the MainCameraMainCamera Tag to open a drop-down list. Click on Add Tag...Add Tag...

3. Click on the ++ button.

4. Write the Tag name as S ignInButtonSignInButton and click Save.

Everything needed for the Unity section of this project has now been completed, so it is time to build it from

Unity.

1. Navigate to Build Settings (File > Build Settings).



 Chapter 12 - Deploy to HoloLens

2. If not already, tick Unity C# ProjectsUnity C# Projects .

3. Click BuildBuild. Unity will launch a File ExplorerFile Explorer  window, where you need to create and then select a folder

to build the app into. Create that folder now, and name it AppApp. Then with the AppApp folder selected, click

Select FolderSelect Folder .

4. Unity will begin building your project to the AppApp folder.

5. Once Unity has finished building (it might take some time), it will open a File ExplorerFile Explorer  window at the

location of your build (check your task bar, as it may not always appear above your windows, but will

notify you of the addition of a new window).

To deploy on HoloLens:

1. You will need the IP Address of your HoloLens (for Remote Deploy), and to ensure your HoloLens is in

Developer Mode.Developer Mode. To do this:

a. Whilst wearing your HoloLens, open the SettingsSettings .

b. Go to Network & InternetNetwork & Internet > Wi-FiWi-Fi  > Advanced OptionsAdvanced Options

c. Note the IPv4IPv4  address.

d. Next, navigate back to SettingsSettings , and then to Update & SecurityUpdate & Security  > For DevelopersFor Developers

e. Set Developer Mode OnDeveloper Mode On.

2. Navigate to your new Unity build (the AppApp folder) and open the solution file with Visual StudioVisual Studio.

3. In the Solution ConfigurationSolution Configuration select DebugDebug.

4. In the Solution PlatformSolution Platform , select x86, Remote Machinex86, Remote Machine. You will be prompted to insert the IP addressIP address

of a remote device (the HoloLens, in this case, which you noted).



 Your Microsoft Graph HoloLens application

 Bonus exercises
  Exercise 1Exercise 1

  Exercise 1Exercise 1

5. Go to BuildBuild menu and click on Deploy SolutionDeploy Solution to sideload the application to your HoloLens.

6. Your app should now appear in the list of installed apps on your HoloLens, ready to be launched!

Congratulations, you built a mixed reality app that leverages the Microsoft Graph, to read and display user

Calendar data.

Use Microsoft Graph to display other information about the user

User email / phone number / profile picture

Implement voice control to navigate the Microsoft Graph UI.
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NOTENOTE

 Device support

The Mixed Reality Academy tutorials were designed with HoloLens (1st gen) and Mixed Reality Immersive Headsets in

mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for guidance in

developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being used for

HoloLens 2. They will be maintained to continue working on the supported devices. There will be a new series of tutorials

that will be posted in the future that will demonstrate how to develop for HoloLens 2. This notice will be updated with a

link to those tutorials when they are posted.

In this course, you will learn how to create and deploy a bot using the Microsoft Bot Framework V4 and

communicate with it through a Windows Mixed Reality application.

The Microsoft Bot Framework V4Microsoft Bot Framework V4  is a set of APIs designed to provide developers with the tools to build an

extensible and scalable bot application. For more information, visit the Microsoft Bot Framework page or the V4

Git Repository.

After completing this course, you will have built a Windows Mixed Reality application, which will be able to do

the following:

1. Use a Tap GestureTap Gesture to start the bot listening for the users voice.

2. When the user has said something, the bot will attempt to provide a response.

3. Display the bots reply as text, positioned near the bot, in the Unity Scene.

In your application, it is up to you as to how you will integrate the results with your design. This course is

designed to teach you how to integrate an Azure Service with your Unity project. It is your job to use the

knowledge you gain from this course to enhance your mixed reality application.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/mr-azure-312.md
https://dev.botframework.com/
https://github.com/Microsoft/botbuilder-dotnet/wiki
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NOTENOTE

 Prerequisites

NOTENOTE

  Before you startBefore you start

 Chapter 1 – Create the Bot application

While this course primarily focuses on HoloLens, you can also apply what you learn in this course to Windows Mixed

Reality immersive (VR) headsets. Because immersive (VR) headsets do not have accessible cameras, you will need an

external camera connected to your PC. As you follow along with the course, you will see notes on any changes you might

need to employ to support immersive (VR) headsets.

This tutorial is designed for developers who have basic experience with Unity and C#. Please also be aware that the

prerequisites and written instructions within this document represent what has been tested and verified at the time of

writing (July 2018). You are free to use the latest software, as listed within the install the tools article, though it should not

be assumed that the information in this course will perfectly match what you will find in newer software than what is listed

below.

We recommend the following hardware and software for this course:

A development PC, compatible with Windows Mixed Reality for immersive (VR) headset development

Windows 10 Fall Creators Update (or later) with Developer mode enabled

The latest Windows 10 SDK

Unity 2017.4

Visual Studio 2017

A Windows Mixed Reality immersive (VR) headset or Microsoft HoloLens with Developer mode enabled

Internet access for Azure, and for Azure Bot retrieval. For more information, please follow this link.

1. To avoid encountering issues building this project, it is strongly suggested that you create the project

mentioned in this tutorial in a root or near-root folder (long folder paths can cause issues at build-time).

2. Set up and test your HoloLens. If you need support setting up your HoloLens, make sure to visit the HoloLens

setup article.

3. It is a good idea to perform Calibration and Sensor Tuning when beginning developing a new HoloLens app

(sometimes it can help to perform those tasks for each user).

For help on Calibration, please follow this link to the HoloLens Calibration article.

For help on Sensor Tuning, please follow this link to the HoloLens Sensor Tuning article.

The first step is to create your bot as a local ASP.Net Core Web application. Once you have finished and tested it,

you will publish it to the Azure Portal.

1. Open Visual Studio. Create a new project, select ASP NET Core Web ApplicationASP NET Core Web Application as the project type

(you will find it under the subsection .NET Core) and call it MyBotMyBot. Click OKOK.

2. In the Window that will appear select EmptyEmpty . Also make sure the target is set to ASP NET Core 2.0ASP NET Core 2.0  and

the Authentication is set to No AuthenticationNo Authentication. Click OKOK.

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://support.microsoft.com/help/4039260/windows-10-mixed-reality-pc-hardware-guidelines
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://dev.botframework.com/
https://docs.microsoft.com/en-us/hololens/hololens-setup
https://docs.microsoft.com/en-us/hololens/hololens-calibration#hololens-2
https://docs.microsoft.com/en-us/hololens/hololens-updates


3. The solution will now open. Right-click on Solution MybotMybot in the Solution ExplorerSolution Explorer  and click on

Manage NuGet Packages for SolutionManage NuGet Packages for Solution.

4. In the BrowseBrowse tab, search for Microsoft.Bot.Builder.Integration.AspNet.CoreMicrosoft.Bot.Builder.Integration.AspNet.Core (make sure you have

Include pre-releaseInclude pre-release checked). Select the package version 4.0 .1-preview4.0.1-preview , and tick the project boxes.

Then click on InstallInstall . You have now installed the libraries needed for the Bot Framework v4Bot Framework v4 . Close the

NuGet page.



5. Right-click on your Project, MyBotMyBot, in the Solution ExplorerSolution Explorer  and click on AddAdd ||  ClassClass .

6. Name the class MyBotMyBot and click on AddAdd.



7. Repeat the previous point, to create another class named ConversationContextConversationContext.

8. Right-click on wwwrootwwwroot in the Solution ExplorerSolution Explorer  and click on AddAdd ||  New ItemNew Item. Select HTML PageHTML Page

(you will find it under the subsection Web). Name the file default.htmldefault.html . Click AddAdd.



namespace MyBot
{
    public static class ConversationContext
    {
        internal static string userName;

        internal static string userMsg;
    }
}

9. The list of classes / objects in the Solution ExplorerSolution Explorer  should look like the image below.

10. Double-click on the ConversationContextConversationContext class. This class is responsible for holding the variables used

by the bot to maintain the context of the conversation. These conversation context values are maintained

in an instance of this class, because any instance of the MyBotMyBot class will refresh each time an activity is

received. Add the following code to the class:

11. Double-click on the MyBotMyBot class. This class will host the handlers called by any incoming activity from

the customer. In this class you will add the code used to build the conversation between the bot and the

customer. As mentioned earlier, an instance of this class is initialized each time an activity is received. Add

the following code to this class:



using Microsoft.Bot;
using Microsoft.Bot.Builder;
using Microsoft.Bot.Schema;
using System.Threading.Tasks;

namespace MyBot
{
    public class MyBot : IBot
    {       
        public async Task OnTurn(ITurnContext context)
        {
            ConversationContext.userMsg = context.Activity.Text;

            if (context.Activity.Type is ActivityTypes.Message)
            {
                if (string.IsNullOrEmpty(ConversationContext.userName))
                {
                    ConversationContext.userName = ConversationContext.userMsg;
                    await context.SendActivity($"Hello {ConversationContext.userName}. Looks like 
today it is going to rain. \nLuckily I have umbrellas and waterproof jackets to sell!");
                }
                else
                {
                    if (ConversationContext.userMsg.Contains("how much"))
                    {
                        if (ConversationContext.userMsg.Contains("umbrella")) await 
context.SendActivity($"Umbrellas are $13.");
                        else if (ConversationContext.userMsg.Contains("jacket")) await 
context.SendActivity($"Waterproof jackets are $30.");
                        else await context.SendActivity($"Umbrellas are $13. \nWaterproof jackets are 
$30.");
                    }
                    else if (ConversationContext.userMsg.Contains("color") || 
ConversationContext.userMsg.Contains("colour"))
                    {
                        await context.SendActivity($"Umbrellas are black. \nWaterproof jackets are 
yellow.");
                    }
                    else
                    {
                        await context.SendActivity($"Sorry {ConversationContext.userName}. I did not 
understand the question");
                    }
                }
            }
            else
            {

                ConversationContext.userMsg = string.Empty;
                ConversationContext.userName = string.Empty;
                await context.SendActivity($"Welcome! \nI am the Weather Shop Bot \nWhat is your 
name?");
            }

        }
    }
}

12. Double-click on the Star tupStar tup class. This class will initialize the bot. Add the following code to the class:



using Microsoft.AspNetCore.Builder;
using Microsoft.AspNetCore.Hosting;
using Microsoft.Bot.Builder.BotFramework;
using Microsoft.Bot.Builder.Integration.AspNet.Core;
using Microsoft.Extensions.Configuration;
using Microsoft.Extensions.DependencyInjection;

namespace MyBot
{
public class Startup
    {
        public IConfiguration Configuration { get; }

        public Startup(IHostingEnvironment env)
        {
            var builder = new ConfigurationBuilder()
                .SetBasePath(env.ContentRootPath)
                .AddJsonFile("appsettings.json", optional: true, reloadOnChange: true)
                .AddJsonFile($"appsettings.{env.EnvironmentName}.json", optional: true)
                .AddEnvironmentVariables();
            Configuration = builder.Build();
        }

        // This method gets called by the runtime. Use this method to add services to the container.
        public void ConfigureServices(IServiceCollection services)
        {
            services.AddSingleton(_ => Configuration);
            services.AddBot<MyBot>(options =>
            {
                options.CredentialProvider = new ConfigurationCredentialProvider(Configuration);
            });
        }

        // This method gets called by the runtime. Use this method to configure the HTTP request 
pipeline.
        public void Configure(IApplicationBuilder app, IHostingEnvironment env)
        {
            if (env.IsDevelopment())
            {
                app.UseDeveloperExceptionPage();
            }

            app.UseDefaultFiles();
            app.UseStaticFiles();
            app.UseBotFramework();
        }
    }
}

13. Open the ProgramProgram class file and verify the code in it is the same as the following:
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using Microsoft.AspNetCore;
using Microsoft.AspNetCore.Hosting;

namespace MyBot
{
    public class Program
    {
        public static void Main(string[] args)
        {
            BuildWebHost(args).Run();
        }

        public static IWebHost BuildWebHost(string[] args) =>
            WebHost.CreateDefaultBuilder(args)
                .UseStartup<Startup>()
                .Build();
    }
}

14. Remember to save your changes, to do so, go to FileFile > Save AllSave All , from the toolbar at the top of Visual

Studio.

Now that you have built the code for your bot, you have to publish it to an instance of the Web App Bot Service,

on the Azure Portal. This Chapter will show you how to create and configure the Bot Service on Azure and then

publish your code to it.

1. First, log in to the Azure Portal (https://portal.azure.com).

a. If you do not already have an Azure account, you will need to create one. If you are following this

tutorial in a classroom or lab situation, ask your instructor or one of the proctors for help setting up

your new account.

2. Once you are logged in, click on Create a resourceCreate a resource in the top left corner, and search for Web App bot,

and click EnterEnter .

3. The new page will provide a description of the Web App Bot Service. At the bottom left of this page, select

the CreateCreate button, to create an association with this Service.

https://portal.azure.com


4. Once you have clicked on CreateCreate:

a. Insert your desired NameName for this Service instance.

b. Select a Subscr iptionSubscr iption.

c. Choose a Resource GroupResource Group or create a new one. A resource group provides a way to monitor,

control access, provision and manage billing for a collection of Azure assets. It is recommended to

keep all the Azure Services associated with a single project (e.g. such as these courses) under a

common resource group).

If you wish to read more about Azure Resource Groups, please follow this link

d. Determine the Location for your resource group (if you are creating a new Resource Group). The

location would ideally be in the region where the application would run. Some Azure assets are

only available in certain regions.

e. Select the Pr icing TierPr icing Tier  appropriate for you, if this is the first time creating a Web App Bot Service,

a free tier (named F0) should be available to you

f. App nameApp name can just be left the same as the Bot name.

g. Leave the Bot template as Basic (C#)Basic (C#) .

h. App service plan/Location should have been auto-filled for your account.

i. Set the Azure StorageAzure Storage that you wish to use to host your Bot. If you dont have one already, you

can create it here.

j. You will also need to confirm that you have understood the Terms and Conditions applied to this

Service.

https://docs.microsoft.com/en-us/azure/azure-resource-manager/resource-group-portal


k. Click Create.

5. Once you have clicked on CreateCreate, you will have to wait for the Service to be created, this might take a

minute.

6. A notification will appear in the Portal once the Service instance is created.

7. Click on the notification to explore your new Service instance.

8. Click the Go to resourceGo to resource button in the notification to explore your new Service instance. You will be

taken to your new Azure Service instance.



9. At this point you need to setup a feature called Direct L ineDirect L ine to allow your client application to

communicate with this Bot Service. Click on ChannelsChannels , then in the Add a featured channelAdd a featured channel  section,

click on Configure Direct L ine channelConfigure Direct L ine channel .

10. In this page you will find the Secret keysSecret keys  that will allow your client app to authenticate with the bot.

Click on the ShowShow  button and take a copy of one of the displayed Keys, as you will need this later in your

project.
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NOTENOTE

Now that your Service is ready, you need to publish your Bot code, that you built previously, to your newly

created Web App Bot Service.

You will have to publish your Bot to the Azure Service every time you make changes to the Bot solution / code.

1. Go back to your Visual Studio Solution that you created previously.

2. Right-click on your MyBotMyBot project, in the Solution ExplorerSolution Explorer , then click on PublishPublish .

3. On the Pick a publish target page, click App Ser viceApp Ser vice, then Select ExistingSelect Existing, lastly click on CreateCreate

ProfileProfile (you may need to click on the dropdown arrow alongside the Publish button, if this is not visible).



4. If you are not yet logged in into your Microsoft Account, you have to do it here.

5. On the PublishPublish page you will find you have to set the same Subscr iptionSubscr iption that you used for the Web

App Bot Service creation. Then set the ViewView  as Resource GroupResource Group and, in the drop down folder structure,

select the Resource GroupResource Group you have created previously. Click OKOK.

6. Now click on the PublishPublish button, and wait for the Bot to be published (it might take a few minutes).
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The following is a typical set up for developing with mixed reality, and as such, is a good template for other

projects.

1. Open Unity and click NewNew .

2. You will now need to provide a Unity project name. Insert HoloLens BotHoloLens Bot. Make sure the project template

is set to 3D3D. Set the LocationLocation to somewhere appropriate for you (remember, closer to root directories is

better). Then, click Create projectCreate project.

3. With Unity open, it is worth checking the default Scr ipt EditorScr ipt Editor  is set to Visual StudioVisual Studio. Go to Edit >Edit >



PreferencesPreferences  and then from the new window, navigate to External ToolsExternal Tools . Change External Scr iptExternal Scr ipt

EditorEditor  to Visual Studio 2017Visual Studio 2017 . Close the PreferencesPreferences  window.

4. Next, go to File > Build SettingsFile > Build Settings  and select Universal Windows PlatformUniversal Windows Platform , then click on the SwitchSwitch

PlatformPlatform button to apply your selection.

5. While still in File > Build SettingsFile > Build Settings  and make sure that:

a. Target DeviceTarget Device is set to HoloLensHoloLens

For the immersive headsets, set Target DeviceTarget Device to Any Device.

b. Build TypeBuild Type is set to D3DD3D

c. SDKSDK is set to Latest installedLatest installed

d. Visual Studio VersionVisual Studio Version is set to Latest installedLatest installed

e. Build and RunBuild and Run is set to Local MachineLocal Machine

f. Save the scene and add it to the build.

a. Do this by selecting Add Open ScenesAdd Open Scenes . A save window will appear.



b. Create a new folder for this, and any future, scene, then select the New folderNew folder  button, to

create a new folder, name it ScenesScenes .

c. Open your newly created ScenesScenes  folder, and then in the File name: text field, type

BotSceneBotScene, then click on SaveSave.

g. The remaining settings, in Build SettingsBuild Settings , should be left as default for now.



6. In the Build Settings window, click on the Player SettingsPlayer Settings  button, this will open the related panel in the

space where the Inspector is located.

7. In this panel, a few settings need to be verified:

a. In the Other SettingsOther Settings  tab:

a. Scr ipting Runtime VersionScr ipting Runtime Version should be Experimental (NET 4.6 Equivalent)Experimental (NET 4.6 Equivalent) ; changing

this will require a restart of the Editor.

b. Scr ipting BackendScripting Backend should be .NET.NET

c. API Compatibility LevelAPI Compatibility Level  should be .NET 4.6.NET 4.6

b. Within the Publishing SettingsPublishing Settings  tab, under CapabilitiesCapabilities , check:

InternetClientInternetClient

MicrophoneMicrophone
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IMPORTANTIMPORTANT
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c. Further down the panel, in XR SettingsXR Settings  (found below Publish SettingsPublish Settings ), tick Vir tual RealityVir tual Reality

Suppor tedSuppor ted, make sure the Windows Mixed Reality SDKWindows Mixed Reality SDK is added.

8. Back in Build Settings Unity C# Projects is no longer greyed out; tick the checkbox next to this.

9. Close the Build Settings window.

10. Save your scene and project (FILE > SAVE SCENE / FILE > SAVE PROJECTFILE > SAVE SCENE / FILE > SAVE PROJECT).

If you wish to skip the Unity Set up component of this course, and continue straight into code, feel free to download this

Azure-MR-312-Package.unitypackage, import it into your project as a Custom PackageCustom Package, and then continue from

Chapter 7.

1. In the Hierarchy panel, select the Main CameraMain Camera.

2. Once selected, you will be able to see all the components of the Main CameraMain Camera in the Inspector panel.

a. The Camera objectCamera object must be named Main CameraMain Camera (note the spelling)

b. The Main Camera TagTag must be set to MainCameraMainCamera (note the spelling)

c. Make sure the Transform PositionTransform Position is set to 0, 0 , 00, 0 , 0

d. Set Clear FlagsClear Flags  to Solid ColorSolid Color .

e. Set the BackgroundBackground Color of the Camera component to Black , Alpha 0 (Hex Code: #00000000)Black , Alpha 0 (Hex Code: #00000000)

https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20312%20-%20Bot%20integration/Azure-MR-312.unitypackage
https://docs.unity3d.com/Manual/AssetPackages.html


To help you deserialize and serialize objects received and sent to the Bot Service you need to download the

NewtonsoftNewtonsoft library. You will find a compatible version already organized with the correct Unity folder structure

here.

To import the Newtonsoft library into your project, use the Unity Package which came with this course.

1. Add the .unitypackage to Unity by using the AssetsAssets  > Impor t PackageImpor t Package > Custom PackageCustom Package menu

option.

2. In the Impor t Unity PackageImpor t Unity Package box that pops up, ensure everything under (and including) PluginsPlugins  is

selected.

3. Click the Impor tImpor t button to add the items to your project.

4. Go to the NewtonsoftNewtonsoft folder under PluginsPlugins  in the project view and select the Newtonsoft plugin.

5. With the Newtonsoft plugin selected, ensure that Any PlatformAny Platform is uncheckedunchecked, then ensure that

WSAPlayerWSAPlayer  is also uncheckedunchecked, then click ApplyApply . This is just to confirm that the files are configured

correctly.

https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20312%20-%20Bot%20integration/NewtonsoftDLL.unitypackage
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NOTENOTE
Marking these plugins configures them to only be used in the Unity Editor. There are a different set of them in the

WSA folder which will be used after the project is exported from Unity.

6. Next, you need to open the WSAWSA folder, within the NewtonsoftNewtonsoft folder. You will see a copy of the same

file you just configured. Select the file, and then in the inspector, ensure that

Any PlatformAny Platform is uncheckedunchecked

onlyonly  WSAPlayerWSAPlayer  is checkedchecked

Dont processDont process  is checkedchecked

1. Create a new TagTag object called BotTagBotTag. Select the Main Camera in the scene. Click on the Tag drop down

menu in the Inspector panel. Click on Add TagAdd Tag.



WARNINGWARNING

 Chapter 8 – Create the BotObjects class

2. Click on the ++ symbol. Name the new TagTag as BotTagBotTag, Save.

Do notDo not  apply the BotTagBotTag to the Main Camera. If you have accidentally done this, make sure to change the Main Camera

tag back to MainCamera.

The first script you need to create is the BotObjectsBotObjects  class, which is an empty class created so that a series of

other class objects can be stored within the same script and accessed by other scripts in the scene.

The creation of this class is purely an architectural choice, these objects could instead be hosted in the Bot script

that you will create later in this course.

To create this class:

1. Right-click in the Project panel, then Create > FolderCreate > Folder . Name the folder Scr iptsScr ipts .
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using System;
using System.Collections;
using System.Collections.Generic;
using UnityEngine;

public class BotObjects : MonoBehaviour{}

/// <summary>
/// Object received when first opening a conversation
/// </summary>
[Serializable]
public class ConversationObject
{
    public string ConversationId;
    public string token;
    public string expires_in;
    public string streamUrl;
    public string referenceGrammarId;
}

/// <summary>
/// Object including all Activities
/// </summary>
[Serializable]
public class ActivitiesRootObject
{
    public List<Activity> activities { get; set; }
    public string watermark { get; set; }
}
[Serializable]
public class Conversation
{
    public string id { get; set; }
}
[Serializable]
public class From
{
    public string id { get; set; }
    public string name { get; set; }
}
[Serializable]
public class Activity
{
    public string type { get; set; }
    public string channelId { get; set; }
    public Conversation conversation { get; set; }
    public string id { get; set; }
    public From from { get; set; }
    public string text { get; set; }
    public string textFormat { get; set; }
    public DateTime timestamp { get; set; }
    public string serviceUrl { get; set; }
}

2. Double-click on the Scr iptsScr ipts  folder to open it. Then within that folder, right-click, and select Create > C#Create > C#

ScriptScr ipt. Name the script BotObjectsBotObjects .

3. Double-click on the new BotObjectsBotObjects  script to open it with Visual StudioVisual Studio.

4. Delete the content of the script and replace it with the following code:

5. Be sure to save your changes in Visual Studio before returning to Unity.



The next class you are going to create is the GazeInputGazeInput class. This class is responsible for :

Creating a cursor that will represent the gaze of the player.

Detecting objects hit by the gaze of the player, and holding a reference to detected objects.

To create this class:

/// <summary>
/// Class responsible for the User's gaze interactions
/// </summary>
[System.Serializable]
public class GazeInput : MonoBehaviour

    [Tooltip("Used to compare whether an object is to be interacted with.")]
    internal string InteractibleTag = "BotTag";

    /// <summary>
    /// Length of the gaze
    /// </summary>
    internal float GazeMaxDistance = 300;

    /// <summary>
    /// Object currently gazed
    /// </summary>
    internal GameObject FocusedObject { get; private set; }

    internal GameObject _oldFocusedObject { get; private set; }

    internal RaycastHit HitInfo { get; private set; }

    /// <summary>
    /// Cursor object visible in the scene
    /// </summary>
    internal GameObject Cursor { get; private set; }

    internal bool Hit { get; private set; }

    internal Vector3 Position { get; private set; }

    internal Vector3 Normal { get; private set; }

    private Vector3 _gazeOrigin;

    private Vector3 _gazeDirection;

1. Go to the Scr iptsScr ipts  folder you created previously.

2. Right-click inside the folder, Create > C# Scr iptCreate > C# Scr ipt. Call the script GazeInputGazeInput.

3. Double-click on the new GazeInputGazeInput script to open it with Visual StudioVisual Studio.

4. Insert the following line right on top of the class name:

5. Then add the following variables inside the GazeInputGazeInput class, above the Star t()Star t()  method:

6. Code for Star t()Star t()  method should be added. This will be called when the class initializes:



    /// <summary>
    /// Start method used upon initialization.
    /// </summary>
    internal virtual void Start()
    {
        FocusedObject = null;
        Cursor = CreateCursor();
    }

    /// <summary>
    /// Method to create a cursor object.
    /// </summary>
    internal GameObject CreateCursor()
    {
        GameObject newCursor = GameObject.CreatePrimitive(PrimitiveType.Sphere);
        newCursor.SetActive(false);
        // Remove the collider, so it does not block Raycast.
        Destroy(newCursor.GetComponent<SphereCollider>());
        newCursor.transform.localScale = new Vector3(0.05f, 0.05f, 0.05f);
        Material mat = new Material(Shader.Find("Diffuse"));
        newCursor.GetComponent<MeshRenderer>().material = mat;
        mat.color = Color.HSVToRGB(0.0223f, 0.7922f, 1.000f);
        newCursor.SetActive(true);

        return newCursor;
    }

    /// <summary>
    /// Called every frame
    /// </summary>
    internal virtual void Update()
    {
        _gazeOrigin = Camera.main.transform.position;

        _gazeDirection = Camera.main.transform.forward;

        UpdateRaycast();
    }

    /// <summary>
    /// Reset the old focused object, stop the gaze timer, and send data if it
    /// is greater than one.
    /// </summary>
    private void ResetFocusedObject()
    {
        // Ensure the old focused object is not null.
        if (_oldFocusedObject != null)
        {
            if (_oldFocusedObject.CompareTag(InteractibleTag))
            {
                // Provide the OnGazeExited event.
                _oldFocusedObject.SendMessage("OnGazeExited", 
                    SendMessageOptions.DontRequireReceiver);
            }
        }
    }

7. Implement a method that will instantiate and setup the gaze cursor :

8. Implement the methods that will setup the Raycast from the Main Camera and will keep track of the

current focused object.
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    private void UpdateRaycast()
    {
        // Set the old focused gameobject.
        _oldFocusedObject = FocusedObject;
        RaycastHit hitInfo;

        // Initialize Raycasting.
        Hit = Physics.Raycast(_gazeOrigin,
            _gazeDirection,
            out hitInfo,
            GazeMaxDistance);
        HitInfo = hitInfo;

        // Check whether raycast has hit.
        if (Hit == true)
        {
            Position = hitInfo.point;
            Normal = hitInfo.normal;

            // Check whether the hit has a collider.
            if (hitInfo.collider != null)
            {
                // Set the focused object with what the user just looked at.
                FocusedObject = hitInfo.collider.gameObject;
            }
            else
            {
                // Object looked on is not valid, set focused gameobject to null.
                FocusedObject = null;
            }
        }
        else
        {
            // No object looked upon, set focused gameobject to null.
            FocusedObject = null;

            // Provide default position for cursor.
            Position = _gazeOrigin + (_gazeDirection * GazeMaxDistance);

            // Provide a default normal.
            Normal = _gazeDirection;
        }

        // Lerp the cursor to the given position, which helps to stabilize the gaze.
        Cursor.transform.position = Vector3.Lerp(Cursor.transform.position, Position, 0.6f);

        // Check whether the previous focused object is this same. If so, reset the focused object.
        if (FocusedObject != _oldFocusedObject)
        {
            ResetFocusedObject();
            if (FocusedObject != null)
            {
                if (FocusedObject.CompareTag(InteractibleTag))
                {
                    // Provide the OnGazeEntered event.
                    FocusedObject.SendMessage("OnGazeEntered",
                        SendMessageOptions.DontRequireReceiver);
                }
            }
        }
    }

9. Be sure to save your changes in Visual Studio before returning to Unity.



The script you are going to create now is called BotBot. This is the core class of your application, it stores:

Your Web App Bot credentials

The method that collects the user voice commands

The method necessary to initiate conversations with your Web App Bot

The method necessary to send messages to your Web App Bot

To send messages to the Bot Service, the SendMessageToBot()SendMessageToBot()  coroutine will build an activity, which is an

object recognized by the Bot Framework as data sent by the user.

To create this class:

using Newtonsoft.Json;
using System.Collections;
using System.Text;
using UnityEngine;
using UnityEngine.Networking;
using UnityEngine.Windows.Speech;

1. Double-click on the Scr iptsScr ipts  folder, to open it.

2. Right-click inside the Scr iptsScr ipts  folder, click Create > C# Scr iptCreate > C# Scr ipt. Name the script BotBot.

3. Double-click on the new script to open it with Visual Studio.

4. Update the namespaces to be the same as the following, at the top of the BotBot class:

5. Inside the BotBot class add the following variables:



    /// <summary>
    /// Static instance of this class
    /// </summary>
    public static Bot Instance;

    /// <summary>
    /// Material of the sphere representing the Bot in the scene
    /// </summary>
    internal Material botMaterial;

    /// <summary>
    /// Speech recognizer class reference, which will convert speech to text.
    /// </summary>
    private DictationRecognizer dictationRecognizer;

    /// <summary>
    /// Use this variable to identify the Bot Id
    /// Can be any value
    /// </summary>
    private string botId = "MRBotId";

    /// <summary>
    /// Use this variable to identify the Bot Name
    /// Can be any value
    /// </summary>
    private string botName = "MRBotName";

    /// <summary>
    /// The Bot Secret key found on the Web App Bot Service on the Azure Portal
    /// </summary>
    private string botSecret = "-- Add your Secret Key here --"; 

    /// <summary>
    /// Bot Endpoint, v4 Framework uses v3 endpoint at this point in time
    /// </summary>
    private string botEndpoint = "https://directline.botframework.com/v3/directline";

    /// <summary>
    /// The conversation object reference
    /// </summary>
    private ConversationObject conversation;

    /// <summary>
    /// Bot states to regulate the application flow
    /// </summary>
    internal enum BotState {ReadyToListen, Listening, Processing}

    /// <summary>
    /// Flag for the Bot state
    /// </summary>
    internal BotState botState;

    /// <summary>
    /// Flag for the conversation status
    /// </summary>
    internal bool conversationStarted = false;

NOTENOTE
Make sure you insert your Bot Secret KeyBot Secret Key  into the botSecretbotSecret  variable. You will have noted your Bot SecretBot Secret

KeyKey at the beginning of this course, in Chapter 2Chapter 2 , step 10, step 10 .

6. Code for Awake()Awake()  and Star t()Star t()  now needs to be added.



    /// <summary>
    /// Called on Initialization
    /// </summary>
    void Awake()
    {
        Instance = this;
    }

    /// <summary>
    /// Called immediately after Awake method
    /// </summary>
    void Start()
    {
        botState = BotState.ReadyToListen;
    }

    /// <summary>
    /// Start microphone capture.
    /// </summary>
    public void StartCapturingAudio()
    {
        botState = BotState.Listening;
        botMaterial.color = Color.red;

        // Start dictation
        dictationRecognizer = new DictationRecognizer();
        dictationRecognizer.DictationResult += DictationRecognizer_DictationResult;
        dictationRecognizer.Start();
    }

    /// <summary>
    /// Stop microphone capture.
    /// </summary>
    public void StopCapturingAudio()
    {
        botState = BotState.Processing;
        dictationRecognizer.Stop();
    }

    /// <summary>
    /// This handler is called every time the Dictation detects a pause in the speech. 
    /// </summary>
    private void DictationRecognizer_DictationResult(string text, ConfidenceLevel confidence)
    {
        // Update UI with dictation captured
        Debug.Log($"User just said: {text}");      

        // Send dictation to Bot
        StartCoroutine(SendMessageToBot(text, botId, botName, "message"));
        StopCapturingAudio();
    }     

7. Add the two handlers that are called by the speech libraries when voice capture begins and ends. The

DictationRecognizer will automatically stop capturing the user voice when the user stops speaking.

8. The following handler collects the result of the user voice input and calls the coroutine responsible for

sending the message to the Web App Bot Service.

9. The following coroutine is called to begin a conversation with the Bot. You will notice that once the

conversation call is complete, it will call the SendMessageToCoroutine()SendMessageToCoroutine()  by passing a series of



    /// <summary>
    /// Request a conversation with the Bot Service
    /// </summary>
    internal IEnumerator StartConversation()
    {
        string conversationEndpoint = string.Format("{0}/conversations", botEndpoint);

        WWWForm webForm = new WWWForm();

        using (UnityWebRequest unityWebRequest = UnityWebRequest.Post(conversationEndpoint, webForm))
        {
            unityWebRequest.SetRequestHeader("Authorization", "Bearer " + botSecret);
            unityWebRequest.downloadHandler = new DownloadHandlerBuffer();

            yield return unityWebRequest.SendWebRequest();
            string jsonResponse = unityWebRequest.downloadHandler.text;

            conversation = new ConversationObject();
            conversation = JsonConvert.DeserializeObject<ConversationObject>(jsonResponse);
            Debug.Log($"Start Conversation - Id: {conversation.ConversationId}");
            conversationStarted = true; 
        }

        // The following call is necessary to create and inject an activity of type 
//"conversationUpdate" to request a first "introduction" from the Bot Service.
        StartCoroutine(SendMessageToBot("", botId, botName, "conversationUpdate"));
    }    

parameters that will set the activity to be sent to the Bot Service as an empty message. This is done to

prompt the Bot Service to initiate the dialogue.

10. The following coroutine is called to build the activity to be sent to the Bot Service.



    /// <summary>
    /// Send the user message to the Bot Service in form of activity
    /// and call for a response
    /// </summary>
    private IEnumerator SendMessageToBot(string message, string fromId, string fromName, string 
activityType)
    {
        Debug.Log($"SendMessageCoroutine: {conversation.ConversationId}, message: {message} from Id: 
{fromId} from name: {fromName}");

        // Create a new activity here
        Activity activity = new Activity();
        activity.from = new From();
        activity.conversation = new Conversation();
        activity.from.id = fromId;
        activity.from.name = fromName;
        activity.text = message;
        activity.type = activityType;
        activity.channelId = "DirectLineChannelId";
        activity.conversation.id = conversation.ConversationId;     

        // Serialize the activity
        string json = JsonConvert.SerializeObject(activity);

        string sendActivityEndpoint = string.Format("{0}/conversations/{1}/activities", botEndpoint, 
conversation.ConversationId);

        // Send the activity to the Bot
        using (UnityWebRequest www = new UnityWebRequest(sendActivityEndpoint, "POST"))
        {
            www.uploadHandler = new UploadHandlerRaw(Encoding.UTF8.GetBytes(json));

            www.downloadHandler = new DownloadHandlerBuffer();
            www.SetRequestHeader("Authorization", "Bearer " + botSecret);
            www.SetRequestHeader("Content-Type", "application/json");

            yield return www.SendWebRequest();

            // extrapolate the response Id used to keep track of the conversation
            string jsonResponse = www.downloadHandler.text;
            string cleanedJsonResponse = jsonResponse.Replace("\r\n", string.Empty);
            string responseConvId = cleanedJsonResponse.Substring(10, 30);

            // Request a response from the Bot Service
            StartCoroutine(GetResponseFromBot(activity));
        }
    }

11. The following coroutine is called to request a response after sending an activity to the Bot Service.
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    /// <summary>
    /// Request a response from the Bot by using a previously sent activity
    /// </summary>
    private IEnumerator GetResponseFromBot(Activity activity)
    {
        string getActivityEndpoint = string.Format("{0}/conversations/{1}/activities", botEndpoint, 
conversation.ConversationId);

        using (UnityWebRequest unityWebRequest1 = UnityWebRequest.Get(getActivityEndpoint))
        {
            unityWebRequest1.downloadHandler = new DownloadHandlerBuffer();
            unityWebRequest1.SetRequestHeader("Authorization", "Bearer " + botSecret);

            yield return unityWebRequest1.SendWebRequest();

            string jsonResponse = unityWebRequest1.downloadHandler.text;

            ActivitiesRootObject root = new ActivitiesRootObject();
            root = JsonConvert.DeserializeObject<ActivitiesRootObject>(jsonResponse);

            foreach (var act in root.activities)
            {
                Debug.Log($"Bot Response: {act.text}");
                SetBotResponseText(act.text);
            }

            botState = BotState.ReadyToListen;
            botMaterial.color = Color.blue;
        }
    } 

    /// <summary>
    /// Set the UI Response Text of the bot
    /// </summary>
    internal void SetBotResponseText(string responseString)
    {        
        SceneOrganiser.Instance.botResponseText.text =  responseString;
    }

NOTENOTE

12. The last method to be added to this class, is required to display the message in the scene:

You may see an error within the Unity Editor Console, about missing the SceneOrganiserSceneOrganiser  class. Disregard this

message, as you will create this class later in the tutorial.

13. Be sure to save your changes in Visual Studio before returning to Unity.

The class you are going to create now is called InteractionsInteractions . This class is used to detect the HoloLens Tap Input

from the user.

If the user taps while looking at the Bot object in the scene, and the Bot is ready to listen for voice inputs, the Bot

object will change color to redred and begin listening for voice inputs.

This class inherits from the GazeInputGazeInput class, and so is able to reference the Star t()Star t()  method and variables from

that class, denoted by the use of basebase.

To create this class:



using UnityEngine.XR.WSA.Input;

public class Interactions : GazeInput
{

    /// <summary>
    /// Allows input recognition with the HoloLens
    /// </summary>
    private GestureRecognizer _gestureRecognizer;

    /// <summary>
    /// Called on initialization, after Awake
    /// </summary>
    internal override void Start()
    {
        base.Start();

        //Register the application to recognize HoloLens user inputs
        _gestureRecognizer = new GestureRecognizer();
        _gestureRecognizer.SetRecognizableGestures(GestureSettings.Tap);
        _gestureRecognizer.Tapped += GestureRecognizer_Tapped;
        _gestureRecognizer.StartCapturingGestures();
    }

1. Double-click on the Scr iptsScr ipts  folder, to open it.

2. Right-click inside the Scr iptsScr ipts  folder, click Create > C# Scr iptCreate > C# Scr ipt. Name the script InteractionsInteractions .

3. Double-click on the new script to open it with Visual Studio.

4. Update the namespaces and the class inheritance to be the same as the following, at the top of the

InteractionsInteractions  class:

5. Inside the InteractionsInteractions  class add the following variable:

6. Then add the Star t()Star t()  method:

7. Add the handler that will be triggered when the user performs the tap gesture in front of the HoloLens

camera
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    /// <summary>
    /// Detects the User Tap Input
    /// </summary>
    private void GestureRecognizer_Tapped(TappedEventArgs obj)
    {
        // Ensure the bot is being gazed upon.
        if(base.FocusedObject != null)
        {
            // If the user is tapping on Bot and the Bot is ready to listen
            if (base.FocusedObject.name == "Bot" && Bot.Instance.botState == 
Bot.BotState.ReadyToListen)
            {
                // If a conversation has not started yet, request one
                if(Bot.Instance.conversationStarted)
                {
                    Bot.Instance.SetBotResponseText("Listening...");
                    Bot.Instance.StartCapturingAudio();
                }
                else
                {
                    Bot.Instance.SetBotResponseText("Requesting Conversation...");
                    StartCoroutine(Bot.Instance.StartConversation());
                }                                  
            }
        }
    }

8. Be sure to save your changes in Visual Studio before returning to Unity.

The last class required in this Lab is called SceneOrganiserSceneOrganiser . This class will setup the scene programmatically,

by adding components and scripts to the Main Camera, and creating the appropriate objects in the scene.

To create this class:

    /// <summary>
    /// Static instance of this class
    /// </summary>
    public static SceneOrganiser Instance;

    /// <summary>
    /// The 3D text representing the Bot response
    /// </summary>
    internal TextMesh botResponseText;

1. Double-click on the Scr iptsScr ipts  folder, to open it.

2. Right-click inside the Scr iptsScr ipts  folder, click Create > C# Scr iptCreate > C# Scr ipt. Name the script SceneOrganiserSceneOrganiser .

3. Double-click on the new script to open it with Visual Studio.

4. Inside the SceneOrganiserSceneOrganiser  class add the following variables:

5. Then add the Awake()Awake()  and Star t()Star t()  methods:



    /// <summary>
    /// Called on Initialization
    /// </summary>
    private void Awake()
    {
        Instance = this;
    }

    /// <summary>
    /// Called immediately after Awake method
    /// </summary>
    void Start ()
    {
        // Add the GazeInput class to this object
        gameObject.AddComponent<GazeInput>();

        // Add the Interactions class to this object
        gameObject.AddComponent<Interactions>();

        // Create the Bot in the scene
        CreateBotInScene();
    }

    /// <summary>
    /// Create the Sign In button object in the scene
    /// and sets its properties
    /// </summary>
    private void CreateBotInScene()
    {
        GameObject botObjInScene = GameObject.CreatePrimitive(PrimitiveType.Sphere);
        botObjInScene.name = "Bot";

        // Add the Bot class to the Bot GameObject
        botObjInScene.AddComponent<Bot>();

        // Create the Bot UI
        botResponseText = CreateBotResponseText();

        // Set properties of Bot GameObject
        Bot.Instance.botMaterial = new Material(Shader.Find("Diffuse"));
        botObjInScene.GetComponent<Renderer>().material = Bot.Instance.botMaterial;
        Bot.Instance.botMaterial.color = Color.blue;
        botObjInScene.transform.position = new Vector3(0f, 2f, 10f);
        botObjInScene.tag = "BotTag";
    }

6. Add the following method, responsible for creating the Bot object in the scene and setting up the

parameters and components:

7. Add the following method, responsible for creating the UI object in the scene, representing the responses

from the Bot:
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    /// <summary>
    /// Spawns cursor for the Main Camera
    /// </summary>
    private TextMesh CreateBotResponseText()
    {
        // Create a sphere as new cursor
        GameObject textObject = new GameObject();
        textObject.transform.parent = Bot.Instance.transform;
        textObject.transform.localPosition = new Vector3(0,1,0);

        // Resize the new cursor
        textObject.transform.localScale = new Vector3(0.1f, 0.1f, 0.1f);

        // Creating the text of the Label
        TextMesh textMesh = textObject.AddComponent<TextMesh>();
        textMesh.anchor = TextAnchor.MiddleCenter;
        textMesh.alignment = TextAlignment.Center;
        textMesh.fontSize = 50;
        textMesh.text = "Hi there, tap on me and I will start listening.";

        return textMesh;
    }

8. Be sure to save your changes in Visual Studio before returning to Unity.

9. In the Unity Editor, drag the SceneOrganiserSceneOrganiser  script from the Scripts folder to the Main Camera. The

Scene Organiser component should now appear on the Main Camera object, as shown in the image

below.

To perform a thorough test of your application you will need to sideload it onto your HoloLens. Before you do,

ensure that:

All the settings mentioned in the Chapter 4Chapter 4  are set correctly.

The script SceneOrganiserSceneOrganiser  is attached to the Main CameraMain Camera object.

In the BotBot class, make sure you have inserted your Bot Secret KeyBot Secret Key  into the botSecretbotSecret variable.
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 Chapter 15 – Deploy to HoloLens

Everything needed for the Unity section of this project has now been completed, so it is time to build it from

Unity.

1. Navigate to Build SettingsBuild Settings , File > Build Settings…File > Build Settings… .

2. From the Build SettingsBuild Settings  window, click BuildBuild.

3. If not already, tick Unity C# ProjectsUnity C# Projects .

4. Click BuildBuild. Unity will launch a File ExplorerFile Explorer  window, where you need to create and then select a folder

to build the app into. Create that folder now, and name it AppApp. Then with the AppApp folder selected, click

Select FolderSelect Folder .

5. Unity will begin building your project to the AppApp folder.

6. Once Unity has finished building (it might take some time), it will open a File ExplorerFile Explorer  window at the

location of your build (check your task bar, as it may not always appear above your windows, but will

notify you of the addition of a new window).

To deploy on HoloLens:

1. You will need the IP Address of your HoloLens (for Remote Deploy), and to ensure your HoloLens is in

Developer ModeDeveloper Mode. To do this:

a. Whilst wearing your HoloLens, open the SettingsSettings .

b. Go to Network & Internet > Wi-Fi > Advanced OptionsNetwork & Internet > Wi-Fi > Advanced Options

c. Note the IPv4IPv4  address.

d. Next, navigate back to SettingsSettings , and then to Update & Security > For DevelopersUpdate & Security > For Developers

e. Set Developer Mode On.

2. Navigate to your new Unity build (the AppApp folder) and open the solution file with Visual StudioVisual Studio.

3. In the Solution ConfigurationSolution Configuration select DebugDebug.

4. In the Solution PlatformSolution Platform , select x86x86 , Remote MachineRemote Machine.
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  Some questions to ask the Bot:Some questions to ask the Bot:

what do you sell? 

how much are umbrellas?

how much are raincoats?

 Your finished Web App Bot (v4) application

NOTENOTE

5. Go to the Build menuBuild menu and click on Deploy SolutionDeploy Solution, to sideload the application to your HoloLens.

6. Your app should now appear in the list of installed apps on your HoloLens, ready to be launched!

To deploy to immersive headset, set the Solution PlatformSolution Platform to Local Machine, and set the ConfigurationConfiguration to

Debug, with x86 as the PlatformPlatform. Then deploy to the local machine, using the Build menuBuild menu, selecting Deploy

Solution.

Once you have launched the application, you will see the Bot as a blue sphere in front of you.

Use the Tap GestureTap Gesture while you are gazing at the sphere to initiate a conversation.

Wait for the conversation to start (The UI will display a message when it happens). Once you receive the

introductory message from the Bot, tap again on the Bot so it will turn red and begin to listen to your

voice.

Once you stop talking, your application will send your message to the Bot and you will promptly receive a

response that will be displayed in the UI.

Repeat the process to send more messages to your Bot (you have to tap each time you want to sen a

message).

This conversation demonstrates how the Bot can retain information (your name), whilst also providing known

information (such as the items that are stocked).

Congratulations, you built a mixed reality app that leverages the Azure Web App Bot, Microsoft Bot Framework

v4.



 Bonus exercises
  Exercise 1Exercise 1

  Exercise 2Exercise 2

The conversation structure in this Lab is very basic. Use Microsoft LUIS to give your bot natural language

understanding capabilities.

This example does not include terminating a conversation and restarting a new one. To make the Bot feature

complete, try to implement closure to the conversation.
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NOTENOTE
The Mixed Reality Academy tutorials were designed with HoloLens (1st gen) and Mixed Reality Immersive Headsets in

mind. As such, we feel it is important to leave these tutorials in place for developers who are still looking for guidance in

developing for those devices. These tutorials will notnot  be updated with the latest toolsets or interactions being used for

HoloLens 2. They will be maintained to continue working on the supported devices. There will be a new series of tutorials

that will be posted in the future that will demonstrate how to develop for HoloLens 2. This notice will be updated with a

link to those tutorials when they are posted.

In this course, you will learn how to add translation capabilities to a mixed reality application using Azure

Cognitive Services, with the Translator Text API.

The Translator Text API is a translation Service which works in near real-time. The Service is cloud-based, and,

using a REST API call, an app can make use of the neural machine translation technology to translate text to

another language. For more information, visit the Azure Translator Text API page.

Upon completion of this course, you will have a mixed reality application which will be able to do the following:

1. The user will speak into a microphone connected to an immersive (VR) headset (or the built-in microphone

of HoloLens).

2. The app will capture the dictation and send it to the Azure Translator Text API.

3. The translation result will be displayed in a simple UI group in the Unity Scene.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tutorials/mr-azure-301.md
https://azure.microsoft.com/services/cognitive-services/translator-text-api/
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 Prerequisites

NOTENOTE

 Before you start

This course will teach you how to get the results from the Translator Service into a Unity-based sample

application. It will be up to you to apply these concepts to a custom application you might be building.

While this course primarily focuses on Windows Mixed Reality immersive (VR) headsets, you can also apply what you learn

in this course to Microsoft HoloLens. As you follow along with the course, you will see notes on any changes you might

need to employ to support HoloLens. When using HoloLens, you may notice some echo during voice capture.

This tutorial is designed for developers who have basic experience with Unity and C#. Please also be aware that the

prerequisites and written instructions within this document represent what has been tested and verified at the time of

writing (May 2018). You are free to use the latest software, as listed within the install the tools article, though it should

not be assumed that the information in this course will perfectly match what you'll find in newer software than what's

listed below.

We recommend the following hardware and software for this course:

A development PC, compatible with Windows Mixed Reality for immersive (VR) headset development

Windows 10 Fall Creators Update (or later) with Developer mode enabled

The latest Windows 10 SDK

Unity 2017.4

Visual Studio 2017

A Windows Mixed Reality immersive (VR) headset or Microsoft HoloLens with Developer mode enabled

A set of headphones with a built-in microphone (if the headset doesn't have a built-in mic and speakers)

Internet access for Azure setup and translation retrieval

To avoid encountering issues building this project, it is strongly suggested that you create the project

mentioned in this tutorial in a root or near-root folder (long folder paths can cause issues at build-time).

The code in this tutorial will allow you to record from the default microphone device connected to your

PC. Make sure the default microphone device is set to the device you plan to use to capture your voice.

To allow your PC to enable dictation, go to Settings > Pr ivacy > Speech, inking & typingSettings > Pr ivacy > Speech, inking & typing and select

the button Turn On speech ser vices and typing suggestionsTurn On speech ser vices and typing suggestions .

If you're using a microphone and headphones connected to (or built-in to) your headset, make sure the

option “When I wear my headset, switch to headset mic” is turned on in Settings > Mixed reality >Settings > Mixed reality >

Audio and speechAudio and speech.

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://support.microsoft.com/help/4039260/windows-10-mixed-reality-pc-hardware-guidelines
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
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 Chapter 1 – The Azure Portal

Be aware that if you are developing for an immersive headset for this lab, you may experience audio output device issues.

This is due to an issue with Unity, which is fixed in later versions of Unity (Unity 2018.2). The issue prevents Unity from

changing the default audio output device at run time. As a work around, ensure you have completed the above steps,

and close and re-open the Editor, when this issue presents itself.

To use the Azure Translator API, you will need to configure an instance of the Service to be made available to

your application.

NOTENOTE

1. Log in to the Azure Portal.

If you do not already have an Azure account, you will need to create one. If you are following this tutorial in a

classroom or lab situation, ask your instructor or one of the proctors for help setting up your new account.

2. Once you are logged in, click on NewNew  in the top left corner and search for "Translator Text API." Select

EnterEnter .

https://portal.azure.com


NOTENOTE
The word NewNew may have been replaced with Create a resourceCreate a resource, in newer portals.

3. The new page will provide a description of the Translator Text API Service. At the bottom left of this page,

select the CreateCreate button, to create an association with this Service.

4. Once you have clicked on CreateCreate:

a. Insert your desired NameName for this Service instance.

b. Select an appropriate Subscr iptionSubscr iption.



c. Select the Pr icing TierPr icing Tier  appropriate for you, if this is the first time creating a Translator Text

Service, a free tier (named F0) should be available to you.

d. Choose a Resource GroupResource Group or create a new one. A resource group provides a way to monitor,

control access, provision and manage billing for a collection of Azure assets. It is recommended to

keep all the Azure Services associated with a single project (e.g. such as these labs) under a

common resource group).

If you wish to read more about Azure Resource Groups, please visit the resource group article.

e. Determine the LocationLocation for your resource group (if you are creating a new Resource Group). The

location would ideally be in the region where the application would run. Some Azure assets are

only available in certain regions.

f. You will also need to confirm that you have understood the Terms and Conditions applied to this

Service.

g. Select CreateCreate.

5. Once you have clicked on CreateCreate, you will have to wait for the Service to be created, this might take a

minute.

6. A notification will appear in the portal once the Service instance is created.

https://docs.microsoft.com/en-us/azure/azure-resource-manager/resource-group-portal
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7. Click on the notification to explore your new Service instance.

8. Click the Go to resourceGo to resource button in the notification to explore your new Service instance. You will be

taken to your new Translator Text API Service instance.

9. Within this tutorial, your application will need to make calls to your Service, which is done through using

your Service’s Subscription Key.

10. From the Quick start page of your Translator Text Service, navigate to the first step, Grab your keys, and

click KeysKeys  (you can also achieve this by clicking the blue hyperlink Keys, located in the Services

navigation menu, denoted by the key icon). This will reveal your Service Keys.

11. Take a copy of one of the displayed keys, as you will need this later in your project.

Set up and test your mixed reality immersive headset.



NOTENOTE
You will not need motion controllers for this course. If you need support setting up an immersive headset, please follow

these steps.

The following is a typical set up for developing with mixed reality and, as such, is a good template for other

projects:

1. Open Unity and click NewNew .

2. You will now need to provide a Unity Project name. Insert MR_TranslationMR_Translation. Make sure the project type is

set to 3D3D. Set the Location to somewhere appropriate for you (remember, closer to root directories is

better). Then, click Create projectCreate project.

3. With Unity open, it is worth checking the default Scr ipt EditorScr ipt Editor  is set to Visual StudioVisual Studio. Go to Edit >Edit >

PreferencesPreferences  and then from the new window, navigate to External ToolsExternal Tools . Change External Scr iptExternal Scr ipt

EditorEditor  to Visual Studio 2017Visual Studio 2017 . Close the PreferencesPreferences  window.

https://support.microsoft.com/help/4043101/windows-10-set-up-windows-mixed-reality


4. Next, go to File > Build SettingsFile > Build Settings  and switch the platform to Universal Windows PlatformUniversal Windows Platform , by

clicking on the Switch PlatformSwitch Platform button.

5. Go to File > Build SettingsFile > Build Settings  and make sure that:

a. Target DeviceTarget Device is set to Any DeviceAny Device.

For Microsoft HoloLens, set Target DeviceTarget Device to HoloLens.

b. Build TypeBuild Type is set to D3DD3D

c. SDKSDK is set to Latest installedLatest installed

d. Visual Studio VersionVisual Studio Version is set to Latest installedLatest installed

e. Build and RunBuild and Run is set to Local MachineLocal Machine



f. Save the scene and add it to the build.

a. Do this by selecting Add Open ScenesAdd Open Scenes . A save window will appear.

b. Create a new folder for this, and any future, scene, then select the New folderNew folder  button, to

create a new folder, name it ScenesScenes .

c. Open your newly created ScenesScenes  folder, and then in the File name: text field, type

MR_TranslationSceneMR_TranslationScene, then press SaveSave.



Be aware, you must save your Unity scenes within the Assets folder, as they must be

associated with the Unity Project. Creating the scenes folder (and other similar folders)

is a typical way of structuring a Unity project.

g. The remaining settings, in Build Settings, should be left as default for now.

6. In the Build Settings window, click on the Player SettingsPlayer Settings  button, this will open the related panel in the

space where the Inspector is located.

7. In this panel, a few settings need to be verified:

a. In the Other SettingsOther Settings  tab:

a. Scr ipting Runtime VersionScr ipting Runtime Version should be StableStable (.NET 3.5 Equivalent).

b. Scr ipting BackendScripting Backend should be .NET.NET

c. API Compatibility LevelAPI Compatibility Level  should be .NET 4.6.NET 4.6
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b. Within the Publishing SettingsPublishing Settings  tab, under CapabilitiesCapabilities , check:

a. InternetClientInternetClient

b. MicrophoneMicrophone

c. Further down the panel, in XR SettingsXR Settings  (found below Publish SettingsPublish Settings ), tick Vir tual RealityVir tual Reality

Suppor tedSuppor ted, make sure the Windows Mixed Reality SDKWindows Mixed Reality SDK is added.

8. Back in Build SettingsBuild Settings , Unity C# Projects is no longer greyed out; tick the checkbox next to this.

9. Close the Build Settings window.

10. Save your Scene and Project (FILE > SAVE SCENE / FILE > SAVE PROJECTFILE > SAVE SCENE / FILE > SAVE PROJECT).



IMPORTANTIMPORTANT
If you wish to skip the Unity Set up component of this course, and continue straight into code, feel free to download this

.unitypackage, import it into your project as a Custom Package, and then continue from Chapter 5. You will still need to

create a Unity Project.

1. In the Hierarchy Panel, you will find an object called Main CameraMain Camera, this object represents your “head”

point of view once you are “inside” your application.

2. With the Unity Dashboard in front of you, select the Main Camera GameObjectMain Camera GameObject. You will notice that the

Inspector Panel (generally found to the right, within the Dashboard) will show the various components of

that GameObject, with Transform at the top, followed by Camera, and some other components. You will

need to reset the Transform of the Main Camera, so it is positioned correctly.

3. To do this, select the GearGear  icon next to the Camera’s Transform component, and selecting ResetReset.

4. The Transform component should then look like:

a. The Position is set to 0, 0 , 00, 0 , 0

b. Rotation is set to 0, 0 , 00, 0 , 0

c. And Scale is set to 1, 1 , 11, 1 , 1

5. Next, with the Main CameraMain Camera object selected, see the Add ComponentAdd Component button located at the very

bottom of the Inspector Panel.

6. Select that button, and search (by either typing Audio Source into the search field or navigating the

sections) for the component called Audio SourceAudio Source as shown below and select it (pressing enter on it also

works).

7. An Audio Source component will be added to the Main CameraMain Camera, as demonstrated below.

https://github.com/Microsoft/HolographicAcademy/raw/Azure-MixedReality-Labs/Azure%20Mixed%20Reality%20Labs/MR%20and%20Azure%20301%20-%20Language%20translation/Azure-MR-301.unitypackage
https://docs.unity3d.com/Manual/AssetPackages.html
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NOTENOTE
For Microsoft HoloLens, you will need to also change the following, which are part of the CameraCamera component on

your Main CameraMain Camera:

Clear Flags:Clear Flags:  Solid Color.

BackgroundBackground ‘Black, Alpha 0’ – Hex color: #00000000.

To show the input and output of the translation, a basic UI needs to be created. For this course, you will create a

Canvas UI object, with several ‘Text’ objects to show the data.

1. Right-click in an empty area of the Hierarchy Panel, under UIUI, add a CanvasCanvas .



2. With the Canvas object selected, in the Inspector Panel (within the ‘Canvas’ component), change RenderRender

ModeMode to World SpaceWorld Space.

3. Next, change the following parameters in the Inspector Panel’s Rect Transform:

a. POS - XX 0 YY  0 ZZ 40

b. Width - 500

c. Height - 300

d. Scale - XX 0.13 YY  0.13 ZZ 0.13

4. Right click on the CanvasCanvas  in the Hierarchy Panel, under UIUI, and add a PanelPanel . This PanelPanel  will provide a

background to the text that you will be displaying in the scene.

5. Right click on the PanelPanel  in the Hierarchy Panel, under UIUI, and add a Text objectText object. Repeat the same

process until you have created four UI Text objects in total (Hint: if you have the first ‘Text’ object selected,

you can simply press ‘Ctr l’  + ‘D’‘Ctr l’  + ‘D’ , to duplicate it, until you have four in total).

6. For each Text ObjectText Object, select it and use the below tables to set the parameters in the Inspector Panel.

a. For the Rect Transform component:



N A M EN A M E
T RA N SF O RM  -T RA N SF O RM  -
P O SIT IO NP O SIT IO N W IDT HW IDT H H EIGH TH EIGH T

MicrophoneStatusLabel XX -80 YY  90 ZZ 0 300 30

AzureResponseLabel XX -80 YY  30 ZZ 0 300 30

DictationLabel XX -80 YY  -30 ZZ 0 300 30

TranslationResultLabel XX -80 YY  -90 ZZ 0 300 30

N A M EN A M E T EXTT EXT F O N T  SIZ EF O N T  SIZ E

MicrophoneStatusLabel Microphone Status: 20

AzureResponseLabel Azure Web Response 20

DictationLabel You just said: 20

TranslationResultLabel Translation: 20

b. For the Text (Scr ipt)Text (Scr ipt)  component:

c. Also, make the Font Style BoldBold. This will make the text easier to read.

7. For each UI Text object created in Chapter 5, create a new child UI Text objectUI Text object. These children will display

the output of the application. Create child objects through right-clicking your intended parent (e.g.

MicrophoneStatusLabel) and then select UIUI and then select TextText.



8. For each of these children, select it and use the below tables to set the parameters in the Inspector Panel.

N A M EN A M E
T RA N SF O RM  -T RA N SF O RM  -
P O SIT IO NP O SIT IO N W IDT HW IDT H H EIGH TH EIGH T

MicrophoneStatusText X 0 Y -30 Z 0 300 30

AzureResponseText X 0 Y -30 Z 0 300 30

DictationText X 0 Y -30 Z 0 300 30

TranslationResultText X 0 Y -30 Z 0 300 30

N A M EN A M E T EXTT EXT F O N T  SIZ EF O N T  SIZ E

MicrophoneStatusText ?? 20

AzureResponseText ?? 20

DictationText ?? 20

TranslationResultText ?? 20

a. For the Rect TransformRect Transform component:

b. For the Text (Scr ipt)Text (Scr ipt)  component:

9. Next, select the 'centre' alignment option for each text component:

10. To ensure the child UI Textchild UI Text objects are easily readable, change their Color. Do this by clicking on the bar

(currently ‘Black’) next to Color.

11. Then, in the new, little, Color window, change the Hex Color to: 0032EAFF0032EAFF
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12. Below is how the UIUI should look.

a. In the Hierarchy Panel:

b. In the Scene and Game Views:

The first script you need to create is the Results class, which is responsible for providing a way to see the results

of translation. The Class stores and displays the following:

The response result from Azure.



The microphone status.

The result of the dictation (voice to text).

The result of the translation.

To create this class:

1. Right-click in the Project Panel, then Create > FolderCreate > Folder . Name the folder Scr iptsScr ipts .

2. With the Scr iptsScr ipts  folder create, double click it to open. Then within that folder, right-click, and select

Create >Create > then C# Scr iptC# Scr ipt. Name the script Results.

3. Double click on the new Results script to open it with Visual StudioVisual Studio.

4. Insert the following namespaces:



    using UnityEngine;
    using UnityEngine.UI;

    public static Results instance;

    [HideInInspector] 
    public string azureResponseCode;

    [HideInInspector] 
    public string translationResult;

    [HideInInspector] 
    public string dictationResult;

    [HideInInspector] 
    public string micStatus;

    public Text microphoneStatusText;

    public Text azureResponseText;

    public Text dictationText;

    public Text translationResultText;

    private void Awake() 
    { 
        // Set this class to behave similar to singleton 
        instance = this;           
    } 

5. Inside the Class insert the following variables:

6. Then add the Awake() method, which will be called when the class initializes.

7. Finally, add the methods which are responsible for outputting the various results information to the UI.
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    /// <summary>
    /// Stores the Azure response value in the static instance of Result class.
    /// </summary>
    public void SetAzureResponse(string result)
    {
        azureResponseCode = result;
        azureResponseText.text = azureResponseCode;
    }

    /// <summary>
    /// Stores the translated result from dictation in the static instance of Result class. 
    /// </summary>
    public void SetDictationResult(string result)
    {
        dictationResult = result;
        dictationText.text = dictationResult;
    }

    /// <summary>
    /// Stores the translated result from Azure Service in the static instance of Result class. 
    /// </summary>
    public void SetTranslatedResult(string result)
    {
        translationResult = result;
        translationResultText.text = translationResult;
    }

    /// <summary>
    /// Stores the status of the Microphone in the static instance of Result class. 
    /// </summary>
    public void SetMicrophoneStatus(string result)
    {
        micStatus = result;
        microphoneStatusText.text = micStatus;
    }

8. Be sure to save your changes in Visual Studio before returning to Unity.

The second class you are going to create is the MicrophoneManager.

This class is responsible for :

Detecting the recording device attached to the headset or machine (whichever is the default).

Capture the audio (voice) and use dictation to store it as a string.

Once the voice has paused, submit the dictation to the Translator class.

Host a method that can stop the voice capture if desired.

To create this class:

    using UnityEngine; 
    using UnityEngine.Windows.Speech;

1. Double click on the Scr iptsScr ipts  folder, to open it.

2. Right-click inside the Scr iptsScr ipts  folder, click Create > C# Scr iptCreate > C# Scr ipt. Name the script MicrophoneManager.

3. Double click on the new script to open it with Visual Studio.

4. Update the namespaces to be the same as the following, at the top of the MicrophoneManager class:



    // Help to access instance of this object 
    public static MicrophoneManager instance; 

    // AudioSource component, provides access to mic 
    private AudioSource audioSource; 

    // Flag indicating mic detection 
    private bool microphoneDetected; 

    // Component converting speech to text 
    private DictationRecognizer dictationRecognizer; 

    private void Awake() 
    { 
        // Set this class to behave similar to singleton 
        instance = this; 
    } 

    void Start() 
    { 
        //Use Unity Microphone class to detect devices and setup AudioSource 
        if(Microphone.devices.Length > 0) 
        { 
            Results.instance.SetMicrophoneStatus("Initialising..."); 
            audioSource = GetComponent<AudioSource>(); 
            microphoneDetected = true; 
        } 
        else 
        { 
            Results.instance.SetMicrophoneStatus("No Microphone detected"); 
        } 
    } 

5. Then, add the following variables inside the MicrophoneManager class:

6. Code for the Awake() and Start() methods now needs to be added. These will be called when the class

initializes:

7. You can delete the Update() method since this class will not use it.

8. Now you need the methods that the App uses to start and stop the voice capture, and pass it to the

Translator class, that you will build soon. Copy the following code and paste it beneath the Start() method.



WARNINGWARNING

 Chapter 7 – Call to Azure and translator service

    /// <summary> 
    /// Start microphone capture. Debugging message is delivered to the Results class. 
    /// </summary> 
    public void StartCapturingAudio() 
    { 
        if(microphoneDetected) 
        {               
            // Start dictation 
            dictationRecognizer = new DictationRecognizer(); 
            dictationRecognizer.DictationResult += DictationRecognizer_DictationResult; 
            dictationRecognizer.Start(); 

            // Update UI with mic status 
            Results.instance.SetMicrophoneStatus("Capturing..."); 
        }      
    } 

    /// <summary> 
    /// Stop microphone capture. Debugging message is delivered to the Results class. 
    /// </summary> 
    public void StopCapturingAudio() 
    { 
        Results.instance.SetMicrophoneStatus("Mic sleeping"); 
        Microphone.End(null); 
        dictationRecognizer.DictationResult -= DictationRecognizer_DictationResult; 
        dictationRecognizer.Dispose(); 
    }

TIPTIP

    /// <summary>
    /// This handler is called every time the Dictation detects a pause in the speech. 
    /// Debugging message is delivered to the Results class.
    /// </summary>
    private void DictationRecognizer_DictationResult(string text, ConfidenceLevel confidence)
    {
        // Update UI with dictation captured
        Results.instance.SetDictationResult(text);

        // Start the coroutine that process the dictation through Azure 
        StartCoroutine(Translator.instance.TranslateWithUnityNetworking(text));   
    }

Though this application will not make use of it, the StopCapturingAudio() method has also been provided here,

should you want to implement the ability to stop capturing audio in your application.

9. You now need to add a Dictation Handler that will be invoked when the voice stops. This method will then

pass the dictated text to the Translator class.

10. Be sure to save your changes in Visual Studio before returning to Unity.

At this point you will notice an error appearing in the Unity Editor Console Panel (“The name ‘Translator’ does not exist...”).

This is because the code references the Translator class, which you will create in the next chapter.

The last script you need to create is the Translator class.



This class is responsible for :

Authenticating the App with Azure, in exchange for an Auth TokenAuth Token.

Use the Auth TokenAuth Token to submit text (received from the MicrophoneManager Class) to be translated.

Receive the translated result and pass it to the Results Class to be visualized in the UI.

To create this Class:

    using System;
    using System.Collections;
    using System.Xml.Linq;
    using UnityEngine;
    using UnityEngine.Networking;

    public static Translator instance; 
    private string translationTokenEndpoint = 
"https://api.cognitive.microsoft.com/sts/v1.0/issueToken"; 
    private string translationTextEndpoint = 
"https://api.microsofttranslator.com/v2/http.svc/Translate?"; 
    private const string ocpApimSubscriptionKeyHeader = "Ocp-Apim-Subscription-Key"; 

    //Substitute the value of authorizationKey with your own Key 
    private const string authorizationKey = "-InsertYourAuthKeyHere-"; 
    private string authorizationToken; 

    // languages set below are: 
    // English 
    // French 
    // Italian 
    // Japanese 
    // Korean 
    public enum Languages { en, fr, it, ja, ko }; 
    public Languages from = Languages.en; 
    public Languages to = Languages.it; 

NOTENOTE

1. Go to the Scr iptsScr ipts  folder you created previously.

2. Right-click in the Project PanelProject Panel , Create > C# Scr iptCreate > C# Scr ipt. Call the script Translator.

3. Double click on the new Translator script to open it with Visual Studiowith Visual Studio.

4. Add the following namespaces to the top of the file:

5. Then add the following variables inside the Translator class:

The languages inserted into the languages enumenum are just examples. Feel free to add more if you wish; the API

supports over 60 languages (including Klingon)!

There is a more interactive page covering available languages, though be aware the page only appears to work

when the site language is set to '' (and the Microsoft site will likely redirect to your native language). You can

change site language at the bottom of the page or by altering the URL.

The authorizationKeyauthorizationKey value, in the above code snippet, must be the KeyKey you received when you subscribed

to the Azure Translator Text API. This was covered in Chapter 1.

6. Code for the Awake() and Start() methods now needs to be added.

7. In this case, the code will make a call to Azure using the authorization Key, to get a Token.

https://docs.microsoft.com/en-us/azure/cognitive-services/translator/languages
https://www.microsoft.com/translator/business/languages/


    private void Awake() 
    { 
        // Set this class to behave similar to singleton  
        instance = this; 
    } 

    // Use this for initialization  
    void Start() 
    { 
        // When the application starts, request an auth token 
        StartCoroutine("GetTokenCoroutine", authorizationKey); 
    }

NOTENOTE

    /// <summary> 
    /// Request a Token from Azure Translation Service by providing the access key. 
    /// Debugging result is delivered to the Results class. 
    /// </summary> 
    private IEnumerator GetTokenCoroutine(string key)
    {
        if (string.IsNullOrEmpty(key))
        {
            throw new InvalidOperationException("Authorization key not set.");
        }

        using (UnityWebRequest unityWebRequest = UnityWebRequest.Post(translationTokenEndpoint, 
string.Empty))
        {
            unityWebRequest.SetRequestHeader("Ocp-Apim-Subscription-Key", key);
            yield return unityWebRequest.SendWebRequest();

            long responseCode = unityWebRequest.responseCode;

            // Update the UI with the response code 
            Results.instance.SetAzureResponse(responseCode.ToString());

            if (unityWebRequest.isNetworkError || unityWebRequest.isHttpError)
            {
                Results.instance.azureResponseText.text = unityWebRequest.error;
                yield return null;
            }
            else
            {
                authorizationToken = unityWebRequest.downloadHandler.text;
            }
        }

        // After receiving the token, begin capturing Audio with the MicrophoneManager Class 
        MicrophoneManager.instance.StartCapturingAudio();
    }

The token will expire after 10 minutes. Depending on the scenario for your app, you might have to make the same

coroutine call multiple times.

8. The coroutine to obtain the Token is the following:



 Chapter 8 – Configure the Unity Scene

WARNINGWARNING

    /// <summary> 
    /// Request a translation from Azure Translation Service by providing a string.  
    /// Debugging result is delivered to the Results class. 
    /// </summary> 
    public IEnumerator TranslateWithUnityNetworking(string text)
    {
        // This query string will contain the parameters for the translation 
        string queryString = string.Concat("text=", Uri.EscapeDataString(text), "&from=", from, 
"&to=", to);

        using (UnityWebRequest unityWebRequest = UnityWebRequest.Get(translationTextEndpoint + 
queryString))
        {
            unityWebRequest.SetRequestHeader("Authorization", "Bearer " + authorizationToken);
            unityWebRequest.SetRequestHeader("Accept", "application/xml");
            yield return unityWebRequest.SendWebRequest();

            if (unityWebRequest.isNetworkError || unityWebRequest.isHttpError)
            {
                Debug.Log(unityWebRequest.error);
                yield return null;
            }

            // Parse out the response text from the returned Xml
            string result = XElement.Parse(unityWebRequest.downloadHandler.text).Value;
            Results.instance.SetTranslatedResult(result);
        }
    }

If you edit the name of the IEnumerator method GetTokenCoroutine()GetTokenCoroutine() , you need to update the StartCoroutine

and StopCoroutine call string values in the above code. As per Unity documentation, to Stop a specific Coroutine,

you need to use the string value method.

9. Next, add the coroutine (with a “support” stream method right below it) to obtain the translation of the

text received by the MicrophoneManager class. This code creates a query string to send to the Azure

Translator Text API, and then uses the internal Unity UnityWebRequest class to make a ‘Get’ call to the

endpoint with the query string. The result is then used to set the translation in your Results object. The

code below shows the implementation:

10. Be sure to save your changes in Visual Studio before returning to Unity.

1. Back in the Unity Editor, click and drag the Results class from the Scr iptsScr ipts  folder to the Main CameraMain Camera

object in the Hierarchy Panel.

2. Click on the Main CameraMain Camera and look at the Inspector Panel. You will notice that within the newly added

Script component, there are four fields with empty values. These are the output references to the

properties in the code.

3. Drag the appropriate TextText objects from the Hierarchy Panel to those four slots, as shown in the image

below.

https://docs.unity3d.com/ScriptReference/MonoBehaviour.StartCoroutine.html


 Chapter 9 – Test in mixed reality

WARNINGWARNING

 Chapter 10 – Build the UWP solution and sideload on local machine

4. Next, click and drag the Translator class from the Scr iptsScr ipts  folder to the Main CameraMain Camera object in the

Hierarchy Panel.

5. Then, click and drag the MicrophoneManager class from the Scr iptsScr ipts  folder to the Main CameraMain Camera object

in the Hierarchy Panel.

6. Lastly, click on the Main CameraMain Camera and look at the Inspector Panel. You will notice that in the script you

dragged on, there are two drop down boxes that will allow you to set the languages.

At this point you need to test that the Scene has been properly implemented.

Ensure that:

All the settings mentioned in Chapter 1 are set correctly.

The Results, Translator, and MicrophoneManager, scripts are attached to the Main CameraMain Camera object.

You have placed your Azure Translator Text API Service KeyKey  within the authorizationKeyauthorizationKey  variable within the

Translator Script.

All the fields in the Main Camera Inspector Panel are assigned properly.

Your microphone is working when running your scene (if not, check that your attached microphone is the

default device, and that you have set it up correctly within Windows).

You can test the immersive headset by pressing the PlayPlay  button in the Unity Editor. The App should be

functioning through the attached immersive headset.

If you see an error in the Unity console about the default audio device changing, the scene may not function as expected.

This is due to the way the mixed reality portal deals with built-in microphones for headsets that have them. If you see this

error, simply stop the scene and start it again and things should work as expected.

Everything needed for the Unity section of this project has now been completed, so it is time to build it from

Unity.

1. Navigate to Build SettingsBuild Settings : File > Build Settings...File > Build Settings...

2. From the Build SettingsBuild Settings  window, click BuildBuild.

https://support.microsoft.com/help/4027981/windows-how-to-set-up-and-test-microphones-in-windows-10


 Chapter 11 – Deploy your application

3. If not already, tick Unity C# ProjectsUnity C# Projects .

4. Click BuildBuild. Unity will launch a File Explorer window, where you need to create and then select a folder to

build the app into. Create that folder now, and name it App. Then with the App folder selected, press

Select FolderSelect Folder .

5. Unity will begin building your project to the App folder.

6. Once Unity has finished building (it might take some time), it will open a File Explorer window at the

location of your build (check your task bar, as it may not always appear above your windows, but will

notify you of the addition of a new window).

To deploy your application:

1. Navigate to your new Unity build (the App folder) and open the solution file with Visual Studio.

2. In the Solution Configuration select DebugDebug.

3. In the Solution Platform, select x86x86 , Local MachineLocal Machine.

For the Microsoft HoloLens, you may find it easier to set this to Remote Machine, so that you are not

tethered to your computer. Though, you will need to also do the following:

Know the IP AddressIP Address  of your HoloLens, which can be found within the Settings > Network &

Internet > Wi-Fi > Advanced Options; the IPv4 is the address you should use.

Ensure Developer Mode is OnOn; found in Settings > Update & Security > For developers.



 Your finished Translation Text API application

 Bonus exercises
  Exercise 1Exercise 1

  Exercise 2Exercise 2

4. Go to Build menuBuild menu and click on Deploy SolutionDeploy Solution to sideload the application to your PC.

5. Your App should now appear in the list of installed apps, ready to be launched.

6. Once launched, the App will prompt you to authorize access to the Microphone. Make sure to click the

YESYES  button.

7. You are now ready to start translating!

Congratulations, you built a mixed reality app that leverages the Azure Translation Text API to convert speech to

translated text.

Can you add text-to-speech functionality to the app, so that the returned text is spoken?

Make it possible for the user to change the source and output languages ('from' and 'to') within the app itself, so

the app does not need to be rebuilt every time you want to change languages.



   

 

Choosing a Unity version and XR plugin
 7/6/2022 • 2 minutes to read • Edit Online

 Unity 2020.3 LTS (Recommended)

IMPORTANTIMPORTANT

IMPORTANTIMPORTANT

While we currently recommend installing Unity 2020.3 LTS with the Mixed Reality OpenXR pluginrecommend installing Unity 2020.3 LTS with the Mixed Reality OpenXR plugin for

Mixed Reality development, you can build apps with other Unity configurations as well.

Microsoft’s current recommended Unity configuration for HoloLens 2 and Windows Mixed Reality development

is Unity 2020.3 LTS with the Mixed Reality OpenXR pluginUnity 2020.3 LTS with the Mixed Reality OpenXR plugin .

The latest Unity 2021 release has a known blocking performance bug with HoloLens 2 if the project is using URP

rendering pipeline.

For new projects using URP rendering, we recommend using latest Unity 2020.3.35f1 or later LTSUnity 2020.3.35f1 or later LTS with the latestthe latest

Mixed Reality OpenXR pluginMixed Reality OpenXR plugin to avoid this issue.

If using other Unity releases, consult the known active blocking issues to ensure you avoid builds with other blocking

issues.

Unity 2020 does not support targeting HoloLens (1st gen). These headsets remain supported in Unity 2019 LTSUnity 2019 LTS with

Legacy Built-in XR for the full lifecycle of Unity 2019 LTS through mid-2022.

The best way to install and manage Unity is through the Unity HubUnity Hub:

1. Install Unity HubUnity Hub.

2. Select the InstallsInstalls  tab and choose AddAdd.

3. Select Unity 2020.3 LTSUnity 2020.3 LTS  and click NextNext.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/choosing-unity-version.md
https://unity3d.com/get-unity/download


4. Check the following components under 'Platforms''Platforms' :

Universal Windows Platform Build Suppor tUniversal Windows Platform Build Suppor t

Windows Build Suppor t (IL2CPP)Windows Build Suppor t (IL2CPP)

5. If you previously installed Unity without these options, you can add them through 'Add Modules''Add Modules'  menu in

Unity Hub:



NOTENOTE

 Unity 2021.3 LTS

 Unity 2019.4 LTS

NOTENOTE

 Unity 2018.4 LTS

Once you have Unity 2020.3 installed, get started creating a project or upgrading an existing project using the

Mixed Reality OpenXR plugin:

Set up a new OpenXR project with MRTK

While we recommend using OpenXR for all new projects, Unity 2020.3 LTS also supports the Windows XR plugin. This

plugin is fully supported, although it won't receive new features such as AR Foundation 4.0 support.

Microsoft supports 2021.3 LTS development on HoloLens 2 and Mixed Reality devices. The OpenXR plugin is the

only path for mixed reality development in Unity 2021.2 and later, as the final Unity version to support the

Windows XR plugin was Unity 2021.1.

Be sure to consult the known blocking issues table to ensure you avoid Unity 2021 builds with known blocking

issues.

If you need to use Unity 2019, you can use Unity 2019 LTS with Legacy Built-in XRUnity 2019 LTS with Legacy Built-in XR .

Unity has deprecated its Legacy Built-in XR support as of Unity 2019. While Unity 2019 does offer a new XR Plug-in

framework, Microsoft is not currently recommending that path in Unity 2019 due to Azure Spatial Anchors

incompatibilities with AR Foundation 2. In Unity 2020, Azure Spatial Anchors is supported within the XR Plug-in

framework.

If you are developing apps for HoloLens (1st gen), these headsets remain supported in Unity 2019 LTS with

Legacy Built-in XR for the full lifecycle of Unity 2019 LTS through mid-2022.



 Next steps

Unity 2018.4 LTS has reached the end of Unity's two-year Long-Term Support window and is no longer

receiving updates from Unity, although your projects will continue to run.

If you have a Unity 2018 project, you should consider planning for a migration forward to Unity 2020.3 LTS and

the Mixed Reality OpenXR plugin.

Set up a new OpenXR project with MRTK Set up a new OpenXR project without MRTK



   

 

Set up a new OpenXR project with MRTK
 7/6/2022 • 9 minutes to read • Edit Online

NOTENOTE

The easiest way to get your Unity project set up for mixed reality is with the Mixed Reality Toolkit (MRTK). MRTK

for Unity is an open-source, cross-platform development kit designed to make it easy to build amazing mixed

reality applications.

MRTK provides a cross-platform input system, foundational components, and common building blocks for

spatial interactions. It can help you speed up your application development for Microsoft HoloLens, Windows

Mixed Reality immersive (VR) headsets, and many other VR/AR devices. The project is aimed at reducing

barriers to entry, enabling everyone to build mixed reality applications and contribute back to the community as

we all grow.

MRTK supports a wide range of platforms, including:

Microsoft HoloLens

Microsoft HoloLens 2

Windows Mixed Reality headsets

OpenVR headsets (HTC Vive / Oculus Rift)

Ultraleap Hand Tracking

Android and iOS devices

Starting with MRTK3 we are introducing a new Mixed Reality design language to developers. For more information, see

the MRTK3 documentation.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/new-openxr-project-with-mrtk.md
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/mrtk3-overview


NOTENOTE

 Other non-OpenXR configuration options

IMPORTANTIMPORTANT

 Create a new Unity project

You can also set up a new OpenXR project without MRTK.

Windows XRWindows XR : Microsoft doesn't recommend using the Windows XR plugin for any new projects in Unity 2020.

Instead, you should use the Mixed Reality OpenXR plugin. However, if you're using Unity 2019 and you need AR

Foundation 2.0 for compatibility with ARCore/ARKit devices, this plugin enables that support.

Using this plugin in Unity 2019 is not compatible with Azure Spatial Anchors.

Legacy XRLegacy XR : If you're still on Unity 2019 or earlier, Microsoft recommends using the Legacy Built-in XR support.

While the Windows XR plugin is functional on Unity 2019, we don't recommend it because it's not compatible

with Azure Spatial Anchors on Unity 2019.

If you're starting a new project, we recommend that you install Unity 2020 instead and use the Mixed Reality

OpenXR plugin.

1. Launch the Unity HubUnity Hub.

2. In the ProjectsProjects  tab, click New ProjectNew Project.

3. Click the drop-down underneath New projectNew project and then select the Editor version you want.



4. Ensure the chosen template is 3D Core3D Core.

5. In the Project nameProject name box, enter a name for your project--for example, "MRTK Tutorial."

6. In the LocationLocation box, click the folder icon, and then navigate to the folder where you want to save your

project and select it. You can also create a new folder.

7. Click Create ProjectCreate Project. This opens your project in Unity.



C a u t i o nC a u t i o n

 Set your build target

When working on Windows, there is a MAX_PATH limit of 255 characters. Unity is affected by these limits and

may fail to compile if any file path is longer than 255 characters. Therefore, we recommend that you store your

Unity project as close to the root of the drive as possible.

1. On the menu bar, select FileFile > Build Settings...Build Settings... .

To build an app for Windows Mixed Reality, you must choose a build target. The build settings for

Universal Windows Platform (UWP) target any device, including immersive headsets like the HP Reverb

G2. This is the best choice if you're building for the HoloLens 2; however, if you're targeting desktop VR,

we recommend that you use the PC, Mac & Linux StandalonePC, Mac & Linux Standalone platform.

2. Do one of the following:

If you're targeting Desktop VRIf you're targeting Desktop VR :

Keep the PC, Mac & Linux StandalonePC, Mac & Linux Standalone platform which is selected by default on a new Unity project:

https://www.microsoft.com/en-us/d/hp-reverb-g2-vr-headset/93qb262d0514?activetab=pivot:overviewtab


If you're targeting the HoloLens 2If you're targeting the HoloLens 2 :

Under PlatformPlatform , select Universal Windows PlatformUniversal Windows Platform . Make sure the following settings are active:

Target deviceTarget device: HoloLens

ArchitectureArchitecture: ARM64

Build TypeBuild Type: D3D Project

Target SDK VersionTarget SDK Version: Latest Installed

Minimum Platform VersionMinimum Platform Version: 10.0.10240.0

Visual Studio VersionVisual Studio Version: Latest installed

Build and Run onBuild and Run on: Local Machine

Build configurationBuild configuration: Release (there are known performance issues with Debug)



 Download and install the Mixed Reality Feature Tool

3. Click the Switch PlatformSwitch Platform button. Unity displays a progress bar while it switches platforms.

4. After the switch platform process is finished, close the Build SettingsBuild Settings  window.

The best way to discover, update, and import feature packages is with the Mixed Reality Feature Tool. You can

search packages by name or category, see their dependencies, and view proposed changes to your project's

manifest file before importing.

NOTENOTE

1. Download the latest version of the Mixed Reality Feature Tool from the Microsoft Download Center.

2. After the download finishes, unzip the file and save it to your desktop.

Before you can run the Mixed Reality Feature Tool, you must install the .NET 5.0 runtime

3. In the unzipped folder, navigate to the executable file MixedRealityFeatureTool.exeMixedRealityFeatureTool.exe and then use it to

launch the Mixed Reality Feature Tool.

https://aka.ms/MRFeatureTool
https://dotnet.microsoft.com/download/dotnet/5.0


 Import the Mixed Reality Toolkit and OpenXR packages
1. In the Mixed Reality Feature Tool, select Star tStar t.

2. Select the Browse button (it's the "three-dot" button in the image below), then navigate to your project,

and then open it.



NOTENOTE
The Project PathProject Path box in the Tool must contain a value, so it inserts a backslash ("_") by default.

After you select a folder, the Tool checks to ensure that it's a valid Unity project folder.



NOTENOTE

3. Select Discover FeaturesDiscover Features .

NoteNote: You may need to wait a few seconds while the Tool refreshes the packages from the feeds.

4. On the Discover FeaturesDiscover Features  page, note that there is a list of six package groups.

5. Click the "+" button to the left of Mixed Reality Toolkit (0 of 10)Mixed Reality Toolkit (0 of 10)  and then select the latest version of

Mixed Reality Toolkit FoundationMixed Reality Toolkit Foundation.

The Mixed Reality Toolkit Foundation package is the only package that must be imported and configured in order

to use MRTK with your project. This package includes the core components required to create a mixed reality

application.

6. Click the "+" button to the left of Platform Suppor t (0 of 5)Platform Suppor t (0 of 5)  and then select the latest version of MixedMixed

Reality OpenXR PluginReality OpenXR Plugin .



 Configure OpenXR settings

7. After you've made your selection(s), click Get FeaturesGet Features .

8. Select ValidateValidate to validate the packages you selected. You should see a dialog that says No validationNo validation

issues were detectedissues were detected. When you do, click OKOK.

9. On the Impor t FeaturesImpor t Features  page, the left-side column, FeaturesFeatures , displays the packages you just selected.

The right-side column, Required dependenciesRequired dependencies , displays any dependencies. You can click the DetailsDetails

link for any of these items to learn more about them.

10. When you're ready to move on, select Impor t.Impor t. On the Review and ApproveReview and Approve page, you can review

information about the packages.

11. Select Approve.Approve.

12. Return to the Unity Editor and click a blank area in the UI. You'll see a progress bar showing you that your

packages are being imported.

1. After Unity has imported the packages, a warning appears asking if you want to enable the backends by

restarting the editor. Select YesYes .



2. After Unity reopens, the MRTK Project Configurator should appear. If it doesn't, open it manually: on the

menu bar, select Mixed RealityMixed Reality  > ToolkitToolkit > UtilitiesUtilities  > Configure Project for MRTKConfigure Project for MRTK:

3. Select Unity OpenXR PluginUnity OpenXR Plugin to enable XR Plugin Management and add the Unity OpenXR Plugin to

your project.



4. The OpenXR Project ValidationOpenXR Project Validation opens. You can ignore this for now.

5. On the Welcome to MRTK!Welcome to MRTK!  screen, select Show XR Plug-In Management SettingsShow XR Plug-In Management Settings .

This opens the Project SettingsProject Settings  window.



 Configure the project for desktop VR
If you're developing for the HoloLens2, skip this section and go to the next one, Configure the project for the

HoloLens 2.

1. In the Project SettingsProject Settings  window, ensure that you're on the XR Plug-in ManagementXR Plug-in Management page and in the

PC, Mac & Linux StandalonePC, Mac & Linux Standalone tab.

2. Ensure that Initialize XR on Star tupInitialize XR on Star tup is selected, and then, under Plugin ProvidersPlugin Providers , click Open XROpen XR .

3. The OpenXR Plugin loads, and then two items appear underneath OpenXROpenXR . Select the first one,

Windows Mixed Reality feature groupWindows Mixed Reality feature group.



 Configure the project for the HoloLens 2

Note that there's now a yellow warning triangle next to OpenXROpenXR . This indicates that you have incompatible

settings that need to be resolved. To find out how to address this, skip the next section about configuring the

HoloLens 2 and continue on with the following section, Resolving incompatible settings.

1. In the Project SettingsProject Settings  window, ensure that you're on the XR Plug-in ManagementXR Plug-in Management page with the

Universal Windows Platform settings (Windows logo tab) selected.

2. Ensure that Initialize XR on Star tupInitialize XR on Star tup is selected, and then, under Plugin ProvidersPlugin Providers , click Open XROpen XR .



 Resolving incompatible settings

3. Two items appear underneath OpenXROpenXR . Select the first one, Microsoft HoloLens feature groupMicrosoft HoloLens feature group.

Note that there's a yellow warning triangle next to OpenXROpenXR . This indicates that you have incompatible settings

that need to be resolved.

The images in this section show the options in the Universal Windows Platform tab. However, the instructions

are the same for the Desktop VR tab, except where noted.

1. Hover your cursor over the yellow warning triangle next to OpenXROpenXR , then read the message in the

popup, and then select the triangle.

2. In the OpenXR Project ValidationOpenXR Project Validation window, there are several issues listed. Select the Fix AllFix All  button.

NOTENOTE: This list may look different depending on which tab you're in.



3. One issue remains and tells you that you must add at least one interaction profile. To do so, click EditEdit.

This takes you to the settings for the OpenXROpenXR  plugin in the Project SettingsProject Settings  window.

4. Underneath Interaction ProfilesInteraction Profiles , note the plus sign (+) button.



5. Click the button three times, each time choosing a different profile:

Eye Gaze Interaction ProfileEye Gaze Interaction Profile

Microsoft Hand Interaction ProfileMicrosoft Hand Interaction Profile

Microsoft Motion Controller  ProfileMicrosoft Motion Controller  Profile

If the Eye Gaze Interaction ProfileEye Gaze Interaction Profile, or any other profile, appears with a yellow triangle next to it, select

the triangle, and then in the OpenXR Project ValidationOpenXR Project Validation window, click the FixFix button. When you're

finished, close the OpenXR Project ValidationOpenXR Project Validation window.

6. In the Project SettingsProject Settings  window under OpenXR Feature GroupsOpenXR Feature Groups , ensure that the following are

selected:

Microsoft HoloLensMicrosoft HoloLens

Hand TrackingHand Tracking

Motion Controller  ModelMotion Controller  Model



 Configure Player settings

TIPTIP

NOTENOTE

7. Click the Depth Submission ModeDepth Submission Mode drop down and then select Depth 16 BitDepth 16 Bit.

Reducing the Depth Format to 16-bit is optional, but it may improve graphics performance in your project. To

learn more, see Depth buffer sharing (HoloLens).

The Render ModeRender Mode setting, located just above Depth Submission ModeDepth Submission Mode, is set by default to Single PassSingle Pass

InstancedInstanced. In mixed reality apps, the scene is rendered twice: once for each eye. The result is "stereoscopic vision."

This doubles the amount of necessary computing, so it's important to select the most efficient rendering path in

Unity to save on both CPU and GPU time. Single pass instanced rendering is the best choice here--we

recommend that you enable it by default for every project. To learn more about this, see the Unity

documentation.

8. Close MRTK Project ConfiguratorMRTK Project Configurator  window.

1. In the Project SettingsProject Settings  window's left-side column, select PlayerPlayer .

2. Note that in the PlayerPlayer  window, the Product NameProduct Name box is already filled. This is taken from your project

name and will be the name displayed in the HoloLens Start menu.

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/performance/perf-getting-started#single-pass-instanced-rendering
https://docs.unity3d.com/Manual/SinglePassInstancing.html


  OptimizationOptimization

TIPTIP

NOTENOTE

To make the app easier to locate during development, add an underscore in front of the name to sort it to the top

of any list.

3. Click the Publishing SettingsPublishing Settings  drop down, and then in the Package namePackage name field, enter a suitable name.

The package name is the unique identifier for the app. If you want to avoid overwriting previously installed

versions of the app with the same name, you should change this identifier before deploying the app.

4. Close the Project SettingsProject Settings  window.

If you're developing for HoloLens 2, on the menu bar, select the Mixed Reality > Project > ApplyMixed Reality > Project > Apply

recommended project settings for HoloLens 2recommended project settings for HoloLens 2  to get better app performance.



  Unity sample projectsUnity sample projects

 See also

You're now ready to begin developing with OpenXR in Unity!

Check out the OpenXR Mixed Reality samples repo for sample unity projects showcasing how to build Unity

applications for HoloLens 2 or Mixed Reality headsets using the Mixed Reality OpenXR plugin.

Set up a new OpenXR project without MRTK

Add the Mixed Reality OpenXR Plugin to your existing Unity project

https://github.com/microsoft/OpenXR-Unity-MixedReality-Samples
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NOTENOTE

 Other non-OpenXR configuration options

IMPORTANTIMPORTANT

 Create a new Unity project

While Microsoft and the community have created open source tools such as the Mixed Reality Toolkit (MRTK)

that will automatically set up your environment for mixed reality, some developers may wish to build their

experiences from the ground up.

Starting with MRTK3 we are introducing a new Mixed Reality design language to developers. For more information, see

the MRTK3 documentation.

Windows XRWindows XR : Microsoft doesn't recommend using the Windows XR plugin for any new projects in Unity 2020.

Instead, you should use the Mixed Reality OpenXR plugin. However, if you're using Unity 2019 and you need AR

Foundation 2.0 for compatibility with ARCore/ARKit devices, this plugin enables that support.

Using this plugin in Unity 2019 is not compatible with Azure Spatial Anchors.

Legacy XRLegacy XR :

If you're still on Unity 2019 or earlier, Microsoft recommends using the Legacy Built-in XR support. While the

Windows XR plugin is functional on Unity 2019, we don't recommend it because it's not compatible with Azure

Spatial Anchors on Unity 2019.

If you're starting a new project, we recommend that you install Unity 2020 instead and use the Mixed Reality

OpenXR plugin.

1. Launch the Unity HubUnity Hub.

2. In the ProjectsProjects  tab, click New ProjectNew Project.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/new-openxr-project-without-mrtk.md
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/mrtk3-overview


3. Click the drop-down underneath New projectNew project and then select the Editor version you want.

4. Ensure the chosen template is 3D Core3D Core.

5. In the Project nameProject name box, enter a name for your project--for example, "MRTK Tutorial."

6. In the LocationLocation box, click the folder icon, and then navigate to the folder where you want to save your

project and select it. You can also create a new folder.



C a u t i o nC a u t i o n

 Set your build target

7. Click Create ProjectCreate Project. This opens your project in Unity.

When working on Windows, there is a MAX_PATH limit of 255 characters. Unity is affected by these limits and

may fail to compile if any file path is longer than 255 characters. Therefore, we recommend that you store your

Unity project as close to the root of the drive as possible.

1. On the menu bar, select FileFile > Build Settings...Build Settings... .

To build an app for Windows Mixed Reality, you must choose a build target. The build settings for

Universal Windows Platform (UWP) target any device, including immersive headsets like the HP Reverb

https://www.microsoft.com/en-us/d/hp-reverb-g2-vr-headset/93qb262d0514?activetab=pivot:overviewtab


G2. This is the best choice if you're building for the HoloLens 2; however, if you're targeting desktop VR,

we recommend that you use the PC, Mac & Linux StandalonePC, Mac & Linux Standalone platform.

2. Do one of the following:

If you're targeting Desktop VRIf you're targeting Desktop VR :

Keep the PC, Mac & Linux StandalonePC, Mac & Linux Standalone platform which is selected by default on a new Unity project:

If you're targeting the HoloLens 2If you're targeting the HoloLens 2 :

Under PlatformPlatform , select Universal Windows PlatformUniversal Windows Platform . Make sure the following settings are active:

Target deviceTarget device: HoloLens

ArchitectureArchitecture: ARM64

Build TypeBuild Type: D3D Project

Target SDK VersionTarget SDK Version: Latest Installed

Minimum Platform VersionMinimum Platform Version: 10.0.10240.0

Visual Studio VersionVisual Studio Version: Latest installed

Build and Run onBuild and Run on: Local Machine

Build configurationBuild configuration: Release (there are known performance issues with Debug)



 Download and install the Mixed Reality Feature Tool

3. Click the Switch PlatformSwitch Platform button. Unity displays a progress bar while it switches platforms.

4. After the switch platform process is finished, close the Build SettingsBuild Settings  window.

The Mixed Reality OpenXR Plugin comes in the form of a package for Unity. The best way to discover, update,

and import feature packages is with the Mixed Reality Feature Tool. You can search packages by name or

category, see their dependencies, and view proposed changes to your project's manifest file before importing.

NOTENOTE

1. Download the latest version of the Mixed Reality Feature Tool from the Microsoft Download Center.

2. After the download finishes, unzip the file and save it to your desktop.

Before you can run the Mixed Reality Feature Tool, you must install the .NET 5.0 runtime

3. In the unzipped folder, navigate to the executable file MixedRealityFeatureTool.exeMixedRealityFeatureTool.exe and then use it to

launch the Mixed Reality Feature Tool.

https://aka.ms/MRFeatureTool
https://dotnet.microsoft.com/download/dotnet/5.0


 Import the Mixed Reality OpenXR plugin
1. In the Mixed Reality Feature Tool, select Star tStar t.

2. Select the Browse button (it's the "three-dot" button in the image below), then navigate to your project,

and then open it.



NOTENOTE
The Project PathProject Path box in the Tool must contain a value, so it inserts a backslash ("_") by default.

After you select a folder, the Tool checks to ensure that it's a valid Unity project folder.



3. Select Discover FeaturesDiscover Features .

NoteNote: You may need to wait a few seconds while the Tool refreshes the packages from the feeds.

4. On the Discover FeaturesDiscover Features  page, note that there is a list of six package groups.

5. Click the "+" button to the left of Platform Suppor t (0 of 5)Platform Suppor t (0 of 5)  and then select the latest version of MixedMixed

Reality OpenXR PluginReality OpenXR Plugin .



 Configure the project for desktop VR

6. After you've made your selection, click Get FeaturesGet Features .

7. Select ValidateValidate to validate the package you selected. You should see a dialog that says No validationNo validation

issues were detectedissues were detected. When you do, click OKOK.

8. On the Impor t FeaturesImpor t Features  page, the left-side column, FeaturesFeatures , displays the package you just selected.

The right-side column, Required dependenciesRequired dependencies , displays any dependencies. You can click the DetailsDetails

link for any of these items to learn more about them.

9. When you're ready to move on, select Impor t.Impor t. On the Review and ApproveReview and Approve page, you can review

information about the package.

10. Select Approve.Approve.

11. Return to the Unity Editor and click a blank area in the UI. You'll see a progress bar showing you that your

package is being imported.

12. After Unity has imported the package, a warning appears asking if you want to enable the backends by

restarting the editor. Select YesYes .

If you're developing for the HoloLens2, skip this section and go to the next one, Configure the project for the

HoloLens 2.

1. On the menu bar, select EditEdit > Project SettingsProject Settings .

2. In the Project SettingsProject Settings  window, ensure that you're on the XR Plug-in ManagementXR Plug-in Management page and in the

PC, Mac & Linux StandalonePC, Mac & Linux Standalone tab.



3. Ensure that Initialize XR on Star tupInitialize XR on Star tup is selected, and then, under Plugin ProvidersPlugin Providers , click Open XROpen XR .

4. The OpenXR Plugin loads, and then two items appear underneath OpenXROpenXR . Select the first one,

Windows Mixed Reality feature groupWindows Mixed Reality feature group.



 Configure the project for the HoloLens 2

Note that there's now a yellow warning triangle next to OpenXROpenXR . This indicates that you have incompatible

settings that need to be resolved. To find out how to address this, skip the next section about configuring the

HoloLens 2 and continue on with the following section, Resolving incompatible settings.

1. On the menu bar, select EditEdit > Project SettingsProject Settings .

2. In the Project SettingsProject Settings  window, ensure that you're on the XR Plug-in ManagementXR Plug-in Management page and in the

Universal Windows PlatformUniversal Windows Platform tab.

3. Ensure that Initialize XR on Star tupInitialize XR on Star tup is selected, and then, under Plugin ProvidersPlugin Providers , click Open XROpen XR .

4. The OpenXR Plugin loads, and then two items appear underneath OpenXROpenXR . Select the first one,



 Resolving incompatible settings

Microsoft HoloLens feature groupMicrosoft HoloLens feature group.

Note that there's a yellow warning triangle next to OpenXROpenXR . This indicates that you have incompatible settings

that need to be resolved.

The images in this section show the options in the Universal Windows Platform tab. However, the instructions

are the same for the Desktop VR tab, except where noted.

1. Hover your cursor over the yellow warning triangle next to OpenXROpenXR , then read the message in the

popup, and then select the triangle.

2. In the OpenXR Project ValidationOpenXR Project Validation window, there are several issues listed. Select the Fix AllFix All  button.



3. One issue remains and tells you that you must add at least one interaction profile. To do so, click EditEdit.

This takes you to the settings for the OpenXROpenXR  plugin in the Project SettingsProject Settings  window.

4. Underneath Interaction ProfilesInteraction Profiles , note the plus sign (+) button.

5. Click the button three times, each time choosing a different profile:

Eye Gaze Interaction ProfileEye Gaze Interaction Profile

Microsoft Hand Interaction ProfileMicrosoft Hand Interaction Profile

Microsoft Motion Controller  ProfileMicrosoft Motion Controller  Profile



If the Eye Gaze Interaction ProfileEye Gaze Interaction Profile, or any other profile, appears with a yellow triangle next to it, select

the triangle, and then in the OpenXR Project ValidationOpenXR Project Validation window, click the FixFix button. When you're

finished, close the OpenXR Project ValidationOpenXR Project Validation window.

6. In the Project SettingsProject Settings  window under OpenXR Feature GroupsOpenXR Feature Groups , ensure that the following are

selected:

If you're in the Desktop VR tab:

Windows Mixed RealityWindows Mixed Reality

Hand TrackingHand Tracking

Motion Controller  ModelMotion Controller  Model

If you're in the Universal Windows Platform tab:



 Configure Player settings

TIPTIP

NOTENOTE

Microsoft HoloLensMicrosoft HoloLens

Hand TrackingHand Tracking

Motion Controller  ModelMotion Controller  Model

7. Click the Depth Submission ModeDepth Submission Mode drop down and then select Depth 16 BitDepth 16 Bit.

Reducing the Depth Format to 16-bit is optional, but it may improve graphics performance in your project. To

learn more, see Depth buffer sharing (HoloLens).

The Render ModeRender Mode setting, located just above Depth Submission ModeDepth Submission Mode, is set by default to Single PassSingle Pass

InstancedInstanced. In mixed reality apps, the scene is rendered twice: once for each eye. The result is "stereoscopic vision."

This doubles the amount of necessary computing, so it's important to select the most efficient rendering path in

Unity to save on both CPU and GPU time. Single pass instanced rendering is the best choice here--we

recommend that you enable it by default for every project. To learn more about this, see the Unity

documentation.

1. In the Project SettingsProject Settings  window's left-side column, select PlayerPlayer .

2. Note that in the PlayerPlayer  window, the Product NameProduct Name box is already filled. This is taken from your project

name and will be the name displayed in the HoloLens Start menu.

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/performance/perf-getting-started#single-pass-instanced-rendering
https://docs.unity3d.com/Manual/SinglePassInstancing.html


  OptimizationOptimization

TIPTIP

NOTENOTE

To make the app easier to locate during development, add an underscore in front of the name to sort it to the top

of any list.

3. Click the Publishing SettingsPublishing Settings  drop down, and then in the Package namePackage name field, enter a suitable name.

The package name is the unique identifier for the app. If you want to avoid overwriting previously installed

versions of the app with the same name, you should change this identifier before deploying the app.

4. Close the Project SettingsProject Settings  window.

If you're developing for HoloLens 2, on the menu bar, Mixed Reality > Project > Apply recommendedMixed Reality > Project > Apply recommended

project settings for HoloLens 2project settings for HoloLens 2  to get better app performance.



  Unity sample projectsUnity sample projects

 See also

You're now ready to begin developing with OpenXR in Unity!

Check out the OpenXR Mixed Reality samples repo for sample unity projects showcasing how to build Unity

applications for HoloLens 2 or Mixed Reality headsets using the Mixed Reality OpenXR plugin.

Set up a new OpenXR project with MRTK

Add the Mixed Reality OpenXR Plugin to your existing Unity project

https://github.com/microsoft/OpenXR-Unity-MixedReality-Samples
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 Download and install the Mixed Reality Feature Tool

If you have a Unity project that's already set up for OpenXR (you have the Unity OpenXR plugin installed and

configured) and you want to add the capability to target your app for the HoloLens 2, follow the instructions

below.

To determine if your project has the Mixed Reality OpenXR plugin installedTo determine if your project has the Mixed Reality OpenXR plugin installed:

1. In Unity, on the menu bar, select EditEdit > Project SettingsProject Settings .

2. Ensure that you're on the XR Plug-in ManagementXR Plug-in Management page with the Universal Windows Platform settings

(Windows logo tab) displayed.

3. If Microsoft Hololens feature groupMicrosoft Hololens feature group is grayed out or doesn't exist, the Mixed Reality OpenXR plugin

isn't installed.

The Mixed Reality OpenXR Plugin comes in the form of a package for Unity. The best way to discover, update,

and import feature packages is with the Mixed Reality Feature Tool. You can search packages by name or

category, see their dependencies, and view proposed changes to your project's manifest file before importing.

NOTENOTE

1. Download the latest version of the Mixed Reality Feature Tool from the Microsoft Download Center.

2. After the download finishes, unzip the file and save it to your desktop.

Before you can run the Mixed Reality Feature Tool, you must install the .NET 5.0 runtime

3. In the unzipped folder, navigate to the executable file MixedRealityFeatureTool.exeMixedRealityFeatureTool.exe and then use it to

launch the Mixed Reality Feature Tool.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/mixed-reality-openxr-plugin.md
https://aka.ms/MRFeatureToolDownload
https://dotnet.microsoft.com/download/dotnet/5.0


 Import the Mixed Reality OpenXR Plugin
1. In the Mixed Reality Feature Tool, select Star tStar t.

2. Select the Browse button (it's the "three-dot" button in the image below), then navigate to the folder

containing your Unity project, and then open it.



NOTENOTE
The Project PathProject Path box in the Tool must contain some value, so it inserts a backslash ("_") by default.

After you select a folder, the Tool checks to ensure that it's a valid Unity project folder.



3. Select Discover FeaturesDiscover Features .

NoteNote: You may need to wait a few seconds while the Tool refreshes the packages from the feeds.

4. On the Discover FeaturesDiscover Features  page, note that there is a list of six package groups.

5. Click the "+" button to the left of Platform Suppor t (0 of 5)Platform Suppor t (0 of 5)  and then select the latest version of MixedMixed

Reality OpenXR PluginReality OpenXR Plugin .



 See also

6. After you've made your selection(s), click Get FeaturesGet Features .

7. Select ValidateValidate to validate the packages you selected. You should see a dialog that says No validationNo validation

issues were detectedissues were detected. When you do, click OKOK.

8. On the Impor t FeaturesImpor t Features  page, the left-side column, FeaturesFeatures , displays the packages you just selected.

The right-side column, Required dependenciesRequired dependencies , displays any dependencies. You can click the DetailsDetails

link for any of these items to learn more about them.

9. When you're ready to move on, select Impor t.Impor t. On the Review and ApproveReview and Approve page, you can review

information about the packages.

10. Select Approve.Approve.

11. Return to the Unity Editor and click a blank area in the UI. You'll see a progress bar showing you that the

package is being imported.

12. In Unity, ensure that you're in the Project SettingsProject Settings  window, on the XR Plug-in ManagementXR Plug-in Management page,

and in the Universal Windows PlatformUniversal Windows Platform tab.

13. There are now two feature groups underneath OpenXROpenXR . Select the first one, Microsoft HoloLensMicrosoft HoloLens

feature groupfeature group.

14. Close the Project SettingsProject Settings  window.

Set up a new OpenXR project with MRTK

Set up a new OpenXR project without MRTK
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IMPORTANTIMPORTANT

 System requirements

NOTENOTE

 Download

NOTENOTE

The Mixed Reality Feature Tool is only available for Unity at the moment. If you're developing in Unreal, refer to the tools

installation documentation.

The Mixed Reality Feature Tool is a new way for developers to discover, update, and add Mixed Reality feature

packages into Unity projects. You can search packages by name or category, see their dependencies, and even

view proposed changes to your projects manifest file before importing. If you've never worked with a manifest

file before, it's a JSON file containing all your projects packages. Once you've validated the packages you want,

the Mixed Reality Feature tool will download them into the project of your choice.

Before you can run the Mixed Reality Feature Tool, you'll need:

.NET 5.0 runtime

Windows 10

The Mixed Reality Feature Tool currently only runs on Windows.

Once you have your environment set up:

Download the latest version of the Mixed Reality Feature Tool from the Microsoft Download Center.

When the download completes, unzip the file and save it to your desktop

We recommend creating a shortcut to the executable file for faster access

If you're new to using the Unity Package Manager, follow our UPM instructions.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/welcome-to-mr-feature-tool.md
https://dotnet.microsoft.com/download/dotnet/5.0
https://www.microsoft.com/software-download/windows10ISO
https://aka.ms/MRFeatureTool
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/configuration/usingupm#managing-mixed-reality-features-with-the-unity-package-manager


 

Changes in this release

 1. Getting started

Version 1.0.2206.1-Preview includes the following fixes:

Improvements to feed processing

Updated logging

The following features have been added in this release:

Packages referenced in the project manifest can now be restored with one click.

Launch the Mixed Reality Feature Tool from the executable file, which displays the start page on first launch:

From the start page, you can:

Configure tool settings using the gear icongear icon button

Use the question markquestion mark button to launch the default web browser and display our documentation

Select Star tStar t to begin discovering feature packages



NOTENOTE

 2. Selecting your Unity project

If you will be using the MRTK3 public preview release in your project, you must enable Show preview releases  in the 

Feature  tab of settings.

To ensure that all discovered features are supported on your project's version of Unity, the fist step is to point

the Mixed Reality Feature Tool to your project using the ellipsisellipsis  button (to the right of the project path field).



NOTENOTE

IMPORTANTIMPORTANT

 3. Discovering and acquiring feature packages

The dialog that's displayed when browsing for the Unity project folder contains '_' as the file name. There must be a value

for the file name to enable the folder to be selected.

When you have located your project's folder, click the Open button to return to the Mixed Reality Feature Tool.

The Mixed Reality Feature Tool performs validation to ensure that it has been directed to a Unity project folder. The folder

must contain Assets , Packages  and Project Settings  folders.

Once the project has been selected, you can

Restore FeaturesRestore Features : download the Feature Tool shipped packages listed in the project manifest to

Packages/MixedRealityPackages/MixedReality  if they are not present there already. The feature is similar to nuget restore  in

concept. Typically you only need to perform this operation if you have a project (with Feature Tool packages)

cloned from a repo configured to ignore tarball files. You can close the Feature Tool after restoring if you do

not need to get new packages.

and/orand/or

Discover FeaturesDiscover Features : proceed to the next page to select the packages you want to add to your project.

Features are grouped by category to make things easier to find. For example, the Mixed Reality ToolkitMixed Reality Toolkit

category has several features for you to choose from:



 4. Importing feature packages

When the Mixed Reality Feature Tool recognizes previously imported feature(s), it displays a notification

message by each.

Once you've made your choices, select Get featuresGet features  to download all the required packages from the catalog.

For more information, please see discovering and acquiring features.

Following acquisition, the complete set of packages is presented, along with a list of required dependencies. If

you need to change any feature or package selections, this is the time:



NOTENOTE

 5. Reviewing and approving project changes

We highly recommend using the ValidateValidate button to ensure the Unity project can successfully import the

selected features. After validation, you'll see a pop-up dialog with a success message or a list of identified issues.

Select Impor tImpor t to continue.

After clicking the Impor tImpor t  button, if any issues remain a simple message will be displayed. The recommendation is to click

No and to use the ValidateValidate button to view and resolve the issues.

For more information, please see importing features.

The final step is reviewing and approving the proposed changes to the manifest and project files:

The proposed changes to the manifest are displayed on the left

The files to be added to the project are listed to the right

The CompareCompare button allows for side by side viewing of the current manifest and the proposed changes



 6. Project updated

For more information, see reviewing and approving project modifications.

When the proposed changes are approved, your target Unity project is updated to reference the selected Mixed

Reality features.



 See also

The Unity project's PackagesPackages  folder now has a MixedRealityMixedReality  subfolder with the feature package file(s) and the

manifest will contain the appropriate reference(s).

Return to Unity, wait for the new selected features to load, and start building!

Configuring the feature tool

Discovery and acquisition

Viewing feature package details

Importing selected packages

Reviewing and approving project modifications
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 Download settings

  Overwrite existing package filesOverwrite existing package files

  Package cachePackage cache

When using the Mixed Reality Feature Tool, you have access to several different settings categories that you can

customize at will:

Download settings

Feature settings

Import settings

Early Access settings

Diagnostic settings

Enabling this setting causes package files to be downloaded every time they're acquired.

We recommend leaving this option disabled to reduce network bandwidth usageWe recommend leaving this option disabled to reduce network bandwidth usage

By default, previously acquired package files aren't re-downloaded

Change this setting to update the location where feature packages are downloaded.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/configuring-feature-tool.md


NOTENOTE

 Feature settings

  Auto-update the catalogAuto-update the catalog

  Show preview releasesShow preview releases

NOTENOTE

  Show early access program featuresShow early access program features

This setting is read-onlyread-only  in this release. Future releases may make this setting configurable.

Enable this setting to ensure that every time the Mixed Reality Feature Tool is started, the latest feature catalog is

retrieved from the server.

Enable this setting to acquire preview releases.

By default, preview releases are not shown in the Mixed Reality Feature Tool

A preview release is defined as containing the "-preview""-preview" or "-pre""-pre" designation in the package version.

Enable this setting to acquire features from registered early access programs releases.

By default, early access features are not shown in the Mixed Reality Feature Tool



NOTENOTE

 Import settings

  Replace existing package filesReplace existing package files

  Project relative import pathProject relative import path

NOTENOTE

 Early Access settings

Enabling Show early access program features  without Show preview releases  may result in eary access packages

not appearing in Discovery.

By default, the Mixed Reality Feature Tool removes previous copies of the packages being imported to reduce

the file size and unnecessary computations.

Uncheck this setting to keep all versions

Change this setting to update project folder path where feature packages are copied on import.

For example, if the project folder is C:\GalaxyExplorerC:\GalaxyExplorer , the fully qualified import path will be

C:\GalaxyExplorer\Packages\MixedRealityC:\GalaxyExplorer\Packages\MixedReality .

This setting is read-onlyread-only  in this release. Future releases may make this setting configurable.



  Ask for confirmation before removing an early access programAsk for confirmation before removing an early access program

  My previewsMy previews

 Diagnostic settings

This setting determines if a prompt will be displayed each time an early access program is removed.

The list of registered early access programs. Use the Add , Edit  and Remove  to manage the collection of

registered programs.



  Log fileLog file

  Open file buttonOpen file button

 See also

Displays the path to the diagnostic log file.

Clicking on the open file  button will open the file, using the default text editor.

Welcome to the Mixed Reality Feature Tool

Discovery and acquisition

Viewing feature package details

Importing selected packages

Reviewing and approving project modifications
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 Available features
  CategoryCategory

NOTENOTE

The sections in this article outline how to find feature packages in the Mixed Reality Feature Tool. Refer to the

screenshot below if you need a reference for a given section:

The Mixed Reality Feature Tool displays a collection of feature categories to make it easy to find what you want.

Expand any of the categories to display its collection of available features.

If you cannot locate the functionality you're looking for, please check Other featuresOther features .

The category header in the above screenshot contains the following properties, from left to right:

Expand and collapse button

Category name (ex: Mixed Reality Toolkit)

Count of selected features

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/discovering-features.md


NOTENOTE

  FeatureFeature

NOTENOTE

 Refresh the feature catalog

 Select features

Count of available features

Section buttons

The selection buttons are context sensitive. Based on the state of feature selection within the category, one of the 

Select All  and Select None  buttons will be displayed.

Features are listed in their appropriate category. From left to right in the above screenshot, feature entries

contain:

Selection check box

Feature name (ex: Mixed Reality Toolkit Foundation)

List of available versions

Link to the feature package details

If a feature is provided by an Early Access (also called private preview) program, an indicator icon  will be displayed.

To check for new and updated features, click the refresh  button. This will connect to the catalog site and

retrieve the latest information. Once the catalog has been read, the date and time of the last update will be

displayed.

Features are selected by expanding a category, selecting a version, and clicking the check box:

To select every package within a category, a Select All  button is provided. Select None  will deselect all

selected packages.



 Acquiring features

NOTENOTE

 Going back to the previous step

 See also

Each category with one or more selected features will update to display the count.

Once you've chosen your features, select Get featuresGet features  to start downloading the selected feature package files.

By default, previously acquired feature package files won't be re-downloaded. To change this behavior please see

configuring the feature tool.

Once downloading is complete, the Mixed Reality Feature Tool will move to the importing features step.

From Discover featuresDiscover features , the Mixed Reality Feature Tool allows for navigating back to project selection. Select

Go backGo back to start again.

Welcome to the Mixed Reality Feature Tool

Configuring the feature tool

Viewing feature package details

Importing selected packages

Reviewing and approving project modifications
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 Features list

Once your features have been downloaded, they can be reviewed and imported into the Unity project. At this

step, your application window should look like the following image:

The FeaturesFeatures  list contains the collection of packages selected during discovery. Each feature can be selected or

deselected before importing. Package details can be viewed using the DetailsDetails  link shown below

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/importing-features.md


 Required dependencies list

NOTENOTE

 Validating selections

The Required dependenciesRequired dependencies  list contains the packages that one or more of the selected features requires to

function. This list will also contain dependencies of dependencies. Each dependency can be selected or

deselected before importing. Package details can be viewed using the DetailsDetails  link shown below

Deselecting required dependencies will result in one or more missing dependency errors when loading the project in

Unity. These features won't be usable in the project.

We highly recommend validating feature selections before importing. This step will raise any issues that are

likely to impede successful project development.



  Enable dependenciesEnable dependencies

  Disable featuresDisable features

 Importing

IMPORTANTIMPORTANT

 Going back to the previous step

 See also

The Mixed Reality Feature Tool provides two automatic issue resolutions, described in the following sections),

and the option to cancel and resolve issues manually.

The Enable dependenciesEnable dependencies  button will automatically re-select the missing dependencies. This is true for

dependencies that were explicitly selected (appear in the FeaturesFeatures  list) and those that were implicitly selected

based on the requirements of the selected features.

Selecting Disable featuresDisable features  will automatically deselect any feature that depends on one or more of the

dependencies that have been unchecked. This is true for implicitly selected dependency packages and explicitly

selected features.

Select Impor tImpor t to add your selected features and give final approval before updating your target project.

If a validation issue remains when importing, a warning message will be displayed. It is recommended to select No, click

ValidateValidate and resolve any issues presented.

From Impor t featuresImpor t features , the Mixed Reality Feature Tool allows for navigating back to discovery. Select Go backGo back

to download other feature packages.

Welcome to the Mixed Reality Feature Tool

Configuring the feature tool

Discovery and acquisition



Viewing feature package details

Reviewing and approving project modifications



   

 

Feature package details
 7/6/2022 • 2 minutes to read • Edit Online

 See also

The Feature detailsFeature details  view enables reviewing key informatiom about a feature, including:

Description

Package name

Author

License

Required dependencies

Welcome to the Mixed Reality Feature Tool

Configuring the feature tool

Discovery and acquisition

Importing selected packages

Reviewing and approving project modifications

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/viewing-package-details.md


   

 

Approve project changes
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 Compare manifests

To modify a Unity project, you must first review and approve changes to the manifest and project files.

On the Review and ApproveReview and Approve screen:

The ManifestManifest column on the left shows the proposed manifest changes. The contents show exactly what

to write to the project manifest, Packages/manifest.json.

The Files to be copied into the projectFiles to be copied into the project section on the right lists the specific feature package files to

copy into the Unity project.

Select CompareCompare to see a detailed side-by-side comparison of all proposed changes.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/reviewing-changes.md


 Approve changes

 See also

Either scroll bar scrolls both manifests, making it easier to spot the differences between the two files.

On the Review and ApproveReview and Approve screen, select ApproveApprove to copy the listed files into the Unity project and update

the manifest with references to these files.

As part of the modifications, the current manifest.json file is backed up. When you view manifest backups,

the oldest backup is called manifest.json.backup. Newer backups are annotated with a numeric value,

beginning with 0.

Add the feature package .tgz files to source control. Reference the files with relative paths to help

development teams easily share features and manifest changes.

If you need to make changes to your feature selections, select Go BackGo Back on the Review and ApproveReview and Approve

screen to return to the import features step.

Welcome to the Mixed Reality Feature Tool

Configure the feature tool

Discovery and acquisition

View feature package details

Import selected packages



   

 

Camera setup in Unity
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 HoloLens vs VR immersive headsets

 

 

CoreServices.CameraSystem.IsOpaque;

 Camera setup

  HoloLens camera setupHoloLens camera setup

When you wear a mixed reality headset, it becomes the center of your holographic world. The Unity Camera

component will automatically handle stereoscopic rendering and follow your head movement and rotation.

However, to fully optimize visual quality and hologram stability, you should set the camera settings described

below.

The default settings on the Unity Camera component are for traditional 3D applications, which need a skybox-

like background as they don't have a real world.

When running on an immersive headsetimmersive headset, you're rendering everything the user sees, and so you'll likely

want to keep the skybox.

However, when running on a holographic headsetholographic headset like HoloLens, the real world should appear behind

everything the camera renders. Set the camera background to be transparent (in HoloLens, black renders as

transparent) instead of a Skybox texture:

1. Select the Main Camera in the Hierarchy panel

2. In the Inspector panel, find the Camera component and change the Clear Flags dropdown from

Skybox to Solid Color

3. Select the Background color picker and change the RGBA values to (0, 0, 0, 0)

a. If setting this from code, you can use Unity's Color.clear

MRTK

XR SDK

Legacy WSA

MRTK will handle specific camera settings automatically, based on the configuration in the camera system

profile.

Namespace:Namespace: Microsoft.MixedReality.Toolkit.CameraSystem

Type:Type: MixedRealityCameraSystem

To check the camera's opaqueness, the MixedRealityCamera system has an IsOpaque  property.

Whatever kind of experience you're developing, the Main Camera is always the primary stereo rendering

component attached to your device's head-mounted display. It'll be easier to lay out your app if you imagine the

starting position of the user as (X: 0, Y: 0, Z: 0). Since the Main Camera is tracking movement of the user's head,

the starting position of the user can be set by setting the starting position of the Main Camera.

The central choice you need to make is whether you're developing for HoloLens or VR immersive headsets.

Once you've got that, skip to whichever setup section applies.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/camera-in-unity.md
https://docs.unity3d.com/Manual/class-Camera.html
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.unity3d.com/ScriptReference/Color-clear.html
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/camera-system/camera-system-overview#display-settings
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.toolkit.camerasystem.mixedrealitycamerasystem.isopaque


 

 

  VR camera setupVR camera setup

  Room-scale or standing experiencesRoom-scale or standing experiences

NOTENOTE

 

 

For HoloLens apps, you need to use anchors for any objects you want to lock to the scene environment. We

recommend using unbounded space to maximize stability and create anchors in multiple rooms.

MRTK

XR SDK

Legacy WSA

Follow this step-by-step tutorial to add and automatically configure Mixed Reality Toolkit in your Unity project.

It's also possible to work directly with the MixedRealityPlayspace class from MRTK for Unity and set the TargetTarget

ScaleScale to WorldWorld:

MRTK should handle the position of the playspace and camera automatically, but it's good to double check:

1. From the HierarchyHierarchy  panel, expand the MixedRealityPlayspaceMixedRealityPlayspace GameObject and find the Main CameraMain Camera

child object

2. In the InspectorInspector  panel, find the TransformTransform component and change the PositionPosition to (X: 0 , Y: 0 , Z: 0)(X: 0 , Y: 0 , Z: 0)

Windows Mixed Reality supports apps across a wide range of experience scales, from orientation-only and

seated-scale apps up through room-scale apps. On HoloLens, you can go further and build world-scale apps

that let users walk beyond 5 meters, exploring an entire floor of a building and beyond.

Your first step in building a mixed reality experience in Unity is to determine which experience scale your app

will target:

Orientation or seated-scale

Standing or room-scale

World-scale

If you're building for HL2, we recommend creating an eye-level experience, or consider using Scene Understanding to

reason about the floor of your scene.

MRTK

XR SDK

Legacy WSA

Use the MixedRealityPlayspace class from MRTK for Unity and set the Target ScaleTarget Scale to either RoomRoom or

StandingStanding:

https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.toolkit.mixedrealityplayspace
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.toolkit.mixedrealityplayspace


  Seated experiencesSeated experiences
 

 

  Setting up the camera backgroundSetting up the camera background

 Using multiple cameras

MRTK should handle the position of the playspace and camera automatically, but it's good to double check:

1. From the HierarchyHierarchy  panel, expand the MixedRealityPlayspaceMixedRealityPlayspace GameObject and find the Main CameraMain Camera

child object

2. In the InspectorInspector  panel, find the TransformTransform component and change the PositionPosition to (X: 0 , Y: 0 , Z: 0)(X: 0 , Y: 0 , Z: 0)

MRTK

XR SDK

Legacy WSA

Use the MixedRealityPlayspace class from MRTK for Unity and set the Target ScaleTarget Scale to SeatedSeated:

MRTK should handle the position of the playspace and camera automatically, but it's good to double check:

1. From the HierarchyHierarchy  panel, expand the MixedRealityPlayspaceMixedRealityPlayspace GameObject and find the Main CameraMain Camera

child object

2. In the InspectorInspector  panel, find the TransformTransform component and change the PositionPosition to (X: 0 , Y: 0 , Z: 0)(X: 0 , Y: 0 , Z: 0)

If you're using MRTK, the camera's background is automatically configured and managed. For XR SDK or Legacy

WSA projects, we recommend setting the camera's background to solid black on HoloLens and keeping the

skybox for VR.

When there are multiple Camera components in the scene, Unity knows which camera to use for stereoscopic

rendering based on which GameObject has the MainCamera tag. In legacy XR, it also uses this tag to sync head

https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.toolkit.mixedrealityplayspace


 Sharing depth buffers

 

 

 Using clipping planes

 Recentering the camera

 Teleportation

 

 

 Reprojection modes

tracking. In XR SDK, head tracking is driven by a TrackedPoseDriver script attached to the camera.

Sharing your app's depth buffer to Windows each frame will give your app one of two boosts in hologram

stability, based on the type of headset you're rendering for :

VR immersive headsetsVR immersive headsets  can take care of positional reprojection when a depth buffer is provided, adjusting

your holograms for misprediction in both position and orientation.

HoloLens headsetsHoloLens headsets  have a few different methods. HoloLens 1 will automatically select a focus point when a

depth buffer is provided, optimizing hologram stability along the plane that intersects the most content.

HoloLens 2 will stabilize content using Depth LSR (see Remarks).

MRTK

XR SDK

Legacy WSA

MRTK's configuration dialog will attempt to set depth buffer settings for both XR SDK and legacy WSA, but it's

good to check those tabs and verify the settings in Unity.

Rendering content too close to the user can be uncomfortable in mixed reality. You can adjust the near and far

clip planes on the Camera component.

1. Select the Main CameraMain Camera in the HierarchyHierarchy  panel

2. In the InspectorInspector  panel, find the CameraCamera component Clipping PlanesClipping Planes  and change the NearNear  textbox from

0.30.3  to 0.850.85 . Content rendered even closer can lead to user discomfort and should be avoided per the render

distance guidelines.

If you're building a seated-scale experience, you can recenter Unity's world origin at the user's current head

position by calling the XR.InputTracking.RecenterXR.InputTracking.Recenter  method in legacy XR or the

XRInputSubsystem.Tr yRecenterXRInputSubsystem.Tr yRecenter  method in XR SDK.

This feature is typically reserved for VR experiences:

MRTK

XR SDK

Legacy WSA

MRTK provides an in-box teleport system which automatically works across articulated hands and controllers.

Both HoloLens and immersive headsets will reproject each frame your app renders to adjust for any

misprediction of the user's actual head position when photons are emitted.

By default:

VR immersive headsetsVR immersive headsets  will take care of positional reprojection if the app provides a depth buffer for a

given frame. Immersive headsets will also adjust your holograms for misprediction in both position and

https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamerarenderingparameters.setfocuspoint
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/configuration/mrtk-configuration-dialog
https://docs.unity3d.com/ScriptReference/XR.InputTracking.Recenter.html
https://docs.unity3d.com/ScriptReference/XR.XRInputSubsystem.TryRecenter.html
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/teleport-system/teleport-system


 

 

 Next Development Checkpoint

 See also

orientation. If a depth buffer isn't provided, the system will only correct mispredictions in orientation.

Holographic headsetsHolographic headsets  like HoloLens 2 will take care of positional reprojection whether the app provides its

depth buffer or not. Positional reprojection is possible without depth buffers on HoloLens as rendering is

often sparse with a stable background provided by the real world.

MRTK

XR SDK

Legacy WSA

MRTK doesn't currently have helpers for the reprojection mode. Please see one of the other tabs for more

information.

If you're following the Unity development journey we've laid out, you're in the midst of exploring the MRTK core

building blocks. From here, you can continue to the next building block:

Gaze

Or jump to Mixed Reality platform capabilities and APIs:

Shared experiences

You can always go back to the Unity development checkpoints at any time.

Hologram stability

Experience scales

Spatial stage

Tracking loss in Unity

Spatial anchors

Persistence in Unity

Shared experiences in Unity

Azure Spatial Anchors

Azure Spatial Anchors SDK for Unity

https://docs.microsoft.com/en-us/windows/mixed-reality/develop/unity/persistence-in-unity
https://docs.microsoft.com/en-us/azure/spatial-anchors
https://docs.microsoft.com/en-us/dotnet/api/microsoft.azure.spatialanchors


   

 

World locking and spatial anchors in Unity
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 World-scale coordinate systems

Getting your holograms to stay in place, move with you, or in some cases position themselves relative to other

holograms is a big part of creating Mixed Reality applications. This article will take you through our

recommended solution using World Locking Tools, but we'll also cover manually setting up spatial anchors in

your Unity projects. Before we jump into any code, it's important to understand how Unity handles coordinate

space and anchors in its own engine.

Today, when writing games, data visualization apps, or virtual reality apps, the typical approach is to establish

one absolute world coordinate systemworld coordinate system that all other coordinates can reliably map back to. In that

environment, you can always find a stable transform that defines a relationship between any two objects in that

world. If you didn't move those objects, their relative transforms would always remain the same. This kind of

global coordinate system is easy to get right when rendering a purely virtual world where you know all of the

geometry in advance. Room-scale VR apps today typically establish this kind of absolute room-scale coordinate

system with its origin on the floor.

In contrast, an untethered mixed reality device such as HoloLens has a dynamic sensor-driven understanding of

the world, continuously adjusting its knowledge over time of the user's surroundings as they walk many meters

across an entire floor of a building. In a world-scale experience, if you placed all your holograms in a naive rigid

coordinate system, those holograms would end up drifting over time, either based on the world or relative to

each other.

For example, the headset may currently believe two locations in the world to be 4 meters apart, and then later

refine that understanding, learning that the locations are in fact 3.9 meters apart. If those holograms had initially

been placed 4 meters apart in a single rigid coordinate system, one of them would then always appear 0.1

meters off from the real world.

You can manually place spatial anchorsspatial anchors  in Unity to maintain a hologram's position in the physical world when

the user is mobile. However, this sacrifices the self-consistency within the virtual world. Different anchors are

constantly moving in relation to one another, and are also moving through the global coordinate space. In this

scenario, simple tasks like layout become difficult. Physics simulation can also be problematic.

World Locking ToolsWorld Locking Tools  (WLT) gets you the best of both worlds, stabilizing a single rigid coordinate system using

an internal supply of spatial anchors spread throughout the virtual scene as the user moves around. WLT

analyzes the coordinates of the camera and those spatial anchors every frame. Instead of changing the

coordinates of everything in the world to compensate for the corrections in the coordinates of the user's head,

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/spatial-anchors-in-unity.md


 Choose your world locking approach

 Set up world locking
 

 

  Automated setupAutomated setup

IMPORTANTIMPORTANT

  VisualizersVisualizers

 Persistent world locking

WLT just fixes the head's coordinates instead.

If possible, use World Locking Tools for hologram positioning.

World Locking ToolsWorld Locking Tools  provides a stable coordinate system that minimizes the visible inconsistencies between

virtual and real world markers. World Locking Tools world-locks the entire scene with a shared pool of anchors,

rather than locking each group of objects with the group's own individual anchor.

World Locking Tools automatically handles internal creation and management of spatial anchors. You don't need

to interact with ARAnchorManager or WorldAnchor to keep your holograms world-locked.

For Unity 2019/2020 using OpenXR or the Windows XR Plugin, use ARAnchorManagerARAnchorManager .

For older Unity versions or WSA projects, use WorldAnchorWorldAnchor .

World Locking Tools (Recommended)

ARAnchorManager

WorldAnchor

To get started using the World Locking Tools, download the Mixed Reality Feature Tool. To learn more about the

basics, see the main World Locking Tools documentation page for links to Overview, Quickstart, and other useful

topics.

World Locking Tools documentation

When your project is ready to go, run the configure scene utility from Mixed Reality > World Locking ToolsMixed Reality > World Locking Tools :

The Configure scene utility can be rerun at any time. For example, it should be rerun if the AR target has been changed

from Legacy to XR SDK. If the scene is already properly configured, running the utility has no effect.

During early development, adding visualizers can be helpful to ensure WLT is setup and working properly. They

can be removed for production performance, or if for any reason are no longer needed, using the Remove

visualizers utility. More details on the visualizers can be found in the Tools documentation.

Spatial anchors save holograms in real-world space between application sessions. Once saved in the HoloLens

https://docs.microsoft.com/en-us/mixed-reality/world-locking-tools
https://docs.microsoft.com/en-us/mixed-reality/world-locking-tools/
https://docs.microsoft.com/en-us/mixed-reality/world-locking-tools/documentation/howtos/tools#visualizers
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 Next steps

 See also

anchor store, spatial anchors can be found and loaded in different sessions and are an ideal fallback when

there's no internet connectivity.

Local anchors are stored on device, while Azure Spatial Anchors are stored in the cloud. You can have local and Azure

anchors in the same project without conflict. For more information about integrating Azure cloud services to store your

anchors, see Azure Spatial Anchors.

World Locking Tools (Recommended)

ARAnchorManager

WorldAnchor

By default, World Locking Tools restore Unity's coordinate system relative to the physical world across sessions

on devices that support persistence of local spatial anchors. To have a hologram appear in the same place in the

physical world after quitting and rerunning the application, the application only needs to restore the same pose

to the hologram.

If the application needs finer control, you can disable Auto-SaveAuto-Save and Auto-LoadAuto-Load in the inspector, and manage

persistence from a script. For more information, see Persist spatial coordinate systems.

World Locking Tools supports local anchor persistence only on HoloLens devices. For Android, iOS, and

HoloLens devices, integrate with Azure Spatial Anchors to support persistence and sharing of coordinate spaces

across sessions and devices. For more information and samples using World Locking Tools with Azure Spatial

Anchors, see World Locking Tools (WLT) combined with Azure Spatial Anchors (ASA).

Share a world locked coordinate space:

Shared experiences

Learn about spatial mapping:

Spatial mapping

Go back to the Unity development checkpoints:

Core building blocks

World Locking Tools introduction

https://docs.microsoft.com/en-us/mixed-reality/world-locking-tools/documentation/concepts/advanced/persistence
https://docs.microsoft.com/en-us/mixed-reality/world-locking-tools/documentation/howtos/wlt_asa
https://docs.microsoft.com/en-us/mixed-reality/world-locking-tools/documentation/introfaq


Quickstart guides

Tutorials

Samples

Spatial anchor persistence

Azure Spatial Anchors

Azure Spatial Anchors SDK for Unity

Experience scales

Spatial stage

Tracking loss in Unity

Spatial anchors

Shared experiences in Unity

https://docs.microsoft.com/en-us/mixed-reality/world-locking-tools/documentation/howtos/quickstart
https://microsoft.github.io/MixedReality-WorldLockingTools-Samples/Tutorial/01_Minimal/01_Minimal.html
https://docs.microsoft.com/en-us/mixed-reality/world-locking-tools/documentation/howtos/sampleapplications
https://docs.microsoft.com/en-us/azure/spatial-anchors
https://docs.microsoft.com/en-us/dotnet/api/microsoft.azure.spatialanchors
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 Azure Spatial Anchors
  Automated with World Locking ToolsAutomated with World Locking Tools

  Manual configuration of Azure Spatial AnchorsManual configuration of Azure Spatial Anchors

 Local anchor transfers

 Next Development Checkpoint

 

A shared experience lets multiple users, each with their own HoloLens, iOS or Android device, collectively view

and interact with the same hologram. Holograms are positioned at a fixed point in space through spatial anchor

sharing.

As with local anchors, World Locking Tools can use a group of Azure Spatial Anchors to lock entire coordinate

spaces relative to the physical world, rather than use individual anchors to lock individual objects. World locking

the entire space not only provides an environment that's more conducive to precise layout, it's also more

efficient in both developer time and runtime resources.

For further information and samples leveraging Azure Spatial Anchors to share coordinate systems across

HoloLens, Android, and iOS devices, as well as persisting spaces across sessions, see the World Locking Tools

documentation.

Azure Spatial Anchors create durable cloud-backed spatial anchors that your app can locate across multiple

HoloLens, iOS and Android devices. By sharing a common spatial anchor across multiple devices, each user can

see content rendered relative to that anchor in the same physical location.

You can also use Azure Spatial Anchors for asynchronous hologram persistence across HoloLens, iOS, and

Android devices. By sharing a durable cloud spatial anchor, multiple devices can observe the same persisted

hologram over time, even if those devices aren't present together at the same time.

To get started building shared experiences in Unity, try out the 5-minute Azure Spatial Anchors Unity

quickstarts.

Once Azure Spatial Anchors is set up, you can create and locate anchors in Unity.

In situations where you can't use Azure Spatial Anchors, local anchor transfers enable one HoloLens device to

export an anchor so that a second HoloLens can import it. This approach is not supported on iOS and Android

devices, and provides less robust anchor recall than Azure Spatial Anchors.

If you're following the Unity development journey we've laid out, you're in the midst of exploring the Mixed

Reality platform capabilities and APIs. From here, you can continue to the next section:

Locatable camera

Or jump directly to deploying your app on a device or emulator :

Deploy to HoloLens or Windows Mixed Reality immersive headsets

You can always go back to the Unity development checkpoints at any time.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/shared-experiences-in-unity.md
https://docs.microsoft.com/en-us/mixed-reality/world-locking-tools/
https://docs.microsoft.com/en-us/azure/spatial-anchors/overview
https://docs.microsoft.com/en-us/azure/spatial-anchors/overview
https://docs.microsoft.com/en-us/azure/spatial-anchors/unity-overview
https://docs.microsoft.com/en-us/azure/spatial-anchors/concepts/create-locate-anchors-unity
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/local-anchor-transfers-in-unity


See also
Shared experiences in mixed reality

Azure Spatial Anchors

Azure Spatial Anchors SDK for Unity

https://docs.microsoft.com/en-us/azure/spatial-anchors
https://docs.microsoft.com/en-us/dotnet/api/microsoft.azure.spatialanchors


   

 

Articulated Hand and Eye Tracking in Unity
 7/6/2022 • 2 minutes to read • Edit Online

 Building Blocks supporting Hands, eyes and others in MRTK
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A button control, which supports
various input methods including
HoloLens2's articulated hand

Standard UI for manipulating objects in
3D space

Script for manipulating objects with
one or two hands

Slate System Keyboard Interactable

2D style plane, which supports
scrolling with articulated hand input

Example script of using the system
keyboard in Unity

A script for making objects interactable
with visual states and theme support

Solver Object Collection Tooltip

Various object positioning behaviors
such as tag-along, body-lock, constant
view size, and surface magnetism

Script for lay out an array of objects in
a three-dimensional shape

Annotation UI with flexible
anchor/pivot system, which can be
used for labeling motion controllers
and object.

HoloLens 2 has introduced some new and exciting capabilities, such as Articulated Hand and Eye Tracking.

The easiest way to leverage the new capability in Unity is through MRTK. There are also some example scenes to

help you get started.

Get started with Articulated Hand in MRTK

Get started with Eye Tracking in MRTK

MRTK v2 provides a set of UI Controls and building blocks to help you accelerate your development.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/hand-eye-in-unity.md
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/hand-tracking
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/eye-tracking/eye-tracking-main
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/button
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/button
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/bounding-box
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/bounding-box
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/manipulation-handler
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/manipulation-handler
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/slate
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/slate
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/system-keyboard
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/system-keyboard
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/interactable
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/interactable
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/solvers/solver
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/solvers/solver
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/object-collection
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/object-collection
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/tooltip
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/tooltip


App Bar Pointers Fingertip Visualization

UI for Bounding Box's manual
activation

Learn about various types of pointers Visual affordance on the fingertip,
which improves the confidence for the
direct interaction

Eye Tracking: Target Selection Eye Tracking: Navigation

Combine eyes, voice, and hand input
to quickly and effortlessly select
holograms across your scene

Learn how to auto scroll text or zoom
into focused content based on what
you're looking at

Examples for logging, loading, and
visualizing what users have been
looking at in your app
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 Example Scenes

 Next Development Checkpoint

Explore MRTK's various types of interactions and UI controls in this example scene.

You can find other example scenes in Mixed Reality Toolkit GitHub under

Assets/MixedRealityToolkit.Examples/DemosAssets/MixedRealityToolkit.Examples/Demosfolder.

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/app-bar
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/app-bar
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/pointers
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/pointers
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/fingertip-visualization
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/ux-building-blocks/fingertip-visualization
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/eye-tracking/eye-tracking-target-selection
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/eye-tracking/eye-tracking-target-selection
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/eye-tracking/eye-tracking-navigation
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/eye-tracking/eye-tracking-navigation
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/example-scenes/hand-interaction-examples
https://github.com/Microsoft/MixedRealityToolkit-Unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/example-scenes/hand-interaction-examples


 See also

If you're following the Unity development journey we've laid out, you're in the midst of exploring the MRTK core

building blocks. From here, you can continue to the next building block:

Spatial Mapping

Or jump to Mixed Reality platform capabilities and APIs:

Shared experiences

You can always go back to the Unity development checkpoints at any time.

Eye-based interaction

Eye tracking on HoloLens 2

Gaze and commit

Hands - Direct manipulation

Hands - Gestures

Hands - Point and commit

Instinctual interactions

Motion controllers

UnityEngine.XR.WSA.Input

UnityEngine.XR.InputTracking

https://docs.unity3d.com/ScriptReference/XR.WSA.Input.InteractionManager.html
https://docs.unity3d.com/ScriptReference/XR.InputTracking.html


   

 

Motion controllers in Unity
 7/6/2022 • 16 minutes to read • Edit Online

 Unity XR input APIs

 Unity button/axis mapping table

IN P UTIN P UT C O M M O N  UN IT Y  A P ISC O M M O N  UN IT Y  A P IS
( IN P UT. GET B UT TO N / GETA XIS)( IN P UT. GET B UT TO N / GETA XIS)

W IN DO W S M R- SP EC IF ICW IN DO W S M R- SP EC IF IC
IN P UT  A P IIN P UT  A P I
( XR . W SA . IN P UT )( XR . W SA . IN P UT )

L EF T  H A N DL EF T  H A N D RIGH T  H A N DRIGH T  H A N D

Select trigger pressed Axis 9 = 1.0 Axis 10 = 1.0 selectPressed

Select trigger analog value Axis 9 Axis 10 selectPressedAmount

Select trigger partially
pressed

Button 14 
(gamepad compat)

Button 15 
(gamepad compat)

selectPressedAmount > 0.0

Menu button pressed Button 6* Button 7* menuPressed

Grip button pressed Axis 11 = 1.0 (no analog
values)
Button 4 
(gamepad compat)

Axis 12 = 1.0 (no analog
values)
Button 5 
(gamepad compat)

grasped

Thumbstick X 
(left: -1.0, right: 1.0)

Axis 1 Axis 4 thumbstickPosition.x

There are two key ways to take action on your gaze in Unity, hand gestures and motion controllers in HoloLens

and Immersive HMD. You access the data for both sources of spatial input through the same APIs in Unity.

Unity provides two primary ways to access spatial input data for Windows Mixed Reality. The common

Input.GetButton/Input.GetAxis APIs work across multiple Unity XR SDKs, while the

InteractionManager/GestureRecognizer API specific to Windows Mixed Reality exposes the full set of spatial

input data.

For new projects, we recommend using the new XR input APIs from the beginning.

You can find more information about the XR APIs here.

Unity's Input Manager for Windows Mixed Reality motion controllers supports the button and axis IDs listed

below through the Input.GetButton/GetAxis APIs. The "Windows MR-specific" column refers to properties

available off of the InteractionSourceState type. Each of these APIs is described in detail in the sections below.

The button/axis ID mappings for Windows Mixed Reality generally match the Oculus button/axis IDs.

The button/axis ID mappings for Windows Mixed Reality differ from OpenVR's mappings in two ways:

1. The mapping uses touchpad IDs that are distinct from thumbstick, to support controllers with both

thumbsticks and touchpads.

2. The mapping avoids overloading the A and X button IDs for the Menu buttons to leave them available for the

physical ABXY buttons.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/motion-controllers-in-unity.md
https://docs.unity3d.com/Manual/xr_input.html


Thumbstick Y 
(top: -1.0, bottom: 1.0)

Axis 2 Axis 5 thumbstickPosition.y

Thumbstick pressed Button 8 Button 9 thumbstickPressed

Touchpad X 
(left: -1.0, right: 1.0)

Axis 17* Axis 19* touchpadPosition.x

Touchpad Y 
(top: -1.0, bottom: 1.0)

Axis 18* Axis 20* touchpadPosition.y

Touchpad touched Button 18* Button 19* touchpadTouched

Touchpad pressed Button 16* Button 17* touchpadPressed

6DoF grip pose or pointer
pose

Grip pose only: XR.InputTracking.GetLocalPosition
XR.InputTracking.GetLocalRotation

Pass Grip or Pointer as an
argument:
sourceState.sourcePose.TryG
etPosition
sourceState.sourcePose.TryG
etRotation

Tracking state Position accuracy and source loss risk only available through
MR-specific API

sourceState.sourcePose.posi
tionAccuracy
sourceState.properties.sourc
eLossRisk

NOTENOTE

  OpenXROpenXR

IN P UT F EAT UREUSA GEIN P UT F EAT UREUSA GE
H P  REVERB  G2 C O N T RO L L ERH P  REVERB  G2 C O N T RO L L ER
( O P EN XR)( O P EN XR) H O LO L EN S H A N D ( O P EN XR)H O LO L EN S H A N D ( O P EN XR)

primary2DAxis Joystick

primary2DAxisClick Joystick - Click

trigger Trigger

grip Grip Air tap or squeeze

primaryButton [X/A] - Press Air tap

These button/axis IDs differ from the IDs that Unity uses for OpenVR due to collisions in the mappings used by

gamepads, Oculus Touch and OpenVR.

To learn the basics about mixed reality interactions in Unity, visit the Unity Manual for Unity XR Input. This Unity

documentation covers the mappings from controller-specific inputs to more generalizable

InputFeatureUsageInputFeatureUsages, how available XR inputs can be identified and categorized, how to read data from these

inputs, and more.

The Mixed Reality OpenXR Plugin provides additional input interaction profiles, mapped to standard

InputFeatureUsageInputFeatureUsages as detailed below:

https://docs.unity3d.com/ScriptReference/XR.InputTracking.GetLocalPosition.html
https://docs.unity3d.com/ScriptReference/XR.InputTracking.GetLocalRotation.html
https://docs.unity3d.com/ScriptReference/XR.WSA.Input.InteractionSourcePose-positionAccuracy.html
https://docs.unity3d.com/ScriptReference/XR.WSA.Input.InteractionSourceProperties-sourceLossRisk.html
https://docs.unity3d.com/2020.2/Documentation/Manual/xr_input.html


secondaryButton [Y/B] - Press

gripButton Grip - Press

triggerButton Trigger - Press

menuButton Menu

IN P UT F EAT UREUSA GEIN P UT F EAT UREUSA GE
H P  REVERB  G2 C O N T RO L L ERH P  REVERB  G2 C O N T RO L L ER
( O P EN XR)( O P EN XR) H O LO L EN S H A N D ( O P EN XR)H O LO L EN S H A N D ( O P EN XR)

 Grip pose vs. pointing pose

  Grip poseGrip pose

  Pointer posePointer pose

Windows Mixed Reality supports motion controllers in a variety of form factors. Each controller's design differs

in its relationship between the user's hand position and the natural "forward" direction that apps should use for

pointing when rendering the controller.

To better represent these controllers, there are two kinds of poses you can investigate for each interaction

source, the gr ip posegrip pose and the pointer posepointer pose. Both the grip pose and pointer pose coordinates are expressed by

all Unity APIs in global Unity world coordinates.

The gr ip posegrip pose represents the location of the users palm, either detected by a HoloLens or holding a motion

controller.

On immersive headsets, the grip pose is best used to render the user 's handthe user 's hand or an object held in the user 'san object held in the user 's

handhand. The grip pose is also used when visualizing a motion controller. The renderable modelrenderable model  provided by

Windows for a motion controller uses the grip pose as its origin and center of rotation.

The grip pose is defined specifically as follows:

The gr ip positiongrip position: The palm centroid when holding the controller naturally, adjusted left or right to center

the position within the grip. On the Windows Mixed Reality motion controller, this position generally aligns

with the Grasp button.

The gr ip or ientation's Right axisgr ip or ientation's Right axis : When you completely open your hand to form a flat 5-finger pose, the

ray that is normal to your palm (forward from left palm, backward from right palm)

The gr ip or ientation's For ward axisgr ip or ientation's For ward axis : When you close your hand partially (as if holding the controller), the

ray that points "forward" through the tube formed by your non-thumb fingers.

The gr ip or ientation's Up axisgr ip or ientation's Up axis : The Up axis implied by the Right and Forward definitions.

You can access the grip pose through either Unity's cross-vendor input API

(XR.InputTracking.GetLocalPosition/Rotation) or through the Windows MR-specific API

(sourceState.sourcePose.TryGetPosition/Rotation, requesting pose data for the GripGrip node).

The pointer posepointer pose represents the tip of the controller pointing forward.

The system-provided pointer pose is best used to raycast when you're rendering the controller  model itselfrendering the controller  model itself .

If you're rendering some other virtual object in place of the controller, such as a virtual gun, you should point

with a ray that's most natural for that virtual object, such as a ray that travels along the barrel of the app-defined

gun model. Because users can see the virtual object and not the physical controller, pointing with the virtual

object will likely be more natural for those using your app.

Currently, the pointer pose is available in Unity only through the Windows MR-specific API,

sourceState.sourcePose.TryGetPosition/Rotation, passing in InteractionSourceNode.Pointer as the argument.

https://docs.unity3d.com/ScriptReference/XR.InputTracking.html


  OpenXROpenXR

public static readonly InputFeatureUsage<Vector3> PointerPosition = new InputFeatureUsage<Vector3>
("PointerPosition");

 Haptics

 Controller tracking state

  Reasoning about tracking state explicitlyReasoning about tracking state explicitly

T RA C K IN G STAT ET RA C K IN G STAT E SO URC ELO SSRISKSO URC ELO SSRISK P O SIT IO N A C C URA C YP O SIT IO N A C C URA C Y T RY GET P O SIT IO NT RY GET P O SIT IO N

High accuracyHigh accuracy < 1.0 High true

High accuracy (at risk ofHigh accuracy (at risk of
losing)losing)

== 1.0 High true

Approximate accuracyApproximate accuracy == 1.0 Approximate true

No positionNo position == 1.0 Approximate false

You have access to two sets of poses through OpenXR input interactions:

The grip poses for rendering objects in the hand

The aim poses for pointing into the world.

More information on this design and the differences between the two poses can be found in the OpenXR

Specification - Input Subpaths.

Poses supplied by the InputFeatureUsages DevicePositionDevicePosition, DeviceRotationDeviceRotation, DeviceVelocityDeviceVelocity , and

DeviceAngularVelocityDeviceAngularVelocity  all represent the OpenXR gripgrip pose. InputFeatureUsages related to grip poses are

defined in Unity’s CommonUsages.

Poses supplied by the InputFeatureUsages PointerPositionPointerPosition, PointerRotationPointerRotation, PointerVelocityPointerVelocity , and

PointerAngularVelocityPointerAngularVelocity  all represent the OpenXR aimaim pose. These InputFeatureUsages aren't defined in any

included C# files, so you'll need to define your own InputFeatureUsages as follows:

For information on using haptics in Unity’s XR Input system, documentation can be found at the Unity Manual

for Unity XR Input - Haptics.

Like the headsets, the Windows Mixed Reality motion controller requires no setup of external tracking sensors.

Instead, the controllers are tracked by sensors in the headset itself.

If the user moves the controllers out of the headset's field of view, Windows continues to infer controller

positions in most cases. When the controller has lost visual tracking for long enough, the controller's positions

will drop to approximate-accuracy positions.

At this point, the system will body-lock the controller to the user, tracking the user's position as they move

around, while still exposing the controller's true orientation using its internal orientation sensors. Many apps

that use controllers to point at and activate UI elements can operate normally while in approximate accuracy

without the user noticing.

Apps that wish to treat positions differently based on tracking state may go further and inspect properties on

the controller's state, such as SourceLossRisk and PositionAccuracy:

These motion controller tracking states are defined as follows:

https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#semantic-path-input
https://docs.unity3d.com/2020.2/Documentation/ScriptReference/XR.CommonUsages.html
https://docs.unity3d.com/2020.2/Documentation/Manual/xr_input.html#Haptics


 Common Unity APIs (Input.GetButton/GetAxis)

  Getting a logical button's pressed stateGetting a logical button's pressed state

High accuracy:High accuracy: While the motion controller is within the headset's field of view, it will generally provide

high-accuracy positions, based on visual tracking. A moving controller that momentarily leaves the field of

view or is momentarily obscured from the headset sensors (e.g. by the user's other hand) will continue to

return high-accuracy poses for a short time, based on inertial tracking of the controller itself.

High accuracy (at r isk of losing):High accuracy (at r isk of losing): When the user moves the motion controller past the edge of the

headset's field of view, the headset will soon be unable to visually track the controller's position. The app

knows when the controller has reached this FOV boundary by seeing the SourceLossRiskSourceLossRisk  reach 1.0. At that

point, the app may choose to pause controller gestures that require a steady stream of high quality poses.

Approximate accuracy:Approximate accuracy: When the controller has lost visual tracking for long enough, the controller's

positions will drop to approximate-accuracy positions. At this point, the system will body-lock the controller

to the user, tracking the user's position as they move around, while still exposing the controller's true

orientation using its internal orientation sensors. Many apps that use controllers to point at and activate UI

elements can operate as normal while in approximate accuracy without the user noticing. Apps with heavier

input requirements may choose to sense this drop from HighHigh accuracy to ApproximateApproximate accuracy by

inspecting the PositionAccuracyPositionAccuracy  property, for example to give the user a more generous hitbox on off-

screen targets during this time.

No position:No position: While the controller can operate at approximate accuracy for a long time, sometimes the

system knows that even a body-locked position isn't meaningful at the moment. For example, a controller

that was turned on may have never been observed visually, or a user may put down a controller that's then

picked up by someone else. At those times, the system won't provide any position to the app, and

TryGetPosition will return false.

Namespace:Namespace: UnityEngine, UnityEngine.XR

TypesTypes : Input, XR.InputTracking

Unity currently uses its general Input.GetButton/Input.GetAxis APIs to expose input for the Oculus SDK, the

OpenVR SDK and Windows Mixed Reality, including hands and motion controllers. If your app uses these APIs

for input, it can easily support motion controllers across multiple XR SDKs, including Windows Mixed Reality.

To use the general Unity input APIs, you'll typically start by wiring up buttons and axes to logical names in the

Unity Input Manager, binding a button or axis IDs to each name. You can then write code that refers to that

logical button/axis name.

For example, to map the left motion controller's trigger button to the Submit action, go to Edit > ProjectEdit > Project

Settings > InputSettings > Input within Unity, and expand the properties of the Submit section under Axes. Change the

Positive ButtonPositive Button or Alt Positive ButtonAlt Positive Button property to read joystick button 14joystick button 14 , like this:

https://docs.unity3d.com/Manual/OculusControllers.html
https://docs.unity3d.com/Manual/OpenVRControllers.html
https://docs.unity3d.com/Manual/ConventionalGameInput.html


if (Input.GetButton("Submit"))
{
  // ...
}

  Getting a physical button's pressed state directlyGetting a physical button's pressed state directly

if (Input.GetKey("joystick button 8"))
{
  // ...
}

  Getting a hand or motion controller's poseGetting a hand or motion controller's pose

Vector3 leftPosition = InputTracking.GetLocalPosition(XRNode.LeftHand);
Quaternion leftRotation = InputTracking.GetLocalRotation(XRNode.LeftHand);

Unity InputManager

Your script can then check for the Submit action using Input.GetButton:

You can add more logical buttons by changing the S izeSize property under AxesAxes .

You can also access buttons manually by their fully qualified name, using Input.GetKey:

You can access the position and rotation of the controller, using XR.InputTracking:



NOTENOTE

 Windows-specific APIs (XR.WSA.Input)
C a u t i o nC a u t i o n

  Polling for the state of hands and motion controllersPolling for the state of hands and motion controllers

var interactionSourceStates = InteractionManager.GetCurrentReading();
foreach (var interactionSourceState in interactionSourceStates) {
    // ...
}

The above code represents the controller's grip pose (where the user holds the controller), which is useful for rendering a

sword or gun in the user's hand, or a model of the controller itself.

The relationship between this grip pose and the pointer pose (where the tip of the controller is pointing) may differ across

controllers. At this moment, accessing the controller's pointer pose is only possible through the MR-specific input API,

described in the sections below.

If your project is using any of the XR.WSA APIs, these are being phased out in favor of the XR SDK in future

Unity releases. For new projects, we recommend using the XR SDK from the beginning. You can find more

information about the XR Input system and APIs here.

Namespace:Namespace: UnityEngine.XR.WSA.Input

TypesTypes : InteractionManager, InteractionSourceState, InteractionSource, InteractionSourceProperties,

InteractionSourceKind, InteractionSourceLocation

To get at more detailed information about Windows Mixed Reality hand input (for HoloLens) and motion

controllers, you can choose to use the Windows-specific spatial input APIs under the UnityEngine.XR.WSA.Input

namespace. This lets you access additional information, such as position accuracy or the source kind, letting you

tell hands and controllers apart.

You can poll for this frame's state for each interaction source (hand or motion controller) using the

GetCurrentReading method.

Each InteractionSourceState you get back represents an interaction source at the current moment in time. The

InteractionSourceState exposes info such as:

if (interactionSourceState.selectPressed) {
     // ...
}

if (interactionSourceState.touchpadTouched && interactionSourceState.touchpadPosition.x > 0.5) {
     // ...
}

Which kinds of presses are occurring (Select/Menu/Grasp/Touchpad/Thumbstick)

Other data specific to motion controllers, such the touchpad and/or thumbstick's XY coordinates and

touched state

The InteractionSourceKind to know if the source is a hand or a motion controller

https://docs.unity3d.com/Manual/xr_input.html


  Polling for forward-predicted rendering posesPolling for forward-predicted rendering poses

  Handling interaction source eventsHandling interaction source events

if (interactionSourceState.source.kind == InteractionSourceKind.Hand) {
     // ...
}

var sourcePose = interactionSourceState.sourcePose;
Vector3 sourceGripPosition;
Quaternion sourceGripRotation;
if ((sourcePose.TryGetPosition(out sourceGripPosition, InteractionSourceNode.Grip)) &&
     (sourcePose.TryGetRotation(out sourceGripRotation, InteractionSourceNode.Grip))) {
     // ...
}

var headPose = interactionSourceState.headPose;
var headRay = new Ray(headPose.position, headPose.forward);
RaycastHit raycastHit;
if (Physics.Raycast(headPose.position, headPose.forward, out raycastHit, 10)) {
     var cursorPos = raycastHit.point;
     // ...
}

When polling for interaction source data from hands and controllers, the poses you get are forward-

predicted poses for the moment in time when this frame's photons will reach the user's eyes. Forward-

predicted poses are best used for renderingrendering the controller or a held object each frame. If you're targeting

a given press or release with the controller, that will be most accurate if you use the historical event APIs

described below.

You can also get the forward-predicted head pose for this current frame. As with the source pose, this is

useful for renderingrendering a cursor, although targeting a given press or release will be most accurate if you

use the historical event APIs described below.

To handle input events as they happen with their accurate historical pose data, you can handle interaction source

events instead of polling.

To handle interaction source events:

InteractionManager.InteractionSourcePressed += InteractionManager_InteractionSourcePressed;

Register for a InteractionManager input event. For each type of interaction event that you are interested

in, you need to subscribe to it.

Handle the event. Once you have subscribed to an interaction event, you will get the callback when

appropriate. In the SourcePressed example, this will be after the source was detected and before it is

released or lost.



  How to stop handling an eventHow to stop handling an event

InteractionManager.InteractionSourcePressed -= InteractionManager_InteractionSourcePressed;

  List of interaction source eventsList of interaction source events

  Events for historical targeting poses that most accurately match a press or releaseEvents for historical targeting poses that most accurately match a press or release

void InteractionManager_InteractionSourceDetected(InteractionSourceDetectedEventArgs args)
     var interactionSourceState = args.state;

     // args.state has information about:
        // targeting head ray at the time when the event was triggered
        // whether the source is pressed or not
        // properties like position, velocity, source loss risk
        // source id (which hand id for example) and source kind like hand, voice, controller or 
other
}

You need to stop handling an event when you're no longer interested in the event or you're destroying the object

that has subscribed to the event. To stop handling the event, you unsubscribe from the event.

The available interaction source events are:

InteractionSourceDetected (source becomes active)

InteractionSourceLost (becomes inactive)

InteractionSourcePressed (tap, button press, or "Select" uttered)

InteractionSourceReleased (end of a tap, button released, or end of "Select" uttered)

InteractionSourceUpdated (moves or otherwise changes some state)

The polling APIs described earlier give your app forward-predicted poses. While those predicted poses are best

for rendering the controller or a virtual handheld object, future poses aren't optimal for targeting, for two key

reasons:

When the user presses a button on a controller, there can be about 20 ms of wireless latency over Bluetooth

before the system receives the press.

Then, if you're using a forward-predicted pose, there would be another 10-20 ms of forward prediction

applied to target the time when the current frame's photons will reach the user's eyes.

This means that polling gives you a source pose or head pose that is 30-40 ms forward from where the user's

head and hands actually were back when the press or release happened. For HoloLens hand input, while there's

no wireless transmission delay, there's a similar processing delay to detect the press.

To accurately target based on the user's original intent for a hand or controller press, you should use the

historical source pose or head pose from that InteractionSourcePressed or InteractionSourceReleased input

event.

You can target a press or release with historical pose data from the user's head or their controller :

The head pose at the moment in time when a gesture or controller press occurred, which can be used for

targetingtargeting to determine what the user was gazing at:



  Event handlers exampleEvent handlers example

void InteractionManager_InteractionSourcePressed(InteractionSourcePressedEventArgs args) {
     var interactionSourceState = args.state;
     var headPose = interactionSourceState.headPose;
     RaycastHit raycastHit;
     if (Physics.Raycast(headPose.position, headPose.forward, out raycastHit, 10)) {
         var targetObject = raycastHit.collider.gameObject;
         // ...
     }
}

void InteractionManager_InteractionSourcePressed(InteractionSourcePressedEventArgs args)
{
     var interactionSourceState = args.state;
     var sourcePose = interactionSourceState.sourcePose;
     Vector3 sourceGripPosition;
     Quaternion sourceGripRotation;
     if ((sourcePose.TryGetPosition(out sourceGripPosition, InteractionSourceNode.Pointer)) &&
         (sourcePose.TryGetRotation(out sourceGripRotation, InteractionSourceNode.Pointer))) {
         RaycastHit raycastHit;
         if (Physics.Raycast(sourceGripPosition, sourceGripRotation * Vector3.forward, out 
raycastHit, 10)) {
             var targetObject = raycastHit.collider.gameObject;
             // ...
         }
     }
}

The source pose at the moment in time when a motion controller press occurred, which can be used for

targetingtargeting to determine what the user was pointing the controller at. This will be the state of the

controller that experienced the press. If you're rendering the controller itself, you can request the pointer

pose rather than the grip pose, to shoot the targeting ray from what the user will consider the natural tip

of that rendered controller :



using UnityEngine.XR.WSA.Input;

void Start()
{
    InteractionManager.InteractionSourceDetected += InteractionManager_InteractionSourceDetected;
    InteractionManager.InteractionSourceLost += InteractionManager_InteractionSourceLost;
    InteractionManager.InteractionSourcePressed += InteractionManager_InteractionSourcePressed;
    InteractionManager.InteractionSourceReleased += InteractionManager_InteractionSourceReleased;
    InteractionManager.InteractionSourceUpdated += InteractionManager_InteractionSourceUpdated;
}

void OnDestroy()
{
    InteractionManager.InteractionSourceDetected -= InteractionManager_InteractionSourceDetected;
    InteractionManager.InteractionSourceLost -= InteractionManager_InteractionSourceLost;
    InteractionManager.InteractionSourcePressed -= InteractionManager_InteractionSourcePressed;
    InteractionManager.InteractionSourceReleased -= InteractionManager_InteractionSourceReleased;
    InteractionManager.InteractionSourceUpdated -= InteractionManager_InteractionSourceUpdated;
}

void InteractionManager_InteractionSourceDetected(InteractionSourceDetectedEventArgs args)
{
    // Source was detected
    // args.state has the current state of the source including id, position, kind, etc.
}

void InteractionManager_InteractionSourceLost(InteractionSourceLostEventArgs state)
{
    // Source was lost. This will be after a SourceDetected event and no other events for this
    // source id will occur until it is Detected again
    // args.state has the current state of the source including id, position, kind, etc.
}

void InteractionManager_InteractionSourcePressed(InteractionSourcePressedEventArgs state)
{
    // Source was pressed. This will be after the source was detected and before it is
    // released or lost
    // args.state has the current state of the source including id, position, kind, etc.
}

void InteractionManager_InteractionSourceReleased(InteractionSourceReleasedEventArgs state)
{
    // Source was released. The source would have been detected and pressed before this point.
    // This event will not fire if the source is lost
    // args.state has the current state of the source including id, position, kind, etc.
}

void InteractionManager_InteractionSourceUpdated(InteractionSourceUpdatedEventArgs state)
{
    // Source was updated. The source would have been detected before this point
    // args.state has the current state of the source including id, position, kind, etc.
}

 Motion Controllers in MRTK

 Follow along with tutorials

You can access gesture and motion controller from the input Manager.

Step-by-step tutorials, with more detailed customization examples, are available in the Mixed Reality Academy:

MR Input 211: Gesture

MR Input 213: Motion controllers

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/controllers
https://docs.microsoft.com/en-us/windows/mixed-reality/deprecated/mixed-reality-213


 Next Development Checkpoint

 See also

MR Input 213 - Motion controller

If you're following the Unity development journey we've laid out, you're in the midst of exploring the MRTK core

building blocks. From here, you can continue to the next building block:

Hand and eye tracking

Or jump to Mixed Reality platform capabilities and APIs:

Shared experiences

You can always go back to the Unity development checkpoints at any time.

Head-gaze and commit

Motion controllers

https://docs.microsoft.com/en-us/windows/mixed-reality/mixed-reality-213
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IMPORTANTIMPORTANT

 HP Motion Controller overview

 Installing Microsoft.MixedReality.Input with the Mixed Reality Feature
Tool

HP Motion controllers are a brand new type of Windows Mixed Reality controllers: all the same tracking

technology with a slightly different set of available inputs:

Touchpad has been replaced by two buttons: A and B for the right controller, and X and Y for the left

controller.

Grasp is now a trigger that publishes a stream of values between 0.0 and 1.0 instead of a button with Pressed

and Not Pressed states.

Since the new inputs aren't accessible through existing Windows and Unity APIs, you need the dedicated

Microsoft.MixedReality.InputMicrosoft.MixedReality.Input UPM Package.

Classes in this package do not replace existing Windows and Unity APIs but complement them.Classes in this package do not replace existing Windows and Unity APIs but complement them. Features

commonly available to both classic Windows Mixed Reality controllers and HP Motion Controllers are accessible through

the same code path using existing APIs. Only the new inputs require the use of the additional

Microsoft.MixedReality.Input package.

Microsoft.MixedReality.Input.MotionController represents a motion controller. Each MotionController instance

has an XR.WSA.Input.InteractionSource peer, which can be correlated using handedness, vendor ID, product ID,

and version.

You can grab MotionController instances by creating a MotionControllerWatcher and subscribing to its events,

similar to using InteractionManager events to discover new InteractionSource instances. The MotionController ’s

methods and properties describe the inputs supported by the controller, including its buttons, triggers, 2D axis,

and thumbstick. The MotionController class also exposes methods for accessing input states through the

MotionControllerReading class. The MotionControllerReading class represents a snapshot of the controller ’s

state at a given time.

Install the Microsoft.MixedReality.Input plugin with the new Mixed Reality Feature Tool application. Follow the

installation and usage instructions and select the Mixed Reality InputMixed Reality Input package in the Mixed Reality Toolkit

category:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/unity-reverb-g2-controllers.md


 Using Microsoft.MixedReality.Input
  Input valuesInput values

  Creating a cache to maintain a collection of MotionController instances and their statesCreating a cache to maintain a collection of MotionController instances and their states

public class MotionControllerStateCache : MonoBehaviour 
{ 
    /// <summary> 
    /// Internal helper class which associates a Motion Controller 
    /// and its known state 
    /// </summary> 
    private class MotionControllerState 

A MotionController can expose two kinds of inputs:

Buttons and trigger states are expressed by a unique float value between 0.0 and 1.0 that indicates how

much they're pressed.

Thumbstick state is expressed by a Vector2 whose X and Y components are between -1.0 and 1.0.

A button can only return 0.0 (when not pressed) or 1.0 (when pressed) while a trigger can return

continuous values between 0.0 (fully released) to 1.0 (fully pressed).

You can use MotionController.GetPressableInputs() to return a list of inputs returning a pressed value (buttons

and triggers) or the MotionController.GetXYInputs() method to return a list of inputs returning a 2-axis value.

A MotionControllerReading instance represents the state of the controller at a given time:

GetPressedValue() retrieves the state of a button or a trigger.

GetXYValue() retrieves the state of a thumbstick.

Start by instantiating a MotionControllerWatcher and registering handlers for its MotionControllerAdded and

MotionControllerRemoved events to keep a cache of available MotionController instances. This cache should be

a MonoBehavior attached to a GameObject as demonstrated in the following code:



    private class MotionControllerState 
    { 
        /// <summary> 
        /// Construction 
        /// </summary> 
        /// <param name="mc">motion controller</param>` 
        public MotionControllerState(MotionController mc) 
        { 
            this.MotionController = mc; 
        } 

        /// <summary> 
        /// Motion Controller that the state represents 
        /// </summary> 
        public MotionController MotionController { get; private set; } 
        … 
    } 

    private MotionControllerWatcher _watcher; 
    private Dictionary<Handedness, MotionControllerState> 
        _controllers = new Dictionary<Handedness, MotionControllerState>(); 

    /// <summary> 
    /// Starts monitoring controller's connections and disconnections 
    /// </summary> 
    public void Start() 
    { 
        _watcher = new MotionControllerWatcher(); 
        _watcher.MotionControllerAdded += _watcher_MotionControllerAdded; 
        _watcher.MotionControllerRemoved += _watcher_MotionControllerRemoved; 
        var nowait = _watcher.StartAsync(); 
    } 

    /// <summary> 
    /// Stops monitoring controller's connections and disconnections 
    /// </summary> 
    public void Stop() 
    { 
        if (_watcher != null) 
        { 
            _watcher.MotionControllerAdded -= _watcher_MotionControllerAdded; 
            _watcher.MotionControllerRemoved -= _watcher_MotionControllerRemoved; 
            _watcher.Stop(); 
        } 
    }

    /// <summary> 
    /// called when a motion controller has been removed from the system: 
    /// Remove a motion controller from the cache 
    /// </summary> 
    /// <param name="sender">motion controller watcher</param> 
    /// <param name="e">motion controller </param> 
    private void _watcher_MotionControllerRemoved(object sender, MotionController e) 
    { 
        lock (_controllers) 
        { 
            _controllers.Remove(e.Handedness); 
        } 
    }

    /// <summary> 
    /// called when a motion controller has been added to the system: 
    /// Remove a motion controller from the cache 
    /// </summary> 
    /// <param name="sender">motion controller watcher</param> 
    /// <param name="e">motion controller </param> 
    private void _watcher_MotionControllerAdded(object sender, MotionController e) 
    { 
        lock (_controllers) 
        { 



        { 
            _controllers[e.Handedness] = new MotionControllerState(e); 
        } 
    } 
} 

  Reading new inputs by pollingReading new inputs by polling

public class MotionControllerStateCache : MonoBehaviour 
{ 
    … 

    private class MotionControllerState 
    {
        … 

        /// <summary> 
        /// Update the current state of the motion controller 
        /// </summary> 
        /// <param name="when">time of the reading</param> 
        public void Update(DateTime when) 
        { 
            this.CurrentReading = this.MotionController.TryGetReadingAtTime(when); 
        } 

        /// <summary> 
        /// Last reading from the controller 
        /// </summary> 
        public MotionControllerReading CurrentReading { get; private set; } 
    } 

    /// <summary> 
    /// Updates the input states of the known motion controllers 
    /// </summary> 
    public void Update() 
    { 
        var now = DateTime.Now; 

        lock (_controllers) 
        { 
            foreach (var controller in _controllers) 
            { 
                controller.Value.Update(now); 
            } 
        } 
    } 
} 

You can read the current state of each known controller through MotionController.TryGetReadingAtTime during

the Update method of the MonoBehavior class. You want to pass DateTime.Now as the timestamp parameter to

ensure that the latest state of the controller is read.

You can grab the controllers current input value using the Handedness of the controller :



public class MotionControllerStateCache : MonoBehaviour 
{ 
    … 
    /// <summary> 
    /// Returns the current value of a controller input such as button or trigger 
    /// </summary> 
    /// <param name="handedness">Handedness of the controller</param> 
    /// <param name="input">Button or Trigger to query</param> 
    /// <returns>float value between 0.0 (not pressed) and 1.0 
    /// (fully pressed)</returns> 
    public float GetValue(Handedness handedness, ControllerInput input) 
    { 
        MotionControllerReading currentReading = null; 

        lock (_controllers) 
        { 
            if (_controllers.TryGetValue(handedness, out MotionControllerState mc)) 
            { 
                currentReading = mc.CurrentReading; 
            } 
        } 

        return (currentReading == null) ? 0.0f : currentReading.GetPressedValue(input); 
    } 

    /// <summary> 
    /// Returns the current value of a controller input such as button or trigger 
    /// </summary> 
    /// <param name="handedness">Handedness of the controller</param> 
    /// <param name="input">Button or Trigger to query</param> 
    /// <returns>float value between 0.0 (not pressed) and 1.0 
    /// (fully pressed)</returns> 
    public float GetValue(UnityEngine.XR.WSA.Input.InteractionSourceHandedness handedness, ControllerInput 
input) 
    { 
        return GetValue(Convert(handedness), input); 
    } 

    /// <summary> 
    /// Returns a boolean indicating whether a controller input such as button or trigger is pressed 
    /// </summary> 
    /// <param name="handedness">Handedness of the controller</param> 
    /// <param name="input">Button or Trigger to query</param> 
    /// <returns>true if pressed, false if not pressed</returns> 
    public bool IsPressed(Handedness handedness, ControllerInput input) 
    { 
        return GetValue(handedness, input) >= PressedThreshold; 
    } 
} 

/// Read the analog grasp value of all connected interaction sources 
void Update() 
{ 
    … 
    var stateCache = gameObject.GetComponent<MotionControllerStateCache>(); 
    foreach (var sourceState in InteractionManager.GetCurrentReading()) 
    { 
        float graspValue = stateCache.GetValue(sourceState.source.handedness, 
            Microsoft.MixedReality.Input.ControllerInput.Grasp);
        … 
    }
} 

For example, to read the analog grasp value of an InteractionSource:



  Generating events from the new inputsGenerating events from the new inputs

private class MotionControllerState 
{ 
    … 
    /// <summary> 
    /// Returns an array representng buttons which are pressed 
    /// </summary> 
    /// <param name="reading">motion controller reading</param> 
    /// <returns>array of booleans</returns> 
    private bool[] GetPressed(MotionControllerReading reading) 
    { 
        if (reading == null) 
        { 
            return null; 
        } 
        else 
        { 
            bool[] ret = new bool[this.pressableInputs.Length]; 
            for (int i = 0; i < pressableInputs.Length; ++i) 
            { 
                ret[i] = reading.GetPressedValue(pressableInputs[i]) >= PressedThreshold; 
            } 

            return ret; 
        } 
    } 

    /// <summary> 
    /// Get the next available state of the motion controller 
    /// </summary> 
    /// <param name="lastReading">previous reading</param> 
    /// <param name="newReading">new reading</param> 
    /// <returns>true is a new reading was available</returns> 
    private bool GetNextReading(MotionControllerReading lastReading, out MotionControllerReading newReading)  
    { 
        if (lastReading == null) 
        { 
            // Get the first state published by the controller 
            newReading = 
this.MotionController.TryGetReadingAfterSystemRelativeTime(TimeSpan.FromSeconds(0.0)); 
        } 
        else 
        { 
            // Get the next state published by the controller 
            newReading = this.MotionController.TryGetReadingAfterTime(lastReading.InputTime); 
        } 

        return newReading != null; 
    } 

    /// <summary> 
    /// Processes all the new states published by the controller since the last call 
    /// </summary> 
    public IEnumerable<MotionControllerEventArgs> GetNextEvents() 
    {
        MotionControllerReading lastReading = this.CurrentReading; 
        bool[] lastPressed = GetPressed(lastReading); 
        MotionControllerReading newReading; 
        bool[] newPressed; 

Instead of polling for a controller's state once per frame, you have the option of handling all state changes as

events, which lets you handle even the quickest actions lasting less than a frame. In order for this approach to

work, the cache of motion controllers needs to process all states published by a controller since the last frame,

which you can do by storing the timestamp of the last MotionControllerReading retrieved from a

MotionController and calling MotionController.TryGetReadingAfterTime():



        while (GetNextReading(lastReading, out newReading)) 
        { 
            newPressed = GetPressed(newReading); 

            // If we have two readings, compare and generate events 
            if (lastPressed != null) 
            { 
                for (int i = 0; i < pressableInputs.Length; ++i) 
                { 
                    if (newPressed[i] != lastPressed[i]) 
                    { 
                        yield return new MotionControllerEventArgs(this.MotionController.Handedness, 
newPressed[i], this.pressableInputs[i], newReading.InputTime); 
                    } 
                } 
            } 

            lastPressed = newPressed; 
            lastReading = newReading; 
        } 

        // No more reading 
        this.CurrentReading = lastReading; 
    } 
} 

/// <summary> 
/// Event argument class for InputPressed and InputReleased events 
/// </summary> 
public class MotionControllerEventArgs : EventArgs 
{ 
    public MotionControllerEventArgs(Handedness handedness, bool isPressed, rollerInput input, DateTime 
inputTime) 
    { 
        this.Handedness = handedness; 
        this.Input = input; 
        this.InputTime = inputTime; 
        this.IsPressed = isPressed; 
    } 

    /// <summary> 
    /// Handedness of the controller raising the event 
    /// </summary> 
    public Handedness Handedness { get; private set; } 

    /// <summary> 
    /// Button pressed or released 
    /// </summary> 
    public ControllerInput Input { get; private set; } 

    /// <summary> 
    /// Time of the event 
    /// </summary> 
    public DateTime InputTime { get; private set; } 

    /// <summary> 
    /// true if button is pressed, false otherwise 
    /// </summary> 
    public bool IsPressed { get; private set; } 
} 

/// <summary> 
/// Event raised when a button is pressed 

Now that you've updated the cache internal classes, the MonoBehavior class can expose two events – Pressed

and Released – and raise them from its Update() method:



/// Event raised when a button is pressed 
/// </summary> 
public event EventHandler<MotionControllerEventArgs> InputPressed; 

/// <summary> 
/// Event raised when a button is released 
/// </summary> 
public event EventHandler<MotionControllerEventArgs> InputReleased; 

/// <summary> 
/// Updates the input states of the known motion controllers 
/// </summary> 
public void Update() 
{ 
    // If some event handler has been registered, we need to process all states  
    // since the last update, to avoid missing a quick press / release 
    if ((InputPressed != null) || (InputReleased != null)) 
    { 
        List<MotionControllerEventArgs> events = new <MotionControllerEventArgs>(); 

        lock (_controllers) 
        { 
            foreach (var controller in _controllers) 
            { 
                events.AddRange(controller.Value.GetNextEvents()); 
            } 
        } 
 
        // Sort the events by time 
        events.Sort((e1, e2) => DateTime.Compare(e1.InputTime, e2.InputTime)); 

        foreach (MotionControllerEventArgs evt in events) 
        { 
            if (evt.IsPressed && (InputPressed != null)) 
            { 
                InputPressed(this, evt); 
            } 
            else if (!evt.IsPressed && (InputReleased != null)) 
            { 
                InputReleased(this, evt); 
            } 
        } 
    } 
    else 
    { 
        // As we do not predict button presses and the timestamp of the next e is in the future 
        // DateTime.Now is correct in this context as it will return the latest e of controllers 
        // which is the best we have at the moment for the frame. 
        var now = DateTime.Now; 
        lock (_controllers) 
        { 
            foreach (var controller in _controllers) 
            { 
                controller.Value.Update(now); 
            } 
        } 
    } 
} 

The structure in the above code examples makes registering events much more readable:



public InteractionSourceHandedness handedness; 
public Microsoft.MixedReality.Input.ControllerInput redButton;

// Start of the Mono Behavior: register handlers for events from cache 
void Start() 
{ 
    var stateCache = gameObject.GetComponent<MotionControllerStateCache>(); 
    stateCache.InputPressed += stateCache_InputPressed; 
    stateCache.InputReleased += stateCache_InputReleased; 
    … 
} 

// Called when a button is released 
private void stateCache_InputReleased(object sender, MotionControllerStateCache.MotionControllerEventArgs e)  
{ 
    if ((e.SourceHandedness == handedness) && (e.Input == redButton)) 
    { 
        … 
    } 
} 

// Called when a button is pressed 
private void stateCache_InputPressed(object sender, MotionControllerStateCache.MotionControllerEventArgs e) 
{ 
    if ((e.SourceHandedness == handedness) && (e.Input == redButton)) 
    { 
        … 
    } 
} 

 See also
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 High-level composite gesture APIs (GestureRecognizer)

  Create a new Gesture RecognizerCreate a new Gesture Recognizer

GestureRecognizer recognizer = new GestureRecognizer();

  Specify which gestures to watch forSpecify which gestures to watch for

recognizer.SetRecognizableGestures(GestureSettings.Tap | GestureSettings.Hold);

  Subscribe to events for those gesturesSubscribe to events for those gestures

void Start()
{
    recognizer.Tapped += GestureRecognizer_Tapped;
    recognizer.HoldStarted += GestureRecognizer_HoldStarted;
    recognizer.HoldCompleted += GestureRecognizer_HoldCompleted;
    recognizer.HoldCanceled += GestureRecognizer_HoldCanceled;
}

There are two key ways to take action on your gaze in Unity, hand gestures and motion controllers in HoloLens

and Immersive HMD. You access the data for both sources of spatial input through the same APIs in Unity.

Unity provides two primary ways to access spatial input data for Windows Mixed Reality. The common

Input.GetButton/Input.GetAxis APIs work across multiple Unity XR SDKs, while the

InteractionManager/GestureRecognizer API specific to Windows Mixed Reality exposes the full set of spatial

input data.

Namespace:Namespace: UnityEngine.XR.WSA.Input

TypesTypes : GestureRecognizer, GestureSettings, InteractionSourceKind

Your app can also recognize higher-level composite gestures for spatial input sources, Tap, Hold, Manipulation,

and Navigation gestures. You can recognize these composite gestures across both hands and motion controllers

using the GestureRecognizer.

Each Gesture event on the GestureRecognizer provides the SourceKind for the input as well as the targeting

head ray at the time of the event. Some events provide additional context-specific information.

There are only a few steps required to capture gestures using a Gesture Recognizer :

1. Create a new Gesture Recognizer

2. Specify which gestures to watch for

3. Subscribe to events for those gestures

4. Start capturing gestures

To use the GestureRecognizer, you must have created a GestureRecognizer:

Specify which gestures you're interested in via SetRecognizableGestures():

Subscribe to events for the gestures you're interested in.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/gestures-in-unity.md


NOTENOTE

  Start capturing gesturesStart capturing gestures

recognizer.StartCapturingGestures();

  Stop capturing gesturesStop capturing gestures

recognizer.StopCapturingGestures();

  Removing a gesture recognizerRemoving a gesture recognizer

void OnDestroy()
{
    recognizer.Tapped -= GestureRecognizer_Tapped;
    recognizer.HoldStarted -= GestureRecognizer_HoldStarted;
    recognizer.HoldCompleted -= GestureRecognizer_HoldCompleted;
    recognizer.HoldCanceled -= GestureRecognizer_HoldCanceled;
}

 Rendering the motion controller model in Unity

Navigation and Manipulation gestures are mutually exclusive on an instance of a GestureRecognizer.

By default, a GestureRecognizer doesn't monitor input until StartCapturingGestures() is called. It's possible that a

gesture event may be generated after StopCapturingGestures() is called if input was performed before the frame

where StopCapturingGestures() was processed. The GestureRecognizer will remember whether it was on or off

during the previous frame in which the gesture actually occurred, and so it's reliable to start and stop gesture

monitoring based on this frame's gaze targeting.

To stop gesture recognition:

Remember to unsubscribe from subscribed events before destroying a GestureRecognizer object.

Motion controller model and teleportation

To render motion controllers in your app that match the physical controllers your users are holding and



 Throwing objects

articulate as various buttons are pressed, you can use the MotionController  prefabMotionController  prefab in the Mixed Reality

Toolkit. This prefab dynamically loads the correct glTF model at runtime from the system's installed motion

controller driver. It's important to load these models dynamically rather than importing them manually in the

editor, so that your app will show physically accurate 3D models for any current and future controllers your

users may have.

1. Follow the Getting Started instructions to download the Mixed Reality Toolkit and add it to your Unity project.

2. If you replaced your camera with the MixedRealityCameraParent prefab as part of the Getting Started steps,

you're good to go! That prefab includes motion controller rendering. Otherwise, add

Assets/HoloToolkit/Input/Prefabs/MotionControllers.prefab into your scene from the Project pane. You'll

want to add that prefab as a child of whatever parent object you use to move the camera around when the

user teleports within your scene, so that the controllers come along with the user. If your app doesn't involve

teleporting, just add the prefab at the root of your scene.

Throwing objects in virtual reality is a harder problem than it may at first seem. As with most physically based

interactions, when throwing in game acts in an unexpected way, it's immediately obvious and breaks immersion.

We've spent some time thinking deeply about how to represent a physically correct throwing behavior, and have

come up with a few guidelines, enabled through updates to our platform, that we would like to share with you.

You can find an example of how we recommend to implement throwing here. This sample follows these four

guidelines:

Use the controller ’s Use the controller ’s velocityvelocity  instead of position instead of position. In the November update to Windows, we

introduced a change in behavior when in the ''Approximate'' positional tracking state. When in this state,

velocity information about the controller will continue to be reported for as long as we believe its high

accuracy, which is often longer than position remains high accuracy.

Incorporate the Incorporate the angular velocityangular velocity  of the controller of the controller . This logic is all contained in the throwing.cs  file

in the GetThrownObjectVelAngVel  static method, within the package linked above:

Vector3 radialVec = thrownObjectCenterOfMass - throwingControllerPos;
Vector3 tangentialVelocity = Vector3.Cross(throwingControllerAngularVelocity, radialVec);

1. As angular velocity is conserved, the thrown object must maintain the same angular velocity as it

had at the moment of the throw: objectAngularVelocity = throwingControllerAngularVelocity;

2. As the center of mass of the thrown object is likely not at the origin of the grip pose, it likely has a

different velocity than that of the controller in the frame of reference of the user. The portion of the

object’s velocity contributed in this way is the instantaneous tangential velocity of the center of

mass of the thrown object around the controller origin. This tangential velocity is the cross product

of the angular velocity of the controller with the vector representing the distance between the

controller origin and the center of mass of the thrown object.

3. The total velocity of the thrown object is the sum of velocity of the controller and this tangential

velocity: objectVelocity = throwingControllerVelocity + tangentialVelocity;

Pay close attention to the Pay close attention to the timetime at which we apply the velocity at which we apply the velocity . When a button is pressed, it can

take up to 20 ms for that event to bubble up through Bluetooth to the operating system. This means that

if you poll for a controller state change from pressed to not pressed or the other way around, the

controller pose information you get with it will actually be ahead of this change in state. Further, the

controller pose presented by our polling API is forward predicted to reflect a likely pose at the time the

frame will be displayed which could be more than 20 ms in the future. This is good for rendering held

objects, but compounds our time problem for targeting the object as we calculate the trajectory for the

https://github.com/Microsoft/MixedRealityToolkit-Unity/
https://github.com/Microsoft/MixedRealityToolkit-Unity/blob/htk_release/GettingStarted.md
https://github.com/keluecke/MixedRealityToolkit-Unity/blob/master/External/Unitypackages/ThrowingStarter.unitypackage
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 Follow along with tutorials

 Next Development Checkpoint

moment the user released the throw. Fortunately, with the November update, when a Unity event like

InteractionSourcePressed or InteractionSourceReleased is sent, the state includes the historical pose data

from back when the button was pressed or released. To get the most accurate controller rendering and

controller targeting during throws, you must correctly use polling and eventing, as appropriate:

For controller  renderingcontroller  rendering each frame, your app should position the controller's GameObject at the

forward-predicted controller pose for the current frame’s photon time. You get this data from Unity

polling APIs like XR.InputTracking.GetLocalPosition or

XR.WSA.Input.InteractionManager.GetCurrentReading.

For controller  targetingcontroller  targeting upon a press or release, your app should raycast and calculate trajectories

based on the historical controller pose for that press or release event. You get this data from Unity

eventing APIs, like InteractionManager.InteractionSourcePressed.

Use the gr ip poseUse the gr ip pose. Angular velocity and velocity are reported relative to the grip pose, not pointer pose.

Throwing will continue to improve with future Windows updates, and you can expect to find more information

on it here.

You can access gesture and motion controller from the input Manager.

Gesture in MRTK

Motion Controller in MRTK

Step-by-step tutorials, with more detailed customization examples, are available in the Mixed Reality Academy:

MR Input 211: Gesture

MR Input 213: Motion controllers

MR Input 213 - Motion controller

If you're following the Unity development journey we've laid out, you're in the midst of exploring the MRTK core

building blocks. From here, you can continue to the next building block:

Hand and eye tracking

Or jump to Mixed Reality platform capabilities and APIs:

Shared experiences

You can always go back to the Unity development checkpoints at any time.

https://docs.unity3d.com/ScriptReference/XR.InputTracking.GetLocalPosition.html
https://docs.unity3d.com/ScriptReference/XR.WSA.Input.InteractionManager.GetCurrentReading.html
https://docs.unity3d.com/ScriptReference/XR.WSA.Input.InteractionManager.InteractionSourcePressed.html
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/gestures
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/controllers
https://docs.microsoft.com/en-us/windows/mixed-reality/deprecated/mixed-reality-213
https://docs.microsoft.com/en-us/windows/mixed-reality/mixed-reality-213
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 Implementing head-gaze

  Example: Implement head-gazeExample: Implement head-gaze

void Update()
{
       RaycastHit hitInfo;
       if (Physics.Raycast(
               Camera.main.transform.position,
               Camera.main.transform.forward,
               out hitInfo,
               20.0f,
               Physics.DefaultRaycastLayers))
       {
           // If the Raycast has succeeded and hit a hologram
           // hitInfo's point represents the position being gazed at
           // hitInfo's collider GameObject represents the hologram being gazed at
       }
}

  Best practicesBest practices

 Visualizing head-gaze

 Head-gaze in the Mixed Reality Toolkit

 Next Development Checkpoint

Gaze is the primary way for users to target holograms your app creates in Mixed Reality.

Conceptually, you determine head-gaze by projecting a ray forward from the user's headset to see what it hits.

In Unity, the user's head position and direction are exposed through the Camera, specifically

UnityEngine.Camera.main.transform.forward and UnityEngine.Camera.main.transform.position.

Calling Physics.RayCast gives you a RaycastHit containing information about the collision, including the 3D

collision point and the other GameObject the head-gaze ray hit.

While the example above fires a single raycast from the update loop to find the target the user's head points at,

we recommended using a single object to manage all head-gaze processes. Combining your head-gaze logic

will save your app precious processing power and limit your raycasting to one per frame.

Just like with a mouse pointer on a computer, you should implement a cursor that represents the user's head-

gaze. Knowing what content a user is targeting increases confidence in what they're about to interact with.

You can access head-gaze from the Input Manager in MRTK.

If you're following the Unity development journey we've laid out, you're in the midst of exploring the MRTK core

building blocks. From here, you can continue to the next building block:

Motion controllers

Or jump to Mixed Reality platform capabilities and APIs:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/gaze-in-unity.md
https://docs.unity3d.com/ScriptReference/Camera-main.html
https://docs.unity3d.com/ScriptReference/Transform-forward.html
https://docs.unity3d.com/ScriptReference/Camera-main.html
https://docs.unity3d.com/ScriptReference/Transform-position.html
https://docs.unity3d.com/ScriptReference/Physics.Raycast.html
https://docs.unity3d.com/ScriptReference/RaycastHit.html
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/overview


 See also

Shared experiences

You can always go back to the Unity development checkpoints at any time.

Camera

Cursors

Head-gaze and commit
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C a u t i o nC a u t i o n

NOTENOTE

 Enabling the capability for Voice

 Phrase Recognition

  KeywordRecognizerKeywordRecognizer

using UnityEngine.Windows.Speech;
using System.Collections.Generic;
using System.Linq;

Before starting, consider using the Unity plug-in for the Cognitive Speech Services SDK. The plugin has better

Speech Accuracy results and easy access to speech-to-text decode, as well as advanced speech features like

dialog, intent based interaction, translation, text-to-speech synthesis, and natural language speech recognition.

To get started, check out the sample and documentation.

Unity exposes three ways to add Voice input to your Unity application, the first two of which are types of

PhraseRecognizer :

The KeywordRecognizer  supplies your app with an array of string commands to listen for

The GrammarRecognizer  gives your app an SRGS file defining a specific grammar to listen for

The DictationRecognizer  lets your app listen for any word and provide the user with a note or other display

of their speech

Dictation and phrase recognition can't be handled at the same time. If a GrammarRecognizer or KeywordRecognizer is

active, a DictationRecognizer can't be active and vice versa.

The MicrophoneMicrophone capability must be declared for an app to use Voice input.

1. In the Unity Editor, navigate to Edit > Project Settings > PlayerEdit > Project Settings > Player

2. Select the Windows StoreWindows Store tab

3. In the Publishing Settings > CapabilitiesPublishing Settings > Capabilities  section, check the MicrophoneMicrophone capability

4. Grant permissions to the app for microphone access on your HoloLens device

You'll be asked to do this on device startup, but if you accidentally clicked "no" you can change the

permissions in the device settings

To enable your app to listen for specific phrases spoken by the user then take some action, you need to:

1. Specify which phrases to listen for using a KeywordRecognizer  or GrammarRecognizer

2. Handle the OnPhraseRecognized  event and take action corresponding to the phrase recognized

Namespace:Namespace: UnityEngine.Windows.Speech

Types:Types: KeywordRecognizer, PhraseRecognizedEventArgs, SpeechError, SpeechSystemStatus

We'll need a few using statements to save some keystrokes:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/voice-input-in-unity.md
https://docs.microsoft.com/en-us/azure/cognitive-services/speech-service/quickstart-csharp-unity


KeywordRecognizer keywordRecognizer;
Dictionary<string, System.Action> keywords = new Dictionary<string, System.Action>();

//Create keywords for keyword recognizer
keywords.Add("activate", () =>
{
    // action to be performed when this keyword is spoken
});

keywordRecognizer = new KeywordRecognizer(keywords.Keys.ToArray());

keywordRecognizer.OnPhraseRecognized += KeywordRecognizer_OnPhraseRecognized;

private void KeywordRecognizer_OnPhraseRecognized(PhraseRecognizedEventArgs args)
{
    System.Action keywordAction;
    // if the keyword recognized is in our dictionary, call that Action.
    if (keywords.TryGetValue(args.text, out keywordAction))
    {
        keywordAction.Invoke();
    }
}

keywordRecognizer.Start();

  GrammarRecognizerGrammarRecognizer

<PROJECT_ROOT>/Assets/StreamingAssets/SRGS/myGrammar.xml

Then let's add a few fields to your class to store the recognizer and keyword->action dictionary:

Now add a keyword to the dictionary, for example in of a Start()  method. We're adding the "activate" keyword

in this example:

Create the keyword recognizer and tell it what we want to recognize:

Now register for the OnPhraseRecognized  event

An example handler is:

Finally, start recognizing!

Namespace:Namespace: UnityEngine.Windows.Speech

TypesTypes : GrammarRecognizer, PhraseRecognizedEventArgs, SpeechError, SpeechSystemStatus

The GrammarRecognizer is used if you're specifying your recognition grammar using SRGS. This can be useful if

your app has more than just a few keywords, if you want to recognize more complex phrases, or if you want to

easily turn on and off sets of commands. See: Create Grammars Using SRGS XML for file format information.

Once you have your SRGS grammar, and it is in your project in a StreamingAssets folder:

Create a GrammarRecognizer  and pass it the path to your SRGS file:

https://docs.microsoft.com/en-us/previous-versions/office/developer/speech-technologies/hh378349(v=office.14)
https://docs.unity3d.com/Manual/StreamingAssets.html


private GrammarRecognizer grammarRecognizer;
grammarRecognizer = new GrammarRecognizer(Application.streamingDataPath + "/SRGS/myGrammar.xml");

grammarRecognizer.OnPhraseRecognized += grammarRecognizer_OnPhraseRecognized;

private void Grammar_OnPhraseRecognized(PhraseRecognizedEventArgs args)
{
    SemanticMeaning[] meanings = args.semanticMeanings;
    // do something
}

grammarRecognizer.Start();

 Dictation

  Enabling the capability for dictationEnabling the capability for dictation

  DictationRecognizerDictationRecognizer

Now register for the OnPhraseRecognized  event

You'll get a callback containing information specified in your SRGS grammar, which you can handle

appropriately. Most of the important information will be provided in the semanticMeanings  array.

Finally, start recognizing!

Namespace:Namespace: UnityEngine.Windows.Speech

TypesTypes : DictationRecognizer, SpeechError, SpeechSystemStatus

Use the DictationRecognizer  to convert the user's speech to text. The DictationRecognizer exposes dictation

functionality and supports registering and listening for hypothesis and phrase completed events, so you can

give feedback to your user both while they speak and afterwards. Start()  and Stop()  methods respectively

enable and disable dictation recognition. Once done with the recognizer, it should be disposed using Dispose()

to release the resources it uses. It will release these resources automatically during garbage collection at an extra

performance cost if they aren't released before that.

There are only a few steps needed to get started with dictation:

1. Create a new DictationRecognizer

2. Handle Dictation events

3. Start the DictationRecognizer

The Internet ClientInternet Client and MicrophoneMicrophone capabilities must be declared for an app to use dictation:

1. In the Unity Editor, go to Edit > Project Settings > PlayerEdit > Project Settings > Player

2. Select on the Windows StoreWindows Store tab

3. In the Publishing Settings > CapabilitiesPublishing Settings > Capabilities  section, check the InternetClientInternetClient capability

4. Grant permissions to the app for microphone access on your HoloLens device if you haven't already

Optionally, if you didn't already enable the microphone, check the MicrophoneMicrophone capability

You'll be asked to do this on device startup, but if you accidentally clicked "no" you can change the

permissions in the device settings

Create a DictationRecognizer like so:



dictationRecognizer = new DictationRecognizer();

dictationRecognizer.DictationResult += DictationRecognizer_DictationResult;

private void DictationRecognizer_DictationResult(string text, ConfidenceLevel confidence)
{
    // do something
}

dictationRecognizer.DictationHypothesis += DictationRecognizer_DictationHypothesis;

private void DictationRecognizer_DictationHypothesis(string text)
{
    // do something
}

dictationRecognizer.DictationComplete += DictationRecognizer_DictationComplete;

There are four dictation events that can be subscribed to and handled to implement dictation behavior.

1. DictationResult

2. DictationComplete

3. DictationHypothesis

4. DictationError

DictationResultDictationResult

This event is fired after the user pauses, typically at the end of a sentence. The full recognized string is returned

here.

First, subscribe to the DictationResult  event:

Then handle the DictationResult callback:

DictationHypothesisDictationHypothesis

This event is fired continuously while the user is talking. As the recognizer listens, it provides text of what it's

heard so far.

First, subscribe to the DictationHypothesis  event:

Then handle the DictationHypothesis callback:

DictationCompleteDictationComplete

This event is fired when the recognizer stops, whether from Stop() being called, a timeout occurring, or some

other error.

First, subscribe to the DictationComplete  event:

Then handle the DictationComplete callback:



private void DictationRecognizer_DictationComplete(DictationCompletionCause cause)
{
   // do something
}

dictationRecognizer.DictationError += DictationRecognizer_DictationError;

private void DictationRecognizer_DictationError(string error, int hresult)
{
    // do something
}

dictationRecognizer.Start();

dictationRecognizer.DictationResult -= DictationRecognizer_DictationResult;
dictationRecognizer.DictationComplete -= DictationRecognizer_DictationComplete ;
dictationRecognizer.DictationHypothesis -= DictationRecognizer_DictationHypothesis ;
dictationRecognizer.DictationError -= DictationRecognizer_DictationError ;
dictationRecognizer.Dispose();

 Using both Phrase Recognition and Dictation

PhraseRecognitionSystem.Shutdown();

DictationErrorDictationError

This event is fired when an error occurs.

First, subscribe to the DictationError  event:

Then handle the DictationError callback:

Once you've subscribed and handled the dictation events that you care about, start the dictation recognizer to

begin receiving events.

If you no longer want to keep the DictationRecognizer around, you need to unsubscribe from the events and

Dispose the DictationRecognizer.

TipsTips

Start()  and Stop()  methods respectively enable and disable dictation recognition.

Once done with the recognizer, it must be disposed using Dispose()  to release the resources it uses. It will

release these resources automatically during garbage collection at an extra performance cost if they aren't

released before that.

Timeouts occur after a set period of time. You can check for these timeouts in the DictationComplete  event.

There are two timeouts to be aware of:

1. If the recognizer starts and doesn't hear any audio for the first five seconds, it will time out.

2. If the recognizer has given a result, but then hears silence for 20 seconds, it will time out.

If you want to use both phrase recognition and dictation in your app, you'll need to fully shut one down before

you can start the other. If you have multiple KeywordRecognizers running, you can shut them all down at once

with:



PhraseRecognitionSystem.Restart();

 Voice input in Mixed Reality Toolkit

 Next Development Checkpoint

You can call Restart()  to restore all recognizers to their previous state after the DictationRecognizer has

stopped:

You could also just start a KeywordRecognizer, which will restart the PhraseRecognitionSystem as well.

You can find MRTK examples for voice input in the following demo scenes:

Dictation

Speech

If you're following the Unity development checkpoint journey we've laid out, you're next task is exploring the

Mixed Reality platform capabilities and APIs:

Shared experiences

You can always go back to the Unity development checkpoints at any time.

https://github.com/microsoft/MixedRealityToolkit-Unity/tree/main/Assets/MRTK/Examples/Demos/Input/Scenes/Dictation
https://github.com/microsoft/MixedRealityToolkit-Unity/tree/main/Assets/MRTK/Examples/Demos/Input/Scenes/Speech


   

 

Text in Unity
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 Working with Unity's 3D Text (Text Mesh) and UI Text

Text is one of the most important components in holographic apps. To display text in Unity, there are three types

of text components you can use—UI Text, 3D Text Mesh, and Text Mesh Pro. By default, UI Text and 3D Text Mesh

appear blurry and are too large. Changing a few variables results in sharper, higher-quality text with a

manageable size in HoloLens. You can achieve better rendering quality by applying a scaling factor to get proper

dimensions when using the UI Text and 3D Text Mesh components.

Blurry default text in Unity

Unity assumes all new elements added to a scene are one Unity Unit in size, or 100% transform scale. One Unity

unit translates to about 1 meter on HoloLens. For fonts, the bounding box for a 3D TextMesh comes in by default

at about 1 meter in height.

Default Unity 3D Text (Text Mesh) occupies one Unity Unit, which is 1 meter

Most visual designers use points to define font sizes in the real world. There are about 2835

(2,834.645666399962) points in 1 meter. Based on the point system conversion to 1 meter and Unity's default

Text Mesh font size of 13, the simple math of 13 divided by 2835 equals 0.0046 (0.004586111116 to be exact)

which provides a good standard scale to start with (some may wish to round to 0.005). Scaling the text object or

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/text-in-unity.md


container to these values will not only allow for the 1:1 conversion of font sizes in a design program, but also

provides a standard so you can maintain consistency throughout your experience.

Scaling values for the Unity 3D Text and UI Text

Unity 3D Text Mesh with optimized values

When adding a UI or canvas-based text element to a scene, the size disparity is greater still. The differences in

the two sizes are about 1000%, which would bring the scale factor for UI-based text components to 0.00046

(0.0004586111116 to be exact) or 0.0005 for the rounded value.



NOTENOTE

 Working with Text Mesh Pro

 Recommended text size

Unity UI Text with optimized values

The default value of any font may be affected by the texture size of that font or how the font was imported into Unity.

These tests were performed based on the default Arial font in Unity, as well as one other imported font.

With Unity's Text Mesh Pro, you can secure the text rendering quality. It supports crisp text outlines regardless of

the distance using the Signed Distance Field (SDF) technique. Using the same calculation method that we used

above for the 3D Text Mesh and UI Text, we can find the proper scaling values to use with conventional

typographic points. Since the default 3D Text Mesh Pro font with the size of 36 has a bounding size of 2.5 Unity

units (2.5 m), we can use a scaling value of 0.005 to get the point size. The Text Mesh Pro under the UI menu has

a default bounding size of 25 Unity units (25 m). This gives us 0.0005 for the scaling value.

Scaling values for the Unity 3D Text and UI

As you can expect, type sizes that we use on a PC or a tablet device (typically between 12–32pt) look small at a

https://steamcdn-a.akamaihd.net/apps/valve/2007/SIGGRAPH2007_AlphaTestedMagnification.pdf


  The minimum legible font sizeThe minimum legible font size

DISTA N C EDISTA N C E VIEW IN G A N GL EVIEW IN G A N GL E T EXT  H E IGH TT EXT  H E IGH T F O N T  SIZ EF O N T  SIZ E

45 cm (direct manipulation
distance)

0.4°-0.5° 3.14–3.9mm 8.9–11.13pt

2 m 0.35°-0.4° 12.21–13.97mm 34.63-39.58 pt

  The comfortably legible font sizeThe comfortably legible font size

DISTA N C EDISTA N C E VIEW IN G A N GL EVIEW IN G A N GL E T EXT  H E IGH TT EXT  H E IGH T F O N T  SIZ EF O N T  SIZ E

45 cm (direct manipulation
distance)

0.65°-0.8° 5.1-6.3 mm 14.47-17.8 pt

2 m 0.6°-0.75° 20.9-26.2 mm 59.4-74.2 pt

distance of 2 meters. It depends on the characteristics of each font, but in general the recommended minimum

viewing angle and the font height for legibility are around 0.35°-0.4°/12.21-13.97 mm based on our user

research studies. It's about 35-40 pt with the scaling factor introduced above.

For the near interaction at 0.45 m (45 cm), the minimum legible font's viewing angle and the height are 0.4°-0.5°

/ 3.14–3.9mm. It's about 9-12 pt with the scaling factor introduced above.

Content at near and far interaction range

Segoe UI (the default font for Windows) works well in most cases. However, avoid using light or semi light font

families in small size since thin vertical strokes will vibrate and it will degrade the legibility. Modern fonts with

enough stroke thickness work well. For example, Helvetica and Arial look gorgeous and are legible in HoloLens

with regular or bold weights.



 Text with Mixed Reality Toolkit v2
  Sharp text rendering quality with proper dimensionSharp text rendering quality with proper dimension

  Shader with occlusion supportShader with occlusion support

Viewing distance, angle, and text height

Based on these scaling factors, we have created text prefabs with UI Text and 3D Text Mesh. Developers can use

these prefabs to get sharp text and consistent font size.

Sharp text rendering quality with proper dimension

Unity's default font material doesn't support occlusion. Because of this, you'll see the text behind the objects by

default. We've included a simple shader that supports the occlusion. The image below shows the text with

default font material (left) and the text with proper occlusion (right).

https://github.com/microsoft/MixedRealityToolkit-Unity/tree/main/Assets/MRTK/SDK/StandardAssets/Prefabs/Text
https://github.com/microsoft/MixedRealityToolkit-Unity/blob/main/Assets/MRTK/StandardAssets/Shaders/Text3DShader.shader


 Next Development Checkpoint

 See also

Shader with occlusion support

If you're following the Unity development journey we've laid out, you're in the midst of exploring the MRTK core

building blocks. From here, you can continue to the next building block:

Voice input

Or jump to Mixed Reality platform capabilities and APIs:

Shared experiences

You can always go back to the Unity development checkpoints at any time.

Text Prefab in the MRTK

Typography

https://github.com/microsoft/MixedRealityToolkit-Unity/tree/main/Assets/MRTK/SDK/StandardAssets/Prefabs/Text
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 Where do I get the SDK?

 Conceptual Overview
  The SceneThe Scene

Scene understanding transforms the unstructured environment sensor data that your Mixed Reality device

captures and converts it into a powerful abstract representation. The SDK acts as the communication layer

between your application and the Scene Understanding runtime. It's aimed to mimic existing standard

constructs, such as 3D scene graphs for 3D representations, and 2D rectangles and panels for 2D applications.

While the constructs Scene Understanding mimics will map to concrete frameworks, in general

SceneUnderstanding is framework agnostic allowing for interoperability between varied frameworks that

interact with it. As Scene Understanding evolves the role of the SDK is to ensure new representations and

capabilities continue to be exposed within a unified framework. In this document, we will first introduce high-

level concepts that will help you get familiar with the development environment/usage and then provide more

detailed documentation for specific classes and constructs.

The SceneUnderstanding SDK is downloadable via the Mixed Reality Feature Tool.

Note:Note: the latest release depends on preview packages and you'll need to enable pre-release packages to see it.

For version 0.5.2022-rc and later, Scene Understanding supports language projections for C# and C++ allowing

applications to develop applications for Win32 or UWP platforms. As of this version, SceneUnderstanding

supports unity in-editor support barring the SceneObserver, which is used solely for communicating with

HoloLens2.

SceneUnderstanding requires Windows SDK version 18362 or higher.

Your mixed reality device is constantly integrating information about what it sees in your environment. Scene

Understanding funnels all of these data sources and produces one single cohesive abstraction. Scene

Understanding generates Scenes, which are a composition of SceneObjects that represent an instance of a

single thing, (for example, a wall/ceiling/floor.) Scene Objects themselves are a composition of

[SceneComponents, which represent more granular pieces that make up this SceneObject. Examples of

components are quads and meshes, but in the future could represent bounding boxes, collision meshes,

metadata etc.

The process of converting the raw sensor data into a Scene is a potentially expensive operation that could take

seconds for medium spaces (~10x10m) to minutes for large spaces (~50x50m) and therefore it is not

something that is being computed by the device without application request. Instead, Scene generation is

triggered by your application on demand. The SceneObserver class has static methods that can Compute or

Deserialize a scene, which you can then enumerate/interact with. The "Compute" action is executed on-demand

and executes on the CPU but in a separate process (the Mixed Reality Driver). However, while we do compute in

another process the resulting Scene data is stored and maintained in your application in the Scene object.

Below is a diagram that illustrates this process flow and shows examples of two applications interfacing with the

Scene Understanding runtime.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/scene-understanding-SDK.md
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On the left-hand side is a diagram of the mixed reality runtime, which is always on and running in its own

process. This runtime is responsible for performing device tracking, spatial mapping, and other operations that

Scene Understanding uses to understand and reason about the world around you. On the right side of the

diagram, we show two theoretical applications that make use of Scene Understanding. The first application

interfaces with MRTK, which uses the Scene Understanding SDK internally, the second app computes and uses

two separate scene instances. All three Scenes in this diagram generate distinct instances of the scenes, the

driver isn't tracking global state that is shared between applications and Scene Objects in one scene aren't found

in another. Scene Understanding does provide a mechanism to track over time, but this is done using the SDK.

Tracking code is already running in the SDK in your app's process.

Because each Scene stores its data in your application's memory space, you can assume that all functions of the

Scene object or its internal data are always executed in your application's process.

To work with Scene Understanding, it may be valuable to know and understand how the runtime represents

components logically and physically. The Scene represents data with a specific layout that was chosen to be

simple while maintaining an underlying structure that is pliable to meet future requirements without needing

major revisions. The Scene does this by storing all Components (building blocks for all Scene Objects) in a flat

list and defining hierarchy and composition through references where specific components reference others.

Below we present an example of a structure in both its flat and logical form.



 API overview

  SceneComponentsSceneComponents

  SceneObjectsSceneObjects

SC EN EO B JEC T K IN DSC EN EO B JEC T K IN D DESC RIP T IO NDESC RIP T IO N

Scene

SceneObject_3

SceneObject_1

SceneObject_2

SceneMesh_1

SceneQuad_1

SceneQuad_2

SceneQuad_1

SceneQuad_3

SceneMesh_3

SceneObject_1

SceneObject_2

SceneObject_3

SceneQuad_1

SceneQuad_2

SceneQuad_3

SceneMesh_1

SceneMesh_2

This illustration highlights the difference between the physical and logical layout of the Scene. On the left, we

see the hierarchical layout of the data that your application sees when enumerating the scene. On the right, we

see that the scene is comprised of 12 distinct components that are accessible individually if necessary. When

processing a new scene, we expect applications to walk this hierarchy logically, however when tracking between

scene updates, some applications may only be interested in targeting specific components that are shared

between two scenes.

The following section provides a high-level overview of the constructs in Scene Understanding. Reading this

section will give you an understanding of how scenes are represented, and what the various components do/are

used for. The next section will provide concrete code examples and additional details that are glossed over in this

overview.

All of the types described below reside in the Microsoft.MixedReality.SceneUnderstanding  namespace.

Now that you understand the logical layout of scenes, we can present the concept of SceneComponents and

how they're used to compose hierarchy. SceneComponents are the most granular decompositions in

SceneUnderstanding representing a single core thing, for example, a mesh or a quad or a bounding box.

SceneComponents are things that can update independently and can be referenced by other SceneComponents,

hence they have a single global property, a unique ID, that allow for this type of tracking/referencing

mechanism. IDs are used for the logical composition of scene hierarchy as well as object persistence (the act of

updating one scene relative to another).

If you're treating every newly computed scene as being distinct, and simply enumerating all data within it, then

IDs are largely transparent to you. However, if you're planning to track components over several updates, you'll

use the IDs to index and find SceneComponents between Scene objects.

A SceneObject is a SceneComponent that represents an instance of a "thing" for example, a wall, a floor, a

ceiling, etc.... expressed by their Kind property. SceneObjects are geometric, and therefore have functions and

properties that represent their location in space, however they don't contain any geometric or logical structure.

Instead, SceneObjects reference other SceneComponents, specifically SceneQuads, and SceneMeshes, which

provide the varied representations that are supported by the system. When a new scene is computed, your

application will most likely enumerate the Scene's SceneObjects to process what it's interested in.

SceneObjects can have any one of the following:



Background The SceneObject is known to be notnot  one of the other
recognized kinds of scene object. This class shouldn't be
confused with Unknown where Background is known not to
be wall/floor/ceiling etc.... while unknown isn't yet
categorized.

Wall A physical wall. Walls are assumed to be immovable
environmental structures.

Floor Floors are any surfaces on which one can walk. Note: stairs
aren't floors. Also note, that floors assume any walkable
surface and therefore there's no explicit assumption of a
singular floor. Multi-level structures, ramps etc.... should all
classify as floor.

Ceiling The upper surface of a room.

Platform A large flat surface on which you could place holograms.
These tend to represent tables, countertops, and other large
horizontal surfaces.

World A reserved label for geometric data that is agnostic to
labeling. The mesh generated by setting the
EnableWorldMesh update flag would be classified as world.

Unknown This scene object has yet to be classified and assigned a kind.
This shouldn't be confused with Background, as this object
could be anything, the system has just not come up with a
strong enough classification for it yet.

  SceneMeshSceneMesh

  Winding Order and Coordinate SystemsWinding Order and Coordinate Systems

  SceneQuadSceneQuad

  SceneQuad shapeSceneQuad shape

A SceneMesh is a SceneComponent that approximates the geometry of arbitrary geometric objects using a

triangle list. SceneMeshes are used in several different contexts; they can represent components of the

watertight cell structure or as the WorldMesh, which represents the unbounded spatial mapping mesh

associated with the Scene. The index and vertex data provided with each mesh uses the same familiar layout as

the vertex and index buffers that are used for rendering triangle meshes in all modern rendering APIs. In Scene

Understanding, meshes use 32-bit indices and may need to be broken up into chunks for certain rendering

engines.

All meshes produced by Scene Understanding are expected to return meshes in a Right-Handed coordinate

system using clockwise winding order.

Note: OS builds prior to .191105 may have a known bug where "World" meshes were returning in Counter-

Clockwise winding order, which has subsequently been fixed.

A SceneQuad is a SceneComponent that represents 2d surfaces that occupy the 3D world. SceneQuads can be

used similarly to ARKit ARPlaneAnchor or ARCore Planes but they offer more high-level functionality as 2d

canvases to be used by flat apps, or augmented UX. 2D specific APIs are provided for quads that make

placement and layout simple to use, and developing (with the exception of rendering) with quads should feel

more akin to working with 2d canvases than 3d meshes.

SceneQuads define a bounded rectangular surface in 2d. However, SceneQuads are representing surfaces with

arbitrary and potentially complex shapes (e.g. a donut shaped table.) To represent the complex shape of the

https://docs.microsoft.com/en-us/windows/win32/direct3d9/rendering-from-vertex-and-index-buffers


 Scene understanding SDK details and reference

NOTENOTE
When using MRTK, please note you will be interacting with MRTK's [`WindowsSceneUnderstandingObserver`]

(xref:Microsoft.MixedReality.Toolkit.WindowsSceneUnderstanding.Experimental.WindowsSceneUnderstandingObserver) and

thus may skip this section under most circumstances. Please refer to the [MRTK Scene Understanding docs](/windows/mixed-

reality/mrtk-unity/features/spatial-awareness/scene-understanding) for more information.

  InitializationInitialization

if (!SceneObserver.IsSupported())
{
    // Handle the error
}

// This call should grant the access we need.
await SceneObserver.RequestAccessAsync();

// Create Query settings for the scene update
SceneQuerySettings querySettings;

querySettings.EnableSceneObjectQuads = true;                                       // Requests that the 
scene updates quads.
querySettings.EnableSceneObjectMeshes = true;                                      // Requests that the 
scene updates watertight mesh data.
querySettings.EnableOnlyObservedSceneObjects = false;                              // Do not explicitly turn 
off quad inference.
querySettings.EnableWorldMesh = true;                                              // Requests a static 
version of the spatial mapping mesh.
querySettings.RequestedMeshLevelOfDetail = SceneMeshLevelOfDetail.Fine;            // Requests the finest 
LOD of the static spatial mapping mesh.

// Initialize a new Scene
Scene myScene = SceneObserver.ComputeAsync(querySettings, 10.0f).GetAwaiter().GetResult();

  Initialization from Data (also known as. the PC Path)Initialization from Data (also known as. the PC Path)

surface of a quad you may use the GetSurfaceMask API to render the shape of the surface onto an image buffer

you provide. If the SceneObject that has the quad also has a mesh, the mesh triangles should be equivalent to

this rendered image, they both represent real geometry of the surface, either in 2d or 3d coordinates.

The following section will help get you familiar with the basics of SceneUnderstanding. This section should

provide you with the basics, at which point you should have enough context to browse through the sample

applications to see how SceneUnderstanding is used holistically.

The first step to working with SceneUnderstanding is for your application to gain reference to a Scene object.

This can be done in one of two ways, a Scene can either be computed by the driver, or an existing Scene that was

computed in the past can be de-serialized. The latter is useful for working with SceneUnderstanding during

development, where applications and experiences can be prototyped quickly without a mixed reality device.

Scenes are computed using a SceneObserver. Before creating a Scene, your application should query your

device to ensure that it supports SceneUnderstanding, as well as to request user access for information that

SceneUnderstanding needs.

If RequestAccessAsync() is not called, computing a new Scene will fail. Next we will compute a new scene that's

rooted around the Mixed Reality headset and has a 10-meter radius.

While Scenes can be computed for direct consumption, they can also be computed in serialized form for later



// Create Query settings for the scene update
SceneQuerySettings querySettings;

// Compute a scene but serialized as a byte array
SceneBuffer newSceneBuffer = SceneObserver.ComputeSerializedAsync(querySettings, 
10.0f).GetAwaiter().GetResult();

// If we want to use it immediately we can de-serialize the scene ourselves
byte[] newSceneData = new byte[newSceneBuffer.Size];
newSceneBuffer.GetData(newSceneData);
Scene mySceneDeSerialized = Scene.Deserialize(newSceneData);

// Save newSceneData for later

  SceneObject EnumerationSceneObject Enumeration

SceneObject firstFloor = null;

// Find the first floor object
foreach (var sceneObject in myScene.SceneObjects)
{
    if (sceneObject.Kind == SceneObjectKind.Floor)
    {
        firstFloor = sceneObject;
        break;
    }
}

  Component update and refinding componentsComponent update and refinding components

// Compute a new scene, and tell the system that we want to compute relative to the previous scene
Scene myNextScene = SceneObserver.ComputeAsync(querySettings, 10.0f, myScene).GetAwaiter().GetResult();

// Use the Id for the floor we found last time, and find it again
firstFloor = (SceneObject)myNextScene.FindComponent(firstFloor.Id);

if (firstFloor != null)
{
    // We found it again, we can now update the transforms of all objects we attached to this floor 
transform
}

 Accessing Meshes and Quads from Scene Objects

use. This has proven to be useful for development as it allows developers to work in and test Scene

Understanding without the need for a device. The act of serializing a scene is nearly identical to computing it, the

data is returned to your application instead of being deserialized locally by the SDK. You may then deserialize it

yourself or save it for future use.

Now that your application has a scene, your application will be looking at and interacting with SceneObjects.

This is done by accessing the SceneObjectsSceneObjects  property:

There's another function that retrieves components in the Scene called FindComponentFindComponent. This function is useful

when updating tracking objects and finding them in later scenes. The following code will compute a new scene

relative to a previous scene and then find the floor in the new scene.

Once SceneObjects have been found your application will most likely want to access the data that is contained in

the quads/meshes that it is composed of. This data is accessed with the QuadsQuads  and MeshesMeshes  properties. The

following code will enumerate all quads and meshes of our floor object.



// Get the transform for the SceneObject
System.Numerics.Matrix4x4 objectToSceneOrigin = firstFloor.GetLocationAsMatrix();

// Enumerate quads
foreach (var quad in firstFloor.Quads)
{
    // Process quads
}

// Enumerate meshes
foreach (var mesh in firstFloor.Meshes)
{
    // Process meshes
}

  Dealing with TransformsDealing with Transforms

Notice that it's the SceneObject that has the transform that is relative to the Scene origin. This is because the

SceneObject represents an instance of a "thing" and is locatable in space, the quads, and meshes represent

geometry that is transformed relative to their parent. It's possible for separate SceneObjects to reference the

same SceneMesh/SceneQuad SceneComponents, and it's also possible that a SceneObject has more than one

SceneMesh/SceneQuad.

Scene Understanding has made a deliberate attempt to align with traditional 3D scene representations when

dealing with transforms. Each Scene is therefore confined to a single coordinate system much like most

common 3D environmental representations. SceneObjects each provide their location relative to that coordinate

system. If your application is dealing with Scenes that stretch the limit of what a single origin provides it can

anchor SceneObjects to SpatialAnchors, or generate several scenes and merge them together, but for simplicity

we assume that watertight scenes exist in their own origin that's localized by one NodeId defined by

Scene.OriginSpatialGraphNodeId.

The following Unity code, for example, shows how to use Windows Perception and Unity APIs to align

coordinate systems together. See SpatialCoordinateSystem and SpatialGraphInteropPreview for details on the

Windows Perception APIs, and Mixed Reality native objects in Unity for details on obtaining a

SpatialCoordinateSystem that corresponds to Unity's world origin.

https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialcoordinatesystem
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.preview.spatialgraphinteroppreview
https://docs.microsoft.com/en-us/windows/mixed-reality/unity-xrdevice-advanced


private System.Numerics.Matrix4x4? GetSceneToUnityTransformAsMatrix4x4(SceneUnderstanding.Scene scene)
{
    System.Numerics.Matrix4x4? sceneToUnityTransform = System.Numerics.Matrix4x4.Identity;

    
    Windows.Perception.Spatial.SpatialCoordinateSystem sceneCoordinateSystem = 
Microsoft.Windows.Perception.Spatial.Preview.SpatialGraphInteropPreview.CreateCoordinateSystemForNode(scene.
OriginSpatialGraphNodeId);
    Windows.Perception.Spatial.SpatialCoordinateSystem unityCoordinateSystem = 
Microsoft.Windows.Perception.Spatial.SpatialCoordinateSystem.FromNativePtr(UnityEngine.XR.WindowsMR.WindowsM
REnvironment.OriginSpatialCoordinateSystem);

    sceneToUnityTransform = sceneCoordinateSystem.TryGetTransformTo(unityCoordinateSystem);

    if (sceneToUnityTransform != null)
    {
        sceneToUnityTransform = ConvertRightHandedMatrix4x4ToLeftHanded(sceneToUnityTransform.Value);
    }
    else
    {
        return null;
    }
            
    return sceneToUnityTransform;
}

Each SceneObject  has a transform, which is then applied to that object. In Unity we convert to right handed

coordinates and assign local transforms as so:



private System.Numerics.Matrix4x4 ConvertRightHandedMatrix4x4ToLeftHanded(System.Numerics.Matrix4x4 matrix)
{
    matrix.M13 = -matrix.M13;
    matrix.M23 = -matrix.M23;
    matrix.M43 = -matrix.M43;

    matrix.M31 = -matrix.M31;
    matrix.M32 = -matrix.M32;
    matrix.M34 = -matrix.M34;

    return matrix;
}

 private void SetUnityTransformFromMatrix4x4(Transform targetTransform, System.Numerics.Matrix4x4 matrix, 
bool updateLocalTransformOnly = false)
 {
    if(targetTransform == null)
    {
        return;
    }

    Vector3 unityTranslation;
    Quaternion unityQuat;
    Vector3 unityScale;

    System.Numerics.Vector3 vector3;
    System.Numerics.Quaternion quaternion;
    System.Numerics.Vector3 scale;

    System.Numerics.Matrix4x4.Decompose(matrix, out scale, out quaternion, out vector3);

    unityTranslation = new Vector3(vector3.X, vector3.Y, vector3.Z);
    unityQuat        = new Quaternion(quaternion.X, quaternion.Y, quaternion.Z, quaternion.W);
    unityScale       = new Vector3(scale.X, scale.Y, scale.Z);

    if(updateLocalTransformOnly)
    {
        targetTransform.localPosition = unityTranslation;
        targetTransform.localRotation = unityQuat;
    }
    else
    {
        targetTransform.SetPositionAndRotation(unityTranslation, unityQuat);
    }
}

// Assume we have an SU object called suObject and a unity equivalent unityObject

System.Numerics.Matrix4x4 converted4x4LocationMatrix = 
ConvertRightHandedMatrix4x4ToLeftHanded(suObject.GetLocationAsMatrix());
SetUnityTransformFromMatrix4x4(unityObject.transform, converted4x4LocationMatrix, true);
        

  QuadQuad
Quads were designed to help 2D placement scenarios and should be thought of as extensions to 2D canvas UX

elements. While Quads are components of SceneObjects and can be rendered in 3D, the Quad APIs themselves

assume Quads are 2D structures. They offer information such as extent, shape, and provide APIs for placement.

Quads have rectangular extents, but they represent arbitrarily shaped 2D surfaces. To enable placement on these

2D surfaces that interact with the 3D environment quads offer utilities to make this interaction possible.

Currently Scene Understanding provides two such functions, FindCentermostPlacementFindCentermostPlacement and

GetSurfaceMaskGetSurfaceMask . FindCentermostPlacement is a high-level API that locates a position on the quad where an

object can be placed and will try to find the best location for your object guaranteeing that the bounding box



NOTENOTE

// This code assumes you already have a "Root" object that attaches the Scene's Origin.

// Find the first quad
foreach (var sceneObject in myScene.SceneObjects)
{
    // Find a wall
    if (sceneObject.Kind == SceneObjectKind.Wall)
    {
        // Get the quad
        var quads = sceneObject.Quads;
        if (quads.Count > 0)
        {
            // Find a good location for a 1mx1m object  
            System.Numerics.Vector2 location;
            if (quads[0].FindCentermostPlacement(new System.Numerics.Vector2(1.0f, 1.0f), out location))
            {
                // We found one, anchor something to the transform
                // Step 1: Create a new game object for the quad itself as a child of the scene root
                // Step 2: Set the local transform from quads[0].Position and quads[0].Orientation
                // Step 3: Create your hologram and set it as a child of the quad's game object
                // Step 4: Set the hologram's local transform to a translation (location.x, location.y, 0)
            }
        }
    }
}

  MeshMesh

void GetTriangleIndices(int[] indices);
void GetVertices(System.Numerics.Vector3[] vertices);

uint[] indices = new uint[mesh.TriangleIndexCount];
System.Numerics.Vector3[] positions = new System.Numerics.Vector3[mesh.VertexCount];

mesh.GetTriangleIndices(indices);
mesh.GetVertexPositions(positions);

you provide will stay on the underlying surface.

The coordinates of the output are relative to the quad in "quad space" with the top left corner being (x = 0, y = 0), just as

it would be with other windows Rect types. Be sure to take this into account when working with the origins of your own

objects.

The following example shows how to find the centermost placeable location and anchor a hologram to the quad.

Steps 1-4 are highly dependent on your particular framework/implementation, but the themes should be

similar. It's important to note that the Quad simply represents a bounded 2D plane that is localized in space. By

having your engine/framework know where the quad is and rooting your objects relative to the quad, your

holograms will be located correctly with respect to the real world.

Meshes represent geometric representations of objects or environments. Much like spatial mapping, mesh index

and vertex data provided with each spatial surface mesh uses the same familiar layout as the vertex and index

buffers that are used for rendering triangle meshes in all modern rendering APIs. Vertex positions are provided

in the coordinate system of the Scene . The specific APIs used to reference this data are as follows:

The following code provides an example of generating a triangle list from the mesh structure:



  ColliderMeshColliderMesh

 Developing with scene understanding

  Where can I get sample code?Where can I get sample code?

  Where can I get sample scenes?Where can I get sample scenes?

 See also

The index/vertex buffers must be >= the index/vertex counts, but otherwise can be arbitrarily sized allowing for

efficient memory reuse.

Scene objects provide access to mesh and collider mesh data via the Meshes and ColliderMeshes properties.

These meshes will always match, meaning that the i'th index of the Meshes property represents the same

geometry as the i'th index of the ColliderMeshes property. If the runtime/object supports collider meshes, you

are guaranteed to get the lowest polygon, highest order approximation and it's good practice to use

ColliderMeshes wherever your application would use colliders. If the system does not support colliders the

Mesh object returned in ColliderMeshes will be the same object as the mesh reducing memory constraints.

At this point, you should understand the core building blocks of the scene understanding runtime and SDK. The

bulk of the power and complexity lies in access patterns, interaction with 3D frameworks, and tools that can be

written on top of these APIs to do more advanced tasks like spatial planning, room analysis, navigation, physics,

and so on. We hope to capture these in samples that should hopefully guide you in the proper direction to make

your scenarios shine. If there are samples or scenarios we aren't addressing, let us know and we'll try to

document/prototype what you need.

Scene Understanding sample code for Unity can be found on our Unity Sample Page page. This application will

allow you to communicate with your device and render the various scene objects, or, it will allow you to load a

serialized scene on your PC and allow you to experience Scene Understanding without a device.

If you have a HoloLens2, you can save any scene you've captured by saving the output of

ComputeSerializedAsync to file and deserializing it at your own convenience.

If you don't have a HoloLens2 device but want to play with Scene Understanding, you'll need to download a pre-

captured scene. The Scene Understanding sample currently ships with serialized scenes that can be downloaded

and used at your own convenience. You can find them here:

Scene Understanding Sample Scenes

Spatial mapping

Scene understanding

Unity Sample

https://github.com/sceneunderstanding-microsoft/unitysample
https://github.com/microsoft/MixedReality-SceneUnderstanding-Samples
https://github.com/microsoft/MixedReality-SceneUnderstanding-Samples
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Spatial mapping ✔️ ✔️ ❌

 Setting the SpatialPerception capability

NOTENOTE

 How to add mapping in Unity
 

Spatial mapping lets you retrieve triangle meshes that represent the surfaces in the world around a HoloLens

device. You can use surface data for placement, occlusion, and room analysis to give your Unity projects an extra

dose of immersion.

Unity includes full support for spatial mapping, which is exposed to developers in the following ways:

1. Spatial mapping components available in the MixedRealityToolkit, which provide a convenient and rapid path

for getting started with spatial mapping

2. Lower-level spatial mapping APIs, which provide full control and enable more sophisticated application-

specific customization

To use spatial mapping in your app, the SpatialPerception capability needs to be set in your AppxManifest.

In order for an app to consume spatial mapping data, the SpatialPerception capability must be enabled.

How to enable the SpatialPerception capability:

1. In the Unity Editor, open the "Player Settings""Player Settings" pane (Edit > Project Settings > Player)

2. Select on the "Windows Store""Windows Store" tab

3. Expand "Publishing Settings""Publishing Settings" and check the "SpatialPerception""SpatialPerception" capability in the "Capabilities""Capabilities" list

If you have already exported your Unity project to a Visual Studio solution, you will need to either export to a new folder

or manually set this capability in the AppxManifest in Visual Studio.

Spatial mapping also requires a MaxVersionTested of at least 10.0.10586.0:

1. In Visual Studio, right-click on Package.appxmanifestPackage.appxmanifest in the Solution Explorer and select View CodeView Code

2. Find the line specifying TargetDeviceFamilyTargetDeviceFamily  and change MaxVersionTested="10.0.10240.0"MaxVersionTested="10.0.10240.0" to

MaxVersionTested="10.0.10586.0"MaxVersionTested="10.0.10586.0"

3. SaveSave the Package.appxmanifest.

MRTK

XR SDK

Legacy WSA

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/spatial-mapping-in-unity.md
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


 

 Spatial awareness system

 Higher-level mesh analysis: Spatial Understanding
C a u t i o nC a u t i o n

  Spatial UnderstandingSpatial Understanding

  Understanding ModulesUnderstanding Modules

  Ray CastingRay Casting

In MRTK, look at the Spatial awareness getting started guide for information on setting up various spatial mesh

observers.

For information on on-device observers, look at the Configuring mesh observers for device guide.

For information on scene understanding observers, look at the Scene understanding observer guide.

Spatial Understanding has been deprecated in favor of Scene Understanding.

The MixedRealityToolkit is a collection of utility code for holographic development built on Unity's holographic

APIs.

When placing holograms in the physical world, it's often desirable to go beyond spatial mapping's mesh and

surface planes. When placement is done procedurally, a higher level of environmental understanding is

desirable. This usually requires making decisions about what is floor, ceiling, and walls. You also have the ability

to optimize against a set of placement constraints to determine the best physical locations for holographic

objects.

During development of Young Conker and Fragments, Asobo Studios faced this problem head on by developing

a room solver. Each of these games had game-specific needs, but they shared core spatial understanding

technology. The HoloToolkit.SpatialUnderstanding library encapsulates this technology, allowing you to quickly

find empty spaces on the walls, place objects on the ceiling, identify placed for character to sit, and a myriad of

other spatial understanding queries.

All of the source code is included, allowing you to customize it to your needs and share your improvements with

the community. The code for the C++ solver has been wrapped into a UWP dll and exposed to Unity with a drop

in prefab contained within the MixedRealityToolkit.

There are three primary interfaces exposed by the module: topology for simple surface and spatial queries,

shape for object detection, and the object placement solver for constraint-based placement of object sets. Each

of these is described below. In addition to the three primary module interfaces, a ray casting interface can be

used to retrieve tagged surface types and a custom watertight playspace mesh can be copied out.

After the room scan is completed, labels are internally generated for surfaces like the floor, ceiling, and walls. The

PlayspaceRaycast  function takes a ray and returns if the ray collides with a known surface and if so, information

about that surface in the form of a RaycastResult .

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/spatial-awareness/spatial-awareness-getting-started
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/spatial-awareness/configuring-spatial-awareness-mesh-observer
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/spatial-awareness/scene-understanding
https://github.com/Microsoft/MixedRealityToolkit-Unity


struct RaycastResult
{
    enum SurfaceTypes
    {
        Invalid,    // No intersection
        Other,
        Floor,
        FloorLike,  // Not part of the floor topology,
                    //  but close to the floor and looks like the floor
        Platform,   // Horizontal platform between the ground and
                    //  the ceiling
        Ceiling,
        WallExternal,
        WallLike,   // Not part of the external wall surface,
                    //  but vertical surface that looks like a
                    //  wall structure
    };
    SurfaceTypes SurfaceType;
    float SurfaceArea;  // Zero if unknown
                        //  (i.e. if not part of the topology analysis)
    DirectX::XMFLOAT3 IntersectPoint;
    DirectX::XMFLOAT3 IntersectNormal;
};

  Topology QueriesTopology Queries

NOTENOTE

Internally, the raycast is computed against the computed 8-cm cubed voxel representation of the playspace. Each

voxel contains a set of surface elements with processed topology data (aka surfels). The surfels contained within

the intersected voxel cell is compared and the best match used to look up the topology information. This

topology data contains the labeling returned in the form of the “SurfaceTypes” enum, as well as the surface area

of the intersected surface.

In the Unity sample, the cursor casts a ray each frame. First, against Unity’s colliders. Second, against the

understanding module’s world representation. And finally, again UI elements. In this application, UI gets priority,

next the understanding result, and lastly, Unity’s colliders. The SurfaceType is reported as text next to the cursor.

Surface type is labeled next to the cursor

Within the DLL, the topology manager handles labeling of the environment. As mentioned above, much of the

data is stored within surfels, contained within a voxel volume. In addition, the “PlaySpaceInfos” structure is used

to store information about the playspace, including the world alignment (more details on this below), floor, and

ceiling height. Heuristics are used for determining floor, ceiling, and walls. For example, the largest and lowest

horizontal surface with greater than 1-m2 surface area is considered the floor.

The camera path during the scanning process is also used in this process.

A subset of the queries exposed by the Topology manager are exposed out through the dll. The exposed

topology queries are as follows.



QueryTopology_FindPositionsOnWalls
QueryTopology_FindLargePositionsOnWalls
QueryTopology_FindLargestWall
QueryTopology_FindPositionsOnFloor
QueryTopology_FindLargestPositionsOnFloor
QueryTopology_FindPositionsSittable

EXTERN_C __declspec(dllexport) int QueryTopology_FindPositionsOnWalls(
    _In_ float minHeightOfWallSpace,
    _In_ float minWidthOfWallSpace,
    _In_ float minHeightAboveFloor,
    _In_ float minFacingClearance,
    _In_ int locationCount,
    _Inout_ Dll_Interface::TopologyResult* locationData)

struct TopologyResult
{
    DirectX::XMFLOAT3 position;
    DirectX::XMFLOAT3 normal;
    float width;
    float length;
};

NOTENOTE

  Shape QueriesShape Queries

Each of the queries has a set of parameters, specific to the query type. In the following example, the user

specifies the minimum height & width of the desired volume, minimum placement height above the floor, and

the minimum amount of clearance in front of the volume. All measurements are in meters.

Each of these queries takes a pre-allocated array of “TopologyResult” structures. The “locationCount” parameter

specifies the length of the passed in array. The return value reports the number of returned locations. This

number is never greater than the passed in “locationCount” parameter.

The “TopologyResult” contains the center position of the returned volume, the facing direction (i.e. normal), and

the dimensions of the found space.

In the Unity sample, each of these queries is linked up to a button in the virtual UI panel. The sample hard codes the

parameters for each of these queries to reasonable values. See SpaceVisualizer.cs in the sample code for more examples.

In the dll, the shape analyzer (“ShapeAnalyzer_W”) uses the topology analyzer to match against custom shapes

defined by the user. The Unity sample defines a set of shapes and exposes the results out through the in-app

query menu, within the shape tab. The intention is that the user can define their own object shape queries and

make use of those, as needed by their application.

The shape analysis works on horizontal surfaces only. A couch, for example, is defined by the flat seat surface

and the flat top of the couch back. The shape query looks for two surfaces of a specific size, height, and aspect

range, with the two surfaces aligned and connected. Using the APIs terminology, the couch seat and back top are

shape components and the alignment requirements are shape component constraints.

An example query defined in the Unity sample (ShapeDefinition.cs), for “sittable” objects is as follows.



shapeComponents = new List<ShapeComponent>()
{
    new ShapeComponent(
        new List<ShapeComponentConstraint>()
        {
            ShapeComponentConstraint.Create_SurfaceHeight_Between(0.2f, 0.6f),
            ShapeComponentConstraint.Create_SurfaceCount_Min(1),
            ShapeComponentConstraint.Create_SurfaceArea_Min(0.035f),
        }
    ),
};
AddShape("Sittable", shapeComponents);

shapeConstraints = new List<ShapeConstraint>()
{
    ShapeConstraint.Create_RectanglesSameLength(0, 1, 0.6f),
    ShapeConstraint.Create_RectanglesParallel(0, 1),
    ShapeConstraint.Create_RectanglesAligned(0, 1, 0.3f),
    ShapeConstraint.Create_AtBackOf(1, 0),
};

  Object Placement SolverObject Placement Solver

Each shape query is defined by a set of shape components, each with a set of component constraints and a set

of shape constraints which listing dependencies between the components. This example includes three

constraints in a single component definition and no shape constraints between components (as there's only one

component).

In contrast, the couch shape has two shape components and four shape constraints. Components are identified

by their index in the user ’s component list (0 and 1 in this example).

Wrapper functions are provided in the Unity module for easy creation of custom shape definitions. The full list

of component and shape constraints can be found in “SpatialUnderstandingDll.cs” within the

“ShapeComponentConstraint” and the “ShapeConstraint” structures.

Rectangle shape is found on this surface

The object placement solver can be used to identify ideal locations in the physical room to place your objects.

The solver will find the best fit location given the object rules and constraints. In addition, object queries persist

until the object is removed with “Solver_RemoveObject” or “Solver_RemoveAllObjects” calls, allowing

constrained multi-object placement. Objects placement queries consist of three parts: placement type with

parameters, a list of rules, and a list of constraints. To run a query, use the following API.



public static int Solver_PlaceObject(
            [In] string objectName,
            [In] IntPtr placementDefinition,        // ObjectPlacementDefinition
            [In] int placementRuleCount,
            [In] IntPtr placementRules,             // ObjectPlacementRule
            [In] int constraintCount,
            [In] IntPtr placementConstraints,       // ObjectPlacementConstraint
            [Out] IntPtr placementResult)

public enum PlacementType
{
    Place_OnFloor,
    Place_OnWall,
    Place_OnCeiling,
    Place_OnShape,
    Place_OnEdge,
    Place_OnFloorAndCeiling,
    Place_RandomInAir,
    Place_InMidAir,
    Place_UnderFurnitureEdge,
};

public static ObjectPlacementRule Create_AwayFromPosition(
    Vector3 position, float minDistance)
public static ObjectPlacementConstraint Create_NearPoint(
    Vector3 position, float minDistance = 0.0f, float maxDistance = 0.0f)

This function takes an object name, placement definition, and a list of rules and constraints. The C# wrappers

provides construction helper functions to make rule and constraint construction easy. The placement definition

contains the query type – that is, one of the following.

Each of the placement types has a set of parameters unique to the type. The “ObjectPlacementDefinition”

structure contains a set of static helper functions for creating these definitions. For example, to find a place to

put an object on the floor, you can use the following function. public static ObjectPlacementDefinition

Create_OnFloor(Vector3 halfDims) In addition to the placement type, you can provide a set of rules and

constraints. Rules cannot be violated. Possible placement locations that satisfy the type and rules are then

optimized against the set of constraints in order to select the optimal placement location. Each of the rules and

constraints can be created by the provided static creation functions. An example rule and constraint construction

function is provided below.

The below object placement query is looking for a place to put a half meter cube on the edge of a surface, away

from other previously place objects and near the center of the room.



List<ObjectPlacementRule> rules =
    new List<ObjectPlacementRule>() {
        ObjectPlacementRule.Create_AwayFromOtherObjects(1.0f),
    };

List<ObjectPlacementConstraint> constraints =
    new List<ObjectPlacementConstraint> {
        ObjectPlacementConstraint.Create_NearCenter(),
    };

Solver_PlaceObject(
    “MyCustomObject”,
    new ObjectPlacementDefinition.Create_OnEdge(
        new Vector3(0.25f, 0.25f, 0.25f),
        new Vector3(0.25f, 0.25f, 0.25f)),
    rules.Count,
    UnderstandingDLL.PinObject(rules.ToArray()),
    constraints.Count,
    UnderstandingDLL.PinObject(constraints.ToArray()),
    UnderstandingDLL.GetStaticObjectPlacementResultPtr());

  Room Scanning ProcessRoom Scanning Process

If successful, a “ObjectPlacementResult” structure containing the placement position, dimensions, and

orientation is returned. In addition, the placement is added to the dll’s internal list of placed objects. Subsequent

placement queries will take this object into account. The “LevelSolver.cs” file in the Unity sample contains more

example queries.

Figure 3: The blue boxes how the result from three place on floor queries with away from camera position rules

When solving for placement location of multiple objects required for a level or application scenario, first solve

indispensable and large objects in order to maximizing the probability that a space can be found. Placement

order is important. If object placements cannot be found, try less constrained configurations. Having a set of

fallback configurations is critical to supporting functionality across many room configurations.

While the spatial mapping solution provided by the HoloLens is designed to be generic enough to meet the

needs of the entire gamut of problem spaces, the spatial understanding module was built to support the needs

of two specific games. Its solution is structured around a specific process and set of assumptions, summarized

below.



Fixed size playspace – The user specifies the maximum playspace size in the init call.

One-time scan process –
    The process requires a discrete scanning phase where the user walks around,
    defining the playspace.
    Query functions will not function until after the scan has been finalized.

SpatialUnderstanding_Init – Called once at the start.

GeneratePlayspace_InitScan – Indicates that the scan phase should begin.

GeneratePlayspace_UpdateScan_DynamicScan –
    Called each frame to update the scanning process. The camera position and
    orientation is passed in and is used for the playspace painting process,
    described above.

GeneratePlayspace_RequestFinish –
    Called to finalize the playspace. This will use the areas “painted” during
    the scan phase to define and lock the playspace. The application can query
    statistics during the scanning phase as well as query the custom mesh for
    providing user feedback.

Import_UnderstandingMesh –
    During scanning, the “SpatialUnderstandingCustomMesh” behavior provided by
    the module and placed on the understanding prefab will periodically query the
    custom mesh generated by the process. In addition, this is done once more
    after scanning has been finalized.

  Understanding MeshUnderstanding Mesh

User driven playspace “painting” – During the scanning phase, the user moves and looks around the plays pace,

effectively painting the areas, which should be included. The generated mesh is important to provide user

feedback during this phase. Indoors home or office setup – The query functions are designed around flat

surfaces and walls at right angles. This is a soft limitation. However, during the scanning phase, a primary axis

analysis is completed to optimize the mesh tessellation along major and minor axis. The included

SpatialUnderstanding.cs file manages the scanning phase process. It calls the following functions.

The scanning flow, driven by the “SpatialUnderstanding” behavior calls InitScan, then UpdateScan each frame.

When the statistics query reports reasonable coverage, the user is allowed to airtap to call RequestFinish to

indicate the end of the scanning phase. UpdateScan continues to be called until its return value indicates that the

dll has completed processing.

The understanding dll internally stores the playspace as a grid of 8 cm sized voxel cubes. During the initial part

of scanning, a primary component analysis is completed to determine the axes of the room. Internally, it stores

its voxel space aligned to these axes. A mesh is generated approximately every second by extracting the

isosurface from the voxel volume.



 Troubleshooting

 Spatial Mapping in Mixed Reality Toolkit

 Next Development Checkpoint

 See also

Generated mesh produced from the voxel volume

Ensure you have set the SpatialPerception capability

When tracking is lost, the next OnSurfaceChanged event will remove all meshes.

For more information on using Spatial Mapping with Mixed Reality Toolkit, see the spatial awareness section of

the MRTK docs.

If you're following the Unity development journey we've laid out, you're in the midst of exploring the MRTK core

building blocks. From here, you can continue to the next building block:

Text

Or jump to Mixed Reality platform capabilities and APIs:

Shared experiences

You can always go back to the Unity development checkpoints at any time.

Coordinate systems

Coordinate systems in Unity

MixedRealityToolkit

UnityEngine.MeshFilter

UnityEngine.MeshCollider

UnityEngine.Bounds

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/spatial-awareness/spatial-awareness-getting-started
https://docs.microsoft.com/en-us/windows/mixed-reality/develop/unity/coordinate-systems-in-unity
https://github.com/Microsoft/MixedRealityToolkit-Unity
https://docs.unity3d.com/ScriptReference/MeshFilter.html
https://docs.unity3d.com/ScriptReference/MeshCollider.html
https://docs.unity3d.com/ScriptReference/Bounds.html
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 Spatializer options

 Enable spatialization

NOTENOTE

 Distance-based attenuation

This page links to resources for spatial sound in Unity.

Spatializer options for mixed reality applications include:

Unity provides the MS HRTF Spatializer as part of the Windows Mixed Reality optional package.

The Microsoft Spatializer is available from the Microsoft spatializer GitHub repository.

Runs on CPU in a higher-cost 'single-source' architecture.

Provided for backwards compatibility with original HoloLens applications.

Uses a lower-cost 'multi-source' architecture.

Offloaded to a hardware accelerator on the HoloLens 2.

For new applications, we recommend the Microsoft Spatializer.

Use NuGet for Unity to install Microsoft.SpatialAudio.Spatializer.Unity and choose Microsoft SpatializerMicrosoft Spatializer  in

your project's audio settings. Then:

Attach an Audio SourceAudio Source to an object in the hierarchy

Check the Enable spatializationEnable spatialization checkbox

Move the Spatial BlendSpatial Blend slider to '1'

Ensure spatial audio is enabled on your developer workstation.

Right-click on the volume icon in the task bar and making sure that Spatial Sound is set to something

other than "off".

Choose Windows Sonic for HeadphonesWindows Sonic for Headphones  to get the best representation of what you'll hear on

HoloLens 2.

If you get an error in Unity about not being able to load plugin Microsoft.SpatialAudio.Spatializer.Unity because one of its

dependencies is missing, check that you have the latest version of the Microsoft Visual C++ Redistributable installed on

your PC.

For more information, see:

Microsoft spatializer GitHub repository

Microsoft's spatializer tutorial

Unity's audio source documentation

Unity's spatializer documentation

Unity's default distance-based decay has a minimum distance of 1 meter and a maximum distance of 500

meters, with a logarithmic rolloff. These settings may work for your scenario, or you may find that sources

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/spatial-sound-in-unity.md
https://github.com/microsoft/spatialaudio-unity
https://github.com/GlitchEnzo/NuGetForUnity/releases/latest
https://support.microsoft.com/en-us/help/2977003/the-latest-supported-visual-c-downloads
https://github.com/microsoft/spatialaudio-unity
https://docs.microsoft.com/en-us/learn/modules/spatial-audio-tutorials-mrtk/
https://docs.unity3d.com/2019.3/Documentation/Manual/class-AudioSource.html
https://docs.unity3d.com/Manual/VRAudioSpatializer.html


 Reverb

 Unity spatial sound examples

 Next Development Checkpoint

 See also

attenuate too quickly or too slowly. For more information, see:

Sound design in mixed reality for recommended settings.

Unity's audio source documentation for instructions on setting these curves.

The Microsoft Spatializer disables post-spatializer effects by default. To enable reverb and other effects for

spatialized sources:

Attach the Room Effect Send LevelRoom Effect Send Level  component to each source

Adjust the send level curve for each source, to control the gain on the audio sent back to the graph for effects

processing

See Chapter 5 of the spatializer tutorial for details.

For examples of spatial sound in Unity, see:

MRTK demos

The Microsoft Spatializer sample project

If you're following the Unity development journey we've laid out, you're in the midst of exploring the Mixed

Reality core building blocks. From here, you can continue to the next building block:

Text

Or jump to Mixed Reality platform capabilities and APIs:

Shared experiences

You can always go back to the Unity development checkpoints at any time.

Sound design in mixed reality

Microsoft's spatializer tutorial

https://docs.unity3d.com/2019.3/Documentation/Manual/class-AudioSource.html
https://docs.microsoft.com/en-us/learn/modules/spatial-audio-tutorials-mrtk/10-use-reverb-to-add-distance-to-spatial-audio
https://github.com/microsoft/MixedRealityToolkit-Unity/tree/mrtk_release/Assets/MixedRealityToolkit.Examples/Demos/Audio
https://github.com/microsoft/spatialaudio-unity/tree/master/Samples/MicrosoftSpatializerSample
https://docs.microsoft.com/en-us/learn/modules/spatial-audio-tutorials-mrtk/
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 Enabling the capability for camera access

 Photo capture

  Common set-up for PhotoCaptureCommon set-up for PhotoCapture

private void Start()
{
    PhotoCapture.CreateAsync(false, OnPhotoCaptureCreated);
}

The "WebCam" capability must be declared for an app to use the camera.

1. In the Unity Editor, go to the player settings by navigating to the "Edit > Project Settings > Player" page

2. Select the "Windows Store" tab

3. In the "Publishing Settings > Capabilities" section, check the WebCamWebCam and MicrophoneMicrophone capabilities

Only a single operation can occur with the camera at a time. You can check which mode the camera is currently

in with UnityEngine.XR.WSA.WebCam.Mode  in Unity 2018 and earlier or UnityEngine.Windows.WebCam.Mode  in Unity

2019 and later. Available modes are photo, video, or none.

Namespace (before Unity 2019):Namespace (before Unity 2019): UnityEngine.XR.WSA.WebCam

Namespace (Unity 2019 and later):Namespace (Unity 2019 and later): UnityEngine.Windows.WebCam

Type:Type: PhotoCapture

The PhotoCapture type allows you to take still photographs with the Photo Video Camera. The general pattern

for using PhotoCapture to take a photo is as follows:

1. Create a PhotoCapture object

2. Create a CameraParameters object with the settings you want

3. Start Photo Mode via StartPhotoModeAsync

4. Take the photo you want

5. Stop Photo Mode and clean up resources

(optional) Interact with that picture

For all three uses, start with the same first three steps above

Start by creating a PhotoCapture object

Next, store your object, set your parameters, and start Photo Mode

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/locatable-camera-in-unity.md


private PhotoCapture photoCaptureObject = null;

void OnPhotoCaptureCreated(PhotoCapture captureObject)
{
    photoCaptureObject = captureObject;

    Resolution cameraResolution = PhotoCapture.SupportedResolutions.OrderByDescending((res) => res.width * 
res.height).First();

    CameraParameters c = new CameraParameters();
    c.hologramOpacity = 0.0f;
    c.cameraResolutionWidth = cameraResolution.width;
    c.cameraResolutionHeight = cameraResolution.height;
    c.pixelFormat = CapturePixelFormat.BGRA32;

    captureObject.StartPhotoModeAsync(c, false, OnPhotoModeStarted);
}

void OnStoppedPhotoMode(PhotoCapture.PhotoCaptureResult result)
{
    photoCaptureObject.Dispose();
    photoCaptureObject = null;
}

  Capture a photo to a fileCapture a photo to a file

private void OnPhotoModeStarted(PhotoCapture.PhotoCaptureResult result)
{
    if (result.success)
    {
        string filename = string.Format(@"CapturedImage{0}_n.jpg", Time.time);
        string filePath = System.IO.Path.Combine(Application.persistentDataPath, filename);

        photoCaptureObject.TakePhotoAsync(filePath, PhotoCaptureFileOutputFormat.JPG, 
OnCapturedPhotoToDisk);
    }
    else
    {
        Debug.LogError("Unable to start photo mode!");
    }
}

In the end, you'll also use the same clean-up code presented here

After these steps, you can choose which type of photo to capture.

The simplest operation is to capture a photo directly to a file. The photo can be saved as a JPG or a PNG.

If you successfully started photo mode, take a photo and store it on disk

After capturing the photo to disk, exit photo mode and then clean up your objects



void OnCapturedPhotoToDisk(PhotoCapture.PhotoCaptureResult result)
{
    if (result.success)
    {
        Debug.Log("Saved Photo to disk!");
        photoCaptureObject.StopPhotoModeAsync(OnStoppedPhotoMode);
    }
    else
    {
        Debug.Log("Failed to save Photo to disk");
    }
}

  Capture a photo to a Texture2D with locationCapture a photo to a Texture2D with location

private void OnPhotoModeStarted(PhotoCapture.PhotoCaptureResult result)
{
    if (result.success)
    {
        photoCaptureObject.TakePhotoAsync(OnCapturedPhotoToMemory);
    }
    else
    {
        Debug.LogError("Unable to start photo mode!");
    }
}

void OnCapturedPhotoToMemory(PhotoCapture.PhotoCaptureResult result, PhotoCaptureFrame photoCaptureFrame)
{
    if (result.success)
    {
        // Create our Texture2D for use and set the correct resolution
        Resolution cameraResolution = PhotoCapture.SupportedResolutions.OrderByDescending((res) => res.width 
* res.height).First();
        Texture2D targetTexture = new Texture2D(cameraResolution.width, cameraResolution.height);
        // Copy the raw image data into our target texture
        photoCaptureFrame.UploadImageDataToTexture(targetTexture);
        // Do as we wish with the texture such as apply it to a material, etc.
    }
    // Clean up
    photoCaptureObject.StopPhotoModeAsync(OnStoppedPhotoMode);
}

  Locatable cameraLocatable camera

When capturing data to a Texture2D, the process is similar to capturing to disk.

Follow the setup process above.

In OnPhotoModeStarted, capture a frame to memory.

You'll then apply your result to a texture and use the common clean-up code above.

To place this texture in the scene and display it using the locatable camera matrices, add the following code to

OnCapturedPhotoToMemory in the result.success  check:



if (photoCaptureFrame.hasLocationData)
{
    photoCaptureFrame.TryGetCameraToWorldMatrix(out Matrix4x4 cameraToWorldMatrix);

    Vector3 position = cameraToWorldMatrix.GetColumn(3) - cameraToWorldMatrix.GetColumn(2);
    Quaternion rotation = Quaternion.LookRotation(-cameraToWorldMatrix.GetColumn(2), 
cameraToWorldMatrix.GetColumn(1));

    photoCaptureFrame.TryGetProjectionMatrix(Camera.main.nearClipPlane, Camera.main.farClipPlane, out 
Matrix4x4 projectionMatrix);
}

  Capture a photo and interact with the raw bytesCapture a photo and interact with the raw bytes

void OnCapturedPhotoToMemory(PhotoCapture.PhotoCaptureResult result, PhotoCaptureFrame photoCaptureFrame)
{
    if (result.success)
    {
        List<byte> imageBufferList = new List<byte>();
        // Copy the raw IMFMediaBuffer data into our empty byte list.
        photoCaptureFrame.CopyRawImageDataIntoBuffer(imageBufferList);

        // In this example, we captured the image using the BGRA32 format.
        // So our stride will be 4 since we have a byte for each rgba channel.
        // The raw image data will also be flipped so we access our pixel data
        // in the reverse order.
        int stride = 4;
        float denominator = 1.0f / 255.0f;
        List<Color> colorArray = new List<Color>();
        for (int i = imageBufferList.Count - 1; i >= 0; i -= stride)
        {
            float a = (int)(imageBufferList[i - 0]) * denominator;
            float r = (int)(imageBufferList[i - 1]) * denominator;
            float g = (int)(imageBufferList[i - 2]) * denominator;
            float b = (int)(imageBufferList[i - 3]) * denominator;

            colorArray.Add(new Color(r, g, b, a));
        }
        // Now we could do something with the array such as texture.SetPixels() or run image processing on 
the list
    }
    photoCaptureObject.StopPhotoModeAsync(OnStoppedPhotoMode);
}

 Video capture

Unity has provided sample code for applying the projection matrix to a specific shader on their forums.

To interact with the raw bytes of an in memory frame, follow the same setup steps as above and

OnPhotoModeStarted as in capturing a photo to a Texture2D. The difference is in OnCapturedPhotoToMemory

where you can get the raw bytes and interact with them.

In this example, you'll create a List to be further processed or applied to a texture via SetPixels()

Namespace (before Unity 2019):Namespace (before Unity 2019): UnityEngine.XR.WSA.WebCam

Namespace (Unity 2019 and later):Namespace (Unity 2019 and later): UnityEngine.Windows.WebCam

Type:Type: VideoCapture

VideoCapture functions similarly to PhotoCapture. The only two differences are that you must specify a Frames

Per Second (FPS) value and you can only save directly to disk as a .mp4 file. The steps to use VideoCapture are

as follows:

https://forum.unity.com/threads/holographic-photo-blending-with-photocapture.416023/?_ga=2.57872105.210548785.1614215615-862490274.1597860099


void Start ()
{
    VideoCapture.CreateAsync(false, OnVideoCaptureCreated);
}

void OnVideoCaptureCreated(VideoCapture videoCapture)
{
    if (videoCapture != null)
    {
        m_VideoCapture = videoCapture;

        Resolution cameraResolution = VideoCapture.SupportedResolutions.OrderByDescending((res) => res.width 
* res.height).First();
        float cameraFramerate = 
VideoCapture.GetSupportedFrameRatesForResolution(cameraResolution).OrderByDescending((fps) => fps).First();

        CameraParameters cameraParameters = new CameraParameters();
        cameraParameters.hologramOpacity = 0.0f;
        cameraParameters.frameRate = cameraFramerate;
        cameraParameters.cameraResolutionWidth = cameraResolution.width;
        cameraParameters.cameraResolutionHeight = cameraResolution.height;
        cameraParameters.pixelFormat = CapturePixelFormat.BGRA32;

        m_VideoCapture.StartVideoModeAsync(cameraParameters,
                                            VideoCapture.AudioState.None,
                                            OnStartedVideoCaptureMode);
    }
    else
    {
        Debug.LogError("Failed to create VideoCapture Instance!");
    }
}

void OnStartedVideoCaptureMode(VideoCapture.VideoCaptureResult result)
{
    if (result.success)
    {
        string filename = string.Format("MyVideo_{0}.mp4", Time.time);
        string filepath = System.IO.Path.Combine(Application.persistentDataPath, filename);

        m_VideoCapture.StartRecordingAsync(filepath, OnStartedRecordingVideo);
    }
}

1. Create a VideoCapture object

2. Create a CameraParameters object with the settings you want

3. Start Video Mode via StartVideoModeAsync

4. Start recording video

5. Stop recording video

6. Stop Video Mode and clean up resources

Start by creating our VideoCapture object VideoCapture m_VideoCapture = null;

Next, set up the parameters you'll want for the recording and start.

Once started, begin the recording

After recording has started, you could update your UI or behaviors to enable stopping. Here you just log.



void OnStartedRecordingVideo(VideoCapture.VideoCaptureResult result)
{
    Debug.Log("Started Recording Video!");
    // We will stop the video from recording via other input such as a timer or a tap, etc.
}

// The user has indicated to stop recording
void StopRecordingVideo()
{
    m_VideoCapture.StopRecordingAsync(OnStoppedRecordingVideo);
}

void OnStoppedRecordingVideo(VideoCapture.VideoCaptureResult result)
{
    Debug.Log("Stopped Recording Video!");
    m_VideoCapture.StopVideoModeAsync(OnStoppedVideoCaptureMode);
}

void OnStoppedVideoCaptureMode(VideoCapture.VideoCaptureResult result)
{
    m_VideoCapture.Dispose();
    m_VideoCapture = null;
}

 Troubleshooting

 Next Development Checkpoint

 See also

At a later point, you'll want to stop the recording using a timer or user input, for instance.

Once the recording has stopped, stop video mode and clean up your resources.

No resolutions are available

Ensure the WebCamWebCam capability is specified in your project.

If you're following the Unity development checkpoint journey we've laid out, you're in the midst of exploring the

Mixed Reality platform capabilities and APIs. From here, you can continue to the next topic:

Focus point

Or jump directly to deploying your app on a device or emulator :

Deploy to HoloLens or Windows Mixed Reality immersive headsets

You can always go back to the Unity development checkpoints at any time.

Locatable camera sample

Locatable camera overview

Locatable camera with C++ samples

Mixed reality capture

Mixed reality capture for developers

Media capture introduction

Holographic face tracking sample

https://github.com/Microsoft/Windows-universal-samples/tree/master/Samples/HolographicFaceTracking
https://docs.microsoft.com/en-us/hololens/holographic-photos-and-videos
https://docs.microsoft.com/en-us/windows/uwp/audio-video-camera/
https://github.com/Microsoft/Windows-universal-samples/tree/master/Samples/HolographicFaceTracking
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NOTENOTE

  ExampleExample

public GameObject focusedObject;
void Update()
{
    // Normally the normal is best set to be the opposite of the main camera's
    // forward vector.
    // If the content is actually all on a plane (like text), set the normal to
    // the normal of the plane and ensure the user does not pass through the
    // plane.
    var normal = -Camera.main.transform.forward;     
    var position = focusedObject.transform.position;
    UnityEngine.XR.WSA.HolographicSettings.SetFocusPointForFrame(position, normal);
}

NOTENOTE

Namespace:Namespace: UnityEngine.XR.WSA

TypeType: HolographicSettings

Use the focus point to provide HoloLens with a hint about how to best stabilize the holograms currently being

displayed.

If you want to set the Focus Point in Unity, it needs to be set every frame using

HolographicSettings.SetFocusPointForFrame(). When the Focus Point isn't set for a frame, the default

stabilization plane is used.

By default, new Unity projects have the "Enable Depth Buffer Sharing" option set. With this option, a Unity app running

on either an immersive desktop headset or a HoloLens running the Windows 10 April 2018 Update (RS4) or later will

submit your depth buffer to Windows to optimize hologram stability automatically, without your app specifying a focus

point:

On an immersive desktop headset, this will enable per-pixel depth-based reprojection.

On a HoloLens running the Windows 10 April 2018 Update or later, this will analyze the depth buffer to pick an

optimal stabilization plane automatically.

Either approach should provide even better image quality without explicit work by your app to select a focus point for

each frame. Note that if you do provide a focus point manually, that will override the automatic behavior described above,

and will usually reduce hologram stability. Generally, you should only specify a manual focus point when your app is

running on a HoloLens that has not yet been updated to the Windows 10 April 2018 Update.

There are many ways to set the Focus Point, as suggested by the overloads available on the

SetFocusPointForFrame static function. Presented below is a simple example to set the focus plane to the

provided object for each frame:

The simple code above may reduce hologram stability if the focused object ends up behind the user. We generally

recommend setting Enable Depth Buffer SharingEnable Depth Buffer Sharing instead of manually specifying a focus point.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/focus-point-in-unity.md


 

Next Development Checkpoint

  See alsoSee also

If you're following the Unity development journey we've laid out, you're in the midst of exploring the Mixed

Reality platform capabilities and APIs. From here, you can continue to the next topic:

Tracking loss

Or jump directly to deploying your app on a device or emulator :

Deploy to HoloLens or Windows Mixed Reality immersive headsets

You can always go back to the Unity development checkpoints at any time.

Stabilization plane
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NOTENOTE

  Render from the PV camera (opt-in)Render from the PV camera (opt-in)

  En a b l e  t h e  P h o t o Vi d e o C a m e r a  H o l o g r a p h i c V i e w C o n fi g u r a t i o n  i n  U n i t yEn a b l e  t h e  P h o t o Vi d e o C a m e r a  H o l o g r a p h i c V i e w C o n fi g u r a t i o n  i n  U n i t y

NOTENOTE

  H a n d l e  t h e  a d d i t i o n a l  H o l o g r a p h i c C a m e r a  r e n d e r  i n  U n i t yH a n d l e  t h e  a d d i t i o n a l  H o l o g r a p h i c C a m e r a  r e n d e r  i n  U n i t y

  Creating a custom MRC recorderCreating a custom MRC recorder

  MRC access for developersMRC access for developers

See Render from the PV camera below for guidance on a new MRC capability for HoloLens 2.

Before getting started here, we recommend that you take a look at our mixed reality capture overview article.

HoloLens 2 adds the ability for an immersive app to render from the PV camerarender from the PV camera while mixed reality capture

is running. To ensure the app supports the additional render correctly, the app has to opt in to this functionality.

Render from the PV camera offers the following improvements over the default MRC experience:

Hologram alignment to your physical environment and hands for near interactions should be accurate at all

distances. Avoid having an offset at distances other than the focus point as you might see in the default MRC.

The right eye in the headset won't be compromised, as it won't be used to render the holograms for the MRC

output.

There are three steps to enable rendering from the PV camera:

1. Enable the PhotoVideoCamera HolographicViewConfiguration

2. Handle the additional HolographicCamera render

3. Verify your shaders and code render correctly from this additional HolographicCamera

If you're using Unity 2018, this requires Unity 2018.4.13f1Unity 2018.4.13f1  or newer. If you're using Unity 2019, this requires UnityUnity

2019.42019.4 , or newer.

To opt in to rendering from the PV Camera when using the Mixed Reality Toolkit, enable the Windows Mixed

Reality Camera Settings provider and check Render from PV CameraRender from PV Camera.

This is done for you automatically by Unity.

While the user can always trigger a photo or video using the system MRC capture service, an application may

want to build a custom camera app that include holograms in the camera stream just like MRC. This allows the

application to kick off captures from user input, build custom recording UI, or customize MRC settings to name a

few examples.

HoloStudio adds a custom MRC camera using MRC effectsHoloStudio adds a custom MRC camera using MRC effects

See Locatable camera in Unity for the property to enable holograms.

We recommend you always request Exclusive control for the camera when using MRC. This will ensure your

application has full control of the settings for the camera as long as you're aware of the limitations listed above.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/mixed-reality-capture-unity.md
https://microsoft.github.io/MixedRealityToolkit-Unity/README.html
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/camera-system/windows-mixed-reality-camera-settings


 

See also
Mixed reality capture overview

Mixed reality capture for HoloLens users

https://docs.microsoft.com/en-us/hololens/holographic-photos-and-videos
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 Default Handling

 Manual Handling

  PollingPolling

When the device can't locate itself in the world, the app experiences "tracking loss". By default, Unity will pause

the update loop and display a splash image to the user anytime tracking is lost. Once tracking is regained, the

splash image goes away and the update loop continues.

As an alternative, the user can manually handle this transition by opting out of the setting. All content will seem

to become body locked during tracking loss if nothing is done to handle it.

The update loop and all messages and events will stop for the duration of tracking loss by default. At that same

time, an image will be displayed to the user. You can customize this image by going to Edit->Settings->Player,

clicking Splash Image, and setting the Holographic Tracking Loss image.

To manually handle tracking loss, you need to go to EditEdit > Project SettingsProject Settings  > PlayerPlayer  > Universal WindowsUniversal Windows

Platform settings tabPlatform settings tab > Splash ImageSplash Image > Windows HolographicWindows Holographic and uncheck "On Tracking Loss Pause and

Show Image". After which, you need to handle tracking changes with the APIs specified below.

Namespace:Namespace: UnityEngine.XR.WSA

Type:Type: WorldManager

World Manager exposes an event to detect tracking lost/gained

(WorldManager.OnPositionalLocatorStateChanged) and a property to query the current state

(WorldManager.state)

When the tracking state isn't active, the camera won't appear to translate in the virtual world even as the user

translates. Objects will no longer correspond to any physical location and all will appear body locked.

When handling tracking changes on your own, you either need to poll for the state property each frame or

handle the OnPositionalLocatorStateChanged event.

The most important state is PositionalLocatorState.Active, which means tracking is fully functional. Any other

state will result in only rotational deltas to the main camera. For example:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/tracking-loss-in-unity.md


void Update()
{
    switch (UnityEngine.XR.WSA.WorldManager.state)
    {
        case PositionalLocatorState.Active:
            // handle active
            break;
        case PositionalLocatorState.Activating:
        case PositionalLocatorState.Inhibited:
        case PositionalLocatorState.OrientationOnly:
        case PositionalLocatorState.Unavailable:
        default:
            // only rotational information is available
            break;
    }
}

  Handling the OnPositionalLocatorStateChanged eventHandling the OnPositionalLocatorStateChanged event

void Start()
{
    UnityEngine.XR.WSA.WorldManager.OnPositionalLocatorStateChanged += 
WorldManager_OnPositionalLocatorStateChanged;
}

private void WorldManager_OnPositionalLocatorStateChanged(PositionalLocatorState oldState, 
PositionalLocatorState newState)
{
    if (newState == PositionalLocatorState.Active)
    {
        // Handle becoming active
    }
    else
    {
        // Handle becoming rotational only
    }
}

 See also

More conveniently, you can also subscribe to OnPositionalLocatorStateChanged to handle the transitions:

Handling tracking loss in DirectX
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 HoloLens system keyboard behavior in Unity

 Using the system keyboard in your Unity app
  Declare the keyboardDeclare the keyboard

UnityEngine.TouchScreenKeyboard keyboard;
public static string keyboardText = "";

  Invoke the keyboardInvoke the keyboard

keyboard = TouchScreenKeyboard.Open("text to edit");

  Retrieve typed contentsRetrieve typed contents

keyboardText = keyboard.text;

 Alternative keyboard options

Namespace:Namespace: UnityEngine

TypeType: TouchScreenKeyboard

While HoloLens supports many forms of input including Bluetooth keyboards, most applications can't assume

that all users will have a physical keyboard available. If your application requires text input, some form of on-

screen keyboard should be provided.

Unity provides the TouchScreenKeyboard class for accepting keyboard input when there's no physical keyboard

available.

On HoloLens, the TouchScreenKeyboard leverages the system's on-screen keyboard and directly overlays on top

of the volumetric view of your MR application. The experience is similar to using keyboard in the built-in apps of

HoloLens. Note that the system keyboard will behave according to the target platform's capabilities, for example

the keyboard on HoloLens 2 would support direct hand interactions, while the keyboard on HoloLens (1st gen)

would support GGV (Gaze, Gesture, and Voice). Additionally, the system keyboard will not show up when

performing Unity Remoting from the editor to a HoloLens.

In the class, declare a variable to store the TouchScreenKeyboard and a variable to hold the string the keyboard

returns.

When an event occurs requesting keyboard input, use the following to show the keyboard.

You can use additional parameters passed into the TouchScreenKeyboard.Open  function to control the behavior of

the keyboard (e.g. setting placeholder text or supporting autocorrection). For the full list of parameters please

refer to Unity's documentation.

The content can simply be retrieved by calling keyboard.text . You may want to retrieve the content per frame or

only when the keyboard is closed.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/keyboard-input-in-unity.md
https://docs.unity3d.com/ScriptReference/TouchScreenKeyboard.html
https://docs.unity3d.com/ScriptReference/TouchScreenKeyboard.html
https://docs.unity3d.com/ScriptReference/TouchScreenKeyboard.Open.html


 Next Development Checkpoint

Besides using the TouchScreenKeyboard class directly, you can also get user input by using Unity's UI Input Field

or TextMeshPro Input Field. Additionally, there is an implementation based on TouchScreenKeyboard in the

HandInteractionExamples scene of MRTK (there is a keyboard interaction sample on the left hand side).

If you're following the Unity development journey we've laid out, you're in the midst of exploring the Mixed

Reality platform capabilities and APIs. From here, you can continue to any topic or jump directly to deploying

your app on a device or emulator.

Deploy to HoloLens or Windows Mixed Reality immersive headsets

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/example-scenes/hand-interaction-examples
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity
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 See also

For an overview of hologram stability, including some Unity tips, we recommend that you take a look at our

hologram stability overview article. The sections of the page that contain the Unity tips are linked below.

Reprojection

Choosing reprojection technique

Using planar reprojection

Understanding Performance for Mixed Reality

Color, light, and materials

Instinctual interactions

MRTK Hologram Stabilization

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/hologram-stability-unity.md
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/performance/hologram-stabilization
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  Detecting QR codesDetecting QR codes
  Adding the webcam capabilityAdding the webcam capability

await QRCodeWatcher.RequestAccessAsync();

 Using OpenXR

 Getting the coordinate system for a QR code

Before getting started here, we recommend that you take a look at our QR code tracking overview article which

contains an overview, a device support table, and best practices.

You'll need to add the capability webcam  to your manifest to detect QR codes. This capability is required as the

data within detected codes in the user's environment may contain sensitive information.

Permission can be requested by calling QRCodeWatcher.RequestAccessAsync() :

C#:

Permission must be requested before you construct a QRCodeWatcher object.

While QR code detection requires the webcam  capability, the detection occurs using the device's tracking

cameras. This provides a wider detection FOV and better battery life compared to detection with the device's

photo/video (PV) camera.

You can use the QR code detection API in Unity without importing MRTK by installing the NuGet package using

NuGet for Unity. If you want to get a feel for how it works, download the sample Unity app. The sample app has

examples for displaying a holographic square over QR codes and associated data such as GUID, physical size,

timestamp, and decoded data.

When using the OpenXR plugin, grab the SpatialGraphNodeId  from the QR API and use the 

Microsoft.MixedReality.OpenXR.SpatialGraphNode  API to locate the QR code.

For reference, we have a QR tracking sample project on GitHub with more a detailed usage explanation for the 

SpatialGraphNode  API.

Each detected QR code exposes a spatial coordinate system aligned with the QR code at the top-left corner of

the fast detection square in the top left:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/qr-code-tracking-unity.md
https://github.com/GlitchEnzo/NuGetForUnity
https://github.com/yl-msft/QRTracking
https://github.com/microsoft/MixedReality-QRCode-Sample
https://github.com/yl-msft/QRTracking/blob/main/SampleQRCodes/Assets/Scripts/SpatialGraphNodeTracker.cs


 See also

When converted into Unity coordinates, the Z-axis points out of the paper and is left-handed.

QR code tracking overview

QR code tracking with native C++ and C## samples

QR code tracking API reference

Coordinate systems

Azure Spatial Anchors

https://docs.microsoft.com/en-us/azure/spatial-anchors/overview
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 Setup

 Build your socket client and server

IMPORTANTIMPORTANT

 See also

You can setup your Universal Windows Platform (UWP) Unity apps to receive UDP packets with the help of a

UDP socket client and server. UDP sockets don't maintain connection on both endpoints, so they're a fast and

simple solution for networking between remote machines. However, you'll be responsible for checking if the

packets get to their destination, as UDP sockets don't do that automatically.

Open your projects HoloLens manifest.json file and make sure you've enabled:

Internet (Client & Ser ver)Internet (Client & Ser ver)

Pr ivate Networks (Client & Ser ver)Pr ivate Networks (Client & Ser ver) .

Follow the instructions for building a basic UDP socket client and server. You'll be using the DatagramSocket

class to send and receive data over UDP and form an echo client and server. We also recommend reading

through the other resource sections in this article, as they apply to more customized and complex use cases.

If you're having trouble sending UDP packets from PC to PC, check that your network allows these operations. If your

network is blocking the UDP packets in any way, your HoloLens device won't be able to listen for them.

You can download a complete DatagramSocket UDP sample app from the link below:

Install the tools

Experiments with Shared Holograms and Azure Blob Storage/UDP Multicasting

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/udp-packets-in-unity.md
https://docs.microsoft.com/en-us/windows/uwp/networking/sockets#build-a-basic-udp-socket-client-and-server
https://docs.microsoft.com/en-us/uwp/api/windows.networking.sockets.datagramsocket
https://docs.microsoft.com/en-us/samples/microsoft/windows-universal-samples/datagramsocket/
https://mtaulty.com/2017/12/29/experiments-with-shared-holograms-and-azure-blob-storage-udp-multicasting-part-1/


   

 

WinRT APIs with Unity for HoloLens
 7/6/2022 • 2 minutes to read • Edit Online

 Mixed Reality APIs

using namespace Microsoft.Windows.Perception.Spatial;

var worldOrigin = SpatialCoordinateSystem.FromNativePtr(unityWorldOriginPtr);

 Conditionally include WinRT API calls

This page describes how to make use of WinRT APIs in your Unity project for HoloLens.

A Mixed Reality focused subset of the Windows SDK has been made available in a .NET Standard 2.0 compatible

projection, which you can use in your project without preprocessor directives. Most APIs in the Windows.

Perception and Windows.UI.Input.Spatial namespaces are included and may expand to include additional APIs in

the future. The projected APIs can be used while running in the Editor, which enables the use of Play Mode. To

use this projection, make the following modifications to your project:

1. Add a reference to the Microsoft.Windows.MixedReality.DotNetWinRT NuGet package using NuGet for Unity.

2. Prefix references to the Windows  namespace with Microsoft. :

3. Replace native pointer casts with FromNativePtr :

You can also use the WinRT APIs in Unity projects built for the Universal Windows Platform and Xbox One

platform by using preprocessor directives. Any code that you write in Unity scripts that target WinRT APIs must

be conditionally included for only those builds.

This can be done via two steps in Unity:

1. API compatibility level must be set to .NET 4.6.NET 4.6  or .NET Standard 2.0.NET Standard 2.0  in the player settings

2. The preprocessor directive ENABLE_WINMD_SUPPORTENABLE_WINMD_SUPPORT must be wrapped around any WinRT-leveraged

code

EditEdit > Project SettingsProject Settings  > PlayerPlayer  > ConfigurationConfiguration > Api Compatibility LevelApi Compatibility Level  to .NET 4.6.NET 4.6  or

.NET Standard 2.0.NET Standard 2.0

The following code snippet is from the Unity manual page for Universal Windows Platform: WinRT API in C#

scripts. In this example, an advertising ID is returned, but only on UWP and Xbox One builds:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/using-the-windows-namespace-with-unity-apps-for-hololens.md
https://docs.microsoft.com/en-us/windows/mixed-reality/unity-play-mode
https://www.nuget.org/packages/Microsoft.Windows.MixedReality.DotNetWinRT
https://github.com/GlitchEnzo/NuGetForUnity
https://docs.unity3d.com/Manual/windowsstore-scripts.html


using UnityEngine;
public class WinRTAPI : MonoBehaviour {
    void Update() {
        auto adId = GetAdvertisingId();
        // ...
    }

    string GetAdvertisingId() {
        #if ENABLE_WINMD_SUPPORT
            return Windows.System.UserProfile.AdvertisingManager.AdvertisingId;
        #else
            return "";
        #endif
    }
}

 Edit your scripts in a Unity C# project

 See also

When you double-click a script in the Unity editor, it will by default launch your script in an editor project. The

WinRT APIs will appear to be unknown because the Visual Studio project doesn't reference the Windows

Runtime. The ENABLE_WINMD_SUPPORTENABLE_WINMD_SUPPORT directive is undefined and any #if wrapped code is ignored until

you build your project into a UWP Visual Studio solution.

Build and deploy a Unity Visual Studio solution to the Hololens

Windows Runtime Support Unity

https://docs.unity3d.com/Manual/IL2CPP-WindowsRuntimeSupport.html
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 WindowsMixedRealityUtilities

public static HolographicFrame CurrentHolographicFrame { get; }
public static SpatialCoordinateSystem SpatialCoordinateSystem { get; }
public static SpatialInteractionManager SpatialInteractionManager { get; }

  Unmarshaling native pointersUnmarshaling native pointers

var worldOrigin = 
Microsoft.Windows.Perception.Spatial.SpatialCoordinateSystem.FromNativePtr(spatialCoordinateSystemPtr);

#if ENABLE_WINMD_SUPPORT
var worldOrigin = Marshal.GetObjectForIUnknown(spatialCoordinateSystemPtr) as 
Windows.Perception.Spatial.SpatialCoordinateSystem;
#endif

  Converting between coordinate systemsConverting between coordinate systems

Every Mixed Reality app gets a HolographicSpace before it starts receiving camera data and rendering frames. In

Unity, the engine takes care of those steps for you, handling Holographic objects and internally updating as part

of its render loop.

However, in advanced scenarios you may need to get access to the underlying native objects, such as the

HolographicCamera and current HolographicFrame.

MRTK

Windows XR Plugin

Legacy WSA

Namespace:Namespace: Microsoft.MixedReality.Toolkit.WindowsMixedReality

Type:Type: WindowsMixedRealityUtilities

MRTK provides already-marshalled types across both legacy WSA and XR SDK through the

WindowsMixedRealityUtilitiesWindowsMixedRealityUtilities  class.

After obtaining the IntPtr  from one of the methods above (not needed for MRTK), use the following code

snippets to marshal them to managed objects.

If you are using Microsoft.Windows.MixedReality.DotNetWinRT, you can construct a managed object from a

native pointer using the FromNativePtr()  method:

Otherwise, use Marshal.GetObjectForIUnknown()  and cast to the type you want:

Unity uses a left-handed coordinate system, while the Windows Perception APIs use right-handed coordinate

systems. To convert between these two conventions, you can use the following helpers:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/unity-xrdevice-advanced.md
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamera
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframe
https://www.nuget.org/packages/Microsoft.Windows.MixedReality.DotNetWinRT


namespace NumericsConversion
{
    public static class NumericsConversionExtensions
    {
        public static UnityEngine.Vector3 ToUnity(this System.Numerics.Vector3 v) => new 
UnityEngine.Vector3(v.X, v.Y, -v.Z);
        public static UnityEngine.Quaternion ToUnity(this System.Numerics.Quaternion q) => new 
UnityEngine.Quaternion(q.X, q.Y, -q.Z, -q.W);
        public static UnityEngine.Matrix4x4 ToUnity(this System.Numerics.Matrix4x4 m) => new 
UnityEngine.Matrix4x4(
            new Vector4( m.M11,  m.M12, -m.M13,  m.M14),
            new Vector4( m.M21,  m.M22, -m.M23,  m.M24),
            new Vector4(-m.M31, -m.M32,  m.M33, -m.M34),
            new Vector4( m.M41,  m.M42, -m.M43,  m.M44));

        public static System.Numerics.Vector3 ToSystem(this UnityEngine.Vector3 v) => new 
System.Numerics.Vector3(v.x, v.y, -v.z);
        public static System.Numerics.Quaternion ToSystem(this UnityEngine.Quaternion q) => new 
System.Numerics.Quaternion(q.x, q.y, -q.z, -q.w);
        public static System.Numerics.Matrix4x4 ToSystem(this UnityEngine.Matrix4x4 m) => new 
System.Numerics.Matrix4x4(
            m.m00,  m.m10, -m.m20,  m.m30,
            m.m01,  m.m11, -m.m21,  m.m31,
           -m.m02, -m.m12,  m.m22, -m.m32,
            m.m03,  m.m13, -m.m23,  m.m33);
    }
}

  Using HolographicFrame native dataUsing HolographicFrame native data

NOTENOTE
Changing the state of the native objects received via HolographicFrameNativeData may cause unpredictable behavior and

rendering artifacts, especially if Unity also reasons about that same state. For example, you should not call

HolographicFrame.UpdateCurrentPrediction, or else the pose prediction that Unity renders with that frame will be out of

sync with the pose that Windows is expecting, which will reduce hologram stability.

If you need access to native interfaces for rendering or debugging purposes, use data from

HolographicFrameNativeData in your native plugins or C# code.

Here's an example of how you can use HolographicFrameNativeData to get the current frame's prediction for

photon time using the XR SDK extensions.



using System;
using System.Runtime.InteropServices;

public static bool GetCurrentFrameDateTime(out DateTime frameDateTime)
{
#if ENABLE_WINMD_SUPPORT
    IntPtr holographicFramePtr = 
UnityEngine.XR.WindowsMR.WindowsMREnvironment.CurrentHolographicRenderFrame;

    if (holographicFramePtr != IntPtr.Zero)
    {
        var holographicFrame = Marshal.GetObjectForIUnknown(holographicFramePtr) as 
Windows.Graphics.Holographic.HolographicFrame;
        frameDateTime = holographicFrame.CurrentPrediction.Timestamp.TargetTime.DateTime;
        return true;
    }
#endif

    frameDateTime = DateTime.MinValue;
    return false;
}

 See Also
Using the Windows namespace with Unity apps for HoloLens

SpatialCoordinateSystem

HolographicFrame

HolographicCamera

Rendering in DirectX

https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialcoordinatesystem
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframe
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamera
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NOTENOTE

 Where do I get the SDK?

 Conceptual overview

When the HoloLens 2 is running in warm environments or with heavy performance requirements (CPU/GPU

usage, peripheral usage, etc.), it might get hot enough that it takes actions automatically to keep itself from

overheating. These actions would include things like:

Adjusting charging performance

Providing user feedback

Closing applications

... and in worst-case scenarios:

Shutting down the HoloLens 2

If your application demands high peripheral performance, consider using the PowerThermalNotification

Software Development Kit (SDK) to subscribe to notification events and implement your own custom actions.

Doing so can allow the device to operate longer in situations when otherwise an application may be terminated

by the system.

Support for the Microsoft.MixedReality.PowerThermalNotification SDK is included in the 22H1 release.

This article describes the PowerThermalNotification SDK and its basic usage to get you started.

The PowerThermalNotification SDK is downloadable via the Mixed Reality Feature Tool.

PowerThermalNotification SDK supports language projections for C# and C++, allowing developers to develop

applications for Win32 or UWP platforms.

The power consumed by the HoloLens 2 is dissipated in heat. A traditional PC device would have a fan to

address this, but a wearable device must be lightweight. Because of this, the cooling solution is more complex.

HoloLens 2 has built-in hardware and software safety features to ensure that the headset doesn't get too hot for

the user, but these features must be balanced with user experience as well. For example, if we know which part

of the HoloLens 2 is heating up, we can choose to throttle the peripherals responsible for this heat. As a last

resort, we might close an application that's thought to be responsible for the power that led to this heat.

HoloLens 2 handles heat issues by using temperature sensors. A thermal framework ties groups of sensors to

different peripherals on the device. The sensors are grouped because it may be impossible to determine which

peripheral in a physical area is responsible for the power draw that heats up the HoloLens 2.

The PowerThermalNotification SDK exposes the APIs necessary to monitor these groups of sensors. SDK events

fire when a peripheral being used by the application is showing signs that a mitigation may be required. The

application can then adapt its customer experience to reduce the thermal impact. Reducing impact means less

risk of system action such as application or device shutdown.

A simple example would be an application that's using the CPU to process a large amount of video data. The

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/managing-power-and-thermals.md
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NOTENOTE

 Suggestions for application response

  Suggested mitigations by peripheralSuggested mitigations by peripheral
  CPUCPU

  GPUGPU

  

application could subscribe to a performance notification for the CPU component. When the application receives

a notification, it can reduce the CPU workload. If another event is received that indicates no further mitigation is

necessary, the CPU workload can be restored.

The following table is a breakdown of system actions by peripheral. Actions described below can be suppressed

using the SDK. See Suppressing Default System Mitigations

Actions in the "Last Resort", "Software Shutdown", and "Failsafe" columns cannot be suppressed.

The following is a breakdown of suggested mitigations an application can take based on which peripheral(s)

need mitigation. It's up to the application developer to determine which of these actions may have a more

significant effect on each peripheral since every application is different. Developers should prioritize actions they

take based on the impact to the end user.

Adjust per-frame workload

Physics operations

Minimize background CPU cycles

Reduce render resolution

Reduce scene complexity(number of triangles and texture)

Reduce photo/video camera processing

Stop using the photo/video camera

App can then reduce Field of View (FOV) to offset content blurriness

Reduce camera resolution

Reduce camera frame rate

Reduce app post-processing of camera images

https://docs.unity3d.com/ScriptReference/MonoBehaviour.FixedUpdate.html
https://docs.unity3d.com/Manual/OptimizingGraphicsPerformance.html
https://docs.unity3d.com/ScriptReference/XR.XRSettings-renderViewportScale.html
https://docs.unity3d.com/ScriptReference/QualitySettings.SetQualityLevel.html


DRAMDRAM

  NetworkNetwork

  BatteryBattery

  DisplayDisplay

  Photo/video cameraPhoto/video camera

 Implementation use cases

NOTENOTE

 Event-based API usage
  Registering for eventsRegistering for events

Texture complexity

Reduce render resolution

Reduce bandwidth

Reduce video call frame rate

Stop background network activity (for example, application telemetry)

Move to a cooler environment

Use device without a charger

Avoid running on a charger with a below-50% charge

Increase the number of black pixels in the scene

Use low-power colors (for example, green)

Dim the display

Overview

Reduce camera resolution

Reduce camera frame rate

Reduce app post-processing of camera images

Stop using the photo/video camera

The SDK is designed to support two standard use cases to get information:

Event-based

Polling-based

Event-based notification will provide the quickest feedback path to the application in case it needs to take action.

However, in some cases it may be more convenient for the developer to use polling.

State information is updated, at most, every few seconds for each peripheral, so polling any faster than that may waste

CPU cycles.

To get notifications, there are three requirements:

System support for the API including the specified peripheral

A non-empty PeripheralsOfInterest property

A non-empty PowerThermalMitigationLevelChanged event handler or a non-empty

PowerThermalThermalScoreChanged event handler

You won't receive events if your application doesn't meet these requirements.

The first item can be checked using the IsSupported function. If the system supports notifications for at least one

https://docs.unity3d.com/ScriptReference/QualitySettings.SetQualityLevel.html
https://docs.unity3d.com/ScriptReference/XR.XRSettings-renderViewportScale.html
https://doc.photonengine.com/en-us/realtime/current/reference/performance-tips
https://docs.unity3d.com/ScriptReference/SystemInfo-batteryStatus.html
https://docs.unity3d.com/ScriptReference/SystemInfo-batteryLevel.html
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.display.brightnessoverride
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalnotification.peripheralsofinterest
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalnotification.powerthermalmitigationlevelchanged
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalnotification.powerthermalthermalscorechanged
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalnotification.issupported


using Microsoft.MixedReality.PowerThermalNotification;

private void NotificationHandler(object sender, PowerThermalEventArgs args)
{
    //  Notification handling can be done here using information contained in args
}

private void InitializeThermalNotifications()
{
    PowerThermalNotification p = PowerThermalNotification.GetForCurrentProcess();
    
    PowerThermalPeripheralFlags requestedFlags = PowerThermalPeripheralFlags.Cpu | 
PowerThermalPeripheralFlags.PhotoVideoCamera;
     if (PowerThermalNotification.IsSupported(requestedFlags))
    {
        //At least one of these peripherals is supported by the system
        p.PeripheralsOfInterest = requestedFlags;
        p.PowerThermalMitigationLevelChanged += NotificationHandler;
    }  
}

  Handling eventsHandling events

of the peripherals in the mask, the function will return true. You can choose not to check support using this

function as long as your application doesn't explicitly depend on PowerThermalNotification SDK events.

Once you meet the three requirements above, you'll receive initial notifications for all supported

PeripheralsOfInterest. If you later change PeripheralsOfInterest or either of the event handlers, you'll receive

another set of notifications based on current status.

Here's a code snippet for grabbing the PowerThermalNotification class instance and configuring it for

notifications for both PowerThermalPeripheralFlags.Cpu and PowerThermalPeripheralFlags.PhotoVideoCamera:

When the PowerThermalMitigationLevelChanged event fires, it comes with PowerThermalEventArgs. These

should be used to understand the event.

Similarly, when the PowerThermalThermalScoreChanged event fires, it comes with PowerThermalScoreArgs.

When an event is received, the event handler should inspect args.ImpactedPeripherals, which identifies which

peripheral(s) are impacted (there may be more than one).

For PowerThermalMitigationLevelChanged events, the args.MitigationLevel indicates how severe of a mitigation

is recommended for the specified peripherals. If the args.MitigationLevel is

PowerThermalMitigationLevel.NoUserImpact then any mitigations associated with the specified peripherals

should be removed.

For PowerThermalThermalScoreChanged events, the args.ThermalScore indicates a score from 100 to 0

reflecting a linear scale approaching an application shutdown event (zero). The Thermal Score range begins

outside of the mitigation reporting range to allow earlier notification to the application when approaching the

need for mitigations.

Here's an example handler :

https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalnotification.peripheralsofinterest
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalnotification.peripheralsofinterest
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalnotification
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalperipheralflags
https://docs.microsoft.com/en-us/dotnet/api//microsoft.mixedreality.powerthermalnotification.powerthermalperipheralflags
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalnotification.powerthermalmitigationlevelchanged
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermaleventargs
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalnotification.powerthermalthermalscorechanged
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalscoreargs
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermaleventargs.impactedperipherals
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalnotification.powerthermalmitigationlevelchanged
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermaleventargs.mitigationlevel
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermaleventargs.mitigationlevel
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalmitigationlevel
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalnotification.powerthermalthermalscorechanged
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalscoreargs.thermalscore


bool doCpuThrottle = false;

private void NotificationHandler(object sender, PowerThermalEventArgs args)
{
    if (args.ImpactedPeripherals.HasFlag(PowerThermalPeripheralFlags.Cpu))
    {
        if(args.MitigationLevel = PowerThermalMitigationLevel.NoUserImpact)
        {
            doCpuThrottle = false;
        }
        else if(args.MitigationLevel >= PowerThermalMitigationLevel.MinimumUserImpact)
        {
            // Note that this only kicks in at MinimumUserImpact and does not get released until 
NoUserImpact
            doCpuThrottle = true;
        }
    }

    if (args.ImpactedPeripherals.HasFlag(PowerThermalPeripheralFlags.PhotoVideoCamera))
    {
        SetMitigationStatus(PhotoVideoCameraStatusText, PhotoVideoRectangle, args.MitigationLevel);
    }
}

NOTENOTE

NOTENOTE

  Putting it together (event-based model)Putting it together (event-based model)

The ImpactedPeripherals parameter of args only identifies those peripherals that were both impacted AND part of

PeripheralsOfInterest. Other impacted peripherals that were not included in PeripheralsOfInterest will not be identified.

Mitigation levels for peripherals have hysteresis. Once the level increases, it doesn't decrease until it releases. The release is

an event with args.MitigationLevel set to PowerThermalMitigationLevel.NoUserImpact.

Here's a simple example of a set of scripts that can be used in Unity to enable this functionality. The

NotificationComponent class can be added to any game object and that game object can track the mitigation

level of the assigned peripheral. The NotificationManager class deals with the SDK managing subscriptions

through the single instance of the PowerThermalNotification class.

Here's the NotificationManager class:

https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalnotification.getforcurrentprocess
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalnotification


using System.Collections;
using System.Collections.Generic;
using UnityEngine;
using UnityEngine.UI;

using Microsoft.MixedReality.PowerThermalNotification;

public class NotificationManager
{
    private static readonly object listLock = new object();
    private static List<NotificationComponent> components = new List<NotificationComponent>();
    private static PowerThermalNotification p = PowerThermalNotification.GetForCurrentProcess();
    private static bool FirstTime = true;

    private static void NotificationHandler(object sender, PowerThermalEventArgs args)
    {
        lock (listLock)
        {
            foreach (NotificationComponent c in components)
            {
                UnityEngine.WSA.Application.InvokeOnAppThread(() =>
                {
                    c.SetMitigationLevel(args.ImpactedPeripherals, args.MitigationLevel);
                }, false);
            }
        } 
    }

    public static void ChangeSuppression(PowerThermalPeripheralFlags peripherals, bool suppress)
    {
        p.SuppressPlatformMitigation(peripherals, suppress);
    }

    public static void AddNotification(NotificationComponent component, PowerThermalPeripheralFlags 
peripheralsOfInterest)
    {
        if (FirstTime)
        {
            p.PowerThermalMitigationLevelChanged += NotificationHandler;
            FirstTime = false;
        }
        
        if (PowerThermalNotification.IsSupported(peripheralsOfInterest))
        {
            lock (listLock)
            {
                component.SetMitigationLevel(peripheralsOfInterest, (PowerThermalMitigationLevel)0);
                components.Add(component);
            }
            p.PeripheralsOfInterest |= peripheralsOfInterest;
        }
    }
}

Here is the NotificationComponent class:



using System.Collections;
using System.Collections.Generic;
using UnityEngine;

using Microsoft.MixedReality.PowerThermalNotification;

public class NotificationComponent : MonoBehaviour
{
    //Note that this could be multiple peripherals, just need to make sure to look at impactedPeripherals in 
the handler
    public PowerThermalPeripheralFlags monitoredPeripheral = (PowerThermalPeripheralFlags) 0;
    public bool isSuppressed = false;

    public void SetMitigationLevel(PowerThermalMitigationLevel level)
    {
        Color newColor = Color.white;

        if (level == PowerThermalMitigationLevel.NoUserImpact)
        {
            newColor = Color.green;
        }
        else if (level == PowerThermalMitigationLevel.MinimumUserImpact)
        {
            newColor = Color.yellow;
        }
        else if (level == PowerThermalMitigationLevel.MediumUserImpact)
        {
            newColor = new Color32(255, 127, 37, 255);//Orange
        }
        else
        {
            newColor = Color.red;
        }

        MaterialPropertyBlock props = new MaterialPropertyBlock();
        props.SetColor("_Color", newColor);
        GetComponent<Renderer>().SetPropertyBlock(props);
    }

    public void SetMitigationLevel(PowerThermalPeripheralFlags impactedPeripherals, 
PowerThermalMitigationLevel level)
    {
        if (impactedPeripherals.HasFlag(monitoredPeripheral))
        {
            SetMitigationLevel(level);
        }
    }

    void Start()
    {
        NotificationManager.AddNotification(this, monitoredPeripheral);
        NotificationManager.ChangeSuppression(monitoredPeripheral, isSuppressed);
    }

}

 Polling-based API usage
  Updating peripherals of interestUpdating peripherals of interest
Similar to the event-based usage, setting the PeripheralsOfInterest property is required to poll a given

peripheral.

https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalnotification.peripheralsofinterest


WARNINGWARNING

  Calling the polling APIsCalling the polling APIs

NOTENOTE

private async void timerCallback(object state)
{
    await Dispatcher.RunAsync(Windows.UI.Core.CoreDispatcherPriority.Normal, () =>
    {
        PowerThermalNotification p = PowerThermalNotification.GetForCurrentProcess();

        PowerThermalPeripheralState CpuState = p.GetLatestPeripheralState(PowerThermalPeripheralFlags.Cpu);
        PowerThermalPeripheralState PhotoVideoCameraState = 
p.GetLatestPeripheralState(PowerThermalPeripheralFlags.PhotoVideoCamera);
        
        CpuScoreText.Text = CpuState.ThermalScore.ToString();
        PhotoVideoScoreText.Text = PhotoVideoCameraState.ThermalScore.ToString();
    });
}

private void InitializeThermalNotifications()
{
    PowerThermalNotification p = PowerThermalNotification.GetForCurrentProcess();

    PowerThermalPeripheralFlags requestedFlags = PowerThermalPeripheralFlags.Cpu | 
PowerThermalPeripheralFlags.PhotoVideoCamera;
    p.SuppressedPlatformMitigationForPeripherals = requestedFlags;//Suppress any platform mitigation on CPU 
or PhotoVideoCamera

    if (PowerThermalNotification.IsSupported(requestedFlags))
    {
        p.PeripheralsOfInterest = requestedFlags;

        Timer timer = new Timer(timerCallback, null, 0, 3000);
    }
    else
    {
        TitleLabel.Text = "Not Supported";
    }
}

If you attempt to call GetLastPeripheralState for a given peripheral without first setting that flag in PeripheralsOfInterest,

an exception will be thrown. Similarly, if you attempt to use GetLastPeripheralState with an invalid value (multiple flag bits

set, or an unsupported bit), an exception will be thrown.

Once PeripheralsOfInterest has the peripheral bit(s) set that you wish to poll, you can call into

GetLastPeripheralState.

The returned PowerThermalPeripheralState contains the latest values for Thermal Score and Mitigation Level for

the given peripheral.

It's possible that in future platforms, certain peripherals may not be supported. In these cases the API will return a

Thermal Score of 100 and a Mitigation Level of NoUserImpact. The application can check the IsSupportedPeripheral field

of the structure to check whether or not this is the case for a given peripheral.

See Handling Events for details on handling of the Thermal Score and MitigationLevel returned by

PowerThermalPeripheralState.

Here's a small snippet showing polling:

https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalnotification.getlatestperipheralstate
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalnotification.peripheralsofinterest
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalnotification.getlatestperipheralstate
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalnotification.peripheralsofinterest
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalnotification.getlatestperipheralstate
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalperipheralstate
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalperipheralstate.issupportedperipheral
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalperipheralstate.thermalscore
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalperipheralstate.mitigationlevel
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalperipheralstate


 Suppressing default system mitigations

PowerThermalNotification p = PowerThermalNotification.GetForCurrentProcess();
PowerThermalPeripheralFlags requestedFlags = PowerThermalPeripheralFlags.Cpu | 
PowerThermalPeripheralFlags.PhotoVideoCamera;

//You can do this to set the property explicitly
p.SuppressedPlatformMitigationForPeripherals = requestedFlags;

//Or you can do this to manipulate the property mask. 
//This specific example clears the CPU, leaving the PhotoVideoCamera suppressed
p.SuppressPlatformMitigation(PowerThermalPeripheralFlags.Cpu, false);

NOTENOTE

 Testing

If you don't want the system to attempt to mitigate certain peripherals, you can suppress them. To do this, just

update the SuppressedPlatformMitigationForPeripherals property, or call the SuppressPlatformMitigation

function.

Here's a small snippet:

The suppression APIs will only work if the process using the PowerThermalNotification class is in the foreground.

Background processes can still subscribe to events but may not disable HoloLens 2 actions.

Once you've integrated the SDK into your application, you'll want to test it. For HoloLens 2 operating systems

that support the SDK, a developer page will be available in Device Portal. From this page, you can control the

mitigation levels and thermal scores for each peripheral. You can also monitor which peripherals have

mitigations being actively suppressed.

You can also leverage the REST APIs to monitor/test mitigation levels and thermal scores from another device.

More information can be found on the Device Portal API Reference

https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalnotification.suppressedplatformmitigationforperipherals
https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalnotification.suppressplatformmitigation
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 Conceptual Overview

 How should I activate Moving Platform Mode?

W H O  KN O W S IF  H L 2 IS IN  AW H O  KN O W S IF  H L 2 IS IN  A
M O VIN G P L AT F O RMM O VIN G P L AT F O RM

B EST  M ET H O D O F  SET T IN GB EST  M ET H O D O F  SET T IN G
M O VIN G P L AT F O RM  M O DEM O VIN G P L AT F O RM  M O DE B EN EF IT SB EN EF IT S C O ST SC O ST S

System Administrator Mobile Device Management The user doesn't need to be
involved. Any app will work
without modification.
Device can be protected
from entering the incorrect
mode.

User and Apps can't change
the mode.

End User The Settings App The user is often the most
knowledgeable about when
and where they're using the
device. Any app will work
without modification.

The user may not know the
mode exists.

The Application Use the SDK described in
this article.

Use case specific cues can
be used to swap the mode
when the environment can't
be known ahead of time.
Removes the requirement
that a user has to make this
decision and change the
mode in settings.

A poorly designed app can
give a very bad experience,
and leave the device in an
unexpected mode.

 Best practices for Moving Platform Mode

Moving Platform Mode allows HoloLens 2 to work correctly on moving platforms such as ships, oil platforms,

and other vehicles.

Learn more about Moving Platform Mode

For mixed reality systems to work correctly, the headset must be tracked relative to the environment. This

relative tracking allows the graphics to be rendered such that they appear to the user of the headset to be solidly

locked in the environment. Tracking is usually achieved by combining poses that are calculated using outward-

looking cameras and measurements from the Inertial Measurement Unit (IMU). This method works well when

the environment is in the inertial frame of reference. Small effects, like planetary motion, are usually neglected.

When the environment isn't in the inertial frame of reference, the normal head tracking system will fail. The

Moving Platform Mode feature solves this problem by accounting for the motion of the environment relative to

the inertial frame. Thus, when in Moving Platform Mode, HoloLens 2 can render holograms that appear fixed to

the environment, even if the environment is a lurching ship!

In order to enable a range of use cases, various methods have been provided to activate Moving Platform Mode.

It's important that you carefully consider which method to choose. A key question to ask is: Who knows whether

the HoloLens 2 is currently within a moving platform? See the following table for an example:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/moving-platform-unity.md
https://docs.microsoft.com/en-us/hololens/hololens2-moving-platform
https://docs.microsoft.com/en-us/hololens/hololens2-moving-platform#via-mobile-device-management-mdm
https://docs.microsoft.com/en-us/hololens/hololens2-moving-platform#on-device-settings


P RIN C IPA LP RIN C IPA L DESC RIP T IO NDESC RIP T IO N

Respect user choice You should offer the user the choice before changing the
mode for them, and you should continue to respect that
choice for the runtime of the app

Provide a warning to the user Avoid changing mode immediately on start/resume of the
app. This presents a poor user experience, since the user
may not know why the device is losing tracking.

Minimize changing mode When changing the Moving Platform Mode settings the
device will lose tracking, causing a negative user experience.
It's therefore recommended that you minimize the frequency
with which you change the mode. Ideally the mode would
only be changed if the device is transitioning from a
stationary environment to a moving one, or vice versa.

If uncertain about environment, use Moving Platform Mode Moving Platform Mode can work in both stationary
environments and moving ones. The regular tracking
algorithms only work in stationary environments, so if you're
uncertain about whether the environment is moving,
choosing Moving Platform Mode can be the safer choice.

Don't use Moving Platform Mode in known stationary
environments

Moving Platform Mode performs less well than the standard
mode in stationary environments. This is a small
degradation, though will be noticeable to most users.

Consider what mode to leave the device in This SDK allows developers to design experiences that are
robust across boot of the device. Consider if the device will
be on a moving platform next time it boots, and leave the
device in the appropriate mode.

 Where do I get the SDK?

 How do I use this SDK

// Top of file
using Microsoft.MixedReality.MovingPlatform;
// Code body
m_movingPlatformManager = new MovingPlatformManager();

  Reading the current modeReading the current mode

MovingPlatformMode currentMode = m_movingPlatformManager.Mode;

The Moving Platform SDK supports language projections for C# and C++, allowing developers to develop

applications for Win32 or UWP platforms. Download and install the SDK with the Mixed Reality Feature Tool.

After installing the SDK, you can set up your script to use MovingPlatformManger as follows:

The current value of the mode can be read as follows:

MovingPlatformMode is an enum that is defined as follows:



public enum MovingPlatformMode
{
    Standard,                // The legacy mode that devices use out-of-the-box.
    MovingPlatformOptimized  // Allows tracking on moving platforms.
}

  Setting the modeSetting the mode

bool success = m_movingPlatformManager.TrySetMode(MovingPlatformMode.MovingPlatformOptimized);

  Callback on mode changeCallback on mode change

// Code Body
m_movingPlatformManager.ModeChanged += CallbackOnMPMChanged;
...
void CallbackOnMPMChanged(object sender, MovingPlatformEventArgs args)
{
    movingPlatformModeChanged = true;
    movingPlatformModeValue = args.ModeEntered;
}
...
void Update()
{
    // It's not reccomended to do work in the callback.
    if (movingPlatformModeChanged)
    {
        movingPlatformModeChanged = false;
        // Do some work
    }
}

  Checking if mode is settableChecking if mode is settable

bool supported = m_movingPlatformManager.IsSetModeSupported();

 A demo script

Devices that don't have Moving Platform Mode available, like VR devices and HoloLens 1, will always return

'Standard'.

You can set the Moving Platform Mode value as follows:

TrySetMode will return true if the device mode now matches the requested mode. If the mode is already in the

desired state, nothing will be done and the device won't lose tracking.

At times, it could be useful to know if another app, or the user, has changed the Moving Platform Mode value.

You can do this as follows.

Sometimes it's useful to know whether the mode is settable before attempting to change it. For example, if you'd

like to know if there's any value in asking the user their preference. You can find if moving platform mode is

settable with the IsSetModeSupported function:

This function will return true if the device can change modes, and false if that's not possible. This function does

account for Mobile Device Management (MDM) policies. For example, if MDM forces the MovingPlatformMode

to "On", then this function will return false.

This script shows all of the important elements of the SDK in one place. The example doesn't follow the best

practices shown above.



using System.Collections;
using System.Collections.Generic;
using UnityEngine;
using Microsoft.MixedReality.MovingPlatform;
using System;

public class MovingPlatformDemo : MonoBehaviour
{
    public GameObject cube; // A simple cube to display colors.
    private MovingPlatformManager m_movingPlatformManager;
    private Renderer cubeRenderer;
    private bool movingPlatformModeChanged;
    private MovingPlatformMode movingPlatformModeValue;

    // Start is called before the first frame update
    void Start()
    {
        m_movingPlatformManager = new MovingPlatformManager();
        cubeRenderer = cube.GetComponent<Renderer>();

        // Get initial value of mode, 
        // Just this mechanism would be adequate if a one time check is acceptable. 
        MovingPlatformMode initialMovingPlatformMode = m_movingPlatformManager.Mode;

        // Find if It's possible to change the mode. 
        bool isSettable = m_movingPlatformManager.IsSetModeSupported();

        // Here you would add some use case specific logic using initialMovingPlatformMode and isSettable
        // to decide if you should ask the user if they want to change the mode. 

        // To set the mode.
        bool success = m_movingPlatformManager.TrySetMode(MovingPlatformMode.MovingPlatformOptimized);

        // Visual indicator of current state: Green = Moving Platform Optimized, Red = Regular.
        SetColourFromState(m_movingPlatformManager.Mode, cubeRenderer);

        // We set a callback to be notified if there's a change in mode. This is typically optional.
        m_movingPlatformManager.ModeChanged += CallbackOnMPMChanged;
        movingPlatformModeChanged = false;
    }

    // Update is called once per frame
    void Update()
    {
        // This must be done in the UI thread.
        if (movingPlatformModeChanged)
        {
            movingPlatformModeChanged = false;
            SetColourFromState(movingPlatformModeValue, cubeRenderer);
        }
    }

    // Sets renderer to:
    // Green = Moving Platform Mode Enabled
    // Red = Moving Platform Mode Disabled
    void SetColourFromState(MovingPlatformMode mode, Renderer thisRend)
    {
        if (mode == MovingPlatformMode.MovingPlatformOptimized)
        {
            thisRend.material.color = new Color(0f, 1f, 0f, 1f);
        }
        else
        {
            thisRend.material.color = new Color(1f, 0f, 0f, 1f);
        }
    }

    void CallbackOnMPMChanged(object sender, MovingPlatformEventArgs args)



    {
        movingPlatformModeChanged = true;
        movingPlatformModeValue = args.ModeEntered;
    }
}

 See also
Moving Platform Mode

https://docs.microsoft.com/en-us/hololens/hololens2-moving-platform
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 Two modes in Holographic Remoting are available

M O DEM O DE REM OT E A P P  RUN N IN G O N  P CREM OT E A P P  RUN N IN G O N  P C
H O LO GRA P H IC  REM OT IN G P L AY ERH O LO GRA P H IC  REM OT IN G P L AY ER
A P P  RUN N IN G O N  H O LO L EN S 2A P P  RUN N IN G O N  H O LO L EN S 2

Mode 1 Connect mode Listen mode

Mode 2 Listen mode Connect mode

 Set up the Holographic Remoting Player app

This article explains the following use case for Holographic Remoting:

You want the resources of a PC to power your app instead of relying on the HoloLens on-boardYou want the resources of a PC to power your app instead of relying on the HoloLens on-board

resourcesresources : You can create and build an app that has Holographic Remoting capability. The user experiences

the app on the HoloLens, but the app actually runs on a PC, which allows the app to take advantage of the

PC's more powerful resources. This can be especially helpful if your app has high-resolution assets or models

and you don't want the frame rate to suffer. We call this a Holographic Remoting remote app. Inputs from the

HoloLens--gaze, gesture, voice, and spatial mapping--are sent to the PC, where the content is rendered in a

virtual immersive view. The rendered frames are then sent to the HoloLens.

This type of Holographic Remoting is also available for Windows Mixed Reality (WMR) immersive headsets. This

could be useful if, for example, your WMR headset is connected to a backpack PC and you wish to stream your

app from a more powerful PC to the backpack PC.

To learn more about Holographic Remoting, see Holographic Remoting Overview

Note that you can also use Holographic Remoting if you want to preview and debug your app during the

development process.

To use Holographic Remoting in Mode 1 alone, install the Holographic Remoting Player app from the Microsoft

Store on your HoloLens 2. As explained below, after you download and run the app, you'll see the version

number and IP address to connect to. We recommend using the latest version of Holographic RemotingWe recommend using the latest version of Holographic Remoting

Player availablePlayer available.

Holographic Remoting requires a fast PC and Wi-Fi connection. You can find more details in the Holographic

Remoting Player article linked above.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/use-pc-resources.md


 Build a remote app running on PC for Holographic Remoting using
Unity

To use Holographic Remoting in both modes specified above, you need to clone Holographic Remoting Sample

player and deploy it to HoloLens 2 using Visual Studio.

StartCoroutine(Remoting.AppRemoting.Connect(remotingConfiguration));

1. On the menu bar, select Edit > Project SettingsEdit > Project Settings .

2. In the left-side column, select XR plug-in ManagementXR plug-in Management.

3. In the XR Plug-in ManagementXR Plug-in Management section, select Microsoft HoloLens feature groupMicrosoft HoloLens feature group and

Holographic Remoting remote app feature groupHolographic Remoting remote app feature group.

4. Unselect Initialize XR on Star tupInitialize XR on Star tup:

5. Write some code to set the remoting configuration and trigger XR initialization. The app can either call

into ConnectConnect function for Mode 1, or call into L istenListen function for Mode 2. Refer to the sample app

distributed with the Mixed Reality OpenXR Plugin containing AppRemoting.cs for more details.

6. For Mode 1, the ConnectConnect mode, call Microsoft.MixedReality.OpenXR.Remoting.AppRemoting.Connect  with a

filled-in RemotingConfiguration . The sample app exposes this in the inspector and shows how to fill in the

IP address from a text field. Calling Connect  will set the configuration and automatically initialize XR,

which is why it must be called as a coroutine:

7. For Mode 2, the L istenListen mode, call Microsoft.MixedReality.OpenXR.Remoting.AppRemoting.Listen  with a

https://github.com/microsoft/MixedReality-HolographicRemoting-Samples/blob/main/player/sample/SamplePlayer.sln


 Run the remote app and Holographic Remoting Player app in the
modes described above
  Mode 1: Run the remote app on PC in Connect Mode and the Holographic Remoting player app in ListenMode 1: Run the remote app on PC in Connect Mode and the Holographic Remoting player app in Listen
Mode:Mode:

  Mode 2: Run the remote app on your PC in Listen Mode and the HAR player app in Connect Mode:Mode 2: Run the remote app on your PC in Listen Mode and the HAR player app in Connect Mode:

StartCoroutine(Remoting.AppRemoting.Listen(remotingListenConfiguration));

filled-in RemotingListenConfiguration . The sample app exposes this in the InspectorInspector . Calling Listen  will

set the configuration and wait for a connection from the Holographic Remoting sample player, which is

why it must be called as a coroutine:

8. While running, you can obtain the current connection state with the AppRemoting.TryGetConnectionState

API, and optionally disconnect and de-initialize XR using AppRemoting.Disconnect() . This could be used to

disconnect and reconnect to a different device within the same app session. The sample app provides a

tappable cube which will disconnect the remoting session if tapped.

If the Holographic Remoting Player app is already installed from the store on the HoloLens 2, skip the

three steps below and run the app.

Open the Holographic Remoting Sample Player app using VS 2019. In order to run on a HoloLens 2 that's

attached to your PC using a USB cable, configure as follows: 

Open the Proper tiesProper ties  page for your project, navigate to Configuration Proper tiesConfiguration Proper ties  > DebuggingDebugging >

Remote MachineRemote Machine, and then, in the Command Line ArgumentsCommand Line Arguments  field, add "-listen". 

To deploy the SamplePlayer solution on HoloLens 2, press the play button in the VS solution. You'll be

able to see the HAR Sample player running on HoloLens 2, displaying that it is "Waiting for a connection

on IP address of HoloLens 2."

In the remote app running on the host PC, add the IP address of HoloLens 2 displayed above and then

select ConnectConnect.

After the connection is established, the Holographic Remoting Player app running on HoloLens 2 will

start "Receiving".

On the 2D UI screen in the remote app running on PC, click L istenListen.

Open the Holographic Remoting Sample Player app using VS 2019. In order to run on a HoloLens 2 that's

attached to your PC using a USB cable, configure as follows: 



 Migrate from previous Holographic Remoting APIs

  UnityEngine.XR.WSA.HolographicRemotingUnityEngine.XR.WSA.HolographicRemoting

XR. W SA . H O LO GRA P H IC REM OT IN GXR. W SA . H O LO GRA P H IC REM OT IN G O P EN XR. REM OT IN G. A P P REM OT IN GO P EN XR. REM OT IN G. A P P REM OT IN G

HolographicRemoting.ConnectRemotingSession() AppRemoting.Connect(RemotingConfiguration)

HolographicRemoting.DisconnectRemotingSession() AppRemoting.Disconnect()

HolographicRemoting.ConnectionState AppRemoting.TryGetConnectionState(out
ConnectionState, out DisconnectReason)

  UnityEngine.XR.WindowsMR.WindowsMRRemotingUnityEngine.XR.WindowsMR.WindowsMRRemoting

XR.XR . W IN DO W SW IN DO W S M R. W IN DO W SM RREM OT IN GM R. W IN DO W SM RREM OT IN G O P EN XR. REM OT IN G. A P P REM OT IN GO P EN XR. REM OT IN G. A P P REM OT IN G

WindowsMRRemoting.Connect() AppRemoting.Connect(RemotingConfiguration)

WindowsMRRemoting.Listen() AppRemoting.Listen(RemotingListenConfiguration)

WindowsMRRemoting.Disconnect() AppRemoting.Disconnect()

WindowsMRRemoting.TryGetConnectionState(out
ConnectionState)

and 
WindowsMRRemoting.TryGetConnectionFailureReason(out
ConnectionFailureReason)

AppRemoting.TryGetConnectionState(out
ConnectionState, out DisconnectReason)

WindowsMRRemoting.isAudioEnabled , 

WindowsMRRemoting.maxBitRateKbps , 

WindowsMRRemoting.remoteMachineName

Passed into AppRemoting.Connect  via the 

RemotingConfiguration  struct

Give in the IP address of the host PC as command line argument to the SamplePlayer app. Right click on

SamplePlayer project → Properties→ Configuration Properties → Debugging → Command Line

Arguments 

To deploy the SamplePlayer solution on HoloLens 2, press the play button in the VS solution. You'll be

able to see the HAR Sample player running on HoloLens 2, displaying that it is "Connecting to IP address

given in command line arguments"

Once the connection is established, the Holographic Remoting Sample Player app running on HoloLens 2

will start "Receiving".

To learn more about Holographic Remoting, see Holographic Remoting Overview

From the sample code on Unity's docs:

https://docs.unity3d.com/2020.1/Documentation/ScriptReference/XR.WSA.HolographicRemoting.html


WindowsMRRemoting.isConnected AppRemoting.TryGetConnectionState(out
ConnectionState state, out _) && state ==
ConnectionState.Connected

XR.XR . W IN DO W SW IN DO W S M R. W IN DO W SM RREM OT IN GM R. W IN DO W SM RREM OT IN G O P EN XR. REM OT IN G. A P P REM OT IN GO P EN XR. REM OT IN G. A P P REM OT IN G

 See Also
Holographic Remoting Overview

Preview and debug your app with Holographic Remoting and Play mode

Tutorial: Getting started with PC Holographic Remoting

Tutorial: Creating a Holographic Remoting PC application

https://docs.microsoft.com/en-us/learn/modules/pc-holographic-remoting-tutorials/
https://docs.microsoft.com/en-us/learn/modules/pc-holographic-remoting-tutorials/4-create-holographic-remoting-pc-application
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 Get the tools

 Getting started with Vuforia Engine

 Configuring a Vuforia App for HoloLens

 Build and Run the Vuforia Engine Sample for HoloLens

Vuforia Engine brings an important capability to HoloLens – the power to connect AR experiences to specific

images and objects in the environment. You can use this capability to overlay guided step-by-step instructions

on top of machinery for the industrial enterprise or add digital features and experiences to a physical product or

game.

Vuforia Engine offers a broad range of features and targets to make your AR development process more flexible.

One of our newest features, Vuforia Model Targets, is a key capability for both commercial and industrial uses.

Model Targets allow applications to recognize physical objects like machines, automobiles, or toys and track

them based on a CAD or digital 3D model. For industrial uses, this feature can provide assembly workers and

service technicians with AR work instructions and procedural guidance while in the factory or out in the field.

Existing Vuforia Engine apps that were built for phones and tablets can easily be configured in Unity to run on

HoloLens. You can even use Vuforia Engine to take your new HoloLens app to Windows 10 tablets such as the

Surface Pro and Surface Book.

Install the recommended versions of Visual Studio and Unity and then configure Unity to use Visual Studio and

the preferred IDE and compiler.

When installing Unity, be sure to install the “Windows Store IL2CPP Scripting Backend”.

Add the Vuforia Engine package as described here..

The best starting point for learning about Vuforia Engine and HoloLens is the Vuforia Engine HoloLens sample

(available in the Unity Asset Store). The sample provides a complete HoloLens project including pre-configured

scenes that can be deployed to a HoloLens.

The scenes show how to use Vuforia Image Targets to recognize an image and augment it with digital content in

a HoloLens experience. The Vuforia Engine HoloLens Sample also includes a scene showing the usage of Model

Targets and VuMarks on HoloLens. You can easily substitute your own content in the scenes to experiment with

the creation of HoloLens apps that use Vuforia Engine.

Developing a Vuforia Engine app for HoloLens is fundamentally the same as developing Vuforia Engine apps for

other devices. You can then apply the build settings and configurations described in the section below. That’s all

that’s needed to enable Vuforia Engine to work with the HoloLens spatial mapping and positional tracking

systems.

1. Download the Vuforia Engine Sample for HoloLens from the Unity Asset Store

2. Apply the recommended Unity engine options for power and performance

3. Add the sample scenes to ScenesScenes  in Build.Build.

4. In Build SettingsBuild Settings , switch build platform to UWPUWP by clicking the Add Open ScenesAdd Open Scenes  button. 

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/vuforia-development-overview.md
https://library.vuforia.com/content/vuforia-library/en/articles/Solution/vuforia-engine-package-hosting-for-unity.html
https://assetstore.unity.com/packages/templates/packs/vuforia-hololens-sample-101553
https://assetstore.unity.com/packages/templates/packs/vuforia-hololens-sample-101553


 The Vuforia Developer Portal

5. Select the Player SettingsPlayer Settings  button.

Select the UWPUWP icon and expand the XR SettingsXR Settings  section.

Ensure that Vir tual Reality Suppor tedVir tual Reality Suppor ted is enabled.

Under Vir tual Reality SDKsVir tual Reality SDKs  ensure that:

Ensure that the Stereo Rendering ModeStereo Rendering Mode is set to S ingle Pass Instanced.S ingle Pass Instanced.

Window Mixed RealityWindow Mixed Reality  is included in the list and that Enable Depth BufferEnable Depth Buffer  Sharing is enabled.

The Depth FormatDepth Format is set to 16-bit depth.16-bit depth.

6. Expand the Publishing SettingsPublishing Settings  section.

Under CapabilitiesCapabilities  ensure that Internet Client, WebCam, Microphone,Internet Client, WebCam, Microphone, and SpatialPerceptionSpatialPerception are

selected.

NOTE: SpatialPerceptionNOTE: SpatialPerception should only be selected if you intend to use the Surface Observer API.

Under Suppor ted Device FamiliesSuppor ted Device Families , ensure that HolographicHolographic is selected.

7. Expand the Resolution and PresentationResolution and Presentation section.

Disable Run in BackgroundRun in Background so that Vuforia Engine pauses when the app is put into the background and

can access the camera again when the app is resumed.

In the Default OrientationDefault Orientation dropdown, ensure that Landscape LeftLandscape Left is selected.

8. Return to the Build SettingsBuild Settings  window and select BuildBuild to generate a Visual Studio project.

9. Build the executable from Visual Studio and install it on your HoloLens.

Developers looking to create their own AR experiences with Vuforia Engine and HoloLens should sign up on our

Vuforia Developer Portal at developer.vuforia.com. In the portal, developers have access to the Vuforia Engine

Forums where they can join community discussions, a library with in-depth documentation on all the Vuforia

Engine Features, and the Vuforia Target Manager where users can create their own custom Targets. Developers

can also sign up for a free Developer License using the Vuforia License Manager.

https://developer.vuforia.com/
https://developer.vuforia.com/forum
https://library.vuforia.com/
https://developer.vuforia.com/target-manager
https://developer.vuforia.com/license-manager


 Device Tracking with Vuforia

 Performance Mode with Vuforia Engine

 See also

Device Tracking maintains tracking even when a target is no longer in view. It's automatically enabled for all

targets when the Positional Device Tracker is enabled. For HoloLens applications, the Positional Device Tracker is

started automatically in Unity.

Vuforia Engine automatically fuses the poses from camera tracking and HoloLens's spatial tracking to provide

stable target poses independent of whether the target is seen by the camera or not.

Since the process is handled automatically, it doesn't require any programming by the developer.

The following is a high-level descr iption of the process:The following is a high-level descr iption of the process:

1. Vuforia’s target Tracker recognizes the target

2. Target tracking is then initialized

3. The position and rotation of the target are analyzed to provide a robust pose estimate for the HoloLens

4. Vuforia Engine transforms the target's pose into the HoloLens spatial mapping coordinate space

5. HoloLens takes over tracking if the target is no longer in view. Whenever you look again at the target, Vuforia

will continue to track the images and objects accurately.

Targets that are detected, but no longer in view, are reported as EXTENDED_TRACKED. In these cases, the

DefaultTrackableEventHandler script that is used on all targets continues to render augmentation content. The

developer can control this behavior by implementing a custom trackable event handler script.

It's possible through the Vuforia Engine to manage the performance on the HoloLens to extent AR experiences

and reduce the workload on the CPU. The Vuforia Engine offers three modes that can be selected: default, for

optimizing speed, and for optimizing quality.

MODE_OPTIMIZE_SPEED lets you minimize the workload on the HoloLens device and is great for extending

AR experiences. We recommended for situations where the app is tracking static objects/targets.

MODE_DEFAULT is the normal mode, which can be used in most scenarios.

MODE_OPTIMIZE_QUALITY is better for tracking movable targets or model targets you expect to be picked

up.

Setting the modeSetting the mode

To change the performance mode in Unity, navigate to Vuforia Configuration (Ctrl+Shift+V / Cmd+Shift+V) that

is located as a component in the ARCamera GameObject.

Select the dropdown menu for Camera Device Mode and select one of the three options.

Install the tools

Coordinate systems

Spatial mapping

Camera in Unity

Build and deploy a Unity Visual Studio solution to the Hololens

Vuforia documentation: Getting Started with Vuforia Engine for Windows 10 Development

Vuforia documentation: Getting Started with Vuforia Engine in Unity

Vuforia documentation: Working with the HoloLens sample in Unity

Vuforia documentation: Device Tracking in Vuforia

https://library.vuforia.com/features/environments/device-tracker-overview.html
https://library.vuforia.com/articles/Training/Getting-Started-with-Vuforia-for-Windows-10-Development.html
https://library.vuforia.com/articles/Training/getting-started-with-vuforia-in-unity.html
https://library.vuforia.com/articles/Solution/Working-with-the-HoloLens-sample-in-Unity.html
https://library.vuforia.com/features/environments/device-tracker-overview.html


Vuforia documentation: Framerate and Performance Optimization

https://library.vuforia.com/content/vuforia-library/en/articles/Solution/Framerate-Optimization-for-Mixed-Reality-Apps.html


   

 

Surfaces
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NOTENOTE

 Download app from Microsoft Store in HoloLens 2

 Demo video

 About the app

This article discusses an exploratory sample we’ve created in the Mixed Reality Design Labs, a place where we share our

learnings about and suggestions for mixed reality app development. Our design-related articles and code will evolve as

we make new discoveries.

Surfaces is an open-source sample app from Microsoft's Mixed Reality Design Labs. It explores how we can

create a tactile sensation with visual, audio, and fully articulated hand-tracking.

If you have HoloLens 2 device, you can directly download and install the app in your device.

Recorded with HoloLens 2 using Mixed Reality Capture

Surfaces demonstrates how to use Mixed Reality Toolkit(MRTK)'s input system and building blocks to create an

app experience for HoloLens 2. In this project, you can find the examples of:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/sampleapp-surfaces.md
https://github.com/Microsoft/MRDesignLabs_Unity
https://github.com/microsoft/MRDL_Unity_Surfaces
https://www.microsoft.com/store/apps/9nvkpv3sk3x0?cid=storebadge&ocid=badge
https://www.microsoft.com/en-us/videoplayer/embed/RE4IhWQ


 MR Dev Days 2020 - Learnings from the MR Surfaces App

 Project repository on GitHub

 About the author

Yoon ParkYoon Park
UX Designer @Microsoft

 See also

Use MRTK's Input System, specifically hand / joint tracking.

Use MRTK's Standard Shader for performant graphics.

You can use this project's components to create your own mixed reality app experiences.

Learnings from the MR Surfaces App

Lars Simkins, Senior designer behind the MRDL Surfaces app talks about the app's design story and technical

highlights.

https://github.com/microsoft/MRDL_Unity_Surfaces

MRTK Examples Hub - (Download from Microsoft Store in HoloLens 2)

Surfaces - (Download from Microsoft Store in HoloLens 2)

Periodic Table of the Elements 2.0

Galaxy Explorer 2.0

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/input/overview
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/rendering/mrtk-standard-shader
https://docs.microsoft.com/en-us/shows/mixed-reality/learnings-from-the-mr-surfaces-app
https://github.com/microsoft/MRDL_Unity_Surfaces
http://dongyoonpark.com
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/example-scenes/example-hub
https://www.microsoft.com/en-us/p/mrtk-examples-hub/9mv8c39l2sj4
https://www.microsoft.com/en-us/p/surfaces/9nvkpv3sk3x0
https://medium.com/@dongyoonpark/bringing-the-periodic-table-of-the-elements-app-to-hololens-2-with-mrtk-v2-a6e3d8362158


   

 

Periodic Table of the Elements 2.0
 7/6/2022 • 2 minutes to read • Edit Online

NOTENOTE

 Demo video

 Download the app package from GitHub

 Upgrading the project for HoloLens 2 with MRTK

 OpenXR

This article discusses an exploratory sample we’ve created in the Mixed Reality Design Labs, a place where we share our

learnings about and suggestions for mixed reality app development. Our design-related articles and code will evolve as

we make new discoveries.

Periodic Table of the Elements is an open-source sample app from Microsoft's Mixed Reality Design Labs. The

app was originally designed for HoloLens 1st generation and immersive headset back in 2015 to demonstrate

how to create an end-to-end experience using MRTK's building blocks. To fully leverage new articulated hand

tracking and eye tracking input on HoloLens 2, the app has been updated using MRTK v2.

Recorded with HoloLens 2 using Mixed Reality Capture

Checkout the ReleaseReleasepage on GitHub.

You can find HoloLens 2 porting story from the article: Br inging the Periodic Table of the Elements app toBringing the Periodic Table of the Elements app to

HoloLens 2 with MRTK v2 (2019)HoloLens 2 with MRTK v2 (2019)

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/periodic-table-of-the-elements-2.md
https://github.com/Microsoft/MRDesignLabs_Unity
https://github.com/Microsoft/MRDesignLabs_Unity_PeriodicTable
https://www.microsoft.com/en-us/videoplayer/embed/RE4IkCF
https://github.com/microsoft/MRDL_Unity_PeriodicTable/releases
https://dongyoonpark.medium.com/bringing-the-periodic-table-of-the-elements-app-to-hololens-2-with-mrtk-v2-a6e3d8362158


 Design story

 About the author

Yoon ParkYoon Park
UX Designer @Microsoft

 See also

Read a story on updating Periodic Table project to Unity 2020 + OpenXR pipeline: Updating MRTK MixedUpdating MRTK Mixed

Reality Project to OpenXR+Unity 2020: Per iodic Table of the Elements for HoloLens 2 (2021)Reality Project to OpenXR+Unity 2020: Per iodic Table of the Elements for HoloLens 2 (2021)

Check out the design story on the Periodic Table of the Elements app: Per iodic Table of the Elements 1.0Periodic Table of the Elements 1.0

MRTK Examples Hub - (Download from Microsoft Store in HoloLens 2)

Surfaces - (Download from Microsoft Store in HoloLens 2)

Galaxy Explorer 2.0

https://dongyoonpark.medium.com/updating-mrtk-mixed-reality-project-to-openxr-unity-2020-periodic-table-of-the-elements-4cf55b0479a4
http://dongyoonpark.com
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/example-scenes/example-hub
https://www.microsoft.com/en-us/p/mrtk-examples-hub/9mv8c39l2sj4
https://www.microsoft.com/en-us/p/surfaces/9nvkpv3sk3x0


   

 

The making of Galaxy Explorer for HoloLens 2
 7/6/2022 • 12 minutes to read • Edit Online

 Download app from Microsoft Store in HoloLens 2

Welcome to the updated Galaxy Explorer for HoloLens 2 application! Galaxy Explorer was originally developed

as an open-source application for HoloLens (first gen) through the Share Your Idea program, and is one of the

first mixed reality experiences many people had. Now we're updating it for the new and exciting capabilities of

HoloLens 2.

As one of the Microsoft Mixed Reality Studios, we usually develop commercial grade solutions and are

developing & testing on target platforms throughout the creative and development process. We're embarking

on this project using the frameworks and tools (like MRTK) as they become available to us and the community -

and we want to bring you along for the ride.

Just like the original Galaxy Explorer, our team will be open sourcing the project on GitHub to ensure the

community has full access. We'll also be documenting our journey here in complete transparency about how we

ported from MRTK v1 to MRTK v2, enhanced the experience with new features available in HoloLens 2, and

ensured that Galaxy Explorer remained a multi-platform experience. Whether you're viewing Galaxy Explorer on

HoloLens (first gen), HoloLens 2, a Windows Mixed Reality headset or on your Windows 10 desktop, we want to

make sure you're enjoying the journey as much as we are!

This page will expand as we progress through the project with links to more detailed articles, code, design

artifacts, and additional MRTK documentation to provide you with an insider's look at the project.

If you have HoloLens 2 device, you can directly download and install the app in your device.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/galaxy-explorer-update.md
https://docs.microsoft.com/en-us/windows/mixed-reality/galaxy-explorer
https://www.microsoft.com/hololens/hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/
https://github.com/Microsoft/GalaxyExplorer
https://www.microsoft.com/store/apps/9nblggh4q4jg?cid=storebadge&ocid=badge


 

Thinking about interactions

  Direct manipulation vs. the vast distances in spaceDirect manipulation vs. the vast distances in space

  Back to the drawing boardBack to the drawing board

As a creative studio, we were ecstatic about the privilege to port Galaxy Explorer to HoloLens 2. We knew from

the start that we wanted the experience to be a celebration of the new device and to demonstrate that Mixed

Reality empowerment is limited only by the imagination.

HoloLens 2 allows users to touch, grasp, and move holograms in ways that feel natural – they respond a lot like

real objects. Fully articulated hand models are amazing, because it lets users do what feels natural. For example,

everybody picks up a cup slightly differently – and instead of enforcing one particular way to do it, HoloLens 2

lets you do it your way.

This is a significant change from the Air Tap-based interfaces on first-generation HoloLens devices. Instead of

interacting with holograms from a distance, users can now get "up close and personal". When porting existing

experiences over to HoloLens 2 or planning new ones, it's important to make yourself familiar with the direct

manipulation of holograms.

It's a magical experience to reach out, grab a planet and hold it in your hand. The challenge with this approach is

the size of the solar system – it's huge! The user would need to walk around their room to get close to each

planet to interact with it.

To allow users to interact with objects that are farther away, MRTK offers hand rays that shoot out from the

center of the user's palm, acting as an extension of the hand. A donut-shaped cursor is attached to the end of the

ray to indicate where the ray intersects with a target object. The object that the cursor lands on can then receive

gestural commands from the hand.

In the original version of Galaxy Explorer, the user would target a planet with the gaze cursor and then air tap to

call it closer. The easiest way to port the experience to HoloLens 2 is to take this behavior and use hand rays to

select planets. While this was functional, it left us wanting more.

We came together to ideate what could be built on top of the existing interactions. The thinking was: Although

HoloLens 2 allows users to interact with holograms in natural, realistic ways, holograms are by definition not

real. So as long as an interaction is plausible for the user, it doesn't matter if that interaction would be possible

with a real object or not – we can make it possible.

One concept that we explored was based on telekinesis – the power to manipulate objects with one's mind.

Often seen in super hero movies, a person would reach out with their mind and call an object into their open

hand. We played around with the idea some more and came up with a quick sketch of how the concept could

work.

https://www.youtube-nocookie.com/embed/wogJv5v9x-s
https://www.youtube-nocookie.com/embed/Qol5OFNfN14


  Force grab prototypingForce grab prototyping

  Implementing force grab into the applicationImplementing force grab into the application

The user would point the hand ray at a planet, which would provide target feedback. As the user then extends

their open hand, the planet would be pulled towards the user by a magical force until it's close enough to grab it.

Hence our name for the interaction: force grab. As the user would push away the planet with their open hand, it

would return again to its orbit.

We then created multiple prototypes to test the concept: How does the interaction feel overall? Should the called

object stop in front of the user or stick to their hands until placed? Should the called object change size or scale

while being called?

When we tried the force grab on planets, we realized that we had to change the scale of the solar system. It

turned out that an accurate, medium-sized representation of the solar system is difficult for users to understand

and navigate - they didn't know where to look. However, a small-sized-representation made some planets too

small to be easily selected. As a result, the size of the planets and the spacing between solar objects was

designed to feel comfortable within a medium-sized room while maintaining relative accuracy.

During the later stages of our development sprint, we were lucky enough to have fellow MSFT Mixed Reality

experts in-house, so we got to work getting their input as expert testers and doing quick iterations on the force

grab interaction.



  Adding affordances for targetingAdding affordances for targeting

  Adding affordances for force grabAdding affordances for force grab

In picture: Jenny Kam, Senior Design Lead, testing a work-in-progress of Galaxy Explorer.

As we experimented on HoloLens 2, we found that even though the new interactions are natural and intuitive,

holograms remain the same: with no weight or tactile sensations. Since holograms don't provide natural

feedback that humans are used to receiving when they interact with objects, we needed to create them.

We thought about the visual and audio feedback that users would be provided for the various stages of their

interactions, and since the force grab mechanism is central to interacting with Galaxy Explorer, we did many

iterations. The aim was to find the right balance of audio and visual feedback for each stage of the interaction:

focusing on the intended object, calling it to the user, and then releasing it. What we learned is that more audio

and visual feedback was required to reinforce the interaction than we were used to for HoloLens (first gen).

  Once we had the basic force grab mechanism with audio and visual affordances, we looked at how to make

selecting planets more user-friendly. There were two main things to address: Because the solar system is a 3D

moving interface, there's added complexity for users to learn how to target objects consistently. This was

compounded by the fact that the hand ray is fast at selecting an object, making planets move towards the user

incredibly quickly.

We approached this with a three-pronged solution. The first was fairly intuitive: slow down the selection process

so that planets approach the user at a more natural pace. Once the speed was adjusted, we had to revisit the

audio and visual affordances, adding audio feedback as the planet tracked towards the user.



 Spotlight on Jupiter

  Geometry and meshesGeometry and meshes

The second part of the solution was to make the visualization of the entire force grab interaction tangible. We

visualized a thick line that moves towards the targeted object once the hand ray connects with it, and then

brings the object back to the user - like a lasso.

Finally, we optimized the scale of the solar system so that the planets were large enough for the user's gaze and

hand ray to target them.

These three improvements allowed users to make accurate selections, calling planets to them in an intuitive way.

Overall, the effect of the final force grab is a more immersive and interactive experience in the solar system.

Creating the solar bodies of the Milky Way was a humbling experience. In particular, the unique characteristics of

Jupiter make it a sight to behold. It's the largest and most colorful of the gas giants, and contains more mass

than all other planets combined. Its sheer size and mesmerizing bands of turbulence and cloud dynamics are

prefect for special artistic attention.

As a gas giant, Jupiter's outer shells consists of gaseous layers. The combination of its fast rotational speed,

inner heat exchange, and Coriolis forces creates colorful layers and streams that form into swirling cloud belts

and vortices. Capturing this intricate beauty was key in creating our solar system.

It was immediately clear that using visualizing techniques like fluid simulations and animated textures with

precomputed streams were out of question. The computing power required to simulate this in combination with

everything else happening simultaneously would have had significant detrimental impacts on performance.



  TexturingTexturing

The next approach was a 'smoke-and-mirror' solution, consisting of overlaying transparent texture layers, each

of which addressed a specific aspect of the atmospheric movement, compiled on a composition of rotating

meshes.

In the image below, you can see the inner shell on the left. This mat layer provided a background to the

composition to guard against any small gaps between the multiple layers that made up the clouds. Because of

the layer's slow rotation, it also served as a visual buffer between the faster moving bands to help build visual

unity throughout the layers.

After setting this anchor to the model, the moving cloud layers were then projected on the middle and right

meshes seen below.

The existing texture was separated into a three-part texture atlas: The upper third hosts a motionless layer of

clouds with gaps to provide a parallax effect, the middle section contains the fast moving outer streams, and the

lower third contains a slowly rotating inner base layer.

The characteristic Great Red Spot was also separated into its various moving parts and then inserted into an

otherwise invisible area of the texture. These components can be seen as the red-toned speckles in the middle

section of the image below.

Because each band has a specific direction and speed, the texture was applied to each mesh individually. The

meshes then had a common center and pivot point, which made it possible to concentrically animate the whole

surface.



  Rotation and texture behaviorRotation and texture behavior
Once the the visual composition of Jupiter was set, we needed to ensure the rotation and orbit speeds were

properly calculated and applied accordingly. It takes roughly 9 hours for Jupiter to complete a full rotation. This

is a matter of definition due to its Differential Rotation. Therefore the equatorial stream has been set as a 'master

stream', taking 3600 frames for a full rotation. Every other layer needed to have a rotational speed as a factor of

3600 in order to match its initial position, allowing, e.g., 600, 900, 1200, 1800 etc.



  The Great Red SpotThe Great Red Spot

  Getting it right in UnityGetting it right in Unity

The individually rotating streams provided a good visual impression, but lacked in detail when observed at close

range.

The most eye-catching part was Jupiter's Great Red Spot, so we created a set of meshes and textures specifically

to showcase it.   We used a similar mechanism as with Jupiter's bands: a set of rotating parts was composed on

top of each other, while also being grouped under its 'master layer' to ensure they remain in position no matter

how fast the rest moves.

When the meshes were set up and in place, different layers of the stormy vortex were applied and each disc was

then animated individually, the center pieces moving fastest, with the rest progressively slowing down as it

moving outwards.

The composition also had the same pivot as every other mesh, while also keeping its tilt from its original y-axis

(!) to allow freedom in animating the rotation. 3600 frames is the base rate, with each layer having a factor of

this as a period of rotation.

There are a couple of key things to keep in mind when implementing this in Unity.

Unity is easily confused when dealing with large sets of transparent layers. The solution was to duplicate the

texture material for each mesh and apply ascending Render Queue values progressively from the inner to the

outer by 5 to each material.

The result was the inner shell had a Render Queue value of 3000 (default), the static red-toned outer later had a

value of 3005, the fast white outer clouds had 3010. The Great Red Spot (progressing from inner to outer layer),

finished with a value of 3025 in this model.



  Final touchesFinal touches
The textured Jupiter layers were set up at first, which proved to be insufficient for implementation.

The original Planet Standard shader, and all of its variations, receive their lighting information via a script, the

SunLightReceiver, which is not supported by the MRTK Standard shader.

Simply swapping the shaders wasn't a solution because the Planet Standard shader doesn't support texture

maps with transparencies. We edited this shader to make the Jupiter build work as intended.

Finally, the Alpha Blends needed to be set up by setting the Source Blend to 10 and the Destination Blend to 5.

You can see the final rendering of Jupiter in Galaxy Explorer!



 

Meet the team

 Additional information
  Mixed Reality StudiosMixed Reality Studios

Our Mixed Reality studio team is made up of designers, 3D artists, UX specialists, developers, a program

manager, and a studio head. We hail from all over the world: Belgium, Canada, Germany, Israel, Japan, the United

Kingdom, and the United States. We're a multidisciplinary team that comes from a diverse background: gaming -

both traditional and indie, digital marketing, health care and science.

We're excited to create Galaxy Explorer for HoloLens 2, and to update the HoloLens (first gen), VR, and desktop

versions.

On top from left to right: Artemis Tsouflidou (Developer), Angie Teickner (Visual Designer), David Janer (UX

Designer), Laura Garrett (Delivery & Production Lead), Yasushi Zonno (Creative Lead), Eline Ledent (Developer),

and Ben Turner (Sr. Developer). Bottom from left to right: Amit Rojtblat (Technical Artist), Martin Wettig (3D

Artist), and Dirk Songuer (Studio Head). Not featured: Tim Gerken (Tech Lead) and Oscar Salandin (Visual

Designer).

Microsoft Mixed Reality Studio teams - located in the Americas, Europe, and Asia-Pacific - are experts in user

experience design, holographic computing, AR/VR technologies, and 3D development; including 3D asset

creation, DirectX, Unity and Unreal. We help envision desired futures, design, build and deliver solutions, while

enabling customers to create measurable impact across their organization. The studios work closely with over

22,000 Microsoft Services professionals for enterprise application integration, adoption, operations, and

support.



   

 

Quality Fundamentals
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 Device I/O and environment

  SurfacesSurfaces

Quality Fundamentals is a HoloLens 2 app that demonstrates the fundamentals of building a great mixed reality

experience. Instead of just learning and reading about quality issues in mixed reality, we can now experience

common environmental, design, and performance issues and solutions firsthand by selecting the options

provided in the app.

To download and install the app, go to the app download page:

Quality Fundamentals

In this sample app, we'll learn about:

Device I/O and environment: How the environmental factors can affect HoloLens' performance.

Spatial Anchors: How to align holograms to a physical space by using spatial anchors.

Holographic stability and fidelity: Explore techniques to help improve the stability and fidelity of Holograms.

3D asset fundamentals: How to optimize 3D assets to maintain high visual fidelity.

Start the Quality Fundamentals app on HoloLens. Once the app's homepage appears, select Device I/O andDevice I/O and

EnvironmentEnvironment. We'll explore how the HoloLens sensors and the surrounding environment affect spatial

mapping, tracking and the placement of holograms.

Mirrors or surfaces with mirrored finishes can confuse the HoloLens sensors about the shape of the object.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/quality-fundamentals.md
https://www.microsoft.com/p/quality-fundamentals/9mwz852q88fw?activetab=pivot:overviewtab


  LightingLighting

 Anchor fundamentals

 Stability and fidelity

  Frame rateFrame rate

Objects reflected on the surface may be interpreted by the device as changing environment, which can cause the

device to lose tracking. If mirrored surfaces are causing challenges for HoloLens, consider adding a screen or

closable blinds.

For more information, see surfaces in a space in HoloLens environment considerations.

HoloLens performance can be negatively impacted by either very low or very bright light conditions. The

tracking sensors on the HoloLens need around 500-1000 lux of light to operate optimally. You can use a

luxmeter or mobile app to measure the amount of light in your space.

For more information, see lighting in HoloLens environment considerations.

To explore how to use Spatial Anchors to align holograms to a physical space, select Anchor FundametalsAnchor Fundametals  on

the app's homepage.

In this part of the app, we'll explore the following user scenarios:

What happens when no anchor is being applied to an object.

When multiple Spatial Anchors are being used for a group of objects.

Sharing a Spatial Anchor between multiple collaborators by using a QR code.

Anchor placement for very large objects in a space.

For more information, see Spatial Anchors in the Mixed Reality documentation.

On the application's homepage, select Stability and FidelityStability and Fidelity  to explore how to improve hologram stability.

We'll explore the following key concepts:

Frame rate.

Late stage reprojection (LSR).

Z-fighting.

Anti-aliasing.

To provide the best hologram experience possible, application developers must maintain 60 frames per second

(FPS). In this part of the app, toggle between different triangle count options to experience the difference with

various frame rates.

https://docs.microsoft.com/en-us/hololens/hololens-environment-considerations#surfaces-in-a-space
https://docs.microsoft.com/en-us/hololens/hololens-environment-considerations
https://docs.microsoft.com/en-us/hololens/hololens-environment-considerations?branch=pr-en-us-3071#lighting
https://docs.microsoft.com/en-us/hololens/hololens-environment-considerations


  Late stage reprojection (LSR)Late stage reprojection (LSR)

  Z-fightingZ-fighting

For more information, see frame rate in the hologram stability article.

Reprojection is used to stabilize holograms as users move around their space. Try out the different reprojection

options provided by this part of the app to see the difference in hologram quality.

For detailed information, see reprojection in the hologram stability article.

Z-fighting occurs when the mixed reality application cannot discern which object is in front of the other. You'll

notice flickering of the holographic objects as they fight for the same z-depth value. Experience the effects of z-

fighting in the app by changing the placement of a holographic object, the logo on a bicycle in this case.



  Anti-aliasingAnti-aliasing

 3D asset fundamentals

  Triangle countTriangle count

For detailed information about z-fighting, see enable depth buffer sharing in the recommended settings for

Unity article.

Anti-aliasing is a technique used to smooth jagged edges on curved lines and diagonals in holograms. In this

part of the app, experience the affects of aliasing on displayed text and bicycle spokes.

On the application's homepage, select 3D Asset Fundamentals3D Asset Fundamentals  to explore how to optimize 3D assets to meet

the frame rate requirement while maintaining high visual fidelity.

We'll explore the following key concepts:

Triangle count.

Shader passes.

Draw calls.

Finale.

Select the number and complexity of bicycle models to experience the visual difference based on FPS.



  Shader passesShader passes

For more information, see asset creation process.

Select the number of bikes and different shader options to experience the visual difference based on FPS.



  Draw callsDraw calls

  FinaleFinale

 

For more information, see MRTK Standard Shader.

Draw calls are resource-intensive calls to the graphics card. In this part of the app, experience the visual

difference first hand, as the number of draw calls impact FPS.

See CPU-to-GPU performance recommendations.

Here, we can explore how many fully optimized bicycles can be displayed, and the level of fidelity possible given

the optimization techniques.

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/rendering/mrtk-standard-shader


Next steps
Explore other mixed reality sample scenarios:

Samples and feature apps



   

 

Periodic Table of the Elements
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NOTENOTE

NOTENOTE

 Demo video

 About the app

This article discusses an exploratory sample we’ve created in the Mixed Reality Design Labs, a place where we share our

learnings about and suggestions for mixed reality app development. Our design-related articles and code will evolve as

we make new discoveries.

This sample app was designed for HoloLens 1st gen. See Periodic Table of the Elements 2.0 for HoloLens 2 version.

Periodic Table of the Elements is an open-source sample app from Microsoft's Mixed Reality Design Labs. Learn

how to lay out an array of objects in 3D space with various surface types using an Object collectionObject collection. Also learn

how to create interactable objects that respond to standard inputs from HoloLens. You can use this project's

components to create your own mixed reality app experience.

Recorded with HoloLens 2 using Mixed Reality Capture

Periodic Table of the Elements visualizes the chemical elements and each of their properties in a 3D space. It

incorporates the basic interactions of HoloLens such as gaze and air tap. Users can learn about the elements

with animated 3D models. They can visually understand an element's electron shell and its nucleus - which is

composed of protons and neutrons.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/periodic-table-of-the-elements.md
https://github.com/Microsoft/MRDesignLabs_Unity
https://github.com/Microsoft/MRDesignLabs_Unity_PeriodicTable
https://www.microsoft.com/en-us/videoplayer/embed/RE4IkCF


 Background

 Design

After I first experienced HoloLens, I knew I wanted to experiment with a periodic table app in mixed reality. Since

each element has many data points that are displayed with text, I thought it would be great subject matter for

exploring typographic composition in a 3D space. Giving users the chance to visualize the element's electron

model was another interesting part of this project.

For the default view of the periodic table, I imagined three-dimensional boxes that would contain the electron

model of each element. The surface of each box would be translucent so that the user could get a rough idea of

the element's volume. With gaze and air tap, the user could open up a detailed view of each element. To make

the transition between table view and detail view smooth and natural, I made it similar to the physical

interaction of a box opening in real life.

Design sketches

In detail view, I wanted to visualize the information of each element with beautifully rendered text in 3D space.

The animated 3D electron model is displayed in the center area and can be viewed from different angles.



 Common controls and patterns used in this app
  Interactable object (button)Interactable object (button)

  Object collectionObject collection

Interaction prototypes

The user can change the surface type by air tapping the buttons on the bottom of the table - they can switch

between plane, cylinder, sphere, and scatter.

Interactable object is an object, which can respond to basic HoloLens inputs. It's provided as a prefab/script,

which you can easily apply to any object. For example, you can make a coffee cup in your scene interactable and

respond to inputs such as gaze, air tap, navigation, and manipulation gestures. Learn more

Object collection is an object, which helps you lay out multiple objects in various shapes. It supports plane,

cylinder, sphere, and scatter. You can configure additional properties such as radius, number of rows and the

spacing. Learn more



 Technical details

 Porting story for HoloLens 2

 About the author

Yoon ParkYoon Park
UX Designer @Microsoft

 See also

You can find scripts and prefabs for the Periodic Table of the Elements app on the Mixed Reality Design Labs

GitHub.

Read the story on how Periodic Table of the Elements app was updated with HoloLens 2's instinctual

interactions.

Periodic Table of the Elements 2.0

MRTK Examples Hub - (Download from Microsoft Store in HoloLens 2)

Surfaces - (Download from Microsoft Store in HoloLens 2)

Periodic Table of the Elements 2.0

Galaxy Explorer 2.0

https://github.com/Microsoft/MRDesignLabs_Unity_PeriodicTable
https://medium.com/@dongyoonpark/bringing-the-periodic-table-of-the-elements-app-to-hololens-2-with-mrtk-v2-a6e3d8362158
http://dongyoonpark.com
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/example-scenes/example-hub
https://www.microsoft.com/en-us/p/mrtk-examples-hub/9mv8c39l2sj4
https://www.microsoft.com/en-us/p/surfaces/9nvkpv3sk3x0
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NOTENOTE

 Share your idea

You shared your ideas. We’re shar ing the code.You shared your ideas. We’re shar ing the code.

The Galaxy Explorer Project is ready. You've shared your ideas with the community, chosen an app, watched a

team build it, and now you can get the source code. If you have a device, the Galaxy Explorer Project is available

for download from the Windows Store for Microsoft HoloLens.

This sample app was designed for HoloLens 1st gen. See Galaxy Explorer 2.0 for HoloLens 2 version.

Our HoloLens development team of designers, artists, and developers built Galaxy Explorer and invited all of

you to be part of this journey with them. After six weeks of core development and two weeks of refinement, this

app is now ready for you! You can also follow along our whole journey through the video series below.

The Galaxy Explorer journey begins with the "Share your idea" campaign.

The Microsoft HoloLens community is bursting with spectacular ideas for how holographic computing will

transform our world. We believe the most incredible HoloLens apps will come out of ideas you imagine

together.

You shared over 5000 amazing ideas throughout those few weeks! Our development team reviewed the most

successful and viable ideas and offered to build one of the top three ideas.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/galaxy-explorer.md
https://www.youtube-nocookie.com/embed/HsnH2Q7HxOA
https://www.youtube-nocookie.com/embed/ZxGdW_ASrRc


 Ep 1: Trust the Process

 Ep 2: Let's Do This

 Ep 3: Laying Foundations

 Ep 4: Make It Real

 Ep 5: See What Happens

 Ep 6: Coming to Life

 Ep 7: The Final Product

 Case study

 Meet the team

After a 24-hour Twitter poll, Galaxy Explorer was the winning idea! Our HoloLens development team of

designers, artists, and developers built Galaxy Explorer and invited all of you to be part of this journey with

them. You can follow the development process in the videos below.

In Episode 1, the development team begins the creative process: brainstorming, concepting, and deciding what

to prototype.

In Episode 2, the development team completes the prototyping phase – tackling hard problems and figuring out

which ideas to pursue further.

In Episode 3, the team starts the first week of development – creating a plan, writing production code, creating

art assets, and figuring out the user interface.

In Episode 4, the team dives deeper into development – bringing in scientific data, optimizing the rendering

process, and incorporating spatial mapping.

In Episode 5, the development team tests the app, searches for bugs that need to be fixed, and refines the

experience.

In Episode 6, the team finishes the last week of development, prepares for two weeks of polish work, and

reflects on the progress they’ve made

In Episode 7, the team completes the project and shares their code.

You can find even more insights and lessons from developing Galaxy Explorer by reading the "Creating a galaxy

in mixed reality" case study.

https://www.youtube-nocookie.com/embed/rIX2XrRQgDg
https://www.youtube-nocookie.com/embed/q1ee8a-84Ro
https://www.youtube-nocookie.com/embed/fUqni6C4nmo
https://www.youtube-nocookie.com/embed/ePA6hcaqoug
https://www.youtube-nocookie.com/embed/Up1EDRrCrho
https://www.youtube-nocookie.com/embed/sMuJFKbylY4
https://www.youtube-nocookie.com/embed/HsnH2Q7HxOA
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-creating-a-galaxy-in-mixed-reality


 See also

Galaxy Explorer development team

We learned that building the right team is one of the most important investments we could make and decided

to organize similarly to a game studio for those of you familiar with that development model. We chose to have

11 core team members to control scope, since we had a fixed timeframe (create something cool before Build on

March 30, 2016).

For this project, we started with a producer, Jessica who conducted planning, reviewing progress, and keeping

things running day to day. She's the one with pink hair. We had a design director (Jon) and a senior designer

(Peter). They held the creative vision for Galaxy Explorer. Jon is the one in glasses in the front row, and Peter is

the second from the right in the back.

We had three developers – BJ (between Jon and Jessica), Mike (second row on the left), and Karim (second row

middle, next to BJ). They figured out the technical solutions needed to realize that creative vision.

We started out with four artists full-time – a concept artist (Jedd, second from left in the back), a modeler (Andy,

third from right in the back), a technical artist (Alex (right-most person)) and an animator (Steve (left-most

person). Each of them does more than that, too – but those are their primary responsibilities.

We had one full-time tester – Lena – who tested our builds every day, set up our build reviews, and reviewed

features as they come online. Everyone tested constantly though, as we were always looking at our builds.

Lena's the one rocking the leather jacket.

We're all a part of a larger studio here at Microsoft (think team in non-game development). There were a bunch

of other people involved as well – we called on the talents of our art director, audio engineer, and studio

leadership frequently throughout the project, but those folks were shared resources with other projects our

broader team has.

Case study - Creating a galaxy in mixed reality

Galaxy Explorer GitHub repo

Galaxy Explorer 2.0

https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-creating-a-galaxy-in-mixed-reality
https://github.com/Microsoft/GalaxyExplorer
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NOTENOTE

NOTENOTE

 Demo video

 Rethinking classic experiences for Windows Mixed Reality

This article discusses an exploratory sample we’ve created in the Mixed Reality Design Labs, a place where we share our

learnings about and suggestions for mixed reality app development. Our design-related articles and code will evolve as

we make new discoveries.

This sample app was designed for HoloLens 1st gen.

Lunar Module is an open-source sample app from Microsoft's Mixed Reality Design Labs. Learn how to extend

HoloLens' base gestures with two-handed tracking and Xbox controller input, create objects that are reactive to

surface mapping and plane finding, and implement simple menu systems. All of the project's components are

available for use in your own mixed reality app experiences.

Recorded with HoloLens 2 using Mixed Reality Capture

High up in the atmosphere, a small ship reminiscent of the Apollo module methodically surveys jagged terrain

below. Our fearless pilot spots a suitable landing area. The descent is arduous but thankfully, this journey has

been made many times before...

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/lunar-module.md
https://github.com/Microsoft/MRDesignLabs_Unity
https://github.com/Microsoft/MRDesignLabs_Unity_LunarModule
https://www.microsoft.com/en-us/videoplayer/embed/RE4IcIP


Original interface from Atari’s 1979 Lunar Lander

Lunar Lander is an arcade classic where players attempt to pilot a moon lander onto a flat spot of lunar terrain.

Anyone born in the 1970s has most likely spent hours in an arcade with their eyes glued to this vector ship

plummeting from the sky. As a player navigates their ship toward a landing area, the terrain scales to reveal

progressively more detail. Success means landing within the safe threshold of horizontal and vertical speed.

Points are awarded for time spent landing and remaining fuel, with a multiplier based on the size of the landing

area.

Aside from the gameplay, the arcade era of games brought constant innovation of control schemes. From the

simplest four-way joystick and button configurations (seen in the iconic Pac-Man) to the highly specific and

complicated schemes seen in the late 90 s and 00s (like those in golf simulators and rail shooters). The input

scheme used in the Lunar Lander machine is intriguing for two reasons: curb appeal and immersion.

Atari's Lunar Lander arcade console

Why did Atari and so many other game companies decide to rethink input?

A kid walking through an arcade will naturally be intrigued by the newest, flashiest machine. But Lunar Lander

features a novel input mechanic that stood out from the crowd.

Lunar Lander uses two buttons for rotating the ship left and right and a thrust leverthrust lever  to control the amount of

https://en.wikipedia.org/wiki/Lunar_Lander_(1979_video_game)
https://en.wikipedia.org/wiki/Pac-Man


 Designing with immersion

  Adding input for hand gesturesAdding input for hand gestures

thrust the ship produces. This lever gives users a certain level of finesse a regular joystick can’t provide. It also

happens to be a component common to modern aviation cockpits. Atari wanted Lunar Lander to immerse the

user in the feeling that they were in fact piloting a lunar module. This concept is known as tactile immersiontactile immersion.

Tactile immersion is the experience of sensory feedback from doing repetitive actions. In this case, the repetitive

action of adjusting the throttle lever and rotation, which our eyes see and our ears hear, helps connect the player

to the act of landing a ship on the moon’s surface. This concept can be tied to the psychological concept of

"flow." Where a user is fully absorbed in a task that has the right mixture of challenge and reward, or put more

simply, they’re “in the zone.”

Arguably, the most prominent type of immersion in mixed reality is spatial immersion. The whole point of mixed

reality is to fool ourselves into believing these digital objects exist in the real world. We’re synthesizing

holograms in our surroundings, spatially immersed in entire environments and experiences. This doesn’t mean

we can’t still employ other types of immersion in our experiences just as Atari did with tactile immersion in

Lunar Lander.

How might we apply tactile immersion to an updated, volumetric sequel to the Atari classic? Before tackling the

input scheme, the game construct for three-dimensional space needs to be addressed.

Visualizing spatial mapping in HoloLens

By leveraging a user ’s surroundings, we effectively have infinite terrain options for landing our lunar module. To

make the game most like the original title, a user could potentially manipulate and place landing pads of varying

difficulties in their environment.

Requiring the user to learn the input scheme, control the ship, and have a small target to land on is a lot to ask.

A successful game experience features the right mix of challenge and reward. The user can choose a level of

difficulty, with the easiest mode simply requiring the user to successfully land in a user-defined area on a surface

scanned by the HoloLens. Once a user gets the hang of the game, they can then crank up the difficulty as they

see fit.

HoloLens base input has only two gestures - Air Tap and Bloom. Users don’t need to remember contextual

nuances or a laundry list of specific gestures that makes the platform’s interface both versatile and easy to learn.

While the system may only expose these two gestures, HoloLens as a device is can track two hands at once. Our

ode to Lunar Lander is an [immersive app, which means we can extend the base set of gestures to leverage two

hands and add our own delightfully tactile means for lunar module navigation.



  Adding input for game controllersAdding input for game controllers

Looking back at the original control scheme, we needed to solve for thrust and rotationwe needed to solve for thrust and rotation. The caveat is

rotation in the new context adds an additional axis (technically two, but the Y axis is less important for landing).

The two distinct ship movements naturally lend themselves to be mapped to each hand:

Tap and drag gesture to rotate lander on all three axes

ThrustThrust

The lever on the original arcade machine mapped to a scale of values, the higher the lever was moved the more

thrust was applied to the ship. An important nuance to point out here is how the user can take their hand off of

the control and maintain a desired value. We can effectively use tap-and-drag behavior to achieve the same

result. The thrust value starts at zero. The user taps and drags to increase the value. At that point they could let

go to maintain it. Any tap-and-drag gesture value change would be the delta from the original value.

RotationRotation

This is a little more tricky. Having holographic “rotate” buttons to tap makes for a terrible experience. There isn’t

a physical control to leverage, so the behavior must come from manipulation of an object representing the

lander, or with the lander itself. We came up with a method using tap-and-drag, which enables a user to

effectively “push and pull” it in the direction they want it to face. Anytime a user taps and holds, the point in

space where the gesture was initiated becomes the origin for rotation. Dragging from the origin converts the

delta of the hand's translation (X,Y,Z) and applies it to the delta of the lander's rotation values. Or more simply,

dragging left <-> right, up <-> down, forward <-> back in spaces rotates the ship accordingly.

Since the HoloLens can track two hands, rotation can be assigned to the right hand while thrust is controlled by

the left. Finesse is the driving factor for success in this game. The feel of these interactions is the absolute

highest priority. Especially in context of tactile immersion. A ship that reacts too quickly would be difficult to

steer, while one too slow would require the user to “push and pull” on the ship for an awkwardly long amount of

time.

While hand gestures on the HoloLens provide a novel method of fine-grain control, There's still a certain lack of

'true' tactile feedback that you get from analog controls. Connecting an Xbox game controller allows us to bring

back this sense of physicality while leveraging the control sticks to keep fine-grain control.

There are multiple ways to apply the relatively straight-forward control scheme to the Xbox controller. Since

we're trying to stay as close to the original arcade set up as possible, ThrustThrust maps best to the trigger button.

These buttons are analog controls, meaning they have more than simple on and off states, they actually respond

to the degree of pressure put on them. This gives us a similar construct as the thrust leverthrust lever . Unlike the original

game and the hand gesture, this control will cut the ship's thrust once a user stops putting pressure on the

trigger. It still gives the user the same degree of finesse as the original arcade game did.



 Technical details

 About the author

Addison LinvilleAddison Linville
UX Designer @Microsoft

 See also

Left thumbstick is mapped to yaw and roll; right thumbstick is mapped to pitch and roll

The dual thumbsticks naturally lend themselves to controlling ship rotation. Unfortunately, there are three axes

on which the ship can rotate and two thumbsticks which both support two axes. This mismatch means either

one thumbstick controls one axis; or there's overlap of axes for the thumbsticks. The former solution ended up

feeling "broken" since thumbsticks inherently blend their local X and Y values. The latter solution required some

testing to find which redundant axes feel the most natural. The final sample uses yaw and roll (Y and X axes) for

the left thumbstick, and pitch and roll (Z and X axes) for the right thumbstick. This felt the most natural as roll

seems to independently pair well with yaw and pitch. As a side note, using both thumbsticks for roll also

happens to double the rotation value; it's pretty fun to have the lander do loops.

This sample app demonstrates how spatial recognition and tactile immersion can significantly change an

experience thanks to Windows Mixed Reality's extensible input modalities. While Lunar Lander may be nearing

40 years in age, the concepts exposed with that little octagon-with-legs will live on forever. When imagining the

future, why not look at the past?

You can find scripts and prefabs for the Lunar Module sample app on the Mixed Reality Design Labs GitHub.

MRTK Examples Hub - (Download from Microsoft Store in HoloLens 2)

Surfaces - (Download from Microsoft Store in HoloLens 2)

Periodic Table of the Elements 2.0

Galaxy Explorer 2.0

https://github.com/Microsoft/MRDesignLabs_Unity_LunarModule
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/example-scenes/example-hub
https://www.microsoft.com/en-us/p/mrtk-examples-hub/9mv8c39l2sj4
https://www.microsoft.com/en-us/p/surfaces/9nvkpv3sk3x0
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 Use recommended Unity project settings

 How to profile with Unity

  GPU profilingGPU profiling
  Unity profilerUnity profiler

NOTENOTE

  Unity frame debuggerUnity frame debugger

  HoloLens frame rate overlayHoloLens frame rate overlay

This article builds on the performance recommendations for mixed reality, but focuses on Unity-specific

improvements.

We recently released an application called Quality Fundamentals that covers common performance, design, and

environment issues and solutions for HoloLens 2 apps. This app is a great visual demo for the content that

follows.

Download the Quality Fundamentals app

The most important first step when optimizing performance of mixed reality apps in Unity is to be sure you're

using the recommended environment settings for Unity. That article contains content with some of the most

important scene configurations for building performant Mixed Reality apps. Some of these recommended

settings are highlighted below, as well.

Unity provides the Unity ProfilerUnity Profiler  built-in, which is a great resource to gather valuable performance insights for

your particular app. Although you can run the profiler in-editor, these metrics don't represent the true runtime

environment so results should be used cautiously. We recommend that you remotely profile your application

while running on-device for the most accurate and actionable insights.

Unity provides great documentation for :

1. How to connect the Unity profiler to UWP applications remotely

2. How to effectively diagnose performance problems with the Unity Profiler

With the Unity Profiler connected and after adding the GPU profiler (see Add Profiler in top right corner), one

can see how much time is being spent on the CPU & GPU respectively in the middle of the profiler. This allows

the developer to get a quick approximation if their application is CPU or GPU bounded.

To use GPU profiling, you need to disable Graphics JobsGraphics Jobs in the Unity Player SettingsPlayer Settings . See Unity's GPU UsageGPU Usage

Profiler moduleProfiler module for more details.

Unity's Frame Debugger is also a powerful and insightful tool to use. It will give you a good overview of what

the GPU is doing each frame. Things to look out for are additional rendering targets and blit commands to copy

between them as these are very expensive on HoloLens. Ideally, no off-screen render targets should be used on

HoloLens. These are usually added when enabling expensive rendering features (for example MSAA, HDR or

full-screen effects like bloom) which should be avoided.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/performance-recommendations-for-unity.md
https://www.microsoft.com/p/quality-fundamentals/9mwz852q88fw
https://docs.unity3d.com/Manual/Profiler.html
https://docs.unity3d.com/Manual/windowsstore-profiler.html
https://learn.unity.com/tutorial/diagnosing-performance-problems-2019-3
https://docs.unity3d.com/Manual/Profiler.html
https://docs.unity3d.com/Manual/FrameDebugger.html


  PIXPIX

NOTENOTE

UnityEngine.XR.XRSettings.renderViewportScale = 0.7f;

 CPU performance recommendations

  Cache referencesCache references

using UnityEngine;
using System.Collections;

public class ExampleClass : MonoBehaviour
{
    private Camera cam;
    private CustomComponent comp;

    void Start() 
    {
        cam = Camera.main;
        comp = GetComponent<CustomComponent>();
    }

    void Update()
    {
        // Good
        this.transform.position = cam.transform.position + cam.transform.forward * 10.0f;

        // Bad
        this.transform.position = Camera.main.transform.position + Camera.main.transform.forward * 10.0f;

        // Good
        comp.DoSomethingAwesome();

        // Bad
        GetComponent<CustomComponent>().DoSomethingAwesome();
    }
}

The Device Portal System Performance page has a good summary of CPU and GPU performance of the device.

You can enable Display frame rate counter in headsetDisplay frame rate counter in headset and Display frame rate graph in headsetDisplay frame rate graph in headset. These

options will enable an FPS counter and graph, respectively, that will give you immediate feedback in any running

application on your device.

PIX can be used to profile Unity applications as well. There are also detailed instructions on how to use and

install PIX for HoloLens 2. In a development build, the same scopes that you see in Unity's Frame Debugger will

be shown in PIX as well and can be inspected and profiled in more detail.

Unity provides the ability to easily modify the render target resolution of your application at runtime through the

XRSettings.renderViewportScale property. The final image presented on-device has a fixed resolution. The platform will

sample the lower resolution output to build a higher resolution image for rendering on displays.

The content below covers more in-depth performance practices, especially targeted for Unity & C#

development.

We recommend caching references to all relevant components and GameObjects at initialization because

repeating function calls such as GetComponent<T>() and Camera.main are more expensive relative to the

memory cost to store a pointer. . Camera.main just uses FindGameObjectsWithTag() underneath, which

expensively searches your scene graph for a camera object with the "MainCamera" tag.

https://devblogs.microsoft.com/pix/download/
https://docs.unity3d.com/Manual/FrameDebugger.html
https://docs.unity3d.com/ScriptReference/XR.XRSettings-renderViewportScale.html
https://docs.unity3d.com/ScriptReference/GameObject.GetComponent.html
https://docs.unity3d.com/ScriptReference/Camera-main.html
https://docs.unity3d.com/ScriptReference/GameObject.FindGameObjectsWithTag.html


NOTENOTE

  Avoid expensive operationsAvoid expensive operations

NOTENOTE

Avoid GetComponent(string) 

When using GetComponent(), there are a handful of different overloads. It is important to always use the Type-based

implementations and never the string-based searching overload. Searching by string in your scene is significantly more

costly than searching by Type. 

(Good) Component GetComponent(Type type) 

(Good) T GetComponent<T>() 

(Bad) Component GetComponent(string)> 

// Example Code
using System.Linq;

List<int> data = new List<int>();
data.Any(x => x > 10);

var result = from x in data
             where x > 10
             select x;

    GameObject.SendMessage()
    GameObject.BroadcastMessage()
    UnityEngine.Object.Find()
    UnityEngine.Object.FindWithTag()
    UnityEngine.Object.FindObjectOfType()
    UnityEngine.Object.FindObjectsOfType()
    UnityEngine.Object.FindGameObjectsWithTag()
    UnityEngine.Object.FindGameObjectsWithTag()

1. Avoid use of Avoid use of L INQLINQ

Although LINQ can be clean and easy to read and write, it generally requires more computation and

memory than if you wrote the algorithm manually.

2. Common Unity APIsCommon Unity APIs

Certain Unity APIs, although useful, can be expensive to execute. Most of these involve searching your

entire scene graph for some matching list of GameObjects. These operations can generally be avoided by

caching references or implementing a manager component for the GameObjects to track the references

at runtime.

SendMessage() and BroadcastMessage() should be eliminated at all costs. These functions can be on the order of 1000x

slower than direct function calls.

3. Beware of boxingBeware of boxing

Boxing is a core concept of the C# language and runtime. It's the process of wrapping value-typed

variables such as char , int , bool , etc. into reference-typed variables. When a value-typed variable is

"boxed", it's wrapped in a System.Object , which is stored on the managed heap. Memory is allocated and

eventually when disposed must be processed by the garbage collector. These allocations and

deallocations incur a performance cost and in many scenarios are unnecessary or can be easily replaced

by a less expensive alternative.

https://docs.unity3d.com/ScriptReference/GameObject.GetComponent.html
https://docs.microsoft.com/en-us/dotnet/csharp/programming-guide/concepts/linq/getting-started-with-linq
https://docs.unity3d.com/ScriptReference/GameObject.SendMessage.html
https://docs.unity3d.com/ScriptReference/GameObject.BroadcastMessage.html
https://docs.microsoft.com/en-us/dotnet/csharp/programming-guide/types/boxing-and-unboxing


  Repeating code pathsRepeating code paths

NOTENOTE

// boolean value type is boxed into object boxedMyVar on the heap
bool myVar = true;
object boxedMyVar = myVar;

To avoid boxing, be sure that the variables, fields, and properties in which you store numeric types and

structs (including Nullable<T> ) are strongly typed as specific types such as int , float?  or MyStruct ,

instead of using object. If putting these objects into a list, be sure to use a strongly typed list such as 

List<int>  rather than List<object>  or ArrayList .

Example of boxing in C#Example of boxing in C#

Any repeating Unity callback functions (i.e Update) that are executed many times per second and/or frame

should be written carefully. Any expensive operations here will have huge and consistent impact on

performance.

void Update()
{
}

1. Empty callback functionsEmpty callback functions

Although the code below may seem innocent to leave in your application, especially since every Unity

script auto-initializes with an Update method, these empty callbacks can become expensive. Unity

operates back and forth between an unmanaged and managed code boundary, between UnityEngine

code and your application code. Context switching over this bridge is fairly expensive, even if there's

nothing to execute. This becomes especially problematic if your app has 100s of GameObjects with

components that have empty repeating Unity callbacks.

Update() is the most common manifestation of this performance issue but other repeating Unity callbacks, such as the

following can be equally as bad, if not worse: FixedUpdate(), LateUpdate(), OnPostRender", OnPreRender(),

OnRenderImage(), etc.

    UnityEngine.Physics.Raycast()
    UnityEngine.Physics.RaycastAll()

2. Operations to favor running once per frameOperations to favor running once per frame

The following Unity APIs are common operations for many Holographic Apps. Although not always

possible, the results from these functions can commonly be computed once and the results reutilized

across the application for a given frame.

a) It's good practice to have a dedicated Singleton class or service to handle your gaze Raycast into the

scene and then reuse this result in all other scene components, instead of making repeated and identical

Raycast operations by each component. Some applications may require raycasts from different origins or

against different LayerMasks.

b) Avoid GetComponent() operations in repeated Unity callbacks like Update() by caching references in

Start() or Awake()

https://docs.unity3d.com/ScriptReference/LayerMask.html


  MiscellaneousMiscellaneous

 CPU-to-GPU performance recommendations

    UnityEngine.Object.GetComponent()

    UnityEngine.Object.Instantiate()

c) It's good practice to instantiate all objects, if possible, at initialization and use object pooling to recycle

and reuse GameObjects throughout runtime of your application

3. Avoid interfaces and vir tual constructsAvoid interfaces and vir tual constructs

Invoking function calls through interfaces vs direct objects or calling virtual functions can often be much

more expensive than using direct constructs or direct function calls. If the virtual function or interface is

unnecessary, then it should be removed. However, the performance hit for these approaches is worth the

trade-off if using them simplifies development collaboration, code readability, and code maintainability.

Generally, the recommendation is to not mark fields and functions as virtual unless there's a clear

expectation that this member needs to be overwritten. One should be especially careful around high-

frequency code paths that are called many times per frame or even once per frame such as an 

UpdateUI()  method.

4. Avoid passing structs by valueAvoid passing structs by value

Unlike classes, structs are value-types and when passed directly to a function, their contents are copied

into a newly created instance. This copy adds CPU cost, as well as additional memory on the stack. For

small structs, the effect is minimal and thus acceptable. However, for functions repeatedly invoked every

frame as well as functions taking large structs, if possible modify the function definition to pass by

reference. Learn more here

1. PhysicsPhysics

a) Generally, the easiest way to improve physics is to limit the amount of time spent on Physics or the

number of iterations per second. This will reduce simulation accuracy. See TimeManager in Unity

b) The types of colliders in Unity have widely different performance characteristics. The order below lists

the most performant colliders to least performant colliders from left to right. It's important to avoid Mesh

Colliders, which are substantially more expensive than the primitive colliders.

Sphere < Capsule < Box <<< Mesh (Convex) < Mesh (non-Convex)

See Unity Physics Best Practices for more info

2. AnimationsAnimations

Disable idle animations by disabling the Animator component (disabling the game object won't have the

same effect). Avoid design patterns where an animator sits in a loop setting a value to the same thing.

There's considerable overhead for this technique, with no effect on the application. Learn more here.

3. Complex algorithmsComplex algorithms

If your application is using complex algorithms such as inverse kinematics, path finding, etc, look to find a

simpler approach or adjust relevant settings for their performance

Generally, CPU-to-GPU performance comes down to the draw callsdraw calls  submitted to the graphics card. To improve

performance, draw calls need to be strategically a) reduceda) reduced or b) restructuredb) restructured for optimal results. Since draw

calls themselves are resource-intensive, reducing them will reduce overall work required. Further, state changes

https://docs.microsoft.com/en-us/dotnet/csharp/programming-guide/classes-and-structs/how-to-know-the-difference-passing-a-struct-and-passing-a-class-to-a-method
https://docs.unity3d.com/Manual/class-TimeManager.html
https://unity3d.com/learn/tutorials/topics/physics/physics-best-practices
https://docs.unity3d.com/Manual/MecanimPeformanceandOptimization.html


  Single pass instanced renderingSingle pass instanced rendering

NOTENOTE

  Static batchingStatic batching

  Dynamic batchingDynamic batching

  Other techniquesOther techniques

between draw calls require costly validation and translation steps in the graphics driver and thus, restructuring

of your application's draw calls to limit state changes (i.e different materials, etc) can boost performance.

Unity has a great article that gives an overview and dives into batching draw calls for their platform.

Unity Draw Call Batching

Single Pass Instanced Rendering in Unity allows for draw calls for each eye to be reduced down to one instanced

draw call. Because of cache coherency between two draw calls, there's also some performance improvement on

the GPU as well.

To enable this feature in your Unity Project

1. Open Player XR SettingsPlayer XR Settings  (go to EditEdit > Project SettingsProject Settings  > PlayerPlayer  > XR SettingsXR Settings )

2. Select S ingle Pass InstancedSingle Pass Instanced from the Stereo Rendering MethodStereo Rendering Method drop-down menu (Vir tual RealityVir tual Reality

Suppor tedSuppor ted checkbox must be checked)

Read the following articles from Unity for details with this rendering approach.

How to maximize AR and VR performance with advanced stereo rendering

Single Pass Instancing

One common issue with Single Pass Instanced Rendering occurs if developers already have existing custom shaders not

written for instancing. After enabling this feature, developers may notice some GameObjects only render in one eye. This

is because the associated custom shaders do not have the appropriate properties for instancing.

See Single Pass Stereo Rendering for HoloLens from Unity for how to address this problem

Unity is able to batch many static objects to reduce draw calls to the GPU. Static Batching works for most

Renderer objects in Unity that 1) share the same mater ial1) share the same mater ial  and 2) are all marked as 2) are all marked as StaticStatic (Select an object

in Unity and select the checkbox in the top right of the inspector). GameObjects marked as Static cannot be

moved throughout your application's runtime. Thus, static batching can be difficult to leverage on HoloLens

where virtually every object needs to be placed, moved, scaled, etc. For immersive headsets, static batching can

dramatically reduce draw calls and thus improve performance.

Read Static Batching under Draw Call Batching in Unity for more details.

Since it's problematic to mark objects as Static for HoloLens development, dynamic batching can be a great tool

to compensate for this lacking feature. It can also be useful on immersive headsets, as well. However, dynamic

batching in Unity can be difficult to enable because GameObjects must a) share the same Mater iala) share the same Mater ial  and b)b)

meet a long list of other cr iter iameet a long list of other cr iter ia .

Read Dynamic Batching under Draw Call Batching in Unity for the full list. Most commonly, GameObjects

become invalid to be batched dynamically, because the associated mesh data can be no more than 300 vertices.

Batching can only occur if multiple GameObjects are able to share the same material. Typically, this will be

blocked by the need for GameObjects to have a unique texture for their respective Material. It's common to

combine Textures into one big Texture, a method known as Texture Atlasing.

Furthermore, it's preferable to combine meshes into one GameObject where possible and reasonable. Each

Renderer in Unity will have its associated draw call(s) versus submitting a combined mesh under one Renderer.

https://docs.unity3d.com/Manual/DrawCallBatching.html
https://blogs.unity3d.com/2017/11/21/how-to-maximize-ar-and-vr-performance-with-advanced-stereo-rendering/
https://docs.unity3d.com/Manual/SinglePassInstancing.html
https://docs.unity3d.com/Manual/SinglePassStereoRenderingHoloLens.html
https://docs.unity3d.com/ScriptReference/Renderer.html
https://docs.unity3d.com/Manual/DrawCallBatching.html
https://docs.unity3d.com/Manual/DrawCallBatching.html
https://en.wikipedia.org/wiki/Texture_atlas


NOTENOTE

 GPU performance recommendations

  Bandwidth and fill ratesBandwidth and fill rates

  Optimize depth buffer sharingOptimize depth buffer sharing

  Avoid full-screen effectsAvoid full-screen effects

  Optimal lighting settingsOptimal lighting settings

Modifying properties of Renderer.material at runtime will create a copy of the Material and thus potentially break

batching. Use Renderer.sharedMaterial to modify shared material properties across GameObjects.

Learn more about optimizing graphics rendering in Unity

When rendering a frame on the GPU, an application is either bound by memory bandwidth or fill rate.

Memor y bandwidthMemor y bandwidth is the rate of reads and writes the GPU can do from memory

Fill rateFill rate refers to the pixels that can be drawn per second by the GPU.

In Unity, change Texture QualityTexture Quality  in EditEdit > Project SettingsProject Settings  > Quality SettingsQuality Settings .

In Unity, use the XRSettings.renderViewportScale property.

It's recommended to enable Depth buffer shar ingDepth buffer shar ing under Player XR SettingsPlayer XR Settings  to optimize for hologram

stability. When enabling depth-based late-stage reprojection with this setting however, it's recommended to

select 16-bit depth format16-bit depth format instead of 24-bit depth format24-bit depth format. The 16-bit depth buffers will drastically reduce

the bandwidth (and thus power) associated with depth buffer traffic. This can be a big win both in power

reduction and performance improvement. However, there are two possible negative outcomes by using 16-bit

depth format.

Z-FightingZ-Fighting

The reduced depth range fidelity makes z-fighting more likely to occur with 16 bit than 24-bit. To avoid these

artifacts, modify the near/far clip planes of the Unity camera to account for the lower precision. For HoloLens-

based applications, a far clip plane of 50 m instead of the Unity default 1000 m can generally eliminate any z-

fighting.

Disabled Stencil BufferDisabled Stencil Buffer

When Unity creates a Render Texture with 16-bit depth, there's no stencil buffer created. Selecting 24-bit depth

format, per Unity documentation, will create a 24-bit z-buffer, as well as an [8-bit stencil buffer]

(https://docs.unity3d.com/Manual/SL-Stencil.html) (if 32-bit is applicable on a device, which is generally the case

such as HoloLens).

Techniques that operate on the full screen can be expensive since their order of magnitude is millions of

operations every frame. It's recommended to avoid post-processing effects such as anti-aliasing, bloom, and

more.

Real-time Global Illumination in Unity can provide outstanding visual results but involves expensive lighting

calculations. We recommended disabling real-time Global Illumination for every Unity scene file via WindowWindow  >

RenderingRendering > L ighting SettingsLighting Settings  > Uncheck Real-time Global IlluminationReal-time Global Illumination.

Furthermore, it's recommended to disable all shadow casting as these also add expensive GPU passes onto a

Unity scene. Shadows can be disable per light but can also be controlled holistically via Quality settings.

EditEdit > Project SettingsProject Settings , then select the QualityQuality  category > Select Low QualityLow Quality  for the UWP Platform. One

can also just set the ShadowsShadows property to Disable ShadowsDisable Shadows .

https://unity3d.com/learn/tutorials/temas/performance-optimization/optimizing-graphics-rendering-unity-games
https://docs.unity3d.com/Manual/class-QualitySettings.html
https://docs.unity3d.com/ScriptReference/XR.XRSettings-renderViewportScale.html
https://en.wikipedia.org/wiki/Z-fighting
https://docs.unity3d.com/Manual/class-Camera.html
https://docs.unity3d.com/ScriptReference/RenderTexture-depth.html
https://docs.unity3d.com/Manual/SL-Stencil.html
https://docs.unity3d.com/Manual/PostProcessingOverview.html
https://docs.unity3d.com/Manual/GIIntro.html


  Reduce poly countReduce poly count

  Understanding shaders in UnityUnderstanding shaders in Unity

  Optimize pixel shadersOptimize pixel shaders

We recommended that you use baked lighting with your models in Unity.

Polygon count is reduced by either

1. Removing objects from a scene

2. Asset decimation, which reduces the number of polygons for a given mesh

3. Implementing a Level of Detail (LOD) System into your application, which renders far away objects with

lower-polygon version of the same geometry

An easy approximation to compare shaders in performance is to identify the average number of operations each

executes at runtime. This can be done easily in Unity.

1. Select your shader asset or select a material, then in the top-right corner of the inspector window, select

the gear icon followed by "Select Shader""Select Shader"

2. With the shader asset selected, select the "Compile and show code""Compile and show code" button under the inspector

window

3. After compiling, look for the statistics section in the results with the number of different operations for

both the vertex and pixel shader (Note: pixel shaders are often also called fragment shaders)

Looking at the compiled statistic results using the method above, the fragment shader will generally execute

more operations than the vertex shader, on average. The fragment shader, also known as the pixel shader, is

executed per pixel on the screen output while the vertex shader is only executed per-vertex of all meshes being

drawn to the screen.

Thus, not only do fragment shaders have more instructions than vertex shaders because of all the lighting

calculations, fragment shaders are almost always executed on a larger dataset. For example, if the screen output

is a 2k by 2k image, then the fragment shader can get executed 2,000*2,000 = 4,000,000 times. If rendering two

eyes, this number doubles since there are two screens. If a mixed reality application has multiple passes, full-

screen post-processing effects, or rendering multiple meshes to the same pixel, this number will increase

https://docs.unity3d.com/Manual/LevelOfDetail.html
https://en.wikipedia.org/wiki/Shader#Pixel_shaders
https://en.wikipedia.org/wiki/Shader#Vertex_shaders


  Unity Standard shader alternativesUnity Standard shader alternatives

  Shader preloadingShader preloading

  Limit overdrawLimit overdraw

 Memory recommendations

  Garbage collectionGarbage collection

  Object poolingObject pooling

dramatically.

Therefore, reducing the number of operations in the fragment shader can generally give far greater

performance gains over optimizations in the vertex shader.

Instead of using a physically based rendering (PBR) or another high-quality shader, look at utilizing a more

performant and cheaper shader. The Mixed Reality Toolkit provides the MRTK standard shader that has been

optimized for mixed reality projects.

Unity also provides an unlit, vertex lit, diffuse, and other simplified shader options that are faster compared to

the Unity Standard shader. See Usage and Performance of Built-in Shaders for more detailed information.

Use Shader preloading and other tricks to optimize shader load time. In particular, shader preloading means you

won't see any hitches due to runtime shader compilation.

In Unity, one can display overdraw for their scene, by toggling the draw mode menudraw mode menu in the top-left corner of

the Scene viewScene view  and selecting OverdrawOverdraw .

Generally, overdraw can be mitigated by culling objects ahead of time before they're sent to the GPU. Unity

provides details on implementing Occlusion Culling for their engine.

Excessive memory allocation & deallocation operations can have adverse effects on your holographic

application, resulting in inconsistent performance, frozen frames, and other detrimental behavior. It's especially

important to understand memory considerations when developing in Unity since memory management is

controlled by the garbage collector.

Holographic apps will lose processing compute time to the garbage collector (GC) when the GC is activated to

analyze objects that are no longer in scope during execution and their memory needs to be released, so it can be

made available for reuse. Constant allocations and de-allocations will generally require the garbage collector to

run more frequently, thus hurting performance and user experience.

Unity has provided an excellent page that explains in detail how the garbage collector works and tips to write

more efficient code in regards to memory management.

Optimizing garbage collection in Unity games

One of the most common practices that leads to excessive garbage collection isn't caching references to

components and classes in Unity development. Any references should be captured during Start() or Awake() and

reused in later functions such as Update() or LateUpdate().

Other quick tips:

Use the StringBuilder C# class to dynamically build complex strings at runtime

Remove calls to Debug.Log() when no longer needed, as they still execute in all build versions of an app

If your holographic app generally requires lots of memory, consider calling System.GC.Collect()System.GC.Collect()  during

loading phases such as when presenting a loading or transition screen

Object pooling is a popular technique for reducing the cost of continuous object allocation and deallocations.

This is done by allocating a large pool of identical objects and reusing inactive, available instances from this pool

instead of constantly spawning and destroying objects over time. Object pools are great for reuseable

components that have variable lifetime during an app.

https://github.com/Microsoft/MixedRealityToolkit-Unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/rendering/mrtk-standard-shader
https://docs.unity3d.com/Manual/shader-Performance.html
https://docs.unity3d.com/Manual/OptimizingShaderLoadTime.html
https://docs.unity3d.com/Manual/ViewModes.html
https://docs.unity3d.com/Manual/OcclusionCulling.html
https://unity3d.com/learn/tutorials/topics/performance-optimization/optimizing-garbage-collection-unity-games?playlist=44069
https://docs.microsoft.com/en-us/dotnet/api/system.text.stringbuilder
https://docs.microsoft.com/en-us/dotnet/api/system.gc.collect


 Startup performance

 See also

Object Pooling Tutorial in Unity

Consider starting your app with a smaller scene, then using SceneManager.LoadSceneAsync to load the rest of

the scene. This allows your app to get to an interactive state as fast as possible. There may be a large CPU spike

while the new scene is being activated and that any rendered content might stutter or hitch. One way to work

around this is to set the AsyncOperation.allowSceneActivation property to "false" on the scene being loaded,

wait for the scene to load, clear the screen to black, and then set it back to "true" to complete the scene

activation.

Remember that while the startup scene is loading, the holographic splash screen will be displayed to the user.

Optimizing graphics rendering in Unity games

Optimizing garbage collection in Unity games

Physics Best Practices [Unity]

Optimizing Scripts [Unity]

https://unity3d.com/learn/tutorials/topics/scripting/object-pooling
https://docs.unity3d.com/ScriptReference/SceneManagement.SceneManager.LoadSceneAsync.html
https://unity3d.com/learn/tutorials/temas/performance-optimization/optimizing-graphics-rendering-unity-games?playlist=44069
https://unity3d.com/learn/tutorials/topics/performance-optimization/optimizing-garbage-collection-unity-games?playlist=44069
https://unity3d.com/learn/tutorials/topics/physics/physics-best-practices
https://docs.unity3d.com/2020.1/Documentation/Manual/MobileOptimizationPracticalGuide.html


   

 

Managed debugging with Unity
 7/6/2022 • 2 minutes to read • Edit Online

Follow these steps to attach a managed debugger to your Unity IL2CPP UWP build for HoloLens and HoloLens

2.

1. You'll need to be on a network that supports multicast.

2. Go to UWP Publishing Settings CapabilitiesUWP Publishing Settings Capabilities  and check InternetClientSer verInternetClientSer ver  and

PrivateNetworkClientSer verPr ivateNetworkClientSer ver :

3. Configure the Unity UWP build settings:

Development Build

Script Debugging

Wait for Managed Debugger (optional)

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/managed-debugging-with-unity-il2cpp.md
https://en.wikipedia.org/wiki/Multicast


4. Build in Unity.

5. Build and deploy from the Visual Studio solution to your device. You should build with the DebugDebug or

ReleaseRelease configurations. The MasterMaster  configuration disables the Unity profiler and can prevent optimal

debugging. Optionally, verify Internet (Client & Ser ver)Internet (Client & Ser ver)  and Pr ivate Networks (Client & Ser ver)Pr ivate Networks (Client & Ser ver)

in the capabilities list in Package.appxmanifest in the solution.

6. Make sure your device is connected to the same network as your PC and start the app on your device.

7. Make sure the device is notis not connected to your PC via USB.

8. Double-click one of your scripts in Unity and go to the Visual Studio solution that opens to view and edit.

9. Debug -> Attach Unity Debugger.

10. Select your device in the list and click "OK" to attach.



 See also
C# debugging

https://docs.microsoft.com/en-us/visualstudio/get-started/csharp/tutorial-debugger


   

 

Recommended settings for Unity
 7/6/2022 • 9 minutes to read • Edit Online

 Performant environment set-up
  Low-quality settingsLow-quality settings

  Lighting settingsLighting settings

NOTENOTE

  Single pass instancing rendering pathSingle pass instancing rendering path

Unity provides a set of default options that are generally the average case for all platforms. However, Unity

offers some behaviors specific to mixed reality that can be toggled through project settings.

It's important to modify the Unity Quality settingsUnity Quality settings  to Ver y LowVer y Low  so that your application is runs and performs

well at the appropriate framerate, especially for HoloLens development. For development on immersive

headsets, depending on the specs of the desktop powering the VR experience, one can still achieve framerate

without the lowest quality parameters.

In Unity 2019 LTS+, you can set the project's quality level by going to EditEdit > Project SettingsProject Settings  > QualityQuality  and

setting the DefaultDefault by clicking on the downward arrow to the **Very Low-quality level.

Similar to Quality scene settings, it's important to set optimal Lighting settings for your Mixed Reality

application. In Unity, the Lighting setting that will usually have the greatest performance impact on your scene is

Realtime Global IlluminationRealtime Global Illumination. You can turn off Global Illumination by going to WindowWindow  > RenderingRendering >

Lighting SettingsLighting Settings  > Realtime Global IlluminationRealtime Global Illumination.

There's another lighting setting, Baked Global IlluminationBaked Global Illumination. This setting can provide performant and visually

striking results on immersive headsets but isn't applicable for HoloLens development. Baked GlobalBaked Global

IlluminationIllumination is only calculated for static GameObjects, which aren't found in HoloLens scenes because of the

nature of an unknown and changing environment.

Read Global Illumination from Unity for more information.

Realtime Global I lluminationRealtime Global I llumination is set per-sceneper-scene and thus developers must save this property for every Unity scene in

their project.

In Mixed Reality applications, the scene is rendered twice, once for each eye to the user. Compared to traditional

3D development, this effectively doubles the amount of work that needs to be computed. It's important to select

the most efficient rendering path in Unity to save both on CPU and GPU time. Single pass instanced rendering

optimizes the Unity rendering pipeline for Mixed Reality apps and it's recommended to enable this setting by

default for every project.

To enable this feature in your Unity Project

1. Open Player XR SettingsPlayer XR Settings  (go to EditEdit > Project SettingsProject Settings  > PlayerPlayer  > XR SettingsXR Settings )

2. Select S ingle Pass InstancedSingle Pass Instanced from the Stereo Rendering MethodStereo Rendering Method drop-down menu (Vir tual RealityVir tual Reality

Suppor tedSuppor ted checkbox must be checked)

Read the following articles from Unity for more details with this rendering approach.

How to maximize AR and VR performance with advanced stereo rendering

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/recommended-settings-for-unity.md
https://docs.unity3d.com/Manual/GIIntro.html
https://blogs.unity3d.com/2017/11/21/how-to-maximize-ar-and-vr-performance-with-advanced-stereo-rendering/


NOTENOTE

  Enable depth buffer sharingEnable depth buffer sharing

IMPORTANTIMPORTANT

Single Pass Instancing

One common issue with Single Pass Instanced Rendering occurs if developers already have existing custom shaders not

written for instancing. After enabling this feature, developers may notice some GameObjects only render in one eye. This

is because the associated custom shaders do not have the appropriate properties for instancing.

See Single Pass Stereo Rendering for HoloLens from Unity for how to address this problem

To achieve better hologram stability from the perception of the user, it's recommended to enable the DepthDepth

Buffer SharingBuffer Sharing property in Unity. By turning this on, Unity will share the depth map produced by your

application with the Windows Mixed Reality platform. The platform can then better optimize hologram stability

specifically for your scene for any given frame being rendered by your application.

To enable this feature in your Unity Project

1. Open Player XR SettingsPlayer XR Settings  (go to EditEdit > Project SettingsProject Settings  > PlayerPlayer  > XR SettingsXR Settings )

2. Select the checkbox for Enable Depth Buffer SharingEnable Depth Buffer Sharing under Vir tual Reality SDKsVir tual Reality SDKs  > Windows MixedWindows Mixed

RealityReality  expansion (Vir tual Reality Suppor tedVir tual Reality Suppor ted checkbox must be checked)

Further, it's recommended to select 16-bit depth16-bit depth under the Depth FormatDepth Format setting in this panel, especially for

HoloLens Development. Selecting 16-bit compared to 24-bit will significantly reduce the bandwidth

requirements as less data will need to be moved/processed.

In order for the Windows Mixed Reality platform to optimize hologram stability, it relies on the depth buffer to

be accurate and match any rendered holograms on screen. Thus, with depth buffer sharing on, it is important

when rendering color, to also render depth. In Unity, most Opaque or TransparentCutout materials will render

depth by default but transparent and text objects will not render depth although this is shader-dependent, etc.

If using the Mixed Reality Toolkit Standard shader, to render depth for transparent objects:

1. Select the transparent material that is using the MRTK Standard shader and open the Inspector editor

window

2. Select the Fix NowFix Now  button within the depth buffer sharing warning. This can also be performed manually by

setting the Rendering ModeRendering Mode to CustomCustom; then set ModeMode to TransparentTransparent and finally set Depth WriteDepth Write to

OnOn

Developers should beware of Z-fighting when changing these values along with the camera's near/far plane settings. Z-

Fighting occurs when two gameobjects try to render to the same pixel and due to limitations in fidelity of the depth

buffer (i.e z depth), Unity cannot discern which object is in front of the other. Developers will note a flickering between two

game objects as they fight for the same z-depth value. This can be solved by switching to 24-bit depth format as there

will be a larger range of values for each object to calculate upon for their z-depth from the camera.

However, it is recommended, particularly for HoloLens development, to modify the camera's near and far planes to a

smaller range instead and retain the 16-bit depth format. The z-depth is non-linearly mapped to the range of values

along the near and far camera planes. This can be modified by selecting the Main Camera in your scene and under

InspectorInspector , change the Near & Far Clipping PlaneNear & Far Clipping Plane values to reduce their range (i.e from 1000m to 100m or other x

value, etc.)

https://docs.unity3d.com/Manual/SinglePassInstancing.html
https://docs.unity3d.com/Manual/SinglePassStereoRenderingHoloLens.html
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/rendering/mrtk-standard-shader


IMPORTANTIMPORTANT

  Building for IL2CPPBuilding for IL2CPP

NOTENOTE

 Publishing properties
  Holographic splash screenHolographic splash screen

SH O W  UN IT Y  SP L A SH  SC REENSH O W  UN IT Y  SP L A SH  SC REEN H O LO GRA P H IC  SP L A SH  IM A GEH O LO GRA P H IC  SP L A SH  IM A GE B EH AVIO RB EH AVIO R

Unity does not create a stencil buffer when using 16-bit depth format. Thus, some Unity UI effects and other stencil-

required effects will not work unless 24-bit depth format is selected which will create an 8-bit stencil buffer.

Unity has deprecated support for the .NET scripting backend and thus recommends that developers utilize

IL2CPPIL2CPP for their UWP visual studio builds. Although this brings various advantages, building your visual studio

solution from Unity for IL2CPPIL2CPP can be slower than the old .NET method. Thus, it is highly recommended to

follow best practices for building IL2CPPIL2CPP to save on development iteration time.

1. Leverage incremental building by building your project to the same directory every time, reusing the pre-

built files there

2. Disable anti-malware software scans for your project & build folders

3. Use an SSD for building

Open Virus & threat protectionVirus & threat protection under your Windows 10 settings app

Select Manage SettingsManage Settings  under Virus & threat protection settingsVirus & threat protection settings

Select Add or remove exclusionsAdd or remove exclusions  under the ExclusionsExclusions  section

Select Add an exclusionAdd an exclusion and select the folder containing your Unity project code and build outputs

Read Optimizing Build Times for IL2CPP for more info.

Furthermore, it may be beneficial to setup a Cache Server, especially for Unity projects with a large amount of assets

(excluding script files) or constantly changing scenes/assets. When opening a project, Unity stores qualifying assets into an

internal cache format on the developer machine. Items must be re-imported and thus re-processed when modified. This

process can be done once and saved in a Cache Server and consequently shared with other developers to save time,

instead of every developer processing the re-import of new changes locally.

HoloLens has a mobile-class CPU and GPU, which means apps may take a bit longer to load. While the app is

loading, users will just see black, and so they may wonder what's going on. To reassure them during loading,

you can add a holographic splash screen.

To toggle the holographic splash screen:

1. Go to EditEdit > Project SettingsProject Settings  > PlayerPlayer  page

2. Select the Windows StoreWindows Store tab and open the Splash ImageSplash Image section

3. Apply your image under the Windows Holographic > Holographic Splash ImageWindows Holographic > Holographic Splash Image property.

Toggling the Show Unity Splash ScreenShow Unity Splash Screen option will enable or disable the Unity branded splash

screen. If you don't have a Unity Pro license, the Unity branded splash screen will always be displayed.

If a Holographic Splash ImageHolographic Splash Image is applied, it will always be displayed whether the Show Unity

Splash Screen checkbox is enabled or disabled. Specifying a custom holographic splash image is only

available to developers with a Unity Pro license.

https://docs.unity3d.com/ScriptReference/RenderTexture-depth.html
https://docs.unity3d.com/Manual/SL-Stencil.html
https://docs.unity3d.com/Manual/IL2CPP-OptimizingBuildTimes.html
https://docs.unity3d.com/Manual/CacheServer.html


On None Show default Unity splash screen for 5
seconds or until the app is loaded,
whichever is longer.

On Custom Show Custom splash screen for 5
seconds or until the app is loaded,
whichever is longer.

Off None Show transparent black (nothing) until
app is loaded.

Off Custom Show Custom splash screen for 5
seconds or until the app is loaded,
whichever is longer.

SH O W  UN IT Y  SP L A SH  SC REENSH O W  UN IT Y  SP L A SH  SC REEN H O LO GRA P H IC  SP L A SH  IM A GEH O LO GRA P H IC  SP L A SH  IM A GE B EH AVIO RB EH AVIO R

  Tracking lossTracking loss

  Opt-out of automatic pauseOpt-out of automatic pause

  Tracking loss eventsTracking loss events

  CapabilitiesCapabilities

Read Unity's Splash Screen documentation for more info.

A Mixed reality headset depends on seeing the environment around it to construct world-locked coordinate

systems, which allow holograms to remain in position. When the headset is unable to locate itself in the world,

the headset is said to have lost tracking. In these cases, functionality dependent on world-locked coordinate

systems, such as spatial stages, spatial anchors and spatial mapping, don't work.

If a loss of tracking occurs, Unity's default behavior is to stop rendering holograms, pause the game loop, and

display a tracking lost notification that comfortably follows the users gaze. Custom notifications can also be

provided in the form of a tracking loss image. For apps that depend upon tracking for their whole experience, it's

sufficient to let Unity handle this entirely until tracking is regained. Developers can supply a custom image to be

shown during tracking loss.

To customize the tracking lost image:

1. Go to EditEdit > Project SettingsProject Settings  > PlayerPlayer  page

2. Select on the Windows StoreWindows Store tab and open the Splash ImageSplash Image section

3. Apply your image under the Windows Holographic > Tracking Loss ImageWindows Holographic > Tracking Loss Image property.

Some apps may not require tracking (e.g. orientation-only apps such as 360-degree video viewers) or may need

to continue processing uninterrupted while tracking is lost. You can opt out of the default loss of tracking

behavior but you're responsible for hiding/disabling any objects, which wouldn't render properly in a tracking-

loss scenario. In most cases, the only content that is recommended to be render in that case is body-locked

content, centered around the main camera.

To opt out of automatic pause behavior :

1. Go to the EditEdit > Project SettingsProject Settings  > PlayerPlayer  page

2. Select the Windows StoreWindows Store tab and open the Splash ImageSplash Image section

3. Modify the Windows Holographic > On Tracking Loss Pause and Show ImageWindows Holographic > On Tracking Loss Pause and Show Image checkbox.

To define custom behavior when tracking is lost, handle the global tracking loss events.

For an app to take advantage of certain functionality, it must declare the appropriate capabilities in its manifest.

The manifest declarations can be made in Unity so they're included in every future project export.

https://docs.unity3d.com/Manual/class-PlayerSettingsSplashScreen.html
https://docs.microsoft.com/en-us/windows/mixed-reality/develop/unity/coordinate-systems-in-unity
https://docs.unity3d.com/Manual/ExecutionOrder.html
https://docs.microsoft.com/en-us/windows/mixed-reality/develop/unity/coordinate-systems-in-unity
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SpatialPerception SurfaceObserver

WebCam PhotoCapture and VideoCapture

PicturesLibrary / VideosLibrary PhotoCapture or VideoCapture, respectively (when storing
the captured content)

Microphone VideoCapture (when capturing audio), DictationRecognizer,
GrammarRecognizer, and KeywordRecognizer

InternetClient DictationRecognizer (and to use the Unity Profiler)

 See also

Capabilities can be enabled for a Mixed Reality application by:

1. Go to EditEdit > Project SettingsProject Settings  > PlayerPlayer  page

2. Select the Windows StoreWindows Store tab, open the Publishing SettingsPublishing Settings  section, and look for the CapabilitiesCapabilities  list

The applicable capabilities for enabling the commonly used APIs for Holographic apps are: 

Unity development overview

Understanding performance for Mixed Reality

Performance recommendations for Unity



   

 

Preview and debug your app using Holographic
Remoting and Play mode
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 Set up Holographic Remoting

 

 

This article explains the following use case for Holographic Remoting:

You want to preview and debug your app during the development processYou want to preview and debug your app during the development process : You can run your app

locally in the Unity editor on your PC in Play Mode and stream the experience to your HoloLens. This

provides a way to quickly debug your app without building and deploying a full project. We call this type of

app a Holographic Remoting Play Mode Preview app. Inputs from the HoloLens--gaze, gesture, voice, and

spatial mapping--are sent to the PC, where content is rendered in a virtual immersive view. The rendered

frames are then sent to the HoloLens.

To learn more about Holographic Remoting, see Holographic Remoting Overview

Note that you can also use Holographic Remoting if you want the resources of a PC to power your app instead

of relying on the HoloLens on-board resources.

To use Holographic Remoting, you need to install the Holographic Remoting Player app from the Microsoft Store

on your HoloLens. As explained below, after you download and run the app, you'll see the version number and

IP address to connect to. You'll need v2.4 or later in order to work with the OpenXR pluginYou'll need v2.4 or later in order to work with the OpenXR plugin .

Holographic Remoting requires a fast PC and Wi-Fi connection. You can find more details in the Holographic

Remoting Player article linked above.

Unity 2020 + OpenXR

Unity 2019/2020 + Windows XR Plugin

Legacy WSA

The following steps assume that you have already set up your project to use OpenXR (in other words, you've

imported the required packages and chosen settings for the OpenXR plug-in). If you haven't yet done this, see

Setting up your XR configuration.

1. On your HoloLens 2, go to the Microsoft StoreMicrosoft Store and install the Holographic Remoting PlayerHolographic Remoting Player  app.

2. On your HoloLens 2, launch and play the Holographic Remoting Player app. Note that on the Start menu,

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/preview-and-debug-your-app.md
https://docs.microsoft.com/en-us/windows/mixed-reality/develop/unity/xr-project-setup?branch=main&tabs=openxr
https://www.microsoft.com/store/p/holographic-remoting-player/9nblggh4sv40


TIPTIP

the tile for the app says Holographic RemotingHolographic Remoting. After launching the app, make sure to press the "Play"

button on the app's interface.

3. In Unity, on the menu bar, select Mixed RealityMixed Reality  > RemotingRemoting > Holographic remoting for playHolographic remoting for play

modemode.

4. In the Holographic Remoting for Play ModeHolographic Remoting for Play Mode window, in the Remote Host NameRemote Host Name box, enter the IP

address of your HoloLens 2.

The IP address of your HoloLens 2 can be found when running the Holographic Remoting Player

5. Change other settings as needed.

6. Click the Enable Holographic Remoting for Play ModeEnable Holographic Remoting for Play Mode button.

7. Select the Play button to enter Play Mode, and then view the app in your HoloLens 2.



 See Also

TIPTIP
To debug C# scripts in play mode, attach Visual Studio to Unity.

Holographic Remoting Player

Tutorial: Getting started with PC Holographic Remoting

Tutorial: Creating a Holographic Remoting PC application

https://docs.microsoft.com/en-us/visualstudio/gamedev/unity/get-started/using-visual-studio-tools-for-unity?pivots=windows
https://docs.microsoft.com/en-us/learn/modules/pc-holographic-remoting-tutorials/
https://docs.microsoft.com/en-us/learn/modules/pc-holographic-remoting-tutorials/4-create-holographic-remoting-pc-application


   

 

Build and deploy to the HoloLens
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 Build the Unity project

Before you build and deploy your project, make sure that you have already set up your XR configuration and

switched to the Universal Windows Platform.

1. In Unity on the menu bar, select FileFile > Build Settings...Build Settings... .

2. In the Build SettingsBuild Settings  window, select the Add Open ScenesAdd Open Scenes  button. This adds your current scene to the

Scenes In BuildScenes In Build list.

3. If you followed the instructions in the Set up a new OpenXR project with MRTK article, you should have

all the correct settings for a Universal Windows Platform build in place. As a reminder, here are the

settings once again:

-Set Target deviceTarget device to HoloLens

-Set ArchitectureArchitecture to ARM 64

-Set Build TypeBuild Type to D3D Project

-Set Target SDK VersionTarget SDK Version to Latest Installed

-Set Minimum Platform VersionMinimum Platform Version to 10.0.10240.0

-Set Visual Studio VersionVisual Studio Version to Latest installed

-Set Build and Run onBuild and Run on to USB Device

-Set Build configurationBuild configuration to Release (there are known performance issues with Debug)

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/build-and-deploy-to-hololens.md


 Rebuilding your project

 Building and deploying a Unity Visual Studio solution

4. Click the BuildBuild button.

5. In the Build Universal Windows PlatformBuild Universal Windows Platform dialog, choose the folder you want to store your build in.

(To keep things organized, you may want to create a folder named BuildsBuilds , or something similar, and then

save your build there.)

6. Select the folder you chose and then click Select FolderSelect Folder  to start the build process.

If you make changes to your project, you'll need to do another build from Unity. Some examples of changes are:

You change a script.

You add or remove assets in the Project tab.

You change any value in the Inspector tab.

You add or remove objects from the Hierarchy tab.

You change any Unity project settings.

1. After Unity has finished building the project, a Windows Explorer window will open to the project root

directory. Navigate into the folder that contains your newly-created solution file.

2. Find the solution file located inside this folder and open it.

The remainder of building and deploying apps happens in Visual Studio.



   

 

Best practices for working with Unity and Visual
Studio
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 Improving iteration time

 Visual Studio Tools for Unity

 Expose C# class variables for easy tuning

When you're creating a mixed reality application with Unity, you need to switch between Unity and Visual Studio

to build and deploy the app package to HoloLens or an immersive headset. By default, two instances of Visual

Studio are required - one instance to modify Unity scripts and another to deploy to the device and debug. The

following instructions let you develop using a single Visual Studio instance, reducing the frequency of exporting

Unity projects and improves the debugging experience.

Support for .NET scripting back-end in Unity was deprecated in Unity 2018 and removed as of Unity 2019+, so

we recommend you switch to IL2CPP. However, you may experience longer build times from Unity to Visual

Studio. To improve for faster iteration, set up your environment for best compilation results:

1. Use incremental building by building your project to the same directory every time, reusing the pre-built

files there

2. Disable anti-malware software scans for your project & build folders

3. Use an SSD for building

Open Virus & threat protectionVirus & threat protection under your Windows 10 settings app

Select Manage SettingsManage Settings  under Virus & threat protection settingsVirus & threat protection settings

Select Add or remove exclusionsAdd or remove exclusions  under the ExclusionsExclusions  section

Select Add an exclusionAdd an exclusion and select the folder containing your Unity project code and build outputs

Review Optimizing Build Times for IL2CPP for more info. Also, review Debugging on IL2CPP Scripting Back-end.

Consider installing the UnityScriptAnalyzer Visual Studio extension. This tool analyzes your Unity C# scripts for

code that can be written in a more optimized manner.

Download Visual Studio Tools for Unity

Benefits of Visual Studio Tools for UnityBenefits of Visual Studio Tools for Unity

Debug Unity in-editor play mode from Visual Studio by putting breakpoints, evaluating variables and

complex expressions.

Use the Unity Project Explorer to find your script with the exact same hierarchy that Unity displays.

Get the Unity console directly inside Visual Studio.

Use wizards to quickly create or navigate to scripts.

There are two ways to expose class variables. The recommended way is to add the [SerializeField] attribute to

your private variables. Serialized fields can be accessed from the editor but not programmatically exposed. The

other option is to make C# class variables public to expose them in the editor UI.

Both approaches make it possible to easily tweak variables while playing in-editor, which is especially useful for

tuning interaction mechanic properties.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/best-practices-for-working-with-unity-and-visual-studio.md
https://docs.unity3d.com/Manual/IL2CPP.html
https://docs.unity3d.com/Manual/IL2CPP-OptimizingBuildTimes.html
https://docs.unity3d.com/Manual/windowsstore-debugging-il2cpp.html
https://github.com/Microsoft/MixedRealityCompanionKit/tree/master/UnityScriptAnalyzer
https://docs.microsoft.com/en-us/visualstudio/cross-platform/getting-started-with-visual-studio-tools-for-unity


 Regenerate UWP Visual Studio solutions after Windows SDK or Unity
upgrade

 Use text-format assets for easy comparison of content changes

 See also

UWP Visual Studio solutions checked in to source control can get out-of-date after upgrading to a new Windows

SDK or Unity engine. You can resolve out-of-date solutions after by building a new UWP solution from Unity and

merging differences into the checked-in solution.

Storing assets in text format makes it easier to review content change diffs in Visual Studio. You can store assets

in text format by selecting Edit > Project Settings > EditorEdit > Project Settings > Editor  and change Asset Ser ializationAsset Ser ialization mode to ForceForce

TextText. However, merging text asset file changes is error-prone and not recommended, so consider enabling

exclusive binary checkouts in your source control.

Visual Studio Tools for Unity

Optimizing Build Times for IL2CPP

UnityScriptAnalyzer Visual Studio extension

https://visualstudiogallery.msdn.microsoft.com/8d26236e-4a64-4d64-8486-7df95156aba9
https://docs.unity3d.com/Manual/IL2CPP-OptimizingBuildTimes.html
https://github.com/Microsoft/MixedRealityCompanionKit/tree/master/UnityScriptAnalyzer
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IMPORTANTIMPORTANT

 Active blocking issues

B LO C K IN G ISSUESB LO C K IN G ISSUES STAT US &  L A ST  UP DAT ESTAT US &  L A ST  UP DAT E   VERSIO N S W IT H  ISSUE    VERSIO N S W IT H  ISSUE    M IT IGAT IO N     M IT IGAT IO N   

ARM32 UWP Unity apps
built in release mode using
Visual Studio 2022 will hit
an internal compiler error in
Visual Studio.

Pending release:Pending release:
2022/06/27

Visual Studio 2022
version 17.1.1+

Use Visual Studio 2019 or
2022 version <= 17.0

HL2 app using URP,
WindowsXR plugin and
Gamma color space
rendering has worse render
performance in Unity 2020
or later.

Investigating:Investigating:
2022/05/06

Unity 2020.*.* 
with URP 10.*.* 
and Windows XR Plugin 4.*.
*

Upgrade to OpenXR Plugin
instead of WindowsXR
plugin

HL2 app using URP has
worse render performance
in Unity 2021 compared to
Unity 2020.

Investigating:Investigating:
2022/05/06

Unity 2021.*.* 
with URP 12.*.*

Either avoid URP in
Unity 2021 or use URP in
Unity 2020.LTS

 Resolved blocking issues

B LO C K IN G ISSUESB LO C K IN G ISSUES STAT US &  L A ST  UP DAT ESTAT US &  L A ST  UP DAT E   VERSIO N S W IT H  ISSUE    VERSIO N S W IT H  ISSUE    VERSIO N S W IT H  F IXES    VERSIO N S W IT H  F IXES  

HL2 app using Unity's Burst
package (e.g. commonly
used when using URP) will
hit ILCPP compile error in
VisualStudio.

Fixed:Fixed:
2022/06/06

Unity Burst package 
1.6.5 or 1.7.0~1

Use Unity Burst package
1.6.6 or 1.7.2 or later
versions.

Some versions of Unity or Unity plugins have known incompatibilities blocking apps from working as expected

on HoloLens 2 or Windows Mixed Reality devices. While we generally support all LTS versions of Unity and their

verified plugins, we recommend avoiding those specific builds of Unity and Unity plugins to ensure your apps

work as expected.

The latest Unity 2021 release has a known blocking performance bug with HoloLens 2 if the project is using URP

rendering pipeline.

For new projects using URP rendering, we recommend using latest Unity 2020.3.35f1 or later LTSUnity 2020.3.35f1 or later LTS with the latestthe latest

Mixed Reality OpenXR pluginMixed Reality OpenXR plugin to avoid this issue.

If using other Unity releases, consult the known active blocking issues to ensure you avoid builds with other blocking

issues.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/known-issues.md
https://developercommunity.visualstudio.com/t/uwp-arm-32-build-fails-with-fatal-error-c1001-inte/1697106#T-N10059007
https://issuetracker.unity3d.com/issues/build-fails-with-error-mono-dot-cecil-dot-assemblyresolutionexception-failed-to-resolve-assembly-when-unity-iap-is-in-the-project


Application with default
splash screen will show four
spinning dots when
launching on HL2, or after
the application is
suspended and resumed.

Fixed:Fixed:
2022/05/20

Unity 2020.3.32-34f1 
and Unity 2021.2.17~19f1
and Unity 2021.3.0~3f1

Use Unity 2020.3.35f1 or
Unity 2021.3.4f1 or later

HL2 application shows
severely jittery image.

Fixed:Fixed:
2021/12/02

Unity 2020.3.21f1 to 
Unity 2020.3.23f1

Use Unity 2020.3.24f1
and later

OpenXR backend with URP
can deadlock on HL2.

Fixed:Fixed:
2021/05/13

Unity 2020.3.0f1 to 
Unity 2020.3.7f1

Use Unity 2020.3.8f1
and later

B LO C K IN G ISSUESB LO C K IN G ISSUES STAT US &  L A ST  UP DAT ESTAT US &  L A ST  UP DAT E   VERSIO N S W IT H  ISSUE    VERSIO N S W IT H  ISSUE    VERSIO N S W IT H  F IXES    VERSIO N S W IT H  F IXES  
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The Mixed Reality OpenXR plugin releases and related notes are available on GitHub.

To receive notifications when a new version of the plugin is released:

1. On the GitHub page linked above, click the Notifications button (it might display "Watch" or "Unwatch"),

and then select CustomCustom.

2. In the CustomCustom dialog, select Releases.Releases.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/openxr-release-notes.md
https://github.com/microsoft/OpenXR-Unity-MixedReality-Samples/releases
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IMPORTANTIMPORTANT

 Development checkpoints

  1. Getting started1. Getting started

Getting started with mixed reality applications is a big task. New concepts, platforms, and cutting edge hardware

can seem like barriers. However, if you're an Unreal developer you're in luck. Unreal Engine 4 has full support for

Windows Mixed Reality (VR) and HoloLens 2 (AR) devices.

4.26

4.25

The latest Unreal Engine 4.26 release includes:

Support for new cross-device XR APIs

OpenXR support + Microsoft OpenXR plugin

HoloLens Media Player plugin for performant video playback

Azure Spatial Anchors for iOS and Android (beta)

Support for reverse connections when remoting, enabling streaming from Azure to HoloLens 2

HoloLens 2 system keyboard access

Windows App Certification Kit compliance for packaged apps

Unreal Insights support for HoloLens 2

HP Reverb G2 controller support

See the Unreal Engine 4.26 release notes for more.

If you're new to Unreal development, don't jump in blind. Explore the Unreal tutorial series and look for assets in

the Unreal marketplace. You can also find support in the mixed reality forums. These resources are your links to

the community of builders and problem solvers in today's mixed reality market.

Take a look at our por ting guidepor ting guide if you have an existing Unreal project that you want to bring over to immersive

headsets such as the Reverb G2.

Use the following checkpoints to bring your Unreal games and applications into the world of mixed reality. If

you haven't explored the Designing Holograms sample application, we recommend downloading it to

familiarize yourself with the basics of Mixed Reality UX.

First, you'll need to install the tools for HoloLens 2 development. Next, go through our tutorial series to get a

basic understanding of the Mixed Reality Toolkit, a properly configured development environment for mixed

reality apps, and a working MRTK project in Unreal. As of Unreal 4.26, you also have the option of developing an

OpenXR app for HoloLens 2.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-development-overview.md
https://docs.microsoft.com/en-us/windows/mixed-reality
https://www.microsoft.com/windows/windows-mixed-reality
https://www.microsoft.com/hololens/hardware
https://github.com/microsoft/Microsoft-OpenXR-Unreal
https://docs.unrealengine.com/Support/Builds/ReleaseNotes/4_26/index.html
https://docs.unrealengine.com/GettingStarted/index.html
https://www.unrealengine.com/marketplace/store
https://forums.unrealengine.com/development-discussion/vr-ar-development
https://www.microsoft.com/p/designing-holograms/9nxwnjklrzwd


C H EC KP O IN TC H EC KP O IN T O UTC O M EO UTC O M E

Install the latest tools Download and install the latest version of Unreal Engine and
setup your project for mixed reality

Set up your project Get the latest version of Unreal Engine and MRTK

Creating your first HoloLens Unreal application Start off your Unreal and HoloLens development journey by
building a basic Mixed Reality application

HoloLens 2 tutorial series Get set up for mixed reality development in Unreal, build
your first app with MRTK, and deploy your app to HoloLens
2

Get started with OpenXR in Unreal Install and enable the following plugin from the Unreal
Engine Marketplace:

Ensure the Microsoft Windows Mixed Reality plugin is
disabled.

The full list of currently supported features in OpenXR is
below.

  2. Core building blocks2. Core building blocks

 

 

F EAT UREF EAT URE C A PA B IL IT IESC A PA B IL IT IES

Input simulation Use mouse and keyboard input in the editor to simulate a
Head-Mounted Display (HMD) and hand tracking features

Hand interaction Interact with UX components using articulated hand inputs

Pressable button Drive the state of button blueprints through low level
components

Manipulator Move and rotate an actor with one or two-hand
manipulation input

Microsoft OpenXR

There are a number of key mixed reality features that our tutorial series doesn't cover. These building blocks are

available as standalone features and through the Mixed Reality Toolkit. You might not need all of them at once,

but we recommend exploring early on. After diving into the core building blocks listed below, you'll have a

toolbox full of features you can integrate into your Mixed Reality projects.

The Mixed Reality Toolkit for Unreal is a set of plugins designed to speed up your development in Unreal. Each

plugin includes components, samples, and documentation for setting up immersive experiences.

UX Tools for Unreal is the first plugin to be released and is currently only supported on HoloLens 2. The

plugin includes C++ code, Blueprints, and example assets of common UX features for input simulation,

hand interactions, surface magnetism and more.

Graphics Tools for Unreal is a UE game plugin with code, blueprints and example assets created to help

improve the visual fidelity of Mixed Reality applications while staying within performance budgets.

Available in MRTK

Standalone features

https://www.unrealengine.com/marketplace/en-US/product/ef8930ca860148c498b46887da196239
https://github.com/microsoft/MixedRealityToolkit-Unreal
https://www.unrealengine.com/marketplace/en-US/product/mixed-reality-ux-tools
https://github.com/microsoft/MixedReality-GraphicsTools-Unreal/
https://microsoft.github.io/MixedReality-UXTools-Unreal/Docs/InputSimulation.html
https://microsoft.github.io/MixedReality-UXTools-Unreal/Docs/HandInteraction.html
https://microsoft.github.io/MixedReality-UXTools-Unreal/Docs/PressableButton.html
https://microsoft.github.io/MixedReality-UXTools-Unreal/Docs/Manipulator.html


Follow behavior Keep an actor or component within sight of another
component

F EAT UREF EAT URE C A PA B IL IT IESC A PA B IL IT IES

NOTENOTE

  3. Advanced features3. Advanced features

F EAT UREF EAT URE C A PA B IL IT IESC A PA B IL IT IES

HoloLens camera Capture Mixed Reality and real-world visual content from
your app running on a HoloLens device

QR codes Render QR codes as holograms using a coordinate system at
each code's real-world position

WinRT Create a separate binary with WinRT code that can be
consumed by Unreal’s build system

  4. Streaming and deploying to a device4. Streaming and deploying to a device

  5. Adding services5. Adding services

 

 

  6. Low-code alternatives6. Low-code alternatives
 

 

You can dive into the UX Tools for Unreal GitHubUX Tools for Unreal GitHub repository for more details.

Other key features that play a role in mixed reality applications are available without any extra packages or

setup. These features can be added to Unreal projects with or without MRTK installed. After diving into these

more advanced capabilities, you'll be able to build more complex Mixed Reality apps.

If you want to test out your application on a HoloLens device while still in development, you can stream it

directly from your PC by using either the Unreal editor or a packaged Windows executable.

If this is your first time deploying an Unreal app to HoloLens 2, you'll need to download supporting files from

the Epic Launcher. Once you have those files installed, you're ready to deploy from either the Unreal editor or the

Device Portal.

At this point in your development journey, you might be looking to add services or for a helping hand with

commercial deployment. Integrating Azure Cloud Services can level up your projects in a major way. We've

compiled a few starting points for you to explore and expand your Mixed Reality knowledge.

Azure Spatial Anchors

Azure Spatial Anchors (ASA) is a cross-platform service that allows you to build spatially aware mixed reality

applications. With Azure Spatial Anchors, you can map, persist, and share holographic content across multiple

devices, at real-world scale.

Overview

Spatial Anchors in Unreal

Dynamics 365

Microsoft Dynamics 365 Guides is a mixed-reality application for Microsoft HoloLens that lets operators learn

during the flow of work by providing holographic instructions when and where they are needed. These

instruction cards are visually tethered to the place where the work must be done, and can include images,

videos, and 3D holographic models.

https://microsoft.github.io/MixedReality-UXTools-Unreal/Docs/FollowComponent.html
https://github.com/microsoft/MixedReality-UXTools-Unreal
https://docs.microsoft.com/en-us/azure/spatial-anchors/overview


 What's next?

  DebuggingDebugging

  PerformancePerformance

 Supported Features

H O LO L EN S 2 F EAT UREH O LO L EN S 2 F EAT URE
EA RL IEST  SUP P O RT ED UN REA LEA RL IEST  SUP P O RT ED UN REA L
EN GIN E VERSIO NEN GIN E VERSIO N SUP P O RT ED IN  O P EN XR ( 4. 26+)SUP P O RT ED IN  O P EN XR ( 4. 26+)

ARM64 support 4.23 ✔️

Streaming from a PC 4.23 ✔️

Spatial mapping 4.23 ✔️

Hand and joint tracking 4.23 ✔️

Eye tracking 4.23 ✔️

Voice input 4.23 ✔️

Spatial anchors 4.23 ✔️

Camera access 4.23 ✔️

QR codes 4.23 ✔️

Spatial audio 4.23 ✔️

Planar LSR over streaming 4.24

Sample apps 4.24 ✔️

Overview

Get started

I'm an Admin

I'm an Author

I'm an Operator

Entity reference for developers

A developer's job is never done, especially when learning a new tool or SDK. The following sections can take you

into areas beyond the beginner level material you've already completed, along with helpful resources if you get

stuck. Note that these topics and resources are not in any sequential order, so feel free to jump around and

explore!

If you're looking to debug the application while it's running on device with Visual Studio, follow these

instructions.

Developing for mixed reality comes with performance checkpoints that depend on the platform. A HoloLens 2

app must run at 60 frames per second for holograms to appear stable and responsive. Luckily, we have

performance recommendations for upgrading performance in your Unreal applications.

https://docs.microsoft.com/en-us/dynamics365/mixed-reality/guides/
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/guides/get-started
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/guides/setup
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/guides/authoring-overview
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/guides/operator-overview
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/guides/developer-entity-reference
https://docs.microsoft.com/en-us/visualstudio/debugger/debug-installed-app-package#remote


Mobile multi-View: Performance hits
60 fps

4.25 ✔️

Streaming from a packaged desktop
app

4.25.1 ✔️

Azure Spatial Anchors for HoloLens 2 4.25 ✔️

Mixed Reality UX Tools support 4.25 ✔️

Developer docs & tutorials 4.25 ✔️

System keyboard 4.26 ✔️

HoloLens Media Player plugin 4.26 ✔️

Azure Spatial Anchors for iOS and
Android

4.26

Microsoft OpenXR plugin with
Microsoft vendor-specific OpenXR
extensions

4.26 ✔️

Streaming from Azure to HoloLens 2 4.26 ✔️

Windows App Certification Kit
compliance for packaged apps

4.26 ✔️

HP Reverb G2 controller support 4.26 ✔️

H O LO L EN S 2 F EAT UREH O LO L EN S 2 F EAT URE
EA RL IEST  SUP P O RT ED UN REA LEA RL IEST  SUP P O RT ED UN REA L
EN GIN E VERSIO NEN GIN E VERSIO N SUP P O RT ED IN  O P EN XR ( 4. 26+)SUP P O RT ED IN  O P EN XR ( 4. 26+)

 See also

Install the tools

Unreal docs for streaming, deploying to emulator and device

Unreal performance guidelines for mobile devices

https://docs.unrealengine.com/Platforms/AR/HoloLens2/index.html
https://docs.unrealengine.com/Platforms/Mobile/Performance/index.html
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 What is Mixed Reality Toolkit (MRTK)?

  ModularModular

  PerformantPerformant

 Project setup

MRTK is an amazing open-source toolkit that has been around since the HoloLens was first released. The toolkit

wouldn't be where it is today without the hard work of our contributing developer community.

The Mixed Reality Toolkit for Unreal (MRTK-Unreal) is a set of components, in the form of plugins, samples and

documentation, designed to help development of Mixed Reality applications using the Unreal Engine. Currently,

the toolkit consists of:

UX Tools for Unreal, which provides code, blueprints, and examples to implement UX features for Hololens 2

applications.

Graphics Tools for Unreal, which helps improve the visual fidelity of Mixed Reality applications while staying

within performance budgets.

Take a look at MRTK's documentation on GitHub and get started with UX Tools or Graphics Tools installation

guides.

We've built MRTK Unreal in a modular way, so you don't need to take every bit of the toolkit into your project.

You can pick and choose the plugins you need, and add or remove them whenever you see fit. This approach

keeps your project size smaller and makes it easier to manage.

Working with mobile platforms, we constructed MRTK Unreal with performance in mind. This is super important

and we wanted to ensure that the tools aren't going to work against you.

Download Unreal Engine and MRTK

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-mrtk-introduction.md
https://github.com/microsoft/MixedReality-UXTools-Unreal
https://github.com/microsoft/MixedReality-GraphicsTools-Unreal
https://microsoft.github.io/MixedReality-UXTools-Unreal/README.html
https://microsoft.github.io/MixedReality-UXTools-Unreal/Docs/Installation.html
https://github.com/microsoft/MixedReality-GraphicsTools-Unreal/blob/main/Docs/Installation.md


 

See also
Install the tools

Developing with MRTK for Unreal

UX Tools - Installation guide (GitHub)

UX Tools- Documentation home (GitHub)

Graphics Tools - Installation guide (GitHub)

Graphics Tools - Documentation home (GitHub)

https://microsoft.github.io/MixedReality-UXTools-Unreal/Docs/Installation.html
https://microsoft.github.io/MixedReality-UXTools-Unreal/README.html
https://github.com/microsoft/MixedReality-GraphicsTools-Unreal/blob/main/Docs/Installation.md
https://github.com/microsoft/MixedReality-GraphicsTools-Unreal/


   

 

Setting up your Unreal project
 7/6/2022 • 3 minutes to read • Edit Online

 Import Mixed Reality Toolkit for Unreal

  Introducing the MRTK Hub for UnrealIntroducing the MRTK Hub for Unreal

We recommend installing Unreal Engine version 4.25 or later to take full advantage of built-in HoloLens

support.

Go to the L ibrar yLibrar y  tab in the Epic Games Launcher, select the dropdown arrow next to LaunchLaunch and click

OptionsOptions . Under Target PlatformsTarget Platforms , select HoloLens 2HoloLens 2  and click ApplyApply . 

Mixed Reality Toolkit (MRTK) is an open-source, cross-platform development kit for mixed reality applications.

MRTK provides a cross-platform input system, foundational components, and common building blocks for

spatial interactions. The toolkit is intended to accelerate the development of applications targeting Microsoft

HoloLens, Windows Mixed Reality immersive (VR) headsets, and the OpenVR platform.

If you don't already have a mixed reality project, follow the first three sections of the HoloLens 2 Getting Started

tutorials to get a project ready for the MRTK.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-project-setup.md
https://docs.unrealengine.com//GettingStarted/Installation/index.html


NOTENOTE

  Installing the MRTK HubInstalling the MRTK Hub

  Installing mixed reality pluginsInstalling mixed reality plugins

We recommend that you use the MRTK Hub to acquire MRTK plugins. It's a new way for developers to discover

and update Microsoft Mixed Reality plugins and add them to their Unreal projects. You can view plugins, see

their dependencies and install them into your project without leaving the Unreal Editor.

Discover new Microsoft Mixed Reality plugins and install them and their dependencies into your Unreal

project.

Keep your Microsoft Mixed Reality plugins up to date.

Remove Microsoft Mixed Reality plugins from your project if you no longer need them.

The MRTK Hub for Unreal is only available for Unreal Engine version 4.26 or later. For Unreal Engine version 4.25, you can

get MRTK plugins from the Unreal Engine Marketplace or GitHub as described in the Getting Started section.

Download the plugin from the Unreal Engine Marketplace, then open your project, and then enable the plugin

from the Mixed Reality section of the Plugins menu. When prompted, restart the editor.

Once the plugin is enabled for your project, you can access the Hub from the toolbar button.

To install a plugin using the Hub, select the plugin you want to add to your project and then press the Install

button. To download the plugin, verify that there are no conflicts in the Issues box and press Confirm. Once the

plugin is downloaded, you'll be prompted to restart the editor.

https://www.unrealengine.com/marketplace/en-US/product/mixed-reality-toolkit-hub


IMPORTANTIMPORTANT

  Updating mixed reality pluginsUpdating mixed reality plugins

  Removing mixed reality pluginsRemoving mixed reality plugins

Once the editor has restarted, your can continue on your mixed reality development journey.

Once the plugin is installed, it must be checked into source control like any other project-level plugin.

To update a plugin using the Hub, select the plugin you want to update from the list and press the Install button.

To download the updated plugin, verify that there are no conflicts in the Issues box and press Confirm. You'll be

prompted to restart the editor to complete the update. Note that this restart may take some time as the plugins

are updated.



  Reviewing changes and detecting incompatibilitiesReviewing changes and detecting incompatibilities

NOTENOTE

To uninstall a plugin using the Hub, select the plugin you want to remove, and then select the version you have

installed from the dropdown. To remove the plugin, verify that there are no conflicts in the Issues box and press

Confirm. You'll be prompted to restart the editor to complete the removal. Note that this restart may take some

time as the plugins are removed.

You can view the exact changes that will be made to your project in the bottom section of the Hub's window.

From here you can see the plugins that will be added or removed from your project alongside any potential

incompatibilities that might cause issues when the changes have been made.

The Issues list will surface incompatibilities in the Unreal engine version and plugin dependency versions but it doesn't

automatically fix or suggest fixes to issues.



NOTENOTE

Mixed Reality Toolkit-Unreal (GitHub)Mixed Reality Toolkit-Unreal (GitHub)

If you don't want to use MRTK for Unreal, you'll need to script all interactions and behaviors yourself.

https://github.com/Microsoft/MixedRealityToolkit-Unreal
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 4.26 upgrades

  4.25 deprecations4.25 deprecations

DEP REC AT ED F UN C T IO NDEP REC AT ED F UN C T IO N N EW  F UN C T IO NN EW  F UN C T IO N

CreateNamedARPin

LoadWMRAnchorStoreARPins

When updating to a new version of Unreal, deprecated functions show up as warnings when compiling

blueprints or packaging the project. Functions are deprecated when a new function has been added that should

be used instead.

In 4.26, all AR and VR platforms have been refactored to add common interfaces and keep application code

platform agnostic, so you may see more warnings than usual. Updating to the new APIs is recommended so the

project can be more easily ported to other platforms.

Warning messages will show which function has been deprecated and indicate what function to use instead. All

deprecated functions will continue to work for this release but may not work in future releases. Deprecated

functions will also no longer be listed when searching for functions in a blueprint.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-porting.md


LoadWMRAnchorSaveARPinToWMRAnchorStoreStoreARPins

RemoveARPinFromWMRAnchorStore

SetEnabledMixedRealityCamera

ResizeMixedRealityCamera

StartCameraCapture

StopCameraCapture

StartQRCodeCapture

DEP REC AT ED F UN C T IO NDEP REC AT ED F UN C T IO N N EW  F UN C T IO NN EW  F UN C T IO N



StopQRCodeCapture

Spatial mapping previously automatically started in 4.25, but
now needs to be toggled in 4.26.

ShowKeyboard Removed in 4.26 since the keyboard automatically shows
when a text widget is focused on.

HideKeyboard Removed in 4.26 since the keyboard will automatically hide
when a text widget is unfocused.

SupportsHandTracking

IsDisplayOpaque

GetHandJointTransform, GetPointerPoseInfo,
GetControllerTrackingStatus

GetVersionString

IsTrackingAvailable

DEP REC AT ED F UN C T IO NDEP REC AT ED F UN C T IO N N EW  F UN C T IO NN EW  F UN C T IO N



IsButtonClicked, IsButtonDown, IsGrasped, IsSelectPressed Use Unreal’s input action system.

SetFocusPointForFrame Removed in 4.26. Previously used for reprojection when
remoting, which now supports depth reprojection.

DEP REC AT ED F UN C T IO NDEP REC AT ED F UN C T IO N N EW  F UN C T IO NN EW  F UN C T IO N

 4.26 changes
The significant change is that Star t in VRStar t in VR  from Edit > Project Settings > Project > Descr iption >Edit > Project Settings > Project > Descr iption >

SettingsSettings  is mandatory for starting Windows Mixed Reality plugin. Without that parameter, you will not see your

holograms on the device.



   

 

Creating your first HoloLens Unreal application
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 Objectives

 Creating a new project

This guide will walk you through getting your first Mixed Reality app running on the HoloLens in Unreal Engine.

In the tradition of "Hello World", you'll create a simple app that displays a cube on the screen. To make it more

useful, you'll also create your first gesture to rotate the cube and quit the application.

Start a HoloLens Project

Enable the correct plugins

Create an ARSessionConfig Data Asset

Set up gesture inputs

Build a basic level

Implement a pinch gesture

The first thing you need is a project to work with. If you're a first-time Unreal developer, you'll need to download

supporting files from the Epic Launcher.

1. Launch Unreal Engine

2. In the New Project CategoriesNew Project Categories , select GamesGames  and click NextNext:

3. Select the BlankBlank template and click NextNext:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-quickstart.md


NOTENOTE

4. In the Project SettingsProject Settings , set C++, Scalable 3D or 2D, Mobile/TabletC++, Scalable 3D or 2D, Mobile/Tablet, and No Star ter ContentNo Star ter Content, then

choose a save location and click Create ProjectCreate Project

You're using a C++ rather than a Blueprint project in order to be ready to use the OpenXR plugin later. This QuickStart

uses the default OpenXR plugin that comes with Unreal Engine. However, downloading and using the official Microsoft

OpenXR plugin is recommended. That requires the project to be a C++ project.



 Enabling required plugins

Your new project should open up automatically in the Unreal editor, which means you're ready for the next

section.

You'll need to enable two plugins before you can start adding objects to the scene.

1. Open Edit > PluginsEdit > Plugins  and select Augmented RealityAugmented Reality  from the built-in options list.

Scroll down to HoloLensHoloLens  and check EnabledEnabled

2. Type OpenXROpenXR  in the search box at the top right and enable the OpenXROpenXR  and

OpenXRMsftHandInteractionOpenXRMsftHandInteraction plugins:



NOTENOTE

 Creating a level

3. Restart your editor

This tutorial uses OpenXR, but the two plugins you've installed above don't currently provide the full feature set for

HoloLens development. The HandInteraction plugin will suffice for the "Pinch" gesture you'll use later, but if you want to

go beyond the basics you'll need to download the Microsoft OpenXR plugin.

With the plugins enabled, you can focus on filling it with content.

Your next task is to create a player setup with a starting point and a cube for reference and scale.

1. Select File > New LevelFile > New Level  and choose Empty LevelEmpty Level . The default scene in the viewport should now be empty

2. From the ModesModes  tab, select BasicBasic and drag PlayerStar tPlayerStar t into the scene

In the DetailsDetails  tab, set LocationLocation to X = 0, Y = 0,X = 0, Y = 0, and Z = 0Z = 0  to place the user at the center of the scene when

the app starts

3. From the BasicBasic tab, drag a CubeCube into the scene

Set the cube's LocationLocation to X = 50, Y = 0X = 50, Y = 0 , and Z = 0Z = 0  to position the cube 50 cm away from the player at

https://github.com/microsoft/Microsoft-OpenXR-Unreal


start

Change the cube's ScaleScale to X = 0.2 , Y = 0.2X = 0.2 , Y = 0.2 , and Z = 0.2Z = 0.2

You can't see the cube unless you add a light to your scene, which is your last task before testing the scene.

4. In the ModesModes  panel, switch to the L ightsL ights  tab and drag a Directional L ightDirectional L ight into the scene

Position the light above PlayerStar tPlayerStar t so you can see it

5. Go to File > Save CurrentFile > Save Current, name your level MainMain, and select SaveSave

With the scene set, press PlayPlay  in the toolbar to see your cube in action! When you're finished admiring your

work, press Esc to stop the application.



 Adding a session asset

Now that the scene is set up, lets get it ready for some basic interactions in AR. First, you need to create an AR

Session and can add blueprints to enable hand interaction.

AR sessions in Unreal don't happen by themselves. To use a session, you need an ARSessionConfig data asset to

work with, which is your next task:

1. In the Content BrowserContent Browser , select Add New > Miscellaneous > Data AssetAdd New > Miscellaneous > Data Asset and make sure you're at the

root Content folder level

2. Select ARSessionConfigARSessionConfig, click SelectSelect, and name the asset ARSessionConfigARSessionConfig:

2. Double-click ARSessionConfigARSessionConfig to open it, SaveSave with all default settings, and return to the Main window:



With that done, your next step is to make sure the AR session starts and stops when the level loads and ends.

Luckily, Unreal has a special blueprint called a Level BlueprintLevel Blueprint that acts as a level-wide global event graph.

Connecting the ARSessionConfig asset in the Level Blueprint guarantees the AR session will fire right when the

game starts playing.

3. From the editor toolbar, select Blueprints > Open Level BlueprintBlueprints > Open Level Blueprint:

4. Drag the execution node (left-facing arrow icon) off Event BeginPlayEvent BeginPlay  and release

Search for the Star t AR Session nodeStar t AR Session node and hit enter

Click the Select AssetSelect Asset dropdown under Session ConfigSession Config and choose the ARSessionConfigARSessionConfig asset



IMPORTANTIMPORTANT

 Setting up inputs

5. Right-click anywhere in the EventGraph and create a new Event EndPlayEvent EndPlay  node.

Drag the execution pin and release, then search for a Stop AR SessionStop AR Session node and hit enter

Hit CompileCompile, then SaveSave and return to the Main window

If the AR session is still running when the level ends, certain features may stop working if you restart your app while

streaming to a headset.

1. Select Edit > Project SettingsEdit > Project Settings  and go to the Engine > InputEngine > Input

2. Select the ++ icon next to Action MappingsAction Mappings  and create RightPinchRightPinch and LeftPinchLeftPinch actions:

3. Map the RightPinchRightPinch and LeftPinchLeftPinch actions the to the respective OpenXR Msft Hand InteractionOpenXR Msft Hand Interaction actions:



 Setting up gestures
Now that we have setup the inputs, we can get to the exciting part: Adding gestures! Lets rotate the cube on the

right pinch and quit the application on left pinch.

1. Open the Level BlueprintLevel Blueprint and add an InputAction RightPinchInputAction RightPinch and InputAction LeftPinchInputAction LeftPinch

Connect the right pinch event to an AddActorLocalRotationAddActorLocalRotation with your CubeCube as the target and DeltaDelta

RotationRotation set to X = 0, Y = 0X = 0, Y = 0 , and Z = 20Z = 20 . The cube will now rotate by 20 degrees every time you pinch

Connect the left pinch event to Quit GameQuit Game

2. In the cube's TransformTransform settings, set MobilityMobility  to MovableMovable so it can move dynamically:

At this point, you're ready to deploy and test the application!
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NOTENOTE

 Prerequisites

Whether you're new to mixed reality or a seasoned pro, you're in the right place to start your HoloLens 2 and

Unreal Engine journey. This tutorial series will give you a step-by-step guide on how to build an interactive chess

app with the UX Tools plugin--part of the Mixed Reality Toolkit for Unreal. The plugin will help you add common

UX features to your projects with code, blueprints, and examples.

If you prefer video guides, we have a talk that covers a lot of the same information as this tutorial. The talk also covers the

use of GraphicsTools to further improve the the game's performance: Intro to HoloLens 2 development using the Unreal

Engine and MRTK-Unreal.

By the end of the series you'll have experience with:

Starting a new project

Setting up for mixed reality

Working with user input

Adding buttons

Playing on an emulator or device

Make sure you've installed the following before jumping in:

Windows 10 1809 or later

Windows 10 SDK 10.0.18362.0 or later

Unreal Engine 4.26 or later

Microsoft HoloLens 2 device configured for development or Emulator

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/tutorials/unreal-uxt-ch1.md
https://www.unrealengine.com/en-US/
https://github.com/microsoft/MixedReality-UXTools-Unreal
https://github.com/microsoft/MixedRealityToolkit-Unreal
https://www.youtube.com/watch?v=avTjzrv1jmc
https://www.unrealengine.com/en-US/get-now


  Installing Visual Studio 2019Installing Visual Studio 2019

Visual Studio 2019 with the workloads below

First, make sure you're set up with all the required Visual Studio packages:

1. Install the latest version of Visual Studio 2019

2. Install the following workloads:

Desktop development with C++

.NET desktop development

Universal Windows Platform development

3. Expand Universal Windows Platform development and select:

USB Device Connectivity

C++ (v142) Universal Windows Platform tools

4. Install the following components:

Compilers, build tools, and runtimes > MSVC v142 - VS 2019 C++ ARM64 build tools (latest version)

You can confirm the installation with the following picture

That's it! You're all set to move on to starting the chess project.

Next section: 2. Initializing your project and first application

https://visualstudio.microsoft.com/downloads/
https://docs.microsoft.com/en-us/visualstudio/install/modify-visual-studio#modify-workloads
https://docs.microsoft.com/en-us/visualstudio/install/modify-visual-studio#modify-individual-components
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IMPORTANTIMPORTANT

 Objectives

 Creating a new Unreal project

In the first tutorial, you'll start out with a new Unreal project and enable the HoloLens plugin, create and light a

level, and add chess pieces. You'll be using our pre-made assets for all 3D objects and materials, so don't worry

about modeling anything yourself. By the end of this tutorial, you'll have a blank canvas that's ready for mixed

reality.

Make sure you have all the prerequisites from the Getting Started page.

Configuring an Unreal project for HoloLens development

Importing assets and setting up a scene

Creating Actors and script-level events with blueprints

The first thing you need is a project to work with. If you're a first-time Unreal developer, you'll need to download

supporting files from the Epic Launcher.

1. Launch Unreal Engine

2. Select GamesGames  in New Project CategoriesNew Project Categories  and click NextNext.

3. Select the BlankBlank Template and click NextNext.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/tutorials/unreal-uxt-ch2.md
https://docs.microsoft.com/en-us/windows/mixed-reality/unreal-uxt-ch1


NOTENOTE

4. Set C++C++, Scalable 3D or 2D, Mobile/TabletScalable 3D or 2D, Mobile/Tablet, and No Star ter ContentNo Star ter Content as your Project SettingsProject Settings , then

choose a save location and click Create ProjectCreate Project.

You must select a C++ project rather than a Blueprint project in order to build the UX Tools plugin, which you'll be setting

up later on in section 4.



 Enabling required plugins

The project should open up automatically in the Unreal editor, which means you're ready for the next section.

In order to use the features available via Microsoft's mixed reality platform, you'll first need to install and enable

the Microsoft OpenXR plugin. To learn more about the plugin, you can check out the project on GitHub.

1. Open the Epic Games Launcher. Navigate to Unreal Engine Marketplace and search for "Microsoft OpenXR".

Install the plugin to your engine.

2. Back in the Unreal editor, go to Project SettingsProject Settings  > PluginsPlugins  and search for "Microsoft OpenXR". Ensure the

plugin is enabled and restart the editor if prompted.

https://github.com/microsoft/Microsoft-OpenXR-Unreal
https://www.unrealengine.com/marketplace/product/ef8930ca860148c498b46887da196239


 Creating a level

Enabling the Microsoft OpenXR plugin will automatically enable all the other plugins required for mixed reality

development. Note that the "Microsoft Windows Mixed Reality" plugin must be disabled in order to use OpenXR.

Your next task is to create a player setup with a starting point and a cube for reference and scale.

1. Select File > New LevelFile > New Level  and choose Empty LevelEmpty Level . The default scene in the viewport should now be

empty.

2. Select BasicBasic from the ModesModes  tab and drag PlayerStar tPlayerStar t into the scene.

Set LocationLocation to X = 0X = 0 , Y = 0Y = 0 , and Z = 0Z = 0  in the DetailsDetails  tab to set the user at the center of the scene

when the app starts up.



3. Drag a CubeCube from the BasicBasic tab into the scene.

Set LocationLocation to X = 50X = 50 , Y = 0Y = 0 , and Z = 0Z = 0 . to position the cube 50 cm away from the player at start

time.

Change ScaleScale to X = 0.2X = 0.2 , Y = 0.2Y = 0.2 , and Z = 0.2Z = 0.2  to shrink the cube down.

You can't see the cube unless you add a light to your scene, which is your last task before testing the scene.

4. Switch to the L ightsL ights  tab in the ModesModes  panel and drag a Directional L ightDirectional L ight into the scene. Position the light

above PlayerStar tPlayerStar t so you can see it.

5. Go to File > Save CurrentFile > Save Current, name your level MainMain, and select SaveSave.

With the scene set, press PlayPlay  in the toolbar to see your cube in action! When you're finished admiring your

work, press EscEsc to stop the application.



 Importing assets

Now that the scene is set up, you can start adding in the chess board and piece to round out the application

environment.

The scene is looking a bit empty at the moment, but you'll fix that by importing the ready-made assets into the

project.

1. Download and unzip the GitHub assets folder using 7-zip.

2. Select Add New > New FolderAdd New > New Folder  from the Content BrowserContent Browser  and name it ChessAssetsChessAssets .

Double-click the new folder where you'll import the 3D assets.

3. Select Impor tImpor t from the Content BrowserContent Browser , select all the items in the unzipped assets folder and click

OpenOpen.

Assets include the 3D object meshes for the chess board and pieces in FBX format and texture maps in

TGA format that you'll use to for materials.

4. When the FBX Import Options window pops up, expand the Mater ialMater ial  section and change Mater ialMater ial

Impor t MethodImpor t Method to Do Not Create Mater ialDo Not Create Mater ial .

Select Impor t AllImpor t All .

https://github.com/microsoft/MixedReality-Unreal-Samples/blob/master/ChessApp/ChessAssets.7z
https://www.7-zip.org/


 Adding blueprints

NOTENOTE

That's all you need to do for the assets. Your next set of tasks is to create the building blocks of the application

with blueprints.

1. Select Add New > New FolderAdd New > New Folder  in the Content BrowserContent Browser  and name it BlueprintsBlueprints .

If you're new to blueprints, they're special assets that provide a node-based interface for creating new types of Actors and

script level events.

2. Double-click into the BlueprintsBlueprints  folder, then right-click and select Blueprint ClassBlueprint Class .

Select ActorActor  and name the blueprint BoardBoard.

The new BoardBoard blueprint now shows up in the BlueprintsBlueprints  folder as seen in the following screenshot.

https://docs.unrealengine.com/en-US/Engine/Blueprints/index.html


 Working with materials

You're all set to start adding materials to the created objects.

The objects you've created are default grey, which isn't much fun to look at. Adding materials and meshes to

your objects is the last set of tasks in this tutorial.

1. Double-click BoardBoard to open the blueprint editor.

2. Select Add Component > SceneAdd Component > Scene from the ComponentsComponents  panel and name it RootRoot. Notice that RootRoot

shows up as a child of DefaultSceneRootDefaultSceneRoot in the screenshot below:

3. Click-and-drag RootRoot onto DefaultSceneRootDefaultSceneRoot to replace it and get rid of the sphere in the viewport.

4. Select Add Component > Static MeshAdd Component > Static Mesh from the ComponentsComponents  panel and name it SM_BoardSM_Board. It will

appear as a child object under RootRoot.



4. Select SM_BoardSM_Board, scroll down to the Static MeshStatic Mesh section of the DetailsDetails  panel, and select ChessBoardChessBoard

from the dropdown.

5. Still in the DetailsDetails  panel, expand the Mater ialsMater ials  section and select Create New Asset > Mater ialCreate New Asset > Mater ial  from the

dropdown.

Name the material M_ChessBoardM_ChessBoard and save it to the ChessAssetsChessAssets  folder.



6. Double-click the M_ChessBoardM_ChessBoard material imaged to open the Material Editor.

7. In the Material Editor, right-click and search for Texture SampleTexture Sample.

Expand the Mater ial Expression Texture BaseMaterial Expression Texture Base section in the DetailsDetails  panel and set TextureTexture to

ChessBoard_AlbedoChessBoard_Albedo.

Drag the RGBRGB output pin to the Base Color pin of M_ChessBoardM_ChessBoard.



 Populating the scene

8. Repeat the previous step 4 more times to create four more Texture SampleTexture Sample nodes with the following

settings:

Set TextureTexture to ChessBoard_AOChessBoard_AO and link the RGBRGB to the Ambient OcclusionAmbient Occlusion pin.

Set TextureTexture to ChessBoard_MetalChessBoard_Metal  and link the RGBRGB to the MetallicMetallic pin.

Set TextureTexture to ChessBoard_NormalChessBoard_Normal  and link the RGBRGB to the NormalNormal  pin.

Set TextureTexture to ChessBoard_RoughChessBoard_Rough and link the RGBRGB to the RoughnessRoughness  pin.

Click SaveSave.

Make sure your material setup looks like the above screenshot before continuing.



If you go back to the BoardBoard blueprint, you'll see that the material you just created has been applied. All that's left

is setting up the scene! First, change the following properties to make sure the board is a reasonable size and

angled correctly when it's placed in the scene:

1. Set ScaleScale to (0 .05, 0 .05, 0 .05)(0 .05, 0 .05, 0 .05)  and Z RotationZ Rotation to 9090 .

Click CompileCompile in the top toolbar, then SaveSave and return to the Main window.

2. Right-click Cube > Edit > DeleteCube > Edit > Delete and drag BoardBoard from the Content BrowserContent Browser  into the viewport.

Set LocationLocation to X = 80X = 80 , Y = 0Y = 0 , and Z = -20Z = -20 .

3. Select the PlayPlay  button to view your new board in the level. Press EscEsc to return to the editor.

Now you'll follow the same steps to create a chess piece as you did with the board:

1. Go to the BlueprintsBlueprints  folder, right-click, and select Blueprint ClassBlueprint Class  and choose ActorActor . Name the actor

WhiteKingWhiteKing.

2. Double-click WhiteKingWhiteKing to open it in the Blueprint Editor, select Add Component > SceneAdd Component > Scene and name it

RootRoot.

Drag-and-drop RootRoot onto DefaultSceneRootDefaultSceneRoot to replace it.

3. Click Add Component > Static MeshAdd Component > Static Mesh and name it SM_KingSM_King.

Set Static MeshStatic Mesh to Chess_KingChess_King and Mater ialMater ial  to a new Material called M_ChessWhiteM_ChessWhite in the

Details panel.

4. Open M_ChessWhiteM_ChessWhite in the Material editor and hook up the following Texture SampleTexture Sample nodes to the

following:

Set TextureTexture to ChessWhite_AlbedoChessWhite_Albedo and link the RGBRGB to the Base ColorBase Color  pin.

Set TextureTexture to ChessWhite_AOChessWhite_AO and link the RGBRGB to the Ambient OcclusionAmbient Occlusion pin.

Set TextureTexture to ChessWhite_MetalChessWhite_Metal  and link the RGBRGB to the MetallicMetallic pin.

Set TextureTexture to ChessWhite_NormalChessWhite_Normal  and link the RGBRGB to the NormalNormal  pin.

Set TextureTexture to ChessWhite_RoughChessWhite_Rough and link the RGBRGB to the RoughnessRoughness  pin.

Click SaveSave.

Your M_ChessKingM_ChessKing material should look like the following image before continuing.



You're almost there, just need to add the new chess piece into the scene:

1. Open the WhiteKingWhiteKing blueprint and change the ScaleScale to (0 .05, 0 .05, 0 .05)(0 .05, 0 .05, 0 .05)  and Z RotationZ Rotation to 9090 .

Compile and save your blueprint, then head back to the main window.

2. Drag WhiteKingWhiteKing into the viewport, switch to the World OutlinerWorld Outliner  panel drag WhiteKingWhiteKing onto BoardBoard to

make it a child object.

3. In the DetailsDetails  panel under TransformTransform , set WhiteKingWhiteKing's LocationLocation to X = -26X = -26 , Y = 4Y = 4 , and Z = 0Z = 0 .

That's a wrap! Select PlayPlay  to see your populated level in action, and press EscEsc when you're ready to exit. You

covered a lot of ground just creating a simple project, but now you're ready to move on to the next part of the

series: setting up for mixed reality.

Next Section: 3. Set up your project for mixed reality



   

 

3. Setting up your project for mixed reality
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 Objectives

 Adding the session asset

In the previous tutorial, you spent time setting up the chess app project. This section is going to walk you

through setting up the app for mixed reality development, which means adding an AR session. You'll be using an

ARSessionConfig data asset for this task, which has useful AR settings like spatial mapping and occlusion. You

can find more details about the ARSessionConfig asset and the UARSessionConfig class in Unreal's

documentation.

Working with Unreal Engine's AR settings

Using an ARSessionConfig data asset

Setting up a Pawn and game mode

AR sessions in Unreal don't happen by themselves. To use a session, you need an ARSessionConfig data asset to

work with, which is your next task:

1. Click Add New > Miscellaneous > Data AssetAdd New > Miscellaneous > Data Asset in the Content BrowserContent Browser . Make sure you're at the root

ContentContent folder level.

Select ARSessionConfigARSessionConfig, click SelectSelect, and name the asset ARSessionConfigARSessionConfig.

3. Double-click ARSessionConfigARSessionConfig to open it, leave all default settings and hit SaveSave. Return to the Main

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/tutorials/unreal-uxt-ch3.md
https://docs.unrealengine.com/en-US/PythonAPI/class/ARSessionConfig.html
https://docs.unrealengine.com/en-US/API/Runtime/AugmentedReality/UARSessionConfig/index.html


window.

With that done, your next step is to make sure the AR session starts and stops when the level loads and ends.

Luckily, Unreal has a special blueprint called a Level BlueprintLevel Blueprint that acts as a level-wide global event graph.

Connecting the ARSessionConfig asset in the Level BlueprintLevel Blueprint guarantees the AR session will fire right when

the game starts playing.

1. Click Blueprints > Open Level BlueprintBlueprints > Open Level Blueprint from the editor toolbar :

5. Drag the execution node (left-facing arrow icon) off Event BeginPlayEvent BeginPlay  and release, then search for the Star tStar t

AR SessionAR Session node and hit enter.

Click the Select AssetSelect Asset dropdown under Session ConfigSession Config and choose the ARSessionConfigARSessionConfig asset.



 Create a Pawn

6. Right-click anywhere in the EventGraph and create a new Event EndPlayEvent EndPlay  node. Drag the execution pin and

release, then search for a Stop AR SessionStop AR Session node and hit enter. If the AR session is still running when the

level ends, certain features may stop working if you restart your app while streaming to a headset.

Hit CompileCompile, then SaveSave and return to the Main window.

At this point, the project still needs a player object. In Unreal, a PawnPawn represents the user in the game, but in this

case it's going to be the HoloLens 2 experience.

1. Click Add New > Blueprint ClassAdd New > Blueprint Class  in the ContentContent folder and expand the All ClassesAll Classes  section at the

bottom.

Search for DefaultPawnDefaultPawn, click SelectSelect, name it MRPawnMRPawn, and double-click the asset to open.



NOTENOTE

2. Click Add Component > CameraAdd Component > Camera from the ComponentsComponents  panel and name it CameraCamera. Make sure that the

CameraCamera component is a direct child of the root (CollisionComponentCollisionComponent). This allows the player camera to

move with the HoloLens 2 device.

By default, Pawns have mesh and collision components. In most Unreal projects, Pawns are solid objects that can collide

with other components. Since the Pawn and user are the same in mixed reality, you want to be able to pass through

holograms without any collisions.

3. Select CollisionComponentCollisionComponent from the ComponentsComponents  panel and scroll down to the CollisionCollision section of the

DetailsDetails  panel.

Click the Collision PresetsCollision Presets  dropdown and change the value to NoCollisionNoCollision.

Do the same for the MeshComponentMeshComponent





 Create a Game Mode

4. CompileCompile and SaveSave the Blueprint.

With your work here done, return to the Main Window.

The last puzzle piece of the mixed reality setup is the Game Mode. The Game Mode determines a number of

settings for the game or experience, including the default pawn to use.

1. Click Add New > Blueprint ClassAdd New > Blueprint Class  in the ContentContent folder and select Game Mode BaseGame Mode Base as the parent class.

Name it MRGameModeMRGameMode and double-click to open.

2. Go to the ClassesClasses  section in the DetailsDetails  panel and change the Default Pawn ClassDefault Pawn Class  to MRPawnMRPawn.

Hit CompileCompile, then SaveSave and return to the Main window.

3. Select Edit > Projects SettingsEdit > Projects Settings  and click Maps & ModesMaps & Modes  in the left-hand list.

Expand Default ModesDefault Modes  and change Default Game ModeDefault Game Mode to MRGameModeMRGameMode.

Expand Default MapsDefault Maps  and change both EditorStar tupMapEditorStar tupMap and GameDefaultMapGameDefaultMap to MainMain. When

you close and reopen the editor or play the game, the Main map will now be selected by default.



With the project fully set up for mixed reality, you're ready to move on to the next tutorial and start adding user

input to the scene.

Next Section: 4. Making your scene interactive
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 Objectives

 Downloading the Mixed Reality UX Tools plugin

In the previous tutorial, you added an ARSession, Pawn, and Game Mode to complete the mixed reality setup for

the chess app. This section focuses on using the open source Mixed Reality Toolkit UX Tools plugin, which

provides tools to make the scene interactive. By the end of this section, your chess pieces will be moving by user

input.

Installing the Mixed Reality UX Tools plugin

Adding Hand Interaction Actors to your fingertips

Creating and adding Manipulators to objects in the scene

Using input simulation to validate the project

Before you start working with user input, you'll need to add the Mixed Reality UX Tools plugin to the project. To

learn more about UX Tools, you can check out the project on GitHub.

1. Open the Epic Games Launcher. Navigate to Unreal Engine Marketplace and search for "Mixed Reality UX

Tools". Install the plugin to your engine.

2. Back in the Unreal editor, go to Project SettingsProject Settings  > PluginsPlugins  and search for "Mixed Reality UX Tools". Ensure

the plugin is enabled and restart the editor if prompted.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/tutorials/unreal-uxt-ch4.md
https://github.com/microsoft/MixedReality-UXTools-Unreal
https://aka.ms/uxt-unreal
https://www.unrealengine.com/marketplace/en-US/product/mixed-reality-ux-tools


NOTENOTE

 Spawning Hand Interaction Actors

3. The UXTools plugin has a Content folder with subfolders for components, including ButtonsButtons , XRXR

SimulationSimulation, and PointersPointers , and a C++ Classes folder with additional code.

If you don’t see the UXTools ContentUXTools Content  section in the Content BrowserContent Browser , check View Options > Show EngineView Options > Show Engine

ContentContent  and *View Options > Show Plugin Content.

Additional plugin documentation can be found on the Mixed Reality UX Tools GitHub repository.

With the plugin installed, you're ready to start using the tools it has to offer, starting with hand interaction

actors.

Hand interaction with UX elements is done with Hand Interaction Actors, which create and drive the pointers and

visuals for near and far interactions.

Near interactions - pinching elements between index finger and thumb or by poking them with a fingertip.

Far interactions - pointing a ray from the virtual hand at an element and pressing index and thumb together.

In our case, adding a Hand Interaction Actor to MRPawnMRPawn will:

https://aka.ms/uxt-unreal


Add a cursor to the tips of the Pawn’s index fingers.

Provide articulated hand input events that can be manipulated through the Pawn.

Allow far interaction input events through hand rays extending from the palms of the virtual hands.

We recommend reading through the documentation on hand interactions before continuing.

Once you're ready, open the MRPawnMRPawn Blueprint and go to the Event GraphEvent Graph.

1. Drag and release the execution pin from Event BeginPlayEvent BeginPlay  to place a new node.

Select Spawn Actor from ClassSpawn Actor from Class , click the dropdown next to the ClassClass  pin and search for Uxt HandUxt Hand

Interaction ActorInteraction Actor .

2. Spawn a second Uxt Hand Interaction ActorUxt Hand Interaction Actor , this time setting the HandHand to RightRight. When the event

begins, a Uxt Hand Interaction Actor will be spawned on each hand.

Your Event GraphEvent Graph should match the following screenshot:

Both Uxt Hand Interaction Actors need owners and initial transform locations. The initial transform doesn’t

matter in this case because UX Tools will have the Hand Interaction Actors jump to the virtual hands as soon as

they're visible. However, the SpawnActor  function requires a Transform input to avoid a compiler error, so you'll

use the default values.

1. Drag and release the pin off one of the Spawn TransformSpawn Transform pins to place a new node.

Search for the Make TransformMake Transform node, then drag the Return ValueReturn Value to the other hand’s SpawnSpawn

TransformTransform so that both SpawnActorSpawnActor  nodes are connected.

2. Select the down arrowdown arrow  at the bottom of both SpawnActorSpawnActor  nodes to reveal the OwnerOwner  pin.

Drag the pin off one of the OwnerOwner  pins and release to place a new node.

Search for selfself  and select the Get a reference to selfGet a reference to self  variable.

Create a link between the SelfSelf  object reference node and the other Hand Interaction Actor ’s OwnerOwner

pin.

3. Lastly, check the Show Near Cursor on Grab TargetsShow Near Cursor on Grab Targets  box for both Hand Interaction Actors. A cursor

should appear on the grab target as your index finger gets close, so you can see where your finger is

relative to the target.

CompileCompile, savesave, and return to the Main window.

Make sure the connections match the following screenshot, but feel free to drag around nodes to make your

Blueprint more readable.

https://microsoft.github.io/MixedReality-UXTools-Unreal/Docs/HandInteraction.html


 Attaching Manipulators

You can find more information about Hand Interaction Actors in the UX Tools documentation.

Now the virtual hands in the project have a way of selecting objects, but they still can't manipulate them. Your

last task before testing the app is to add Manipulator components to the actors in the scene.

A Manipulator is a component that responds to articulated hand input and can be grabbed, rotated, and

translated. Applying the Manipulator ’s transform to an Actors transform allows direct Actor manipulation.

1. Open the BoardBoard blueprint, click Add ComponentAdd Component and search for Uxt Generic ManipulatorUxt Generic Manipulator  in the

ComponentsComponents  panel.

2. Expand the Generic ManipulatorGeneric Manipulator  section in the DetailsDetails  panel. You can set one-handed or two-handed

manipulation, rotation mode, and smoothing from here. Feel free to select whichever modes you wish, then

CompileCompile and SaveSave Board.

https://microsoft.github.io/MixedReality-UXTools-Unreal/Docs/HandInteraction.html


 Testing the scene

NOTENOTE

3. Repeat the steps above for the WhiteKingWhiteKing Actor.

You can find more information about the Manipulator Components provided in the Mixed Reality UX Tools

plugin in the documentation.

Good news everyone! You're ready to test out the app with its new virtual hands and user input. Press PlayPlay  in

the Main Window and you'll see two mesh hands with rays extending from each hand’s palm. You can control

the hands and their interactions as follows:

Hold down the left Altleft Alt key to control the left handleft hand and the left Shiftleft Shift key to control the r ight handright hand.

Move your mouse to move the hand and scroll with your mouse wheelmouse wheel  to move the hand for wardsfor wards  or

backwardsbackwards .

Use the left mouse button to pinchpinch and the middle mouse button to pokepoke.

Input simulation may not work if you have multiple headsets plugged into your PC. If you're having issues, try

unplugging your other headsets.

Try using the simulated hands to pick up, move, and set down the white chess king and manipulate the board!

Experiment with both near and far interaction - notice that when your hands get close enough to grab the board

and king directly, a finger cursor at the tip of the index finger replaces the hand ray.

You can find more information about the simulated hands feature provided by the MRTK UX Tools plugin in the

documentation.

Now that your virtual hands can interact with objects, you're ready to move on to the next tutorial and add user

interfaces and events.

https://microsoft.github.io/MixedReality-UXTools-Unreal/Docs/Manipulator.html
https://microsoft.github.io/MixedReality-UXTools-Unreal/Docs/InputSimulation.html


Next Section: 5. Adding a button & resetting piece locations
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 Objectives

 Creating a reset function

 Adding a button

In the previous tutorial, you added Hand Interaction Actors to the Pawn and Manipulator components to the

chess board to make them both interactive. In this section, you'll continue to use the Mixed Reality Toolkit UX

Tools plugin to build out your chess app with new functions and Actor references in Blueprints. By the end of this

section, you'll be ready to package and deploy the mixed reality app on a device or emulator.

Adding an interactive button

Creating a function to reset a pieces' location

Hooking the button up to trigger the function when pressed

Your first task is to create a function blueprint that resets a chess piece to its original position in the scene.

1. Open WhiteKingWhiteKing, select the ++ icon next to the FunctionsFunctions  section in the My BlueprintMy Blueprint and name it

Reset LocationReset Location.

2. Drag and release the execution from Reset LocationReset Location on the Blueprint grid to create a

SetActorRelativeTransformSetActorRelativeTransform node.

This function sets the transform (location, rotation, and scale) of an actor relative to its parent. You’ll

use this function to reset the king’s position on the board, even if the board has been moved from its

original position.

3. Right-click inside the Event Graph, select Make TransformMake Transform , and change its LocationLocation to X = -26X = -26 , Y = 4Y = 4 ,

Z = 0Z = 0 .

Connect its Return ValueReturn Value to the New Relative TransformNew Relative Transform pin in SetActorRelativeTransformSetActorRelativeTransform .

CompileCompile and SaveSave the project before returning to the Main window.

Now that the function is set up correctly, your next task is to create a button that fires it off when touched.

1. Click Add New > Blueprint ClassAdd New > Blueprint Class , expand the All ClassesAll Classes  section, and search for

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/tutorials/unreal-uxt-ch5.md


UxtPressableButtonActorUxtPressableButtonActor .

Name it ResetButtonResetButton and double click to open the Blueprint

2. Ensure ResetButton(self )ResetButton(self )  is selected in the ComponentsComponents  panel. In the DetailsDetails  panel, navigate to the

ButtonButton section. Change the default Button LabelButton Label  to "Reset", expand the Button Icon BrushButton Icon Brush section, and

press the Open Icon Brush EditorOpen Icon Brush Editor  button.



 Firing the function

The Icon Brush Editor will open, which you can use to select a new icon for your button.

There are plenty of other settings you can adjust to configure your button. To learn more about the UXT

Pressable Button component, check out the documentation.

3. Click ButtonComponent (Inherited)ButtonComponent (Inherited)  in the ComponentsComponents  panel and scroll down the DetailsDetails  panel to the

EventsEvents  section.

Click the green ++ button next to On Button PressedOn Button Pressed to add an event to the Event Graph, which will

be called when the button is pressed.

From here, you’ll want to call WhiteKingWhiteKing’s Reset LocationReset Location function, which needs a reference to the

WhiteKingWhiteKing Actor in the Level.

4. In the My BlueprintMy Blueprint panel, navigate to the VariablesVariables  section, click the ++ button, and name the variable

WhiteKingWhiteKing.

In the DetailsDetails  panel, select the dropdown next to Variable TypeVariable Type, search for WhiteKingWhiteKing, and select

the Object ReferenceObject Reference.

Check the box next to Instance EditableInstance Editable, which allows the variable to be set from the Main Level.

5. Drag the WhiteKing variable from My Blueprint > VariablesMy Blueprint > Variables  onto the Reset Button Event Graph and

choose Get WhiteKingGet WhiteKing.

All that's left is to officially fire off the reset function when the button is pressed.

1. Drag the WhiteKing output pin and release to place a new node. Select the Reset LocationReset Location function. Finally,

https://microsoft.github.io/MixedReality-UXTools-Unreal/Docs/PressableButton.html


drag the outgoing execution pin from On Button PressedOn Button Pressed to the incoming execution pin on ResetReset

LocationLocation. CompileCompile and SaveSave the ResetButton Blueprint, then return to the Main window.

2. Drag ResetButtonResetButton into the viewport and set its location to X = 50X = 50 , Y = -25Y = -25 , and Z = 10Z = 10 . Set its rotation to

Z = 180Z = 180 . Under DefaultDefault, set the value of the WhiteKingWhiteKing variable to WhiteKingWhiteKing.

Run the app, move the chess piece to a new location, and press your HoloLens 2-style button to see the reset

logic in action!

You now have a mixed reality app with an interactable chess piece and board, and a fully functioning button that

resets the piece’s location. You can find the completed app up to this point in its GitHub repo. Feel free to go

beyond this tutorial and set up the rest of the chess pieces so that the entire board is reset when you press the

reset button.

https://github.com/microsoft/MixedReality-Unreal-Samples/tree/master/ChessApp


IMPORTANTIMPORTANT

You're ready to move on to the final section of this tutorial where you'll learn how to package and deploy the

app to a device or emulator.

At this point, you should update your project with the recommended Unreal performance settingsUnreal performance settings before deploying

your application to a device or emulator.

Next Section: 6. Packaging & deploying to device or emulator
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 Objectives

 [Device Only] Streaming

In the previous tutorial, you added a simple button that resets the chess piece to its original position. In this final

section, you'll get the app ready to run on a HoloLens 2 or an Emulator. If you have a HoloLens 2, you can either

stream from your computer or package the app to run directly on the device. If you don't have a device, you'll be

packaging the app to run on the Emulator. By the end of this section, you'll have a deployed mixed reality app

that you can play, complete with interactions and UI.

[Device only] Streaming to HoloLens 2 with holographic app remoting

Packaging and deploying the app to a HoloLens 2 device or emulator

Holographic Remoting means streaming data from a PC or standalone UWP device to the HoloLens 2, not

switching the channel. A remoting host app receives an input data stream from a HoloLens, renders content in a

virtual immersive view, and streams content frames back to HoloLens over Wi-Fi. Streaming lets you add

remote immersive views into existing desktop PC software and has access to more system resources.

If you're going this route with the chess app, you'll need a few things:

1. Install the Holographic Remoting PlayerHolographic Remoting Player  from the Microsoft Store on your HoloLens 2 and run the app.

Note your IP address displayed in the app.

Go to Edit > Project SettingsEdit > Project Settings  and sure the Windows Default RHIDefault RHI is set to DefaultDefault or D3D11D3D11 :

2. Back in the Unreal editor, go to Edit > Project SettingsEdit > Project Settings  and check Enable RemotingEnable Remoting in the Open XROpen XR

Holographic RemotingHolographic Remoting section.

3. Restart the editor, then enter your device's IP address (as displayed in the Holographic Remoting Player

app), then click ConnectConnect.

Once you’re connected, click the drop-down arrow to the right of the PlayPlay  button and select VR PreviewVR Preview . The

app will run in the VR Preview window, which is streamed to the HoloLens headset.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/tutorials/unreal-uxt-ch6.md
https://docs.microsoft.com/en-us/windows/mixed-reality/add-holographic-remoting


 Packaging and deploying the app via device portal

NOTENOTE

IMPORTANTIMPORTANT

IMPORTANTIMPORTANT

IMPORTANTIMPORTANT

If this is your first time packaging an Unreal app for HoloLens, you'll need to download supporting files from the Epic

Launcher.

Go to Editor Preferences > General > Source Code > Source Code EditorEditor Preferences > General > Source Code > Source Code Editor  and check that Visual Studio 2019

is selected.

Go to the Librar yLibrar y  tab in the Epic Games Launcher, select the dropdown arrow next to LaunchLaunch >and click OptionsOptions .

Under Target PlatformsTarget Platforms, select HoloLens 2HoloLens 2  and click ApplyApply . 

1. Go to Edit > Project SettingsEdit > Project Settings .

Add a project name under Project > Descr iption > About > Project NameProject > Descr iption > About > Project Name.

Add CN=YourCompanyNameCN=YourCompanyName under Project > Descr iption > Publisher > CompanyProject > Descr iption > Publisher > Company

Distinguished NameDistinguished Name.

Select Star t in VRStar t in VR  under Project > Descr iption > SettingsProject > Descr iption > Settings .

Leaving either of these fields blank will result in an error when you try and generate a new certificate in step 3.

The publisher's name must be in LADPv3 Distinguished Names Format. A malformed publisher's name leads to the

"Signing key not found. The app could not be digitally signed." error upon packaging.

Not selecting "Start in VR" will lead your application trying to start in a slate

https://www.ietf.org/rfc/rfc2253.txt


2. Enable Build for HoloLens EmulationBuild for HoloLens Emulation and/or Build for HoloLens DeviceBuild for HoloLens Device under Platforms >Platforms >

HoloLensHoloLens .



IMPORTANTIMPORTANT

3. Click Generate newGenerate new  in the PackagingPackaging section (next to S igning Cer tificateSigning Cer tificate).

If you're using an already generated certificate, then the certificate's publisher name must be the same as the application's

publisher name. Otherwise it leads to the "Signing key not found. The app could not be digitally signed." error.

4. Click NoneNone for testing purposes when you're prompted to create a Private Key Password.

5. Go to File > Package ProjectFile > Package Project and select HoloLensHoloLens .

Create a new folder to save your package in and click Select FolderSelect Folder .

6. Open the Windows Device Portal once the app is packaged, go to Views > AppsViews > Apps  and find the DeployDeploy

appsapps  section.

7. Click Browse...Browse..., go to your ChessApp.appxbundleChessApp.appxbundle file and click OpenOpen.

Check the box next to Allow me to select framework packagesAllow me to select framework packages  if you're installing the app on your

device for the first time.

In the next dialogue, include the appropriate VCLibsVCLibs  and appxappx files, arm64arm64  for device and x64x64  for

emulator. You can find the files under HoloLensHoloLens  inside the folder where you saved your package.

8. Click InstallInstall

https://docs.microsoft.com/en-us/windows/mixed-reality/using-the-windows-device-portal


 Next Development Checkpoint

You can now go to All AppsAll Apps  and tap the newly installed app to run it, or start the app directly from

the Windows Device Por talWindows Device Por tal .

Congratulations! Your HoloLens mixed reality application is finished and ready to go. However, you're not at the

end of the road. MRTK has lots of standalone features that you can add to your projects, including spatial

mapping, gaze and voice input, and even QR codes. More information on these features can be found in the

Unreal development overview.

If you're following the Unreal development journey we've laid out, you're in the midst of exploring the MRTK

core building blocks. From here, you can continue to the next building block:

Gaze input

Or jump to Mixed Reality platform capabilities and APIs:

HoloLens camera

You can always go back to the Unreal development checkpoints at any time.

https://docs.microsoft.com/en-us/windows/mixed-reality/unreal-development-overview
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 Enabling eye tracking

NOTENOTE

 Using eye tracking

Gaze input in mixed reality apps is all about finding out what your users are looking at. When the eye tracking

cameras on your device match up with rays in Unreal's world space, your user's line of sight data becomes

available. Gaze can be used in both blueprints and C++, and is a core feature for mechanics like object

interaction, way finding, and camera controls.

In Project Settings > HoloLensProject Settings > HoloLens , enable the Gaze InputGaze Input capability:

Create a new actor and add it to your scene

HoloLens eye tracking in Unreal only has a single gaze ray for both eyes. Stereoscopic tracking, which requires two rays,

isn't supported.

First, check that your device supports eye tracking with the IsEyeTrackerConnectedIsEyeTrackerConnected function. If the function

returns true, call GetGazeDataGetGazeData to find where the user ’s eyes are looking at in the current frame:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-gaze-input.md


NOTENOTE

 Getting head orientation

NOTENOTE

 Using C++

The fixation point and the confidence value are not available on HoloLens.

Use the gaze origin and direction in a line trace to find out exactly where your users are looking. The gaze value

is a vector, starting at the gaze origin and ending at the origin plus the gaze direction multiplied by the line trace

distance:

You can also use the rotation of the Head Mounted Display (HMD) to represent the direction of the user ’s head.

You can get the users head direction without enabling the Gaze Input capability, but you won't get you any eye

tracking information. Add a reference to the blueprint as the world context to get the correct output data:

Getting HMD Data is only available in Unreal 4.26 and onwards.

In your game’s build.csbuild.cs  file, add EyeTrackerEyeTracker  to the PublicDependencyModuleNamesPublicDependencyModuleNames list:



PublicDependencyModuleNames.AddRange(
    new string[] {
        "Core",
        "CoreUObject",
        "Engine",
        "InputCore",
        "EyeTracker"
});

#include "EyeTrackerFunctionLibrary.h"
#include "DrawDebugHelpers.h"

void AEyeTracker::Tick(float DeltaTime)
{
    Super::Tick(DeltaTime);

    if(UEyeTrackerFunctionLibrary::IsEyeTrackerConnected())
    {
        FEyeTrackerGazeData GazeData;
        if(UEyeTrackerFunctionLibrary::GetGazeData(GazeData))
        {
            FVector Start = GazeData.GazeOrigin;
            FVector End = GazeData.GazeOrigin + GazeData.GazeDirection * 100;

            FHitResult Hit Result;
            if (GWorld->LineTraceSingleByChannel(HitResult, Start, End, ECollisionChannel::ECC_Visiblity))
            {
                DrawDebugCoordinateSystem(GWorld, HitResult.Location, FQuat::Identity.Rotator(), 10);
            }
        }
    }
}

 Next Development Checkpoint

In File/ New C++ ClassFile/ New C++ Class , create a new C++ actor called EyeTrackerEyeTracker

A Visual Studio solution will open up the new EyeTracker class. Build and run to open the Unreal game

with the new EyeTracker actor. Search for “EyeTracker” in the Place ActorsPlace Actors  window and drag and drop

the class into the game window to add it to the project:

In EyeTracker.cppEyeTracker.cpp, add includes for EyeTrackerFunctionLibrar yEyeTrackerFunctionLibrar y , and DrawDebugHelpersDrawDebugHelpers :

Check that your device supports eye tracking with UEyeTrackerFunctionLibrar y::IsEyeTrackerConnectedUEyeTrackerFunctionLibrar y::IsEyeTrackerConnected

before trying to get any gaze data. If eye tracking is supported, find the start and end of a ray for a line trace

from UEyeTrackerFunctionLibrar y::GetGazeDataUEyeTrackerFunctionLibrar y::GetGazeData. From there, you can construct a gaze vector and pass its

contents to L ineTraceSingleByChannelL ineTraceSingleByChannel  to debug any ray hit results:

If you're following the Unreal development journey we've laid out, you're in the midst of exploring the MRTK

core building blocks. From here, you can continue to the next building block:

Hand tracking



 See also

Or jump to Mixed Reality platform capabilities and APIs:

HoloLens camera

You can always go back to the Unreal development checkpoints at any time.

Calibration

Comfort

Gaze and commit

Voice input

https://docs.microsoft.com/en-us/hololens/hololens-calibration
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/voice-design
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 Hand pose

The hand tracking system uses a person’s palms and fingers as input. Data on position and rotation of every

finger, the entire palm, and hand gestures is available. Starting in Unreal 4.26, hand tracking is based on the

Unreal HeadMountedDisplay plugin and uses a common API across all XR platforms and devices. Functionality

is the same for both Windows Mixed Reality and OpenXR systems.

Hand pose lets you track and use the hands and fingers of your users as input, which can be accessed in both

Blueprints and C++. The Unreal API sends the data as a coordinate system, with ticks synchronized with the

Unreal Engine.

 

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-hand-tracking.md


 

 

4.26

4.25

The hierarchy is described by EHandKeypoint  enum:



You can get all this data from a user ’s hands using the Get Motion Controller  DataGet Motion Controller  Data function. That function

returns an XRMotionControllerDataXRMotionControllerData structure. Below is a sample Blueprint script that parses the

XRMotionControllerData structure to get hand joint locations and draws a debug coordinate system at each

joint’s location.

It's important to check if the structure is valid and that it's a hand. Otherwise, you may get undefined behavior in



 Hand Live Link Animation

access to positions, rotations, and radii arrays.

Hand poses are exposed to Animation using the Live Link plugin.

If the Windows Mixed Reality and Live Link plugins are enabled:

1. Select Window > L ive L inkWindow > L ive L ink to open the Live Link editor window.

2. Select SourceSource and enable Windows Mixed Reality Hand Tracking SourceWindows Mixed Reality Hand Tracking Source

After you enable the source and open an animation asset, expand the AnimationAnimation section in the Preview ScenePreview Scene

tab too see additional options.

The hand animation hierarchy is the same as in EWMRHandKeypoint . Animation can be retargeted using

WindowsMixedRealityHandTrackingLiveLinkRemapAssetWindowsMixedRealityHandTrackingLiveLinkRemapAsset:

https://docs.unrealengine.com/Engine/Animation/LiveLinkPlugin/index.html


 

It can also be subclassed in the editor :



Hand Mesh
  Hand Mesh as a Tracked GeometryHand Mesh as a Tracked Geometry

IMPORTANTIMPORTANT

NOTENOTE

  Accessing Hand Mesh DataAccessing Hand Mesh Data

Getting hand meshes as a tracked geometry in OpenXR requires you to call Set Use Hand MeshSet Use Hand Mesh with EnabledEnabled

Tracking Geometr yTracking Geometr y .

To enable that mode you should call Set Use Hand MeshSet Use Hand Mesh with Enabled Tracking Geometr yEnabled Tracking Geometr y :

It’s not possible for both modes to be enabled at the same time. If you enable one, the other is automatically disabled.

Before you can access hand mesh data, you'll need to:

Select your ARSessionConfigARSessionConfig asset, expand the AR Settings -> World MappingAR Settings -> World Mapping settings, and check

Generate Mesh Data from Tracked Geometr yGenerate Mesh Data from Tracked Geometr y .



  C++ API ReferenceC++ API Reference

enum class EARObjectClassification : uint8
{
    // Other types
 HandMesh,
};

class FARSupportInterface
{
    public:
    // Other params
 DECLARE_AR_SI_DELEGATE_FUNCS(OnTrackableAdded)
 DECLARE_AR_SI_DELEGATE_FUNCS(OnTrackableUpdated)
 DECLARE_AR_SI_DELEGATE_FUNCS(OnTrackableRemoved)
};

void UARHandMeshComponent::OnTrackableAdded(UARTrackedGeometry* Added)

UMRMeshComponent* UARTrackedGeometry::GetUnderlyingMesh()

  Blueprint API ReferenceBlueprint API Reference

Below are the default mesh parameters:

1. Use Mesh Data for Occlusion

2. Generate Collision for Mesh Data

3. Generate Nav Mesh for Mesh Data

4. Render Mesh Data in Wireframe – debug parameter that shows generated mesh

These parameter values are used as the spatial mapping mesh and hand mesh defaults. You can change them at

any time in Blueprints or code for any mesh.

Use EEARObjectClassification  to find hand mesh values in all trackable objects.

The following delegates are called when the system detects any trackable object, including a hand mesh.

Make sure your delegate handlers follow the function signature below:

You can access mesh data through the UARTrackedGeometry::GetUnderlyingMesh :

To work with Hand Meshes in Blueprints:

1. Add an ARTrackableNotifyARTrackableNotify  Component to a Blueprint actor

2. Go to the DetailsDetails  panel and expand the EventsEvents  section.



3. Overwrite On Add/Update/Remove Tracked Geometry with the following nodes in your Event Graph:



  Hand Mesh visualization in OpenXRHand Mesh visualization in OpenXR
The recommended way to visualize hand mesh is to use Epic’s XRVisualization plugin together with the

Microsoft OpenXR plugin.

Then in the blueprint editor, you should use Set Use Hand MeshSet Use Hand Mesh function from the Microsoft OpenXR plugin

with Enabled XRVisualizationEnabled XRVisualization as a parameter :

To manage the rendering process, you should use Render Motion ControllerRender Motion Controller  from XRVisualization:

The result:

https://github.com/microsoft/Microsoft-OpenXR-Unreal
https://github.com/microsoft/Microsoft-OpenXR-Unreal


 Hand rays

IMPORTANTIMPORTANT

 

 

If you need anything more complicated, such as drawing a hand mesh with a custom shader, you need to get the

meshes as a tracked geometry.

Getting hand pose works for close interactions like grabbing objects or pressing buttons. However, sometimes

you need to work with holograms that are far away from your users. This can be accomplished with hand rays,

which can be used as pointing devices in both C++ and Blueprints. You can draw a ray from your hand to a far

point and, with some help from Unreal ray tracing, select a hologram that would otherwise be out of reach.

Since all function results change every frame, they're all made callable. For more information about pure and impure or

callable functions, see the Blueprint user guid on functions.

4.26

4.25

To get the data for the hand rays, you should use the Get Motion Controller Data function from the previous

section. The returned structure contains two parameters you can use to create a hand ray – Aim PositionAim Position and

Aim RotationAim Rotation. These parameters form a ray directed by your elbow. You should take them and find a hologram

being pointed by.

Below is an example of determining whether a hand ray hits a Widget and setting a custom hit result:

https://docs.unrealengine.com/Engine/Blueprints/UserGuide/Functions/index.html#purevs.impure


 Gestures

 

 

  Windows Mixed RealityWindows Mixed Reality

The HoloLens 2 tracks spatial gestures, which means you can capture those gestures as input. Gesture tracking

is based on a subscription model. You should use the “Configure Gestures” function to tell the device which

gestures you want to track. You can find more details about gestures are the HoloLens 2 Basic Usage document.

4.26

4.25

Then you should add code to subscribe to the following events:

https://docs.microsoft.com/en-us/hololens/hololens2-basic-usage


 



  OpenXROpenXR
In OpenXR, gesture events are tracked through the input pipeline. Using hand interaction, the device can

automatically recognize Tap and Hold gestures, but not the others. They are named as

OpenXRMsftHandInteraction Select and Grip mappings. You don’t need to enable subscription, you should

declare the events in Project Settings/Engine/Input, just like this:



 Next Development Checkpoint
If you're following the Unreal development journey we've laid out, you're in the midst of exploring the MRTK

core building blocks. From here, you can continue to the next building block:

Local Spatial Anchors

Or jump to Mixed Reality platform capabilities and APIs:

HoloLens camera

You can always go back to the Unreal development checkpoints at any time.
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 Enabling Spatial Mapping

Spatial mapping lets you place objects on physical surfaces in the real-world. When the world around the

HoloLens is mapped, holograms seem more real to the user. Spatial mapping also anchors objects in the user's

world by taking advantage of depth cues, helping convince them that these holograms are actually in their

space. Holograms floating in space or moving with the user won't feel as real, so you always want to place items

for comfort whenever possible.

You can find more information on spatial mapping quality, placement, occlusion, rendering, and more, in the

Spatial mapping document.

To enable spatial mapping on HoloLens:

Open Edit > Project SettingsEdit > Project Settings  and scroll down to the PlatformsPlatforms section.

Select HoloLensHoloLens  and check Spatial PerceptionSpatial Perception.

To opt into spatial mapping and debug the MRMeshMRMesh in a HoloLens game:

1. Open the ARSessionConfigARSessionConfig and expand the ARSettings > World MappingARSettings > World Mapping section.

2. Check Generate Mesh Data from Tracked Geometr yGenerate Mesh Data from Tracked Geometr y , which tells the HoloLens plugin to start

asynchronously getting spatial mapping data and surface it to Unreal through the MRMeshMRMesh.

3. Check Render Mesh Data in WireframeRender Mesh Data in Wireframe to show a white wireframe outline of every triangle in the

MRMeshMRMesh.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-spatial-mapping.md


 

Spatial Mapping at runtime

 Working with MRMesh

You can modify the following parameters to update the spatial mapping runtime behavior :

Open Edit > Project SettingsEdit > Project Settings , scroll down to the PlatformsPlatforms section, and select HoloLens > SpatialHoloLens > Spatial

MappingMapping:

Max Tr iangles Per Cubic MeterMax Tr iangles Per Cubic Meter  updates the density of the triangles in the spatial mapping mesh.

Spatial Meshing Volume SizeSpatial Meshing Volume Size is the size of the cube around the player to render and update spatial

mapping data.

If the expected application runtime environment is expected to be large, this value may need to be

large to match the real-world space. The value can be smaller if the application only needs to place

holograms on surfaces immediately around the user. As the user walks around the world, the spatial

mapping volume will move with them.

First, you need to start Spatial Mapping:

Once spatial mapping has been captured for the space, we recommend toggling off spatial mapping. The spatial

mapping may be completed either after a certain amount of time, or when raycasts in each direction return

collisions against the MRMesh.

To get access to the MRMeshMRMesh at runtime:

1. Add an ARTrackableNotifyARTrackableNotify  Component to a Blueprint actor.

2. Select the ARTrackableNotifyARTrackableNotify  component and expand the EventsEvents  section in the DetailsDetails  panel.

Select the ++ button on the events you want to monitor.



 Spatial Mapping in C++

PublicDependencyModuleNames.AddRange(
    new string[] {
        "Core",
        "CoreUObject",
        "Engine",
        "InputCore",    
        "EyeTracker",
        "AugmentedReality",
        "MRMesh"
});

In this case, the On Add Tracked Geometr yOn Add Tracked Geometr y  event is being monitored, which looks for valid world meshes

matching to spatial mapping data. You can find the full list of events in the UARTrackableNotify component API.

You can change the mesh’s material in the Blueprint Event Graph or in C++. The screenshot below shows the

Blueprint route:

In your game's build.cs file, add AugmentedRealityAugmentedReality  and MRMeshMRMesh to the PublicDependencyModuleNames list:

To access the MRMesh, subscribe to the OnTrackableAddedOnTrackableAdded delegates:

https://docs.unrealengine.com/API/Runtime/AugmentedReality/UARTrackableNotifyComponent/index.html


#include "ARBlueprintLibrary.h"
#include "MRMeshComponent.h"

void AARTrackableMonitor::BeginPlay()
{
    Super::BeginPlay();

    // Subscribe to Tracked Geometry delegates
    UARBlueprintLibrary::AddOnTrackableAddedDelegate_Handle(
        FOnTrackableAddedDelegate::CreateUObject(this, &AARTrackableMonitor::OnTrackableAdded)
    );
}

void AARTrackableMonitor::OnTrackableAdded(UARTrackedGeometry* Added)
{
    // When tracked geometry is received, check that it's from spatial mapping
    if(Added->GetObjectClassification() == EARObjectClassification::World)
    {
        UMRMeshComponent* MRMesh = Added->GetUnderlyingMesh();
    }
}

NOTENOTE

 See also

There are similar delegates for updated and removed events, AddOnTrackableUpdatedDelegate_HandleAddOnTrackableUpdatedDelegate_Handle and

AddOnTrackableRemovedDelegate_HandleAddOnTrackableRemovedDelegate_Handle respectively.

You can find the full list of events in the UARTrackedGeometry API.

Spatial mapping

https://docs.unrealengine.com/API/Runtime/AugmentedReality/UARTrackedGeometry/index.html
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NOTENOTE

 Prerequisites

IMPORTANTIMPORTANT

 Setup

Scene understanding provides the MRMesh with planes that are classified with their interpreted usage, like

walls, floors, ceilings, and tables. Use cases are similar to spatial mapping, but the meshes have this additional

metadata and will be surfaced as planes rather than a rough mesh.

You can find more information in the Scene Understanding document.

Starting with Holographic Remoting version 2.8.0 Scene Understanding is fully supported.

Scene Understanding requires OpenXR and Unreal 4.27.1 or newer.

The Microsoft OpenXR plugin must be used from the Unreal Marketplace or GitHub.

Alternatively, start with the OpenXR sample application which demonstrates how to use Scene Understanding.

To enable scene understanding on HoloLens:

1. Open Edit > Project SettingsEdit > Project Settings  and scroll down to the PlatformsPlatforms section.

2. Select HoloLensHoloLens  and then select Spatial PerceptionSpatial Perception.

To opt into scene understanding and use the MRMeshMRMesh in a HoloLens game:

1. Open the ARSessionConfigARSessionConfig and expand the ARSettings > World MappingARSettings > World Mapping section.

2. Check Generate Mesh Data from Tracked Geometr yGenerate Mesh Data from Tracked Geometr y , which tells the HoloLens plugin to start

asynchronously getting scene understanding data and surface it to Unreal through the MRMeshMRMesh.

3. Optionally check Render Mesh Data in WireframeRender Mesh Data in Wireframe to show a white wireframe outline of every triangle in

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-scene-understanding.md
https://www.unrealengine.com/marketplace/en-US/product/ef8930ca860148c498b46887da196239
https://github.com/microsoft/Microsoft-OpenXR-Unreal/releases
https://github.com/microsoft/Microsoft-OpenXR-Unreal


 Optional ini Settings

[/Script/HoloLensSettings.SceneUnderstanding]
SceneUnderstandingVolumeHeight=4
ShouldDoSceneUnderstandingMeshDetection=true

the MRMeshMRMesh.

4. In the second ARSettingsARSettings  dropdown, find the Horizontal Plane DetectionHorizontal Plane Detection and Ver tical PlaneVer tical Plane

DetectionDetection checkboxes. These can be selectively disabled if your experience only requires horizontal or

vertical planes. By default, both horizontal and vertical planes will be used.

You can modify the following parameters to update the spatial mapping runtime behavior :

Open Edit > Project SettingsEdit > Project Settings , then scroll down to the PlatformsPlatforms section, and then select HoloLens >HoloLens >

Spatial MappingSpatial Mapping:

Spatial Meshing Volume SizeSpatial Meshing Volume Size is the diameter of a sphere around the player to render and update scene

understanding data.

If the application runtime environment is expected to be large, this value may need to be large to match the

real-world space. The value can be smaller if the application only needs to place holograms on surfaces

immediately around the user. As the user walks around the world, the spatial mapping volume will move

with them.

When using scene understanding, large scanning volumes can hurt performance since many more meshes are

being generated than spatial mapping. To keep draw calls lower, an additional ini setting can be used to restrict

the volume height:

In the game's Config/DefaultGame.ini file, add a section [/Script/HoloLensSettings.SceneUnderstanding] with

optional settings:

SceneUnderstandingVolumeHeightSceneUnderstandingVolumeHeight will restrict the scene understanding scan volume to a

https://github.com/microsoft/Microsoft-OpenXR-Unreal/blob/076a5defe01e08360f382b2498d17708c00b85bf/MsftOpenXRGame/Config/DefaultGame.ini#L13


 Working with the MRMesh

rectangular prism with this height and sides of length Spatial Meshing Volume SizeSpatial Meshing Volume Size.

ShouldDoSceneUnderstandingMeshDetectionShouldDoSceneUnderstandingMeshDetection will add meshes to each of the identified planes.

Meshes will overlap some surfaces, such as tables, more accurately than planes, but will incur additional

draw and compute calls. By default, only planes will be detected.

First you need to start the ARSession:

Then you need to start scene understanding:

In this example, we check the CanDetectPlanesCanDetectPlanes  function to check if we should toggle scene understanding or

spatial mapping. This will allow the code to work in both remoting and on a HoloLens device. Otherwise,

toggling scene understanding when remoting will not return any planes.

To get access to the MRMeshMRMesh at runtime:

1. Add an ARTrackableNotifyARTrackableNotify  component to a Blueprint actor.

1. Select the ARTrackableNotifyARTrackableNotify  component and expand the EventsEvents  section in the DetailsDetails  panel.

2. Select the ++ button on the events you want to monitor.



 See Also

You can find the full list of events in the UARTrackableNotify component API.

In this example, as MRMeshes are identified, their object classification is queried and a different material is set

based on what type of surface it is.

To perform collision tests against scene understanding meshes, LineTraceTrackedObjects3D can be used:

Disable Test Plane ExtentsTest Plane Extents  to perform hit tests against only scene understanding meshes, otherwise both

meshes and planes will be used. Planes don't always cover real-world geometry, so they could cause a false

collision if used. For example, open doorways will be covered by the plane from the wall around it.

The tracked geometry and object classification can be queried from the trace result, so you can perform

different functions based on whether you hit a wall or a table, for example.

In this example, a debug coordinate system is drawn at the collision point on the closest scene understanding

mesh that was hit.

Scene Understanding

Spatial Mapping in Unreal

https://docs.unrealengine.com/4.27/API/Runtime/AugmentedReality/UARTrackableNotifyComponent/index.html
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 Installing the Microsoft Spatial Sound plugin

NOTENOTE

 Setting the spatialization plugin for HoloLens 2 platform

Unlike vision, humans hear in 360-degree surround sound. Spatial sound emulates how human hearing works,

providing the cues needed to identify sound locations in world-space. When you add spatial soundin your mixed

reality applications, you're enhancing the level of immersion your user's experience.

High-quality spatial sound processing is complex, so the HoloLens 2 comes with dedicated hardware for

processing those sound objects. Before you can access this hardware processing support, you'll need to install

the MicrosoftSpatialSoundMicrosoftSpatialSound plugin in your Unreal project. This article will walk you through the installation

and configuration of the plugin and point you towards more in-depth resources.

The first step to adding spatial sound to your project is installing the Microsoft Spatial Sound plugin, which you

can find by:

1. Clicking Edit > PluginsEdit > Plugins  and searching for MicrosoftSpatialSoundMicrosoftSpatialSound in the search box.

2. Selecting the EnabledEnabled checkbox in the MicrosoftSpatialSoundMicrosoftSpatialSound plugin.

3. Restarting the Unreal Editor by selecting Restar t NowRestar t Now  from the plugins page.

If you haven't already, you'll need to install the Microsoft Windows Mixed RealityMicrosoft Windows Mixed Reality  and HoloLensHoloLens plugins by following

the instructions in the Initializing your projectInitializing your project  section of our Unreal tutorial series.

Once the editor restarts, your project is all set!

Configuring the spatialization plugin is done on a per-platform basis. You can enable the Microsoft Spatial

Sound plugin for the HoloLens 2 by:

1. Selecting Edit > Project SettingsEdit > Project Settings , scrolling to **Platforms, and clicking HoloLensHoloLens .

2. Expanding the AudioAudio properties and setting the Spatialization PluginSpatialization Plugin field to Microsoft Spatial SoundMicrosoft Spatial Sound.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-spatial-audio.md


 Enabling spatial audio on your workstation

If you're going to be previewing your application in the Unreal editor on a desktop PC, you'll need to repeat the

above steps for the WindowsWindows platform:

Spatial audio is disabled by default on desktop versions of Windows. You can enable it by:

Right-clicking on the volumevolume icon in the task bar.

Choose Spatial sound -> Windows Sonic for HeadphonesSpatial sound -> Windows Sonic for Headphones  to get the best representation of what

you'll hear on HoloLens 2.



NOTENOTE

 Creating Attenuation objects

This setting is only required if you plan to test your project in the Unreal editor.

After you've installed and configured the necessary plugins:

1. Search for an Ambient SoundAmbient Sound actor in the Place ActorsPlace Actors  window and drag it into the SceneScene window.

2. Make the Ambient SoundAmbient Sound actor a child of a visual element in your scene.

An Ambient Sound actor doesn't have any visual representation by default, so you'll only hear a sound

from its position in the scene. Attaching it to a visual element let's you see and move the actor like any

other asset.

3. Right-click on the Content BrowserContent Browser  and selecting Create Advanced Asset -> Sounds -> SoundCreate Advanced Asset -> Sounds -> Sound

AttenuationAttenuation:



4. Right-click on the Sound AttenuationSound Attenuation asset in the Content BrowserContent Browser  window and select the EditEdit option to

bring up the properties window.

Switch the Spatialization MethodSpatialization Method to BinauralBinaural .

5. Select the Ambient SoundAmbient Sound actor and scroll down to the AttenuationAttenuation section in the DetailsDetails  panel.

Set the Attenuation SettingsAttenuation Settings  property to the Sound AttenuationSound Attenuation asset you created.



6. Set the Sound AssetSound Asset you want to attach to the Ambient Sound actor :

Update the SoundSound property of the Ambient Sound actor to specify the SoundAsset file to use.



NOTENOTE
The SoundAsset file needs to be mono to be spatialized with the Microsoft Spatial Sound plug-in. You can find the sound

file properties by hovering over the asset in the Content Browser window as shown in the screenshot below.



 Configuring objects for spatialization

 Next Development Checkpoint

 See also

When the sound asset is configured, the ambient sound can be spatialized using the dedicated hardware offload

support on HoloLens 2.

Working with spatial audio means you're in charge of managing how sound behaves in a virtual environment.

Your main focus is creating sound objects that appear louder when the user is close, and quieter when the user

is far away. This is referred to as sound attenuation, making sounds appear as if they're positioned in a fixed

spot.

All attenuation objects come with modifiable settings for :

Distance

Spatialization

Air Absorption

Listener Focus

Reverb Send

Occlusion

Sound attenuation in Unreal has details and implementation specifics on each of these topics.

If you're following the Unreal development journey we've laid out, you're in the midst of exploring the MRTK

core building blocks. From here, you can continue to the next building block:

Voice input

Or jump to Mixed Reality platform capabilities and APIs:

HoloLens camera

You can always go back to the Unreal development checkpoints at any time.

https://docs.unrealengine.com/Engine/Audio/DistanceModelAttenuation/index.html


Spatial Sound

Spatial Sound Design

MR Spatial 220: Spatial sound

https://docs.microsoft.com/en-us/windows/mixed-reality/spatial-sound
https://docs.microsoft.com/en-us/windows/mixed-reality/spatial-sound-design
https://docs.microsoft.com/en-us/windows/mixed-reality/holograms-220
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NOTENOTE

IMPORTANTIMPORTANT

 Checking the anchor store

 

 

 Saving anchors

 

 

Spatial anchors save holograms in real-world space between application sessions as ARPinARPins. Once saved in the

HoloLens' anchor store, ARPin's can be loaded in future sessions and are an ideal fallback option when there's

no internet connectivity.

Anchor functions from UE 4.25 are obsolete in 4.26 and should be replaced with newer ones.

Local anchors are stored on device, while Azure Spatial Anchors are stored in the cloud. If you're looking to use Azure

cloud services to store your anchors, we have a document that can walk you through integrating Azure Spatial Anchors.

Note that you can have local and Azure anchors in the same project without conflict.

Before saving or loading anchors, you need to check if the anchor store is ready. Calling any of the HoloLens

anchor functions before the anchor store is ready won't succeed.

4.26

4.25

Once the application has a component you need to pin to the world, it can be saved to the anchor store with the

following sequence:

4.26

4.25

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-spatial-anchors.md


 Loading anchors

 

 

 Removing anchors

Breaking this down:

1. Spawn an actor at a known location.

2. Create an ARPinARPin with that location and a name based on the actor ’s class.

3. Add the actor to the ARPinARPin and save the pin to the HoloLens anchor store.

The anchor name you choose must be unique, which in this example is the current timestamp.

4. If the anchor is successfully saved to the anchor store, you can see it in the HoloLens device portal under

System > Map manager > Anchor Files Saved On DeviceSystem > Map manager > Anchor Files Saved On Device.

When an application starts, you can use the following blueprint to restore components to their anchor locations:

4.26

4.25

Breaking this down:

1. Iterate over all of the anchors in the anchor store.

2. Spawn an actor at identity.

3. Pin that actor to the ARPinARPin from the anchor store.

It's important to spawn the actor at identity since the anchor is responsible for repositioning the

hologram in the world based on where it was saved. Any transform added here will add an offset to

the anchor.

The anchor ID is also queried so that different actors can be spawned depending on the anchor’s saved name.



 

 

NOTENOTE

 Next Development Checkpoint

 See also

When you're done with an anchor, you can clear individual anchors or the entire anchor store with the RemoveRemove

ARPin from WMRAnchor StoreARPin from WMRAnchor Store and Remove All ARPins from WMRAnchor StoreRemove All ARPins from WMRAnchor Store components.

4.26

4.25

Bear in mind that Spatial Anchors are still in Beta, so be sure to check back for updated information and features.

If you're following the Unreal development journey we've laid out, you're in the midst of exploring the MRTK

core building blocks. From here, you can continue to the next building block:

Azure Spatial Anchors

Or jump to Mixed Reality platform capabilities and APIs:

HoloLens camera

You can always go back to the Unreal development checkpoints at any time.

Azure Spatial Anchors

Spatial anchors

Coordinate systems
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NOTENOTE

IMPORTANTIMPORTANT

 Prerequisites

 Getting Azure Spatial Anchors account info

NOTENOTE

 Enable Capabilities and Permissions
  HoloLensHoloLens

Azure Spatial Anchors is a Microsoft Mixed Reality service, allowing augmented reality devices to discover, share,

and persist anchor points in the physical world. Documentation below provides instructions for integrating the

Azure Spatial Anchors service into an Unreal project. If you're looking for more information, check out the Azure

Spatial Anchors service.

Unreal Engine 4.26 now has plugins for ARKit and ARCore support if you're targeting iOS or Android.

Local anchors are stored on device, while Azure Spatial Anchors are stored in the cloud. If you're looking to store your

anchors locally on a device, we have a Local Spatial Anchors document that can walk you through the process. Note that

you can have local and Azure anchors in the same project without conflict.

To complete this guide, make sure you have:

Installed Unreal version 4.25 or later

A HoloLens 2 project setup in Unreal

Read through the Azure Spatial Anchors overview

Basic knowledge on C++ and Unreal

Before using Azure Spatial Anchors in your project, you need to:

Create a spatial anchors resource and copy the account fields listed below. These values are used to

authenticate users with your application's account:

Account IDAccount ID

Account KeyAccount Key

Check out the Azure Spatial Anchors authentication docs for more information.

Azure Spatial Anchors in Unreal 4.25 does not support Azure AD authentication tokens, but support for this functionality

will be coming in a later release.

Open Project Settings > HoloLensProject Settings > HoloLens  and enable the Internet ClientInternet Client capability:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-azure-spatial-anchors.md
https://azure.microsoft.com/services/spatial-anchors/
https://www.unrealengine.com/get-now
https://docs.microsoft.com/en-us/azure/spatial-anchors/overview
https://docs.microsoft.com/en-us/azure/spatial-anchors/quickstarts/get-started-hololens#create-a-spatial-anchors-resource
https://docs.microsoft.com/en-us/azure/spatial-anchors/concepts/authentication?tabs=csharp


  AndroidAndroid
For an Android app to display a permission dialogue and allow location capabilities, the Request AndroidRequest Android

PermissionsPermissions  function must be called before attempting to start the Azure Spatial Anchor session:

Create a local variable for the input permissions, and populate with:

android.permission.ACCESS_WIFI_STATE

android.permission.CHANGE_WIFI_STATE

android.permission.INTERNET

android.permission.BLUETOOTH

android.permission.BLUETOOTH_ADMIN

android.permission.ACCESS_COARSE_LOCATION

android.permission.ACCESS_FINE_LOCATION

android.permission.CAMERA

Finally, open Project Settings > AndroidProject Settings > Android and set the same permissions in the Extra PermissionsExtra Permissions  field under

Advanced APK PackagingAdvanced APK Packaging:



  iOSiOS

 Adding Azure Spatial Anchors plugins
  HoloLensHoloLens

To build an application for iOS, you will need to use Unreal on a Mac. To package with an Apple developer

account, open Project Settings > iOSProject Settings > iOS  and scroll down to the BuildBuild section. Enable the Automatic S igningAutomatic S igning

checkbox and populate the IOS Team IDIOS Team ID with your Team ID.

You can find your Team ID by logging into developer.apple.comdeveloper.apple.com, navigating to the MembershipMembership tab and

searching for Team IDTeam ID.

To display a permission dialogue and allow the iOS device to access location information, the Init LocationInit Location

Ser vicesSer vices  and Star t Location Ser vicesStar t Location Ser vices  functions must be called before attempting to start the Azure Spatial

Anchor session:

Enable the Azure Spatial Anchors plugins in the Unreal editor by:

1. Clicking Edit > PluginsEdit > Plugins  and searching for Azure Spatial AnchorsAzure Spatial Anchors  and Azure Spatial Anchors ForAzure Spatial Anchors For

WMRWMR.

2. Select the EnabledEnabled checkbox in both plugins to allow access to the Azure Spatial Anchors blueprint libraries

in your application.



  AndroidAndroid

  iOSiOS

Once that's done, restart the Unreal Editor for the plugin changes to take effect. The project is now ready to use

Azure Spatial Anchors.

Enable the Azure Spatial Anchors plugins in the Unreal editor by:

1. Clicking Edit > PluginsEdit > Plugins  and searching for Azure Spatial AnchorsAzure Spatial Anchors  and Azure Spatial Anchors ForAzure Spatial Anchors For

ARCoreARCore.

2. Select the EnabledEnabled checkbox in both plugins to allow access to the Azure Spatial Anchors blueprint libraries

in your application.

Once that's done, restart the Unreal Editor for the plugin changes to take effect. The project is now ready to use

Azure Spatial Anchors.

Enable the Azure Spatial Anchors plugins in the Unreal editor by:

1. Clicking Edit > PluginsEdit > Plugins  and searching for Azure Spatial AnchorsAzure Spatial Anchors  and Azure Spatial Anchors ForAzure Spatial Anchors For

ARKitARKit.

2. Select the EnabledEnabled checkbox in both plugins to allow access to the Azure Spatial Anchors blueprint libraries

in your application.



 Starting a Spatial Anchors session

3. Also search for Mobile Location Ser vicesMobile Location Ser vices  and Mobile Location Ser vices - IOS ImplementationMobile Location Ser vices - IOS Implementation

4. Select the EnabledEnabled checkbox in both plugins to allow the iOS device to access current location.

Once that's done, restart the Unreal Editor for the plugin changes to take effect. The project is now ready to use

Azure Spatial Anchors.

An Azure Spatial Anchors session allows client applications to communicate with the Azure Spatial Anchors

service. You'll need to create and start an Azure Spatial Anchors session to create, persist, and share Azure

Spatial Anchors:

1. Open the blueprint for the Pawn you're using in the application.

2. Add two string variables for the Account IDAccount ID and Account KeyAccount Key , then assign the corresponding values from

your Azure Spatial Anchors account to authenticate the session.



Start an Azure Spatial Anchors session by:

1. Checking that an AR SessionAR Session is running in the HoloLens application, as the Azure Spatial Anchors session

can't start until an AR Session is running. If you don't have one setup, create an AR Session asset.

2. Adding the Star t Azure Spatial Anchors SessionStar t Azure Spatial Anchors Session custom event and configure it as shown in the

screenshot below.

Creating a session doesn't start the session by default, which allows you to configure the session for

authentication with the Azure Spatial Anchors service.

https://docs.microsoft.com/en-us/windows/mixed-reality/unreal-uxt-ch3#adding-the-session-asset


3. Configure the Azure Spatial Anchors session to provide the Account IDAccount ID, Account KeyAccount Key , Account DomainAccount Domain,

and Course Localization SettingsCourse Localization Settings . All of the checkboxes should be enabled in the course localization

settings so the azure spatial anchor service can use sensor data to locate anchors.

4. Start the Azure Spatial Anchors session, allowing the application to create and locate Azure Spatial Anchors.

It's good practice to clean up Azure Spatial Anchors resources in your Event Graph blueprint when you're no

longer using the service:

1. Stop the Azure Spatial Anchors session. The session will no longer be running, but its associated resources

will still exist in the Azure Spatial Anchors plugin.



 Creating an anchor

2. Destroy the Azure Spatial Anchors session to clean up any Azure Spatial Anchors session resources still

known to the Azure Spatial Anchors plugin.

Your Event Graph blueprint should look like the screenshot below:

An Azure Spatial Anchor represents a physical world pose in the augmented reality application space, which

locks augmented reality content to physical locations. Azure Spatial Anchors can also be shared among different

users. This sharing allows augmented reality content drawn on different devices to be positioned in the same

location in the physical world.

To create a new Azure Spatial Anchor:

1. Check that an Azure Spatial Anchors session is running. The application can't create or persist an Azure

Spatial Anchor when no Azure Spatial Anchors session is running.



2. Create or obtain an Unreal Scene ComponentScene Component that should have its location persisted.

In the below image, the Scene Component Needing AnchorScene Component Needing Anchor  component is used as a variable. An

Unreal Scene Component is needed to establish an application world transform for an AR Pin and

Azure Spatial Anchor.

To construct and save an Azure Spatial Anchor for an Unreal Scene Component:

1. Call the Pin Component for the Unreal Scene Component and specify the Scene Component's WorldWorld

TransformTransform as the World Transform used for the AR Pin.

Unreal tracks AR points in the application space using AR Pins, which are used to create an Azure

Spatial Anchor. In Unreal, an AR Pin is analogous to a SpatialAnchor on HoloLens.

https://docs.unrealengine.com/API/Runtime/Engine/Components/USceneComponent/index.html
https://docs.unrealengine.com/BlueprintAPI/HoloLensAR/ARPin/index.html
https://docs.unrealengine.com/BlueprintAPI/ARAugmentedReality/Pin/PinComponent/index.html


 

2. Call Create Cloud AnchorCreate Cloud Anchor  using the newly created AR Pin.

Create Cloud Anchor creates an Azure Spatial Anchor locally but not in the Azure Spatial Anchor

service. Parameters for the Azure Spatial Anchor, such as an expiration date, can be set before creating

the Azure Spatial Anchor with the service.

3. Set the Azure Spatial Anchor expiration. This function's Lifetime parameter allows the developer to specify in

seconds how long the anchor should be maintained by the service.

For example, a week long expiration would take a value of 60 seconds x 60 minutes x 24 hours x seven

days = 604,800 seconds.

After setting anchor parameters, declare the anchor as ready to save. In the example below, the newly created

Azure Spatial Anchor is added to a set of Azure Spatial Anchors needing saving. This set is declared as a variable

for the Pawn blueprint.



Saving an Anchor

NOTENOTE

 Deleting an Anchor

After configuring the Azure Spatial Anchor with your parameters, call Save Cloud AnchorSave Cloud Anchor . Save Cloud Anchor

declares the anchor to the Azure Spatial Anchors service. When the call to Save Cloud Anchor succeeds, the

Azure Spatial Anchor is available to other users of the Azure Spatial Anchor service.

Save Cloud Anchor is an asynchronous function and can only be called on a game thread event such as EventTickEventTick . Save

Cloud Anchor may not appear as an available blueprint function in custom blueprint Functions. However, it should be

available in the Pawn Event Graph blueprint editor.

In the example below, the Azure Spatial Anchor is stored in a set during an input event callback. The anchor is

then saved on the EventTick. Saving an Azure Spatial Anchor may take multiple attempts depending on the

amount of spatial data that your Azure Spatial Anchors session has created. That's why it's a good idea to check

whether the save call succeeded.

If the anchor doesn't save, readd it to the set of anchors still needing to be saved. Future EventTicks will keep

trying to save the anchor until it's successfully stored.

Once the anchor saves, the AR Pins' transform acts as a reference transform for placing content in your app.

Other users can detect this anchor and align AR content for different devices in the physical world.

You can delete anchors from the Azure Spatial Anchor service by calling Delete Cloud AnchorDelete Cloud Anchor .



NOTENOTE

 Locating pre-existing anchors

Delete Cloud Anchor is a latent function and can only be called on a game thread event, such as EventTick. Delete Cloud

Anchor may not appear as an available blueprint function in custom blueprint Functions. It should however be available in

the Pawn Event Graph blueprint editor.

In the example below, the anchor is flagged for deletion on a custom input event. The deletion is then attempted

on the EventTick. If the anchor deletion fails, add the Azure Spatial Anchor to the set of anchors flagged for

deletion and tries again on later EventTicks.

Your Event Graph blueprint should now look like the screenshot below:

Existing anchors can be created by peers with the Azure Spatial Anchors service:

1. Obtain an Azure Spatial Anchor identifier for the anchor that you would like to detect.

An anchor identifier can be obtained for an anchor created by the same device in a previous Azure

Spatial Anchors session. It can also be created and shared by peer devices interacting with the Azure

Spatial Anchors service.

2. Add an AzureSpatialAnchorsEventAzureSpatialAnchorsEvent component to your Pawn blueprint.

This component allows you to subscribe to various Azure Spatial Anchors events, such as events called

when Azure Spatial Anchors are located.



3. Subscribe to the ASAAnchor Located DelegateASAAnchor Located Delegate for the AzureSpatialAnchorsEventAzureSpatialAnchorsEvent component.

The delegate lets the application know when new anchors associated with the Azure Spatial Anchors

account have been located.

With the event callback, Azure Spatial Anchors created by peers using the Azure Spatial Anchors

session won't have AR Pins created by default. To create an AR Pin for the detected Azure Spatial

Anchor, developers can call Create ARPin Around Azure Cloud Spatial AnchorCreate ARPin Around Azure Cloud Spatial Anchor .



To locate Azure Spatial Anchors created by peers using the Azure Spatial Anchor service, the application will

have to create an Azure Spatial Anchors WatcherAzure Spatial Anchors Watcher :

1. Check that an Azure Spatial Anchors session is running.

2. Create an AzureSpatialAnchorsLocateCriter iaAzureSpatialAnchorsLocateCriter ia .

3. Declare the Azure Spatial Anchor identifier you're looking for in the AzureSpatialAnchorsLocateCritier iaAzureSpatialAnchorsLocateCritier ia .

4. Call Create WatcherCreate Watcher .

You can specify various location parameters like distance from the user or distance from another

anchor.

The application now begins looking for Azure Spatial Anchors known to the Azure Spatial Anchors service,

meaning that users can locate Azure Spatial Anchors created by their peers.

After locating the Azure Spatial Anchor, call Stop WatcherStop Watcher  to stop the Azure Spatial Anchors Watcher and clean

up watcher resources.



 Next Development Checkpoint

 Next steps

Your final Event Graph blueprint should now look like the screenshot below:

If you're following the Unreal development journey we've laid out, you're in the midst of exploring the MRTK

core building blocks. From here, you can continue to the next building block:

Spatial mapping

Or jump to Mixed Reality platform capabilities and APIs:

HoloLens camera

You can always go back to the Unreal development checkpoints at any time.

Local Spatial Anchors

Spatial Anchors documentation

Spatial Anchor features

Effective anchor experience guidelines

https://docs.microsoft.com/en-us/azure/spatial-anchors/
https://azure.microsoft.com/services/spatial-anchors/#features
https://docs.microsoft.com/en-us/azure/spatial-anchors/concepts/guidelines-effective-anchor-experiences
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 Enabling Speech Recognition

NOTENOTE

Voice input in Unreal allows you to interact with a hologram without having to use hand gestures and is only

supported HoloLens 2. Voice input on HoloLens 2 is powered by the same engine that supports speech in all

other Universal Windows Apps, but Unreal uses a more limited engine to process voice input. This limits voice

input features in Unreal to predefined speech mappings, which are covered in the following sections.

If you use Windows Mixed Reality Plugin, Voice input doesn’t require any special Windows Mixed Reality APIs;

it's built on the existing Unreal Engine 4 Input mapping API. If you use OpenXR, you should additionally install

Microsoft OpenXR plugin.

To enable speech recognition on HoloLens:

1. Select Project Settings > Platform > HoloLens > CapabilitiesProject Settings > Platform > HoloLens > Capabilities  and enable MicrophoneMicrophone.

2. Enabled speech recognition in Settings > Pr ivacy > SpeechSettings > Pr ivacy > Speech and select EnglishEnglish .

Speech recognition always functions in the Windows display language configured in the SettingsSettings app. It’s recommended

that you also enable Online speech recognitionOnline speech recognition for the best service quality.

3. A dialog will show up when the application first starts to ask if you want to enable the microphone. Selecting

YesYes  starts voice input in the app.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-voice-input.md
https://docs.unrealengine.com/Gameplay/Input/index.html
https://github.com/microsoft/Microsoft-OpenXR-Unreal


 

Adding Speech Mappings

NOTENOTE

Connecting speech to action is an important step when using voice input. These mappings monitor the app for

speech keywords that a user might say, then fire off a linked action. You can find Speech Mappings by:

1. Selecting Edit > Project SettingsEdit > Project Settings , scrolling to the EngineEngine section, and clicking InputInput.

To add a new Speech Mapping for a jump command:

1. Select the ++ icon next to Array elementsArray elements  and fill out the following values:

jumpWordjumpWord for Action NameAction Name

jumpjump for Speech KeywordSpeech Keyword

Any English word(s) or short sentence(s) can be used as a keyword.

Speech Mappings can be used as Input components like Action or Axis Mappings or as blueprint nodes in the

Event Graph. For example, you could link the jump command to print out two different logs depending on when

the word is spoken:

1. Double-click a blueprint to open it in the Event GraphEvent Graph.

2. R ight-clickRight-click  and search for the Action NameAction Name of your speech mapping (in this case jumpWordjumpWord), then hit

EnterEnter  to add an Input ActionInput Action node to the graph.

3. Drag and drop the PressedPressed pin to Pr int Str ingPrint Str ing node as shown in the image below. You can leave the

ReleasedReleased pin empty, it won't execute anything for speech mappings.

4. Play the app, say the word jumpjump, and watch the console print out the logs!



 Next Development Checkpoint

 See also

That's all the setup you'll need to start adding voice input to your HoloLens apps in Unreal. You can find more

information on speech and interactivity at the links below, and be sure to think about the experience you're

creating for your users.

If you're following the Unreal development journey we've laid out, you're next task is exploring the Mixed Reality

platform capabilities and APIs:

HoloLens camera

You can always go back to the Unreal development checkpoints at any time.

Voice Input

Gaze and commit

Instinctual interactions
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 Constructors

NOTENOTE

 3D buttons and textures

 Variants

 Animation

 Communications

 Global state

 Optimizing Blueprints

The following are some general best practices we recommend all developers follow when creating an Unreal

Engine project for Mixed Reality.

If you need the equivalent of a "constructor" in blueprints, use Unreals' construction script. The primary

advantage over using "BeginPlay" events is the constructor script runs in the "editor" as well. Most of the time

the values can be cached right at the start or even at compile time.

You can find more supporting information for Construction scripts in our editor extensions overview.

It's natural to think about performance when creating or planning to use 3D buttons in mixed reality

applications. However, not everything has to be made from meshes to be perceived as 3D. You have the option

of using Paper2D with carefully crafted textures to get that 3D look. This works really well for buttons that

"seem" 3D, but are just photoshopped images on a quad. A fancy version of these is called a sprite.

Use Unreal Variants in scenarios where you're creating a scene with multiple object configurations at runtime.

Variations can include changing materials or meshes.

Take advantage of the Spline component (not the Spline "Mesh" Component) and Timeline nodes if you're

creating lots of "interactable animations".

Use a Level Blueprint if you're having trouble dynamically finding objects or using too much bandwidth to

communicate between multiple actors and blueprints. Remember, Unreal Engine 4 isn't like Unity, not everything

has to be inside a component. Level Blueprints are a perfectly valid and recommended way of simplifying the

communication between multiple actors. Object references can even be "cached" at startup in the Level

Blueprint's OnBeginPlay.

You'll often need to store level-specific state like score, level data, player-specific information, or anything else

that doesn't quite belong to a particular object. Don't overlook the GameMode. Most people forget that it exists,

but the GameMode can be created per level, and contain data specific to each level.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-best-practices.md
https://docs.unrealengine.com/ProgrammingAndScripting/Blueprints/UserGuide/UserConstructionScript/index.html
https://docs.unrealengine.com/AnimatingObjects/Paper2D/Sprites/index.html
https://docs.unrealengine.com/Basics/Levels/Variants/index.html
https://docs.unrealengine.com/API/Runtime/Engine/Components/USplineComponent/index.html
https://docs.unrealengine.com/ProgrammingAndScripting/Blueprints/UserGuide/Timelines/index.html
https://docs.unrealengine.com/ProgrammingAndScripting/Blueprints/UserGuide/Types/LevelBlueprint/index.html
https://docs.unrealengine.com/en-US/InteractiveExperiences/Framework/GameMode/index.html


If you're finding your blueprints to be too slow, let Unreal "nativize" your blueprints before resorting to rewriting

the code in c++. Try using the automatic nativization before creating your own custom solution.

https://docs.unrealengine.com/ProgrammingAndScripting/Blueprints/TechnicalGuide/NativizingBlueprints/index.html
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 Recommended Unreal project settings

Unreal Engine has several features that can increase an apps performance, all based on the discussion outlined

in performance recommendations for mixed reality. You're encouraged to read up on application bottlenecks,

analyzing and profiling mixed reality apps, and general performance fixes before continuing.

You can find each of the following settings in Edit > Project SettingsEdit > Project Settings .

1. Using the mobile VR renderer :

Scroll to the ProjectProject section, select Target HardwareTarget Hardware, and set the target platform to Mobile/TabletMobile/Tablet

2. Using the Forward Renderer :

Forward Renderer is much better for Mixed Reality than the default Deferred rendering pipeline

because of the number of features that can be individually turned off.

You can find more information in Unreal's documentation.

3. Using mobile multi-view:

Scroll to the EngineEngine section, select RenderingRendering, expand the VRVR  section, and enable both InstancedInstanced

StereoStereo and Mobile Multi-ViewMobile Multi-View . Mobile HDR should be unchecked.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/performance-recommendations-for-unreal.md
https://docs.unrealengine.com/Platforms/VR/DevelopVR/VRPerformance/index.html


4. [OpenXR only][OpenXR only]  Ensure DefaultDefault or D3D12D3D12  is the selected Default RHIDefault RHI:

Selecting D3D11D3D11  will have a negative performance impact due to the platform performing an

additional render pass. D3D12D3D12  should provide rendering performance improvements besides

avoiding the additional render pass.

5. Disabling Vertex Fogging:

Vertex fogging applies fog calculations at each vertex in a polygon and then interpolates the results

across the face of the polygon. If your game does not use fog, we recommend disabling Vertex

Fogging to increase shading performance.



NOTENOTE

6. Disabling occlusion culling:

Scroll to the EngineEngine section, select RenderingRendering, expand the CullingCulling section, and uncheck OcclusionOcclusion

CullingCulling.

Occlusion culling on the GPU on mobile devices is slow. Generally, you want the GPU to be primarily

concerned with rendering. If you feel that occlusion will help performance, try enabling software

occlusion instead.

If you need occlusion culling for a detailed scene being rendered, it's recommended that you

enable Suppor t Software Occlusion CullingSuppor t Software Occlusion Culling in Engine > RenderingEngine > Rendering. Unreal will do the

work on the CPU and avoid GPU occlusion queries, which perform poorly on HoloLens 2.

Enabling software occlusion could make performance worse if you're already CPU bound by a large number of draw-calls.

7. Disabling Custom Depth-Stencil Pass:

Disabling Custom Depth-Stencil requires an extra pass, meaning it's slow. Translucency is also slow on

Unreal. You can find more information in Unreal's documentation.

https://docs.unrealengine.com/Engine/Performance/Guidelines/index.html


 Optional settings

NOTENOTE

 See also

8. Reducing Cascaded Shadow Maps:

Reducing the number of shadow maps will improve performance. Generally, you should set the

property to 1 unless there's a visible quality loss.

The following settings may improve performance, but at the cost of disabling certain features. Only use these settings if

you're sure you don't need the features in question.

1. Mobile Shader Permutation Reduction

If your lights don't move independently of the camera, then you can safely set the property value to 0.

The primary benefit is that it will allow Unreal to cull several shader permutations, speeding up shader

compilation.

Unreal Engine mobile performance guidelines

https://docs.unrealengine.com/Platforms/Mobile/Performance/index.html
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 Using CustomizedUVs

The materials you use can directly affect how well your projects run in Unreal Engine. This page acts as a quick-

start for the basic settings you should be using to get the best performance out of your mixed reality

applications.

If you need to provide UV tiling on your material, use CustomizedUVs rather than modifying the UV of the

texture node directly. CustomizedUVs let you manipulate UVs in the Vertex shaders rather than the Pixel shader.

You can find material details in the Unreal Engine documentation and best practice examples in the screenshots

below:

Recommended material setup

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-materials.md
https://docs.unrealengine.com/Platforms/Mobile/Materials/index.html
file:///C:/localrun/t/fs14/bgqa/windows/mixed-reality/develop/unreal/images/unreal-materials-img-01.png#lightbox


 Changing Blend Mode

 Updating lighting for mobile

 Adjusting Forward Shading

Non-recommended material setup

We recommend setting the blend mode to opaque unless there's a strong reason to do otherwise. Masked and

Translucent materials are slow. You can find more details on materials in the Unreal Engine documentation.

Full precision should be turned off. Lightmap lighting can be dialed down by turning of directional information.

When disabled, lighting from lightmaps will be flat but cheaper.

These options improve visual fidelity at the cost of performance. They should be turned off for maximum

performance.

file:///C:/localrun/t/fs14/bgqa/windows/mixed-reality/develop/unreal/images/unreal-materials-img-01b.png#lightbox
https://docs.unrealengine.com/Platforms/Mobile/Materials/index.html


 Setting material translucency

 Optional settings

 Best practices

Indicates that the translucent material should not be affected by bloom or DOF. Since both those effects are rare

in MR, this setting should be on by default.

The following settings may improve performance, but note that they disable certain features. Only use these

settings if you're sure you don't need the features in question.

If your material doesn't require reflections or shine, then setting this option can provide a tremendous

performance boost. In internal testing, it's as fast as "unlit" while providing lighting information.

The following aren't "settings" as much as they're best practices related to Materials.

When creating parameters, prefer to use "Static Parameters" wherever possible. Static Switches can be used to

remove an entire branch of a material with no runtime cost. Instances can have different values, making it

possible to have a templated shader set up with no performance loss. The downside, is that several

permutations are created that will cause shader recompilation. Try to minimize the number of static parameters

in the material and the number of permutations of those static parameters that are used. You can find more

details on rendering material parameters in the Unreal Engine documentation.

https://docs.unrealengine.com/Engine/Rendering/Materials/ExpressionReference/Parameters/index.html#staticswitchparameter


When creating Material Instances, preference should be given to Mater ial Instance ConstantMater ial Instance Constant over Material

Instance Dynamic. Mater ial Instance ConstantMater ial Instance Constant is an instanced Material that calculates only once before

runtime.

The material instance created via the Content Browser (r ight-click > Create Mater ial Instanceright-click > Create Mater ial Instance) is a Material

Instance Constant. Material Instance Dynamic are created via code. You can find more details on material

instances in the Unreal Engine documentation.

Keep an eye on the complexity of your materials/shaders. You can view the cost of your Material on various

platforms by clicking on the Platform Stats icon. You can also find more details on materials in the Unreal Engine

documentation.

You can get a quick idea of the relative complexity of your shader via the Shader Complexity View mode.

View Mode Hotkey: Alt + 8

Console command: viewmode shadercomplexity

https://docs.unrealengine.com/Engine/Rendering/Materials/MaterialInstances/index.html
https://docs.unrealengine.com/Platforms/Mobile/Materials/index.html
https://docs.unrealengine.com/Engine/UI/LevelEditor/Viewports/ViewModes/index.html


 See also
Mobile materials

View modes

Material instances

https://docs.unrealengine.com/Platforms/Mobile/Materials/index.html
https://docs.unrealengine.com/Engine/UI/LevelEditor/Viewports/ViewModes/index.html
https://docs.unrealengine.com/Engine/Rendering/Materials/MaterialInstances/index.html
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 Setup

IMPORTANTIMPORTANT

Unreal Insights is a profiling system that collects, analyzes, and visualizes data from Unreal Engine. The profiling

system can help you find optimization bottlenecks and areas where you apps performance could use a boost.

Normally, you enable Unreal Insights right from the editor, but for HoloLens 2 you'll need to use the command

line.

Unreal lets you to create and configure a "Custom Profile" in the HoloLens launcher with the command line

parameters that enable Unreal Insights.

1. Find the IP address of your computer using the ipconfigipconfig command on the command prompt. The IP address

is the IPv4 address listed by ipconfig. Keep this in mind for later when you set Command Line Parameters.

If you're behind a VPN, you may need to provide the IP address provided via the VPN instead.

2. Open Project SettingsProject Settings  from the "Edit" toolbar in the main editor window.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-insights.md
https://docs.unrealengine.com/TestingAndOptimization/PerformanceAndProfiling/UnrealInsights/Overview/index.html


 Launch

3. Scroll down the left panel until you find the PlatformsPlatforms header and select HoloLensHoloLens .

4. Confirm that the CapabilitiesCapabilities  section has "Internet Client", "Internet Client Server", and "Private Network

Client Server" selected.

1. Open Project LauncherProject Launcher  from the UE4 panel under the LaunchLaunch button:

2. Select the ++ button to create a custom profile under Custom Launch ProfilesCustom Launch Profiles . Once created, you can

always edit this profile later :



NOTENOTE

IMPORTANTIMPORTANT

3. Select edit profileedit profile button on the HoloLens custom launch profile. In the BuildBuild section, check Build UATBuild UAT and

set Additional Command Line ParametersAdditional Command Line Parameters .

Try these for starters: -tracehost=IP_OF_YOUR_PC --tracehost=IP_OF_YOUR_PC -

trace=Log,Bookmark ,Frame,CPU,GPU,LoadTime,File,Nettrace=Log,Bookmark ,Frame,CPU,GPU,LoadTime,File,Net

You can find a complete list of available launch parameters in the Unreal Insights reference

documentation.

"IP_OF_YOUR_PC" is the IP address we found in step 1. This is the IP address of the computer running Unreal Insights,

NOT the IP address of the HoloLens.

Traces can get large very quickly. Enable only those channels you need to keep trace size low.

4. Select CookCook to By the BookBy the Book to enable copying to device. Make sure your maps are selected in CookedCooked

MapsMaps .

5. Set How would you like to package the buildHow would you like to package the build to Package & store locallyPackage & store locally . Note the file path you

choose, as you will need this later.

https://docs.unrealengine.com/TestingAndOptimization/PerformanceAndProfiling/UnrealInsights/Reference/index.html


 Profiling

6. Set How would you like to deploy the build?How would you like to deploy the build? to Do not deployDo not deploy .

8. Select BackBack to return to the root of the Project LauncherProject Launcher  dialog

9. Back in the editor, Click LaunchLaunch on your custom launch profile

10. Watch as your project is built, and then deploy the appxbundle (in the package path from step 5) to your

HoloLens through the device portal

11. Launch Unreal Insights. The Unreal Insights executable is stored in the binaries engine folder, usually as

follows: "C:\Program Files\Epic Games\UE_4.26\Engine\Binaries\Win64\UnrealInsights.exe"

12. Launch the app on your HoloLens.

Back in Unreal Insights, select the L iveLive connection to your device to start profiling

The custom profile is shared between projects. From here on out, you can use the custom profile you created

instead of having to do this every time. You only need to recreate the connection to the device every time you

start Unreal with steps 3 to 6 in the setup section.



 See also
Unreal Insights documentation

https://docs.unrealengine.com/TestingAndOptimization/PerformanceAndProfiling/UnrealInsights/index.html
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 Construction scripts

 Scripted actions

 Editor utility widgets

 Plugins

Unreal provides an extensive set of features that allow you to customize the engine to your needs. The features

range from simple but limited, to very powerful but complex. The following steps are listed in order of

increasing complexity. In general, you should reach for simpler solutions to your problem, and exhausting its

options, before moving to a more complex option. As an example, we have found that the basic Construction

Script can be used in lieu of plugins most of the time.

You can use construction scripts to perform initialization actions, which run when Blueprint instance are created.

User Constructions script

Blueprint example

Video tutorial

Scripted Actions are Editor Utility Blueprints. You can launch them in the Unreal Editor by:

Right-clicking AssetsAssets  in the Content Browser

Or by right-clicking ActorsActors  either in the Level Viewport or in the World Outliner

Scripted Actions are uniquely suited for times when you need your Blueprint logic to have contextual awareness

about sets of Assets or Actors. Typically, a Scripted Action gets a list of Assets or Actors that you've selected

when the action is executed, then modifies those objects or considers them in its graph.

Scripted Actions

Running scripted actions on project startup

You can use Editor Utility Widgets anytime you want to add new UI elements to modify the User Interface (UI) of

the Unreal Editor. Editor Utility Widgets are based on Unreal Motion Graphics (UMG), so you can set up Widgets

in a Blueprint like you would for any other UMG Widget Blueprint.

These Widgets are specifically for the Editor UI, and you can use them to create custom Editor tabs. You can then

select these custom tabs from the Windows menu, like you would select existing Editor tabs.

Unreal lets you develop and manage your own custom plugins for use with UE4 tools and runtime. You can

enable or disable your plugins at any time in the Unreal Editor. Plugins can add runtime gameplay functionality,

modify built-in Engine features, create new file types, and extend the capabilities of the Editor.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-editor-extensions.md
https://docs.unrealengine.com/ProgrammingAndScripting/Blueprints/UserGuide/UserConstructionScript/index.html
https://docs.unrealengine.com/Resources/ContentExamples/Blueprints/1_4/index.html
https://www.youtube.com/watch?v=z1SD-d9yJmQ&ab_channel=UnrealEngine
https://docs.unrealengine.com/ProductionPipelines/ScriptingAndAutomation/Blueprints/ScriptedActions/index.html
https://docs.unrealengine.com/ProductionPipelines/ScriptingAndAutomation/Blueprints/StartupObjects/index.html
https://docs.unrealengine.com/InteractiveExperiences/UMG/UserGuide/EditorUtilityWidgets/index.html
https://docs.unrealengine.com/ProductionPipelines/Plugins/index.html
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IMPORTANTIMPORTANT

 

 

 PV Camera Feed Setup

IMPORTANTIMPORTANT

The HoloLens has a Photo/Video (PV) Camera on the visor that can be used for both Mixed Reality Capture

(MRC) and locating objects in Unreal world space from pixel coordinates in the camera frame.

The PV Camera isn't supported with Holographic Remoting, but it's possible to use a webcam attached to your PC to

simulate the HoloLens PV Camera functionality.

4.26

4.25

The PV camera is implemented in both Windows Mixed Reality and OpenXR plugins. However, OpenXR needs the

Microsoft OpenXR plugin to be installed. Also, OpenXR for Unreal 4.26 has a limitation: camera can work with DirectX11

RHI. This limitation is fixed in Unreal 4.27.1 or later.

In Project Settings > HoloLensProject Settings > HoloLens , enable the WebcamWebcam capability:

Create a new actor called “CamCapture” and add a plane to render the camera feed:

Add the actor to your scene, create a new material called CamTextureMaterial with a Texture Object

Parameter, and a texture sample. Send the texture’s rgb data to the output emissive color :

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-hololens-camera.md
https://github.com/microsoft/Microsoft-OpenXR-Unreal


 Rendering the PV Camera Feed
In the CamCapture blueprint, turn on the PV Camera:

Create a dynamic material instance from CamTextureMaterial and assign this material to the actor ’s plane:

Get the texture from the camera feed and assign it to the dynamic material if it's valid. If the texture isn't valid,

start a timer and try again after the timeout:

Finally, scale the plane by the camera image’s aspect ratio:



 Find Camera Positions in World Space
The camera on the HoloLens 2 is offset vertically from the device’s head tracking. A few functions exist to locate

the camera in world space to account for the offset.

GetPVCameraToWorldTransform gets the transform in world space of the PV Camera and will be positioned on

the camera lens:

GetWorldSpaceRayFromCameraPoint casts a ray from the camera lens into the scene in Unreal world space to

find a pixel's content in the camera frame:

GetPVCameraIntrinsics returns the camera intrinsic values, which can be used when doing computer vision

processing on a camera frame:

To find what exists in world space at a particular pixel coordinate, use a line trace with the world space ray:



 Rendering the PV Camera Feed in C++

PublicDependencyModuleNames.AddRange(
    new string[] {
        "Core",
        "CoreUObject",
        "Engine",
        "InputCore",
        "AugmentedReality"
});

Here we cast a 2-meter ray from the camera lens to the camera-space position ¼ from the top left of the frame.

Then use the hit result to render something where the object exists in world space:

When using spatial mapping, this hit position will match the surface that the camera is seeing.

Create a new C++ actor called CamCapture

In the project’s build.cs, add “AugmentedReality” to the PublicDependencyModuleNames list:

In CamCapture.h, include ARBlueprintLibrary.h



#include "ARBlueprintLibrary.h"

private:
    UStaticMesh* StaticMesh;
    UStaticMeshComponent* StaticMeshComponent;
    UMaterialInstanceDynamic* DynamicMaterial;
    bool IsTextureParamSet = false;

ACamCapture::ACamCapture()
{
    PrimaryActorTick.bCanEverTick = true;

    // Load a mesh from the engine to render the camera feed to.
    StaticMesh = LoadObject<UStaticMesh>(nullptr, TEXT("/Engine/EngineMeshes/Cube.Cube"), nullptr, 
LOAD_None, nullptr);

    // Create a static mesh component to render the static mesh
    StaticMeshComponent = CreateDefaultSubobject<UStaticMeshComponent>(TEXT("CameraPlane"));
    StaticMeshComponent->SetStaticMesh(StaticMesh);

    // Scale and add to the scene
    StaticMeshComponent->SetWorldScale3D(FVector(0.1f, 1, 1));
    this->SetRootComponent(StaticMeshComponent);
}

void ACamCapture::BeginPlay()
{
    Super::BeginPlay();

    // Create a dynamic material instance from the game's camera material.
    // Right-click on a material in the project and select "Copy Reference" to get this string.
    FString CameraMatPath("Material'/Game/Materials/CamTextureMaterial.CamTextureMaterial'");
    UMaterial* BaseMaterial = (UMaterial*)StaticLoadObject(UMaterial::StaticClass(), nullptr, 
*CameraMatPath, nullptr, LOAD_None, nullptr);
    DynamicMaterial = UMaterialInstanceDynamic::Create(BaseMaterial, this);

    // Use the dynamic material instance when rendering the camera mesh.
    StaticMeshComponent->SetMaterial(0, DynamicMaterial);

    // Start the webcam.
    UARBlueprintLibrary::ToggleARCapture(true, EARCaptureType::Camera);
}

You also need to add local variables for the mesh and material:

In CamCapture.cpp, update the constructor to add a static mesh to the scene:

In BeginPlay create a dynamic material instance from the project’s camera material, apply it to the static mesh

component, and start the HoloLens camera.

In the editor, right-click on the CamTextureMaterial in the content browser and select “Copy Reference” to get the

string for CameraMatPath.

In Tick get the texture from the camera, set it to the texture parameter in the CamTextureMaterial material, and

scale the static mesh component by the camera frame’s aspect ratio:



void ACamCapture::Tick(float DeltaTime)
{
    Super::Tick(DeltaTime);

    // Dynamic material instance only needs to be set once.
    if(IsTextureParamSet)
    {
        return;
    }

    // Get the texture from the camera.
    UARTexture* ARTexture = UARBlueprintLibrary::GetARTexture(EARTextureType::CameraImage);
    if(ARTexture != nullptr)
    {
        // Set the shader's texture parameter (named "Param") to the camera image.
        DynamicMaterial->SetTextureParameterValue("Param", ARTexture);
        IsTextureParamSet = true;

        // Get the camera instrincs
        FARCameraIntrinsics Intrinsics;
        UARBlueprintLibrary::GetCameraIntrinsics(Intrinsics);

        // Scale the camera mesh by the aspect ratio.
        float R = (float)Intrinsics.ImageResolution.X / (float)Intrinsics.ImageResolution.Y;
        StaticMeshComponent->SetWorldScale3D(FVector(0.1f, R, 1));
    }
}

 Next Development Checkpoint

 See also

If you're following the Unreal development journey we've laid out, you're in the midst of exploring the Mixed

Reality platform capabilities and APIs. From here, you can continue to the next topic:

QR codes

Or jump directly to deploying your app on a device or emulator :

Deploying to device

You can always go back to the Unreal development checkpoints at any time.

Locatable camera

Mixed reality capture for developers



   

 

Mixed reality capture with Unreal
 7/6/2022 • 2 minutes to read • Edit Online

NOTENOTE

  Render from the PV camera (opt-in)Render from the PV camera (opt-in)

  En a b l e  t h e  P h o t o Vi d e o C a m e r a  H o l o g r a p h i c V i e w C o n fi g u r a t i o n  i n  U n r e a lEn a b l e  t h e  P h o t o Vi d e o C a m e r a  H o l o g r a p h i c V i e w C o n fi g u r a t i o n  i n  U n r e a l

NOTENOTE

  H a n d l e  t h e  a d d i t i o n a l  H o l o g r a p h i c C a m e r a  r e n d e r  i n  U n r e a lH a n d l e  t h e  a d d i t i o n a l  H o l o g r a p h i c C a m e r a  r e n d e r  i n  U n r e a l

  Creating a custom MRC recorderCreating a custom MRC recorder

See Render from the PV camera below for guidance on a new MRC capability for HoloLens 2.

Before getting started here, we recommend that you take a look at our mixed reality capture overview article.

HoloLens 2 adds the ability for an immersive app to render from the PV camerarender from the PV camera while mixed reality capture

is running. To ensure the app supports the additional render correctly, the app has to opt in to this functionality.

Render from the PV camera offers the following improvements over the default MRC experience:

Hologram alignment to your physical environment and hands for near interactions should be accurate at all

distances. Avoid having an offset at distances other than the focus point as you might see in the default MRC.

The right eye in the headset won't be compromised, as it won't be used to render the holograms for the MRC

output.

There are three steps to enable rendering from the PV camera:

1. Enable the PhotoVideoCamera HolographicViewConfiguration

2. Handle the additional HolographicCamera render

3. Verify your shaders and code render correctly from this additional HolographicCamera

This requires Unreal Engine 4.25Unreal Engine 4.25  or newer.

To opt in to rendering from the PV Camera:

1. Call SetEnabledMixedRealityCameraSetEnabledMixedRealityCamera and ResizeMixedRealityCameraResizeMixedRealityCamera

Use the S ize XSize X and S ize YSize Y  values to set the video dimensions.

This is done for you automatically by Unreal.

While the user can always trigger a photo or video using the system MRC capture service, an application may

want to build a custom camera app that include holograms in the camera stream just like MRC. This allows the

application to kick off captures from user input, build custom recording UI, or customize MRC settings to name a

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/mixed-reality-capture-unreal.md


  MRC access for developersMRC access for developers

 See also

few examples.

We recommend you always request Exclusive control for the camera when using MRC. This will ensure your

application has full control of the settings for the camera as long as you're aware of the limitations listed above.

Mixed reality capture overview

Mixed reality capture for HoloLens users

https://docs.microsoft.com/en-us/hololens/holographic-photos-and-videos
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C a u t i o nC a u t i o n

 Enabling QR detection

 

 

If you're new to working with QR codes, you may want to review our QR code tracking overview.

The HoloLens 2 can see QR codes in world space using the webcam, which renders them as holograms at each

code's real-world position. HoloLens 2 can also render holograms in the same location on multiple devices to

create a shared experience. Make sure you're following the best practices for adding QR codes to your

applications:

Quiet zones

Lighting and backdrop

Size, distance, and angular position

Pay special attention to the environment considerations when QR codes are being placed in your app. You can

find more information on each of these topics and instructions on how to download the required NuGet

package in our QR code tracking overview document.

QR codes are the only type of images that can be tracked by HoloLens out of the box - Unreal's

UARTrackedImageUARTrackedImage module isn't supported on HoloLens. If you need to track custom images, you can access

the device's webcam and process images using a third party image recognition library.

Since the HoloLens 2 needs to use the webcam to see QR codes, you'll need to enable it in the project settings:

Open Edit > Project SettingsEdit > Project Settings , scroll to the PlatformsPlatforms section, and select HoloLensHoloLens .

You'll also need to opt into QR code tracking by adding an ARSessionConfig asset.

Expand the CapabilitiesCapabilities  section and check WebcamWebcam.

4.26

4.25

If you're using UE 4.26, we recommend using the following blueprint setup to add a small delay, because QR

code tracking must be initialized AFTER starting an AR Session:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-qr-codes.md
https://docs.microsoft.com/en-us/hololens/hololens-environment-considerations
https://docs.microsoft.com/en-us/windows/mixed-reality/unreal-uxt-ch3#adding-the-session-asset


 Setting up a tracked QR code
QR codes are surfaced through Unreal’s AR tracked geometry system as a tracked image. To get this working,

you'll need to:

1. Create an Actor Blueprint and add an ARTrackableNotifyARTrackableNotify  component:

2. Select ARTrackableNotifyARTrackableNotify  and expand the EventsEvents  section in the DetailsDetails  panel:

3. Click ++ next to On Add Tracked Geometr yOn Add Tracked Geometr y  to add the node to the Event Graph.

You can find the full list of events in the UARTrackableNotify component API.

https://docs.unrealengine.com/en-US/API/Runtime/AugmentedReality/UARTrackableNotifyComponent/index.html


 Using a tracked QR code

 

 

 Finding the unique ID

 Next Development Checkpoint

The Event Graph in the following image shows the OnUpdateTrackedImageOnUpdateTrackedImage event being used to render a

point in the center of a QR code and print out its data.

4.26

4.25

Here's what's going on:

1. First, the tracked image is cast to an ARTrackedQRCodeARTrackedQRCode to check that the current updated image is a QR

code.

2. The encoded data is retrieved from the QRCodeQRCode variable. You can get the top-left of the QR code from the

location of GetLocalToWorldTransformGetLocalToWorldTransform and the dimensions with GetEstimateSizeGetEstimateSize.

You can also get the coordinate system for a QR code in code.

Every QR code has a unique guid ID, which you can find by:

Dragging and dropping the As ARTracked QRCodeAs ARTracked QRCode pin and searching for Get Unique IDGet Unique ID.

If you're following the Unreal development checkpoint journey we've laid out, you can proceed to the next topic:

WinRT

https://docs.microsoft.com/en-us/windows/mixed-reality/qr-code-tracking#getting-the-coordinate-system-for-a-qr-code


 See also

Or jump directly to deploying your app on a device or emulator :

Deploying to device

You can always go back to the Unreal development checkpoints at any time.

QR code tracking overview

Spatial mapping

Holograms

Coordinate systems
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 Create a new widget

Unreal Motion Graphics (UMG) is Unreal Engine’s built-in UI system, used to create interfaces such as menus

and text boxes. User interfaces built with UMG consist of widgets. We'll guide you through creating a new

widget, adding it to world space, and enabling interaction using the system keyboard as an example. You can

learn more about UMG in the official Unreal Engine documentation.

Create a Widget Blueprint to lay out the game’s UI:

Open the new blueprint and add components from the Palette to the canvas. In this case, we've added two

Text Box components from the “Input” section:

Select a widget in the Hierarchy or Designer window and modify parameters in the details panel. In this case,

we’ve added some default “Hint Text” and a tint color that appears when you hover over the text box. A text

box will pop up a virtual keyboard on HoloLens when it's interacted with:

Events can also be subscribed to in the details panel:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-umg-keyboard.md
https://docs.unrealengine.com/en-US/Engine/UMG/index.html


 Add a Widget to World Space

 Widget Interaction

Create a new Actor, add a Widget component, and add the actor to the scene:

In the details panel for the Widget, set the Widget ClassWidget Class  to the Widget Blueprint created earlier :

For a text Widget, ensure Receive Hardware InputReceive Hardware Input is unchecked so we only update its text from the virtual

keyboard:

UMG Widgets typically receive input from a mouse. On HoloLens or VR, we need to simulate a mouse with a

Widget Interaction component to get the same events.

Create a new Actor, add a Widget InteractionWidget Interaction component, and add the actor to your scene:

In the details panel for the Widget Interaction component:

Set the interaction distance to the distance value you want

Set the Interaction SourceInteraction Source to customcustom

For development, set Show DebugShow Debug to truetrue:



The default for Interaction Source is “World”, which should send raycasts based on the world position of the

Widget Interaction component. In AR and VR, that's not the case. Enabling “Show Debug” and adding a hover

tint to widgets is important to check the widget interaction component is doing what you expect. The

workaround is to use a custom source and set the raycast in the event graph from the hand ray.

Here we're calling this from Event Tick:

Then add virtual mouse pointer events to the widget interaction component reacting to HoloLens input. In this

case, send a Left Mouse press event when the hand is grasped, and a Left Mouse release event when not

grasped:

Now, when you deploy the app to the HoloLens 2, you’ll see a hand ray extending from your right hand. If you

direct it at one of the editable text boxes and air tap, the system keyboard will appear in front of you and allow

you to enter text.



NOTENOTE

 See Also:

The HoloLens system keyboard requires Unreal Engine 4.26 or later. Additionally, the keyboard will not appear when your

app is being streamed from the Unreal editor to the headset, only when the app is running on device.

Unreal's UMG documentation

Unreal's UMG tutorials

https://docs.unrealengine.com/Engine/UMG/index.html
https://docs.unrealengine.com/Programming/Tutorials/UMG/index.html
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 The standard WinRT APIs

if (Target.Platform == UnrealTargetPlatform.Win64 || Target.Platform == UnrealTargetPlatform.HoloLens)
{
 // These parameters are mandatory for winrt support
 bEnableExceptions = true;
 bUseUnity = false;
 CppStandard = CppStandardVersion.Cpp17;
 PublicSystemLibraries.AddRange(new string[] { "shlwapi.lib", "runtimeobject.lib" });
 PrivateIncludePaths.Add(Path.Combine(Target.WindowsPlatform.WindowsSdkDir,        
                                        "Include", 
                                        Target.WindowsPlatform.WindowsSdkVersion, 
                                        "cppwinrt"));
}

#if (PLATFORM_WINDOWS || PLATFORM_HOLOLENS) 
//Before writing any code, you need to disable common warnings in WinRT headers
#pragma warning(disable : 5205 4265 4268 4946)

#include "Windows/AllowWindowsPlatformTypes.h"
#include "Windows/AllowWindowsPlatformAtomics.h"
#include "Windows/PreWindowsApi.h"

#include <unknwn.h>
#include <winrt/Windows.Foundation.h>
#include <winrt/Windows.Perception.Spatial.h>
#include <winrt/Windows.Foundation.Collections.h>

#include "Windows/PostWindowsApi.h"
#include "Windows/HideWindowsPlatformAtomics.h"
#include "Windows/HideWindowsPlatformTypes.h"
#endif

 WinRT from a NuGet package

Over the course of your HoloLens development you may need to write a feature using WinRT. For example,

opening a file dialogue in a HoloLens application would need the FileSavePicker in

winrt/Windows.Storage.Pickers.h header file. WinRT is supported in Unreal's build system from version 4.26

onwards.

4.26

4.25

The most common and easiest way to use WinRT is to call methods from WinSDK. To do so, open

YourModule.Build.cs file and add the following lines:

Next, you need to add the following WinRT headers:

WinRT code can only be compiled in the Win64 and HoloLens platforms, so the if statement prevents WinRT

libraries from being included on other platforms. unknwn.h was added for having the IUnknown interface.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-winRT.md


<?xml version="1.0" encoding="utf-8"?>
<packages>
  <package id="Microsoft.MixedReality.QR" version="0.5.2102" targetFramework="native" />
  <package id="Microsoft.VCRTForwarders.140" version="1.0.6" targetFramework="native" />
  <package id="Microsoft.Windows.CppWinRT" version="2.0.200729.8" targetFramework="native" />
</packages>

// WinRT with Nuget support
if (Target.Platform == UnrealTargetPlatform.Win64 || Target.Platform == UnrealTargetPlatform.HoloLens)
{
 // these parameters mandatory for winrt support
 bEnableExceptions = true;
 bUseUnity = false;
 CppStandard = CppStandardVersion.Cpp17;
 PublicSystemLibraries.AddRange(new string [] { "shlwapi.lib", "runtimeobject.lib" });

 // prepare everything for nuget
 string MyModuleName = GetType().Name;
 string NugetFolder = Path.Combine(PluginDirectory, "Intermediate", "Nuget", MyModuleName);
 Directory.CreateDirectory(NugetFolder);

 string BinariesSubFolder = Path.Combine("Binaries", "ThirdParty", Target.Type.ToString(), 
Target.Platform.ToString(), Target.Architecture);

 PrivateDefinitions.Add(string.Format("THIRDPARTY_BINARY_SUBFOLDER=\"{0}\"", BinariesSubFolder.Replace(@"\", 
@"\\")));

 string BinariesFolder = Path.Combine(PluginDirectory, BinariesSubFolder);
 Directory.CreateDirectory(BinariesFolder);

 ExternalDependencies.Add("packages.config");

 // download nuget
 string NugetExe = Path.Combine(NugetFolder, "nuget.exe");
 if (!File.Exists(NugetExe))
 {
  using (System.Net.WebClient myWebClient = new System.Net.WebClient())
  {
   // we aren't focusing on a specific nuget version, we can use any of them but the latest one is 
preferable
   myWebClient.DownloadFile(@"https://dist.nuget.org/win-x86-commandline/latest/nuget.exe", NugetExe);
  }
 }

 // run nuget to update the packages
 {

It’s a little more complicated if you need to add a NuGet package with WinRT support. In this case, Visual Studio

can do practically all job for you, but the Unreal build system can’t. Luckily, it’s not too difficult. Below is an

example of how you would go about downloading the Microsoft.MixedReality.QR package. You can replace it

with another, just make sure you don’t lose the winmd file and copy the correct dll.

Windows SDK dlls from the previous section are handled by the OS. NuGet’s dlls must be managed by the code

in your module. We recommend adding code to download them, copying into binaries folder, and load into the

process memory at the module startup.

At the first step, you should add a packages.config (https://docs.microsoft.com/nuget/reference/packages-

config) into the root folder of your module. There you should add all packages you want to download, including

all their dependencies. Here I added Microsoft.MixedReality.QR as a primary payload and two others as

dependencies to it. The format of that file is same as in Visual Studio:

Now you can download the NuGet, the required packages, or refer to the NuGet documentation.

Open YourModule.Build.cs and add the following code:

https://docs.microsoft.com/en-us/nuget/reference/packages-config
https://docs.microsoft.com/en-us/nuget/consume-packages/install-use-packages-nuget-cli


 {
  var StartInfo = new System.Diagnostics.ProcessStartInfo(NugetExe, string.Format("install \"{0}\" -
OutputDirectory \"{1}\"", Path.Combine(ModuleDirectory, "packages.config"), NugetFolder));
  StartInfo.UseShellExecute = false;
  StartInfo.CreateNoWindow = true;
  var ExitCode = Utils.RunLocalProcessAndPrintfOutput(StartInfo);
  if (ExitCode < 0)
  {
   throw new BuildException("Failed to get nuget packages.  See log for details.");
  }
 }

 // get list of the installed packages, that's needed because the code should get particular versions of the 
installed packages
 string[] InstalledPackages = Utils.RunLocalProcessAndReturnStdOut(NugetExe, string.Format("list -Source \"
{0}\"", NugetFolder)).Split(new char[] { '\r', '\n' });

 // winmd files of the packages
 List<string> WinMDFiles = new List<string>();

 // WinRT lib for some job
 string QRPackage = InstalledPackages.FirstOrDefault(x => x.StartsWith("Microsoft.MixedReality.QR"));
 if (!string.IsNullOrEmpty(QRPackage))
 {
  string QRFolderName = QRPackage.Replace(" ", ".");

  // copying dll and winmd binaries to our local binaries folder
  // !!!!! please make sure that you use the path of file! Unreal can't do it for you !!!!!
  string WinMDFile = Path.Combine(NugetFolder, QRFolderName, 
@"lib\uap10.0.18362\Microsoft.MixedReality.QR.winmd");
  SafeCopy(WinMDFile, Path.Combine(BinariesFolder, "Microsoft.MixedReality.QR.winmd"));

  SafeCopy(Path.Combine(NugetFolder, QRFolderName, string.Format(@"runtimes\win10-
{0}\native\Microsoft.MixedReality.QR.dll", Target.WindowsPlatform.Architecture.ToString())),
   Path.Combine(BinariesFolder, "Microsoft.MixedReality.QR.dll"));

  // also both both binaries must be in RuntimeDependencies, unless you get failures in Hololens platform
  RuntimeDependencies.Add(Path.Combine(BinariesFolder, "Microsoft.MixedReality.QR.dll"));
  RuntimeDependencies.Add(Path.Combine(BinariesFolder, "Microsoft.MixedReality.QR.winmd"));

  //add winmd file to the list for further processing using cppwinrt.exe
  WinMDFiles.Add(WinMDFile);
 }

 if (Target.Platform == UnrealTargetPlatform.Win64)
 {
  // Microsoft.VCRTForwarders.140 is needed to run WinRT dlls in Win64 platforms
  string VCRTForwardersPackage = InstalledPackages.FirstOrDefault(x => 
x.StartsWith("Microsoft.VCRTForwarders.140"));
  if (!string.IsNullOrEmpty(VCRTForwardersPackage))
  {
   string VCRTForwardersName = VCRTForwardersPackage.Replace(" ", ".");
   foreach (var Dll in Directory.EnumerateFiles(Path.Combine(NugetFolder, VCRTForwardersName, 
"runtimes/win10-x64/native/release"), "*_app.dll"))
   {
    string newDll = Path.Combine(BinariesFolder, Path.GetFileName(Dll));
    SafeCopy(Dll, newDll);
    RuntimeDependencies.Add(newDll);
   }
  }
 }

 // get WinRT package 
 string CppWinRTPackage = InstalledPackages.FirstOrDefault(x => x.StartsWith("Microsoft.Windows.CppWinRT"));
 if (!string.IsNullOrEmpty(CppWinRTPackage))
 {
  string CppWinRTName = CppWinRTPackage.Replace(" ", ".");
  string CppWinRTExe = Path.Combine(NugetFolder, CppWinRTName, "bin", "cppwinrt.exe");
  string CppWinRTFolder = Path.Combine(PluginDirectory, "Intermediate", CppWinRTName, MyModuleName);



  Directory.CreateDirectory(CppWinRTFolder);

  // all downloaded winmd file with WinSDK to be processed by cppwinrt.exe
  var WinMDFilesStringbuilder = new System.Text.StringBuilder();
  foreach (var winmd in WinMDFiles)
  {
   WinMDFilesStringbuilder.Append(" -input \"");
   WinMDFilesStringbuilder.Append(winmd);
   WinMDFilesStringbuilder.Append("\"");
  }

  // generate winrt headers and add them into include paths
  var StartInfo = new System.Diagnostics.ProcessStartInfo(CppWinRTExe, string.Format("{0} -input \"{1}\" -
output \"{2}\"", WinMDFilesStringbuilder, Target.WindowsPlatform.WindowsSdkVersion, CppWinRTFolder));
  StartInfo.UseShellExecute = false;
  StartInfo.CreateNoWindow = true;
  var ExitCode = Utils.RunLocalProcessAndPrintfOutput(StartInfo);
  if (ExitCode < 0)
  {
   throw new BuildException("Failed to get generate WinRT headers.  See log for details.");
  }

  PrivateIncludePaths.Add(CppWinRTFolder);
 }
 else
 {
  // fall back to default WinSDK headers if no winrt package in our list
  PrivateIncludePaths.Add(Path.Combine(Target.WindowsPlatform.WindowsSdkDir, "Include", 
Target.WindowsPlatform.WindowsSdkVersion, "cppwinrt"));
 }
}

private void SafeCopy(string source, string destination)
{
 if(!File.Exists(source))
 {
  Log.TraceError("Class {0} can't find {1} file for copying", this.GetType().Name, source);
  return;
 }

 try
 {
  File.Copy(source, destination, true);
 }
 catch(IOException ex)
 {
  Log.TraceWarning("Failed to copy {0} to {1} with exception: {2}", source, destination, ex.Message);
  if (!File.Exists(destination))
  {
   Log.TraceError("Destination file {0} does not exist", destination);
   return;
  }

  Log.TraceWarning("Destination file {0} already existed and is probably in use.  The old file will be used 
for the runtime dependency.  This may happen when packaging a Win64 exe from the editor.", destination);
 }
}

You'll need to define the SafeCopy method as follows:

NuGet DLLs needs to load into your Win32 process memory manually; we recommend adding manual loading

into the startup method of your module:



void StartupModule() override
{
#if PLATFORM_WINDOWS
 const FString LibrariesDir = FPaths::ProjectPluginsDir() / "MyModule" / THIRDPARTY_BINARY_SUBFOLDER;
 FPlatformProcess::PushDllDirectory(*LibrariesDir);

 const FString DllName = "Microsoft.MixedReality.QR.dll";
 if (!FPlatformProcess::GetDllHandle(*DllName))
 {
  UE_LOG(LogHMD, Warning, TEXT("Dll \'%s\' can't be loaded from \'%s\'"), *DllName, *LibrariesDir);
 }

 FPlatformProcess::PopDllDirectory(*LibrariesDir);
#endif
}

 Next Development Checkpoint

 See also

Finally, you can include WinRT headers into your code as described in the previous section.

If you're following the Unreal development journey we've laid out, you're in the midst of exploring the Mixed

Reality platform capabilities and APIs. From here, you can continue to any topic or jump directly to deploying

your app on a device or emulator.

Deploying to device

C++/WinRT APIs

FileSavePicker class

Unreal Third-Party Libraries

https://docs.microsoft.com/en-us/windows/uwp/cpp-and-winrt-apis/
https://docs.microsoft.com/en-us/uwp/api/windows.storage.pickers.filesavepicker
https://docs.unrealengine.com/Programming/BuildTools/UnrealBuildTool/ThirdPartyLibraries/index.html
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NOTENOTE

  Streaming limitationsStreaming limitations

  OpenXROpenXR

 Device support

"Streaming" is sometimes referred to as "Holographic Remoting." To learn more, see Holographic Remoting

Overview

Streaming from a PC to HoloLens provides two major advantages:

It lets your mixed reality app take advantage of your PC's computational power.

It helps speed up development iteration time.

To get started, you'll need to download the Holographic Remoting Player to your HoloLens device. The

Holographic Remoting Player lets your app to stream directly to the remoting player on your HoloLens from the

following sources:

The Unreal Engine editor

A packaged Windows executable

When streaming, you have access to almost all of the same HoloLens capabilities as you would when running an

application on a device. This includes hand joint tracking if you're on a HoloLens 2, spatial mapping, and spatial

anchors, but leaves out the features on this list.

Streaming quality is highly dependent on the strength of your wifi network.

All capabilities are automatically enabled for the holographic remoting player. If you find a capability that requires user

permission (ex: eye tracking) to be working over streaming but not when running on device, check to ensure you've

enabled the proper capabilities under your project settings.

Hand meshes, the HoloLens camera, and the system keyboard are unavailable over streaming. Note that speech

input for streamed apps can be acquired via the microphone of the PC you are streaming from.

Unreal 4.26 running on OpenXR supports streaming to versions 2.4.0+ of the Holographic Remoting Player. For

the latest feature support with Holographic Remoting see the version history and the troubleshooting pages.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-streaming.md


SourceSource HoloLens first GenHoloLens first Gen HoloLens 2HoloLens 2 II
mm
mm
ee
rr
ss
ii
vv
ee
HH
ee
aa
dd
ss
ee
tt
ss

Unreal editor ✔️ ✔️ ✔
️

Windows package ❌ ✔️ ✔
️

NOTENOTE

 Streaming from the Unreal editor

 Streaming from a packaged Windows executable

Starting with Holographic Remoting version 2.2.0 streaming is also available for Windows PCs running Windows Mixed

Reality.

As a developer, you'll find that streaming from the Unreal editor to your HoloLens device provides significant

benefits when testing, namely that you no longer have to wait for your app to build and deploy before trying

out your updates.

You can find detailed instructions for streaming from the Unreal editor in our tutorial series.

In Unreal 4.25.1 and onwards, you can stream your app to a HoloLens 2 device from a packaged Windows

executable:

1. Go to File > Package Project > WindowsFile > Package Project > Windows in the editor menu.

Choose a location to save your package and select Select FolderSelect Folder .

2. Once the package has finished building, open the Holographic Remoting PlayerHolographic Remoting Player  on your HoloLens 2

and make note of the IP Address.

3. Leave the Holographic Remoting PlayerHolographic Remoting Player  open and use the command line prompt to:

cd into the local directory where you saved your package.

Enter the following command: <App Name>.exe -vr -HoloLensRemoting=<IP Address>

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hardware


NOTENOTE

NOTENOTE

  Command line optionsCommand line options
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-HoloLensRemoting=<IP address:port> Takes the IP address (and optional port) of the HoloLens 2
device to connect to. If no port is provided, default to 8265.

-RemotingBitrate=<bitrate> (optional) Default 8000. Max network transfer rate (kb/s).

-HoloLensRemotingListen (optional) Start a listen server

-HoloLensRemotingListenPort=<port> (optional) Takes the port to listen on. Used for connecting to
a PC or VM from a HoloLens device.

-HoloLens1Remoting=<IP address> (deprecated in 4.26) Takes the IP address of the HoloLens 1
device to connect to

-eyetracking=WindowsMixedRealityEyeTracker (optional) Use the Windows Mixed Reality eye tracker

 See also

The application name in your project settings should be automatically used to create the Windows package. If these are

different for some reason, use the Windows executable name in the command prompt.

If eye tracking isn't working when streaming from a packaged executable, either disable any other plugins with PC-

supported eye trackers (example: Magic Leap) or run the application from the command line with the relevant eye

tracking argument (see command line options).

Hit enter and watch your application start streaming!

Additional command line options for streaming from each platform in Unreal Engine 4.26+ can be found in the

table below.

Windows Mixed Reality

OpenXR

Holographic remoting version history

Writing a custom Holographic Remoting player app

Establishing a secure connection with Holographic Remoting
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 Getting started

IMPORTANTIMPORTANT

 

 

  Enabling HP Motion Controller PluginEnabling HP Motion Controller Plugin

 Porting an existing OpenXR app

Unreal Engine 4.26 and either OpenXR or SteamVR is required to access the HP Motion Controller plugin you'll need to

work with the HP Reverb G2 controllers.

All platforms

SteamVR

The interaction profile and controller mappings are in the HP Motion Controller plugin, which must be enabled

to expose the controller mappings to Unreal’s input system.

If no controller bindings exist in the game for the HP Mixed Reality Controller, the OpenXR runtime will try to

remap existing bindings to the active controller. In this case, the game has Oculus Touch bindings and no HP

Mixed Reality Controller bindings.

The events will still fire, but if the game needs to make use of controller-specific bindings, like the right menu

button, the HP Mixed Reality interaction profile must be used. Multiple controller bindings can be specified per

action to better support different devices.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-reverb-g2-controllers.md


 Adding input action mappings

 Adding input events

Define a new action and map to one of the key presses in the HP Mixed Reality Controller section.

The HP Reverb G2 controller also has an analog grip, which can be used in the axis mappings with the “Squeeze

Axis” binding. There's a separate Squeeze binding, which should be used for action mappings when the grip

button is fully pressed.

Right-click on a Blueprint and search for the new action names from the input system to add events for these

actions. Here the Blueprint is responding to the events with a print string outputting the current button and axis

state.



  Using inputUsing input
 

 

All platforms

SteamVR

The same action and axis mappings in the game’s input project settings can be used from C++.

1. Create a new C++ Class with File/New C++ Class...

2. Create a pawn



AMyPawn::AMyPawn()
{
    PrimaryActorTick.bCanEverTick = true;

    AutoPossessPlayer = EAutoReceiveInput::Player0;
}

void AMyPawn::SetupPlayerInputComponent(UInputComponent* PlayerInputComponent)
{
    Super::SetupPlayerInputComponent(PlayerInputComponent);

    PlayerInputComponent->BindAction("X_Button", IE_Pressed, this, &AMyPawn::XPressed);
    PlayerInputComponent->BindAction("L_GripAxis", this, &AMyPawn::LeftGripAxis);
}

void AMyPawn::XPressed()
{
    UE_LOG(LogTemp, Log, TEXT("X Pressed"));
}

void AMyPawn::LeftGripAxis(float AxisValue)
{
    if(AxisValue != 0.0f) 
    {
        UE_LOG(LogTemp, Log, TEXT("Left Grip Axis Valule: %f"), AxisValue);
    }
}

3. In the project’s Visual Studio solution, find the new Pawn class and configure it for input.

First, in the constructor, set AutoPossessPlayer to the first player to route input to the pawn.

Then in SetupPlayerInputComponent, bind actions and axis events to the action names from the project’s

input settings.

Add the callback functions to the class:



private:
    void XPressed();
    void LeftGripAxis(float AxisValue);

 See also

Update the Pawn’s header with the callback function definitions:

4. Compile from Visual Studio to launch the editor with the new pawn. Drag and drop the pawn from the

content browser into the game and the pawn will now execute the callbacks when input is pressed.

SteamVR Input

Using SteamVR with Windows Mixed Reality

Unreal Player Camera

https://docs.unrealengine.com/Platforms/VR/SteamVR/HowTo/SteamVRInput/index.html
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/using-steamvr-with-windows-mixed-reality
https://docs.unrealengine.com/Programming/Tutorials/PlayerCamera/3/index.html
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IMPORTANTIMPORTANT

 Download app from Microsoft Store in HoloLens 2

 First principles

Kippy the robot wakes up to find itself stranded on an island. It’s up to you to put on your problem-solving hat

to help it find a path back to its rocket ship! Strap on your HoloLens 2 and download the app from the Microsoft

Store or clone the repository from GitHub and get Kippy home safe!

Make sure you're using Unreal Engine 4.25 or laterUnreal Engine 4.25 or later  if you're building Kippy's Escape from the GitHub repository.

Kippy’s Escape is an open-source HoloLens 2 sample app built with Unreal Engine 4 and Mixed Reality UX Tools

for Unreal. In this post, we’ll walk you through our process from first principles and visual design to

implementing and optimizing the experience. You can find more information on developing Mixed Reality

applications with MRTK UX Tools in the Unreal development overview.

If you have HoloLens 2 device, you can directly download and install the app in your device.

In setting out to create Kippy’s Escape, our goal was to create an experience that would highlight Unreal Engine’s

HoloLens 2 support, the HoloLens 2’s capabilities, and the Mixed Reality Toolkit. We wanted to inspire

developers to imagine what they could create with Unreal and HoloLens 2.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-kippys-escape.md
https://www.microsoft.com/p/kippys-escape/9nbd7gl86vkd
https://github.com/microsoft/MixedReality-Unreal-KippysEscape
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://github.com/microsoft/MixedReality-UXTools-Unreal
https://www.microsoft.com/store/apps/9nbd7gl86vkd?cid=storebadge&ocid=badge
https://docs.unrealengine.com/Platforms/AR/HoloLens2/index.html


 Designing the game

We came up with three guiding principles for the experience: that it needed to be fun, interactive, and have a low

barrier to entry. We wanted the experience to be intuitive enough that even a first-time mixed reality user won’t

need a tutorial to go through it.

The HoloLens 2 has access to design features found nowhere else in gaming today. Objects can be directly

pushed or manipulated using your hands or targeted with eye tracking. These key features are behind some of

the fun moments we built out in Kippy’s Escape.

Using the unique HoloLens 2 features as guidance for our game design, we scoped out a few small environment

scenarios. Islands made sense because they can be adjusted for different player heights, and provided some

entertaining bridge ideas. We landed on the theme of ancient civilization meets sci-fi tech, with the idea that

someone had built machinery over ruins harnessing a strange energy provided by each island. The islands were

each given their own look and feel, a detail that helped create visual interest. A good balance between modeling

and texturing would keep draw calls low for rendering performance, so a stylized look was designed with that in

mind.

Some early sketches for what the experience might look like



Renderings of the second island

To keep within our short production schedule, we agreed that a floating character could capture intent and

emotion without rigorous animation cycles. And so Kippy was born! It emotes a few different expressions

through its eyes and through minimalistic vocal sound effects to help guide the player throughout the

experience.

Kippy showing different expressions via its eyes



 Building the game mechanics

If the user takes too long to solve a puzzle, Kippy will give the user a hint

Beyond the character and environment design, we made a concerted effort to make the game feel fun. Eye

tracking allowed us to fire off material and sound attributes, which highlighted key pieces of the game. Spatial

audio helped make the levels feel at home in the player ’s surroundings. Being able to grab objects, push

buttons, and manipulate sliders drives innovative player engagements. It was important to make sure these

connection points felt natural.

The end of the bridge cable glows when the user ’s hand approaches it



Kippy’s Escape relies heavily on Mixed Reality UX Tools components to make the game interactive - namely hand

interaction actors, bounds controls, manipulators, sliders, and buttons.

The hand interaction actor enables both direct and far manipulation of holograms. At the start of Kippy’s Escape,

the user is given the opportunity to set the location of the game. Hand beams extending from the user ’s palm

make it easy to manipulate large holograms that are far away, as seen in the gif below.

The placeholder scene itself can be dragged and rotated using UX Tools’ bounds control component.

On the second island, the user must pick up gems and place them in their matching slots. The gems have

manipulators attached to them that allow the user to pick them up and place them down.

A pressable button is the key to bringing up bombs for use on the third island.

https://microsoft.github.io/MixedReality-UXTools-Unreal/Docs/HandInteraction.html
https://microsoft.github.io/MixedReality-UXTools-Unreal/Docs/BoundsControl.html
https://microsoft.github.io/MixedReality-UXTools-Unreal/Docs/Manipulator.html
https://microsoft.github.io/MixedReality-UXTools-Unreal/Docs/PressableButton.html


 Optimizing for HoloLens 2

A slider component appears on the fourth island, triggering the final bridge to be raised.

With any experience built to run on a mobile device, keeping an eye on performance is critical. Unreal 4.25

includes a major update to support for mobile multi-view, which significantly reduces rendering overhead and

boosts frame-rate. We recommend checking out our other recommended performance settings for HoloLens 2

development with Unreal when you're optimizing.

Physics objects still remain costly for performance, so a couple clever workarounds were used. For instance, the

third “bridge” requires blowing up some debris blocking the stairway. Instead of having a force impact the

stones as physics objects, the bomb detonation triggers a swap, switching the static stones for an exploding

particle effect.

https://microsoft.github.io/MixedReality-UXTools-Unreal/Docs/PinchSlider.html


 Try it out!

 About the team

Jack CaronJack Caron
Lead Game Designer
Jack currently works on Mixed Reality experiences for
Microsoft, including HoloLens 2 projectsand AltspaceVR, and
was previously a designer on the HoloLens platform team.

Summer WuSummer Wu
Producer
Summer works on the mixed reality developer platform and heads the team’s Unreal Engine related efforts.

We also cut down our draw calls from over 400 to ~260 by:

Reducing mesh complexity

Combining meshes

Removing some of our initial dynamic lighting elements

While there’s likely more we could have done, we felt that was a good balance between performance and visual

quality.

Boot up your HoloLens 2 and download the app from the Microsoft Store, or clone the repository from GitHub

and build the app yourself!

Special thanks to our friends at Framestore for helping us bring Kippy’s Escape to life. From character

development, to asset design, to game programming, their collaboration on this project was pivotal.

https://www.microsoft.com/p/kippys-escape/9nbd7gl86vkd
https://github.com/microsoft/MixedReality-Unreal-KippysEscape
https://www.framestore.com/
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 Download app from Microsoft Store in HoloLens 2

 The ask

“Pre-MRTK, developing for HoloLens 2 using Unreal was a bit tedious because all of the spatial interactions had

to be coded by hand, in C++. The MRTK for Unreal made a lot of those same tasks trivial. I’d estimate it cut the

time required for the initial prototype in half.” - Jose Rodriguez, Software Developer

“The Ford GT40 Experience is proof that a high-fidelity HoloLens 2 app can be completed in just a few months,

with a modest budget, yet still deliver highly impactful results.” - Daniel Cheetham, Chief Innovation Officer,

Happy Finish

Using the Mixed Reality Toolkit (MRTK) for Unreal, creative production company Happy Finish delivered a

HoloLens 2 experience that provides a fresh perspective on the Ford GT40, the legendary race car that beat

Ferrari at the 24 Hours of Le Mans!

Using a range of natural and intuitive spatial interactions, users can explore the GT40’s beauty, performance, and

engineering—all delivered in a way that takes advantage of the high visual fidelity provided by the Unreal

Engine. Software development for the entire project was completed by a single developer in less than three

months, made possible by MRTK for Unreal's visual scripting and design environment.

If you have HoloLens 2 device, you can directly download and install the app in your device.

Happy Finish is one of the world’s leading creative production companies, with a client base that includes, Ford,

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-ford-gt40.md
https://www.microsoft.com/store/apps/9p4vllktfvfp?cid=storebadge&ocid=badge


 The solution

Microsoft, Nike, Netflix, Vodafone, and other household names. The company got its start as a high-end photo-

retouch agency, branching-out into film and CGI before extending its dedication to excellence in immersive

storytelling with 3D spatial design and interaction.

In mid-2020, Microsoft approached Happy Finish to produce a demo app that could help showcase the

possibilities enabled by the new Mixed Reality Toolkit (MRTK) for Unreal, which builds on the support for

HoloLens 2 in the Unreal Engine. At this point, the company already had two successful Unreal-on-HoloLens 2

projects under its belt. Both were for a globally recognized consumer brand, which chose Unreal on HoloLens 2

for an internal R&D/B2B sales tool for its high visual fidelity, as required to best showcase that client’s own high-

end products.

Although the solution itself would be left up to Happy Finish, it had to meet a few key guidelines. First, it had to

focus on an enterprise scenario to illustrate the utility of Unreal on HoloLens 2 outside of the gaming industry.

Second, it had to be device-only, meaning it could serve as a standalone demo—without requiring a network

connection and external processing power to get the target frame rates and visual quality. Third, it should blend

the range of intuitive interactions supported by the MRTK into a seamless and natural experience. Finally, the

proposed solution should showcase the inherent visual fidelity and other benefits of the Unreal Engine itself,

such as shader efficiencies.

Given these guidelines, Happy Finish began to brainstorm the possibilities, coming up with the idea for a mixed

reality experience that used spatial interaction to communicate the worth of a brand-name, high-value product.

After considering a range of objects that included watches, cameras, cars, and private jets, Happy Finish

ultimately decided on the Ford GT40, an automotive legend that achieved notoriety in 1966 when Ford beat

Ferrari at the 24 Hours of Le Mans—as shown in the 2019 blockbuster film Ford vs. Ferrari.

Upon obtaining buy-in from Ford, an existing Happy Finish client, the company set out to deliver a fresh

perspective on the classic automotive icon.

The work began on May 7, 2020. After obtaining the GT40 model files, a 3D artist spent three weeks optimizing

polygon models, UV mapping, repainting texture maps, and condensing those maps into as few textures as

possible. A technical artist worked in parallel to benchmark the output of the 3D artist, determine optimal

texture sizes given target frame rates, and figure out the best way to apply custom shaders in Unreal. All of this

preproduction work was done to optimize the on-device experience.

Creative Director Alex Lambert entered the picture after the preproduction work was finished. He started by

watching Ford vs. Ferrari, thinking about how to weave together a narrative around the scenarios and

interactions. He also collected visual references for the UI artist, such as images of the GT40 dashboard and

visuals of the Le Mans racetrack, and collected audio recordings of the GT40 in action for the sound designer.

With the narrative defined and optimized preproduction assets in hand, freelance software developer Jose

Rodriguez was enlisted to bring it all together. Rodriguez had been the developer on the previous two Unreal-

on-HoloLens 2 projects that Happy Finish had done, before the MRTK for Unreal had been released.

The value provided by the MRTK for Unreal became evident early-on, helping Rodriguez deliver an initial

prototype in one week. He implemented three unique scenarios, one for each of the key aspects of the GT40 that

Lambert had identified: its beauty, its performance, and its engineering. For each scenario, Rodriguez used the

MRTK to integrate the optimized 3D assets from the preproduction phase into a range of spatial interactions.

With the MRTK for Unreal, Rodriguez built out each scenario using the visual Unreal Motion Graphics (UMG) UI

Designer instead of having to implement everything in C++. UX Tools for Unreal, the plug-in containing UX

building blocks and components within the MRTK, gave him Unreal Blueprints for input simulation, visually

scripting hand interactions, pressable buttons, 3D image manipulation, surface magnetism, and more—all

within a no-code, drag-and-drop design environment.

https://www.unrealengine.com/marketplace/product/mixed-reality-ux-tools
https://docs.unrealengine.com/ProgrammingAndScripting/Blueprints/index.html


 The final build

  BeautyBeauty

“Pre-MRTK, developing for HoloLens 2 using Unreal was a bit tedious because all of the spatial interactions had

to be coded by hand, in C++,” says Rodriguez. “The MRTK for Unreal made a lot of those same tasks trivial. I’d

estimate it cut the time required for the initial prototype in half.”

With a prototype in hand, the team began weekly iterations to refine the experience. “This is when the Mixed

Reality Capture feature and the Windows Device Portal became really helpful,” recalls Lambert. “I used them to

capture my design reviews, broadcast my feedback to others, and collaborate on changes. Working in isolation

like that would have been impossible to do without such tools.”

As Lambert requested changes, such as repositioning UI elements or changing a button’s behavior, Rodriguez

implemented them. While some of the changes required small code tweaks, most of them were handled in the

Unreal visual designer. “I was surprised at how fast I could iterate,” says Rodriguez. “No time was wasted; I would

make a change in the designer and then press play to immediately view it on-device. The MRTK really

streamlined my work.”

Rodriguez also recalls being impressed by how production-ready all of the development tooling was. “We

progressed smoothly from initial prototype through final production, without having to come back and

reimplement or optimize things in code,” he says.

Happy Finish completed production of the Ford GT40 Experience for HoloLens 2 on July 28, 2020, delivering a

fresh perspective on the legendary race car. The experience starts with a welcome screen, then guides the user

to set up an anchor by grabbing the Ford logo and placing it on a flat surface like a table or desktop.

The beautybeauty  segment brings the user to a GT40 configurator, which displays the GT40 on a rotating pedestal,

similar to how a physical car might be displayed at an automotive show. The user can apply different wheel

options, choose from different color schemes, and open and close the doors and trunk (or boot, as they call it in

the UK). Throughout the beauty experience, the user can pick up the car and freely manipulate it for a closer

look.



  PerformancePerformance

  EngineeringEngineering

The performanceperformance segment showcases the GT40’s speed and durability. The voiceover starts by describing how

the car was developed and put through its paces at Ford’s Kingman, Arizona proving grounds, with 3D visuals

showing the GT40 in motion on the test track. As the introduction to the performance segment concludes, the

voiceover prompts the user to “Press the Le Mans button to hit the racetrack.”

The second part of the performance segment showcases the GT40 under the range of conditions drivers might

experience at the 24 Hours of Le Mans, which is held annually at the Circuit de la Sarthe near Le Mans, France. A

3D view shows the car in motion on the Le Mans track, with buttons provided for making the car go faster or

slower. Images of the GT40’s analog speedometer and tachometer float above the racetrack view, with more race

telemetry displayed in the background. The user can toggle between day and night views and between dry and

wet driving conditions, providing a realistic and lifelike perspective of what Ken Miles and the other GT40

drivers experienced in the actual race.

The engineeringengineering segment of the Ford GT40 Experience showcases one of the engineering innovations that

helped Ford win the race: the ability to change brake rotors and pads in less than a minute, as compared to the

20-30 minutes needed by all the other teams. Using intuitive gestures, the user can manipulate a detailed 3D

model of the GT40 wheel and brake assembly. To expand the assembly, the user picks up a lug wrench, aligns it

to the center lock on the wheel, turns it counterclockwise, and then pulls it away from the wheel. Other gestures

are used to remove the worn brake rotors and pads, replace them with new ones, collapse the assembly, and

resecure the center lock. In the background, a timer displays the elapsed time, letting the user see if they can

complete the process as quickly as the pit crew at Le Mans.



  Getting impressive visual fidelityGetting impressive visual fidelity

  Rapid solution deliveryRapid solution delivery

  Potential Azure service enhancementsPotential Azure service enhancements

The Ford GT40 Experience can be downloaded from the Microsoft store, enabling anyone with a HoloLens 2 to

explore how Happy Finish brought a fresh perspective to legendary race car.

While the range of spatial interactions supported by the Ford GT40 Experience are impressive on their own, the

creativity and visual fidelity the experience delivers is what really makes it shine. Through its optimization of 3D

models and use of Unreal custom shaders, Happy Finish hit its target of 60 frames per second, even with the

performance segment of the app approaching 315,000 polygons in size.

“I’m really happy with how we were able to pull together a set of fluid, intuitive interactions into a coherent and

engaging narrative,” says Lambert. “Clearly, the power of Unreal Engine on HoloLens 2 opens up a new world of

opportunity for more surprising and exciting mixed reality experiences. Uncompromised visual fidelity isn’t

always the end goal for enterprise applications on HoloLens 2, but when it is, support for Unreal on HoloLens 2

becomes invaluable.”

As impressive as the end-user Ford GT40 Experience is how quickly Happy Finish delivered it, with the entire

project—from preproduction to final delivery—completed in just under 12 weeks. In summary, the project

consumed 1088 hours of effort, broken down as follows: creative director (80 hours), UX designer (56 hours), UI

designer (40 hours), sound designer (40 hours), 3D/technical artist (328 hours), software developer (408 hours),

technical director (40 hours), producer (56 hours), and quality assurance (40 hours).

“Overall, we came in pretty close to our original project estimates,” says Daniel Cheetham, Chief Innovation

Officer at Happy Finish, who heads up the company’s interactive division. “The Ford GT40 Experience is proof

that a high-fidelity HoloLens 2 app can be completed in just a few months, with a modest budget, yet still deliver

highly impactful results.”

From a development perspective, based on his previous experience with Unreal on HoloLens 2, Rodriguez

estimates that the MRTK for Unreal cut the total time and effort required on his part in half. He also notes how

the MRTK can help developers who have never worked with HoloLens 2 get started. “When other developers say

they’re interested in mixed reality, I encourage them to just jump in, install the HoloLens 2 development stack

and MRTK, and go for it. The MRTK makes building an app quick and easy, and the Unreal visual editor works so

well that you don’t even need a HoloLens 2 device to get started. It’s not complicated at all—everything just

works.”

Lambert sees several ways that Azure mixed reality services could be used to enhance the Ford GT40

Experience, such as using Azure Spatial Anchors to deliver a multi-user experience anchored in the real world.

“From a creative perspective, Azure Spatial Anchors open up an entirely new range of possibilities through the

ability they provide to map, persist, and restore 3D content or points of interest within our physical world,” he

https://www.microsoft.com/p/ford-gt40/9p4vllktfvfp?activetab=pivot:overviewtab


  Endless new possibilitiesEndless new possibilities

 Try it out!

says.

Lambert also envisions how either Azure Remote Rendering or streaming the app from Azure could be used to

achieve desired frame rates while working with more detailed and complex 3D models. “We had to implement

some highly optimized custom shaders in Unreal to hit our on-device target of 60 frames per second,” he

explains. “With Azure Remote Rendering, we could do a lot more—and do it a lot more easily, without as much

work required to optimize polygon models, repaint texture maps, and so on.”

So what’s next for Happy Finish? Ford’s feedback on the Ford GT40 experience has been overwhelmingly

positive, leading to further discussions between Happy Finish and Ford on future HoloLens 2 projects. Outside

its relationship with Ford, Happy Finish is already starting a new project on HoloLens 2, where the MRTK for

Unreal will be a foundational building block for most the user experience.

“We’ve always maintained a technology-agnostic approach to each new project, proposing whichever tool-set is

best-suited to helping the client achieve desired outcomes,” says Cheetham. “That said, HoloLens 2 has emerged

as the de-facto gold standard for mixed reality, especially in the enterprise, standing head-and-shoulders above

all other options in terms of both device capabilities and the pervasiveness of the supporting ecosystem.”

According to Cheetham, the global pandemic has fueled immense new interest in immersive mixed reality

among potential customers. “We’re busier than ever, with about 50 percent of potential clients being open to

discussing a mixed reality option,” he says. “The key is to get people to try it. You can tell them about mixed

reality all day, but when you hand them a HoloLens 2 to experience for themselves, they immediately get how it

can be a game-changer. Support for Unreal Engine in HoloLens 2 only increases the value we can offer, enabling

us to deliver visually stunning experiences that are sure to satisfy even the most demanding clients.”

Download the Ford GT40 app

Check out our introduction to Mixed Reality development on HoloLens 2 or MRTK for Unreal on GitHub.

https://www.microsoft.com/p/ford-gt40/9p4vllktfvfp
https://github.com/microsoft/MixedRealityToolkit-Unreal
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 Deploying to device from the Unreal editor

There are two ways to deploy an Unreal application to HoloLens 2:

Directly from the Unreal editor

As a package uploaded via the device portal

Both options require you to set up your HoloLens to use the device portal for development.

1. Select the dropdown arrow next to the LaunchLaunch button. Initially, the HoloLens device option will be grayed

out.

2. Open the Device ManagerDevice Manager  and note that your HoloLens won't automatically appear in the device list.

3. Expand the Add An Unlisted DeviceAdd An Unlisted Device section.

4. Select HoloLensHoloLens  as your PlatformPlatform .

5. Enter your devices' IP address and port information separated by a colon as the device identifier. For

example, "127.0.0.1:10080" (when connected via USB). Use your Device Portal username and password

credentials.

6. Hit AddAdd and close the device manager.

If there's an error, such as wrong address or user credentials, a message will print to the Output Log.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-deploying.md


NOTENOTE

 Deploying to device via device portal

 Next Development Checkpoint

7. Select the dropdown arrow next to the LaunchLaunch button again - this time you should see the HoloLens device

you just added. Select the HoloLens device to build and deploy to your HoloLens.

Building for the device may involve recompiling shaders (especially on the first run)- this can take a while. Don't let the

device go to sleep until the app is running (you may have to wear it). Otherwise shader compilation will fail!

You can find detailed instructions on packaging and deploying an app in the Unreal tutorial series.

If you're following the Unreal development journey we've laid out, you're in the midst of the deployment stage.

From here, you can continue to adding advanced services:

Advanced services

You can always go back to the Unreal development checkpoints at any time.
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 Project settings for the store packaging

When you're ready to get your Unreal app out to the world, there are a few project settings that need updating

before you submit to the Microsoft Store. All of these settings have default values, but should be changed for

production to best represent the application.

1. First, select Project Settings > Descr iptionProject Settings > Descr iption and update the game and publisher information:

The Game NameGame Name will appear in the app tile on the HoloLens

The Company Distinguished NameCompany Distinguished Name is used when generating the project certificate and should be

in the format:

CN=CommonName, O=OrganizationName, L=LocalityName,CN=CommonName, O=OrganizationName, L=LocalityName,

S=StateOrProvinceName, C=Countr yNameS=StateOrProvinceName, C=Countr yName:

2. Expand the HoloLensHoloLens  section of the project settings and update the packaging resources. These resource

names will be shown on the application’s store page:

3. Expand the ImagesImages  section and update the default store images with textures that represent the store app.

Optionally, select the 3D Logo3D Logo checkbox to upload a glb file to use as a 3D live cube when launching the

application:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-publishing-to-store.md


 Optional App Installer

 Windows App Certification Kit

4. Lastly, select Generate NewGenerate New  to generate a signing certificate from the project name and company

distinguished name

Set a Tile Background ColorTile Background Color , which will appear in place of any transparent pixels in the store

images.

Expand the dropdown and enable Use Retail Windows Store EnvironmentUse Retail Windows Store Environment to run on retail-locked,

not dev-unlocked, devices.

An App Installer file can be created from Project Settings > HoloLensProject Settings > HoloLens , which can be used to distribute the

application outside of the store. Enable the Should Create App InstallerShould Create App Installer  checkbox and set a URL or network

path where you'd like the game’s appxbundle to be stored.

When the app is being packaged, both the appxbundle and appinstaller will be generated. Upload the

appxbundle to the installation URL, then launch the appinstaller to install the app from the network location.



C:\Program Files (x86)\Windows Kits\10\App Certification Kit.

The Windows 10 SDK ships with the Windows App Certification Kit (WACK) to validate common issues that

could affect uploading a package to the store. You can find the WACK in the Windows Kits directory, usually

under the following path:

1. After your appx file is packaged for publication, run appcer tui.exeappcer tui.exe and follow the prompts to scan the appx:

2. Select Validate Store AppValidate Store App:

3. Browse for the appx in the top section and select NextNext:



4. Select NextNext to run the tests and create a report:

All available tests that can be run on the host PC will be enabled by default

5. Wait for the tests to finish. Once complete, the final window will show a pass or fail result, which can be

viewed in the saved report.



 Known WACK failure with 4.25
The Windows Mixed Reality plugin in Unreal 4.25 will fail WACK because some x64 binaries are included while

packaging for HoloLens. The failure will look like this:

To fix the issue:

1. Browse to the Unreal installation or source directory root by opening an Unreal project and right-click on the

Unreal icon in the taskbar.

2. Right-click on UE4Editor, select properties, and browse to the path in the LocationLocation entry:



Open 
Engine\Plugins\Runtime\WindowsMixedReality\Source\WindowsMixedRealityHMD\WindowsMixedRealityHMD.Build.cs.

if(Target.Platform != UnrealTargetPlatform.Win32)

if(Target.Platform == UnrealTargetPlatform.Win64)

 See also

3. In WindowsMixedRealityHMD.Build.csWindowsMixedRealityHMD.Build.cs , modify line 32line 32  from:

to:

4. Close Unreal, reopen the project, and repackage for HoloLens. Rerun WACK and the error will be gone.

Submitting an app to the Microsoft Store

Windows App Certification Kit

Create an App Installer file manually

https://developer.microsoft.com/windows/downloads/app-certification-kit
https://docs.microsoft.com/en-us/windows/msix/app-installer/how-to-create-appinstaller-file
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 Mixed Reality applications on the web

NOTENOTE

W EB XR F EAT UREW EB XR F EAT URE AVA IL A B IL IT YAVA IL A B IL IT Y

WebXR Device API (w3.org) Edge 81 on Windows Desktop 
Edge 91 on Hololens 2

WebXR Augmented Reality Module - Level 1 (w3.org) Edge 91. Hololens 2 only

WebXR Hand Input Module - Level 1 (w3.org) Edge 93. Hololens 2 only

WebXR Anchors Module (immersive-web.github.io) Edge 93. Hololens 2 only

WebXR Hit Test Module (immersive-web.github.io) Edge 93. Hololens 2 only

  Viewing WebXRViewing WebXR

 What can I use to develop immersive Web experiences?

JavaScript is one of the most popular programming languages in the world! It's simple, lightweight, and widely

used on the Web. Leverage the power of your JavaScript and Web skills to create more engaging Mixed Reality

experiences.

Mixed Reality features are available on the Web through WebXR. You can see virtual reality (VR) and augmented

reality (AR) content in a compatible WebXR-enabled browser without installing any additional software or

plugins. You can use that same browser with a physical device like the HoloLens 2.

The WebXR Device APIWebXR Device API is for accessing virtual reality (VR) and augmented reality (AR) devices, including

sensors and head-mounted displays, on the Web. The WebXR Device API is available on Microsoft Edge and

Chrome version 79, and later versions support WebXR as a default. You can check the latest browser support

status for WebXR at caniuse.com.

WebVRWebVR is deprecated and is not available in current browsers, so it should not be used for any new development. You'll

need to migrate any existing WebVRWebVR implementations forward to WebXRWebXR.

You can view WebXR experiences in Windows Mixed Reality with the new Microsoft Edge and Firefox Reality

browsers. To test if your browser supports WebXR, you can navigate to WebXR Samples in your browser.

The following list shows the JavaScript frameworks and APIs for building immersive experiences that currently

dominate the market and are widely accepted and adopted by mixed reality JavaScript developers:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/javascript/webxr-overview.md
https://www.w3.org/TR/webxr/
https://caniuse.com/#search=webxr
https://www.w3.org/TR/webxr/
https://www.w3.org/TR/webxr-ar-module-1/
https://www.w3.org/TR/webxr-hand-input-1/
https://immersive-web.github.io/anchors/
https://immersive-web.github.io/hit-test/
https://mixedreality.mozilla.org/firefox-reality/
https://immersive-web.github.io/webxr-samples/


F RA M EW O RKF RA M EW O RK EXA M P L EEXA M P L E

Babylon.jsBabylon.js

Babylon is a JavaScript 3D engine that makes developing 3D
content and immersive applications easy. Before getting
started with immersive applications, we recommend that
you learn the basics of Babylon.js development.

- Learn how to build 3D applications with Babylon.js: Getting
started
- Play with 3D examples and their source code using
Babylon.js: Playground
- Dive deeper into WebXR
- Learn how to get started with our tutorials: Create your
first "Hello World!" app

A-FrameA-Frame 

A-frame is a declarative JavaScript framework that you can
use to get started with Virtual Reality on the Web. To learn
more, check out the A-Frame documentation

Three.jsThree.js  

Three.js is a popular 3D library for creating immersive
experiences. Learn more about three.js and explore
examples.

WebGLWebGL  

You can access the WebXR Device APIs directly by using
WebGL APIs. WebGL (Web Graphics Library) is a JavaScript
API for rendering high-performance interactive 3D and 2D
graphics within any compatible Web browser without the
use of plug-ins.

 See Also

 Next steps--Tutorials

WebXR Device API specification

WebXR Device API documentation

WebXR Samples

Immersiveweb.dev

Using Babylon.js to create WebXR experiences

WebGL API

Gamepad API and Gamepad Extensions

Windows Mixed Reality and the new Microsoft Edge

Handling Lost Context in WebGL

Pointerlock

glTF

Immersive web community group

Immersive Web W3C Github

https://doc.babylonjs.com/
https://doc.babylonjs.com/start
https://doc.babylonjs.com/examples/
https://doc.babylonjs.com/divingDeeper/webXR
https://aframe.io/
https://aframe.io/docs/1.2.0/introduction/
https://threejs.org
https://threejs.org/docs/index.html#manual/en/introduction/Creating-a-scene
https://threejs.org/examples/#webgl_animation_cloth
https://developer.mozilla.org/en-US/docs/Web/API/WebGL_API
https://immersive-web.github.io/webxr/
https://developer.mozilla.org/en-US/docs/Web/API/WebXR_Device_API
https://immersive-web.github.io/webxr-samples/
https://immersiveweb.dev/
https://doc.babylonjs.com/how_to/introduction_to_webxr
https://docs.microsoft.com/en-us/previous-versions/windows/internet-explorer/ie-developer/dev-guides/bg182648(v=vs.85)
https://msdn.microsoft.com/library/dn743630(v=vs.85).aspx
https://w3c.github.io/gamepad/extensions.html
https://www.khronos.org/webgl/wiki/HandlingContextLost
https://www.w3.org/TR/pointerlock/
https://www.khronos.org/gltf
https://www.w3.org/community/immersive-web/
https://github.com/immersive-web


Create your first WebXR application using Babylon.js

Build a piano in WebXR using Babylon.js
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 Prerequisites

 Getting started

NOTENOTE

This tutorial will show you how to create a basic Mixed Reality app using Babylon.js and Visual Studio Code. The

app you're going to build will render a cube, let you rotate it to bring the other faces into view, and add

interactions. In this tutorial, you learn how to:

Set up a development environment

The Babylon.js API to create basic 3D elements

Create a new web page

Interact with 3D elements

Run the application in a Windows Mixed Reality Simulator

WebXR-supported browser, for example Microsoft Edge

Babylon.js 4.2 or higher

NodeJS

Optional: Windows 10 Creator Update if you want to use a Windows Mixed Reality Simulator

Optional: Windows Mixed Reality simulator

To create this project from scratch, start with a Visual Studio Code (VSCode) project.

Using VSCode isn't mandatory, but we'll be using it for convenience throughout the tutorial. More experienced JavaScript

developers can use any other editor of their choice, even the simplest Notepad.

<html>
    <head>
        <title>Babylon.js sample code</title>
        <script src="https://cdn.babylonjs.com/babylon.js"></script>
    </head>
<body>
</body>
</html>

1. Either download the Babylon.js single file or use an online version that can be found on the official

Babylon.js web site. You can also clone the entire Babylon.js project from GitHub

2. Create an empty file and save it as html page, for example index.html

3. Create a basic html markup and reference the Babylon.js javascript file. The final code is as shown below:

4. Add a canvas HTML element inside the body to render the contents of Babylon.js. Note that the canvas

has an id attribute, which lets you access this HTML element from JavaScript later on.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/javascript/tutorials/babylonjs-webxr-helloworld/introduction-01.md
https://doc.babylonjs.com/divingDeeper/developWithBjs/frameworkVers
https://nodejs.org/
https://www.microsoft.com/software-download/windows10
https://doc.babylonjs.com/divingDeeper/developWithBjs/frameworkVers
https://doc.babylonjs.com/divingDeeper/developWithBjs/frameworkVers
https://github.com/BabylonJS/Babylon.js


 Next steps

<html>
    <head>
        <title>Babylon.js sample code</title>
        <script src="https://cdn.babylonjs.com/babylon.js"></script>
        <style>
            body,#renderCanvas { width: 100%; height: 100%;}
        </style>
    </head>
<body>
    <canvas id="renderCanvas"></canvas>
</body>
</html>

5. The canvas occupies the entire web page. That completes our web page. At this point, the web page is

ready. You can open it in any browser and ensure there are no errors shown, though there is no

immersive experience yet.

Next Tutorial: 2. Prepare a scene



   

 

Tutorial: Prepare a scene
 7/6/2022 • 3 minutes to read • Edit Online

 Before you begin

<html>
    <head>
        <title>Babylon.js sample code</title>
        <script src="https://cdn.babylonjs.com/babylon.js"></script>
        <style>
            body,#renderCanvas { width: 100%; height: 100%;}
        </style>
    </head>
<body>
    <canvas id="renderCanvas"></canvas>
</body>
</html>

 Create a scene

Learn how to prepare a scene, and add some basic 3D elements to it.

In this tutorial, learn how to:

Create a scene

Add a camera

Add light

Add basic 3D elements

In previous tutorial step a basic web page was created. Have the web page open for editing.

A scene is where all the contents will be displayed. There might be multiple scenes and it is possible to switch

between scenes. Read more about Babylon.js Scene.

<script type="text/javascript">
    const canvas = document.getElementById("renderCanvas");
    const engine = new BABYLON.Engine(canvas, true);

    const createScene = function() {
        const scene = new BABYLON.Scene(engine);
        scene.clearColor = new BABYLON.Color3.Black;
        return scene;
    }

    const sceneToRender = createScene();
</script>

1. Add the script tag after the canvas html element and add the following code to create a scene filled in

black color :

In the code above we have to create an instance of Babylon.js web rendering engine that renders a scene

and hooks events on the canvas. For more information about the engine, check the documentation page

babylon.engine

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/javascript/tutorials/babylonjs-webxr-helloworld/prepare-scene-02.md
https://doc.babylonjs.com/divingDeeper/scene
https://doc.babylonjs.com/typedoc/classes/babylon.engine


 Add basic 3D element

 Add a camera

engine.runRenderLoop(function () {
    sceneToRender.render();
});

2. The scene is not rendered by default. Remember, there might be multiple scenes and you control which

scene is displayed. To render the scene repeatedly on every frame, execute the following code after the

call to createScene function:

const box = BABYLON.MeshBuilder.CreateBox("box", {});
box.position.x = 0.5;
box.position.y = 1;

1. Let's add our first 3D shape. In the 3D virtual world shapes are built from meshes, lots of triangular facets

joined together, each facet made from three vertices. You can either use a predefined mesh or create your

own custom mesh. Here we will be using a predefined box mesh, i.e. a cube. To create the box use

BABYLON.MeshBuilder.CreateBox. The parameters are name, and options (options are different according

to the type of mesh). Append the following code to the function createScene:

2. Open the web page in the Microsoft Edge browser and check the output. The browser window shows a

blank page. Open DevTools by using the keyboard and select F12 or Control+Shift+I (Windows, Linux) or

Command+Option+I (macOS). After opening the Console tab, you can start looking for errors. There will

be an error displayed: 'Uncaught Error : No camera defined'. Now we have to add a camera to the scene.

const alpha =  Math.PI/4;
const beta = Math.PI/3;
const radius = 8;
const target = new BABYLON.Vector3(0, 0, 0);

const camera = new BABYLON.ArcRotateCamera("Camera", alpha, beta, radius, target, scene);
camera.attachControl(canvas, true);

1. In order to view the virtual world and interact with it, a camera must be attached to the canvas. Let's add

the camera of type BABYLON.ArcRotateCamera, which can be rotated around a target. The parameters

required to create an instance of the camera are:

a. namename: name of the camera

b. alphaalpha: angular position along the longitudinal axis (in radians)

c. betabeta: angular position along the latitudinal axis (in radians)

d. radiusradius : distance from the target

e. targettarget: the point that the camera would always face towards (defined by x-y-z coordinates)

f. scenescene: the scene that the camera is in

Alpha, beta, radius, and target together define the camera's position in the space, as shown in the

diagram below:

Add the following code to the createScene function:

2. If you check the output in the browser, you will see a black canvas. We are missing the light.

https://doc.babylonjs.com/divingDeeper/mesh/creation/set/box
https://doc.babylonjs.com/divingDeeper/cameras/camera_introduction#arc-rotate-camera


 Add light

const light = new BABYLON.HemisphericLight("light", new BABYLON.Vector3(1, 1, 0));

<html>
<head>
    <script src="https://cdn.babylonjs.com/babylon.js"></script>
    <style>
        body,#renderCanvas { width: 100%; height: 100%;}
    </style>
</head>
<body>
    <canvas id="renderCanvas"></canvas>
    <script>
        const canvas = document.getElementById("renderCanvas");
        const engine = new BABYLON.Engine(canvas, true);

        const createScene = function() {
            const scene = new BABYLON.Scene(engine);
            scene.clearColor = new BABYLON.Color3.Black;

            const alpha =  Math.PI/4;
            const beta = Math.PI/3;
            const radius = 8;
            const target = new BABYLON.Vector3(0, 0, 0);

            const camera = new BABYLON.ArcRotateCamera("Camera", alpha, beta, radius, target, scene);
            camera.attachControl(canvas, true);

            const light = new BABYLON.HemisphericLight("light", new BABYLON.Vector3(1, 1, 0));

            const box = BABYLON.MeshBuilder.CreateBox("box", {});
            box.position.x = 0.5;
            box.position.y = 1;

            return scene;
        };

        const sceneToRender = createScene();
        engine.runRenderLoop(function(){
            sceneToRender.render();
        });
    </script>
</body>
</html>

1. There are four types of lights that can be used with a range of lighting properties: Point, Directional, Spot

and Hemispheric Light. Let's add the ambient light HemisphericLight, as follows:

2. The final code of the web page will look as follows:

3. Check the output in the browser. You should see the cube and using the mouse you can rotate the camera

around the cube and see the different faces of the cube:

https://doc.babylonjs.com/typedoc/classes/babylon.hemisphericlight


 Next steps
Next Tutorial: 3. Interact with 3D object



   

 

Tutorial: Interact with 3D object
 7/6/2022 • 7 minutes to read • Edit Online

 Before you begin

<html>
<head>
    <script src="https://cdn.babylonjs.com/babylon.js"></script>
    <style>
        body,#renderCanvas { width: 100%; height: 100%;}
    </style>
</head>
<body>
    <canvas id="renderCanvas"></canvas>
    <script>
        const canvas = document.getElementById("renderCanvas");
        const engine = new BABYLON.Engine(canvas, true);
        
        const createScene = function() {
            const scene = new BABYLON.Scene(engine);
            scene.clearColor = new BABYLON.Color3.Black;
            
            const alpha =  Math.PI/4;
            const beta = Math.PI/3;
            const radius = 8;
            const target = new BABYLON.Vector3(0, 0, 0);
            
            const camera = new BABYLON.ArcRotateCamera("Camera", alpha, beta, radius, target, scene);
            camera.attachControl(canvas, true);
            
            const light = new BABYLON.HemisphericLight("light", new BABYLON.Vector3(1, 1, 0));
            
            const box = BABYLON.MeshBuilder.CreateBox("box", {});
            box.position.x = 0.5;
            box.position.y = 1;
            
            return scene;
        };
        
        const sceneToRender = createScene();
        engine.runRenderLoop(function(){
            sceneToRender.render();
        });
    </script>
</body>
</html>

Learn how to create 3D objects and interactions for a Mixed Reality experience using Babylon.js. In this section,

you'll start with something simple, like painting the faces of a cube when you select the object.

This tutorial covers the following topics:

How to add interactions

Enable WebXR immersive mode

Run the app on Windows Mixed Reality Simulator

Run and debug the app on Android Chrome

In previous tutorial step a basic web page with a scene was created. Have the hosting web page open for editing.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/javascript/tutorials/babylonjs-webxr-helloworld/interact-03.md


 Add interaction

const boxMaterial = new BABYLON.StandardMaterial("material", scene);
boxMaterial.diffuseColor = BABYLON.Color3.Random();
box.material = boxMaterial;

box.actionManager = new BABYLON.ActionManager(scene);
box.actionManager.registerAction(new BABYLON.ExecuteCodeAction(
    BABYLON.ActionManager.OnPickTrigger, 
    function (evt) {
        const sourceBox = evt.meshUnderPointer;

        //move the box upright
        sourceBox.position.x += 0.1;
        sourceBox.position.y += 0.1;

        //update the color
        boxMaterial.diffuseColor = BABYLON.Color3.Random();
    }));

1. First, let's update our code that creates the cube, so that the cube is painted with a random color. To do

that, we will add material to our cube. Material allows us to specify color and textures and can be used to

cover other objects. How a material appears depends on the light or lights used in the scene and how it is

set to react. For example, the diffuseColor spreads the color all over the mesh to which it is attached. Add

the following code:

2. Now that the cube is painted with a random color, let's add an interaction to:

Change the color when the cube is clicked

Move the cube after the color is changed

To add interactions we should be using actions. An action is launched in response to the event trigger. For

example, when the user clicks on the cube. All we need to do is instantiate BABYLON.ActionManager and

register an action for certain trigger. The BABYLON.ExecuteCodeAction will run our JavaScript function

when someone clicks on the cube:

3. The final code of the web page will look as follows:

https://doc.babylonjs.com/divingDeeper/materials/using/materials_introduction
https://doc.babylonjs.com/divingDeeper/events/actions
https://doc.babylonjs.com/typedoc/classes/babylon.executecodeaction


 Enable WebXR immersive experience

<html>
<head>
    <script src="https://cdn.babylonjs.com/babylon.js"></script>
    <style>
        body,#renderCanvas { width: 100%; height: 100%;}
    </style>
</head>
<body>
    <canvas id="renderCanvas"></canvas>
    <script>
        const canvas = document.getElementById("renderCanvas");
        const engine = new BABYLON.Engine(canvas, true);

        const createScene = function() {
            const scene = new BABYLON.Scene(engine);
            scene.clearColor = new BABYLON.Color3.Black;

            const alpha =  Math.PI/4;
            const beta = Math.PI/3;
            const radius = 8;
            const target = new BABYLON.Vector3(0, 0, 0);

            const camera = new BABYLON.ArcRotateCamera("Camera", alpha, beta, radius, target, scene);
            camera.attachControl(canvas, true);

            const light = new BABYLON.HemisphericLight("light", new BABYLON.Vector3(1, 1, 0));

            const box = BABYLON.MeshBuilder.CreateBox("box", {});
            box.position.x = 0.5;
            box.position.y = 1;

            const boxMaterial = new BABYLON.StandardMaterial("material", scene);
            boxMaterial.diffuseColor = BABYLON.Color3.Random();
            box.material = boxMaterial;

            box.actionManager = new BABYLON.ActionManager(scene);
            box.actionManager.registerAction(
                new BABYLON.ExecuteCodeAction(BABYLON.ActionManager.OnPickTrigger, 
                function (evt) {
                    const sourceBox = evt.meshUnderPointer;
                    sourceBox.position.x += 0.1;
                    sourceBox.position.y += 0.1;

                    boxMaterial.diffuseColor = BABYLON.Color3.Random();
                }));

            return scene;
        };

        const sceneToRender = createScene();
        engine.runRenderLoop(function(){
            sceneToRender.render();
        });
    </script>
</body>
</html>

Now that our cube is changing colors, we're ready to try the immersive experience.

1. In this step we're going to introduce a ground. The cube will be hanging in the air and we will see a floor

at the bottom. Add the ground as follows:

https://doc.babylonjs.com/divingDeeper/mesh/creation/set/ground


const ground = BABYLON.MeshBuilder.CreateGround("ground", {width: 4, height: 4});

const xrPromise = scene.createDefaultXRExperienceAsync({
    floorMeshes: [ground]
});
return xrPromise.then((xrExperience) => {
    console.log("Done, WebXR is enabled.");
    return scene;
});

createScene().then(sceneToRender => {
    engine.runRenderLoop(() => sceneToRender.render());
});

This creates a simple 4x4-meter floor.

2. In order to add WebXR support, we need to call createDefaultXRExperienceAsync, which has a Promise

result. Add this code at the end of createScene function instead of return scene;:

3. Since the createScene function is now returning a promise instead of a scene, we need to modify how

createScene and engine.runRenderLoop are called. Replace the current calls of these functions, which are

located right before the </script> tag, with the code below:

4. The final code of the web page will look as follows:



<html>
<head>
    <script src="https://cdn.babylonjs.com/babylon.js"></script>
    <style>
        body,#renderCanvas { width: 100%; height: 100%;}
    </style>
</head>
<body>
    <canvas id="renderCanvas"></canvas>
    <script>
        const canvas = document.getElementById("renderCanvas");
        const engine = new BABYLON.Engine(canvas, true);

        const createScene = function() {
            const scene = new BABYLON.Scene(engine);
            scene.clearColor = new BABYLON.Color3.Black;

            const alpha =  Math.PI/4;
            const beta = Math.PI/3;
            const radius = 8;
            const target = new BABYLON.Vector3(0, 0, 0);

            const camera = new BABYLON.ArcRotateCamera("Camera", alpha, beta, radius, target, scene);
            camera.attachControl(canvas, true);

            const light = new BABYLON.HemisphericLight("light", new BABYLON.Vector3(1, 1, 0));

            const box = BABYLON.MeshBuilder.CreateBox("box", {});
            box.position.x = 0.5;
            box.position.y = 1;

            const boxMaterial = new BABYLON.StandardMaterial("material", scene);
            boxMaterial.diffuseColor = BABYLON.Color3.Random();
            box.material = boxMaterial;

            box.actionManager = new BABYLON.ActionManager(scene);
            box.actionManager.registerAction(
                new BABYLON.ExecuteCodeAction(BABYLON.ActionManager.OnPickTrigger, 
                function (evt) {
                    const sourceBox = evt.meshUnderPointer;
                    sourceBox.position.x += 0.1;
                    sourceBox.position.y += 0.1;

                    boxMaterial.diffuseColor = BABYLON.Color3.Random();
                }));

            const ground = BABYLON.MeshBuilder.CreateGround("ground", {width: 4, height: 4});

            const xrPromise = scene.createDefaultXRExperienceAsync({
                floorMeshes: [ground]
            });

            return xrPromise.then((xrExperience) => {
                console.log("Done, WebXR is enabled.");
                return scene;
            });
        };

        createScene().then(sceneToRender => {
            engine.runRenderLoop(() => sceneToRender.render());
        });
    </script>
</body>
</html>

5. The above code generates the following output in the browser window: 



 Run on a Windows Mixed Reality Simulator
1. Enable the Windows Mixed Reality Simulator if you have not done so in the past.

2. Select the Immersive-VR button on the bottom right corner : 

3. This action will launch the Windows Mixed Reality Simulator window as shown below: 

4. Use the W,A,S, and D keys on your keyboard to walk forward, back left and right accordingly. Use



NOTENOTE

 Run and debug on Android device

  PrerequisitesPrerequisites

simulated hand to target the cube and press the Enter key on your keyboard to perform the click action.

The cube will change its color and move to a new position.

When targeting the cube, make sure that the end of hand ray (white circle) intersects with the cube as shown on the

picture above. Learn more about Point and commit with hands.

Perform the following steps to enable debugging on your Android device:

A web server that serves static html page in secure context (https:// or via Port forwarding on localhost)

on development machine. For example leverage serve npm package as simple lightweight web server

that serves static html files, check more npm serve

The device originally shipped with the Google Play Store and must be running Android 7.0 or newer

The latest version of Google Chrome on both the development workstation and on the device

To verify that the device is correctly configured to run WebXR, browse to a sample WebXR page on the

device. You should see the message, such as:

Your browser supports WebXR and can run Virtual Reality and Augmented Reality experiences if you

have the appropriate hardware.

serve

1. Enable developer mode and USB debugging on an Android device. See how to do this for your version of

Android at the official documentation page Configure on-device developer options

2. Next, connect Android device to your development machine or laptop via USB cable

3. Ensure that the web server on the development machine is running. For example, navigate to the root

folder containing your web hosting page (index.html) and execute the following code (assuming you use

serve npm package):

4. Open Google Chrome on your development machine and enter in the address bar the following text:

chrome://inspect#devices 

https://github.com/vercel/serve#readme
https://support.google.com/chrome/answer/95346
https://immersive-web.github.io/webxr-samples/
https://developer.android.com/studio/debug/dev-options


5. Ensure that the Discover USB devices checkbox is enabled

6. Click the button Port forwarding and ensure that Port forwarding is enabled and contains an entry

localhost:5000 as shown below: 

7. In your connected Android device open a Google Chrome window and browse to http://localhost:5000

and you should see the cube

8. On your development machine, in Chrome, you will see your device and a list of web pages currently

opened in there: 



 Takeaways

9. Click the button Inspect next to an entry http://localhost:5000: 

10. Use the Chrome DevTools to debug the page

The following are the most important takeaways from this tutorial:

Babylon.js makes it easy to create immersive experiences using JavaScript

https://developers.google.com/web/tools/chrome-devtools


 Next steps

To create virtual scenes you don't need to write low-level code or learn a new technology

You can build Mixed Reality applications with WebXR-supported browser without need to buy a headset

Congratulations! You've completed our series of Babylon.js tutorials and learned how to:

Set up a development environment

Create a new web page to display results

The Babylon.js API to create and interact with basic 3D elements

Run and test the application in a Windows Mixed Reality Simulator

For more information on Mixed Reality JavaScript development see JavaScript development overview.

If you're looking for another Babylon.js tutorial, checkout the Piano-building Tutorial Series to learn how to build

a piano in the VR space using Babylon.js.

https://docs.microsoft.com/en-us/javascript-development-overview.md


   

 

Tutorial: Build a piano in WebXR using Babylon.js
 7/6/2022 • 4 minutes to read • Edit Online

 Prerequisites

 Getting started

Building a piano in the real world requires much in the way of time, skills, and materials. What about building

one for the VR/AR world?

In this tutorial series, you'll learn how to use Babylon.js to create a Mixed Reality web app that contains a

functioning 88-key standup piano in the virtual world. In the completed app, you'll be able to teleport to the

piano and play the keys using your mixed reality controllers.

In this tutorial series, you'll learn how to:

Create, position, and merge meshes to build a piano keyboard

Import a Babylon.js model of a standup piano frame

Add pointer interactions to each piano key

Enable teleportation and multipointer support in WebXR

A computer connected to the internet

Basic Javascript Knowledge

WebXR Javascript Hello World Tutorial

WebXR-supported browser, for example Microsoft Edge

Babylon.js 4.2 or higher

Any VR headset or Windows Mixed Reality simulator

Optional: Windows 10 Creator Update if you want to use a Windows Mixed Reality Simulator

Let's begin by setting up the HTML web page that will contain the Babylon.js scene.

NOTENOTE

1. Create a folder named babylonjs-piano-tutorial and open the folder in Visual Studio Code.

While you can use any code editor to follow along, we'll be using Visual Studio Code throughout this tutorial for

convenience.

2. Within the folder, create a file named index.html and insert the template below into the file:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/javascript/tutorials/babylonjs-webxr-piano/introduction-01.md
https://doc.babylonjs.com/divingDeeper/developWithBjs/frameworkVers
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://www.microsoft.com/software-download/windows10


 Setup the scene

<html>
    <head>
        <title>Piano in BabylonJS</title>
        <script src="https://cdn.babylonjs.com/babylon.js"></script>
        <style>
            body,#renderCanvas { width: 100%; height: 100%;}
        </style>
    </head>
    <body>
        <canvas id="renderCanvas"></canvas>
        <script type="text/javascript">
            const canvas = document.getElementById("renderCanvas"); 
            const engine = new BABYLON.Engine(canvas, true); 

            createScene(engine).then(sceneToRender => {
                engine.runRenderLoop(() => sceneToRender.render());
            });

            // Watch for browser/canvas resize events
            window.addEventListener("resize", function () {
                engine.resize();
            });
        </script>
    </body>
</html>

If you need more explanation on the content of this template, see the Hello World Tutorial, which is a

prerequisite of this tutorial.

3. If you try to open this file in a browser, the console shows an error indicating that the createScene()

function isn't found. Let's resolve this error by implementing the function createScene()  in the next

section.

const createScene = async function(engine) {
    const scene = new BABYLON.Scene(engine);
    return scene;
}

1. In the same folder as index.html, create another file named scene.js. We'll store all of the javascript code

related to setting up the scene and creating the piano in this file.

2. Let's add the createScene()  function into scene.js:

Note that we're making createScene()  an async function. Stay tuned to find out why.

3. Next, we'll need a light and a camera to make the scene visible to us. Update the createScene()  function:



const createScene = async function(engine) {
    const scene = new BABYLON.Scene(engine);

    const alpha =  3*Math.PI/2;
    const beta = Math.PI/50;
    const radius = 220;
    const target = new BABYLON.Vector3(0, 0, 0);

    const camera = new BABYLON.ArcRotateCamera("Camera", alpha, beta, radius, target, scene);
    camera.attachControl(canvas, true);

    const light = new BABYLON.HemisphericLight("light", new BABYLON.Vector3(0, 1, 0), scene);
    light.intensity = 0.6;

    return scene;
}

const xrHelper = await scene.createDefaultXRExperienceAsync();

const createScene = async function(engine) {
    const scene = new BABYLON.Scene(engine);

    const alpha =  3*Math.PI/2;
    const beta = Math.PI/50;
    const radius = 220;
    const target = new BABYLON.Vector3(0, 0, 0);

    const camera = new BABYLON.ArcRotateCamera("Camera", alpha, beta, radius, target, scene);
    camera.attachControl(canvas, true);

    const light = new BABYLON.HemisphericLight("light", new BABYLON.Vector3(0, 1, 0), scene);
    light.intensity = 0.6;

    const xrHelper = await scene.createDefaultXRExperienceAsync();

    return scene;
}

Here, we have created an ArcRotateCamera, which points almost completely downwards and targets the

origin point of the space. The light we have created is a HemisphericLight that points to the sky and is

useful for simulating an ambient space. We've also dimmed the light a little by lowering its intensity.

If you need a refresher on how to create a camera and a light, revisit the Prepare Scene section of the

Hello World Tutorial Series before proceeding to the next step.

4. Finally, since we are developing for a WebXR platform, we will need to enable the XR experience in the

scene by inserting the following line before return scene; :

In javascript, in order to use the await  keyword on an async  function within a function, the parent

function would also have to be async , which is why we defined createScene  function as async earlier.

Later in this tutorial series, we will be using this xrHelper  to enable and configure different WebXR

features supported by Babylon.js.

5. The completed scene.js should look like this:

6. Now that we have a working createScene()  function, let's have index.html load the scene.js file as a script

so that the createScene()  function is recognized in index.html. Add this line of code within the <header>

section of the html file:

https://doc.babylonjs.com/divingDeeper/cameras/camera_introduction#arc-rotate-camera
https://doc.babylonjs.com/divingDeeper/lights/lights_introduction#the-hemispheric-light
https://doc.babylonjs.com/divingDeeper/webXR/introToWebXR


 Next steps

<html>
    <head>
        <title>Piano in BabylonJS</title>
        <script src="https://cdn.babylonjs.com/babylon.js"></script>
        <script src="scene.js"></script>
        <style>
            body,#renderCanvas { width: 100%; height: 100%;}
        </style>
    </head>
    <body>
        <canvas id="renderCanvas"></canvas>
        <script type="text/javascript">
            const canvas = document.getElementById("renderCanvas");
            const engine = new BABYLON.Engine(canvas, true); 

            createScene(engine).then(sceneToRender => {
                engine.runRenderLoop(() => sceneToRender.render());
            });

            // Watch for browser/canvas resize events
            window.addEventListener("resize", function () {
                engine.resize();
            });
        </script>
    </body>
</html>

7. Open index.html in your browser, and you will find that the error message we saw earlier is no longer

present, and we have an empty Babylon.js scene in the page.

Next tutorial: Build a 3D piano model



   

 

Tutorial: Build a 3D piano model
 7/6/2022 • 17 minutes to read • Edit Online

 Before you begin

In the previous tutorial in the series, we have setup a web page containing a Babylon.js scene with a camera and

a light. In this tutorial, we will be building and adding a piano model into the scene.

In this tutorial, you will learn how to:

Create, position, and merge meshes

Build a piano keyboard from box meshes

Import a 3D model of a piano frame

Make sure that you have gone through the previous tutorial in the series and are ready to continue adding to

the code.

index.html

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/javascript/tutorials/babylonjs-webxr-piano/keyboard-model-02.md


<html>
    <head>
        <title>Piano in BabylonJS</title>
        <script src="https://cdn.babylonjs.com/babylon.js"></script>
        <script src="scene.js"></script>
        <style>
            body,#renderCanvas { width: 100%; height: 100%;}
        </style>
    </head>
    <body>
        <canvas id="renderCanvas"></canvas>
        <script type="text/javascript">
            const canvas = document.getElementById("renderCanvas");
            const engine = new BABYLON.Engine(canvas, true); 

            createScene(engine).then(sceneToRender => {
                engine.runRenderLoop(() => sceneToRender.render());
            });
            
            // Watch for browser/canvas resize events
            window.addEventListener("resize", function () {
                engine.resize();
            });
        </script>
    </body>
</html>

const createScene = async function(engine) {
    const scene = new BABYLON.Scene(engine);

    const alpha =  3*Math.PI/2;
    const beta = Math.PI/50;
    const radius = 220;
    const target = new BABYLON.Vector3(0, 0, 0);
    
    const camera = new BABYLON.ArcRotateCamera("Camera", alpha, beta, radius, target, scene);
    camera.attachControl(canvas, true);
    
    const light = new BABYLON.HemisphericLight("light", new BABYLON.Vector3(0, 1, 0), scene);
    light.intensity = 0.6;

    const xrHelper = await scene.createDefaultXRExperienceAsync();

    return scene;
}

 Getting started

scene.js

Let's begin by making a simple piano keyboard which has this structure:



 Build a simple piano keyboard

NOTENOTE

In this image, there are 7 white keys and 5 black keys, each labeled with the note's name. A full 88-key piano

keyboard contains 7 full repetitions of this selection of keys (also called a register) and 4 extra keys. Every

register has double the frequency of its previous register. For example, the pitch frequency of C5 (which means

the C note in the fifth register) is double of C4's, D5's pitch frequency is double of D4's, and so on.

Visually, each register looks exactly the same as another, so we can start with investigating how to create a

simple piano keyboard with this selection of keys. Later, we can find a way to expand the scope to an 88-key full

piano keyboard.

While it is possible to find pre-made 3D models of piano keyboards from online sources and import them into our

webpage, we will build the keyboard from scratch in this tutorial to allow maximum customizability and to showcase how

3D models can be created through Babylon.js.

1. Before we begin to create any meshes for building the keyboard, notice that each black key is not

perfectly aligned at the middle of the two white keys around it, and not every key has the same width.

This means that we must create and position the mesh for each key individually.

2. For white keys, we can make an observation that each white key is composed of two parts: (1) the bottom

part below the black key(s) and (2) the top part next to the black key(s). The two parts have different

dimensions but are stacked together to crete a full white key.



const whiteKeyBottom = BABYLON.MeshBuilder.CreateBox("whiteKeyBottom", {width: 2.3, height: 1.5, 
depth: 4.5}, scene);
const whiteKeyTop = BABYLON.MeshBuilder.CreateBox("whiteKeyTop", {width: 1.4, height: 1.5, depth: 5}, 
scene);
whiteKeyTop.position.z += 4.75;
whiteKeyTop.position.x -= 0.45;

// Parameters of BABYLON.Mesh.MergeMeshes:
// (arrayOfMeshes, disposeSource, allow32BitsIndices, meshSubclass, subdivideWithSubMeshes, 
multiMultiMaterials)
const whiteKeyV1 = BABYLON.Mesh.MergeMeshes([whiteKeyBottom, whiteKeyTop], true, false, null, false, 
false);
whiteKeyV1.material = whiteMat;
whiteKeyV1.name = "C4";

3. Here is the code for creating a single white key for the note C (don't worry about adding this into scene.js

yet):

Here we created two Box meshes, one for the bottom part and one for the top part of the white key. We

then modify the position of the top part to stack it on top of the bottom part and to move it towards the

left to leave space for the neighboring black key (C#).

Finally, these two parts were merged using the MergeMeshes function to become one complete white

key. This is the resulting mesh that this code would produce:

https://doc.babylonjs.com/divingDeeper/mesh/creation/set/box#box-mesh
https://doc.babylonjs.com/divingDeeper/mesh/mergeMeshes


NOTENOTE

const blackMat = new BABYLON.StandardMaterial("black");
blackMat.diffuseColor = new BABYLON.Color3(0, 0, 0);

const blackKey = BABYLON.MeshBuilder.CreateBox("C#4", {width: 1.4, height: 2, depth: 5}, scene);
blackKey.position.z += 4.75;
blackKey.position.y += 0.25;
blackKey.position.x += 0.95;
blackKey.material = blackMat;

4. Creating a black key is simpler. Since all black keys are of the shape of a box, we can create a black key

just by creating a box mesh with a black-colored StandardMaterial.

Since the default mesh color is a light grey that resembles white, this tutorial doesn't include steps to add a white

color material to the white keys. However, feel free to add the material yourself if you'd like a true, bright white

color on the white keys.

Here is the code to create the black key C# (don't worry about adding this to scene.js either):

The black key produced by this code (along with the previous white key) would look like this:

https://doc.babylonjs.com/divingDeeper/materials/using/materials_introduction#color


 Build a simple piano keyboard efficiently

5. As you can see, creating each key can result in a lot of similar code since we have to specify each of their

dimensions and position. Let's try to make the creation process more efficient in the next section.

1. While each white key has a slightly different shape than each other, all of them can be created by

combining a top part and a bottom part. Let's implement a generic function to create and position any

white key.

Add the function below to scene.js, outside the createScene()  function:



const buildKey = function (scene, parent, props) {
    if (props.type === "white") {
        /*
        Props for building a white key should contain: 
        note, topWidth, bottomWidth, topPositionX, wholePositionX, register, referencePositionX

        As an example, the props for building the middle C white key would be
        {type: "white", note: "C", topWidth: 1.4, bottomWidth: 2.3, topPositionX: -0.45, 
wholePositionX: -14.4, register: 4, referencePositionX: 0}
        */

        // Create bottom part
        const bottom = BABYLON.MeshBuilder.CreateBox("whiteKeyBottom", {width: props.bottomWidth, 
height: 1.5, depth: 4.5}, scene);

        // Create top part
        const top = BABYLON.MeshBuilder.CreateBox("whiteKeyTop", {width: props.topWidth, height: 1.5, 
depth: 5}, scene);
        top.position.z =  4.75;
        top.position.x += props.topPositionX;

        // Merge bottom and top parts
        // Parameters of BABYLON.Mesh.MergeMeshes: (arrayOfMeshes, disposeSource, allow32BitsIndices, 
meshSubclass, subdivideWithSubMeshes, multiMultiMaterials)
        const key = BABYLON.Mesh.MergeMeshes([bottom, top], true, false, null, false, false);
        key.position.x = props.referencePositionX + props.wholePositionX;
        key.name = props.note + props.register;
        key.parent = parent;

        return key;
    }
}

In this block of code, we created a function named buildKey() , which builds and returns a white key if 

props.type  is "white" . By identifying the type of the key in the parameter props , we can create both

black keys and white keys in the same function by branching out using an if-statement.

The parameters of buildKey()  are:

scenescene: scene that the key is in

parentparent: parent of the mesh (this allows us to group all keys together to a single parent)

propsprops : properties of the key that will be built

The props  for a white key will contain the following items:

typetype: "white"

namename: the name of the note which the key represents

topWidthtopWidth: width of the top part

bottomWidthbottomWidth: width of the bottom part

topPositionXtopPositionX: x-position of the top part relative to the bottom part

wholePositionXwholePositionX: x-position of the whole key relative to the end point of the register (the right edge

of key B).

registerregister : register that the key belongs to (a number between 0 and 8)

referencePositionXreferencePositionX: x-coordinate of the end point of the register (used as a reference point).

By separating wholePositionX  and referencePositionX , we are able to initialize the props  parameters

needed to create a specific type of key (e.g. C) within any register, and then add on register  and 

referencePositionX  to the props  when creating that key in a specific register (e.g. C4, C5).

2. Similarly, we can also write a generic function to create a black key. Let's expand the buildKey()  function

to include that logic:



const buildKey = function (scene, parent, props) {
    if (props.type === "white") {
        /*
        Props for building a white key should contain: 
        note, topWidth, bottomWidth, topPositionX, wholePositionX, register, referencePositionX

        As an example, the props for building the middle C white key would be
        {type: "white", note: "C", topWidth: 1.4, bottomWidth: 2.3, topPositionX: -0.45, 
wholePositionX: -14.4, register: 4, referencePositionX: 0}
        */

        // Create bottom part
        const bottom = BABYLON.MeshBuilder.CreateBox("whiteKeyBottom", {width: props.bottomWidth, 
height: 1.5, depth: 4.5}, scene);

        // Create top part
        const top = BABYLON.MeshBuilder.CreateBox("whiteKeyTop", {width: props.topWidth, height: 1.5, 
depth: 5}, scene);
        top.position.z =  4.75;
        top.position.x += props.topPositionX;

        // Merge bottom and top parts
        // Parameters of BABYLON.Mesh.MergeMeshes: (arrayOfMeshes, disposeSource, allow32BitsIndices, 
meshSubclass, subdivideWithSubMeshes, multiMultiMaterials)
        const key = BABYLON.Mesh.MergeMeshes([bottom, top], true, false, null, false, false);
        key.position.x = props.referencePositionX + props.wholePositionX;
        key.name = props.note + props.register;
        key.parent = parent;

        return key;
    }
    else if (props.type === "black") {
        /*
        Props for building a black key should contain: 
        note, wholePositionX, register, referencePositionX

        As an example, the props for building the C#4 black key would be
        {type: "black", note: "C#", wholePositionX: -13.45, register: 4, referencePositionX: 0}
        */

        // Create black color material
        const blackMat = new BABYLON.StandardMaterial("black");
        blackMat.diffuseColor = new BABYLON.Color3(0, 0, 0);

        // Create black key
        const key = BABYLON.MeshBuilder.CreateBox(props.note + props.register, {width: 1.4, height: 
2, depth: 5}, scene);
        key.position.z += 4.75;
        key.position.y += 0.25;
        key.position.x = props.referencePositionX + props.wholePositionX;
        key.material = blackMat;
        key.parent = parent;

        return key;
    }
}

The props  for a black key contains the following items:

typetype: "black"

namename: the name of the note which the key represents

wholePositionXwholePositionX: x-position of the whole key relative to the end point of the register (the right edge

of key B)

registerregister : register that the key belongs to (a number between 0 and 8)



const keyParams = [
    {type: "white", note: "C", topWidth: 1.4, bottomWidth: 2.3, topPositionX: -0.45, wholePositionX: 
-14.4},
    {type: "black", note: "C#", wholePositionX: -13.45},
    {type: "white", note: "D", topWidth: 1.4, bottomWidth: 2.4, topPositionX: 0, wholePositionX: -
12},
    {type: "black", note: "D#", wholePositionX: -10.6},
    {type: "white", note: "E", topWidth: 1.4, bottomWidth: 2.3, topPositionX: 0.45, wholePositionX: -
9.6},
    {type: "white", note: "F", topWidth: 1.3, bottomWidth: 2.4, topPositionX: -0.55, wholePositionX: 
-7.2},
    {type: "black", note: "F#", wholePositionX: -6.35},
    {type: "white", note: "G", topWidth: 1.3, bottomWidth: 2.3, topPositionX: -0.2, wholePositionX: -
4.8},
    {type: "black", note: "G#", wholePositionX: -3.6},
    {type: "white", note: "A", topWidth: 1.3, bottomWidth: 2.3, topPositionX: 0.2, wholePositionX: -
2.4},
    {type: "black", note: "A#", wholePositionX: -0.85},
    {type: "white", note: "B", topWidth: 1.3, bottomWidth: 2.4, topPositionX: 0.55, wholePositionX: 
0},
]

// Transform Node that acts as the parent of all piano keys
const keyboard = new BABYLON.TransformNode("keyboard");

keyParams.forEach(key => {
    buildKey(scene, keyboard, Object.assign({register: 4, referencePositionX: 0}, key));
})

const buildKey = function (scene, parent, props) {
    if (props.type === "white") {
        /*
        Props for building a white key should contain: 
        note, topWidth, bottomWidth, topPositionX, wholePositionX, register, referencePositionX

        As an example, the props for building the middle C white key would be
        {type: "white", note: "C", topWidth: 1.4, bottomWidth: 2.3, topPositionX: -0.45, 
wholePositionX: -14.4, register: 4, referencePositionX: 0}
        */

        // Create bottom part
        const bottom = BABYLON.MeshBuilder.CreateBox("whiteKeyBottom", {width: props.bottomWidth, 
height: 1.5, depth: 4.5}, scene);

referencePositionXreferencePositionX: x-coordinate of the end point of the register (used as a reference point).

The props  for creating a black key is a lot simpler because creating a black key only involves creating a

box, and every black key's width and z-position are the same.

3. Now that we have a more efficient way of creating the keys, let's initialize an array that stores the props

for each key that corresponds to a note in a register, and then call the buildKey()  function with each of

them to create a simple keyboard in the 4th register.

We will also create a TransformNode named keyboard  to act as the parent of all piano keys. Since any

position or scaling change applied to the parent would also be applied to the children, grouping the keys

in this way will allow us to to scale or move them as a whole.

Append the following lines of code in the createScene()  function:

As you have probably noticed, in this code block we are placing all the keys relative to the origin of the

space.

4. Here is the code that scene.js contains so far :

https://doc.babylonjs.com/divingDeeper/mesh/transforms/parent_pivot/transform_node#a-transformnode
https://doc.babylonjs.com/divingDeeper/mesh/transforms/parent_pivot/parent#overview-of-a-parent


        // Create top part
        const top = BABYLON.MeshBuilder.CreateBox("whiteKeyTop", {width: props.topWidth, height: 1.5, 
depth: 5}, scene);
        top.position.z =  4.75;
        top.position.x += props.topPositionX;

        // Merge bottom and top parts
        // Parameters of BABYLON.Mesh.MergeMeshes: (arrayOfMeshes, disposeSource, allow32BitsIndices, 
meshSubclass, subdivideWithSubMeshes, multiMultiMaterials)
        const key = BABYLON.Mesh.MergeMeshes([bottom, top], true, false, null, false, false);
        key.position.x = props.referencePositionX + props.wholePositionX;
        key.name = props.note + props.register;
        key.parent = parent;

        return key;
    }
    else if (props.type === "black") {
        /*
        Props for building a black key should contain: 
        note, wholePositionX, register, referencePositionX

        As an example, the props for building the C#4 black key would be
        {type: "black", note: "C#", wholePositionX: -13.45, register: 4, referencePositionX: 0}
        */

        // Create black color material
        const blackMat = new BABYLON.StandardMaterial("black");
        blackMat.diffuseColor = new BABYLON.Color3(0, 0, 0);

        // Create black key
        const key = BABYLON.MeshBuilder.CreateBox(props.note + props.register, {width: 1.4, height: 
2, depth: 5}, scene);
        key.position.z += 4.75;
        key.position.y += 0.25;
        key.position.x = props.referencePositionX + props.wholePositionX;
        key.material = blackMat;
        key.parent = parent;

        return key;
    }
}

const createScene = async function(engine) {
    const scene = new BABYLON.Scene(engine);

    const alpha =  3*Math.PI/2;
    const beta = Math.PI/50;
    const radius = 220;
    const target = new BABYLON.Vector3(0, 0, 0);

    const camera = new BABYLON.ArcRotateCamera("Camera", alpha, beta, radius, target, scene);
    camera.attachControl(canvas, true);

    const light = new BABYLON.HemisphericLight("light", new BABYLON.Vector3(0, 1, 0), scene);
    light.intensity = 0.6;

    const keyParams = [
        {type: "white", note: "C", topWidth: 1.4, bottomWidth: 2.3, topPositionX: -0.45, 
wholePositionX: -14.4},
        {type: "black", note: "C#", wholePositionX: -13.45},
        {type: "white", note: "D", topWidth: 1.4, bottomWidth: 2.4, topPositionX: 0, wholePositionX: 
-12},
        {type: "black", note: "D#", wholePositionX: -10.6},
        {type: "white", note: "E", topWidth: 1.4, bottomWidth: 2.3, topPositionX: 0.45, 
wholePositionX: -9.6},
        {type: "white", note: "F", topWidth: 1.3, bottomWidth: 2.4, topPositionX: -0.55, 
wholePositionX: -7.2},
        {type: "black", note: "F#", wholePositionX: -6.35},
        {type: "white", note: "G", topWidth: 1.3, bottomWidth: 2.3, topPositionX: -0.2, 
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wholePositionX: -4.8},
        {type: "black", note: "G#", wholePositionX: -3.6},
        {type: "white", note: "A", topWidth: 1.3, bottomWidth: 2.3, topPositionX: 0.2, 
wholePositionX: -2.4},
        {type: "black", note: "A#", wholePositionX: -0.85},
        {type: "white", note: "B", topWidth: 1.3, bottomWidth: 2.4, topPositionX: 0.55, 
wholePositionX: 0},
    ]

    // Transform Node that acts as the parent of all piano keys
    const keyboard = new BABYLON.TransformNode("keyboard");

    keyParams.forEach(key => {
        buildKey(scene, keyboard, Object.assign({register: 4, referencePositionX: 0}, key));
    })

    const xrHelper = await scene.createDefaultXRExperienceAsync();

    return scene;
}

5. This is what the resulting keyboard would look like:

In this section, let's expand the usage of the key-creation functions to generating a full, 88-key piano keyboard.

1. As mentioned earlier, a full, 88-key piano keyboard contains 7 repeated registers and 4 other notes. 3 of

those extra notes are in register 0 (left end of the keyboard), and 1 is in register 8 (right end of the

keyboard).



 Adding a piano frame

// Register 1 through 7
var referencePositionX = -2.4*14;
for (let register = 1; register <= 7; register++) {
    keyParams.forEach(key => {
        buildKey(scene, keyboard, Object.assign({register: register, referencePositionX: 
referencePositionX}, key));
    })
    referencePositionX += 2.4*7;
}

// Register 0
buildKey(scene, keyboard, {type: "white", note: "A", topWidth: 1.9, bottomWidth: 2.3, topPositionX: -
0.20, wholePositionX: -2.4, register: 0, referencePositionX: -2.4*21});
keyParams.slice(10, 12).forEach(key => {
    buildKey(scene, keyboard, Object.assign({register: 0, referencePositionX: -2.4*21}, key));
})

// Register 8
buildKey(scene, keyboard, {type: "white", note: "C", topWidth: 2.3, bottomWidth: 2.3, topPositionX: 
0, wholePositionX: -2.4*6, register: 8, referencePositionX: 84});

2. We will first work on building the 7 full repetitions by adding an additional loop around the loop we

wrote earlier. Replace the previous loop for the buildKey()  function with the following code:

In this loop, we build the keys for register 1 through 7 and increment the reference position every time

we move on to the next register.

3. Next, let's create the rest of the keys. Add the following snippet to the createScene()  function:

Note that the left-most key and the right-most key of the piano keyboard don't fit into the dimensions of

the props defined in keyParams  (because they are not next to a black key at the edge), so we need to

define a new props  object for each of them to specify their special shape.

4. The keyboard produced should look like this after the changes are made:

1. The scene looks a little odd with just a keyboard floating in the space. Let's add a piano frame around the

keyboard to create the look of a standup piano.

2. Similar to how we created the keys, we can also create the frame by positioning and combining a group

of box meshes.



// Transform node that acts as the parent of all piano components
const piano = new BABYLON.TransformNode("piano");
keyboard.parent = piano;

// Import and scale piano frame
BABYLON.SceneLoader.ImportMesh("frame", "https://raw.githubusercontent.com/MicrosoftDocs/mixed-
reality/docs/mixed-reality-docs/mr-dev-docs/develop/javascript/tutorials/babylonjs-webxr-
piano/files/", "pianoFrame.babylon", scene, function(meshes) {
    const frame = meshes[0];
    frame.parent = piano;
});

// Lift piano keys
keyboard.position.y += 80;

const buildKey = function (scene, parent, props) {
    if (props.type === "white") {
        /*
        Props for building a white key should contain: 
        note, topWidth, bottomWidth, topPositionX, wholePositionX, register, referencePositionX

        As an example, the props for building the middle C white key would be
        {type: "white", note: "C", topWidth: 1.4, bottomWidth: 2.3, topPositionX: -0.45, 
wholePositionX: -14.4, register: 4, referencePositionX: 0}
        */

        // Create bottom part
        const bottom = BABYLON.MeshBuilder.CreateBox("whiteKeyBottom", {width: props.bottomWidth, 
height: 1.5, depth: 4.5}, scene);

        // Create top part
        const top = BABYLON.MeshBuilder.CreateBox("whiteKeyTop", {width: props.topWidth, height: 1.5, 
depth: 5}, scene);
        top.position.z =  4.75;
        top.position.x += props.topPositionX;

        // Merge bottom and top parts
        // Parameters of BABYLON.Mesh.MergeMeshes: (arrayOfMeshes, disposeSource, allow32BitsIndices, 
meshSubclass, subdivideWithSubMeshes, multiMultiMaterials)
        const key = BABYLON.Mesh.MergeMeshes([bottom, top], true, false, null, false, false);
        key.position.x = props.referencePositionX + props.wholePositionX;
        key.name = props.note + props.register;
        key.parent = parent;

        return key;

However, we will leave that challenge for you to try on your own and use

BABYLON.SceneLoader.ImportMesh to import a pre-made mesh of a standup piano frame. Append this

piece of code to createScene() :

Note that we are, again, creating a parent TransformNode  named piano  to group the keyboard and the

frame together as a whole. This will make moving or scaling the entire piano a lot easier if we ever need

to do so.

3. Once the frame is imported, notice that the keyboard is lying at the bottom of the frame (since the y-

coordinates of the keys are at 0 by default). Let's lift the keyboard so that it fits into the standup piano

frame:

Since keyboard  is the parent of all piano keys, we can lift all of the piano keys by just changing the y-

position of keyboard .

4. The final code of scene.js should look like this:

https://doc.babylonjs.com/divingDeeper/importers/loadingFileTypes#sceneloaderimportmesh


        return key;
    }
    else if (props.type === "black") {
        /*
        Props for building a black key should contain: 
        note, wholePositionX, register, referencePositionX

        As an example, the props for building the C#4 black key would be
        {type: "black", note: "C#", wholePositionX: -13.45, register: 4, referencePositionX: 0}
        */

        // Create black color material
        const blackMat = new BABYLON.StandardMaterial("black");
        blackMat.diffuseColor = new BABYLON.Color3(0, 0, 0);

        // Create black key
        const key = BABYLON.MeshBuilder.CreateBox(props.note + props.register, {width: 1.4, height: 
2, depth: 5}, scene);
        key.position.z += 4.75;
        key.position.y += 0.25;
        key.position.x = props.referencePositionX + props.wholePositionX;
        key.material = blackMat;
        key.parent = parent;

        return key;
    }
}

const createScene = async function(engine) {
    const scene = new BABYLON.Scene(engine);

    const alpha =  3*Math.PI/2;
    const beta = Math.PI/50;
    const radius = 220;
    const target = new BABYLON.Vector3(0, 0, 0);

    const camera = new BABYLON.ArcRotateCamera("Camera", alpha, beta, radius, target, scene);
    camera.attachControl(canvas, true);

    const light = new BABYLON.HemisphericLight("light", new BABYLON.Vector3(0, 1, 0), scene);
    light.intensity = 0.6;

    const keyParams = [
        {type: "white", note: "C", topWidth: 1.4, bottomWidth: 2.3, topPositionX: -0.45, 
wholePositionX: -14.4},
        {type: "black", note: "C#", wholePositionX: -13.45},
        {type: "white", note: "D", topWidth: 1.4, bottomWidth: 2.4, topPositionX: 0, wholePositionX: 
-12},
        {type: "black", note: "D#", wholePositionX: -10.6},
        {type: "white", note: "E", topWidth: 1.4, bottomWidth: 2.3, topPositionX: 0.45, 
wholePositionX: -9.6},
        {type: "white", note: "F", topWidth: 1.3, bottomWidth: 2.4, topPositionX: -0.55, 
wholePositionX: -7.2},
        {type: "black", note: "F#", wholePositionX: -6.35},
        {type: "white", note: "G", topWidth: 1.3, bottomWidth: 2.3, topPositionX: -0.2, 
wholePositionX: -4.8},
        {type: "black", note: "G#", wholePositionX: -3.6},
        {type: "white", note: "A", topWidth: 1.3, bottomWidth: 2.3, topPositionX: 0.2, 
wholePositionX: -2.4},
        {type: "black", note: "A#", wholePositionX: -0.85},
        {type: "white", note: "B", topWidth: 1.3, bottomWidth: 2.4, topPositionX: 0.55, 
wholePositionX: 0},
    ]

    // Transform Node that acts as the parent of all piano keys
    const keyboard = new BABYLON.TransformNode("keyboard");

    // Register 1 through 7
    var referencePositionX = -2.4*14;
    for (let register = 1; register <= 7; register++) {
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    for (let register = 1; register <= 7; register++) {
        keyParams.forEach(key => {
            buildKey(scene, keyboard, Object.assign({register: register, referencePositionX: 
referencePositionX}, key));
        })
        referencePositionX += 2.4*7;
    }

    // Register 0
    buildKey(scene, keyboard, {type: "white", note: "A", topWidth: 1.9, bottomWidth: 2.3, 
topPositionX: -0.20, wholePositionX: -2.4, register: 0, referencePositionX: -2.4*21});
    keyParams.slice(10, 12).forEach(key => {
        buildKey(scene, keyboard, Object.assign({register: 0, referencePositionX: -2.4*21}, key));
    })

    // Register 8
    buildKey(scene, keyboard, {type: "white", note: "C", topWidth: 2.3, bottomWidth: 2.3, 
topPositionX: 0, wholePositionX: -2.4*6, register: 8, referencePositionX: 84});

    // Transform node that acts as the parent of all piano components
    const piano = new BABYLON.TransformNode("piano");
    keyboard.parent = piano;

    // Import and scale piano frame
    BABYLON.SceneLoader.ImportMesh("frame", "https://raw.githubusercontent.com/MicrosoftDocs/mixed-
reality/docs/mixed-reality-docs/mr-dev-docs/develop/javascript/tutorials/babylonjs-webxr-
piano/files/", "pianoFrame.babylon", scene, function(meshes) {
        const frame = meshes[0];
        frame.parent = piano;
    });

    // Lift the piano keyboard
    keyboard.position.y += 80;

    const xrHelper = await scene.createDefaultXRExperienceAsync();

    return scene;
}

5. Now we should have a standup piano that looks like this: 

Next tutorial: Play the 3D piano



   

 

Tutorial: Play the 3D piano
 7/6/2022 • 16 minutes to read • Edit Online

 Before you begin

<html>
    <head>
        <title>Piano in BabylonJS</title>
        <script src="https://cdn.babylonjs.com/babylon.js"></script>
        <script src="scene.js"></script>
        <style>
            body,#renderCanvas { width: 100%; height: 100%;}
        </style>
    </head>
    <body>
        <canvas id="renderCanvas"></canvas>
        <script type="text/javascript">
            const canvas = document.getElementById("renderCanvas");
            const engine = new BABYLON.Engine(canvas, true); 

            createScene(engine).then(sceneToRender => {
                engine.runRenderLoop(() => sceneToRender.render());
            });
            
            // Watch for browser/canvas resize events
            window.addEventListener("resize", function () {
                engine.resize();
            });
        </script>
    </body>
</html>

const buildKey = function (scene, parent, props) {
    if (props.type === "white") {
        /*
        Props for building a white key should contain: 
        note, topWidth, bottomWidth, topPositionX, wholePositionX, register, referencePositionX

        As an example, the props for building the middle C white key would be
        {type: "white", note: "C", topWidth: 1.4, bottomWidth: 2.3, topPositionX: -0.45, wholePositionX: -
14.4, register: 4, referencePositionX: 0}
        */

In the previous tutorial, we have successfully created a model of a full 88-key piano keyboard. Now let's make it

playable in the XR space.

In this tutorial, you will learn how to:

Add interactive piano features using pointer events

Scale meshes to a different size

Enable teleportation and multi-pointer support in XR

Make sure that you have gone through the previous tutorial in the series are ready to continue adding to the

code.

index.html

scene.js

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/javascript/tutorials/babylonjs-webxr-piano/keyboard-interaction-03.md


        */

        // Create bottom part
        const bottom = BABYLON.MeshBuilder.CreateBox("whiteKeyBottom", {width: props.bottomWidth, height: 
1.5, depth: 4.5}, scene);

        // Create top part
        const top = BABYLON.MeshBuilder.CreateBox("whiteKeyTop", {width: props.topWidth, height: 1.5, depth: 
5}, scene);
        top.position.z =  4.75;
        top.position.x += props.topPositionX;

        // Merge bottom and top parts
        // Parameters of BABYLON.Mesh.MergeMeshes: (arrayOfMeshes, disposeSource, allow32BitsIndices, 
meshSubclass, subdivideWithSubMeshes, multiMultiMaterials)
        const key = BABYLON.Mesh.MergeMeshes([bottom, top], true, false, null, false, false);
        key.position.x = props.referencePositionX + props.wholePositionX;
        key.name = props.note + props.register;
        key.parent = parent;

        return key;
    }
    else if (props.type === "black") {
        /*
        Props for building a black key should contain: 
        note, wholePositionX, register, referencePositionX

        As an example, the props for building the C#4 black key would be
        {type: "black", note: "C#", wholePositionX: -13.45, register: 4, referencePositionX: 0}
        */

        // Create black color material
        const blackMat = new BABYLON.StandardMaterial("black");
        blackMat.diffuseColor = new BABYLON.Color3(0, 0, 0);

        // Create black key
        const key = BABYLON.MeshBuilder.CreateBox(props.note + props.register, {width: 1.4, height: 2, 
depth: 5}, scene);
        key.position.z += 4.75;
        key.position.y += 0.25;
        key.position.x = props.referencePositionX + props.wholePositionX;
        key.material = blackMat;
        key.parent = parent;

        return key;
    }
}

const createScene = async function(engine) {
    const scene = new BABYLON.Scene(engine);

    const alpha =  3*Math.PI/2;
    const beta = Math.PI/50;
    const radius = 220;
    const target = new BABYLON.Vector3(0, 0, 0);
    
    const camera = new BABYLON.ArcRotateCamera("Camera", alpha, beta, radius, target, scene);
    camera.attachControl(canvas, true);
    
    const light = new BABYLON.HemisphericLight("light", new BABYLON.Vector3(0, 1, 0), scene);
    light.intensity = 0.6;

    const keyParams = [
        {type: "white", note: "C", topWidth: 1.4, bottomWidth: 2.3, topPositionX: -0.45, wholePositionX: -
14.4},
        {type: "black", note: "C#", wholePositionX: -13.45},
        {type: "white", note: "D", topWidth: 1.4, bottomWidth: 2.4, topPositionX: 0, wholePositionX: -12},
        {type: "black", note: "D#", wholePositionX: -10.6},
        {type: "white", note: "E", topWidth: 1.4, bottomWidth: 2.3, topPositionX: 0.45, wholePositionX: -
9.6},



9.6},
        {type: "white", note: "F", topWidth: 1.3, bottomWidth: 2.4, topPositionX: -0.55, wholePositionX: -
7.2},
        {type: "black", note: "F#", wholePositionX: -6.35},
        {type: "white", note: "G", topWidth: 1.3, bottomWidth: 2.3, topPositionX: -0.2, wholePositionX: -
4.8},
        {type: "black", note: "G#", wholePositionX: -3.6},
        {type: "white", note: "A", topWidth: 1.3, bottomWidth: 2.3, topPositionX: 0.2, wholePositionX: -
2.4},
        {type: "black", note: "A#", wholePositionX: -0.85},
        {type: "white", note: "B", topWidth: 1.3, bottomWidth: 2.4, topPositionX: 0.55, wholePositionX: 0},
    ]

    // Transform Node that acts as the parent of all piano keys
    const keyboard = new BABYLON.TransformNode("keyboard");

    // Register 1 through 7
    var referencePositionX = -2.4*14;
    for (let register = 1; register <= 7; register++) {
        keyParams.forEach(key => {
            buildKey(scene, keyboard, Object.assign({register: register, referencePositionX: 
referencePositionX}, key));
        })
        referencePositionX += 2.4*7;
    }

    // Register 0
    buildKey(scene, keyboard, {type: "white", note: "A", topWidth: 1.9, bottomWidth: 2.3, topPositionX: -
0.20, wholePositionX: -2.4, register: 0, referencePositionX: -2.4*21});
    keyParams.slice(10, 12).forEach(key => {
        buildKey(scene, keyboard, Object.assign({register: 0, referencePositionX: -2.4*21}, key));
    })

    // Register 8
    buildKey(scene, keyboard, {type: "white", note: "C", topWidth: 2.3, bottomWidth: 2.3, topPositionX: 0, 
wholePositionX: -2.4*6, register: 8, referencePositionX: 84});

    // Transform node that acts as the parent of all piano components
    const piano = new BABYLON.TransformNode("piano");
    keyboard.parent = piano;

    // Import and scale piano frame
    BABYLON.SceneLoader.ImportMesh("frame", "https://raw.githubusercontent.com/MicrosoftDocs/mixed-
reality/docs/mixed-reality-docs/mr-dev-docs/develop/javascript/tutorials/babylonjs-webxr-piano/files/", 
"pianoFrame.babylon", scene, function(meshes) {
        const frame = meshes[0];
        frame.parent = piano;
    });

    // Lift the piano keyboard
    keyboard.position.y += 80;

    const xrHelper = await scene.createDefaultXRExperienceAsync();

    return scene;
}

 Making the piano keyboard playable
Right now, the piano keyboard we have created is a static model that does not respond to any user interactions.

In this section, we will program the keys to move downward and play a sound when someone presses on them.

1. Babylon.js provides different kinds of events, or observables, that we can interact with. In our case, we will

be dealing with the onPointerObservable  since we want to program the keys to perform actions when

someone press on them through a pointer, which can be a mouse click, touch, XR controller button click,

etc.

https://doc.babylonjs.com/divingDeeper/events/observables


scene.onPointerObservable.add((pointerInfo) => {
    // do something
});

scene.onPointerObservable.add((pointerInfo) => {
    switch (pointerInfo.type) {
        case BABYLON.PointerEventTypes.POINTERDOWN:
            // When the pointer is down on a piano key,
            // move the piano key downward (to show that it is pressed)
            // and play the sound of the note
            break;
        case BABYLON.PointerEventTypes.POINTERUP:
            // When the pointer is released,
            // move the piano key upward to its original position
            // and stop the sound of the note of the key that is released
            break;
    }
});

Here is the basic structure of how we can add any behavior to an onPointerObservable :

2. While Babylon.js provides many different types of pointer events, we will only be using the POINTERDOWN

and POINTERUP  events to program the behavior of the piano keys, using the structure below:

3. Let's first work on moving the piano key downward and upward when we press and release the key.

At the pointer down event, we need to detect the mesh that is being clicked, make sure that it is a piano

key, and change the mesh's y-coordinate negatively by a small amount to make it look like the key was

pressed down.

For the pointer up event, it is a little more complicated because the pointer which pressed on the key

might not be released on the key. For example, someone might click down on key C4, drag their mouse to

E4, and then release their click. In this case, we still want to release the key that was pressed (C4) instead

of where the pointerUp  event occurs (E4).

Let's look at how the following code achieves what we want:

https://doc.babylonjs.com/typedoc/classes/babylon.pointereventtypes


const pointerToKey = new Map();
scene.onPointerObservable.add((pointerInfo) => {
    switch (pointerInfo.type) {
        case BABYLON.PointerEventTypes.POINTERDOWN:
            if(pointerInfo.pickInfo.hit) {
                const pickedMesh = pointerInfo.pickInfo.pickedMesh;
                const pointerId = pointerInfo.event.pointerId;
                if (pickedMesh.parent === keyboard) {
                    pickedMesh.position.y -= 0.5;
                    // play the sound of the note
                    pointerToKey.set(pointerId, {
                        mesh: pickedMesh
                    });
                }
            }
            break;
        case BABYLON.PointerEventTypes.POINTERUP:
            const pointerId = pointerInfo.event.pointerId;
            if (pointerToKey.has(pointerId)) {
                pointerToKey.get(pointerId).mesh.position.y += 0.5;
                // stop the sound of the note of the key that is released
                pointerToKey.delete(pointerId);
            }
            break;
    }
});

The pointerId  is unique to every pointer and can help us identify a pointer when we have multiple

controllers or if we are using a touch screen. Here we initialized a Map  object named pointerToKey  to

store the relationship of which pointer pressed on which key, so that we know which key to release when

the pointer is released, regardless of where the release happens.

4. Here's what the interaction would look like with the code above:

5. Now let's work on playing and stopping a sound when a key is pressed and released. To achieve this, we

will be utilizing a Javascript library named soundfont-playersoundfont-player , which allows us to easily play MIDI

sounds of an instrument we choose.

Download the minified code of the library, save it in the same folder as index.html, and include it in the 

file:///C:/localrun/t/fs14/bgqa/windows/mixed-reality/develop/javascript/tutorials/babylonjs-webxr-piano/files/soundfont-player.min.js


 Scaling the piano for immersive VR mode

<head>
    <title>Babylon Template</title>
    <script src="https://cdn.babylonjs.com/babylon.js"></script>
    <script src="scene.js"></script>
    <script src="soundfont-player.min.js"></script>
    <style>
            body,#renderCanvas { width: 100%; height: 100%;}
    </style>
</head>

const pianoSound = await Soundfont.instrument(new AudioContext(), 'acoustic_grand_piano');
const C4 = piano.play("C4"); // Play note C4
C4.stop(); // Stop note C4

const pointerToKey = new Map()
const piano = await Soundfont.instrument(new AudioContext(), 'acoustic_grand_piano');

scene.onPointerObservable.add((pointerInfo) => {
    switch (pointerInfo.type) {
        case BABYLON.PointerEventTypes.POINTERDOWN:
            if(pointerInfo.pickInfo.hit) {
                let pickedMesh = pointerInfo.pickInfo.pickedMesh;
                let pointerId = pointerInfo.event.pointerId;
                if (keys.has(pickedMesh)) {
                    pickedMesh.position.y -= 0.5; // Move the key downward
                    pointerToKey.set(pointerId, {
                        mesh: pickedMesh,
                        note: pianoSound.play(pointerInfo.pickInfo.pickedMesh.name) // Play the sound 
of the note
                    });
                }
            }
            break;
        case BABYLON.PointerEventTypes.POINTERUP:
            let pointerId = pointerInfo.event.pointerId;
            if (pointerToKey.has(pointerId)) {
                pointerToKey.get(pointerId).mesh.position.y += 0.5; // Move the key upward
                pointerToKey.get(pointerId).note.stop(); // Stop the sound of the note
                pointerToKey.delete(pointerId);
            }
            break;
    }
});

<header>  tag in index.html:

Once the library is imported, here is how we can initialize an instrument and play/stop MIDI sounds

using the library:

6. Now let's incorporate this into the pointer events and finalize the code for this section:

Since we named each key's mesh by the note that it represents, we can easily indicate which note to play

by passing in the mesh's name to the pianoSound.play()  function. Also note that we are storing the

sound into the pointerToKey  map so that we know what sound to stop when a key is released.

By now, you have probably already played with the piano with your mouse (or even with a touch screen) as you

added the interactive functionalities. In this section, we will be moving into the immersive VR space.



const scaleFromPivot = function(transformNode, pivotPoint, scale) {
    const _sx = scale / transformNode.scaling.x;
    const _sy = scale / transformNode.scaling.y;
    const _sz = scale / transformNode.scaling.z;
    transformNode.scaling = new BABYLON.Vector3(_sx, _sy, _sz); 
    transformNode.position = new BABYLON.Vector3(pivotPoint.x + _sx * (transformNode.position.x - 
pivotPoint.x), pivotPoint.y + _sy * (transformNode.position.y - pivotPoint.y), pivotPoint.z + _sz * 
(transformNode.position.z - pivotPoint.z));
}

1. In order to open the page in your immersive VR headset, you must first connect your headset to your

developer machine and make sure that it is set up for use in the Windows Mixed Reality App. If you're

using the Windows Mixed Reality Simulator, make sure that it is enabled.

2. You will now see a Immersive VR button at the bottom right of the web page. Click on it and you will be

able to see the piano in the XR device you are connected to.

3. Once you are in the virtual space, you might notice that the piano we have built is extremely huge. In the

VR world, we can only standing at the bottom of it and play it by pointing the pointer to the keys in the

distance.

4. Let's scale down the piano so that its size is more like a normal standup piano in real life. To do so, we will

need to use a utility function that allows us to scale a mesh relative to a point in the space. Add this

function to scene.js (outside of createScene() ):

This function takes in 3 parameters:

transformNodetransformNode: the TransformNode  to be scaled

pivotPointpivotPoint: a Vector3  object which indicates the point that the scaling is relative to

scalescale: the scale factor

5. We will use this function to scale the piano frame and keys by a factor of 0.015, with a pivot point at the

origin. Append the function call to the createScene()  function by placing it after 

keyboard.position.y += 80; :

https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/set-up-windows-mixed-reality
https://doc.babylonjs.com/toolsAndResources/utilities/Pivot#enlargement


 Enabling WebXR features

// Put this line at the beginning of createScene()
const scale = 0.015;

// Put this function call after keyboard.position.y += 80;

// Scale the entire piano
scaleFromPivot(piano, new BABYLON.Vector3(0, 0, 0), scale);

const alpha =  3*Math.PI/2;
const beta = Math.PI/50;
const radius = 220*scale; // scale the radius
const target = new BABYLON.Vector3(0, 0, 0);

const camera = new BABYLON.ArcRotateCamera("Camera", alpha, beta, radius, target, scene);
camera.attachControl(canvas, true);

6. Let's not forget to scale camera position as well:

7. Now when we enter the VR space again, the piano would be of the size of an ordinary standup piano.

Now that we have scaled the piano to the right size in the VR space, let's enable some cool WebXR features to

improve our piano-playing experience in the space.

1. If you have been playing the piano using your immersive VR controllers, you might have noticed that you

can only use one controller at a time. Let's enable the multi-pointer support in the XR space by using

Babylon.js's WebXR features manager.

Add the following code into the createScene()  function, after the xrHelper  initialization line:

https://doc.babylonjs.com/typedoc/interfaces/babylon.iwebxrcontrollerpointerselectionoptions
https://doc.babylonjs.com/divingDeeper/webXR/webXRFeaturesManager


const featuresManager = xrHelper.baseExperience.featuresManager;

const pointerSelection = featuresManager.enableFeature(BABYLON.WebXRFeatureName.POINTER_SELECTION, 
"stable", {
    xrInput: xrHelper.input,
    enablePointerSelectionOnAllControllers: true        
});

const ground = BABYLON.MeshBuilder.CreateGround("ground", {width: 400, height: 400});

const teleportation = featuresManager.enableFeature(BABYLON.WebXRFeatureName.TELEPORTATION, "stable", 
{
    xrInput: xrHelper.input,
    floorMeshes: [ground],
    snapPositions: [new BABYLON.Vector3(2.4*3.5*scale, 0, -10*scale)],
});

2. Additionally, depending on where your starting point is, you might find it a little difficult to position

yourself in front of the piano. If you are familiar with the immersive VR environment, you might already

know about telepor tationtelepor tation, which is a feature that allows you to move to another spot in the space

instantly by pointing at it.

3. In order to use Babylon.js's teleportation feature, we first need to have a ground mesh that we can "stand

on" in the VR space. Add the following code to the createScene()  function to create a ground:

4. The teleportation support also comes with a very useful feature called snap-to positions. In short, snap-to

positions are specific positions that we want users to land at.

For example, we can set a snap-to position in front of the piano so that users can easily teleport to that

location when they point their pointers close to the piano.

Append the code below to enable the teleportation feature and specify a snap-to point:

5. Now, you should be able to easily position yourself in front of the piano by teleporting to the snap-to

point in front of the piano, and you should be able to play two keys at a time using both controllers.

https://doc.babylonjs.com/divingDeeper/webXR/WebXRSelectedFeatures#teleportation-module
https://doc.babylonjs.com/divingDeeper/webXR/WebXRSelectedFeatures#snap-to-hotspots


 Summary

const buildKey = function (scene, parent, props) {
    if (props.type === "white") {
        /*
        Props for building a white key should contain: 
        note, topWidth, bottomWidth, topPositionX, wholePositionX, register, referencePositionX

        As an example, the props for building the middle C white key would be
        {type: "white", note: "C", topWidth: 1.4, bottomWidth: 2.3, topPositionX: -0.45, wholePositionX: -
14.4, register: 4, referencePositionX: 0}
        */

        // Create bottom part
        const bottom = BABYLON.MeshBuilder.CreateBox("whiteKeyBottom", {width: props.bottomWidth, height: 
1.5, depth: 4.5}, scene);

        // Create top part
        const top = BABYLON.MeshBuilder.CreateBox("whiteKeyTop", {width: props.topWidth, height: 1.5, depth: 
5}, scene);
        top.position.z =  4.75;
        top.position.x += props.topPositionX;

        // Merge bottom and top parts
        // Parameters of BABYLON.Mesh.MergeMeshes: (arrayOfMeshes, disposeSource, allow32BitsIndices, 
meshSubclass, subdivideWithSubMeshes, multiMultiMaterials)
        const key = BABYLON.Mesh.MergeMeshes([bottom, top], true, false, null, false, false);
        key.position.x = props.referencePositionX + props.wholePositionX;

Congratulations! You've completed our series of the Babylon.js piano-building tutorial and learned how to:

Create, position, and merge meshes to build a model of a piano keyboard

Import a Babylon.js model of a standup piano frame

Add pointer interactions to each piano key

Scale the size of meshes based on a pivot point

Enable key WebXR features such as teleportation and multipointer support

Here is the final code for scene.js and index.html:

scene.js



        key.name = props.note + props.register;
        key.parent = parent;

        return key;
    }
    else if (props.type === "black") {
        /*
        Props for building a black key should contain: 
        note, wholePositionX, register, referencePositionX

        As an example, the props for building the C#4 black key would be
        {type: "black", note: "C#", wholePositionX: -13.45, register: 4, referencePositionX: 0}
        */

        // Create black color material
        const blackMat = new BABYLON.StandardMaterial("black");
        blackMat.diffuseColor = new BABYLON.Color3(0, 0, 0);

        // Create black key
        const key = BABYLON.MeshBuilder.CreateBox(props.note + props.register, {width: 1.4, height: 2, 
depth: 5}, scene);
        key.position.z += 4.75;
        key.position.y += 0.25;
        key.position.x = props.referencePositionX + props.wholePositionX;
        key.material = blackMat;
        key.parent = parent;

        return key;
    }
}

const scaleFromPivot = function(transformNode, pivotPoint, scale) {
    const _sx = scale / transformNode.scaling.x;
    const _sy = scale / transformNode.scaling.y;
    const _sz = scale / transformNode.scaling.z;
    transformNode.scaling = new BABYLON.Vector3(_sx, _sy, _sz); 
    transformNode.position = new BABYLON.Vector3(pivotPoint.x + _sx * (transformNode.position.x - 
pivotPoint.x), pivotPoint.y + _sy * (transformNode.position.y - pivotPoint.y), pivotPoint.z + _sz * 
(transformNode.position.z - pivotPoint.z));
}

const createScene = async function(engine) {
    const scale = 0.015;
    const scene = new BABYLON.Scene(engine);

    const alpha =  3*Math.PI/2;
    const beta = Math.PI/50;
    const radius = 220*scale;
    const target = new BABYLON.Vector3(0, 0, 0);

    const camera = new BABYLON.ArcRotateCamera("Camera", alpha, beta, radius, target, scene);
    camera.attachControl(canvas, true);

    const light = new BABYLON.HemisphericLight("light", new BABYLON.Vector3(0, 1, 0), scene);
    light.intensity = 0.6;

    const keyParams = [
        {type: "white", note: "C", topWidth: 1.4, bottomWidth: 2.3, topPositionX: -0.45, wholePositionX: -
14.4},
        {type: "black", note: "C#", wholePositionX: -13.45},
        {type: "white", note: "D", topWidth: 1.4, bottomWidth: 2.4, topPositionX: 0, wholePositionX: -12},
        {type: "black", note: "D#", wholePositionX: -10.6},
        {type: "white", note: "E", topWidth: 1.4, bottomWidth: 2.3, topPositionX: 0.45, wholePositionX: -
9.6},
        {type: "white", note: "F", topWidth: 1.3, bottomWidth: 2.4, topPositionX: -0.55, wholePositionX: -
7.2},
        {type: "black", note: "F#", wholePositionX: -6.35},
        {type: "white", note: "G", topWidth: 1.3, bottomWidth: 2.3, topPositionX: -0.2, wholePositionX: -
4.8},



4.8},
        {type: "black", note: "G#", wholePositionX: -3.6},
        {type: "white", note: "A", topWidth: 1.3, bottomWidth: 2.3, topPositionX: 0.2, wholePositionX: -
2.4},
        {type: "black", note: "A#", wholePositionX: -0.85},
        {type: "white", note: "B", topWidth: 1.3, bottomWidth: 2.4, topPositionX: 0.55, wholePositionX: 0},
    ]

    // Transform Node that acts as the parent of all piano keys
    const keyboard = new BABYLON.TransformNode("keyboard");

    // Register 1 through 7
    var referencePositionX = -2.4*14;
    for (let register = 1; register <= 7; register++) {
        keyParams.forEach(key => {
            buildKey(scene, keyboard, Object.assign({register: register, referencePositionX: 
referencePositionX}, key));
        })
        referencePositionX += 2.4*7;
    }

    // Register 0
    buildKey(scene, keyboard, {type: "white", note: "A", topWidth: 1.9, bottomWidth: 2.3, topPositionX: -
0.20, wholePositionX: -2.4, register: 0, referencePositionX: -2.4*21});
    keyParams.slice(10, 12).forEach(key => {
        buildKey(scene, keyboard, Object.assign({register: 0, referencePositionX: -2.4*21}, key));
    })

    // Register 8
    buildKey(scene, keyboard, {type: "white", note: "C", topWidth: 2.3, bottomWidth: 2.3, topPositionX: 0, 
wholePositionX: -2.4*6, register: 8, referencePositionX: 84});

    // Transform node that acts as the parent of all piano components
    const piano = new BABYLON.TransformNode("piano");
    keyboard.parent = piano;

    // Import and scale piano frame
    BABYLON.SceneLoader.ImportMesh("frame", "https://raw.githubusercontent.com/MicrosoftDocs/mixed-
reality/docs/mixed-reality-docs/mr-dev-docs/develop/javascript/tutorials/babylonjs-webxr-piano/files/", 
"pianoFrame.babylon", scene, function(meshes) {
        const frame = meshes[0];
        frame.parent = piano;
    });

    // Lift the piano keyboard
    keyboard.position.y += 80;

    // Scale the entire piano
    scaleFromPivot(piano, new BABYLON.Vector3(0, 0, 0), scale);

    const pointerToKey = new Map()
    const pianoSound = await Soundfont.instrument(new AudioContext(), 'acoustic_grand_piano');

    scene.onPointerObservable.add((pointerInfo) => {
        switch (pointerInfo.type) {
            case BABYLON.PointerEventTypes.POINTERDOWN:
                // Only take action if the pointer is down on a mesh
                if(pointerInfo.pickInfo.hit) {
                    let pickedMesh = pointerInfo.pickInfo.pickedMesh;
                    let pointerId = pointerInfo.event.pointerId;
                    if (pickedMesh.parent === keyboard) {
                        pickedMesh.position.y -= 0.5; // Move the key downward
                        pointerToKey.set(pointerId, {
                            mesh: pickedMesh,
                            note: pianoSound.play(pointerInfo.pickInfo.pickedMesh.name) // Play the sound of 
the note
                        });
                    }
                }
                break;



                break;
            case BABYLON.PointerEventTypes.POINTERUP:
                let pointerId = pointerInfo.event.pointerId;
                // Only take action if the released pointer was recorded in pointerToKey
                if (pointerToKey.has(pointerId)) {
                    pointerToKey.get(pointerId).mesh.position.y += 0.5; // Move the key upward
                    pointerToKey.get(pointerId).note.stop(); // Stop the sound of the note
                    pointerToKey.delete(pointerId);
                }
                break;
        }
    });

    const xrHelper = await scene.createDefaultXRExperienceAsync();

    const featuresManager = xrHelper.baseExperience.featuresManager;

    featuresManager.enableFeature(BABYLON.WebXRFeatureName.POINTER_SELECTION, "stable", {
        xrInput: xrHelper.input,
        enablePointerSelectionOnAllControllers: true        
    });

    const ground = BABYLON.MeshBuilder.CreateGround("ground", {width: 400, height: 400});

    featuresManager.enableFeature(BABYLON.WebXRFeatureName.TELEPORTATION, "stable", {
        xrInput: xrHelper.input,
        floorMeshes: [ground],
        snapPositions: [new BABYLON.Vector3(2.4*3.5*scale, 0, -10*scale)],
    });

    return scene;
}

<html>
    <head>
        <title>Babylon Template</title>
        <script src="https://cdn.babylonjs.com/babylon.js"></script>
        <script src="scene.js"></script>
        <script src="soundfont-player.min.js"></script>
        <style>
            body,#renderCanvas { width: 100%; height: 100%;}
        </style>
    </head>
   <body>
    <canvas id="renderCanvas"></canvas>
    <script>
        const canvas = document.getElementById("renderCanvas"); // Get the canvas element
        const engine = new BABYLON.Engine(canvas, true); // Generate the BABYLON 3D engine

        // Register a render loop to repeatedly render the scene
        createScene(engine).then(sceneToRender => {
            engine.runRenderLoop(() => sceneToRender.render());
        });

        // Watch for browser/canvas resize events
        window.addEventListener("resize", function () {
                engine.resize();
        });
    </script>
   </body>
</html>

 Next steps

index.html



For more information on Mixed Reality JavaScript development see JavaScript development overview.

https://docs.microsoft.com/en-us/windows/mixed-reality/develop/javascript/javascript-development-overview
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IMPORTANTIMPORTANT

 Development checkpoints

  1. Getting started1. Getting started

 

 

C H EC KP O IN TC H EC KP O IN T O UTC O M EO UTC O M E

What is OpenXR? Begin your native development journey by getting
acquainted with OpenXR and what it has to offer

Install the latest tools Download and install the latest native development tools

Set up for HoloLens 2 Configure your device and environment for HoloLens 2
development

Set up for immersive headsets Configure your device and environment for Windows Mixed
Reality development

3D engines like Unity or Unreal aren't the only Mixed Reality development paths open to you. You can also

create Mixed Reality apps using the Windows Mixed Reality APIs with DirectX 11 or DirectX 12. By going to the

platform source, you're essentially building your own middleware or framework.

If you have an existing WinRT project that you'd like to maintain, head over to our main WinRT documentation.

Use the following checkpoints to bring your Unity games and applications into the world of mixed reality.

Windows Mixed Reality supports two kinds of apps:

UWP or Win32 Mixed Reality applicationsMixed Reality applications  that use the HolographicSpace API or OpenXR API to render an

immersive view that fills the headset display

2D apps2D apps  (UWP) that use DirectX, XAML, or another framework to render 2D views on slates in the Windows

Mixed Reality home

The differences between DirectX development for 2D views and immersive views primarily concern holographic

rendering and spatial input. Your UWP application's IFrameworkView or your Win32 application's HWND are

required and remain largely the same. The same is true for the WinRT APIs that are available to your app. But

you must use a different subset of these APIs to take advantage of holographic features. For example, the

system for holographic applications manages the swapchain and frame present to enable a pose-predicted

frame loop.

OpenXR

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/directx-development-overview.md
https://docs.microsoft.com/en-us/uwp/api/windows.applicationmodel.core.iframeworkview


Try a sample app Explore a UWP and Win32 version of the same basic
OpenXR app on your device

Take a tour of the OpenXR API Watch a 60-minute walkthrough video that tours all key
components of the OpenXR API in Visual Studio

Add the OpenXR loader Add the OpenXR loader to an existing native project to get
started developing

C H EC KP O IN TC H EC KP O IN T O UTC O M EO UTC O M E

  2. Core building blocks2. Core building blocks

F EAT UREF EAT URE C A PA B IL IT YC A PA B IL IT Y

Gaze Let users target holograms with by looking at them

Gesture Add spatial actions to your apps

Holographic rendering Draw a hologram at a precise location in the world around
your users

Motion controller Let your users take action in your Mixed Reality
environments

Spatial mapping Map your physical space with a virtual mesh overlay to mark
the boundaries of your environment

Voice Capture spoken keywords, phrases, and dictation from your
users

NOTENOTE

  3. Deploying and testing3. Deploying and testing

 What's next?

  Additional resourcesAdditional resources

Windows Mixed Reality applications use the following APIs to build mixed-reality experiences for HoloLens and

other immersive headsets:

You can find upcoming and in-development core features in the OpenXR roadmap documentation.

You can develop on a desktop using OpenXR on a HoloLens 2 or Windows Mixed Reality immersive headset. If

you don't have access to a headset, you can use the HoloLens 2 Emulator or the Windows Mixed Reality

Simulator instead.

A developer's job is never done, especially when learning a new tool or SDK. The following sections can take you

into areas beyond the beginner level material you've already completed. These topics and resources aren't in

any sequential order, so feel free to jump around and explore!

If you're looking to level up your OpenXR game, check out the links below:

OpenXR best practices

OpenXR performance



 See also

OpenXR troubleshooting

App model

App views test
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NOTENOTE

 How do I get started?

 Creating a UWP project

This article relates to the legacy WinRT native APIs. For new native app projects, we recommend using the OpenXR APIOpenXR API .

A holographic app you create for a HoloLens will be a Universal Windows Platform (UWP) app. If targeting

desktop Windows Mixed Reality headsets, you can create a UWP app or a Win32 app.

The DirectX 11 holographic UWP app template is much like the DirectX 11 UWP app template. The template

includes a program loop, a DeviceResourcesDeviceResources  class to manage the Direct3D device and context, and a simplified

content renderer class. It also has an IFrameworkView, just like any other UWP app.

The mixed reality app, however, has some additional capabilities that aren't present in a typical Direct3D UWP

app. The Windows Mixed Reality app template can:

Handle Direct3D device resources associated with holographic cameras.

Retrieve camera back buffers from the system. In the case of Direct3D12, create holographic back buffer

resources and manage resource lifetimes.

Handle gaze input, and recognize a gesture.

Go into full-screen stereo rendering mode.

First install the tools, following the instructions on downloading Visual Studio 2019 and the Windows Mixed

Reality app templates. The mixed reality app templates are available on the Visual Studio marketplace as a web

download, or by installing them as an extension through the Visual Studio UI.

Now you're ready to create your DirectX 11 Windows Mixed Reality app! Note, to remove the sample content,

comment out the DRAW_SAMPLE_CONTENTDRAW_SAMPLE_CONTENT preprocessor directive in pch.h.

Once the tools are installed, you can then create a holographic DirectX UWP project.

To create a new project in Visual Studio 2019:

1. Start Visual StudioVisual Studio.

2. In the Get Star tedGet Star ted section on the right, select Create a new projectCreate a new project.

3. In the drop-down menus in the Create a new projectCreate a new project dialog, select C++C++, Windows Mixed RealityWindows Mixed Reality , and

UWPUWP.

4. Select Holographic DirectX 11 App (Universal Windows) (C++/WinRT)Holographic DirectX 11 App (Universal Windows) (C++/WinRT) . 

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/creating-a-holographic-directx-project.md
https://docs.microsoft.com/en-us/windows/uwp/get-started/universal-application-platform-guide
https://docs.microsoft.com/en-us/uwp/api/windows.applicationmodel.core.iframeworkview
https://marketplace.visualstudio.com/items?itemName=WindowsMixedRealityteam.WindowsMixedRealityAppTemplatesVSIX


Holographic DirectX 11 C++/WinRT UWP app project template in Visual Studio 2019

IMPORTANTIMPORTANT

5. Select NextNext.

6. Fill in the Project nameProject name and LocationLocation text boxes, and select or tap CreateCreate. The holographic app project is

created.

7. For development targeting only HoloLens 2, ensure that the Target versionTarget version and Minimum versionMinimum version are set

to Windows 10, version 1903Windows 10, version 1903 . If you're also targeting HoloLens (1st gen) or desktop Windows Mixed

Reality headsets, you can set Minimum versionMinimum version to Windows 10, version 1809Windows 10, version 1809 . This will require some

version adaptive checks in your code when using new features of HoloLens 2. 

Setting Windows 10, version 1903Windows 10, version 1903  as the target and minimum versions

Be sure that the project template's name includes "(C++/WinRT)". If not, you have an older version of the

holographic project templates installed. To get the latest project templates, install them as an extension to Visual

Studio 2019.

https://docs.microsoft.com/en-us/windows/uwp/debug-test-perf/version-adaptive-code


IMPORTANTIMPORTANT
If you do not see Windows 10, version 1903Windows 10, version 1903  as an option, you do not have the latest Windows 10 SDK

installed. To get this option to appear, install version 10.0.18362.0 or later of the Windows 10 SDK.

To create a new project in Visual Studio 2017:

1. Start Visual StudioVisual Studio.

2. From the FileFile menu, point to NewNew  and select ProjectProject from the context menu. The New ProjectNew Project dialog

opens.

3. Expand InstalledInstalled on the left and expand the Visual C++Visual C++ language node.

4. Navigate to the Windows Universal > HolographicWindows Universal > Holographic node and select Holographic DirectX 11 AppHolographic DirectX 11 App

(Universal Windows) (C++/WinRT)(Universal Windows) (C++/WinRT) . 

Holographic DirectX 11 C++/WinRT UWP app project template in Visual Studio 2017

IMPORTANTIMPORTANT

5. Fill in the NameName and LocationLocation text boxes, and select or tap OKOK. The holographic app project is created.

6. For development targeting only HoloLens 2, ensure that the Target versionTarget version and Minimum versionMinimum version are set

to Windows 10, version 1903Windows 10, version 1903 . If you're also targeting HoloLens (1st gen) or desktop Windows Mixed

Reality headsets, you can set Minimum versionMinimum version to Windows 10, version 1809Windows 10, version 1809 . This will require some

version adaptive checks in your code when using new features of HoloLens 2. 

Be sure that the project template's name includes "(C++/WinRT)". If not, you have an older version of the

holographic project templates installed. To get the latest project templates, install them as an extension to Visual

Studio 2017.

https://developer.microsoft.com/windows/downloads/windows-10-sdk
https://docs.microsoft.com/en-us/windows/uwp/debug-test-perf/version-adaptive-code


  UWP app entry pointUWP app entry point

// The main function bootstraps into the IFrameworkView.
int __stdcall wWinMain(HINSTANCE, HINSTANCE, PWSTR, int)
{
    winrt::init_apartment();
    CoreApplication::Run(AppViewSource());
    return 0;
}

 Creating a Win32 project

Setting Windows 10, version 1903Windows 10, version 1903  as the target and minimum versions

IMPORTANTIMPORTANT
If you do not see Windows 10, version 1903Windows 10, version 1903  as an option, you do not have the latest Windows 10 SDK

installed. To get this option to appear, install version 10.0.18362.0 or later of the Windows 10 SDK.

The template generates a project using C++/WinRT, a C++17 language projection of the Windows Runtime

APIs that supports any standards-compliant C++17 compiler. The project shows how to create a world-locked

cube that's placed 2 meters from the user. The user can air-tap or press a button on the controller to place the

cube in a different position specified by the user's gaze. You can modify this project to create any mixed reality

app.

You can also create a new project using the Visual C#Visual C# holographic project template, which is based on

SharpDX. If your holographic C# project didn't start from the Windows Holographic app template, you'll need to

copy the ms.fxcompile.targets file from a Windows Mixed Reality C# template project and import it in

your.csproj file to compile HLSL files that you add to your project. A Direct3D 12 template is also provided in the

Windows Mixed Reality app templates extension to Visual Studio.

Review Using Visual Studio to deploy and debug for information on how to build and deploy the sample to your

HoloLens, PC with immersive device attached, or an emulator.

The rest of the instructions below will assume that you're using C++ to build your app.

Your holographic UWP app starts in the wWinMainwWinMain function in AppView.cpp. The wWinMainwWinMain function creates

the app's IFrameworkView and starts the CoreApplication with it.

From AppView.cppAppView.cpp:

From that point on, the AppView class handles interaction with Windows basic input events, CoreWindow

events and messaging, and so on. It will also create the HolographicSpace used by your app.

The easiest way to get started building a Win32 holographic project is to adapt the BasicHologram Win32

sample.

https://developer.microsoft.com/windows/downloads/windows-10-sdk
https://docs.microsoft.com/en-us/windows/uwp/cpp-and-winrt-apis/
https://docs.microsoft.com/en-us/uwp/api/windows.applicationmodel.core.iframeworkview
https://docs.microsoft.com/en-us/uwp/api/windows.applicationmodel.core.coreapplication
https://github.com/Microsoft/Windows-classic-samples/tree/master/Samples/BasicHologram


  Win32 app entry pointWin32 app entry point

int APIENTRY wWinMain(
    _In_     HINSTANCE hInstance,
    _In_opt_ HINSTANCE hPrevInstance,
    _In_     LPWSTR    lpCmdLine,
    _In_     int       nCmdShow)
{
    UNREFERENCED_PARAMETER(hPrevInstance);
    UNREFERENCED_PARAMETER(lpCmdLine);

    winrt::init_apartment();

    App app;

    // Initialize global strings, and perform application initialization.
    app.Initialize(hInstance);

    // Create the HWND and the HolographicSpace.
    app.CreateWindowAndHolographicSpace(hInstance, nCmdShow);

    // Main message loop:
    app.Run(hInstance);

    // Perform application teardown.
    app.Uninitialize();

    return 0;
}

 Render holographic content

M ET H O DM ET H O D EXP L A N AT IO NEXP L A N AT IO N

CreateDeviceDependentResources Loads shaders and creates the cube mesh.

PositionHologram Places the hologram at the location specified by the
provided SpatialPointerPose.

Update Rotates the cube, and sets the model matrix.

Render Renders a frame using the vertex and pixel shaders.

This Win32 sample uses C++/WinRT, a C++17 language projection of the Windows Runtime APIs that supports

any standards-compliant C++17 compiler. The project shows how to create a world-locked cube that's placed 2

meters from the user. The user can press a button on the controller to place the cube in a different position that's

specified by the user's gaze. You can modify this project to create any mixed reality app.

Your holographic Win32 app starts in the wWinMainwWinMain function in AppMain.cpp. The wWinMainwWinMain function

creates the app's HWND and starts its message loop.

From AppMain.cppAppMain.cpp:

From that point on, the AppMain class handles interaction with basic window messages, and so on. It will also

create the HolographicSpace used by your app.

The project's ContentContent folder contains classes for rendering holograms in the holographic space. The default

hologram in the template is a spinning cube that's placed 2 meters away from the user. Drawing this cube is

implemented in SpinningCubeRenderer.cppSpinningCubeRenderer.cpp, which has these key methods:

https://docs.microsoft.com/en-us/windows/uwp/cpp-and-winrt-apis/
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialpointerpose


SH A DERSH A DER EXP L A N AT IO NEXP L A N AT IO N

GeometryShader.hlsl A pass-through that leaves the geometry unmodified.

PixelShader.hlsl Passes through the color data. The color data is interpolated
and assigned to a pixel at the rasterization step.

VertexShader.hlsl Simple shader to do vertex processing on the GPU.

VPRTVertexShader.hlsl Simple shader to do vertex processing on the GPU, that is
optimized for Windows Mixed Reality stereo rendering.

 Interact with your holograms

 Update holographic content

 Notes

 See also

The ShadersShaders  subfolder contains four default shader implementations:

VertexShaderShared.hlsl  contains common code shared between VertexShader.hlsl  and 

VPRTVertexShader.hlsl .

Note: The Direct3D 12 app template also includes ViewInstancingVertexShader.hlsl . This variant uses D3D12

optional features to render stereo images more efficiently.

The shaders compile when the project is built, and loaded in the

SpinningCubeRenderer ::CreateDeviceDependentResourcesSpinningCubeRenderer ::CreateDeviceDependentResources  method.

User input is processed in the SpatialInputHandlerSpatialInputHandler  class, which gets a SpatialInteractionManager instance and

subscribes to the SourcePressed event. This enables detecting the air-tap gesture and other spatial input events.

Your mixed reality app updates in a game loop, which by default is implemented in the UpdateUpdate method in 

AppMain.cpp . The UpdateUpdate method updates scene objects, like the spinning cube, and returns a

HolographicFrame object that is used to get up-to-date view and projection matrices and to present the swap

chain.

The RenderRender  method in AppMain.cpp  takes the HolographicFrame and renders the current frame to each

holographic camera, according to the current app and spatial positioning state.

The Windows Mixed Reality app template now supports compilation with the Spectre mitigation flag enabled

(/Qspectre). Make sure to install the Spectre-mitigated version of the Microsoft Visual C++ (MSVC) runtime

libraries before compiling a configuration with Spectre mitigation enabled. To install the Spectre-mitigated C++

libraries, launch the Visual Studio Installer and select ModifyModify . Navigate to Individual componentsIndividual components  and search

for "spectre". Select the boxes corresponding to the target platforms and MSVC version that you need to compile

Spectre-mitigated code for, and click ModifyModify  to begin the install.

Getting a HolographicSpace

HolographicSpace

Rendering in DirectX

Using Visual Studio to deploy and debug

Using the HoloLens emulator

https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionmanager
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionmanager.sourcepressed
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframe
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframe
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicspaceh


Using XAML with holographic DirectX apps
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NOTENOTE

 Set up the holographic space

m_holographicSpace = HolographicSpace::CreateForCoreWindow(window);

This article relates to the legacy WinRT native APIs. For new native app projects, we recommend using the OpenXR APIOpenXR API .

The HolographicSpace class is your portal into the holographic world. It controls immersive rendering, provides

camera data, and provides access to spatial reasoning APIs. You'll create one for your UWP app's CoreWindow

or your Win32 app's HWND.

Creating the holographic space object is the first step in making your Windows Mixed Reality app. Traditional

Windows apps render to a Direct3D swap chain created for the core window of their application view. This swap

chain is displayed to a slate in the holographic UI. To make your application view holographic rather than a 2D

slate, create a holographic space for its core window instead of a swap chain. Presenting holographic frames

that are created by this holographic space puts your app into full-screen rendering mode.

For a UWP appUWP app starting from the Holographic DirectX 11 App (Universal Windows) template, look for this code

in the SetWindowSetWindow  method in AppView.cpp:

If you're building a Win32 appWin32 app starting from the BasicHologram Win32 sample, look at

App::CreateWindowAndHolographicSpaceApp::CreateWindowAndHolographicSpace for an HWND example. You can then convert it into an

immersive HWND by creating an associated HolographicSpace:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/getting-a-holographicspace.md
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicspace
https://docs.microsoft.com/api/windows.ui.core.corewindow
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicspace


void App::CreateWindowAndHolographicSpace(HINSTANCE hInstance, int nCmdShow)
{
    // Store the instance handle in our class variable.
    m_hInst = hInstance;

    // Create the window for the HolographicSpace.
    hWnd = CreateWindowW(
        m_szWindowClass, 
        m_szTitle,
        WS_VISIBLE,
        CW_USEDEFAULT, 
        0, 
        CW_USEDEFAULT, 
        0, 
        nullptr, 
        nullptr, 
        hInstance, 
        nullptr);

    if (!hWnd)
    {
        winrt::check_hresult(E_FAIL);
    }

    {
        // Use WinRT factory to create the holographic space.
        using namespace winrt::Windows::Graphics::Holographic;
        winrt::com_ptr<IHolographicSpaceInterop> holographicSpaceInterop =
            winrt::get_activation_factory<HolographicSpace, IHolographicSpaceInterop>();
        winrt::com_ptr<ABI::Windows::Graphics::Holographic::IHolographicSpace> spHolographicSpace;
        winrt::check_hresult(holographicSpaceInterop->CreateForWindow(
            hWnd, __uuidof(ABI::Windows::Graphics::Holographic::IHolographicSpace),
            winrt::put_abi(spHolographicSpace)));

        if (!spHolographicSpace)
        {
            winrt::check_hresult(E_FAIL);
        }

        // Store the holographic space.
        m_holographicSpace = spHolographicSpace.as<HolographicSpace>();
    }

    // The DeviceResources class uses the preferred DXGI adapter ID from the holographic
    // space (when available) to create a Direct3D device. The HolographicSpace
    // uses this ID3D11Device to create and manage device-based resources such as
    // swap chains.
    m_deviceResources->SetHolographicSpace(m_holographicSpace);

    // The main class uses the holographic space for updates and rendering.
    m_main->SetHolographicSpace(hWnd, m_holographicSpace);

    // Show the window. This will activate the holographic view and switch focus
    // to the app in Windows Mixed Reality.
    ShowWindow(hWnd, nCmdShow);
    UpdateWindow(hWnd);
}

Once you've obtained a HolographicSpace for either your UWP CoreWindow or Win32 HWND, the

HolographicSpace can handle holographic cameras, create coordinate systems, and do holographic rendering.

The current holographic space is used in multiple places in the DirectX template:

The DeviceResourcesDeviceResources  class needs to get some information from the HolographicSpace object to create the

Direct3D device. This is the DXGI adapter ID associated with the holographic display. The HolographicSpace

class uses your app's Direct3D 11 device to create and manage device-based resources, such as the back

https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicspace


NOTENOTE

 Subscribe to camera events, create, and remove camera resources

m_cameraAddedToken = m_holographicSpace.CameraAdded(
    std::bind(&AppMain::OnCameraAdded, this, _1, _2));

m_cameraRemovedToken = m_holographicSpace.CameraRemoved(
    std::bind(&AppMain::OnCameraRemoved, this, _1, _2));

buffers for each holographic camera. If you're interested in seeing what this function does under the hood,

you'll find it in DeviceResources.cpp.

The function DeviceResources::InitializeUsingHolographicSpaceDeviceResources::InitializeUsingHolographicSpace demonstrates how to obtain the

adapter by looking up the LUID – and how to choose a default adapter when no preferred adapter is

specified.

The app's main class uses the holographic space from AppView::SetWindowAppView::SetWindow  or

App::CreateWindowAndHolographicSpaceApp::CreateWindowAndHolographicSpace for updates and rendering.

While the sections below mention function names from the template like AppView::SetWindowAppView::SetWindow that assume that you

started from the holographic UWP app template, the code snippets you see will apply equally across UWP and Win32

apps.

Next, we'll dive into the setup process that SetHolographicSpaceSetHolographicSpace is responsible for in the AppMain class.

Your app's holographic content lives in its holographic space, and is viewed through one or more holographic

cameras, which represent different perspectives on the scene. Now that you have the holographic space, you can

receive data for holographic cameras.

Your app needs to respond to CameraAddedCameraAdded events by creating any resources that are specific to that camera.

An example of such a resource is your back buffer render target view. You can see this code in the

DeviceResources::SetHolographicSpaceDeviceResources::SetHolographicSpace function, called by AppView::SetWindowAppView::SetWindow  before the app creates

any holographic frames:

Your app also needs to respond to CameraRemovedCameraRemoved events by releasing resources that were created for that

camera.

From DeviceResources::SetHolographicSpaceDeviceResources::SetHolographicSpace:

The event handlers must complete some work to keep holographic rendering flowing smoothly, and your app

rendering at all. Read the code and comments for the details: you can look for OnCameraAddedOnCameraAdded and

OnCameraRemovedOnCameraRemoved in your main class to understand how the m_cameraResourcesm_cameraResources  map is handled by

DeviceResourcesDeviceResources .

Right now, we're focused on AppMain and the setup that it does to enable your app to know about holographic

cameras. With this in mind, it's important to take note of the following two requirements:

1. For the CameraAddedCameraAdded event handler, the app can work asynchronously to finish creating resources and

loading assets for the new holographic camera. Apps that take more than one frame to complete this

work should request a deferral, and complete the deferral after loading asynchronously. A PPL task can

be used to do asynchronous work. Your app must ensure that it's ready to render to that camera right

away when it exits the event handler, or when it completes the deferral. Exiting the event handler or

completing the deferral tells the system that your app is now ready to receive holographic frames with

that camera included.

https://docs.microsoft.com/en-us/cpp/parallel/concrt/parallel-patterns-library-ppl


NOTENOTE

 Create a frame of reference for your holographic content

spatialLocator = SpatialLocator::GetDefault();

m_stationaryReferenceFrame =
    m_spatialLocator.CreateStationaryFrameOfReferenceAtCurrentLocation();

2. When the app receives a CameraRemovedCameraRemoved event, it must release all references to the back buffer and

exit the function right away. This includes render target views, and any other resource that might hold a

reference to the IDXGIResource. The app must also ensure that the back buffer isn't attached as a render

target, as shown in CameraResources::ReleaseResourcesForBackBufferCameraResources::ReleaseResourcesForBackBuffer . To help speed things along,

your app can release the back buffer and then launch a task to asynchronously complete any other tear

down work for the camera. The holographic app template includes a PPL task that you can use for this

purpose.

If you want to determine when an added or removed camera shows up on the frame, use the HolographicFrameHolographicFrame

AddedCameras and RemovedCameras properties.

Your app's content must be positioned in a spatial coordinate system to be rendered in the HolographicSpace.

The system provides two primary frames of reference, which you can use to establish a coordinate system for

your holograms.

There are two kinds of reference frames in Windows Holographic: reference frames attached to the device, and

reference frames that remain stationary as the device moves through the user's environment. The holographic

app template uses a stationary reference frame by default; this is one of the simplest ways to render world-

locked holograms.

Stationary reference frames are designed to stabilize positions near the device's current location. This means

that coordinates further from the device can drift slightly relative to the user's environment as the device learns

more about the space around it. There are two ways to create a stationary frame of reference: acquire the

coordinate system from the spatial stage, or use the default SpatialLocator. If you're creating a Windows Mixed

Reality app for immersive headsets, the recommended starting point is the spatial stage. The spatial stage also

provides information about the capabilities of the immersive headset worn by the player. Here, we show how to

use the default SpatialLocator.

The spatial locator represents the Windows Mixed Reality device, and tracks the motion of the device and

provides coordinate systems that can be understood relative to its location.

From AppMain::OnHolographicDisplayIsAvailableChangedAppMain::OnHolographicDisplayIsAvailableChanged:

Create the stationary reference frame once when the app is launched. This is analogous to defining a world

coordinate system, with the origin placed at the device's position when the app is launched. This reference frame

doesn't move with the device.

From AppMain::SetHolographicSpaceAppMain::SetHolographicSpace:

All reference frames are gravity aligned, meaning that the y-axis points "up" in relation to the user's

environment. Since Windows uses "right-handed" coordinate systems, the direction of the –z axis coincides with

the "forward" direction the device is facing when the reference frame is created.

https://docs.microsoft.com/en-us/windows/desktop/api/dxgi/nn-dxgi-idxgiresource
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframe.addedcameras
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframe.removedcameras
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatiallocator
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatiallocator


NOTENOTE

 Respond to locatability changed events

m_locatabilityChangedToken = m_spatialLocator.LocatabilityChanged(
    std::bind(&HolographicApp6Main::OnLocatabilityChanged, this, _1, _2));

 See also

When your app requires precise placement of individual holograms, use a SpatialAnchor to anchor the individual

hologram to a position in the real world. For example, use a spatial anchor when the user indicates a point to be of special

interest. Anchor positions do not drift, but they can be adjusted. By default, when an anchor is adjusted, it eases its

position into place over the next several frames after the correction has occurred. Depending on your application, when

this occurs you may want to handle the adjustment in a different manner (e.g. by deferring it until the hologram is out of

view). The RawCoordinateSystem property and RawCoordinateSystemAdjusted events enable these customizations.

Rendering world-locked holograms requires the device to locate itself in the world. This may not always be

possible because of environmental conditions, and if so, the user may expect a visual indication of the tracking

interruption. This visual indication must be rendered using reference frames attached to the device, instead of

stationary to the world.

Your app can request to be notified if tracking is interrupted for any reason. Register for the LocatabilityChanged

event to detect when the device's ability to locate itself in the world changes. From

AppMain::SetHolographicSpace:AppMain::SetHolographicSpace:

Then use this event to determine when holograms cannot be rendered stationary to the world.

Rendering in DirectX

Coordinate systems in DirectX

https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialanchor
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialanchor.rawcoordinatesystem
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialanchor.rawcoordinatesystemadjusted
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NOTENOTE

 Update for the current frame

  Create a new holographic frame and get its predictionCreate a new holographic frame and get its prediction

// The HolographicFrame has information that the app needs in order
// to update and render the current frame. The app begins each new
// frame by calling CreateNextFrame.
HolographicFrame holographicFrame = m_holographicSpace.CreateNextFrame();

// Get a prediction of where holographic cameras will be when this frame
// is presented.
HolographicFramePrediction prediction = holographicFrame.CurrentPrediction();

  Process camera updatesProcess camera updates

This article relates to the legacy WinRT native APIs. For new native app projects, we recommend using the OpenXR APIOpenXR API .

Windows Mixed Reality is built on DirectX to produce rich, 3D graphical experiences for users. The rendering

abstraction sits just above DirectX, which lets apps reason about the position and orientation of holographic

scene observers predicted by the system. The developer can then locate their holograms based on each camera,

letting the app render these holograms in various spatial coordinate systems as the user moves around.

Note: This walkthrough describes holographic rendering in Direct3D 11. A Direct3D 12 Windows Mixed Reality

app template is also supplied with the Mixed Reality app templates extension.

To update the application state for holograms, once per frame the app will:

Get a HolographicFrame from the display management system.

Update the scene with the current prediction of where the camera view will be when render is completed.

Note, there can be more than one camera for the holographic scene.

To render to holographic camera views, once per frame the app will:

For each camera, render the scene for the current frame, using the camera view and projection matrices from

the system.

The HolographicFrame has information that the app needs to update and render the current frame. The app

begins each new frame by calling the CreateNextFrameCreateNextFrame method. When this method is called, predictions are

made using the latest sensor data available, and encapsulated in CurrentPredictionCurrentPrediction object.

A new frame object must be used for each rendered frame as it is only valid for an instant in time. The

CurrentPredictionCurrentPrediction property contains information such as the camera position. The information is extrapolated

to the exact moment in time when the frame is expected to be visible to the user.

The following code is excerpted from AppMain::UpdateAppMain::Update:

Back buffers can change from frame to frame. Your app needs to validate the back buffer for each camera, and

release and recreate resource views and depth buffers as needed. Notice that the set of poses in the prediction is

the authoritative list of cameras being used in the current frame. Usually, you use this list to iterate on the set of

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/rendering-in-directx.md
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframe
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframe


m_deviceResources->EnsureCameraResources(holographicFrame, prediction);

for (HolographicCameraPose const& cameraPose : prediction.CameraPoses())
{
    HolographicCameraRenderingParameters renderingParameters = frame.GetRenderingParameters(cameraPose);
    CameraResources* pCameraResources = cameraResourceMap[cameraPose.HolographicCamera().Id()].get();
    pCameraResources->CreateResourcesForBackBuffer(this, renderingParameters);
}

  Get the coordinate system to use as a basis for renderingGet the coordinate system to use as a basis for rendering

pose = SpatialPointerPose::TryGetAtTimestamp(
    m_stationaryReferenceFrame.CoordinateSystem(), prediction.Timestamp());

// Get a container object with the view and projection matrices for the given
// pose in the given coordinate system.
auto viewTransformContainer = cameraPose.TryGetViewTransform(coordinateSystem);

  Process gaze and gesture inputProcess gaze and gesture input

  Process time-based updatesProcess time-based updates

cameras.

From AppMain::UpdateAppMain::Update:

From DeviceResources::EnsureCameraResourcesDeviceResources::EnsureCameraResources :

Windows Mixed Reality lets your app create various coordinate systems, like attached and stationary reference

frames for tracking locations in the physical world. Your app can then use these coordinate systems to reason

about where to render holograms each frame. When requesting coordinates from an API, you'll always pass in

the SpatialCoordinateSystem within which you want those coordinates to be expressed.

From AppMain::UpdateAppMain::Update:

These coordinate systems can then be used to generate stereo view matrices when rendering the content in

your scene.

From CameraResources::UpdateViewProjectionBufferCameraResources::UpdateViewProjectionBuffer :

Gaze and hand input aren't time-based and don't have to update in the StepTimerStepTimer  function. However this input

is something that the app needs to look at each frame.

Any real-time rendering app will need some way to process time-based updates - the Windows Holographic

app template uses a StepTimerStepTimer  implementation, similar to the StepTimer provided in the DirectX 11 UWP app

template. This StepTimer sample helper class can provide fixed time-step updates, variable time-step updates,

and the default mode is variable time steps.

For holographic rendering, we've chosen not to put too much into the timer function because you can configure

it to be a fixed time step. It might get called more than once per frame – or not at all, for some frames – and our

holographic data updates should happen once per frame.

From AppMain::UpdateAppMain::Update:

https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialcoordinatesystem


m_timer.Tick([this]()
{
    m_spinningCubeRenderer->Update(m_timer);
});

  Position and rotate holograms in your coordinate systemPosition and rotate holograms in your coordinate system

// Rotate the cube.
// Convert degrees to radians, then convert seconds to rotation angle.
const float    radiansPerSecond = XMConvertToRadians(m_degreesPerSecond);
const double   totalRotation = timer.GetTotalSeconds() * radiansPerSecond;
const float    radians = static_cast<float>(fmod(totalRotation, XM_2PI));
const XMMATRIX modelRotation = XMMatrixRotationY(-radians);

// Position the cube.
const XMMATRIX modelTranslation = XMMatrixTranslationFromVector(XMLoadFloat3(&m_position));

// Multiply to get the transform matrix.
// Note that this transform does not enforce a particular coordinate system. The calling
// class is responsible for rendering this content in a consistent manner.
const XMMATRIX modelTransform = XMMatrixMultiply(modelRotation, modelTranslation);

// The view and projection matrices are provided by the system; they are associated
// with holographic cameras, and updated on a per-camera basis.
// Here, we provide the model transform for the sample hologram. The model transform
// matrix is transposed to prepare it for the shader.
XMStoreFloat4x4(&m_modelConstantBufferData.model, XMMatrixTranspose(modelTransform));

  Update constant buffer dataUpdate constant buffer data

// Update the model transform buffer for the hologram.
context->UpdateSubresource(
    m_modelConstantBuffer.Get(),
    0,
    nullptr,
    &m_modelConstantBufferData,
    0,
    0
);

 Render the current frame

If you're operating in a single coordinate system, as the template does with the

SpatialStationar yReferenceFrameSpatialStationar yReferenceFrame, this process isn't different from what you're otherwise used to in 3D

graphics. Here, we rotate the cube and set the model matrix based on the position in the stationary coordinate

system.

From SpinningCubeRenderer ::UpdateSpinningCubeRenderer ::Update:

Note about advanced scenarios:Note about advanced scenarios: The spinning cube is a simple example of how to position a hologram

within a single reference frame. It's also possible to use multiple SpatialCoordinateSystems in the same

rendered frame, at the same time.

Model transforms for content are updated as usual. By now, you'll have computed valid transforms for the

coordinate system you'll be rendering in.

From SpinningCubeRenderer ::UpdateSpinningCubeRenderer ::Update:

What about view and projection transforms? For best results, we want to wait until we're almost ready for our

draw calls before we get these.



  Get an updated HolographicFrame predictionGet an updated HolographicFrame prediction

holographicFrame.UpdateCurrentPrediction();
HolographicFramePrediction prediction = holographicFrame.CurrentPrediction();

  Render to each cameraRender to each camera

Rendering on Windows Mixed Reality isn't much different from rendering on a 2D mono display, but there are a

few differences:

Holographic frame predictions are important. The closer the prediction is to when your frame is presented,

the better your holograms will look.

Windows Mixed Reality controls the camera views. Render to each one because the holographic frame will be

presenting them for you later.

We recommend doing stereo rendering using instanced drawing to a render target array. The holographic

app template uses the recommended approach of instanced drawing to a render target array, which uses a

render target view onto a Texture2DArrayTexture2DArray .

If you want to render without using stereo instancing, you'll need to create two non-array

RenderTargetViews, one for each eye. Each RenderTargetViews references one of the two slices in the

Texture2DArrayTexture2DArray  provided to the app from the system. This isn't recommended, as it's typically slower than

using instancing.

Updating the frame prediction enhances the effectiveness of image stabilization. You get more accurate

positioning of holograms because of the shorter time between the prediction and when the frame is visible to

the user. Ideally update your frame prediction just before rendering.

Loop on the set of camera poses in the prediction, and render to each camera in this set.

Set up your rendering passSet up your rendering pass

Windows Mixed Reality uses stereoscopic rendering to enhance the illusion of depth and to render

stereoscopically, so both the left and the right display are active. With stereoscopic rendering, there's an offset

between the two displays, which the brain can reconcile as actual depth. This section covers stereoscopic

rendering using instancing, using code from the Windows Holographic app template.

Each camera has its own render target (back buffer), and view and projection matrices, into the holographic

space. Your app will need to create any other camera-based resources - such as the depth buffer - on a per-

camera basis. In the Windows Holographic app template, we provide a helper class to bundle these resources

together in DX::CameraResources. Start by setting up the render target views:

From AppMain::RenderAppMain::Render :



// This represents the device-based resources for a HolographicCamera.
DX::CameraResources* pCameraResources = cameraResourceMap[cameraPose.HolographicCamera().Id()].get();

// Get the device context.
const auto context = m_deviceResources->GetD3DDeviceContext();
const auto depthStencilView = pCameraResources->GetDepthStencilView();

// Set render targets to the current holographic camera.
ID3D11RenderTargetView *const targets[1] =
    { pCameraResources->GetBackBufferRenderTargetView() };
context->OMSetRenderTargets(1, targets, depthStencilView);

// Clear the back buffer and depth stencil view.
if (m_canGetHolographicDisplayForCamera &&
    cameraPose.HolographicCamera().Display().IsOpaque())
{
    context->ClearRenderTargetView(targets[0], DirectX::Colors::CornflowerBlue);
}
else
{
    context->ClearRenderTargetView(targets[0], DirectX::Colors::Transparent);
}
context->ClearDepthStencilView(
    depthStencilView, D3D11_CLEAR_DEPTH | D3D11_CLEAR_STENCIL, 1.0f, 0);

// The view and projection matrices for each holographic camera will change
// every frame. This function refreshes the data in the constant buffer for
// the holographic camera indicated by cameraPose.
if (m_stationaryReferenceFrame)
{
    pCameraResources->UpdateViewProjectionBuffer(
        m_deviceResources, cameraPose, m_stationaryReferenceFrame.CoordinateSystem());
}

// Attach the view/projection constant buffer for this camera to the graphics pipeline.
bool cameraActive = pCameraResources->AttachViewProjectionBuffer(m_deviceResources);

Use the prediction to get the view and projection matr ices for the cameraUse the prediction to get the view and projection matr ices for the camera

The view and projection matrices for each holographic camera will change with every frame. Refresh the data in

the constant buffer for each holographic camera. Do this after you updated the prediction, and before you make

any draw calls for that camera.

From AppMain::RenderAppMain::Render :

Here, we show how the matrices are acquired from the camera pose. During this process, we also obtain the

current viewport for the camera. Note how we provide a coordinate system: this is the same coordinate system

we used to understand gaze, and it's the same one we used to position the spinning cube.

From CameraResources::UpdateViewProjectionBufferCameraResources::UpdateViewProjectionBuffer :



// The system changes the viewport on a per-frame basis for system optimizations.
auto viewport = cameraPose.Viewport();
m_d3dViewport = CD3D11_VIEWPORT(
    viewport.X,
    viewport.Y,
    viewport.Width,
    viewport.Height
);

// The projection transform for each frame is provided by the HolographicCameraPose.
HolographicStereoTransform cameraProjectionTransform = cameraPose.ProjectionTransform();

// Get a container object with the view and projection matrices for the given
// pose in the given coordinate system.
auto viewTransformContainer = cameraPose.TryGetViewTransform(coordinateSystem);

// If TryGetViewTransform returns a null pointer, that means the pose and coordinate
// system cannot be understood relative to one another; content cannot be rendered
// in this coordinate system for the duration of the current frame.
// This usually means that positional tracking is not active for the current frame, in
// which case it is possible to use a SpatialLocatorAttachedFrameOfReference to render
// content that is not world-locked instead.
DX::ViewProjectionConstantBuffer viewProjectionConstantBufferData;
bool viewTransformAcquired = viewTransformContainer != nullptr;
if (viewTransformAcquired)
{
    // Otherwise, the set of view transforms can be retrieved.
    HolographicStereoTransform viewCoordinateSystemTransform = viewTransformContainer.Value();

    // Update the view matrices. Holographic cameras (such as Microsoft HoloLens) are
    // constantly moving relative to the world. The view matrices need to be updated
    // every frame.
    XMStoreFloat4x4(
        &viewProjectionConstantBufferData.viewProjection[0],
        XMMatrixTranspose(XMLoadFloat4x4(&viewCoordinateSystemTransform.Left) *
            XMLoadFloat4x4(&cameraProjectionTransform.Left))
    );
    XMStoreFloat4x4(
        &viewProjectionConstantBufferData.viewProjection[1],
        XMMatrixTranspose(XMLoadFloat4x4(&viewCoordinateSystemTransform.Right) *
            XMLoadFloat4x4(&cameraProjectionTransform.Right))
    );
}

// Set the viewport for this camera.
context->RSSetViewports(1, &m_d3dViewport);

// Send the constant buffer to the vertex shader.
context->VSSetConstantBuffers(
    1,
    1,
    m_viewProjectionConstantBuffer.GetAddressOf()
);

The viewport should be set each frame. Your vertex shader (at least) will generally need access to the

view/projection data.

From CameraResources::AttachViewProjectionBufferCameraResources::AttachViewProjectionBuffer :

Render to the camera back buffer and commit the depth bufferRender to the camera back buffer and commit the depth buffer :

It's a good idea to check that Tr yGetViewTransformTr yGetViewTransform succeeded before trying to use the view/projection data,

because if the coordinate system isn't locatable (for example, tracking was interrupted) your app can't render

with it for that frame. The template only calls RenderRender  on the spinning cube if the CameraResourcesCameraResources  class



// Only render world-locked content when positional tracking is active.
if (cameraActive)
{
    // Draw the sample hologram.
    m_spinningCubeRenderer->Render();
    if (m_canCommitDirect3D11DepthBuffer)
    {
        // On versions of the platform that support the CommitDirect3D11DepthBuffer API, we can 
        // provide the depth buffer to the system, and it will use depth information to stabilize 
        // the image at a per-pixel level.
        HolographicCameraRenderingParameters renderingParameters =
            holographicFrame.GetRenderingParameters(cameraPose);
        
        IDirect3DSurface interopSurface =
            DX::CreateDepthTextureInteropObject(pCameraResources->GetDepthStencilTexture2D());

        // Calling CommitDirect3D11DepthBuffer causes the system to queue Direct3D commands to 
        // read the depth buffer. It will then use that information to stabilize the image as
        // the HolographicFrame is presented.
        renderingParameters.CommitDirect3D11DepthBuffer(interopSurface);
    }
}

NOTENOTE

indicates a successful update.

Windows Mixed Reality includes features for image stabilization to keep holograms positioned where a

developer or user puts them in the world. Image stabilization helps hide the latency inherent in a rendering

pipeline to ensure the best holographic experiences for users. A focus point may be specified to enhance image

stabilization even further, or a depth buffer may be provided to compute optimized image stabilization in real

time.

For best results, your app should provide a depth buffer using the CommitDirect3D11DepthBuffer API. Windows

Mixed Reality can then use geometry information from the depth buffer to optimize image stabilization in real

time. The Windows Holographic app template commits the app's depth buffer by default, helping optimize

hologram stability.

From AppMain::RenderAppMain::Render :

Windows will process your depth texture on the GPU, so it must be possible to use your depth buffer as a shader

resource. The ID3D11Texture2D that you create should be in a typeless format and it should be bound as a shader

resource view. Here is an example of how to create a depth texture that can be committed for image stabilization.

Code for Depth buffer resource creation for CommitDirect3D11DepthBufferDepth buffer resource creation for CommitDirect3D11DepthBuffer :

https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamerarenderingparameters.commitdirect3d11depthbuffer


// Create a depth stencil view for use with 3D rendering if needed.
CD3D11_TEXTURE2D_DESC depthStencilDesc(
    DXGI_FORMAT_R16_TYPELESS,
    static_cast<UINT>(m_d3dRenderTargetSize.Width),
    static_cast<UINT>(m_d3dRenderTargetSize.Height),
    m_isStereo ? 2 : 1, // Create two textures when rendering in stereo.
    1, // Use a single mipmap level.
    D3D11_BIND_DEPTH_STENCIL | D3D11_BIND_SHADER_RESOURCE
);

winrt::check_hresult(
    device->CreateTexture2D(
        &depthStencilDesc,
        nullptr,
        &m_d3dDepthStencil
    ));

CD3D11_DEPTH_STENCIL_VIEW_DESC depthStencilViewDesc(
    m_isStereo ? D3D11_DSV_DIMENSION_TEXTURE2DARRAY : D3D11_DSV_DIMENSION_TEXTURE2D,
    DXGI_FORMAT_D16_UNORM
);
winrt::check_hresult(
    device->CreateDepthStencilView(
        m_d3dDepthStencil.Get(),
        &depthStencilViewDesc,
        &m_d3dDepthStencilView
    ));

// Draw the objects.
context->DrawIndexedInstanced(
    m_indexCount,   // Index count per instance.
    2,              // Instance count.
    0,              // Start index location.
    0,              // Base vertex location.
    0               // Start instance location.
);

// A constant buffer that stores each set of view and projection matrices in column-major format.
cbuffer ViewProjectionConstantBuffer : register(b1)
{
    float4x4 viewProjection[2];
};

Draw holographic contentDraw holographic content

The Windows Holographic app template renders content in stereo by using the recommended technique of

drawing instanced geometry to a Texture2DArray of size 2. Let's look at the instancing part of this, and how it

works on Windows Mixed Reality.

From SpinningCubeRenderer ::RenderSpinningCubeRenderer ::Render :

Each instance accesses a different view/projection matrix from the constant buffer. Here's the constant buffer

structure, which is just an array of two matrices.

From Ver texShaderShared.hlslVer texShaderShared.hlsl , included by VPRTVer texShader.hlslVPRTVer texShader.hlsl :

The render target array index must be set for each pixel. In the following snippet, output.viewId is mapped to the

SV_RenderTargetArrayIndexSV_RenderTargetArrayIndex semantic. This requires support for an optional Direct3D 11.3 feature, which

allows the render target array index semantic to be set from any shader stage.

From VPRTVer texShader.hlslVPRTVer texShader.hlsl :



// Per-vertex data passed to the geometry shader.
struct VertexShaderOutput
{
    min16float4 pos     : SV_POSITION;
    min16float3 color   : COLOR0;

    // The render target array index is set here in the vertex shader.
    uint        viewId  : SV_RenderTargetArrayIndex;
};

// Per-vertex data used as input to the vertex shader.
struct VertexShaderInput
{
    min16float3 pos     : POSITION;
    min16float3 color   : COLOR0;
    uint        instId  : SV_InstanceID;
};

// Simple shader to do vertex processing on the GPU.
VertexShaderOutput main(VertexShaderInput input)
{
    VertexShaderOutput output;
    float4 pos = float4(input.pos, 1.0f);

    // Note which view this vertex has been sent to. Used for matrix lookup.
    // Taking the modulo of the instance ID allows geometry instancing to be used
    // along with stereo instanced drawing; in that case, two copies of each 
    // instance would be drawn, one for left and one for right.
    int idx = input.instId % 2;

    // Transform the vertex position into world space.
    pos = mul(pos, model);

    // Correct for perspective and project the vertex position onto the screen.
    pos = mul(pos, viewProjection[idx]);
    output.pos = (min16float4)pos;

    // Pass the color through without modification.
    output.color = input.color;

    // Set the render target array index.
    output.viewId = idx;

    return output;
}

  Important note about rendering stereo content on HoloLensImportant note about rendering stereo content on HoloLens

From Ver texShaderShared.hlslVer texShaderShared.hlsl , included by VPRTVer texShader.hlslVPRTVer texShader.hlsl :

If you want to use your existing instanced drawing techniques with this method of drawing to a stereo render

target array, draw twice the number of instances you normally have. In the shader, divide input.instIdinput.instId by 2 to

get the original instance ID, which can be indexed into (for example) a buffer of per-object data: 

int actualIdx = input.instId / 2;

Windows Mixed Reality supports the ability to set the render target array index from any shader stage.

Normally, this is a task that could only be done in the geometry shader stage because of the way the semantic is

defined for Direct3D 11. Here, we show a complete example of how to set up a rendering pipeline with just the

vertex and pixel shader stages set. The shader code is as described above.

From SpinningCubeRenderer ::RenderSpinningCubeRenderer ::Render :



const auto context = m_deviceResources->GetD3DDeviceContext();

// Each vertex is one instance of the VertexPositionColor struct.
const UINT stride = sizeof(VertexPositionColor);
const UINT offset = 0;
context->IASetVertexBuffers(
    0,
    1,
    m_vertexBuffer.GetAddressOf(),
    &stride,
    &offset
);
context->IASetIndexBuffer(
    m_indexBuffer.Get(),
    DXGI_FORMAT_R16_UINT, // Each index is one 16-bit unsigned integer (short).
    0
);
context->IASetPrimitiveTopology(D3D11_PRIMITIVE_TOPOLOGY_TRIANGLELIST);
context->IASetInputLayout(m_inputLayout.Get());

// Attach the vertex shader.
context->VSSetShader(
    m_vertexShader.Get(),
    nullptr,
    0
);
// Apply the model constant buffer to the vertex shader.
context->VSSetConstantBuffers(
    0,
    1,
    m_modelConstantBuffer.GetAddressOf()
);

// Attach the pixel shader.
context->PSSetShader(
    m_pixelShader.Get(),
    nullptr,
    0
);

// Draw the objects.
context->DrawIndexedInstanced(
    m_indexCount,   // Index count per instance.
    2,              // Instance count.
    0,              // Start index location.
    0,              // Base vertex location.
    0               // Start instance location.
);

  Important note about rendering on non-HoloLens devicesImportant note about rendering on non-HoloLens devices
Setting the render target array index in the vertex shader requires that the graphics driver supports an optional

Direct3D 11.3 feature, which HoloLens does support. Your app may can safely implement just that technique for

rendering, and all requirements will be met for running on the Microsoft HoloLens.

It may be the case that you want to use the HoloLens emulator as well, which can be a powerful development

tool for your holographic app - and support Windows Mixed Reality immersive headset devices that are

attached to Windows 10 PCs. Support for the non-HoloLens rendering path - for all of Windows Mixed Reality -

is also built into the Windows Holographic app template. In the template code, you'll find code to enable your

holographic app to run on the GPU in your development PC. Here's how the DeviceResourcesDeviceResources  class checks for

this optional feature support.

From DeviceResources::CreateDeviceResourcesDeviceResources::CreateDeviceResources :



// Check for device support for the optional feature that allows setting the render target array index from 
the vertex shader stage.
D3D11_FEATURE_DATA_D3D11_OPTIONS3 options;
m_d3dDevice->CheckFeatureSupport(D3D11_FEATURE_D3D11_OPTIONS3, &options, sizeof(options));
if (options.VPAndRTArrayIndexFromAnyShaderFeedingRasterizer)
{
    m_supportsVprt = true;
}

if (!m_usingVprtShaders)
{
    // On devices that do not support the D3D11_FEATURE_D3D11_OPTIONS3::
    // VPAndRTArrayIndexFromAnyShaderFeedingRasterizer optional feature,
    // a pass-through geometry shader is used to set the render target 
    // array index.
    context->GSSetShader(
        m_geometryShader.Get(),
        nullptr,
        0
    );
}

To support rendering without this optional feature, your app must use a geometry shader to set the render

target array index. This snippet would be added after VSSetConstantBuffersVSSetConstantBuffers , and before PSSetShaderPSSetShader  in the

code example shown in the previous section that explains how to render stereo on HoloLens.

From SpinningCubeRenderer ::RenderSpinningCubeRenderer ::Render :

HLSL NOTEHLSL NOTE: In this case, you must also load a slightly modified vertex shader that passes the render target

array index to the geometry shader using an always-allowed shader semantic, such as TEXCOORD0. The

geometry shader doesn't have to do any work; the template geometry shader passes through all data, with the

exception of the render target array index, which is used to set the SV_RenderTargetArrayIndex semantic.

App template code for Geometr yShader.hlslGeometr yShader.hlsl :



// Per-vertex data from the vertex shader.
struct GeometryShaderInput
{
    min16float4 pos     : SV_POSITION;
    min16float3 color   : COLOR0;
    uint instId         : TEXCOORD0;
};

// Per-vertex data passed to the rasterizer.
struct GeometryShaderOutput
{
    min16float4 pos     : SV_POSITION;
    min16float3 color   : COLOR0;
    uint rtvId          : SV_RenderTargetArrayIndex;
};

// This geometry shader is a pass-through that leaves the geometry unmodified 
// and sets the render target array index.
[maxvertexcount(3)]
void main(triangle GeometryShaderInput input[3], inout TriangleStream<GeometryShaderOutput> outStream)
{
    GeometryShaderOutput output;
    [unroll(3)]
    for (int i = 0; i < 3; ++i)
    {
        output.pos   = input[i].pos;
        output.color = input[i].color;
        output.rtvId = input[i].instId;
        outStream.Append(output);
    }
}

 Present
  Enable the holographic frame to present the swap chainEnable the holographic frame to present the swap chain

HolographicFramePresentResult presentResult = frame.PresentUsingCurrentPrediction();

  Handle DeviceLost scenarios in cooperation with the HolographicFrameHandle DeviceLost scenarios in cooperation with the HolographicFrame

With Windows Mixed Reality, the system controls the swap chain. The system then manages presenting frames

to each holographic camera to ensure a high-quality user experience. It also provides a viewport update each

frame, for each camera, to optimize aspects of the system such as image stabilization or Mixed Reality Capture.

So, a holographic app using DirectX doesn't call PresentPresent on a DXGI swap chain. Instead, you use the

HolographicFrame class to present all swapchains for a frame once you're done drawing it.

From DeviceResources::PresentDeviceResources::Present:

By default, this API waits for the frame to finish before it returns. Holographic apps should wait for the previous

frame to finish before starting work on a new frame, because this reduces latency and allows for better results

from holographic frame predictions. This isn't a hard rule, and if you have frames that take longer than one

screen refresh to render you can disable this wait by passing the HolographicFramePresentWaitBehavior

parameter to PresentUsingCurrentPrediction. In this case, you would likely use an asynchronous rendering

thread to maintain a continuous load on the GPU. The refresh rate of the HoloLens device is 60 hz, where one

frame has a duration of approximately 16 ms. Immersive headset devices can range from 60 hz to 90 hz; when

refreshing the display at 90 hz, each frame will have a duration of approximately 11 ms.

DirectX 11 apps would typically want to check the HRESULT returned by the DXGI swap chain's PresentPresent function

to find out if there was a DeviceLostDeviceLost error. The HolographicFrame class handles this for you. Inspect the

returned HolographicFramePresentResult to find out if you need to release and recreate the Direct3D device and

https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframe
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframe.presentusingcurrentprediction
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframe
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframepresentresult


// The PresentUsingCurrentPrediction API will detect when the graphics device
// changes or becomes invalid. When this happens, it is considered a Direct3D
// device lost scenario.
if (presentResult == HolographicFramePresentResult::DeviceRemoved)
{
    // The Direct3D device, context, and resources should be recreated.
    HandleDeviceLost();
}

m_holographicSpace.SetDirect3D11Device(m_d3dInteropDevice);

 Hybrid graphics PCs and mixed reality applications

device-based resources.

If the Direct3D device was lost, and you did recreate it, you have to tell the HolographicSpace to start using the

new device. The swap chain will be recreated for this device.

From DeviceResources::InitializeUsingHolographicSpaceDeviceResources::InitializeUsingHolographicSpace:

Once your frame is presented, you can return back to the main program loop and allow it to continue to the next

frame.

Windows 10 Creators Update PCs may be configured with bothboth discrete and integrated GPUs. With these types

of computers, Windows will choose the adapter the headset is connected to. Applications must ensure the

DirectX device it creates uses the same adapter.

Most general Direct3D sample code demonstrates creating a DirectX device using the default hardware adapter,

which on a hybrid system may not be the same as the one used for the headset.

To work around any issues, use the HolographicAdapterID from either HolographicSpace.PrimaryAdapterId() or

HolographicDisplay.AdapterId(). This adapterId can then be used to select the right DXGIAdapter using

IDXGIFactory4.EnumAdapterByLuid.

From DeviceResources::InitializeUsingHolographicSpaceDeviceResources::InitializeUsingHolographicSpace:

https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicspace
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicadapterid
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicspace
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicdisplay


// The holographic space might need to determine which adapter supports
// holograms, in which case it will specify a non-zero PrimaryAdapterId.
LUID id =
{
    m_holographicSpace.PrimaryAdapterId().LowPart,
    m_holographicSpace.PrimaryAdapterId().HighPart
};

// When a primary adapter ID is given to the app, the app should find
// the corresponding DXGI adapter and use it to create Direct3D devices
// and device contexts. Otherwise, there is no restriction on the DXGI
// adapter the app can use.
if ((id.HighPart != 0) || (id.LowPart != 0))
{
    UINT createFlags = 0;

    // Create the DXGI factory.
    ComPtr<IDXGIFactory1> dxgiFactory;
    winrt::check_hresult(
        CreateDXGIFactory2(
            createFlags,
            IID_PPV_ARGS(&dxgiFactory)
        ));
    ComPtr<IDXGIFactory4> dxgiFactory4;
    winrt::check_hresult(dxgiFactory.As(&dxgiFactory4));

    // Retrieve the adapter specified by the holographic space.
    winrt::check_hresult(
        dxgiFactory4->EnumAdapterByLuid(
            id,
            IID_PPV_ARGS(&m_dxgiAdapter)
        ));
}
else
{
    m_dxgiAdapter.Reset();
}

// Create the Direct3D 11 API device object and a corresponding context.
ComPtr<ID3D11Device> device;
ComPtr<ID3D11DeviceContext> context;

const D3D_DRIVER_TYPE driverType = m_dxgiAdapter == nullptr ? D3D_DRIVER_TYPE_HARDWARE : 
D3D_DRIVER_TYPE_UNKNOWN;
const HRESULT hr = D3D11CreateDevice(
    m_dxgiAdapter.Get(),        // Either nullptr, or the primary adapter determined by Windows Holographic.
    driverType,                 // Create a device using the hardware graphics driver.
    0,                          // Should be 0 unless the driver is D3D_DRIVER_TYPE_SOFTWARE.
    creationFlags,              // Set debug and Direct2D compatibility flags.
    featureLevels,              // List of feature levels this app can support.
    ARRAYSIZE(featureLevels),   // Size of the list above.
    D3D11_SDK_VERSION,          // Always set this to D3D11_SDK_VERSION for Windows Runtime apps.
    &device,                    // Returns the Direct3D device created.
    &m_d3dFeatureLevel,         // Returns feature level of device created.
    &context                    // Returns the device immediate context.
);

Code to update DeviceResources::CreateDeviceResources to use IDXGIAdapterupdate DeviceResources::CreateDeviceResources to use IDXGIAdapter

Hybrid graphics and Media FoundationHybrid graphics and Media Foundation

Using Media Foundation on hybrid systems may cause issues where video won't render or video texture are

corrupt because Media Foundation is defaulting to a system behavior. In some scenarios, creating a separate

ID3D11Device is required to support multi-threading and the correct creation flags are set.



// create dx device for media pipeline
winrt::com_ptr<ID3D11Device> spMediaDevice;

// See above. Also make sure to enable the following flags on the D3D11 device:
//   * D3D11_CREATE_DEVICE_VIDEO_SUPPORT
//   * D3D11_CREATE_DEVICE_BGRA_SUPPORT
if (FAILED(CreateMediaDevice(spAdapter.get(), &spMediaDevice)))
    return;                                                     

// Turn multithreading on 
winrt::com_ptr<ID3D10Multithread> spMultithread;
if (spContext.try_as(spMultithread))
{
    spMultithread->SetMultithreadProtected(TRUE);
}

// lock the shared dxgi device manager
// call MFUnlockDXGIDeviceManager when no longer needed
UINT uiResetToken;
winrt::com_ptr<IMFDXGIDeviceManager> spDeviceManager;
hr = MFLockDXGIDeviceManager(&uiResetToken, spDeviceManager.put());
if (FAILED(hr))
    return hr;
    
// associate the device with the manager
hr = spDeviceManager->ResetDevice(spMediaDevice.get(), uiResetToken);
if (FAILED(hr))
    return hr;

 See also

When initializing the ID3D11Device, D3D11_CREATE_DEVICE_VIDEO_SUPPORT flag must be defined as part of

the D3D11_CREATE_DEVICE_FLAG. Once the device and context is created, call SetMultithreadProtected to

enable multithreading. To associate the device with the IMFDXGIDeviceManager, use the

IMFDXGIDeviceManager ::ResetDevice function.

Code to associate a ID3D11Device with IMFDXGIDeviceManagerassociate a ID3D11Device with IMFDXGIDeviceManager :

Coordinate systems in DirectX

Using the HoloLens emulator

https://docs.microsoft.com/en-us/windows/desktop/api/d3d10/nf-d3d10-id3d10multithread-setmultithreadprotected
https://docs.microsoft.com/en-us/windows/desktop/api/mfobjects/nn-mfobjects-imfdxgidevicemanager
https://docs.microsoft.com/en-us/windows/desktop/api/mfobjects/nf-mfobjects-imfdxgidevicemanager-resetdevice
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NOTENOTE

NOTENOTE

 Spatial coordinate systems in Windows

This article relates to the legacy WinRT native APIs. For new native app projects, we recommend using the OpenXR APIOpenXR API .

Coordinate systems form the basis for spatial understanding offered by Windows Mixed Reality APIs.

Today's seated VR or single-room VR devices establish one primary coordinate system for their tracked space.

Mixed Reality devices like HoloLens are designed for large undefined environments, with the device discovering

and learning about its surroundings as the user walks around. The device adapts to continually improving

knowledge about the user's rooms, but results in coordinate systems that change their relationship to one

another over the apps lifetime. Windows Mixed Reality supports a wide spectrum of devices, ranging from

seated immersive headsets through world-attached reference frames.

The code snippets in this article currently demonstrate use of C++/CX rather than C++17-compliant C++/WinRT as used

in the C++ holographic project template. The concepts are equivalent for a C++/WinRT project, though you will need to

translate the code.

The core type used to reason about real-world coordinate systems in Windows is the SpatialCoordinateSystem.

An instance of this type represents an arbitrary coordinate system, providing a method for getting

transformation matrix data that you can use to transform between two coordinate systems without

understanding the details of each.

Methods that return spatial information will accept a SpatialCoordinateSystem parameter to let you decide the

coordinate system in which it's most useful for those coordinates to be returned. Spatial information is

represented as points, rays, or volumes in the user's surroundings, and the units for these coordinates will

always be in meters.

A SpatialCoordinateSystem has a dynamic relationship with other coordinate systems, including those that

represent the device's position. At any point, the device can locate some coordinate systems and not others. For

most coordinate systems, your app must be ready to handle periods of time during which they cannot be

located.

Your application shouldn't create SpatialCoordinateSystems directly - rather they should be consumed via the

Perception APIs. There are three primary sources of coordinate systems in the Perception APIs, each of which

map to a concept described on the Coordinate systems page:

To get a stationary frame of reference, create a SpatialStationaryFrameOfReference or obtain one from the

current SpatialStageFrameOfReference.

To get a spatial anchor, create a SpatialAnchor.

To get an attached frame of reference, create a SpatialLocatorAttachedFrameOfReference.

All of the coordinate systems returned by these objects are right-handed, with +y up, +x to the right and +z

backwards. You can remember which direction the positive z-axis points by pointing the fingers of either your

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/coordinate-systems-in-directx.md
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialcoordinatesystem
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialstationaryframeofreference
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialstageframeofreference
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialanchor
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatiallocatorattachedframeofreference


 Place holograms in the world using a spatial stage

SpatialStageManager::SpatialStageManager(
    const std::shared_ptr<DX::DeviceResources>& deviceResources, 
    const std::shared_ptr<SceneController>& sceneController)
    : m_deviceResources(deviceResources), m_sceneController(sceneController)
{
    // Get notified when the stage is updated.
    m_spatialStageChangedEventToken = SpatialStageFrameOfReference::CurrentChanged +=
        ref new EventHandler<Object^>(std::bind(&SpatialStageManager::OnCurrentChanged, this, _1));

    // Make sure to get the current spatial stage.
    OnCurrentChanged(nullptr);
}

void SpatialStageManager::OnCurrentChanged(Object^ /*o*/)
{
    // The event notifies us that a new stage is available.

left or right hand in the positive x direction and curling them into the positive y direction. The direction your

thumb points, either toward or away from you, is the direction that the positive z-axis points for that coordinate

system. The following illustration shows these two coordinate systems.

Left-hand and right-hand coordinate systems

Use the SpatialLocator class to create either an attached or stationary frame of reference to bootstrap into a

SpatialCoordinateSystem based on the HoloLens position. Continue to the next section to learn more about this

process.

The coordinate system for opaque Windows Mixed Reality immersive headsets is accessed using the static

SpatialStageFrameOfReference::Current property. This API provides:

A coordinate system

Information about whether the player is seated or mobile

The boundary of a safe area for walking around if the player is mobile

An indication of whether the headset is directional.

An event handler for updates to the spatial stage.

First, we get the spatial stage and subscribe for updates to it:

Code for Spatial stage initializationSpatial stage initialization

In the OnCurrentChanged method, your app should inspect the spatial stage and update the player experience.

In this example, we provide a visualization of the stage boundary and the start position specified by the user and

the stage's range of view and range of movement properties. We also fall back to our own stationary coordinate

system, when a stage cannot be provided.

Code for Spatial stage updateSpatial stage update

https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatiallocator
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialstageframeofreference.current


    // The event notifies us that a new stage is available.
    // Get the current stage.
    m_currentStage = SpatialStageFrameOfReference::Current;

    // Clear previous content.
    m_sceneController->ClearSceneObjects();

    if (m_currentStage != nullptr)
    {
        // Obtain stage geometry.
        auto stageCoordinateSystem = m_currentStage->CoordinateSystem;
        auto boundsVertexArray = m_currentStage->TryGetMovementBounds(stageCoordinateSystem);

        // Visualize the area where the user can move around.
        std::vector<float3> boundsVertices;
        boundsVertices.resize(boundsVertexArray->Length);
        memcpy(boundsVertices.data(), boundsVertexArray->Data, boundsVertexArray->Length * sizeof(float3));
        std::vector<unsigned short> indices = TriangulatePoints(boundsVertices);
        m_stageBoundsShape =
            std::make_shared<SceneObject>(
                    m_deviceResources,
                    reinterpret_cast<std::vector<XMFLOAT3>&>(boundsVertices),
                    indices,
                    XMFLOAT3(DirectX::Colors::SeaGreen),
                    stageCoordinateSystem);
        m_sceneController->AddSceneObject(m_stageBoundsShape);

        // In this sample, we draw a visual indicator for some spatial stage properties.
        // If the view is forward-only, the indicator is a half circle pointing forward - otherwise, it
        // is a full circle.
        // If the user can walk around, the indicator is blue. If the user is seated, it is red.

        // The indicator is rendered at the origin - which is where the user declared the center of the
        // stage to be during setup - above the plane of the stage bounds object.
        float3 visibleAreaCenter = float3(0.f, 0.001f, 0.f);

        // Its shape depends on the look direction range.
        std::vector<float3> visibleAreaIndicatorVertices;
        if (m_currentStage->LookDirectionRange == SpatialLookDirectionRange::ForwardOnly)
        {
            // Half circle for forward-only look direction range.
            visibleAreaIndicatorVertices = CreateCircle(visibleAreaCenter, 0.25f, 9, XM_PI);
        }
        else
        {
            // Full circle for omnidirectional look direction range.
            visibleAreaIndicatorVertices = CreateCircle(visibleAreaCenter, 0.25f, 16, XM_2PI);
        }

        // Its color depends on the movement range.
        XMFLOAT3 visibleAreaColor;
        if (m_currentStage->MovementRange == SpatialMovementRange::NoMovement)
        {
            visibleAreaColor = XMFLOAT3(DirectX::Colors::OrangeRed);
        }
        else
        {
            visibleAreaColor = XMFLOAT3(DirectX::Colors::Aqua);
        }

        std::vector<unsigned short> visibleAreaIndicatorIndices = 
TriangulatePoints(visibleAreaIndicatorVertices);

        // Visualize the look direction range.
        m_stageVisibleAreaIndicatorShape =
            std::make_shared<SceneObject>(
                    m_deviceResources,
                    reinterpret_cast<std::vector<XMFLOAT3>&>(visibleAreaIndicatorVertices),
                    visibleAreaIndicatorIndices,
                    visibleAreaColor,



                    visibleAreaColor,
                    stageCoordinateSystem);
        m_sceneController->AddSceneObject(m_stageVisibleAreaIndicatorShape);
    }
    else
    {
        // No spatial stage was found.
        // Fall back to a stationary coordinate system.
        auto locator = SpatialLocator::GetDefault();
        if (locator)
        {
            m_stationaryFrameOfReference = locator->CreateStationaryFrameOfReferenceAtCurrentLocation();

            // Render an indicator, so that we know we fell back to a mode without a stage.
            std::vector<float3> visibleAreaIndicatorVertices;
            float3 visibleAreaCenter = float3(0.f, -2.0f, 0.f);
            visibleAreaIndicatorVertices = CreateCircle(visibleAreaCenter, 0.125f, 16, XM_2PI);
            std::vector<unsigned short> visibleAreaIndicatorIndices = 
TriangulatePoints(visibleAreaIndicatorVertices);
            m_stageVisibleAreaIndicatorShape =
                std::make_shared<SceneObject>(
                    m_deviceResources,
                    reinterpret_cast<std::vector<XMFLOAT3>&>(visibleAreaIndicatorVertices),
                    visibleAreaIndicatorIndices,
                    XMFLOAT3(DirectX::Colors::LightSlateGray),
                    m_stationaryFrameOfReference->CoordinateSystem);
            m_sceneController->AddSceneObject(m_stageVisibleAreaIndicatorShape);
        }
    }
}

std::vector<unsigned short> SpatialStageManager::TriangulatePoints(std::vector<float3> const& vertices)
{
    size_t const& vertexCount = vertices.size();

    // Segments of the shape are removed as they are triangularized.
    std::vector<bool> vertexRemoved;
    vertexRemoved.resize(vertexCount, false);
    unsigned int vertexRemovedCount = 0;

    // Indices are used to define triangles.
    std::vector<unsigned short> indices;

    // Decompose into convex segments.
    unsigned short currentVertex = 0;
    while (vertexRemovedCount < (vertexCount - 2))
    {
        // Get next triangle:
        // Start with the current vertex.
        unsigned short index1 = currentVertex;

        // Get the next available vertex.
        unsigned short index2 = index1 + 1;

        // This cycles to the next available index.
        auto CycleIndex = [=](unsigned short indexToCycle, unsigned short stopIndex)
        {
            // Make sure the index does not exceed bounds.
            if (indexToCycle >= unsigned short(vertexCount))
            {
                indexToCycle -= unsigned short(vertexCount);

The set of vertices that define the stage boundary are provided in clockwise order. The Windows Mixed Reality

shell draws a fence at the boundary when the user approaches it, but you may want to triangularize the

walkable area for your own purposes. The following algorithm can be used to triangularize the stage.

Code for Spatial stage tr iangular izationSpatial stage tr iangular ization



                indexToCycle -= unsigned short(vertexCount);
            }

            while (vertexRemoved[indexToCycle])
            {
                // If the vertex is removed, go to the next available one.
                ++indexToCycle;

                // Make sure the index does not exceed bounds.
                if (indexToCycle >= unsigned short(vertexCount))
                {
                    indexToCycle -= unsigned short(vertexCount);
                }

                // Prevent cycling all the way around.
                // Should not be needed, as we limit with the vertex count.
                if (indexToCycle == stopIndex)
                {
                    break;
                }
            }

            return indexToCycle;
        };
        index2 = CycleIndex(index2, index1);

        // Get the next available vertex after that.
        unsigned short index3 = index2 + 1;
        index3 = CycleIndex(index3, index1);

        // Vertices that may define a triangle inside the 2D shape.
        auto& v1 = vertices[index1];
        auto& v2 = vertices[index2];
        auto& v3 = vertices[index3];

        // If the projection of the first segment (in clockwise order) onto the second segment is 
        // positive, we know that the clockwise angle is less than 180 degrees, which tells us 
        // that the triangle formed by the two segments is contained within the bounding shape.
        auto v2ToV1 = v1 - v2;
        auto v2ToV3 = v3 - v2;
        float3 normalToV2ToV3 = { -v2ToV3.z, 0.f, v2ToV3.x };
        float projectionOntoNormal = dot(v2ToV1, normalToV2ToV3);
        if (projectionOntoNormal >= 0)
        {
            // Triangle is contained within the 2D shape.

            // Remove peak vertex from the list.
            vertexRemoved[index2] = true;
            ++vertexRemovedCount;

            // Create the triangle.
            indices.push_back(index1);
            indices.push_back(index2);
            indices.push_back(index3);

            // Continue on to the next outer triangle.
            currentVertex = index3;
        }
        else
        {
            // Triangle is a cavity in the 2D shape.
            // The next triangle starts at the inside corner.
            currentVertex = index2;
        }
    }

    indices.shrink_to_fit();
    return indices;
}



 Place holograms in the world using a stationary frame of reference

           // The simplest way to render world-locked holograms is to create a stationary reference frame
           // when the app is launched. This is roughly analogous to creating a "world" coordinate system
           // with the origin placed at the device's position as the app is launched.
           referenceFrame = locator.CreateStationaryFrameOfReferenceAtCurrentLocation();

 Place holograms in the world using spatial anchors

  Persist and share spatial anchorsPersist and share spatial anchors

The SpatialStationaryFrameOfReference class represents a frame of reference that remains stationary relative to

the user's surroundings as the user moves around. This frame of reference prioritizes keeping coordinates stable

near the device. One key use of a SpatialStationaryFrameOfReference is to act as the underlying world

coordinate system within a rendering engine when rendering holograms.

To get a SpatialStationaryFrameOfReference, use the SpatialLocator class and call

CreateStationaryFrameOfReferenceAtCurrentLocation.

From the Windows Holographic app template code:

Stationary reference frames are designed to provide a best-fit position relative to the overall space. Individual

positions within that reference frame are allowed to drift slightly. This is normal as the device learns more

about the environment.

When precise placement of individual holograms is required, a SpatialAnchor should be used to anchor the

individual hologram to a position in the real world - for example, a point the user indicates to be of special

interest. Anchor positions don't drift, but can be corrected; the anchor will use the corrected position starting

in the next frame after the correction has occurred.

Spatial anchors are a great way to place holograms at a specific place in the real world, with the system ensuring

the anchor stays in place over time. This topic explains how to create and use an anchor, and how to work with

anchor data.

You can create a SpatialAnchor at any position and orientation within the SpatialCoordinateSystem of your

choosing. The device must be able to locate that coordinate system at the moment, and the system must not

have reached its limit of spatial anchors.

Once defined, the coordinate system of a SpatialAnchor adjusts continually to keep the precise position and

orientation of its initial location. You can then use this SpatialAnchor to render holograms that will appear fixed

in the user's surroundings at that exact location.

The effects of the adjustments that keep the anchor in place are magnified as distance from the anchor

increases. You should avoid rendering content relative to an anchor that is more than about 3 meters from that

anchor's origin.

The CoordinateSystem property gets a coordinate system that lets you place content relative to the anchor, with

easing applied when the device adjusts the anchor's precise location.

Use the RawCoordinateSystem property and the corresponding RawCoordinateSystemAdjusted event to

manage these adjustments yourself.

You can persist a SpatialAnchor locally using the SpatialAnchorStore class and then get it back in a future app

session on the same HoloLens device.

By using Azure Spatial Anchors, you can create a durable cloud anchor from a local SpatialAnchor, which your

app can then locate across multiple HoloLens, iOS and Android devices. By sharing a common spatial anchor

https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialstationaryframeofreference
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatiallocator
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatiallocator
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialanchor
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialanchor
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialanchor
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialanchorstore
https://docs.microsoft.com/en-us/azure/spatial-anchors/overview


  Create SpatialAnchors for holographic contentCreate SpatialAnchors for holographic content

NOTENOTE

   // Check for new input state since the last frame.
   SpatialInteractionSourceState^ pointerState = m_spatialInputHandler->CheckForInput();
   if (pointerState != nullptr)
   {
       // Try to get the pointer pose relative to the SpatialStationaryReferenceFrame.
       SpatialPointerPose^ pointerPose = pointerState->TryGetPointerPose(currentCoordinateSystem);
       if (pointerPose != nullptr)
       {
           // When a Pressed gesture is detected, the anchor will be created two meters in front of the 
user.

           // Get the gaze direction relative to the given coordinate system.
           const float3 headPosition = pointerPose->Head->Position;
           const float3 headDirection = pointerPose->Head->ForwardDirection;

           // The anchor position in the StationaryReferenceFrame.
           static const float distanceFromUser = 2.0f; // meters
           const float3 gazeAtTwoMeters = headPosition + (distanceFromUser * headDirection);

           // Create the anchor at position.
           SpatialAnchor^ anchor = SpatialAnchor::TryCreateRelativeTo(currentCoordinateSystem, 
gazeAtTwoMeters);

           if ((anchor != nullptr) && (m_spatialAnchorHelper != nullptr))
           {
               // In this example, we store the anchor in an IMap.
               auto anchorMap = m_spatialAnchorHelper->GetAnchorMap();

               // Create an identifier for the anchor.
               String^ id = ref new String(L"HolographicSpatialAnchorStoreSample_Anchor") + anchorMap->Size;

               anchorMap->Insert(id->ToString(), anchor);
           }
       }
   }

  

across multiple devices, each user can see content rendered relative to that anchor in the same physical location

in real time.

You can also use Azure Spatial Anchors for asynchronous hologram persistence across HoloLens, iOS, and

Android devices. By sharing a durable cloud spatial anchor, multiple devices can observe the same persisted

hologram over time, even if those devices aren't present together at the same time.

To get started building shared experiences in your HoloLens app, try out the 5-minute Azure Spatial Anchors

HoloLens quickstart.

Once you're up and running with Azure Spatial Anchors, you can then create and locate anchors on HoloLens.

Walkthroughs are available for Android and iOS as well, enabling you to share the same anchors on all devices.

For this code sample, we modified the Windows Holographic app template to create anchors when the PressedPressed

gesture is detected. The cube is then placed at the anchor during the render pass.

Since multiple anchors are supported by the helper class, we can place as many cubes as we want to use this

code sample!

The IDs for anchors are something you control in your app. In this example, we have created a naming scheme that is

sequential based on the number of anchors currently stored in the app's collection of anchors.

https://docs.microsoft.com/en-us/azure/spatial-anchors/overview
https://docs.microsoft.com/en-us/azure/spatial-anchors/quickstarts/get-started-hololens
https://docs.microsoft.com/en-us/azure/spatial-anchors/concepts/create-locate-anchors-cpp-winrt
https://docs.microsoft.com/en-us/azure/spatial-anchors/create-locate-anchors-overview


Asynchronously load, and cache, the SpatialAnchorStoreAsynchronously load, and cache, the SpatialAnchorStore

   // Request the spatial anchor store, which is the WinRT object that will accept the imported anchor data.
   return create_task(SpatialAnchorManager::RequestStoreAsync())
       .then([](task<SpatialAnchorStore^> previousTask)
   {
       std::shared_ptr<SampleSpatialAnchorHelper> newHelper = nullptr;

       try
       {
           SpatialAnchorStore^ anchorStore = previousTask.get();

           // Once the SpatialAnchorStore has been loaded by the system, we can create our helper class.

           // Using "new" to access private constructor
           newHelper = std::shared_ptr<SampleSpatialAnchorHelper>(new 
SampleSpatialAnchorHelper(anchorStore));

           // Now we can load anchors from the store.
           newHelper->LoadFromAnchorStore();
       }
       catch (Exception^ exception)
       {
           PrintWstringToDebugConsole(
               std::wstring(L"Exception while loading the anchor store: ") +
               exception->Message->Data() +
               L"\n"
               );
       }

       // Return the initialized class instance.
       return newHelper;
   });

   SampleSpatialAnchorHelper::SampleSpatialAnchorHelper(SpatialAnchorStore^ anchorStore)
   {
       m_anchorStore = anchorStore;
       m_anchorMap = ref new Platform::Collections::Map<String^, SpatialAnchor^>();
   }

NOTENOTE

Let's see how to write a SampleSpatialAnchorHelper class that helps handle this persistence, including:

Storing a collection of in-memory anchors, indexed by a Platform::String key.

Loading anchors from the system's SpatialAnchorStore, which is kept separate from the local in-memory

collection.

Saving the local in-memory collection of anchors to the SpatialAnchorStore when the app chooses to do so.

Here's how to save SpatialAnchor objects in the SpatialAnchorStore.

When the class starts up, we request the SpatialAnchorStore asynchronously. This involves system I/O as the API

loads the anchor store, and this API is made asynchronous so that the I/O is non-blocking.

You'll be given a SpatialAnchorStore that you can use to save the anchors. This is an IMapView that associates

key values that are Strings, with data values that are SpatialAnchors. In our sample code, we store this in a

private class member variable that is accessible through a public function of our helper class.

Don't forget to hook up the suspend/resume events to save and load the anchor store.

https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialanchor
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialanchorstore


   void HolographicSpatialAnchorStoreSampleMain::SaveAppState()
   {
       // For example, store information in the SpatialAnchorStore.
       if (m_spatialAnchorHelper != nullptr)
       {
           m_spatialAnchorHelper->TrySaveToAnchorStore();
       }
   }

   void HolographicSpatialAnchorStoreSampleMain::LoadAppState()
   {
       // For example, load information from the SpatialAnchorStore.
       LoadAnchorStore();
   }

  Save content to the anchor storeSave content to the anchor store

   // TrySaveToAnchorStore: Stores all anchors from memory into the app's anchor store.
   //
   // For each anchor in memory, this function tries to store it in the app's AnchorStore. The operation 
will fail if
   // the anchor store already has an anchor by that name.
   //
   bool SampleSpatialAnchorHelper::TrySaveToAnchorStore()
   {
       // This function returns true if all the anchors in the in-memory collection are saved to the anchor
       // store. If zero anchors are in the in-memory collection, we will still return true because the
       // condition has been met.
       bool success = true;

       // If access is denied, 'anchorStore' will not be obtained.
       if (m_anchorStore != nullptr)
       {
           for each (auto& pair in m_anchorMap)
           {
               auto const& id = pair->Key;
               auto const& anchor = pair->Value;

               // Try to save the anchors.
               if (!m_anchorStore->TrySave(id, anchor))
               {
                   // This may indicate the anchor ID is taken, or the anchor limit is reached for the app.
                   success=false;
               }
           }
       }

       return success;
   }

  Load content from the anchor store when the app resumesLoad content from the anchor store when the app resumes

When the system suspends your app, you need to save your spatial anchors to the anchor store. You may also

choose to save anchors to the anchor store at other times, as you find to be necessary for your app's

implementation.

When you're ready to try saving the in-memory anchors to the SpatialAnchorStore, you can loop through your

collection and try to save each one.

You can restore saved anchors in the AnchorStore by transferring them from the anchor store's IMapView to

your own in-memory database of SpatialAnchors when your app resumes or at any time.



   // This is an in-memory anchor list that is separate from the anchor store.
   // These anchors may be used, reasoned about, and so on before committing the collection to the store.
   Windows::Foundation::Collections::IMap<Platform::String^, Windows::Perception::Spatial::SpatialAnchor^>^ 
m_anchorMap;

NOTENOTE

NOTENOTE

   // LoadFromAnchorStore: Loads all anchors from the app's anchor store into memory.
   //
   // The anchors are stored in memory using an IMap, which stores anchors using a string identifier. Any 
string can be used as
   // the identifier; it can have meaning to the app, such as "Game_Leve1_CouchAnchor," or it can be a GUID 
that is generated
   // by the app.
   //
   void SampleSpatialAnchorHelper::LoadFromAnchorStore()
   {
       // If access is denied, 'anchorStore' will not be obtained.
       if (m_anchorStore != nullptr)
       {
           // Get all saved anchors.
           auto anchorMapView = m_anchorStore->GetAllSavedAnchors();
           for each (auto const& pair in anchorMapView)
           {
               auto const& id = pair->Key;
               auto const& anchor = pair->Value;
               m_anchorMap->Insert(id, anchor);
           }
       }
   }

  Clear the anchor store, when neededClear the anchor store, when needed

To restore anchors from the SpatialAnchorStore, restore each one that you're interested in to your own in-

memory collection.

You need your own in-memory database of SpatialAnchors to associate Strings with the SpatialAnchors that you

create. In our sample code, we choose to use a Windows::Foundation::Collections::IMap to store the anchors,

which makes it easy to use the same key and data value for the SpatialAnchorStore.

An anchor that is restored might not be locatable right away. For example, it might be an anchor in a separate room or in

a different building altogether. Anchors retrieved from the AnchorStore should be tested for locatability before using

them.

In this example code, we retrieve all anchors from the AnchorStore. This is not a requirement; your app could just as well

pick and choose a certain subset of anchors by using String key values that are meaningful to your implementation.

Sometimes, you need to clear app state and write new data. Here's how you do that with the SpatialAnchorStore.

Using our helper class, it's almost unnecessary to wrap the Clear function. We choose to do so in our sample

implementation, because our helper class is given the responsibility of owning the SpatialAnchorStore instance.

https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialanchorstore


   // ClearAnchorStore: Clears the AnchorStore for the app.
   //
   // This function clears the AnchorStore. It has no effect on the anchors stored in memory.
   //
   void SampleSpatialAnchorHelper::ClearAnchorStore()
   {
       // If access is denied, 'anchorStore' will not be obtained.
       if (m_anchorStore != nullptr)
       {
           // Clear all anchors from the store.
           m_anchorStore->Clear();
       }
   }

  Example: Relating anchor coordinate systems to stationary reference frame coordinate systemsExample: Relating anchor coordinate systems to stationary reference frame coordinate systems

   // In this code snippet, someAnchor is a SpatialAnchor^ that has been initialized and is valid in the 
current environment.
   float4x4 anchorSpaceToCurrentCoordinateSystem;
   SpatialCoordinateSystem^ anchorSpace = someAnchor->CoordinateSystem;
   const auto tryTransform = anchorSpace->TryGetTransformTo(currentCoordinateSystem);
   if (tryTransform != nullptr)
   {
       anchorSpaceToCurrentCoordinateSystem = tryTransform->Value;
   }

 Create holograms using a device-attached frame of reference

Let's say you have an anchor, and you want to relate something in your anchor's coordinate system to the

SpatialStationaryReferenceFrame you’re already using for your other content. You can use TryGetTransformTo to

get a transform from the anchor’s coordinate system to that of the stationary reference frame:

This process is useful to you in two ways:

1. It tells you if the two reference frames can be understood relative to one another, and;

2. If so, it provides you a transform to go directly from one coordinate system to the other.

With this information, you have an understanding of the spatial relation between objects between the two

reference frames.

For rendering, you can often obtain better results by grouping objects according to their original reference

frame or anchor. Perform a separate drawing pass for each group. The view matrices are more accurate for

objects with model transforms that are created initially using the same coordinate system.

There are times when you want to render a hologram that remains attached to the device's location, for example

a panel with debugging information or an informational message when the device is only able to determine its

orientation and not its position in space. To accomplish this, we use an attached frame of reference.

The SpatialLocatorAttachedFrameOfReference class defines coordinate systems, which are relative to the device

rather than to the real-world. This frame has a fixed heading relative to the user's surroundings that points in the

direction the user was facing when the reference frame was created. From then on, all orientations in this frame

of reference are relative to that fixed heading, even as the user rotates the device.

For HoloLens, the origin of this frame's coordinate system is located at the center of rotation of the user's head,

so that its position is not affected by head rotation. Your app can specify an offset relative to this point to

position holograms in front of the user.

To get a SpatialLocatorAttachedFrameOfReference, use the SpatialLocator class and call

CreateAttachedFrameOfReferenceAtCurrentHeading.

https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialcoordinatesystem


  Use a reference frame attached to the deviceUse a reference frame attached to the device

   // A reference frame attached to the holographic camera.
   Windows::Perception::Spatial::SpatialLocatorAttachedFrameOfReference^   m_referenceFrame;

   // In this example, we create a reference frame attached to the device.
   m_referenceFrame = m_locator->CreateAttachedFrameOfReferenceAtCurrentHeading();

   // Next, we get a coordinate system from the attached frame of reference that is
   // associated with the current frame. Later, this coordinate system is used for
   // for creating the stereo view matrices when rendering the sample content.
   SpatialCoordinateSystem^ currentCoordinateSystem =
       m_referenceFrame->GetStationaryCoordinateSystemAtTimestamp(prediction->Timestamp);

  Get a spatial pointer pose, and follow the user's GazeGet a spatial pointer pose, and follow the user's Gaze

SpatialPointerPose^ pose = SpatialPointerPose::TryGetAtTimestamp(currentCoordinateSystem, prediction-
>Timestamp);

This applies to the entire range of Windows Mixed Reality devices.

These sections talk about what we changed in the Windows Holographic app template to enable a device-

attached frame of reference using this API. This "attached" hologram will work alongside stationary or anchored

holograms, and may also be used when the device is temporarily unable to find its position in the world.

First, we changed the template to store a SpatialLocatorAttachedFrameOfReference instead of a

SpatialStationaryFrameOfReference:

From HolographicTagAlongSampleMain.hHolographicTagAlongSampleMain.h :

From HolographicTagAlongSampleMain.cppHolographicTagAlongSampleMain.cpp:

During the update, we now obtain the coordinate system at the time stamp obtained from with the frame

prediction.

We want our example hologram to follow the user's gaze, similar to how the holographic shell can follow the

user's gaze. For this, we need to get the SpatialPointerPose from the same time stamp.

This SpatialPointerPose has the information needed to position the hologram according to the user's current

heading.

For user comfort, we use linear interpolation ("lerp") to smooth the change in position over a period of time.

This is more comfortable for the user than locking the hologram to their gaze. Lerping the tag-along hologram's

position also allows us to stabilize the hologram by dampening the movement. If we didn't do this dampening,

the user would see the hologram jitter because of what are normally considered to be imperceptible

movements of the user's head.

From Stationar yQuadRenderer ::PositionHologramStationar yQuadRenderer ::PositionHologram:



   const float& dtime = static_cast<float>(timer.GetElapsedSeconds());

   if (pointerPose != nullptr)
   {
       // Get the gaze direction relative to the given coordinate system.
       const float3 headPosition  = pointerPose->Head->Position;
       const float3 headDirection = pointerPose->Head->ForwardDirection;

       // The tag-along hologram follows a point 2.0m in front of the user's gaze direction.
       static const float distanceFromUser = 2.0f; // meters
       const float3 gazeAtTwoMeters = headPosition + (distanceFromUser * headDirection);

       // Lerp the position, to keep the hologram comfortably stable.
       auto lerpedPosition = lerp(m_position, gazeAtTwoMeters, dtime * c_lerpRate);

       // This will be used as the translation component of the hologram's
       // model transform.
       SetPosition(lerpedPosition);
   }

NOTENOTE

       // If you're making a debug view, you might not want the tag-along to be directly in the
       // center of your field of view. Use this code to position the hologram to the right of
       // the user's gaze direction.
       /*
       const float3 offset = float3(0.13f, 0.0f, 0.f);
       static const float distanceFromUser = 2.2f; // meters
       const float3 gazeAtTwoMeters = headPosition + (distanceFromUser * (headDirection + offset));
       */

  Rotate the hologram to face the cameraRotate the hologram to face the camera

In the case of a debugging panel, you might choose to reposition the hologram off to the side a little so that it doesn't

obstruct your view. Here's an example of how you might do that.

For Stationar yQuadRenderer ::PositionHologramStationar yQuadRenderer ::PositionHologram:

It isn't enough to position the hologram, which in this case is a quad; we must also rotate the object to face the

user. This rotation occurs in world space, because this type of billboarding allows the hologram to remain a part

of the user's environment. View-space billboarding isn't as comfortable because the hologram becomes locked

to the display orientation; in that case, you would also have to interpolate between the left and right view

matrices to acquire a view-space billboard transform that doesn't disrupt stereo rendering. Here, we rotate on

the X and Z axes to face the user.

From Stationar yQuadRenderer ::UpdateStationar yQuadRenderer ::Update:



   // Seconds elapsed since previous frame.
   const float& dTime = static_cast<float>(timer.GetElapsedSeconds());

   // Create a direction normal from the hologram's position to the origin of person space.
   // This is the z-axis rotation.
   XMVECTOR facingNormal = XMVector3Normalize(-XMLoadFloat3(&m_position));

   // Rotate the x-axis around the y-axis.
   // This is a 90-degree angle from the normal, in the xz-plane.
   // This is the x-axis rotation.
   XMVECTOR xAxisRotation = XMVector3Normalize(XMVectorSet(XMVectorGetZ(facingNormal), 0.f, -
XMVectorGetX(facingNormal), 0.f));

   // Create a third normal to satisfy the conditions of a rotation matrix.
   // The cross product  of the other two normals is at a 90-degree angle to
   // both normals. (Normalize the cross product to avoid floating-point math
   // errors.)
   // Note how the cross product will never be a zero-matrix because the two normals
   // are always at a 90-degree angle from one another.
   XMVECTOR yAxisRotation = XMVector3Normalize(XMVector3Cross(facingNormal, xAxisRotation));

   // Construct the 4x4 rotation matrix.

   // Rotate the quad to face the user.
   XMMATRIX rotationMatrix = XMMATRIX(
       xAxisRotation,
       yAxisRotation,
       facingNormal,
       XMVectorSet(0.f, 0.f, 0.f, 1.f)
       );

   // Position the quad.
   const XMMATRIX modelTranslation = XMMatrixTranslationFromVector(XMLoadFloat3(&m_position));

   // The view and projection matrices are provided by the system; they are associated
   // with holographic cameras, and updated on a per-camera basis.
   // Here, we provide the model transform for the sample hologram. The model transform
   // matrix is transposed to prepare it for the shader.
   XMStoreFloat4x4(&m_modelConstantBufferData.model, XMMatrixTranspose(rotationMatrix * modelTranslation));

  Render the attached hologramRender the attached hologram

   // The view and projection matrices for each holographic camera will change
   // every frame. This function refreshes the data in the constant buffer for
   // the holographic camera indicated by cameraPose.
   pCameraResources->UpdateViewProjectionBuffer(
       m_deviceResources,
       cameraPose,
       m_referenceFrame->GetStationaryCoordinateSystemAtTimestamp(prediction->Timestamp)
       );

For this example, we also choose to render the hologram in the coordinate system of the

SpatialLocatorAttachedReferenceFrame, which is where we positioned the hologram. (If we had decided to

render using another coordinate system, we would need to acquire a transform from the device-attached

reference frame's coordinate system to that coordinate system.)

From HolographicTagAlongSampleMain::RenderHolographicTagAlongSampleMain::Render :

That's it! The hologram will now "chase" a position that is 2 meters in front of the user's gaze direction.



NOTENOTE

 Handling tracking loss

   // Be able to respond to changes in the positional tracking state.
   m_locatabilityChangedToken =
       m_locator->LocatabilityChanged +=
           ref new Windows::Foundation::TypedEventHandler<SpatialLocator^, Object^>(
               std::bind(&HolographicApp1Main::OnLocatabilityChanged, this, _1, _2)
               );

   void HolographicApp1Main::OnLocatabilityChanged(SpatialLocator^ sender, Object^ args)
   {
       switch (sender->Locatability)
       {
       case SpatialLocatability::Unavailable:
           // Holograms cannot be rendered.
           {
               String^ message = L"Warning! Positional tracking is " +
                                           sender->Locatability.ToString() + L".\n";
               OutputDebugStringW(message->Data());
           }
           break;

       // In the following three cases, it is still possible to place holograms using a
       // SpatialLocatorAttachedFrameOfReference.
       case SpatialLocatability::PositionalTrackingActivating:
           // The system is preparing to use positional tracking.

       case SpatialLocatability::OrientationOnly:
           // Positional tracking has not been activated.

       case SpatialLocatability::PositionalTrackingInhibited:
           // Positional tracking is temporarily inhibited. User action may be required
           // in order to restore positional tracking.
           break;

       case SpatialLocatability::PositionalTrackingActive:
           // Positional tracking is active. World-locked content can be rendered.
           break;
       }
   }

This example also loads additional content - see StationaryQuadRenderer.cpp.

When the device can't locate itself in the world, the app experiences "tracking loss". Windows Mixed Reality apps

should be able to handle such disruptions to the positional tracking system. These disruptions can be observed,

and responses created, by using the LocatabilityChanged event on the default SpatialLocator.

From AppMain::SetHolographicSpace:AppMain::SetHolographicSpace:

When your app receives a LocatabilityChanged event, it can change behavior as needed. For example, in the

PositionalTrackingInhibited state, your app can pause normal operation and render a tag-along hologram that

displays a warning message.

The Windows Holographic app template comes with a LocatabilityChanged handler already created for you. By

default, it displays a warning in the debug console when positional tracking is unavailable. You can add code to

this handler to provide a response as needed from your app.

From AppMain.cpp:AppMain.cpp:



 Spatial mapping

 See also

The spatial mapping APIs make use of coordinate systems to get model transforms for surface meshes.

Coordinate systems

Spatial anchors

Azure Spatial Anchors

Head and eye gaze in DirectX

Hands and motion controllers in DirectX

Spatial mapping in DirectX

https://docs.microsoft.com/en-us/azure/spatial-anchors
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 Subscribe for CoreWindow input events
  Keyboard inputKeyboard input

// Register for keypress notifications.
   window->KeyDown +=
       ref new TypedEventHandler<CoreWindow^, KeyEventArgs^>(this, &AppView::OnKeyPressed);

    …

   // Input event handlers

   void AppView::OnKeyPressed(CoreWindow^ sender, KeyEventArgs^ args)
   {
       //
       // TODO: Respond to keyboard input here.
       //
   }

  Virtual keyboard inputVirtual keyboard input

  Mouse InputMouse Input

NOTENOTE

This article relates to the legacy WinRT native APIs. For new native app projects, we recommend using the

OpenXR APIOpenXR API.

The code snippets in this article currently demonstrate use of C++/CX rather than C++17-compliant

C++/WinRT as used in the C++ holographic project template. The concepts are equivalent for a C++/WinRT

project, though you will need to translate the code.

In the Windows Holographic app template, we include an event handler for keyboard input just like any other

UWP app. Your app consumes keyboard input data the same way in Windows Mixed Reality.

From AppView.cpp:

For immersive desktop headsets, you can support virtual keyboards rendered by Windows over your immersive

view by implementing CoreTextEditContextCoreTextEditContext. This lets Windows understand the state of your own app-

rendered text boxes, so the virtual keyboard can correctly contribute to the text there.

For more information on implementing CoreTextEditContext support, see the CoreTextEditContext sample.

You can also use mouse input, again via the UWP CoreWindow input event handlers. Here's how to modify the

Windows Holographic app template to support mouse clicks in the same way as pressed gestures. After making

this modification, a mouse click while wearing an immersive headset device will reposition the cube.

UWP apps can also get raw XY data for the mouse by using the MouseDevice API.

Start by declaring a new OnPointerPressed handler in AppView.h:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/keyboard-mouse-and-controller-input-cpp.md
https://github.com/Microsoft/Windows-universal-samples/tree/master/Samples/CustomEditControl
https://docs.microsoft.com/en-us/uwp/api/windows.devices.input.mousedevice


protected:
       void OnPointerPressed(Windows::UI::Core::CoreWindow^ sender, Windows::UI::Core::PointerEventArgs^ 
args);

// Register for pointer pressed notifications.
   window->PointerPressed +=
       ref new TypedEventHandler<CoreWindow^, PointerEventArgs^>(this, &AppView::OnPointerPressed);

void AppView::OnPointerPressed(CoreWindow^ sender, PointerEventArgs^ args)
   {
       // Allow the user to interact with the holographic world using the mouse.
       if (m_main != nullptr)
       {
           m_main->OnPointerPressed();
       }
   }

// Handle mouse input.
       void OnPointerPressed();

// Keep track of mouse input.
       bool m_pointerPressed = false;

void MyHolographicAppMain::OnPointerPressed()
   {
       m_pointerPressed = true;
   }

SpatialInteractionSourceState^ pointerState = m_spatialInputHandler->CheckForInput();
   SpatialPointerPose^ pose = nullptr;
   if (pointerState != nullptr)
   {
       pose = pointerState->TryGetPointerPose(currentCoordinateSystem);
   }
   else if (m_pointerPressed)
   {
       pose = SpatialPointerPose::TryGetAtTimestamp(currentCoordinateSystem, prediction->Timestamp);
   }
   m_pointerPressed = false;

In AppView.cpp, add this code to SetWindow:

Then put this definition for OnPointerPressed at the bottom of the file:

The event handler we just added is a pass-through to the template main class. Let's modify the main class to

support this pass-through. Add this public method declaration to the header file:

You'll need this private member variable, as well:

Finally, we'll update the main class with new logic to support mouse clicks. Start by adding this event handler.

Make sure to update the class name:

Now, in the Update method, replace the existing logic for getting a pointer pose with this:

Recompile and redeploy. Notice that the mouse click will now reposition the cube in your immersive headset -



  Game controller supportGame controller support

// Recognize gamepads that are plugged in after the app starts.
       void OnGamepadAdded(Platform::Object^, Windows::Gaming::Input::Gamepad^ args);

// Stop looking for gamepads that are unplugged.
       void OnGamepadRemoved(Platform::Object^, Windows::Gaming::Input::Gamepad^ args);

Windows::Foundation::EventRegistrationToken                     m_gamepadAddedEventToken;
       Windows::Foundation::EventRegistrationToken                     m_gamepadRemovedEventToken;

// Keeps track of a gamepad and the state of its A button.
       struct GamepadWithButtonState
       {
           Windows::Gaming::Input::Gamepad^ gamepad;
           bool buttonAWasPressedLastFrame = false;
       };
       std::vector<GamepadWithButtonState>                             m_gamepads;

// If connected, a game controller can also be used for input.
   m_gamepadAddedEventToken = Gamepad::GamepadAdded +=
       ref new EventHandler<Gamepad^>(
           bind(&$safeprojectname$Main::OnGamepadAdded, this, _1, _2)
           );

m_gamepadRemovedEventToken = Gamepad::GamepadRemoved +=
       ref new EventHandler<Gamepad^>(
           bind(&$safeprojectname$Main::OnGamepadRemoved, this, _1, _2)
           );

for (auto const& gamepad : Gamepad::Gamepads)
   {
       OnGamepadAdded(nullptr, gamepad);
   }

or HoloLens with bluetooth mouse attached.

Game controllers can be a fun and convenient way of allowing the user to control an immersive Windows Mixed

Reality experience.

add the following private member declarations to the header class for your main file:

Initialize gamepad events, and any gamepads that are currently attached, in the constructor for your main class:

Add these event handlers to your main class. Make sure to update the class name:



void MyHolographicAppMain::OnGamepadAdded(Object^, Gamepad^ args)
   {
       for (auto const& gamepadWithButtonState : m_gamepads)
       {
           if (args == gamepadWithButtonState.gamepad)
           {
               // This gamepad is already in the list.
               return;
           }
       }
       m_gamepads.push_back({ args, false });
   }

void MyHolographicAppMain::OnGamepadRemoved(Object^, Gamepad^ args)
   {
       m_gamepads.erase(
           std::remove_if(m_gamepads.begin(), m_gamepads.end(), [&](GamepadWithButtonState& 
gamepadWithState)
               {
                   return gamepadWithState.gamepad == args;
               }),
           m_gamepads.end());
   }

// Check for new input state since the last frame.
   for (auto& gamepadWithButtonState : m_gamepads)
   {
       bool buttonDownThisUpdate = ((gamepadWithButtonState.gamepad->GetCurrentReading().Buttons & 
GamepadButtons::A) == GamepadButtons::A);
       if (buttonDownThisUpdate && !gamepadWithButtonState.buttonAWasPressedLastFrame)
       {
           m_pointerPressed = true;
       }
       gamepadWithButtonState.buttonAWasPressedLastFrame = buttonDownThisUpdate;
   }

// For context.
   SpatialInteractionSourceState^ pointerState = m_spatialInputHandler->CheckForInput();
   SpatialPointerPose^ pose = nullptr;
   if (pointerState != nullptr)
   {
       pose = pointerState->TryGetPointerPose(currentCoordinateSystem);
   }
   else if (m_pointerPressed)
   {
       pose = SpatialPointerPose::TryGetAtTimestamp(currentCoordinateSystem, prediction->Timestamp);
   }
   m_pointerPressed = false;

Finally, update the input logic to recognize changes in controller state. Here, we use the same m_pointerPressed

variable discussed in the section above for adding mouse events. Add this to the Update method, just before

where it checks for the SpatialPointerPose:

Don't forget to unregister the events when cleaning up the main class:



if (m_gamepadAddedEventToken.Value != 0)
   {
       Gamepad::GamepadAdded -= m_gamepadAddedEventToken;
   }
   if (m_gamepadRemovedEventToken.Value != 0)
   {
       Gamepad::GamepadRemoved -= m_gamepadRemovedEventToken;
   }

 See also

Recompile, and redeploy. You can now attach, or pair, a game controller and use it to reposition the spinning

cube.

Hardware accessories
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NOTENOTE

  Device supportDevice support

FeatureFeature HoloLens (1st gen)HoloLens (1st gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Head-gaze ✔️ ✔️ ✔️

Eye-gaze ❌ ✔️ ❌

 Using head-gaze

This article relates to the legacy WinRT native APIs. For new native app projects, we recommend using the OpenXR APIOpenXR API .

In Windows Mixed Reality, eye and head gaze input is used to determine what the user is looking at. You can use

the data to drive primary input models like head-gaze and commit, and provide context for different interaction

types. There are two types of gaze vectors available through the API: head-gaze and eye-gaze. Both are provided

as a three-dimensional ray with an origin and direction. Applications can then raycast into their scenes, or the

real world, and determine what the user is targeting.

Head-gazeHead-gaze represents the direction that the user's head is pointed in. Think of head-gaze as the position and

forward direction of the device itself, with the position as the center point between the two displays. Head-gaze

is available on all Mixed Reality devices.

Eye-gazeEye-gaze represents the direction that the user's eyes are looking towards. The origin is located between the

user's eyes. It's available on Mixed Reality devices that include an eye tracking system.

Both head and eye-gaze rays are accessible through the SpatialPointerPose API. Call

SpatialPointerPose::TryGetAtTimestamp to receive a new SpatialPointerPose object at the specified timestamp

and coordinate system. This SpatialPointerPose contains a head-gaze origin and direction. It also contains an

eye-gaze origin and direction if eye tracking is available.

To access the head-gaze, start by calling SpatialPointerPose::TryGetAtTimestamp to receive a new

SpatialPointerPose object. Pass the following parameters.

A SpatialCoordinateSystem that represents the coordinate system you want for the head-gaze. This is

represented by the coordinateSystem variable in the following code. For more information, visit our

coordinate systems developer guide.

A Timestamp that represents the exact time of the head pose requested. Typically, you'll use a timestamp that

corresponds to the time when the current frame will be displayed. You can get this predicted display

timestamp from a HolographicFramePrediction object, which is accessible through the current

HolographicFrame. This HolographicFramePrediction object is represented by the prediction variable in the

following code.

Once you have a valid SpatialPointerPose, the head position and forward direction are accessible as properties.

The following code shows how to access them.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/gaze-in-directx.md
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialpointerpose
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialpointerpose.trygetattimestamp
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialpointerpose.trygetattimestamp
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialcoordinatesystem
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframeprediction.timestamp#windows_graphics_holographic_holographicframeprediction_timestamp
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframeprediction
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframe


using namespace winrt::Windows::UI::Input::Spatial;
using namespace winrt::Windows::Foundation::Numerics;

SpatialPointerPose pointerPose = SpatialPointerPose::TryGetAtTimestamp(coordinateSystem, 
prediction.Timestamp());
if (pointerPose)
{
 float3 headPosition = pointerPose.Head().Position();
 float3 headForwardDirection = pointerPose.Head().ForwardDirection();

 // Do something with the head-gaze
}

 Using eye-gaze

  Requesting access to eye-gaze inputRequesting access to eye-gaze input

using namespace winrt::Windows::Perception::People;
using namespace winrt::Windows::UI::Input;

std::thread requestAccessThread([this]()
{
 auto status = EyesPose::RequestAccessAsync().get();

 if (status == GazeInputAccessStatus::Allowed)
  m_isEyeTrackingEnabled = true;
 else
  m_isEyeTrackingEnabled = false;
});

requestAccessThread.detach();

For your users to use eye-gaze input, each user has to go through an eye tracking user calibration the first time

they use the device. The eye-gaze API is similar to head-gaze. It uses the same SpatialPointerPose API, which

provides a ray origin and direction that you can raycast against your scene. The only difference is that you need

to explicitly enable eye tracking before using it:

1. Request user permission to use eye tracking in your app.

2. Enable the "Gaze Input" capability in your package manifest.

When your app is starting up, call EyesPose::RequestAccessAsync to request access to eye tracking. The system

will prompt the user if needed, and return GazeInputAccessStatus::Allowed once access has been granted. This is

an asynchronous call, so it requires a bit of extra management. The following example spins up a detached

std::thread to wait for the result, which it stores to a member variable called m_isEyeTrackingEnabled.

Starting a detached thread is just one option for handling async calls. You could also use the new co_await

functionality supported by C++/WinRT. Here's another example for asking for user permission:

EyesPose::IsSupported() allows the application to trigger the permission dialog only if there's an eye tracker.

GazeInputAccessStatus m_gazeInputAccessStatus; // This is to prevent popping up the permission prompt

over and over again.

https://docs.microsoft.com/en-us/hololens/hololens-calibration
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialpointerpose
https://docs.microsoft.com/en-us/uwp/api/windows.perception.people.eyespose.requestaccessasync#windows_perception_people_eyespose_requestaccessasync
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.gazeinputaccessstatus
https://docs.microsoft.com/en-us/windows/uwp/cpp-and-winrt-apis/concurrency


GazeInputAccessStatus m_gazeInputAccessStatus; // This is to prevent popping up the permission prompt over 
and over again.

// This will trigger to show the permission prompt to the user.
// Ask for access if there is a corresponding device and registry flag did not disable it.
if (Windows::Perception::People::EyesPose::IsSupported() &&
   (m_gazeInputAccessStatus == GazeInputAccessStatus::Unspecified))
{ 
 Concurrency::create_task(Windows::Perception::People::EyesPose::RequestAccessAsync()).then(
 [this](GazeInputAccessStatus status)
 {
    // GazeInputAccessStatus::{Allowed, DeniedBySystem, DeniedByUser, Unspecified}
      m_gazeInputAccessStatus = status;
  
  // Let's be sure to not ask again.
  if(status == GazeInputAccessStatus::Unspecified)
  {
         m_gazeInputAccessStatus = GazeInputAccessStatus::DeniedBySystem; 
  }
 });
}

  Declaring the Declaring the Gaze InputGaze Input capability capability
Double-click the appxmanifest file in Solution Explorer. Then navigate to the Capabilities section and check the

Gaze Input capability.

This adds the following lines to the Package section in the appxmanifest file:



  <Capabilities>
    <DeviceCapability Name="gazeInput" />
  </Capabilities>

  Getting the eye-gaze rayGetting the eye-gaze ray

using namespace winrt::Windows::UI::Input::Spatial;
using namespace winrt::Windows::Foundation::Numerics;

SpatialPointerPose pointerPose = SpatialPointerPose::TryGetAtTimestamp(coordinateSystem, 
prediction.Timestamp());
if (pointerPose)
{
 if (pointerPose.Eyes() && pointerPose.Eyes().IsCalibrationValid())
 {
  if (pointerPose.Eyes().Gaze())
  {
   auto spatialRay = pointerPose.Eyes().Gaze().Value();
   float3 eyeGazeOrigin = spatialRay.Origin;
   float3 eyeGazeDirection = spatialRay.Direction;
   
   // Do something with the eye-gaze
  }
 }
}

 Fallback when eye tracking isn't available

Once you have received access to ET, you're free to grab the eye-gaze ray every frame. As with head-gaze, get

the SpatialPointerPose by calling SpatialPointerPose::TryGetAtTimestamp with a desired timestamp and

coordinate system. The SpatialPointerPose contains an EyesPose object through the Eyes property. This is non-

null only if eye tracking is enabled. From there, you can check if the user in the device has an eye tracking

calibration by calling EyesPose::IsCalibrationValid. Next, use the Gaze property to get the SpatialRay containing

the eye-gaze position and direction. The Gaze property can sometimes be null, so be sure to check for this. This

can happen is if a calibrated user temporarily closes their eyes.

The following code shows how to access the eye-gaze ray.

As mentioned in our eye tracking design docs, both designers and developers should be aware of instances

where eye tracking data may not be available.

There are various reasons for data being unavailable:

A user not being calibrated

A user has denied the app access to his/her eye tracking data

Temporary interferences, such as smudges on the HoloLens visor or hair occluding the user's eyes.

While some of the APIs have already been mentioned in this document, in the following, we provide a summary

of how to detect that eye tracking is available as a quick reference:

Check that the system supports eye tracking at all. Call the following method:

Windows.Perception.People.EyesPose.IsSupported()

Check that the user is calibrated. Call the following property:

Windows.Perception.People.EyesPose.IsCalibrationValid

Check that the user has given your app permission to use their eye tracking data: Retrieve the current

'GazeInputAccessStatus'. An example on how to do this is explained at Requesting access to gaze input.

https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialpointerpose
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialpointerpose.trygetattimestamp
https://docs.microsoft.com/en-us/uwp/api/windows.perception.people.eyespose
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialpointerpose.eyes
https://docs.microsoft.com/en-us/uwp/api/windows.perception.people.eyespose.iscalibrationvalid#windows_perception_people_eyespose_iscalibrationvalid
https://docs.microsoft.com/en-us/uwp/api/windows.perception.people.eyespose.gaze#windows_perception_people_eyespose_gaze
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialray
https://docs.microsoft.com/en-us/uwp/api/windows.perception.people.eyespose.issupported#windows_perception_people_eyespose_issupported
https://docs.microsoft.com/en-us/uwp/api/windows.perception.people.eyespose.iscalibrationvalid#windows_perception_people_eyespose_iscalibrationvalid
https://docs.microsoft.com/en-us/windows/mixed-reality/gaze-in-directx#requesting-access-to-gaze-input


 Correlating gaze with other inputs

 Calibration

 See also

You may also want to check that your eye tracking data isn't stale by adding a timeout between received eye

tracking data updates and otherwise fallback to head-gaze as discussed below. Visit our fallback design

considerations for more information.

Sometimes you may find that you need a SpatialPointerPose that corresponds with an event in the past. For

example, if the user does an Air Tap, your app might want to know what they were looking at. For this purpose,

simply using SpatialPointerPose::TryGetAtTimestamp with the predicted frame time would be inaccurate because

of the latency between system input processing and display time. Also, if using eye-gaze for targeting, our eyes

tend to move on even before finishing a commit action. This is less of an issue for a simple Air Tap, but becomes

more critical when combining long voice commands with fast eye movements. One way to handle this scenario

is to make an additional call to SpatialPointerPose::TryGetAtTimestamp, using a historical timestamp that

corresponds to the input event.

However, for input that routes through the SpatialInteractionManager, there's an easier method. The

SpatialInteractionSourceState has its own TryGetAtTimestamp function. Calling that will provide a perfectly

correlated SpatialPointerPose without the guesswork. For more information on working with

SpatialInteractionSourceStates, take a look at the Hands and Motion Controllers in DirectX documentation.

For eye tracking to work accurately, each user is required to go through an eye tracking user calibration. This

allows the device to adjust the system for a more comfortable and higher quality viewing experience for the

user and to ensure accurate eye tracking at the same time. Developers don’t need to do anything on their end to

manage user calibration. The system will ensure that the user gets prompted to calibrate the device under the

following circumstances:

The user is using the device for the first time

The user previously opted out of the calibration process

The calibration process didn't succeed the last time the user used the device

Developers should make sure to provide adequate support for users where eye tracking data may not be

available. Learn more about considerations for fallback solutions at Eye tracking on HoloLens 2.

Calibration

Coordinate systems in DirectX

Eye-gaze on HoloLens 2

Gaze and commit input model

Hands and motion controllers in DirectX

Voice Input in DirectX

https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialpointerpose
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialpointerpose.trygetattimestamp
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialpointerpose.trygetattimestamp
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsourcestate
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsourcestate.trygetpointerpose
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialpointerpose
https://docs.microsoft.com/en-us/hololens/hololens-calibration
https://docs.microsoft.com/en-us/hololens/hololens-calibration
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 Getting started

using namespace winrt::Windows::UI::Input::Spatial;

SpatialInteractionManager interactionManager = SpatialInteractionManager::GetForCurrentView();

  Event-driven inputEvent-driven input

using namespace winrt::Windows::UI::Input::Spatial;

auto interactionManager = SpatialInteractionManager::GetForCurrentView();
interactionManager.SourcePressed({ this, &MyApp::OnSourcePressed });

This article relates to the legacy WinRT native APIs. For new native app projects, we recommend using the OpenXR APIOpenXR API .

In Windows Mixed Reality, both hand and motion controller input is handled through the spatial input APIs,

found in the Windows.UI.Input.Spatial namespace. This enables you to easily handle common actions like SelectSelect

presses the same way across both hands and motion controllers.

To access spatial input in Windows Mixed Reality, start with the SpatialInteractionManager interface. You can

access this interface by calling SpatialInteractionManager ::GetForCurrentView, typically sometime during app

startup.

The SpatialInteractionManager's job is to provide access to SpatialInteractionSources, which represent a source

of input. There are three kinds of SpatialInteractionSources available in the system.

HandHand represents a user's detected hand. Hand sources offer different features based on the device, ranging

from basic gestures on HoloLens to fully articulated hand tracking on HoloLens 2.

ControllerController  represents a paired motion controller. Motion controllers can offer different capabilities, for

example, Select triggers, Menu buttons, Grasp buttons, touchpads, and thumbsticks.

VoiceVoice represents the user's voice speaking system-detected keywords. For example, this source will inject a

Select press and release whenever the user says "Select".

Per-frame data for a source is represented by the SpatialInteractionSourceState interface. There are two different

ways to access this data, depending on whether you want to use an event-driven or polling-based model in your

application.

The SpatialInteractionManager provides a number of events that your app can listen for. A few examples include

SourcePressed, [SourceReleased, and SourceUpdated.

For example, the following code hooks up an event handler called MyApp::OnSourcePressed to the

SourcePressed event. This allows your app to detect presses on any type of interaction source.

This pressed event is sent to your app asynchronously, along with the corresponding

SpatialInteractionSourceState at the time the press happened. Your app or game engine may want to start

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/hands-and-motion-controllers-in-directx.md
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionmanager.getforcurrentview
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsource
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsourcestate
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionmanager.sourcepressed
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionmanager.sourceupdated


using namespace winrt::Windows::UI::Input::Spatial;

void MyApp::OnSourcePressed(SpatialInteractionManager const& sender, SpatialInteractionSourceEventArgs 
const& args)
{
 if (args.PressKind() == SpatialInteractionPressKind::Select)
 {
  // Select button was pressed, update app state
 }
}

  Polling-based inputPolling-based input

using namespace winrt::Windows::UI::Input::Spatial;

auto interactionManager = SpatialInteractionManager::GetForCurrentView();
auto sourceStates = m_spatialInteractionManager.GetDetectedSourcesAtTimestamp(prediction.Timestamp());

for (auto& sourceState : sourceStates)
{
 if (sourceState.IsSelectPressed())
 {
  // Select button is down, update app state
 }
}

  Predicted vs. historical posesPredicted vs. historical poses

processing right away or queue up the event data in your input processing routine. Here's an event handler

function for the SourcePressed event, which checks whether the select button has been pressed.

The above code only checks for the 'Select' press, which corresponds to the primary action on the device.

Examples include doing an AirTap on HoloLens or pulling the trigger on a motion controller. 'Select' presses

represent the user's intention to activate the hologram they're targeting. The SourcePressed event will fire for a

number of different buttons and gestures, and you can inspect other properties on the SpatialInteractionSource

to test for those cases.

You can also use SpatialInteractionManager to poll for the current state of input every frame. To do this, call

GetDetectedSourcesAtTimestamp every frame. This function returns an array containing one

SpatialInteractionSourceState for every active SpatialInteractionSource. This means one for each active motion

controller, one for each tracked hand, and one for speech if a 'select' command was recently uttered. You can

then inspect the properties on each SpatialInteractionSourceState to drive input into your application.

Here's an example of how to check for the 'select' action using the polling method. The prediction variable

represents a HolographicFramePrediction object, which can be obtained from the HolographicFrame.

Each SpatialInteractionSource has an ID, which you can use to identify new sources and correlate existing

sources from frame to frame. Hands get a new ID every time they leave and enter the FOV, but controller IDs

remain static for the duration of the session. You can use the events on SpatialInteractionManager such as

SourceDetected and SourceLost, to react when hands enter or leave the device's view, or when motion

controllers are turned on/off or are paired/unpaired.

GetDetectedSourcesAtTimestamp has a timestamp parameter. This enables you to request state and pose data

that is either predicted or historical, letting you correlate spatial interactions with other sources of input. For

example, when rendering the hand's position in the current frame, you can pass in the predicted timestamp

provided by the HolographicFrame. This enables the system to forward-predict the hand position to closely

align with the rendered frame output, minimizing perceived latency.

However, such a predicted pose doesn't produce an ideal pointing ray for targeting with an interaction source.

https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionmanager.getdetectedsourcesattimestamp
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsourcestate
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsource
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframeprediction
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframe
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionmanager.sourcedetected
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionmanager.sourcelost
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframe


 Cross-device input properties
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SpatialInteractionSou
rce::HandednessHandedness

Right or left hand /
controller.

Not Supported Supported Supported

SpatialInteractionSou
rceState::IsSelectPreIsSelectPre
ssedssed

Current state of the
primary button.

Air Tap Trigger Relaxed Air Tap
(upright pinch)

SpatialInteractionSou
rceState::IsGraspedIsGrasped

Current state of the
grab button.

Not Supported Grab button Pinch or Closed Hand

SpatialInteractionSou
rceState::IsMenuPreIsMenuPre
ssedssed

Current state of the
menu button.

Not Supported Menu Button Not Supported

SpatialInteractionSou
rceLocation::PositionPosition

XYZ location of the
hand or grip position
on the controller.

Palm location Grip pose position Palm location

For example, when a motion controller button is pressed, it can take up to 20 ms for that event to bubble up

through Bluetooth to the operating system. Similarly, after a user does a hand gesture, some amount of time

may pass before the system detects the gesture and your app then polls for it. By the time your app polls for a

state change, the head and hand poses used to target that interaction actually happened in the past. If you target

by passing your current HolographicFrame's timestamp to GetDetectedSourcesAtTimestamp, the pose will

instead be forward predicted to the targeting ray at the time the frame will be displayed, which could be more

than 20 ms in the future. This future pose is good for rendering the interaction source, but compounds our time

problem for targeting the interaction, as the user's targeting occurred in the past.

Fortunately, the SourcePressed, [SourceReleased, and SourceUpdated events provide the historical State

associated with each input event. This directly includes the historical head and hand poses available through

TryGetPointerPose, along with a historical Timestamp that you can pass to other APIs to correlate with this event.

That leads to the following best practices when rendering and targeting with hands and controllers each frame:

For hand/controller  renderinghand/controller  rendering each frame, your app should pollpoll  for the for ward-predictedfor ward-predicted pose of

each interaction source at the current frame’s photon time. You can poll for all interaction sources by calling

GetDetectedSourcesAtTimestamp each frame, passing in the predicted timestamp provided by

HolographicFrame::CurrentPrediction.

For hand/controller  targetinghand/controller  targeting upon a press or release, your app should handle pressed/released eventsevents ,

raycasting based on the histor icalhistor ical  head or hand pose for that event. You get this targeting ray by handling

the SourcePressed or SourceReleased event, getting the State property from the event arguments, and then

calling its TryGetPointerPose method.

The SpatialInteractionSource API supports controllers and hand tracking systems with a wide range of

capabilities. A number of these capabilities are common between device types. For example, hand tracking and

motion controllers both provide a 'select' action and a 3D position. Wherever possible, the API maps these

common capabilities to the same properties on the SpatialInteractionSource. This enables applications to more

easily support a wide range of input types. The following table describes the properties that are supported, and

how they compare across input types.

https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionmanager.sourcepressed
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionmanager.sourceupdated
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsourceeventargs.state
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsourcestate.trygetpointerpose
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsourcestate.timestamp
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionmanager.getdetectedsourcesattimestamp
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframe.currentprediction
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionmanager.sourcepressed
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionmanager.sourcereleased
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsourceeventargs.state
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsourcestate.trygetpointerpose
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsource.handedness
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsourcestate.isselectpressed
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsourcestate.isgrasped
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsourcestate.ismenupressed
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsourcelocation.position


SpatialInteractionSou
rceLocation::OrientaOrienta
tiontion

Quaternion
representing the
orientation of the
hand or grip pose on
the controller.

Not Supported Grip pose orientation Palm orientation

SpatialPointerInteract
ionSourcePose::PositiPositi
onon

Origin of the
pointing ray.

Not Supported Supported Supported

SpatialPointerInteract
ionSourcePose::For wFor w
ardDirectionardDirection

Direction of the
pointing ray.

Not Supported Supported Supported
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  Grip pose vs. pointing poseGrip pose vs. pointing pose

 Controller-specific input properties

Some of the above properties aren't available on all devices, and the API provides a means to test for this. For

example, you can inspect the SpatialInteractionSource::IsGraspSupported property to determine whether the

source provides a grasp action.

Windows Mixed Reality supports motion controllers in different form factors. It also supports articulated hand

tracking systems. All of these systems have different relationships between the hand position and the natural

"forward" direction that apps should use for pointing or rendering objects in the user's hand. To support all of

this, there are two types of 3D poses provided for both hand tracking and motion controllers. The first is grip

pose, which represents the user's hand position. The second is pointing pose, which represents a pointing ray

originating from the user's hand or controller. So, if you want to render the user 's handthe user 's hand or an object held inan object held in

the user 's handthe user 's hand, such as a sword or gun, use the grip pose. If you want to raycast from the controller or hand,

for example when the user is **pointing at UI, use the pointing pose.

You can access the gr ip posegrip pose through SpatialInteractionSourceState::Properties::TryGetLocation(...). It's defined

as follows:

The gr ip positiongrip position: The palm centroid when holding the controller naturally, adjusted left or right to center

the position within the grip.

The gr ip or ientation's Right axisgr ip or ientation's Right axis : When you completely open your hand to form a flat 5-finger pose, the

ray that is normal to your palm (forward from left palm, backward from right palm)

The gr ip or ientation's For ward axisgr ip or ientation's For ward axis : When you close your hand partially (as if holding the controller), the

ray that points "forward" through the tube formed by your non-thumb fingers.

The gr ip or ientation's Up axisgr ip or ientation's Up axis : The Up axis implied by the Right and Forward definitions.

You can access the pointer posepointer pose through

SpatialInteractionSourceState::Properties::TryGetLocation(...)::SourcePointerPose or

SpatialInteractionSourceState::TryGetPointerPose(...)::TryGetInteractionSourcePose.

For controllers, the SpatialInteractionSource has a Controller property with additional capabilities.

HasThumbstick :HasThumbstick : If true, the controller has a thumbstick. Inspect the ControllerProperties property of the

SpatialInteractionSourceState to acquire the thumbstick x and y values (ThumbstickX and ThumbstickY), as

well as its pressed state (IsThumbstickPressed).

HasTouchpad:HasTouchpad: If true, the controller has a touchpad. Inspect the ControllerProperties property of the

SpatialInteractionSourceState to acquire the touchpad x and y values (TouchpadX and TouchpadY), and to

https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsourcelocation.orientation
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialpointerinteractionsourcepose.position#windows_ui_input_spatial_spatialpointerinteractionsourcepose_position
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialpointerinteractionsourcepose.forwarddirection#windows_ui_input_spatial_spatialpointerinteractionsourcepose_forwarddirection
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsource.isgraspsupported
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsourceproperties.trygetlocation#windows_ui_input_spatial_spatialinteractionsourceproperties_trygetlocation_windows_perception_spatial_spatialcoordinatesystem_
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsourcelocation#windows_ui_input_spatial_spatialinteractionsourcelocation_sourcepointerpose
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialpointerpose#windows_ui_input_spatial_spatialpointerpose_trygetinteractionsourcepose_windows_ui_input_spatial_spatialinteractionsource_
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractioncontrollerproperties


 Articulated hand tracking

  Hand skeletonHand skeleton

know if the user is touching the pad (IsTouchpadTouched) and if they're pressing the touchpad down

(IsTouchpadPressed).

S impleHapticsController :S impleHapticsController : The SimpleHapticsController API for the controller allows you to inspect the

haptics capabilities of the controller, and it also allows you to control haptic feedback.

The range for touchpad and thumbstick is -1 to 1 for both axes (from bottom to top, and from left to right). The

range for the analog trigger, which is accessed using the SpatialInteractionSourceState::SelectPressedValue

property, has a range of 0 to 1. A value of 1 correlates with IsSelectPressed being equal to true; any other value

correlates with IsSelectPressed being equal to false.

The Windows Mixed Reality API provides full support for articulated hand tracking, for example on HoloLens 2.

Articulated hand tracking can be used to implement direct manipulation and point-and-commit input models in

your applications. It can also be used to author fully custom interactions.

Articulated hand tracking provides a 25 joint skeleton that enables many different types of interactions. The

skeleton provides five joints for the index/middle/ring/little fingers, four joints for the thumb, and one wrist

joint. The wrist joint serves as the base of the hierarchy. The following picture illustrates the layout of the

skeleton.

In most cases, each joint is named based on the bone that it represents. Since there are two bones at every joint,

we use a convention of naming each joint based on the child bone at that location. The child bone is defined as



N A M EN A M E DESC RIP T IO NDESC RIP T IO N

Position 3D position of the joint, available in any requested
coordinate system.

Orientation 3D orientation of the bone, available in any requested
coordinate system.

Radius Distance to surface of the skin at the joint position. Useful
for tuning direct interactions or visualizations that rely on
finger width.

Accuracy Provides a hint on how confident the system feels about this
joint's information.

using namespace winrt::Windows::Perception::People;
using namespace winrt::Windows::Foundation::Numerics;

auto handPose = currentState.TryGetHandPose();
if (handPose)
{
 JointPose joint;
 if (handPose.TryGetJoint(desiredCoordinateSystem, HandJointKind::IndexTip, joint))
 {
  float3 indexTipPosition = joint.Position;

  // Do something with the index tip position
 }
}

  Hand meshHand mesh

the bone further from the wrist. For example, the "Index Proximal" joint contains the beginning position of the

index proximal bone, and the orientation of that bone. It doesn't contain the ending position of the bone. If you

need that, you'd get it from the next joint in the hierarchy, the "Index Intermediate" joint.

In addition to the 25 hierarchical joints, the system provides a palm joint. The palm isn't typically considered part

of the skeletal structure. It's provided only as a convenient way to get the hand's overall position and orientation.

The following information is provided for each joint:

You can access the hand skeleton data through a function on the SpatialInteractionSourceState. The function is

called TryGetHandPose, and it returns an object called HandPose. If the source doesn't support articulated hands,

then this function will return null. Once you have a HandPose, you can get current joint data by calling

TryGetJoint, with the name of the joint you're interested in. The data is returned as a JointPose structure. The

following code gets the position of the index finger tip. The variable currentState represents an instance of

SpatialInteractionSourceState.

The articulated hand tracking API allows for a fully deformable triangle hand mesh. This mesh can deform in

real time along with the hand skeleton, and is useful for visualization and advanced physics techniques. To

access the hand mesh, you need to first create a HandMeshObserver object by calling

TryCreateHandMeshObserverAsync on the SpatialInteractionSource. This only needs to be done once per

source, typically the first time you see it. That means you'll call this function to create a HandMeshObserver

object whenever a hand enters the FOV. This is an async function, so you'll have to deal with a bit of concurrency

here. Once available, you can ask the HandMeshObserver object for the triangle index buffer by calling

GetTriangleIndices. Indices don't change frame over frame, so you can get those once and cache them for the

lifetime of the source. Indices are provided in clockwise winding order.

https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsourcestate
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsourcestate.trygethandpose#windows_ui_input_spatial_spatialinteractionsourcestate_trygethandpose
https://docs.microsoft.com/en-us/uwp/api/windows.perception.people.handpose
https://docs.microsoft.com/en-us/uwp/api/windows.perception.people.handpose.trygetjoint#windows_perception_people_handpose_trygetjoint_windows_perception_spatial_spatialcoordinatesystem_windows_perception_people_handjointkind_windows_perception_people_jointpose__
https://docs.microsoft.com/en-us/uwp/api/windows.perception.people.jointpose
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsourcestate
https://docs.microsoft.com/en-us/uwp/api/windows.perception.people.handmeshobserver
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsource.trycreatehandmeshobserverasync
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsource
https://docs.microsoft.com/en-us/uwp/api/windows.perception.people.handmeshobserver.gettriangleindices#windows_perception_people_handmeshobserver_gettriangleindices_system_uint16___


using namespace Windows::Perception::People;

std::thread createObserverThread([this, currentState]()
{
    HandMeshObserver newHandMeshObserver = currentState.Source().TryCreateHandMeshObserverAsync().get();
    if (newHandMeshObserver)
    {
  unsigned indexCount = newHandMeshObserver.TriangleIndexCount();
  vector<unsigned short> indices(indexCount);
  newHandMeshObserver.GetTriangleIndices(indices);

        // Save the indices and handMeshObserver for later use - and use a mutex to synchronize access if 
needed!
     }
});
createObserverThread.detach();

using namespace winrt::Windows::Perception::People;

auto handPose = currentState.TryGetHandPose();
if (handPose)
{
    std::vector<HandMeshVertex> vertices(handMeshObserver.VertexCount());
    auto vertexState = handMeshObserver.GetVertexStateForPose(handPose);
    vertexState.GetVertices(vertices);

    auto meshTransform = vertexState.CoordinateSystem().TryGetTransformTo(desiredCoordinateSystem);
    if (meshTransform != nullptr)
    {
     // Do something with the vertices and mesh transform, along with the indices that you saved earlier
    }
}

 Gaze and Commit composite gestures

The following code spins up a detached std::thread to create the mesh observer and extracts the index buffer

once the mesh observer is available. It starts from a variable called currentState, which is an instance of

SpatialInteractionSourceState representing a tracked hand.

Starting a detached thread is just one option for handling async calls. Alternatively, you could use the new

co_await functionality supported by C++/WinRT.

Once you have a HandMeshObserver object, you should hold onto it for the duration that its corresponding

SpatialInteractionSource is active. Then each frame, you can ask it for the latest vertex buffer that represents the

hand by calling GetVertexStateForPose and passing in a HandPose instance that represents the pose that you

want vertices for. Each vertex in the buffer has a position and a normal. Here's an example of how to get the

current set of vertices for a hand mesh. As before, the currentState variable represents an instance of

SpatialInteractionSourceState.

In contrast to skeleton joints, the hand mesh API doesn't allow you to specify a coordinate system for the

vertices. Instead, the HandMeshVertexState specifies the coordinate system that the vertices are provided in. You

can then get a mesh transform by calling TryGetTransformTo and specifying the coordinate system you want.

You'll need to use this mesh transform whenever you work with the vertices. This approach reduces CPU

overhead, especially if you're only using the mesh for rendering purposes.

For applications using the gaze-and-commit input model, particularly on HoloLens (first gen), the Spatial Input

API provides an optional SpatialGestureRecognizer that can be used to enable composite gestures built on top

of the 'select' event. By routing interactions from the SpatialInteractionManager to a hologram's

SpatialGestureRecognizer, apps can detect Tap, Hold, Manipulation, and Navigation events uniformly across

https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsourcestate
https://docs.microsoft.com/en-us/windows/uwp/cpp-and-winrt-apis/concurrency
https://docs.microsoft.com/en-us/uwp/api/windows.perception.people.handmeshobserver.getvertexstateforpose
https://docs.microsoft.com/en-us/uwp/api/windows.perception.people.handpose
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsourcestate
https://docs.microsoft.com/en-us/uwp/api/windows.perception.people.handmeshvertexstate
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialcoordinatesystem.trygettransformto#windows_perception_spatial_spatialcoordinatesystem_trygettransformto_windows_perception_spatial_spatialcoordinatesystem_
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialgesturerecognizer


 See also

hands, voice, and spatial input devices, without having to handle presses and releases manually.

SpatialGestureRecognizer does only the minimal disambiguation between the set of gestures that you request.

For example, if you request just Tap, the user may hold their finger down as long as they like and a Tap will still

occur. If you request both Tap and Hold, after about a second of holding down their finger the gesture will

promote to a Hold and a Tap will no longer occur.

To use SpatialGestureRecognizer, handle the SpatialInteractionManager's InteractionDetected event and grab the

SpatialPointerPose exposed there. Use the user's head gaze ray from this pose to intersect with the holograms

and surface meshes in the user's surroundings to determine what the user is intending to interact with. Then,

route the SpatialInteraction in the event arguments to the target hologram's SpatialGestureRecognizer, using its

CaptureInteraction method. This starts interpreting that interaction according to the SpatialGestureSettings set

on that recognizer at creation time - or by TrySetGestureSettings.

On HoloLens (first gen), interactions and gestures should derive their targeting from the user's head gaze, rather

than rendering or interacting at the hand's location. Once an interaction has started, relative motions of the

hand may be used to control the gesture, as with the Manipulation or Navigation gesture.

Head and eye gaze in DirectX

Direct manipulation input model

Point-and-commit input model

Gaze and commit input model

Motion controllers

https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionmanager
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialgesturerecognizer
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialgesturesettings
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialgesturerecognizer
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 Use SpeechRecognizer for continuous speech recognition

m_speechRecognizer = ref new SpeechRecognizer();

m_speechCommandList = ref new Platform::Collections::Vector<String^>();
   m_speechCommandData.clear();
   m_speechCommandList->Append(StringReference(L"white"));
   m_speechCommandData.push_back(float4(1.f, 1.f, 1.f, 1.f));
   m_speechCommandList->Append(StringReference(L"grey"));
   m_speechCommandData.push_back(float4(0.5f, 0.5f, 0.5f, 1.f));
   m_speechCommandList->Append(StringReference(L"green"));
   m_speechCommandData.push_back(float4(0.f, 1.f, 0.f, 1.f));
   m_speechCommandList->Append(StringReference(L"black"));
   m_speechCommandData.push_back(float4(0.1f, 0.1f, 0.1f, 1.f));
   m_speechCommandList->Append(StringReference(L"red"));
   m_speechCommandData.push_back(float4(1.f, 0.f, 0.f, 1.f));
   m_speechCommandList->Append(StringReference(L"yellow"));
   m_speechCommandData.push_back(float4(1.f, 1.f, 0.f, 1.f));
   m_speechCommandList->Append(StringReference(L"aquamarine"));
   m_speechCommandData.push_back(float4(0.f, 1.f, 1.f, 1.f));
   m_speechCommandList->Append(StringReference(L"blue"));
   m_speechCommandData.push_back(float4(0.f, 0.f, 1.f, 1.f));
   m_speechCommandList->Append(StringReference(L"purple"));
   m_speechCommandData.push_back(float4(1.f, 0.f, 1.f, 1.f));

This article relates to the legacy WinRT native APIs. For new native app projects, we recommend using the OpenXR APIOpenXR API .

This article explains how to implement voice commands plus small-phrase and sentence recognition in a DirectX

app for Windows Mixed Reality.

The code snippets in this article use C++/CX rather than C++17-compliant C++/WinRT, which is used in the C++

holographic project template. The concepts are equivalent for a C++/WinRT project, but you need to translate the code.

This section describes how to use continuous speech recognition to enable voice commands in your app. This

walk-through uses code from the HolographicVoiceInput sample. When the sample is running, speak the name

of one of the registered color commands to change the color of the spinning cube.

First, create a new Windows::Media::SpeechRecognition::SpeechRecognizer instance.

From HolographicVoiceInputSampleMain::CreateSpeechConstraintsForCurrentState:

Create a list of speech commands for the recognizer to listen for. Here, we construct a set of commands to

change the color of a hologram. For convenience, we also create the data that we'll use for the commands later.

You can use phonetic words that might not be in a dictionary to specify commands.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/voice-input-in-directx.md
https://go.microsoft.com/fwlink/p/?LinkId=844964


m_speechCommandList->Append(StringReference(L"SpeechRecognizer"));
   m_speechCommandData.push_back(float4(0.5f, 0.1f, 1.f, 1.f));

SpeechRecognitionListConstraint^ spConstraint = ref new 
SpeechRecognitionListConstraint(m_speechCommandList);
   m_speechRecognizer->Constraints->Clear();
   m_speechRecognizer->Constraints->Append(spConstraint);
   create_task(m_speechRecognizer->CompileConstraintsAsync()).then([this]
(SpeechRecognitionCompilationResult^ compilationResult)
   {
       if (compilationResult->Status == SpeechRecognitionResultStatus::Success)
       {
           m_speechRecognizer->ContinuousRecognitionSession->StartAsync();
       }
       else
       {
           // Handle errors here.
       }
   });

m_speechRecognizer->ContinuousRecognitionSession->ResultGenerated +=
       ref new TypedEventHandler<SpeechContinuousRecognitionSession^, 
SpeechContinuousRecognitionResultGeneratedEventArgs^>(
           std::bind(&HolographicVoiceInputSampleMain::OnResultGenerated, this, _1, _2)
           );

// Change the cube color, if we get a valid result.
   void HolographicVoiceInputSampleMain::OnResultGenerated(SpeechContinuousRecognitionSession ^sender, 
SpeechContinuousRecognitionResultGeneratedEventArgs ^args)
   {
       if (args->Result->RawConfidence > 0.5f)
       {
           m_lastCommand = args->Result->Text;
       }
   }

To load the commands list into the list of constraints for the speech recognizer, use a

SpeechRecognitionListConstraint object.

Subscribe to the ResultGenerated event on the speech recognizer's SpeechContinuousRecognitionSession. This

event notifies your app when one of your commands has been recognized.

Your OnResultGenerated event handler receives event data in a

SpeechContinuousRecognitionResultGeneratedEventArgs instance. If the confidence is greater than the

threshold you defined, your app should note that the event happened. Save the event data so that you can use it

in a later update loop.

From HolographicVoiceInputSampleMain.cpp:

In our example code, we change the color of the spinning hologram cube according to the user's command.

From HolographicVoiceInputSampleMain::Update:

https://docs.microsoft.com/en-us/uwp/api/windows.media.speechrecognition.speechrecognitionlistconstraint
https://docs.microsoft.com/en-us/uwp/api/windows.media.speechrecognition.speechcontinuousrecognitionsession
https://docs.microsoft.com/en-us/uwp/api/windows.media.speechrecognition.speechcontinuousrecognitionsession
https://docs.microsoft.com/en-us/uwp/api/windows.media.speechrecognition.speechcontinuousrecognitionresultgeneratedeventargs


// Check for new speech input since the last frame.
   if (m_lastCommand != nullptr)
   {
       auto command = m_lastCommand;
       m_lastCommand = nullptr;

       int i = 0;
       for each (auto& iter in m_speechCommandList)
       {
           if (iter == command)
           {
               m_spinningCubeRenderer->SetColor(m_speechCommandData[i]);
               break;
           }

           ++i;
       }
   }

 Use "one-shot" recognition

auto constraint = ref new SpeechRecognitionTopicConstraint(SpeechRecognitionScenario::WebSearch, 
L"webSearch");
   m_speechRecognizer->Constraints->Clear();
   m_speechRecognizer->Constraints->Append(constraint);
   return create_task(m_speechRecognizer->CompileConstraintsAsync())
       .then([this](task<SpeechRecognitionCompilationResult^> previousTask)
   {

try
       {
           SpeechRecognitionCompilationResult^ compilationResult = previousTask.get();

           // Check to make sure that the constraints were in a proper format and the recognizer was able to 
compile it.
           if (compilationResult->Status == SpeechRecognitionResultStatus::Success)
           {
               // If the compilation succeeded, we can start listening for the user's spoken phrase or 
sentence.
               create_task(m_speechRecognizer->RecognizeAsync()).then([this](task<SpeechRecognitionResult^>& 
previousTask)
               {

You can configure a speech recognizer to listen for phrases or sentences that the user speaks. In this case, we

apply a SpeechRecognitionTopicConstraint that tells the speech recognizer what type of input to expect. Here's

an app workflow for this scenario:

1. Your app creates the SpeechRecognizer, provides UI prompts, and starts listening for a spoken command.

2. The user speaks a phrase or sentence.

3. Recognition of the user's speech occurs, and a result is returned to the app. At this point, your app should

provide a UI prompt to indicate that recognition has occurred.

4. Depending on the confidence level that you want to respond to and the confidence level of the speech

recognition result, your app can process the result and respond as appropriate.

This section describes how to create a SpeechRecognizer, compile the constraint, and listen for speech input.

The following code compiles the topic constraint, which in this case is optimized for web search.

If compilation succeeds, we can continue with speech recognition.



try
                   {
                       auto result = previousTask.get();

                       if (result->Status != SpeechRecognitionResultStatus::Success)
                       {
                           PrintWstringToDebugConsole(
                               std::wstring(L"Speech recognition was not successful: ") +
                               result->Status.ToString()->Data() +
                               L"\n"
                               );
                       }

                       // In this example, we look for at least medium confidence in the speech result.
                       if ((result->Confidence == SpeechRecognitionConfidence::High) ||
                           (result->Confidence == SpeechRecognitionConfidence::Medium))
                       {
                           // If the user said a color name anywhere in their phrase, it will be recognized 
in the
                           // Update loop; then, the cube will change color.
                           m_lastCommand = result->Text;

                           PrintWstringToDebugConsole(
                               std::wstring(L"Speech phrase was: ") +
                               m_lastCommand->Data() +
                               L"\n"
                               );
                       }
                       else
                       {
                           PrintWstringToDebugConsole(
                               std::wstring(L"Recognition confidence not high enough: ") +
                               result->Confidence.ToString()->Data() +
                               L"\n"
                               );
                       }
                   }

The result is then returned to the app. If we're confident enough in the result, we can process the command. This

code example processes results with at least medium confidence.

Whenever you use speech recognition, watch for exceptions that could indicate that the user has turned off the

microphone in the system privacy settings. This can happen during initialization or recognition.



catch (Exception^ exception)
                   {
                       // Note that if you get an "Access is denied" exception, you might need to enable the 
microphone
                       // privacy setting on the device and/or add the microphone capability to your app 
manifest.

                       PrintWstringToDebugConsole(
                           std::wstring(L"Speech recognizer error: ") +
                           exception->ToString()->Data() +
                           L"\n"
                           );
                   }
               });

               return true;
           }
           else
           {
               OutputDebugStringW(L"Could not initialize predefined grammar speech engine!\n");

               // Handle errors here.
               return false;
           }
       }
       catch (Exception^ exception)
       {
           // Note that if you get an "Access is denied" exception, you might need to enable the microphone
           // privacy setting on the device and/or add the microphone capability to your app manifest.

           PrintWstringToDebugConsole(
               std::wstring(L"Exception while trying to initialize predefined grammar speech engine:") +
               exception->Message->Data() +
               L"\n"
               );

           // Handle exceptions here.
           return false;
       }
   });

NOTENOTE
There are several predefined SpeechRecognitionScenarios that you can use to optimize speech recognition.

// Compile the dictation topic constraint, which optimizes for speech dictation.
auto dictationConstraint = ref new 
SpeechRecognitionTopicConstraint(SpeechRecognitionScenario::Dictation, "dictation");
m_speechRecognizer->Constraints->Append(dictationConstraint);

// Add a web search topic constraint to the recognizer.
auto webSearchConstraint = ref new 
SpeechRecognitionTopicConstraint(SpeechRecognitionScenario::WebSearch, "webSearch");
speechRecognizer->Constraints->Append(webSearchConstraint);

To optimize for dictation, use the dictation scenario.

For speech web searches, use the following web-specific scenario constraint.

Use the form constraint to fill out forms. In this case, it's best to apply your own grammar that's

https://docs.microsoft.com/en-us/uwp/api/windows.media.speechrecognition.speechrecognitionscenario


 Use continuous recognition

 Handle quality degradation

m_speechRecognizer->RecognitionQualityDegrading +=
       ref new TypedEventHandler<SpeechRecognizer^, SpeechRecognitionQualityDegradingEventArgs^>(
           std::bind(&HolographicVoiceInputSampleMain::OnSpeechQualityDegraded, this, _1, _2)
           );

// Add a form constraint to the recognizer.
auto formConstraint = ref new 
SpeechRecognitionTopicConstraint(SpeechRecognitionScenario::FormFilling, "formFilling");
speechRecognizer->Constraints->Append(formConstraint );

optimized for filling out the form.

You can provide your own grammar in the SRGS format.

For the continuous-dictation scenario, see the Windows 10 UWP speech code sample.

Environmental conditions sometimes interfere with speech recognition. For example, the room might be too

noisy, or the user might speak too loudly. Whenever possible, the speech recognition API provides information

about the conditions that caused the quality degradation. This information is pushed to your app through a

WinRT event. The following example shows how to subscribe to this event.

In our code sample, we write the conditions information to the debug console. An app might want to provide

feedback to the user through the UI, speech synthesis, and another method. Or it might need to behave

differently when speech is interrupted by a temporary reduction in quality.

https://github.com/Microsoft/Windows-universal-samples/blob/master/Samples/SpeechRecognitionAndSynthesis/cpp/Scenario_ContinuousDictation.xaml.cpp


void HolographicSpeechPromptSampleMain::OnSpeechQualityDegraded(SpeechRecognizer^ recognizer, 
SpeechRecognitionQualityDegradingEventArgs^ args)
   {
       switch (args->Problem)
       {
       case SpeechRecognitionAudioProblem::TooFast:
           OutputDebugStringW(L"The user spoke too quickly.\n");
           break;

       case SpeechRecognitionAudioProblem::TooSlow:
           OutputDebugStringW(L"The user spoke too slowly.\n");
           break;

       case SpeechRecognitionAudioProblem::TooQuiet:
           OutputDebugStringW(L"The user spoke too softly.\n");
           break;

       case SpeechRecognitionAudioProblem::TooLoud:
           OutputDebugStringW(L"The user spoke too loudly.\n");
           break;

       case SpeechRecognitionAudioProblem::TooNoisy:
           OutputDebugStringW(L"There is too much noise in the signal.\n");
           break;

       case SpeechRecognitionAudioProblem::NoSignal:
           OutputDebugStringW(L"There is no signal.\n");
           break;

       case SpeechRecognitionAudioProblem::None:
       default:
           OutputDebugStringW(L"An error was reported with no information.\n");
           break;
       }
   }

Concurrency::task<void> HolographicSpeechPromptSampleMain::StopCurrentRecognizerIfExists()
   {
       return create_task([this]()
       {
           if (m_speechRecognizer != nullptr)
           {
               return create_task(m_speechRecognizer->StopRecognitionAsync()).then([this]()
               {
                   m_speechRecognizer->RecognitionQualityDegrading -= 
m_speechRecognitionQualityDegradedToken;

                   if (m_speechRecognizer->ContinuousRecognitionSession != nullptr)
                   {
                       m_speechRecognizer->ContinuousRecognitionSession->ResultGenerated -= 
m_speechRecognizerResultEventToken;
                   }
               });
           }
           else
           {
               return create_task([this]() { m_speechRecognizer = nullptr; });
           }
       });
   }

If you're not using ref classes to create your DirectX app, you must unsubscribe from the event before you

release or recreate your speech recognizer. The HolographicSpeechPromptSample has a routine to stop

recognition and unsubscribe from events.



 Use speech synthesis to provide audible prompts

auto speechSynthesizer = ref new Windows::Media::SpeechSynthesis::SpeechSynthesizer();

// Phrase recognition works best when requesting a phrase or sentence.
   StringReference voicePrompt = L"At the prompt: Say a phrase, asking me to change the cube to a specific 
color.";

create_task(speechSynthesizer->SynthesizeTextToStreamAsync(voicePrompt), 
task_continuation_context::use_current())
       .then([this, speechSynthesizer](task<Windows::Media::SpeechSynthesis::SpeechSynthesisStream^> 
synthesisStreamTask)
   {
       try
       {

Windows::Media::SpeechSynthesis::SpeechSynthesisStream^ stream = synthesisStreamTask.get();

           auto hr = m_speechSynthesisSound.Initialize(stream, 0);
           if (SUCCEEDED(hr))
           {
               m_speechSynthesisSound.SetEnvironment(HrtfEnvironment::Small);
               m_speechSynthesisSound.Start();

               // Amount of time to pause after the audio prompt is complete, before listening
               // for speech input.
               static const float bufferTime = 0.15f;

               // Wait until the prompt is done before listening.
               m_secondsUntilSoundIsComplete = m_speechSynthesisSound.GetDuration() + bufferTime;
               m_waitingForSpeechPrompt = true;
           }
       }

The holographic speech samples use speech synthesis to provide audible instructions to the user. This section

shows how to create a synthesized voice sample and then play it back through the HRTF audio APIs.

We recommend providing your own speech prompts when you request phrase input. Prompts can also help

indicate when speech commands can be spoken for a continuous-recognition scenario. The following example

demonstrates how to use a speech synthesizer to do this. You could also use a pre-recorded voice clip, a visual

UI, or another indicator of what to say, for example in scenarios where the prompt isn't dynamic.

First, create the SpeechSynthesizer object.

You also need a string that includes the text to synthesize.

Speech is synthesized asynchronously through SynthesizeTextToStreamAsync. Here, we start an async task to

synthesize the speech.

The speech synthesis is sent as a byte stream. We can use that byte stream to initialize an XAudio2 voice. For our

holographic code samples, we play it back as an HRTF audio effect.

As with speech recognition, speech synthesis throws an exception if something goes wrong.



catch (Exception^ exception)
       {
           PrintWstringToDebugConsole(
               std::wstring(L"Exception while trying to synthesize speech: ") +
               exception->Message->Data() +
               L"\n"
               );

           // Handle exceptions here.
       }
   });

 See also
Speech app design

SpeechRecognitionAndSynthesis sample

https://docs.microsoft.com/en-us/windows/uwp/design/input/speech-interactions
https://github.com/Microsoft/Windows-universal-samples/tree/master/Samples/SpeechRecognitionAndSynthesis
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NOTENOTE

NOTENOTE

 Device support

FeatureFeature HoloLens (1st gen)HoloLens (1st gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Spatial mapping ✔️ ✔️ ❌

 DirectX development overview

  Perception APIsPerception APIs

This article relates to the legacy WinRT native APIs. For new native app projects, we recommend using the OpenXR APIOpenXR API .

This topic describes how to implement spatial mapping in your DirectX app, including a detailed explanation of

the spatial mapping sample application packaged with the Universal Windows Platform SDK.

This topic uses code from the HolographicSpatialMapping UWP code sample.

The code snippets in this article currently demonstrate use of C++/CX rather than C++17-compliant C++/WinRT as used

in the C++ holographic project template. The concepts are equivalent for a C++/WinRT project, though you will need to

translate the code.

Native application development for spatial mapping uses the APIs in the Windows.Perception.Spatial

namespace. These APIs give you full control of spatial mapping functionality, in the same way that spatial

mapping APIs are exposed by Unity.

The primary types provided for spatial mapping development are as follows:

SpatialSurfaceObserver provides information about surfaces in application-specified regions of space near

the user, in the form of SpatialSurfaceInfo objects.

SpatialSurfaceInfo describes a single extant spatial surface, including a unique ID, bounding volume and time

of last change. It will provide a SpatialSurfaceMesh asynchronously upon request.

SpatialSurfaceMeshOptions contains parameters used to customize the SpatialSurfaceMesh objects

requested from SpatialSurfaceInfo.

SpatialSurfaceMesh represents the mesh data for a single spatial surface. The data for vertex positions,

vertex normals, and triangle indices is contained in member SpatialSurfaceMeshBuffer objects.

SpatialSurfaceMeshBuffer wraps a single type of mesh data.

When developing an application using these APIs, your basic program flow will look like this (as demonstrated

in the sample application described below):

Set up your SpatialSurfaceObser verSet up your SpatialSurfaceObser ver

Call RequestAccessAsync, to ensure that the user has given permission for your application to use the

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/spatial-mapping-in-directx.md
https://github.com/Microsoft/Windows-universal-samples/tree/master/Samples/HolographicSpatialMapping
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.surfaces.spatialsurfaceobserver
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.surfaces.spatialsurfaceinfo
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.surfaces.spatialsurfacemeshoptions
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.surfaces.spatialsurfacemesh
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.surfaces.spatialsurfacemeshbuffer
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.surfaces.spatialsurfaceobserver


  TroubleshootingTroubleshooting

 Spatial Mapping code sample walkthrough

  Set up your app to use the spatialPerception capabilitySet up your app to use the spatialPerception capability

<Capabilities>
  <uap2:Capability Name="spatialPerception" />
</Capabilities>

Process Obser vedSurfacesChanged eventsProcess Obser vedSurfacesChanged events

Receive and process meshReceive and process mesh

device's spatial mapping capabilities.

Instantiate a SpatialSurfaceObserver object.

Call SetBoundingVolumes to specify the regions of space in which you want information about spatial

surfaces. You may modify these regions in the future by calling this function again. Each region is

specified using a SpatialBoundingVolume.

Register for the ObservedSurfacesChanged event, which will fire whenever new information is

available about the spatial surfaces in the regions of space you've specified.

In your event handler, call GetObservedSurfaces to receive a map of SpatialSurfaceInfo objects. Using

this map, you can update your records of which spatial surfaces exist in the user's environment.

For each SpatialSurfaceInfo object, you may query TryGetBounds to determine the spatial extents of

the surface, expressed in a spatial coordinate system of your choosing.

If you decide to request, mesh for a spatial surface, call TryComputeLatestMeshAsync. You may

provide options specifying the density of triangles, and the format of the returned mesh data.

Each call to TryComputeLatestMeshAsync will asynchronously return one SpatialSurfaceMesh object.

From this object, you can access the contained SpatialSurfaceMeshBuffer objects, which gives you

access to the triangle indices, vertex positions, and vertex normals of the mesh if you request them.

This data will be in a format directly compatible with the Direct3D 11 APIs used for rendering meshes.

From here your application can optionally analyze or process the mesh data, and use it for rendering

and physics raycasting and collision.

One important detail to note is that you must apply a scale to the mesh vertex positions (for example

in the vertex shader used for rendering the meshes), to convert them from the optimized integer units

in which they're stored in the buffer, to meters. You can retrieve this scale by calling

VertexPositionScale.

Don't forget to scale mesh vertex positions in your vertex shader, using the scale returned by

SpatialSurfaceMesh.VertexPositionScale

The Holographic Spatial Mapping code sample includes code that you can use to get started loading surface

meshes into your app, including infrastructure for managing and rendering surface meshes.

Now, we walk through how to add surface-mapping capability to your DirectX app. You can add this code to

your Windows Holographic app template project, or you can follow along by browsing through the code sample

mentioned above. This code sample is based on the Windows Holographic app template.

Your app can use the spatial mapping capability. This is necessary because the spatial mesh is a representation

of the user's environment, which may be considered private data. Declare this capability in the

package.appxmanifest file for your app. Here's an example:

The capability comes from the uap2uap2  namespace. To get access to this namespace in your manifest, include it as

an xlmns attribute in the <Package> element. Here's an example:

https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.surfaces.spatialsurfaceobserver
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialboundingvolume
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.surfaces.spatialsurfaceobserver
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.surfaces.spatialsurfaceobserver
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.surfaces.spatialsurfaceinfo
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.surfaces.spatialsurfaceinfo
https://docs.microsoft.com/en-us/windows/win32/api/d3d11/nf-d3d11-id3d11device-createbuffer
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.surfaces.spatialsurfacemesh
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.surfaces.spatialsurfacemesh
https://github.com/Microsoft/Windows-universal-samples/tree/master/Samples/HolographicSpatialMapping


<Package
    xmlns="https://schemas.microsoft.com/appx/manifest/foundation/windows10"
    xmlns:mp="https://schemas.microsoft.com/appx/2014/phone/manifest"
    xmlns:uap="https://schemas.microsoft.com/appx/manifest/uap/windows10"
    xmlns:uap2="https://schemas.microsoft.com/appx/manifest/uap/windows10/2"
    IgnorableNamespaces="uap uap2 mp"
    >

  Check for spatial mapping feature supportCheck for spatial mapping feature support

if (m_surfaceObserver == nullptr)
   {
       using namespace Windows::Foundation::Metadata;
       if (ApiInformation::IsApiContractPresent(L"Windows.Foundation.UniversalApiContract", 4))
       {
           if (!SpatialSurfaceObserver::IsSupported())
           {
               // The current system does not have spatial mapping capability.
               // Turn off spatial mapping.
               m_spatialPerceptionAccessRequested = true;
               m_surfaceAccessAllowed = false;
           }
       }

       if (!m_spatialPerceptionAccessRequested)
       {
           /// etc ...

  Request access to spatial mapping dataRequest access to spatial mapping data

Windows Mixed Reality supports a wide range of devices, including devices, which don't support spatial

mapping. If your app can use spatial mapping, or must use spatial mapping, to provide functionality, it should

check to make sure spatial mapping is supported before trying to use it. For example, if spatial mapping is

required by your mixed reality app, it should display a message to that effect if a user tries running it on a device

without spatial mapping. Or, your app can render its own virtual environment in place of the user's environment,

providing an experience that is similar to what would happen if spatial mapping were available. In any event,

this API allows your app to be aware of when it won't get spatial mapping data and respond in the appropriate

way.

To check the current device for spatial mapping support, first make sure the UWP contract is at level 4 or greater

and then call SpatialSurfaceObserver ::IsSupported(). Here's how to do so in the context of the Holographic

Spatial Mapping code sample. Support is checked just before requesting access.

The SpatialSurfaceObserver ::IsSupported() API is available starting in SDK version 15063. If necessary, retarget

your project to platform version 15063 before using this API.

When the UWP contract is less than level 4, the app should proceed as though the device is capable of doing

spatial mapping.

Your app needs to request permission to access spatial mapping data before trying to create any surface

observers. Here's an example based upon our Surface Mapping code sample, with more details provided later

on this page:

https://github.com/Microsoft/Windows-universal-samples/tree/master/Samples/HolographicSpatialMapping


auto initSurfaceObserverTask = create_task(SpatialSurfaceObserver::RequestAccessAsync());
initSurfaceObserverTask.then([this, coordinateSystem]
(Windows::Perception::Spatial::SpatialPerceptionAccessStatus status)
{
    if (status == SpatialPerceptionAccessStatus::Allowed)
    {
        // Create a surface observer.
    }
    else
    {
        // Handle spatial mapping unavailable.
    }
}

  Create a surface observerCreate a surface observer

// Obtains surface mapping data from the device in real time.
Windows::Perception::Spatial::Surfaces::SpatialSurfaceObserver^     m_surfaceObserver;
Windows::Perception::Spatial::Surfaces::SpatialSurfaceMeshOptions^  m_surfaceMeshOptions;

// The surface mapping API reads information about the user's environment. The user must
// grant permission to the app to use this capability of the Windows Mixed Reality device.
auto initSurfaceObserverTask = create_task(SpatialSurfaceObserver::RequestAccessAsync());
initSurfaceObserverTask.then([this, coordinateSystem]
(Windows::Perception::Spatial::SpatialPerceptionAccessStatus status)
{
    if (status == SpatialPerceptionAccessStatus::Allowed)
    {
        // If status is allowed, we can create the surface observer.
        m_surfaceObserver = ref new SpatialSurfaceObserver();

// The surface observer can now be configured as needed.

        // In this example, we specify one area to be observed using an axis-aligned
        // bounding box 20 meters in width and 5 meters in height and centered at the
        // origin.
        SpatialBoundingBox aabb =
        {
            { 0.f,  0.f, 0.f },
            {20.f, 20.f, 5.f },
        };

        SpatialBoundingVolume^ bounds = SpatialBoundingVolume::FromBox(coordinateSystem, aabb);
        m_surfaceObserver->SetBoundingVolume(bounds);

The Windows::Perception::Spatial::SurfacesWindows::Perception::Spatial::Surfaces  namespace includes the SpatialSurfaceObserver class, which

observes one or more volumes that you specify in a SpatialCoordinateSystem. Use a SpatialSurfaceObserver

instance to access surface mesh data in real time.

From AppMain.hAppMain.h :

As noted in the previous section, you must request access to spatial mapping data before your app can use it.

This access is granted automatically on the HoloLens.

Next, you need to configure the surface observer to observe a specific bounding volume. Here, we observe a

box that is 20x20x5 meters, centered at the origin of the coordinate system.

You can set multiple bounding volumes instead.

This is pseudocode:

https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.surfaces.spatialsurfaceobserver
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialcoordinatesystem
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.surfaces.spatialsurfaceobserver


m_surfaceObserver->SetBoundingVolumes(/* iterable collection of bounding volumes*/);

m_surfaceObserver->SetBoundingVolume(
            SpatialBoundingVolume::FromFrustum(/*SpatialCoordinateSystem*/, /*SpatialBoundingFrustum*/)
            );

  Initialize and update the surface mesh collectionInitialize and update the surface mesh collection

auto mapContainingSurfaceCollection = m_surfaceObserver->GetObservedSurfaces();
        for (auto& pair : mapContainingSurfaceCollection)
        {
            // Store the ID and metadata for each surface.
            auto const& id = pair->Key;
            auto const& surfaceInfo = pair->Value;
            m_meshCollection->AddOrUpdateSurface(id, surfaceInfo);
        }

m_surfaceObserver->ObservedSurfacesChanged += ref new TypedEventHandler<SpatialSurfaceObserver^, 
Platform::Object^>(
            bind(&HolographicDesktopAppMain::OnSurfacesChanged, this, _1, _2)
            );

IMapView<Guid, SpatialSurfaceInfo^>^ const& surfaceCollection = sender->GetObservedSurfaces();

It's also possible to use other bounding shapes - such as a view frustum, or a bounding box that isn't axis

aligned.

This is pseudocode:

If your app needs to do anything differently when surface mapping data isn't available, you can write code to

respond to the case where the SpatialPerceptionAccessStatus isn't AllowedAllowed - for example, it won't be allowed on

PCs with immersive devices attached because those devices don't have hardware for spatial mapping. For these

devices, you should instead rely on the spatial stage for information about the user's environment and device

configuration.

If the surface observer was successfully created, we can continue to initialize our surface mesh collection. Here,

we use the pull model API to get the current set of observed surfaces right away:

There's also a push model available to get surface mesh data. You're free to design your app to use only the pull

model if you choose, in which case you'll poll for data every so often - say, once per frame - or during a specific

time period, such as during game setup. If so, the above code is what you need.

In our code sample, we chose to demonstrate the use of both models for pedagogical purposes. Here, we

subscribe to an event to receive up-to-date surface mesh data whenever the system recognizes a change.

Our code sample is also configured to respond to these events. Let's walk through how we do this.

NOTE:NOTE: This might not be the most efficient way for your app to handle mesh data. This code is written for clarity

and isn't optimized.

The surface mesh data is provided in a read-only map that stores SpatialSurfaceInfo objects using

Platform::Guids as key values.

To process this data, we look first for key values that aren't in our collection. Details on how the data is stored in

our sample app will be presented later in this topic.

https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialperceptionaccessstatus
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.surfaces.spatialsurfaceinfo
https://msdn.microsoft.com/library/windows/desktop/aa373931.aspx


// Process surface adds and updates.
for (const auto& pair : surfaceCollection)
{
    auto id = pair->Key;
    auto surfaceInfo = pair->Value;

    if (m_meshCollection->HasSurface(id))
    {
        // Update existing surface.
        m_meshCollection->AddOrUpdateSurface(id, surfaceInfo);
    }
    else
    {
        // New surface.
        m_meshCollection->AddOrUpdateSurface(id, surfaceInfo);
    }
}

m_meshCollection->PruneMeshCollection(surfaceCollection);

void RealtimeSurfaceMeshRenderer::PruneMeshCollection(IMapView<Guid, SpatialSurfaceInfo^>^ const& 
surfaceCollection)
{
    std::lock_guard<std::mutex> guard(m_meshCollectionLock);
    std::vector<Guid> idsToRemove;

    // Remove surfaces that moved out of the culling frustum or no longer exist.
    for (const auto& pair : m_meshCollection)
    {
        const auto& id = pair.first;
        if (!surfaceCollection->HasKey(id))
        {
            idsToRemove.push_back(id);
        }
    }

    for (const auto& id : idsToRemove)
    {
        m_meshCollection.erase(id);
    }
}

  Acquire and use surface mesh data buffersAcquire and use surface mesh data buffers

We also have to remove surface meshes that are in our surface mesh collection, but that aren't in the system

collection anymore. To do so, we need to do something akin to the opposite of what we just showed for adding

and updating meshes; we loop on our app's collection, and check to see if the GuidGuid we have is in the system

collection. If it's not in the system collection, we remove it from ours.

From our event handler in AppMain.cpp:

The implementation of mesh pruning in RealtimeSurfaceMeshRenderer.cpp:

Getting the surface mesh information was as easy as pulling a data collection and processing updates to that

collection. Now, we'll go into detail on how you can use the data.

In our code example, we chose to use the surface meshes for rendering. This is a common scenario for occluding

holograms behind real-world surfaces. You can also render the meshes, or render processed versions of them,

to show the user what areas of the room are scanned before you start providing app or game functionality.

The code sample starts the process when it receives surface mesh updates from the event handler that we



void RealtimeSurfaceMeshRenderer::AddOrUpdateSurface(Guid id, SpatialSurfaceInfo^ newSurface)
{
    auto options = ref new SpatialSurfaceMeshOptions();
    options->IncludeVertexNormals = true;

    auto createMeshTask = create_task(newSurface->TryComputeLatestMeshAsync(1000, options));
    createMeshTask.then([this, id](SpatialSurfaceMesh^ mesh)
    {
        if (mesh != nullptr)
        {
            std::lock_guard<std::mutex> guard(m_meshCollectionLock);
            '''m_meshCollection[id].UpdateSurface(mesh);'''
        }
    }, task_continuation_context::use_current());
}

void SurfaceMesh::UpdateSurface(SpatialSurfaceMesh^ surfaceMesh)
{
    m_surfaceMesh = surfaceMesh;
    m_updateNeeded = true;
}

void SurfaceMesh::CreateDeviceDependentResources(ID3D11Device* device)
{
    m_indexCount = m_surfaceMesh->TriangleIndices->ElementCount;
    if (m_indexCount < 3)
    {
        // Not enough indices to draw a triangle.
        return;
    }

Windows::Storage::Streams::IBuffer^ positions = m_surfaceMesh->VertexPositions->Data;
    Windows::Storage::Streams::IBuffer^ normals   = m_surfaceMesh->VertexNormals->Data;
    Windows::Storage::Streams::IBuffer^ indices   = m_surfaceMesh->TriangleIndices->Data;

described in the previous section. The important line of code in this function is the call to update the surface

mesh: by this time we have already processed the mesh info, and we're about to get the vertex and index data

for use as we see fit.

From RealtimeSurfaceMeshRenderer.cpp:

Our sample code is designed so that a data class, SurfaceMeshSurfaceMesh, handles mesh data processing and rendering.

These meshes are what the RealtimeSurfaceMeshRendererRealtimeSurfaceMeshRenderer  actually keeps a map of. Each one has a reference

to the SpatialSurfaceMesh it came from, so you can use it anytime you need to access the mesh vertex or index

buffers, or get a transform for the mesh. For now, we flag the mesh as needing an update.

From SurfaceMesh.cpp:

Next time the mesh is asked to draw itself, it will check the flag first. If an update is needed, the vertex and index

buffers will be updated on the GPU.

First, we acquire the raw data buffers:

Then, we create Direct3D device buffers with the mesh data provided by the HoloLens:



CreateDirectXBuffer(device, D3D11_BIND_VERTEX_BUFFER, positions, m_vertexPositions.GetAddressOf());
    CreateDirectXBuffer(device, D3D11_BIND_VERTEX_BUFFER, normals,   m_vertexNormals.GetAddressOf());
    CreateDirectXBuffer(device, D3D11_BIND_INDEX_BUFFER,  indices,   m_triangleIndices.GetAddressOf());

    // Create a constant buffer to control mesh position.
    CD3D11_BUFFER_DESC constantBufferDesc(sizeof(SurfaceTransforms), D3D11_BIND_CONSTANT_BUFFER);
    DX::ThrowIfFailed(
        device->CreateBuffer(
            &constantBufferDesc,
            nullptr,
            &m_modelTransformBuffer
            )
        );

    m_loadingComplete = true;
}

  Update and render surface meshesUpdate and render surface meshes

NOTE:NOTE: For the CreateDirectXBuffer helper function used in the previous snippet, see the Surface Mapping code

sample: SurfaceMesh.cpp, GetDataFromIBuffer.h. Now the device resource creation is complete, and the mesh is

considered to be loaded and ready for update and render.

Our SurfaceMesh class has a specialized update function. Each SpatialSurfaceMesh has its own transform, and

our sample uses the current coordinate system for our SpatialStationar yReferenceFrameSpatialStationar yReferenceFrame to acquire the

transform. Then it updates the model constant buffer on the GPU.

https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.surfaces.spatialsurfacemesh


void SurfaceMesh::UpdateTransform(
    ID3D11DeviceContext* context,
    SpatialCoordinateSystem^ baseCoordinateSystem
    )
{
    if (m_indexCount < 3)
    {
        // Not enough indices to draw a triangle.
        return;
    }

    XMMATRIX transform = XMMatrixIdentity();

    auto tryTransform = m_surfaceMesh->CoordinateSystem->TryGetTransformTo(baseCoordinateSystem);
    if (tryTransform != nullptr)
    {
        transform = XMLoadFloat4x4(&tryTransform->Value);
    }

    XMMATRIX scaleTransform = XMMatrixScalingFromVector(XMLoadFloat3(&m_surfaceMesh->VertexPositionScale));

    XMStoreFloat4x4(
        &m_constantBufferData.vertexWorldTransform,
        XMMatrixTranspose(
            scaleTransform * transform
            )
        );

    // Normals don't need to be translated.
    XMMATRIX normalTransform = transform;
    normalTransform.r[3] = XMVectorSet(0.f, 0.f, 0.f, XMVectorGetW(normalTransform.r[3]));
    XMStoreFloat4x4(
        &m_constantBufferData.normalWorldTransform,
        XMMatrixTranspose(
            normalTransform
        )
        );

    if (!m_loadingComplete)
    {
        return;
    }

    context->UpdateSubresource(
        m_modelTransformBuffer.Get(),
        0,
        NULL,
        &m_constantBufferData,
        0,
        0
        );
}

When it's time to render surface meshes, we do some prep work before rendering the collection. We set up the

shader pipeline for the current rendering configuration, and we set up the input assembler stage. The

holographic camera helper class CameraResources.cppCameraResources.cpp already has set up the view/projection constant buffer

by now.

From RealtimeSurfaceMeshRenderer ::RenderRealtimeSurfaceMeshRenderer ::Render :



auto context = m_deviceResources->GetD3DDeviceContext();

context->IASetPrimitiveTopology(D3D11_PRIMITIVE_TOPOLOGY_TRIANGLELIST);
context->IASetInputLayout(m_inputLayout.Get());

// Attach our vertex shader.
context->VSSetShader(
    m_vertexShader.Get(),
    nullptr,
    0
    );

// The constant buffer is per-mesh, and will be set as such.

if (depthOnly)
{
    // Explicitly detach the later shader stages.
    context->GSSetShader(nullptr, nullptr, 0);
    context->PSSetShader(nullptr, nullptr, 0);
}
else
{
    if (!m_usingVprtShaders)
    {
        // Attach the passthrough geometry shader.
        context->GSSetShader(
            m_geometryShader.Get(),
            nullptr,
            0
            );
    }

    // Attach our pixel shader.
    context->PSSetShader(
        m_pixelShader.Get(),
        nullptr,
        0
        );
}

std::lock_guard<std::mutex> guard(m_meshCollectionLock);

auto device = m_deviceResources->GetD3DDevice();

// Draw the meshes.
for (auto& pair : m_meshCollection)
{
    auto& id = pair.first;
    auto& surfaceMesh = pair.second;

    surfaceMesh.Draw(device, context, m_usingVprtShaders, isStereo);
}

Once this is done, we loop on our meshes and tell each one to draw itself. NOTE:NOTE: This sample code isn't

optimized to use any sort of frustum culling, but you should include this feature in your app.

The individual meshes are responsible for setting up the vertex and index buffer, stride, and model transform

constant buffer. As with the spinning cube in the Windows Holographic app template, we render to stereoscopic

buffers using instancing.

From SurfaceMesh::DrawSurfaceMesh::Draw :



// The vertices are provided in {vertex, normal} format

const auto& vertexStride = m_surfaceMesh->VertexPositions->Stride;
const auto& normalStride = m_surfaceMesh->VertexNormals->Stride;

UINT strides [] = { vertexStride, normalStride };
UINT offsets [] = { 0, 0 };
ID3D11Buffer* buffers [] = { m_vertexPositions.Get(), m_vertexNormals.Get() };

context->IASetVertexBuffers(
    0,
    ARRAYSIZE(buffers),
    buffers,
    strides,
    offsets
    );

const auto& indexFormat = static_cast<DXGI_FORMAT>(m_surfaceMesh->TriangleIndices->Format);

context->IASetIndexBuffer(
    m_triangleIndices.Get(),
    indexFormat,
    0
    );

context->VSSetConstantBuffers(
    0,
    1,
    m_modelTransformBuffer.GetAddressOf()
    );

if (!usingVprtShaders)
{
    context->GSSetConstantBuffers(
        0,
        1,
        m_modelTransformBuffer.GetAddressOf()
        );
}

context->PSSetConstantBuffers(
    0,
    1,
    m_modelTransformBuffer.GetAddressOf()
    );

context->DrawIndexedInstanced(
    m_indexCount,       // Index count per instance.
    isStereo ? 2 : 1,   // Instance count.
    0,                  // Start index location.
    0,                  // Base vertex location.
    0                   // Start instance location.
    );

  Rendering choices with Surface MappingRendering choices with Surface Mapping
The Surface Mapping code sample offers code for occlusion-only rendering of surface mesh data, and for on-

screen rendering of surface mesh data. Which path you choose - or both - depends on your application. We'll

walk through both configurations in this document.

Rendering occlusion buffers for holographic effectRendering occlusion buffers for holographic effect

Start by clearing the render target view for the current virtual camera.

From AppMain.cpp:



context->ClearRenderTargetView(pCameraResources->GetBackBufferRenderTargetView(), 
DirectX::Colors::Transparent);

// Pre-pass rendering: Create occlusion buffer from Surface Mapping data.
context->ClearDepthStencilView(pCameraResources->GetSurfaceDepthStencilView(), D3D11_CLEAR_DEPTH | 
D3D11_CLEAR_STENCIL, 1.0f, 0);

// Set the render target to null, and set the depth target occlusion buffer.
// We will use this same buffer as a shader resource when drawing holograms.
context->OMSetRenderTargets(0, nullptr, pCameraResources->GetSurfaceOcclusionDepthStencilView());

// The first pass is a depth-only pass that generates an occlusion buffer we can use to know which
// hologram pixels are hidden behind surfaces in the environment.
m_meshCollection->Render(pCameraResources->IsRenderingStereoscopic(), true);

// Hologram rendering pass: Draw holographic content.
context->ClearDepthStencilView(pCameraResources->GetHologramDepthStencilView(), D3D11_CLEAR_DEPTH | 
D3D11_CLEAR_STENCIL, 1.0f, 0);

// Set the render target, and set the depth target drawing buffer.
ID3D11RenderTargetView *const targets[1] = { pCameraResources->GetBackBufferRenderTargetView() };
context->OMSetRenderTargets(1, targets, pCameraResources->GetHologramDepthStencilView());

// Render the scene objects.
// In this example, we draw a special effect that uses the occlusion buffer we generated in the
// Pre-Pass step to render holograms using X-Ray Vision when they are behind physical objects.
m_xrayCubeRenderer->Render(
    pCameraResources->IsRenderingStereoscopic(),
    pCameraResources->GetSurfaceOcclusionShaderResourceView(),
    pCameraResources->GetHologramOcclusionShaderResourceView(),
    pCameraResources->GetDepthTextureSamplerState()
    );

This is a "pre-rendering" pass. Here, we create an occlusion buffer by asking the mesh renderer to render only

depth. In this configuration, we don't attach a render target view, and the mesh renderer sets the pixel shader

stage to nullptrnullptr  so that the GPU doesn't bother to draw pixels. The geometry will be rasterized to the depth

buffer, and the graphics pipeline will stop there.

We can draw holograms with an extra depth test against the Surface Mapping occlusion buffer. In this code

sample, we render pixels on the cube a different color if they are behind a surface.

From AppMain.cpp:

Based on code from SpecialEffectPixelShader.hlsl:



// Draw boundaries
min16int surfaceSum = GatherDepthLess(envDepthTex, uniSamp, input.pos.xy, pixelDepth, input.idx.x);

if (surfaceSum <= -maxSum)
{
    // The pixel and its neighbors are behind the surface.
    // Return the occluded 'X-ray' color.
    return min16float4(0.67f, 0.f, 0.f, 1.0f);
}
else if (surfaceSum < maxSum)
{
    // The pixel and its neighbors are a mix of in front of and behind the surface.
    // Return the silhouette edge color.
    return min16float4(1.f, 1.f, 1.f, 1.0f);
}
else
{
    // The pixel and its neighbors are all in front of the surface.
    // Return the color of the hologram.
    return min16float4(input.color, 1.0f);
}

// Spatial Mapping mesh rendering pass: Draw Spatial Mapping mesh over the world.
context->ClearDepthStencilView(pCameraResources->GetSurfaceOcclusionDepthStencilView(), D3D11_CLEAR_DEPTH | 
D3D11_CLEAR_STENCIL, 1.0f, 0);

// Set the render target to the current holographic camera's back buffer, and set the depth buffer.
ID3D11RenderTargetView *const targets[1] = { pCameraResources->GetBackBufferRenderTargetView() };
context->OMSetRenderTargets(1, targets, pCameraResources->GetSurfaceDepthStencilView());

// This drawing pass renders the surface meshes to the stereoscopic display. The user will be
// able to see them while wearing the device.
m_meshCollection->Render(pCameraResources->IsRenderingStereoscopic(), false);

 See also

Note:Note: For our GatherDepthLessGatherDepthLess  routine, see the Surface Mapping code sample: SpecialEffectPixelShader.hlsl.

Rendering surface mesh data to the displayRendering surface mesh data to the display

We can also just draw the surface meshes to the stereo display buffers. We chose to draw full faces with lighting,

but you're free to draw wireframe, process meshes before rendering, apply a texture map, and so on.

Here, our code sample tells the mesh renderer to draw the collection. This time we don't specify a depth-only

pass, it'll attach a pixel shader and complete the rendering pipeline using the targets that we specified for the

current virtual camera.

Creating a holographic DirectX project

Windows.Perception.Spatial API

https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial
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NOTENOTE

 XAML view switching overview

 XAML view switching workflow

 Tip for rendering graphics across both views

This article relates to the legacy WinRT native APIs. For new native app projects, we recommend using the OpenXR APIOpenXR API .

This topic explains the impact of switching between 2D XAML views and immersive views in your DirectX app,

and how to make efficient use of both a XAML view and immersive view.

On HoloLens, an immersive app that may later display a 2D XAML view needs to initialize that XAML view first

and immediately switch to an immersive view from there. XAML will load before your app can do anything,

which adds a small increase to your startup time. XAML will continue to occupy memory space in your app

process while it stays in the background. The amount of startup delay and memory usage depends on what

your app does with XAML before switching to the native view. If you do nothing in your XAML startup code at

first except start your immersive view, the impact should be minor. Also, because your holographic rendering is

done directly to the immersive view, you'll avoid any XAML-related restrictions on that rendering.

The memory usage counts for both CPU and GPU. Direct3D 11 can swap virtual graphics memory, but it might

not be able to swap out some or all of the XAML GPU resources, and there might be a noticeable performance

hit. Either way, not loading any XAML features you don't need will leave more room for your app and provide a

better experience.

The workflow for an app that goes directly from XAML to immersive mode is like so:

The app starts up in the 2D XAML view.

The app’s XAML startup sequence detects if the current system supports holographic rendering:

If so, the app creates the immersive view and brings it to the foreground right away. XAML loading is skipped

for anything not necessary on Windows Mixed Reality devices, including any rendering classes and asset

loading in the XAML view. If the app is using XAML for keyboard input, that input page should still be created.

If not, the XAML view can continue with business as usual.

If your app needs to implement some amount of rendering in DirectX for the XAML view in Windows Mixed

Reality, your best bet is to create one renderer that can work with both views. The renderer should be one

instance that can be accessed from both views, and it should switch between 2D and holographic rendering. This

way GPU assets only load once, which reduces load times, memory impact, and the amount of swapped

resources when switching views.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/using-xaml-with-holographic-directx-apps.md
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  Using MediaFrameReferenceUsing MediaFrameReference

  Using Media FoundationUsing Media Foundation

#include <winrt/windows.perception.spatial.preview.h>
#include <mfapi.h>
#include <mfidl.h>
 
using namespace winrt::Windows::Foundation;
using namespace winrt::Windows::Foundation::Numerics;
using namespace winrt::Windows::Perception;
using namespace winrt::Windows::Perception::Spatial;
using namespace winrt::Windows::Perception::Spatial::Preview;
 
class CameraFrameLocator
{
public:
    struct CameraFrameLocation
    {
        SpatialCoordinateSystem CoordinateSystem;
        float4x4 CameraViewToCoordinateSytemTransform;
        MFPinholeCameraIntrinsics Intrinsics;
    };
 
    std::optional<CameraFrameLocation> TryLocateCameraFrame(IMFSample* pSample)
    {
        MFCameraExtrinsics cameraExtrinsics;
        MFPinholeCameraIntrinsics cameraIntrinsics;
        UINT32 sizeCameraExtrinsics = 0;
        UINT32 sizeCameraIntrinsics = 0;

Before getting started here, we recommend that you take a look at our Locatable camera overview article which

contains overview information and a table with HoloLens 1 and 2 camera details.

These instructions apply if you're using the MediaFrameReference class to read image frames from the camera.

Each image frame (whether photo or video) includes a SpatialCoordinateSystem rooted at the camera at the

time of capture, which can be accessed using the CoordinateSystem property of your MediaFrameReference.

Each frame contains a description of the camera lens model, which can be found in the CameraIntrinsics

property. Together, these transforms define for each pixel a ray in 3D space representing the path taken by the

photons that produced the pixel. These rays can be related to other content in the app by obtaining the

transform from the frame's coordinate system to some other coordinate system (e.g. from a stationary frame of

reference).

Each image frame provides the following:

Pixel Data (in RGB/NV12/JPEG/etc. format)

A SpatialCoordinateSystem from the location of capture

A CameraIntrinsics class containing the lens mode of the camera

The HolographicFaceTracking sample shows the fairly straightforward way to query for the transform between

the camera's coordinate system and your own application coordinate systems.

If you are using Media Foundation directly to read image frames from the camera, you can use each frame's

MFSampleExtension_CameraExtrinsics attribute and MFSampleExtension_PinholeCameraIntrinsics attribute to

locate camera frames relative to your application's other coordinate systems, as shown in this sample code:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/locatable-camera-cpp.md
https://docs.microsoft.com/en-us/uwp/api/windows.media.capture.frames.mediaframereference
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialcoordinatesystem
https://docs.microsoft.com/en-us/uwp/api/windows.media.capture.frames.mediaframereference.coordinatesystem#windows_media_capture_frames_mediaframereference_coordinatesystem
https://docs.microsoft.com/en-us/uwp/api/windows.media.capture.frames.mediaframereference
https://docs.microsoft.com/en-us/uwp/api/windows.media.capture.frames.videomediaframe.cameraintrinsics#windows_media_capture_frames_videomediaframe_cameraintrinsics
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialcoordinatesystem
https://docs.microsoft.com/en-us/uwp/api/windows.media.capture.frames.videomediaframe.cameraintrinsics#windows_media_capture_frames_videomediaframe_cameraintrinsics
https://github.com/Microsoft/Windows-universal-samples/tree/master/Samples/HolographicFaceTracking
https://docs.microsoft.com/en-us/windows/win32/medfound/mfsampleextension-cameraextrinsics
https://docs.microsoft.com/en-us/windows/win32/medfound/mfsampleextension-pinholecameraintrinsics


        UINT32 sizeCameraIntrinsics = 0;
        UINT64 sampleTimeHns = 0;
 
        // query sample for calibration and validate
        if (FAILED(pSample->GetUINT64(MFSampleExtension_DeviceTimestamp, &sampleTimeHns)) ||
            FAILED(pSample->GetBlob(MFSampleExtension_CameraExtrinsics, (UINT8*)& cameraExtrinsics, 
sizeof(cameraExtrinsics), &sizeCameraExtrinsics)) ||
            FAILED(pSample->GetBlob(MFSampleExtension_PinholeCameraIntrinsics, (UINT8*)& cameraIntrinsics, 
sizeof(cameraIntrinsics), &sizeCameraIntrinsics)) ||
            (sizeCameraExtrinsics != sizeof(cameraExtrinsics)) ||
            (sizeCameraIntrinsics != sizeof(cameraIntrinsics)) ||
            (cameraExtrinsics.TransformCount == 0))
        {
            return std::nullopt;
        }
 
        // compute extrinsic transform
        const auto& calibratedTransform = cameraExtrinsics.CalibratedTransforms[0];
        const GUID& dynamicNodeId = calibratedTransform.CalibrationId;
        const float4x4 cameraToDynamicNode =
            make_float4x4_from_quaternion(quaternion{ calibratedTransform.Orientation.x, 
calibratedTransform.Orientation.y, calibratedTransform.Orientation.z, calibratedTransform.Orientation.w }) *
            make_float4x4_translation(calibratedTransform.Position.x, calibratedTransform.Position.y, 
calibratedTransform.Position.z);
 
        // update locator cache for dynamic node
        if (dynamicNodeId != m_currentDynamicNodeId || !m_locator)
        {
            m_locator = SpatialGraphInteropPreview::CreateLocatorForNode(dynamicNodeId);
            if (!m_locator)
            {
                return std::nullopt;
            }
 
            m_frameOfReference = m_locator.CreateAttachedFrameOfReferenceAtCurrentHeading();
            m_currentDynamicNodeId = dynamicNodeId;
        }
 
        // locate dynamic node
        auto timestamp = PerceptionTimestampHelper::FromSystemRelativeTargetTime(TimeSpan{ sampleTimeHns });
        auto coordinateSystem = m_frameOfReference.GetStationaryCoordinateSystemAtTimestamp(timestamp);
        auto location = m_locator.TryLocateAtTimestamp(timestamp, coordinateSystem);
        if (!location)
        {
            return std::nullopt;
        }
 
        const float4x4 dynamicNodeToCoordinateSystem = make_float4x4_from_quaternion(location.Orientation()) 
* make_float4x4_translation(location.Position());
 
        return CameraFrameLocation{ coordinateSystem, cameraToDynamicNode * dynamicNodeToCoordinateSystem, 
cameraIntrinsics };
    }

private:
    GUID m_currentDynamicNodeId{ GUID_NULL };
    SpatialLocator m_locator{ nullptr };
    SpatialLocatorAttachedFrameOfReference m_frameOfReference{ nullptr };
};

 Locatable Camera Usage Scenarios
  Show a photo or video in the world where it was capturedShow a photo or video in the world where it was captured
The Device Camera frames come with a "Camera To World" transform, that can be used to show exactly where

the device was when the image was taken. For example, you could position a small holographic icon at this

location (CameraToWorld.MultiplyPoint(Vector3.zero)) and even draw a little arrow in the direction that the



  Frame RateFrame Rate

public static Vector3 ClosestPointBetweenRays(
   Vector3 point1, Vector3 normalizedDirection1,
   Vector3 point2, Vector3 normalizedDirection2) {
   float directionProjection = Vector3.Dot(normalizedDirection1, normalizedDirection2);
   if (directionProjection == 1) {
     return point1; // parallel lines
   }
   float projection1 = Vector3.Dot(point2 - point1, normalizedDirection1);
   float projection2 = Vector3.Dot(point2 - point1, normalizedDirection2);
   float distanceAlongLine1 = (projection1 - directionProjection * projection2) / (1 - directionProjection * 
directionProjection);
   float distanceAlongLine2 = (projection2 - directionProjection * projection1) / (directionProjection * 
directionProjection - 1);
   Vector3 pointOnLine1 = point1 + distanceAlongLine1 * normalizedDirection1;
   Vector3 pointOnLine2 = point2 + distanceAlongLine2 * normalizedDirection2;
   return Vector3.Lerp(pointOnLine2, pointOnLine1, 0.5f);
 }

  Positioning a modeled scenePositioning a modeled scene

camera was facing (CameraToWorld.MultiplyVector(Vector3.forward)).

Keeping an interactive application frame-rate is critical, especially when dealing with long-running image

recognition algorithms. For this reason, we commonly use the following pattern:

1. Main Thread: manages the camera object

2. Main Thread: requests new frames (async)

3. Main Thread: pass new frames to tracking thread

4. Tracking Thread: processes image to collect key points

5. Main Thread: moves virtual model to match found key points

6. Main Thread: repeat from step 2

Some image marker systems only provide a single pixel location (others provide the full transform in which case

this section won't be needed), which equates to a ray of possible locations. To get to a single third location, we

can then leverage multiple rays and find the final result by their approximate intersection. To do this, you'll need

to:

1. Get a loop going collecting multiple camera images

2. Find the associated feature points, and their world rays

3. When you have a dictionary of features, each with multiple world rays, you can use the following code to

solve for the intersection of those rays:

Given two or more tracked tag locations, you can position a modeled scene to fit the user's current scenario. If

you can't assume gravity, then you'll need three tag locations. In many cases, we use a color scheme where white

spheres represent real-time tracked tag locations, and blue spheres represent modeled tag locations. This allows

the user to visually gauge the alignment quality. We assume the following setup in all our applications:

Two or more modeled tag locations

One 'calibration space', which in the scene is the parent of the tags

Camera feature identifier

Behavior, which moves the calibration space to align the modeled tags with the real-time tags (we're careful

to move the parent space, not the modeled markers themselves, because other connect is positions relative

to them).



// In the two tags case:
 Vector3 idealDelta = (realTags[1].EstimatedWorldPos - realTags[0].EstimatedWorldPos);
 Vector3 curDelta = (modelledTags[1].transform.position - modelledTags[0].transform.position);
 if (IsAssumeGravity) {
   idealDelta.y = 0;
   curDelta.y = 0;
 }
 Quaternion deltaRot = Quaternion.FromToRotation(curDelta, idealDelta);
 trans.rotation = Quaternion.LookRotation(deltaRot * trans.forward, trans.up);
 trans.position += realTags[0].EstimatedWorldPos - modelledTags[0].transform.position;

  Track or Identify Tagged Stationary or Moving real-world objects/faces using LEDs or other recognizerTrack or Identify Tagged Stationary or Moving real-world objects/faces using LEDs or other recognizer
librarieslibraries

 See also

Examples:

Industrial robots with LEDs (or QR codes for slower moving objects)

Identify and recognize objects in the room

Identify and recognize people in the room, for example placing holographic contact cards over faces

Locatable camera sample

Locatable camera overview

Locatable camera in Unity

Mixed reality capture

Mixed reality capture for developers

Media capture introduction

Holographic face tracking sample

https://github.com/Microsoft/Windows-universal-samples/tree/master/Samples/HolographicFaceTracking
https://docs.microsoft.com/en-us/hololens/holographic-photos-and-videos
https://docs.microsoft.com/en-us/windows/uwp/audio-video-camera/
https://github.com/Microsoft/Windows-universal-samples/tree/master/Samples/HolographicFaceTracking
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NOTENOTE

  Render from the PV camera (opt-in)Render from the PV camera (opt-in)

  En a b l e  t h e  P h o t o Vi d e o C a m e r a  H o l o g r a p h i c V i e w C o n fi g u r a t i o n  i n  D i r e c t XEn a b l e  t h e  P h o t o Vi d e o C a m e r a  H o l o g r a p h i c V i e w C o n fi g u r a t i o n  i n  D i r e c t X

var display = Windows.Graphics.Holographic.HolographicDisplay.GetDefault();
var view = 
display.TryGetViewConfiguration(Windows.Graphics.Holographic.HolographicViewConfigurationKind.PhotoVideoCame
ra);
if (view != null)
{
    view.IsEnabled = true;
}

  H a n d l e  t h e  a d d i t i o n a l  H o l o g r a p h i c C a m e r a  r e n d e r  i n  D i r e c t XH a n d l e  t h e  a d d i t i o n a l  H o l o g r a p h i c C a m e r a  r e n d e r  i n  D i r e c t X

See Render from the PV camera below for guidance on a new MRC capability for HoloLens 2.

Before getting started here, we recommend that you take a look at our mixed reality capture overview article.

HoloLens 2 adds the ability for an immersive app to render from the PV camerarender from the PV camera while mixed reality capture

is running. To ensure the app supports the additional render correctly, the app has to opt in to this functionality.

Render from the PV camera offers the following improvements over the default MRC experience:

Hologram alignment to your physical environment and hands for near interactions should be accurate at all

distances. Avoid having an offset at distances other than the focus point as you might see in the default MRC.

The right eye in the headset won't be compromised, as it won't be used to render the holograms for the MRC

output.

There are three steps to enable rendering from the PV camera:

1. Enable the PhotoVideoCamera HolographicViewConfiguration

2. Handle the additional HolographicCamera render

3. Verify your shaders and code render correctly from this additional HolographicCamera

To opt in to rendering from the PV Camera, an app simply enables the PhotoVideoCamera's

HolographicViewConfiguration:

When the app has opt-in to render from the PV camera and mixed reality capture starts:

1. HolographicSpace's CameraAdded event will fire. This event can be deferred if the app can't handle the

camera at this time.

2. Once the event has completed with no outstanding deferrals, the HolographicCamera will appear in the next

HolographicFrame's AddedCameras list.

When mixed reality capture stops (or if the app disables the view configuration while mixed reality capture is

running): the HolographicCamera will appear in the next HolographicFrame's RemovedCameras list and the

HolographicSpace's CameraRemoved event will fire.

A ViewConfiguration property has been added to HolographicCamera to help identify the configuration a

camera belongs to.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/mixed-reality-capture-directx.md
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicviewconfiguration
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamera.viewconfiguration


  Ve r i fy  sh a d e r s  a n d  c o d e  su p p o r t  a d d i t i o n a l  c a m e r a sVe r i fy  sh a d e r s  a n d  c o d e  su p p o r t  a d d i t i o n a l  c a m e r a s

  Disabling MRC in your appDisabling MRC in your app
  2D app2D app

  Immersive appImmersive app

  Password KeyboardPassword Keyboard

  Knowing when MRC is activeKnowing when MRC is active

NOTENOTE

 Integrating MRC functionality from within your app

  MRC with built-in camera UIMRC with built-in camera UI

  MRC with screen captureMRC with screen capture

  Creating a custom MRC recorderCreating a custom MRC recorder

Run a mixed reality capture and check for unusual alignment, missing content, or performance issues. Update

shaders and code as appropriate.

If there are certain scenes that can't support rendering to an additional camera, you can disable the

PhotoVideoCamera's HolographicViewConfiguration.

2D apps can choose to have their visual content obscured when mixed reality capture is running by:

Present with the DXGI_PRESENT_RESTRICT_TO_OUTPUT flag

Create the app's swap chain with the DXGI_SWAP_CHAIN_FLAG_HW_PROTECTED flag

With the Windows 10 May 2019 Update, setting ApplicationView's IsScreenCaptureEnabled

Immersive apps can choose to have their visual content excluded from mixed reality capture by:

Setting HolographicCameraRenderingParameter's IsContentProtectionEnabled to disable mixed reality

capture for its associated frame

Setting HolographicCamera's IsHardwareContentProtectionEnabled to disable mixed reality capture for its

associated holographic camera

With the Windows 10 May 2019 Update, visual content is automatically excluded from mixed reality capture

when a password or pin keyboard is visible.

The AppCapture class can be used by an app to know when system mixed reality capture is running (for either

audio or video).

AppCapture's GetForCurrentView API can return null if mixed reality capture isn't available on the device. It's also

important to de-register the CapturingChanged event when your app is suspended, otherwise MRC can get into a

blocked state.

Your mixed reality app can start MRC photo or video capture from within the app, and the content captured is

made available to your app without being stored to the device's "Camera roll." You can create a custom MRC

recorder or take advantage of built-in camera capture UI.

Developers can use the Camera Capture UI API to get a user-captured mixed reality photo or video with just a

few lines of code.

This API launches the built-in MRC camera UI where users can take a photo or video and returns the resulting

capture to your app. You can create a custom Mixed Reality Capture recorder if you need to add your own

camera UI or lower-level access to capture streams.

With the HoloLens 2 May 2021 update (Windows Holographic, version 21H1 build 20346.1002), developers can

use the Screen capture API to request a stream of mixed reality video frames.

https://docs.microsoft.com/en-us/windows/desktop/direct3ddxgi/dxgi-present
https://docs.microsoft.com/en-us/windows/desktop/api/dxgi/ne-dxgi-dxgi_swap_chain_flag
https://docs.microsoft.com/en-us/uwp/api/windows.ui.viewmanagement.applicationview.isscreencaptureenabled
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamerarenderingparameters.iscontentprotectionenabled
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamera.ishardwarecontentprotectionenabled
https://docs.microsoft.com/en-us/uwp/api/windows.media.capture.appcapture
https://docs.microsoft.com/en-us/uwp/api/windows.media.capture.appcapture.getforcurrentview
https://docs.microsoft.com/en-us/windows/uwp/audio-video-camera/capture-photos-and-video-with-cameracaptureui
https://docs.microsoft.com/en-us/windows/uwp/audio-video-camera/screen-capture
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P RO P ERT Y  N A M EP RO P ERT Y  N A M E T Y P ET Y P E DEFA ULT  VA L UEDEFA ULT  VA L UE DESC RIP T IO NDESC RIP T IO N

StreamType UINT32 (MediaStreamType) 1 (VideoRecord) Describe which capture
stream this effect is used
for. Audio isn't available.

HologramCompositionEnabl
ed

boolean TRUE Flag to enable or disable
holograms in video capture.

RecordingIndicatorEnabled boolean TRUE Flag to enable or disable
recording indicator on
screen during hologram
capturing.

VideoStabilizationEnabled boolean FALSE Flag to enable or disable
video stabilization powered
by the HoloLens tracker.

While the user can always trigger a photo or video using the system MRC capture service, an application may

want to build a custom camera app that include holograms in the camera stream just like MRC. This allows the

application to kick off captures from user input, build custom recording UI, or customize MRC settings to name a

few examples.

HoloStudio adds a custom MRC camera using MRC effectsHoloStudio adds a custom MRC camera using MRC effects

Other applications can do this by using the Windows Media Capture APIs to control the Camera and add an

MRC Video and Audio effect to include virtual holograms and application audio in stills and videos.

Applications have two options to add the effect:

The older API: Windows.Media.Capture.MediaCapture.AddEffectAsync()

The new Microsoft recommended API (returns an object, making it possible to manipulate dynamic

properties): Windows.Media.Capture.MediaCapture.AddVideoEffectAsync() /

Windows.Media.Capture.MediaCapture.AddAudioEffectAsync() which require the app create its own

implementation of IVideoEffectDefinition and IAudioEffectDefinition. See the MRC sample app for examples.

The Windows.Media.MixedRealityCapture namespace will not be recognized by Visual Studio, but the strings are still valid.

MRC Video Effect (Windows.Media.MixedRealityCapture.MixedRealityCaptureVideoEffectWindows.Media.MixedRealityCapture.MixedRealityCaptureVideoEffect)

https://docs.microsoft.com/en-us/uwp/api/windows.media.capture.mediacapture
https://docs.microsoft.com/en-us/uwp/api/windows.media.capture.mediacapture.addeffectasync
https://docs.microsoft.com/en-us/uwp/api/windows.media.capture.mediacapture.addvideoeffectasync
https://docs.microsoft.com/en-us/uwp/api/windows.media.capture.mediacapture.addaudioeffectasync
https://docs.microsoft.com/en-us/uwp/api/windows.media.effects.ivideoeffectdefinition
https://docs.microsoft.com/en-us/uwp/api/windows.media.effects.iaudioeffectdefinition
https://github.com/microsoft/Windows-universal-samples/tree/master/Samples/HolographicMixedRealityCapture
https://docs.microsoft.com/en-us/uwp/api/windows.media.capture.mediastreamtype


VideoStabilizationBufferLen
gth

UINT32 0 Set how many historical
frames are used for video
stabilization. 0 is 0-latency
and nearly "free" from a
power and performance
perspective. 15 is
recommended for highest
quality (at the cost of 15
frames of latency and
memory).

GlobalOpacityCoefficient float 0.9 (HoloLens) 1.0
(Immersive headset)

Set global opacity
coefficient of hologram in
range from 0.0 (fully
transparent) to 1.0 (fully
opaque).

BlankOnProtectedContent boolean FALSE Flag to enable or disable
returning an empty frame if
there's a 2d UWP app
showing protected content.
If this flag is false and a 2d
UWP app is showing
protected content, the 2d
UWP app will be replaced
by a protected content
texture in both the headset
and in the mixed reality
capture.

ShowHiddenMesh boolean FALSE Flag to enable or disable
showing the holographic
camera's hidden area mesh
and neighboring content.

OutputSize Size 0, 0 Set the desired output size
after cropping for video
stabilization. A default crop
size is chosen if 0 or an
invalid output size is
specified.

OutputSubtype String Nv12 Set the desired output
subtype after hologram
composition and/or video
stabilization. Supports Nv12
and Argb32
MediaEncodingSubtypes.

P RO P ERT Y  N A M EP RO P ERT Y  N A M E T Y P ET Y P E DEFA ULT  VA L UEDEFA ULT  VA L UE DESC RIP T IO NDESC RIP T IO N

https://docs.microsoft.com/en-us/uwp/api/windows.media.mediaproperties.mediaencodingsubtypes.nv12
https://docs.microsoft.com/en-us/uwp/api/windows.media.mediaproperties.mediaencodingsubtypes.argb32
https://docs.microsoft.com/en-us/uwp/api/windows.media.mediaproperties.mediaencodingsubtypes


PreferredHologramPerspecti
ve

UINT32 Render from CameraRender from Camera
setting in the Windows
Device Portal

Enum used to indicate
which holographic camera
view configuration should
be captured: 0 (Display)
means that the app won't
be asked to render from the
photo/video camera, 1
(PhotoVideoCamera) will
ask the app to render from
the photo/video camera (if
the app supports it). Only
supported on HoloLens 2

P RO P ERT Y  N A M EP RO P ERT Y  N A M E T Y P ET Y P E DEFA ULT  VA L UEDEFA ULT  VA L UE DESC RIP T IO NDESC RIP T IO N

NOTENOTE

P RO P ERT Y  N A M EP RO P ERT Y  N A M E T Y P ET Y P E DEFA ULT  VA L UEDEFA ULT  VA L UE DESC RIP T IO NDESC RIP T IO N

MixerMode UINT32 2 (Mic and System audio) Enum used to indicate
which audio sources should
be used: 0 (Mic audio only),
1 (System audio only), 2
(Mic and System audio)

LoopbackGain float App Audio GainApp Audio Gain setting in
the Windows Device Portal

Gain to apply to system
audio volume. Ranges from
0.0 to 5.0. Only supported
on HoloLens 2

MicrophoneGain float Mic Audio GainMic Audio Gain setting in
the Windows Device Portal

Gain to apply to mic
volume. Ranges from 0.0 to
5.0. Only supported on
HoloLens 2

NOTENOTE

  Simultaneous MRC limitationsSimultaneous MRC limitations

You can change the default value of PreferredHologramPerspectivePreferredHologramPerspective in the Windows Device Portal by going to the

Mixed Reality Capture page and unchecking Render from CameraRender from Camera. The setting defaults to 1 (PhotoVideoCamera)1 (PhotoVideoCamera),

but can be unchecked to set it to 0 (Display)0 (Display).

The default value of PreferredHologramPerspectivePreferredHologramPerspective was 0 (Display)0 (Display) prior to the June 2020 update (Windows

Holographic, version 2004 build 19041.1106 and Windows Holographic, version 1903 build 18362.1064).

Support for OutputSubtypeOutputSubtype was added with the May 2021 update (Windows Holographic, version 21H1 build

20346.1002).

MRC Audio Effect (Windows.Media.MixedRealityCapture.MixedRealityCaptureAudioEffectWindows.Media.MixedRealityCapture.MixedRealityCaptureAudioEffect)

You can change the default value of LoopbackGainLoopbackGain or MicrophoneGainMicrophoneGain in the Windows Device Portal by going to the

Mixed Reality Capture page and adjusting the slider next to their respective settings. Both settings default to 1.01.0 , but can

be set to any value between 0.00.0  and 5.05.0 .

Using Windows Device Portal to configure the default gain values was added with the June 2020 update (Windows

Holographic, version 2004 build 19041.1106 and Windows Holographic, version 1903 build 18362.1064).



  Photo/video camera accessPhoto/video camera access

  B u i l t - i n  M R C  p h o t o  a n d  v i d e o  c a m e r a  a c c e ssB u i l t - i n  M R C  p h o t o  a n d  v i d e o  c a m e r a  a c c e ss

NOTENOTE

  MRC access for developersMRC access for developers

C a u t i o nC a u t i o n

C a u t i o nC a u t i o n

NOTENOTE

 See also

You need to be aware of certain limitations when multiple apps are accessing MRC at the same time.

On HoloLens 1, MRC will fail to capture a photo or capture video while a process is recording video or taking a

photo. The reverse is also true: if MRC is running, the application will fail to get access to the camera.

With HoloLens 2, it's possible for you to share access to the camera. If you don't need direct control of the

resolution or frame-rate, you can initialize MediaCapture using the SharedMode property with SharedReadOnly.

MRC functionality built into Windows 10 (via Cortana, Start Menu, hardware shortcuts, Miracast, Windows

Device Portal):

Will run with ExclusiveControl by default

However, support has been added to MRC subsystem to operate in a shared mode:

If an app requests ExclusiveControl access to the photo/video camera, built-in MRC will automatically stop

using the photo/video camera so the app's request will succeed

If built in MRC is started while an app has ExclusiveControl, built-in MRC will run in SharedReadOnly mode

This shared mode functionality has certain restrictions:

Photo via Cortana, hardware shortcuts, or Start Menu: Requires the Windows 10 April 2018 Update (or later)

Video via Cortana, hardware shortcuts, or Start Menu: Requires the Windows 10 April 2018 Update (or later)

Streaming MRC over Miracast: Requires the Windows 10 October 2018 Update (or later)

Streaming MRC over Windows Device Portal or via the HoloLens companion app: Requires HoloLens 2

The resolution and frame-rate of the built-in MRC camera UI might be reduced from its normal values when another app

is using the photo/video camera.

We recommend you always request Exclusive control for the camera when using MRC. This will ensure your

application has full control of the settings for the camera as long as you're aware of the limitations listed above.

Create a media capture object using the initialization settings

Set the SharingMode property to exclusiveexclusive

Be sure to carefully read the SharingMode remarks before continuing.

Set up your camera the way you want it

Start the app, capture video frames with the start API, then enable MRC

If you start MRC before you start your app, we can't guarantee the feature will work as expected.

You can find a full sample of the above process in the holographic face tracking sample.

Before the Windows 10 April 2018 Update, an app's custom MRC recorder was mutually exclusive with system MRC

(capturing photos, capturing videos, or streaming from the Windows Device Portal).

https://docs.microsoft.com/en-us/uwp/api/windows.media.capture.mediacaptureinitializationsettings.sharingmode
https://docs.microsoft.com/en-us/uwp/api/windows.media.capture.mediacaptureinitializationsettings
https://docs.microsoft.com/en-us/uwp/api/windows.media.capture.mediacaptureinitializationsettings.sharingmode#windows_media_capture_mediacaptureinitializationsettings_sharingmode
https://docs.microsoft.com/en-us/uwp/api/windows.media.capture.mediacaptureinitializationsettings.sharingmode#remarks
https://docs.microsoft.com/en-us/samples/microsoft/windows-universal-samples/holographicfacetracking


Mixed reality capture overview

Mixed reality capture for HoloLens users

https://docs.microsoft.com/en-us/hololens/holographic-photos-and-videos


   

 

QR code tracking (C# and C++)
 7/6/2022 • 6 minutes to read • Edit Online

 Getting the QR package

 Detecting QR codes
  Adding the webcam capabilityAdding the webcam capability

await QRCodeWatcher.RequestAccessAsync();

co_await QRCodeWatcher.RequestAccessAsync();

  Detecting QR codes in C++Detecting QR codes in C++

Before getting started here, we recommend that you take a look at our QR code tracking overview article which

contains an overview, a device support table, and best practices.

You can download the NuGet package for QR code detection here.

You'll need to add the capability webcam  to your manifest to detect QR codes. This capability is required as the

data within detected codes in the user's environment may contain sensitive information.

Permission can be requested by calling QRCodeWatcher.RequestAccessAsync() :

C#:

C++:

Permission must be requested before you construct a QRCodeWatcher object.

While QR code detection requires the webcam  capability, the detection occurs using the device's tracking

cameras. This provides a wider detection FOV and better battery life compared to detection with the device's

photo/video (PV) camera.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/qr-code-tracking-cs-cpp.md
https://nuget.org/Packages/Microsoft.MixedReality.QR


using namespace winrt::Windows::Foundation;
using namespace winrt::Microsoft::MixedReality::QR;

class QRListHelper
{
public:
    QRListHelper(MyApplication& app) :
        m_app(app)
    {}

    IAsyncAction SetUpQRCodes()
    {
        if (QRCodeWatcher::IsSupported())
        {
            QRCodeWatcherAccessStatus status = co_await QRCodeWatcher::RequestAccessAsync();
            InitializeQR(status);
        }
    }

private:
    void OnAddedQRCode(const IInspectable&, const QRCodeAddedEventArgs& args)
    {
        m_app.OnAddedQRCode(args);
    }

    void OnUpdatedQRCode(const IInspectable&, const QRCodeUpdatedEventArgs& args)
    {
        m_app.OnUpdatedQRCode(args);
    }

    void OnEnumerationComplete(const IInspectable&, const IInspectable&)
    {
        m_app.OnEnumerationComplete();
    }

    MyApplication& m_app;
    QRCodeWatcher m_qrWatcher{ nullptr };

    void InitializeQR(QRCodeWatcherAccessStatus status)
    {
        if (status == QRCodeWatcherAccessStatus::Allowed)
        {
            m_qrWatcher = QRCodeWatcher();
            m_qrWatcher.Added({ this, &QRListHelper::OnAddedQRCode });
            m_qrWatcher.Updated({ this, &QRListHelper::OnUpdatedQRCode });
            m_qrWatcher.EnumerationCompleted({ this, &QRListHelper::OnEnumerationComplete });
            m_qrWatcher.Start();
        }
        else
        {
            // Permission denied by system or user
            // Handle the failures
        }
    }
};

 Getting the coordinate system for a QR code
Each detected QR code exposes a spatial coordinate system aligned with the QR code at the top-left corner of

the fast detection square in the top left:



// Creates a 2D rectangle in the x-y plane, with the specified properties.
std::vector<float3> MyApplication::CreateRectangle(float width, float height)
{
    std::vector<float3> vertices(4);

    vertices[0] = { 0, 0, 0 };
    vertices[1] = { width, 0, 0 };
    vertices[2] = { width, height, 0 };
    vertices[3] = { 0, height, 0 };

    return vertices;
}

std::vector<float3> qrVertices = CreateRectangle(code.PhysicalSideLength(), code.PhysicalSideLength()); 

using namespace winrt::Windows::Perception::Spatial;
using namespace winrt::Windows::Perception::Spatial::Preview;
SpatialCoordinateSystem qrCoordinateSystem = 
SpatialGraphInteropPreview::CreateCoordinateSystemForNode(code.SpatialGraphNodeId());

When directly using the QR SDK, the Z-axis is pointing into the paper (not shown).

A QR code's SpatialCoordinateSystem aligns as shown. You can get the coordinate system from the platform by

calling SpatialGraphInteropPreview::CreateCoordinateSystemForNode and passing in the code's

SpatialGraphNodeId.

The C++ code below shows how to create a rectangle and place it using the QR code's coordinate system:

You can use the physical size to create the QR rectangle:

The coordinate system can be used to draw the QR code or attach holograms to the location:

Altogether, your QRCodeAddedHandler may look something like this:

https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.preview.spatialgraphinteroppreview.createcoordinatesystemfornode


void MyApplication::OnAddedQRCode(const QRCodeAddedEventArgs& args)
{
    QRCode code = args.Code();
    std::vector<float3> qrVertices = CreateRectangle(code.PhysicalSideLength(), code.PhysicalSideLength());
    std::vector<unsigned short> qrCodeIndices = TriangulatePoints(qrVertices);
    XMFLOAT3 qrAreaColor = XMFLOAT3(DirectX::Colors::Aqua);

    SpatialCoordinateSystem qrCoordinateSystem = 
SpatialGraphInteropPreview::CreateCoordinateSystemForNode(code.SpatialGraphNodeId());
    std::shared_ptr<SceneObject> m_qrShape =
        std::make_shared<SceneObject>(
            m_deviceResources,
            qrVertices,
            qrCodeIndices,
            qrAreaColor,
            qrCoordinateSystem);

    m_sceneController->AddSceneObject(m_qrShape);
}

 QR Code tracking API reference

namespace Microsoft.MixedReality.QR
{
    /// <summary>
    /// Represents a detected QR code.
    /// </remarks>
    public class QRCode
    {
        /// <summary>
        /// Unique id that identifies this QR code for this session.
        /// </summary>
        public Guid Id { get; }

        /// <summary>
        /// Spatial graph node id for this QR code to create a coordinate system.
        /// </summary>
        public Guid SpatialGraphNodeId { get; }

        /// <summary>
        /// Version of this QR code. Version 1-40 are regular QR codes and M1 to M4 are Micro QR code 
formats 1-4.
        /// </summary>
        public QRVersion Version { get; }

        /// <summary>
        /// Physical width and height of this QR code in meters.
        /// </summary>
        public float PhysicalSideLength { get; }

        /// <summary>
        /// Decoded QR code data.
        /// </summary>
        public String Data { get; }

        /// <summary>
        /// Size of the RawData of this QR code.
        /// </summary>
        public UInt32 RawDataSize { get; }

        /// <summary>
        /// Gets the error-corrected raw data bytes.
        /// Used when the platform is unable to decode the code's format,
        /// allowing your app to decode as needed.
        /// </summary>



        public void GetRawData(byte[] buffer);

        /// <summary>
        /// The last detected time in 100ns QPC ticks.
        /// </summary>
        public System.TimeSpan SystemRelativeLastDetectedTime { get; }

        /// <summary>
        /// The last detected time.
        /// </summary>
        public System.DateTimeOffset LastDetectedTime { get; }
    }

    /// <summary>
    /// Event arguments for a QRCodeWatcher's Added event.
    /// </summary>
    public class QRCodeAddedEventArgs
    {
        /// <summary>
        /// Gets the QR Code that was added
        /// </summary>
        public QRCode Code { get; }
    }

    /// <summary>
    /// Event arguments for a QRCodeWatcher's Removed event.
    /// </summary>
    public class QRCodeRemovedEventArgs
    {
        /// <summary>
        /// Gets the QR Code that was removed.
        /// </summary>
        public QRCode Code { get; }
    }

    /// <summary>
    /// Event arguments for a QRCodeWatcher's Updated event.
    /// </summary>
    public class QRCodeUpdatedEventArgs
    {
        /// <summary>
        /// Gets the QR Code that was updated.
        /// </summary>
        public QRCode Code { get; }
    }

    /// <summary>
    /// Represents the status of an access request for QR code detection.
    /// </summary>
    public enum QRCodeWatcherAccessStatus
    {
        /// <summary>
        /// The system has denied permission for the app to detect QR codes.
        /// </summary>
        DeniedBySystem = 0,
        /// <summary>
        /// The app has not declared the webcam capability in its manifest.
        /// </summary>
        NotDeclaredByApp = 1,
        /// <summary>
        /// The user has denied permission for the app to detect QR codes.
        /// </summary>
        DeniedByUser = 2,
        /// <summary>
        /// A user prompt is required to get permission to detect QR codes.
        /// </summary>
        UserPromptRequired = 3,
        /// <summary>
        /// The user has given permission to detect QR codes.



        /// The user has given permission to detect QR codes.
        /// </summary>
        Allowed = 4,
    }

    /// <summary>
    /// Detects QR codes in the user's environment.
    /// </summary>
    public class QRCodeWatcher
    {
        /// <summary>
        /// Gets whether QR code detection is supported on the current device.
        /// </summary>
        public static bool IsSupported();

        /// <summary>
        /// Request user consent before using QR code detection.
        /// </summary>
        public static IAsyncOperation<QRCodeWatcherAccessStatus> RequestAccessAsync();

        /// <summary>
        /// Constructs a new QRCodeWatcher.
        /// </summary>
        public QRCodeWatcher();

        /// <summary>
        /// Starts detecting QR codes.
        /// </summary>
        /// <remarks>
        /// Start should only be called once RequestAccessAsync has succeeded.
        /// Start should not be called if QR code detection is not supported.
        /// Check that IsSupported returns true before calling Start.
        /// </remarks>
        public void Start();

        /// <summary>
        /// Stops detecting QR codes.
        /// </summary>
        public void Stop();

        /// <summary>
        /// Get the list of QR codes detected.
        /// </summary>
        /// <remarks>
        /// </remarks>
        public IList<QRCode> GetList();

        /// <summary>
        /// Event representing the addition of a QR Code.
        /// </summary>
        public event EventHandler<QRCodeAddedEventArgs> Added;

        /// <summary>
        /// Event representing the removal of a QR Code.
        /// </summary>
        public event EventHandler<QRCodeRemovedEventArgs> Removed;

        /// <summary>
        /// Event representing the update of a QR Code.
        /// </summary>
        public event EventHandler<QRCodeUpdatedEventArgs> Updated;

        /// <summary>
        /// Event representing the enumeration of QR Codes completing after a Start call.
        /// </summary>
        public event EventHandler<Object> EnumerationCompleted;
    }

    /// <summary>
    /// Version info for QR codes, including Micro QR codes.



    /// Version info for QR codes, including Micro QR codes.
    /// </summary>
    public enum QRVersion
    {
        QR1 = 1,
        QR2 = 2,
        QR3 = 3,
        QR4 = 4,
        QR5 = 5,
        QR6 = 6,
        QR7 = 7,
        QR8 = 8,
        QR9 = 9,
        QR10 = 10,
        QR11 = 11,
        QR12 = 12,
        QR13 = 13,
        QR14 = 14,
        QR15 = 15,
        QR16 = 16,
        QR17 = 17,
        QR18 = 18,
        QR19 = 19,
        QR20 = 20,
        QR21 = 21,
        QR22 = 22,
        QR23 = 23,
        QR24 = 24,
        QR25 = 25,
        QR26 = 26,
        QR27 = 27,
        QR28 = 28,
        QR29 = 29,
        QR30 = 30,
        QR31 = 31,
        QR32 = 32,
        QR33 = 33,
        QR34 = 34,
        QR35 = 35,
        QR36 = 36,
        QR37 = 37,
        QR38 = 38,
        QR39 = 39,
        QR40 = 40,
        MicroQRM1 = 41,
        MicroQRM2 = 42,
        MicroQRM3 = 43,
        MicroQRM4 = 44,
    }
}

 See also
QR code tracking overview

QR code tracking in Unity

Coordinate systems

Azure Spatial Anchors

https://docs.microsoft.com/en-us/azure/spatial-anchors/overview
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 Why OpenXR?

 What is OpenXR?

 Roadmap

OpenXR is an open royalty-free API standard from Khronos, providing

engines with native access to a range of devices across the mixed reality

spectrum.

You can develop using OpenXR on a HoloLens 2 or Windows Mixed Reality

immersive VR headset on the desktop. If you don't have access to a headset, you can use the HoloLens 2

Emulator or the Windows Mixed Reality Simulator instead.

With OpenXR, you can build engines that target both holographic devices, like HoloLens 2, and immersive VR

devices, like Windows Mixed Reality headsets for desktop PCs. OpenXR lets you write code once that's then

portable across a wide range of hardware platforms.

The OpenXR API uses a loader to connect your application directly to your headset's native platform support.

End users get maximum performance and minimum latency, whether they're using a Windows Mixed Reality or

any other headset.

The OpenXR API provides the core pose prediction, frame timing, and spatial input functionality you'll need to

build an engine that can target both holographic and immersive devices.

To learn about the OpenXR API, check out the OpenXR 1.0 specification, API reference, and quick reference guide.

For more information, see the Khronos OpenXR page.

To target the full feature set of HoloLens 2, you'll also use cross-vendor and vendor-specific OpenXR extensions

that enable additional features beyond the OpenXR 1.0 core, such as articulated hand tracking, eye tracking,

spatial mapping, and spatial anchors. For more information, see the Roadmap section below on the extensions

coming later this year.

OpenXR isn't itself a mixed reality engine. Instead, OpenXR enables engines like Unity and Unreal to write

portable code once that can then access the native platform features of the user's holographic or immersive

device, whatever vendor built that platform.

The OpenXR specification defines an extension mechanism that enables runtime implementers to expose

additional functionality beyond the core features defined in the base OpenXR 1.0 specification.

There are three kinds of OpenXR extensions:

Vendor extensions (for example, Vendor extensions (for example, MSFT ) :) : Enables per-vendor innovation in hardware or software

features. Any runtime vendor can introduce and ship a vendor extension at any time.

Cross-vendor Cross-vendor EXT  extensions: extensions: Cross-vendor extensions that multiple companies define and implement.

Experimental vendor extensions (for example, Experimental vendor extensions (for example, MSFT_preview ) :) : Experimental vendor extensions

being previewed to gather feedback. MSFT_preview  extensions are for developer devices only and will

be removed when the real extension ships. To experiment with them, you can enable preview

extensions on your developer device.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/openxr.md
https://www.khronos.org/
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html
https://www.khronos.org/registry/OpenXR/specs/1.0/man/html/openxr.html
https://www.khronos.org/files/openxr-10-reference-guide.pdf
https://www.khronos.org/openxr/
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html


F EAT URE A REAF EAT URE A REA EXT EN SIO N  AVA IL A B IL IT YEXT EN SIO N  AVA IL A B IL IT Y

Systems + sessions OpenXR 1.0 core spec:OpenXR 1.0 core spec:
XrInstance , XrSystemId , XrSession

Reference spaces (view, local, stage) OpenXR 1.0 core spec:OpenXR 1.0 core spec:
XrSpace

View configurations (mono, stereo) OpenXR 1.0 core spec:OpenXR 1.0 core spec:
XrView...

Swapchains + frame timing OpenXR 1.0 core spec:OpenXR 1.0 core spec:
XrSwapchain...  + xrWaitFrame

Composition layers
(projection, quad)

OpenXR 1.0 core spec:OpenXR 1.0 core spec:
XrCompositionLayer...  + xrEndFrame

Input and haptics OpenXR 1.0 core spec:OpenXR 1.0 core spec:
XrAction...

Direct3D 11/12 integration Official Official KHR  extensions released: extensions released:

XR_KHR_D3D11_enable
XR_KHR_D3D12_enable

Unbounded reference space
(world-scale experiences)

MSFT  extension released: extension released:

XR_MSFT_unbounded_reference_space

Spatial anchors

Hand interaction
(grip/aim pose, air-tap, grasp)

MSFT  extension released: extension released:

XR_MSFT_hand_interaction

Hand articulation + hand mesh

Eye gaze EXT  extension released: extension released:

XR_EXT_eye_gaze_interaction

Groups of interested companies can introduce EXT extensions at any time.

Official Official KHR  extensions: extensions: Official Khronos extensions ratified as part of a core spec release. KHR extensions

are covered by the same license as the core spec itself.

The Windows Mixed Reality OpenXR Runtime supports a set of MSFT  and EXT  extensions that brings the full

set of HoloLens 2 features to OpenXR applications:

MSFT  extension released: extension released:

XR_MSFT_spatial_anchor

MSFT  extension released in runtime 108: extension released in runtime 108:

(HoloLens 2 only)
XR_MSFT_spatial_anchor_persistence

HoloLens 2 only

HoloLens 2 only
EXT  extension released: extension released:

XR_EXT_hand_tracking

MSFT  extension released: extension released:

XR_MSFT_hand_tracking_mesh

HoloLens 2 only

https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#instance
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#system
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#session
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#spaces
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#view_configurations
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#rendering
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#frame-synchronization
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#compositing
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#frame-submission
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#input
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_KHR_D3D11_enable
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_KHR_D3D12_enable
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_MSFT_unbounded_reference_space
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_MSFT_spatial_anchor
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_MSFT_spatial_anchor_persistence
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_MSFT_hand_interaction
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_EXT_hand_tracking
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_MSFT_hand_tracking_mesh
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_EXT_eye_gaze_interaction


Mixed Reality Capture
(third render from PV camera)

MSFT  extensions released: extensions released:

XR_MSFT_secondary_view_configuration

XR_MSFT_first_person_observer

Motion controller interaction profiles
(Samsung Odyssey and HP Reverb G2)

MSFT  extensions released in runtime 103: extensions released in runtime 103:

XR_EXT_samsung_odyssey_controller

XR_EXT_hp_mixed_reality_controller

Motion controller render models MSFT  extension released in runtime 104: extension released in runtime 104:

XR_MSFT_controller_model

Scene understanding (planes, meshes) MSFT  extension released in runtime 106: extension released in runtime 106:

XR_MSFT_scene_understanding

XR_MSFT_scene_understanding_serialization

Composition layer reprojection modes
(auto-planar or orientation-only reprojection)

MSFT  extension released in runtime 106: extension released in runtime 106:

XR_MSFT_composition_layer_reprojection

Interop with other Mixed Reality SDKs
(for example, QR)

MSFT  extension released: extension released:

XR_MSFT_spatial_graph_bridge

Interop with UWP CoreWindow API
(for example, for keyboard/mouse)

MSFT  extension released in runtime 103: extension released in runtime 103:

XR_MSFT_holographic_window_attachment

Interop with legacy Mixed Reality WinRT APIs
(for example, SpatialAnchorTransferManager ))

Other cross-vendor extensions

F EAT URE A REAF EAT URE A REA EXT EN SIO N  AVA IL A B IL IT YEXT EN SIO N  AVA IL A B IL IT Y

 Where can you use OpenXR?

HoloLens 2 only

HoloLens 2 only

MSFT  extension released in runtime 105: extension released in runtime 105:

XR_MSFT_perception_anchor_interop

Official Official KHR  extensions released: extensions released:

XR_KHR_composition_layer_depth

XR_KHR_visibility_mask

XR_KHR_win32_convert_performance_counter_time

XR_KHR_composition_layer_color_scale_bias

EXT  extensions released: extensions released:

XR_EXT_win32_appcontainer_compatible

XR_EXT_debug_utils

While some of these extensions may start out as vendor-specific MSFT  extensions, Microsoft and other OpenXR

runtime vendors are working together to design cross-vendor EXT  or KHR  extensions for many of these

feature areas. Cross-vendor extensions will make the code you write for those features portable across runtime

vendors, as with the core specification.

https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_MSFT_secondary_view_configuration
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_MSFT_first_person_observer
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_EXT_samsung_odyssey_controller
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_EXT_hp_mixed_reality_controller
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_MSFT_controller_model
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_MSFT_scene_understanding
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_MSFT_scene_understanding_serialization
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_MSFT_composition_layer_reprojection
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_MSFT_spatial_graph_bridge
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_MSFT_holographic_window_attachment
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialanchortransfermanager
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_MSFT_perception_anchor_interop
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_KHR_composition_layer_depth
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_KHR_visibility_mask
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_KHR_win32_convert_performance_counter_time
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_KHR_composition_layer_color_scale_bias
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_EXT_win32_appcontainer_compatible
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html#XR_EXT_debug_utils


  OpenXR in UnityOpenXR in Unity

  OpenXR in Unreal EngineOpenXR in Unreal Engine

  OpenXR for native developmentOpenXR for native development

Minecraft's new RenderDragon engine has built its desktop VR support using OpenXR!

Microsoft has been working with Unity and Epic Games to ensure the future of mixed reality is open, not just for

HoloLens 2, but across the full breadth of PC VR, including HP’s new Reverb G2 headset. OpenXR powers the

cross-vendor VR support for major titles shipping today, such as Minecraft and Microsoft Flight Simulator! For

more information on developing for HoloLens (1st gen), see the release notes.

To learn how you can get started with OpenXR in Unity, Unreal Engine or your own engine, read on!

Microsoft’s current recommended Unity configuration for HoloLens 2 and Windows Mixed Reality development

is Unity 2020.3 LTSUnity 2020.3 LTS  with the Mixed Reality OpenXR plugin. This plugin includes support for the OpenXR

extensions that light up the full capabilities of HoloLens 2 and Windows Mixed Reality headsets, including

hand/eye tracking, spatial anchors and HP Reverb G2 controllers. MRTK-Unity supports OpenXR as of MRTK 2.7.

For more information about getting started with Unity 2020 and OpenXR, see Choosing a Unity version and XR

plugin.

If you are developing for HoloLens (1st gen), you'll need to continue using Unity 2019.4 LTSUnity 2019.4 LTS  with the legacy

WinRT API backend. If you’re targeting the new HP Reverb G2 controller in a Unity 2019 app, see our HP Reverb

G2 input docs.

Starting in Unity 2021.3 LTSUnity 2021.3 LTS , OpenXR will be the only supported Unity backend for targeting HoloLens 2 and

Windows Mixed Reality headsets.

Unreal Engine 4.23 was the first major game engine release to ship preview support for OpenXR 1.0! Now in

Unreal Engine 4.26Unreal Engine 4.26 , support for HoloLens 2, Windows Mixed Reality and other desktop VR headsets is

available through Unreal Engine's built-in OpenXR support. Unreal Engine 4.26 also supports Microsoft's

OpenXR extension plugin, enabling hand interaction and HP Reverb G2 controller support, lighting up the full

feature set of HoloLens 2 and Windows Mixed Reality headsets. Unreal Engine 4.26 is available today on the Epic

Games Launcher, with MRTK-Unreal 0.12 supporting OpenXR projects.

You can develop using OpenXR on a HoloLens 2 or Windows Mixed Reality immersive VR headset on the

desktop. If you don't have access to a headset, you can use the HoloLens 2 Emulator or the Windows Mixed

Reality Simulator instead.

https://www.microsoft.com/mixed-reality/windows-mixed-reality?rtc=1
https://docs.microsoft.com/en-us/hololens/hololens1-release-notes
https://docs.microsoft.com/en-us/learn/paths/beginner-hololens-2-tutorials/?tabs=openxr#importing-the-mixed-reality-toolkit-and-configuring-the-unity-project
https://github.com/microsoft/Microsoft-OpenXR-Unreal
https://www.unrealengine.com/download/creators


 See also

To start developing OpenXR applications for HoloLens 2 or Windows Mixed Reality VR headsets, see how to get

started with OpenXR development.

For a tour through all the major components of the OpenXR API, along with examples of the real-world

applications using OpenXR today, check out this 60-minute walkthrough video:

More information on OpenXR

OpenXR 1.0 specification

OpenXR 1.0 API reference

OpenXR 1.0 quick reference guide

https://docs.microsoft.com/en-us/shows/Mixed-Reality/OpenXR-Cross-platform-native-mixed-reality/player?format=ny
https://www.khronos.org/openxr/
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html
https://www.khronos.org/registry/OpenXR/specs/1.0/man/html/openxr.html
https://www.khronos.org/files/openxr-10-reference-guide.pdf
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 Getting started with OpenXR for HoloLens 2

NOTENOTE

 Getting started with OpenXR for Windows Mixed Reality headsets

 Getting the OpenXR Tools for Windows Mixed Reality

You can develop using OpenXR on a HoloLens 2 or Windows Mixed Reality immersive headset on the desktop. If

you don't have access to a headset, you can use the HoloLens 2 Emulator or the Windows Mixed Reality

Simulator instead.

To start developing OpenXR applications for HoloLens 2:

1. Set up a HoloLens 2 device or install a recent version of the HoloLens 2 emulator.

That's it! The OpenXR API runtime is preinstalled on HoloLens 2 devices, and you'll receive automatic updates

through the Store.

To make sure you've got the latest OpenXR runtime with all extensions present, you can launch the StoreStore app

from the HoloLens device or emulator. Open the menu in the upper-right of the Store app, select DownloadsDownloads

and updatesand updates , and choose Get updatesGet updates .

If you're using the emulator, the emulator image will reset each time you start it, and so your best bet is to just make sure

that you have the latest version of the HoloLens 2 emulator image.

To start developing OpenXR applications for immersive Windows Mixed Reality headsets:

1. Be sure you're running at least the Windows 10 October 2020 Update (20H2), which is the minimum

supported OS release for Windows Mixed Reality end users to run OpenXR applications. Earlier versions of

Windows 10 should still work with OpenXR but may not have ideal performance or quality. If you're on an

earlier version of Windows 10, you can upgrade by using the Windows 10 Update Assistant.

2. Set up a Windows Mixed Reality headset or enable the Windows Mixed Reality simulator.

That's it! The Windows Mixed Reality OpenXR runtime is installed and made active automatically for all

Windows Mixed Reality users. The Microsoft Store then keeps the runtime up to date.

If you've been using multiple VR headsets on your PC, keep in mind that the active OpenXR runtime may be

changed by another vendor's system software. To reactivate the Windows Mixed Reality OpenXR Runtime, on

the Star tStar t menu, launch "Mixed Reality Portal" and then select "Fix it" at the top of the window. If that button is

missing, the OpenXR runtime is already active.

If you're developing OpenXR applications for HoloLens 2 or PC VR, you might find this OpenXR Tools for

Windows Mixed Reality app useful. It provides a demo of various OpenXR features and an OpenXR Runtime

page that contains key information about the active runtime and current headset.

To find and install the OpenXR Tools app, on your HoloLens 2, go to the Store app and search for "OpenXR."

When using the HoloLens 2 emulator, the easiest way to install the OpenXR Tools for Windows Mixed Reality is

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/openxr-getting-started.md
https://docs.microsoft.com/en-us/hololens/hololens2-start
https://www.microsoft.com/software-download/windows10
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/set-up-windows-mixed-reality
https://www.microsoft.com/store/productId/9n5cvvl23qbt


 Exploring the OpenXR API and sample app

 Running your OpenXR app

through the Windows Device Portal. In the Portal, navigate to the "OpenXR" page and then, under DeveloperDeveloper

FeaturesFeatures , select the InstallInstall  button. This also works on physical HoloLens 2 devices.

Be sure to install the tools you'll need for OpenXR development if you haven't already.

The BasicXrApp project shows a simple OpenXR sample with Win32 and UWP HoloLens 2 project files in Visual

Studio. Because the solution contains a HoloLens UWP project, you'll need the Universal Windows Platform

development workload installed in Visual Studio to fully open it.

While the Win32 and UWP project files are separate because of differences in packaging and deployment, the

app code inside each project is almost exactly the same!

For a tour of the OpenXR API, check out this 60-minute video of the BasicXrApp sample in Visual Studio. The

video shows how each of the major components of the OpenXR API can be used in your own engine, and also

demonstrates some of the applications built on OpenXR today:

After building an OpenXR Win32 desktop .EXE, you can use it with a VR headset on any desktop VR platform

that supports OpenXR, whatever the headset type.

https://github.com/microsoft/OpenXR-MixedReality/tree/master/samples/BasicXrApp
https://aka.ms/docs/player?show=mixed-reality&ep=openxr-cross-platform-native-mixed-reality


 Using OpenXR in an existing project

  Reference official OpenXR NuGet packageReference official OpenXR NuGet package

  Include official OpenXR loader sourceInclude official OpenXR loader source

 Using preview extensions

After building an OpenXR UWP app package, you can deploy that package to either a HoloLens 2 device or the

HoloLens 2 Emulator.

To get started with OpenXR in an existing project, you'll include the OpenXR loader. The loader discovers the

active OpenXR runtime on the device and provides access to the core functions and extension functions that it

implements.

You can reference the official OpenXR NuGet package from your Visual Studio project or include the official

OpenXR loader source from the Khronos GitHub repo. Either approach will give you access to OpenXR 1.0 core

features, plus published KHR , EXT  and MSFT  extensions.

If you're interested to experiment with MSFT_preview  extensions as well, you can copy in preview OpenXR

headers from the Mixed Reality GitHub repo.

The OpenXR.LoaderOpenXR.Loader  NuGet package is the easiest way to reference a prebuilt OpenXR loader .DLL in your

Visual Studio C++ solution. This will give you access to OpenXR 1.0 core features, plus published KHR , EXT  and

MSFT  extensions.

To add an OpenXR.Loader NuGet package reference to your Visual Studio C++ solution:

1. In Solution ExplorerSolution Explorer , right-click the project that will use OpenXR and select Manage NuGet Packages...Manage NuGet Packages... .

2. Switch to the BrowseBrowse tab and search for OpenXR.LoaderOpenXR.Loader .

3. Select the OpenXR.LoaderOpenXR.Loader  package and select Install in the details pane to the right.

4. Select OK to accept the changes to your project.

5. Add #include <openxr/openxr.h>  to a source file to start using the OpenXR API.

To see an example of the OpenXR API in action, check out the BasicXrApp sample app.

If you want to build the loader yourself, for example to avoid the extra loader .DLL, you can pull the official

Khronos OpenXR loader sources into your project. This will give you access to OpenXR 1.0 core features, plus

published KHR , EXT  and MSFT  extensions.

To get started here, follow the instructions in the Khronos OpenXR-SDK repo on GitHub. The project is set up to

build with CMake - if you're using MSBuild, you'll need to copy the code into your own project.

The MSFT_preview  extensions listed in the extension roadmap are experimental vendor extensions being

previewed to gather feedback. These extensions are for developer devices only and will be removed when the

real extension ships.

If you're interested to try out the available MSFT_preview  extensions, go through the following steps to update

your project:

1. Follow either of the approaches above to integrate an OpenXR loader into your project.

2. Replace the standard OpenXR headers in your project with the preview headers from the Mixed Reality

OpenXR repo on GitHub.

To then activate preview extension support on your target HoloLens 2 or desktop PC:

1. To make sure you've got the latest OpenXR runtime with all extensions present, launch the StoreStore app from

within the target device or emulator, open the menu in the upper-right, select Downloads and updatesDownloads and updates  and

https://www.nuget.org/packages/OpenXR.Loader/
https://github.com/microsoft/OpenXR-MixedReality/tree/master/samples/BasicXrApp
https://github.com/KhronosGroup/OpenXR-SDK
https://github.com/microsoft/OpenXR-MixedReality/tree/master/openxr_preview/include/openxr


choose Get updatesGet updates .

2. Install the OpenXR Tools for Windows Mixed Reality app from the Microsoft Store onto the target device and

run it.

3. Navigate to the SettingsSettings  tab and enable Use latest preview OpenXR runtimeUse latest preview OpenXR runtime. This enables the preview

runtime on your device, which has preview extensions activated. 

4. Confirm the Runtime versionRuntime version shown on the OpenXR RuntimeOpenXR Runtime tab of the OpenXR Tools for Windows

Mixed Reality matches the required version of the preview extensions you plan to try. If so, you should see

the extension in the ExtensionsExtensions  list. Once a stable extension is available, its preview extension will be

removed.

https://www.microsoft.com/store/productId/9n5cvvl23qbt


 Troubleshooting

See the Mixed Reality OpenXR repo for documentation of these preview extensions and samples of how to use

them.

If you have trouble getting up and running with OpenXR development, check out our troubleshooting tips.

https://github.com/microsoft/OpenXR-MixedReality#openxr-preview-extensions
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 Best practices for visual quality and stability

  Gamma-correct renderingGamma-correct rendering

  Submit depth buffer for projection layersSubmit depth buffer for projection layers

  Choose a reasonable depth rangeChoose a reasonable depth range

  Prepare for different environment blend modesPrepare for different environment blend modes

  Choose unbounded reference space as application's root spaceChoose unbounded reference space as application's root space

  

You can see an example of the best practices below in BasicXrApp's OpenXRProgram.cpp file. The Run() function

at the beginning captures a typical OpenXR app code flow from initialization to the event and rendering loop.

The best practices in this section describe how to get the best visual quality and stability in any OpenXR

application.

For further performance recommendations specific to HoloLens 2, see the Best practices for performance on

HoloLens 2 section below.

Care must be taken to ensure that your rendering pipeline is gamma-correct. When rendering to a swapchain,

the render-target view format should match the swapchain format. For example, 

DXGI_FORMAT_B8G8R8A8_UNORM_SRGB  for both the swapchain format and the render-target view. There's an

exception if the app's rendering pipeline does a manual sRGB conversion in shader code. The app should

request an sRGB swapchain format but use the linear format for the render-target view. For example, request 

DXGI_FORMAT_B8G8R8A8_UNORM_SRGB  as the swapchain format but use DXGI_FORMAT_B8G8R8A8_UNORM  as the render-

target view to prevent content from being double-gamma corrected.

Always use XR_KHR_composition_layer_depth  extension and submit the depth buffer together with the projection

layer when submitting a frame to xrEndFrame . Enabling hardware depth reprojection on HoloLens 2 improves

hologram stability.

Prefer a narrower depth range to scope the virtual content to help hologram stability on HoloLens. For example,

the OpenXrProgram.cpp sample is using 0.1 meters to 20 meters. Use reversed-Z for a more uniform depth

resolution. On HoloLens 2, using the preferred DXGI_FORMAT_D16_UNORM  depth format will help achieve better

frame rate and performance, although 16-bit depth buffers provide less depth resolution than 24-bit depth

buffers. Following these best practices to make best use of the depth resolution becomes more important.

If your application will also run on immersive headsets that completely block out the world, be sure to

enumerate supported environment blend modes using xrEnumerateEnvironmentBlendModes  API, and prepare your

rendering content correctly. For example, for a system with XR_ENVIRONMENT_BLEND_MODE_ADDITIVE  such as the

HoloLens, the app should use transparent as the clear color, while for a system with 

XR_ENVIRONMENT_BLEND_MODE_OPAQUE , the app should render some opaque color or some virtual room in the

background.

Applications typically establish some root world coordinate space to connect views, actions, and holograms

together. Use XR_REFERENCE_SPACE_TYPE_UNBOUNDED_MSFT  when the extension is supported to establish a world-

scale coordinate system, enabling your app to avoid undesired hologram drift when the user moves far (for

example, 5 meters away) from where the app starts. Use XR_REFERENCE_SPACE_TYPE_LOCAL  as a fallback if the

unbounded space extension doesn't exist.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/openxr-best-practices.md
https://github.com/microsoft/OpenXR-MixedReality/tree/master/samples/BasicXrApp
https://developer.nvidia.com/content/depth-precision-visualized


Associate hologram with spatial anchorAssociate hologram with spatial anchor

  Support mixed reality captureSupport mixed reality capture

 Best practices for performance on HoloLens 2

  Select a swapchain formatSelect a swapchain format

  Render with recommended rendering parameters and frame timingRender with recommended rendering parameters and frame timing

  Use a single projection layerUse a single projection layer

  Render with texture array and VPRTRender with texture array and VPRT

  Avoid quad layersAvoid quad layers

When using an unbounded reference space, holograms you place directly in that reference space may drift as

the user walks to distant rooms and then comes back. For hologram users place at a discrete location in the

world, create a spatial anchor using the xrCreateSpatialAnchorSpaceMSFT  extension function and position the

hologram at its origin. That will keep that hologram independently stable over time.

Although HoloLens 2's primary display uses additive environment blending, when the user starts mixed reality

capture, the app's rendering content will be alpha-blended with the environment video stream. To achieve the

best visual quality in mixed reality capture videos, it's best to set the 

XR_COMPOSITION_LAYER_BLEND_TEXTURE_SOURCE_ALPHA_BIT  in your projection layer's layerFlags .

As a mobile device with hardware reprojection support, HoloLens 2 has stricter requirements for optimal

performance. There are a number of ways to submit composition data through, which results in post-processing

with a noticeable performance penalty.

Always enumerate supported pixel formats using xrEnumerateSwapchainFormats , and choose the first color and

depth pixel format from the runtime that the app supports, because that's what the runtime prefers for optimal

performance. Note, on HoloLens 2, DXGI_FORMAT_B8G8R8A8_UNORM_SRGB  and DXGI_FORMAT_D16_UNORM  is typically the

first choice to achieve better rendering performance. This preference can be different on VR headsets running

on a Desktop PC, where 24-bit depth buffers have less of a performance impact.

Performance Warning:Performance Warning: Using a format other than the primary swapchain color format will result in runtime

post-processing, which comes at a significant performance penalty.

Always render with the recommended view configuration width/height ( recommendedImageRectWidth  and 

recommendedImageRectHeight  from XrViewConfigurationView ), and always use xrLocateViews  API to query for the

recommended view pose, FOV, and other rendering parameters before rendering. Always use the 

XrFrameEndInfo.predictedDisplayTime  from the latest xrWaitFrame  call when querying for poses and views. This

allows HoloLens to adjust rendering and optimize visual quality for the person who is wearing the HoloLens.

HoloLens 2 has limited GPU power for rendering content and a hardware compositor optimized for a single

projection layer. Always using a single projection layer can help the application's framerate, hologram stability

and visual quality.

Performance Warning:Performance Warning: Submitting anything but a single protection layer will result in runtime post-

processing, which comes at a significant performance penalty.

Create one xrSwapchain  for both left and right eye using arraySize=2  for color swapchain, and one for depth.

Render the left eye into slice 0 and the right eye into slice 1. Use a shader with VPRT and instanced draw calls for

stereoscopic rendering to minimize GPU load. This also enables the runtime's optimization to achieve the best

performance on HoloLens 2. Alternatives to using a texture array, such as double-wide rendering or a separate

swapchain per eye, will result in runtime post-processing, which comes at a significant performance penalty.

Rather than submitting quad layers as composition layers with XrCompositionLayerQuad , render the quad

content directly into the projection swapchain.



Performance Warning:Performance Warning: Providing additional layers beyond a single projection layer, such as quad layers, will

result in runtime post-processing, which comes at a significant performance penalty.
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 How can my app recenter its reference space?

Below are some common OpenXR how-to questions that we are often asked as developers dive in on building

engines that target the OpenXR API.

To recenter a reference space such as LOCAL  space or STAGE  space:

1. Call xrLocateSpace  to find the current location of the VIEW  reference space within the reference space you

are recentering.

2. Call xrCreateReferenceSpace  again for the reference space you are recentering, adding the current VIEW

pose to the poseInReferenceSpace  field on your XrReferenceSpaceCreateInfo  struct.

3. Call xrDestroyReferenceSpace  on the old reference space handle and start using your new recentered

reference space in its place.

Be sure to stash away the XrReferenceSpaceCreateInfo  struct you use in step 2, so that the next time you need to

recenter, you can add the then-current VIEW  pose to the struct's accumulated poseInReferenceSpace  field.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/openxr-cookbook.md
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On HoloLens 2, there are a number of ways to submit composition data through xrEndFrame , which can result

in post-processing and noticeable performance penalties.

To avoid poor performance, submit a single XrCompositionProjectionLayer  with the following characteristics:

Use a texture array swapchain

Use the primary color swapchain format

Use the recommended view dimensions

Don't set the XR_COMPOSITION_LAYER_UNPREMULTIPLIED_ALPHA_BIT  flag

Set the XrCompositionLayerDepthInfoKHR  minDepth  to 0.0f and maxDepth  to 1.0f

For better performance, consider :

Using the 16-bit depth format

Making instanced draw calls

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/openxr-performance.md
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  OpenXR app not starting Windows Mixed RealityOpenXR app not starting Windows Mixed Reality

Here are some troubleshooting tips when developing an OpenXR app using the Windows Mixed Reality OpenXR

Runtime. If you have any other questions about the OpenXR 1.0 specification, visit the Khronos OpenXR Forums

or Slack #openxr channel.

If your OpenXR app isn't starting Windows Mixed Reality when you run it, the Windows Mixed Reality OpenXR

Runtime may not be set as the active runtime. Follow the instructions for getting started with OpenXR for

Windows Mixed Reality headsets to fix the issue.

You can also run the OpenXR Developer Tools for Windows Mixed Reality to get troubleshooting help on the

state of your systems Windows Mixed Reality OpenXR Runtime.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/openxr-troubleshooting.md
https://www.khronos.org/registry/OpenXR/specs/1.0/html/xrspec.html
https://community.khronos.org/c/openxr
https://khr.io/slack
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 Representing 3D Textures

public struct Int3 { public int X, Y, Z; /* ... */ }
 public class VolumeHeader  {
   public readonly Int3 Size;
   public VolumeHeader(Int3 size) { this.Size = size;  }
   public int CubicToLinearIndex(Int3 index) {
     return index.X + (index.Y * (Size.X)) + (index.Z * (Size.X * Size.Y));
   }
   public Int3 LinearToCubicIndex(int linearIndex)
   {
     return new Int3((linearIndex / 1) % Size.X,
       (linearIndex / Size.X) % Size.Y,
       (linearIndex / (Size.X * Size.Y)) % Size.Z);
   }
   /* ... */
 }
 public class VolumeBuffer<T> {
   public readonly VolumeHeader Header;
   public readonly T[] DataArray;
   public T GetVoxel(Int3 pos)        {
     return this.DataArray[this.Header.CubicToLinearIndex(pos)];
   }
   public void SetVoxel(Int3 pos, T val)        {
     this.DataArray[this.Header.CubicToLinearIndex(pos)] = val;
   }
   public T this[Int3 pos] {
     get { return this.GetVoxel(pos); }
     set { this.SetVoxel(pos, value); }
   }
   /* ... */
 }

float3 _VolBufferSize;
 int3 UnitVolumeToIntVolume(float3 coord) {
   return (int3)( coord * _VolBufferSize.xyz );
 }
 int IntVolumeToLinearIndex(int3 coord, int3 size) {
   return coord.x + ( coord.y * size.x ) + ( coord.z * ( size.x * size.y ) );
 }
 uniform StructuredBuffer<float> _VolBuffer;
 float SampleVol(float3 coord3 ) {
   int3 intIndex3 = UnitVolumeToIntVolume( coord3 );
   int index1D = IntVolumeToLinearIndex( intIndex3, _VolBufferSize.xyz);
   return __VolBuffer[index1D];
 }

 Shading and Gradients

If you're new to volume rendering, we recommend that you read our overview.

On the CPU:

On the GPU:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/volume-rendering.md


float4 ShadeVol( float intensity ) {
   float unitIntensity = saturate( intensity - IntensityMin / ( IntensityMax - IntensityMin ) );
   // Simple two point black and white intensity:
   color.rgba = unitIntensity;
   // Color ramp method:
   color.rgba = tex2d( ColorRampTexture, float2( unitIntensity, 0 ) );

// Change color to match segment index (fade each segment towards black):
 color.rgb = SegmentColors[ segment_index ] * color.a; // brighter alpha gives brighter color

 Volume Slicing in a Shader

// In the vertex shader:
 float4 worldPos = mul(_Object2World, float4(input.vertex.xyz, 1));
 float4 volSpace = mul(_WorldToVolume, float4(worldPos, 1));

// In the pixel shader:
 float4 color = ShadeVol( SampleVol( volSpace ) );

 Volume Tracing in Shaders

How to shade a volume, such as MRI, for useful visualization. The primary method is to have an 'intensity

window' (a min and max) that you want to see intensities within, and simply scale into that space to see the

black and white intensity. A 'color ramp' can then be applied to the values within that range, and stored as a

texture, so that different parts of the intensity spectrum can be shaded different colors:

In many of our applications, we store in our volume both a raw intensity value and a 'segmentation index' (to

segment different parts such as skin and bone; these segments are created by experts in dedicated tools). This

can be combined with the approach above to put a different color, or even different color ramp for each

segment index:

A great first step is to create a "slicing plane" that can move through the volume, 'slicing it', and how the scan

values at each point. This assumes that there's a 'VolumeSpace' cube, which represents where the volume is in

world space, that can be used as a reference for placing the points:

How to use the GPU to do subvolume tracing (walks a few voxels deep, then layers on the data from back to

front):



float4 AlphaBlend(float4 dst, float4 src) {
   float4 res = (src * src.a) + (dst - dst * src.a);
   res.a = src.a + (dst.a - dst.a*src.a);
   return res;
 }
 float4 volTraceSubVolume(float3 objPosStart, float3 cameraPosVolSpace) {
   float maxDepth = 0.15; // depth in volume space, customize!!!
   float numLoops = 10; // can be 400 on nice PC
   float4 curColor = float4(0, 0, 0, 0);
   // Figure out front and back volume coords to walk through:
   float3 frontCoord = objPosStart;
   float3 backCoord = frontPos + (normalize(cameraPosVolSpace - objPosStart) * maxDepth);
   float3 stepCoord = (frontCoord - backCoord) / numLoops;
   float3 curCoord = backCoord;
   // Add per-pixel random offset, avoids layer aliasing:
   curCoord += stepCoord * RandomFromPositionFast(objPosStart);
   // Walk from back to front (to make front appear in-front of back):
   for (float i = 0; i < numLoops; i++) {
     float intensity = SampleVol(curCoord);
     float4 shaded = ShadeVol(intensity);
     curColor = AlphaBlend(curColor, shaded);
     curCoord += stepCoord;
   }
   return curColor;
 }

// In the vertex shader:
 float4 worldPos = mul(_Object2World, float4(input.vertex.xyz, 1));
 float4 volSpace = mul(_WorldToVolume, float4(worldPos.xyz, 1));
 float4 cameraInVolSpace = mul(_WorldToVolume, float4(_WorldSpaceCameraPos.xyz, 1));

// In the pixel shader:
 float4 color = volTraceSubVolume( volSpace, cameraInVolSpace );

 Whole Volume Rendering

float4 volTraceSubVolume(float3 objPosStart, float3 cameraPosVolSpace) {
   float maxDepth = 1.73; // sqrt(3), max distance from point on cube to any other point on cube
   int maxSamples = 400; // just in case, keep this value within bounds
   // not shown: trim front and back positions to both be within the cube
   int distanceInVoxels = length(UnitVolumeToIntVolume(frontPos - backPos)); // measure distance in voxels
   int numLoops = min( distanceInVoxels, maxSamples ); // put a min on the voxels to sample

 Mixed Resolution Scene Rendering

Modifying the subvolume code above, we get:

How to render a part of the scene with a low resolution and put it back in place:

1. Setup two off-screen cameras, one to follow each eye that update each frame

2. Setup two low-resolution render targets (that is, 200x200 each) that the cameras render into

3. Set up a quad that moves in front of the user

Each Frame:

1. Draw the render targets for each eye at low-resolution (volume data, expensive shaders, and so on)

2. Draw the scene normally as full resolution (meshes, UI, and so on)



3. Draw a quad in front of the user, over the scene, and project the low-res renders onto that

4. Result: visual combination of full-resolution elements with low-resolution but high-density volume data
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 Setup

PIX is a performance tuning and debugging tool for DirectX 12 applications on Windows but can also be used

for DirectX 11 using Direct3D 11 on 12.

1. Latest version of PIX installed on the PC.

2. Latest Windows SDK for IPoverUSBIPoverUSB to be able to connect the HoloLens 2 to a PC via USB.

3. An ARM64ARM64  build of your application. PIX only supports ARM64.

4. The HoloLens2 needs to be connected to the PC via a USB cable.

Some configurations, like using a Windows Insider build can break PIX on HoloLens 2. If that happens, reflash your device

to erase all data and repeat the instructions below.

1. Enable Developer ModeDeveloper Mode and Device Por talDevice Por tal :

Open SettingsSettings  from Mixed Reality Home:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/installing-pix-hololens.md
https://devblogs.microsoft.com/pix
https://docs.microsoft.com/en-us/windows/win32/direct3d12/direct3d-11-on-12
https://devblogs.microsoft.com/pix/download
https://developer.microsoft.com/windows/downloads/windows-sdk/
https://insider.windows.com
https://docs.microsoft.com/en-us/hololens/hololens-recovery


Select Update & SecurityUpdate & Security :



Select For DevelopersFor Developers :

Turn on Use Developer FeaturesUse Developer Features  and Enable Device Por talEnable Device Por tal





IMPORTANTIMPORTANT

 Preparing for deployment

With the device still connected, awake, and with the user logged in, launch Visual Studio.

Make sure your device isn't in standby mode or asleep. If you're having trouble with this step, refer to the Windows

Device Portal instructions.

1. In Visual Studio, set ARM64ARM64  as the platform and DeviceDevice as the device:

2. When Visual Studio prompts you for a PINPIN from the device:



Select SettingsSettings  from Shell

Select Update & SecurityUpdate & Security

Select For DevelopersFor Developers  and press Pair under Device Discover yDevice Discover y



 Launching PIX

Enter the generated PIN number in Visual Studio

3. Visual Studio will deploy the app to the connected HoloLens 2, which may take a few minutes depending on

the app.

First, use Device Portal to verify the app isn't running on the HoloLens 2. Then, launch PIX, connect to your

device, and select HomeHome:

Select ConnectConnect from the left-side menu:
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2. From the ComputerComputer  tab, select AddAdd, and enter the following credentials:

Alias: Up to user ’s discretion

Host Name or IP Address: 127.0.0.1

3. Select ConnectConnect in the lower right of the ComputerComputer  tab:

The first connection is always slower because binaries are being copied.

1. When PIX has connected to the HoloLens 2, find your app in the Select Target ProcessSelect Target Process  section in the

Launch UWP tab, and then make sure Launch for GPU CaptureLaunch for GPU Capture is active.

2. If your application is running on DX11, make sure that Force D3D11On12Force D3D11On12  is selected.

3. Click LaunchLaunch:



 GPU captured
1. Start the GPU capture by clicking PhotoPhoto in the GPU CaptureGPU Capture section:

2. Open the capture for analysis by clicking on the generated screenshot in the GPU CaptureGPU Capture panel:



IMPORTANTIMPORTANT

 See also

3. Press Star tStar t to begin the analysis:

If you collect timing data after taking a GPU capture, you'll be required to reboot the headset. This is a one-time restart of

the device and is required for timing data collection.

PIX is now ready for use! For an introduction on how to use PIX, please refer to PIX GPU captures.

PIX homepage

PIX GPU captures

https://devblogs.microsoft.com/pix/gpu-captures/
https://devblogs.microsoft.com/pix
https://devblogs.microsoft.com/pix/gpu-captures/
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You can use Holographic Remoting to stream holographic content to your HoloLens in real time. There are two

main uses for Holographic Remoting, and it's important to understand the difference:

1. (Unity or Unreal): You want to preview and debug your app during the development processYou want to preview and debug your app during the development process :

You can run your app locally in the Unity editor on your PC in Play Mode and stream the experience to

your HoloLens. Holographic Remoting provides a way to quickly debug your app without building and

deploying a full project. We call this type of app a Holographic Remoting Player app.

Learn more about previewing and debugging your app in UnityUnity

Learn more about previewing and debugging your app in UnrealUnreal

2. (Unity, Unreal or C++): You want the resources of a PC to power your app instead of relying onYou want the resources of a PC to power your app instead of relying on

the HoloLens on-board resourcesthe HoloLens on-board resources : You can create and build an app that has Holographic Remoting

capability. The user experiences the app on the HoloLens, but the app actually runs on a PC, which allows

it to take advantage of the PC's more powerful resources. Holographic Remoting can be especially helpful

if your app has high-resolution assets or models and you don't want the frame rate to suffer. We call this

type of app a Holographic Remoting Remote app.

Learn more about using PC resources in Unity

Learn more about using PC resources in Unreal

Write a Holographic Remoting remote app using Windows Mixed Reality APIs (C++)

Write a Holographic Remoting remote app using OpenXR APIs (C++)

In either case, inputs from the HoloLens--gaze, gesture, voice, and spatial mapping--are sent to the PC, content

is rendered in a virtual immersive view, and the rendered frames are then sent to the HoloLens.

When developing a remote application either the Windows Mixed Reality API or the OpenXR API has to be used. Mixing

both APIs within the same application is not supported.

Holographic Remoting for HoloLens 2 is a major version change. Remote applications for HoloLens (1st gen)HoloLens (1st gen) must use

NuGet package version 1.x.x1.x.x and remote applications for HoloLens 2HoloLens 2  must use 2.x.x2.x.x. This implies that remote

applications written for HoloLens 2 are not compatible with HoloLens (1st gen) and vice versa.

Holographic Remoting Terminology

Holographic Remoting Player

Tutorial: Getting started with PC Holographic Remoting

Tutorial: Creating a Holographic Remoting PC application

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/holographic-remoting-overview.md
https://docs.microsoft.com/en-us/learn/modules/pc-holographic-remoting-tutorials/
https://docs.microsoft.com/en-us/learn/modules/pc-holographic-remoting-tutorials/4-create-holographic-remoting-pc-application
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Player The Player is the application that runs on your head-
mounted display. The Player sends poses to the Remote
application and receives video frames from the Remote in
exchange, all in real time. You can find the Holographic
Remoting Player in the Windows Store. The store Player
provides the general functionality to use Holographic
Remoting. You can use the store Player for various Remote
applications and there is no need for you to create a Player
application. If you need extended functionality in the Player
application, you can write your own Player. For more
information, see Writing a custom Player app

Remote The Remote is the application that runs on a desktop
computer or on a virtual machine in the cloud. The Remote
receives poses from the Player, performs the calculation-
intense rendering, and sends video frames back to the
Player. You can find C++ Remote examples in our
Holographic Remoting samples github repository. If you use
Holographic Remoting within Unity or Unreal, the game
engines are the Remote application.

Server A server listens for an incoming connection. With
Holographic Remoting, it's possible that either the Player or
the Remote is the server depending on your needs. This
functionality is the reason we use the extra terms Player and
Remote. For example, the store Player runs as a server, which
waits for a connection from a Remote client. If your custom
Player should be the client, you can configure the Remote
app as server.

Client A client connects to a server. As stated before, with
Holographic Remoting, it's possible that either the Player or
the Remote is the client. If your Player has to be the client,
you can create a custom Player. For more information, see
Writing a custom Player app.

Hostname The hostname is used to identify a device in the network. To
establish a Holographic Remoting connection, you have to
provide the server's hostname (for example, the IP address)
on the client side. With the hostname, the client knows
where it can find the server in the network.

Holographic Remoting combines advanced technologies and uses many terms, which could introduce some

ambiguities. Therefore, the following section will list some of the terminology related to Holographic Remoting.

The descriptions of these terms are rough and simple explanations targeted on the use with Holographic Remoting, it is

not a technical description.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/holographic-remoting-terminology.md
https://www.microsoft.com/p/holographic-remoting-player/9nblggh4sv40
https://github.com/microsoft/MixedReality-HolographicRemoting-Samples


Ports Ports are used by many Internet protocols, such as TCP or
UDP, to assign packets to the correct processes. For the
Holographic Remoting connection you also have to provide
the port that the client and the server should use. The
default port is 8265 on both sides.

TCP The Transmission Control Protocol (TCP) is a common
network protocol. TCP creates a connection between client
and server by executing a three-way handshake. TCP is a
"reliable" protocol--it detects errors and performs a
retransmission if packets are lost. Unfortunately, the
reliability comes with the cost of extra latency.

UDP The User Datagram Protocol is a connectionless and
"unreliable" protocol. UDP doen't resend packets if they're
lost. One advantage of UDP is that the latency is lower
compared to TCP. For real-time applications, such as
Holographic Remoting, reducing latency is important. Luckily,
not all the data has to be sent in a reliable fashion; this
allows the use of UDP. For example, the Player sends the
pose in real time with high frequency to the Remote. If one
of the packets that contain the pose data gets lost, waiting
for a retransmission would take so long that the pose is
already outdated. In this case, the Remote can just use one
of the subsequent new poses.

Firewall A firewall protects a system from unwanted network
accesses. Depending on your firewall settings, you have to
allow Holographic Remoting applications and the used ports
in order to connect successfully.

Data Channel Data channels are used to send certain data between the
Player and the Remote. Holographic Remoting uses various
data channels, such as video and audio. If you need to send
custom data between your Player and Remote apps, you can
use a custom data channel. All the data channels, including
the custom data channels, share the available bandwidth.
For more information, see Custom data channels with the
OpenXR API or Custom data channels with the Windows
Mixed Reality API.

Bandwidth In general, bandwidth expresses how many bits per second
can be transferred. For Holographic Remoting, the available
bandwidth between the Player and the Remote application is
critical for the experience. The maximum bandwidth
Holographic Remoting should use can be configured on the
Remote application. The actual available bandwidth depends
on various factors such as the physical connection or other
traffic in the network. Holographic Remoting compensates
for changes in the available bandwidth as well as possible
and the video encoder will account for these changes by
adjusting the quality of the video stream.

T ERMT ERM DESC RIP T IO NDESC RIP T IO N



Video Encoder The Remote application uses hardware accelerated video-
encoding to compress the rendered image into a video
stream. This compression is needed because transmitting the
uncompressed video data is impossible in real time. In your
Remote application, you can select which video codec should
be used for encoding. For more information, see Writing a
remote app using the OpenXR API or Writing a remote app
using the Windows Mixed Reality API.

Video Decoder The video decoder is used to decode the encoded image on
the Player side. The video decoding is also hardware
accelerated to minimize latency between the Player and
Remote.

Latency Latency is the amount of time data takes to pass from one
side to the other. Holographic Remoting is used for real-time
applications. Therefore, the latency between the Player and
the Remote application plays an important role in the
experience. The experience won't be great if you turn your
head and you don't instantly see the changes in your HMD.
Holographic Remoting is highly optimized and the latency is
reduced to a minimum; it can be unnoticeable that an image
was rendered on another machine.

Windows Mixed Reality API The Windows Mixed Reality API (sometimes called
"HolographicSpace API") is an API introduced in Windows 10
that allows allows access to Windows Mixed Reality devices.
With Holographic Remoting, you can use the Windows
Mixed Reality API to stream in real time to Windows Mixed
Reality devices.

OpenXR API OpenXR is a new open standard that provides access to XR
platforms and devices across various vendors. Holographic
Remoting provides an OpenXR runtime that allows real-time
streaming to XR devices. With Holographic Remoting, it's
also possible to use a Windows Mixed Reality Player with a
OpenXR Remote.
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 See Also
Holographic Remoting Overview
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 Remote PC

 Player PC

NOTENOTE

GP U M A N UFA C T URERGP U M A N UFA C T URER SUP P O RT ED M O DEL SSUP P O RT ED M O DEL S

NVIDIA Check the support matrix at the bottom of this page

AMD Check the support matrix on this page

Intel Skylake and newer CPUs

IMPORTANTIMPORTANT

 Network

This chapter lists the minimum system requirements to work with Holographic Remoting.

Windows 10 version 1903 or higher or Windows 11.

Up-to-date graphics drivers.

GPU with H264 video encodeencode support.

Optional: GPU with H265 video encodeencode support.

Windows 10 version 1903 or higher or Windows 11.

Up-to-date graphics drivers.

GPU with H264 video decodedecode support.

Optional: GPU with H265 video decodedecode support.

The player PC requirements are only relevant if your player application runs on a Windows PC with Windows Mixed

Reality instead of the HoloLens 2.

The table below helps to find which GPUs support hardware video encoding and decoding:

Even though the correct H265 codec might be installed, security properties on the codec DLLs may cause codec

initialization failures. The troubleshooting section describes steps on how to solve this problem.

Windows update doesn't always deliver the very latest GPU drivers. Check your GPU manufacturer's website for latest

drivers:

AMD driversAMD drivers

Intel driversIntel drivers

NVIDIA driversNVIDIA drivers

A stable, low-latency network connection between the player and remote is critical for a good user experience.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/holographic-remoting-system-requirements.md
https://developer.nvidia.com/video-encode-decode-gpu-support-matrix
https://en.wikipedia.org/wiki/Unified_Video_Decoder#UVD_6
https://www.amd.com/en/support
https://www.intel.com/content/www/us/en/support/detect.html
https://www.nvidia.com/Download/index.aspx


 Software

 See Also

The following software must be installed on a developer PC:

The latest version of Visual Studio 2019 download

Workloads:

Individual components:

Desktop development with C++

Universal Windows Platform development

Windows 10 SDK (10.0.19041.0)

MSVC v142 - VS 2019 C++ (x64/x86|ARM|ARM64) build tools (newest)

MSVC v142 - VS 2019 C++ (x64/x86|ARM|ARM64) Spectre-mitigated libs (newest)

Net Native

.Net Framework 4.5 targeting pack

Nuget Package manager

C++ 2019 Redistributable Update

C++ Universal Windows Platform support for v142 build tools (ARM64)

C++/WinRT

Windows Universal C Runtime

Holographic Remoting Overview

Holographic Remoting Terminology

https://visualstudio.microsoft.com/vs/older-downloads/
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 Connecting to the Holographic Remoting Player

 Quality and Performance

The Holographic Remoting Player is a companion app that connects to PC apps and games that support

Holographic Remoting. The Player is available for both HoloLens (first gen) and HoloLens 2. PC apps that

supported Holographic Remoting with HoloLens need to be updated to support Holographic Remoting with

HoloLens 2. Contact your app provider if you have questions about which versions are supported.

Starting with version 2.2.0 the Holographic Remoting player is also available for Windows PCs running Windows Mixed

Reality.

Starting with version 2.4.0 remote apps using the OpenXR API can be created. To get started check out Writing a

Holographic Remoting remote app using OpenXR APIs.

Follow your app's instructions to connect to the Holographic Remoting Player. You'll need to enter the IP address

of your HoloLens device, which you can see on the Remoting Player's main screen, as follows:

Whenever you see the main screen, you'll know that you don't have an app connected.

The holographic remoting connection is not encr yptednot encr ypted. Always use Holographic Remoting over a secure Wi-Fi

connection that you trust.

The quality and performance of your experience will vary based on three factors:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/holographic-remoting-player.md
https://www.microsoft.com/p/holographic-remoting-player/9nblggh4sv40


 Diagnostics

The holographic experience you're runningThe holographic experience you're running - Apps that render high-resolution or highly detailed

content may require a faster PC or faster wireless connection.

Your PC's hardwareYour PC's hardware - Your PC needs to be able to run and encode your holographic experience at 60

frames per second. For a graphics card, we generally recommend a GeForce GTX 970 or AMD Radeon R9

290 or better. Again, your particular experience may require a higher or lower-end card.

Your Wi-Fi connectionYour Wi-Fi connection - Your holographic experience is streamed over Wi-Fi. Use a fast network with low

congestion to maximize quality. Using a PC that is connected over an Ethernet cable, rather than Wi-Fi, may

also improve quality.

To measure the quality of your connection, say "enable diagnostics""enable diagnostics" while on the main screen of the

Holographic Remoting Player. When diagnostics are enabled, on HoloLens (first gen)HoloLens (first gen)  the app will show you:

FPSFPS  - The average number of rendered frames the Remoting player is receiving and rendering per second.

The ideal is 60 FPS.

LatencyLatency  - The average amount of time it takes for a frame to go from your PC to the HoloLens. The lower

the better. The latency is largely dependent on your Wi-Fi network.

On HoloLens 2HoloLens 2  the app will show you:

RenderRender  - The number of frames the Remoting player rendered during the last second. Note, this is

independent from the number of frames, which arrived via the network (see Video framesVideo frames). The

average/maximum render delta time in milliseconds over the last second between rendered frames is

displayed.

Video framesVideo frames  - The first number displayed is skipped video frames, the second is reused video frames,

and the third is received video frames. All numbers represent the count over the last second.

Received frames  is the number of video frames, which arrived over the last second. Under normal

conditions, this should be 60 but if it's not this is an indicator that either frames are dropped because of

network issues or the remote/remote side doesn't produce frames with the expected rate.

Reused frames  is the count of video frames used more than once over the last second. For instance, if

video frames arrive late, the rendering loop of the player still renders a frame but needs to reuse the
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video frame it already used for the previous frame.

Skipped frames  is the count of video frames, which haven't been used by the rendering loop of the

player. For instance, network jitter can have the effect that video frames arriving aren't evenly distributed

anymore. For example, if some are late and others arrive in time with the result that they do not have a

delta of 16.66 milliseconds anymore when running on 60 Hz. It can occur that more than one frame

arrives between two ticks of the render loop of the player. In this case, the player skips one or more

frames as it's supposed to always display the most recent received video frame.

When facing network jitter, skipped and reused frames are usually about the same. In contrast, if you only see skipped

frames, this is an indicator that the player does not hit its target frame rate. In this case, you should keep an eye on the

maximum render delta time when diagnosing issues.

Video frames deltaVideo frames delta - The minimum/maximum delta between received video frames over the last second.

This number usually correlates with skipped/reused frames in case of issues caused by network jitter.

LatencyLatency  - The average turnaround in milliseconds over the last second. Turnaround in this context means the

time from sending pose/sensor data from the HoloLens to the remote/remote side until displaying the video

frame for that pose/telemetry data on the HoloLens display.

Video frames discardedVideo frames discarded - The number of discarded video frames over the last second and since a

connection has been established. The primary cause for discarded video frames is when a video frame

doesn't arrive in order and for that reason needs to be discarded as there's already a newer one. This is

similar to discarded frames but the cause is at a lower level in the Remoting stack. Discarded video frames

are only expected under bad network conditions.

While on the main screen, you can say "disable diagnostics""disable diagnostics" to turn off diagnostics.

Holographic Remoting overview

HoloLens (first gen): Add Holographic Remoting

Writing a Holographic Remoting remote app using Windows Mixed Reality APIs

Writing a Holographic Remoting remote app using OpenXR APIs

Holographic Remoting software license terms

Microsoft Privacy Statement

https://docs.microsoft.com/en-us/legal/mixed-reality/microsoft-holographic-remoting-software-license-terms
https://go.microsoft.com/fwlink/?LinkId=521839
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 Get the Holographic Remoting NuGet package

If you're new to Holographic Remoting, you may want to read our overview.

This document describes the creation of a remote application for HoloLens 2 and Windows Mixed Reality headsets using

the OpenXR API. Remote applications for HoloLens (1st gen)HoloLens (1st gen) must use NuGet package version 1.x.x1.x.x. This implies that

remote applications written for HoloLens 2 are not compatible with HoloLens 1 and vice versa. The documentation for

HoloLens 1 can be found here.

Holographic Remoting apps can stream remotely rendered content to HoloLens 2 and Windows Mixed Reality

immersive headsets. You can also access more system resources and integrate remote immersive views into

existing desktop PC software. A remote app receives an input data stream from HoloLens 2, renders content in a

virtual immersive view, and streams content frames back to HoloLens 2. The connection is made using standard

Wi-Fi. Holographic Remoting is added to a desktop or UWP app via a NuGet packet. Additional code is required

which handles the connection and renders in an immersive view. A typical remoting connection will have as low

as 50 ms of latency. The player app can report the latency in real time.

All code on this page and working projects can be found in the Holographic Remoting samples github

repository.

A good starting point is a working OpenXR based Desktop or UWP app. For details see Getting started with

OpenXR.

Any app using Holographic Remoting should be authored to use a multi-threaded apartment. The use of a single-

threaded apartment is supported but will lead to sub-optimal performance and possibly stuttering during playback.

When using C++/WinRT winrt::init_apartment a multi-threaded apartment is the default.

The following steps are required to add the NuGet package to a project in Visual Studio.

1. Open the project in Visual Studio.

2. Right-click the project node and select Manage NuGet Packages...Manage NuGet Packages...

3. In the panel that appears, select BrowseBrowse and then search for "Holographic Remoting".

4. Select Microsoft.Holographic.Remoting.OpenXrMicrosoft.Holographic.Remoting.OpenXr , then ensure that the latest 2 .x.x2.x.x version is selected, and

then select InstallInstall .

5. If the PreviewPreview  dialog appears, select OKOK.

6. Select I AcceptI Accept when the license agreement dialog pops up.

7. Repeat the steps 3 to 6 for the following NuGet Packages: OpenXR.Headers, OpenXR.Loader

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/holographic-remoting-create-remote-openxr.md
https://github.com/microsoft/MixedReality-HolographicRemoting-Samples
https://docs.microsoft.com/en-us/windows/win32/com/multithreaded-apartments
https://docs.microsoft.com/en-us/windows/win32/com/single-threaded-apartments
https://docs.microsoft.com/en-us/windows/uwp/cpp-and-winrt-apis/get-started
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 Select the Holographic Remoting OpenXR runtime

bool EnableRemotingXR() {
    wchar_t executablePath[MAX_PATH];
    if (GetModuleFileNameW(NULL, executablePath, ARRAYSIZE(executablePath)) == 0) {
        return false;
    }
    
    std::filesystem::path filename(executablePath);
    filename = filename.replace_filename("RemotingXR.json");

    if (std::filesystem::exists(filename)) {
        SetEnvironmentVariableW(L"XR_RUNTIME_JSON", filename.c_str());
            return true;
        }

    return false;
}

 Create XrInstance with Holographic Remoting Extension

TIPTIP

IMPORTANTIMPORTANT

 Connect to the device

Version 1.x.x1.x.x of the NuGet package is still available for developers who want to target HoloLens 1. For details see Add

Holographic Remoting (HoloLens (1st gen)).

The first step you need to do in your remote app is to select the Holographic Remoting OpenXR runtime, which

is part of the Microsoft.Holographic.Remoting.OpenXr NuGet package. You can do this by setting the 

XR_RUNTIME_JSON  environment variable to the path of the RemotingXR.json file within your app. This

environment variable is used by the OpenXR loader to not use the system default OpenXR runtime but instead

redirect to the Holographic Remoting OpenXR runtime. When using the

Microsoft.Holographic.Remoting.OpenXr NuGet package the RemotingXR.json file is automatically copied during

compilation to the output folder, the OpenXR runtime selection typically looks as follows.

The first actions a typical OpenXR app should take are select OpenXR extensions and create an XrInstance. The

OpenXR core specification doesn't provide any remoting specific API. For that reason, Holographic Remoting

introduces its own OpenXR extension named XR_MSFT_holographic_remoting . Ensure that 

XR_MSFT_HOLOGRAPHIC_REMOTING_EXTENSION_NAME  is included in the XrInstanceCreateInfo of the xrCreateInstance call.

By default the rendered content of your app is only streamed to the Holographic Remoting player either running on a

HoloLens 2 or on a Windows Mixed Reality headsets. To also display the rendered content on the remote PC, via a swap-

chain of a window for instance, Holographic Remoting provides a second OpenXR extension named 

XR_MSFT_holographic_remoting_frame_mirroring . Ensure to also enable this extension using 

XR_MSFT_HOLOGRAPHIC_REMOTING_FRAME_MIRRORING_EXTENSION_NAME  in case you want to use that functionality.

To learn about the Holographic Remoting OpenXR extension API, check out the specification which can be found in the

Holographic Remoting samples github repository.

https://htmlpreview.github.io/?https://github.com/microsoft/MixedReality-HolographicRemoting-Samples/blob/main/remote_openxr/specification.html
https://github.com/microsoft/MixedReality-HolographicRemoting-Samples


WARNINGWARNING

XrRemotingRemoteContextPropertiesMSFT contextProperties;
contextProperties = XrRemotingRemoteContextPropertiesMSFT{static_cast<XrStructureType>
(XR_TYPE_REMOTING_REMOTE_CONTEXT_PROPERTIES_MSFT)};
contextProperties.enableAudio = false;
contextProperties.maxBitrateKbps = 20000;
contextProperties.videoCodec = XR_REMOTING_VIDEO_CODEC_H265_MSFT;
contextProperties.depthBufferStreamResolution = XR_REMOTING_DEPTH_BUFFER_STREAM_RESOLUTION_HALF_MSFT;
xrRemotingSetContextPropertiesMSFT(m_instance.Get(), m_systemId, &contextProperties);

XrRemotingConnectInfoMSFT connectInfo{static_cast<XrStructureType>(XR_TYPE_REMOTING_CONNECT_INFO_MSFT)};
connectInfo.remoteHostName = "192.168.x.x";
connectInfo.remotePort = 8265;
connectInfo.secureConnection = false;
xrRemotingConnectMSFT(m_instance.Get(), m_systemId, &connectInfo);

XrRemotingListenInfoMSFT listenInfo{static_cast<XrStructureType>(XR_TYPE_REMOTING_LISTEN_INFO_MSFT)};
listenInfo.listenInterface = "0.0.0.0";
listenInfo.handshakeListenPort = 8265;
listenInfo.transportListenPort = 8266;
listenInfo.secureConnection = false;
xrRemotingListenMSFT(m_instance.Get(), m_systemId, &listenInfo);

After your remote app has created the XrInstance and queried the XrSystemId via xrGetSystem, a connection to

the player device can be established.

The Holographic Remoting OpenXR runtime is only able to provide device specific data such as view configurations or

environment blend modes after a connection has been established. xrEnumerateViewConfigurations , 

xrEnumerateViewConfigurationViews , xrGetViewConfigurationProperties , xrEnumerateEnvironmentBlendModes ,

and xrGetSystemProperties  will give you default values, matching what you would typically get if you connect to a

player running on a HoloLens 2, before being fully connected. It is strongly recommended to not call these methods

before a connection has been established. The suggestion is used these methods after the XrSession has been successfully

created and the session state is at least XR_SESSION_STATE_READY.

General properties such as max bitrate, audio enabled, video codec, or depth buffer stream resolution can be

configured via xrRemotingSetContextPropertiesMSFT  as follows.

The connection can be done in one of two ways.

1. The remote app connects to the player running on the device.

2. The player running on the device connects to the remote app.

To establish a connection from the remote app to the player device, call the xrRemotingConnectMSFT  method

specifying the hostname and port via the XrRemotingConnectInfoMSFT  structure. The port used by the

Holographic Remoting Player is 82658265 .

Listening for incoming connections on the remote app can be done by calling the xrRemotingListenMSFT

method. Both the handshake port and transport port can be specified via the XrRemotingListenInfoMSFT

structure. The handshake port is used for the initial handshake. The data is then sent over the transport port. By

default 82658265  and 82668266  are used.

The connection state must be disconnected when you call xrRemotingConnectMSFT  or xrRemotingListenMSFT . You

can get the connection state at any point after you have created an XrInstance and queried for the XrSystemId

via xrRemotingGetConnectionStateMSFT .



XrRemotingConnectionStateMSFT connectionState;
xrRemotingGetConnectionStateMSFT(m_instance.Get(), m_systemId, &connectionState, nullptr);

IMPORTANTIMPORTANT

 Handling Remoting specific events

Available connection states are:

XR_REMOTING_CONNECTION_STATE_DISCONNECTED_MSFT

XR_REMOTING_CONNECTION_STATE_CONNECTING_MSFT

XR_REMOTING_CONNECTION_STATE_CONNECTED_MSFT

xrRemotingConnectMSFT  or xrRemotingListenMSFT  must be called before trying to create a XrSession via

xrCreateSession. If you try to create a XrSession while the connection state is 

XR_REMOTING_CONNECTION_STATE_DISCONNECTED_MSFT  the session creation will succeed but the session state will

immediately transition to XR_SESSION_STATE_LOSS_PENDING.

Holographic Remoting's implementation of xrCreateSession  supports waiting for a connection to be

established. You can call xrRemotingConnectMSFT  or xrRemotingListenMSFT  immediately followed by a call to,

which will block and wait for a connection to be established. The timeout is fixed to 10 seconds. If a connection

can be established within this time, the XrSession creation will succeed and the session state will transition to

XR_SESSION_STATE_READY. In case no connection can be established the session creation also succeeds but

immediately transitions to XR_SESSION_STATE_LOSS_PENDING.

In general, the connection state is couple with the XrSession state. Any change to the connection state also

affects the session state. For instance, if the connection state switches from 

XR_REMOTING_CONNECTION_STATE_CONNECTED_MSFT  to XR_REMOTING_CONNECTION_STATE_DISCONNECTED_MSFT  the session

state will transition to XR_SESSION_STATE_LOSS_PENDING as well.

The Holographic Remoting OpenXR runtime exposes three events, which are important to monitor the state of a

connection.

1. XR_TYPE_REMOTING_EVENT_DATA_CONNECTED_MSFT : Triggered when a connection to the device has been

successfully established.

2. XR_TYPE_REMOTING_EVENT_DATA_DISCONNECTED_MSFT : Triggered if an established connection is closed or a

connection couldn't be established.

3. XR_TYPE_REMOTING_EVENT_DATA_LISTENING_MSFT : When listening for incoming connections starts.

These events are placed in a queue and your remote app must read from the queue with regularity via 

xrPollEvent .



auto pollEvent = [&](XrEventDataBuffer& eventData) -> bool {
 eventData.type = XR_TYPE_EVENT_DATA_BUFFER;
 eventData.next = nullptr;
 return CHECK_XRCMD(xrPollEvent(m_instance.Get(), &eventData)) == XR_SUCCESS;
};

XrEventDataBuffer eventData{};
while (pollEvent(eventData)) {
 switch (eventData.type) {
 
 ...
 
 case XR_TYPE_REMOTING_EVENT_DATA_LISTENING_MSFT: {
  DEBUG_PRINT("Holographic Remoting: Listening on port %d",
     reinterpret_cast<const XrRemotingEventDataListeningMSFT*>(&eventData)->listeningPort);
  break;
 }
 case XR_TYPE_REMOTING_EVENT_DATA_CONNECTED_MSFT: {
  DEBUG_PRINT("Holographic Remoting: Connected.");
  break;
 }
 case XR_TYPE_REMOTING_EVENT_DATA_DISCONNECTED_MSFT: {
  DEBUG_PRINT("Holographic Remoting: Disconnected - Reason: %d",
     reinterpret_cast<const XrRemotingEventDataDisconnectedMSFT*>(&eventData)->disconnectReason);
  break;
 }
}

 Preview streamed content locally

XrFrameEndInfo frameEndInfo{XR_TYPE_FRAME_END_INFO};
...

XrRemotingFrameMirrorImageD3D11MSFT mirrorImageD3D11{
    static_cast<XrStructureType>(XR_TYPE_REMOTING_FRAME_MIRROR_IMAGE_D3D11_MSFT)};
mirrorImageD3D11.texture = m_window->GetNextSwapchainTexture();

XrRemotingFrameMirrorImageInfoMSFT mirrorImageEndInfo{
    static_cast<XrStructureType>(XR_TYPE_REMOTING_FRAME_MIRROR_IMAGE_INFO_MSFT)};
mirrorImageEndInfo.image = reinterpret_cast<const XrRemotingFrameMirrorImageBaseHeaderMSFT*>
(&mirrorImageD3D11);

frameEndInfo.next = &mirrorImageEndInfo;

xrEndFrame(m_session.Get(), &frameEndInfo);

m_window->PresentSwapchain();

 Optional: Custom data channels

To display the same content in the remote app that is sent to the device the 

XR_MSFT_holographic_remoting_frame_mirroring  extension can be used. With this extension, you can submit a

texture to xrEndFrame by using the XrRemotingFrameMirrorImageInfoMSFT  that isn't chained to the

XrFrameEndInfo as follows.

The example above uses a DX11 swap chain texture and presents the window immediately after the call to

xrEndFrame. The usage isn't restricted to swap chain textures. Furthermore, no additional GPU synchronization

is required. For details on usage and constraints, check out the extension specification. If your remote app is

using DX12, use XrRemotingFrameMirrorImageD3D12MSFT instead of

XrRemotingFrameMirrorImageD3D11MSFT.

https://htmlpreview.github.io/?https://github.com/microsoft/MixedReality-HolographicRemoting-Samples/blob/main/remote_openxr/specification.html#XR_MSFT_remoting_frame_mirroring


 Optional: Speech

NOTENOTE

NOTENOTE

 Optional: Coordinate System Synchronization

 See Also

Starting with version 2.5.0, custom data channels can be used with the OpenXR API to send user data over the

already-established remoting connection. For more information, see Custom Data Channels with the OpenXR

API.

Starting with version 2.6.0, the XR_MSFT_holographic_remoting_speech  extension allows the remote app to react to

speech commands detected by the player app with the OpenXR API.

[!IMPORTANT] The detailed specification can be found in the Holographic Remoting samples github

repository.

To initialize a speech recognizer on the player app, the remote app can call xrInitializeRemotingSpeechMSFT . This

call transmits speech initialization parameters, which consist of a language, a dictionary of phrases, and the

contents of a grammar file, to the player app.

Before version 2.6.1 the speech recognizer must only be initialized once per XrSession .

If the creation of the speech recognizer succeeded, as indicated by the 

XR_TYPE_EVENT_DATA_REMOTING_SPEECH_RECOGNIZER_STATE_CHANGED_MSFT  event, the remote app will be notified when a

speech recognition result was generated on the player app. The 

XrEventDataRemotingSpeechRecognizerStateChangedMSFT  event structure is placed in the event queue when the

state of the speech recognizer on the player side changes.

XrRemotingSpeechRecognizerStateMSFT  defines all possible states of the speech recognizer on the player side and

the XrEventDataRemotingSpeechRecognizedMSFT  event structure is placed in the event queue if the speech

recognizer on the player side has a recognized phrase. After the remote app is notified about a recognized

phrase, it can retrieve the recognized phrase by calling xrRetrieveRemotingSpeechRecognizedTextMSFT .

The XrRemotingSpeechRecognitionConfidenceMSFT  is a direct mapping of the SpeechRecognitionConfidence enum

returned with the speech recognition result by the Windows Speech Recognition API.

Starting with version 2.7.0, coordinate system synchronization can be used to align spatial data between the

player and remote app. For more information, see Coordinate System Synchronization with Holographic

Remoting Overview.

Holographic Remoting overview

Writing a custom Holographic Remoting player app

Establishing a secure connection with Holographic Remoting

Holographic Remoting troubleshooting and limitations

Holographic Remoting software license terms

Microsoft Privacy Statement

https://htmlpreview.github.io/?https://github.com/microsoft/MixedReality-HolographicRemoting-Samples/blob/main/remote_openxr/specification.html
https://github.com/microsoft/MixedReality-HolographicRemoting-Samples
https://docs.microsoft.com/en-us/uwp/api/windows.media.speechrecognition.speechrecognitionconfidence
https://docs.microsoft.com/en-us/legal/mixed-reality/microsoft-holographic-remoting-software-license-terms
https://go.microsoft.com/fwlink/?LinkId=521839
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 Create a Custom Data Channel

XrRemotingDataChannelMSFT m_userDataChannel;

XrRemotingDataChannelCreateInfoMSFT channelInfo{static_cast<XrStructureType>
(XR_TYPE_REMOTING_DATA_CHANNEL_CREATE_INFO_MSFT)};
channelInfo.channelId = 0;
channelInfo.channelPriority = XR_REMOTING_DATA_CHANNEL_PRIORITY_LOW_MSFT;
CHECK_XRCMD(m_extensions.xrCreateRemotingDataChannelMSFT(m_instance.Get(), m_systemId, &channelInfo, 
&m_userDataChannel));

Use custom data channels to send custom data over an established remoting connection.

Custom data channels require a custom remote app and a custom player app. This allows communication between the

two custom apps.

A simple ping-pong example can be found in the remote and player samples inside the Holographic Remoting samples

github repository. Uncomment #define ENABLE_CUSTOM_DATA_CHANNEL_SAMPLE  inside the OpenXrProgramm.cpp and

SamplePlayerMain.h files to enable the sample code.

The detailed specification can be found in the Holographic Remoting samples github repository.

A custom data channel is defined by the XrRemotingDataChannelMSFT  handle:

After a connection is successfully established, new data channels can be created via the 

xrCreateRemotingDataChannelMSFT  function:

Custom data channels can be created from the player and the remote application even if the runtimes are

different. If a data channel is created by the player side, the remote side is notified with the 

XrEventDataRemotingDataChannelCreatedMSFT  event structure:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/holographic-remoting-custom-data-channels-openxr.md
https://github.com/microsoft/MixedReality-HolographicRemoting-Samples
https://htmlpreview.github.io/?https://github.com/microsoft/MixedReality-HolographicRemoting-Samples/blob/main/remote_openxr/specification.html
https://github.com/microsoft/MixedReality-HolographicRemoting-Samples


XrEventDataBuffer eventData{};
while (pollEvent(eventData)) 
{
    switch (eventData.type) 
    {
        case XR_TYPE_EVENT_DATA_REMOTING_DATA_CHANNEL_CREATED_MSFT: 
        {
            auto channelCreatedEventData = reinterpret_cast<const 
XrEventDataRemotingDataChannelCreatedMSFT*>(&eventData);
            m_userDataChannel = channelCreatedEventData->channel;
            break;
        }
    }
}

 Get the Channel State

XrRemotingDataChannelStateMSFT channelState{static_cast<XrStructureType>
(XR_TYPE_REMOTING_DATA_CHANNEL_STATE_MSFT)};
CHECK_XRCMD(m_extensions.xrGetRemotingDataChannelStateMSFT(m_userDataChannel, &channelState));

 Send Data

if (channelState.connectionStatus == XR_REMOTING_DATA_CHANNEL_STATUS_OPENED_MSFT) {
    // Only send the packet if the send queue is smaller than 1MiB
    if (channelState.sendQueueSize >= 1 * 1024 * 1024) {
        return;
    }
    uint8_t data[] = {1};

    XrRemotingDataChannelSendDataInfoMSFT sendInfo{
        static_cast<XrStructureType>(XR_TYPE_REMOTING_DATA_CHANNEL_SEND_DATA_INFO_MSFT)};
    sendInfo.data = data;
    sendInfo.size = sizeof(data);
    sendInfo.guaranteedDelivery = true;
    CHECK_XRCMD(m_extensions.xrSendRemotingDataMSFT(m_userDataChannel, &sendInfo));
}

NOTENOTE

 Retrieve Data

The initial XrRemotingDataChannelStatusMSFT  state after calling xrCreateRemotingDataChannelMSFT  is 

XR_REMOTING_DATA_CHANNEL_STATUS_OPEN_PENDING_MSFT . Once the data channel has been fully established, the

channel`s state switches to XR_REMOTING_DATA_CHANNEL_STATUS_OPENED_MSFT . The 

XrEventDataRemotingDataChannelOpenedMSFT  event structure is placed in the event queue when the state of a

previously created data channel switches from XR_REMOTING_DATA_CHANNEL_STATUS_OPEN_PENDING_MSFT  to 

XR_REMOTING_DATA_CHANNEL_STATUS_OPENED_MSFT .

The xrGetRemotingDataChannelStateMSFT  function can be used to query the data channel state:

If the channel is open the xrSendRemotingDataMSFT  function is used to send data to the player side:

The data you send over a custom data channel shares the bandwidth with other data channels Holographic Remoting

uses.



XrEventDataBuffer eventData{};
while (pollEvent(eventData)) 
{
    switch (eventData.type) 
    {
        case XR_TYPE_EVENT_DATA_REMOTING_DATA_CHANNEL_DATA_RECEIVED_MSFT: 
        {
            auto dataReceivedEventData = reinterpret_cast<const 
XrEventDataRemotingDataChannelDataReceivedMSFT*>(&eventData);
            std::vector<uint8_t> packet(dataReceivedEventData->size);
            uint32_t dataBytesCount;
            CHECK_XRCMD(m_extensions.xrRetrieveRemotingDataMSFT(dataReceivedEventData->channel,
                                                                dataReceivedEventData->packetId,
                                                                static_cast<uint32_t>(packet.size()),
                                                                &dataBytesCount,
                                                                packet.data()));
            break;
        }
    }
}

 Destroy a Data Channel

CHECK_XRCMD(m_extensions.xrDestroyRemotingDataChannelMSFT(m_userDataChannel));

 See Also

Every time data arrives via a data channel, an XrEventDataRemotingDataChannelDataReceivedMSFT  event structure is

placed into the event queue. Received packets can be retrieved with the xrRetrieveRemotingDataMSFT  function:

You can destroy a data channel with xrDestroyRemotingDataChannelMSFT :

The XrRemotingDataChannelMSFT  handle is invalid after the xrDestroyRemotingDataChannelMSFT  call and the data

channel handle must not be used afterwards.

The XrEventDataRemotingDataChannelClosedMSFT  will be placed in the event queue in case the player side closes or

destroys the data channel. The data channel state switches to XR_REMOTING_DATA_CHANNEL_STATUS_CLOSED_MSFT . For

a closed data channel, the XrRemotingDataChannelMSFT  handle remains valid.

Holographic Remoting Overview

Writing a Holographic Remoting remote app using OpenXR APIs
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 Holographic Remoting security

IMPORTANTIMPORTANT

NOTENOTE

 Planning the security implementation

If you're new to Holographic Remoting, you may want to read our overview.

This guidance is specific to Holographic Remoting on HoloLens 2 and Windows PCs running Windows Mixed Reality.

This page gives you an overview of network security for Holographic Remoting. You'll find information about:

Security in the context of Holographic Remoting and why you might need it

Recommended measures based on different use cases

Holographic Remoting exchanges information over a network. If no security measures are in place, adversaries

on the same network may compromise the integrity of the communication or access confidential information.

The sample apps and the Holographic Remoting Player in the Windows Store come with security disabled.

Doing so makes the samples easier to understand. It also helps you to get started more quickly with

development.

For field testing or production, we strongly recommend enabling security in your Holographic Remoting

solution.

Security in Holographic Remoting, when set up correctly for your use case, gives you the following guarantees:

Authenticity:Authenticity: both player and remote app can be sure the other side is who they claim to be

Confidentiality:Confidentiality: no third party can read the information exchanged between player and remote app

Integrity:Integrity: player and remote can detect any in-transit changes to their communication

To be able to use security features, you will need to implement both a custom player and a custom remote app using

either Windows Mixed Reality or OpenXR APIs.

Starting with version 2.4.0 remote apps using the OpenXR API can be created. An overview on how to establish a secure

connection in an OpenXR environment can be found here.

When you enable security in Holographic Remoting, the remoting library will automatically enable encryption

and integrity checks for all data exchanged over the network.

Ensuring proper authentication requires some extra work though. What exactly you need to do depends on your

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/holographic-remoting-secure-connection.md


IMPORTANTIMPORTANT
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  Planning the server-to-client authenticationPlanning the server-to-client authentication

  Planning the client-to-server authenticationPlanning the client-to-server authentication

use case, and the rest of this section is about figuring out the necessary steps.

This article can only provide general guidance. If you feel unsure, consider consulting a security expert that can give you

guidance specific to your use case.

First some terminology: when describing network connections, the terms client and server will be used. The

server is the side listening for incoming connections on a known endpoint address, and the client is the one

connecting to the server's endpoint.

The client and and server roles are not tied to whether an app is acting as a player or as a remote. While the samples

have the player in the server role, it's easy to reverse the roles if it better fits your use case.

The server uses digital certificates to prove its identity to the client. The client validates the server's certificate

during the connection handshake phase. If the client doesn't trust the server, it will end the connection at this

point.

How the client validates the server certificate, and what kinds of server certificates can be used, depends on

your use case.

Use case 1:Use case 1: The server hostname isn't fixed, or the server isn't addressed by host name at all.

In this use case, it isn't practical (or even possible) to issue a certificate for the server's host name. We

recommendation you validate the certificate's thumbprint instead. Like a human fingerprint, the thumbprint

uniquely identifies a certificate.

It's important to communicate the thumbprint to the client out-of-band. That means, you can't send it over the

same network connection that's used for remoting. Instead, you could manually enter it into the client's

configuration, or to have the client scan a QR code.

Use case 2:Use case 2: The server can be reached over a stable host name.

In this use case, the server has a specific host name, and you know this name isn't likely to change. You can then

use a certificate issued to the server's host name. Trust will be established based on the host name and the

certificate's chain of trust.

If you choose this option, the client needs to know the server's host name and the root certificate in advance.

Clients authenticate against the server using a free-form token. What this token should contain will again

depend on your use case:

Use case 1:Use case 1: You only need to verify the client app's identity.

In this use case, a shared secret can be sufficient. This secret must be complex enough that it can't be guessed.

A good shared secret is a random GUID, which is manually entered in both the server's and client's

configuration. To create one you can, for example, use the New-Guid  command in PowerShell.

Make sure this shared secret is never communicated over insecure channels. The remoting library ensures that

the shared secret is always sent encrypted, and only to trusted peers.

Use case 2:Use case 2: You also need to verify the identity of the client app's user.



 See Also

A shared secret won't be enough to cover this use case. Instead, you can use tokens created by an identity

provider. An authentication workflow using an identity provider would look like this:

The client authorizes against the identity provider and requests a token

The identity provider generates a token and sends it to the client

The client sends this token to the server through Holographic Remoting

The server validates the client's token against the identity provider

One example of an identity provider is the Microsoft identity platform.

Like in the previous use case, make sure these tokens aren't sent through insecure channels or otherwise

exposed.

Holographic Remoting Overview

Secure Connection with the OpenXR API

Secure Connection with the Windows Mixed Reality API

https://docs.microsoft.com/en-us/azure/active-directory/develop/
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When using the OpenXR API, all secure connection-related API is available as part of the 

XR_MSFT_holographic_remoting  OpenXR extension.

To learn about the Holographic Remoting OpenXR extension API, check out the specification which can be found in the

Holographic Remoting samples github repository.

Remember that you need to implement custom remote and player apps if you want to enable connection

security. Both of the custom apps need:

A certificate provider and an authentication validator if the app runs as the server.

An authentication provider and a certificate validator if the app runs as the client.

The OpenXR API is similar to the Windows Mixed Reality API described here. However, instead of implementing

interfaces, the key elements for secure connection using the XR_MSFT_holographic_remoting  OpenXR extension

are the following callbacks:

xrRemotingRequestAuthenticationTokenCallbackMSFT , generates, or retrieves the authentication token to be

sent.

xrRemotingValidateServerCertificateCallbackMSFT , validates the certificate chain.

xrRemotingValidateAuthenticationTokenCallbackMSFT , validates the client authentication token.

xrRemotingRequestServerCertificateCallbackMSFT , supply the server application with the certificate to use.

With Holographic Remoting it is possible that either the Player or the Remote is the server depending on your needs (For

more information, see Holographic Remoting Terminology). If your custom remote or custom player application can run as

client and server the app has to provide all four callbacks.

The callbacks can be provided to the remoting OpenXR runtime via 

xrRemotingSetSecureConnectionClientCallbacksMSFT  and xrRemotingSetSecureConnectionServerCallbacksMSFT . In

order to do so, you can create static functions for the callbacks:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/holographic-remoting-secure-connection-openxr.md
https://htmlpreview.github.io/?https://github.com/microsoft/MixedReality-HolographicRemoting-Samples/blob/main/remote_openxr/specification.html
https://github.com/microsoft/MixedReality-HolographicRemoting-Samples


class SecureConnectionCallbacks {
public:
    ...

    // Static callbacks
    static XrResult XRAPI_CALL
    RequestAuthenticationTokenStaticCallback(XrRemotingAuthenticationTokenRequestMSFT* 
authenticationTokenRequest) {
        if (!authenticationTokenRequest->context) {
            return XR_ERROR_RUNTIME_FAILURE;
        }
        return reinterpret_cast<SecureConnectionCallbacks*>(authenticationTokenRequest->context)
            ->RequestAuthenticationToken(authenticationTokenRequest);
    }

    static XrResult XRAPI_CALL
    ValidateServerCertificateStaticCallback(XrRemotingServerCertificateValidationMSFT* 
serverCertificateValidation) {
        if (!serverCertificateValidation->context) {
            return XR_ERROR_RUNTIME_FAILURE;
        }
        return reinterpret_cast<SecureConnectionCallbacks*>(serverCertificateValidation->context)
            ->ValidateServerCertificate(serverCertificateValidation);
    }

    static XrResult XRAPI_CALL
    ValidateAuthenticationTokenStaticCallback(XrRemotingAuthenticationTokenValidationMSFT* 
authenticationTokenValidation) {
        if (!authenticationTokenValidation->context) {
            return XR_ERROR_RUNTIME_FAILURE;
        }
        return reinterpret_cast<SecureConnectionCallbacks*>(authenticationTokenValidation->context)
            ->ValidateAuthenticationToken(authenticationTokenValidation);
    }

    static XrResult XRAPI_CALL
    RequestServerCertificateStaticCallback(XrRemotingServerCertificateRequestMSFT* serverCertificateRequest) 
{
        if (!serverCertificateRequest->context) {
            return XR_ERROR_RUNTIME_FAILURE;
        }
        return reinterpret_cast<SecureConnectionCallbacks*>(serverCertificateRequest->context)
            ->RequestServerCertificate(serverCertificateRequest);
    }
}

The static callback functions all look similar and in the example above they just call a function on the context

object, which is set in xrRemotingSetSecureConnectionClientCallbacksMSFT  or 

xrRemotingSetSecureConnectionServerCallbacksMSFT . The actual implementation of the callbacks is then done

inside the member functions of the context object:



class SecureConnectionCallbacks {   
    ...

private:
    // The client has to provide a token and has to validate the certificate.
    XrResult RequestAuthenticationToken(XrRemotingAuthenticationTokenRequestMSFT* 
authenticationTokenRequest) {
        // To provide a token fill out the authenticationTokenRequest with your token.
    }
    XrResult ValidateServerCertificate(XrRemotingServerCertificateValidationMSFT* 
serverCertificateValidation) {
        // Validate the certificate.
    }

    // The server has to provide a certificate and hast to validate the token.
    XrResult ValidateAuthenticationToken(XrRemotingAuthenticationTokenValidationMSFT* 
authenticationTokenValidation) {
        // Validate the token.
    }
    XrResult RequestServerCertificate(XrRemotingServerCertificateRequestMSFT* serverCertificateRequest) {
        // To provide a certificate fill out the serverCertificateRequest with your certificate.
    }
}

Now you can provide the callbacks to xrRemotingSetSecureConnectionClientCallbacksMSFT  and 

xrRemotingSetSecureConnectionServerCallbacksMSFT . Additionally, the secure connection needs to be enabled via

the secureConnection parameter on the XrRemotingConnectInfoMSFT  structure or the XrRemotingListenInfoMSFT

structure depending on whether you're using xrRemotingConnectMSFT  or xrRemotingListenMSFT :



...

SecureConnectionCallbacks callbackObject;

...

if (client) 
{
    XrRemotingSecureConnectionClientCallbacksMSFT clientCallbacks{static_cast<XrStructureType>
(XR_TYPE_REMOTING_SECURE_CONNECTION_CLIENT_CALLBACKS_MSFT);
    clientCallbacks.context = &callbackObject;
    clientCallbacks.requestAuthenticationTokenCallback = 
SecureConnectionCallbacks::RequestAuthenticationTokenStaticCallback;
    clientCallbacks.validateServerCertificateCallback = 
SecureConnectionCallbacks::ValidateServerCertificateStaticCallback;
    clientCallbacks.performSystemValidation = true;
    CHECK_XRCMD(m_extensions.xrRemotingSetSecureConnectionClientCallbacksMSFT(m_instance.Get(), m_systemId, 
&clientCallbacks));
    
    ...

    connectInfo.secureConnection = true; // Enable secure connection!
    CHECK_XRCMD(m_extensions.xrRemotingConnectMSFT(m_instance.Get(), m_systemId, &connectInfo));
}

if (server) 
{
    XrRemotingSecureConnectionServerCallbacksMSFT serverCallbacks{static_cast<XrStructureType>
(XR_TYPE_REMOTING_SECURE_CONNECTION_SERVER_CALLBACKS_MSFT);
    serverCallbacks.context = &callbackObject;
    serverCallbacks.requestServerCertificateCallback = 
SecureConnectionCallbacks::RequestServerCertificateStaticCallback;
    serverCallbacks.validateAuthenticationTokenCallback = 
SecureConnectionCallbacks::ValidateAuthenticationTokenStaticCallback;
    serverCallbacks.authenticationRealm = /*YourAuthenticationRealm*/;
    CHECK_XRCMD(m_extensions.xrRemotingSetSecureConnectionServerCallbacksMSFT(m_instance.Get(), m_systemId, 
&serverCallbacks));

    ...

    listenInfo.secureConnection = true; // Enable secure connection!
    CHECK_XRCMD(m_extensions.xrRemotingListenMSFT(m_instance.Get(), m_systemId, &listenInfo));
}

NOTENOTE

 See Also

You can find a detailed example in the OpenXR sample app.

Secure Connection with Holographic Remoting Overview

https://github.com/microsoft/MixedReality-HolographicRemoting-Samples
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NOTENOTE

 See Also

Starting with version 2.7.0, Holographic Remoting supports coordinate system synchronization.

Use coordinate system synchronization to synchronize spatial data between a custom player app and a custom

remote app. With coordinate system synchronization, it's possible to express spatial data within a common

space even across different player and remote runtimes.

An example for the coordinate system synchronization is to align content that was rendered by the player app

with the content rendered by the remote app. Furthermore, coordinate system synchronization allows the

custom remote app to correctly align sensor data from the player device. Sensor data can be retrieved, for

example, by HoloLens2ForCV.

In general, the coordinate system synchronization consists of two parts:

The player app sets and regularly updates the coordinate system (from now on, we refer to this coordinate

system as the "user coordinate system").

The remote app gets the user coordinate system in a runtime-dependent way. With the synchronized

coordinate system, both the player app and remote app can transform spatial data into a common

coordinate system.

Coordinate system synchronization supports only a single coordinate system. To synchronize data from multiple

coordinate systems, you can transform the data into the user coordinate system.

Coordinate System Synchronization with Holographic Remoting and the OpenXR API

Coordinate System Synchronization with Holographic Remoting and the Windows Mixed Reality API

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/holographic-remoting-coordinate-system-synchronization.md
https://github.com/microsoft/HoloLens2ForCV
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TIPTIP

IMPORTANTIMPORTANT

 Set and Update the User Coordinate System in the Player App

 Get the User Coordinate System in the Remote App

xr::SpaceHandle space;
XrReferenceSpaceCreateInfo createInfo{XR_TYPE_REFERENCE_SPACE_CREATE_INFO};
createInfo.referenceSpaceType = static_cast<XrReferenceSpaceType>
(XR_REMOTING_REFERENCE_SPACE_TYPE_USER_MSFT);
createInfo.poseInReferenceSpace = xr::math::Pose::Translation({0.0f, 0.0f, 0.0f});
CHECK_XRCMD(xrCreateReferenceSpace(m_session.Get(), &createInfo, space.Put()));

 See Also

With the OpenXR API, the user coordinate system is wrapped into a reference space of type 

XR_REMOTING_REFERENCE_SPACE_TYPE_USER_MSFT .

A simple example can be found in the remote and player samples inside the Holographic Remoting samples github

repository. Uncomment #define ENABLE_USER_COORDINATE_SYSTEM_SAMPLE  inside the OpenXrProgramm.cpp and

SamplePlayerMain.h files to enable the sample code.

To learn about the Holographic Remoting OpenXR extension API, check out the specification which can be found in the

Holographic Remoting samples github repository.

Holographic Remoting currently only supports writing a custom player with the Windows Mixed Reality API. A

player written with the Windows Mixed Reality API can be used with a OpenXR remote! Therefore, you have to

set the User Coordinate System from the Windows Mixed Reality player. For more information, see Coordinate

System Synchronization with Holographic Remoting and the Windows Mixed Reality API.

To create the user coordinate system in the remote app call xrCreateReferenceSpace  with the 

XR_REMOTING_REFERENCE_SPACE_TYPE_USER_MSFT  argument:

Coordinate System Synchronization with Holographic Remoting Overview

Coordinate System Synchronization with Holographic Remoting and the Windows Mixed Reality API

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/holographic-remoting-coordinate-system-synchronization-openxr.md
https://github.com/microsoft/MixedReality-HolographicRemoting-Samples
https://htmlpreview.github.io/?https://github.com/microsoft/MixedReality-HolographicRemoting-Samples/blob/main/remote_openxr/specification.html
https://github.com/microsoft/MixedReality-HolographicRemoting-Samples
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IMPORTANTIMPORTANT

 Prerequisites

IMPORTANTIMPORTANT

 Get the Holographic Remoting NuGet package

If you're new to Holographic Remoting, you may want to read our overview.

This document describes the creation of a remote application for HoloLens 2 using the HolographicSpace API. Remote

applications for HoloLens (1st gen)HoloLens (1st gen) must use NuGet package version 1.x.x1.x.x. This implies that remote applications

written for HoloLens 2 are not compatible with HoloLens 1 and vice versa. The documentation for HoloLens 1 can be

found here.

Holographic Remoting apps can stream remotely rendered content to HoloLens 2 and Windows Mixed Reality

immersive headsets. You can also access more system resources and integrate remote immersive views into

existing desktop PC software. A remote app receives an input data stream from HoloLens 2, renders content in a

virtual immersive view, and streams content frames back to HoloLens 2. The connection is made using standard

Wi-Fi. Holographic Remoting is added to a desktop or UWP app via a NuGet packet. Additional code is required

which handles the connection and renders in an immersive view. A typical remoting connection will have as low

as 50 ms of latency. The player app can report the latency in real time.

All code on this page and working projects can be found in the Holographic Remoting samples github

repository.

A good starting point is a working DirectX-based Desktop or UWP app that targets the Windows Mixed Reality

API. For details, see DirectX development overview. The C++ holographic project template is a good starting

point.

Any app using Holographic Remoting should be authored to use a multi-threaded apartment. The use of a single-

threaded apartment is supported but will lead to sub-optimal performance and possibly stuttering during playback.

When using C++/WinRT winrt::init_apartment a multi-threaded apartment is the default.

The following steps are required to add the NuGet package to a project in Visual Studio.

1. Open the project in Visual Studio.

2. Right-click the project node and select Manage NuGet Packages...Manage NuGet Packages...

3. In the panel that appears, select BrowseBrowse and then search for "Holographic Remoting".

4. Select Microsoft.Holographic.RemotingMicrosoft.Holographic.Remoting, ensure to pick the latest 2 .x.x2.x.x version and select InstallInstall .

5. If the PreviewPreview  dialog appears, select OKOK.

6. Select I AcceptI Accept when the license agreement dialog pops up.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/holographic-remoting-create-remote-wmr.md
https://github.com/microsoft/MixedReality-HolographicRemoting-Samples
https://docs.microsoft.com/en-us/windows/win32/com/multithreaded-apartments
https://docs.microsoft.com/en-us/windows/win32/com/single-threaded-apartments
https://docs.microsoft.com/en-us/windows/uwp/cpp-and-winrt-apis/get-started


NOTENOTE

 Create the remote context

// class declaration
#include <winrt/Microsoft.Holographic.AppRemoting.h>

...

private:
    // RemoteContext used to connect with a Holographic Remoting player and display rendered frames
    winrt::Microsoft::Holographic::AppRemoting::RemoteContext m_remoteContext = nullptr;

// class implementation
#include <HolographicAppRemoting\Streamer.h>

...

CreateRemoteContext(m_remoteContext, 20000, false, PreferredVideoCodec::Default);

WARNINGWARNING

m_holographicSpace = winrt::Windows::Graphics::Holographic::HolographicSpace::CreateForCoreWindow(nullptr);

 Connect to the device

Version 1.x.x1.x.x of the NuGet package is still available for developers who want to target HoloLens 1. For details see Add

Holographic Remoting (HoloLens (1st gen)).

As a first step the application should create a remote context.

Holographic Remoting works by replacing the Windows Mixed Reality runtime which is part of Windows with a remoting

specific runtime. This is done during the creation of the remote context. For that reason any call on any Windows Mixed

Reality API before creating the remote context can result in unexpected behavior. The recommended approach is to create

the remote context as early as possible before interaction with any Mixed Reality API. Never mix objects created or

retrieved through any Windows Mixed Reality API before the call to CreateRemoteContext with objects created or

retrieved afterwards.

Next the holographic space needs to be created. Specifying a CoreWindow isn't required. Desktop apps that

don't have a CoreWindow can just pass a nullptr .

When the remote app is ready for rendering content, a connection to the player device can be established.

Connection can be done in one of two ways.

1. The remote app connects to the player running on the device.

2. The player running on the device connects to the remote app.

To establish a connection from the remote app to the player device, call the Connect  method on the remote

context specifying the hostname and port. The port used by the Holographic Remoting Player is 82658265 .



try
{
    m_remoteContext.Connect(m_hostname, m_port);
}
catch(winrt::hresult_error& e)
{
    DebugLog(L"Connect failed with hr = 0x%08X", e.code());
}

IMPORTANTIMPORTANT

TIPTIP

try
{
    m_remoteContext.Listen(L"0.0.0.0", m_port, m_port + 1);
}
catch(winrt::hresult_error& e)
{
    DebugLog(L"Listen failed with hr = 0x%08X", e.code());
}

IMPORTANTIMPORTANT

 Handling Remoting specific events

winrt::weak_ref<winrt::Microsoft::Holographic::AppRemoting::IRemoteContext> remoteContextWeakRef = 
m_remoteContext;

m_onConnectedEventRevoker = m_remoteContext.OnConnected(winrt::auto_revoke, [this, remoteContextWeakRef]() {
    if (auto remoteContext = remoteContextWeakRef.get())
    {
        // Update UI state
    }
});

As with any C++/WinRT API Connect  might throw an winrt::hresult_error which needs to be handled.

To avoid using C++/WinRT language projection the file 

build\native\include\<windows sdk version>\abi\Microsoft.Holographic.AppRemoting.h  located inside the

Holographic Remoting NuGet package can be included. It contains declarations of the underlying COM interfaces. The use

of C++/WinRT is recommended though.

Listening for incoming connections on the remote app can be done by calling the Listen  method. Both the

handshake port and transport port can be specified during this call. The handshake port is used for the initial

handshake. The data is then sent over the transport port. By default 82658265  and 82668266  are used.

The build\native\include\HolographicAppRemoting\Microsoft.Holographic.AppRemoting.idl  inside the NuGet

package contains detailed documentation for the API exposed by Holographic Remoting.

The remote context exposes three events, which are important to monitor the state of a connection.

1. OnConnected: Triggered when a connection to the device has been successfully established.

https://docs.microsoft.com/en-us/windows/uwp/cpp-and-winrt-apis/


m_onDisconnectedEventRevoker =
    m_remoteContext.OnDisconnected(winrt::auto_revoke, [this, remoteContextWeakRef](ConnectionFailureReason 
failureReason) {
        if (auto remoteContext = remoteContextWeakRef.get())
        {
            DebugLog(L"Disconnected with reason %d", failureReason);
            // Update UI

            // Reconnect if this is a transient failure.
            if (failureReason == ConnectionFailureReason::HandshakeUnreachable ||
                failureReason == ConnectionFailureReason::TransportUnreachable ||
                failureReason == ConnectionFailureReason::ConnectionLost)
            {
                DebugLog(L"Reconnecting...");

                ConnectOrListen();
            }
            // Failure reason None indicates a normal disconnect.
            else if (failureReason != ConnectionFailureReason::None)
            {
                DebugLog(L"Disconnected with unrecoverable error, not attempting to reconnect.");
            }
        }
    });

m_onListeningEventRevoker = m_remoteContext.OnListening(winrt::auto_revoke, [this, remoteContextWeakRef]() {
    if (auto remoteContext = remoteContextWeakRef.get())
    {
        // Update UI state
    }
});

auto connectionState = m_remoteContext.ConnectionState();

 Handling speech events

winrt::Microsoft::Holographic::AppRemoting::IRemoteSpeech::OnRecognizedSpeech_revoker 
m_onRecognizedSpeechRevoker;

if (auto remoteSpeech = m_remoteContext.GetRemoteSpeech())
{
    InitializeSpeechAsync(remoteSpeech, m_onRecognizedSpeechRevoker, weak_from_this());
}

2. OnDisconnected: Triggered if an established connection is closed or a connection couldn't be established.

3. OnListening: When listening for incoming connections starts.

Additionally the connection state can be queried using the ConnectionState  property on the remote context.

Using the remote speech interface it's possible to register speech triggers with HoloLens 2 and have them

remoted to the remote application.

The following extra member is required to track the state of the remote speech:

First, retrieve the remote speech interface.



winrt::Windows::Foundation::IAsyncOperation<winrt::Windows::Storage::StorageFile> LoadGrammarFileAsync()
{
    const wchar_t* speechGrammarFile = L"SpeechGrammar.xml";
    auto rootFolder = winrt::Windows::ApplicationModel::Package::Current().InstalledLocation();
    return rootFolder.GetFileAsync(speechGrammarFile);
}

winrt::fire_and_forget InitializeSpeechAsync(
    winrt::Microsoft::Holographic::AppRemoting::IRemoteSpeech remoteSpeech,
    winrt::Microsoft::Holographic::AppRemoting::IRemoteSpeech::OnRecognizedSpeech_revoker& 
onRecognizedSpeechRevoker,
    std::weak_ptr<SampleRemoteMain> sampleRemoteMainWeak)
{
    onRecognizedSpeechRevoker = remoteSpeech.OnRecognizedSpeech(
        winrt::auto_revoke, [sampleRemoteMainWeak](const 
winrt::Microsoft::Holographic::AppRemoting::RecognizedSpeech& recognizedSpeech) {
            if (auto sampleRemoteMain = sampleRemoteMainWeak.lock())
            {
                sampleRemoteMain->OnRecognizedSpeech(recognizedSpeech.RecognizedText);
            }
        });

    auto grammarFile = co_await LoadGrammarFileAsync();

    std::vector<winrt::hstring> dictionary;
    dictionary.push_back(L"Red");
    dictionary.push_back(L"Blue");
    dictionary.push_back(L"Green");
    dictionary.push_back(L"Default");
    dictionary.push_back(L"Aquamarine");

    remoteSpeech.ApplyParameters(L"", grammarFile, dictionary);
}

Using an asynchronous helper method you can then initialize the remote speech. This should be done

asynchronously as initializing might take a considerable amount of time. Concurrency and asynchronous

operations with C++/WinRT explains how to author asynchronous functions with C++/WinRT.

There are two ways of specifying phrases to be recognized.

1. Specification inside a speech grammar xml file. See How to create a basic XML Grammar for details.

2. Specify by passing them inside the dictionary vector to ApplyParameters .

Inside the OnRecognizedSpeech callback, the speech events can then be processed:

https://docs.microsoft.com/en-us/windows/uwp/cpp-and-winrt-apis/concurrency
https://docs.microsoft.com/en-us/previous-versions/office/developer/speech-technologies/hh361658(v=office.14)


void SampleRemoteMain::OnRecognizedSpeech(const winrt::hstring& recognizedText)
{
    bool changedColor = false;
    DirectX::XMFLOAT4 color = {1, 1, 1, 1};

    if (recognizedText == L"Red")
    {
        color = {1, 0, 0, 1};
        changedColor = true;
    }
    else if (recognizedText == L"Blue")
    {
        color = {0, 0, 1, 1};
        changedColor = true;
    }
    else if (recognizedText == L"Green")
    {
        ...
    }

    ...
}

 Preview streamed content locally

#include <windows.graphics.directx.direct3d11.interop.h>

...

m_onSendFrameEventRevoker = m_remoteContext.OnSendFrame(
    winrt::auto_revoke, [this](const winrt::Windows::Graphics::DirectX::Direct3D11::IDirect3DSurface& 
texture) {
        winrt::com_ptr<ID3D11Texture2D> texturePtr;
        {
            winrt::com_ptr<ID3D11Resource> resource;
            winrt::com_ptr<::IInspectable> inspectable = texture.as<::IInspectable>();
            winrt::com_ptr<Windows::Graphics::DirectX::Direct3D11::IDirect3DDxgiInterfaceAccess> 
dxgiInterfaceAccess;
            winrt::check_hresult(inspectable->QueryInterface(__uuidof(dxgiInterfaceAccess), 
dxgiInterfaceAccess.put_void()));
            winrt::check_hresult(dxgiInterfaceAccess->GetInterface(__uuidof(resource), 
resource.put_void()));
            resource.as(texturePtr);
        }

        // Copy / blit texturePtr into the back buffer here.
    });

 Depth Reprojection

To display the same content in the remote app that is sent to the device the OnSendFrame  event of the remote

context can be used. The OnSendFrame  event is triggered every time the Holographic Remoting library sends the

current frame to the remote device. This is the ideal time to take the content and also blit it into the desktop or

UWP window.

Starting with version 2.1.0, Holographic Remoting supports Depth Reprojection. This requires both the color

buffer and depth buffer to be streamed from the Remote application to the HoloLens 2. By default depth buffer

streaming is enabled and configured to use half the resolution of the color buffer. This can be changed as

follows:



// class implementation
#include <HolographicAppRemoting\Streamer.h>

...

CreateRemoteContext(m_remoteContext, 20000, false, PreferredVideoCodec::Default);

// Configure for half-resolution depth.
m_remoteContext.ConfigureDepthVideoStream(DepthBufferStreamResolution::Half_Resolution);

void SampleRemoteMain::Render(HolographicFrame holographicFrame)
{
    ...

    m_deviceResources->UseHolographicCameraResources([this, holographicFrame](auto& cameraResourceMap) {
        
        ...

        for (auto cameraPose : prediction.CameraPoses())
        {
            DXHelper::CameraResources* pCameraResources = 
cameraResourceMap[cameraPose.HolographicCamera().Id()].get();

            ...

            m_deviceResources->UseD3DDeviceContext([&](ID3D11DeviceContext3* context) {
                
                ...

                // Commit depth buffer if available and enabled.
                if (m_canCommitDirect3D11DepthBuffer && m_commitDirect3D11DepthBuffer)
                {
                    auto interopSurface = pCameraResources->GetDepthStencilTextureInteropObject();
                    HolographicCameraRenderingParameters renderingParameters = 
holographicFrame.GetRenderingParameters(cameraPose);
                    renderingParameters.CommitDirect3D11DepthBuffer(interopSurface);
                }
            });
        }
    });
}

Note, if default values should not be used ConfigureDepthVideoStream  must be called before establishing a

connection to the HoloLens 2. The best place is right after you have created the remote context. Possible values

for DepthBufferStreamResolution are:

Full_Resolution

Half_Resolution

Quarter_Resolution

Disabled (added with version 2.1.3 and if used no additional depth video stream is created)

Keep in mind that using a full resolution depth buffer also affects bandwidth requirements and needs to be

accounted for in the maximum bandwidth value you provide to CreateRemoteContext .

Beside configuring the resolution, you also have to commit a depth buffer via

HolographicCameraRenderingParameters.CommitDirect3D11DepthBuffer.

To verify if depth reprojection is correctly working on HoloLens 2, you can enable a depth visualizer via the

https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamerarenderingparameters.commitdirect3d11depthbuffer#windows_graphics_holographic_holographiccamerarenderingparameters_commitdirect3d11depthbuffer_windows_graphics_directx_direct3d11_idirect3dsurface_


 Optional: Custom data channels

 Optional: Coordinate System Synchronization

 See Also

Device Portal. See Verifying Depth is Set Correctly for details.

Custom data channels can be used to send user data over the already-established remoting connection. For

more information, see Custom Data Channels.

Starting with version 2.7.0, coordinate system synchronization can be used to align spatial data between the

player and remote application. For more information, see Coordinate System Synchronization with Holographic

Remoting Overview.

Holographic Remoting Overview

Writing a custom Holographic Remoting player app

Custom Holographic Remoting data channels

Establishing a secure connection with Holographic Remoting

Holographic Remoting troubleshooting and limitations

Holographic Remoting software license terms

Microsoft Privacy Statement

https://docs.microsoft.com/en-us/legal/mixed-reality/microsoft-holographic-remoting-software-license-terms
https://go.microsoft.com/fwlink/?LinkId=521839
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IMPORTANTIMPORTANT

 Prerequisites

IMPORTANTIMPORTANT

 Get the Holographic Remoting NuGet package

If you're new to Holographic Remoting, you may want to read our overview.

This document describes the creation of a custom player application for HoloLens 2. Custom players written for HoloLens

2 are not compatible with remote applications written for HoloLens 1. This implies that both applications must use NuGet

package version 2.x.x2.x.x.

By creating a custom Holographic Remoting player app, you can create a custom application capable of

displaying immersive views from on a remote machine on your HoloLens 2. All code on this page and working

projects can be found in the Holographic Remoting samples github repository.

A Holographic Remoting player lets your app display holographic content rendered on a desktop PC or UWP

device like the Xbox One with access to more system resources. A Holographic Remoting player app streams

input data to a Holographic Remoting remote application and receives back an immersive view as video and

audio stream. The connection is made using standard Wi-Fi. To create a player app, use a NuGet package to add

Holographic Remoting to your UWP app. Then write code to handle the connection and to display an immersive

view.

A good starting point is a working DirectX based UWP app that already targets the Windows Mixed Reality API.

For details see DirectX development overview. If you don't have an existing app and want to start from scratch

the C++ holographic project template is a good starting point.

Any app using Holographic Remoting should be authored to use a multi-threaded apartment. The use of a single-

threaded apartment is supported but will lead to sub-optimal performance and possibly stuttering during playback.

When using C++/WinRT winrt::init_apartment a multi-threaded apartment is the default.

The following steps are required to add the NuGet package to a project in Visual Studio.

1. Open the project in Visual Studio.

2. Right-click the project node and select Manage NuGet Packages...Manage NuGet Packages...

3. In the panel that appears, select BrowseBrowse and then search for "Holographic Remoting".

4. Select Microsoft.Holographic.RemotingMicrosoft.Holographic.Remoting, ensure to pick the latest 2 .x.x2.x.x version and select InstallInstall .

5. If the PreviewPreview  dialog appears, select OKOK.

6. Select I AcceptI Accept when the license agreement dialog appears.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/holographic-remoting-create-player.md
https://github.com/microsoft/MixedReality-HolographicRemoting-Samples
https://docs.microsoft.com/en-us/windows/win32/com/multithreaded-apartments
https://docs.microsoft.com/en-us/windows/win32/com/single-threaded-apartments
https://docs.microsoft.com/en-us/windows/uwp/cpp-and-winrt-apis/get-started


IMPORTANTIMPORTANT

 Modify the Package.appxmanifest of the application

  </Capabilities>

  <!--Add lines below -->
  <Extensions>
    <Extension Category="windows.activatableClass.inProcessServer">
      <InProcessServer>
        <Path>Microsoft.Holographic.AppRemoting.dll</Path>
        <ActivatableClass ActivatableClassId="Microsoft.Holographic.AppRemoting.PlayerContext" 
ThreadingModel="both" />
      </InProcessServer>
    </Extension>
  </Extensions>
  <!--Add lines above -->

</Package>

 Create the player context

// class declaration:

#include <winrt/Microsoft.Holographic.AppRemoting.h>

...

private:
// PlayerContext used to connect with a Holographic Remoting remote app and display remotely rendered frames
winrt::Microsoft::Holographic::AppRemoting::PlayerContext m_playerContext = nullptr;

// class implementation:

// Create the player context
// IMPORTANT: This must be done before creating the HolographicSpace (or any other call to the Holographic 
API).
m_playerContext = winrt::Microsoft::Holographic::AppRemoting::PlayerContext::Create();

 The build\native\include\HolographicAppRemoting\Microsoft.Holographic.AppRemoting.idl  inside the NuGet

package contains detailed documentation for the API exposed by Holographic Remoting.

To make the application aware of the Microsoft.Holographic.AppRemoting.dll added by the NuGet package, the

following steps need to be taken on the project:

1. In the Solution Explorer, right-click the Package.appxmanifestPackage.appxmanifest file and select Open With...Open With...

2. Select XML (Text) EditorXML (Text) Editor  and select OKOK

3. Add the following lines to the file and save

As a first step the application should create a player context.



WARNINGWARNING

m_holographicSpace = winrt::Windows::Graphics::Holographic::HolographicSpace::CreateForCoreWindow(window);

 Connect to the remote app

try
{
    m_playerContext.Connect(m_hostname, m_port);
}
catch(winrt::hresult_error& e)
{
    // Failed to connect. Get an error details via e.code() and e.message()
}

IMPORTANTIMPORTANT

try
{
    m_playerContext.Listen(L"0.0.0.0", m_port, m_port + 1);
}
catch(winrt::hresult_error& e)
{
    // Failed to listen. Get an error details via e.code() and e.message()
}

 Handling connection-related events

Holographic Remoting works by replacing the Windows Mixed Reality runtime which is part of Windows with a remoting

specific runtime. This is done during the creation of the player context. For that reason any call on any Windows Mixed

Reality API before creating the player context can result in unexpected behavior. The recommended approach is to create

the player context as early as possible before interaction with any Mixed Reality API. Never mix objects created or

retrieved through any Windows Mixed Reality API before the call to PlayerContext::Create  with objects created or

retrieved afterwards.

Next the HolographicSpace can be created, by calling HolographicSpace.CreateForCoreWindow.

Once the player app is ready for rendering content, a connection to the remote app can be established.

The connection can be established in one of the following ways:

1. The player app running on HoloLens 2 connects to the remote app.

2. The remote app connects to the player app running on HoloLens 2.

To connect from the player app to the remote app call the Connect  method on the player context specifying the

hostname and port. The default port is 82658265 .

As with any C++/WinRT API Connect  might throw an winrt::hresult_error which needs to be handled.

Listening for incoming connections on the player app can be done by calling the Listen  method. Both the

handshake port and transport port can be specified during this call. The handshake port is used for the initial

handshake. The data is then sent over the transport port. By default port number 82658265  and 82668266  are used.

https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicspace.createforcorewindow


m_onConnectedEventToken = m_playerContext.OnConnected([]() 
{
    // Handle connection successfully established
});

m_onDisconnectedEventToken = m_playerContext.OnDisconnected([](ConnectionFailureReason failureReason)
{
    switch (failureReason)
    {
        // Handle connection failed or terminated.
        // See ConnectionFailureReason for possible reasons.
    }
}

NOTENOTE

m_onListeningEventToken = m_playerContext.OnListening([]()
{
    // Handle start listening for incoming connections
});

winrt::Microsoft::Holographic::AppRemoting::ConnectionState state = m_playerContext.ConnectionState();

 Display the remotely rendered frame

// Blit the remote frame into the backbuffer for the HolographicFrame.
winrt::Microsoft::Holographic::AppRemoting::BlitResult result = m_playerContext.BlitRemoteFrame();

The PlayerContext  exposes three events to monitor the state of the connection

1. OnConnected: Triggered when a connection to the remote app has been successfully established.

2. OnDisconnected: Triggered if an established connection is terminated or a connection couldn't be established.

Possible ConnectionFailureReason  values are documented in the Microsoft.Holographic.AppRemoting.idl  file.

3. OnListening: When listening for incoming connections starts.

Additionally the connection state can be queried using the ConnectionState  property on the player context.

To display the remotely rendered content, call PlayerContext::BlitRemoteFrame  while rendering a

HolographicFrame.

BlitRemoteFrame  requires that the back buffer for the current HolographicFrame is bound as render target. The

back buffer can be received from the HolographicCameraRenderingParameters via the Direct3D11BackBuffer

property.

When called, BlitRemoteFrame  copies the latest received frame from the remote application into the BackBuffer

of the HolographicFrame. Additionally the focus point set is set, if the remote application has specified a focus

point during the rendering of the remote frame.

https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframe
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframe.getrenderingparameters
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamerarenderingparameters.direct3d11backbuffer
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IMPORTANTIMPORTANT

  Projection Transform ModeProjection Transform Mode

 Optional: Set BlitRemoteFrameTimeout
 

PlayerContext::BlitRemoteFrame  potentially overwrites the focus point for the current frame.

To specify a fallback focus point, call HolographicCameraRenderingParameters::SetFocusPoint before 

PlayerContext::BlitRemoteFrame .

To overwrite the remote focus point, call HolographicCameraRenderingParameters::SetFocusPoint after 

PlayerContext::BlitRemoteFrame .

On success, BlitRemoteFrame  returns BlitResult::Success_Color . Otherwise it returns the failure reason:

BlitResult::Failed_NoRemoteFrameAvailable : Failed because no remote frame is available.

BlitResult::Failed_NoCamera : Failed because no camera present.

BlitResult::Failed_RemoteFrameTooOld : Failed because remote frame is too old (see

PlayerContext::BlitRemoteFrameTimeout property).

Starting with version 2.1.0 it's possible with a custom player to use depth reprojection via Holographic Remoting.

BlitResult  can also return BlitResult::Success_Color_Depth  under the following conditions:

The remote app has committed a depth buffer via

HolographicCameraRenderingParameters.CommitDirect3D11DepthBuffer.

The custom player app has bound a valid depth buffer before calling BlitRemoteFrame .

If these conditions are met, BlitRemoteFrame  will blit the remote depth into the currently bound local depth

buffer. You can then render additional local content, which will have depth intersection with the remote rendered

content. Additionally you can commit the local depth buffer via

HolographicCameraRenderingParameters.CommitDirect3D11DepthBuffer in your custom player to have depth

reprojection for remote and local rendered content.

One problem, which surfaces when using depth reprojection via Holographic Remoting is that the remote

content can be rendered with a different projection transform than local content directly rendered by your

custom player app. A common use-case is to specify different values for near and far plane (via

HolographicCamera::SetNearPlaneDistance and HolographicCamera::SetFarPlaneDistance) on the player side

and the remote side. In this case, it's not clear if the projection transform on the player side should reflect the

remote near/far plane distances or the local ones.

Starting with version 2.1.0 you can control the projection transform mode via 

PlayerContext::ProjectionTransformConfig . Supported values are:

Local  - HolographicCameraPose::ProjectionTransform returns a projection transform, which reflects the

near/far plane distances set by your custom player app on the HolographicCamera.

Remote  - Projection transform reflects the near/far plane distances specified by the remote app.

Merged  - Near/Far plane distances from your remote app and your custom player app are merged. By

default this is done by taking the minimum of the near plane distances and the maximum of the far plane

distances. In case either the remote or local side are inverted, say far < near, the remote near/far plane

distances are flipped.

https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamerarenderingparameters.setfocuspoint
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamerarenderingparameters.setfocuspoint
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamerarenderingparameters.commitdirect3d11depthbuffer#windows_graphics_holographic_holographiccamerarenderingparameters_commitdirect3d11depthbuffer_windows_graphics_directx_direct3d11_idirect3dsurface_
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamerarenderingparameters.commitdirect3d11depthbuffer#windows_graphics_holographic_holographiccamerarenderingparameters_commitdirect3d11depthbuffer_windows_graphics_directx_direct3d11_idirect3dsurface_
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamera.setnearplanedistance
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamera.setfarplanedistance
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamerapose.projectiontransform
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using namespace std::chrono_literals;

// Set the BlitRemoteFrame timeout to 0.5s
m_playerContext.BlitRemoteFrameTimeout(500ms);

 Optional: Get statistics about the last remote frame

// Get statistics for the last presented frame.
winrt::Microsoft::Holographic::AppRemoting::PlayerFrameStatistics statistics = 
m_playerContext.LastFrameStatistics();

 Optional: Custom data channels

 Optional: Over-Rendering

PlayerContext::BlitRemoteFrameTimeout  is supported starting with version 2.0.9.

The PlayerContext::BlitRemoteFrameTimeout  property specifies the amount of time a remote frame is reused if

no new remote frame is received.

A common use-case is to enable the BlitRemoteFrame timeout to display a blank screen if no new frames are

received for a certain amount of time. When enabled the return type of the BlitRemoteFrame  method can also be

used to switch to a locally rendered fallback content.

To enable the timeout, set the property value to a duration equal or greater than 100 ms. To disable the timeout,

set the property to zero duration. If the timeout is enabled and no remote frame is received for the set duration,

BlitRemoteFrame will fail and return Failed_RemoteFrameTooOld  until a new remote frame is received.

To diagnose performance or network issues, statistics about the last remote frame can be retrieved via the 

PlayerContext::LastFrameStatistics  property. Statistics are updated during the call to

HolographicFrame::PresentUsingCurrentPrediction.

For more information, see the PlayerFrameStatistics  documentation in the 

Microsoft.Holographic.AppRemoting.idl  file.

Custom data channels can be used to send user data over the already-established remoting connection. For

more information, see custom data channels.

Holographic Remoting predicts where the user's head will be at the time the rendered images appear on the

displays. However, this prediction is an approximation. Therefore, the predicted viewport on the remote app and

the later actual viewport on the player app can differ. Stronger deviations (for example, due to unpredictable

motion) could cause black regions at the borders of the viewing frustum. Starting with version 2.6.0 you can use

Over-Rendering to reduce the black regions and enhance the visual quality by artificially increasing the viewport

beyond the viewing frustum.

Over-Rendering can be enabled via PlayerContext::ConfigureOverRendering .

The OverRenderingConfig  specifies a fractional size increase to the actual viewport, so that the predicted

viewport becomes larger and less cutting occurs. With an increased viewport size, the pixel density decreases, so

the OverRenderingConfig allows you to increase the resolution as well. If the viewport increase is equal to the

resolution increase the pixel density remains the same. OverRenderingConfig  is defined as:

https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicframe.presentusingcurrentprediction


struct OverRenderingConfig
{
    float HorizontalViewportIncrease; // The fractional horizontal viewport increase. (e.g. 10% -> 0.1).
    float VerticalViewportIncrease; // The fractional vertical viewport increase. (e.g. 10% -> 0.1).
                
    float HorizontalResolutionIncrease; // The fractional horizontal resolution increase. (e.g. 10% -> 0.1).
    float VerticalResolutionIncrease; // The fractional vertical resolution increase. (e.g. 10% -> 0.1).
};

 Optional: Coordinate System Synchronization

 See Also

Starting with version 2.7.0 coordinate system synchronization can be used to align spatial data between the

player and remote app. For more information, see Coordinate System Synchronization with Holographic

Remoting Overview.
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 Create a custom data channel

std::recursive_mutex m_customDataChannelLock;
winrt::Microsoft::Holographic::AppRemoting::IDataChannel m_customDataChannel = nullptr;
winrt::Microsoft::Holographic::AppRemoting::IDataChannel::OnDataReceived_revoker 
m_customChannelDataReceivedEventRevoker;
winrt::Microsoft::Holographic::AppRemoting::IDataChannel::OnClosed_revoker 
m_customChannelClosedEventRevoker;

// Valid channel ids for channels created on the remote side are 0 up to and including 63
m_remoteContext.CreateDataChannel(0, DataChannelPriority::Low);

// Valid channel ids for channels created on the player side are 64 up to and including 127
m_playerContext.CreateDataChannel(64, DataChannelPriority::Low);

Use custom data channels to send custom data over an established remoting connection.

Custom data channels require a custom remote app and a custom player app, as it allows for communication between the

two custom apps.

A simple ping-pong example can be found in the remote and player samples inside the Holographic Remoting samples

github repository. Uncomment #define ENABLE_CUSTOM_DATA_CHANNEL_SAMPLE  inside the SampleRemoteApp.h /

SamplePlayerMain.h files to enable the sample code.

To create a custom data channel, the following fields are required:

After a connection is successfully established, you can create new data channels from either the remote side, the

player side, or both. Both the RemoteContext and the PlayerContext provide a CreateDataChannel()  method for

creating data channels. The first parameter is the channel ID, which is used to identify the data channel in later

operations. The second parameter is the priority that specifies with which priority data of this channel is

transferred to the other side. On the remote side, valid channel IDs range from 0 up to and including 63. On the

player side, valid channel IDs are from 64 up to and including 127. Valid priorities are Low , Medium , or High .

To start the creation of a data channel on the remoteremote side:

To start the creation of a data channel on the playerplayer  side:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/holographic-remoting-custom-data-channels.md
https://github.com/microsoft/MixedReality-HolographicRemoting-Samples
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 Handling custom data channel events

m_onDataChannelCreatedEventRevoker = m_remoteContext.OnDataChannelCreated(winrt::auto_revoke,
    [this](const IDataChannel& dataChannel, uint8_t channelId)
    {
        std::lock_guard lock(m_customDataChannelLock);
        m_customDataChannel = dataChannel;

        // Register to OnDataReceived and OnClosed event of the data channel here, see below...
    });

m_customChannelDataReceivedEventRevoker = m_customDataChannel.OnDataReceived(winrt::auto_revoke, 
    [this]()
    {
        // React on data received via the custom data channel here.
    });

m_customChannelClosedEventRevoker = m_customDataChannel.OnClosed(winrt::auto_revoke,
    [this]()
    {
        // React on data channel closed here.

        std::lock_guard lock(m_customDataChannelLock);
        if (m_customDataChannel)
        {
            m_customDataChannel = nullptr;
        }
    });

 Sending data

IMPORTANTIMPORTANT

To create a new custom data channel, only one side (either remote or player) needs to call the CreateDataChannel

method.

To establish a custom data channel, the OnDataChannelCreated  event needs to be handled (on both the player

and the remote side). It triggers when a user data channel has been created by either side and provides a 

IDataChannel  object, which can be used to send and receive data over this channel.

To register a listener on the OnDataChannelCreated  event:

To get notified when data is received, register to the OnDataReceived  event on the IDataChannel  object provided

by the OnDataChannelCreated  handler. Register to the OnClosed  event, to get notified when the data channel has

been closed.

To send data over a custom data channel, use the IDataChannel::SendData()  method. The first parameter is a 

winrt::array_view<const uint8_t>  to the data that should be send. The second parameter specifies where the

data should be resend, until the other side acknowledge the reception.

In case of bad network conditions, the same data packet might arrive more than once. The receiving code must be able to

handle this situation.



uint8_t data[] = {1};
m_customDataChannel.SendData(data, true);

 Closing a custom data channel

m_customDataChannel.Close();

 See Also

To close a custom data channel, use the IDataChannel::Close()  method. Both sides will be notified by the 

OnClosed  event once the custom data channel has been closed.
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 Holographic Remoting security

IMPORTANTIMPORTANT

NOTENOTE

 Planning the security implementation

If you're new to Holographic Remoting, you may want to read our overview.

This guidance is specific to Holographic Remoting on HoloLens 2 and Windows PCs running Windows Mixed Reality.

This page gives you an overview of network security for Holographic Remoting. You'll find information about:

Security in the context of Holographic Remoting and why you might need it

Recommended measures based on different use cases

Holographic Remoting exchanges information over a network. If no security measures are in place, adversaries

on the same network may compromise the integrity of the communication or access confidential information.

The sample apps and the Holographic Remoting Player in the Windows Store come with security disabled.

Doing so makes the samples easier to understand. It also helps you to get started more quickly with

development.

For field testing or production, we strongly recommend enabling security in your Holographic Remoting

solution.

Security in Holographic Remoting, when set up correctly for your use case, gives you the following guarantees:

Authenticity:Authenticity: both player and remote app can be sure the other side is who they claim to be

Confidentiality:Confidentiality: no third party can read the information exchanged between player and remote app

Integrity:Integrity: player and remote can detect any in-transit changes to their communication

To be able to use security features, you will need to implement both a custom player and a custom remote app using

either Windows Mixed Reality or OpenXR APIs.

Starting with version 2.4.0 remote apps using the OpenXR API can be created. An overview on how to establish a secure

connection in an OpenXR environment can be found here.

When you enable security in Holographic Remoting, the remoting library will automatically enable encryption

and integrity checks for all data exchanged over the network.

Ensuring proper authentication requires some extra work though. What exactly you need to do depends on your

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/holographic-remoting-secure-connection.md
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  Planning the server-to-client authenticationPlanning the server-to-client authentication

  Planning the client-to-server authenticationPlanning the client-to-server authentication

use case, and the rest of this section is about figuring out the necessary steps.

This article can only provide general guidance. If you feel unsure, consider consulting a security expert that can give you

guidance specific to your use case.

First some terminology: when describing network connections, the terms client and server will be used. The

server is the side listening for incoming connections on a known endpoint address, and the client is the one

connecting to the server's endpoint.

The client and and server roles are not tied to whether an app is acting as a player or as a remote. While the samples

have the player in the server role, it's easy to reverse the roles if it better fits your use case.

The server uses digital certificates to prove its identity to the client. The client validates the server's certificate

during the connection handshake phase. If the client doesn't trust the server, it will end the connection at this

point.

How the client validates the server certificate, and what kinds of server certificates can be used, depends on

your use case.

Use case 1:Use case 1: The server hostname isn't fixed, or the server isn't addressed by host name at all.

In this use case, it isn't practical (or even possible) to issue a certificate for the server's host name. We

recommendation you validate the certificate's thumbprint instead. Like a human fingerprint, the thumbprint

uniquely identifies a certificate.

It's important to communicate the thumbprint to the client out-of-band. That means, you can't send it over the

same network connection that's used for remoting. Instead, you could manually enter it into the client's

configuration, or to have the client scan a QR code.

Use case 2:Use case 2: The server can be reached over a stable host name.

In this use case, the server has a specific host name, and you know this name isn't likely to change. You can then

use a certificate issued to the server's host name. Trust will be established based on the host name and the

certificate's chain of trust.

If you choose this option, the client needs to know the server's host name and the root certificate in advance.

Clients authenticate against the server using a free-form token. What this token should contain will again

depend on your use case:

Use case 1:Use case 1: You only need to verify the client app's identity.

In this use case, a shared secret can be sufficient. This secret must be complex enough that it can't be guessed.

A good shared secret is a random GUID, which is manually entered in both the server's and client's

configuration. To create one you can, for example, use the New-Guid  command in PowerShell.

Make sure this shared secret is never communicated over insecure channels. The remoting library ensures that

the shared secret is always sent encrypted, and only to trusted peers.

Use case 2:Use case 2: You also need to verify the identity of the client app's user.



 See Also

A shared secret won't be enough to cover this use case. Instead, you can use tokens created by an identity

provider. An authentication workflow using an identity provider would look like this:

The client authorizes against the identity provider and requests a token

The identity provider generates a token and sends it to the client

The client sends this token to the server through Holographic Remoting

The server validates the client's token against the identity provider

One example of an identity provider is the Microsoft identity platform.

Like in the previous use case, make sure these tokens aren't sent through insecure channels or otherwise

exposed.

Holographic Remoting Overview

Secure Connection with the OpenXR API

Secure Connection with the Windows Mixed Reality API

https://docs.microsoft.com/en-us/azure/active-directory/develop/
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 Implementing a certificate provider

Remember that you need to implement custom remote and player apps if you want to enable connection

security. You can use the provided samples as starting points for your own apps.

To enable security, call ListenSecure()  instead of Listen() , and ConnectSecure()  instead of Connect()  to

establish the remoting connection.

These calls require you to provide implementations of certain interfaces for providing and validating security-

related information:

The server needs to implement a certificate provider and an authentication validator

The client needs to implement an authentication provider and a certificate validator.

All interfaces have a function requesting you to take action, which receives a callback object as parameter. Using

this object, you can easily implement asynchronous handling of the request. Keep a reference to this object, and

call the completion function when the asynchronous action is complete. The completion function may be called

from any thread.

Implementing WinRT interfaces can easily be done using C++/WinRT. The Author APIs with C++/WinRT chapter describes

this in detail.

The build\native\include\HolographicAppRemoting\Microsoft.Holographic.AppRemoting.idl  inside the NuGet

package contains detailed documentation for the API related to secure connections.

Certificate providers supply the server application with the certificate to use. The implementation consists of

two parts:

1. A certificate object, which implements the ICertificate  interface:

GetCertificatePfx()  should return the binary contents of a PKCS#12  certificate store. A .pfx  file

contains PKCS#12  data, so its contents can be used directly here.

GetSubjectName()  should return the friendly name that identifies the certificate to use. If no friendly

name is assigned to the certificate, this function should return the certificate's subject name.

GetPfxPassword()  should return the password required to open the certificate store (or an empty

string if no password is required).

2. A certificate provider implementing the ICertificateProvider  interface:

GetCertificate()  should construct a certificate object and return it by calling CertificateReceived()

on the callback object.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/holographic-remoting-secure-connection-wmr.md
https://docs.microsoft.com/en-us/windows/uwp/cpp-and-winrt-apis/author-apis


 

Implementing an authentication validator

 Implementing an authentication provider

 Implementing a certificate validator
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Authentication validators receive the authentication token sent by the client, and answer back with the validation

result.

Implement the IAuthenticationReceiver  interface as follows:

GetRealm()  should return the name of the authentication realm (an HTTP realm used during the remoting

connection handshake).

ValidateToken()  should validate the client authentication token and call ValidationCompleted()  on the

callback object with the validation result.

Authentication providers generate or retrieve the authentication token to be sent to the server.

Implement the IAuthenticationProvider  interface as follows:

GetToken()  should generate or retrieve the authentication token to be sent. Once the token is ready, call the 

TokenReceived()  method on the callback object.

Certificate validators receive the certificate chain sent by the server and determine whether the server can be

trusted.

To validate certificates, you can use the validation logic of the underlying system. This system validation can

either support your own validation logic, or replace it altogether. If you don't pass your own certificate validator

when requesting a secure connection, system validation will be used automatically.

On Windows, the system validation will check for :

Integrity of the certificate chain: the certificates form a consistent chain that ends at a trusted root certificate

Certificate validity: the server's certificate is within its validity timespan, and is issued for server

authentication

Revocation: The certificate hasn't been revoked

Name match: The host name of the server matches one of the host names the certificate was issued for

Implement the ICertificateValidator  interface as follows:

PerformSystemValidation()  should return true  if a system validation as described above should be

performed. In this case, the system validation result is passed as an input to the ValidateCertificate()

method.

ValidateCertificate()  should validate the certificate chain and then call CertificateValidated()  on the

passed callback with the final validation result. This method accepts the certificate chain, the name of the

server the connection is being established with, and whether a revocation check should be forced. If the

certificate chain contains multiple certificates, the first one is the subject certificate.

If your use case requires a different form of validation (see certificate use case #1 above), bypass system validation

entirely. Instead, use any API or library that can handle DER-encoded X.509 certificates to decode the certificate chain and

perform the checks needed for your use case.



See Also
Secure Connection with Holographic Remoting Overview
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 See Also

Starting with version 2.7.0, Holographic Remoting supports coordinate system synchronization.

Use coordinate system synchronization to synchronize spatial data between a custom player app and a custom

remote app. With coordinate system synchronization, it's possible to express spatial data within a common

space even across different player and remote runtimes.

An example for the coordinate system synchronization is to align content that was rendered by the player app

with the content rendered by the remote app. Furthermore, coordinate system synchronization allows the

custom remote app to correctly align sensor data from the player device. Sensor data can be retrieved, for

example, by HoloLens2ForCV.

In general, the coordinate system synchronization consists of two parts:

The player app sets and regularly updates the coordinate system (from now on, we refer to this coordinate

system as the "user coordinate system").

The remote app gets the user coordinate system in a runtime-dependent way. With the synchronized

coordinate system, both the player app and remote app can transform spatial data into a common

coordinate system.

Coordinate system synchronization supports only a single coordinate system. To synchronize data from multiple

coordinate systems, you can transform the data into the user coordinate system.

Coordinate System Synchronization with Holographic Remoting and the OpenXR API

Coordinate System Synchronization with Holographic Remoting and the Windows Mixed Reality API

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/holographic-remoting-coordinate-system-synchronization.md
https://github.com/microsoft/HoloLens2ForCV
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 Set and Update the User Coordinate System in the Player App

// In the Player app:

// Create a stationary frame of reference
winrt::Windows::Perception::Spatial::SpatialStationaryFrameOfReference spatialFrameOfReference = nullptr;
winrt::Windows::Perception::Spatial::SpatialLocator spatialLocator = 
winrt::Windows::Perception::Spatial::SpatialLocator::GetDefault();
if (spatialLocator != nullptr)
{
    spatialFrameOfReference = spatialLocator.CreateStationaryFrameOfReferenceAtCurrentLocation(float3(0.0f, 
0.0f, 0.0f), quaternion(0, 0, 0, 1), 0.0);
}

...

// Update the user coordinate system with the coordinate system of the spatial frame of reference
try
{
    SpatialCoordinateSystem userCoordinateSystem = spatialFrameOfReference.CoordinateSystem();
    m_playerContext.UpdateUserSpatialFrameOfReference(userCoordinateSystem);
}
catch (...)
{
}

NOTENOTE

 

With the Windows Mixed Reality API, the user coordinate system is wrapped into a

SpatialStationaryFrameOfReference.

A simple example can be found in the remote and player samples inside the Holographic Remoting samples github

repository. Uncomment #define ENABLE_USER_COORDINATE_SYSTEM_SAMPLE  inside the SampleRemoteApp.h and

SamplePlayerMain.h files to enable the sample code.

To set and update the user coordinate system, call UpdateUserSpatialFrameOfReference  on the player context and

pass a SpatialCoordinateSystem into it. A SpatialCoordinateSystem can, for example, be a

SpatialStationaryFrameOfReference, SpatialLocatorAttachedFrameOfReference, or a SpatialAnchor.

With the sample SpatialStationaryFrameOfReference, UpdateUserSpatialFrameOfReference  has to be called in a regular

interval to avoid drifting after loss of device tracking, even if the user coordinate system has not changed!

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/holographic-remoting-coordinate-system-synchronization-wmr.md
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialstationaryframeofreference
https://github.com/microsoft/MixedReality-HolographicRemoting-Samples
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialcoordinatesystem
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialcoordinatesystem
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialstationaryframeofreference
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatiallocatorattachedframeofreference
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialanchor
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialstationaryframeofreference


Get the User Coordinate System in the Remote App

// In the Remote app:
winrt::Windows::Perception::Spatial::SpatialStationaryFrameOfReference spatialUserFrameOfReference = 
m_remoteContext.GetUserSpatialFrameOfReference();

 See Also

To access the user coordinate system, call GetUserSpatialFrameOfReference  on the remote context. 

GetUserSpatialFrameOfReference  returns a SpatialStationaryFrameOfReference, which represents the user

coordinate system.

Coordinate System Synchronization with Holographic Remoting Overview

Coordinate System Synchronization with Holographic Remoting and the OpenXR API

https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialstationaryframeofreference
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IMPORTANTIMPORTANT

 HoloLens 2

NOTENOTE

 Add holographic remoting to your desktop or UWP app

NOTENOTE

  Get the remoting NuGet packagesGet the remoting NuGet packages

If you're new to Holographic Remoting, you may want to read our overview.

This document describes the creation of a host application for HoloLens 1. Host application for HoloLens (1st gen)HoloLens (1st gen)

must use NuGet package version 1.x.x1.x.x. This implies that host applications written for HoloLens 1 are not compatible with

HoloLens 2 and vice versa.

HoloLens developers using Holographic Remoting will need to update their apps to make them compatible with

HoloLens 2. This requires a new version of the Holographic Remoting NuGet package. Be sure to use version

2.0.0.0 or above of the Holographic Remoting NuGet package when connecting to the Holographic Remoting

Player on HoloLens 2. Otherwise, the connection will fail.

Guidance specific to HoloLens 2 can be found here.

This page describes how to add Holographic Remoting to a desktop or UWP app.

Holographic remoting lets your app target a HoloLens with holographic content hosted on a desktop PC or on a

UWP device such as the Xbox One. You also have access to more system resources, making it possible to

integrate remote immersive views into existing desktop PC software. A remoting host app receives an input data

stream from a HoloLens, renders content in a virtual immersive view, and streams content frames back to

HoloLens. The connection is made using standard Wi-Fi. To use remoting, use a NuGet package to add

holographic remoting to your desktop or UWP app, then write code to handle the connection and render an

immersive view. Helper libraries are included in the code sample that simplify the task of handling the device

connection.

A typical remoting connection will have as low as 50 ms of latency. The player app can report the latency in real

time.

The code snippets in this article currently demonstrate use of C++/CX rather than C++17-compliant C++/WinRT as used

in the C++ holographic project template. The concepts are equivalent for a C++/WinRT project, though you'll need to

translate the code.

Follow these steps to get the NuGet package for holographic remoting, and add a reference from your project:

1. Go to your project in Visual Studio.

2. Right-click on the project node and select Manage NuGet Packages...Manage NuGet Packages...

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/add-holographic-remoting.md


  Create the HolographicStreamerHelpersCreate the HolographicStreamerHelpers

#include <HolographicStreamerHelpers.h>

   private:
       Microsoft::Holographic::HolographicStreamerHelpers^ m_streamerHelpers;

private:
       Microsoft::Holographic::HolographicStreamerHelpers^ m_streamerHelpers;

       Microsoft::WRL::Wrappers::SRWLock                   m_connectionStateLock;

       RemotingHostSample::AppView^                        m_appView;
       Platform::String^                                   m_ipAddress;
       Microsoft::Holographic::HolographicStreamerHelpers^ m_streamerHelpers;

       Microsoft::WRL::Wrappers::CriticalSection           m_deviceLock;
       Microsoft::WRL::ComPtr<IDXGISwapChain1>             m_swapChain;
       Microsoft::WRL::ComPtr<ID3D11Texture2D>             m_spTexture;

  Initialize HolographicStreamerHelpers and connect to HoloLensInitialize HolographicStreamerHelpers and connect to HoloLens

m_streamerHelpers = ref new HolographicStreamerHelpers();
       m_streamerHelpers->CreateStreamer(m_d3dDevice);

       // We currently need to stream at 720p because that's the resolution of our remote display.
       // There is a check in the holographic streamer that makes sure the remote and local
       // resolutions match. The default streamer resolution is 1080p.
       m_streamerHelpers->SetVideoFrameSize(1280, 720);

       try
       {
           m_streamerHelpers->Connect(m_ipAddress->Data(), 8001);
       }
       catch (Platform::Exception^ ex)
       {
           DebugLog(L"Connect failed with hr = 0x%08X", ex->HResult);
       }

3. In the panel that appears, select BrowseBrowse and then search for "Holographic Remoting".

4. Select Microsoft.Holographic.RemotingMicrosoft.Holographic.Remoting and select InstallInstall .

5. If the PreviewPreview  dialog appears, select OKOK.

6. Select I AcceptI Accept when the license agreement dialog appears.

First, we need to add an instance of HolographicStreamerHelpers to the class that will handle remoting.

You'll also need to track connection state. If you want to render the preview, you need to have a texture to copy it

to. You also need a few things like a connection state lock, some way of storing the IP address of HoloLens, and

so on.

To connect to a HoloLens device, create an instance of HolographicStreamerHelpers and connect to the target IP

address. You'll need to set the video frame size to match the HoloLens display width and height, because the

Holographic Remoting library expects the encoder and decoder resolutions to match exactly.

The device connection is asynchronous. Your app needs to provide event handlers for connect, disconnect, and

frame send events.

The OnConnected event can update the UI, start rendering, and so on. In our desktop code sample, we update

the window title with a "connected" message.



m_streamerHelpers->OnConnected += ref new ConnectedEvent(
           [this]()
           {
               UpdateWindowTitle();
           });

Platform::WeakReference streamerHelpersWeakRef = Platform::WeakReference(m_streamerHelpers);
       m_streamerHelpers->OnDisconnected += ref new DisconnectedEvent(
           [this, streamerHelpersWeakRef](_In_ HolographicStreamerConnectionFailureReason failureReason)
           {
               DebugLog(L"Disconnected with reason %d", failureReason);
               UpdateWindowTitle();

               // Reconnect if this is a transient failure.
               if (failureReason == HolographicStreamerConnectionFailureReason::Unreachable ||
                   failureReason == HolographicStreamerConnectionFailureReason::ConnectionLost)
               {
                   DebugLog(L"Reconnecting...");

                   try
                   {
                       auto helpersResolved = streamerHelpersWeakRef.Resolve<HolographicStreamerHelpers>();
                       if (helpersResolved)
                       {
                           helpersResolved->Connect(m_ipAddress->Data(), 8001);
                       }
                       else
                       {
                           DebugLog(L"Failed to reconnect because a disconnect has already occurred.\n");
                       }
                   }
                   catch (Platform::Exception^ ex)
                   {
                       DebugLog(L"Connect failed with hr = 0x%08X", ex->HResult);
                   }
               }
               else
               {
                   DebugLog(L"Disconnected with unrecoverable error, not attempting to reconnect.");
               }
           });

The OnDisconnected event can handle reconnection, UI updates, and so on. In this example, we reconnect if

there's a transient failure.

When the remoting component is ready to send a frame, your app is provided an opportunity to make a copy of

it in the SendFrameEvent. Here, we copy the frame to a swap chain so that we can display it in a preview

window.



m_streamerHelpers->OnSendFrame += ref new SendFrameEvent(
           [this](_In_ const ComPtr<ID3D11Texture2D>& spTexture, _In_ FrameMetadata metadata)
           {
               if (m_showPreview)
               {
                   ComPtr<ID3D11Device1> spDevice = m_appView->GetDeviceResources()->GetD3DDevice();
                   ComPtr<ID3D11DeviceContext> spContext = m_appView->GetDeviceResources()-
>GetD3DDeviceContext();

                   ComPtr<ID3D11Texture2D> spBackBuffer;
                   ThrowIfFailed(m_swapChain->GetBuffer(0, IID_PPV_ARGS(&spBackBuffer)));

                   spContext->CopySubresourceRegion(
                       spBackBuffer.Get(), // dest
                       0,                  // dest subresource
                       0, 0, 0,            // dest x, y, z
                       spTexture.Get(),    // source
                       0,                  // source subresource
                       nullptr);           // source box, null means the entire resource

                   DXGI_PRESENT_PARAMETERS parameters = { 0 };
                   ThrowIfFailed(m_swapChain->Present1(1, 0, &parameters));
               }
           });

  Render holographic contentRender holographic content

m_appView->Initialize(m_streamerHelpers->HolographicSpace, m_streamerHelpers->RemoteSpeech);

void DesktopWindow::Tick()
   {
       auto lock = m_deviceLock.Lock();
       m_appView->Tick();

       // display preview, etc.
   }

To render content using remoting, you set up a virtual IFrameworkView within your desktop or UWP app and

process holographic frames from remoting. All of the Windows Holographic APIs are used the same way by this

view, but it's set up slightly differently.

Instead of creating them yourself, the holographic space and speech components come from your

HolographicRemotingHelpers class:

Instead of using an update loop in a Run method, you provide tick updates from the main loop of your desktop

or UWP app. This allows your desktop or UWP app to remain in control of message processing.

The holographic app view's Tick() method completes one iteration of the update, draw, present loop.



void AppView::Tick()
   {
       if (m_main)
       {
           // When running on Windows Holographic, we can use the holographic rendering system.
           HolographicFrame^ holographicFrame = m_main->Update();

           if (holographicFrame && m_main->Render(holographicFrame))
           {
               // The holographic frame has an API that presents the swap chain for each
               // holographic camera.
               m_deviceResources->Present(holographicFrame);
           }
       }
   }

  Disconnect and end the remote sessionDisconnect and end the remote session

void DesktopWindow::DisconnectFromRemoteDevice()
   {
       // Disconnecting from the remote device can change the connection state.
       auto exclusiveLock = m_connectionStateLock.LockExclusive();

       if (m_streamerHelpers != nullptr)
       {
           m_streamerHelpers->Disconnect();

           // Reset state
           m_streamerHelpers = nullptr;
       }
   }

 Get the remoting player

 Notes and resources

internal:
       const std::shared_ptr<DX::DeviceResources>& GetDeviceResources()
       {
           return m_deviceResources;
       }

The holographic app view update, render, and present loop are exactly the same as it is when running on

HoloLens - except that you have access to a much greater amount of system resources on your desktop PC. You

can render many more triangles, have more drawing passes, do more physics, and use x64 processes to load

content that requires more than 2 GB of RAM.

To disconnect - for example, when the user clicks a UI button to disconnect - call Disconnect() on the

HolographicStreamerHelpers, and then release the object.

The Windows Holographic remoting player is offered in the Windows app store as an endpoint for remoting

host apps to connect to. To get the Windows Holographic remoting player, visit the Windows app store from

your HoloLens, search for Remoting, and download the app. The remoting player includes a feature to display

statistics on-screen, which can be useful when debugging remoting host apps.

The holographic app view will need a way to provide your app with the Direct3D device, which must be used to

initialize the holographic space. Your app should use this Direct3D device to copy and display the preview frame.

Code sample:Code sample: A complete Holographic Remoting code sample is available, which includes a holographic

https://github.com/Microsoft/HoloLensCompanionKit


 See Also

application view that is compatible with remoting and remoting host projects for desktop Win32, UWP DirectX,

and UWP with XAML.

Debugging note:Debugging note: The Holographic Remoting library can throw first-chance exceptions. These exceptions may

be visible in debugging sessions, depending on the Visual Studio exception settings that are active at the time.

These exceptions are caught internally by the Holographic Remoting library and can be ignored.

Holographic Remoting Overview

Writing a custom Holographic Remoting player app

Establishing a secure connection with Holographic Remoting

Holographic Remoting troubleshooting and limitations

Holographic Remoting software license terms

Microsoft Privacy Statement

https://docs.microsoft.com/en-us/legal/mixed-reality/microsoft-holographic-remoting-software-license-terms
https://go.microsoft.com/fwlink/?LinkId=521839
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 Spectre mitigated libraries not found.

 Speech

 H265 video codec not available

 Limitations

This guidance is specific to Holographic Remoting on HoloLens 2 and Windows PCs running Windows Mixed Reality.

Holographic Remoting sample apps have Spectre mitigation (/Qspectre) enabled in Release configuration.

If you get the vccorlib.lib cannot be opened fatal error, make sure that your Visual Studio Workload includes the

Spectre mitigated libraries

The Holographic Remoting Player supports a diagnostics overlay, which can be enabled by saying 

Enable Diagnostics  and disabled by saying Disable Diagnostics . If you have trouble with these voice

commands, you can also launch the Holographic Remoting player via a web browser using 

ms-holographic-remoting:?stats  as a URL.

Install the HEVC Video Extensions when you want to use the H265 video codec in your remote app. If you run

into issues where the codec is installed but can't be used, check out troubleshooting guide.

The following APIs are currently notnot supported when using Holographic Remoting for HoloLens 2 and will raise

an ERROR_NOT_SUPPORTED  error unless otherwise stated:

Windows.Graphics.Holographic

HolographicCamera.ViewConfiguration

HolographicCamera.IsHardwareContentProtectionEnabled

HolographicViewConfiguration.RequestRenderTargetSize

HolographicCameraPose.OverrideProjectionTransform

HolographicCameraPose.OverrideViewport

HolographicCameraPose.OverrideViewTransform

HolographicCameraRenderingParameters.CommitDirect3D11DepthBuffer

HolographicDisplay.TryGetViewConfiguration

Supported starting with version 2.0.18

On previous versions, always raise an error.

Supported starting with version 2.2.0

On previous versions, don't fail, but the render target size won't be changed.

Supported starting with version 2.2.0

Supported starting with version 2.1.0

Querying HolographicViewConfigurationKind.PhotoVideoCamera will always return a nullptr .

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/holographic-remoting-troubleshooting.md
https://docs.microsoft.com/en-us/cpp/build/reference/qspectre
https://www.microsoft.com/p/hevc-video-extensions/9nmzlz57r3t7
https://docs.microsoft.com/en-us/azure/remote-rendering/resources/troubleshoot#h265-codec-not-available
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamera.viewconfiguration
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamera.ishardwarecontentprotectionenabled#windows_graphics_holographic_holographiccamera_ishardwarecontentprotectionenabled
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicviewconfiguration.requestrendertargetsize#windows_graphics_holographic_holographicviewconfiguration_requestrendertargetsize_windows_foundation_size_
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamerapose.overrideprojectiontransform
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamerapose.overrideviewport
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamerapose.overrideviewtransform
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamerarenderingparameters.commitdirect3d11depthbuffer#windows_graphics_holographic_holographiccamerarenderingparameters_commitdirect3d11depthbuffer_windows_graphics_directx_direct3d11_idirect3dsurface_
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicdisplay.trygetviewconfiguration
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HolographicSpace.CreateFramePresentationMonitor

HolographicDisplay.GetDefault

Supported starting with version 2.0.18

On previous versions, always raise an error.

Will report an error if called before a connection was established.

Windows.Perception.Spatial

SpatialLocation.AbsoluteAngularAcceleration

SpatialLocation.AbsoluteAngularAccelerationAxisAngle

SpatialLocation.AbsoluteAngularVelocity

SpatialLocation.AbsoluteAngularVelocityAxisAngle

SpatialLocation.AbsoluteLinearAcceleration

SpatialLocation.AbsoluteLinearVelocity

SpatialStageFrameOfReference.Current

SpatialStageFrameOfReference.RequestNewStageAsync

SpatialAnchor.RemovedByUser

SpatialAnchorExporter.GetDefault

SpatialAnchorExporter.RequestAccessAsync

SpatialAnchorTransferManager.RequestAccessAsync

SpatialAnchorTransferManager.TryExportAnchorsAsync

SpatialAnchorTransferManager.TryImportAnchorsAsync

Supported starting with version 2.2.0

On previous versions, always return nullptr .

Supported starting with version 2.2.0

Supported starting with version 2.0.9.

On previous versions, always return nullptr .

Supported starting with version 2.0.9.

On previous versions, the async operation always completed with 

SpatialPerceptionAccessStatus.DeniedBySystem .

Async operation always completes with SpatialPerceptionAccessStatus.DeniedBySystem .

Async operation always completes with false .

Async operation always completes with nullptr .

Windows.UI.Input.Spatial

SpatialInteractionSource.TryCreateHandMeshObserver

SpatialInteractionSource.TryCreateHandMeshObserverAsync

SpatialInteractionSource.Controller

Supported starting with version 2.2.0

Windows.Perception.Spatial.Preview

SpatialGraphInteropPreview.CreateLocatorForNode

SpatialGraphInteropPreview.TryCreateFrameOfReference

Holographic Remoting Overview

Holographic Remoting Version History

https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicspace.createframepresentationmonitor
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicdisplay.getdefault#windows_graphics_holographic_holographicdisplay_getdefault
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatiallocation.absoluteangularacceleration
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatiallocation.absoluteangularaccelerationaxisangle
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatiallocation.absoluteangularvelocity
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatiallocation.absoluteangularvelocityaxisangle
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatiallocation.absolutelinearacceleration
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatiallocation.absolutelinearvelocity
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialstageframeofreference.current
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialstageframeofreference.requestnewstageasync
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialanchor.removedbyuser
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialanchorexporter.getdefault
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialanchorexporter.requestaccessasync
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialanchortransfermanager.requestaccessasync#windows_perception_spatial_spatialanchortransfermanager_requestaccessasync
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialanchortransfermanager.tryexportanchorsasync#windows_perception_spatial_spatialanchortransfermanager_tryexportanchorsasync_windows_foundation_collections_iiterable_windows_foundation_collections_ikeyvaluepair_system_string_windows_perception_spatial_spatialanchor___windows_storage_streams_ioutputstream_
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialanchortransfermanager.tryimportanchorsasync
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsource.trycreatehandmeshobserver#windows_ui_input_spatial_spatialinteractionsource_trycreatehandmeshobserver
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsource.trycreatehandmeshobserverasync
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsource.controller#windows_ui_input_spatial_spatialinteractionsource_controller
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.preview
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.preview.spatialgraphinteroppreview.createlocatorfornode
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.preview.spatialgraphinteroppreview.trycreateframeofreference


Writing a Holographic Remoting remote app using Windows Mixed Reality APIs

Writing a Holographic Remoting remote app using OpenXR APIs

Writing a custom Holographic Remoting player app

Holographic Remoting software license terms

Microsoft Privacy Statement

https://docs.microsoft.com/en-us/legal/mixed-reality/microsoft-holographic-remoting-software-license-terms
https://go.microsoft.com/fwlink/?LinkId=521839
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 Version 2.8.0 (May 03, 2022)
 

 Version 2.7.5 (March 23, 2022)
 

 Version 2.7.4 (February 8, 2022)
 

 Version 2.7.3 (February 7, 2022)
 

 Version 2.7.2 (December 15, 2021)
 

 Version 2.7.1 (October 26, 2021)
 

 Version 2.7.0 (September 29, 2021)
 

 Version 2.6.2 (August 20, 2021)

This guidance is specific to Holographic Remoting on HoloLens 2 and Windows PCs running Windows Mixed Reality.

Full feature support for the XR_MSFT_scene_understanding extension. With that, all scene compute features

and scene compute consistencies are now supported.

Optimizations and latency reduction.

Fixed issues with multi-GPU systems.

Lots of other bug fixes and stability improvements.

Various bug fixes and stability improvements.

Fixed issue preventing the Holographic Remoting player, available via the Microsoft Store, from launching

correctly.

Fixed HEVC video decoding latency regression.

Various bug fixes and stability improvements.

Various bug fixes and stability improvements.

Added support for the OpenXR extension XR_MSFT_spatial_anchor_persistence, which allows persistence

and retrieval of spatial anchors across application sessions on a device.

Added a new user coordinate system type that can be used to synchronize spatial locations between custom

players and remote applications.

Fixed an issue where connected and disconnected events from PlayerContext and RemoteContext could be

broadcast concurrently or even in the wrong order. The broadcast now always happens in order, but prohibits

blocking in an event handler to wait for the broadcast of a subsequent event.

Various bug fixes and stability improvements.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/native/holographic-remoting-version-history.md


 

 Version 2.6.1 (July 20, 2021)
 

 Version 2.6.0 (June 10, 2021)
 

 Version 2.5.0 (February 12, 2021)
 

Fixed an OpenXR quad layer composition issue that can negatively affect hologram stability.

The XR_MSFT_holographic_remoting_speech extension now allows reinitialization of the speech recognizer

with new parameters during a running session.

Fixed an issue where speech recognition reliability lessened over multiple connections.

Various bug fixes and stability improvements.

Holographic Remoting using the OpenXR API now supports:

Holographic Remoting using the Mixed Reality API now supports:

Holographic Remoting using both the OpenXR and Mixed Reality APIs now supports:

The Microsoft.MixedReality.SceneUnderstanding SDK. It allows applications to compute a description of the

scene surrounding the user (such as walls, floors, and surfaces) providing quads, meshes, and content

placement cues.

The Microsoft.MixedReality.QR SDK, which allows applications to track the location, size, and content of

detected QR codes.

Over-Rendering, which reduces black regions at the sides on the HMD.

The OpenXR remote sample has been updated to include:

The Mixed Reality remote sample has been updated to include:

The Holographic Remoting player now shows a loading animation while the connection is being established.

Fixed issues with RenderDoc compatibility in both the OpenXR API runtime and the Mixed Reality API sample.

Various bug fixes and stability improvements.

The new XR_MSFT_holographic_remoting_speech extension, which allows applications to listen to

custom speech commands in various languages.

The XR_MSFT_scene_understanding extension. It provides applications with a high-level

representation of the planes, meshes, and objects in the user's environment. The extension enables

development of spatially aware applications. Note,

XR_SCENE_COMPUTE_CONSISTENCY_OCCLUSION_OPTIMIZED_MSFT is the only consistency

supported by xrComputeNewSceneMSFT in this version.

The XR_MSFT_spatial_graph_bridge extension, which allows applications to create XrSpace handles to

track the Spatial Graph Nodes of other Windows Mixed Reality device platform libraries or APIs. Note,

with XR_SPATIAL_GRAPH_NODE_TYPE_STATIC_MSFT is the only node type supported by

xrCreateSpatialGraphNodeSpaceMSFT in this version.

The SpatialGraphInteropPreview.CreateCoordinateSystemForNode overloads, which allow

applications to track static Spatial Graph Nodes so that users can reason about places and things in

their environment.

An example of using the XR_MSFT_holographic_remoting_speech extension.

An example of using the Microsoft.MixedReality.SceneUnderstanding SDK.

An example of using the Microsoft.MixedReality.QR SDK (which replaces the previous QR code

detection mechanism).

Holographic Remoting using the OpenXR API now supports:

XR_MSFT_spatial_anchor extension. This extension allows an application to create spatial anchors. Spatial

anchors are arbitrary points in the user ’s physical environment that will be tracked by the runtime.

XR_MSFT_controller_model extension. This extension provides a mechanism to load GLTF models for
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Improved synchronization between player and remote side. The improvement allows dynamically changing

pose and frame buffering, which ensures that remote rendered content smoothly reaches the displays at the

expected target frame rate.

Improved performance of the Holographic Remoting player available via the Microsoft Store.

Optimized transmission of spatial surface meshes, which can be queried via SpatialSurfaceObserver by a

remote app.

Fixed an issue in which calling SpatialAnchorManager methods or releasing anchors caused exceptions on

disconnect.

Fixed threading issue leading to crashes when closing PlayerContext or RemoteContext instances.

Holographic Remoting Player on Desktop: Display an error message when Windows Mixed Reality is missing

instead of closing silently.

Lots of other bug fixes and stability improvements.

controllers.

Custom data channels as part of the XR_MSFT_holographic_remoting extension. An example for that

is shown in the OpenXR remote sample.

Fixed issue with SpatialAnchorManager ::RequestStoreAsync not working reliably when called while

connecting.

Fixed issue with SpatialAnchorManager ::TrySave not correctly saving an anchor if the anchor in question

can't be located.

Holographic Remoting now support writing remote apps using the OpenXR API. Check out Writing a

Holographic Remoting remote app using OpenXR APIs to get started.

Bug fixes and stability improvements.

Fixed regression with remote pose prediction, which caused visual jitter.

Implemented PerceptionDeviceSetCreateFactoryOverride, which ensures that PerceptionDevice.dll shipped

with Holographic Remoting doesn't interfere with the version shipped with Windows 10.

Fixed crashes, which can happen when Holographic Remoting Player is suspended.

Stability improvements.

Bug fixes and stability improvements.

Fixed issue with HolographicCamera.LeftViewportParameters and

HolographicCamera.RightViewportParameters not returning any hidden area mesh vertices when streaming

from a Windows Mixed Reality headset.

Fixed crash, which can happen with poor network connection.

https://github.com/microsoft/MixedReality-HolographicRemoting-Samples
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.surfaces.spatialsurfaceobserver
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamera.leftviewportparameters
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamera.rightviewportparameters
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Windows App Certification Kit validation with version 2.2.0 will fail. In case you're on version 2.2.0 and want to submit

your application to the Microsoft store p lease updated to at least version 2.2.1.

Fixed Windows App Certification Kit compliance issues.

The Holographic Remoting player can now be installed on PCs running Windows Mixed Reality, making it

possible to stream to immersive headsets.

Motion controllers are now supported by Holographic Remoting and controller-specific data can be retrieved

via SpatialInteractionSource.Controller.

SpatialStageFrameOfReference is now supported and the current stage can be retrieved via

SpatialStageFrameOfReference.Current. Also, a new stage can be requested via

SpatialStageFrameOfReference.RequestNewStageAsync.

In previous versions, pose prediction was handled on the player side by the Holographic Remoting player.

Starting with version 2.2.0, Holographic Remoting has time synchronization, and prediction is fully done by

the remote application. Users should also expect improved hologram stability under difficult network

situations.

Changed behavior of HolographicSpace.CameraAdded event. In previous versions, it was notnot guaranteed

that a newly added HolographicCamera also has a valid HolographicCameraPose when creating the next

frame via HolographicSpace.CreateNextFrame. Starting with version 2.1.3, HolographicSpace.CameraAdded

is synchronized with pose data coming from the Holographic Remoting Player. Users can expect that when a

camera is newly added it also has a valid HolographicCameraPose available for that camera on the next

frame.

Added DisabledDisabled to DepthBufferStreamResolution, which can be used to disable depth buffer streaming via

RemoteContext.ConfigureDepthVideoStream. Note, if used

HolographicCameraRenderingParameters.CommitDirect3D11DepthBuffer will fail with

E_ILLEGAL_METHOD_CALL.

The Holographic Remoting Player's startup screen has been redesigned and now doesn't block the user's

view.

Stability improvements and bug fixes.

Fixed audio backwards compatibility issue between latest Holographic Remoting player and remote apps

using version smaller than 2.1.0.

Fixed spatial anchor issue, which unexpectedly closed the Holographic Remoting player. This issue also affects

custom players.

Fixed video encoding issue with remote apps when using AMD GPUs.

Holographic Remoting Player performance improvements.

https://developer.microsoft.com/windows/downloads/app-certification-kit/
https://developer.microsoft.com/windows/downloads/app-certification-kit/
https://docs.microsoft.com/en-us/uwp/api/windows.ui.input.spatial.spatialinteractionsource.controller#windows_ui_input_spatial_spatialinteractionsource_controller
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialstageframeofreference
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialstageframeofreference.current
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialstageframeofreference.requestnewstageasync
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicspace.cameraadded
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamera
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamerapose
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicspace.createnextframe
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicspace.cameraadded
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamerapose
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamerarenderingparameters.commitdirect3d11depthbuffer
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Switched network transport to use RTP via UDP. Secure connections use SRTP now. Note, the Holographic

Remoting Player is still compatible with all previously released Holographic Remoting versions. To benefit

from the new network transport, both the Holographic Remoting Player and the remote app in question have

to use version 2.1.0.

Added support for HolographicCameraRenderingParameters.CommitDirect3D11DepthBuffer.

Fixed various bugs that lead to crashes.

Added support for HolographicViewConfiguration

Fixed various bugs that lead to crashes.

Fixed bug where a HolographicSpace.CameraAdded callback was required for a HolographicCamera to get

accepted and show up as added camera in the HolographicFrame.

Fixed deadlock in QR code tracking.

Fixed unhandled exception because of a blocking wait in main thread.

Support for new PerceptionDevice APIs (Windows 10 November 2019 Update).

Fixed issue, which prevents hold gesture events being triggered by SpatialGestureRecognizer.

Fixed threading issue when using SpatialSurfaceObserver.SetBoundingVolume.

Fixed crash in SpatialGestureRecognizer when using NavigationRail(X/Y/Z).

Fixed crash when using trigger button of VR controllers. Holographic Remoting doesn't fully support

controllers, only the trigger button and the Windows button are working if paired with HoloLens 2.

Added support for SpatialAnchorExporter

Added new interface IPlayerContext2  (implemented by PlayerContext ) providing the following members:

Added Failed_RemoteFrameTooOld  value to BlitResult

Stability and reliability improvements

BlitRemoteFrameTimeout property.

Fixed crash when calling HolographicCameraRenderingParameters.CommitDirect3D11DepthBuffer with a

IDXGISurface2 as parameter.

Stability and reliability improvements

https://en.wikipedia.org/wiki/Real-time_Transport_Protocol
https://en.wikipedia.org/wiki/Secure_Real-time_Transport_Protocol
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamerarenderingparameters.commitdirect3d11depthbuffer#windows_graphics_holographic_holographiccamerarenderingparameters_commitdirect3d11depthbuffer_windows_graphics_directx_direct3d11_idirect3dsurface_
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicviewconfiguration
https://docs.microsoft.com/en-us/uwp/api/windows.perception.spatial.spatialanchorexporter
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamerarenderingparameters.commitdirect3d11depthbuffer
https://docs.microsoft.com/en-us/windows/win32/api/dxgi1_2/nn-dxgi1_2-idxgisurface2
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 See Also

First public release of Holographic Remoting for HoloLens 2.

Holographic Remoting Overview

Writing a Holographic Remoting remote app using Windows Mixed Reality APIs

Writing a Holographic Remoting remote app using OpenXR APIs

Writing a custom Holographic Remoting player app

Holographic Remoting troubleshooting and limitations

Holographic Remoting software license terms

Microsoft Privacy Statement

https://docs.microsoft.com/en-us/legal/mixed-reality/microsoft-holographic-remoting-software-license-terms
https://go.microsoft.com/fwlink/?LinkId=521839
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The articles in this section present overviews of some of the more advanced mixed reality concepts. For a review

of core concepts, see the Core concepts overview, which is located in the Design section of the documentation.

Advanced concepts include:

Mixed Reality Capture

Use anchors to share holograms

Holographic Remoting

Porting apps

Using the Windows device portal

HoloLens research mode

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/advanced-concepts-overview.md
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 Device camera information
  HoloLens (first-generation)HoloLens (first-generation)

  HoloLens 2HoloLens 2

HoloLens includes a world-facing camera mounted on the front of the device that enables apps to see what the

user sees. Developers have access to and control of the camera, just as they would for color cameras on

smartphones, portables, or desktops. The same universal Windows media capture and Windows Media

Foundation APIs that work on mobile and desktop work on HoloLens. Unity has wrapped these windows APIs to

abstract camera usage features on HoloLens. Feature tasks include taking regular photos and videos (with or

without holograms) and locating the camera's position in and perspective on the scene.

VIDEOVIDEO P REVIEWP REVIEW ST IL LST IL L
H O RIZ O N TA L  F IEL DH O RIZ O N TA L  F IEL D
O F  VIEW  ( H - F O V)O F  VIEW  ( H - F O V) SUGGEST ED USA GESUGGEST ED USA GE

1280x720 1280x720 1280x720 45 deg (default mode with
video stabilization)

N/A N/A 2048x1152 67 deg Highest resolution
still image

1408x792 1408x792 1408x792 48 deg Overscan (padding)
resolution before
video stabilization

1344x756 1344x756 1344x756 67 deg Large FOV video
mode with overscan

896x504 896x504 896x504 48 deg Low power / Low-
resolution mode for
image-processing
tasks

Fixed focus photo/video (PV) camera with auto white balance, auto exposure, and full image-processing

pipeline.

White Privacy LED facing the world that illuminates whenever the camera is active.

The camera supports the following modes (all modes are 16:9 aspect ratio) at 30, 24, 20, 15, and 5 fps:

Autofocus photo/video (PV) camera with auto white balance, auto exposure, and full image-processing

pipeline. The autofocus system can adjust object distance from 30 cm to infinity. The effective focal length

for the HoloLens 2 PV camera lens is 4.87 mm +/- 5%. In addition to the 5% variation due to

manufacturing tolerance, the focal length will change dynamically due to the autofocus system. The AF

travel (stroke) is up to 0.2 mm.

White Privacy LED facing the world that illuminates whenever the camera is active.

HoloLens 2 supports different camera profiles. Learn how to discover and select camera capabilities.

The camera supports the following profiles and resolutions (all video modes are 16:9 aspect ratio):

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/locatable-camera-overview.md
https://docs.microsoft.com/en-us/uwp/api/windows.media.capture.mediacapture
https://docs.microsoft.com/en-us/windows/uwp/audio-video-camera/camera-profiles
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L  F IEL D O FL  F IEL D O F
VIEW  ( H -VIEW  ( H -
F O V)F O V)

SUGGEST EDSUGGEST ED
USA GEUSA GE

Legacy, 0
BalancedVid
eoAndPhoto
, 100

2272x1278 2272x1278 15.30 64.69 High-quality
video
recording

Legacy, 0
BalancedVid
eoAndPhoto
,100

896x504 896x504 15.30 64.69 Preview
stream for
high-quality
photo
capture

Legacy, 0
BalancedVid
eoAndPhoto
, 100

3904x2196 64.69 High-quality
photo
capture

BalancedVid
eoAndPhoto
, 120

1952x1100 1952x1100 1952x1100 15.30 64.69 Long
duration
scenarios

BalancedVid
eoAndPhoto
, 120

1504x846 1504x846 15.30 64.69 Long
duration
scenarios

VideoConfer
encing, 100

1952x1100 1952x1100 1952x1100 15, 30,60 64.69 Video
conferencing
, long
duration
scenarios

Videoconfer
encing, 100

1504x846 1504x846 5, 15, 30,60 64.69 Video
conferencing
, long
duration
scenarios

Videoconfer
encing, 100
BalancedVid
eoAndPhoto
, 120

1920x1080 1920x1080 1920x1080 15, 30 64.69 Video
conferencing
, long
duration
scenarios

Videoconfer
encing, 100
BalancedVid
eoAndPhoto
, 120

1280x720 1280x720 1280x720 15, 30 64.69 Video
conferencing
, long
duration
scenarios

Videoconfer
encing, 100
BalancedVid
eoAndPhoto
,120

1128x636 15, 30 64.69 Video
conferencing
, long
duration
scenarios



NOTENOTE

 Locating the Device Camera in the World

  Distortion ErrorDistortion Error

Videoconfer
encing, 100
BalancedVid
eoAndPhoto
, 120

960x540 15,30 64.69 Video
conferencing
, long
duration
scenarios

Videoconfer
encing, 100
BalancedVid
eoAndPhoto
, 120

760x428 15, 30 64.69 Video
conferencing
, long
duration
scenarios

Videoconfer
encing, 100
BalancedVid
eoAndPhoto
, 120

640x360 15, 30 64.69 Video
conferencing
, long
duration
scenarios

Videoconfer
encing, 100
BalancedVid
eoAndPhoto
, 120

500x282 15, 30 64.69 Video
conferencing
, long
duration
scenarios

Videoconfer
encing, 100
BalancedVid
eoAndPhoto
, 120

424x240 15, 30 64.69 Video
conferencing
, long
duration
scenarios
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Customers can leverage mixed reality capture to take videos or photos of your app that include holograms and employ

video stabilization.

If you want the content of your user's capture to look as good as possible, there are some things you should consider. You

can also enable (and customize) mixed reality capture from directly within your app. Learn more at mixed reality capture

for developers.

When HoloLens takes photos and videos, the captured frames include the location of the camera in the world

and the lens model of the camera. This information allows applications to reason about the position of the

camera in the real world for augmented imaging scenarios. Developers can creatively roll their own scenarios

using their favorite image processing or custom computer vision libraries.

"Camera" elsewhere in HoloLens documentation may refer to the "virtual game camera" (the frustum the app

renders to). Unless described otherwise, "camera" on this page refers to the real-world RGB color camera.

On HoloLens 2, the video and still image streams are undistorted in the system's image-processing pipeline

before the frames are made available to the application. The preview stream contains the original distorted

frames. Because only the CameraIntrinsics are made available, applications must assume that image frames

https://docs.microsoft.com/en-us/hololens/holographic-photos-and-videos


 Locatable Camera Usage Scenarios
  Show a photo or video in the world where it was capturedShow a photo or video in the world where it was captured

  Tag / Pattern / Poster / Object TrackingTag / Pattern / Poster / Object Tracking

represent a perfect pinhole camera.

On HoloLens (first-generation), the undistortion function in the image processor may still leave an error of up to

10 pixels when using the CameraIntrinsics in the frame metadata. In many use cases, this error won't matter.

However, if, for example, you're aligning holograms to real-world posters or markers and you notice a < 10-px

offset (roughly 11 mm for holograms positioned 2 meters away), this distortion error could be the cause.

The Device Camera frames come with a "Camera To World" transform that can be used to show exactly where

the device was when it captured the image. For example, you could position a small holographic icon at this

location (CameraToWorld.MultiplyPoint(Vector3.zero)) and even draw a little arrow in the direction that the

camera was facing (CameraToWorld.MultiplyVector(Vector3.forward)).

Many mixed reality applications use a recognizable image or visual pattern to create a trackable point in space.

An application can render objects relative to that point or create a known location. A typical use for HoloLens is

finding a real-world object that's tagged with fiducials. This might occur, for example, on tablets that have been

set up to communicate with HoloLens via Wi-Fi.

You'll need a few things to recognize a visual pattern and place an object in the application's world space:

1. An image pattern recognition toolkit, such as QR code, AR tags, face finder, circle trackers, OCR, and so on.

2. Collect image frames at runtime and pass them to the recognition layer.

3. Unproject their image locations back into world positions or likely world rays.

4. Position your virtual models over these world locations.

Some important image-processing links:

OpenCV

QR Tags

FaceSDK

Microsoft Translator

Keeping an interactive application frame-rate is critical, especially when dealing with long-running image

recognition algorithms. For this reason, we commonly use the following pattern:

1. Main Thread: manages the camera object.

2. Main Thread: requests new frames (async).

3. Main Thread: pass new frames to tracking thread.

4. Tracking Thread: processes image to collect key points.

5. Main Thread: moves virtual model to match found key points.

6. Main Thread: repeat from step 2.

Some image marker systems only provide a single-pixel location, which equates to a ray of possible locations.

(Others provide the full transform, in which case this section isn't needed.) To get to a single 3D location, we can

calculate multiple rays and find the final result by their approximate intersection. To get this result, you'll need to:

1. Create a loop that collects multiple camera images.

2. Find the associated feature points and their world rays.

Given two or more tracked tag locations, you can position a modeled scene to fit the user's current scenario. If

you can't assume gravity, then you'll need three tag locations. In many cases, we use a color scheme where white

spheres represent real-time tracked tag locations, and blue spheres represent modeled tag locations. This allows

https://opencv.org/
https://en.wikipedia.org/wiki/QR_code
https://research.microsoft.com/projects/facesdk/
https://www.microsoft.com/translator/business


  Track or identify tagged stationary or moving real-world objects/faces using LEDs or other recognizerTrack or identify tagged stationary or moving real-world objects/faces using LEDs or other recognizer
librarieslibraries

 See also

the user to visually gauge the alignment quality. We assume the following setup in all our applications:

Two or more modeled tag locations.

One 'calibration space', which in the scene is the parent of the tags.

Camera feature identifier.

Behavior, which moves the calibration space to align the modeled tags with the real-time tags (we're careful

to move the parent space, not the modeled markers themselves, because other connect is positions relative

to them).

Examples:

Industrial robots with LEDs (or QR codes for slower moving objects).

Identify and recognize objects in the room.

Identify and recognize people in the room--for example, placing holographic contact cards over faces.

Locatable camera sample

Locatable camera with C++ samples

Mixed reality capture

Mixed reality capture for developers

Media capture introduction

Holographic face tracking sample

https://github.com/Microsoft/Windows-universal-samples/tree/master/Samples/HolographicFaceTracking
https://docs.microsoft.com/en-us/hololens/holographic-photos-and-videos
https://docs.microsoft.com/en-us/windows/uwp/audio-video-camera/
https://github.com/Microsoft/Windows-universal-samples/tree/master/Samples/HolographicFaceTracking
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NOTENOTE

 The importance of quality MRC

 How MRC impacts your app
  Enabling MRC in your appEnabling MRC in your app

  Enabling improved alignment for MRC in your appEnabling improved alignment for MRC in your app

  Set the focus pointSet the focus point

  Render from the PV camera (opt-in)Render from the PV camera (opt-in)

See Render from the PV camera below for guidance on a new MRC capability for HoloLens 2.

You can take a mixed reality capture (MRC) photo or video at any time, but there are few things to keep in mind

when developing your application. This includes best practices for MRC visual quality and being responsive to

system changes while MRCs are being captured.

Developers can also seamlessly integrate mixed reality capture and insertion into their apps.

MRC on HoloLens (first-generation) supports videos and photos up to 720p, while MRC on HoloLens 2 supports

videos up to 1080p and photos up to 4K resolution.

Whether it's mixed reality screenshots on your Microsoft Store page or other users sharing capture content on

social networks, Mixed Reality Capture media is often a users first exposure to your app. You can use MRC to

demo your app, educate users, encourage users to share their mixed world interactions, and for user research

and problem solving.

By default, an app doesn't have to do anything to enable users to take mixed reality captures.

By default, mixed reality capture combines the right eye's holographic output with the photo/video (PV) camera.

These two sources are combined using the focus point set by the currently running immersive app.

This means that holograms outside the focus plane won't align because of the physical distance between the PV

camera and the right display.

Immersive apps (on HoloLens) should set the focus point of where they want their stabilization plane to be. This

ensures the best alignment in both the headset and in mixed reality capture.

If a focus point isn't set, the stabilization plane will default to 2 meters.

HoloLens 2 adds the ability for an immersive app to render from the PV camerarender from the PV camera while mixed reality capture

is running. To ensure the app supports the additional render correctly, the app has to opt in to this functionality.

Render from the PV camera offers the following improvements over the default MRC experience:

Hologram alignment to your physical environment and hands for near interactions should be accurate at all

distances. Avoid having an offset at distances other than the focus point as you might see in the default MRC.

The right eye in the headset won't be compromised, as it won't be used to render the holograms for the MRC

output.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/mixed-reality-capture-overview.md
https://docs.microsoft.com/en-us/hololens/holographic-photos-and-videos


  Best practices (HoloLens-specific)Best practices (HoloLens-specific)

Learn more about rendering from the PV camera (DirectX).

MRC is expected to work without additional development effort, but there are a few things to be aware of when

providing the best mixed reality capture experience.

MRC uses the hologram’s alpha channel to blend with the MRC uses the hologram’s alpha channel to blend with the cameracamera imager y imager y

The most important step is to make sure your app is clearing to transparent black instead of clearing to opaque

black. In Unity, this is done by default with the MixedRealityToolkit. If you're developing in non-Unity, you may

need to make a one line change.

Here are some of the artifacts you might see in MRC if your app isn't clearing to transparent black:

Example FailuresExample Failures : Black edges around the content (failing to clear to transparent black)

Example FailuresExample Failures : The entire background scene of the hologram appears black. Setting a background alpha

value of one results in a black background

Expected ResultExpected Result: Holograms appear properly blended with the real-world (expected result if clearing to

transparent black)

SolutionSolution:

Change any content that is showing up as opaque black to have an alpha value of 0.

Ensure that the app is clearing to transparent black.

Unity defaults to clear automatically with the MixedRealityToolkit, but if it’s a non-Unity app you should

modify the color used with ID3D11DeiceContext::ClearRenderTargetView(). You want to ensure you clear to

transparent black (0,0,0,0) instead of opaque black (0,0,0,1).

You can now tune the alpha values of your assets if you’d like, but typically don’t need to. Most of the time,

MRCs will look good out of the box. MRC assumes pre-multiplied alpha. The alpha values will only affect the



  What to expect when MRC is enabled on HoloLensWhat to expect when MRC is enabled on HoloLens

 Integrating MRC functionality from within your app

  MRC with built-in camera UIMRC with built-in camera UI

  Creating a custom MRC recorderCreating a custom MRC recorder

MRC capture.

The following apply to both HoloLens (first-generation) and HoloLens 2, unless otherwise noted:

The system will throttle the application to 30-Hz rendering. This creates some headroom for MRC to run so

the app doesn’t need to keep a constant budget reserve and also matches the MRC video record framerate of

30 fps

Hologram content in the right eye of the device may appear to “sparkle” when recording/streaming MRC:

text may become more difficult to read and hologram edges may appear more jaggy (opting in to third

camera render on HoloLens 2HoloLens 2  avoids this compromise)

MRC photos and videos will respect the application’s focus point if the application has enabled it, which will

help ensure holograms are accurately positioned. For videos, the Focus Point is smoothed so holograms may

appear to slowly drift into place if the Focus Point depth changes significantly. Holograms that are at different

depths from the focus point may appear offset from the real world (see example below where Focus Point is

set at 2 meters but hologram is positioned at 1 meter).

Your mixed reality app can start MRC photo or video capture from within the app, and the content captured is

made available to your app without being stored to the device's "Camera roll." You can create a custom MRC

recorder or take advantage of built-in camera capture UI.

Developers can use the Camera Capture UI API to get a user-captured mixed reality photo or video with just a

few lines of code.

This API launches the built-in MRC camera UI where users can take a photo or video and returns the resulting

capture to your app. You can create a custom Mixed Reality Capture recorder if you need to add your own

camera UI or lower-level access to capture streams.

While the user can always trigger a photo or video using the system MRC capture service, an application may

want to build a custom camera app that include holograms in the camera stream just like MRC. This allows the

application to kick off captures from user input, build custom recording UI, or customize MRC settings to name a

few examples.

https://docs.microsoft.com/en-us/windows/uwp/audio-video-camera/capture-photos-and-video-with-cameracaptureui


  Simultaneous MRC limitationsSimultaneous MRC limitations

  Photo/video camera accessPhoto/video camera access

  B u i l t - i n  M R C  p h o t o / v i d e o  c a m e r a  a c c e ssB u i l t - i n  M R C  p h o t o / v i d e o  c a m e r a  a c c e ss

  MRC access for developersMRC access for developers

 See also

HoloStudio adds a custom MRC camera using MRC effectsHoloStudio adds a custom MRC camera using MRC effects

Unity Applications should see Locatable_camera_in_Unity for the property to enable holograms.

Other applications can do this by using the Windows Media Capture APIs to control the Camera and add an

MRC Video and Audio effect to include virtual holograms and application audio in stills and videos.

Learn more creating a custom MRC recorder (DirectX).

You need to be aware of certain limitations when multiple apps are accessing MRC at the same time.

On HoloLens 1, MRC will fail to capture a photo or capture video while a process is recording video or taking a

photo. The reverse is also true: if MRC is running, the application will fail to get access to the camera.

With HoloLens 2, it's possible for you to share access to the camera. If you don't need direct control of the

resolution or frame-rate, you can initialize MediaCapture using the SharedMode property with SharedReadOnly.

Learn about built-in MRC photo/video camera access (DirectX).

We recommend you always request Exclusive control for the camera when using MRC. This will ensure your

application has full control of the settings for the camera as long as you're aware of the limitations listed above.

Learn more about MRC access for developers (DirectX).

Mixed reality capture

Unity Development Overview

Unreal development overview

https://docs.microsoft.com/en-us/uwp/api/windows.media.capture.mediacapture
https://docs.microsoft.com/en-us/uwp/api/windows.media.capture.mediacaptureinitializationsettings.sharingmode
https://docs.microsoft.com/en-us/hololens/holographic-photos-and-videos


   

 

How it works - Mixed Reality Capture Studios
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Microsoft Mixed Reality Capture Studios enable content creators to create 360-degree holograms from real life

subjects that can be use in applications across augmented reality, virtual reality, and 2D screens. To learn more

about the potential of using a Mixed Reality Capture Studio to bring life to mixed reality, visit the official website.

To learn more about the technology behind the studio, and how it's brought to life on a range of devices, watch

the video below and read the "High-Quality Streamable Free-Viewpoint Video" technical whitepaper, originally

presented at Siggraph 2015. 

Whitepaper :Whitepaper :

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/how-it-works-mixed-reality-capture-studios.md
https://www.microsoft.com//mixed-reality/capture-studios
https://www.youtube-nocookie.com/embed/OzIo8OTZFy0


   

 

Use anchors to share holograms
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NOTENOTE

 Azure Spatial Anchors

 Local anchor transfers

 See also

This article relates to the legacy WinRT native APIs. For new native app projects, we recommend using the OpenXR APIOpenXR API .

A shared experience is one where multiple users with their own HoloLens, iOS, or Android device, collectively

view and interact with the same hologram. The hologram is positioned at a fixed point in space using spatial

anchor sharing.

This article provides brief introductions to Azure Spatial Anchors and local anchors. If you're new to Azure

Spatial Anchors, we recommend that you read this detailed overview first.

You can use Azure Spatial Anchors to create durable cloud-backed spatial anchors, which your app can then

locate across multiple HoloLens, iOS and Android devices. By sharing a common spatial anchor across multiple

devices, each user can see content rendered relative to that anchor in the same physical location. This allows for

real-time shared experiences.

You can also use Azure Spatial Anchors for asynchronous hologram persistence across HoloLens, iOS, and

Android devices. By sharing a durable cloud spatial anchor, multiple devices can observe the same persisted

hologram over time, even if those devices aren't present together at the same time.

To get started building shared experiences in your HoloLens app, try out the 5-minute Azure Spatial Anchors

HoloLens quickstart.

Once you're up and running with Azure Spatial Anchors, you can then create and locate anchors on HoloLens.

Walkthroughs are available for Android and iOS as well, enabling you to share the same anchors on all devices.

In situations where you can't use Azure Spatial Anchors, local anchor transfers enable one HoloLens device to

export an anchor to be imported by a second HoloLens device. This approach provides less robust anchor recall

than Azure Spatial Anchors, and iOS and Android devices are not supported by this approach.

Shared experiences in mixed reality

Azure Spatial Anchors

Azure Spatial Anchors SDK for HoloLens

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/shared-spatial-anchors-in-directx.md
https://docs.microsoft.com/en-us/azure/spatial-anchors/overview
https://docs.microsoft.com/en-us/azure/spatial-anchors/overview
https://docs.microsoft.com/en-us/azure/spatial-anchors/quickstarts/get-started-hololens
https://docs.microsoft.com/en-us/azure/spatial-anchors/concepts/create-locate-anchors-cpp-winrt
https://docs.microsoft.com/en-us/azure/spatial-anchors/create-locate-anchors-overview
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/local-anchor-transfers-in-directx
https://docs.microsoft.com/en-us/azure/spatial-anchors
https://docs.microsoft.com/en-us/cpp/api/spatial-anchors/winrt/
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 Device support

F EAT UREF EAT URE H O LO L EN S 1ST  GENH O LO L EN S 1ST  GEN H O LO L EN S 2H O LO L EN S 2 IM M ERSIVE  H EA DSET SIM M ERSIVE  H EA DSET S

QR code detection ✔️ ✔️

To access the GitHub repo for the QR code sample:

QR code tracking in Unity

With HoloLens 2 and immersive headsets, you can detect QR codes in the environment around the headset,

establishing a coordinate system at each code's real-world location. You can also render holograms in the same

location on multiple devices to create a shared experience. Once you enable your device's webcam, you'll

recognize QR codes in the latest versions of your projects. For best results going into production, we

recommend that you review the best practices section.

In this article, you'll learn about:

Supported devices for QR code tracking

Supported QR code versions

Best practices for QR code detection

Troubleshooting and FAQ

Quiet zones around QR codes

Lighting and backdrop

Size of QR codes

Distance and angular position from the QR code

Managing QR code data

QR code placement in a space

What capabilities are needed?

How do I make the QR Code Tracking Feature work on HoloLens 2 devices?

Where do I find the API plugin files?

How do I prepare a UWP to use Microsoft.MixedReality.QR.QRCodeWatcher?

How do I prepare Unity with the Microsoft.MixedReality.QR.QRCodeWatcher?

How can I make QR codes?

If QR code tracking doesn't work in general, what do I do?

What's the accuracy?

How close do I need to be to the QR code to detect it?

Why can't I read QR codes with logos?

The QR codes are detected, so why am I getting no data?

Are QR codes saved at the 'space' level or app level?

How does that work with the underlying platform? Where do they persist?

How do I debug the app in Visual studio when I receive the " Microsoft.MixedReality.QR.pdb  not

found" error message?

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/qr-code-tracking-overview.md
https://github.com/microsoft/MixedReality-QRCode-Sample
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://www.microsoft.com/hololens/hardware


NOTENOTE

 Supported QR code versions

  Q R C O DE VERSIO N SQ R C O DE VERSIO N S

Supported:

Not supported:

 Best practices for QR code detection
  Quiet zones around QR codesQuiet zones around QR codes

  Lighting and backdropLighting and backdrop

  Size of QR codesSize of QR codes

  Distance and angular position from the QR codeDistance and angular position from the QR code

QR code tracking with immersive Windows Mixed Reality headsets on desktop PCs is supported on Windows 10 Version

2004 and higher. Use the Microsoft.MixedReality.QRCodeWatcher.IsSupported()  API to determine whether the

feature is supported on the current device.

The following table lists the supported and unsupported QR code versions:

QR versions 1 - 10

Micro QR codes M1-M4

All encodings

QR Codes 10 - 20 (these may work, but are not
guaranteed)

QR Codes 20+

Tweaked modules, for example: circular modules,
reflections, inverted (black/white).

Logos

Structured appends

To be read correctly, QR codes require a margin around all sides of the code. This margin must not contain any

printed content and should be four modules (a single black square in the code) wide.

The QR spec contains more information about quiet zones.

QR code detection quality is susceptible to varying illumination and backdrop.

Under normal lighting conditions, provide enough contrast for the black/white modules for better

performance.

In extreme lighting conditions with bright lighting or dark backdrop, you can try to reduce and adjust

contrast which could improve QR code detection rate. The white background within the QR code can be

reduced from 255 downwards.

Windows Mixed Reality devices don't work with QR codes with sides smaller than 5 cm.

For QR codes with sides ranging from 5 cm to 10 cm, the device must be fairly close to detect the code. It may

take longer to detect the code.

The exact time to detect codes depends not only on the size of the QR codes, but how far away you are from the

code. Moving closer to the code will help offset issues with size.

The tracking cameras can only detect a certain level of detail. For small codes (less than 10 cm along the sides)

you must be fairly close. For a version 1 QR code varying from 10 cm to 25 cm in size, the minimum detection

https://www.qrcode.com/en/howto/code.html


IMPORTANTIMPORTANT

  Managing QR code dataManaging QR code data

  QR code placement in a spaceQR code placement in a space

distance is between 0.15 meters and 0.5 meters.

The detection distance for size increases linearly, but also depends on supported QR version or module size. The

higher the version, the smaller the modules, which can only be detected from a closer position. You can also try

micro-QR codes if you want the distance of detection to be longer. QR detection works with a range of angles

+= 45 deg to ensure we have proper resolution to detect the code.

Other detection considerations:

QR codes on curved surfaces aren’t supported.

In-plane orientation is supported. Out of plane should be <= +-45 looking straight on to have better

detection.

The physical size of the QR code should have modules of at least 2/3 pixels. Note: Higher versions of QR

codes will have smaller modules.

For the tradeoff relationship between distance and size of the QR code for optimal detection, see the following

graph:

Always make sure you have enough contrast and a proper border.

Windows Mixed Reality devices detect QR codes at the system level in the driver. When the device is rebooted or

the driver restarts, the detected QR codes history is cleared. QR codes redetected are treated as new objects.

We recommend configuring your app to ignore QR codes older than a specific timestamp, which can be

specified within the app. The QR Code API specifies the time that last detection happened. Most app developers

will use the system time when the app is launched to determine the time a QR code is detected.

QR code data aren’t app-specific. Upon app launch, there will be a list of available QR codes being provided. The

app developer will determine which QR codes are relevant to this app.

For recommendations on where and how to place QR codes, refer to Environment considerations for HoloLens.

https://docs.microsoft.com/en-us/hololens/hololens-environment-considerations


 Troubleshooting and FAQ
  What capabilities are needed?What capabilities are needed?

#if WINDOWS_UWP

async QRCodeWatcher.RequestAccessAsync();

#endif

  How do I make the QR Code Tracking Feature work on HoloLens 2 devices?How do I make the QR Code Tracking Feature work on HoloLens 2 devices?

  Where do I find the API plugin files?Where do I find the API plugin files?

  How do I prepare a UWP to use Microsoft.MixedReality.QR.QRCodeWatcher?How do I prepare a UWP to use Microsoft.MixedReality.QR.QRCodeWatcher?

  How do I prepare Unity with the Microsoft.MixedReality.QR.QRCodeWatcher?How do I prepare Unity with the Microsoft.MixedReality.QR.QRCodeWatcher?

  How can I make QR codes?How can I make QR codes?

  If QR code tracking doesn't work in general, what do I do?If QR code tracking doesn't work in general, what do I do?

  What's the accuracy?What's the accuracy?

You'll need the webcamwebcam capability added to your manifest (checkbox in Unity Capabilities). If you're building as

a standard UWP project, it’s also in the package.appxmanifest  in the solution project.

Request access by calling the following function:

The access status should be (status == QRCodeWatcherAccessStatus::Allowed) .

If access is denied, then the feature will return access denied when you start the QRTracking .

This API should be called before you construct the QRCodeWatcher  object.

If you're running the project from Unity, you also need to ensure that you're calling from the UI thread.

Otherwise, the API will always return denied. For more information, see AppCallbacks class in the Unity Manual.

For more information on setting up your project for Unity, see configure Unity for Windows Mixed Reality.

QR tracking is automatic on HoloLens 2, and you'll need the "webcam" capability added to your app.

All the required files and documentation can be found here.

https://www.nuget.org/packages/Microsoft.MixedReality.QR

Use the NuGet pack to unpack the required files.

Add a reference to the Microsoft.MixedReality.QR.winmd  in your project and start using the API.

Add the correct architecture versions of the plugins and use them accordingly in the build.

Use NuGet for Unity and point to the NuGet pack above.

Check out any QR code generator--here's one example.

Is the QR Code version a supported version? We don't support the high-density versions like version 40.

Nothing above version 10 is guaranteed; versions above 20 aren’t supported.

Are you close enough to the QR code? See distance and angular position from the QR code.

How is the lighting? There’s a known issue where detection becomes difficult when the QR code is on a dark

environmental background--the QR code will appear washed out to the camera due to high contrast. For

more information, see lighting and backdrop.

When detected in a single frame, the size is expected to have at most a 1% error from the actual size. For

example, a 10 cm code might be up to +/- 1 mm off in measured size. Under continuous detection, a code's

https://docs.unity3d.com/Manual/windowsstore-appcallbacks.html
https://docs.microsoft.com/en-us/learn/modules/learn-mrtk-tutorials/1-3-exercise-configure-unity-for-windows-mixed-reality?ns-enrollment-type=learningpath&ns-enrollment-id=learn.azure.beginner-hololens-2-tutorials&tabs=openxr
https://www.nuget.org/packages/Microsoft.MixedReality.QR
https://www.the-qrcode-generator.com/


  How close do I need to be to the QR code to detect it?How close do I need to be to the QR code to detect it?

  Why can't I read QR codes with logos?Why can't I read QR codes with logos?

  The QR codes are detected, so why am I getting no data?The QR codes are detected, so why am I getting no data?

  Are QR codes saved at the ‘space’ level or app level?Are QR codes saved at the ‘space’ level or app level?

  How does that work with the underlying platform? How does that work with the underlying platform? Where do they persist?Where do they persist?

  How do I debug the app in Visual Studio when I receive the "How do I debug the app in Visual Studio when I receive the " Microsoft.MixedReality.QR.pdb  not found" error not found" error
message?message?

  To reproduceTo reproduce

position might drift around by up to +/- 2.5 mm. Once you’ve moved out of detection range, a previous

detection's position is up to the mercy of the map error.

The distance obviously depends on the size of the QR code, and also what version it is. For more information,

see distance and angular position from the QR code.

On HoloLens 2, for a version 1 QR code varying from 5 cm sides to 25 cm sides, the minimum detection

distance ranges from 0.25 meters to 0.5 meters. The furthest these can be detected from goes from about 0.5

m for the smallest code to two meters for the bigger.

On Windows Mixed Reality, these distances for the sizes are halved.

For any codes bigger, extrapolate--the detection distance for size increases linearly. For any code smaller,

detection simply won’t occur--4-5 cm is the smallest we can detect.

Currently, we don't support QR codes with logos.

If the platform can’t decode the QR code, there will be no data. You can use the stream and interpret the data

using open-source code.

Some features, such as structure append, aren’t supported.

For more information, see what QR code versions are supported?.

QR codes are saved at the system level in driver session, or boot session on HoloLens. For more information,

see managing QR code data.

Detected QR codes are persisted in memory by the driver.

Symbol loading for Microsoft.MixedReality.QR.dll  was skipped because it isn’t specified in the included

modules list.

Follow the steps to reproduce this behavior :

1. Install Microsoft.MixedReality.QR (NuGet) and MRTK

2. Try to debug

You should be able to debug the app with Microsoft.MixedReality.QR.dll, but the DLL isn’t found:



  Recommended solutionRecommended solution

 See also

We're working on adding symbols to the next release. In the meantime, you should still be able to debug your

app by excluding the DLL in the Visual Studio options:

For more information, see Configuring Visual Studio’s settings.

QR code tracking with native C++ and C# samples

QR code tracking in Unity

Coordinate systems

Azure Spatial Anchors

HoloLens 2 Locatable camera overview

https://devblogs.microsoft.com/devops/understanding-symbol-files-and-visual-studios-symbol-settings/#configuring-visual-studios-settings
https://docs.microsoft.com/en-us/azure/spatial-anchors/overview
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F EAT UREF EAT URE H O LO L EN S 1ST  GENH O LO L EN S 1ST  GEN H O LO L EN S 2H O LO L EN S 2

Windows Device Portal ✔️ ✔️

NOTENOTE

 Setting up HoloLens to use Windows Device Portal

IMPORTANTIMPORTANT

The Windows Device Portal for HoloLens lets you configure and manage your device remotely over Wi-Fi or

USB. The Device Portal is a web server on your HoloLens that you can connect to from a web browser on your

PC. The Device Portal includes many tools that will help you manage your HoloLens and debug and optimize

your apps.

This documentation is specifically about the Windows Device Portal for HoloLens. To use the Windows Device

portal for desktop (including for Windows Mixed Reality), see Windows Device Portal overview

Device Portal is a developer tool and is not to be used in applications deployed to your organization.

1. Power on your HoloLens and put on the device.

2. Use the Start gesture for HoloLens2 or Bloom on HoloLens (1st Gen) to launch the main menu.

3. Gaze at the SettingsSettings  tile and do an air-tap gesture on HoloLens (1st Gen). You can also select it on HoloLens

2 by touching it or using a Hand ray.

4. Select the UpdateUpdate menu item.

5. Select the For developersFor developers  menu item.

6. Enable Developer ModeDeveloper Mode.

If you're in multi-user and not an admin, the ability to enter Developer Mode may be grayed out. Please ensure that you

are an admin on the deviceadmin on the device.

7. Scroll down and enable Device Por talDevice Por tal .

8. If you're setting up Windows Device Portal so you can deploy apps to this HoloLens over USB or Wi-Fi, select

PairPair  to generate a pairing PIN. Leave the Settings app at the PIN popup until you enter the PIN into Visual

Studio during your first deployment.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/using-the-windows-device-portal.md
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/uwp/debug-test-perf/device-portal
https://docs.microsoft.com/en-us/hololens/hololens2-basic-usage#start-gesture
https://docs.microsoft.com/en-us/hololens/hololens1-basic-usage#open-the-start-menu-with-bloom
https://docs.microsoft.com/en-us/hololens/hololens1-basic-usage#select-holograms-with-gaze-and-air-tap
https://docs.microsoft.com/en-us/hololens/hololens2-basic-usage
https://docs.microsoft.com/en-us/hololens/security-adminless-os


 Connecting over Wi-Fi
1. Connect your HoloLens to Wi-Fi.

2. Look up your device's IP address by either :

Going to Settings > Network & Internet > Wi-Fi > Advanced OptionsSettings > Network & Internet > Wi-Fi > Advanced Options .

Going to Settings > Network & InternetSettings > Network & Internet and selecting Hardware proper tiesHardware proper ties .

Using the "What's my IP address?" voice command.

3. From a web browser on your PC, go to https://<YOUR_HOLOLENS_IP_ADDRESS>

The browser will display the following message: "There's a problem with this website's security

certificate" because the certificate, which is issued to the Device Portal is a test certificate. You can

https://docs.microsoft.com/en-us/hololens/hololens-network


 Connecting over USB

IMPORTANTIMPORTANT

ignore this certificate error for now and continue.

IpOverUsb is no longer recommended per new browser standards as it requires the use of port 10080. If you still wish to

use IpOverUsb, check the 'USB Device Connectivity' box during Visual Studio installation, which isn't checked by default.

Instead, we recommend connecting with UsbNcm, which is supported by default on HoloLens 2. If you are using a

HoloLens 1, we recommend connecting to your PC using WiFi.

1. If your HoloLens 2 is running Windows Holographic version 21H1 or higher, go to 'For developers' in the

Settings app and make sure that 'Device discovery' is toggled ON.

2. Connect your HoloLens 2 to your PC with a USB-C cable.

3. Find your UsbNcm IP. There are a few ways to do this:

In the Settings app on the device (This method only works for HoloLenses running Windows Holographic

version 21H1 or higher, with 'Device discovery' toggled ON.)

1. Go into the Settings app on the device.

2. Go to "Update & Security" > "For developers." This is the same place you enabled Device Portal.

3. At the bottom of the page, copy your EthernetEthernet IP address. This is your UsbNcm IP. 

In Device Portal

1. On your device, open Device Portal using your HoloLens' WiFi address. If you don't know your

HoloLens' WiFi address, you can use the voice command "What's my IP address?"

2. Go to System > Networking

3. On the far right side of the page in the "IP Configuration" panel, locate the section that starts with

"Description: UsbNcm Function."

4. Your UsbNcm IP is the "IPv4 address" line. You can copy the address or just click on the address - it is a

hyperlink which will reopen Device Portal using the UsbNcm IP.

In a command prompt

1. In any command prompt, navigate to the bin<SDK version>\x86 folder where your Windows 10 SDK

is installed, such as C:\Program Files (x86)\Windows Kits\10\bin\10.0.19041.0\x86.

2. Type "winappdeploycmd devices" and press Enter.

3. In the output, look for the entry where the Model/Name column is your HoloLens device name, such

as HOLOLENS-xxxxxx. The UsbNcm IP is at the start of this line and will be an Automatic Private IP

address in the form of 169.254.x.x. Copy this address.



  Moving files over USBMoving files over USB

NOTENOTE

 Connecting to an emulator

 Creating a Username and Password

 Security certificate

4. If you copied your UsbNcm IP, from a web browser on your PC go to https:// followed by your UsbNcm IP.

You can move files from your PC to your HoloLens without any additional setup.

1. Connect your PC to your HoloLens with a USB cord

2. Drag your files into PC\[Your_HoloLens_Device_Name]\Internal StoragePC\[Your_HoloLens_Device_Name]\Internal Storage on your desktop

3. Open the Star t MenuStar t Menu and select All apps > File ExplorerAll apps > File Explorer  on your HoloLens

You may need to select This deviceThis device on the left side of the panel to navigate away from "Recently used" to locate your

files.

You can also use the Device Portal with your emulator. To connect to the Device Portal, use the toolbar. Select

this icon:  Open Device Por talOpen Device Por tal : Open the Windows Device Portal for the HoloLens OS in the emulator.

Set up access to Windows Device Portal

The first time you connect to the Device Portal on your HoloLens, you'll need to create a username and

password.

1. In a web browser on your PC, enter the IP address of the HoloLens. The Setup access page opens.

2. Select or tap Request pinRequest pin and look at the HoloLens display to get the generated PIN.

3. Enter the PIN in the PIN displayed on your devicePIN displayed on your device textbox.

4. Enter the user name you'll use to connect to the Device Portal. It doesn't need to be a Microsoft Account

(MSA) name or a domain name.

5. Enter a password and confirm it. The password must be at least seven characters in length. It doesn't need to

be an MSA or domain password.

6. Click PairPair  to connect to Windows Device Portal on the HoloLens.

If you wish to change this username or password at any time, you can repeat this process by visiting the device

security page by navigating to: https://<YOUR_HOLOLENS_IP_ADDRESS>/devicepair.htm.

If you see a "certificate error" in your browser, you can fix it by creating a trust relationship with the device.



NOTENOTE

 Sideloading applications
  Installing a certificateInstalling a certificate

  Installing an appInstalling an app

Each HoloLens generates a self-signed certificate for its SSL connection. By default, this certificate is not trusted

by your PC's web browser and you may get a "certificate error". You can securely connect to your device by

downloading this certificate from your HoloLens over USB or a Wi-Fi network you trust and trusting it on your

PC.

1. Make sure you are on a secure network (USB or a Wi-Fi network you trust).Make sure you are on a secure network (USB or a Wi-Fi network you trust).

2. Download this device's certificate from the "Security" page on the Device Portal.

3. Install the certificate in the "Trusted Root Certification Authorities" store on your PC.

4. Restart the browser.

Navigate to: https://<YOUR_HOLOLENS_IP_ADDRESS>/devicepair.htm

Open the node for System > Preferences.

Scroll down to Device Security, select the "Download this device's certificate" button.

From the Windows menu, type: Manage Computer Certificates and start the applet.

Expand the Trusted Root Cer tification AuthorityTrusted Root Cer tification Authority  folder.

Select the Cer tificatesCer tificates  folder.

From the Action menu, select: All Tasks > Import...

Complete the Certificate Import Wizard, using the certificate file you downloaded from the Device

Portal.

This certificate will only be trusted for the device and the user will have to go through the process again if the device is

flashed.

1. In Windows Device Portal, navigate to the AppsApps  manager page

2. In the Deploy apps section, select Install Cer tificateInstall Cer tificate

3. Under Select certificate file (.cer) used to sign an app package, select Choose File and browse to the

certificate associated with the app package that you want to sideload

4. Select InstallInstall  to start the installation



NOTENOTE
In order for an app to install successfully via Device Portal it must be signed by a certificate, this certificate must be

installed to the device prior to attempting to install the app. See the previous section for instructions.

1. When you've created an app package from Visual Studio, you can remotely install it onto your device from

the generated files:

2. In Windows Device Portal, navigate to the AppsApps  manager page

3. In the DeployDeploy  apps section, select Local StorageLocal Storage

4. Under Select the application package, select Choose File and browse to the app package that you want to

sideload

5. Check the respective boxes if you want to install optional or framework packages along with the app

installation and select NextNext:

6. Select InstallInstall  to start the installation



 Device Portal Pages
  HomeHome

Once the installation is complete, go back to the All appsAll apps  page on your HoloLens and launch your newly

installed application!

Windows Device Portal home page on Microsoft HoloLens

[NOTE] Settings configured in the Device Portal apply to the entire device and persist through reboots.

Device Portal is for use by developers, not in deployed applications.

Your Device Portal session starts at the Home page. Access other pages from the navigation bar along the left

side of the home page.

The toolbar at the top of the page provides access to commonly used status and features.

OnlineOnline: Indicates whether the device is connected to Wi-Fi.

ShutdownShutdown: Turns off the device.

Restar tRestar t: Cycles power on the device.

SecuritySecurity : Opens the Device Security page.

CoolCool : Indicates the temperature of the device.

A/CA/C: Indicates whether the device is plugged in and charging.

HelpHelp: Opens the REST interface documentation page.

The home page shows the following info:

Device Status:Device Status: monitors the health of your device and reports critical errors.

Windows information:Windows information: shows the name of the HoloLens and the currently installed version of Windows.

PreferencesPreferences  section contains the following settings:

IPDIPD: Sets the interpupillary distance (IPD) - the distance, in millimeters, between the center of the

user's pupils when looking straight ahead. The setting takes effect immediately. The default value was

calculated automatically when you set up your device.

Device nameDevice name: Assign a name to the HoloLens. eboot the device after changing this value for it to take

effect. After clicking SaveSave, a dialog will ask if you want to reboot the device immediately or reboot



  3D View3D View

  Map ManagerMap Manager

later.

S leep settingsSleep settings : Sets the length of time to wait before the device goes to sleep when it's plugged in

and when it's on battery.

3D View page in Windows Device Portal on Microsoft HoloLens

Use the 3D View page to see how HoloLens interprets your surroundings. Navigate the view by using the

mouse:

Rotate: left click + mouse;

Pan: right click + mouse;

Zoom: mouse scroll.

Tracking optionsTracking options

View optionsView options : Set options on the 3D view:

Surface reconstructionSurface reconstruction: Select or tap UpdateUpdate to display the latest spatial mapping mesh from the device.

A full pass may take some time to complete (up to a few seconds). The mesh doesn't update automatically in

the 3D view, and you must manually select UpdateUpdate to get the latest mesh from the device. Select SaveSave to

save the current spatial mapping mesh as an obj file on your PC.

Spatial anchorsSpatial anchors : Select Update to display or update the spatial anchors for the active app.

Turn on continuous visual tracking by checking Force visual trackingForce visual tracking.

PausePause stops visual tracking.

TrackingTracking: Indicates whether visual tracking is active.

Show floorShow floor : Displays a checkered floor plane.

Show frustumShow frustum: Displays the view frustum.

Show stabilization planeShow stabilization plane: Displays the plane that HoloLens uses for stabilizing motion.

Show meshShow mesh: Displays the spatial mapping mesh that represents your surroundings.

Show spatial anchorsShow spatial anchors : Displays spatial anchors for the active app. Select the Update button to get

and refresh the anchors.

Show detailsShow details : Displays hand positions, head rotation quaternions, and the device origin vector as

they change in real time.

Full screen buttonFull screen button: Shows the 3D View in full screen mode. Press ESC to exit full screen view.



  Exporting and importing mapsExporting and importing maps

NOTENOTE

  Mixed Reality CaptureMixed Reality Capture

Map Manager allows you to share maps across devices, which can be used to set up shared experiences for

Location-Based Entertainment customers. The tool allows you to import and export system maps and anchors.

To access the Map Manager, log into the Device Portal and select Mixed Reality -> Map ManagerMixed Reality -> Map Manager :

Map Manager page in Windows Device Portal on Microsoft HoloLens

To export maps, select Expor t System Map & AnchorsExpor t System Map & Anchors . This could take a while so be prepared to wait for 30-

60 seconds while the map is exported. Once it’s complete, the file will be downloaded in your browser.

To import maps and anchors, select Upload a map fileUpload a map file and Upload an anchor fileUpload an anchor file respectively and select a

map or anchor file that you've already exported. The uploaded map or anchor file can come from any other

HoloLens device.

On HoloLens, it's also possible to import and export the spatial mapping data base. However, this doesn't work on non-

HoloLens devices.



IMPORTANTIMPORTANT

Mixed Reality Capture page in Windows Device Portal on Microsoft HoloLens

Device Portal is for use by developers, not in deployed applications. Settings configured in the Device Portal apply to the

entire device and persist through reboots. Any settings modified in the Device Portal will apply to mixed reality captures

and apps.

Use the Mixed Reality Capture page to save media streams from the HoloLens.

Capture SettingsCapture Settings : Control the media streams that are captured by checking the following settings:

Audio SettingsAudio Settings  (HoloLens 2 only):

Photo and Video SettingsPhoto and Video Settings  (HoloLens 2, version 2004 or later):

Select or tap the L ive previewLive preview  button to show the capture stream. Stop live previewStop live preview  stops the capture

HologramsHolograms : Captures the holographic content in the video stream. Holograms are rendered in mono,

not stereo.

PV cameraPV camera: Captures the video stream from the photo/video camera.

Mic AudioMic Audio: Captures audio from the microphone array.

App AudioApp Audio: Captures audio from the currently running app.

Render from CameraRender from Camera: Aligns the capture to be from the perspective of the photo/video camera, if

supported by the running app (HoloLens 2 only).

L ive preview qualityL ive preview quality : Select the screen resolution, frame rate, and streaming rate for the live

preview.

Audio Media Categor yAudio Media Categor y : Select the category is used when processing the microphone. DefaultDefault will

include some of the environment, while CommunicationsCommunications  applies background noise cancellation.

App Audio GainApp Audio Gain : The gain applied to app audio's volume.

Mic Audio GainMic Audio Gain : The gain applied to mic audio's volume.

Capture ProfileCapture Profile: Select the profile used when taking photos and videos. The profile determines

which resolutions and frame-rates are available.

Photo ResolutionPhoto Resolution: The resolution the photo will be taken with.

Video Resolution and Frame-rateVideo Resolution and Frame-rate: The resolution and frame-rate the video will be taken with.

Video Stabilization BufferVideo Stabilization Buffer : The buffer size used when taking a video. The higher the value, the

better it can compensate for quick movements.



SET T IN GSET T IN G A P P L IES TO  SY ST EM  M RCA P P L IES TO  SY ST EM  M RC A P P L IES TO  C USTO M  M RC  REC O RDERSA P P L IES TO  C USTO M  M RC  REC O RDERS

Holograms No No

PV camera No No

Mic Audio No No

App Audio No No

Render from Camera Yes Yes (can be overridden)

Live preview quality No No

Audio Media Category Yes No

App Audio Gain Yes Yes (can be overridden)

Mic Audio Gain Yes Yes (can be overridden)

Capture Profile Yes No

Photo Resolution Yes No

Video Resolution and Frame-rate Yes No

Video Stabilization Buffer Yes Yes (can be overridden)

stream.

Select or tap RecordRecord to start recording the mixed-reality stream, using the specified settings. StopStop

recordingrecording ends the recording and saves it.

Select or tap Take photoTake photo to take a still image from the capture stream.

Select or tap Restore Default SettingsRestore Default Settings  to restore the default settings for audio, photo, and video settings.

Videos and photosVideos and photos : Shows a list of video and photo captures taken on the device.

All settings on this page apply to captures taken using Windows Device Portal. Some additionally apply to

System MRC, including start menu, hardware buttons, global voice commands, Miracast, and custom MRC

Recorders.



NOTENOTE

  Performance TracingPerformance Tracing

  ProcessesProcesses

There are limitations to simultaneous MRC:

If an app tries to access the photo/video camera while Windows Device Portal is recording a video, the video recording

will stop.

If an app is actively using the photo/video camera, Windows Device Portal is able to take a photo or record a video.

Live streaming:

HoloLens 2 will not stop recording video if the app accesses the photo/video camera with SharedReadOnly

mode.

HoloLens (1st gen) prevents an app from accessing the photo/video camera while live streaming from Windows

Device Portal.

HoloLens (1st gen) will fail to live stream if an app is actively using the photo/video camera.

HoloLens 2 automatically stops live streaming when an app tries to access the photo/video camera in

ExclusiveControl mode.

HoloLens 2 is able to start a live stream while an app is actively using the PV camera.

Performance Tracing page in Windows Device Portal on Microsoft HoloLens

Capture Windows Performance Recorder (WPR) traces from your HoloLens.

Available profilesAvailable profiles : Select the WPR profile from the dropdown, and select or tap Star tStar t to start tracing.

Custom profilesCustom profiles : Select or tap BrowseBrowse to choose a WPR profile from your PC. Select or tap Upload andUpload and

star tstar t to start tracing.

To stop the trace, select the stop link. Stay on this page until the trace file has completed downloading.

Captured ETL files can be opened for analysis in Windows Performance Analyzer.

For a more in-depth look at performance tracing, see the HoloLens performance tracing how to.

https://docs.microsoft.com/en-us/previous-versions/windows/it-pro/windows-8.1-and-8/hh448205(v=win.10)
https://docs.microsoft.com/en-us/previous-versions/windows/it-pro/windows-8.1-and-8/hh448170(v=win.10)


  System PerformanceSystem Performance

Processes page in Windows Device Portal on Microsoft HoloLens

Shows details about currently running processes. This includes both apps and system processes.

System Performance page in Windows Device Portal on Microsoft HoloLens

Shows real-time graphs of system diagnostic info, like power usage, frame rate, and CPU load.

These are the available metrics:

SoC powerSoC power : Instantaneous system-on-chip power usage, averaged over one minute

System powerSystem power : Instantaneous system power usage, averaged over one minute

Frame rateFrame rate: Frames per second, missed VBlanks per second, and consecutive missed VBlanks

GPUGPU: GPU engine usage, percent of total available

CPUCPU: percent of total available

I/OI/O: Reads and writes

NetworkNetwork : Received and sent



  AppsApps

  App Crash DumpsApp Crash Dumps

Memor yMemor y : Total, in use, committed, paged, and non-paged

Apps page in Windows Device Portal on Microsoft HoloLens

Manages the apps that are installed on the HoloLens.

Installed appsInstalled apps : Remove and start apps.

Running appsRunning apps : Lists apps that are running currently.

Install appInstall app: Select app packages for installation from a folder on your computer/network.

DependencyDependency : Add dependencies for the app you're going to install.

DeployDeploy : Deploy the selected app + dependencies to the HoloLens.

App Crash Dumps page in Windows Device Portal on Microsoft HoloLens

This page allows you to collect crash dumps for your side-loaded apps. Check the Crash Dumps EnabledCrash Dumps Enabled



  File ExplorerFile Explorer

  Kiosk ModeKiosk Mode

NOTENOTE

checkbox for each app for which you want to collect crash dumps. Return to this page to collect crash dumps.

Dump files can be opened in Visual Studio for debugging.

File Explorer page in Windows Device Portal on Microsoft HoloLens

Use the file explorer to browse, upload, and download files. You can work with files in the Documents folder,

Pictures folder, and in the local storage folders for apps that you deployed from Visual Studio or the Device

Portal.

Kiosk mode is only available with the Microsoft HoloLens Commercial Suite.

Check the Set up HoloLens in kiosk mode article in Windows IT Pro Center for up-to-date instructions on

https://docs.microsoft.com/en-us/previous-versions/visualstudio/visual-studio-2015/debugger/using-dump-files
https://docs.microsoft.com/en-us/hololens/hololens-commercial-features
https://docs.microsoft.com/en-us/hololens/hololens-kiosk#set-up-kiosk-mode-using-the-windows-device-portal-windows-10-version-1607-and-version-1803


  LoggingLogging

  SimulationSimulation

enabling kiosk mode via Windows Device Portal.

Logging page in Windows Device Portal on Microsoft HoloLens

Manages real-time Event Tracing for Windows (ETW) on the HoloLens.

Check Hide providersHide providers  to show the EventsEvents  list only.

Registered providersRegistered providers : Select the ETW provider and the tracing level. Tracing level is one of these values:

1. Abnormal exit or termination

2. Severe errors

3. Warnings

4. Non-error warnings

Select or tap EnableEnable to start tracing. The provider is added to the Enabled ProvidersEnabled Providers  dropdown.

Custom providersCustom providers : Select a custom ETW provider and the tracing level. Identify the provider by its GUID.

Don't include brackets in the GUID.

Enabled providersEnabled providers : Lists the enabled providers. Select a provider from the dropdown and click or tap

DisableDisable to stop tracing. Click or tap Stop allStop all  to suspend all tracing.

Providers histor yProviders histor y : Shows the ETW providers that were enabled during the current session. Click or tap

EnableEnable to activate a provider that was disabled. Click or tap ClearClear  to clear the history.

EventsEvents : Lists ETW events from the selected providers in table format. This table is updated in real time.

Beneath the table, click the ClearClear  button to delete all ETW events from the table. This doesn't disable any

providers. You can click Save to fileSave to file to export the currently collected ETW events to a CSV file locally.

FiltersFilters : Allow you to filter the ETW events collected by ID, Keyword, Level, Provider Name, Task Name, or Text.

You can combine several criteria together :

1. For criteria applying to the same property, events that can satisfy any one of these criteria are shown.

2. For criteria applying to a different property, events must satisfy all of the criteria

For example, you can specify the criteria (Task Name contains 'Foo' or 'Bar') AND (Text contains 'error' or

'warning')



  NetworkingNetworking

Simulation page in Windows Device Portal on Microsoft HoloLens

Allows you to record and play back input data for testing.

Capture roomCapture room: Used to download a simulated room file that contains the spatial mapping mesh for the

user's surroundings. Name the room and then click CaptureCapture to save the data as an .xef file on your PC. This

room file can be loaded into the HoloLens emulator.

RecordingRecording: Check the streams to record, name the recording, and click or tap RecordRecord to start recoding.

Perform actions with your HoloLens and then click StopStop to save the data as an .xef file on your PC. This file

can be loaded on the HoloLens emulator or device.

NOTENOTE

PlaybackPlayback : Click or tap Upload recordingUpload recording to select a xef file from your PC and send the data to the

HoloLens.

Control modeControl mode: Select DefaultDefault or S imulationSimulation from the dropdown, and click or tap the SetSet button to select

the mode on the HoloLens. Choosing "Simulation" disables the real sensors on your HoloLens and uses

uploaded simulated data instead. If you switch to "Simulation", your HoloLens won't respond to the real user

until you switch back to "Default".

The Recording feature is currently only available on the HoloLens 1st gen. Recording is not yet supported on

HoloLens 2, but Playback of existing recordings is supported.



  PowerThermalSDK TestPowerThermalSDK Test

NOTENOTE

Networking page in Windows Device Portal on Microsoft HoloLens

Manages Wi-Fi connections on the HoloLens.

WiFi adaptersWiFi adapters : Select a Wi-Fi adapter and profile by using the dropdown controls. Click or tap ConnectConnect to

use the selected adapter.

Available networksAvailable networks : Lists the Wi-Fi networks that the HoloLens can connect to. Click or tap RefreshRefresh to

update the list.

IP configurationIP configuration: Shows the IP address and other details of the network connection.

PowerThermalSDK Test page in Windows Device Portal on Microsoft HoloLens

For use with the PowerThermalNotification SDK. See Managing power and thermals.

Use this page to monitor and control the mitigation levels and thermal scores used with the SDK. The page also

provides details on which peripherals are having their mitigations suppressed by active applications.

This page is only available in OS builds that support the PowerThermalNotification SDK



  Virtual InputVirtual Input

 Device Portal REST APIs

 Troubleshooting
  How to fix the "It's lonely here" messageHow to fix the "It's lonely here" message

NOTENOTE

Virtual Input page in Windows Device Portal on Microsoft HoloLens

Sends keyboard input from the remote machine to the HoloLens.

Click or tap the region under Vir tual keyboardVir tual keyboard to enable sending keystrokes to the HoloLens. Type in the

Input textInput text textbox and click or tap SendSend to send the keystrokes to the active app.

Everything in the Device Portal is built on top of REST APIs that you can optionally use to access the data and

control your device programmatically.

Going from a HoloLens 2 to HoloLens (1st gen) may cause the pages to become lonely if used on the HoloLens 2 prior to

use on the HoloLens (1st gen).



1. Select Reset layoutReset layout from the top-left Menu:

2. Click Reset layoutReset layout under the Reset workspaceReset workspace heading. The portal page will automatically refresh and

display your content.





   

 

Performance tracing with HoloLens
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 Use WPA to analyze performance traces

  InstallationInstallation

  TerminologyTerminology

Performance tracing with HoloLens is a powerful way to find and resolve computational or hardware

bottlenecks. When traces are analyzed with the Windows Performance Analyzer, you're able to visualize and

explore hardware or software bottlenecks. Examples of this might be something that's causing a HoloLens to

overheat or CPU processes that are especially taxing on the system.

Performance Trace Analysis in WPA

To get a detailed understanding of system and application behavior and resource usage for HoloLens, you can

use the performance tracing feature. This feature captures Windows Performance Recorder traces in the form of

an event trace log (ETL) file for use in the Windows Performance Analyzer (WPA).

To analyze a trace file, download WPA from the Microsoft Store.

For more general purpose debugging tools, you can also use the Windows Performance Toolkit. To get this

toolkit, download the Windows Assessment and Deployment Kit.

When searching for information about performance traces, you'll inevitably come across a range of terms. The

most important ones are:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/hololens-performance-tracing-howto.md
https://docs.microsoft.com/en-us/previous-versions/windows/it-pro/windows-8.1-and-8/hh448205(v=win.10)
https://docs.microsoft.com/en-us/previous-versions/windows/it-pro/windows-8.1-and-8/hh448170(v=win.10)
https://www.microsoft.com/en-us/p/windows-performance-analyzer/9n0w1b2bxgnz
https://docs.microsoft.com/en-us/windows-hardware/test/wpt/
https://docs.microsoft.com/en-us/windows-hardware/get-started/adk-install


T ERMT ERM DEF IN IT IO NDEF IN IT IO N

ETWETW Event Tracing for Windows: The overarching name for kernel-
level tracing facility that's built into Windows.

ETLETL Event Trace Log: The file extension for files that store the
tracing data. Thus, when you do a trace, you typically will
have an *.etl  file afterwards.

WPRWPR Windows Performance Recorder: The application that starts
and stops the recording of event traces. WPR takes a profile
file (*.wprp)  that configures which exact events to log.

Below, you’ll learn how to do a trace for HoloLens through
the Windows Device Portal.

WPAWPA Windows Performance Analyzer: A GUI application that's
used to open *.etl  files and sift through data to identify

performance issues. WPA allows you to sort data by various
criteria, display the data in several ways, dig down into
details, and correlate information.

 Recording a trace on HoloLens

  Perform a tracePerform a trace

Generate an ETL file using the Device Portal in your HoloLens.

Performance tracing page in Device Portal for HoloLens 2

1. On the left, navigate to PerformancePerformance > Performance TracingPerformance Tracing.

2. Choose an available profile or select Custom profilesCustom profiles  > BrowseBrowse then do one of the following:

3. Click Star t TraceStar t Trace.

4. The HoloLens is now recording a trace. Make sure to trigger the performance issues that you want to

investigate, and then select Stop TraceStop Trace.

Use your own custom profile

Use this example profile to analyze CPU performance

Create your own custom profile

https://docs.microsoft.com/en-us/windows/win32/etw/about-event-tracing
https://docs.microsoft.com/en-us/windows-hardware/drivers/devtest/trace-log
https://docs.microsoft.com/en-us/windows-hardware/test/wpt/windows-performance-recorder
https://docs.microsoft.com/en-us/windows-hardware/test/wpt/windows-performance-analyzer
https://aka.ms/CPUProfileforDevicePortal
https://docs.microsoft.com/en-us/windows-hardware/test/wpt/authoring-recording-profiles/


 Analyzing traces with WPA

  Perform analysis of trace filePerform analysis of trace file

5. The trace will be listed at the bottom of the webpage. Select the disk icon at the right-hand side to download

the ETL file.

You now have an ETL file that you can either open directly in WPA or send to someone else.

Windows Performance Analyzer is the standard tool to visualize traces as graphs and tables to allow you to

analyze system and application performance. WPA is a powerful, multifaceted tool, so we won't explain it in

detail here. For more detail, use the Step-by-step guide to use Windows Performance Analyzer.

To learn more about WPA, have a look at these resources:

Watch the introductory videos for a first overview.

WPA itself has a Getting Started tab, which explains common steps.

Learn about the WPA User Interface.

There's excellent information on this website--however, not all of it's relevant for beginners.

Files you need for WPA trace analysisFiles you need for WPA trace analysis

There are several files you'll need to analyze your trace file in WPA. We've included an example WPA profile to

help you get started.

HoloLens trace file (*.etl)

Symbol file (*.pdb) . Make sure it's extracted (not zipped).

WPA profile (*.wpaProfile) . Use this example WPA Profile for CPU analysis.

Folder_for_WPA_files
  ├─ HoloLens_trace_file.elt - # HoloLens trace file (*.etl)
  ├─ CPU_analysis.wpaProfile - # WPA Profile (*.wpaProfile)
  └─ Symbols - # Make sure it's extracted (not zipped).
    ├─ *.pdb
    ├─ *.pdb
    └─ ...

1. Set up your files in a folder for WPA to access them.

ExampleExample

2. Launch the Windows Performance Analyzer (WPA).

3. Open the ETL trace file by selecting FileFile > OpenOpen > select the .etl  in your file browser.

https://docs.microsoft.com/en-us/windows-hardware/test/wpt/wpa-step-by-step-guide
https://docs.microsoft.com/en-us/windows-hardware/test/wpt/windows-performance-analyzer
https://docs.microsoft.com/en-us/windows-hardware/test/wpt/wpa-in-product-getting-started-help
https://docs.microsoft.com/en-us/windows-hardware/test/wpt/introduction-to-the-wpa-user-interface
https://aka.ms/CPUProfileforWPA
https://www.microsoft.com/store/productId/9N0W1B2BXGNZ


4. Load symbol file into WPA by selecting TraceTrace > Load SymbolsLoad Symbols .



TIPTIP
Configure extra symbol paths by selecting TraceTrace > Configure Symbol PathsConfigure Symbol Paths .

5. Apply WPA profile to generate graphs for analysis. In your WPA folder, select ProfilesProfiles  > ApplyApply  > BrowseBrowse

> choose the *.wpaProfile  file > ApplyApply .

6. Once graphs are selected, WPA will display them in the Analysis tab.

Dive DeeperDive Deeper

To learn more about WPA, see the WPA documentation.

https://docs.microsoft.com/en-us/windows-hardware/test/wpt/windows-performance-analyzer


 Next steps
Dive deeper into WPA or learn more about performance tracing.

Step-by-step guide to use Windows Performance Analyzer

Authoring Recording Profiles

https://docs.microsoft.com/en-us/windows-hardware/test/wpt/wpa-step-by-step-guide.md
https://docs.microsoft.com/en-us/windows-hardware/test/wpt/authoring-recording-profiles
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 App deployment

 Dump collection

Everything in the Windows Device Portal is built on top of REST API's that you can use to access the data and

control your device programmatically.

/api/app/packagemanager/package (DELETE)/api/app/packagemanager/package (DELETE)

Uninstalls an app.

Parameters

package: File name of the package to be uninstalled.

/api/app/packagemanager/package (POST)/api/app/packagemanager/package (POST)

Installs an App.

Parameters

package: File name of the package to be installed.

Payload

multi-part conforming http body

/api/app/packagemanager/packages (GET)/api/app/packagemanager/packages (GET)

Retrieves the list of installed apps on the system. Includes details.

Return data

List of installed packages with details

/api/app/packagemanager/state (GET)/api/app/packagemanager/state (GET)

Gets the status of in-progress app installation.

/api/debug/dump/usermode/crashcontrol (DELETE)/api/debug/dump/usermode/crashcontrol (DELETE)

Disables crash dump collection for a sideloaded app.

Parameters

packageFullname: package name

/api/debug/dump/usermode/crashcontrol (GET)/api/debug/dump/usermode/crashcontrol (GET)

Gets settings for sideloaded apps crash dump collection.

Parameters

packageFullname: package name

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/device-portal-api-reference.md


 ETW

 Holographic OS

/api/debug/dump/usermode/crashcontrol (POST)/api/debug/dump/usermode/crashcontrol (POST)

Enables and sets dump control settings for a sideloaded app.

Parameters

packageFullname: package name

/api/debug/dump/usermode/crashdump (DELETE)/api/debug/dump/usermode/crashdump (DELETE)

Deletes a crash dump for a sideloaded app.

Parameters

packageFullname: package name

fileName: dump file name

/api/debug/dump/usermode/crashdump (GET)/api/debug/dump/usermode/crashdump (GET)

Retrieves a crash dump for a sideloaded app.

Parameters

packageFullname: package name

fileName: dump file name

Return data

Dump file. Inspect with WinDbg or Visual Studio.

/api/debug/dump/usermode/dumps (GET)/api/debug/dump/usermode/dumps (GET)

Returns list of all crash dumps for sideloaded apps.

Return data

List of crash dumps per side loaded app

/api/etw/providers (GET)/api/etw/providers (GET)

Enumerates registered providers.

Return data

List of providers, friendly name and GUID

/api/etw/session/realtime (GET/WebSocket)/api/etw/session/realtime (GET/WebSocket)

Creates a real-time ETW session; managed over a websocket.

Return data

ETW events from the enabled providers

/api/holographic/os/etw/customproviders (GET)/api/holographic/os/etw/customproviders (GET)

Returns a list of HoloLens-specific ETW providers that aren't registered with the system.

/api/holographic/os/ser vices (GET)/api/holographic/os/ser vices (GET)



 Holographic Perception

 Holographic Thermal

Returns the states of all services running.

/api/holographic/os/settings/ipd (GET)/api/holographic/os/settings/ipd (GET)

Gets the stored IPD (Interpupillary distance) in millimeters.

/api/holographic/os/settings/ipd (POST)/api/holographic/os/settings/ipd (POST)

Sets the IPD.

Parameters

ipd: New IPD value to be set in millimeters

/api/holographic/os/webmanagement/settings/https (GET)/api/holographic/os/webmanagement/settings/https (GET)

Gets HTTPS requirements for the Device Portal.

/api/holographic/os/webmanagement/settings/https (POST)/api/holographic/os/webmanagement/settings/https (POST)

Sets HTTPS requirements for the Device Portal.

Parameters

required: yes, no or default

/api/holographic/perception/client (GET/WebSocket)/api/holographic/perception/client (GET/WebSocket)

Accepts WebSocket upgrades and runs a perception client that sends updates at 30 fps.

Parameters

clientmode: "active" forces visual tracking mode when it can't be established passively

When using these thermal APIs, reference the managing power and thermals article.

/api/holographic/thermal/stage (GET)/api/holographic/thermal/stage (GET)

Get the thermal stage of the device (0 normal, 1 warm, 2 critical).

/api/holographic/thermal/getMitigationLevels (GET/websocket)/api/holographic/thermal/getMitigationLevels (GET/websocket)

Open a websocket (or do a single HTTP GET query), returning a list of objects containing the following:

IsSuppressed - Identifying if a given peripheral has mitigations suppressed

Level - Latest thermal mitigation level for this peripheral

Mask - Mask of this peripheral

ThermalScore - Latest thermal score for this peripheral

Objects are named by peripheral name (Example: Battery)

/api/holographic/thermal/setMitigationLevel (POST)/api/holographic/thermal/setMitigationLevel (POST)

Change the mitigation level being reported for a given peripheral

Parameters

mask: bitmask with single bit set for the peripheral of interest (See PowerThermalPeripheralFlags for details)

level: new level to use (0-3)

https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalperipheralflags


 Map Manager

  Download/Upload/Delete FilesDownload/Upload/Delete Files

$.post("/api/holographic/mapmanager/download?FileName=" + spaceID)

/api/holographic/thermal/setThermalScore (POST)/api/holographic/thermal/setThermalScore (POST)

Change the thermal score being reported for a given peripheral

Parameters

mask: bitmask with single bit set for the peripheral of interest (See PowerThermalPeripheralFlags for details)

thermalScore: new thermal score to use (100-0)

/api/holographic/mapmanager/mapFiles (GET)/api/holographic/mapmanager/mapFiles (GET)

Gets the list of the available map files (.mapx).

/api/holographic/mapmanager/anchorFiles (GET)/api/holographic/mapmanager/anchorFiles (GET)

Gets the list of available anchor files (.ancx).

/api/holographic/mapmanager/srdbFiles (GET)/api/holographic/mapmanager/srdbFiles (GET)

Gets the list of available spatial reconstruction database files (.srdb).

/api/holographic/mapmanager/getanchors (GET)/api/holographic/mapmanager/getanchors (GET)

Gets the list of persisted anchors for the current user.

/api/holographic/mapmanager/download (GET)/api/holographic/mapmanager/download (GET)

Downloads a map, anchor, or spatial reconstruction database file. The file must've been previously uploaded or

exported.

Parameters

FileName: Name of file to download.

Example:

/api/holographic/mapmanager/upload (POST)/api/holographic/mapmanager/upload (POST)

Uploads a map, anchor, or spatial reconstruction database file. Once a file is uploaded, it can later be imported

and used by the system.

Parameters

file: Name of the file to upload.

Example:

https://docs.microsoft.com/en-us/dotnet/api/microsoft.mixedreality.powerthermalnotification.powerthermalperipheralflags


var form_data = new FormData();
form_data.append("file", file_data);

$.ajax({
    url: "/api/holographic/mapmanager/upload",
    dataType: 'json',
    cache: false,
    contentType: false,
    processData: false,
    data: form_data,
    type: 'post'
})

$.post("/api/holographic/mapmanager/delete?FileName=" + spaceID)

  ExportExport

$.post("/api/holographic/mapmanager/export")

$.post("/api/holographic/mapmanager/exportanchors")

$.post("/api/holographic/mapmanager/exportmapandanchors")

$.post("/api/holographic/mapmanager/exportmapandspatialmappingdb")

/api/holographic/mapmanager/delete (POST)/api/holographic/mapmanager/delete (POST)

Deletes a map, anchor, or spatial reconstruction database file. The file must've been previously uploaded or

exported.

Parameters

FileName: Name of file to delete.

Example:

/api/holographic/mapmanager/expor t (POST)/api/holographic/mapmanager/expor t (POST)

Exports the map currently in use by the system. Once exported, it can be downloaded.

Example:

/api/holographic/mapmanager/expor tanchors (POST)/api/holographic/mapmanager/expor tanchors (POST)

Exports the map currently in use by the system. Once exported, it can be downloaded. Example:

/api/holographic/mapmanager/expor tmapandanchors (POST)/api/holographic/mapmanager/expor tmapandanchors (POST)

Exports the map and anchors currently in use by the system. Once exported, they can be downloaded. Example:

/api/holographic/mapmanager/expor tmapandspatialmappingdb (POST)/api/holographic/mapmanager/expor tmapandspatialmappingdb (POST)

Exports the map and spatial reconstruction database currently in use by the system. Once exported, they can be

downloaded.

Example:



  ImportImport

$.post("/api/holographic/mapmanager/import?FileName=" + spaceID, function() { alert("Import was 
successful!"); })

$.post("/api/holographic/mapmanager/import?FileName=" + spaceID, function() { alert("Import was 
successful!"); })

$.post("/api/holographic/mapmanager/import?FileName=" + spaceID, function() { alert("Import was 
successful!"); })

  OtherOther

$.post("/api/holographic/mapmanager/resetmapandanchorsandsrdb")

 Mixed Reality Capture

/api/holographic/mapmanager/impor t (POST)/api/holographic/mapmanager/impor t (POST)

Indicates to the system which map should be used. Can be called on files that have been exported or uploaded.

Parameters

FileName: Name of the map to be used.

Example:

/api/holographic/mapmanager/impor tanchors (POST)/api/holographic/mapmanager/impor tanchors (POST)

Indicates to the system which anchors should be used. Can be called on files that have been exported or

uploaded.

Parameters

FileName: Name of the anchors to be used.

Example:

/api/holographic/mapmanager/impor tspatialmappingdb (POST)/api/holographic/mapmanager/impor tspatialmappingdb (POST)

Indicates to the system which spatial reconstruction database should be used. Can be called on files that have

been exported or uploaded.

Parameters

FileName: Name of the spatial mapping db to be used.

Example:

/api/holographic/mapmanager/resetmapandanchorsandsrdb (POST)/api/holographic/mapmanager/resetmapandanchorsandsrdb (POST)

Reset the system the map, anchors and spatial reconstruction database.

Example:

/api/holographic/mapmanager/status (GET)/api/holographic/mapmanager/status (GET)

Gets the status of the system, including which map, anchors, and spatial reconstruction database files were last

imported.



{"IsRecording": boolean}

/api/holographic/mrc/file (GET)/api/holographic/mrc/file (GET)

Downloads a mixed reality file from the device. Use the op=stream query parameter for streaming.

Parameters

filename: Name, hex64 encoded, of the video file to get

op: stream

/api/holographic/mrc/file (DELETE)/api/holographic/mrc/file (DELETE)

Deletes a mixed reality recording from the device.

Parameters

filename: Name, hex64 encoded, of the file to delete

/api/holographic/mrc/files (GET)/api/holographic/mrc/files (GET)

Returns the list of mixed reality files stored on the device.

/api/holographic/mrc/photo (POST)/api/holographic/mrc/photo (POST)

Takes a mixed reality photo and creates a file on the device.

Parameters

holo: capture holograms: true or false (defaults to false)

pv: capture PV camera: true or false (defaults to false)

RenderFromCamera: (HoloLens 2 only) render from perspective of photo/video camera: true or false

(defaults to true)

/api/holographic/mrc/settings (GET)/api/holographic/mrc/settings (GET)

Gets the default mixed reality capture settings.

/api/holographic/mrc/settings (POST)/api/holographic/mrc/settings (POST)

Sets the default mixed reality capture settings. Some of these settings are applied to the system's MRC photo

and video capture.

/api/holographic/mrc/status (GET)/api/holographic/mrc/status (GET)

Gets the state of mixed reality capture within the Windows Device Portal.

ResponseResponse

The response contains a JSON property that indicates if Windows Device Portal is recording video or not.

/api/holographic/mrc/thumbnail (GET)/api/holographic/mrc/thumbnail (GET)

Gets the thumbnail image for the specified file.

Parameters

filename: Name, hex64 encoded, of the file for which the thumbnail is being requested

/api/holographic/mrc/video/control/star t (POST)/api/holographic/mrc/video/control/star t (POST)

Starts a mixed reality recording.



 Mixed Reality Streaming
C a u t i o nC a u t i o n

 Networking

Parameters

holo: capture holograms: true or false (defaults to false)

pv: capture PV camera: true or false (defaults to false)

mic: capture microphone: true or false (defaults to false)

loopback: capture app audio: true or false (defaults to false)

RenderFromCamera: (HoloLens 2 only) render from perspective of photo/video camera: true or false

(defaults to true)

vstab: (HoloLens 2 only) enable video stabilization: true or false (defaults to true)

vstabbuffer : (HoloLens 2 only) video stabilization buffer latency: 0 to 30 frames (defaults to 15 frames)

/api/holographic/mrc/video/control/stop (POST)/api/holographic/mrc/video/control/stop (POST)

Stops the current mixed reality recording.

Because of loopback isolation, you can't connect to mixed reality streaming from inside an app on a device.

HoloLens supports live preview of mixed reality via chunked download of a fragmented mp4.

Mixed reality streams share the same set of parameters to control what's captured:

holo: capture holograms: true or false

pv: capture PV camera: true or false

mic: capture microphone: true or false

loopback: capture app audio: true or false

If none of these are specified, then holograms, photo/video camera, and app audio will be captured.

If any are specified, the unspecified parameters will default to false

Optional parameters (HoloLens 2 only)

RenderFromCamera: render from perspective of photo/video camera: true or false (defaults to true)

vstab: enable video stabilization: true or false (defaults to false)

vstabbuffer : video stabilization buffer latency: 0 to 30 frames (defaults to 15 frames)

/api/holographic/stream/live.mp4 (GET)/api/holographic/stream/live.mp4 (GET)

A 1280x720p 30fps 5Mbit stream.

/api/holographic/stream/live_high.mp4 (GET)/api/holographic/stream/live_high.mp4 (GET)

A 1280x720p 30fps 5Mbit stream.

/api/holographic/stream/live_med.mp4 (GET)/api/holographic/stream/live_med.mp4 (GET)

A 854x480p 30fps 2.5Mbit stream.

/api/holographic/stream/live_low.mp4 (GET)/api/holographic/stream/live_low.mp4 (GET)

A 428x240p 15fps 0.6Mbit stream.

/api/networking/ipconfig (GET)/api/networking/ipconfig (GET)



 OS Information

 Perception Simulation Control

 Perception Simulation Playback

Gets the current IP configuration.

/api/os/info (GET)/api/os/info (GET)

Gets operating system information.

/api/os/machinename (GET)/api/os/machinename (GET)

Gets the machine name.

/api/os/machinename (POST)/api/os/machinename (POST)

Sets the machine name.

Parameters

name: New machine name, hex64 encoded, to set to

/api/holographic/simulation/control/mode (GET)/api/holographic/simulation/control/mode (GET)

Gets the simulation mode.

/api/holographic/simulation/control/mode (POST)/api/holographic/simulation/control/mode (POST)

Sets the simulation mode.

Parameters

mode: simulation mode: default, simulation, remote, legacy

/api/holographic/simulation/control/stream (DELETE)/api/holographic/simulation/control/stream (DELETE)

Delete a control stream.

/api/holographic/simulation/control/stream (GET/WebSocket)/api/holographic/simulation/control/stream (GET/WebSocket)

Open a WebSocket connection for a control stream.

/api/holographic/simulation/control/stream (POST)/api/holographic/simulation/control/stream (POST)

Create a control stream (priority is required) or post data to a created stream (streamId required). Posted data is

expected to be of type 'application/octet-stream'.

/api/holographic/simulation/display/stream (GET/WebSocket)/api/holographic/simulation/display/stream (GET/WebSocket)

Request a simulation video stream containing the content rendered to the system display when in 'Simulation'

mode. A simple format descriptor header will be sent initially, followed by H.264-encoded textures, with each

preceded by a header indicating the eye index and texture size.

/api/holographic/simulation/playback/file (DELETE)/api/holographic/simulation/playback/file (DELETE)

Delete a recording.

Parameters

recording: Name of recording to delete.



/api/holographic/simulation/playback/file (POST)/api/holographic/simulation/playback/file (POST)

Upload a recording.

/api/holographic/simulation/playback/files (GET)/api/holographic/simulation/playback/files (GET)

Get all recordings.

/api/holographic/simulation/playback/session (GET)/api/holographic/simulation/playback/session (GET)

Get the current playback state of a recording.

Parameters

recording: Name of recording.

/api/holographic/simulation/playback/session/file (DELETE)/api/holographic/simulation/playback/session/file (DELETE)

Unload a recording.

Parameters

recording: Name of recording to unload.

/api/holographic/simulation/playback/session/file (POST)/api/holographic/simulation/playback/session/file (POST)

Load a recording.

Parameters

recording: Name of recording to load.

/api/holographic/simulation/playback/session/files (GET)/api/holographic/simulation/playback/session/files (GET)

Get all loaded recordings.

/api/holographic/simulation/playback/session/pause (POST)/api/holographic/simulation/playback/session/pause (POST)

Pause a recording.

Parameters

recording: Name of recording.

/api/holographic/simulation/playback/session/play (POST)/api/holographic/simulation/playback/session/play (POST)

Play a recording.

Parameters

recording: Name of recording.

/api/holographic/simulation/playback/session/stop (POST)/api/holographic/simulation/playback/session/stop (POST)

Stop a recording.

Parameters

recording: Name of recording.

/api/holographic/simulation/playback/session/types (GET)/api/holographic/simulation/playback/session/types (GET)

Get the types of data in a loaded recording.

Parameters



 Perception Simulation Recording

 Performance data

 Power

 Remote Control

recording: Name of recording.

/api/holographic/simulation/recording/star t (POST)/api/holographic/simulation/recording/star t (POST)

Start a recording. Only a single recording can be active at once. One of these must be set: head, hands,

spatialMapping or environment.

Parameters

head: Set to 1 to record head data.

hands: Set to 1 to record hand data.

spatialMapping: Set to 1 to record spatial mapping.

environment: Set to 1 to record environment data.

name: Name of the recording.

singleSpatialMappingFrame: Set to 1 to record only a single spatial mapping frame.

/api/holographic/simulation/recording/status (GET)/api/holographic/simulation/recording/status (GET)

Get recording state.

/api/holographic/simulation/recording/stop (GET)/api/holographic/simulation/recording/stop (GET)

Stop the current recording. Recording will be returned as a file.

/api/resourcemanager/processes (GET)/api/resourcemanager/processes (GET)

Returns the list of running processes with details.

Return data

JSON with list of processes and details for each process

/api/resourcemanager/systemperf (GET)/api/resourcemanager/systemperf (GET)

Returns system perf statistics (I/O read/write, memory stats, etc.

Return data

JSON with system information: CPU, GPU, Memory, Network, IO

/api/power/batter y (GET)/api/power/batter y (GET)

Gets the current battery state.

/api/power/state (GET)/api/power/state (GET)

Checks if the system is in a low power state.

/api/control/restar t (POST)/api/control/restar t (POST)

Restarts the target device.



 Task Manager

 WiFi Management

/api/control/shutdown (POST)/api/control/shutdown (POST)

Shuts down the target device.

/api/taskmanager/app (DELETE)/api/taskmanager/app (DELETE)

Stops a modern app.

Parameters

package: Full name of the app package, hex64 encoded

forcestop: Force all processes to stop (=yes)

/api/taskmanager/app (POST)/api/taskmanager/app (POST)

Starts a modern app

Parameters

appid: PRAID of app to start, hex64 encoded

package: Full name of the app package, hex64 encoded

/api/wifi/interfaces (GET)/api/wifi/interfaces (GET)

Enumerates wireless network interfaces.

Return data

List of wireless interfaces with details (GUID, description etc.)

/api/wifi/network (DELETE)/api/wifi/network (DELETE)

Deletes a profile associated with a network on a specified interface.

Parameters

interface: network interface guid

profile: profile name

/api/wifi/networks (GET)/api/wifi/networks (GET)

Enumerates wireless networks on the specified network interface.

Parameters

interface: network interface guid

Return data

List of wireless networks found on the network interface with details

/api/wifi/network (POST)/api/wifi/network (POST)

Connects or disconnects to a network on the specified interface.

Parameters

interface: network interface guid



 Windows Performance Recorder

 See also

ssid: ssid, hex64 encoded, to connect to

op: connect or disconnect

createprofile: yes or no

key: shared key, hex64 encoded

/api/wpr/customtrace (POST)/api/wpr/customtrace (POST)

Uploads a WPR profile and starts tracing using the uploaded profile.

Payload

multi-part conforming http body

Return data

Returns the WPR session status.

/api/wpr/status (GET)/api/wpr/status (GET)

Retrieves the status of the WPR session

Return data

WPR session status.

/api/wpr/trace (GET)/api/wpr/trace (GET)

Stops a WPR (performance) tracing session.

Return data

Returns the trace ETL file

/api/wpr/trace (POST)/api/wpr/trace (POST)

Starts a WPR (performance) tracing session.

Parameters

profile: Profile name. Available profiles are stored in perfprofiles/profiles.json

Return data

On start, returns the WPR session status.

Using the Windows Device Portal

Device Portal core API reference (UWP)

https://docs.microsoft.com/en-us/windows/uwp/debug-test-perf/device-portal-api-core
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IMPORTANTIMPORTANT

 Usage

Research Mode was introduced on HoloLens (1st Gen) devices to give access to key sensors, specifically for

research applications that aren't intended for deployment. Research Mode for HoloLens 2 keeps the capabilities

of HoloLens 1 but adds access to the following streams:

Visible L ight Environment Tracking CamerasVisible L ight Environment Tracking Cameras  - Gray-scale cameras used by the system for head

tracking and map building.

Depth CameraDepth Camera – Operates in two modes:

AHAT, high-frequency (45 FPS) near-depth sensing used for hand tracking. Differently from the first

version short-throw mode, AHAT gives pseudo-depth with phase wrap beyond 1 meter.

Long-throw, low-frequency (1-5 FPS) far-depth sensing used by Spatial Mapping

Two versions of the IR-reflectivity streamTwo versions of the IR-reflectivity stream - Used by the HoloLens to compute depth. These images

are illuminated by infrared and unaffected by ambient visible light.

If you're using a HoloLens 2, you also have access to the additional inputs below:

AccelerometerAccelerometer  – Used by the system to determine linear acceleration along the X, Y, and Z axes and gravity.

GyroGyro – Used by the system to determine rotations.

MagnetometerMagnetometer  – Used by the system to estimate absolute orientation.

Research Mode is currently in Public Preview.

A mixed reality capture of a test application that displays the eight sensor streams available in Research Mode

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/research-mode.md


 Security and performance

 Device support

FeatureFeature HoloLens first GenHoloLens first Gen HoloLens 2HoloLens 2

Head Tracking Cameras ✔️ ✔️

Depth & IR Camera ✔️ ✔️

Accelerometer ❌ ✔️

Gyroscope ❌ ✔️

Magnetometer ❌ ✔️

 Enabling Research Mode (HoloLens first Gen and HoloLens 2)

Research Mode is designed for academic and industrial researchers exploring new ideas in the fields of

Computer Vision and Robotics. It's not intended for applications deployed in enterprise environments or

available through the Microsoft Store or other distribution channels.

Additionally, Microsoft doesn't provide assurances that Research Mode or equivalent functionality is going to be

supported in future hardware or OS updates. However, don't let that stop you from using it to develop and test

new ideas!

Enabling Research Mode uses more battery power than using the HoloLens 2 under normal conditions, even if

the application using the Research Mode features isn't running. Enabling this mode can also lower the overall

security of your device because applications may misuse sensor data. You can find more information on device

security in the HoloLens security FAQ.

Research Mode is an extension of Developer Mode. Before starting, the developer features of the device need to

be enabled to access the Research Mode settings:

Open Star t Menu > SettingsStar t Menu > Settings  and select UpdatesUpdates .

Select For DevelopersFor Developers  and enable Developer ModeDeveloper Mode.

Scroll down and enable Device Por talDevice Por tal .

After the developer features are enabled, connect to the device portal to enable the Research Mode features:

Go to System > Research ModeSystem > Research Mode in the Device Por talDevice Por tal .

Select Allow access to sensor streamAllow access to sensor stream.

Restart the device from the PowerPower  menu item at the top of the page.

Once you've restarted the device, the applications loaded through the Device Por talDevice Por tal  can access Research Mode

streams.

https://docs.microsoft.com/en-us/hololens/hololens1-faq-security
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/uwp/debug-test-perf/device-portal-hololens


IMPORTANTIMPORTANT

  Using sensor data in your appsUsing sensor data in your apps

 Support

 See also

Research Mode window in the HoloLens Device Portal

Research Mode for HoloLens 2 is available beginning with build 19041.1364 . If you need access in an earlier build, sign

up for our Insider Preview program. You can find more details in the Research Mode GitHub repository.

Applications can access the sensor stream data in the same way that Media Foundation accesses photo and

video camera streams.

All APIs that work for HoloLens development are also available in Research Mode. In particular, the application

knows precisely where HoloLens is in 6DoF space at each sensor frame capture time.

We have sample applications showing Research Mode stream access, using the intrinsics and extrinsics, and

recording streams:

HoloLens (first gen)

HoloLens 2

For HoloLens (first gen), use the issue tracker in the HoloLensForCV repository to post feedback and track

known issues.

For HoloLens 2, use the issue tracker in the HoloLens2ForCV repository to post feedback and track known

issues.

Microsoft Media Foundation

HoloLensForCV GitHub repo

https://docs.microsoft.com/en-us/hololens/hololens-insider
https://github.com/microsoft/HoloLens2ForCV
https://docs.microsoft.com/en-us/windows/win32/medfound/microsoft-media-foundation-sdk
https://docs.microsoft.com/en-us/windows/mixed-reality/locatable-camera#locating-the-device-camera-in-the-world
https://github.com/Microsoft/HoloLensForCV
https://github.com/microsoft/HoloLens2ForCV
https://github.com/Microsoft/HololensForCV/issues
https://github.com/microsoft/HoloLens2ForCV/issues
https://docs.microsoft.com/en-us/windows/win32/medfound/microsoft-media-foundation-sdk
https://github.com/Microsoft/HoloLensForCV


HoloLens2ForCV GitHub repo

Using the Windows Device Portal

https://github.com/microsoft/HoloLens2ForCV
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 Frame rate

  Device impactDevice impact

HoloLensHoloLens Immersive headsetsImmersive headsets

✔️ ✔️

  Quality criteriaQuality criteria

B ESTB EST M EET SM EET S FA ILFA IL

The app consistently meets frames per
second (FPS) goal for target device: 60
fps on HoloLens; 90 fps on Ultra PCs;
and 60 fps on mainstream PCs.

The app has intermittent frame drops
not impeding the core experience, or
FPS is consistently lower than desired
goal but doesn’t impede the app
experience.

The app is experiencing a drop in
frame rate on average every 10
seconds or less.

  How to measureHow to measure

  RecommendationsRecommendations

  

This document describes the top factors impacting the quality of mixed reality apps. For each factor, the

following information is provided:

Overview – a brief description of the quality factor and why it's important.

Device impact - which type of Window Mixed Reality device is affected.

Quality criteria – how to evaluate the quality factor.

How to measure – methods to measure (or experience) the issue.

Recommendations – summary of approaches to provide a better user experience.

Resources – relevant developer and design resources that are useful to create better app experiences.

Frame rate is the first pillar of hologram stability and user comfort. Frame rate below the recommended targets

can cause holograms to appear jittery, negatively impacting the believability of the experience and potentially

causing eye fatigue. The target frame rate for your experience on Windows Mixed Reality immersive headsets is

either 60 Hz or 90 Hz depending on which Windows Mixed Reality-compatible PCs you're supporting. For

HoloLens, the target frame rate is 60 Hz.

A real-time frame rate graph is provided by the Windows Device Portal under "System Performance."

For development debugging, add a frame rate diagnostic counter into the app. See Resources for a sample

counter.

Frame rate drops can be experienced in device while the app is running by moving your head from side to

side. If the hologram shows unexpected jittery movement, then low frame rate or the stability plane is likely

the cause.

Add a frame rate counter at the beginning of the development work.

Changes that incur a drop in frame rate should be evaluated and appropriately resolved as a performance

bug.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/app-quality-criteria-overview.md
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


ResourcesResources
  DocumentationDocumentation

  Tools and tutorialsTools and tutorials

  External referencesExternal references

 Hologram stability

  Device impactDevice impact

HoloLensHoloLens Immersive headsetsImmersive headsets

✔️ ❌

  Quality criteriaQuality criteria

B ESTB EST M EET SM EET S FA ILFA IL

Holograms consistently appear stable. Secondary content shows unexpected
movement; or unexpected movement
doesn't impede overall app experience.

Primary content in frame shows
unexpected movement.

  How to measureHow to measure

  RecommendationsRecommendations

Understanding Performance for Mixed Reality

Hologram stability and framerate

Asset performance budget

Performance recommendations for Unity

Mixed Reality Toolkit, FPS counter display

Mixed Reality Toolkit, Shaders

Unity, Optimizing mobile applications

Stable holograms will increase the usability and believability of your app and create a more comfortable viewing

experience for the user. The quality of hologram stability is a result of good app development and the device's

ability to understand (track) its environment. While frame rate is the first pillar of stability, other factors can

impact stability, including:

Use of the stabilization plane

Distance to spatial anchors

Tracking

While wearing the device and viewing the experience:

Move your head from side to side. If the holograms show unexpected movement, then low frame rate or

improper alignment of the stability plane to the focal plane is the likely cause.

Move around the holograms and environment and look for behaviors such as swim and jumpiness. This type

of motion is likely caused by the device not tracking the environment, or the distance to the spatial anchor.

If large or multiple holograms are in the frame, observe hologram behavior at various depths while moving

your head position from side to side. If shakiness appears, it's likely caused by the stabilization plane.

Add a frame rate counter at the beginning of the development work.

Use the stabilization plane.

Always render anchored holograms within three meters of their anchor.

Make sure your environment is set up for proper tracking.

https://github.com/Microsoft/MixedRealityToolkit-Unity/blob/htk_release/Assets/HoloToolkit/Utilities/README.md
https://github.com/Microsoft/MixedRealityToolkit-Unity/tree/htk_release/Assets/HoloToolkit/Utilities/Shaders
https://www.youtube.com/watch?v=j4YAY36xjwE
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


  ResourcesResources
  DocumentationDocumentation

  Tools and tutorialsTools and tutorials

 Holograms position on real surfaces

  Device impactDevice impact

HoloLensHoloLens Immersive headsetsImmersive headsets

✔️ ❌

  Quality criteriaQuality criteria

B ESTB EST M EET SM EET S FA ILFA IL

Holograms align to the surface
typically in the centimeters to inches
range. If you need more accuracy, the
app should provide an efficient means
for collaboration within the app spec.

NA The holograms appear unaligned with
the physical target object by either
breaking the surface plane or
appearing to float away from the
surface. If accuracy is required,
Holograms should meet the proximity
spec of the scenario.

  How to measureHow to measure

  RecommendationsRecommendations

  ResourcesResources
  DocumentationDocumentation

Design your experience to avoid holograms at various focal depth levels within the frame.

Hologram stability and framerate

Understanding Performance for Mixed Reality

Performance recommendations for Unity

Spatial anchors

Handling tracking errors

Stationary frame of reference

MR Companion Kit, Kinect IPD

Misalignments of holograms with physical objects (if intended to be placed in relation to one another) are a

clear indication of the non-union of holograms and real-world. Accuracy of the placement should be relative to

the needs of the scenario; for example, general surface placement can use the spatial map, but more accurate

placement will require some use of markers and calibration.

Holograms that are placed on spatial map shouldn't appear to dramatically float above or below the surface.

Holograms that require accurate placement should have some form of marker and calibration system that is

accurate to the scenario's requirement.

Spatial map is useful for placing objects on surfaces when precision isn’t required.

For the best precision, use markers or posters to set the holograms and an Xbox controller (or some manual

alignment mechanism) for final calibration.

Consider breaking extra-large holograms into logical parts and aligning each part to the surface.

Improperly set interpupillary distance (IPD) can also effect hologram alignment. Always configure HoloLens

to the user's IPD.

https://github.com/Microsoft/MixedRealityCompanionKit/tree/master/KinectIPD
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


  Tools and tutorialsTools and tutorials

  External referencesExternal references

 Viewing zone of comfort

  Device impactDevice impact

HoloLensHoloLens Immersive headsetsImmersive headsets

✔️ ❌

  Quality criteriaQuality criteria

Best

Meets Content is within the viewing and motion guidance, but
improper use or no use of the clipping plane.

Fail Content is presented too close (typically <1.25 m, or <50
cm for stationary holograms requiring closer observation.)

  How to measureHow to measure

Spatial mapping placement

Room scanning process

Spatial anchors best practices

Handling tracking errors

Spatial mapping in Unity

Vuforia development overview

MR Toolkit, Spatial Mapping Libraries

MR Companion Kit, Poster Calibration Sample

MR Companion Kit, Kinect IPD

Lowes Case Study, Precision alignment

App developers control where users' eyes converge by placing content and holograms at various depths. Users

wearing HoloLens will always accommodate to 2.0 m to maintain a clear image because HoloLens displays are

fixed at an optical distance approximately 2.0 m away from the user. Improper content depth can lead to visual

discomfort or fatigue.

Place content at 2 m.

When holograms cannot be placed at 2 m and
conflicts between convergence and accommodation
cannot be avoided, the optimal zone for hologram
placement is between 1.25 m and 5 m.

In every case, designers should structure content to
encourage users to interact 1+ m away (e.g. adjust
content size and default placement parameters).

Unless not required by the scenario, a clipping plane
should be implemented with fade-out starting at 1
m.

In cases where closer observation of a motionless
hologram is required, the content shouldn't be closer
than 50 cm.

For buttons, the distance should be 45 cm with a
viewing angle no smaller than 2° and sized 1.6 x 1.6
cm.

https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-expanding-the-spatial-mapping-capabilities-of-hololens
https://github.com/Microsoft/MixedRealityToolkit-Unity/blob/htk_release/Assets/HoloToolkit/SpatialMapping/README.md
https://github.com/Microsoft/MixedRealityCompanionKit/tree/master/PosterCalibrationSample
https://github.com/Microsoft/MixedRealityCompanionKit/tree/master/KinectIPD
https://www.youtube.com/watch?v=LceMdyKZ4PI
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


  RecommendationsRecommendations

  ResourcesResources

 Depth switching

  Device impactDevice impact

HoloLensHoloLens Immersive headsetsImmersive headsets

✔️ ✔️

  Quality criteriaQuality criteria

B ESTB EST M EET SM EET S FA ILFA IL

Limited or natural depth switching
that doesn’t cause the user to
unnaturally refocus.

Abrupt depth switch this is core and
designed into the app experience, or
abrupt depth switch that is caused by
unexpected real-world content.

Consistent depth switch, or abrupt
depth switching that isn’t necessary or
core to the app experience.

  How to measureHow to measure

  RecommendationsRecommendations

  ResourcesResources

 Use of spatial sound

Content should typically be 2 m away, but no closer than 1.25 or further than 5 m.

With few exceptions, the HoloLens clipping render distance should be set to 85CM with fade out of content

starting at 1 m. Approach the content and note the clipping plane effect.

Stationary content should not be closer than 50 cm away.

Design content for the optimal viewing distance of 2 m.

Set the clipping render distance to 85 cm with fade out of content starting at 1 m.

For stationary holograms that need closer viewing, the clipping plane should be no closer than 30 cm and

fade out should start at least 10 cm away from the clipping plane.

Comfort with HoloLens

Render distance

Focus point in Unity

Experimenting with scale

Text, Recommended font size

Regardless of viewing zone of comfort issues, demands for the user to switch frequently or quickly between

near and far focal objects (including holograms and real-world content) can lead to oculomotor fatigue, and

general discomfort.

If the app requires the user to consistently and/or abruptly change depth focus, there is depth switching

problem.

Keep primary content at a consistent focal plane and make sure the stabilization plane matches the focal

plane. This will alleviate oculomotor fatigue and unexpected hologram movement.

Render distance

Focus point in Unity

In Windows Mixed Reality, the audio engine provides the aural component of the mixed reality experience by

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


  Device impactDevice impact

HoloLensHoloLens Immersive headsetsImmersive headsets

✔️ ✔️

  Quality criteriaQuality criteria

B ESTB EST M EET SM EET S FA ILFA IL

Sound is logically spatialized, and the
UX appropriately uses sound to assist
with object discovery and user
feedback. Sound is natural and
relevant to objects and normalized
across the scenario.

Spatial audio is used appropriately for
believability but missing as means to
help with user feedback and
discoverability.

Sound is not spatialized as expected,
and/or lack of sound to assist user
within the UX. Or spatial audio was
not considered or used in the design
of the scenario.

  How to measureHow to measure

  RecommendationsRecommendations

  ResourcesResources
  DocumentationDocumentation

  Tools and tutorialsTools and tutorials

 Focus on holographic frame (FOV) boundaries

simulating 3D sound using direction, distance, and environmental simulations. Using spatial sound in an

application allows developers to convincingly place sounds in a 3-dimensional space (sphere) all around the

user. Those sounds will then seem as if they were coming from real physical objects or the mixed reality

holograms in the user's surroundings. Spatial sound is a powerful tool for immersion, accessibility, and UX

design in mixed reality applications.

In general, relevant sounds should emit from target holograms (eg., bark sound coming from holographic

dog.)

Sound cues should be used throughout the UX to assist the user with feedback or awareness of actions

outside the holographic frame.

Use spatial audio to assist with object discovery and user interfaces.

Real sounds work better than synthesize or unnatural sound.

Most sounds should be spatialized.

Avoid invisible emitters.

Avoid spatial masking.

Normalize all sounds.

Spatial sound

Spatial sound design

Spatial sound in Unity

Case study, Spatial sound for HoloTour

Case study, Using spatial sound in RoboRaid

Mixed Reality Toolkit - Spatial Audio

Well-designed user experiences can create and maintain useful context of the virtual environment that extends

around the users. Mitigating the effect of the FOV boundaries involves a thoughtful design of content scale and

context, use of spatial audio, guidance systems, and the user's position. If done right, the user will feel less

impaired by the FOV boundaries while having a comfortable app experience.

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://github.com/Microsoft/MixedRealityToolkit-Unity/blob/htk_release/Assets/HoloToolkit/SpatialSound/README.md


  Device impactDevice impact

HoloLensHoloLens Immersive headsetsImmersive headsets

✔️ ❌

  Quality criteriaQuality criteria

B ESTB EST M EET SM EET S FA ILFA IL

User never loses context and viewing
is comfortable. Context assistance is
provided for large objects.
Discoverability and viewing guidance is
provided for objects outside the frame.
In general, motion design and scale of
the holograms are appropriate for a
comfortable viewing experience.

User never loses context, but extra
neck motion may be required in
limited situations. In limited situations
scale causes holograms to break either
the vertical or horizontal frame causing
some neck motion to view holograms.

User likely to lose context and/or
consistent neck motion is required to
view holograms. No context guidance
for large holographic objects, moving
objects easy to lose outside the frame
with no discoverability guidance, or tall
holograms requires regular neck
motion to view.

  How to measureHow to measure

  RecommendationsRecommendations

  ResourcesResources
  DocumentationDocumentation

  External referencesExternal references

 Content reacts to user position

  Device impactDevice impact

HoloLensHoloLens Immersive headsetsImmersive headsets

✔️ ✔️

Context for a (large) hologram is lost or not understood due to being clipped at the boundaries.

Locations of holograms are hard to find due to the lack of attention directors or content that rapidly moves in

and out of the holographic frame.

Scenario requires regular and repetitive up and down head motion to fully see a hologram resulting in neck

fatigue.

Start the experience with small objects that fit the FOV, then transition with visual cues to larger versions.

Use spatial audio and attention directors to help the user find content that is outside the FOV.

As much as possible, avoid holograms that vertically clip the FOV.

Provide the user with in-app guidance for best viewing location.

Holographic frame

Case Study, HoloStudio UI and interaction design learnings

Scale of objects and environments

Cursors, Visual cues

Much ado about the FOV

Holograms should react to the user position in roughly the same ways that "real" objects do. A notable design

consideration is UI elements that can't necessarily assume a user's position is stationary and adapt to the user's

motion. Designing an app that correctly adapts to user position will create a more believable experience and

make it easier to use.

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-3-holostudio-ui-and-interaction-design-learnings
https://www.linkedin.com/pulse/hololens-much-ado-field-of-view-michael-hoffman?lipi=urn%253Ali%253Apage%253Ad_flagship3_feed%253B6iQ%252FbTevLDU93w3I2ewLJw%253D%253D
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


  Quality criteriaQuality criteria

Best Content and UI adapt to user positions allowing user to
naturally interact with content within the scope of expected
user movement.

Meets UI adapts to the user position, but may impede the view of
key content requiring the user to adjust their position.

Fail

  How to measureHow to measure

  RecommendationsRecommendations

  ResourcesResources
  DocumentationDocumentation

 Input interaction clarity

  Device impactDevice impact

HoloLensHoloLens Immersive headsetsImmersive headsets

✔️ ✔️

  Quality criteriaQuality criteria

1. UI elements are lost or locked during movement
causing user to unnaturally return to (or find)
controls.

2. UI elements limit the view of primary content.

3. UI movement isn't optimized for viewing distance
and momentum particularly with tag-along UI
elements.

All measurements should be done within a reasonable scope of the scenario. While user movement will vary,

don’t try to trick the app with extreme user movement.

For UI elements, relevant controls should be available regardless of user movement. For example, if the user

is viewing and walking around a 3D map with zoom, the zoom control should be readily available to the user

regardless of location.

The user is the camera and they control the movement. Let them drive.

Consider billboarding for text and menuing systems that would otherwise be world-locked or obscured if a

user were to move around.

Use tag-along for content that needs to follow the user while still allowing the user to see what is in front of

them.

Interaction design

Color, light, and material

Billboarding and tag-along

Instinctual interactions

Self-motion and user locomotion

Input interaction clarity is critical to an app's usability and includes input consistency, approachability,

discoverability of interaction methods. User can use platform-wide common interactions without relearning. If

the app has custom input, it should be clearly communicated and demonstrated.

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


B ESTB EST M EET SM EET S FA ILFA IL

Input interaction methods are
consistent with Windows Mixed Reality
provided guidance. Any custom input
shouldn't be redundant with standard
input (rather use standard interaction)
and must be clearly communicated
and demonstrated to the user.

Similar to best, but custom inputs are
redundant with standard input
methods. User can still achieve the
goal and progress through the app
experience.

Difficult to understand input method
or button mapping. Input is heavily
customized, doesn't support standard
input, no instructions, or likely to cause
fatigue and comfort issues.

  How to measureHow to measure

  RecommendationsRecommendations

  ResourcesResources
  DocumentationDocumentation

  Tools and tutorialsTools and tutorials

The app uses consistent standard input methods.

If the app has custom input, it's clearly communicated through:

First-run experience

Introductory screens

Tooltips

Hand coach

Help section

Voice over

Use standard input methods whenever possible.

Provide demonstrations, tutorials, and tooltips for non-standard input methods.

Use a consistent interaction model throughout the app.

Instinctual interactions

Interactable objects

Head-gaze and dwell

Cursors

Comfort and gaze

Voice input

Motion controllers

Input porting guide for Unity

Keyboard input in Unity

Gaze in Unity

Motion controllers in Unity

Gestures in Unity

Voice input in Unity

Keyboard, mouse, and controller input in DirectX

Head and eye gaze in DirectX

Hands and motion controllers in DirectX

Voice input in DirectX

Case study: The pursuit of more personal computing

Cast study: HoloStudio UI and interaction design learnings

Sample app: Periodic table of the elements

Sample app: Lunar module

https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-the-pursuit-of-more-personal-computing
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-3-holostudio-ui-and-interaction-design-learnings


 Interactable objects

  Device impactDevice impact

HoloLensHoloLens Immersive headsetsImmersive headsets

✔️ ✔️

  Quality criteriaQuality criteria

B ESTB EST M EET SM EET S FA ILFA IL

Regardless of form, interactable objects
are recognizable through visual and
audio cues across three states: idle,
targeted, and selected. "See it, say it" is
clear and consistently used
throughout the experience. Objects
are scaled and distributed to allow for
error free targeting.

User can recognize object as
interactable through audio or visual
feedback, and can target and activate
the object.

Given no visual or audio cues, user
can't recognize an interactable object.
Interactions are error prone due to
object scale or distance between
objects.

  How to measureHow to measure

  RecommendationsRecommendations

  ResourcesResources
  DocumentationDocumentation

  Tools and tutorialsTools and tutorials

 Room scanning

A button has long been a metaphor used for triggering an event in the 2D abstract world. In the three-

dimensional mixed reality world, we don’t have to be confined to this world of abstraction anymore. Anything

can be an Interactable object that triggers an event. An interactable object can be represented as anything from

a coffee cup on the table to a balloon floating in the air. Regardless of the form, interactable objects should be

clearly recognizable by the user through visual and audio cues.

Interactable objects are recognizable as 'interactable'; including buttons, menus, and app-specific content. As

a rule of thumb there should be a visual and audio cue when targeting interactable objects.

Use visual and audio feedback for interactions.

Visual feedback should be differentiated for each input state (idle, targeted, selected)

Interactable objects should be scaled and placed for error free targeting.

Grouped interactable objects (such as a menu bar or list) should have proper spacing for targeting.

Buttons and menus that support voice command should provide text labels for the command keyword ("See

it, say it")

Interactable object

Text in Unity

Bounding box and App bar

Voice input

Mixed Reality Toolkit - UX

Apps that require spatial mapping data rely on the device to automatically collect this data over time and across

sessions as the user explores their environment with the device active. The completeness and quality of this data

depends on a number of factors including the amount of exploration the user has done, how much time has

passed since the exploration and whether objects such as furniture and doors have moved since the device

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://github.com/Microsoft/MixedRealityToolkit-Unity/tree/htk_release/Assets/HoloToolkit-Examples/UX


  Device impactDevice impact

HoloLensHoloLens Immersive headsetsImmersive headsets

✔️ ❌

  Quality criteriaQuality criteria

B ESTB EST M EET SM EET S FA ILFA IL

Visualization of the spatial mesh tell
users scanning is in progress. User
clearly knows what to do and when
the scan starts and stops.

Visualization of the spatial mesh is
provided, but the user may not clearly
know what to do and no progress
information is provided.

No visualization of mesh. No guidance
information provided to the user
regarding where to look, or when the
scan starts/stops.

  How to measureHow to measure

  RecommendationsRecommendations

  ResourcesResources
  DocumentationDocumentation

  Tools and tutorialsTools and tutorials

 Directional indicators

  Device impactDevice impact

HoloLensHoloLens Immersive headsetsImmersive headsets

✔️ ✔️

  

scanned the area. Many apps will analyze the spatial mapping data at the start of the experience to judge

whether the user should perform additional steps to improve the completeness and quality of the spatial map. If

the user is required to scan the environment, clear guidance should be provided during the scanning experience.

During a required room scan, visual and audio guidance are provided indicating where to look, and when to

start and stop scanning.

Indicate how much of the total volume in the users vicinity needs to be part of the experience.

Communicate when the scan starts and stops such as a progress indicator.

Use a visualization of the mesh during the scan.

Provide visual and audio cues to encourage the user to look and move around the room.

Inform the user where to go to improve the data. In many cases, it may be best to tell the user what they

need to do (e.g. look at the ceiling, look behind furniture), in order to get the necessary scan quality.

Room scan visualization

Case study: Expanding the spatial mapping capabilities of HoloLens

Case study: Spatial sound design for HoloTour

Case study: Creating an immersive experience in Fragments

Mixed Reality Toolkit - UX

In a mixed reality app, content may be outside the field of view or occluded by real-world objects. A well-

designed app will make it easier for the user to find non-visible content. Directional indicators alert a user to

important content and provide guidance to the content relative to the user's position. Guidance to non-visible

content can take the form of sound emitters, directional arrows, or direct visual cues.

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-expanding-the-spatial-mapping-capabilities-of-hololens
https://docs.microsoft.com/en-us/windows/mixed-reality/out-of-scope/case-study-creating-an-immersive-experience-in-fragments
https://github.com/Microsoft/MixedRealityToolkit-Unity/tree/htk_release/Assets/HoloToolkit-Examples/UX
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


Quality criteriaQuality criteria

B ESTB EST M EET SM EET S FA ILFA IL

Visual and audio cues directly guide
the user to relevant content outside
the field of view.

An arrow or some indicator that points
the user in the general direction of the
content.

Relevant content is outside of the field
of view, and poor or no location
guidance is provided to the user.

  How to measureHow to measure

  RecommendationsRecommendations

  ResourcesResources

 Data loading

  Device impactDevice impact

HoloLensHoloLens Immersive headsetsImmersive headsets

✔️ ✔️

  Quality criteriaQuality criteria

B ESTB EST M EET SM EET S FA ILFA IL

Animated visual indicator, in the form
of a progress bar or ring, showing
progress during any data loading or
processing. The visual indicator
provides guidance on how long the
wait could be.

User is informed that data loading is in
progress, but there is no indication of
how long the wait could be.

No data loading or process indicators
for task taking longer than 5 seconds.

  How to measureHow to measure

  RecommendationsRecommendations

  ResourcesResources

Relevant content outside of the user field of view is discoverable through visual and/or audio cues.

When relevant content is outside the user's field of view, use directional indicators and audio cues to guide

the user to the content. In many cases, a direct visual guide is preferred over directional arrows.

Directional indicators should not be built into the cursor.

Holographic frame

A progress control provides feedback to the user that a long-running operation is underway. It can mean that

the user can't interact with the app when the progress indicator is visible and can also indicate how long the wait

time might be.

During data loading verify there is no blank state for more than 5 seconds.

Provide a data loading animator showing progress in any situation when the user may perceive this app to

have stalled or crashed. A reasonable rule of thumb is any 'loading' activity that could take more than 5

seconds.

Displaying progress

https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


   

 

Holographic Rendering overview
 7/6/2022 • 7 minutes to read • Edit Online

 Device support

FeatureFeature HoloLens (first gen)HoloLens (first gen) HoloLens 2HoloLens 2 Immersive headsetsImmersive headsets

Rendering ✔️ ✔️ ✔️

 Holographic rendering

 Predicted rendering parameters

NOTENOTE

Holographic rendering enables your application to draw a hologram at a precise location in the world around

the user, whether it's precisely placed in the physical world or within a virtual realm you've created. Holograms

are objects made of sound and light. Rendering enables your application to add the light.

Key to holographic rendering is knowing what kind of device is being used. Devices with see-throughsee-through

displaysdisplays , such as HoloLens, add light to the world. Black pixels are fully transparent, while brighter pixels are

increasingly opaque. Because the light from the displays is added to the light from the real world, white pixels

are translucent.

While stereoscopic rendering provides one depth cue for your holograms, adding grounding effects can help

users see more easily what surface a hologram is near. One grounding technique is to add a glow around a

hologram on the nearby surface, and then render a shadow against this glow. In this way, your shadow appears

to subtract light from the environment. Spatial sound is another important depth cue, letting users reason about

the distance and relative location of a hologram.

Devices with opaque displaysopaque displays , like Windows Mixed Reality immersive headsets, block out the world. Black

pixels are solid black, and any other color appears as that color to the user. Your application is responsible for

rendering everything the user sees. This makes it even more important to maintain a constant refresh rate so

that users have a comfortable experience.

Mixed reality headsets (both HoloLens and immersive headsets) continually track the position and orientation of

the user's head relative to their surroundings. As your application begins preparing its next frame, the system

predicts where the user's head will be in the future at the exact moment that the frame shows up on the

displays. Based on this prediction, the system calculates the view and the projection transforms to use for that

frame. Your application must use these transforms to produce correct resultsmust use these transforms to produce correct results . If system-supplied

transforms aren't used, the resulting image won't align with the real world, leading to user discomfort.

To accurately predict when a new frame will reach the displays, the system is constantly measuring the effective end-to-

end latency of your application's rendering pipeline. While the system adjusts to the length of your rendering pipeline, you

can improve hologram stability by keeping that pipeline as short as possible.

Applications that use advanced techniques to augment the system prediction can override the system view and

projection transforms. These applications must still use system-supplied transforms as a basis for their custom

transforms to produce meaningful results.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/rendering-overview.md
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/hololens/hololens2-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


 Other rendering parameters

 Holographic cameras

 

When rendering a frame, the system specifies the back-buffer viewport in which your application should draw.

This viewport is often smaller than the full size of the frame buffer. Whatever the viewport size, once the frame

is rendered by the application, the system upscales the image to fill the entirety of the displays.

For applications that find themselves unable to render at the required refresh rate, system rendering parameters

can be configured to reduce memory pressure and rendering cost at the cost of increased pixel aliasing. The

back buffer format can also be changed, which for some apps can help to improve memory bandwidth and pixel

throughput.

The rendering frustum, resolution, and framerate in which your app is asked to render might also change from

frame to frame, and might differ across the left and right eye. For example, when mixed reality capture (MRC) is

active and the photo/video camera view configuration isn't opted-into, one eye might be rendered with a larger

FOV or resolution.

For any given frame, your app must render using the view transform, projection transform, and viewport

resolution provided by the system. Additionally, your application must never assume that any rendering or view

parameter remains fixed from frame-to-frame. Engines like Unity handle all these transforms for you in their

own camera objects so that the physical movement of your users and the state of the system is always

respected. If your application allows for virtual movement of the user through the world (e.g. using the

thumbstick on a gamepad), you can add a parent rig object above the camera that moves it around. This causes

the camera to reflect both the user's virtual and physical motion. If your application modifies the view transform,

projection transform, or viewport dimension provided by the system, it must inform the system by calling the

appropriate override API.

To enhance the stability of your holographic rendering, your app should provide to Windows each frame the

depth buffer it used for rendering. If your app does provide a depth buffer, it should have coherent depth values,

with depth expressed in meters from the camera. This enables the system to use your per-pixel depth data to

better stabilize content if the user's head ends up slightly offset from the predicted location. If you aren't able to

provide your depth buffer, you can provide a focus point and normal, defining a plane that cuts through most of

your content. If both the depth buffer and a focus plane are provided, the system might use both. In particular,

it's helpful to provide both the depth buffer and a focus point that includes a velocity vector when your

application displays holograms that are in motion.

Refer to Rendering in DirectX article for low-level details about this topic.

Windows Mixed Reality introduces the concept of a holographic cameraholographic camera. Holographic cameras are similar to

the traditional camera found in 3D graphics texts; they define both the extrinsic (position and orientation) and

intrinsic camera properties. (For example, field-of-view is used to view a virtual 3D scene.) Unlike traditional 3D

cameras, the application isn't in control of the position, orientation, and intrinsic properties of the camera.

Rather, the position and orientation of the holographic camera is implicitly controlled by the user's movement.

The user's movement is relayed to the application on a frame-by-frame basis via a view transform. Likewise, the

camera's intrinsic properties are defined by the device's calibrated optics and relayed frame-by-frame via the

projection transform.

In general, your application will render for a single stereo camera. A robust rendering loop will support multiple

cameras, and will support both mono and stereo cameras. For example, the system might ask your application

to render from an alternate perspective when the user activates a feature like mixed reality capture (MRC),

depending on the headset shape. Applications that can support multiple cameras get them by opting-in to the

kind of cameras they can support.

https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicviewconfiguration#windows_graphics_holographic_holographicviewconfiguration
https://docs.microsoft.com/en-us/hololens/holographic-photos-and-videos
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicviewconfigurationkind#windows_graphics_holographic_holographicviewconfigurationkind
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamerapose#windows_graphics_holographic_holographiccamerapose
https://docs.microsoft.com/en-us/hololens/holographic-photos-and-videos
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicviewconfiguration#windows_graphics_holographic_holographicviewconfiguration
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicviewconfigurationkind#windows_graphics_holographic_holographicviewconfigurationkind


Volume rendering

 Supported resolutions on HoloLens (first gen)

 Supported resolutions on HoloLens 2

 See also

When rendering medical MRIs or engineering volumes in 3D, volume rendering techniques are often used.

These techniques can be interesting in mixed reality, where users can naturally view such a volume from key

angles, simply by moving their head.

The max viewport size is a property of the HolographicDisplay. HoloLens is set to the maximum viewport

size, which is 720p (1268x720), by default.

The viewport size can be changed by setting the ViewportScaleFactor on the HolographicCamera. This scale

factor is in the range of 0 to 1.

The lowest supported viewport size on HoloLens (first gen) is 50% of 720p, which is 360p (634x360). This is

a ViewportScaleFactor of 0.5.

Anything lower than 540p isn't recommended because of visual degradation, but can be used to identify

bottlenecks in pixel fill rate.

The current and maximum supported render target sizes are properties of the view configuration. HoloLens

2 is set to the maximum render target size, which is 1440x936, by default.

Apps can change the size of render target buffers by calling the RequestRenderTargetSize method to request

a new render target size. A new render target size will be chosen, which meets or exceeds the requested

render target size. This API changes the size of the render target buffer, which requires memory reallocation

on the GPU. The implications of this include: The render target size can be scaled down to reduce memory

pressure on the GPU, and this method shouldn't be called at high frequency.

Apps can still change the viewport size in the same way that they did for HoloLens 1. There's no added

memory reallocation on the GPU, so it can be changed at high frequency, but it cannot be used to reduce

memory pressure on the GPU.

The lowest supported viewport size on HoloLens 2 is 634x412, a ViewportScaleFactor of approximately 0.44

when the default render target size is in use.

If a render target size is provided which is smaller than the lowest supported viewport size, the viewport

scale factor will be ignored.

Anything lower than 540p isn't recommended because of visual degradation, but can be used to identify

bottlenecks in pixel fill rate.

Hologram stability

Rendering in DirectX

https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicdisplay
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographicviewconfiguration#windows_graphics_holographic_holographicviewconfiguration


   

 

Volume rendering overview
 7/6/2022 • 5 minutes to read • Edit Online

 Representing 3D Textures

For medical MRI or engineering volumes, see Volume Rendering on Wikipedia. These 'volumetric images'

contain rich information with opacity and color throughout the volume that cannot be easily expressed as

surfaces such as polygonal meshes.

Key solutions to improve performance

1. BAD: Naïve Approach: Show Whole Volume, generally runs too slowly

2. GOOD: Cutting Plane: Show only a single slice of the volume

3. GOOD: Cutting Sub-Volume: Show only a few layers of the volume

4. GOOD: Lower the resolution of the volume rendering (see 'Mixed Resolution Scene Rendering')

There's only a certain amount of information that can be transferred from the application to the screen in any

particular frame, which is the total memory bandwidth. Also, any processing (or 'shading') required to transform

that data for presentation requires time. The primary considerations when doing volume rendering are as such:

Screen-Width * Screen-Height * Screen-Count * Volume-Layers-On-That-Pixel = Total-Volume-Samples-Per-

Frame

1028 * 720 * 2 * 256 = 378961920 (100%) (full res volume: too many samples)

1028 * 720 * 2 * 1 = 1480320 (0.3% of full) (thin slice: 1 sample per pixel, runs smoothly)

1028 * 720 * 2 * 10 = 14803200 (3.9% of full) (subvolume slice: 10 samples per pixel, runs fairly smoothly,

looks 3d)

200 * 200 * 2 * 256 = 20480000 (5% of full) (lower res volume: fewer pixels, full volume, looks 3d but a bit

blurry)

On the CPU:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/volume-rendering-overview.md
https://en.wikipedia.org/wiki/Volume_rendering
https://en.wikipedia.org/wiki/Polygon_mesh


public struct Int3 { public int X, Y, Z; /* ... */ }
 public class VolumeHeader  {
   public readonly Int3 Size;
   public VolumeHeader(Int3 size) { this.Size = size;  }
   public int CubicToLinearIndex(Int3 index) {
     return index.X + (index.Y * (Size.X)) + (index.Z * (Size.X * Size.Y));
   }
   public Int3 LinearToCubicIndex(int linearIndex)
   {
     return new Int3((linearIndex / 1) % Size.X,
       (linearIndex / Size.X) % Size.Y,
       (linearIndex / (Size.X * Size.Y)) % Size.Z);
   }
   /* ... */
 }
 public class VolumeBuffer<T> {
   public readonly VolumeHeader Header;
   public readonly T[] DataArray;
   public T GetVoxel(Int3 pos)        {
     return this.DataArray[this.Header.CubicToLinearIndex(pos)];
   }
   public void SetVoxel(Int3 pos, T val)        {
     this.DataArray[this.Header.CubicToLinearIndex(pos)] = val;
   }
   public T this[Int3 pos] {
     get { return this.GetVoxel(pos); }
     set { this.SetVoxel(pos, value); }
   }
   /* ... */
 }

float3 _VolBufferSize;
 int3 UnitVolumeToIntVolume(float3 coord) {
   return (int3)( coord * _VolBufferSize.xyz );
 }
 int IntVolumeToLinearIndex(int3 coord, int3 size) {
   return coord.x + ( coord.y * size.x ) + ( coord.z * ( size.x * size.y ) );
 }
 uniform StructuredBuffer<float> _VolBuffer;
 float SampleVol(float3 coord3 ) {
   int3 intIndex3 = UnitVolumeToIntVolume( coord3 );
   int index1D = IntVolumeToLinearIndex( intIndex3, _VolBufferSize.xyz);
   return __VolBuffer[index1D];
 }

 Shading and Gradients

float4 ShadeVol( float intensity ) {
   float unitIntensity = saturate( intensity - IntensityMin / ( IntensityMax - IntensityMin ) );
   // Simple two point black and white intensity:
   color.rgba = unitIntensity;
   // Color ramp method:
   color.rgba = tex2d( ColorRampTexture, float2( unitIntensity, 0 ) );

On the GPU:

How to shade a volume, such as MRI, for useful visualization. The primary method is to have an 'intensity

window' (a min and max) that you want to see intensities within, and simply scale into that space to see the

black and white intensity. A 'color ramp' can then be applied to the values within that range, and stored as a

texture, so that different parts of the intensity spectrum can be shaded different colors:



// Change color to match segment index (fade each segment towards black):
 color.rgb = SegmentColors[ segment_index ] * color.a; // brighter alpha gives brighter color

 Volume Slicing in a Shader

// In the vertex shader:
 float4 worldPos = mul(_Object2World, float4(input.vertex.xyz, 1));
 float4 volSpace = mul(_WorldToVolume, float4(worldPos, 1));

// In the pixel shader:
 float4 color = ShadeVol( SampleVol( volSpace ) );

 Volume Tracing in Shaders

float4 AlphaBlend(float4 dst, float4 src) {
   float4 res = (src * src.a) + (dst - dst * src.a);
   res.a = src.a + (dst.a - dst.a*src.a);
   return res;
 }
 float4 volTraceSubVolume(float3 objPosStart, float3 cameraPosVolSpace) {
   float maxDepth = 0.15; // depth in volume space, customize!!!
   float numLoops = 10; // can be 400 on nice PC
   float4 curColor = float4(0, 0, 0, 0);
   // Figure out front and back volume coords to walk through:
   float3 frontCoord = objPosStart;
   float3 backCoord = frontPos + (normalize(cameraPosVolSpace - objPosStart) * maxDepth);
   float3 stepCoord = (frontCoord - backCoord) / numLoops;
   float3 curCoord = backCoord;
   // Add per-pixel random offset, avoids layer aliasing:
   curCoord += stepCoord * RandomFromPositionFast(objPosStart);
   // Walk from back to front (to make front appear in-front of back):
   for (float i = 0; i < numLoops; i++) {
     float intensity = SampleVol(curCoord);
     float4 shaded = ShadeVol(intensity);
     curColor = AlphaBlend(curColor, shaded);
     curCoord += stepCoord;
   }
   return curColor;
 }

In many of our applications, we store in our volume both a raw intensity value and a 'segmentation index' (to

segment different parts such as skin and bone; these segments are created by experts in dedicated tools). This

can be combined with the approach above to put a different color, or even different color ramp for each

segment index:

A great first step is to create a "slicing plane" that can move through the volume, 'slicing it', and how the scan

values at each point. This assumes that there's a 'VolumeSpace' cube, which represents where the volume is in

world space, that can be used as a reference for placing the points:

How to use the GPU to do subvolume tracing (walks a few voxels deep, then layers on the data from back to

front):



// In the vertex shader:
 float4 worldPos = mul(_Object2World, float4(input.vertex.xyz, 1));
 float4 volSpace = mul(_WorldToVolume, float4(worldPos.xyz, 1));
 float4 cameraInVolSpace = mul(_WorldToVolume, float4(_WorldSpaceCameraPos.xyz, 1));

// In the pixel shader:
 float4 color = volTraceSubVolume( volSpace, cameraInVolSpace );

 Whole Volume Rendering

float4 volTraceSubVolume(float3 objPosStart, float3 cameraPosVolSpace) {
   float maxDepth = 1.73; // sqrt(3), max distance from point on cube to any other point on cube
   int maxSamples = 400; // just in case, keep this value within bounds
   // not shown: trim front and back positions to both be within the cube
   int distanceInVoxels = length(UnitVolumeToIntVolume(frontPos - backPos)); // measure distance in voxels
   int numLoops = min( distanceInVoxels, maxSamples ); // put a min on the voxels to sample

 Mixed Resolution Scene Rendering

 See Also

Modifying the subvolume code above, we get:

How to render a part of the scene with a low resolution and put it back in place:

1. Setup two off-screen cameras, one to follow each eye that update each frame

2. Setup two low-resolution render targets (that is, 200x200 each) that the cameras render into

3. Set up a quad that moves in front of the user

Each Frame:

1. Draw the render targets for each eye at low-resolution (volume data, expensive shaders, and so on)

2. Draw the scene normally as full resolution (meshes, UI, and so on)

3. Draw a quad in front of the user, over the scene, and project the low-res renders onto that

4. Result: visual combination of full-resolution elements with low-resolution but high-density volume data

Volume rendering(with C# and HLSL samples)
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 Hologram quality terminology

 Frame rate

To achieve stable holograms, HoloLens has a built-in image stabilization pipeline. The stabilization pipeline

works automatically in the background, so you don't need to take any extra steps to enable it. However, you

should exercise techniques that improve hologram stability and avoid scenarios that reduce stability.

The quality of holograms is a result of good environment and good app development. Apps running at a

constant 60 frames-per-second in an environment where HoloLens can track the surroundings ensures the

hologram and the matching coordinate system are in sync. From a user's perspective, holograms that are meant

to be stationary won't move relative to the environment.

The following terminology can help you when you're identifying problems with the environment, inconsistent or

low rendering rates, or anything else.

Accuracy.Accuracy. Once the hologram is world-locked and placed in the real world, it should stay where it's placed

relative to the surrounding environment and independent of user motion or small and sparse environment

changes. If a hologram later appears in an unexpected location, it's an accuracy problem. Such scenarios can

happen if two distinct rooms look identical.

J itter.J itter. Users observe jitter as high frequency shaking of a hologram, which can happen when tracking of the

environment degrades. For users, the solution is running sensor tuning.

Judder.Judder. Low rendering frequencies result in uneven motion and double images of holograms. Judder is

especially noticeable in holograms with motion. Developers need to maintain a constant 60 FPS.

Drift.Dr ift. Users see drift as a hologram appears to move away from where it was originally placed. Drift

happens when you place holograms far away from spatial anchors, particularly in unmapped parts of the

environment. Creating holograms close to spatial anchors lowers the likelihood of drift.

Jumpiness.Jumpiness. When a hologram "pops" or "jumps" away from its location occasionally. Jumpiness can occur

as tracking adjusts holograms to match updated understanding of your environment.

Swim.Swim. When a hologram appears to sway corresponding to the motion of the user's head. Swim occurs

when the application hasn't fully implemented reprojection, and if the HoloLens isn't calibrated for the

current user. The user can rerun the calibration application to fix the issue. Developers can update the

stabilization plane to further enhance stability.

Color separation.Color separation. The displays in HoloLens are color sequential displays, which flash color channels of red-

green-blue-green at 60 Hz (individual color fields are shown at 240 Hz). Whenever a user tracks a moving

hologram with their eyes, that hologram's leading and trailing edges separate in their constituent colors,

producing a rainbow effect. The degree of separation is dependent upon the speed of the hologram. In some

rarer cases, moving ones head rapidly while looking at a stationary hologram can also result in a rainbow

effect, which is called color separation.

Frame rate is the first pillar of hologram stability. For holograms to appear stable in the world, each image

presented to the user must have the holograms drawn in the correct spot. The displays on HoloLens refresh 240

times a second, showing four separate color fields for each newly rendered image, resulting in a user experience

of 60 FPS (frames per second). To provide the best experience possible, application developers must maintain 60

FPS, which translates to consistently providing a new image to the operating system every 16 milliseconds.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/hologram-stability.md
https://docs.microsoft.com/en-us/hololens/hololens-updates
https://docs.microsoft.com/en-us/hololens/hololens-calibration
https://docs.microsoft.com/en-us/hololens/hololens-calibration


 Hologram render distances

60 FPS60 FPS  To draw holograms to look like they're sitting in the real world, HoloLens needs to render images from

the user's position. Since image rendering takes time, HoloLens predicts where a user's head will be when the

images are shown in the displays. However, this prediction algorithm is an approximation. HoloLens has

hardware that adjusts the rendered image to account for the discrepancy between the predicted head position

and the actual head position. The adjustment makes the image the user sees appear as if it's rendered from the

correct location, and holograms feel stable. The image updates work best with small changes, and it can't

completely fix certain things in the rendered image like motion-parallax.

By rendering at 60 FPS, you're doing three things to help make stable holograms:

1. Minimizing the overall latency between rendering an image and that image being seen by the user. In an

engine with a game and a render thread running in lockstep, running at 30FPS can add 33.3 ms of extra

latency. Reducing latency decreases prediction error and increases hologram stability.

2. Making it so every image reaching the user's eyes have a consistent amount of latency. If you render at 30

fps, the display still displays images at 60 FPS, meaning the same image will be displayed twice in a row. The

second frame will have 16.6-ms more latency than the first frame and will have to correct a more

pronounced amount of error. This inconsistency in error magnitude can cause unwanted 60 Hz judder.

3. Reducing the appearance of judder, which is characterized by uneven motion and double images. Faster

hologram motion and lower render rates are associated with more pronounced judder. Striving to maintain

60 FPS at all times will help avoid judder for a given moving hologram.

Frame-rate consistencyFrame-rate consistency  Frame rate consistency is as important as a high frames-per-second. Occasionally

dropped frames are inevitable for any content-rich application, and the HoloLens implements some

sophisticated algorithms to recover from occasional glitches. However, a constantly fluctuating framerate is a lot

more noticeable to a user than running consistently at lower frame rates. For example, an application that

renders smoothly for five frames (60 FPS for the duration of these five frames) and then drops every other

frame for the next 10 frames (30 FPS for the duration of these 10 frames) will appear more unstable than an

application that consistently renders at 30 FPS.

On a related note, the operating system throttles down applications to 30 FPS when mixed reality capture is

running.

Performance analysisPerformance analysis  There are different kinds of tools that can be used to benchmark your application frame

rate, such as:

GPUView

Visual Studio Graphics Debugger

Profilers built into 3D engines such as Unity

The human visual system integrates multiple distance-dependent signals when it fixates and focuses on an

object.

Accommodation - The focus of an individual eye.

Convergence - Two eyes moving inward or outward to center on an object.

Binocular vision - Disparities between the left- and right-eye images that are dependent on an object's

distance away from your fixation point.

Shading, relative angular size, and other monocular (single eye) cues.

Convergence and accommodation are unique because their extra-retinal cues related to how the eyes change to

perceive objects at different distances. In natural viewing, convergence and accommodation are linked. When

the eyes view something near (for example, your nose), the eyes cross and accommodate to a near point. When

https://docs.microsoft.com/en-us/hololens/holographic-photos-and-videos
https://www.youtube-nocookie.com/embed/-606oZKLa_s
https://en.wikipedia.org/wiki/Accommodation_%2528eye%2529
https://en.wikipedia.org/wiki/Convergence_(eye)
https://en.wikipedia.org/wiki/Stereopsis


 Reprojection

the eyes view something at infinity, the eyes become parallel and the eye accommodates to infinity.

Users wearing HoloLens will always accommodate to 2.0 m to maintain a clear image because the HoloLens

displays are fixed at an optical distance approximately 2.0 m away from the user. App developers control where

users' eyes converge by placing content and holograms at various depths. When users accommodate and

converge to different distances, the natural link between the two cues is broken, which can lead to visual

discomfort or fatigue, especially when the magnitude of the conflict is large.

Discomfort from the vergence-accommodation conflict can be avoided or minimized by keeping converged

content as close to 2.0 m as possible (that is, in a scene with lots of depth place the areas of interest near 2.0 m,

when possible). When content can't be placed near 2.0 m, discomfort from the vergence-accommodation

conflict is greatest when user ’s gaze back and forth between different distances. In other words, it's much more

comfortable to look at a stationary hologram that stays 50 cm away than to look at a hologram 50 cm away that

moves toward and away from you over time.

Placing content at 2.0 m is also advantageous because the two displays are designed to fully overlap at this

distance. For images placed off this plane, as they move off the side of the holographic frame they'll appear

from one display while still being visible on the other. This binocular rivalry can be disruptive to the depth

perception of the hologram.

Optimal distance for placing holograms from the userOptimal distance for placing holograms from the user

Clip PlanesClip Planes  For maximum comfort, we recommend clipping render distance at 85 cm with fade out of content

starting at 1 m. In applications where holograms and users are both stationary, holograms can be viewed

comfortably as near as 50 cm. In those cases, applications should place a clip plane no closer than 30 cm and

fade out should start at least 10 cm away from the clip plane. Whenever content is closer than 85 cm, it's

important to ensure that users don't frequently move closer or farther from holograms or that holograms don't

frequently move closer to or farther from the user as these situations are most likely to cause discomfort from

the vergence-accommodation conflict. Content should be designed to minimize the need for interaction closer

than 85 cm from the user, but when content must be rendered closer than 85 cm, a good rule of thumb for

developers is to design scenarios where users and/or holograms don't move in depth more than 25% of the

time.

Best practicesBest practices  When holograms can't be placed at 2 m and conflicts between convergence and

accommodation can't be avoided, the optimal zone for hologram placement is between 1.25 m and 5 m. In

every case, designers should structure content to encourage users to interact 1+ m away (for example, adjust

content size and default placement parameters).



  Choosing Reprojection TechniqueChoosing Reprojection Technique

STA B IL IZ AT IO N  T Y P ESTA B IL IZ AT IO N  T Y P E IM M ERSIVE  H EA DSET SIM M ERSIVE  H EA DSET S H O LO L EN S GEN ERAT IO N  1H O LO L EN S GEN ERAT IO N  1 H O LO L EN S 2H O LO L EN S 2

Depth Reprojection Recommended N/A Recommended

Unity applications must use
Unity 2018.4.12+, Unity
2019.3+ or Unity 2020.3+.
Otherwise use Automatic
Planar Reprojection.

Automatic Planar
Reprojection

N/A Recommended default Recommended if Depth
Reprojection isn't giving the
best results

Unity applications are
recommended to use Unity
2018.4.12+, Unity 2019.3+
or Unity 2020.3+. Previous
Unity versions will work
with slightly degraded
reprojection results.

HoloLens has a sophisticated hardware-assisted holographic stabilization technique known as reprojection.

Reprojection takes into account motion and change of the point of view (CameraPose) as the scene animates

and the user moves their head. Applications need to take specific actions to best use reprojection.

There are four main types of reprojection

Depth Reprojection:Depth Reprojection: Produces the best results with the least amount of effort from the application. All

parts of the rendered scene are independently stabilized based on their distance from the user. Some

rendering artifacts may be visible where there are sharp changes in depth. This option is only available on

HoloLens 2 and Immersive Headsets.

Planar Reprojection:Planar Reprojection: Allows the application precise control over stabilization. A plane is set by the

application and everything on that plane will be the most stable part of the scene. The further a hologram is

away from the plane, the less stable it will be. This option is available on all Windows MR platforms.

Automatic Planar Reprojection:Automatic Planar Reprojection: The system sets a stabilization plane using information in the depth

buffer. This option is available on HoloLens generation 1 and HoloLens 2.

None:None: If the application does nothing, Planar Reprojection is used with the stabilization plane fixed at 2

meters in the direction of the user's head gaze, usually producing substandard results.

Applications need to take specific actions to enable the different types of reprojection

Depth Reprojection:Depth Reprojection: The application submits their depth buffer to the system for every rendered frame. On

Unity, Depth Reprojection is done with the Shared Depth BufferShared Depth Buffer  option in the Windows Mixed RealityWindows Mixed Reality

SettingsSettings  pane under XR Plugin ManagementXR Plugin Management. DirectX apps call CommitDirect3D11DepthBuffer. The

application shouldn't call SetFocusPoint.

Planar Reprojection:Planar Reprojection: On every frame, applications tell the system the location of a plane to stabilize. Unity

applications call SetFocusPointForFrame and should have Shared Depth BufferShared Depth Buffer  disabled. DirectX apps call

SetFocusPoint and shouldn't call CommitDirect3D11DepthBuffer.

Automatic Planar Reprojection:Automatic Planar Reprojection: To enable, the application needs to submit their depth buffer to the

system as they would for Depth Reprojection. Apps using the Mixed Reality Toolkit (MRTK) can configure the

camera settings provider to use AutoPlanar Reprojection. Native apps should set the DepthReprojectionMode

in the HolographicCameraRenderingParameters to AutoPlanar  each frame. For HoloLens generation 1, the

application should not call SetFocusPoint.

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/features/camera-system/windows-mixed-reality-camera-settings#hololens-2-reprojection-method
https://docs.microsoft.com/en-us/uwp/api/windows.graphics.holographic.holographiccamerarenderingparameters


Planar Reprojection Not Recommended Recommended if Automatic
Planar isn't giving the best
results

Use if neither of the depth
options give desired results

STA B IL IZ AT IO N  T Y P ESTA B IL IZ AT IO N  T Y P E IM M ERSIVE  H EA DSET SIM M ERSIVE  H EA DSET S H O LO L EN S GEN ERAT IO N  1H O LO L EN S GEN ERAT IO N  1 H O LO L EN S 2H O LO L EN S 2

  Verifying Depth is Set CorrectlyVerifying Depth is Set Correctly

NOTENOTE

  Using Planar ReprojectionUsing Planar Reprojection

NOTENOTE

When a reprojection method uses the depth buffer, it's important to verify the contents of the depth buffer

represent the application's rendered scene. A number of factors can cause problems. If there's a second camera

used to render user interface overlays, for example, it's likely to overwrite all the depth information from the

actual view. Transparent objects often don't set depth. Some text rendering won't set depth by default. There will

be visible glitches in the rendering when depth doesn't match the rendered holograms.

HoloLens 2 has a visualizer to show where depth is and isn't being set, which can be enabled from Device Portal.

On the ViewsViews  > Hologram StabilityHologram Stability  tab, select the Display depth visualization in headsetDisplay depth visualization in headset checkbox.

Areas that have depth set properly will be blue. Rendered items that don't have depth set are marked in red and

need to be fixed.

The visualization of the depth will not show up in Mixed Reality Capture. It is only visible through the device.

Some GPU viewing tools will allow visualization of the depth buffer. Application developers can use these tools

to make sure depth is being set properly. Consult the documentation for the application's tools.

For desktop immersive headsets, setting a stabilization plane is usually counter-productive, as it offers less visual quality

than providing your app's depth buffer to the system to enable per-pixel depth-based reprojection. Unless running on a

HoloLens, you should generally avoid setting the stabilization plane.

The device will automatically attempt to choose this plane, but the application should assist by selecting the

focus point in the scene. Unity apps running on a HoloLens should choose the best focus point based on your

scene and pass it into SetFocusPoint(). An example of setting the focus point in DirectX is included in the default

spinning cube template.

Unity will submit your depth buffer to Windows to enable per-pixel reprojection when you run your app on an

immersive headset connected to a desktop PC, which provides even better image quality without explicit work

by the app. You should only provide a Focus Point when your app is running on a HoloLens, or the per-pixel

reprojection will be overridden.



// SetFocusPoint informs the system about a specific point in your scene to
// prioritize for image stabilization. The focus point is set independently
// for each holographic camera.
// You should set the focus point near the content that the user is looking at.
// In this example, we put the focus point at the center of the sample hologram,
// since that is the only hologram available for the user to focus on.
// You can also set the relative velocity and facing of that content; the sample
// hologram is at a fixed point so we only need to indicate its position.
renderingParameters.SetFocusPoint(
    currentCoordinateSystem,
    spinningCubeRenderer.Position
    );

 Color separation

Placement of the focus point largely depends on what the hologram is looking at. The app has the gaze vector

for reference and the app designer knows what content they want the user to observe.

The single most important thing a developer can do to stabilize holograms is to render at 60 FPS. Dropping

below 60 FPS will dramatically reduce hologram stability, whatever the stabilization plane optimization.

Best practicesBest practices  There's no universal way to set up the stabilization plane and it's app-specific. Our main

recommendation is to experiment and see what works best for your scenario. However, try to align the

stabilization plane with as much content as possible because all the content on this plane is perfectly stabilized.

For example:

If you have only planar content (reading app, video playback app), align the stabilization plane with the plane

that has your content.

If there are three small spheres that are world-locked, make the stabilization plane "cut" though the centers

of all the spheres that are currently in the user's view.

If your scene has content at substantially different depths, favor further objects.

Make sure to adjust the stabilization point every frame to coincide with the hologram the user is looking at

Things to AvoidThings to Avoid The stabilization plane is a great tool to achieve stable holograms, but if misused it can result

in severe image instability.

Don't "fire and forget". You can end up with the stabilization plane behind the user or attached to an object

that is no longer in the user's view. Ensure the stabilization plane normal is set opposite camera-forward (for

example, -camera.forward)

Don't rapidly change the stabilization plane back and forth between extremes

Don't leave the stabilization plane set to a fixed distance/orientation

Don't let the stabilization plane cut through the user

Don't set the focus point when running on a desktop PC rather than a HoloLens, and instead rely on per-pixel

depth-based reprojection.

Because of the nature of HoloLens displays, an artifact called "color-separation" can sometimes be perceived. It

manifests as the image separating into individual base colors - red, green, and blue. The artifact can be

especially visible when displaying white objects, since they have large amounts of red, green, and blue. It's most

pronounced when a user visually tracks a hologram that is moving across the holographic frame at high speed.

Another way the artifact can manifest is warping/deformation of objects. If an object has high contrast and/or

pure colors such as red, green, blue, color-separation will be perceived as warping of different parts of the

object.

Example of what the color separation of a head-locked white round cursor could look like as aExample of what the color separation of a head-locked white round cursor could look like as a

user rotates their  head to the side:user rotates their  head to the side:



 See also

Though it's difficult to completely avoid color separation, there are several techniques available to mitigate it.

Color-separation can be seen on:Color-separation can be seen on:

Objects that are moving quickly, including head-locked objects such as the cursor.

Objects that are substantially far from the stabilization plane.

To attenuate the effects of color-separation:To attenuate the effects of color-separation:

Make the object lag the user's gaze. It should appear as if it has some inertia and is attached to the gaze "on

springs". This approach slows the cursor (reducing separation distance) and puts it behind the user's likely

gaze point. So long as it quickly catches up when the user stops shifting their gaze it feels natural.

If you do want to move a hologram, try to keep its movement speed below 5 degrees/second if you expect

the user to follow it with their eyes.

Use light instead of geometry for the cursor. A source of virtual illumination attached to the gaze will be

perceived as an interactive pointer but won't cause color-separation.

Adjust the stabilization plane to match the holograms the user is gazing at.

Make the object red, green, or blue.

Switch to a blurred version of the content. For example, a round white cursor could be changed to a slightly

blurred line oriented in the direction of motion.

As before, rendering at 60 FPS and setting the stabilization plane are the most important techniques for

hologram stability. If facing noticeable color separation, first make sure the frame rate meets expectations.

Understanding Performance for Mixed Reality

Color, light, and materials

Instinctual interactions

MRTK Hologram Stabilization

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/performance/hologram-stabilization
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P L AT F O RMP L AT F O RM TA RGET  F RA M E RAT ETA RGET  F RA M E RAT E

HoloLens 60 FPS

Windows Mixed Reality Ultra PCs 90 FPS

Windows Mixed Reality PCs 60 FPS

 Understanding performance bottlenecks

This article is an introduction to understanding the significance of performance for your Mixed Reality app. User

experience can be greatly degraded if your application doesn't run at optimal frame rate. Holograms will appear

unstable and head tracking of the environment will be inaccurate, leading to a poor experience for the user.

Performance must be considered a first class feature for mixed reality development and not a polish task.

The performant framerate values for each target platform are listed below.

The framework below outlines best practices for hitting target frame rates. For tips on measuring and improving

framerate in the Unity environment, we recommend that you read the performance recommendations for Unity

article

If your app has an underperforming framerate, the first step is to analyze and understand where your

application is computationally intensive. There are two primary processors responsible for the work to render

your scene: the CPU and the GPU, each handling different aspects of your Mixed Reality app. The three key

places where bottlenecks may occur are:

1. App Thread - CPUApp Thread - CPU - Responsible for your app logic, including processing input, animations, physics, and

other app logic.

2. Render Thread - CPU to GPURender Thread - CPU to GPU - Responsible for submitting your draw calls to the GPU. When your app

wants to render an object such as a cube or model, this thread sends a request to the GPU to do the

operations.

3. GPUGPU - Most commonly handles the graphics pipeline of your application to transform 3D data (models,

textures, and so on) into pixels. It ultimately produces a 2D image to submit to your device's screen.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/understanding-performance-for-mixed-reality.md
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


 How to analyze your application

  How to profile in any environmentHow to profile in any environment

Generally, HoloLens applications will be GPU bound, but not always. Use the tools and techniques below to

understand where your particular app is bottlenecked.

There are many tools that allow you to understand the performance profile and potential bottlenecks in your

mixed reality application.

Below are some common tools to help you gather deep profiling information for your application:

Intel Graphics Performance Analyzers

Visual Studio Graphics Debuggers

Unity Profiler

Unity Frame Debugger

Unreal Insights

PIX

GPU Profiling in Unreal

One way to determine if your app is GPU or CPU bound is to lower the resolution of the render target output. By

reducing the number of pixels to calculate, you'll reduce your GPU load. The device will render to a smaller

texture, then up-sample to display your final image.

After lowering rendering resolution, if:

https://software.intel.com/gpa
https://docs.microsoft.com/en-us/visualstudio/debugger/graphics/visual-studio-graphics-diagnostics
https://docs.unity3d.com/Manual/Profiler.html
https://docs.unity3d.com/Manual/FrameDebugger.html
https://devblogs.microsoft.com/pix/
https://docs.unrealengine.com/en-US/TestingAndOptimization/PerformanceAndProfiling/GPU/index.html


NOTENOTE

UnityEngine.XR.XRSettings.renderScale = 0.7f;

 How to improve your application
  CPU performance recommendationsCPU performance recommendations

  GPU performance recommendationsGPU performance recommendations
  Understanding bandwidth vs. fill rateUnderstanding bandwidth vs. fill rate

NOTENOTE

  Reduce polygon countReduce polygon count

  

1. Application framerate increasesincreases , then you're likely GPU BoundGPU Bound

2. Application framerate unchangedunchanged, then you're likely CPU BoundCPU Bound

Unity provides the ability to easily modify the render target resolution of your application at runtime through the

XRSettings.renderViewportScale property. The final image presented on device has a fixed resolution. The platform will

sample the lower resolution output to build a higher resolution image for rendering on displays.

Generally, most work in a mixed reality application on the CPU involves doing the "simulation" of the scene and

processing your application logic. The following areas are targeted for optimization:

Animations

Physics

Memory allocations

Complex algorithms (i.e inverse kinematics, path-finding)

When rendering a frame on the GPU, an application is either bound by memory bandwidth or fill rate.

Memor y bandwidthMemor y bandwidth is the rate of reads and writes the GPU can do from memory

To identify bandwidth limitations, reduce texture quality and check if the framerate has improved.

To identify fill rate limitations, lower the display resolution and see if framerate improves.

If you're working with Unity, check out our Unity-specific GPU performance recommendations. - In Unity, use the

XRSettings.renderViewportScale property

Memory bandwidth generally involves optimizations to either :

1. Lower texture resolutions

2. Use fewer textures (normals, specular, and so on)

Fill rate is focused on reducing the number of operations that need to be computed for a final rendered pixel,

including:

1. Number of objects to render/process

2. Number of operations per shader

3. Number of GPU stages to final result (geometry shaders, post-processing effects, and so on)

4. Number of pixels to render (display resolution)

Higher polygon counts result in more operations for the GPU, so reducing the number of polygons in your

scene reduces the render time. There are other factors that make shading the geometry expensive, but polygon

count is the simplest metric to determine how much work it will take to render a scene.

https://docs.unity3d.com/ScriptReference/XR.XRSettings-renderViewportScale.html
https://docs.unity3d.com/ScriptReference/XR.XRSettings-renderViewportScale.html
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/import-tool/optimize-models#performance-targets


Limit overdrawLimit overdraw

  ShadersShaders

  Sh a d e r  c o d i n g  r e c o m m e n d a t i o n sSh a d e r  c o d i n g  r e c o m m e n d a t i o n s

  Remove GPU stagesRemove GPU stages

 Memory recommendations

  Object poolingObject pooling

 See also

High overdraw occurs when multiple objects are rendered but not shown on screen as they're hidden by an

occluding object. Imagine looking at a wall that has objects behind it. All of the geometry would be processed

for rendering, but only the opaque wall needs to be rendered, which results in unnecessary operations.

Shaders are small programs that run on the GPU and do two important steps in rendering:

1. Determining which vertices should be drawn and where they are in screen space (the Vertex shader)

2. Determining the color of each pixel (the Pixel shader)

The Vertex shader is executed per vertex for every mesh.

The Pixel shader is executed per pixel and rendered by the geometry to the target render texture.

Typically, shaders do many transformations and lighting calculations. Although complex lighting models,

shadows, and other operations can generate fantastic results, they also come with a price. Reducing the number

of operations computed in shaders can greatly reduce the work needed for the GPU per frame.

Use bilinear filtering, whenever possible

Rearrange expressions to use MAD intrinsics to do a multiply and an add at the same time

Precalculate as much as possible on the CPU and pass as constants to the material

Favor moving operations from the pixel shader to the ver tex shaderFavor moving operations from the pixel shader to the ver tex shader

Generally, the number of vertices is much smaller than the number of pixels (720p is 921,600 pixels,

1080p is 2,073,600 pixels, and so on)

Post-processing effects can be expensive and increase the fill rate of your application, including anti-aliasing

techniques like MSAA. On HoloLens, we recommended avoiding these techniques and additional shader stages

such as geometry, hull, and compute shaders.

Excessive memory allocation and deallocation operations can result in inconsistent performance, frozen frames,

and other detrimental behavior. It's especially important to understand memory considerations when

developing in Unity, since memory management is controlled by the garbage collector.

Object pooling is a popular technique to reduce the cost of continuous allocations and deallocations of objects.

This is done by allocating a large pool of identical objects and reusing inactive, available instances from this pool

instead of constantly spawning and destroying objects over time. Object pools are great for reuseable

components that have variable lifetime during an app.

Performance recommendations for Unity

Recommended settings for Unity

Performance recommendations for Unreal

Material recommendations in Unreal

Optimize 3D models

Best practices for converting and optimizing real-time 3D Models

Performance guidelines for artists and designers for Unreal

VR best practices for Unreal

https://docs.microsoft.com/en-us/dynamics365/mixed-reality/import-tool/optimize-models#performance-targets
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/import-tool/best-practices
https://docs.unrealengine.com/en-US/TestingAndOptimization/PerformanceAndProfiling/Guidelines/index.html
https://docs.unrealengine.com/en-US/SharingAndReleasing/XRDevelopment/VR/DevelopVR/ContentSetup/index.html
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 Prerequisites

 Enabling Developer Mode

  Developer mode on HoloLensDeveloper mode on HoloLens

  Developer mode on a Windows PCDeveloper mode on a Windows PC

 Deploying a HoloLens app over Wi-Fi or USB

  Compilation optionsCompilation options

Whether you're using DirectX or Unity to develop your mixed reality app, Visual Studio is your go-to tool for

debugging and deployment. In this section, you'll learn how to:

Deploy applications to your HoloLens or Windows Mixed Reality immersive headset through Visual Studio.

Use the HoloLens emulator that's built into Visual Studio.

Debug mixed reality apps.

1. See Install the Tools for installation instructions.

2. Create a new mixed reality project in Unity or Visual Studio.

3. Build your Unity project per our instructions

Start by enabling Developer ModeDeveloper Mode on your device so Visual Studio can connect to it.

1. Turn on your HoloLens and put on the device.

2. Use the start gesture to launch the main menu.

3. Select the SettingsSettings  tile to launch the app in your environment.

4. Select the UpdateUpdate menu item.

5. Select the For developersFor developers  menu item.

6. Enable Use developer featuresUse developer features  to deploy apps from Visual Studio to your HoloLens. If your device is

running Windows Holographic version 21H1 or newer, also enable Device discover yDevice discover y .

7. Optional: Scroll down and also enable Device Por talDevice Por tal , which lets you connect to the Windows Device Portal

on your HoloLens from a web browser.

If you're working with a Windows Mixed Reality headset connected to your PC, you must enable DeveloperDeveloper

ModeMode on the PC.

1. Go to SettingsSettings .

2. Select Update and SecurityUpdate and Security .

3. Select For developersFor developers .

4. Enable Developer ModeDeveloper Mode, read the disclaimer for the setting you chose, and then select YesYes  to accept the

change.

1. Open your project in Visual Studio

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/using-visual-studio.md
https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Deploying-your-HoloLens-2-application/player?format=ny


C O N F IGURAT IO NC O N F IGURAT IO N EXP L A N AT IO NEXP L A N AT IO N

Debug All optimizations off and the profiler is enabled. Used to
debug scripts.

Master All optimizations are turned on and the profiler is disabled.
Used to submit apps to the Store.

Release All optimizations are turned on and the profiler is enabled.
Used to evaluate app performance.

  Build configurationBuild configuration

2. Click the Compilation Options drop down and then do one of the following:

For Unity projects, choose either ReleaseRelease or MasterMaster

For all other projects, choose ReleaseRelease

Here are definitions for the compilation options:

 

 

1. Select your build configuration based on your device.

HoloLens 2

HoloLens (1st gen)

Choose the ARMARM or ARM64ARM64  configuration option

To learn more about the build configurations, see the "Types of build configurations" table in the Unity

documentation.

https://docs.unity3d.com/Manual/VisualStudioprojectgenerationWindows.html


  Remote connectionRemote connection

NOTENOTE
For HoloLens, you'll typically build for the ARM architecture. However, there's a known issue in Unity 2019.3 that

causes errors when selecting ARM as the build architecture in Visual Studio. The recommended workaround is to

build for ARM64. If that isn't an option, for a Unity project, follow this step before you generate your Unity build:

go to EditEdit  > Project SettingsProject Settings > PlayerPlayer  > Other SettingsOther Settings and then disable Graphics JobsGraphics Jobs .

If you don't see Device as a target option, you may need to change the startup project for the Visual Studio

solution from the IL2CPP project to the UWP project. To do this, in the Solution ExplorerSolution Explorer , right-click your

project, and then select Set as Star tUp ProjectSet as Star tUp Project .

2. Click the deployment target drop-down and then do one of the following:

If you're building and deploying via Wi-Fi, select Remote MachineRemote Machine.

If you're building and deploying via USB, select DeviceDevice.

To set your remote connection:

NOTENOTE

1. On the menu bar, select Project > Proper ties > Configuration Proper ties > DebuggingProject > Proper ties > Configuration Proper ties > Debugging.

For a C# project, a dialog should automatically appear.

2. Click the Debugger to launchDebugger to launch drop down and then select Remote Machine.Remote Machine.

3. In the Machine NameMachine Name field, enter the IP address of your device.



 Deploying an app to the HoloLens (1st gen) Emulator

You can find the IP address on your HoloLens under Settings > Network & Internet >Settings > Network & Internet >

Advanced OptionsAdvanced Options .

We recommend that you manually enter your IP address rather than depend on the "Auto

Detected" feature.

4. Set the Authentication ModeAuthentication Mode to Universal (Unencr ypted protocol)Universal (Unencr ypted protocol) .

5. Build, deploy, and debug your app based on your needs:

To build, deploy and start debugging, select Debug > Star t debuggingDebug > Star t debugging.

To build and deploy without debugging, select Build > Deploy SolutionBuild > Deploy Solution.

6. The first time you deploy an app to your HoloLens from your PC, you'll be prompted for a PIN. Follow the

Pair ing your devicePair ing your device instructions below.

1. Make sure you've installed the HoloLens Emulatorinstalled the HoloLens Emulator .

2. Select an x86x86  build configuration for your app. 

3. Select HoloLens EmulatorHoloLens Emulator  in the deployment target drop-down menu



 Deploying an app to the HoloLens 2 Emulator

4. Select Debug > Star t debuggingDebug > Star t debugging to deploy your app and start debugging

1. Make sure you've installed the HoloLens Emulatorinstalled the HoloLens Emulator .

2. Select an x86x86  or x64x64  build configuration for your app.

3. Select HoloLens 2 EmulatorHoloLens 2 Emulator  in the deployment target drop-down menu

4. Select Debug > Star t debuggingDebug > Star t debugging to deploy your app and start debugging



 Deploying a VR app to your Local PC

 Pairing your device

 Graphics Debugger for HoloLens (1st gen)

 Profiling

To use a Windows Mixed Reality immersive headset that connects to your PC or the Mixed Reality simulator:

1. Select an x86x86  or x64x64  build configuration for your app

2. Select Local MachineLocal Machine in the deployment target drop-down menu

3. Build, deploy, and debug your app based on your needs

Select Debug > Star t debuggingDebug > Star t debugging to deploy your app and start debugging

Select Build > DeployBuild > Deploy  to build and deploy without debugging

The first time you deploy an app from Visual Studio to your HoloLens, you'll be prompted for a PIN. On the

HoloLens, generate a PIN by launching the Settings app, go to Update > For DevelopersUpdate > For Developers , and tap on PairPair .

When the PIN is displayed on your HoloLens, type it into Visual Studio. After pairing is complete, tap DoneDone on

your HoloLens to dismiss the dialog. This PC is now paired with the HoloLens and you can deploy apps

automatically. Repeat these steps for every PC that's used to deploy apps to your HoloLens.

To unpair your HoloLens from all paired computers:

Launch the SettingsSettings  app, go to Update > For DevelopersUpdate > For Developers , and tap on ClearClear .

The Visual Studio Graphics Diagnostics tools are helpful when writing and optimizing a Holographic app. See

Visual Studio Graphics Diagnostics on MSDN for full details.

To Star t the Graphics DebuggerTo Star t the Graphics Debugger

1. Follow the instructions above to target a device or emulator

2. Go to Debug > Graphics > Star t DiagnosticsDebug > Graphics > Star t Diagnostics

3. The first time you start diagnostics with a HoloLens, you may get an "access denied" error. Reboot your

HoloLens to let the updated permissions take effect and try again.

The Visual Studio profiling tools allow you to analyze your app's performance and resource use. This includes

tools to optimize CPU, memory, graphics, and network use. See Run diagnostic tools without debugging on

MSDN for full details.

To Star t the Profiling Tools with HoloLensTo Star t the Profiling Tools with HoloLens

1. Follow the instructions above to target a device or emulator

https://docs.microsoft.com/en-us/previous-versions/visualstudio/visual-studio-2015/debugger/visual-studio-graphics-diagnostics
https://docs.microsoft.com/en-us/previous-versions/visualstudio/visual-studio-2015/profiling/profiling-tools


 Debugging an installed or running app

 Next Development Checkpoint

 See also

2. Go to Debug > Star t Diagnostic Tools Without Debugging...Debug > Star t Diagnostic Tools Without Debugging...

3. Select the tools you want to use

4. Select Star tStar t

5. The first time you start diagnostics without debugging with a HoloLens, you may get an "access denied"

error. Reboot your HoloLens to let the updated permissions take effect and try again.

You can use Visual Studio to debug an installed Universal Windows app without deploying from a Visual Studio

project. This is useful if you want to debug an installed app package or debug an app that's already running.

1. Go to Debug -> Other Debug Targets -> Debug Installed App PackageDebug -> Other Debug Targets -> Debug Installed App Package

2. Select the Remote MachineRemote Machine target for HoloLens or Local MachineLocal Machine for immersive headsets.

3. Enter your device’s IP addressIP address

4. Choose the UniversalUniversal  Authentication Mode

5. The window shows both running and inactive apps. Pick the one what you’d like to debug.

6. Choose the type of code to debug (Managed, Native, Mixed)

7. Select AttachAttach or Star tStar t

If you're following the Unity development checkpoint journey we've laid out, you're in the midst of the

deployment stage. From here, you can continue to the next topic:

Deploying to HoloLens emulator

Or jump directly to adding advanced services:

Advanced services

You can always go back to the Unity development checkpoints at any time.

Install the tools

Using the HoloLens emulator

Deploying and debugging Universal Windows Platform (UWP) apps

Enable your device for development

https://docs.microsoft.com/en-us/windows/uwp/debug-test-perf/deploying-and-debugging-uwp-apps
https://docs.microsoft.com/en-us/windows/uwp/get-started/enable-your-device-for-development
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 Performance

 Testing 3D in 3D

  Environmental test matrixEnvironmental test matrix

Testing HoloLens applications is similar to testing Windows applications. You still need to consider functionality,

interoperability, performance, security, reliability, and so on. However, some areas that don't pop up in PC or

phone apps require special handling. Holographic apps need to run smoothly in a diverse set of environments.

They also need to maintain performance and user comfort at all times. This guide is here to help you with

testing these areas.

Holographic apps need to run smoothly in a diverse set of environments. They also need to maintain

performance and user comfort at all times. Performance is so important to the user's experience with a

Holographic app that we have an entire topic devoted to it. Make sure you read and follow the Understanding

Performance for Mixed Reality

1. Test your app in as many different spaces as possible.Test your app in as many different spaces as possible. Try in large rooms, small rooms, bathrooms,

kitchens, bedrooms, offices, and so on. Also take into consideration rooms with non-standard features such

as non-vertical walls, curved walls, non-horizontal ceilings. Does it work well when transitioning between

rooms, floors, going through hallways or stairs?

2. Test your app in different lighting conditions.Test your app in different lighting conditions. Does it respond properly to different environmental

conditions like lighting, black surfaces, and transparent or reflective surfaces like mirrors and glass walls.

3. Test your app in different motion conditions.Test your app in different motion conditions. Put on device and try your scenarios in various states of

motion. Does it respond properly to different movement or steady state?

4. Test how your app works from different angles.Test how your app works from different angles. If you have a world locked hologram, what happens if

your user walks behind it? What happens if something comes between the user and the hologram? What if

the user looks at the hologram from above or below?

5. Use spatial and audio cues.Use spatial and audio cues. Make sure your app uses spatial and audio cues to prevent the user from

getting lost.

6. Test your app at different levels of ambient noise.Test your app at different levels of ambient noise. If you've implemented voice commands, try

invoking them with varying levels of ambient noise.

7. Test your app seated and standingTest your app seated and standing. Make sure to test from both seating and standing positions.

8. Test your app from different distancesTest your app from different distances . Can UI elements be read and interacted with from far away?

Does your app react to users getting too close to your holograms?

9. Test your app against common app bar interactionsTest your app against common app bar interactions . All app tiles and 2D universal apps have an app

bar that lets you control the apps position in the Mixed World. Make sure clicking Remove ends your app

process gracefully and that the Back button is supported within the context of your 2D universal app. Try

scaling and moving your app in Adjust mode both while it's active, and while it's a suspended app tile.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/testing-your-app-on-hololens.md


 Comfort

 Input
  Interaction modelsInteraction models

  Custom voice commandsCustom voice commands

  PeripheralsPeripherals

 System integration
  BatteryBattery

1. Clip planes.Clip planes. Be attentive to where holograms are rendered.

2. Avoid vir tual movement inconsistent with actual head movement.Avoid vir tual movement inconsistent with actual head movement. Avoid moving the camera in a

way that isn't representative of the user's actual motion. If your app requires moving the user through a

scene, make the motion predictable, minimize acceleration, and let the user control the movement.

3. Follow the hologram quality guidelines.Follow the hologram quality guidelines. Performant apps that implement the hologram quality

guidance are less likely to result in user discomfort.

4. Distr ibute holograms horizontally rather than ver tically.Distr ibute holograms horizontally rather than ver tically. Forcing the user to spend extended periods

of time looking up or down can lead to fatigue in the neck.

Make sure the hologram interactions work with your chosen interaction model. It's also a good idea to validate

with different accessories like mouse and keyboard if they're needed to support accessibility.

Validate when your app has a different behavior with mouse and touch.Validate when your app has a different behavior with mouse and touch. Identifies inconsistencies and

help with design decisions to make the experience more natural for users. For example, triggering an action

based on hover.

Voice input is a natural form of interaction. The user experience can be magical or confusing depending on your

choice of commands and how you expose them. As a rule, you shouldn't use system voice commands such as

"Select" or "Hey Cortana" as custom commands. Here are a few points to consider :

1. Avoid using commands that sound similar.Avoid using commands that sound similar. Can potentially trigger the incorrect command.

2. Choose phonetically r ich words when possible.Choose phonetically r ich words when possible. Minimizes and/or avoid false activations.

Users can interact with your App through peripherals. Apps don't need to do anything special to take advantage

of that capability, however there are a couple things worth checking.

1. Validate custom interactions.Validate custom interactions. Things like custom keyboard shortcuts for your app.

2. Validate switching input types.Validate switching input types. Attempting to use multiple input methods to complete a task, such as

voice, gesture, mouse, and keyboard all in the same scenario.

Test your application without a power source connected to understand how quickly it drains the battery. One can

easily understand the battery state by looking at Power LED readings.



  Power state transitionsPower state transitions

  Multi-app scenariosMulti-app scenarios

 Telemetry

 Emulator and simulated input

LED states that indicate battery power

Validate key scenarios work as expected when transitioning between power states. For example, does the

application remain at its original position? Does it correctly persist its state? Does it continue to function as

expected?

1. Stand-by / Resume.Stand-by / Resume. To enter standby, one can press and release the power button immediately. The device

also will enter standby automatically after 3 minutes of inactivity. To resume from standby, one can press and

release the power button immediately. The device will also resume if you connect or disconnect it from a

power source.

2. Shutdown / Restar t.Shutdown / Restar t. To shut down, press and hold the power button continuously for 6 seconds. To restart,

press the power button.

Validate core app functionality when switching between apps, especially if you've implemented a background

task. Copy/Paste and Cortana integration are also worth checking where applicable.

Use telemetry and analytics to guide you. Integrating analytics into your app will help you get insights about

your app from your Beta testers and end users. This data can be used to help optimize your app before

submission to the Store and for future updates. There are many analytics options out there. If you're not sure

where to start, check out App Insights.

Questions to consider :

1. How are users using the space?

2. How is the app placing objects in the world - can you detect problems?

3. How much time do they spend on different stages of the application?

4. How much time do they spend in the app?

5. What are the most common usage paths the users are trying?

6. Are users hitting unexpected states or errors?

The HoloLens emulator is a great way to efficiently test your Holographic app with different kinds of simulated

user characteristics and spaces. Here are some suggestions for effectively using the emulator to test your app:

1. Use the emulator 's vir tual rooms to expand your testing.Use the emulator 's vir tual rooms to expand your testing. The emulator comes with a set of virtual

rooms that you can use to test your app in even more environments.

https://www.visualstudio.com/products/application-insights-vs.aspx


 Automated testing with Perception Simulation

 Windows App Certification Kit

 See also

2. Use the emulator to look at your app from all angles.Use the emulator to look at your app from all angles. The PageUp/PageDn keys will make your

simulated user taller or shorter.

3. Test your app with a real HoloLens.Test your app with a real HoloLens. The HoloLens Emulator is a great tool to help you quickly iterate on

an app and catch new bugs, but make sure you also test on a physical HoloLens before submitting to the

Windows Store. This is important to ensure that the performance and experience are great on real hardware.

Some app developers might want to automate testing of their apps. Beyond simple unit tests, you can use the

perception simulation stack in HoloLens to automate human and world input to your app. The perception

simulation API can send simulated input to either the HoloLens emulator or a physical HoloLens.

To give your app the best chance of being published on the Windows Store, validate and test it locally before you

submit it for certification. If your app targets the Windows.Holographic device family, the Windows App

Certification Kit will only run local static analysis tests on your PC. No tests will be run on your HoloLens.

Submitting an app to the Windows Store

https://docs.microsoft.com/en-us/windows/uwp/debug-test-perf/windows-app-certification-kit


   

 

Using the HoloLens Emulator
 7/6/2022 • 18 minutes to read • Edit Online

 HoloLens 2 Emulator Overview

 Installing the HoloLens Emulator

  HoloLens Emulator system requirementsHoloLens Emulator system requirements

The HoloLens Emulator lets you test holographic applications on your PC without a physical HoloLens, including

the HoloLens development toolset. The emulator uses a Hyper-V virtual machine, which means human and

environmental inputs being read by HoloLens sensors are simulated from your keyboard, mouse, or Xbox

controller. You don't even need to modify your projects to run on the emulator, the app doesn't know it isn't

running on a real HoloLens.

If you're looking to develop Windows Mixed Reality immersive (VR) headset applications or games for desktop

PCs, check out the Windows Mixed Reality simulator, which lets you simulate desktop headsets.

Download the HoloLens Emulator.

Versions:

Download latest build from HoloLens Emulator archive page.

HoloLens Emulator (first Gen) and holographic project templates.

The HoloLens Emulator uses Hyper-V with RemoteFx (first Gen Emulator) or GPU-PV (HoloLens 2 Emulator) for

hardware accelerated graphics. To use the emulator, make sure your PC meets the following hardware

requirements:

64-bit Windows 10 Pro, Enterprise, or Education

NOTENOTE

64-bit CPU

CPU with four cores (or multiple CPUs with a total of four cores)

8 GB of RAM or more

In the BIOS, the following features must be supported and enabled:

GPU requirements

Windows 10 Home Edition does not support Hyper-V or the HoloLens Emulator.

The HoloLens 2 Emulator requires the Windows 10 October 2018 update or later.

Hardware-assisted virtualization

Second Level Address Translation (SLAT)

Hardware-based Data Execution Prevention (DEP)

DirectX 11.0 or later

WDDM 1.2 graphics driver or later (first gen)

WDDM 2.5 graphics driver (HoloLens 2 Emulator)

The emulator might work with an unsupported GPU, but will be slower

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/using-the-hololens-emulator.md
https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/HoloLens-2-Emulator-Overview/player?format=ny
https://go.microsoft.com/fwlink/?linkid=2065980
https://docs.microsoft.com/en-us/archive/blogs/iftekhar/enable-hardware-settings-in-bios-to-run-hyper-v


 Deploying apps to the HoloLens Emulator

 Basic emulator input

If your system meets the requirements listed above, ensure that the "Hyper-V" feature has been enabledensure that the "Hyper-V" feature has been enabled

on your systemon your system. Go to Control Panel -> Programs -> Programs and Features -> Turn WindowsControl Panel -> Programs -> Programs and Features -> Turn Windows

Features on or offFeatures on or off  and check that Hyper-VHyper-V is selected.

1. Load your application solution in Visual Studio.

NOTENOTE

2. For HoloLens Emulator (first gen), ensure that Platform is set to x86x86 . For the HoloLens 2 Emulator, ensure

that the Platform is set to x86x86  or x64x64 .

3. Select the HoloLens EmulatorHoloLens Emulator  version you want as the target device for debugging.

4. Go to Debug > Star t DebuggingDebug > Star t Debugging or press F5F5  to launch the emulator and deploy your application for

debugging.

When using Unity, build your project from Unity and then load the built solution into Visual Studio, as usual.

The emulator may take a minute or more to boot when you first start it. We recommend that you keep the

emulator open during your debugging session, so that you can quickly deploy applications to the emulator.

Controlling the emulator is similar to many common 3D video games. Input options are available for using the

keyboard, mouse, or Xbox controller. You control the emulator by directing the actions of a simulated user by

wearing a HoloLens. Your actions move the simulated user around the environment. Applications running in the

emulator respond like they would on a real device.

The cursor on HoloLens (first gen) follows head movement and rotation. In the HoloLens 2 Emulator, the cursor

follows hand movement and orientation.

Walk for ward, back , left, and r ightWalk for ward, back , left, and r ight - Use the W,A,S, and D keys on your keyboard, or the left stick on an

Xbox controller.

Look up, down, left, and r ightLook up, down, left, and r ight - Select and drag the mouse, use the arrow keys on your keyboard or the

right stick on an Xbox controller.

Air  tap gestureAir  tap gesture - Right-click the mouse, press the Enter key on your keyboard or use the A button on an

Xbox controller.

Bloom/System gestureBloom/System gesture - Press the Windows key or F2 key on your keyboard or press the B button on an

Xbox controller.

Hand movement for scrollingHand movement for scrolling - Simultaneously hold the Alt key and the right mouse button, and drag the

mouse up or down. In an Xbox controller, hold down the right trigger and A button and move the right stick

up and down.

Hand movement and orientationHand movement and orientation (HoloLens 2 Emulator only) - Hold the Alt key and drag the mouse up

or down, left or right to move the hand. You can also use the arrow keys and Q or E to rotate and tilt the

hand. For an Xbox controller, hold the left or right bumper and use the left thumbstick to move the hand left,

right, forward, and back, the right thumbstick to rotate it. Use up or down on the Dpad to raise or lower the

hand.

Have a Windows Mixed Reality immersive headset? Starting with the HoloLens 2 Emulator (Windows

Holographic, version 2004), you can use your Windows Mixed Reality immersive headset and motion controllers

to control the HoloLens 2 Emulator and view it in stereo. See Using a Windows Mixed Reality immersive headset

and motion controllers with the HoloLens 2 Emulator



 

Anatomy of the HoloLens 2 Emulator
  Main windowMain window

  ToolbarToolbar

  Simulation control panelSimulation control panel

To the right of the main window, find the emulator toolbar. The toolbar contains the following buttons:

 CloseClose: Closes the emulator.

 MinimizeMinimize: Minimizes the emulator window.

 S imulation control panelS imulation control panel : Show or hide the Simulation control panel for configuring and controlling

input to the emulator.

 Fit to screenFit to screen: Fits the emulator to screen.

 ZoomZoom: Make the emulator larger and smaller.

 HelpHelp: Open emulators help.

 Open Device Por talOpen Device Por tal : Open the Windows Device Portal for the HoloLens OS in the emulator.

 ToolsTools : Open the Additional toolsAdditional tools  pane.

The Simulation control panel lets you view the current position and orientation of the simulated human and

input devices. It also allows you to configure both simulated input, such as showing or hiding one or both hands,

and devices used for controlling simulated input, such as your PC's keyboard, mouse and gamepad.



To hide or show the simulation panel, select the toolbar button or press F7 on your keyboard.

Hover the mouse over a control or field to display a tooltip that contains keyboard, mouse, and gamepad

controls for it.

To show or hide a hand, toggle the appropriate switch under Left hand or Right hand.

To control the hand, use either the left or right Alt keys on your keyboard or the left or right bumper on the

gamepad.

To direct all input to one or both hands, select the pushpin button under the toggle switch, which is the same



  Account tabAccount tab

  Optional settings tabOptional settings tab

  Diagnostics tabDiagnostics tab

  Network tabNetwork tab

  NAT Configuration tabNAT Configuration tab

as holding the Alt key for the hand.

To control eye gaze direction, select the pushpin in the Eyes section, which is the same as holding down the Y

key on the keyboard.

To load a room recording, select the Load button in the Recording section. See simulated rooms for more

information.

To adjust the speed that the simulated human or input devices will move or rotate in response to keyboard,

mouse or gamepad input, select the gear icon next to Input settings, and adjust the sliders.

By default, keyboard input controls the simulated human and simulated input. To have your PC's keyboard

input sent through to the HoloLens, uncheck Use keyboard for simulation. F4 is the shortcut key for this

setting.

If the simulation panel is already visible, pressing F8 moves keyboard focus into it.

To undock the simulation panel from the emulator window, select the button at the bottom of the panel or

press F9 on your keyboard. Closing the window or pressing F9 again returns the window to the emulator.

The simulation control panel can be launched as a separate application, allowing you to connect to and

control the HoloLens 2 Emulator, a HoloLens 2 device, or Windows Mixed Reality simulation by running

PerceptionSimulationInput.exe from %ProgramFiles(x86)%\Windows Kits\10\Microsoft XDE\10.0.18362.0.

The Account tab lets you configure the emulator to sign in with a Microsoft Account. This is useful for testing

APIs that require the user to be signed in with an account. Toggling this option requires that you completely

close and restart the HoloLens Emulator for the setting to take effect. If this option is enabled, later launches of

the emulator will ask you to sign in, just like a user would the first-time HoloLens is started. To enter your

credentials using your PC's keyboard, first turn off Use keyboard for simulation in the Simulation Control Panel

or press F4 on your keyboard to toggle the keyboard setting on or off.

The Optional settings tab displays a control to enable or disable hardware accelerated graphics. Hardware

accelerated graphics are used by default, if supported by your PC's graphics adapter drive. If your graphics

adapter's driver doesn't support GPU-PV, this option won't be visible.

The Diagnostics tab shows the emulator's IP address in the form of a link to Windows Device Portal along with

the status of the virtual GPU.

The Network tab shows the network adapter details for the emulator, as well as network adapter details for the

host machine. For the HoloLens 2 Emulator, this tab will only appear when running the emulator on the

Windows 10 May 2019 Update or newer.

This tab will only appear when running the emulator on the Windows 10 May 2019 Update or newer.

The emulator uses your PC's network connection and sits behind a NAT. This tab allows you to map ports from

your host PC to the emulator, which enables remote devices to connect to applications and services running in

the emulator.

For example, if you want to access Device Portal on the emulator from a remote PC:

1. Add an entry for internal port 80 (the port on which Device Portal is listening) by double-clicking on a free

row in the table. For other applications, enter the port number on which that application is listening.

2. Choose any available external port. In this example, we'll use port 8080 as the external port.

3. Select the protocol. The default is TCP. Since Device Portal uses TCP, we'll leave the default.

4. Click "Apply Changes" to enable the mapping. The 'Status' will change from 'Pending' to 'Active'.



  Updates tabUpdates tab

5. On the remote PC, open a browser and navigate to (IP-of-the-PC-running-the-emulator):8080. The Device

Portal interface will appear. The IP address you use on a remote PC must be the IP address of the PC running

the emulator, not of the emulator itself. You can retrieve the IP through various means such as the Settings

app on the PC in the 'Network & Internet' category, 'ipconfig' from a Command Prompt and from the

Network tab in the emulator Tools dialog by looking for the Desktop Adapter entry.

Also note that if you add a port mapping for Device Portal, you can control the emulator remotely using the

Perception Simulation Control tool included in the emulator installation or with the Perception Simulation APIs

by connecting to the host PC's IP address and Device Portal external port, such as 8080 in the example above.

When using Perception Simulation Control to connect to and control the emulator remotely, only specify the

PC's IP address and the configured port. Don't include 'https://'.

There are no port mappings by default. Any mappings you configure are persistent across launches of the

HoloLens 2 Emulator and will be enabled automatically when the emulator has booted fully.

Use the 'Export' button to save your mappings to a file. You can then share this file with other team members

who can use the 'Import' button to automatically configure the same mappings.

This tab will only appear when running the emulator on the Windows 10 May 2019 Update or newer.

On startup, the emulator will check for new versions. If a new version is available, the emulator will display a

prompt showing the version you have, along with the available version and asking if you want to update. If you

select 'Yes', the installer for the new version is downloaded.

The Updates tab allows you control whether or not the emulator checks for new versions by toggling the

"Automatically check for updates" check box on this tab. It also allows you to see and download other available

emulator versions, starting with the September 2019 Update. For versions other than the one currently running,

a download link is provided. Clicking this link will download the installer for that version.



  Using a Windows Mixed Reality immersive headset and motion controllers with the HoloLens 2 EmulatorUsing a Windows Mixed Reality immersive headset and motion controllers with the HoloLens 2 Emulator
Starting with the HoloLens 2 Emulator (Windows Holographic, version 2004), you can use a Windows Mixed

Reality headset and motion controllers to view and interact with the HoloLens 2 Emulator in stereo. This allows

you to make faster, more natural movements with your head and hands without a HoloLens 2 device. It isn't a

complete replacement for a HoloLens 2 device, but is intended to give an improved experience beyond

interacting with the emulator using keyboard, mouse and gamepad in a 2D desktop window. To enable this

feature:

1. Ensure that Windows Mixed Reality is configured on your PC and your Windows Mixed Reality immersive

headset is connected.

2. Launch the HoloLens 2 Emulator

3. Open the Simulation panel by clicking the toolbar button or pressing F7.

4. Scroll the panel to the bottom.

5. Check the box labeled "Use HMD for simulation"

6. Windows Mixed Reality will start and the emulator display will change slightly. Without a headset, the

emulator places both eyes in the center of the head and displays only one eye. With a headset, the emulator

generates true stereo output but only renders one eye to its desktop window, while both eyes are rendered

to your headset.

7. Optionally turn on one or both motion controllers. Controller input is mapped to hand input in the emulator.

For example, to tap, pull the trigger on the motion controller. To move around, use the thumbstick. For a

complete list of controls, see Advanced HoloLens Emulator and Mixed Reality Simulator input

Having trouble seeing content in your headset?

If the display is blank in both the headset and Mixed Reality Portal, but you see content in the HoloLens 2

Emulator window on your desktop, verify that hardware graphics acceleration is enabled in the emulator.

Windows Mixed Reality immersive headset support requires hardware graphics acceleration to be enabled in

the emulator.

If you see content in the headset but holograms are blurry or you see a double image, use the following

steps to adjust the stereo view for your eyes:

1. Temporarily turn off "Use HMD for simulation".

2. Launch Registry Editor (regedit.exe)

3. Navigate to HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\PerceptionSimulation



 Anatomy of the HoloLens (first gen) emulator
  Main windowMain window

  ToolbarToolbar

4. Create a new DWORD value named "EnableEyePoseControl" and set its value to 1.

5. Enable "Use HMD for simulation" in the emulator.

6. When content appears in the headset, use the arrow keys to adjust eye rotation. Hold Left Alt to adjust the

left eye and Right Alt to adjust the right eye. Use 'Q' and 'E' to adjust the roll for each eye, again holding the

appropriate Alt key for the eye. Use the '+' and '-' keys to adjust the distance between the eyes. (Note that

+/- on a number pad will not work. Use the buttons on the main keyboard.)

7. When the stereo view appears correct, press 'S' to save your changes. The new configuration will be saved

for future launches of the emulator.

8. If you want to abandon your changes and revert to the previous configuration, press 'L' to load the default or

previous configuration.

9. Change the "EnableEyePoseControl" value in the registry to 0 and cycle the "Use HMD for simulation" option.

If you have saved a configuration and want to remove it, you can delete the value named "DisplayConfiguration"

at HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\PerceptionSimulation. If you are

currently using the headset with the emulator, you will need to turn off "Use HMD for simulation" and turn it

back on to see this change take effect.

When the emulator launches, you'll see a window, which displays the HoloLens OS.

To the right of the main window, you'll find the emulator toolbar. The toolbar contains the following buttons:

 CloseClose: Closes the emulator.

 MinimizeMinimize: Minimizes the emulator window.

 Human inputHuman input: Mouse and keyboard are used to simulate human input to the emulator.

 Keyboard and mouse inputKeyboard and mouse input: Keyboard and mouse input are passed directly to the HoloLens OS as

keyboard and mouse events, as if you connected a Bluetooth keyboard and mouse.



  Simulation tabSimulation tab

  Room tabRoom tab

 Fit to screenFit to screen: Fits the emulator to screen.

 ZoomZoom: Makes the emulator larger and smaller.

 HelpHelp: Opens emulator help.

 Open Device Por talOpen Device Por tal : Open the Windows Device Portal for the HoloLens OS in the emulator.

 ToolsTools : Open the Additional toolsAdditional tools  pane.

The default tab within the Additional toolsAdditional tools  pane is the S imulationSimulation tab.

The Simulation tab shows the current state of the simulated sensors used to drive the HoloLens OS within the

emulator. Hovering over any value in the Simulation tab provides a tooltip describing how to control that value.

The emulator simulates world input in the form of the spatial mapping mesh from simulated rooms. This tab

lets you pick the room to load instead of the default room.



  Account tabAccount tab

 Simulated rooms

 Known Issues

See simulated rooms for more information.

The Account tab allows you to configure the emulator to sign in with a Microsoft Account. This is useful for

testing APIs that require the user to be signed-in with an account. After checking the box on this page, later

launches of the emulator will ask you to sign in, just like a user would the first time the HoloLens is started.

Simulated rooms are useful for testing your application in multiple environments. Several rooms are shipped

with the emulator. Once you install the emulation, you'll find them in %ProgramFiles(x86)%\Windows

Kits\10\Microsoft XDE\(version)\Plugins\Rooms. All of these rooms were captured in real environments using a

HoloLens:

DefaultRoom.xefDefaultRoom.xef  - A small living room with a TV, coffee table, and two sofas. Loaded by default when you

start the emulator.

Bedroom1.xefBedroom1.xef  - A small bedroom with a desk.

Bedroom2.xefBedroom2.xef  - A bedroom with a queen size bed, dresser, nightstands, and walk-in closet.

GreatRoom.xefGreatRoom.xef  - A large open space great room with living room, dining table, and kitchen.

L ivingRoom.xefL ivingRoom.xef  - A living room with a fireplace, sofa, armchairs, and a coffee table with a vase.

You can also record your own rooms to use in the emulator with the Simulation page of the Windows Device

Portal on your HoloLens (first gen).

In the emulator, you'll only see holograms that you render. But you'll see the simulated room behind the

holograms. This is in contrast to the actual HoloLens where you see both blended together. If you want to see

the simulated room in the HoloLens Emulator, you need to update your application to render the spatial

mapping mesh in the scene.

When uninstalling the HoloLens 2 Emulator, the hard disk image (Flash.vhdx) may be left on your hard drive

in the Windows Kits\10\Emulation\HoloLens<build number> folder. It's safe to delete this file.

Hardware graphics acceleration may cause Holographic apps to crash on some systems with AMD or Intel

graphics. Disabling hardware graphics acceleration in the emulator Tools window works around this issue.



 Troubleshooting

After installing the latest Windows updates as of July 2020, hardware graphics acceleration in the HoloLens

Emulator (first Gen) might no longer be available. The RemoteFX component needed for hardware graphics

acceleration has been deprecated and will be removed in a future Windows release. To re-enable hardware

graphics acceleration, use the Enable-VMRemoteFXPhysicalVideoAdapter PowerShell cmdlet. Refer to the

documentation on the deprecation and removal of RemoteFX support in Windows for additional information.

You may see an error message while installing the emulator, indicating that you need "Visual Studio 2015

Update 1 and UWP tools version 1.2". There are three possible causes of this error :

You don't have a recent enough version of Visual Studio (Visual Studio 2019, Visual Studio 2017, or Visual

Studio 2015 Update 1 or later). To correct this, install the latest release of Visual Studio.

You have a recent version of Visual Studio, but you don't have the Universal Windows Platform (UWP) tools

installed. This is an optional feature for Visual Studio. For HoloLens (first Gen), you'll need UWP Tools for

Visual Studio 2015 or Visual Studio 2017.

You may also see an error installing the emulator on a non-Pro/Enterprise/Education SKU of Windows or if you

don't have Hyper-V feature enabled.

Read the system requirements section above for a complete set of requirements.

Also ensure that the Hyper-V feature has been enabled on your system.

If your installation completes successfully, but you don't see the HoloLens Emulator as an option for deployment

and debugging:

Your Visual Studio project configuration is set to x86 (HoloLens first Gen), x86 or x64 (HoloLens 2 Emulator).

If using Visual Studio 2019, the Platform Toolset in your project configuration is set to v142.

If your installation completes successfully, but Visual Studio displays an error attempting to launch the HoloLens

Emulator :

Run Visual Studio as Administrator

If you've only ever had Visual Studio 2019 installed, verify that the registry value "KitsRoot10" at

HKEY_LOCAL_MACHINE\Software\Microsoft\Windows Kits\Installed Roots points to your 32-bit Program

Files folder (for example, "C:\Program Files (x86)\Windows Kits\10"). If it doesn't, uninstall the HoloLens

Emulator, change the registry value to your 32-bit Program Files folder, then reinstall the HoloLens Emulator.

This issue is addressed in Visual Studio 2019 16.0.3.

If the emulator displays an "Invalid Byte Encoding" error dialog upon launch:

Delete all files in %localappdata%\Microsoft\XDE\HCS and try again.

If your debug target list in Visual Studio is empty (for example, Start is the only option) and you've followed all

troubleshooting steps above:

Delete the ConfigurationCache folder in %localappdata%\Microsoft\VisualStudio\<installation id>\CoreCon

and try again.

If your system hangs when the emulator is starting, disable hardware acceleration for emulator graphics.

Create a registry DWORD value named "DisableGPU" at

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\XDE\10.0 and set its value to 1.

If Hololens2 Emulator doesn't respond to input from your keyboard or mouse, try disabling your VPN

connection.

https://docs.microsoft.com/en-us/powershell/module/hyper-v/enable-vmremotefxphysicalvideoadapter
https://support.microsoft.com/help/4570006/update-to-disable-and-remove-the-remotefx-vgpu-component


 See also
Advanced HoloLens Emulator and Mixed Reality Simulator input

HoloLens Emulator software history

Spatial mapping in Unity

Spatial mapping in DirectX
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 Enabling the Windows Mixed Reality simulator

 Deploying apps to the Mixed Reality simulator

 Basic simulator input

The Windows Mixed Reality simulator allows you to test mixed reality apps on your PC without a Windows

Mixed Reality immersive headset. The simulator is available with the Windows 10 Creators Update. The

simulator is similar to the HoloLens Emulator, though the simulator doesn't use a virtual machine. Simulated

apps run in your Windows 10 desktop user session, just like they would if you were using an immersive

headset. The human and environmental inputs read by the sensors on an immersive headset are instead

simulated using your keyboard, mouse, or Xbox controller. Apps don't need any modification to run in the

simulator, and don't know they aren't running on an immersive headset.

1. Enable Developer modeEnable Developer mode from Settings -> Update and Security -> For developers

2. Launch the Mixed Reality Por talMixed Reality Por tal  from the desktop

3. If this is your first time launching the portal, you'll need to go through the setup experience

4. Select the For developersFor developers  button on the left side of the Mixed Reality Portal

5. Turn the Simulation toggle switch to OnOn

a. Select Get star tedGet star ted

b. Select I agreeI agree to accept the agreement

c. Select Set up for simulation (for developers)Set up for simulation (for developers)  to continue through setup without a physical device

d. Select Set upSet up to confirm your choice

Enabling simulation installs and enables the left simulated 6-DOF controller by default. Before the

Windows 10 May 2019 update, installing a simulated 6-DOF controller requires administrator

permissions. Accept the User Account Control dialog if one appears.

You should now be running with simulation!

If you want to disable Developer mode in Settings, you should first turn the Simulation toggle switch to OffOff  in

the For developersFor developers  section of the Mixed Reality Portal.

Since the simulator runs on your local PC without a Virtual Machine, you can deploy your Universal Windows

apps to the Local MachineLocal Machine when debugging.

Controlling the simulator is similar to many common 3D video games and the HoloLens emulator. There are

input options available using the keyboard, mouse, or Xbox controller.

You control the simulator by directing the actions of a simulated user wearing an immersive headset. Your

actions move the simulated user and cause interactions with apps that respond as they would on an immersive

headset.

Walk for ward, back , left, and r ightWalk for ward, back , left, and r ight - Use the W,A,S, and D keys on your keyboard, or the left stick on an

Xbox controller.

Look up, down, left, and r ightLook up, down, left, and r ight - Select and drag the mouse, use the arrow keys on your keyboard, or the

right stick on an Xbox controller.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/using-the-windows-mixed-reality-simulator.md


 Tracked controllers

 Next Development Checkpoint

 See also

Action button press on controllerAction button press on controller  - Right-click the mouse, press the Enter key on your keyboard, or use

the A button on an Xbox controller.

Home button press on controllerHome button press on controller  - Press the Windows key or F2 key on your keyboard, or press the B

button on an Xbox controller.

Controller  movement for scrollingController  movement for scrolling - Hold the Alt key and the right mouse button, then drag the mouse

up / down. In an Xbox controller, hold down the right trigger and A button and move the right stick up and

down.

The Mixed Reality simulator can simulate up to two hand-held tracked motion controllers. Enable them using the

toggle switches in the Mixed Reality Portal. Each simulated controller has:

Position and orientation in space

Home button

Menu button

Grip button

Touchpad

Thumbstick

Battery level

If you're following the Unity development checkpoint journey we've laid out, you're in the midst of the

deployment stage. From here, you can continue to the next topic or jump directly to adding advanced services.

Advanced services

Using the HoloLens emulator

Advanced Mixed Reality Simulator Input

Spatial mapping in Unity

Spatial mapping in DirectX



   

 

Advanced HoloLens Emulator and Mixed Reality
Simulator input

 7/6/2022 • 7 minutes to read • Edit Online

 Concepts

Most emulator users will only need to use the basic input controls for the HoloLens Emulator or the Windows

Mixed Reality simulator. The details below are for advanced users who have found a need to simulate more

complex types of input.

To get started controlling the virtual input to the HoloLens Emulator and Windows Mixed Reality simulator, you

should first understand a few concepts.

Motion refers to controlling and changing the position and orientation of something in the scene. For a targeted

controllable object, motion is controlled with both rotation and translation (movement) along three axes.

YawYaw : Turn left or right.

PitchPitch: Turn up or down.

RollRoll : Roll side-to-side.

XX: Move left or right.

YY : Move up or down.

ZZ: Move forward or backward.

Gesture and motion controller input are mapped closely to physical devices:

ActionAction: Simulates the action of pressing the forefinger to the thumb or pulling the action button on a

controller. For example, the Action input can be used to simulate the air-tap gesture, to scroll through content,

and to press-and-hold.

BloomBloom/System gesture or Home/System gesture or Home: The HoloLens bloom/system gesture or a controller's Home button is

used to return to the shell and to fire system actions.

Hands have a rich representation in HoloLens 2. In addition to being tracked/not tracked and usable for driving

gestures, hands now have an articulated skeleton model fit to them and exposed to the developer. The skeleton

model has 26 tracked points on each hand.

JointJoint: One of 20 tracked positions for a given tracked hand with an associated point in 3d space.

PosePose: A complete collection of all of the Joints in a tracked hand, 26 Joints in all.

We don't currently expose direct control of individual joint positions through the emulator, but you can set them

through the simulation API. We have a set of useful representative poses that the emulator allows you to toggle

between.

You can also control the state of simulated sensor input:

ResetReset: Returns all simulated sensors to their default values. Starting with the HoloLens 2 Emulator, a reset

can be scoped to one or both hands. Engage the desired hand(s) using the modifier key(s) or button(s) (Left

and/or Right Alt, or the left and/or right bumper on the gamepad).

TrackingTracking: Cycles through the positional tracking modes, including:

DefaultDefault: The OS chooses the best tracking mode based upon the requests made of the system.

OrientationOrientation: Forces Orientation-only tracking, no matter the system requests.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/advanced-hololens-emulator-and-mixed-reality-simulator-input.md


 Types of input

IN P UTIN P UT KEY B O A RDKEY B O A RD M O USEM O USE XB O X C O N T RO L L ERXB O X C O N T RO L L ER

Yaw Left / right arrows Drag Left / Right Right thumbstick left / right

Pitch Up / down arrows Drag up / down Right thumbstick up / down

Roll Q / E DPad left / right

X A / D Left thumbstick left / right

Y Page up / page down DPad up / down

Z W / S Left thumbstick up / down

Action Enter or space Right button A button or either trigger

Bloom/System F2 or Windows key B button

Controller grip button /
Hand grasp

G

Controller menu button M

Controller touchpad touch U

Controller touchpad press P

Controller thumbstick press K

Left controller tracking state F9

Right controller tracking
state

F10

Hand 'Close' Pose 7

Hand 'Open' Pose (default) 8

Hand 'Point' Pose 9

Hand 'Pinch' Pose 0

Reset Escape key Start button

Tracking T or F3 X button

PositionalPositional : Forces Positional tracking, no matter the system requests.

The following table shows how each type of input maps to the keyboard, mouse, and Xbox controller. Each type

has a different mapping depending on the input control mode. You can find more information on input control

modes later in this document.



 Targeting

O B JEC TO B JEC T KEY B O A RD M O DIF IERKEY B O A RD M O DIF IER C O N T RO L L ER M O DIF IERC O N T RO L L ER M O DIF IER EM UL ATO R UI M O DIF IEREM UL ATO R UI M O DIF IER

Body (default) (default) (default)

Head Hold H (Not available) (Not available)

Left Hand/Controller Hold Left Alt button Hold Left Shoulder Button Left-Hand pushpin

Right Hand/Controller Hold Right Alt Button Hold Right Shoulder Button Right-Hand pushpin

Eyes Hold Y (Not available) Eyes Pushpin

IN P UTIN P UT DEFA ULT  ( B O DY )DEFA ULT  ( B O DY )

H A N D/ C O N T RO L L ERH A N D/ C O N T RO L L ER
( H O L D A LT,  H O L D( H O L D A LT,  H O L D
GA M EPA DGA M EPA D
SH O UL DER B UT TO N ,SH O UL DER B UT TO N ,
O R TO GGL E UIO R TO GGL E UI
P USH P IN )P USH P IN ) H EA D ( H O L D H )H EA D ( H O L D H )

EY ES ( H O L D Y  O REY ES ( H O L D Y  O R
TO GGL E UI P USH P IN )TO GGL E UI P USH P IN )

Yaw Turn body left / right Move hand left /
right

Turn head left / right Eye gaze looks
left/right

Pitch Turn head up / down Move hand up /
down

Turn head Up / down Eye gaze looks
up/down

Roll Roll head left / right Roll head left / right (No action)

X Slide body left / right Move
hand/controller left /
right

Turn head left / right (No Action)

Y Move body up /
down

Move
hand/controller up /
down

Turn head up / down (No Action)

Z Move body forward /
backward

Move
hand/controller
forward / backward

Turn head up / down (No Action)

 Controlling an app

Note: The controller buttons can be targeted to one hand/controller or the other using the hand targeting

modifiers.

Some of the above input concepts stand on their own. Action, Bloom/System, Reset, and Tracking are complete

concepts, don't need, and are not affected by, any additional modifiers for targeting. The remaining concepts can

be applied to one of multiple targets. We have introduced ways for you to specify which intended target your

command should be applied to. In all cases, it's possible to specify through the UI or through keyboard presses,

which object to target. In some cases, it's also possible to specify with the xbox controller directly.

The following table describes the options for targeting, and the way to activate each of them.

The following table shows how each target modifier maps each of the core movement input concepts



O P ERAT IO NO P ERAT IO N KEY B O A RD A N D M O USEKEY B O A RD A N D M O USE C O N T RO L L ERC O N T RO L L ER

Body X A / D Left thumbstick left / right

Body Y Page up / page down DPad up / down

Body Z W / S Left thumbstick up / down

Body Yaw Drag mouse left / right Right thumbstick left / right

Head Yaw H + drag mouse left / right H (on Keyboard) + right thumbstick
left / right

Head Pitch Drag mouse up / down Right thumbstick up / down

Head Roll Q / E DPad left / right

Hand/Controller X Alt + A / D Shoulder + left thumbstick left / right

Hand/Controller Y Alt + Page up / page down Shoulder + DPad up / down

Hand/Controller Z Alt + W / S Shoulder + Left thumbstick up / down

Hand/Controller Yaw Alt + drag mouse left / right Shoulder + right thumbstick left / right

Hand/Controller Pitch Alt + drag mouse up / down Shoulder + right thumbstick up /
down

Hand/Controller Roll Alt + Q / E Shoulder + DPad left / right

Action Right mouse button Trigger

Bloom / System / Home F2 or Windows key B button

Reset Escape Start button

Tracking T X button

Scrolling Alt + right mouse button + drag
mouse up / down

Shoulder + trigger + right thumbstick
up / down

Move/rotate faster Left or right Shift key Press and hold the right thumbstick

Move/rotate slow Left or right Ctrl key Press and hold the left thumbstick

 Using a Windows Mixed Reality immersive headset and motion
controllers with the HoloLens 2 Emulator

The following set of controls is suggested for day-to-day use:

When using a Windows Mixed Reality immersive headset with the HoloLens 2 Emulator, movement and rotation

are automatically mapped to headset movement and rotation. Motion controller position and orientation are

automatically mapped to hand position and orientation in the emulator. The table below lists additional actions



NOTENOTE

O P ERAT IO NO P ERAT IO N A C T IO NA C T IO N N OT ESN OT ES

Body X Thumbstick Left / Right

Body Z Thumbstick Forward / Back

Body Y Keyboard Page Up /Down Ensure that Windows Mixed Reality has
focus. Press Win+Y if focus is on the
Windows Desktop to return focus to
Windows Mixed Reality.

Eyes Look Left / Right DPad Left / Right

Eyes Look Up / Down DPad Up / Down

Tap Trigger

Pinch/Grasp Grip button

System Gesture Menu button

Reset Position Thumbstick click

 Perception Simulation Control Panel keyboard shortcuts

O P ERAT IO NO P ERAT IO N SH O RTC UTSH O RTC UT DESC RIP T IO N / N OT ESDESC RIP T IO N / N OT ES

Toggle 'Use keyboard for simulation' F4 When turned off, keyboard input goes
to the HoloLens or Windows Mixed
Reality application.

Toggle 'Use mouse for simulation' F5 When turned off, mouse input goes to
the Mixed Reality environment
(Windows Mixed Reality only)

Toggle 'Use gamepad for simulation' F6 When turned off, gamepad input is
ignored by simulation

Show or hide the control panel F7

Set keyboard focus to the control
panel

F8 If the panel is not currently visible, it
will be shown first.

available when using a motion controller.

When using a headset, standard keyboard, mouse, and gamepad controls are automatically ignored.

You can access the Perception Simulation Control panel and enable or disable PC input devices with the

following keyboard shortcuts.



Dock or undock the panel to/from the
emulator or Mixed Reality Portal
window

F9 If the window is closed when
undocked, it's docked and hidden.

O P ERAT IO NO P ERAT IO N SH O RTC UTSH O RTC UT DESC RIP T IO N / N OT ESDESC RIP T IO N / N OT ES

 See also
Install the tools

Using the HoloLens emulator

Using the Windows Mixed Reality simulator



   

 

HoloLens 2 Emulator archive
 7/6/2022 • 7 minutes to read • Edit Online

B UIL DB UIL D REL EA SE DAT EREL EA SE DAT E N OT ESN OT ES

HoloLens 2 Emulator build
10.0.20348.1503

June 14, 2022 Windows Holographic, version 22H1
June 2022 Update.

HoloLens 2 Emulator build
10.0.19041.1185

June 14, 2022 Windows Holographic, version 20H2
June 2022 Update.

HoloLens 2 Emulator build
10.0.20348.1503

May 10, 2022 Windows Holographic, version 22H1
May 2022 Update.

HoloLens 2 Emulator build
10.0.19041.1185

May 10, 2022 Windows Holographic, version 20H2
May 2022 Update.

HoloLens 2 Emulator build
10.0.20348.1501

April 12, 2022 Windows Holographic, version 22H1.

HoloLens 2 Emulator build
10.0.19041.1183

April 12, 2022 Windows Holographic, version 20H2
April 2022 Update.

HoloLens 2 Emulator build
10.0.20348.1450

March 8, 2022 Windows Holographic, version 21H2
March 2022 Update.

HoloLens 2 Emulator build
10.0.19041.1178

March 8, 2022 Windows Holographic, version 20H2
March 2022 Update.

HoloLens 2 Emulator build
10.0.20348.1447

February 8, 2022 Windows Holographic, version 21H2
February 2022 Update.

HoloLens 2 Emulator build
10.0.19041.1176

February 8, 2022 Windows Holographic, version 20H2
February 2022 Update.

HoloLens 2 Emulator build
10.0.20348.1442

January 11, 2022 Windows Holographic, version 21H2
January 2022 Update.

HoloLens 2 Emulator build
10.0.19041.1174

January 11, 2022 Windows Holographic, version 20H2
January 2022 Update.

HoloLens 2 Emulator build
10.0.20348.1440

December 14, 2021 Windows Holographic, version 21H2
December 2021 Update.

HoloLens 2 Emulator build
10.0.19041.1173

December 14, 2021 Windows Holographic, version 20H2
December 2021 Update.

HoloLens Emulator (first gen) and HoloLens 2 Emulator builds install side by side. We recommend using the

latest available build, but there might be cases where you want to test an app against an old emulator. This page

includes links to all released versions.

For general HoloLens 2 release notes, see HoloLens Release Notes.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/hololens-emulator-archive.md
https://docs.microsoft.com/en-us/hololens/hololens-release-notes
https://go.microsoft.com/fwlink/?linkid=2198236
https://go.microsoft.com/fwlink/?linkid=2198409
https://go.microsoft.com/fwlink/?linkid=2194808
https://go.microsoft.com/fwlink/?linkid=2194809
https://go.microsoft.com/fwlink/?linkid=2193111
https://go.microsoft.com/fwlink/?linkid=2193110
https://go.microsoft.com/fwlink/?linkid=2189132
https://go.microsoft.com/fwlink/?linkid=2189204
https://go.microsoft.com/fwlink/?linkid=2186711
https://go.microsoft.com/fwlink/?linkid=2186603
https://go.microsoft.com/fwlink/?linkid=2185208
https://go.microsoft.com/fwlink/?linkid=2185051
https://go.microsoft.com/fwlink/?linkid=2183248
https://go.microsoft.com/fwlink/?linkid=2183249


HoloLens 2 Emulator build
10.0.20348.1438

November 9, 2021 Windows Holographic, version 21H2
November 2021 Update.

HoloLens 2 Emulator build
10.0.19041.1170

November 9, 2021 Windows Holographic, version 20H2
November 2021 Update.

HoloLens 2 Emulator build
10.0.20348.1432

October 12, 2021 Windows Holographic, version 21H2
October 2021 Update.

HoloLens 2 Emulator build
10.0.19041.1168

October 12, 2021 Windows Holographic, version 20H2
October 2021 Update.

HoloLens 2 Emulator build
10.0.20348.1018

September 15, 2021 Windows Holographic, version 21H1
September 2021 Update.

HoloLens 2 Emulator build
10.0.19041.1165

September 15, 2021 Windows Holographic, version 20H2
September 2021 Update.

HoloLens 2 Emulator build
10.0.20348.1014

August 10, 2021 Windows Holographic, version 21H1
August 2021 Update.

HoloLens 2 Emulator build
10.0.19041.1161

August 10, 2021 Windows Holographic, version 20H2
August 2021 Update.

HoloLens 2 Emulator build
10.0.20348.1010

July 13, 2021 Windows Holographic, version 21H1
July 2021 Update. 
When using the HoloLens 2 Emulator
on a PC with both integrated and
discrete graphics adapters, the
emulator will, in most cases, now be
able to enable hardware graphics
acceleration, though it might use the
less powerful integrated adapter.
Previously, hardware acceleration could
not be enabled, often reporting a
graphics failure with Code 43. In some
cases, the emulator would not boot
successfully but now will.

HoloLens 2 Emulator build
10.0.19041.1157

July 13, 2021 Windows Holographic, version 20H2
July 2021 Update. 
When using the HoloLens 2 Emulator
on a PC with both integrated and
discrete graphics adapters, the
emulator will, in most cases, now be
able to enable hardware graphics
acceleration, though it might use the
less powerful integrated adapter.
Previously, hardware acceleration could
not be enabled, often reporting a
graphics failure with Code 43. In some
cases, the emulator would not boot
successfully but now will.

HoloLens 2 Emulator build
10.0.20348.1007

June 8, 2021 Windows Holographic, version 21H1
June 2021 Update.

B UIL DB UIL D REL EA SE DAT EREL EA SE DAT E N OT ESN OT ES

https://go.microsoft.com/fwlink/?linkid=2179936
https://go.microsoft.com/fwlink/?linkid=2180206
https://go.microsoft.com/fwlink/?linkid=2174356
https://go.microsoft.com/fwlink/?linkid=2174359
https://go.microsoft.com/fwlink/?linkid=2172762
https://go.microsoft.com/fwlink/?linkid=2172868
https://go.microsoft.com/fwlink/?linkid=2169418
https://go.microsoft.com/fwlink/?linkid=2169166
https://go.microsoft.com/fwlink/?linkid=2167725
https://go.microsoft.com/fwlink/?linkid=2167735
https://go.microsoft.com/fwlink/?linkid=2165258


HoloLens 2 Emulator build
10.0.19041.1154

June 8, 2021 Windows Holographic, version 20H2
June 2021 Update.

HoloLens 2 Emulator build
10.0.20346.1002

May 11, 2021 Windows Holographic, version 21H1
May 2021 Update.

HoloLens 2 Emulator build
10.0.19041.1146

May 11, 2021 Windows Holographic, version 20H2
May 2021 Update.

HoloLens 2 Emulator build
10.0.19041.1144

April 13, 2021 Windows Holographic, version 20H2
April 2021 Update.

HoloLens 2 Emulator build
10.0.18362.1108

April 13, 2021 Windows Holographic, version 1903
April 2021 Update.

HoloLens 2 Emulator build
10.0.19041.1140

March 9, 2021 Windows Holographic, version 20H2
March 2021 Update.

HoloLens 2 Emulator build
10.0.18362.1102

March 9, 2021 Windows Holographic, version 1903
March 2021 Update.

HoloLens 2 Emulator build
10.0.19041.1136

February 9, 2021 Windows Holographic, version 20H2
February 2021 Update.

HoloLens 2 Emulator build
10.0.18362.1098

February 9, 2021 Windows Holographic, version 1903
February 2021 Update.

HoloLens 2 Emulator build
10.0.19041.1134

January 13, 2021 Windows Holographic, version 20H2
January 2021 Update.

HoloLens 2 Emulator build
10.0.18362.1091

January 13, 2021 Windows Holographic, version 1903
January 2021 Update.

HoloLens 2 Emulator build
10.0.19041.1131

December 8, 2020 Windows Holographic, version 20H2
December 2020 Update.

HoloLens 2 Emulator build
10.0.18362.1088

December 8, 2020 Windows Holographic, version 1903
December 2020 Update.

HoloLens 2 Emulator build
10.0.18362.1081

November 10, 2020 Windows Holographic, version 1903
November 2020 Update.

HoloLens 2 Emulator build
10.0.19041.1124

October 13, 2020 Windows Holographic, version 2004
October 2020 Update.

HoloLens 2 Emulator build
10.0.18362.1081

October 13, 2020 Windows Holographic, version 1903
October 2020 Update.

HoloLens 2 Emulator build
10.0.19041.1117

September 07, 2020 Windows Holographic, version 2004
September 2020 Update.

HoloLens 2 Emulator build
10.0.18362.1079

September 07, 2020 Windows Holographic, version 1903
September 2020 Update.

B UIL DB UIL D REL EA SE DAT EREL EA SE DAT E N OT ESN OT ES

https://go.microsoft.com/fwlink/?linkid=2165269
https://go.microsoft.com/fwlink/?linkid=2162581
https://go.microsoft.com/fwlink/?linkid=2162751
https://go.microsoft.com/fwlink/?linkid=2160829
https://go.microsoft.com/fwlink/?linkid=2160820
https://go.microsoft.com/fwlink/?linkid=2156684
https://go.microsoft.com/fwlink/?linkid=2156989
https://go.microsoft.com/fwlink/?linkid=2154784
https://go.microsoft.com/fwlink/?linkid=2154381
https://go.microsoft.com/fwlink/?linkid=2152389
https://go.microsoft.com/fwlink/?linkid=2152388
https://go.microsoft.com/fwlink/?linkid=2151523
https://go.microsoft.com/fwlink/?linkid=2151522
https://go.microsoft.com/fwlink/?linkid=2148612
https://go.microsoft.com/fwlink/?linkid=2145829
https://go.microsoft.com/fwlink/?linkid=2145828
https://go.microsoft.com/fwlink/?linkid=2141987
https://go.microsoft.com/fwlink/?linkid=2141985


HoloLens 2 Emulator build
10.0.19041.1113

August 11, 2020 Windows Holographic, version 2004
August 2020 Update.

HoloLens 2 Emulator build
10.0.18362.1074

August 11, 2020 Windows Holographic, version 1903
August 2020 Update.

HoloLens 2 Emulator build
10.0.19041.1109

July 14, 2020 Windows Holographic, version 2004
July 2020 Update.

HoloLens 2 Emulator build
10.0.18362.1071

July 14, 2020 Windows Holographic, version 1903
July 2020 Update. Resolves an issue
causing immersive applications to
crash on launch when hardware
graphics acceleration is enabled on
certain devices.

HoloLens 2 Emulator build
10.0.19041.1106

June 9, 2020 Windows Holographic, version 2004
June 2020 Update. Resolves issues
with DirectX 12 applications not
rendering, the on-screen keyboard not
appearing, grasping objects with hands
not working as expected and the
emulator failing to start with an error
about nested virtualization on AMD-
based systems.

HoloLens 2 Emulator build
10.0.18362.1064

June 9, 2020 Windows Holographic, version 1903
June 2020 Update. Resolves issues
with DirectX 12 applications not
rendering, the on-screen keyboard not
appearing and grasping objects with
hands not working as expected.

HoloLens 2 Emulator build
10.0.19041.1103

May 12, 2020 Windows Holographic, version 2004.
Windows Mixed Reality headsets and
motion controllers can be used to
control and view the HoloLens 2
Emulator in stereo.

HoloLens 2 Emulator build
10.0.18362.1061

May 12, 2020 Windows Holographic, version 1903
May 2020 Update.

HoloLens 2 Emulator build
10.0.18362.1059

April 13, 2020 Windows Holographic, version 1903
April 2020 Update.

HoloLens 2 Emulator build
10.0.18362.1056

March 10, 2020 Windows Holographic, version 1903
March 2020 Update.

HoloLens 2 Emulator build
10.0.18362.1053

February 11, 2020 Windows Holographic, version 1903
February 2020 Update.

HoloLens 2 Emulator build
10.0.18362.1044

January 13, 2020 Windows Holographic, version 1903
January 2020 Update.

B UIL DB UIL D REL EA SE DAT EREL EA SE DAT E N OT ESN OT ES

https://go.microsoft.com/fwlink/?linkid=2138219
https://go.microsoft.com/fwlink/?linkid=2138317
https://go.microsoft.com/fwlink/?linkid=2135188
https://go.microsoft.com/fwlink/?linkid=2135245
https://go.microsoft.com/fwlink/?linkid=2132415
https://go.microsoft.com/fwlink/?linkid=2132601
https://go.microsoft.com/fwlink/?linkid=2129088
https://go.microsoft.com/fwlink/?linkid=2129833
https://go.microsoft.com/fwlink/?linkid=2126826
https://go.microsoft.com/fwlink/?linkid=2121323
https://go.microsoft.com/fwlink/?linkid=2118321
https://go.microsoft.com/fwlink/?linkid=2114824


HoloLens 2 Emulator build
10.0.18362.1042

December 6, 2019 Windows Holographic, version 1903
December 2019 Update. Addresses an
issue were a Holographic app running
in the emulator will be suspended
unexpectedly when displaying the pins
panel. Enables connectivity to a remote
emulator when using the Perception
Simulation API or the Perception
Simulation Control app.

HoloLens 2 Emulator build
10.0.18362.1034

October 8, 2019 Windows Holographic, version 1903
October 2019 Update. The emulator
will prompt to update to a new version
when running a version older than the
latest available. When using the
emulator on the Windows 10 May
2019 Update or newer, the new NAT
Configuration tab allows developers to
open ports for applications running on
separate devices to connect to the
emulator and the Updates tab shows
available emulator versions. See the
HoloLens emulator documentation for
additional details.

HoloLens 2 Emulator build
10.0.18362.1031

September 11, 2019 Windows Holographic, version 1903
September 2019 Update. The Network
tab will appear in the emulator Tools
window when running the emulator on
the Windows 10 May 2019 Update or
newer.

HoloLens 2 Emulator build
10.0.18362.1028

August 14, 2019 Windows Holographic, version 1903
August 2019 Update. Holographic app
templates are no longer included but
are available in the Visual Studio
Marketplace. The emulator will now
work when SDKs are installed to a
custom location.

HoloLens 2 Emulator build
10.0.18362.1021

July 8, 2019 Windows Holographic, version 1903
July 2019 Update. Addresses a signing
issue with DiskStream.dll

HoloLens 2 Emulator build
10.0.18362.1019

June 11, 2019 Windows Holographic, version 1903
June 2019 Update. No longer needs to
be run as Administrator. Start menu
shortcut added.

HoloLens 2 Emulator build
10.0.18362.1005

April 16, 2019 Windows Holographic, version 1903.

B UIL DB UIL D REL EA SE DAT EREL EA SE DAT E N OT ESN OT ES

 HoloLens Emulator (first gen) archive

https://go.microsoft.com/fwlink/?linkid=2112589
https://go.microsoft.com/fwlink/?linkid=2106649
https://go.microsoft.com/fwlink/?linkid=2103724
https://go.microsoft.com/fwlink/?linkid=2101019
https://go.microsoft.com/fwlink/?linkid=2098508
https://go.microsoft.com/fwlink/?linkid=2095316
https://go.microsoft.com/fwlink/?linkid=2087187


B UIL DB UIL D REL EA SE DAT EREL EA SE DAT E N OT ESN OT ES

HoloLens Emulator build
10.0.17763.134

November 19, 2018 Latest HoloLens (first gen) build.
Windows 10 October 2018 Update.

HoloLens Emulator build
10.0.17134.80

May 21, 2018

HoloLens Emulator build
10.0.14393.1358

July 7, 2017

HoloLens Emulator build 10.0.14393.0 August 2, 2016

HoloLens Emulator build
10.0.14342.1018

May 31, 2016

HoloLens Emulator build
10.0.11082.1033

March 30, 2016

 See also
Install the tools

Using the HoloLens emulator

Advanced HoloLens emulator and Mixed reality simulator input

https://go.microsoft.com/fwlink/?linkid=2065980
https://go.microsoft.com/fwlink/?linkid=874531
https://go.microsoft.com/fwlink/?linkid=852626
https://go.microsoft.com/fwlink/?LinkID=823018
https://go.microsoft.com/fwlink/?LinkID=823018
https://go.microsoft.com/fwlink/?LinkID=724053
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 Setting Up a Visual Studio Project for Perception Simulation

Do you want to build an automated test for your app? Do you want your tests to go beyond component-level

unit testing and really exercise your app end-to-end? Perception Simulation is what you're looking for. The

Perception Simulation library sends human and world input data to your app so you can automate your tests.

For example, you can simulate the input of a human looking to a specific, repeatable position and then use a

gesture or motion controller.

Perception Simulation can send simulated input like this to a physical HoloLens, the HoloLens emulator (first

gen), the HoloLens 2 Emulator, or a PC with Mixed Reality Portal installed. Perception Simulation bypasses the

live sensors on a Mixed Reality device and sends simulated input to applications running on the device.

Applications receive these input events through the same APIs they always use and can't tell the difference

between running with real sensors versus Perception Simulation. Perception Simulation is the same technology

used by the HoloLens emulators to send simulated input to the HoloLens Virtual Machine.

To begin using simulation in your code, start by creating an IPerceptionSimulationManager object. From that

object, you can issue commands to control properties of a simulated "human", including head position, hand

position, and gestures. You can also enable and manipulate motion controllers.

1. Install the HoloLens emulator on your development PC. The emulator includes the libraries you' use for

Perception Simulation.

2. Create a new Visual Studio C# desktop project (a Console Project works great to get started).

3. Add the following binaries to your project as references (Project->Add->Reference...). You can find them in

%ProgramFiles(x86)%\Microsoft XDE\(version), such as %ProgramFiles(x86)%\Microsoft%ProgramFiles(x86)%\Microsoft

XDE\10.0.18362.0XDE\10.0.18362.0  for the HoloLens 2 Emulator. (Note: although the binaries are part of the HoloLens 2

Emulator, they also work for Windows Mixed Reality on the desktop.) a.

PerceptionSimulationManager.Interop.dll - Managed C# wrapper for Perception Simulation. b.

PerceptionSimulationRest.dll - Library for setting up a web-socket communication channel to the HoloLens

or emulator. c. SimulationStream.Interop.dll - Shared types for simulation.

4. Add the implementation binary PerceptionSimulationManager.dll to your project a. First add it as a binary to

the project (Project->Add->Existing Item...). Save it as a link so that it doesn't copy it to your project source

folder. 

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/advanced-concepts/perception-simulation-overview.md


b. Then make sure that it gets copied to your output folder on build. This is in the property sheet for the



 Creating an IPerceptionSimulation Manager Object

binary. 

5. Set your active solution platform to x64. (Use the Configuration Manager to create a Platform entry for x64 if

one doesn't already exist.)

To control simulation, you'll issue updates to objects retrieved from an IPerceptionSimulationManager object.

The first step is to get that object and connect it to your target device or emulator. You can get the IP address of

your emulator by clicking on the Device Portal button in the toolbar

 Open Device Por talOpen Device Por tal : Open the Windows Device Portal for the HoloLens OS in the emulator. For Windows

Mixed Reality, this can be retrieved in the Settings app under "Update & Security", then "For developers" in the

"Connect using:" section under "Enable Device Portal." Be sure to note both the IP address and port.

First, you'll call RestSimulationStreamSink.Create to get a RestSimulationStreamSink object. This is the target

device or emulator that you'll control over an http connection. Your commands will be passed to and handled by



 Control the simulated Human

manager.Human.Move(new Vector3(0.1f, 0.0f, 0.0f))

 Basic Sample C# console application

the Windows Device Portal running on the device or emulator. The four parameters you'll need to create an

object are:

Uri uri - IP address of the target device (e.g., "https://123.123.123.123" or "https://123.123.123.123:50080")

System.Net.NetworkCredential credentials - Username/password for connecting to the Windows Device

Portal on the target device or emulator. If you're connecting to the emulator via its local address (e.g., 168...*)

on the same PC, any credentials will be accepted.

bool normal - True for normal priority, false for low priority. You generally want to set this to true for test

scenarios, which allows your test to take control. The emulator and Windows Mixed Reality simulation use

low-priority connections. If your test also uses a low-priority connection, the most recently established

connection will be in control.

System.Threading.CancellationToken token - Token to cancel the async operation.

Second, you'll create the IPerceptionSimulationManager. This is the object you use to control simulation. This

must also be done in an async method.

An IPerceptionSimulationManager has a Human property that returns an ISimulatedHuman object. To control

the simulated human, perform operations on this object. For example:



using System;
using System.Collections.Generic;
using System.Linq;
using System.Text;
using System.Threading;
using System.Threading.Tasks;
using Microsoft.PerceptionSimulation;

namespace ConsoleApplication1
{
    class Program
    {
        static void Main(string[] args)
        {
            Task.Run(async () =>
            {
                RestSimulationStreamSink sink = null;
                CancellationToken token = new System.Threading.CancellationToken();

                try
                {
                    sink = await RestSimulationStreamSink.Create(
                        // use the IP address for your device/emulator
                        new Uri("https://169.254.227.115"),
                        // no credentials are needed for the emulator
                        new System.Net.NetworkCredential("", ""),
                        // normal priorty
                        true,
                        // cancel token
                        token);

                    IPerceptionSimulationManager manager = 
PerceptionSimulationManager.CreatePerceptionSimulationManager(sink);
                }
                catch (Exception e)
                {
                    Console.WriteLine(e);
                }

                // Always close the sink to return control to the previous application.
                if (sink != null)
                {
                    await sink.Close(token);
                }
            });

            // If main exits, the process exits.  
            Console.WriteLine("Press any key to exit...");
            Console.ReadLine();
        }
    }
}

 Extended Sample C# console application

using System;
using System.Collections.Generic;
using System.Linq;
using System.Text;
using System.Threading;
using System.Threading.Tasks;
using Microsoft.PerceptionSimulation;

namespace ConsoleApplication1
{



    class Program
    {
        static void Main(string[] args)
        {
            RestSimulationStreamSink sink = null;
            CancellationToken token = new System.Threading.CancellationToken();

            Task.Run(async () =>
            {
                try
                {
                    sink = await RestSimulationStreamSink.Create(
                        // use the IP address for your device/emulator
                        new Uri("https://169.254.227.115"),
                        // no credentials are needed for the emulator
                        new System.Net.NetworkCredential("", ""),
                        // normal priorty
                        true,
                        // cancel token
                        token);

                    IPerceptionSimulationManager manager = 
PerceptionSimulationManager.CreatePerceptionSimulationManager(sink);

                    // Now, we'll simulate a sequence of actions.
                    // Sleeps in-between each action give time to the system
                    // to be able to properly react.
                    // This is just an example. A proper automated test should verify
                    // that the app has behaved correctly
                    // before proceeding to the next step, instead of using Sleeps.

                    // Activate the right hand
                    manager.Human.RightHand.Activated = true;

                    // Simulate Bloom gesture, which should cause Shell to disappear
                    manager.Human.RightHand.PerformGesture(SimulatedGesture.Home);
                    Thread.Sleep(2000);

                    // Simulate Bloom gesture again... this time, Shell should reappear
                    manager.Human.RightHand.PerformGesture(SimulatedGesture.Home);
                    Thread.Sleep(2000);

                    // Simulate a Head rotation down around the X axis
                    // This should cause gaze to aim about the center of the screen
                    manager.Human.Head.Rotate(new Rotation3(0.04f, 0.0f, 0.0f));
                    Thread.Sleep(300);

                    // Simulate a finger press & release
                    // Should cause a tap on the center tile, thus launching it
                    manager.Human.RightHand.PerformGesture(SimulatedGesture.FingerPressed);
                    Thread.Sleep(300);
                    manager.Human.RightHand.PerformGesture(SimulatedGesture.FingerReleased);
                    Thread.Sleep(2000);

                    // Simulate a second finger press & release
                    // Should activate the app that was launched when the center tile was clicked
                    manager.Human.RightHand.PerformGesture(SimulatedGesture.FingerPressed);
                    Thread.Sleep(300);
                    manager.Human.RightHand.PerformGesture(SimulatedGesture.FingerReleased);
                    Thread.Sleep(5000);

                    // Simulate a Head rotation towards the upper right corner
                    manager.Human.Head.Rotate(new Rotation3(-0.14f, 0.17f, 0.0f));
                    Thread.Sleep(300);

                    // Simulate a third finger press & release
                    // Should press the Remove button on the app
                    manager.Human.RightHand.PerformGesture(SimulatedGesture.FingerPressed);
                    Thread.Sleep(300);



                    Thread.Sleep(300);
                    manager.Human.RightHand.PerformGesture(SimulatedGesture.FingerReleased);
                    Thread.Sleep(2000);

                    // Simulate Bloom gesture again... bringing the Shell back once more
                    manager.Human.RightHand.PerformGesture(SimulatedGesture.Home);
                    Thread.Sleep(2000);
                }
                catch (Exception e)
                {
                    Console.WriteLine(e);
                }
            });

            // If main exits, the process exits.  
            Console.WriteLine("Press any key to exit...");
            Console.ReadLine();

            // Always close the sink to return control to the previous application.
            if (sink != null)
            {
                sink.Close(token);
            }
        }
    }
}

 Note on 6-DOF controllers

    PerceptionSimulationDevice.exe <action> 6dof <instance>

    PerceptionSimulationDevice.exe i 6dof 1

Before calling any properties on methods on a simulated 6-DOF controller, you must activate the controller. Not

doing so will result in an exception. Starting with the Windows 10 May 2019 Update, simulated 6-DOF

controllers can be installed and activated by setting the Status property on the ISimulatedSixDofController

object to SimulatedSixDofControllerStatus.Active. In the Windows 10 October 2018 Update and earlier, you must

separately install a simulated 6-DOF controller first by calling the PerceptionSimulationDevice tool located in the

\Windows\System32 folder. The usage of this tool is as follows:

For example

Supported actions are:

i = install

q = query

r = remove

Supported instances are:

1 = the left 6-DOF controller

2 = the right 6-DOF controller

The exit code of the process will indicate success (a zero return value) or failure (a non-zero return value). When

using the 'q' action to query whether a controller is installed, the return value will be zero (0) if the controller

isn't already installed or one (1) if the controller is installed.

When removing a controller on the Windows 10 October 2018 Update or earlier, set its status to Off via the API

first, then call the PerceptionSimulationDevice tool.



 API Reference
  Microsoft.PerceptionSimulation.SimulatedDeviceTypeMicrosoft.PerceptionSimulation.SimulatedDeviceType

public enum SimulatedDeviceType
{
    Reference = 0
}

  Microsoft.PerceptionSimulation.HeadTrackerModeMicrosoft.PerceptionSimulation.HeadTrackerMode

public enum HeadTrackerMode
{
    Default = 0,
    Orientation = 1,
    Position = 2
}

  Microsoft.PerceptionSimulation.SimulatedGestureMicrosoft.PerceptionSimulation.SimulatedGesture

public enum SimulatedGesture
{
    None = 0,
    FingerPressed = 1,
    FingerReleased = 2,
    Home = 4,
    Max = Home
}

This tool must be run as Administrator.

Describes a simulated device type

Microsoft.PerceptionSimulation.S imulatedDeviceType.ReferenceMicrosoft.PerceptionSimulation.S imulatedDeviceType.Reference

A fictitious reference device, the default for PerceptionSimulationManager

Describes a head tracker mode

Microsoft.PerceptionSimulation.HeadTrackerMode.DefaultMicrosoft.PerceptionSimulation.HeadTrackerMode.Default

Default Head Tracking. This means the system may select the best head tracking mode based upon runtime

conditions.

Microsoft.PerceptionSimulation.HeadTrackerMode.OrientationMicrosoft.PerceptionSimulation.HeadTrackerMode.Orientation

Orientation Only Head Tracking. This means that the tracked position may not be reliable, and some

functionality dependent on head position may not be available.

Microsoft.PerceptionSimulation.HeadTrackerMode.PositionMicrosoft.PerceptionSimulation.HeadTrackerMode.Position

Positional Head Tracking. This means that the tracked head position and orientation are both reliable

Describes a simulated gesture

Microsoft.PerceptionSimulation.S imulatedGesture.NoneMicrosoft.PerceptionSimulation.S imulatedGesture.None

A sentinel value used to indicate no gestures.

Microsoft.PerceptionSimulation.S imulatedGesture.FingerPressedMicrosoft.PerceptionSimulation.S imulatedGesture.FingerPressed

A finger pressed gesture.



  Microsoft.PerceptionSimulation.SimulatedSixDofControllerStatusMicrosoft.PerceptionSimulation.SimulatedSixDofControllerStatus

public enum SimulatedSixDofControllerStatus
{
    Off = 0,
    Active = 1,
    TrackingLost = 2,
}

  Microsoft.PerceptionSimulation.SimulatedSixDofControllerButtonMicrosoft.PerceptionSimulation.SimulatedSixDofControllerButton

public enum SimulatedSixDofControllerButton
{
    None = 0,
    Home = 1,
    Menu = 2,
    Grip = 4,
    TouchpadPress = 8,
    Select = 16,
    TouchpadTouch = 32,
    Thumbstick = 64,
    Max = Thumbstick
}

Microsoft.PerceptionSimulation.S imulatedGesture.FingerReleasedMicrosoft.PerceptionSimulation.S imulatedGesture.FingerReleased

A finger released gesture.

Microsoft.PerceptionSimulation.S imulatedGesture.HomeMicrosoft.PerceptionSimulation.S imulatedGesture.Home

The home/system gesture.

Microsoft.PerceptionSimulation.S imulatedGesture.MaxMicrosoft.PerceptionSimulation.S imulatedGesture.Max

The maximum valid gesture.

The possible states of a simulated 6-DOF controller.

Microsoft.PerceptionSimulation.S imulatedSixDofControllerStatus.OffMicrosoft.PerceptionSimulation.S imulatedSixDofControllerStatus.Off

The 6-DOF controller is turned off.

Microsoft.PerceptionSimulation.S imulatedSixDofControllerStatus.ActiveMicrosoft.PerceptionSimulation.S imulatedSixDofControllerStatus.Active

The 6-DOF controller is turned on and tracked.

Microsoft.PerceptionSimulation.S imulatedSixDofControllerStatus.TrackingLostMicrosoft.PerceptionSimulation.S imulatedSixDofControllerStatus.TrackingLost

The 6-DOF controller is turned on but cannot be tracked.

The supported buttons on a simulated 6-DOF controller.

Microsoft.PerceptionSimulation.S imulatedSixDofControllerButton.NoneMicrosoft.PerceptionSimulation.S imulatedSixDofControllerButton.None

A sentinel value used to indicate no buttons.

Microsoft.PerceptionSimulation.S imulatedSixDofControllerButton.HomeMicrosoft.PerceptionSimulation.S imulatedSixDofControllerButton.Home

The Home button is pressed.

Microsoft.PerceptionSimulation.S imulatedSixDofControllerButton.MenuMicrosoft.PerceptionSimulation.S imulatedSixDofControllerButton.Menu

The Menu button is pressed.



  Microsoft.PerceptionSimulation.SimulatedEyesCalibrationStateMicrosoft.PerceptionSimulation.SimulatedEyesCalibrationState

public enum SimulatedGesture
{
    Unavailable = 0,
    Ready = 1,
    Configuring = 2,
    UserCalibrationNeeded = 3
}

  Microsoft.PerceptionSimulation.SimulatedHandJointTrackingAccuracyMicrosoft.PerceptionSimulation.SimulatedHandJointTrackingAccuracy

public enum SimulatedHandJointTrackingAccuracy
{
    Unavailable = 0,
    Approximate = 1,
    Visible = 2
}

Microsoft.PerceptionSimulation.S imulatedSixDofControllerButton.GripMicrosoft.PerceptionSimulation.S imulatedSixDofControllerButton.Grip

The Grip button is pressed.

Microsoft.PerceptionSimulation.S imulatedSixDofControllerButton.TouchpadPressMicrosoft.PerceptionSimulation.S imulatedSixDofControllerButton.TouchpadPress

The TouchPad is pressed.

Microsoft.PerceptionSimulation.S imulatedSixDofControllerButton.SelectMicrosoft.PerceptionSimulation.S imulatedSixDofControllerButton.Select

The Select button is pressed.

Microsoft.PerceptionSimulation.S imulatedSixDofControllerButton.TouchpadTouchMicrosoft.PerceptionSimulation.S imulatedSixDofControllerButton.TouchpadTouch

The TouchPad is touched.

Microsoft.PerceptionSimulation.S imulatedSixDofControllerButton.ThumbstickMicrosoft.PerceptionSimulation.S imulatedSixDofControllerButton.Thumbstick

The Thumbstick is pressed.

Microsoft.PerceptionSimulation.S imulatedSixDofControllerButton.MaxMicrosoft.PerceptionSimulation.S imulatedSixDofControllerButton.Max

The maximum valid button.

The calibration state of the simulated eyes

Microsoft.PerceptionSimulation.S imulatedEyesCalibrationState.UnavailableMicrosoft.PerceptionSimulation.S imulatedEyesCalibrationState.Unavailable

The eyes calibration is unavailable.

Microsoft.PerceptionSimulation.S imulatedEyesCalibrationState.ReadyMicrosoft.PerceptionSimulation.S imulatedEyesCalibrationState.Ready

The eyes have been calibrated. This is the default value.

Microsoft.PerceptionSimulation.S imulatedEyesCalibrationState.ConfiguringMicrosoft.PerceptionSimulation.S imulatedEyesCalibrationState.Configuring

The eyes are being calibrated.

Microsoft.PerceptionSimulation.S imulatedEyesCalibrationState.UserCalibrationNeededMicrosoft.PerceptionSimulation.S imulatedEyesCalibrationState.UserCalibrationNeeded

The eyes need to be calibrated.

The tracking accuracy of a joint of the hand.

Microsoft.PerceptionSimulation.S imulatedHandJointTrackingAccuracy.UnavailableMicrosoft.PerceptionSimulation.S imulatedHandJointTrackingAccuracy.Unavailable



  Microsoft.PerceptionSimulation.SimulatedHandPoseMicrosoft.PerceptionSimulation.SimulatedHandPose

public enum SimulatedHandPose
{
    Closed = 0,
    Open = 1,
    Point = 2,
    Pinch = 3,
    Max = Pinch
}

  Microsoft.PerceptionSimulation.PlaybackStateMicrosoft.PerceptionSimulation.PlaybackState

public enum PlaybackState
{
    Stopped = 0,
    Playing = 1,
    Paused = 2,
    End = 3,
}

The joint isn't tracked.

Microsoft.PerceptionSimulation.S imulatedHandJointTrackingAccuracy.ApproximateMicrosoft.PerceptionSimulation.S imulatedHandJointTrackingAccuracy.Approximate

The joint position is inferred.

Microsoft.PerceptionSimulation.S imulatedHandJointTrackingAccuracy.VisibleMicrosoft.PerceptionSimulation.S imulatedHandJointTrackingAccuracy.Visible

The joint is fully tracked.

The tracking accuracy of a joint of the hand.

Microsoft.PerceptionSimulation.S imulatedHandPose.ClosedMicrosoft.PerceptionSimulation.S imulatedHandPose.Closed

The hand's finger joints are configured to reflect a closed pose.

Microsoft.PerceptionSimulation.S imulatedHandPose.OpenMicrosoft.PerceptionSimulation.S imulatedHandPose.Open

The hand's finger joints are configured to reflect an open pose.

Microsoft.PerceptionSimulation.S imulatedHandPose.PointMicrosoft.PerceptionSimulation.S imulatedHandPose.Point

The hand's finger joints are configured to reflect a pointing pose.

Microsoft.PerceptionSimulation.S imulatedHandPose.PinchMicrosoft.PerceptionSimulation.S imulatedHandPose.Pinch

The hand's finger joints are configured to reflect a pinching pose.

Microsoft.PerceptionSimulation.S imulatedHandPose.MaxMicrosoft.PerceptionSimulation.S imulatedHandPose.Max

The maximum valid value for SimulatedHandPose.

Describes the state of a playback.

Microsoft.PerceptionSimulation.PlaybackState.StoppedMicrosoft.PerceptionSimulation.PlaybackState.Stopped

The recording is currently stopped and ready for playback.

Microsoft.PerceptionSimulation.PlaybackState.PlayingMicrosoft.PerceptionSimulation.PlaybackState.Playing

The recording is currently playing.

Microsoft.PerceptionSimulation.PlaybackState.PausedMicrosoft.PerceptionSimulation.PlaybackState.Paused



  Microsoft.PerceptionSimulation.Vector3Microsoft.PerceptionSimulation.Vector3

public struct Vector3
{
    public float X;
    public float Y;
    public float Z;
    public Vector3(float x, float y, float z);
}

  Microsoft.PerceptionSimulation.Rotation3Microsoft.PerceptionSimulation.Rotation3

public struct Rotation3
{
    public float Pitch;
    public float Yaw;
    public float Roll;
    public Rotation3(float pitch, float yaw, float roll);
}

The recording is currently paused.

Microsoft.PerceptionSimulation.PlaybackState.EndMicrosoft.PerceptionSimulation.PlaybackState.End

The recording has reached the end.

Describes a three components vector, which might describe a point or a vector in 3D space.

Microsoft.PerceptionSimulation.Vector3.XMicrosoft.PerceptionSimulation.Vector3.X

The X component of the vector.

Microsoft.PerceptionSimulation.Vector3.YMicrosoft.PerceptionSimulation.Vector3.Y

The Y component of the vector.

Microsoft.PerceptionSimulation.Vector3.ZMicrosoft.PerceptionSimulation.Vector3.Z

The Z component of the vector.

Microsoft.PerceptionSimulation.Vector3.#ctor(System.Single,System.Single,System.Single)Microsoft.PerceptionSimulation.Vector3.#ctor(System.Single,System.Single,System.Single)

Construct a new Vector3.

Parameters

x - The x component of the vector.

y - The y component of the vector.

z - The z component of the vector.

Describes a three components rotation.

Microsoft.PerceptionSimulation.Rotation3.PitchMicrosoft.PerceptionSimulation.Rotation3.Pitch

The Pitch component of the Rotation, down around the X axis.

Microsoft.PerceptionSimulation.Rotation3.YawMicrosoft.PerceptionSimulation.Rotation3.Yaw

The Yaw component of the Rotation, right around the Y axis.

Microsoft.PerceptionSimulation.Rotation3.RollMicrosoft.PerceptionSimulation.Rotation3.Roll

The Roll component of the Rotation, right around the Z axis.



  Microsoft.PerceptionSimulation.SimulatedHandJointConfigurationMicrosoft.PerceptionSimulation.SimulatedHandJointConfiguration

public struct SimulatedHandJointConfiguration
{
    public Vector3 Position;
    public Rotation3 Rotation;
    public SimulatedHandJointTrackingAccuracy TrackingAccuracy;
}

  Microsoft.PerceptionSimulation.FrustumMicrosoft.PerceptionSimulation.Frustum

public struct Frustum
{
    float Near;
    float Far;
    float FieldOfView;
    float AspectRatio;
}

  Microsoft.PerceptionSimulation.SimulatedDisplayConfigurationMicrosoft.PerceptionSimulation.SimulatedDisplayConfiguration

Microsoft.PerceptionSimulation.Rotation3.#ctor(System.Single,System.Single,System.Single)Microsoft.PerceptionSimulation.Rotation3.#ctor(System.Single,System.Single,System.Single)

Construct a new Rotation3.

Parameters

pitch - The pitch component of the Rotation.

yaw - The yaw component of the Rotation.

roll - The roll component of the Rotation.

Describes the configuration of a joint on a simulated hand.

Microsoft.PerceptionSimulation.S imulatedHandJointConfiguration.PositionMicrosoft.PerceptionSimulation.S imulatedHandJointConfiguration.Position

The position of the joint.

Microsoft.PerceptionSimulation.S imulatedHandJointConfiguration.RotationMicrosoft.PerceptionSimulation.S imulatedHandJointConfiguration.Rotation

The rotation of the joint.

Microsoft.PerceptionSimulation.S imulatedHandJointConfiguration.TrackingAccuracyMicrosoft.PerceptionSimulation.S imulatedHandJointConfiguration.TrackingAccuracy

The tracking accuracy of the joint.

Describes a view frustum, as typically used by a camera.

Microsoft.PerceptionSimulation.Frustum.NearMicrosoft.PerceptionSimulation.Frustum.Near

The minimum distance that is contained in the frustum.

Microsoft.PerceptionSimulation.Frustum.FarMicrosoft.PerceptionSimulation.Frustum.Far

The maximum distance that is contained in the frustum.

Microsoft.PerceptionSimulation.Frustum.FieldOfViewMicrosoft.PerceptionSimulation.Frustum.FieldOfView

The horizontal field of view of the frustum, in radians (less than PI).

Microsoft.PerceptionSimulation.Frustum.AspectRatioMicrosoft.PerceptionSimulation.Frustum.AspectRatio

The ratio of horizontal field of view to vertical field of view.

Describes the configuration of the simulated headset's display.



public struct SimulatedDisplayConfiguration
{
    public Vector3 LeftEyePosition;
    public Rotation3 LeftEyeRotation;
    public Vector3 RightEyePosition;
    public Rotation3 RightEyeRotation;
    public float Ipd;
    public bool ApplyEyeTransforms;
    public bool ApplyIpd;
}

  Microsoft.PerceptionSimulation.IPerceptionSimulationManagerMicrosoft.PerceptionSimulation.IPerceptionSimulationManager

public interface IPerceptionSimulationManager
{   
    ISimulatedDevice Device { get; }
    ISimulatedHuman Human { get; }
    void Reset();
}

  Microsoft.PerceptionSimulation.ISimulatedDeviceMicrosoft.PerceptionSimulation.ISimulatedDevice

Microsoft.PerceptionSimulation.S imulatedDisplayConfiguration.LeftEyePositionMicrosoft.PerceptionSimulation.S imulatedDisplayConfiguration.LeftEyePosition

The transform from the center of the head to the left eye for purposes of stereo rendering.

Microsoft.PerceptionSimulation.S imulatedDisplayConfiguration.LeftEyeRotationMicrosoft.PerceptionSimulation.S imulatedDisplayConfiguration.LeftEyeRotation

The rotation of the left eye for purposes of stereo rendering.

Microsoft.PerceptionSimulation.S imulatedDisplayConfiguration.RightEyePositionMicrosoft.PerceptionSimulation.S imulatedDisplayConfiguration.RightEyePosition

The transform from the center of the head to the right eye for purposes of stereo rendering.

Microsoft.PerceptionSimulation.S imulatedDisplayConfiguration.RightEyeRotationMicrosoft.PerceptionSimulation.S imulatedDisplayConfiguration.RightEyeRotation

The rotation of the right eye for purposes of stereo rendering.

Microsoft.PerceptionSimulation.S imulatedDisplayConfiguration.IpdMicrosoft.PerceptionSimulation.S imulatedDisplayConfiguration.Ipd

The Ipd value reported by the system for purposes of stereo rendering.

Microsoft.PerceptionSimulation.S imulatedDisplayConfiguration.ApplyEyeTransformsMicrosoft.PerceptionSimulation.S imulatedDisplayConfiguration.ApplyEyeTransforms

Whether the values provided for left and right eye transforms should be considered valid and applied to the

running system.

Microsoft.PerceptionSimulation.S imulatedDisplayConfiguration.ApplyIpdMicrosoft.PerceptionSimulation.S imulatedDisplayConfiguration.ApplyIpd

Whether the value provided for Ipd should be considered valid and applied to the running system.

Root for generating the packets used to control a device.

Microsoft.PerceptionSimulation.IPerceptionSimulationManager.DeviceMicrosoft.PerceptionSimulation.IPerceptionSimulationManager.Device

Retrieve the simulated device object that interprets the simulated human and the simulated world.

Microsoft.PerceptionSimulation.IPerceptionSimulationManager.HumanMicrosoft.PerceptionSimulation.IPerceptionSimulationManager.Human

Retrieve the object that controls the simulated human.

Microsoft.PerceptionSimulation.IPerceptionSimulationManager.ResetMicrosoft.PerceptionSimulation.IPerceptionSimulationManager.Reset

Resets the simulation to its default state.



public interface ISimulatedDevice
{
    ISimulatedHeadTracker HeadTracker { get; }
    ISimulatedHandTracker HandTracker { get; }
    void SetSimulatedDeviceType(SimulatedDeviceType type);
}

  Microsoft.PerceptionSimulation.ISimulatedDevice2Microsoft.PerceptionSimulation.ISimulatedDevice2

public interface ISimulatedDevice2
{
    bool IsUserPresent { [return: MarshalAs(UnmanagedType.Bool)] get; [param: MarshalAs(UnmanagedType.Bool)] 
set; }
    SimulatedDisplayConfiguration DisplayConfiguration { get; set; }

};

  Microsoft.PerceptionSimulation.ISimulatedHeadTrackerMicrosoft.PerceptionSimulation.ISimulatedHeadTracker

public interface ISimulatedHeadTracker
{
    HeadTrackerMode HeadTrackerMode { get; set; }
};

  Microsoft.PerceptionSimulation.ISimulatedHandTrackerMicrosoft.PerceptionSimulation.ISimulatedHandTracker

Interface describing the device, which interprets the simulated world and the simulated human

Microsoft.PerceptionSimulation.IS imulatedDevice.HeadTrackerMicrosoft.PerceptionSimulation.IS imulatedDevice.HeadTracker

Retrieve the Head Tracker from the Simulated Device.

Microsoft.PerceptionSimulation.IS imulatedDevice.HandTrackerMicrosoft.PerceptionSimulation.IS imulatedDevice.HandTracker

Retrieve the Hand Tracker from the Simulated Device.

Microsoft.PerceptionSimulation.IS imulatedDevice.SetS imulatedDeviceType(Microsoft.PerceptionSiMicrosoft.PerceptionSimulation.IS imulatedDevice.SetS imulatedDeviceType(Microsoft.PerceptionSi

mulation.S imulatedDeviceType)mulation.S imulatedDeviceType)

Set the properties of the simulated device to match the provided device type.

Parameters

type - The new type of Simulated Device

Additional properties are available by casting the ISimulatedDevice to ISimulatedDevice2

Microsoft.PerceptionSimulation.IS imulatedDevice2.IsUserPresentMicrosoft.PerceptionSimulation.IS imulatedDevice2.IsUserPresent

Retrieve or set whether or not the simulated human is actively wearing the headset.

Microsoft.PerceptionSimulation.IS imulatedDevice2.DisplayConfigurationMicrosoft.PerceptionSimulation.IS imulatedDevice2.DisplayConfiguration

Retrieve or set the properties of the simulated display.

Interface describing the portion of the simulated device that tracks the head of the simulated human.

Microsoft.PerceptionSimulation.IS imulatedHeadTracker.HeadTrackerModeMicrosoft.PerceptionSimulation.IS imulatedHeadTracker.HeadTrackerMode

Retrieves and sets the current head tracker mode.

Interface describing the portion of the simulated device that tracks the hands of the simulated human



public interface ISimulatedHandTracker
{
    Vector3 WorldPosition { get; }
    Vector3 Position { get; set; }
    float Pitch { get; set; }
    bool FrustumIgnored { [return: MarshalAs(UnmanagedType.Bool)] get; [param: 
MarshalAs(UnmanagedType.Bool)] set; }
    Frustum Frustum { get; set; }
}

  Microsoft.PerceptionSimulation.ISimulatedHumanMicrosoft.PerceptionSimulation.ISimulatedHuman

public interface ISimulatedHuman 
{
    Vector3 WorldPosition { get; set; }
    float Direction { get; set; }
    float Height { get; set; }
    ISimulatedHand LeftHand { get; }
    ISimulatedHand RightHand { get; }
    ISimulatedHead Head { get; }s
    void Move(Vector3 translation);
    void Rotate(float radians);
}

Microsoft.PerceptionSimulation.IS imulatedHandTracker.WorldPositionMicrosoft.PerceptionSimulation.IS imulatedHandTracker.WorldPosition

Retrieve the position of the node with relation to the world, in meters.

Microsoft.PerceptionSimulation.IS imulatedHandTracker.PositionMicrosoft.PerceptionSimulation.IS imulatedHandTracker.Position

Retrieve and set the position of the simulated hand tracker, relative to the center of the head.

Microsoft.PerceptionSimulation.IS imulatedHandTracker.PitchMicrosoft.PerceptionSimulation.IS imulatedHandTracker.Pitch

Retrieve and set the downward pitch of the simulated hand tracker.

Microsoft.PerceptionSimulation.IS imulatedHandTracker.FrustumIgnoredMicrosoft.PerceptionSimulation.IS imulatedHandTracker.FrustumIgnored

Retrieve and set whether the frustum of the simulated hand tracker is ignored. When ignored, both hands are

always visible. When not ignored (the default) hands are only visible when they are within the frustum of the

hand tracker.

Microsoft.PerceptionSimulation.IS imulatedHandTracker.FrustumMicrosoft.PerceptionSimulation.IS imulatedHandTracker.Frustum

Retrieve and set the frustum properties used to determine if hands are visible to the simulated hand tracker.

Top-level interface for controlling the simulated human.

Microsoft.PerceptionSimulation.IS imulatedHuman.WorldPositionMicrosoft.PerceptionSimulation.IS imulatedHuman.WorldPosition

Retrieve and set the position of the node with relation to the world, in meters. The position corresponds to a

point at the center of the human's feet.

Microsoft.PerceptionSimulation.IS imulatedHuman.DirectionMicrosoft.PerceptionSimulation.IS imulatedHuman.Direction

Retrieve and set the direction the simulated human faces in the world. 0 radians faces down the negative Z axis.

Positive radians rotate clockwise about the Y axis.

Microsoft.PerceptionSimulation.IS imulatedHuman.HeightMicrosoft.PerceptionSimulation.IS imulatedHuman.Height

Retrieve and set the height of the simulated human, in meters.

Microsoft.PerceptionSimulation.IS imulatedHuman.LeftHandMicrosoft.PerceptionSimulation.IS imulatedHuman.LeftHand



  Microsoft.PerceptionSimulation.ISimulatedHuman2Microsoft.PerceptionSimulation.ISimulatedHuman2

public interface ISimulatedHuman2
{
    /* New members in addition to those available on ISimulatedHuman */
    ISimulatedSixDofController LeftController { get; }
    ISimulatedSixDofController RightController { get; }
}

  Microsoft.PerceptionSimulation.ISimulatedHandMicrosoft.PerceptionSimulation.ISimulatedHand

public interface ISimulatedHand
{
    Vector3 WorldPosition { get; }
    Vector3 Position { get; set; }
    bool Activated { [return: MarshalAs(UnmanagedType.Bool)] get; [param: MarshalAs(UnmanagedType.Bool)] 
set; }
    bool Visible { [return: MarshalAs(UnmanagedType.Bool)] get; }
    void EnsureVisible();
    void Move(Vector3 translation);
    void PerformGesture(SimulatedGesture gesture);
}

Retrieve the left hand of the simulated human.

Microsoft.PerceptionSimulation.IS imulatedHuman.RightHandMicrosoft.PerceptionSimulation.IS imulatedHuman.RightHand

Retrieve the right hand of the simulated human.

Microsoft.PerceptionSimulation.IS imulatedHuman.HeadMicrosoft.PerceptionSimulation.IS imulatedHuman.Head

Retrieve the head of the simulated human.

Microsoft.PerceptionSimulation.IS imulatedHuman.Move(Microsoft.PerceptionSimulation.Vector3)Microsoft.PerceptionSimulation.IS imulatedHuman.Move(Microsoft.PerceptionSimulation.Vector3)

Move the simulated human relative to its current position, in meters.

Parameters

translation - The translation to move, relative to current position.

Microsoft.PerceptionSimulation.IS imulatedHuman.Rotate(System.Single)Microsoft.PerceptionSimulation.IS imulatedHuman.Rotate(System.Single)

Rotate the simulated human relative to its current direction, clockwise about the Y axis

Parameters

radians - The amount to rotate around the Y axis.

Additional properties are available by casting the ISimulatedHuman to ISimulatedHuman2

Microsoft.PerceptionSimulation.IS imulatedHuman2.LeftControllerMicrosoft.PerceptionSimulation.IS imulatedHuman2.LeftController

Retrieve the left 6-DOF controller.

Microsoft.PerceptionSimulation.IS imulatedHuman2.RightControllerMicrosoft.PerceptionSimulation.IS imulatedHuman2.RightController

Retrieve the right 6-DOF controller.

Interface describing a hand of the simulated human

Microsoft.PerceptionSimulation.IS imulatedHand.WorldPositionMicrosoft.PerceptionSimulation.IS imulatedHand.WorldPosition

Retrieve the position of the node with relation to the world, in meters.



  Microsoft.PerceptionSimulation.ISimulatedHand2Microsoft.PerceptionSimulation.ISimulatedHand2

public interface ISimulatedHand2
{
    /* New members in addition to those available on ISimulatedHand */
    Rotation3 Orientation { get; set; }
}

  Microsoft.PerceptionSimulation.ISimulatedHand3Microsoft.PerceptionSimulation.ISimulatedHand3

public interface ISimulatedHand3
{
    /* New members in addition to those available on ISimulatedHand and ISimulatedHand2 */
    GetJointConfiguration(SimulatedHandJoint joint, out SimulatedHandJointConfiguration jointConfiguration);
    SetJointConfiguration(SimulatedHandJoint joint, SimulatedHandJointConfiguration jointConfiguration);
    SetHandPose(SimulatedHandPose pose, bool animate);
}

Microsoft.PerceptionSimulation.IS imulatedHand.PositionMicrosoft.PerceptionSimulation.IS imulatedHand.Position

Retrieve and set the position of the simulated hand relative to the human, in meters.

Microsoft.PerceptionSimulation.IS imulatedHand.ActivatedMicrosoft.PerceptionSimulation.IS imulatedHand.Activated

Retrieve and set whether the hand is currently activated.

Microsoft.PerceptionSimulation.IS imulatedHand.VisibleMicrosoft.PerceptionSimulation.IS imulatedHand.Visible

Retrieve whether the hand is currently visible to the SimulatedDevice (that is, whether it's in a position to be

detected by the HandTracker).

Microsoft.PerceptionSimulation.IS imulatedHand.EnsureVisibleMicrosoft.PerceptionSimulation.IS imulatedHand.EnsureVisible

Move the hand such that it is visible to the SimulatedDevice.

Microsoft.PerceptionSimulation.IS imulatedHand.Move(Microsoft.PerceptionSimulation.Vector3)Microsoft.PerceptionSimulation.IS imulatedHand.Move(Microsoft.PerceptionSimulation.Vector3)

Move the position of the simulated hand relative to its current position, in meters.

Parameters

translation - The amount to translate the simulated hand.

Microsoft.PerceptionSimulation.IS imulatedHand.PerformGesture(Microsoft.PerceptionSimulation.SMicrosoft.PerceptionSimulation.IS imulatedHand.PerformGesture(Microsoft.PerceptionSimulation.S

imulatedGesture)imulatedGesture)

Perform a gesture using the simulated hand. It will only be detected by the system if the hand is enabled.

Parameters

gesture - The gesture to perform.

Additional properties are available by casting an ISimulatedHand to ISimulatedHand2.

Microsoft.PerceptionSimulation.IS imulatedHand2.OrientationMicrosoft.PerceptionSimulation.IS imulatedHand2.Orientation

Retrieve or set the rotation of the simulated hand. Positive radians rotate clockwise when looking along the axis.

Additional properties are available by casting an ISimulatedHand to ISimulatedHand3

Microsoft.PerceptionSimulation.IS imulatedHand3.GetJointConfigurationMicrosoft.PerceptionSimulation.IS imulatedHand3.GetJointConfiguration

Get the joint configuration for the specified joint.



  Microsoft.PerceptionSimulation.ISimulatedHeadMicrosoft.PerceptionSimulation.ISimulatedHead

public interface ISimulatedHead
{
    Vector3 WorldPosition { get; }
    Rotation3 Rotation { get; set; }
    float Diameter { get; set; }
    void Rotate(Rotation3 rotation);
}

  Microsoft.PerceptionSimulation.ISimulatedHead2Microsoft.PerceptionSimulation.ISimulatedHead2

public interface ISimulatedHead2
{
    /* New members in addition to those available on ISimulatedHead */
    ISimulatedEyes Eyes { get; }
}

  Microsoft.PerceptionSimulation.ISimulatedSixDofControllerMicrosoft.PerceptionSimulation.ISimulatedSixDofController

Microsoft.PerceptionSimulation.IS imulatedHand3.SetJointConfigurationMicrosoft.PerceptionSimulation.IS imulatedHand3.SetJointConfiguration

Set the joint configuration for the specified joint.

Microsoft.PerceptionSimulation.IS imulatedHand3.SetHandPoseMicrosoft.PerceptionSimulation.IS imulatedHand3.SetHandPose

Set the hand to a known pose with an optional flag to animate. Note: animating won't result in joints

immediately reflecting their final joint configurations.

Interface describing the head of the simulated human.

Microsoft.PerceptionSimulation.IS imulatedHead.WorldPositionMicrosoft.PerceptionSimulation.IS imulatedHead.WorldPosition

Retrieve the position of the node with relation to the world, in meters.

Microsoft.PerceptionSimulation.IS imulatedHead.RotationMicrosoft.PerceptionSimulation.IS imulatedHead.Rotation

Retrieve the rotation of the simulated head. Positive radians rotate clockwise when looking along the axis.

Microsoft.PerceptionSimulation.IS imulatedHead.DiameterMicrosoft.PerceptionSimulation.IS imulatedHead.Diameter

Retrieve the simulated head's diameter. This value is used to determine the head's center (point of rotation).

Microsoft.PerceptionSimulation.IS imulatedHead.Rotate(Microsoft.PerceptionSimulation.Rotation3)Microsoft.PerceptionSimulation.IS imulatedHead.Rotate(Microsoft.PerceptionSimulation.Rotation3)

Rotate the simulated head relative to its current rotation. Positive radians rotate clockwise when looking along

the axis.

Parameters

rotation - The amount to rotate.

Additional properties are available by casting an ISimulatedHead to ISimulatedHead2

Microsoft.PerceptionSimulation.IS imulatedHead2.EyesMicrosoft.PerceptionSimulation.IS imulatedHead2.Eyes

Retrieve the eyes of the simulated human.

Interface describing a 6-DOF controller associated with the simulated human.



public interface ISimulatedSixDofController
{
    Vector3 WorldPosition { get; }
    SimulatedSixDofControllerStatus Status { get; set; }
    Vector3 Position { get; }
    Rotation3 Orientation { get; set; }
    void Move(Vector3 translation);
    void PressButton(SimulatedSixDofControllerButton button);
    void ReleaseButton(SimulatedSixDofControllerButton button);
    void GetTouchpadPosition(out float x, out float y);
    void SetTouchpadPosition(float x, float y);
}

Microsoft.PerceptionSimulation.IS imulatedSixDofController.WorldPositionMicrosoft.PerceptionSimulation.IS imulatedSixDofController.WorldPosition

Retrieve the position of the node with relation to the world, in meters.

Microsoft.PerceptionSimulation.IS imulatedSixDofController.StatusMicrosoft.PerceptionSimulation.IS imulatedSixDofController.Status

Retrieve or set the current state of the controller. The controller status must be set to a value other than Off

before any calls to move, rotate, or press buttons will succeed.

Microsoft.PerceptionSimulation.IS imulatedSixDofController.PositionMicrosoft.PerceptionSimulation.IS imulatedSixDofController.Position

Retrieve or set the position of the simulated controller relative to the human, in meters.

Microsoft.PerceptionSimulation.IS imulatedSixDofController.OrientationMicrosoft.PerceptionSimulation.IS imulatedSixDofController.Orientation

Retrieve or set the orientation of the simulated controller.

Microsoft.PerceptionSimulation.IS imulatedSixDofController.Move(Microsoft.PerceptionSimulation.Microsoft.PerceptionSimulation.IS imulatedSixDofController.Move(Microsoft.PerceptionSimulation.

Vector3)Vector3)

Move the position of the simulated controller relative to its current position, in meters.

Parameters

translation - The amount to translate the simulated controller.

Microsoft.PerceptionSimulation.IS imulatedSixDofController.PressButton(S imulatedSixDofControlleMicrosoft.PerceptionSimulation.IS imulatedSixDofController.PressButton(S imulatedSixDofControlle

rButton)rButton)

Press a button on the simulated controller. It will only be detected by the system if the controller is enabled.

Parameters

button - The button to press.

Microsoft.PerceptionSimulation.IS imulatedSixDofController.ReleaseButton(S imulatedSixDofControlMicrosoft.PerceptionSimulation.IS imulatedSixDofController.ReleaseButton(S imulatedSixDofControl

lerButton)lerButton)

Release a button on the simulated controller. It will only be detected by the system if the controller is enabled.

Parameters

button - The button to release.

Microsoft.PerceptionSimulation.IS imulatedSixDofController.GetTouchpadPosition(out float, outMicrosoft.PerceptionSimulation.IS imulatedSixDofController.GetTouchpadPosition(out float, out

float)float)

Get the position of a simulated finger on the simulated controller's touchpad.

Parameters



  Microsoft.PerceptionSimulation.ISimulatedSixDofController2Microsoft.PerceptionSimulation.ISimulatedSixDofController2

public interface ISimulatedSixDofController2
{
    /* New members in addition to those available on ISimulatedSixDofController */
    void GetThumbstickPosition(out float x, out float y);
    void SetThumbstickPosition(float x, float y);
    float BatteryLevel { get; set; }
}

  Microsoft.PerceptionSimulation.ISimulatedEyesMicrosoft.PerceptionSimulation.ISimulatedEyes

public interface ISimulatedEyes
{
    Rotation3 Rotation { get; set; }
    void Rotate(Rotation3 rotation);
    SimulatedEyesCalibrationState CalibrationState { get; set; }
    Vector3 WorldPosition { get; }
}

x - The horizontal position of the finger.

y - The vertical position of the finger.

Microsoft.PerceptionSimulation.IS imulatedSixDofController.SetTouchpadPosition(float, float)Microsoft.PerceptionSimulation.IS imulatedSixDofController.SetTouchpadPosition(float, float)

Set the position of a simulated finger on the simulated controller's touchpad.

Parameters

x - The horizontal position of the finger.

y - The vertical position of the finger.

Additional properties and methods are available by casting an ISimulatedSixDofController to

ISimulatedSixDofController2

Microsoft.PerceptionSimulation.IS imulatedSixDofController2.GetThumbstickPosition(out float, outMicrosoft.PerceptionSimulation.IS imulatedSixDofController2.GetThumbstickPosition(out float, out

float)float)

Get the position of the simulated thumbstick on the simulated controller.

Parameters

x - The horizontal position of the thumbstick.

y - The vertical position of the thumbstick.

Microsoft.PerceptionSimulation.IS imulatedSixDofController2.SetThumbstickPosition(float, float)Microsoft.PerceptionSimulation.IS imulatedSixDofController2.SetThumbstickPosition(float, float)

Set the position of the simulated thumbstick on the simulated controller.

Parameters

x - The horizontal position of the thumbstick.

y - The vertical position of the thumbstick.

Microsoft.PerceptionSimulation.IS imulatedSixDofController2.Batter yLevelMicrosoft.PerceptionSimulation.IS imulatedSixDofController2.Batter yLevel

Retrieve or set the battery level of the simulated controller. The value must be greater than 0.0 and less than or

equal to 100.0.

Interface describing the eyes of the simulated human.



  Microsoft.PerceptionSimulation.ISimulationRecordingMicrosoft.PerceptionSimulation.ISimulationRecording

public interface ISimulationRecording
{
    StreamDataTypes DataTypes { get; }
    PlaybackState State { get; }
    void Play();
    void Pause();
    void Seek(UInt64 ticks);
    void Stop();
};

Microsoft.PerceptionSimulation.IS imulatedEyes.RotationMicrosoft.PerceptionSimulation.IS imulatedEyes.Rotation

Retrieve the rotation of the simulated eyes. Positive radians rotate clockwise when looking along the axis.

Microsoft.PerceptionSimulation.IS imulatedEyes.Rotate(Microsoft.PerceptionSimulation.Rotation3)Microsoft.PerceptionSimulation.IS imulatedEyes.Rotate(Microsoft.PerceptionSimulation.Rotation3)

Rotate the simulated eyes relative to its current rotation. Positive radians rotate clockwise when looking along

the axis.

Parameters

rotation - The amount to rotate.

Microsoft.PerceptionSimulation.IS imulatedEyes.CalibrationStateMicrosoft.PerceptionSimulation.IS imulatedEyes.CalibrationState

Retrieves or sets the calibration state of the simulated eyes.

Microsoft.PerceptionSimulation.IS imulatedEyes.WorldPositionMicrosoft.PerceptionSimulation.IS imulatedEyes.WorldPosition

Retrieve the position of the node with relation to the world, in meters.

Interface for interacting with a single recording loaded for playback.

Microsoft.PerceptionSimulation.IS imulationRecording.DataTypesMicrosoft.PerceptionSimulation.IS imulationRecording.DataTypes

Retrieves the list of data types in the recording.

Microsoft.PerceptionSimulation.IS imulationRecording.StateMicrosoft.PerceptionSimulation.IS imulationRecording.State

Retrieves the current state of the recording.

Microsoft.PerceptionSimulation.IS imulationRecording.PlayMicrosoft.PerceptionSimulation.IS imulationRecording.Play

Start the playback. If the recording is paused, playback will resume from the paused location; if stopped,

playback will start at the beginning. If already playing, this call is ignored.

Microsoft.PerceptionSimulation.IS imulationRecording.PauseMicrosoft.PerceptionSimulation.IS imulationRecording.Pause

Pauses the playback at its current location. If the recording is stopped, the call is ignored.

Microsoft.PerceptionSimulation.IS imulationRecording.Seek(System.UInt64)Microsoft.PerceptionSimulation.IS imulationRecording.Seek(System.UInt64)

Seeks the recording to the specified time (in 100-nanoseconds intervals from the beginning) and pauses at that

location. If the time is beyond the end of the recording, it's paused at the last frame.

Parameters

ticks - The time to which to seek.

Microsoft.PerceptionSimulation.IS imulationRecording.StopMicrosoft.PerceptionSimulation.IS imulationRecording.Stop

Stops the playback and resets the position to the beginning.



  Microsoft.PerceptionSimulation.ISimulationRecordingCallbackMicrosoft.PerceptionSimulation.ISimulationRecordingCallback

public interface ISimulationRecordingCallback
{
    void PlaybackStateChanged(PlaybackState newState);
};

  Microsoft.PerceptionSimulation.PerceptionSimulationManagerMicrosoft.PerceptionSimulation.PerceptionSimulationManager

public static class PerceptionSimulationManager
{
    public static IPerceptionSimulationManager CreatePerceptionSimulationManager(ISimulationStreamSink 
sink);
    public static ISimulationStreamSink CreatePerceptionSimulationRecording(string path);
    public static ISimulationRecording LoadPerceptionSimulationRecording(string path, 
ISimulationStreamSinkFactory factory);
    public static ISimulationRecording LoadPerceptionSimulationRecording(string path, 
ISimulationStreamSinkFactory factory, ISimulationRecordingCallback callback);

Interface for receiving state changes during playback.

Microsoft.PerceptionSimulation.IS imulationRecordingCallback .PlaybackStateChanged(Microsoft.PeMicrosoft.PerceptionSimulation.IS imulationRecordingCallback .PlaybackStateChanged(Microsoft.Pe

rceptionSimulation.PlaybackState)rceptionSimulation.PlaybackState)

Called when an ISimulationRecording's playback state has changed.

Parameters

newState - The new state of the recording.

Root object for creating Perception Simulation objects.

Microsoft.PerceptionSimulation.PerceptionSimulationManager.CreatePerceptionSimulationManageMicrosoft.PerceptionSimulation.PerceptionSimulationManager.CreatePerceptionSimulationManage

r(Microsoft.PerceptionSimulation.IS imulationStreamSink)r(Microsoft.PerceptionSimulation.IS imulationStreamSink)

Create on object for generating simulated packets and delivering them to the provided sink.

Parameters

sink - The sink that will receive all generated packets.

Return value

The created Manager.

Microsoft.PerceptionSimulation.PerceptionSimulationManager.CreatePerceptionSimulationRecordiMicrosoft.PerceptionSimulation.PerceptionSimulationManager.CreatePerceptionSimulationRecordi

ng(System.Str ing)ng(System.Str ing)

Create a sink, which stores all received packets in a file at the specified path.

Parameters

path - The path of the file to create.

Return value

The created sink.

Microsoft.PerceptionSimulation.PerceptionSimulationManager.LoadPerceptionSimulationRecordingMicrosoft.PerceptionSimulation.PerceptionSimulationManager.LoadPerceptionSimulationRecording

(System.Str ing,Microsoft.PerceptionSimulation.IS imulationStreamSinkFactor y)(System.Str ing,Microsoft.PerceptionSimulation.IS imulationStreamSinkFactor y)

Load a recording from the specified file.



  Microsoft.PerceptionSimulation.StreamDataTypesMicrosoft.PerceptionSimulation.StreamDataTypes

public enum StreamDataTypes
{
    None = 0x00,
    Head = 0x01,
    Hands = 0x02,
    SpatialMapping = 0x08,
    Calibration = 0x10,
    Environment = 0x20,
    SixDofControllers = 0x40,
    Eyes = 0x80,
    DisplayConfiguration = 0x100
    All = None | Head | Hands | SpatialMapping | Calibration | Environment | SixDofControllers | Eyes | 
DisplayConfiguration
}

Parameters

path - The path of the file to load.

factory - A factory used by the recording for creating an ISimulationStreamSink when required.

Return value

The loaded recording.

Microsoft.PerceptionSimulation.PerceptionSimulationManager.LoadPerceptionSimulationRecordingMicrosoft.PerceptionSimulation.PerceptionSimulationManager.LoadPerceptionSimulationRecording

(System.Str ing,Microsoft.PerceptionSimulation.IS imulationStreamSinkFactor y,Microsoft.Perception(System.Str ing,Microsoft.PerceptionSimulation.IS imulationStreamSinkFactor y,Microsoft.Perception

Simulation.IS imulationRecordingCallback)S imulation.IS imulationRecordingCallback)

Load a recording from the specified file.

Parameters

path - The path of the file to load.

factory - A factory used by the recording for creating an ISimulationStreamSink when required.

callback - A callback, which receives updates regrading the recording's status.

Return value

The loaded recording.

Describes the different types of stream data.

Microsoft.PerceptionSimulation.StreamDataTypes.NoneMicrosoft.PerceptionSimulation.StreamDataTypes.None

A sentinel value used to indicate no stream data types.

Microsoft.PerceptionSimulation.StreamDataTypes.HeadMicrosoft.PerceptionSimulation.StreamDataTypes.Head

Stream of data for the position and orientation of the head.

Microsoft.PerceptionSimulation.StreamDataTypes.HandsMicrosoft.PerceptionSimulation.StreamDataTypes.Hands

Stream of data for the position and gestures of hands.

Microsoft.PerceptionSimulation.StreamDataTypes.SpatialMappingMicrosoft.PerceptionSimulation.StreamDataTypes.SpatialMapping

Stream of data for spatial mapping of the environment.

Microsoft.PerceptionSimulation.StreamDataTypes.CalibrationMicrosoft.PerceptionSimulation.StreamDataTypes.Calibration

Stream of data for calibration of the device. Calibration packets are only accepted by a system in Remote Mode.



  Microsoft.PerceptionSimulation.ISimulationStreamSinkMicrosoft.PerceptionSimulation.ISimulationStreamSink

public interface ISimulationStreamSink
{
    void OnPacketReceived(uint length, byte[] packet);
}

  Microsoft.PerceptionSimulation.ISimulationStreamSinkFactoryMicrosoft.PerceptionSimulation.ISimulationStreamSinkFactory

public interface ISimulationStreamSinkFactory
{
    ISimulationStreamSink CreateSimulationStreamSink();
}

Microsoft.PerceptionSimulation.StreamDataTypes.EnvironmentMicrosoft.PerceptionSimulation.StreamDataTypes.Environment

Stream of data for the environment of the device.

Microsoft.PerceptionSimulation.StreamDataTypes.S ixDofControllersMicrosoft.PerceptionSimulation.StreamDataTypes.S ixDofControllers

Stream of data for motion controllers.

Microsoft.PerceptionSimulation.StreamDataTypes.EyesMicrosoft.PerceptionSimulation.StreamDataTypes.Eyes

Stream of data with the eyes of the simulated human.

Microsoft.PerceptionSimulation.StreamDataTypes.DisplayConfigurationMicrosoft.PerceptionSimulation.StreamDataTypes.DisplayConfiguration

Stream of data with the display configuration of the device.

Microsoft.PerceptionSimulation.StreamDataTypes.AllMicrosoft.PerceptionSimulation.StreamDataTypes.All

A sentinel value used to indicate all recorded data types.

An object that receives data packets from a simulation stream.

Microsoft.PerceptionSimulation.IS imulationStreamSink .OnPacketReceived(uint length, byte[]Microsoft.PerceptionSimulation.IS imulationStreamSink .OnPacketReceived(uint length, byte[]

packet)packet)

Receives a single packet, which is internally typed and versioned.

Parameters

length - The length of the packet.

packet - The data of the packet.

An object that creates ISimulationStreamSink.

Microsoft.PerceptionSimulation.IS imulationStreamSinkFactor y.CreateSimulationStreamSink()Microsoft.PerceptionSimulation.IS imulationStreamSinkFactor y.CreateSimulationStreamSink()

Creates a single instance of ISimulationStreamSink.

Return value

The created sink.
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 Distribution options

IMPORTANTIMPORTANT

ScenarioScenario Local device installsLocal device installs Share with anyoneShare with anyone Share with anShare with an
organizationorganization

Getting your apps into the hands of your users or out into the world is the most important, and sometimes

painstaking, part of any development effort. We've simplified the process into a set of resources, which depend

on the distribution and deployment scenario that's best suited for you or your team.

HoloLens

Windows Mixed Reality

If you have a HoloLens application, choose your preferred distribution option from the table below. If you're

publishing to the Microsoft Store, you have the option of adding In-app purchases to monetize your content.

If you're sharing your app with another party, you need to build and supply the appx file.

If you're using App Installer, you'll also need to share the certificate with the user.

If you're sharing with an organization, you need a work or school account and access to the organizations MDM

(Mobile Device Management) infrastructure.

If you're the sharing party, you need to be an Admin in your tenant and use the Microsoft Endpoint Manager

admin center to make the app available. Another option is to share the appx file and the app dependencies

with your end user.

If you're the end user, the app will either automatically download or be available for download once you enroll

with the sharing organization's tenant.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/distribute/distribute-overview.md
https://docs.microsoft.com/en-us/hololens/hololens-enroll-mdm
https://docs.microsoft.com/en-us/mem/intune/apps/apps-deploy


App InstallerApp Installer ✔️ ✔️ ❌

MDM - Company Por talMDM - Company Por tal ❌ ❌ ✔️

MDM - Required App InstallMDM - Required App Install ❌ ❌ ✔️

Microsoft StoreMicrosoft Store ❌ ✔️ ✔️

Microsoft Store for BusinessMicrosoft Store for Business ❌ ❌ ✔️

Provisioning PackageProvisioning Package ✔️ ✔️ ✔️

Custom Win32 deploymentCustom Win32 deployment  (Not
available for HoloLens devices - see
below)

✔️ ✔️ ❌

IMPORTANTIMPORTANT

 Other scenarios

 See also

App Installer isn't currently available for managed devices or HoloLens (1st Gen) devices.

You can produce a Win32 .EXE file using the PC Standalone build target from Unity for Win32 application

deployment, including Steam and Game Pass. Once you have the .EXE, you can submit your apps as

normal to your chosen platform.

If you need to install a HoloLens 2 application while you're offline, refer to the offline secure HoloLens 2

instructions or install the app through a Provisioning Package without enabling developer mode.

You can also deploy builds to your device and share them with other developers who have Developer

Mode enabled by deploying and debugging with Visual Studio or installing an application package with

the Device Portal.

Finding, installing, and uninstalling applications from the Microsoft Store

https://docs.microsoft.com/en-us/hololens/app-deploy-app-installer
https://docs.microsoft.com/en-us/hololens/app-deploy-app-installer
https://docs.microsoft.com/en-us/hololens/app-deploy-intune
https://docs.microsoft.com/en-us/hololens/app-deploy-store-business
https://docs.microsoft.com/en-us/hololens/app-deploy-provisioning-package
https://docs.microsoft.com/en-us/hololens/hololens-common-scenarios-offline-secure
https://docs.microsoft.com/en-us/hololens/holographic-store-apps
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 3D app launcher creation process

 Design concepts
  Fantastic yet familiarFantastic yet familiar

  IntuitiveIntuitive

When you put on a Windows Mixed Reality immersive (VR) headset, you enter the Windows Mixed Reality

home. The home is visualized as a house on a cliff surrounded by mountains and water, but you can choose

other environments and even create your own). Within the home's space, a user is free to arrange and organize

the 3D objects and apps that they care about any way they want. A 3D app launcher3D app launcher  is a “physical” object in

the user ’s mixed reality house that they can select to launch an app.

Floaty Bird 3D app launcher example (fictional app)

There are 3 steps to creating a 3D app launcher :

1. Designing and concepting (this article)

2. Modeling and exporting

3. Integrating it into your application:

UWP apps

Win32 apps

The Windows Mixed Reality environment your app launcher lives in is part familiar, part fantastical/sci-fi. The

best launchers follow the rules of this world. Think of how you can take a familiar, representative object from

your app, but bend some of the rules of actual reality. Magic will result.

When you look at your app launcher, its purpose - to launch your app - should be obvious and shouldn’t cause

any confusion. For example, be sure your launcher is an obvious-enough representative of your app that it won’t

be confused for a piece of decor in the Cliff House. Your app launcher should invite people to touch/select it.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/distribute/3d-app-launcher-design-guidance.md


  Home scaleHome scale

  Own-ableOwn-able

Fresh Note 3D app launcher example (fictional app)

3D app launchers live in the Cliff House and their default size should make sense with the other “physical”

objects in the space. If you place your launcher beside, say, a house plant or some furniture, it should feel at

home, size-wise. A good starting point is to see how it looks at 30 cubic centimeters, but remember that users

can scale it up or down if they like.

The app launcher should feel like an object a person would be excited to have in their space. They’ll be virtually

surrounding themselves with these things, so the launcher should feel like something the user thought was

desirable enough to seek out and keep nearby.



  RecognizableRecognizable

  VolumetricVolumetric

Astro Warp 3D app launcher example (fictional app)

Your 3D app launcher should instantly express “your app’s brand” to people who see it. If you have a star

character or an especially identifiable object in your app, we recommend using that as a significant part of your

design. In a mixed reality world, an object will draw more interest from users than just a logo alone.

Recognizable objects communicate brand quickly and clearly.

Your app deserves more than just putting your logo on a flat plane and calling it a day. Your launcher should feel

like an exciting, 3D, physical object in the user ’s space. A good approach is to imagine your app was going to

have a balloon in the Macy’s Thanksgiving Day Parade. Ask yourself, what would really wow people as it came

down the street? What would look great from all viewing angles?



 Logo only

 More recognizable

with a character



 Flat approach, not

surprisingly, feels flat

 Volumetric



 Tips for good 3D models

  What to avoidWhat to avoid

approach better showcases your app

When planning dimensions for your app launcher, shoot for roughly a 30-cm cube. So, a 1:1:1 size ratio.

Models must be under 10,000 polygons. Learn more about triangle counts and levels of details (LODs)

Test on an immersive headset.

Build details into your model’s geometry where possible – don’t rely on textures for detail.

Build “water tight” closed geometry. No holes that aren't modeled in.

Use natural materials in your object. Imagine crafting it in the real world.

Make sure your model reads well at different distances and sizes.

When your model is ready to go, read the exporting assets guidelines.

Model with subtle details in the texture

Don't use high-contrast details or small, busy patterns and textures.

Don't use thin geometry – it doesn’t work well at a distance and will alias badly.

Don't let parts of your model extend too much beyond the 1:1:1 size ratio. It will create scaling problems.



 How to handle type

Avoid high-contrast, small, busy patterns

We recommend your type takes up about 1/3 of your app launcher (or more). Type is the main thing that

gives people an idea that your launcher is, in fact, a launcher so it’s nice if it’s substantial.

Avoid making type super wide – try to keep it within the confines of the app launchers core dimensions

(more or less).

Flat type can work, but it can be hard to view from certain angles and in certain environments. You might

consider putting it a solid object or backdrop behind it to help with this.

Adding dimension to your type feels nice in 3D. Shading the sides of the type a different, darker color can

help with readability.

 Flat type without a

backdrop can be hard to view from certain angles and in certain environments



 Type with a built-in

backdrop can work well

 Extruded type can

work well if you shade the sides

Type colors that workType colors that work

White

Black

Bright semi-saturated color



  Colors to avoidColors to avoid

 Lighting

Type colors that work

Type colors that cause trouble include:

Mid-tones

Gray

Over-saturated colors or desaturated colors

Type colors that cause trouble

The lighting for your app launcher comes from the Cliff House environment. Be sure to test your launcher in

several places throughout the house so it looks good in both light and shadows. The good news is, if you’ve

followed the other design guidance in this document, your launcher should be in good shape for most lighting

in the Cliff House.

Good places to test how your launcher looks in the various lights in the environment are the Studio, the Media



 Texturing
  Authoring your texturesAuthoring your textures

Room, anywhere outside and on the Back Patio (the concrete area with the lawn). Another good test is to put it in

half light and half shadow and see what it looks like.

Make sure your launcher looks good in both light and shadows

The end format of your 3D app launcher will be a .glb file, which is made using the PBR (Physically Based

Rendering) pipeline. This can be a tricky process - now is a good time to employ a technical artist if you haven't

already. If you’re a brave DIY-er, taking the time to research and learn PBR terminology and what’s happening

under the hood before you begin will help you avoid common mistakes.

Fresh Note 3D app launcher example (fictional app)

https://wiki.polycount.com/wiki/PBR


  Recommended authoring toolRecommended authoring tool

  Best practicesBest practices

 See also

We recommend using Substance Painter by Allegorithmic to author your final file. If you’re not familiar with

authoring PBR shaders in Substance Painter, here’s a tutorial.

(Alternately 3D-Coat, Quixel Suite 2, or Marmoset Toolbag would also work if you’re more familiar with one of

these.)

If your app launcher object was authored for PBR, it should be straightforward to convert it for the Cliff

House environment.

Our shader is expecting a Metal/Roughness work flow – The Unreal PBR shader is a close facsimile.

When exporting your textures, keep the recommended texture sizes in mind.

Make sure to build your objects for real-time lighting—this means:

Avoid baked shadows – or painted shadows

Avoid baked lighting in the textures

Use one of the PBR material authoring packages to get the right maps generated for our shader

Create 3D models for use in the mixed reality home

Implement 3D app launchers (UWP apps)

Implement 3D app launchers (Win32 apps)

https://www.allegorithmic.com/products/substance-painter
https://docs.allegorithmic.com/documentation/display/SPDOC/Tutorials
https://3dcoat.com/home/
https://quixel.se/suite2/
https://www.marmoset.co/toolbag/
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 Asset requirements overview

NOTENOTE

 Detailed guidance
  Exporting modelsExporting models

  Modeling guidelinesModeling guidelines

The Windows Mixed Reality home is the starting point where users land before launching applications. When

designing your application for Windows Mixed Reality headsets, use a 3D model as an app launcher and place

3D deep links into the Windows Mixed Reality home. This article outlines the guidelines for creating 3D models

compatible with the Windows Mixed Reality home.

When creating 3D models for Windows Mixed Reality, there are some requirements that all assets must meet:

1. Exporting - Assets must be delivered in the .glb (binary glTF), .obj, or .fbx file format

2. Modeling - Assets must be less than 10k triangles, have no more than 64 nodes and 32 submeshes per LOD

3. Materials - Textures can't be larger than 4096 x 4096 and the smallest mip map should be no larger than 4

on either dimension

4. Animation - Animations can't be longer than 20 minutes at 30 FPS (36,000 keyframes) and must contain <=

8192 morph target vertices

5. Optimizing - Assets should be optimized using the WindowsMRAssetConverter. Required on Windows OS

Versions <= 1709* and recommended on Windows OS versions >= 1803

The 3D Viewer app supports different formats and resolutions, but ultimately converts models to .glb/glTF before

displaying them in the Mixed Reality home.

The rest of this article includes a detailed overview of these requirements and extra guidelines to ensure your

models work well with the Windows Mixed Reality home.

The Windows Mixed Reality home expects 3D assets to be delivered using the .glb file format with embedded

images and binary data. Glb is the binary version of the glTF format, which is a royalty free open standard for

3D asset delivery maintained by the Khronos group. As glTF evolves as an industry standard for interoperable

3D content, so will Microsoft’s support for the format across Windows apps and experiences. If you haven't

created a glTF asset before you can find a list of supported exporters and converters on the glTF working group

github page.

Windows expects assets to be generated using the following modeling guidelines to ensure compatibility with

the Mixed Reality home experience. When modeling in your program of your choice, keep in mind the following

recommendations and limitations:

1. The Up axis should be set to “Y”.

2. The asset should face “forward” towards the positive Z axis.

3. All assets should be built on the ground plane at the scene origin (0,0,0)

4. Working Units should be set to meters and assets so that assets can be authored at world scale

5. All meshes don't need to be combined, but it's recommended if you're targeting resource constrained devices

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/distribute/creating-3d-models-for-use-in-the-windows-mixed-reality-home.md
https://github.com/Microsoft/glTF-Toolkit/releases
https://github.com/KhronosGroup/glTF/blob/master/README.md#converters-and-exporters


  Triangle counts and levels of detail (LODs)Triangle counts and levels of detail (LODs)

LO D L EVELLO D L EVEL REC O M M EN DED T RIA N GL E C O UN TREC O M M EN DED T RIA N GL E C O UN T M A X T RIA N GL E C O UN TM A X T RIA N GL E C O UN T

LOD 0 10,000 10,000

LOD 1 5,000 10,000

LOD 2 2,500 10,000

  Node counts and submesh limitsNode counts and submesh limits

F EAT UREF EAT URE DESC RIP T IO NDESC RIP T IO N M A X SUP P O RT EDM A X SUP P O RT ED DO C UM EN TAT IO NDO C UM EN TAT IO N

Nodes Objects in the glTF Scene 64 per LOD Here

Submeshes Sum of primitives on all
meshes

32 per LOD Here

 Material guidelines

REC O M M EN DED T EXT URE SIZ EREC O M M EN DED T EXT URE SIZ E M A X T EXT URE SIZ EM A X T EXT URE SIZ E LO W EST  M IPLO W EST  M IP

512x512 4096x4096 max 4x4

  Albedo (base color) mapAlbedo (base color) map

  NormalNormal

6. All meshes should share one material, with only one texture set being used for the whole asset

7. UVs must be laid out in a square arrangement in the 0-1 space. Avoid tiling textures although they're

permitted.

8. Multi-UVs aren't supported

9. Double-sided materials aren't supported

The Windows Mixed Reality home doesn't support models with more than 10,000 triangles. It’s recommended

you triangulate your meshes before exporting to ensure they don't exceed this count. Windows MR also

supports optional geometry levels of detail (LODs) to ensure a performant and high-quality experience. The

WindowsMRAssetConverter will help you combine 3 versions of your model into a single .glb model. Windows

determines which LOD to display based on the amount of screen real estate the model is taking up. Only 3 LOD

levels are supported with the following recommended triangle counts: 

The Windows Mixed Reality home doesn't support models with more than 64 nodes or 32 submeshes per LOD.

Nodes are a concept in the glTF specification that define the objects in the scene. Submeshes are defined in the

array of primitives on the mesh in the object.

Textures should be prepared using a PBR metal roughness workflow. Begin by creating a full set of textures

including Albedo, Normal, Occlusion, Metallic, and Roughness. Windows Mixed Reality supports textures with

resolutions up to 4096x4096 but it's recommended that you author at 512x512. Textures should be authored at

resolutions in multiples of 4. This is a requirement for the compression format applied to textures in the

exporting steps outlined below. When generating mip maps or a texture, the lowest mip must be a maximum of

4x4. 

Raw color with no lighting information. This map also contains the reflectance and diffuse information for metal

(white in the metallic map) and insulator (black in the metallic map) surfaces respectively.

https://github.com/Microsoft/glTF-Toolkit/releases
https://github.com/KhronosGroup/glTF/tree/master/specification/2.0#nodes-and-hierarchy
https://github.com/KhronosGroup/glTF/tree/master/specification/2.0#meshes
https://github.com/KhronosGroup/glTF/tree/master/specification/2.0#nodes-and-hierarchy
https://github.com/KhronosGroup/glTF/tree/master/specification/2.0#meshes


  Roughness mapRoughness map

  Ambient occlusion mapAmbient occlusion map

  Metallic mapMetallic map

 Optimizations

NOTENOTE

  MaterialsMaterials

  HoloLensHoloLens

GLT F  P RO P ERT YGLT F  P RO P ERT Y T EXT URET EXT URE PA C K IN G SC H EM EPA C K IN G SC H EM E

pbrMetallicRoughness baseColorTexture Red (R), Green (G), Blue (B)

MSFT_packing_normalRoughnessMetal
lic

normalRoughnessMetallicTexture Normal (RG), Roughness (B), Metallic
(A)

T EXT URET EXT URE EXP EC T ED C O M P RESSIO NEXP EC T ED C O M P RESSIO N

baseColorTexture, normalRoughnessMetallicTexture BC7

  Immersive (VR) headsetsImmersive (VR) headsets

Tangent Space Normal map

Describes the microsurface of the object. White 1.0 is rough Black 0.0 is smooth. This map gives the asset the

most character, as it truly describes the surface. For example, scratches, fingerprints, smudges, grime, and so on.

Value scale map showing areas of occluded light, which blocks reflections

Tells the shader if something is metal or not. Raw Metal = 1.0 white Non-metal = 0.0 black. There can be

transitional gray values that indicate something covering the raw metal such as dirt, but in general this map

should be black and white only.

Windows Mixed Reality home offers a series of optimizations on top of the core glTF spec defined using custom

extensions. These optimizations are required on Windows versions <= 1709 and recommended on newer

versions of Windows. You can easily optimize any glTF 2.0 model using the Windows Mixed Reality Asset

Converter available on GitHub. This tool will perform the correct texture packing and optimizations as specified

below. For general usage, we recommend using the WindowsMRAssetConverter, but if you need more control

over the experience and would like to build your own optimization pipeline then you can refer to the detailed

specification below.

For a definitive list of what the possibilities are for exact model limits, refer to the 3D model optimization article for use in

Dynamics 365 applications.

To improve asset loading time in Mixed Reality environments Windows MR supports rendering compressed

DDS textures packed according to the texture packing scheme defined in this section. DDS textures are

referenced using the MSFT_texture_dds extension. Compressing textures is highly recommended.

HoloLens-based mixed reality experiences expect textures to be packed using a 2-texture setup using the

following packing specification: 

When compressing the DDS textures the following compression is expected on each map: 

PC-based Windows Mixed Reality experiences for immersive (VR) headsets expect textures to be packed using a

3-texture setup using the following packing specification:

https://github.com/Microsoft/glTF-Toolkit/releases
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/guides/3d-content-guidelines/optimize-models
https://github.com/sbtron/glTF/tree/MSFT_lod/extensions/Vendor/MSFT_texture_dds
https://github.com/KhronosGroup/glTF/blob/master/extensions/2.0/Vendor/MSFT_packing_normalRoughnessMetallic/README.md


  W i n d o w s  O S > =  1 8 0 3W i n d o w s  O S > =  1 8 0 3

GLT F  P RO P ERT YGLT F  P RO P ERT Y T EXT URET EXT URE PA C K IN G SC H EM EPA C K IN G SC H EM E

pbrMetallicRoughness baseColorTexture Red (R), Green (G), Blue (B)

MSFT_packing_occlusionRoughnessMe
tallic

occlusionRoughnessMetallicTexture Occlusion (R), Roughness (G), Metallic
(B)

MSFT_packing_occlusionRoughnessMe
tallic

normalTexture Normal (RG)

T EXT URET EXT URE EXP EC T ED C O M P RESSIO NEXP EC T ED C O M P RESSIO N

normalTexture BC5

baseColorTexture, occlusionRoughnessMetallicTexture BC7

  W i n d o w s  O S < =  1 70 9W i n d o w s  O S < =  1 70 9

GLT F  P RO P ERT YGLT F  P RO P ERT Y T EXT URET EXT URE PA C K IN G SC H EM EPA C K IN G SC H EM E

pbrMetallicRoughness baseColorTexture Red (R), Green (G), Blue (B)

MSFT_packing_occlusionRoughnessMe
tallic

roughnessMetallicOcclusionTexture Roughness (R), Metallic (G), Occlusion
(B)

MSFT_packing_occlusionRoughnessMe
tallic

normalTexture Normal (RG)

T EXT URET EXT URE EXP EC T ED C O M P RESSIO NEXP EC T ED C O M P RESSIO N

normalTexture BC5

baseColorTexture, roughnessMetallicOcclusionTexture BC7

  Adding mesh LODsAdding mesh LODs

LO D L EVELLO D L EVEL REC O M M EN DED T RIA N GL E C O UN TREC O M M EN DED T RIA N GL E C O UN T M A X T RIA N GL E C O UN TM A X T RIA N GL E C O UN T

LOD 0 10,000 10,000

When compressing the DDS textures the following compression is expected on each map: 

When compressing the DDS textures the following compression is expected on each map: 

Windows MR uses geometry node LODs to render 3D models in different levels of detail depending on on-

screen coverage. While this feature is technically not required, it's recommended for all assets. Currently

Windows supports 3 levels of detail. The default LOD is 0, which represents the highest quality. Other LODs are

numbered sequentially, for example, 1, 2 and get progressively lower in quality. The Windows Mixed Reality

Asset Converter supports generating assets that meet this LOD specification by accepting multiple glTF models

and merging them into a single asset with valid LOD levels. The following table outlines the expected LOD

ordering and triangle targets: 

https://github.com/KhronosGroup/glTF/blob/master/extensions/2.0/Vendor/MSFT_packing_occlusionRoughnessMetallic/README.md
https://github.com/KhronosGroup/glTF/blob/master/extensions/2.0/Vendor/MSFT_packing_occlusionRoughnessMetallic/README.md
https://github.com/KhronosGroup/glTF/blob/master/extensions/2.0/Vendor/MSFT_packing_occlusionRoughnessMetallic/README.md
https://github.com/KhronosGroup/glTF/blob/master/extensions/2.0/Vendor/MSFT_packing_occlusionRoughnessMetallic/README.md
https://github.com/Microsoft/glTF-Toolkit/releases


LOD 1 5,000 10,000

LOD 2 2,500 10,000

LO D L EVELLO D L EVEL REC O M M EN DED T RIA N GL E C O UN TREC O M M EN DED T RIA N GL E C O UN T M A X T RIA N GL E C O UN TM A X T RIA N GL E C O UN T

  Screen coverageScreen coverage

LO D L EVELLO D L EVEL REC O M M EN DED RA N GEREC O M M EN DED RA N GE DEFA ULT  RA N GEDEFA ULT  RA N GE

LOD 0 100% - 50% 0.5

LOD 1 Under 50% - 20% 0.2

LOD 2 Under 20% - 1% 0.01

LOD 4 Under 1% -

 Animation guidelines

NOTENOTE

  ToolsTools

  Opening and previewing the modelOpening and previewing the model

When using LODs always specify 3 LOD levels. Missing LODs will cause the model to not render unexpectedly as

the LOD system switches to the missing LOD level. glTF 2.0 doesn't currently support LODs as part of the core

spec. LODs should be defined using the MSFT_LOD extension.

LODs are displayed in Windows Mixed Reality based on a system driven by the screen coverage value set on

each LOD. Objects that are currently consuming a larger portion of the screen space are displayed at a higher

LOD level. Screen coverage isn't a part of the core glTF 2.0 spec and must be specified using

MSFT_ScreenCoverage in the “extras” section of the MSFT_lod extension. 

This feature was added as part of Windows 10 April 2018 Update. On older versions of Windows these animations won't

play back, however, they will still load if authored according to the guidance in this article.

The mixed reality home supports animated glTF objects on HoloLens and immersive (VR) headsets. If you wish

to trigger animations on your model, you'll need to use the Animation Map extension on the glTF format. This

extension lets you trigger animations in the glTF model based on the user's presence in the world, for example

trigger an animation when the user is close to the object or while they're looking at it. If you glTF object has

animations, but doesn't define triggers the animations won't be played back. The section below describes one

workflow for adding these triggers to any animated glTF object.

First, download the following tools if you don't have them already. These tools will make it easy to open any glTF

model, preview it, make changes and save back out as glTF or .glb:

1. Visual Studio Code

2. glTF Tools for Visual Studio Code

Start by opening up the glTF model in VSCode by dragging the .glTF file into the editor window. If you've a .glb

instead of a .glTF file you can import it into VSCode using the glTF Tools addon that you downloaded. Go to

"View -> Command Palette" and then begin typing "glTF" in the command palette and select "glTF: Import from

glb", which will pop up a file picker for you to import a .glb with.

https://github.com/sbtron/glTF/tree/MSFT_lod/extensions/Vendor/MSFT_lod
https://github.com/sbtron/glTF/tree/MSFT_lod/extensions/Vendor/MSFT_lod
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/release-notes-april-2018
https://code.visualstudio.com/
https://marketplace.visualstudio.com/items?itemName=cesium.gltf-vscode


  Adding the triggersAdding the triggers

  "extensionsUsed": [
    "EXT_animation_map"
  ],
  "extensions" : {
      "EXT_animation_map" : {
            "bindings": [
                {
                    "semantic": "GAZE",
                    "animations": [0]
                }
            ]
      }
  }

  Saving and exportingSaving and exporting

  RestrictionsRestrictions

F EAT UREF EAT URE M A XIM UMM A XIM UM

Duration 20 minutes

Keyframes 36,000

Morph Target Vertices 8192

 

Once you've opened your glTF model, you should see the JSON in the editor window. You can also preview the

model in a live 3D viewer using the by right-clicking the file name and selecting the "glTF: Preview 3D Model"

command shortcut from the right click menu.

Animation triggers are added to glTF model JSON using the Animation Map extension. The animation map

extension is publicly documented here on GitHub (NOTE: THIS IS A DRAFT EXTENSION). To add the extension to

your model just scroll to the end of the glTF file in the editor and add the "extensionsUsed" and "extensions"

block to your file if they don't already exist. In the "extensionsUsed" section, you'll add a reference to the

"EXT_animation_map" extension and in the "extensions" block you'll add your mappings to the animations in the

model.

As noted in the spec you define what triggers the animation using the "semantic" string on a list of "animations",

which is an array of animation indices. In the example below we've specified the animation to play while the user

is gazing at the object:

The following animation triggers semantics are supported by the Windows Mixed Reality home.

"ALWAYS": Constantly loop an animation

"HELD": Looped during the entire duration an object is grabbed.

"GAZE": Looped while an object is being looked at

"PROXIMITY": Looped while a viewer is near to an object

"POINTING": Looped while a user is pointing at an object

Once you've made the changes to your glTF model, you can save it directly as glTF. You can also right-click the

name of the file in the editor and select "glTF: Export to GLB (binary file)" to export a .glb.

Animations can't be longer than 20 minutes and can't contain more than 36,000 keyframes (20 mins at 30 FPS).

Additionally when using morph target-based animations don't exceed 8192 morph target vertices or less.

Exceeding these counts will cause the animated asset to be unsupported in the Windows Mixed Reality home.

https://github.com/msfeldstein/glTF/blob/04f7005206257cf97b215df5e3f469d7838c1fee/extensions/Vendor/FB_animation_map/README.md
https://github.com/msfeldstein/glTF/blob/04f7005206257cf97b215df5e3f469d7838c1fee/extensions/Vendor/FB_animation_map/README.md


glTF Implementation notes

 More resources

 See also

Windows MR doesn't support flipping geometry using negative scales. Geometry with negative scales will likely

result in visual artifacts.

The glTF asset MUST point to the default scene using the scene attribute to be rendered by Windows MR.

Additionally the Windows MR glTF loader before the Windows 10 April 2018 update requiresrequires  accessors:

Must have min and max values.

Type SCALAR must be componentType UNSIGNED_SHORT (5123) or UNSIGNED_INT (5125).

Type VEC2 and VEC3 must be componentType FLOAT (5126).

The following material properties are used from core glTF 2.0 spec but not required:

baseColorFactor, metallicFactor, roughnessFactor

baseColorTexture: Must point to a texture stored in dds.

emissiveTexture: Must point to a texture stored in dds.

emissiveFactor

alphaMode

The following material properties are ignored from core spec:

All Multi-UVs

metalRoughnessTexture: Must instead use Microsoft optimized texture packing defined below

normalTexture: Must instead use Microsoft optimized texture packing defined below

normalScale

occlusionTexture: Must instead use Microsoft optimized texture packing defined below

occlusionStrength

Windows MR doesn't support primitive mode lines and points.

Only a single UV vertex attribute is supported.

glTF Exporters and Converters

glTF Toolkit

glTF 2.0 Specification

Microsoft glTF LOD Extension Specification

PC Mixed Reality Texture Packing Extensions Specification

HoloLens Mixed Reality Texture Packing Extensions Specification

Microsoft DDS Textures glTF extensions specification

Implement 3D app launchers (UWP apps)

Implement 3D app launchers (Win32 apps)

Navigating the Windows Mixed Reality home

https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/release-notes-april-2018
https://github.com/KhronosGroup/glTF#converters-and-exporters
https://github.com/Microsoft/glTF-Toolkit
https://github.com/KhronosGroup/glTF/blob/master/README.md
https://github.com/KhronosGroup/glTF/blob/master/extensions/2.0/Vendor/MSFT_lod/README.md
https://github.com/KhronosGroup/glTF/blob/master/extensions/2.0/Vendor/MSFT_packing_occlusionRoughnessMetallic/README.md
https://github.com/KhronosGroup/glTF/blob/master/extensions/2.0/Vendor/MSFT_packing_normalRoughnessMetallic/README.md
https://github.com/KhronosGroup/glTF/tree/master/extensions/2.0/Vendor/MSFT_texture_dds
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NOTENOTE

 3D app launcher creation process

 Configuring the 3D launcher

  XMLXML

This feature was added as part of the 2017 Fall Creators Update (RS3) for immersive headsets and is supported by

HoloLens with the Windows 10 April 2018 Update. Make sure your application is targeting a version of the Windows SDK

greater than or equal to 10.0.16299 on immersive Headsets and 10.0.17125 on HoloLens. You can find the latest

Windows SDK here.

The Windows Mixed Reality home is the starting point where users land before launching applications. When

creating a UWP application for Windows Mixed Reality, by default, apps are launched as 2D slates with their

app's logo. When developing experiences for Windows Mixed Reality, a 3D launcher can optionally be defined to

override the default 2D launcher for your application. In general, 3D launchers are recommended for launching

immersive applications that take users out of the Windows Mixed Reality home. The default 2D launcher is

preferred when the app is activated in place. You can also create a 3D deep link (secondaryTile) as a 3D launcher

to content within a 2D UWP app.

There are three steps to creating a 3D app launcher :

1. Designing and concepting

2. Modeling and exporting

3. Integrating it into your application (this article)

3D assets to be used as launchers for your application should be authored using the Windows Mixed Reality

authoring guidelines to ensure compatibility. Assets that fail to meet this authoring specification won't be

rendered in the Windows Mixed Reality home.

When you create a new project in Visual Studio, it creates a simple default tile that displays your app's name and

logo. To replace this 2D representation with a custom 3D model edit the app manifest of your application to

include the “MixedRealityModel” element as part of your default tile definition. To revert to the 2D launcher just

remove the MixedRealityModel definition from the manifest.

First, locate the app package manifest in your current project. By default, the manifest will be named

Package.appxmanifest. If you're using Visual Studio, then right-click the manifest in your solution viewer and

select View sourceView source to open the xml for editing.

At the top of the manifest, add the uap5 schema and include it as an ignorable namespace:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/distribute/implementing-3d-app-launchers.md
https://developer.microsoft.com/windows/downloads/windows-10-sdk
https://www.youtube-nocookie.com/embed/TxIslHsEXno


<Package xmlns:mp="http://schemas.microsoft.com/appx/2014/phone/manifest" 
         xmlns:uap="http://schemas.microsoft.com/appx/manifest/uap/windows10" 
         xmlns:uap2="http://schemas.microsoft.com/appx/manifest/uap/windows10/2" 
         xmlns:uap5="http://schemas.microsoft.com/appx/manifest/uap/windows10/5"
         IgnorableNamespaces="uap uap2 uap5 mp"
         xmlns="http://schemas.microsoft.com/appx/manifest/foundation/windows10">

<Applications>
    <Application Id="App"
      Executable="$targetnametoken$.exe"
      EntryPoint="ExampleApp.App">
      <uap:VisualElements
        DisplayName="ExampleApp"
        Square150x150Logo="Assets\Logo.png"
        Square44x44Logo="Assets\SmallLogo.png"
        Description="ExampleApp"
        BackgroundColor="#464646">
        <uap:DefaultTile Wide310x150Logo="Assets\WideLogo.png" >
          <uap5:MixedRealityModel Path="Assets\My3DTile.glb" />
        </uap:DefaultTile>
        <uap:SplashScreen Image="Assets\SplashScreen.png" />
      </uap:VisualElements>
    </Application>
</Applications>

  Bounding boxBounding box

Next specify the "MixedRealityModel" in the default tile for your application:

The MixedRealityModel element accepts a file path pointing to a 3D asset stored in your app package. Currently

only 3D models delivered using the .glb file format and authored against the Windows Mixed Reality 3D asset

authoring instructions are supported. Assets must be stored in the app package and animation isn't currently

supported. If the “Path” parameter is left blank Windows will show the 2D slate instead of the 3D launcher.

Note:Note: the .glb asset must be marked as "Content" in your build settings before building and running your app.

Select the .glb in your solution explorer and use the properties section to mark it as "Content" in the build

settings

A bounding box can be used to optionally add an extra buffer region around the object. The bounding box is

specified using a center point and extents, which indicate the distance from the center of the bounding box to its

edges along each axis. Units for the bounding box can be mapped to 1 unit = 1 meter. If a bounding box isn't

provided, then one will be automatically fitted to the mesh of the object. If the provided bounding box is smaller

than the model, then it will be resized to fit the mesh.

Support for the bounding box attribute will come with the Windows RS4 update as a property on the

MixedRealityModel element. To define a bounding box first at the top of the app manifest add the uap6 schema

and include it as ignorable namespaces:



<Package xmlns:mp="http://schemas.microsoft.com/appx/2014/phone/manifest" 
         xmlns:uap="http://schemas.microsoft.com/appx/manifest/uap/windows10" 
         xmlns:uap2="http://schemas.microsoft.com/appx/manifest/uap/windows10/2" 
         xmlns:uap5="http://schemas.microsoft.com/appx/manifest/uap/windows10/5"
         xmlns:uap6="http://schemas.microsoft.com/appx/manifest/uap/windows10/6"
         IgnorableNamespaces="uap uap2 uap5 uap6 mp"
         xmlns="http://schemas.microsoft.com/appx/manifest/foundation/windows10">

        <uap:DefaultTile Wide310x150Logo="Assets\WideLogo.png" >
          <uap5:MixedRealityModel Path="Assets\My3DTile.glb">
              <uap6:SpatialBoundingBox  Center=”1,-2,3” Extents=”1,2,3” />
          </uap5:MixedRealityModel>
        </uap:DefaultTile>

  Using UnityUsing Unity

NOTENOTE

 3D deep links (secondaryTiles)

NOTENOTE

IMPORTANTIMPORTANT

  Creating a 3D “secondaryTile”Creating a 3D “secondaryTile”

Next, on the MixedRealityModel set the SpatialBoundingBox property to define the bounding box:

When working with Unity the project must be built and opened in Visual Studio before the App Manifest can be

edited.

The 3D launcher must be redefined in the manifest when building and deploying a new Visual Studio solution from Unity.

This feature was added as part of the 2017 Fall Creators Update (RS3) for immersive (VR) headsets and as part of the

April 2018 Update (RS4) for HoloLens. Make sure your application is targeting a version of the Windows SDK greater than

or equal to 10.0.16299 on immersive (VR) headsets and 10.0.17125 on HoloLens. You can find the latest Windows SDK

here.

3D deep links (secondaryTiles) only work with 2D UWP apps. You can, however, create a 3D app launcher to launch an

exclusive app from the Windows Mixed Reality home.

Your 2D applications can be enhanced for Windows Mixed Reality by adding the ability to place 3D models from

your app into the Windows Mixed Reality home as deep links to content within your 2D app, just like 2D

secondary tiles on the Windows Start menu. For example, you can create 360° photospheres that link directly

into a 360° photo viewer app, or let users place 3D content from a collection of assets that opens a details page

about the author. These are just a couple ways to expand the functionality of your 2D application with 3D

content.

You can place 3D content from your application using “secondaryTiles” by defining a mixed reality model at

creation time. Mixed reality models are created by referencing a 3D asset in your app package and optionally

defining a bounding box.

https://developer.microsoft.com/windows/downloads/windows-10-sdk
https://docs.microsoft.com/en-us/windows/uwp/controls-and-patterns/tiles-and-notifications-secondary-tiles


NOTENOTE

using Windows.UI.StartScreen;
using Windows.Foundation.Numerics;
using Windows.Perception.Spatial;

// Initialize the tile
SecondaryTile tile = new SecondaryTile("myTileId")
{
    DisplayName = "My Tile",
    Arguments = "myArgs"
};

tile.VisualElements.Square150x150Logo = new Uri("ms-appx:///Assets/MyTile/Square150x150Logo.png");

//Assign 3D model (only ms-appx and ms-appdata are allowed)
TileMixedRealityModel model = tile.VisualElements.MixedRealityModel;
model.Uri = new Uri("ms-appx:///Assets/MyTile/MixedRealityModel.glb");
model.ActivationBehavior = TileMixedRealityModelActivationBehavior.Default;
model.BoundingBox = new SpatialBoundingBox
{
    Center = new Vector3 { X = 1, Y = 0, Z = 0 },
    Extents = new Vector3 { X = 3, Y = 5, Z = 4 }
};

// And place it
await tile.RequestCreateAsync();

  Bounding boxBounding box

  Activation behaviorActivation behavior

NOTENOTE

  Obtaining and updating an existing “secondaryTile”Obtaining and updating an existing “secondaryTile”

Creating “secondaryTiles” from within an exclusive view is not currently supported.

A bounding box can be used to add an extra buffer region around the object. The bounding box is specified

using a center point and extents, which indicate the distance from the center of the bounding box to its edges

along each axis. Units for the bounding box can be mapped to 1 unit = 1 meter. If a bounding box isn't provided,

one will be automatically fitted to the mesh of the object. If the provided bounding box is smaller than the

model, it will be resized to fit the mesh.

This feature will be supported as of the Windows RS4 update. Make sure your application is targeting a version of the

Windows SDK greater than or equal to 10.0.17125 if you plan to use this feature

You can define the activation behavior for a 3D secondaryTile to control how it reacts when a user selects it. This

can be used to place 3D objects in the Mixed Reality home that are purely informative or decorative. The

following activation behavior types are supported:

1. Default: When a user selects the 3D secondaryTile the app is activated

2. None: When the user selects the 3D secondaryTile nothing happens and the app isn't activated.

Developers can get back a list of their existing secondary tiles, which includes the properties that they previously

specified. They can also update the properties by changing the value and then calling UpdateAsync().



// Grab the existing secondary tile
SecondaryTile tile = (await SecondaryTile.FindAllAsync()).First();

Uri updatedUri = new Uri("ms-appdata:///local/MixedRealityUpdated.glb");

// See if the model needs updating
if (!tile.VisualElements.MixedRealityModel.Uri.Equals(updatedUri))
{
    // Update it
    tile.VisualElements.MixedRealityModel.Uri = updatedUri;

    // And apply the changes
    await tile.UpdateAsync();
}

  Checking that the user is in Windows Mixed RealityChecking that the user is in Windows Mixed Reality

 Tile notifications

 See also

3D deep links (secondaryTiles) can only be created while the view is being displayed in a Windows Mixed Reality

headset. When your view isn't being presented in a Windows Mixed Reality headset, we recommend gracefully

handling this by either hiding the entry point or showing an error message. You can check this by querying

IsCurrentViewPresentedOnHolographic().

Tile notifications don't currently support sending an update with a 3D asset. This means that developers can't do

the following:

Push Notifications

Periodic Polling

Scheduled Notifications

For more information on the other tiles features and attributes and how they're used for 2D tiles, see the Tiles

for UWP Apps documentation.

Mixed reality model sample containing a 3D app launcher.

3D app launcher design guidance

Creating 3D models for use in the Windows Mixed Reality home

Implementing 3D app launchers (Win32 apps)

Navigating the Windows Mixed Reality home

https://docs.microsoft.com/en-us/uwp/api/windows.applicationmodel.preview.holographic.holographicapplicationpreview#windows_applicationmodel_preview_holographic_holographicapplicationpreview_iscurrentviewpresentedonholographicdisplay_
https://docs.microsoft.com/en-us/windows/uwp/controls-and-patterns/tiles-and-notifications-creating-tiles
https://github.com/Microsoft/Windows-universal-samples/tree/master/Samples/MixedRealityModel
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NOTENOTE

 3D app launcher creation process

 Configuring the 3D launcher

This feature is only available to PCs running the latest Windows Insider flights (RS5), build 17704 and newer.

The Windows Mixed Reality home is the starting point where users land before launching applications. By

default, you need to launch immersive Win32 VR apps and games from outside the headset and won't appear in

the "All apps" list on the Windows Mixed Reality Start menu. If you follow the instructions in this article to

implement a 3D app launcher, your immersive Win32 VR experience can be launched from within the Windows

Mixed Reality Start menu and home environment.

This is only true for immersive Win32 VR experiences distributed outside of Steam. For VR experiences

distributed through Steam, we've updated the Windows Mixed Reality for SteamVR Beta along with the latest

Windows Insider RS5 flights so that SteamVR titles show up in the Windows Mixed Reality Start menu in the "All

apps" list automatically using a default launcher. In other words, the method described in this article is

unnecessary for SteamVR titles and will be overridden by the Windows Mixed Reality for SteamVR Beta

functionality.

There are three steps to creating a 3D app launcher :

1. Designing and concepting

2. Modeling and exporting

3. Integrating it into your application (this article)

3D assets to be used as launchers for your application should be authored using the Windows Mixed Reality

authoring guidelines to ensure compatibility. Assets that fail to meet this authoring specification won't be

rendered in the Windows Mixed Reality home.

Win32 applications will appear in the "All apps" list on the Windows Mixed Reality Start menu if you create a 3D

app launcher for them. To do that, create a Visual Elements Manifest XML file referencing the 3D App Launcher

by following these steps:

1. Create a 3D App Launcher asset GLB file3D App Launcher asset GLB file (See Modeling and exporting).

2. Create a Visual Elements ManifestVisual Elements Manifest for your application.

a. You can start with the sample below. See the full Visual Elements Manifest documentation for more

details.

b. Update Square150x150LogoSquare150x150Logo and Square70x70LogoSquare70x70Logo with a PNG/JPG/GIF for your app.

These will be used for the app’s 2D logo in the Windows Mixed Reality All Apps list and for the

Start Menu on desktop.

The file path is based on the folder containing the Visual Elements Manifest.

You still need to provide a desktop Start Menu icon for your app through the standard

mechanisms. This can either be directly in the executable or in the shortcut you create. For

example, via IShellLink::SetIconLocation.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/distribute/implementing-3d-app-launchers-win32.md
https://insider.windows.com
https://steamcommunity.com/games/719950/announcements/detail/1687045485866139800
https://docs.microsoft.com/en-us/previous-versions/windows/apps/dn393983(v=win.10)
https://docs.microsoft.com/en-us/previous-versions/windows/apps/dn393983(v=win.10)
https://docs.microsoft.com/en-us/previous-versions/windows/apps/dn393983(v=win.10)


  Sample Visual Elements ManifestSample Visual Elements Manifest

<Application xmlns:xsi="https://www.w3.org/2001/XMLSchema-instance">
  <VisualElements
    ShowNameOnSquare150x150Logo="on"
    Square150x150Logo="YOUR_APP_LOGO_150X150.png"
    Square70x70Logo=" YOUR_APP_LOGO_70X70.png"
    ForegroundText="light"
    BackgroundColor="#000000">
    <MixedRealityModel Path="YOUR_3D_APP_LAUNCHER_ASSET.glb">
        <SpatialBoundingBox Center="0,0,0" Extents="Auto" />
    </MixedRealityModel>
  </VisualElements>
</Application>

  Sample app launcher shortcut creationSample app launcher shortcut creation

  Sample .LNK shortcut creation (C++)Sample .LNK shortcut creation (C++)

#include <windows.h>
#include <propkey.h>
#include <shlobj_core.h>
#include <shlwapi.h>
#include <propvarutil.h>
#include <wrl.h>

#include <memory>

using namespace Microsoft::WRL;

#define RETURN_IF_FAILED(x) do { HRESULT hr = x; if (FAILED(hr)) { return hr; } } while(0)
#define RETURN_IF_WIN32_BOOL_FALSE(x) do { DWORD res = x; if (res == 0) { return 
HRESULT_FROM_WIN32(GetLastError()); } } while(0)

3. Add a shor tcutAdd a shor tcut to your application to the desktop Windows Start Menu. See the sample below for an

example C++ implementation.

4. Optional: If your desktop shortcut doesn't point directly to your application’s EXE (for example, if it invokes a

custom protocol handler like “myapp://”), the Start Menu won’t automatically find the app’s

VisualElementsManifest.xml file. To resolve this, the shortcut should specify the file path of the Visual

Elements Manifest using System.AppUserModel.VisualElementsManifestHintPath (). This can be set in the

shortcut using the same techniques as System.AppUserModel.ID. You aren't required to use

System.AppUserModel.ID but you may do so if you wish for the shortcut to match the explicit Application

User Model ID of the application if one is used. See the sample app launcher shortcut creation section below

for a C++ sample.

c. Update the MixedRealityModel PathMixedRealityModel Path to point to the GLB for your 3D App Launcher

d. Save the file with the same name as your executable file, with an extension of

".VisualElementsManifest.xml" and save it in the same directory. For example, for the executable file

"contoso.exe", the accompanying XML file is named "contoso.visualelementsmanifest.xml".

Optional: You can use a resources.pri file if you would like for MRT to provide multiple asset

sizes for different resolution scales and high contrast themes.

Create it in %ALLUSERSPROFILE%\Microsoft\Windows\Start Menu\Programs (machine) or

%APPDATA%\Microsoft\Windows\Start Menu\Programs (user)

If an update changes your visual elements manifest or the assets referenced by it, the updater or

installer should update the shortcut such that the manifest is reparsed and cached assets are updated.

The sample code below shows how you can create a shortcut in C++, including overriding the path to the Visual

Elements Manifest XML file. Note the override is only required in cases where your shortcut doesn't point

directly to the EXE associated with the manifest (for example, your shortcut uses a custom protocol handler like

"myapp://").



int wmain()
{
    RETURN_IF_FAILED(CoInitializeEx(nullptr, COINIT_APARTMENTTHREADED));

    ComPtr<IShellLink> shellLink;
    RETURN_IF_FAILED(CoCreateInstance(__uuidof(ShellLink), nullptr, CLSCTX_INPROC_SERVER, 
IID_PPV_ARGS(&shellLink)));
    RETURN_IF_FAILED(shellLink->SetPath(L"MyLauncher://launch/app-identifier"));

    // It is also possible to use an icon file in another location. For example, "C:\Program Files 
(x86)\MyLauncher\assets\app-identifier.ico".
    RETURN_IF_FAILED(shellLink->SetIconLocation(L"C:\\Program Files (x86)\\MyLauncher\\apps\\app-
identifier\\game.exe", 0 /*iIcon*/));

    ComPtr<IPropertyStore> propStore;
    RETURN_IF_FAILED(shellLink.As(&propStore));

    {
        // Optional: If the application has an explict Application User Model ID, then you should usually 
specify it in the shortcut.
        PROPVARIANT propVar;
        RETURN_IF_FAILED(InitPropVariantFromString(L"ExplicitAppUserModelID", &propVar));
        RETURN_IF_FAILED(propStore->SetValue(PKEY_AppUserModel_ID, propVar));
        PropVariantClear(&propVar);
    }

    {
        // A hint path to the manifest is only necessary if the target path of the shortcut is not a file 
path to the executable.
        // By convention the manifest is named <executable name>.VisualElementsManifest.xml and is in the 
same folder as the executable
        // (and resources.pri if applicable). Assets referenced by the manifest are relative to the folder 
containing the manifest.

        //
        // PropKey.h
        //
        //  Name:     System.AppUserModel.VisualElementsManifestHintPath -- 
PKEY_AppUserModel_VisualElementsManifestHintPath
        //  Type:     String -- VT_LPWSTR  (For variants: VT_BSTR)
        //  FormatID: {9F4C2855-9F79-4B39-A8D0-E1D42DE1D5F3}, 31
        //  
        //  Suggests where to look for the VisualElementsManifest for a Win32 app
        //
        // DEFINE_PROPERTYKEY(PKEY_AppUserModel_VisualElementsManifestHintPath, 0x9F4C2855, 0x9F79, 0x4B39, 
0xA8, 0xD0, 0xE1, 0xD4, 0x2D, 0xE1, 0xD5, 0xF3, 31);
        // #define INIT_PKEY_AppUserModel_VisualElementsManifestHintPath { { 0x9F4C2855, 0x9F79, 0x4B39, 
0xA8, 0xD0, 0xE1, 0xD4, 0x2D, 0xE1, 0xD5, 0xF3 }, 31 }

        PROPVARIANT propVar;
        RETURN_IF_FAILED(InitPropVariantFromString(L"C:\\Program Files (x86)\\MyLauncher\\apps\\app-
identifier\\game.visualelementsmanifest.xml", &propVar));
        RETURN_IF_FAILED(propStore->SetValue(PKEY_AppUserModel_VisualElementsManifestHintPath, propVar));
        PropVariantClear(&propVar);
    }

    constexpr PCWSTR shortcutPath = L"%APPDATA%\\Microsoft\\Windows\\Start Menu\\Programs\\game.lnk";
    const DWORD requiredBufferLength = ExpandEnvironmentStrings(shortcutPath, nullptr, 0);
    RETURN_IF_WIN32_BOOL_FALSE(requiredBufferLength);

    const auto expandedShortcutPath = std::make_unique<wchar_t[]>(requiredBufferLength);
    RETURN_IF_WIN32_BOOL_FALSE(ExpandEnvironmentStrings(shortcutPath, expandedShortcutPath.get(), 
requiredBufferLength));

    ComPtr<IPersistFile> persistFile;
    RETURN_IF_FAILED(shellLink.As(&persistFile));
    RETURN_IF_FAILED(persistFile->Save(expandedShortcutPath.get(), FALSE));



    return 0;
}

  Sample .URL launcher shortcutSample .URL launcher shortcut

[{9F4C2855-9F79-4B39-A8D0-E1D42DE1D5F3}]
Prop31=C:\Program Files (x86)\MyLauncher\apps\app-identifier\game.visualelementsmanifest.xml
Prop5=ExplicitAppUserModelID

[{000214A0-0000-0000-C000-000000000046}]
Prop3=19,0

[InternetShortcut]
IDList=
URL=MyLauncher://launch/app-identifier
IconFile=C:\Program Files (x86)\MyLauncher\apps\app-identifier\game.exe
IconIndex=0

 See also
Mixed reality model sample containing a 3D app launcher.

3D app launcher design guidance

Creating 3D models for use in the Windows Mixed Reality home

Implementing 3D app launchers (UWP apps)

Navigating the Windows Mixed Reality home

https://github.com/Microsoft/Windows-universal-samples/tree/master/Samples/MixedRealityModel
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NOTENOTE

 Device support

FeatureFeature HoloLensHoloLens Immersive headsetsImmersive headsets

Add model protocol ✔️ ✔️

 The basics

 Implementing the add model protocol

ms-mixedreality:addmodel?uri=<Path to a .glb 3D model either local or remote>

  Invoking the Invoking the add model protocoladd model protocol from a Universal Windows Platform app: from a Universal Windows Platform app:

This feature was added as part of the Windows 10 April 2018 Update. Older versions of Windows are not compatible with

this feature.

The Windows Mixed Reality home is the starting point where users land before launching applications. In some

scenarios, 2D apps (like the Holograms app) enable placement of 3D models directly into the mixed reality

home as decorations or for further inspection in full 3D. The add model protocol allows you to send a 3D model

from your website or application directly into the Windows Mixed Reality home, where it will persist like 3D app

launchers, 2D apps, and holograms.

For example, if you're developing an application that surfaces a catalog of 3D furniture for designing a space,

use the add model protocol to allow users to place those 3D furniture models from the catalog. Once placed in

the world, users can move, resize, and remove these 3D models just like other holograms in the home. This

article provides an overview of implementing the add model protocol for enabling users to decorate their world

with 3D objects from your app or the web.

There are two steps to enabling the placement of 3D models in the Windows Mixed Reality home:

1. Ensure your 3D model is compatible with the Windows Mixed Reality home.

2. Implement the add model protocol in your application or webpage (this article).

Once you have a compatible 3D model, you can implement the add model protocol by activating the following

URI from any webpage or application:

If the URI points to a remote resource, then it will automatically be downloaded and placed in the home. Local

resources will be copied to the mixed reality home's app data folder before being placed in the home. We

recommend designing your experience to account for scenarios where the user might be running an older

version of Windows that doesn't support this feature by hiding the button or disabling it if possible.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/distribute/enable-placement-of-3d-models-in-the-home.md
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/release-notes-april-2018
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


private async void launchURI_Click(object sender, RoutedEventArgs e)
{
   // Define the add model URI
   var uriAddModel = new Uri(@"ms-mixedreality:addModel?uri=sample.glb");

   // Launch the URI to invoke the placement
   var success = await Windows.System.Launcher.LaunchUriAsync(uriAddModel);

   if (success)
   {
      // URI launched
   }
   else
   {
      // URI launch failed
   }
}

  Invoking the Invoking the add model protocoladd model protocol from a webpage: from a webpage:

<a class="btn btn-default" href="ms-mixedreality:addModel?uri=sample.glb"> Place 3D Model </a>

 Considerations for immersive (VR) headsets

 See also

For immersive (VR) headsets, the Mixed Reality Portal doesn't have to be running before invoking the add

model protocol. In this case, the add model protocol will launch the Mixed Reality Portal and place the object

directly where the headset is looking once you arrive in the mixed reality home.

When invoking the add model protocol from the desktop with the Mixed Reality Portal already running,

ensure that the headset is "awake". If not, the placement won't succeed.

Creating 3D models for use in the Windows Mixed Reality home

Navigating the Windows Mixed Reality home
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HoloLens supports in-app purchases (IAPs), but there's some work to set them up.

To use the in app-purchase functionality:

1. Create a XAML 2D view to appear as a slate.

2. Switch to the XAML view to activate placement, which leaves the immersive view.

3. Call the RequestProductPurchaseAsync API:

await CurrentApp.RequestProductPurchaseAsync("DurableItemIAPName");

The RequestProductPurchaseAsync  API brings up the stock Windows OS popup that shows the in-app

purchase name, description, and price. The user can then choose purchase options.

4. Once the user completes the purchase, present UI that lets the user switch back to the app's immersive

view.

Apps that target desktop-based Windows Mixed Reality immersive headsets don't need to manually switch to a

XAML view before they call the RequestProductPurchaseAsync  API.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/distribute/in-app-purchases.md
https://docs.microsoft.com/en-us/uwp/api/windows.applicationmodel.store.currentapp.requestproductpurchaseasync#windows-applicationmodel-store-currentapp-requestproductpurchaseasync(system-string)
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IMPORTANTIMPORTANT

 Prerequisites

IMPORTANTIMPORTANT

 Packaging a Mixed Reality app

  Prepare image assets included in the appxPrepare image assets included in the appx

REQ UIRED A SSETREQ UIRED A SSET REC O M M EN DED SC A L EREC O M M EN DED SC A L E IM A GE F O RM ATIM A GE F O RM AT
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Square 71x71 Logo Any PNG N/A

If you're submitting an Unreal application, make sure you follow the publishing instructionspublishing instructions before continuing.

Both HoloLens and the Windows 10 PC powering your immersive headset run Universal Windows Platform

apps. Whether you're submitting an app that supports HoloLens, PC, or both, app submission goes through the

Partner Center.

If you don't already have a Partner Center developer account, sign up for one before moving on. You can find

more information about submission guidelines and checklists in this app submissions article.

You won't be able to submit any applications to the Microsoft Store if your Partner Center developer account fails the

employment verification check. Please contact the Partner Center support team for more details.

There are several steps to packaging a Mixed Reality application, including:

Correctly preparing all image assets

Choosing the tile image displayed in the HoloLens Start menu

Setting the target and minimum Windows version for the app

Setting the target device families in the app dependencies

Adding metadata to associate the app with the Microsoft Store

Creating an upload package

Each of these submission stages is covered in its own section below - we recommend going through them

sequentially you don't leave any out on your first submission attempt.

The following image assets are required for the appx building tools to build your application into an appx

package, which is required for submission to the Microsoft Store. You can learn more about guidelines for tile

and icon assets on MSDN.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/distribute/submitting-an-app-to-the-microsoft-store.md
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://partner.microsoft.com/dashboard
https://developer.microsoft.com/store/register
https://docs.microsoft.com/en-us/windows/uwp/publish/app-submissions
https://developer.microsoft.com/windows/support
https://docs.microsoft.com/en-us/windows/uwp/app-resources/images-tailored-for-scale-theme-contrast
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Wide 310x150 Logo Any PNG N/A

Store Logo 75x75 (150% scale) PNG Partner Center, Report App,
Write a Review, My Library

Splash Screen 930x450 (150% scale) PNG 2D app launcher (slate)
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  Live Tile requirementsLive Tile requirements

  Specifying target and minimum version of WindowsSpecifying target and minimum version of Windows

  Specifying target device familiesSpecifying target device families

If you're developing for HoloLens, there are other recommended assets that you can take advantage of:

The Start menu on HoloLens will use the largest included square tile image by default. Apps published by

Microsoft have an optional 3D launcher, which you can add to your app by following the 3D app launcher

implementation instructions.

If your Mixed Reality app includes features that are specific to a Windows version, it's important to specify the

supported target and minimum platform versions.

Pay special attention for apps targeting Pay special attention for apps targeting Windows Mixed Reality immersive headsetsWindows Mixed Reality immersive headsets , which require, which require

at least the Windows 10 Fall Creators Update (10.0; Build 16299) to function properly.at least the Windows 10 Fall Creators Update (10.0; Build 16299) to function properly.

You'll be prompted to set the target and minimum version of Windows when you create a new Universal

Windows Project in Visual Studio. For existing projects, you can change this setting in the ProjectProject menu by

selecting the <Your app name's> Proper ties<Your app name's> Proper ties  at the bottom of the drop-down menu.

Setting minimum and target platform versions in Visual Studio

Windows Mixed Reality applications (for both HoloLens and immersive headsets) are part of the Universal

Windows Platform, so any app package with a Windows.UniversalWindows.Universal  target device family can run on HoloLens

or Windows 10 PCs with immersive headsets. If you don't specify a target device family in your app manifest,

you may inadvertently open your app up to unintended Windows 10 devices. Follow the steps below to specify

the intended Windows 10 device family, then double-check you've set the correct device families when you

upload your app package in Partner Center for Microsoft Store submission.

https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details
https://docs.microsoft.com/en-us/uwp/schemas/appxpackage/uapmanifestschema/element-targetdevicefamily


<Dependencies>
   <TargetDeviceFamily Name="Windows.Universal" MinVersion="10.0.10240.0" MaxVersionTested="10.0.10586.0" />
</Dependencies>

<Dependencies>
   <TargetDeviceFamily Name="Windows.Holographic" MinVersion="10.0.10240.0" MaxVersionTested="10.0.10586.0" 
/>
</Dependencies>

<Dependencies>
   <TargetDeviceFamily Name="Windows.Holographic" MinVersion="10.0.18362.0" MaxVersionTested="10.0.18362.0" 
/>
</Dependencies>

<Dependencies>
   <TargetDeviceFamily Name="Windows.Desktop" MinVersion="10.0.16299.0" MaxVersionTested="10.0.16299.0" />
</Dependencies>

<Dependencies>
   <TargetDeviceFamily Name="Windows.Desktop" MinVersion="10.0.16299.0" MaxVersionTested="10.0.16299.0" />
   <TargetDeviceFamily Name="Windows.Holographic" MinVersion="10.0.10240.0" MaxVersionTested="10.0.10586.0" 
/>
</Dependencies>

  Associate app with the StoreAssociate app with the Store

To set this field in Visual Studio, right-click on the Package.appxmanifestPackage.appxmanifest and select View CodeView Code, then find

the TargetDeviceFamily NameTargetDeviceFamily Name field. By default, it should look like the following entry:

If you're creating a HoloLensHoloLens  app, you can make sure it's only installed on HoloLens by setting the target

device family to Windows.HolographicWindows.Holographic:

If your app requires HoloLens 2HoloLens 2  functionality, like eye or hand-tracking, you can make sure it's targeted to

Windows versions 18362 or greater by setting the target device family to Windows.HolographicWindows.Holographic with a

MinVersionMinVersion of 10.0.18362.0:

If your app is created for Windows Mixed Reality immersive headsetsWindows Mixed Reality immersive headsets , you can make sure it's only

installed on Windows 10 PCs with the Windows 10 Fall Creators Update (necessary for Windows Mixed

Reality) by setting the target device family to Windows.DesktopWindows.Desktop with a MinVersionMinVersion of 10.0.16299.0:

Finally, if your app is intended to run on both HoloLensHoloLens  and Windows Mixed Reality immersiveWindows Mixed Reality immersive

headsetsheadsets , you can make sure the app is only available to those two device families and simultaneously

ensure that each target has the correct minimum Windows version by including a line for each target device

family with its respective MinVersion:

You can learn more about targeting device families by reading the TargetDeviceFamily UWP documentation.

When you associate your app with the Microsoft Store, the following values are downloaded to the current

projects local app manifest file:

Package Display Name

Package Name

Publisher ID

Publisher Display Name

https://docs.microsoft.com/en-us/uwp/schemas/appxpackage/uapmanifestschema/element-targetdevicefamily


  Creating an upload packageCreating an upload package

NOTENOTE

NOTENOTE

 Testing your app
  Windows App Certification KitWindows App Certification Kit

Version

If you're overriding the default package.appxmanifest file with your own custom .xml file, you can’t associate

your app with the Microsoft Store. Associating a custom manifest file with the Store will result in an error

message.

You can also test purchase and notification scenarios by going to your Visual Studio solution and selecting

Project > Store > Associate App with the StoreProject > Store > Associate App with the Store.

Follow guidelines at Packaging Universal Windows apps for Windows 10.

The final step of creating an upload package is validating the package using the Windows App Certification Kit.

If you're adding a HoloLens-specific package to an existing product that's available on other Windows 10 device

families, pay attention to:

How version numbers may impact which packages are delivered to specific customers

How packages are distributed to different operating systems

The general guidance is that the package with the highest version number for a device is the one distributed by

the Store.

In a scenario where there's a Windows.UniversalWindows.Universal  package and a Windows.HolographicWindows.Holographic package, and the

Windows.Universal package has a higher version number, a HoloLens user will download the higher version

number Windows.Universal package instead of the Windows.Holographic package.

In cases where the above scenario isn't the outcome you're looking for, there are several available solutions:

Ensure your platform-specific packages, such as Windows.Holographic, always have a higher version number

than your platform agnostic packages like Windows.Universal

Don't package apps as Windows.Universal if you also have platform-specific packages - instead package the

Windows.Universal package for the specific platforms you want it available on

Create a single Windows.Universal package that works across all platforms. Support for this option isn't

great right now so the above solutions are recommended.

To support your app on both HoloLens (1st Gen) and HoloLen 2, you need to upload two app packages; one containing

x86 for HoloLens (1st Gen) and one containing ARM or ARM64 for HoloLens 2.

If you include both ARM and ARM64 in your package, the ARM64 version will be the one used on HoloLens 2.

You can declare a single package to be applicable to multiple target device families

When you create app packages to submit to Partner Center through Visual Studio, the Create App Packages

wizard prompts you to run the Windows App Certification Kit against the packages that get created. To have a

smooth submission process to the Store, it's best to verify that the local copy of your app passes the Windows

App Certification Kit tests before submitting them to the Store. Running the Windows App Certification Kit on a

remote HoloLens isn't currently supported.

https://docs.microsoft.com/en-us/previous-versions/windows/apps/hh454036(v=vs.140)#anchor_2
https://docs.microsoft.com/en-us/windows/uwp/publish/package-version-numbering
https://docs.microsoft.com/en-us/windows/uwp/publish/guidance-for-app-package-management
https://docs.microsoft.com/en-us/previous-versions/windows/apps/jj657973(v=win.10)


  Run on all targeted device familiesRun on all targeted device families

 Submitting your Mixed Reality app to the Store

  Mixed Reality product declarationsMixed Reality product declarations

The Windows Universal Platform allows you to create a single application that runs across all of the Windows 10

device families. However, it doesn't guarantee that Universal Windows apps will just work on all device families.

It's important to test your app on each of your chosen device families to ensure a good experience.

In general, submitting a Windows Mixed Reality app that works on HoloLens or immersive headsets is just like

submitting any UWP app to the Microsoft Store. Once you've created your app by reserving its name, follow the

UWP submission checklist.

One of the first things you'll do is select a category and subcategory for your Mixed Reality experience. It's

important that you choose the most accurate categor y for your appchoose the most accurate categor y for your app. Categories help merchandise your

application in the right Store categories and ensure it shows up using relevant search queries. L isting your VRListing your VR

title as a game won't result in better exposure for your app,title as a game won't result in better exposure for your app, and may prevent it from showing up in

categories that are more fitting and less crowded.

However, there are four key areas in the submission process where you'll want to make Mixed Reality-specific

selections:

1. In the Product declarationsProduct declarations  section under Properties.

2. In the System requirementsSystem requirements  section under Properties.

3. In the Device family availabilityDevice family availability  section under Packages.

4. In several of the Store listing pageStore listing page fields.

On the Proper tiesProper ties  page of the app submission process, you'll find several options related to Mixed Reality in

the Product declarationsProduct declarations  section.

Mixed Reality product declarations

First, you need to identify the device types for which your app offers a Mixed Reality experience. Identifying

device types ensures that your app is included in Windows Mixed Reality collections in the Store.

Next to "This experience is designed for Windows Mixed Reality on:"

Check the PCPC box if your app offers a VR experience when an immersive headset is connected to the user's

PC. We recommend checking this box whether your app is set to run exclusively on an immersive headset or

if it's a standard PC game or app offering a Mixed Reality mode or bonus content when a headset is

connected.

Check the HoloLensHoloLens  box only if your app offers a holographic experience when it's run on HoloLens.

Check bothboth boxes if your app offers a Mixed Reality experience on both device types.

If you selected "PC" above, you'll want to set the "Mixed Reality setup" (activity level). This only applies to Mixed

Reality experiences that run on PCs connected to immersive headsets, as Mixed Reality apps on HoloLens are

https://docs.microsoft.com/en-us/windows/uwp/publish/create-your-app-by-reserving-a-name
https://docs.microsoft.com/en-us/windows/uwp/publish/app-submissions
https://docs.microsoft.com/en-us/windows/uwp/publish/category-and-subcategory-table
https://docs.microsoft.com/en-us/windows/uwp/publish/enter-app-properties
https://docs.microsoft.com/en-us/windows/uwp/publish/enter-app-properties
https://docs.microsoft.com/en-us/windows/uwp/publish/upload-app-packages
https://docs.microsoft.com/en-us/windows/uwp/publish/enter-app-properties
https://docs.microsoft.com/en-us/windows/uwp/publish/app-declarations


  Mixed Reality system requirementsMixed Reality system requirements

world-scale and the user doesn't define a boundary during setup.

Choose Seated + standingSeated + standing if you designed your app to have the user stay in one position. For example, in a

game where you're in control of an aircraft cockpit.

Choose All experiencesAll experiences  if your app is designed with the intention that the user walks around within a set

boundary defined during setup. For example, might be a game where you side-step and duck to dodge

attacks.

On the Proper tiesProper ties  page of the app submission process, you'll find several options related to Mixed Reality in

the System requirementsSystem requirements  section.

System requirements

In this section, you'll identify minimum (required) hardware and recommended (optional) hardware for your

Mixed Reality app.

Input hardware:Input hardware:

Use the checkboxes to tell potential customers if your app supports microphonemicrophone for voice input), XboxXbox

controller  or gamepadcontroller  or gamepad, or Windows Mixed Reality motion controllersWindows Mixed Reality motion controllers . This information will be surfaced

on your app's product detail page in the Store and will help your app get included in the appropriate app/game

collections. For example, a collection may exist for all games that support motion controllers.

Be thoughtful about selecting checkboxes for "minimum hardware" or "recommended hardware" for input types.

For example:

If your game requires motion controllers, but accepts voice input via microphone, select the "minimum

hardware" checkbox next to "Windows Mixed Reality motion controllers," but the "recommended hardware"

checkbox next to "Microphone."

If your game can be played with either an Xbox controller, gamepad, or motion controllers, you might select

the "minimum hardware" checkbox next to "Xbox controller or gamepad" and select the "recommended

hardware" checkbox next to "Windows Mixed Reality motion controllers" as motion controllers will likely

offer a step-up in experience from the gamepad.

Windows Mixed Reality immersive headset:Windows Mixed Reality immersive headset:

Indicating whether an immersive headset is required to use your app, or is optional, is critical to customer

https://docs.microsoft.com/en-us/windows/uwp/publish/enter-app-properties
https://docs.microsoft.com/en-us/windows/uwp/publish/enter-app-properties#system-requirements


  Device family availabilityDevice family availability

TIPTIP

satisfaction and education.

If your app can only be used through an immersive headset, select the "minimum hardware" checkbox next to

"Windows Mixed Reality immersive headset." This will be surfaced on your app's product detail page in Store as

a warning above the purchase button so customers don't think they're purchasing an app that will function on

their PC like a traditional desktop app.

If your app runs on the desktop like a traditional PC app, but offers a VR experience when an immersive headset

is connected (whether the full content of your app is available, or only a portion), select the "recommended

hardware" checkbox next to "Windows Mixed Reality immersive headset." No warning will be surfaced above the

purchase button on your app's product detail page if your app functions as a traditional desktop app without an

immersive headset connected.

PC specifications:PC specifications:

If you want your app to reach as many Windows Mixed Reality immersive headset users as possible, target the

PC specifications for Windows Mixed Reality PCs with integrated graphics.

Whether your Mixed Reality app targets the minimum Windows Mixed Reality PC requirements, or needs a

specific PC configuration like the dedicated GPU of a Windows Mixed Reality Ultra PC, you should add the

relevant PC specifications in the "minimum hardware" column.

If your Mixed Reality app is designed for better performance or offers higher-resolution graphics on a particular

PC configuration or graphics card, you should include the relevant PC specifications in the "recommended

hardware" column.

This only applies if your Mixed Reality app uses an immersive headset connected to a PC. If your Mixed Reality

app only runs on HoloLens, you won't need to indicate PC specifications as HoloLens has only one hardware

configuration.

If you've packaged your app correctly in Visual Studio, uploading it on the Packages page should produce a table

with the available device families.

Device family availability table

If your Mixed Reality app works on immersive headsets, then at least "Windows 10 Desktop" should be selected

in the table. If your Mixed Reality app works on HoloLens, then at least "Windows 10 Holographic" should be

selected. If your app runs on both Windows Mixed Reality headset types, both "Windows 10 Desktop" and

"Windows 10 Holographic" should be selected.

Many developers run into errors when uploading their app's package related to mismatches between the package

manifest and your app/publisher account information in Partner Center. These errors can often be avoided by signing into

Visual Studio with the same account associated with your Windows developer account (the one you use to sign into

Partner Center). If you use the same account, you'll be able to associate your app with its identity in the Microsoft Store

before you package it.

https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/windows-mixed-reality-minimum-pc-hardware-compatibility-guidelines
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/windows-mixed-reality-minimum-pc-hardware-compatibility-guidelines
https://docs.microsoft.com/en-us/windows/uwp/publish/app-package-requirements


  Store listing pageStore listing page

IMPORTANTIMPORTANT

 Offering a free trial for your game or app

Associate your app with the Microsoft Store in Visual Studio

On the Store listing page of the app submission process, there are several places you can add useful information

about your Mixed Reality app.

To ensure your app is correctly categorized by the Store and made discoverable to Windows Mixed Reality customers, you

should add "Windows Mixed Reality""Windows Mixed Reality" as one of your "Search terms" for the app (you can find search terms by

expanding the "Shared fields" section).

Add "Windows Mixed Reality" to search terms

In many cases, your consumers will have limited to no experience with virtual reality before they buy a Windows

Mixed Reality immersive headset. They may not know what to expect from intense games or be familiar with

their own comfort threshold in immersive experiences. Many customers may also try a Windows Mixed Reality

https://docs.microsoft.com/en-us/windows/uwp/publish/create-app-store-listings


 See also

immersive headset on PCs that aren't badged as Windows Mixed Reality PCs. Because of these considerations,

we strongly recommend you consider offering a free trial for your paid Mixed Reality app or game.

What is Mixed Reality?

Development overview

App views

Understanding Performance for Mixed Reality

Performance Recommendations for Unity

Testing your app on HoloLens

Windows Mixed Reality minimum PC hardware compatibility guidelines

https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/windows-mixed-reality-minimum-pc-hardware-compatibility-guidelines
https://docs.microsoft.com/en-us/windows/uwp/publish/set-app-pricing-and-availability#free-trial
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/windows-mixed-reality-minimum-pc-hardware-compatibility-guidelines
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 Available repos

REP O SITO RY  N A M EREP O SITO RY  N A M E URLURL

AltspaceVR MicrosoftDocs/altspace-vr

Azure Object Anchors MicrosoftDocs/azure-docs/articles/object-anchors

Azure Remote Rendering MicrosoftDocs/azure-docs/articles/remote-rendering

Azure Spatial Anchors MicrosoftDocs/azure-docs/articles/spatial-anchors

HoloLens MicrosoftDocs/HoloLens

Mixed Reality MicrosoftDocs/mixed-reality

VR Enthusiasts Guide MicrosoftDocs/mixed-reality/enthusiast-guide

 Before you start

NOTENOTE

Welcome to the public repo for Mixed Reality developer documentation! Any articles you create or edit in this

repo will be visible to the public.will be visible to the public.

The Mixed Reality docs are now on the docs.microsoft.com platform, which uses GitHub-flavored Markdown

with Markdig features. The content you edit in this repo gets formatted into stylized pages that show up at

</windows/mixed-reality>.

This page covers the basic steps and guidelines for contributing and links to Markdown basics. Thank you for

your contribution!

If you don't already have one, you'll need to create a GitHub account.

If you're a Microsoft employee, link your GitHub account to your Microsoft alias on the Microsoft Open Source portal.

Join the "Microsoft""Microsoft" and "MicrosoftDocs""MicrosoftDocs" organizations.

When setting up your GitHub account, we also recommend these security precautions:

Create a strong password for your Github account.

Enable two-factor authentication.

Save your recovery codes in a safe place.

Update your public profile settings.

Set your name, and consider setting your Public email to Don't show my email address.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/CONTRIBUTING.md
https://github.com/MicrosoftDocs/mixed-reality/tree/master/mixed-reality-docs
https://github.com/MicrosoftDocs/altspace-vr
https://github.com/MicrosoftDocs/azure-docs/tree/master/articles/object-anchors
https://github.com/MicrosoftDocs/azure-docs/tree/master/articles/remote-rendering
https://github.com/MicrosoftDocs/azure-docs/tree/master/articles/spatial-anchors
https://github.com/MicrosoftDocs/Hololens
https://github.com/MicrosoftDocs/mixed-reality
https://github.com/MicrosoftDocs/mixed-reality/tree/docs/enthusiast-guide
https://github.com/join
https://repos.opensource.microsoft.com/
https://github.com/settings/admin
https://github.com/settings/two_factor_authentication/configure
https://github.com/settings/auth/recovery-codes
https://github.com/settings/profile


 Editing an existing article

 Renaming or deleting an existing article

If you plan to use the command line, consider setting up Git Credential Manager for Windows. That way, you

won't have to enter your password every time you make a contribution.

We recommend you upload a profile picture because a thumbnail is shown on docs pages you

contribute to.

The publishing system is tied to GitHub, so these steps are important. You'll be listed as either author or

contributor to each article using your GitHub alias.

Use the following workflow to make updates to an existing article via GitHub in a web browser :

1. Navigate to the article you wish to edit in the "mixed-reality-docs" folder.

2. Select the edit button (pencil icon) in the top right, which will automatically fork a disposable branch off

the 'master' branch.

3. Edit the content of the article according to the "Markdown basics".

4. Update metadata at the top of each article:

titletitle: Page title that appears in the browser tab when the article is being viewed. Page titles are used

for SEO and indexing, so don't change the title unless necessary (though this is less critical before

documentation goes public).

descr iptiondescr iption: Write a brief description of the article's content, which boosts SEO and discovery.

authorauthor : If you're the primary owner of the page, add your GitHub alias here.

ms.authorms.author : If you're the primary owner of the page, add your Microsoft alias here (you don't need

@microsoft.com, just the alias).

ms.datems.date: Update the date if you're adding major content to the page, but not for fixes like clarification,

formatting, grammar, or spelling.

keywordskeywords : Keywords aid in SEO (search engine optimization). Add keywords, separated by a comma

and a space, that are specific to your article, but no punctuation after the last keyword in your list. You

don't need to add global keywords that apply to all articles, as those are managed elsewhere.

5. When you've completed your article edits, scroll down and select Propose file changePropose file change.

6. On the next page, select Create pull requestCreate pull request to merge your automatically created branch into 'master.'

7. Repeat the steps above for the next article you want to edit.

If your change will rename or delete an existing article, be sure to add a redirect. That way, anyone with a link to

the existing article will still end up in the right place. Redirects are managed by the

.openpublishing.redirection.json file in the root of the repo.

To add a redirect to .openpublishing.redirection.json, add an entry to the redirections  array:

https://github.com/Microsoft/Git-Credential-Manager-for-Windows/releases/latest


{
    "redirections": [
        {
            "source_path": "mixed-reality-docs/old-article.md",
            "redirect_url": "new-article#section-about-old-topic",
            "redirect_document_id": false
        },

 Creating a new article

The source_path  is the relative repository path to the old article that you're removing. Be sure the path starts

with mixed-reality-docs  and ends with .md .

The redirect_url  is the relative public URL from the old article to the new article. Be sure that this URL

doesn'tdoesn't contain mixed-reality-docs  or .md , as it refers to the public URL and not the repository path.

Linking to a section within the new article using #section  is allowed. You can also use an absolute path to

another site here, if necessary.

redirect_document_id  indicates whether you would like to keep the document ID from the previous file. The

default is false . Use true  if you want to preserve the ms.documentid  attribute value from the redirected

article. If you preserve the document ID, data, such as page views and rankings, will be transferred to the

target article. Do this if the redirect is primarily a rename, and not a pointer to different article that only

covers some of the same content.

If you add a redirect, be sure to delete the old file as well.

Use the following workflow to create new articles in the documentation repo via GitHub in a web browser :

IMPORTANTIMPORTANT

1. Create a fork off the MicrosoftDocs/mixed-reality 'master' branch (using the ForkFork button in the top right).

2. In the "mixed-reality-docs" folder, select Create new fileCreate new file in the top right.

3. Create a page name for the article (use hyphens instead of spaces and don't use punctuation or

apostrophes) and append ".md"

Make sure you create the new article from within the "mixed-reality-docs" folder. You can confirm this by checking

for "/mixed-reality-docs/" in the new file name line.

4. At the top of your new page, add the following metadata block:



 Markdown basics

  Adding tablesAdding tables

  Adding imagesAdding images

---
title:
description:
author:
ms.author:
ms.date:
ms.topic: article
keywords:
---

5. Fill in the relevant metadata fields per the instructions in the section above.

6. Write article content using Markdown basics.

7. Add a ## See also  section at the bottom of the article with links to other relevant articles.

8. When finished, select Commit new fileCommit new file.

9. Select New pull requestNew pull request and merge your fork's 'master' branch into MicrosoftDocs/mixed-reality

'master' (make sure the arrow is pointing the correct way).

The following resources will help you learn how to edit documentation using the Markdown language:

Markdown basics

Markdown-at-a-glance reference poster

Additional resources for writing Markdown for docs.microsoft.com

Because of the way docs.microsoft.com styles tables, they won’t have borders or custom styles, even if you try

inline CSS. It will appear to work for a short period of time, but eventually the platform will strip the styling out

of the table. So plan ahead and keep your tables simple. Here’s a site that makes Markdown tables easy.

The Docs Markdown Extension for Visual Studio Code also makes table generation easy if you're using Visual

Studio Code (see below) to edit the documentation.

You’ll need to upload your images to the "mixed-reality-docs/images" folder in the repo, and then reference

them appropriately in the article. Images will automatically show up at full-size, which means large images will

fill the entire width of the article. We recommend pre-sizing your images before uploading them. The

recommended width is between 600 and 700 pixels, though you should size up or down if it’s a dense

screenshot or a fraction of a screenshot, respectively.

https://help.github.com/articles/basic-writing-and-formatting-syntax/
file:///C:/localrun/t/fs14/bgqa/windows/mixed-reality/images/markdownposter.pdf
https://docs.microsoft.com/en-us/contribute/how-to-write-use-markdown
https://www.tablesgenerator.com/markdown_tables
https://docs.microsoft.com/en-us/teamblog/docs-extension
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 Previewing your work

NOTENOTE

 Editing in the browser vs. editing with a desktop client

 Using Visual Studio Code

  SetupSetup

You can only upload images to your forked repo before merging. So, if you plan on adding images to an article, you'll

need to use Visual Studio Code to add the images to your fork's "images" folder first or make sure you've done the

following in a web browser:

1. Forked the MicrosoftDocs/mixed-reality repo.

2. Edited the article in your fork.

3. Uploaded the images you're referencing in your article to the "mixed-reality-docs/images" folder in your fork.

4. Created a pull requestpull request  to merge your fork into the MicrosoftDocs/mixed-reality 'master' branch.

To learn how to set up your own forked repo, follow the instructions for creating a new article.

While editing in GitHub via a web browser, you can select the PreviewPreview  tab near the top of the page to preview

your work before committing.

Previewing your changes on review.docs.microsoft.com is only available to Microsoft employees

Microsoft employees: once your contributions have been merged into the 'main' branch, you can review the

content before it goes public at https://review.docs.microsoft.com/windows/mixed-reality?branch=main. Find

your article using the table of contents in the left column.

Editing in the browser is the easiest way to make quick changes, however, there are a few disadvantages:

You don't get spell-check.

You don't get any smart-linking to other articles (you have to manually type the article's filename).

It can be a hassle to upload and reference images.

If you'd rather not deal with these issues, use a desktop client like Visual Studio Code with a couple helpful

extensions when contributing.

For the reasons listed above, you may prefer using a desktop client to edit documentation instead of a web

browser. We recommend using Visual Studio Code.

Follow these steps to configure Visual Studio Code to work with this repo:

1. In a web browser :

2. Create a local clone of your fork in Visual Studio Code:

a. Install Git for your PC.

b. Install Visual Studio Code.

c. Fork MicrosoftDocs/mixed-reality if you haven't already.

d. In your fork, select Clone or downloadClone or download and copy the URL.

a. From the ViewView  menu, select Command PaletteCommand Palette.

b. Type "Git: Clone."

https://review.docs.microsoft.com/windows/mixed-reality?branch=main
https://code.visualstudio.com/
https://code.visualstudio.com/
https://git-scm.com/downloads
https://code.visualstudio.com/


  Editing documentationEditing documentation

NOTENOTE

c. Paste the URL you copied.

d. Choose where to save the clone on your PC.

e. Select Open repoOpen repo in the pop-up.

Use the following workflow to make changes to the documentation with Visual Studio Code:

All the guidance for editing and creating articles, and the basics of editing Markdown, from above applies when using

Visual Studio Code as well.

1. Make sure your cloned fork is up to date with the official repo.

a. In a web browser, create a pull request to sync recent changes from other contributors in

MicrosoftDocs/mixed-reality 'master' to your fork (make sure the arrow is pointing the right way).

b. In Visual Studio Code, select the sync button to sync your freshly updated fork to the local clone.

2. Create or edit articles in your cloned repo using Visual Studio Code.

a. Edit one or more articles (add images to “images” folder if necessary).

b. SaveSave changes in ExplorerExplorer .

c. Commit allCommit all  changes in Source ControlSource Control  (write commit message when prompted).

d. Select the syncsync button to sync your changes back to origin (your fork on GitHub).



  Useful extensionsUseful extensions

3. In a web browser, create a pull request to sync new changes in your fork back to MicrosoftDocs/mixed-

reality 'master' (make sure the arrow is pointing the correct way).

The following Visual Studio Code extensions are useful when editing documentation:

Docs Markdown Extension for Visual Studio Code - Use Alt+MAlt+M to bring up a menu of docs authoring options

like:

Code Spell Checker - misspelled words will be underlined; right-click on a misspelled word to change it or

save it to the dictionary.

Search and reference images you've uploaded.

Add formatting like lists, tables, and docs-specific call-outs like >[!NOTE] .

Search and reference internal links and bookmarks (links to specific sections within a page).

Formatting errors are highlighted (hover your mouse over the error to learn more).

https://marketplace.visualstudio.com/items?itemName=docsmsft.docs-authoring-pack
https://marketplace.visualstudio.com/items?itemName=streetsidesoftware.code-spell-checker
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Episode 1: Paths into Mixed Reality
development

See on-demand video Come learn the lay of the land for
getting started with XR development.
We'll explore programming languages,
engine options, device options, low
code/no-code solutions, and general
advice for getting started.

Episode 2: Plan & design your Mixed
Reality app

See on-demand video So, you have a great idea for an app
but now what? Before heading into
development, there's a lot to consider
to ensure your app experience is well
thought out and accessibly sound.
Learn techniques and tips on planning
and designing your future XR app.

Join April Speight, leader of the Spatial Computing Cloud Advocacy team at Microsoft, for a 10-part video series

dedicated to helping you get started with your Mixed Reality development journey. Created for the true

beginner in mind, this series is ideal for developers and non-developers alike. Register below to attend an event

and take part in live Q&A. You can also access the on-demand post-event recordings here shortly after.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/whats-new/journey-to-mr-series.md
https://docs.microsoft.com/en-us/shows/mixed-reality/journey-into-xr-dev-ep1
https://docs.microsoft.com/en-us/shows/mixed-reality/journey-into-xr-dev-ep2


Episode 3: Low-code/no-code
platforms for AR

See on-demand video Did you know that coding isn't a
requirement to create augmented
reality apps? The number of low-
code/no-code platforms for AR
development has grown over the past
few years - enabling creators of all
backgrounds to develop their own AR
experiences. Join us to explore various
low-code/no-code platforms for AR
development, including a demo for
Microsoft Power Apps.

Episode 4: Enhance XR Experiences
with Azure Cloud Services

See on-demand video Take your XR app to the next level by
integrating features such as speech
recognition, speech translation, object
detection, and even a bot! In this
episode, we'll explore prototypes for
immersive XR experiences that
leverage the power of Azure Cognitive
Services.

Episode 5: Interactions for AR & VR
Development

See on-demand video There are many ways to interact with
virtual objects that go beyond using
our hands and/or motion controllers.
Come learn various input models that
can enable you to interact with XR
apps including a demo for the Mixed
Reality Toolkit.

Episode 6: Developing Immersive XR
Experiences on the Web

See on-demand video Developing immersive Web
experiences is made possible with
various JavaScript frameworks and
APIs. Come learn how to create
immersive augmented reality and
virtual reality experiences on the Web,
including a demo for Babylon.js and
WebXR.

Episode 7: The Structural Elements of
XR

See on-demand video Much like a compound in chemistry is
made of elements from the Periodic
Table of Elements, XR solutions are
built from various building blocks.
What are some of the building blocks
of XR? What is a coordinate system?
Scene understanding? Room scan
visualization? Spatial anchors? In this
session, we'll put on our lab coats and
set up our lab and provide an
introduction to some of the
fundamental building blocks so that
you can create or design XR
applications.
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https://docs.microsoft.com/en-us/shows/mixed-reality/journey-into-xr-dev-ep3
https://docs.microsoft.com/en-us/shows/mixed-reality/journey-into-xr-dev-ep4
https://docs.microsoft.com/en-us/shows/mixed-reality/journey-into-xr-dev-ep5
https://docs.microsoft.com/en-us/shows/mixed-reality/journey-into-xr-dev-ep6
https://www.youtube.com/watch?v=HycWMJgjnOE&list=PLlrxD0HtieHg7iAQdchuIls-ATakL9jMZ&index=4&t=5s


Episode 8: 3D Modeling & World
Building

See on-demand video Modeling the world and objects
surrounding us is made possible with
various design tools for both
beginners and advance creators. Come
learn about some of the tools available
for 3D modeling and how you can
leverage such tools to create your own
virtual world.

Episode 9: Careers in Mixed Reality See on-demand video Panel 1: Join us for a panel discussion
to learn more about careers in XR.
During this live event, we'll meet with
members from the Mixed Reality team
at Microsoft who will share their
experiences from working in the
industry. We'll also hear from recruiters
to learn more about how you can set
yourself up for success to find your
next role in XR.

Episode 10: Careers in Mixed Reality May 17th from 10:00 – 11:00 AM PDT Panel 2: Join us for a panel discussion
to learn more about careers in XR.
During this live event, we'll meet with
members from the Mixed Reality team
at Microsoft who'll share their
experiences from working in the
industry. We'll also hear from recruiters
to learn more about how you can set
yourself up for success to find your
next role in XR. On-demand link:
coming soon.
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New episodes will be posted every other week through June 2022.

https://www.youtube.com/watch?v=mfWmW0hudyw&list=PLlrxD0HtieHg7iAQdchuIls-ATakL9jMZ&index=3&t=3s
https://www.youtube.com/watch?v=AK17DUhPHGQ&list=PLlrxD0HtieHg7iAQdchuIls-ATakL9jMZ&index=1&t=5s
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Mixed Reality development: The right
tools to enable the right MR scenario

May 25, 2021 - 10:00-10:15am PST 25 percent of large businesses will pilot
and deploy mixed reality solutions by
2021 and mixed reality hardware and
software sales are expected to
accelerate from $12B in 2020 to
$72.8B in 2024. This session will
highlight the momentum of mixed
reality application development – and
help developers of all backgrounds
understand the right tools and
resources for the right job when it
comes to enabling mixed reality
scenarios. Presenter: Tyler Adams –
Principal PM, Mixed Reality. Session
Type: Build Live 
Click here for more informationClick here for more information
about this session.about this session.

Join the Microsoft Mixed Reality Team at Build 2021! Make Mixed Reality your Reality

Date - May 25th through May 27th, 2021Date - May 25th through May 27th, 2021

Browse through the sessions below for learning opportunities in mixed reality and ways to maximize your

Microsoft Build experience.

For a complete list of Microsoft Build sessions, see session catalog. 

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/whats-new/mr-build.md
https://mybuild.microsoft.com/sessions?t=%25257B%252522from%252522%25253A%2525222021-05-25T00%25253A00%25253A00-07%25253A00%252522%25252C%252522to%252522%25253A%2525222021-05-27T23%25253A59%25253A00-07%25253A00%252522%25257D&q=Connect%252520IoT%252520data%252520to%252520HoloLens%2525202%252520with%252520Azure%252520Digital%252520Twins%252520%252526%252520Unity&s=%25257B%252522name%252522%25253A%252522translate.refine.label.sort.relevance%252522%25252C%252522type%252522%25253A0%25257D
https://mybuild.microsoft.com/sessions/c786cf4d-6cf6-4b62-b720-f97eea919c5f?source=sessions


Microsoft Mesh: What’s coming and
how to get prepared

May 26, 2021 - 6:00-6:15am PST Building off the excitement from the
Microsoft Mesh announcement during
Microsoft Ignite, this interview will
focus on continuing the momentum
and share with developers and users
on what they can expect from
Microsoft Mesh, as well as understand
the best approach to leverage Mesh +
how to prepare and get started.
Presenter: Simon Skaria – Partner
Director, Mixed Reality. Session Type:
Build Live
Click here for more informationClick here for more information
about this session.about this session.

Welcome to Mixed Reality: Tools &
strategies to approach MR
development

May 26, 2021 - 10:30-11:00am PST Curious about mixed reality application
development? Here is your
opportunity to connect with experts
and have your questions answered on
how to approach getting started.
Regardless of your developer
background, Microsoft’s cross-
platform, open-source approach
enables you to innovate flexibly and
solve problems in a fun and unique
way. Learn about real-world
applications, requirements to get
started, 2D and 3D development, and
resources such as the MRTK and
common UX building blocks to
jumpstart your efforts. Presenter:
Jesse McCulloch – Sr. Program
Manager, Mixed Reality. Session Type:
Ask the Experts
Click here for more informationClick here for more information
about this session.about this session.
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https://mybuild.microsoft.com/sessions/58ece80b-d2ed-4537-89ae-7fbc31f7ba94?source=sessions
https://mybuild.microsoft.com/sessions/6e69bf88-10ba-45a2-a2d0-bee591d703d5?source=sessions


Building Digital Twins, Mixed Reality
and Metaverse Apps

May 26, 2021 - 2:00-3:00pm PST What if you could have a digital twin of
any physical asset or environment?
One that empowered you to run
simulations to discover things that are
important to you. To understand the
past and predict the future. To apply AI
to sense that environment and to
automate things. To interact with that
digital twin and all the insights it
contains in a collaborative way in
mixed reality. All of this is happening
on the Microsoft Cloud with leading
edge companies taking advantage of
digital twins, mixed reality, AI, IoT and
the power of the intelligent cloud and
the intelligent edge. Learn about the
services in the Microsoft Cloud that
enable these Metaverse applications to
drive transformational business
outcomes and meet the Microsoft
team leading this innovation.Presenter:
Sam George – CVP, Azure . Session
Type: Technical Breakout Session
Click here for more informationClick here for more information
about this session.about this session.

Connect IoT data to HoloLens 2 with
Azure Digital Twins & Unity

May 26, 2021 - 3:00-4:00pm PST Build a Mixed Reality solution for an
operating wind farm that enables you
to monitor performance and interact
with streaming IoT data from Azure
Digital Twins on the HoloLens 2. Learn
the essential components and get
sample code that you can re-use for
other real-world applications &
projects. Presenter: Brent Jackson –
Program Manager, Mixed Reality.
Session Type: Learn Live Workshop
Click here for more informationClick here for more information
about this session.about this session.
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https://mybuild.microsoft.com/sessions/f06287c8-8e56-452f-ae2f-e739c2be4870?source=sessions
https://mybuild.microsoft.com/sessions/815a692f-398b-4772-ac18-c021f5116757?source=sessions
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Opening Keynote Alex Kipman Alex Kipman starts our first ever virtual
Mixed Reality Dev Days event.

Intro to Azure Mixed Reality Services:
Azure Remote Rendering

Jonathan Lyons, Christopher Manthei,
and Marc Appelsmeier

How Azure Remote Rendering renders
and streams interactive 3D models
with hundreds of millions of polygons
to devices like HoloLens 2 in real time.

Intro to Unreal + MRTK for HoloLens
2

Summer Wu & Luis Valverde Unreal Engine support for HoloLens 2
reached production-ready status with
the release of UE 4.25 in May 2020. In
tandem, our team released the first
component of the Mixed Reality Toolkit
for Unreal: UX Tools 0.8. This talk
provides an overview of the features in
Unreal Engine 4 and MRTK for Unreal,
and how to use them to build epic
experiences for HoloLens 2.

Getting started with the HoloLens 2
and Unity

Dan Miller - Unity Basics of setting up Unity and building
for the HoloLens 2. This presentation
covers best practices, basic features of
the HoloLens 2, and how to quickly
add hand tracking support and
interactivity with native Unity APIs.

Intro to Azure Mixed Reality Services:
Azure Spatial Anchors

Archana Iyer & Vicente Rivera An overview of Azure Spatial Anchors
and relevant scenarios. This talk
reviewed new capabilities, with code
samples, best practices, and how to
start integrating ASA into your
products.

Intro to MRTK-Unity Catherine Diaz Tutorial on how to create an MRTK app
from start to finish. This talk covers
interaction concepts and shows
MRTK’s multi-platform capabilities.

Session descriptions and links to session recordings from Mixed Reality Dev Days, which was held on May 21-

22, 2020.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/whats-new/mr-dev-days-sessions.md
https://aka.ms/MRDDKeynote
https://docs.microsoft.com/en-us/shows/mixed-reality/intro-to-azure-mixed-reality-services-azure-remote-rendering
https://docs.microsoft.com/en-us/shows/mixed-reality/intro-to-unreal--mrtk-for-hololens-2
https://docs.microsoft.com/en-us/shows/mixed-reality/getting-started-with-the-hololens-2-and-unity
https://docs.microsoft.com/en-us/shows/mixed-reality/intro-to-azure-mixed-reality-services-azure-spatial-anchors
https://docs.microsoft.com/en-us/shows/mixed-reality/intro-to-mrtk-unity


Learnings from the MR Surfaces App Lars Simkins Join the engineers behind the MRDL
Surfaces app for HoloLens 2 as they
talk about the app’s design story and
technical highlights.

Azure Kinect Body Tracking Unity
Integration

Angus Antley Learn how to drive characters in Unity
using the Azure Kinect Body Tracking
SDK.

MRTK’s UX Building Blocks Yoon Park Deep dive on the MRTK’s UX
components that help you build
beautiful mixed reality experiences.

MRTK Performance Tools Kurtis Eveleigh & David Kline An introduction to performance tools,
both in MRTK and external, and an
overview of the MRTK Standard
Shader.

The State of Mixed Reality--Where
Companies are finding Success

Ori Amiga & Matt Fleckenstein Ultra-low latency edge computing,
coupled with AI and mixed reality, is
the foundation for the next generation
of experiences. By blending the digital
and the physical worlds into
ubiquitous computing experiences,
mixed reality is enabling possibilities
we could have only dreamed of
previously. This session provides
unique insight into the mixed reality
market opportunity today and in the
future. The session highlights how
Microsoft is helping leading enterprises
in manufacturing, health care, and
retail to harness the power of mixed
reality to drive business efficiency and
transform customer and employee
experiences.

Fireside Chat Alex Kipman & René Schulte Microsoft MVP, Regional Director, and
community member extraordinaire
René Schulte stands around a fire and
chats about the topics the community
is interested in. René gathered
questions from the community for
about a week, and it was a great
conversation.

Designing AR/VR experiences using
Microsoft Maquette

Ricardo Acosta Designing a phone app or a website
has a well-defined workflow.
Unfortunately, designing spatial reality
experiences can be tricky if you use the
same 2D workflow or toolset. Luckily,
the Microsoft Maquette app focuses
on helping UX designers to design.
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https://docs.microsoft.com/en-us/shows/mixed-reality/learnings-from-the-mr-surfaces-app
https://docs.microsoft.com/en-us/shows/mixed-reality/azure-kinect-body-tracking-unity-integration
https://docs.microsoft.com/en-us/shows/mixed-reality/mrtks-ux-building-blocks
https://docs.microsoft.com/en-us/shows/mixed-reality/mrtk-performance-and-shaders
https://docs.microsoft.com/en-us/shows/mixed-reality/the-state-of-mixed-reality-where-companies-are-finding-success
https://aka.ms/MRDDFireside
https://docs.microsoft.com/en-us/shows/mixed-reality/designing-arvr-experiences-using-microsoft-maquette


MRTK Unity v2 & beyond - How
community feedback helped us
improve MRTK

Bernadette Thalhammer A talk about how we improved the
developer experience by listening to
feedback from the community, and
how developers can leverage these
improvements. Dive into the
documentation and unit testing, the
new object manipulator component,
using the migration window, and
explore some code snippets around
frequently asked questions from the
dev community.

Dark Slope's Unreal Engine plugin for
the Azure Kinect DK

Ben Unsworth - Dark Slope Learn how Dark Slope uses the Azure
Kinect DK and its SDKs to build real-
time interactive engagements in
Unreal Engine.

Introducing StereoKit - MR Made Easy! Nick Klingensmith StereoKit is an easy-to-use open-
source mixed reality library for building
HoloLens and VR applications with C#
and OpenXR. StereoKit prioritizes
mixed reality application development,
allowing for features such as a first-
class mixed reality input system, fast
performance by default even on
mobile devices, quick iteration time
on-device, and a runtime asset pipeline
that lets users and developers load real
assets from the file system. All of this
and more are packaged in a terse API
that’s well documented, easy to learn,
and easy to write.

Building Immersive MR Experiences
with Babylon.js and WebXR

Jason Carter & Raanan Weber Discover how easy and powerful it can
be to develop MR experiences directly
on the web. Babylon.js strives to be
one of the most powerful, beautiful,
simple, and open web rendering
platforms in the world, making it easy
to unlock full MR capabilities across
platforms, devices, and ecosystems.
Check out the latest developments of
Babylon.js and its support of WebXR.

Using Project Acoustics with HoloLens
2

Mike Chemistruck See how to apply Project Acoustics to
Mixed Reality. Learn how the system
recreates real-world effects within the
compute budget of a HoloLens 2.
Examples include diffracted occlusion
and redirection of sounds around
physical doorways and corners, and
reverberation in complex geometries
with multiple connected spaces.
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https://docs.microsoft.com/en-us/shows/mixed-reality/mrtk-unity-v2-and-beyond-how-community-feedback-helped-us-improve-mrtk
https://docs.microsoft.com/en-us/shows/mixed-reality/dark-slopes-unreal-engine-plugin-for-the-azure-kinect-dk
https://docs.microsoft.com/en-us/shows/mixed-reality/introducing-stereokit-mr-made-easy
https://docs.microsoft.com/en-us/shows/mixed-reality/building-immersive-mr-experiences-with-babylonjs-and-webxr
https://docs.microsoft.com/en-us/shows/mixed-reality/using-project-acoustics-with-hololens-2


Holographic Remoting - Rapid
iteration & supercharged graphics on
HoloLens

Brent Jackson HoloLens delivers a revolutionary
mobile computing platform like no
other, but it’s limited to the processing
power of a mobile device. Holographic
remoting brings the raw power of a VR
capable computer to HoloLens. With
Unity in-editor remoting, you don't
have to build and deploy your apps to
test them on a device. Learn how
Holographic remoting can increase the
performance of your applications, and
your developers.

OpenXR on HoloLens 2: Cross-
platform native mixed reality

Alex Turner If you build mixed reality support into
your own engine or native app from
the ground up, learn about the key
details of OpenXR 1.0. See the OpenXR
native API surface, the extensions that
bring the full feature set of HoloLens 2
to life, and the partners from Firefox
Reality to StereoKit already shipping
apps and frameworks built on OpenXR.
With OpenXR, you can build cross-
vendor mixed reality engines and
native apps that span the breadth of
devices in the industry.

Tips from a Year of HoloLens 2
Development

Peter Vale The HoloLens commercialization team
shares tips and lessons learned from
working with our partners. Gain
insight into the most common issues,
along with best practices and
techniques that you can use to get
your HoloLens 2 application ready to
share with your customers.
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https://docs.microsoft.com/en-us/shows/mixed-reality/holographic-remoting-rapid-iteration-and-superharged-graphics-on-hololens
https://docs.microsoft.com/en-us/shows/mixed-reality/openxr-on-hololens-2-cross-platform-native-mixed-reality
https://docs.microsoft.com/en-us/shows/mixed-reality/tips-from-a-year-of-hololens-2-development
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 Designing for mixed reality

Please allow for a small loading window to account for all the cool GIFs and embedded videos on this page.

Learning how to design for mixed reality can be hard because the medium doesn't always translate well to 2D

design processes. Here at Microsoft, we've created a free app for the HoloLens 2 to help you learn the

fundamentals of mixed reality UX Design firsthand. The unique approach of the Designing Holograms app dives

into mixed reality behaviors, tips, and recommendations to help you create engaging and amazing HoloLens

apps of your own. Download the app for free from the Microsoft Store and learn from Microsoft’s Mixed Reality

Design Team!

Download the Designing Holograms app

Designing Hologram’s demo room (also known as the doll house)

Like many of you, I used to design mobile apps. Coming from a 2D design world, jumping into full on spatial

computing, where everything is now in the world, was a significant shift. In mixed reality, apps aren't confined to

a 2D screen anymore; in fact, they're almost free, placed in the real world and interacting with real objects.

To me, connecting 3D experiences to conventional 2D design processes is the most challenging aspect of mixed

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/discover/designing-holograms.md
https://www.microsoft.com/p/designing-holograms/9nxwnjklrzwd


 An opportunity to teach

 Exploring the doll house

reality development. In conversations with customers, I would hear things like “I know what features to include

and how to get them up and running. It’s code, I can follow the docs and tutorials, but the user experience? So

many features, different input options, different scenarios, and physical environments, it’s overwhelming".

Image from the HoloLens 2 Design Workshop in San Francisco

It wasn’t obvious at first, but an excellent opportunity was presented to use mixed reality as a Medium to teach

it.

Designing Holograms is a visual experience that explains mixed reality design concepts and recommendations.

It’s just you and a virtual teacher demonstrating mixed reality design concepts. Everything is from a third person

perspective with the experience firmly in your own space.

Designing Holograms trailer video

The doll house is the virtual environment we use throughout the app. The environment is an 80 x 60 x 40-cm

miniature room that contains the basic elements that most rooms have in common, like walls, lamps, furniture, a

table, and a TV. The doll house is the main protagonist of the app experience, so we needed to make sure it

would work great in any environment. Think of it as a small demo room for visualizing all sorts of mixed reality

concepts.

Video of the Dollhouse adjustment behavior

https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Designing-Holograms-app-trailer/player
https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Dollhouse-adjustment-behavior-in-the-Designing-Holograms-app/player


  1:1 vs 1:10 prototypes1:1 vs 1:10 prototypes
Our initial assumption was that 1:1 demonstrations would be amazing, almost like looking at a real life teacher.

The user would see everything that the teacher sees at a real life scale. However, we immediately realized that

there would be a few problems:

Most developers will run their apps in offices, or rooms smaller than the demo room, so it wouldn’t fit.

Displays are additive, meaning the entire virtual environment will be overlaid over a user ’s room. That can

get confusing with two tables, maybe double couches, and walls that don’t align.

And worst of all a virtual environment heavily constrained by a field of view.

When we tried out a mini 1:10 scale, the result was a fantastic birds-eye view of a realistic room. You could see

everything that was going on from any angle all at the same time. What was most surprising is that most testers

found it so much more immersive to see a small version, then they never toggled back to the 1:1 scale. So we

decided to actually scrap the 1:1 version and avoid the extra work required to adapt UI and other aspects of the

app.

Field of view with 1:1 scale



 Using Mixed Reality Capture

 Manipulating captures and virtual objects

  Head Gaze AdjustmentHead Gaze Adjustment

Field of view with 1:10 scale

One of the most characteristic features of this app is the use of Mixed Reality Capture to teach and demonstrate

mixed reality design concepts.

Microsoft has a Mixed Reality Capture studio in San Francisco. Microsoft also licenses this technology to other

studios, which include Avatar Dimension in Washington D.C., Metastage in Los Angeles, Dimension Studios in

London, SK Telecom in Seoul, and Volucap in Berlin. You can find more information on our Mixed Reality Capture

Studios here.

Raw footage of Daniel Escudero from one of the 106 cameras in the Mixed Reality Capture Studio in San

Francisco.

The capture process generates a keyframed mesh, normals, and texture, which can be delivered as OBJ/PNG

files for further post-production, or ready for playback as an H.264 compressed MP4 file. These files can be

imported into Unity, Unreal, Native, and WebXR projects. Files can run on Windows, iOS, Mac, Android, Magic

Leap, and Playstation VR.

The Capture Player provided to analyze mp4s that contain video with audio and embedded meshes.

Mixed Reality Captures produce virtual representations of people or animals, but at times you may need those

characters to interact with other virtual objects. The following two examples show different ways we

manipulated the scenes to achieve this effect.

https://www.microsoft.com/mixed-reality/capture-studios
https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Raw-capture-footage-for-the-Designing-Holograms-app/player
https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Mixed-Reality-Capture-footage-for-the-Designing-Holograms-app/player


  Syncing Animated ObjectsSyncing Animated Objects

Headgaze adjustment lets you move a captured person’s head at runtime, meaning you could have a capture

face towards a user. In our case, we used it to show the field of view and field of interest. What you see below is

a moving gameobject acting as a target for the head gaze to look at. As we move the target from side to side,

the head of the capture follows.

We used this trick to make sure that the idle capture would always face towards holograms placed in different

parts of the doll house.

The Capture’s head being moved at runtime following a target gameobject in Unity.

The second one, was animating objects to sync with a capture’s movement. In different parts of the app, we

imported sequential OBJs of a specific capture every five frames. The OBJs were then animated in the scene to

make sure they would match the corresponding frame of the capture. It’s a tedious process of animating and

keyframing, but the result is great. You can now see a Mixed Reality Capture interacting with non-captured

objects.



  UI creative processUI creative process

Synced animation between a Mixed Reality Capture and UI panel

When we started the UI design, we wanted to show some of the magic and possibility that holograms have to

offer. Simply showing static 2D windows and text boxes doesn’t feel right in the 3D world. Many of the

possibilities at hand just don't show up, so right from the beginning we decided to move away from that and

make full use of holographic 3D space.

At first, we started with adding some thickness to the panels, icons, and text information. Still, as a user, what I

see is a text box. Text boxes with images, but we aren't there. We went further by making use of the Mixed

Reality Toolkit (MRTK) shaders. The MRTK shaders became a powerful tool, and we made use of its stencil

features to add negative depth to the panels. That means instead of adding elements in front of a text box, the

icons now appear behind a transparent panel. What I see now as a user is something that I just can’t replicate

anymore in the real world, and this is where holographic magic started to happen. Also as a user I don’t really

like to read, I do a lot already in the physical world.

Obviously icons work a lot better than simple text does, to provide an even more powerful guidance, I then

started creating a set of animated objects and avatars, each of them telling a tiny story about what is being done

in the respective scenario and how it’s being used.



 Core concepts
Head Tracking and Eye TrackingHead Tracking and Eye Tracking

Hand TrackingHand Tracking

Spatial AwarenessSpatial Awareness

Holographic frameHolographic frame

https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Microsofts-Designing-Holograms-Head-Tracking-and-Eye-Tracking-Chapter/player
https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Microsofts-Designing-Holograms-Hand-Tracking-Chapter/player
https://docs.microsoft.com/en-us/shows/Docs-Mixed-Reality/Microsofts-Designing-Holograms-Spatial-Awareness-Chapter/player


Coordinate systemsCoordinate systems

Eye trackingEye tracking



Room scan visualization and spatial mappingRoom scan visualization and spatial mapping

Scene understandingScene understanding



 "Try it out" moments

Point and commit with hand raysPoint and commit with hand rays

Designing Holograms teaches mixed reality concepts, but it also allows you to try them in your room. After

some of those explanations, we pause and take you out of the doll house and into an interactive moment. Here

are some examples of those interactive moments:



The hand tracking frame showing when hands are detected and when they enter the field of view.

Interacting with colliding crystals through far interaction



 About the team

Daniel EscuderoDaniel Escudero
Lead Technical Designer
Dan is the Creative Director on Designing Holograms and currently works as Design Lead for the Microsoft’s Mixed
Reality Academy in San Francisco, and was previously a Designer in one of Microsoft’s Mixed Reality Studios in
London.

Mar tin WettigMar tin Wettig
Senior 3D Artist
Martin leads 3D Art and UI Design on Designing Holograms and was previously a Senior 3D Artist at one of
Microsoft’s Mixed Reality Studios in Berlin.

Exploring near interaction affordances

A huge thank you to the Mixed Reality Design Team for sharing so much knowledge, and to the amazing folks at

Object Theory for being essential teammates through every step of the project. Thank you all for you amazing

talent, for your passion and exceptional eye for design.

Download the Designing Holograms app

https://objecttheory.com/
https://www.microsoft.com/p/designing-holograms/9nxwnjklrzwd
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 General modules

  Introduction to Mixed RealityIntroduction to Mixed Reality

 Unity modules

  Build mixed reality digital twins with Azure Digital Twins and UnityBuild mixed reality digital twins with Azure Digital Twins and Unity

Microsoft Learn is where everyone comes to learn. Discover new skills, find certifications, and advance your

career in minutes with interactive, hands-on learning paths.

The more tools you have when developing for Mixed Reality the better. While documentation and written

tutorials are crucial, if you're more of a visual learner then our video content on Microsoft Learn is the place to

be. More modules are being added all the time, so be sure to check back for more updates!

Our Learn modules help you become proficient in Mixed Reality development, offering a module-based

structure to get you started with key tools like Mixed Reality Toolkit, Unity, and Azure mixed reality services.

Getting to Hello World has never been clearer, as we lay out the Learning Objectives, Prerequisites, and set time

to completion expectations all in one interface.

Browse Mixed Reality Learn modules

If you're curious about the foundations of Mixed Reality or haven't chosen a development path yet, start with our

tech-agnostic learning modules to get started.

Build a foundation in the core concepts, terminology, and design processes unique to the Mixed Reality

development space.

Learning objectivesLearning objectives

By the end of this module, you'll be able to:

Define Mixed Reality and differentiate between virtual and augmented reality

Describe the core ideas behind holograms

Start designing and developing 3D applications

Understand what Mixed Reality offers in real-world apps

Use the power of the cloud for Mixed Reality

Whether you're just starting or an experienced professional, our hands-on approach to Mixed Reality

development in Unity helps you get to your goals faster, with more confidence, and at your own pace.

Learn how to create of a mixed reality HoloLens 2 application using Azure Digital Twins and Unity, a real-time

3D platform.

Learning objectivesLearning objectives

By the end of this learning path, you'll be able to:

Install and configure your development environment for building Mixed Reality solutions for the HoloLens 2,

using Azure Digital Twins and Unity

Create a 3D scene in Unity using static and dynamic terrain data with Microsoft’s Maps SDK

Use MRTK interactions to provide a rich user experience

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/discover/mr-learning-overview.md
https://docs.microsoft.com/en-us/learn/browse/?terms=mixed+reality
https://docs.microsoft.com/en-us/learn/modules/intro-to-mixed-reality/
https://docs.microsoft.com/en-us/learn/paths/build-mixed-reality-azure-digital-twins-unity/


  Set up a mixed reality project in Unity with the Mixed Reality ToolkitSet up a mixed reality project in Unity with the Mixed Reality Toolkit

  Create a language translator app with Unity + Azure Cognitive ServicesCreate a language translator app with Unity + Azure Cognitive Services

  Render a model with Azure Remote RenderingRender a model with Azure Remote Rendering

Connect to a Digital Twin data source on Azure

Stream telemetry data to assets in your Unity Scene, using Azure services, including ADT

Visualize the data on a HoloLens 2 via SignalR

Send data updates from the HoloLens 2 app back to Azure Digital Twin

Import the Mixed Reality Toolkit into your Unity project to accelerate your mixed reality development.

Learning objectivesLearning objectives

By the end of this module you'll be able to:

Configure Unity for Windows Mixed Reality Development

Import the Mixed Reality Toolkit (MRTK) foundation package into Unity

Add MRTK to a Unity scene

Compare and contrast the three primary MRTK interaction models

Manipulate holograms using ObjectManipulator

Create alanguagetranslator applicationforyour Mixed Realitydevice (Windows Mixed Reality, HoloLens 2, and so

on)by usingCognitiveServices.

Learning objectivesLearning objectives

By the end of this module, you'll be able to:

Configure a Unity project for the Speech service in Azure Cognitive Services

Integrate the Speech service with a Windows Mixed Reality application

Use speech recognition to translate text

Create an Azure Remote Rendering session and render a 3D model.

Learning objectivesLearning objectives

By the end of this module, you'll be able to:

Create a Remote Rendering session

Load a 3D model

Render a 3D model

https://docs.microsoft.com/en-us/learn/modules/mixed-reality-toolkit-project-unity/
https://docs.microsoft.com/en-us/learn/modules/create-language-translator-mixed-reality-application-unity-azure-cognitive-services/
https://docs.microsoft.com/en-us/learn/modules/render-model-azure-remote-rendering-unity/


   

 

 

 Mixed Reality services

  Azure Remote RenderingAzure Remote Rendering

Unlock what every human is an expert at—the three-dimensional, physical world around us—with Azure mixed reality services.

Help people create, learn, and collaborate more effectively by capturing and surfacing digital information within the context of

their work and world. Bring 3D to mobile devices, headsets, and other untethered devices. Using Azure, help ensure that your most

sensitive information is protected.

Mixed Reality cloud services like Azure Remote RenderingAzure Remote Rendering and Azure Spatial AnchorsAzure Spatial Anchors  help developers build compelling

immersive experiences on a variety of platforms. These services allow you to integrate spatial awareness into your projects when

you're making applications for 3D training, predictive equipment maintenance, and design review, all in the context of your users’

environments.

Azure Remote Rendering, or ARR, is a service that lets you render highly complex 3D models in real time and stream them to a

device. ARR is now generally available and can be added to your Unity or Native C++ projects targeting HoloLens 2 or Windows

desktop PC.

https://docs.microsoft.com/en-us/azure/remote-rendering/


https://docs.microsoft.com/en-us/shows/Mixed-Reality/Intro-to-Azure-Mixed-Reality-Services-Azure-Remote-Rendering/player

ARR is an essential component of any Mixed Reality application that runs on an untethered device, as they have less computational

rendering power. Take the following side-by-side engine model comparison as an example: the high-fidelity model on the left has

over 18 million triangles, while the reduced model on the right has only around 200,000. In scenarios where every detail matters

—industrial plant management, design review for assets like truck engines, pre-operative surgery planning, and more—3D

visualization brings that detail to life. It's what helps designers, engineers, doctors, and students better understand complex

information and make the right call. But this simplification can result in a loss of important detail that's needed in key business and

design decisions.

ARR solves this problem by moving the rendering workload to high-end GPUs in the cloud. A cloud-hosted graphics engine then

takes over and renders the image, encodes it as a video stream, and streams the model directly to the target device.

For complex models that are too much for one high-end GPU to handle, ARR distributes the workload to multiple GPUs and

merges the result into a single image, making the process entirely transparent to the user.

As an added bonus, ARR doesn't restrict what kind of user interface you can use in your app. At the end of a frame, your locally

rendered content is automatically combined with the remote image as seen in the image below:

https://docs.microsoft.com/en-us/shows/Mixed-Reality/Intro-to-Azure-Mixed-Reality-Services-Azure-Remote-Rendering/player


  Azure Spatial AnchorsAzure Spatial Anchors
Azure Spatial Anchors, or ASA, is a cross-platform service that allows you to build spatially aware mixed reality applications. With

Azure Spatial Anchors, you can map, persist, and share holographic content across multiple devices at real-world scale. AOA is now

in public preview for you to try out in your apps.

Azure Spatial Anchors is a uniquely tailored solution for common use cases in Mixed Reality, including:

Way-findingWay-finding: Where two or more spatial anchors could be connected to create a task list or points of interest a user must

interact with.

Multi-user experiencesMulti-user experiences : Where users could pass moves back and forth by interacting with objects in the same virtual space.

Persisting vir tual content in the real-worldPersisting vir tual content in the real-world: Where users could place virtual objects in the real-world that are viewable

from other supported devices.

https://docs.microsoft.com/en-us/azure/spatial-anchors/


  Azure Object AnchorsAzure Object Anchors

The service can be developed in a host of environments and deployed to a large group of devices and platforms. This gives them

special dispensation for their own list of available platforms:

Unity for HoloLens

Unity for iOS

Unity for Android

Native iOS

Native Android

C++/WinRT and DirectX for HoloLens

Xamarin for iOS

Xamarin for Android

Azure Object Anchors, or AOA, is a mixed reality service that helps you create rich, immersive experiences by automatically

aligning 3D content with physical objects. Gain contextual understanding of objects without the need for markers or manual

alignment. Save significant touch labor, reduce alignment errors, and improve user experiences by building mixed reality

applications with Object Anchors.

Azure Object Anchors are especially tailored to common Mixed Reality use cases, including:

TrainingTraining: Create Mixed Reality training experiences for your workers, without the need to place markers or spend time

manually adjusting hologram alignment.

Task GuidanceTask Guidance: Walking employees through a set of tasks can be greatly simplified when using Mixed Reality.

Asset FindingAsset Finding: If you already have a 3D model of some object in your physical space, Azure Object Anchors can enable you to

locate and track instances of that object in your physical environment.

https://docs.microsoft.com/en-us/azure/object-anchors/


 Cognitive Services

  SpeechSpeech
Discover how Speech enables the integration of speech processing capabilities into any app or service. Convert spoken language

into text or produce natural sounding speech from text using standard (or customizable) voice fonts. Try any service free—and

quickly build speech-enabled apps and services with the following capabilities.

https://docs.microsoft.com/en-us/azure/cognitive-services/speech-service/
https://docs.microsoft.com/en-us/azure/cognitive-services/speech-service/


  VisionVision

 Standalone Unity services

  Device supportDevice support

Azure Cloud Ser viceAzure Cloud Ser vice HoloLens 1st GenHoloLens 1st Gen Immersive headsetsImmersive headsets

Language translation ✔️ ✔️

Computer vision ✔️ ✔️

Custom vision ✔️ ✔️

Cross-device notifications ✔️ ✔️

Face recognition ✔️ ✔️

Functions and storage ✔️ ✔️

Streaming video ❌ ✔️

Machine learning ✔️ ✔️

Functions and storage ✔️ ✔️

Application insights ✔️ ✔️

Object detection ✔️ ✔️

Microsoft Graph ✔️ ✔️

Bot integration ✔️ ✔️

Recognize, identify, caption, index, and moderate your pictures, videos, and digital ink content.Learn how Vision makes it possible

for apps and services to accurately identify and analyze content within images, videos, and digital ink.

The standalone services listed below don't apply to Mixed Reality, but can be helpful in a wide range of development contexts. If

you're developing in Unity, each of these services can be integrated into your new or existing projects.

https://docs.microsoft.com/en-us/azure/cognitive-services/computer-vision/
https://docs.microsoft.com/en-us/azure/cognitive-services/computer-vision/
https://docs.microsoft.com/en-us/hololens/hololens1-hardware
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/immersive-headset-hardware-details


 

See also
Azure Spatial Anchor tutorials for HoloLens 2 - 1 of 3 Getting started with Azure Spatial Anchors

Azure Speech Services tutorials for HoloLens 2 - 1 of 4 Integrating and using speech recognition and transcription

https://docs.microsoft.com/en-us/learn/modules/azure-spatial-anchors-tutorials/2-get-started-with-azure-spatial-anchors
https://docs.microsoft.com/en-us/learn/modules/azure-speech-services-tutorials-mrtk/


   

 

Set up a new OpenXR project with MRTK
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NOTENOTE

The easiest way to get your Unity project set up for mixed reality is with the Mixed Reality Toolkit (MRTK). MRTK

for Unity is an open-source, cross-platform development kit designed to make it easy to build amazing mixed

reality applications.

MRTK provides a cross-platform input system, foundational components, and common building blocks for

spatial interactions. It can help you speed up your application development for Microsoft HoloLens, Windows

Mixed Reality immersive (VR) headsets, and many other VR/AR devices. The project is aimed at reducing

barriers to entry, enabling everyone to build mixed reality applications and contribute back to the community as

we all grow.

MRTK supports a wide range of platforms, including:

Microsoft HoloLens

Microsoft HoloLens 2

Windows Mixed Reality headsets

OpenVR headsets (HTC Vive / Oculus Rift)

Ultraleap Hand Tracking

Android and iOS devices

Starting with MRTK3 we are introducing a new Mixed Reality design language to developers. For more information, see

the MRTK3 documentation.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/new-openxr-project-with-mrtk.md
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/mrtk3-overview


NOTENOTE

 Other non-OpenXR configuration options

IMPORTANTIMPORTANT

 Create a new Unity project

You can also set up a new OpenXR project without MRTK.

Windows XRWindows XR : Microsoft doesn't recommend using the Windows XR plugin for any new projects in Unity 2020.

Instead, you should use the Mixed Reality OpenXR plugin. However, if you're using Unity 2019 and you need AR

Foundation 2.0 for compatibility with ARCore/ARKit devices, this plugin enables that support.

Using this plugin in Unity 2019 is not compatible with Azure Spatial Anchors.

Legacy XRLegacy XR : If you're still on Unity 2019 or earlier, Microsoft recommends using the Legacy Built-in XR support.

While the Windows XR plugin is functional on Unity 2019, we don't recommend it because it's not compatible

with Azure Spatial Anchors on Unity 2019.

If you're starting a new project, we recommend that you install Unity 2020 instead and use the Mixed Reality

OpenXR plugin.

1. Launch the Unity HubUnity Hub.

2. In the ProjectsProjects  tab, click New ProjectNew Project.

3. Click the drop-down underneath New projectNew project and then select the Editor version you want.



4. Ensure the chosen template is 3D Core3D Core.

5. In the Project nameProject name box, enter a name for your project--for example, "MRTK Tutorial."

6. In the LocationLocation box, click the folder icon, and then navigate to the folder where you want to save your

project and select it. You can also create a new folder.

7. Click Create ProjectCreate Project. This opens your project in Unity.



C a u t i o nC a u t i o n

 Set your build target

When working on Windows, there is a MAX_PATH limit of 255 characters. Unity is affected by these limits and

may fail to compile if any file path is longer than 255 characters. Therefore, we recommend that you store your

Unity project as close to the root of the drive as possible.

1. On the menu bar, select FileFile > Build Settings...Build Settings... .

To build an app for Windows Mixed Reality, you must choose a build target. The build settings for

Universal Windows Platform (UWP) target any device, including immersive headsets like the HP Reverb

G2. This is the best choice if you're building for the HoloLens 2; however, if you're targeting desktop VR,

we recommend that you use the PC, Mac & Linux StandalonePC, Mac & Linux Standalone platform.

2. Do one of the following:

If you're targeting Desktop VRIf you're targeting Desktop VR :

Keep the PC, Mac & Linux StandalonePC, Mac & Linux Standalone platform which is selected by default on a new Unity project:

https://www.microsoft.com/en-us/d/hp-reverb-g2-vr-headset/93qb262d0514?activetab=pivot:overviewtab


If you're targeting the HoloLens 2If you're targeting the HoloLens 2 :

Under PlatformPlatform , select Universal Windows PlatformUniversal Windows Platform . Make sure the following settings are active:

Target deviceTarget device: HoloLens

ArchitectureArchitecture: ARM64

Build TypeBuild Type: D3D Project

Target SDK VersionTarget SDK Version: Latest Installed

Minimum Platform VersionMinimum Platform Version: 10.0.10240.0

Visual Studio VersionVisual Studio Version: Latest installed

Build and Run onBuild and Run on: Local Machine

Build configurationBuild configuration: Release (there are known performance issues with Debug)



 Download and install the Mixed Reality Feature Tool

3. Click the Switch PlatformSwitch Platform button. Unity displays a progress bar while it switches platforms.

4. After the switch platform process is finished, close the Build SettingsBuild Settings  window.

The best way to discover, update, and import feature packages is with the Mixed Reality Feature Tool. You can

search packages by name or category, see their dependencies, and view proposed changes to your project's

manifest file before importing.

NOTENOTE

1. Download the latest version of the Mixed Reality Feature Tool from the Microsoft Download Center.

2. After the download finishes, unzip the file and save it to your desktop.

Before you can run the Mixed Reality Feature Tool, you must install the .NET 5.0 runtime

3. In the unzipped folder, navigate to the executable file MixedRealityFeatureTool.exeMixedRealityFeatureTool.exe and then use it to

launch the Mixed Reality Feature Tool.

https://aka.ms/MRFeatureTool
https://dotnet.microsoft.com/download/dotnet/5.0


 Import the Mixed Reality Toolkit and OpenXR packages
1. In the Mixed Reality Feature Tool, select Star tStar t.

2. Select the Browse button (it's the "three-dot" button in the image below), then navigate to your project,

and then open it.



NOTENOTE
The Project PathProject Path box in the Tool must contain a value, so it inserts a backslash ("_") by default.

After you select a folder, the Tool checks to ensure that it's a valid Unity project folder.



NOTENOTE

3. Select Discover FeaturesDiscover Features .

NoteNote: You may need to wait a few seconds while the Tool refreshes the packages from the feeds.

4. On the Discover FeaturesDiscover Features  page, note that there is a list of six package groups.

5. Click the "+" button to the left of Mixed Reality Toolkit (0 of 10)Mixed Reality Toolkit (0 of 10)  and then select the latest version of

Mixed Reality Toolkit FoundationMixed Reality Toolkit Foundation.

The Mixed Reality Toolkit Foundation package is the only package that must be imported and configured in order

to use MRTK with your project. This package includes the core components required to create a mixed reality

application.

6. Click the "+" button to the left of Platform Suppor t (0 of 5)Platform Suppor t (0 of 5)  and then select the latest version of MixedMixed

Reality OpenXR PluginReality OpenXR Plugin .



 Configure OpenXR settings

7. After you've made your selection(s), click Get FeaturesGet Features .

8. Select ValidateValidate to validate the packages you selected. You should see a dialog that says No validationNo validation

issues were detectedissues were detected. When you do, click OKOK.

9. On the Impor t FeaturesImpor t Features  page, the left-side column, FeaturesFeatures , displays the packages you just selected.

The right-side column, Required dependenciesRequired dependencies , displays any dependencies. You can click the DetailsDetails

link for any of these items to learn more about them.

10. When you're ready to move on, select Impor t.Impor t. On the Review and ApproveReview and Approve page, you can review

information about the packages.

11. Select Approve.Approve.

12. Return to the Unity Editor and click a blank area in the UI. You'll see a progress bar showing you that your

packages are being imported.

1. After Unity has imported the packages, a warning appears asking if you want to enable the backends by

restarting the editor. Select YesYes .



2. After Unity reopens, the MRTK Project Configurator should appear. If it doesn't, open it manually: on the

menu bar, select Mixed RealityMixed Reality  > ToolkitToolkit > UtilitiesUtilities  > Configure Project for MRTKConfigure Project for MRTK:

3. Select Unity OpenXR PluginUnity OpenXR Plugin to enable XR Plugin Management and add the Unity OpenXR Plugin to

your project.



4. The OpenXR Project ValidationOpenXR Project Validation opens. You can ignore this for now.

5. On the Welcome to MRTK!Welcome to MRTK!  screen, select Show XR Plug-In Management SettingsShow XR Plug-In Management Settings .

This opens the Project SettingsProject Settings  window.



 Configure the project for desktop VR
If you're developing for the HoloLens2, skip this section and go to the next one, Configure the project for the

HoloLens 2.

1. In the Project SettingsProject Settings  window, ensure that you're on the XR Plug-in ManagementXR Plug-in Management page and in the

PC, Mac & Linux StandalonePC, Mac & Linux Standalone tab.

2. Ensure that Initialize XR on Star tupInitialize XR on Star tup is selected, and then, under Plugin ProvidersPlugin Providers , click Open XROpen XR .

3. The OpenXR Plugin loads, and then two items appear underneath OpenXROpenXR . Select the first one,

Windows Mixed Reality feature groupWindows Mixed Reality feature group.



 Configure the project for the HoloLens 2

Note that there's now a yellow warning triangle next to OpenXROpenXR . This indicates that you have incompatible

settings that need to be resolved. To find out how to address this, skip the next section about configuring the

HoloLens 2 and continue on with the following section, Resolving incompatible settings.

1. In the Project SettingsProject Settings  window, ensure that you're on the XR Plug-in ManagementXR Plug-in Management page with the

Universal Windows Platform settings (Windows logo tab) selected.

2. Ensure that Initialize XR on Star tupInitialize XR on Star tup is selected, and then, under Plugin ProvidersPlugin Providers , click Open XROpen XR .



 Resolving incompatible settings

3. Two items appear underneath OpenXROpenXR . Select the first one, Microsoft HoloLens feature groupMicrosoft HoloLens feature group.

Note that there's a yellow warning triangle next to OpenXROpenXR . This indicates that you have incompatible settings

that need to be resolved.

The images in this section show the options in the Universal Windows Platform tab. However, the instructions

are the same for the Desktop VR tab, except where noted.

1. Hover your cursor over the yellow warning triangle next to OpenXROpenXR , then read the message in the

popup, and then select the triangle.

2. In the OpenXR Project ValidationOpenXR Project Validation window, there are several issues listed. Select the Fix AllFix All  button.

NOTENOTE: This list may look different depending on which tab you're in.



3. One issue remains and tells you that you must add at least one interaction profile. To do so, click EditEdit.

This takes you to the settings for the OpenXROpenXR  plugin in the Project SettingsProject Settings  window.

4. Underneath Interaction ProfilesInteraction Profiles , note the plus sign (+) button.



5. Click the button three times, each time choosing a different profile:

Eye Gaze Interaction ProfileEye Gaze Interaction Profile

Microsoft Hand Interaction ProfileMicrosoft Hand Interaction Profile

Microsoft Motion Controller  ProfileMicrosoft Motion Controller  Profile

If the Eye Gaze Interaction ProfileEye Gaze Interaction Profile, or any other profile, appears with a yellow triangle next to it, select

the triangle, and then in the OpenXR Project ValidationOpenXR Project Validation window, click the FixFix button. When you're

finished, close the OpenXR Project ValidationOpenXR Project Validation window.

6. In the Project SettingsProject Settings  window under OpenXR Feature GroupsOpenXR Feature Groups , ensure that the following are

selected:

Microsoft HoloLensMicrosoft HoloLens

Hand TrackingHand Tracking

Motion Controller  ModelMotion Controller  Model



 Configure Player settings

TIPTIP

NOTENOTE

7. Click the Depth Submission ModeDepth Submission Mode drop down and then select Depth 16 BitDepth 16 Bit.

Reducing the Depth Format to 16-bit is optional, but it may improve graphics performance in your project. To

learn more, see Depth buffer sharing (HoloLens).

The Render ModeRender Mode setting, located just above Depth Submission ModeDepth Submission Mode, is set by default to Single PassSingle Pass

InstancedInstanced. In mixed reality apps, the scene is rendered twice: once for each eye. The result is "stereoscopic vision."

This doubles the amount of necessary computing, so it's important to select the most efficient rendering path in

Unity to save on both CPU and GPU time. Single pass instanced rendering is the best choice here--we

recommend that you enable it by default for every project. To learn more about this, see the Unity

documentation.

8. Close MRTK Project ConfiguratorMRTK Project Configurator  window.

1. In the Project SettingsProject Settings  window's left-side column, select PlayerPlayer .

2. Note that in the PlayerPlayer  window, the Product NameProduct Name box is already filled. This is taken from your project

name and will be the name displayed in the HoloLens Start menu.

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/performance/perf-getting-started#single-pass-instanced-rendering
https://docs.unity3d.com/Manual/SinglePassInstancing.html


  OptimizationOptimization

TIPTIP

NOTENOTE

To make the app easier to locate during development, add an underscore in front of the name to sort it to the top

of any list.

3. Click the Publishing SettingsPublishing Settings  drop down, and then in the Package namePackage name field, enter a suitable name.

The package name is the unique identifier for the app. If you want to avoid overwriting previously installed

versions of the app with the same name, you should change this identifier before deploying the app.

4. Close the Project SettingsProject Settings  window.

If you're developing for HoloLens 2, on the menu bar, select the Mixed Reality > Project > ApplyMixed Reality > Project > Apply

recommended project settings for HoloLens 2recommended project settings for HoloLens 2  to get better app performance.



  Unity sample projectsUnity sample projects

 See also

You're now ready to begin developing with OpenXR in Unity!

Check out the OpenXR Mixed Reality samples repo for sample unity projects showcasing how to build Unity

applications for HoloLens 2 or Mixed Reality headsets using the Mixed Reality OpenXR plugin.

Set up a new OpenXR project without MRTK

Add the Mixed Reality OpenXR Plugin to your existing Unity project

https://github.com/microsoft/OpenXR-Unity-MixedReality-Samples
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NOTENOTE

 Other non-OpenXR configuration options

IMPORTANTIMPORTANT

 Create a new Unity project

While Microsoft and the community have created open source tools such as the Mixed Reality Toolkit (MRTK)

that will automatically set up your environment for mixed reality, some developers may wish to build their

experiences from the ground up.

Starting with MRTK3 we are introducing a new Mixed Reality design language to developers. For more information, see

the MRTK3 documentation.

Windows XRWindows XR : Microsoft doesn't recommend using the Windows XR plugin for any new projects in Unity 2020.

Instead, you should use the Mixed Reality OpenXR plugin. However, if you're using Unity 2019 and you need AR

Foundation 2.0 for compatibility with ARCore/ARKit devices, this plugin enables that support.

Using this plugin in Unity 2019 is not compatible with Azure Spatial Anchors.

Legacy XRLegacy XR :

If you're still on Unity 2019 or earlier, Microsoft recommends using the Legacy Built-in XR support. While the

Windows XR plugin is functional on Unity 2019, we don't recommend it because it's not compatible with Azure

Spatial Anchors on Unity 2019.

If you're starting a new project, we recommend that you install Unity 2020 instead and use the Mixed Reality

OpenXR plugin.

1. Launch the Unity HubUnity Hub.

2. In the ProjectsProjects  tab, click New ProjectNew Project.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/new-openxr-project-without-mrtk.md
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity
https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/mrtk3-overview


3. Click the drop-down underneath New projectNew project and then select the Editor version you want.

4. Ensure the chosen template is 3D Core3D Core.

5. In the Project nameProject name box, enter a name for your project--for example, "MRTK Tutorial."

6. In the LocationLocation box, click the folder icon, and then navigate to the folder where you want to save your

project and select it. You can also create a new folder.



C a u t i o nC a u t i o n

 Set your build target

7. Click Create ProjectCreate Project. This opens your project in Unity.

When working on Windows, there is a MAX_PATH limit of 255 characters. Unity is affected by these limits and

may fail to compile if any file path is longer than 255 characters. Therefore, we recommend that you store your

Unity project as close to the root of the drive as possible.

1. On the menu bar, select FileFile > Build Settings...Build Settings... .

To build an app for Windows Mixed Reality, you must choose a build target. The build settings for

Universal Windows Platform (UWP) target any device, including immersive headsets like the HP Reverb

https://www.microsoft.com/en-us/d/hp-reverb-g2-vr-headset/93qb262d0514?activetab=pivot:overviewtab


G2. This is the best choice if you're building for the HoloLens 2; however, if you're targeting desktop VR,

we recommend that you use the PC, Mac & Linux StandalonePC, Mac & Linux Standalone platform.

2. Do one of the following:

If you're targeting Desktop VRIf you're targeting Desktop VR :

Keep the PC, Mac & Linux StandalonePC, Mac & Linux Standalone platform which is selected by default on a new Unity project:

If you're targeting the HoloLens 2If you're targeting the HoloLens 2 :

Under PlatformPlatform , select Universal Windows PlatformUniversal Windows Platform . Make sure the following settings are active:

Target deviceTarget device: HoloLens

ArchitectureArchitecture: ARM64

Build TypeBuild Type: D3D Project

Target SDK VersionTarget SDK Version: Latest Installed

Minimum Platform VersionMinimum Platform Version: 10.0.10240.0

Visual Studio VersionVisual Studio Version: Latest installed

Build and Run onBuild and Run on: Local Machine

Build configurationBuild configuration: Release (there are known performance issues with Debug)



 Download and install the Mixed Reality Feature Tool

3. Click the Switch PlatformSwitch Platform button. Unity displays a progress bar while it switches platforms.

4. After the switch platform process is finished, close the Build SettingsBuild Settings  window.

The Mixed Reality OpenXR Plugin comes in the form of a package for Unity. The best way to discover, update,

and import feature packages is with the Mixed Reality Feature Tool. You can search packages by name or

category, see their dependencies, and view proposed changes to your project's manifest file before importing.

NOTENOTE

1. Download the latest version of the Mixed Reality Feature Tool from the Microsoft Download Center.

2. After the download finishes, unzip the file and save it to your desktop.

Before you can run the Mixed Reality Feature Tool, you must install the .NET 5.0 runtime

3. In the unzipped folder, navigate to the executable file MixedRealityFeatureTool.exeMixedRealityFeatureTool.exe and then use it to

launch the Mixed Reality Feature Tool.

https://aka.ms/MRFeatureTool
https://dotnet.microsoft.com/download/dotnet/5.0


 Import the Mixed Reality OpenXR plugin
1. In the Mixed Reality Feature Tool, select Star tStar t.

2. Select the Browse button (it's the "three-dot" button in the image below), then navigate to your project,

and then open it.



NOTENOTE
The Project PathProject Path box in the Tool must contain a value, so it inserts a backslash ("_") by default.

After you select a folder, the Tool checks to ensure that it's a valid Unity project folder.



3. Select Discover FeaturesDiscover Features .

NoteNote: You may need to wait a few seconds while the Tool refreshes the packages from the feeds.

4. On the Discover FeaturesDiscover Features  page, note that there is a list of six package groups.

5. Click the "+" button to the left of Platform Suppor t (0 of 5)Platform Suppor t (0 of 5)  and then select the latest version of MixedMixed

Reality OpenXR PluginReality OpenXR Plugin .



 Configure the project for desktop VR

6. After you've made your selection, click Get FeaturesGet Features .

7. Select ValidateValidate to validate the package you selected. You should see a dialog that says No validationNo validation

issues were detectedissues were detected. When you do, click OKOK.

8. On the Impor t FeaturesImpor t Features  page, the left-side column, FeaturesFeatures , displays the package you just selected.

The right-side column, Required dependenciesRequired dependencies , displays any dependencies. You can click the DetailsDetails

link for any of these items to learn more about them.

9. When you're ready to move on, select Impor t.Impor t. On the Review and ApproveReview and Approve page, you can review

information about the package.

10. Select Approve.Approve.

11. Return to the Unity Editor and click a blank area in the UI. You'll see a progress bar showing you that your

package is being imported.

12. After Unity has imported the package, a warning appears asking if you want to enable the backends by

restarting the editor. Select YesYes .

If you're developing for the HoloLens2, skip this section and go to the next one, Configure the project for the

HoloLens 2.

1. On the menu bar, select EditEdit > Project SettingsProject Settings .

2. In the Project SettingsProject Settings  window, ensure that you're on the XR Plug-in ManagementXR Plug-in Management page and in the

PC, Mac & Linux StandalonePC, Mac & Linux Standalone tab.



3. Ensure that Initialize XR on Star tupInitialize XR on Star tup is selected, and then, under Plugin ProvidersPlugin Providers , click Open XROpen XR .

4. The OpenXR Plugin loads, and then two items appear underneath OpenXROpenXR . Select the first one,

Windows Mixed Reality feature groupWindows Mixed Reality feature group.



 Configure the project for the HoloLens 2

Note that there's now a yellow warning triangle next to OpenXROpenXR . This indicates that you have incompatible

settings that need to be resolved. To find out how to address this, skip the next section about configuring the

HoloLens 2 and continue on with the following section, Resolving incompatible settings.

1. On the menu bar, select EditEdit > Project SettingsProject Settings .

2. In the Project SettingsProject Settings  window, ensure that you're on the XR Plug-in ManagementXR Plug-in Management page and in the

Universal Windows PlatformUniversal Windows Platform tab.

3. Ensure that Initialize XR on Star tupInitialize XR on Star tup is selected, and then, under Plugin ProvidersPlugin Providers , click Open XROpen XR .

4. The OpenXR Plugin loads, and then two items appear underneath OpenXROpenXR . Select the first one,



 Resolving incompatible settings

Microsoft HoloLens feature groupMicrosoft HoloLens feature group.

Note that there's a yellow warning triangle next to OpenXROpenXR . This indicates that you have incompatible settings

that need to be resolved.

The images in this section show the options in the Universal Windows Platform tab. However, the instructions

are the same for the Desktop VR tab, except where noted.

1. Hover your cursor over the yellow warning triangle next to OpenXROpenXR , then read the message in the

popup, and then select the triangle.

2. In the OpenXR Project ValidationOpenXR Project Validation window, there are several issues listed. Select the Fix AllFix All  button.



3. One issue remains and tells you that you must add at least one interaction profile. To do so, click EditEdit.

This takes you to the settings for the OpenXROpenXR  plugin in the Project SettingsProject Settings  window.

4. Underneath Interaction ProfilesInteraction Profiles , note the plus sign (+) button.

5. Click the button three times, each time choosing a different profile:

Eye Gaze Interaction ProfileEye Gaze Interaction Profile

Microsoft Hand Interaction ProfileMicrosoft Hand Interaction Profile

Microsoft Motion Controller  ProfileMicrosoft Motion Controller  Profile



If the Eye Gaze Interaction ProfileEye Gaze Interaction Profile, or any other profile, appears with a yellow triangle next to it, select

the triangle, and then in the OpenXR Project ValidationOpenXR Project Validation window, click the FixFix button. When you're

finished, close the OpenXR Project ValidationOpenXR Project Validation window.

6. In the Project SettingsProject Settings  window under OpenXR Feature GroupsOpenXR Feature Groups , ensure that the following are

selected:

If you're in the Desktop VR tab:

Windows Mixed RealityWindows Mixed Reality

Hand TrackingHand Tracking

Motion Controller  ModelMotion Controller  Model

If you're in the Universal Windows Platform tab:



 Configure Player settings

TIPTIP

NOTENOTE

Microsoft HoloLensMicrosoft HoloLens

Hand TrackingHand Tracking

Motion Controller  ModelMotion Controller  Model

7. Click the Depth Submission ModeDepth Submission Mode drop down and then select Depth 16 BitDepth 16 Bit.

Reducing the Depth Format to 16-bit is optional, but it may improve graphics performance in your project. To

learn more, see Depth buffer sharing (HoloLens).

The Render ModeRender Mode setting, located just above Depth Submission ModeDepth Submission Mode, is set by default to Single PassSingle Pass

InstancedInstanced. In mixed reality apps, the scene is rendered twice: once for each eye. The result is "stereoscopic vision."

This doubles the amount of necessary computing, so it's important to select the most efficient rendering path in

Unity to save on both CPU and GPU time. Single pass instanced rendering is the best choice here--we

recommend that you enable it by default for every project. To learn more about this, see the Unity

documentation.

1. In the Project SettingsProject Settings  window's left-side column, select PlayerPlayer .

2. Note that in the PlayerPlayer  window, the Product NameProduct Name box is already filled. This is taken from your project

name and will be the name displayed in the HoloLens Start menu.

https://docs.microsoft.com/en-us/windows/mixed-reality/mrtk-unity/performance/perf-getting-started#single-pass-instanced-rendering
https://docs.unity3d.com/Manual/SinglePassInstancing.html


  OptimizationOptimization

TIPTIP

NOTENOTE

To make the app easier to locate during development, add an underscore in front of the name to sort it to the top

of any list.

3. Click the Publishing SettingsPublishing Settings  drop down, and then in the Package namePackage name field, enter a suitable name.

The package name is the unique identifier for the app. If you want to avoid overwriting previously installed

versions of the app with the same name, you should change this identifier before deploying the app.

4. Close the Project SettingsProject Settings  window.

If you're developing for HoloLens 2, on the menu bar, Mixed Reality > Project > Apply recommendedMixed Reality > Project > Apply recommended

project settings for HoloLens 2project settings for HoloLens 2  to get better app performance.



  Unity sample projectsUnity sample projects

 See also

You're now ready to begin developing with OpenXR in Unity!

Check out the OpenXR Mixed Reality samples repo for sample unity projects showcasing how to build Unity

applications for HoloLens 2 or Mixed Reality headsets using the Mixed Reality OpenXR plugin.

Set up a new OpenXR project with MRTK

Add the Mixed Reality OpenXR Plugin to your existing Unity project

https://github.com/microsoft/OpenXR-Unity-MixedReality-Samples
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IMPORTANTIMPORTANT

 HP Motion Controller overview

 Installing Microsoft.MixedReality.Input with the Mixed Reality Feature
Tool

HP Motion controllers are a brand new type of Windows Mixed Reality controllers: all the same tracking

technology with a slightly different set of available inputs:

Touchpad has been replaced by two buttons: A and B for the right controller, and X and Y for the left

controller.

Grasp is now a trigger that publishes a stream of values between 0.0 and 1.0 instead of a button with Pressed

and Not Pressed states.

Since the new inputs aren't accessible through existing Windows and Unity APIs, you need the dedicated

Microsoft.MixedReality.InputMicrosoft.MixedReality.Input UPM Package.

Classes in this package do not replace existing Windows and Unity APIs but complement them.Classes in this package do not replace existing Windows and Unity APIs but complement them. Features

commonly available to both classic Windows Mixed Reality controllers and HP Motion Controllers are accessible through

the same code path using existing APIs. Only the new inputs require the use of the additional

Microsoft.MixedReality.Input package.

Microsoft.MixedReality.Input.MotionController represents a motion controller. Each MotionController instance

has an XR.WSA.Input.InteractionSource peer, which can be correlated using handedness, vendor ID, product ID,

and version.

You can grab MotionController instances by creating a MotionControllerWatcher and subscribing to its events,

similar to using InteractionManager events to discover new InteractionSource instances. The MotionController ’s

methods and properties describe the inputs supported by the controller, including its buttons, triggers, 2D axis,

and thumbstick. The MotionController class also exposes methods for accessing input states through the

MotionControllerReading class. The MotionControllerReading class represents a snapshot of the controller ’s

state at a given time.

Install the Microsoft.MixedReality.Input plugin with the new Mixed Reality Feature Tool application. Follow the

installation and usage instructions and select the Mixed Reality InputMixed Reality Input package in the Mixed Reality Toolkit

category:

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unity/unity-reverb-g2-controllers.md


 Using Microsoft.MixedReality.Input
  Input valuesInput values

  Creating a cache to maintain a collection of MotionController instances and their statesCreating a cache to maintain a collection of MotionController instances and their states

public class MotionControllerStateCache : MonoBehaviour 
{ 
    /// <summary> 
    /// Internal helper class which associates a Motion Controller 
    /// and its known state 
    /// </summary> 
    private class MotionControllerState 

A MotionController can expose two kinds of inputs:

Buttons and trigger states are expressed by a unique float value between 0.0 and 1.0 that indicates how

much they're pressed.

Thumbstick state is expressed by a Vector2 whose X and Y components are between -1.0 and 1.0.

A button can only return 0.0 (when not pressed) or 1.0 (when pressed) while a trigger can return

continuous values between 0.0 (fully released) to 1.0 (fully pressed).

You can use MotionController.GetPressableInputs() to return a list of inputs returning a pressed value (buttons

and triggers) or the MotionController.GetXYInputs() method to return a list of inputs returning a 2-axis value.

A MotionControllerReading instance represents the state of the controller at a given time:

GetPressedValue() retrieves the state of a button or a trigger.

GetXYValue() retrieves the state of a thumbstick.

Start by instantiating a MotionControllerWatcher and registering handlers for its MotionControllerAdded and

MotionControllerRemoved events to keep a cache of available MotionController instances. This cache should be

a MonoBehavior attached to a GameObject as demonstrated in the following code:



    private class MotionControllerState 
    { 
        /// <summary> 
        /// Construction 
        /// </summary> 
        /// <param name="mc">motion controller</param>` 
        public MotionControllerState(MotionController mc) 
        { 
            this.MotionController = mc; 
        } 

        /// <summary> 
        /// Motion Controller that the state represents 
        /// </summary> 
        public MotionController MotionController { get; private set; } 
        … 
    } 

    private MotionControllerWatcher _watcher; 
    private Dictionary<Handedness, MotionControllerState> 
        _controllers = new Dictionary<Handedness, MotionControllerState>(); 

    /// <summary> 
    /// Starts monitoring controller's connections and disconnections 
    /// </summary> 
    public void Start() 
    { 
        _watcher = new MotionControllerWatcher(); 
        _watcher.MotionControllerAdded += _watcher_MotionControllerAdded; 
        _watcher.MotionControllerRemoved += _watcher_MotionControllerRemoved; 
        var nowait = _watcher.StartAsync(); 
    } 

    /// <summary> 
    /// Stops monitoring controller's connections and disconnections 
    /// </summary> 
    public void Stop() 
    { 
        if (_watcher != null) 
        { 
            _watcher.MotionControllerAdded -= _watcher_MotionControllerAdded; 
            _watcher.MotionControllerRemoved -= _watcher_MotionControllerRemoved; 
            _watcher.Stop(); 
        } 
    }

    /// <summary> 
    /// called when a motion controller has been removed from the system: 
    /// Remove a motion controller from the cache 
    /// </summary> 
    /// <param name="sender">motion controller watcher</param> 
    /// <param name="e">motion controller </param> 
    private void _watcher_MotionControllerRemoved(object sender, MotionController e) 
    { 
        lock (_controllers) 
        { 
            _controllers.Remove(e.Handedness); 
        } 
    }

    /// <summary> 
    /// called when a motion controller has been added to the system: 
    /// Remove a motion controller from the cache 
    /// </summary> 
    /// <param name="sender">motion controller watcher</param> 
    /// <param name="e">motion controller </param> 
    private void _watcher_MotionControllerAdded(object sender, MotionController e) 
    { 
        lock (_controllers) 
        { 



        { 
            _controllers[e.Handedness] = new MotionControllerState(e); 
        } 
    } 
} 

  Reading new inputs by pollingReading new inputs by polling

public class MotionControllerStateCache : MonoBehaviour 
{ 
    … 

    private class MotionControllerState 
    {
        … 

        /// <summary> 
        /// Update the current state of the motion controller 
        /// </summary> 
        /// <param name="when">time of the reading</param> 
        public void Update(DateTime when) 
        { 
            this.CurrentReading = this.MotionController.TryGetReadingAtTime(when); 
        } 

        /// <summary> 
        /// Last reading from the controller 
        /// </summary> 
        public MotionControllerReading CurrentReading { get; private set; } 
    } 

    /// <summary> 
    /// Updates the input states of the known motion controllers 
    /// </summary> 
    public void Update() 
    { 
        var now = DateTime.Now; 

        lock (_controllers) 
        { 
            foreach (var controller in _controllers) 
            { 
                controller.Value.Update(now); 
            } 
        } 
    } 
} 

You can read the current state of each known controller through MotionController.TryGetReadingAtTime during

the Update method of the MonoBehavior class. You want to pass DateTime.Now as the timestamp parameter to

ensure that the latest state of the controller is read.

You can grab the controllers current input value using the Handedness of the controller :



public class MotionControllerStateCache : MonoBehaviour 
{ 
    … 
    /// <summary> 
    /// Returns the current value of a controller input such as button or trigger 
    /// </summary> 
    /// <param name="handedness">Handedness of the controller</param> 
    /// <param name="input">Button or Trigger to query</param> 
    /// <returns>float value between 0.0 (not pressed) and 1.0 
    /// (fully pressed)</returns> 
    public float GetValue(Handedness handedness, ControllerInput input) 
    { 
        MotionControllerReading currentReading = null; 

        lock (_controllers) 
        { 
            if (_controllers.TryGetValue(handedness, out MotionControllerState mc)) 
            { 
                currentReading = mc.CurrentReading; 
            } 
        } 

        return (currentReading == null) ? 0.0f : currentReading.GetPressedValue(input); 
    } 

    /// <summary> 
    /// Returns the current value of a controller input such as button or trigger 
    /// </summary> 
    /// <param name="handedness">Handedness of the controller</param> 
    /// <param name="input">Button or Trigger to query</param> 
    /// <returns>float value between 0.0 (not pressed) and 1.0 
    /// (fully pressed)</returns> 
    public float GetValue(UnityEngine.XR.WSA.Input.InteractionSourceHandedness handedness, ControllerInput 
input) 
    { 
        return GetValue(Convert(handedness), input); 
    } 

    /// <summary> 
    /// Returns a boolean indicating whether a controller input such as button or trigger is pressed 
    /// </summary> 
    /// <param name="handedness">Handedness of the controller</param> 
    /// <param name="input">Button or Trigger to query</param> 
    /// <returns>true if pressed, false if not pressed</returns> 
    public bool IsPressed(Handedness handedness, ControllerInput input) 
    { 
        return GetValue(handedness, input) >= PressedThreshold; 
    } 
} 

/// Read the analog grasp value of all connected interaction sources 
void Update() 
{ 
    … 
    var stateCache = gameObject.GetComponent<MotionControllerStateCache>(); 
    foreach (var sourceState in InteractionManager.GetCurrentReading()) 
    { 
        float graspValue = stateCache.GetValue(sourceState.source.handedness, 
            Microsoft.MixedReality.Input.ControllerInput.Grasp);
        … 
    }
} 

For example, to read the analog grasp value of an InteractionSource:



  Generating events from the new inputsGenerating events from the new inputs

private class MotionControllerState 
{ 
    … 
    /// <summary> 
    /// Returns an array representng buttons which are pressed 
    /// </summary> 
    /// <param name="reading">motion controller reading</param> 
    /// <returns>array of booleans</returns> 
    private bool[] GetPressed(MotionControllerReading reading) 
    { 
        if (reading == null) 
        { 
            return null; 
        } 
        else 
        { 
            bool[] ret = new bool[this.pressableInputs.Length]; 
            for (int i = 0; i < pressableInputs.Length; ++i) 
            { 
                ret[i] = reading.GetPressedValue(pressableInputs[i]) >= PressedThreshold; 
            } 

            return ret; 
        } 
    } 

    /// <summary> 
    /// Get the next available state of the motion controller 
    /// </summary> 
    /// <param name="lastReading">previous reading</param> 
    /// <param name="newReading">new reading</param> 
    /// <returns>true is a new reading was available</returns> 
    private bool GetNextReading(MotionControllerReading lastReading, out MotionControllerReading newReading)  
    { 
        if (lastReading == null) 
        { 
            // Get the first state published by the controller 
            newReading = 
this.MotionController.TryGetReadingAfterSystemRelativeTime(TimeSpan.FromSeconds(0.0)); 
        } 
        else 
        { 
            // Get the next state published by the controller 
            newReading = this.MotionController.TryGetReadingAfterTime(lastReading.InputTime); 
        } 

        return newReading != null; 
    } 

    /// <summary> 
    /// Processes all the new states published by the controller since the last call 
    /// </summary> 
    public IEnumerable<MotionControllerEventArgs> GetNextEvents() 
    {
        MotionControllerReading lastReading = this.CurrentReading; 
        bool[] lastPressed = GetPressed(lastReading); 
        MotionControllerReading newReading; 
        bool[] newPressed; 

Instead of polling for a controller's state once per frame, you have the option of handling all state changes as

events, which lets you handle even the quickest actions lasting less than a frame. In order for this approach to

work, the cache of motion controllers needs to process all states published by a controller since the last frame,

which you can do by storing the timestamp of the last MotionControllerReading retrieved from a

MotionController and calling MotionController.TryGetReadingAfterTime():



        while (GetNextReading(lastReading, out newReading)) 
        { 
            newPressed = GetPressed(newReading); 

            // If we have two readings, compare and generate events 
            if (lastPressed != null) 
            { 
                for (int i = 0; i < pressableInputs.Length; ++i) 
                { 
                    if (newPressed[i] != lastPressed[i]) 
                    { 
                        yield return new MotionControllerEventArgs(this.MotionController.Handedness, 
newPressed[i], this.pressableInputs[i], newReading.InputTime); 
                    } 
                } 
            } 

            lastPressed = newPressed; 
            lastReading = newReading; 
        } 

        // No more reading 
        this.CurrentReading = lastReading; 
    } 
} 

/// <summary> 
/// Event argument class for InputPressed and InputReleased events 
/// </summary> 
public class MotionControllerEventArgs : EventArgs 
{ 
    public MotionControllerEventArgs(Handedness handedness, bool isPressed, rollerInput input, DateTime 
inputTime) 
    { 
        this.Handedness = handedness; 
        this.Input = input; 
        this.InputTime = inputTime; 
        this.IsPressed = isPressed; 
    } 

    /// <summary> 
    /// Handedness of the controller raising the event 
    /// </summary> 
    public Handedness Handedness { get; private set; } 

    /// <summary> 
    /// Button pressed or released 
    /// </summary> 
    public ControllerInput Input { get; private set; } 

    /// <summary> 
    /// Time of the event 
    /// </summary> 
    public DateTime InputTime { get; private set; } 

    /// <summary> 
    /// true if button is pressed, false otherwise 
    /// </summary> 
    public bool IsPressed { get; private set; } 
} 

/// <summary> 
/// Event raised when a button is pressed 

Now that you've updated the cache internal classes, the MonoBehavior class can expose two events – Pressed

and Released – and raise them from its Update() method:



/// Event raised when a button is pressed 
/// </summary> 
public event EventHandler<MotionControllerEventArgs> InputPressed; 

/// <summary> 
/// Event raised when a button is released 
/// </summary> 
public event EventHandler<MotionControllerEventArgs> InputReleased; 

/// <summary> 
/// Updates the input states of the known motion controllers 
/// </summary> 
public void Update() 
{ 
    // If some event handler has been registered, we need to process all states  
    // since the last update, to avoid missing a quick press / release 
    if ((InputPressed != null) || (InputReleased != null)) 
    { 
        List<MotionControllerEventArgs> events = new <MotionControllerEventArgs>(); 

        lock (_controllers) 
        { 
            foreach (var controller in _controllers) 
            { 
                events.AddRange(controller.Value.GetNextEvents()); 
            } 
        } 
 
        // Sort the events by time 
        events.Sort((e1, e2) => DateTime.Compare(e1.InputTime, e2.InputTime)); 

        foreach (MotionControllerEventArgs evt in events) 
        { 
            if (evt.IsPressed && (InputPressed != null)) 
            { 
                InputPressed(this, evt); 
            } 
            else if (!evt.IsPressed && (InputReleased != null)) 
            { 
                InputReleased(this, evt); 
            } 
        } 
    } 
    else 
    { 
        // As we do not predict button presses and the timestamp of the next e is in the future 
        // DateTime.Now is correct in this context as it will return the latest e of controllers 
        // which is the best we have at the moment for the frame. 
        var now = DateTime.Now; 
        lock (_controllers) 
        { 
            foreach (var controller in _controllers) 
            { 
                controller.Value.Update(now); 
            } 
        } 
    } 
} 

The structure in the above code examples makes registering events much more readable:



public InteractionSourceHandedness handedness; 
public Microsoft.MixedReality.Input.ControllerInput redButton;

// Start of the Mono Behavior: register handlers for events from cache 
void Start() 
{ 
    var stateCache = gameObject.GetComponent<MotionControllerStateCache>(); 
    stateCache.InputPressed += stateCache_InputPressed; 
    stateCache.InputReleased += stateCache_InputReleased; 
    … 
} 

// Called when a button is released 
private void stateCache_InputReleased(object sender, MotionControllerStateCache.MotionControllerEventArgs e)  
{ 
    if ((e.SourceHandedness == handedness) && (e.Input == redButton)) 
    { 
        … 
    } 
} 

// Called when a button is pressed 
private void stateCache_InputPressed(object sender, MotionControllerStateCache.MotionControllerEventArgs e) 
{ 
    if ((e.SourceHandedness == handedness) && (e.Input == redButton)) 
    { 
        … 
    } 
} 

 See also



   

 

HP Reverb G2 Controllers in Unreal
 7/6/2022 • 3 minutes to read • Edit Online

 Getting started

IMPORTANTIMPORTANT

 

 

  Enabling HP Motion Controller PluginEnabling HP Motion Controller Plugin

 Porting an existing OpenXR app

Unreal Engine 4.26 and either OpenXR or SteamVR is required to access the HP Motion Controller plugin you'll need to

work with the HP Reverb G2 controllers.

All platforms

SteamVR

The interaction profile and controller mappings are in the HP Motion Controller plugin, which must be enabled

to expose the controller mappings to Unreal’s input system.

If no controller bindings exist in the game for the HP Mixed Reality Controller, the OpenXR runtime will try to

remap existing bindings to the active controller. In this case, the game has Oculus Touch bindings and no HP

Mixed Reality Controller bindings.

The events will still fire, but if the game needs to make use of controller-specific bindings, like the right menu

button, the HP Mixed Reality interaction profile must be used. Multiple controller bindings can be specified per

action to better support different devices.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/develop/unreal/unreal-reverb-g2-controllers.md


 Adding input action mappings

 Adding input events

Define a new action and map to one of the key presses in the HP Mixed Reality Controller section.

The HP Reverb G2 controller also has an analog grip, which can be used in the axis mappings with the “Squeeze

Axis” binding. There's a separate Squeeze binding, which should be used for action mappings when the grip

button is fully pressed.

Right-click on a Blueprint and search for the new action names from the input system to add events for these

actions. Here the Blueprint is responding to the events with a print string outputting the current button and axis

state.



  Using inputUsing input
 

 

All platforms

SteamVR

The same action and axis mappings in the game’s input project settings can be used from C++.

1. Create a new C++ Class with File/New C++ Class...

2. Create a pawn



AMyPawn::AMyPawn()
{
    PrimaryActorTick.bCanEverTick = true;

    AutoPossessPlayer = EAutoReceiveInput::Player0;
}

void AMyPawn::SetupPlayerInputComponent(UInputComponent* PlayerInputComponent)
{
    Super::SetupPlayerInputComponent(PlayerInputComponent);

    PlayerInputComponent->BindAction("X_Button", IE_Pressed, this, &AMyPawn::XPressed);
    PlayerInputComponent->BindAction("L_GripAxis", this, &AMyPawn::LeftGripAxis);
}

void AMyPawn::XPressed()
{
    UE_LOG(LogTemp, Log, TEXT("X Pressed"));
}

void AMyPawn::LeftGripAxis(float AxisValue)
{
    if(AxisValue != 0.0f) 
    {
        UE_LOG(LogTemp, Log, TEXT("Left Grip Axis Valule: %f"), AxisValue);
    }
}

3. In the project’s Visual Studio solution, find the new Pawn class and configure it for input.

First, in the constructor, set AutoPossessPlayer to the first player to route input to the pawn.

Then in SetupPlayerInputComponent, bind actions and axis events to the action names from the project’s

input settings.

Add the callback functions to the class:



private:
    void XPressed();
    void LeftGripAxis(float AxisValue);

 See also

Update the Pawn’s header with the callback function definitions:

4. Compile from Visual Studio to launch the editor with the new pawn. Drag and drop the pawn from the

content browser into the game and the pawn will now execute the callbacks when input is pressed.

SteamVR Input

Using SteamVR with Windows Mixed Reality

Unreal Player Camera

https://docs.unrealengine.com/Platforms/VR/SteamVR/HowTo/SteamVRInput/index.html
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/using-steamvr-with-windows-mixed-reality
https://docs.unrealengine.com/Programming/Tutorials/PlayerCamera/3/index.html
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 Distribution options

IMPORTANTIMPORTANT

ScenarioScenario Local device installsLocal device installs Share with anyoneShare with anyone Share with anShare with an
organizationorganization

Getting your apps into the hands of your users or out into the world is the most important, and sometimes

painstaking, part of any development effort. We've simplified the process into a set of resources, which depend

on the distribution and deployment scenario that's best suited for you or your team.

HoloLens

Windows Mixed Reality

If you have a HoloLens application, choose your preferred distribution option from the table below. If you're

publishing to the Microsoft Store, you have the option of adding In-app purchases to monetize your content.

If you're sharing your app with another party, you need to build and supply the appx file.

If you're using App Installer, you'll also need to share the certificate with the user.

If you're sharing with an organization, you need a work or school account and access to the organizations MDM

(Mobile Device Management) infrastructure.

If you're the sharing party, you need to be an Admin in your tenant and use the Microsoft Endpoint Manager

admin center to make the app available. Another option is to share the appx file and the app dependencies

with your end user.

If you're the end user, the app will either automatically download or be available for download once you enroll

with the sharing organization's tenant.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/distribute/distribute-overview.md
https://docs.microsoft.com/en-us/hololens/hololens-enroll-mdm
https://docs.microsoft.com/en-us/mem/intune/apps/apps-deploy


App InstallerApp Installer ✔️ ✔️ ❌

MDM - Company Por talMDM - Company Por tal ❌ ❌ ✔️

MDM - Required App InstallMDM - Required App Install ❌ ❌ ✔️

Microsoft StoreMicrosoft Store ❌ ✔️ ✔️

Microsoft Store for BusinessMicrosoft Store for Business ❌ ❌ ✔️

Provisioning PackageProvisioning Package ✔️ ✔️ ✔️

Custom Win32 deploymentCustom Win32 deployment  (Not
available for HoloLens devices - see
below)

✔️ ✔️ ❌

IMPORTANTIMPORTANT

 Other scenarios

 See also

App Installer isn't currently available for managed devices or HoloLens (1st Gen) devices.

You can produce a Win32 .EXE file using the PC Standalone build target from Unity for Win32 application

deployment, including Steam and Game Pass. Once you have the .EXE, you can submit your apps as

normal to your chosen platform.

If you need to install a HoloLens 2 application while you're offline, refer to the offline secure HoloLens 2

instructions or install the app through a Provisioning Package without enabling developer mode.

You can also deploy builds to your device and share them with other developers who have Developer

Mode enabled by deploying and debugging with Visual Studio or installing an application package with

the Device Portal.

Finding, installing, and uninstalling applications from the Microsoft Store

https://docs.microsoft.com/en-us/hololens/app-deploy-app-installer
https://docs.microsoft.com/en-us/hololens/app-deploy-app-installer
https://docs.microsoft.com/en-us/hololens/app-deploy-intune
https://docs.microsoft.com/en-us/hololens/app-deploy-store-business
https://docs.microsoft.com/en-us/hololens/app-deploy-provisioning-package
https://docs.microsoft.com/en-us/hololens/hololens-common-scenarios-offline-secure
https://docs.microsoft.com/en-us/hololens/holographic-store-apps
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 Introducing the new Microsoft Edge

IMPORTANTIMPORTANT

 Getting ready for the new Microsoft Edge

IMPORTANTIMPORTANT

 Known issues
  Known issues resolved by the 2020-01 Cumulative update for Windows 10 Version 1903 (or later)Known issues resolved by the 2020-01 Cumulative update for Windows 10 Version 1903 (or later)

The new Microsoft Edge is now available for download, but customers can also wait for a future update to install

it with Windows 10, following a measured roll-out approach over the next several months.

With this news, we wanted to let Windows Mixed Reality VR headset customers know what to expectwe wanted to let Windows Mixed Reality VR headset customers know what to expect

from the new Microsoft Edge and show off pending updates for an improved browsing experiencefrom the new Microsoft Edge and show off pending updates for an improved browsing experience

in Windows Mixed Realityin Windows Mixed Reality .

The new Microsoft Edge adopts the Chromium open source project on the desktop to create better compatibility

for customers and less fragmentation of the web for web developers. It will also support WebXR at launch, the

new standard for creating immersive web experiences for VR headsets, in place of WebVR.

When you install Microsoft Edge on an up-to-date Windows 10 device, it will replace the previous (legacy) version on

your PC.

Windows Mixed Reality VR headset customers who want to use the new Microsoft Edge in the mixed reality

home should upgrade to Windows 10 Version 1903 or later for native suppor t of Win32upgrade to Windows 10 Version 1903 or later for native suppor t of Win32

applications (like the new Microsoft Edge)applications (like the new Microsoft Edge)  in the mixed reality home. Check Windows Update or manually

install the latest version of Windows 10.

For the best possible Microsoft Edge experience in the mixed reality home, we also recommend waiting for

some key Windows Mixed Reality optimizations for the new Microsoft Edge arr iv ing with thesome key Windows Mixed Reality optimizations for the new Microsoft Edge arr iv ing with the

2020-01 Cumulative update for Windows 10 Version 1903 (or later)2020-01 Cumulative update for Windows 10 Version 1903 (or later) , which should be available in

Windows Update by the end of January.

If you opt to download the new Microsoft Edge before taking these updates, there will be some known issues with its

behavior in Windows Mixed Reality (which you can read about below).

Launching any Win32 app, including the new Microsoft Edge, causes the headset display to briefly freeze.

The Microsoft Edge tile disappears from the Windows Mixed Reality Start menu (you can find it in the

“Classic apps” folder).

Windows from the previous Microsoft Edge are still placed around the mixed reality home, but cannot be

used. Attempting to activate those windows launches Edge in the Desktop app.

Selecting a hyperlink in the mixed reality home launches a web browser on the desktop instead of the mixed

reality home.

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/whats-new/new-microsoft-edge.md
https://blogs.windows.com/windowsexperience/?p=173496
https://blogs.windows.com/msedgedev/2020/01/15/upgrading-new-microsoft-edge-79-chromium/
https://blogs.windows.com/windowsexperience/2018/12/06/microsoft-edge-making-the-web-better-through-more-open-source-collaboration/
https://www.microsoft.com/en-us/software-download/windows10


  Monitor and input handling issuesMonitor and input handling issues

NOTENOTE

WARNINGWARNING

The WebVR Showcase app is present in the mixed reality home, despite WebVR no longer being supported.

General improvements to keyboard launch and visuals.

After taking the 2020-01 Cumulative update for Windows 10 Version 1903 (or later), virtual monitors will

appear as generic physical monitors in Settings > System > DisplaySettings > System > Display  during Windows Mixed Reality sessions.

Some customers, especially with more than one physical monitor, may notice issues with desktop layout and

input handling as a result.

Why this happensWhy this happens

Support for classic Win32 applications in Windows Mixed Reality was introduced with the Windows 10 May

2019 Update. To enable this support, a virtual monitor must be created to host the Win32 application. Each time

a new Win32 application is launched, another virtual monitor has to be created. Unfortunately, creating a virtual

monitor is an intensive task that can cause the headset display to briefly freeze. Customers offered feedback that

this was an uncomfortable and disruptive experience. Because of feedback and increased Win32 application

usage, we made the decision to pre-allocate three virtual monitors during startup of Windows Mixed Reality.

This prevents disruption and enables customers to launch up to three concurrent Win32 applications without

experiencing the headset display freeze.

WorkaroundWorkaround

We've since received feedback that some customers, especially those with multiple physical monitors, would

prefer to disable this virtual monitor pre-allocation. To give customers control, we've enabled a workaround that

involves changing a registry key value, which is available with the following Windows Updates:

2020-07 Cumulative Update Preview for Windows 10 Version 2004 (KB4568831)

2020-10 Cumulative Update Preview for Windows 10 Version 1909 (KB4580386)

2020-10 Cumulative Update Preview for Windows 10 Version 1903 (KB4580386)

Modifying registry key values is intended for advanced users.

Disabling virtual monitor pre-allocation may result in your headset display briefly freezing when you launch a Win32

application (such as Steam, the new Microsoft Edge, or Google Chrome) in Windows Mixed Reality.

To disable virtual monitor pre-allocation:

1. Check Windows UpdateWindows Update for one of the Windows 10 Cumulative Update Preview versions listed above, and

install the update when available. You may find the update under Optional updatesOptional updates  or Advanced optionsAdvanced options

on the Windows Update settings page

2. Launch Registr y EditorRegistr y Editor

3. Navigate to "HKEY_CURRENT_USER\SOFTWARE\Microsoft\Windows\CurrentVersion\Holographic"

4. If the "PreallocateVirtualMonitors" REG_DWORD isn't present, create it by selecting Edit > New > DWORDEdit > New > DWORD

(32-bit) Value(32-bit) Value and entering PreallocateVirtualMonitors as the name

5. If the "PreallocateVirtualMonitors" REG_DWORD is present (or you just created it), double-click the entry and

change "Value data" from 1 (its default value) to 0 (zero)

TRUE - 1

FALSE - 0

https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/release-notes-may-2019


  Other known issuesOther known issues

 See Also

Virtual monitors will now allocate when you attempt to launch a Win32 application in Windows Mixed Reality

instead of pre-allocating. To reset this and re-enable virtual monitor pre-allocation, return the DWORD "Value

data" to 1.

Audio from Microsoft Edge windows isn't spatialized.

WebXR Overview
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 See also

You can find the latest release notes for Windows Mixed Reality headsets and motion controller drivers in our

Enthusiast Guide documentation. If you're looking for HoloLens information, you can find them in the HoloLens

(1st Gen) or HoloLens 2 release notes.

Immersive headset support (external link)

HoloLens support (external link)

Install the tools

Give us feedback

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/whats-new/release-notes-may-2020.md
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/mixed-reality-software
https://docs.microsoft.com/en-us/hololens/hololens1-release-notes
https://docs.microsoft.com/en-us/hololens/hololens-release-notes
https://docs.microsoft.com/en-us/windows/mixed-reality/enthusiast-guide/troubleshooting-windows-mixed-reality
https://support.microsoft.com/products/hololens
https://docs.microsoft.com/en-us/hololens/hololens-feedback
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 Online Communities

C O M M UN IT Y  N A M EC O M M UN IT Y  N A M E L IN KL IN K DESC RIP T IO NDESC RIP T IO N

HoloDevelopers SlackHoloDevelopers Slack Join Here The HoloDevelopers Slack was initially
created as a place for developers
exploring HoloLens to get to know one
another, form friendships, build trust,
and get help from each other. It has
grown into a thriving community that
covers the spectrum of mixed reality
across many platforms, devices, and
companies.

Stack OverflowStack Overflow MR Questions

Reddit WMR HeadsetsReddit WMR Headsets WMR subreddit

Reddit HoloLensReddit HoloLens HoloLens subreddit

 Local Communities

C O M M UN IT Y  N A M EC O M M UN IT Y  N A M E C O UN T RYC O UN T RY C IT YC IT Y L IN KL IN K

Augmented RealityAugmented Reality
MelbourneMelbourne

Australia Melbourne Link

Chicago AWE NiteChicago AWE Nite USA Chicago Link

HoloMagiciansHoloMagicians Japan Tokyo Link

Mixed Reality UserMixed Reality User
Group - NetherlandsGroup - Netherlands

Netherlands Rijswijk Link

VR PhilippinesVR Philippines Philippines N/A Link

XRL AXRL A USA Los Angeles Link

At Microsoft, we believe having access to strong communities is essential for developers, platforms, and

ecosystems to grow. Use the information below to take part in communities and meet some of the team

members who are here to help you.

If you run a community that you would like included on this page, send an email here with the details

https://github.com/MicrosoftDocs/mixed-reality/blob/docs/mixed-reality-docs/mr-dev-docs/discover/community.md
https://aka.ms/holodevelopers
https://stackoverflow.com/questions/tagged/windows-mixed-reality
https://www.reddit.com/r/WindowsMR/
https://www.reddit.com/r/HoloLens/
mailto:jemccull@microsoft.com
https://www.meetup.com/armelbourne/
https://www.meetup.com/AWENiteChicago/
https://hololens.connpass.com/
https://www.mixug.com
https://www.facebook.com/vrphilippines/
https://www.meetup.com/XRLA_Meetup/
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Daniel EscuderoDaniel Escudero
MR Academy Lead Designer

Interactive designer,
prototyper, and coder,
specialized in Mixed Reality,
with over 15 years of
interaction design
experience. Currently
designing and prototyping
new Mixed Reality
interactions, while creating
workshops and hackathons
with San Francisco Bay Area
partners and the MR, VR,
and AR communities.
Mentor and speaker for
Mixed Reality Design at
multiple MR, VR, and AR
events and lectures.

San Francisco, CA Email

Daniel GonzalezDaniel Gonzalez
Program Manager II

Redmond, WA Email

Jane FangJane Fang
Principal Program Manager
Lead

San Francisco, CA Email

Jesse McCullochJesse McCulloch
Program Manager II

Jesse is a Program Manager
on the Mixed Reality
Developer Ecosystem team
at Microsoft. He's often
found hanging out in
developer Slack groups, on
Twitter trying to keep up
with everything going on in
this rapidly growing space,
or in a big metal tube flying
through the air on his way
to engage with developers
in the real world.

Redmond, Wa Email

Jo RyallJo Ryall
Head of Marketing, SF
Academy

San Francisco, CA Email

mailto:daescu@microsoft.com
mailto:dgonza@microsoft.com
mailto:jafang@microsoft.com
mailto:jemccull@microsoft.com
mailto:joryal@microsoft.com


Nick KlingensmithNick Klingensmith
MR Academy Lead Engineer

Nick is an experienced game
developer specializing in
tool development, graphics
programming, MR, and
Unity! With over 100
published games, he's
worked on small arcade
games, mobile high fidelity
GPU pushing titles, all the
way to massive networked
social games. The tools he's
published on the Unity
Asset Store are also used in
thousands of games, on
just about every modern
platform imaginable. Nick
has collected most of the
official Unity certifications,
and also helped write them.
Nick currently works for
Microsoft as the lead
engineer on the Mixed
Reality Academy team in
San Francisco.

San Francisco, CA Email
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 Microsoft MR Design Team, Developer Experience
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Yoon ParkYoon Park
Principal UX Designer

Yoon is a designer, creative
technologist, and author
from Seoul, Korea. As a
Principal UX Designer at
Microsoft’s Mixed Reality
design team, he's leading
the design effort for the
open-source Mixed Reality
Toolkit(MRTK) project,
Mixed Reality Design
Labs(MRDL), and
documentation. He shares
his personal MR project
design stories on Medium.

Redmond, WA Twitter Medium LinkedIn
Email

mailto:niklinge@microsoft.com
https://medium.com/@dongyoonpark/designing-type-in-space-for-hololens-2-4d926355d5b3
https://twitter.com/cre8ivepark
https://medium.com/@dongyoonpark
https://www.linkedin.com/in/cre8ivepark/
mailto:dongyoon.park@microsoft.com


Cameron MickaCameron Micka
Senior Software Engineer

Cameron Micka is a
software engineer who
takes pride in empowering
developers to achieve their
artistic and creative
ambitions. Cameron joined
Microsoft in 2016 after
developing video games for
nearly a decade at
LucasArts Entertainment,
Fun Bits Interactive, and his
own startup. At Microsoft,
Cameron’s role is to build
tools for Mixed Reality
developers and consult with
partners and customers.

Redmond, WA Twitter Email
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 Azure Cloud Advocate Spatial Computing Team
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April SpeightApril Speight
Cloud Advocate

I've been in the tech industry for 7
years after a career in luxury fashion as
a menswear stylist and visual
merchandiser. I love working with bots
and voice enabled devices. However,
I'm currently creating new realities
within the world of spatial computing!
I like meeting new coders and people
on their journey to transition into the
tech industry. I provide advice and
code tutorials on both my website and
YouTube channel. In my spare time,
you can either find me crafting or
scratching' on turntables!

Twitter

The charter of Azure Cloud Advocates is to help every technologist on the planet succeed. This applies to

students, enterprise employees, and startups. They engage in outreach to developers and others in the software

ecosystem, all designed to further technical education and skill with the Microsoft Cloud + AI platform.

The members listed here are the Cloud Advocates that work on the Spatial Computing team within the Cloud

Advocate organization. They work extremely close with the Mixed Reality Developer Ecosystem team, and it's

often hard to tell where one team stops, and the other one starts.

https://twitter.com/tcmicka
mailto:cameron.micka@microsoft.com
https://www.vogueandcode.com/code
https://www.youtube.com/c/vogueandcode
https://twitter.com/vogueandcode


AyAyşegül Yönetegül Yönet
Sr. Cloud Advocate

Ayşegül is a Senior Azure Cloud
Developer Advocate at Microsoft and
focuses on Spatial Computing, Mixed
Reality, Cognitive Services, and Data
Visualization. She's a co-chair of W3C
Immersive Web Working Group and
Community Group and a Google
Developer Expert for Web
Technologies. She co-hosts of San
Francisco WebXR Meetup and enjoys
teaching at different non-profit
organizations aiming to increase
diversity in the software industry. She's
the co-founder of Code4GoodCode4Good, an
organization with the vision of helping
people to contribute to open source.
Previously she led Women Who Code
meetups, Girl Develop It and Black
Girls Code workshops and was a CTO
at AnnieCannons, a bootcamp
dedicated to teaching tech skills to
human trafficking survivors. Lately she
enjoys creating tutorials for YouTube
AysSomething Channel and YouTube
WebXR Channel.

Twitter

T EA M  M EM B ERT EA M  M EM B ER A B O UTA B O UT T W IT T ERT W IT T ER

https://www.w3.org/immersive-web/
https://www.w3.org/community/immersive-web/
https://www.meetup.com/Web-VR/
https://www.anniecannons.com/
https://www.youtube.com/channel/UCeo_soIgcgBSd3SVRbs_MPQ?view_as=subscriber
https://www.youtube.com/channel/UCNzjXKJVyqYVyPY8rGKwFtQ?view_as=subscriber
https://twitter.com/AysSomething


Em Lazer-WalkerEm Lazer-Walker
Cloud Advocate

Em (she/her or they/them) is a Cloud
Advocate for Microsoft based in
Toronto. She’s an artist/engineer who
makes interactive art, experimental
games, and open-source software
tools to empower creativity. Most of
her work focuses on using
nontraditional interfaces to reframe
everyday objects and spaces as playful
experiences and to inspire people to
become self-motivated learners. She’s
built projects as far-flung as a site-
specific generative poetry walk, a
game played on 19th century
telegraph hardware, and a commercial
board game that uses Amazon Alexa.
In the past, she’s worked at companies
like Pivotal Labs and Etsy, on games
and apps such as Words With Friends
and Timehop, and as a researcher in
the MIT Media Lab's Playful Systems
research group. She’s passionate about
fostering diverse and inclusive
communities, and organizes game
events such as the Roguelike
Celebration and the annual
alt.ctrl.PARTY.
As a game designer and installation
artist, her work has been featured in
places such as the Smithsonian
American Art Museum and the Venice
Architectural Biennale, and has been
showcased at games events and
spaces such as IndieCade (2016
finalist), alt.ctrl.GDC, Bit Bash, Come
Out and Play, Babycastles, Different
Games, and New York Toy Fair (2019
Game of the Year nominee).

Twitter

Madoka ChiyodaMadoka Chiyoda
Cloud Advocate

I joined Microsoft in 2016 after being a
mobile app developer using Xamarin
for years. I love both programming
and drawing manga, so I'm doing
both. Check my manga work here.

Twitter
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Thomas LewisThomas Lewis
Cloud Advocate Lead

Cloud Advocate in Microsoft's
Developer Relations. Spatial
Computing + Academic advocacy.
Favorites: MR/AR/VR/XR, Web, Design
& otters. Pronouns: he/him.

Twitter
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 Microsoft Mixed Reality MVPs
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Aleksandr KudishovAleksandr Kudishov
Russia

MVP focused on Game Development
& Windows Development, VR/AR/MR.
Game Producer, Tech Evangelist,
Holographic Developer, MSP Lead of
Game-Development.

Email

Microsoft Most Valuable Professionals, or MVPs, are technology experts who passionately share their

knowledge with the community. They're always on the "bleeding edge" and have an unstoppable urge to get

their hands on new, exciting technologies. They have deep knowledge of Microsoft products and services, and

can bring together diverse platforms, products, and solutions, to solve real world problems. MVPs make up a

global community of over 4,000 technical experts and community leaders across 90 countries/regions, driven

by their passion, community spirit, and quest for knowledge. Above all, MVPs are always willing to help others -

that's what sets them apart.

https://twitter.com/tommylee
mailto:draconifore@gmail.com


Alexander MeijersAlexander Meijers
The Netherlands, Rijswijk

A professional who inspires, motivates,
and educates businesses on how to
use emerging technologies using
Virtual, Augmented, and Mixed Reality
in their journey to digital innovation.
He has a strong background on
SharePoint, Office 365, and Microsoft
Azure and is working with machine
learning, artificial intelligence, and
cognitive services. Primarily focused on
manufacturing, construction, industry,
logistics, and maritime/offshore, his
goal is helping businesses to achieve
more on creating, improving,
smartening, and shortening of
business processes by using services,
apps, and devices like HoloLens and
Kinect for Azure.

Email

András Velvar tAndrás Velvar t
Budapest, Hungary

András has been a Microsoft Most
Valuable Professional (in Windows
Development / Mixed Reality) for 12
years. He's a frequent speaker at
technology events (Sessionize profile).
He's the author of the open-source
MVPToolkit for Unity that allows Unity
developers to create maintainable,
testable AR/VR enterprise applications.
András' passion is the future of
Human-Computer Interaction,
including mixed, augmented, and
virtual reality, conversational interfaces,
speech recognition. Created multiple
Pluralsight courses, including on
Apple's ARKit and Microsoft's UWP
XAML technologies.

Email
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https://sessionize.com/velvart-andras/
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Bronwen ZandeBronwen Zande
Brisbane, Australia

Bronwen Zande is a Director of Soul
Solutions, having spent more of her life
as a developer than not. She's a long-
term Microsoft Most Valuable
Professional (MVP) having been
awarded MVP status for Windows
Development, Emerging Experiences,
Kinect, Bing Maps, and Live Services.

Bronwen is an active community
member involved in promoting IT as a
career with her participation in judging
Imagine Cup, Young ICT Explorers, and
Technology Takes You Anywhere.
Bronwen was a founding member of
the Brisbane Girl Geek Dinners,
organizer of Developer, Developer,
Developer Brisbane (now DDD
Brisbane), and a multi-year Australian
activator for SheEO.

She is an avid traveler and when not
behind the lens of a camera can often
be found presenting at a local meetup
or user group while on her travels.

Email

Bruno AnjosBruno Anjos
Brazil

Innovation Manager, work at
management and architecture of
Digital Pages innovation projects, with
expertise for XR - Augmented Reality,
Mixed and Virtual Reality platforms.
Microsoft MVP in Mixed Reality 2020-
2021 in Mixed Reality. I work as an
expert in the development and
planning of Mixed Reality solutions -
focusing on Microsoft HoloLens.
Experience with game and application
development, and asset creation and
multimedia content.

Email

T EA M  M EM B ERT EA M  M EM B ER A B O UTA B O UT EM A ILEM A IL

mailto:bronwen@soulsolutions.com.au
mailto:brunof.anjos@outlook.com


Clemente GiorioClemente Giorio
Torino, Italia

"Hacker, geek, maker, researcher,
innovator, trainer, developer...
Has made science and technology his
passion other than his job. Follows
many communities and is often
actively involved as a speaker and
event organizer in particular with:
Coding Gym, DotNetPodcast,
FabLabNapoli, DotNetCampania and
HoloLens Developers.
His signature dishes, far from the
stove, are: Artificial Intelligence,
Computer Vision, Internet of Things,
Natural User Interface, and Mixed
Reality.
Microsoft MVP and Intel Software
Innovator, works as Senior Research &
Development Engineer for Deltatre,
where he develops software
prototypes.

Email

Eric ProvencherEric Provencher
Montreal, QC, Canada

Eric is a Spatial Design Engineer
working on Advanced XR Authoring
Research at Unity Labs. Experienced in
working on MRTK and cross-platform
mixed reality application framework
development from his time at CAE and
a close Microsoft Mixed Reality partner.
Eric maintains MRTK-Quest, a widely
used open-source extension to MRTK.
MRTK-Quest brings native support of
the Oculus ecosystem, including
controller and hand tracking support
on Oculus Quest.

Email

Fabrice BarbinFabrice Barbin
France

Entrepreneur, innovation, and
technology enthusiast for years,
Fabrice is CEO at SYNERGIZ, Microsoft
Mixed Reality Partner, pioneer of
HoloLens use cases in France. Actively
promoting Microsoft technologies as
speaker, rewarded MVP for 12 years,
Fabrice is interested by a large set of
products: HoloLens, Kinect4Azure, IoT,
Surface Hub, Ink, Touch, IA, Machine
Learning, Cognitive Services, Azure

Email
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mailto:tinuxnet@hotmail.com
mailto:erproven@gmail.com
http://www.synergiz.com
mailto:fbarbin@synergiz.com


Francesco ClasadonteFrancesco Clasadonte
Milan, Italy

Fanciful and creative, I engage in
everything I'm passionate about. For
three years I have been working as a
researcher at Politecnico di Milano,
focusing my research on interactive
technologies for children with
disabilities, gaining experiences in
developing IOT systems, smart objects,
robot interaction, lighting design,
multisensory environment, and natural
user interfaces both in national and
international projects.

Currently, I'm working at
FifthIngenium as Senior Creative
Developer, in the fields of IOT, web
solutions, system integration, with
focus on emerging and innovative
technologies such as mixed reality and
artificial intelligence.

Email

Gianni Rosa GallinaGianni Rosa Gallina
Italy

Gianni is a Microsoft MVP since 2011,
focusing on emerging technologies, AI,
and Virtual/Augmented/Mixed Reality
since 2013. Currently he's R&D Senior
Software Engineer in Deltatre's
Innovation Lab, designing, and
prototyping next generation solutions
for sport-related experiences and
services, from VR/MR apps to end-to-
end Azure architectures and video
workflows, passing by Cognitive
Services, AI and much more. Besides
that, he's an active member of the local
community "Torino Technologies
Group" (TTG), organizer and trainer for
Coding Gym Torino monthly meetups,
Pluralsight online courses author,
publish articles on his blog and he's
speaker in national and international
tech conferences and events.

Email

Jessica EngstromJessica Engstrom
Stockholm, Sweden

Microsoft MVP - Windows Platform
Development, Public speaker, UX, Bots,
and Mixed Reality. Coding After Work
Podcast co-host. User group and
conference organizer

Email
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https://fifthingenium.com
mailto:klasaf@outlook.com
mailto:giannishub@hotmail.com
mailto:jessica@catoholic.se


Jimmy EngstromJimmy Engstrom
Stockholm, Sweden

Microsoft MVP - Windows Platform
Development, speaker, Blazor, Mixed
Reality, HoloLens, and Windows
developer. Coding After Work Podcast
co-host. User group and conference
organizer

Email

Joost van SchaikJoost van Schaik
Amersfoort, The Netherlands

I'm not the one to paint big stories
and wide vistas in the MR space – I call
myself a developer++ and I make
things happen. My primary claims to
'fame' are my blog and my apps – one
of the first indie apps for both
HoloLens 1 and 2 available from the
Store are mine. Look for publisher
"LocalJoost" and see for yourself. In the
past three years I've been involved in
quite some commercial projects too. I
consider myself a community person –
I love to share my knowledge, both on
my blog and in person.

Email

Lance LarsenLance Larsen
Madison, WI, USA

Lance Larsen is a Microsoft MVP, a
founder, and the Chief Visionary
Officer (CVO) of HOLOSOFT as well
avid Community Speaker -and-
president of MADdotNET, Madison
Wisconsin's .NET developer
community! Additionally, he's one of
the original organizers of That
Conference - the Summer Camp for
Geeks. Most proud to have focused on
"Growing-up Geek" talks to raise the
next generation of kids on technology.
Technology focused on "HoloLens /
Mixed Reality", "VR / AR for industry",
"Azure Spatial Anchors", "Azure Kinect",
"Unity Development" and much more...

Email
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mailto:jimmy@engstromjimmy.se
mailto:joostvanschaik@outlook.com
https://www.holosoft.com
https://www.maddotnet.com
mailto:lance@lancelarsen.com


Lance McCar thyLance McCar thy
Boston, MA, USA

Lance McCarthy is an exceptional
community leader with an acute
expertise for all things .NET and C#
(especially on the XAML stack) and
HoloLens/Mixed Reality applications.
Lance is helpful online, guiding and
answering questions from Microsoft
developers on Twitter as
@lancewmccarthy and blogs at
DVLUP.com. He organizes & hosts
events in the Boston area such as user
group nights, mini-code camps, and
full hackathons.

Email

Matteo ValorianiMatteo Valoriani
Milan, Italy

Speaker at national and international
conferences, travel and technology
lover, Matteo is Microsoft MVPs since
2014 focusing on Natural User
Interfaces, Kinect, Emerging
Technologies, Volumetric Video,
Augmented Intelligence, and Mixed
Reality.

After working in Microsoft, a PhD on
Computer Vision and unconventional
paradigms for ambient interaction,
Matteo founded and lead
FifthIngenium, an Italian high-tech
company, Microsoft Partner, specialized
on HoloLens and Mixed Reality
solutions for Training, Healthcare, and
Industry 4.0. Every day Matteo helps
its customers, medium and large
companies, to understand and exploit
the potential of Mixed Reality and AI.
Matteo believes in the power of
technology to improve people's lives
and for this reason he promotes and
develops technological projects with
high social impact in the field of
disability and children's education.

Email

T EA M  M EM B ERT EA M  M EM B ER A B O UTA B O UT EM A ILEM A IL

mailto:lance@dvlup.com
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Philipp BauknechtPhilipp Bauknecht
Pforzheim, Germany

Hi, I'm Philipp Bauknecht from
Germany, Founder & CEO of
medialesson GmbH an early adopter of
HoloLens and member of the
Microsoft Mixed Reality Partner
Program. I help my customer's design,
architect, build and operate modern,
beautiful, and useable Apps that run
on any platform as a consultant,
architect, and trainer together with my
team of highly skilled designers and
developers. Besides I teach Interface
Design at the Pforzheim University and
engage with the community as a
speaker at conferences and user
groups and organizer of code camps
and hackathons. I was selected as one
of the 100 creative talents by the
European Union and the Committee of
the Regions. I'm a Microsoft Most
Valuable Professional (MVP) for
Windows Development since 2013. In
2017, I was accepted into the
Microsoft Regional Director Program.

Email

Rafał LegiRafał Legięddź
Pabianice, Poland

Rafał works as a software engineer for
Avenga. Being in the industry since
2007 he develops his passion for the
software at every possible moment. He
believes that being pragmatic in our
field is helpful and proves that by
switching technologies he uses
whenever there's a need or an
opportunity to learn new concepts.
Started with .NET back-end solutions,
he quickly became a web guy and then
he got his head around different kind
of mobile technologies and VR/AR.
Also a Microsoft MVP in Windows
Development.

As his passion evolved, he became
obsessed with knowledge sharing and
community activities. That resulted in
co-founding a conference and a series
of other actions like giving talks or
conducting workshops.
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René SchulteRené Schulte
Dresden, Germany

René Schulte is Director of Global
Innovation at Valorem Reply working
with teams across the globe on
emerging technologies like the
revolutionary 3D volumetric video
telepresence solution HoloBeam and
the AR Cloud enabling large, cross-
platform user experiences with
persistence. He is a creative thought
leader with a passion for UX and deep
technical knowledge from more than
10 years in VR/AR/MR/XR technology
and 3D programming, developing for
the Microsoft HoloLens since 2015,
was featured on Forbes and is listed as
VR/AR/MR dev influencer. He also
coded AI deep learning neural
networks before it was cool and is
applying modern AI to empower
humans. He is a frequent keynote and
session speaker and panelist at
conferences like //build, Unite, Vision
VR/AR Summit, VRDC (GDC), AWE, ESA
and more. Blogs about many topics.
He also created popular open-source
libraries like WriteableBitmapEx and
the AR library SLARToolKit. He was
honored several times for his dev
community work with the Microsoft
MVP award, recognized as Microsoft
Regional Director and Global Advisory
Board member for the VR/AR
Association.

He lives in Dresden, Germany with his
wife and their 5 children.

Email

Simon Darkside JacksonSimon Darkside Jackson
United Kingdom

Long time game evangelist, from the
early days of basic, pascal and C++.

Jumped on the XNA bandwagon in its
infancy from the sailing ship MDX,
from there I've expanded far and wide
dealing with game and development
frameworks from here to the beyond.
Currently enjoying my first year as a
published author and entrant in the ID
program and seeking to get as many
people on boarded as possible.
Additionally I'm being dragged round
the UK supporting the Unity porting
programs (maybe MonoGame later)
and getting lots of projects on to the
windows platform.

Email
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Takahiro MiyauraTakahiro Miyaura
Nara, Japan

I'm working as a software engineer,
and developer in IT industry. In
particular, I've been doing research
XR(VR/AR/MR etc.) technologies, and
various technologies(AI, IoT, and so on)
that can take advantage of XR.

Email

Tamás DemeTamás Deme
Budapest, Hungary

Tamás is a mixed reality engineer
working at the Atlanta based VIM,
where he develops solutions for
devices ranging from servers to a
headset that shows you holograms.
He's a five times Microsoft MVP in
Windows Development, interested in
open-source projects, teaching and
mentoring. You can find him online at
https://tomzorz.me or on twitter at
https://twitter.com/tomzorz_.

Email

Tatsuro UedaTatsuro Ueda
Mie, Japan

MR Educator of Physics in 5 countries
including Afrika, President of Feel
Physics

Email
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Vincent GuiguiVincent Guigui
Paris, France

In charge of the Innovative
Interactions division at OCTO
Technology, I help our customers
develop new interactions between
human and digital world.

I am a lecturer on Innovation and
Natural User Interfaces topics, talking
about Immersive Experiences
(VR/AR/MR), Conversational Interfaces
(Bot), and potential future of the user
interfaces...

Since 2013, I've been awarded by
Microsoft as one of the european
leading experts on Kinect, Natural User
Interfaces, and HoloLens (Most
Valuable Professional award).

Email
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